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Documentation Warranty 
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BY APPLICABLE LAW, KEYSIGHT DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED WITH 
REGARD TO THIS MANUAL AND ANY INFORMATION CONTAINED HEREIN, INCLUDING BUT NOT LIMITED 
TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
KEYSIGHT SHALL NOT BE LIABLE FOR ERRORS OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN 
CONNECTION WITH THE FURNISHING, USE, OR PERFORMANCE OF THIS DOCUMENT OR ANY 
INFORMATION CONTAINED HEREIN. SHOULD KEYSIGHT AND THE USER HAVE A SEPARATE WRITTEN 
AGREEMENT WITH WARRANTY TERMS COVERING THE MATERIAL IN THIS DOCUMENT THAT CONFLICT 
WITH THESE TERMS, THE WARRANTY TERMS IN THE SEPARATE AGREEMENT WILL CONTROL. 

U.S. Government Rights 

U.S. Government Rights. The Software is “commercial computer software,” as defined by Federal Acquisition Regulation 

(“FAR”) 2.101. Pursuant to FAR 12.212 and 27.405-3 and Department of Defense FAR Supplement (“DFARS”) 227.7202, the 

U.S. government acquires commercial computer software under the same terms by which the software is customarily 

provided to the public. Accordingly, Keysight provides the Software to U.S. government customers under its standard 

commercial license, which is embodied in its End User License Agreement (EULA), a copy of which can be found at 

http://www.keysight.com/find/sweula. The license set forth in the EULA represents the exclusive authority by which the U.S. 

government may use, modify, distribute, or disclose the Software. The EULA and the license set forth therein, does not require 

or permit, among other things, that Keysight: (1) Furnish technical information related to commercial computer software or 

commercial computer software documentation that is not customarily provided to the public; or (2) Relinquish to, or otherwise 

provide, the  government rights in excess of these rights customarily provided to the public to use, modify, reproduce, release, 

perform, display, or disclose commercial computer software or commercial computer software documentation. No additional 

government requirements beyond those set forth in the EULA shall apply, except to the extent that those terms, rights, or 

licenses are explicitly required from all providers of commercial computer software pursuant to the FAR and the DFARS and 

are set forth specifically in writing elsewhere in the EULA. Keysight shall be under no obligation to update, revise or otherwise 

modify the Software.  With respect to any technical data as defined by FAR 2.101, pursuant to FAR 12.211 and 27.404.2 and 

DFARS 227.7102, the U.S. government acquires no greater than Limited Rights as defined in FAR 27.401 or DFAR 227.7103-

5 (c), as applicable in any technical data. 

Certification 

Keysight Technologies, Inc. certifies that this product met its published specifications at the time of 

shipment from the factory. Keysight Technologies, Inc. further certifies that its calibration measurements are 

traceable to the United States National Institute of Standards and Technology, to the extent allowed by the 

Institute's calibration facility, and to the calibration facilities of other International Standards Organization 

members.  

Contacting Keysight 

Assistance with test and measurements needs and information on finding a local Keysight office are 

available on the Web at:  http://www.keysight.com/find/assist 

If you do not have access to the Internet, please contact your Keysight field engineer. 

In any correspondence or telephone conversation, refer to the Keysight product by its model number and 

full serial number. With this information, the Keysight representative can determine whether your product is 

still within its warranty period. 
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Supported PXI VNA products for this help: M9485A, M937x

Still looking for answers?

Post your question at the Keysight Discussion Forums
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What's New

Notes

The latest version includes changes from all previous versions.

See New Programming Commands

To see the code version, from the SFP click Help, then About Network Analyzer

What's New in PXIe Code Version A.12.55

M9485A/M937xA

Support Automatic Fixture Removal (Option 007)

Support M9341B Digital/Analog I/O

Support M9111A PXI SMU

M9485A

Support M9161D PXI Solid State Dual SP4T Switch

Support M9379A and M9161D control for Noise Figure measurement (Option 028)

What's New in PXIe Code Version A.12.50

M9485A

Support Noise Figure measurement (Option 028)

Support M9341A

Support M9379A
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Programming the PXI VNA

The following tips can help you successfully program the  PXIe VNA.

SCPI  (Standard Commands for Programmable Instruments)

The PXI VNA is programmable using the SCPI language. The SCPI documentation is included in this

help file.

In the PXI VNA, SCPI commands MUST be sent through either HiSLIP or through the IVI-

COM/Labview driver pass-through.

HiSLIP

The PXI VNA software supports the HiSLIP interface for SCPI commands. This MUST be enabled

from the Soft Front Panel using the IO configuration dialog. Learn more.

Note: (M937xA) If you can NOT connect with an external PC using LAN (HiSLIP), add a single

exception to the firewall – either for the 835x.exe or for port 4880.

IVI-COM / IVI-C / LabView Driver Interfaces

These drivers are the preferred programming interface to the PXI VNA software. The IVI COM driver

is extensively documented in its own help file located at "c:\program files\ivi

foundation\ivi\drivers\agna\agna.chm". The LabView driver is also documented. Both the driver and

help file are included on the CD that was shipped with the product.

There are numerous examples for using the IVI-COM driver to perform common operations.

They are located at: "c:\program files\ivi foundation\ivi\drivers\agna\examples".

Each of these drivers has a SCPI pass-through interface that can be used to send SCPI
commands directly to the instrument.

It is NOT necessary to launch the soft front panel to use these drivers.

Live Soft Front Panel (SFP)

By default, the SFP is NOT visible when using the driver interface to connect to the PXI VNA.

 However, both the remote program and the SFP can run simultaneously. This can be useful during

development to help diagnose any programming errors. Start the SFP by clicking the "Network

Analyzer" icon on the controller desktop.

PXI VNA connection string (M937xA)

1.
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The PXI addresses are available in three locations:

through the Launcher application (Network Analyzer icon on the desktop)1.

through Keysight IO Libraries2.

through the VISA library by using viFindRsrc().3.

From the Launcher application copy the address on the dialog. For a 1-module example, the PXI address

may be PXI15::0::0::INSTR

If you know the chassis and slot number of your module, you can also format the connection string this

way: PXI0::CHASSIS<Chassis#>::SLOT<Slot#>::INSTR. For example, if you only have 1

chassis (this is most common), and the PXI VNA is in slot 9, then the connection string would be:

PXI0::CHASSIS1::SLOT9::INSTR

Speed up Measurements and Data Transfers

Learn how.

Multiple Modules (M937xA)

When using multiple PXI VNA modules, you can choose to use them in a Multisite or Multiport

configuration.

For help configuring your hardware, please refer to the Installation Guide on the M937xA

documentation website: http://na.support.keysight.com/pxi/help/

Multiport

When connecting to multiple modules, at least one of the modules must have option 551. The

connection string for Multiport is a semicolon ";" delineated list of PXI addresses.

For example: The following creates a 4-port VNA using a VNA module in slot 9 combined and another
in slot 10. Port 1 and Port 2 are measured on slot 9. Port 3 and Port 4 are measured on slot 10.

PXI0::CHASSIS1::SLOT9::INSTR;PXI0::CHASSIS1::SLOT10::INSTR

Learn more about Multiport configurations.

Multisite

When connecting to Multisite PXI VNAs, simply connect to each of them separately and configure

them individually.
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When running your program on the PXI controller using the IVI-COM, Labview, or IVI-C driver, you

can use the PXI VNA connection string (shown above). The VNA firmware does not need to be started

with the launcher GUI.

You can also connect over LAN using the HiSLIP address. First, you must enable the HiSLIP interface

using the GPIB dialog. Then, you must launch the VNA modules using the Launcher GUI. Use a unique

address to identify each of the VNA firmware instances as follows for 2 VNA modules.

TCPIP0::<hostname>::hislip0::INSTR

TCPIP0::<hostname>::hislip1::INSTR

Learn more about Multisite configurations.

Mix and Match

You can mix-and-match your Multisite and Multiport instances. For example, with 4 PXI VNA

modules, you can run a 6-port Multiport instance using 3 of your PXI VNA modules at the same time

that you run a 2-port instance using the last module.
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PXI VNA SFP Launcher

The PXI VNA SFP is unique in that this software IS the firmware that runs the modules. It does not

send programming commands to the instrument, but instead communicates directly with the module

hardware. It is a complete, FULL-FEATURED software package. This is a subtle difference, but has

implications on how you will configure and connect to the VNA modules.

See Also: Programming the PXI VNA

How to start the SFP Launcher

M9371A/M9372A/M9373A/M9374A/M9375A

Multiple Modules

M9485A

M9371A/M9372A/M9373A/M9374A/M9375A

Use any of the following methods:

Click  on the host controller desktop to start the PXIe VNA Soft Front Panel (SFP).

Keysight IO Libraries (Keysight Connection Expert). This method can start only a single

module.

Command Prompt: This method does not allow the use of an alias, but ONLY the PXI VISA

address. To do this, run 835x.exe with the PXI instrument name as the only argument. The

following are TWO examples:

C:\program files (x86)\agilent\network analyzer\835x.exe

PXI14::0::0::INSTR;PXI10::0::0::INSTR or

C:\program files (x86)\agilent\network analyzer\835x.exe

PXI0::CHASSIS1::SLOT6::FUNC0::INSTR;PXI0::CHASSIS1::SLOT7::FUNC0::INSTR

The following Launcher dialog appears. This dialog allows you to configure one or more M937xA

VNA modules as a system.

19



Select the modules to comprise the PXI VNA. Learn how to configure multiple modules below.

Refresh - Click to update the list of PXI devices on the system. Do this when you have recently

added or removed a module, or if the Launcher is not showing the devices as expected.

Run - Click to run the SFP software.

 

M9485A

Click  on the host controller desktop to start the PXIe VNA Soft Front Panel (SFP).

The following modules are required to run the application.

One M9300A Reference Module

One M9310A Source Output Module

Two M9309A Synthesizer Modules (One is for the source signal; another is for the local signal)

One M9340A Distributer Modules for 1 chassis configuration. Four M9340A.Distributer Modules

for 2 chassis configuration

At least two of  M9376A or M9377A Modules. (Number of modules should be even).

Function Description

Select Instruments and Modules, Modules or Saved Instruments.
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Show dropdown menu

A list of the displayed Instruments and Modules is filtered by the

following selection mode.

Instruments and Modules – shows both of Saved Instruments and

Modules

Modules – shows the supported modules found through VISA

discovery

Saved Instruments – shows the name of saved instruments (which

are defined by saving a configuration into IVI Configuration Store)

When the modules cannot be detected, see the Troubleshooting Hint for

M9485A .

Help Open M9485A Help

Run Launch SFP with the configuration of the selected instruments.

Save Connection…

Open “Save Instrument Connection” dialog. The configuration of the

currently selected modules is saved into IVI Configuration Store as the

specified name.

Delete Saved Connection…

(When one of the saved

instruments is selected in the

displayed list, “Delete Saved

Connection…” button

appears instead of “Save

Connection…” button.)
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Delete Saved Connection…

(When one of the saved

instruments is selected in the

displayed list, “Delete Saved

Connection…” button

appears instead of “Save

Connection…” button.)

 

Delete the selected instrument definition.

Note:

- When multiple instruments are installed in the same PXI chassis and need run them, run the M9485A

at the last. Otherwise M9485A measurement trigger may be terminated and VNA shows an error. You

can recovery the error by closing error dialog and trigger the VNA again.

- Do not use sleep mode on PC. Confirm if Control Panel > Hardware and Sound > Power Options >

Change when the computer sleeps> Put the computer to sleep is set at Never.

-When your OS is windows 8.1, the following setup is required.

1. Start Keysight Connection Expert

2. Click Manual Configuration tab

3. In "Add a LAN device" pane, set "localhost" for "Hostname or IP Address:" field. Select "HiSLIP"

for "Set Protocol:" selection. Then press "Accept" button.

4. Confirm "Unknown Instrument, TCPIP::localhost::hislip0::INSTR" Connection is available in
"Instruments" tab.

5. Close the Connection Expert window and then run the Launcher.

Multiple Modules (M937xA)

When more than one module is installed in the chassis, you can choose to configure the modules as a

Multiport VNA or as Multisite VNAs .

Multiport VNA (M937xA Option 551 only)
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With option 551 purchased for any single module, you can create a Multiport system as long as the

single module with option 551 is included somewhere in the chassis.

For example:

The above dialog shows 6 modules installed in the chassis in slots 5, 6, 7, 8, 15, 16. The module in slot

5 (PXI13) has option 551. In this case, slots 5, 6, and 7 are selected. Click Run. Those three modules

behave as a Multiport (6-port) VNA. That instance of the SFP, and your remote programs, will allow

you to calibrate and make measurements at ports 1 through 6. Each test port has a source, measurement

receiver, and reference receiver.

The modules MUST be physically configured as a Multiport VNA. Do this by connecting the front-panel Ref
In/Out, Trigger In/Out, and LO In/Out lines. Learn how in the M937xA Installation Guide at the M937xA
documentation website .

The selected modules in a Multiport VNA MUST be sequential and must include at least ONE module with
opt 551. For example, to configure a 6-port VNA using the above installed modules, you could choose Slots
5, 6, 7. You could NOT choose 5, 7, 8; they are not sequential. Nor could you choose 6, 7, 8; they do NOT
include PXI13 which has option 551.

Each VNA module has ports labeled 'Test Port 1' and 'Test Port 2'.  In a Multiport VNA, test ports become
virtually numbered beginning with the module in the lowest numbered slot to the highest numbered slot. In
our example 6-port VNA, the module in slot 6 would be Test Port 3 on top, and Test Port 4 on bottom.  The
module in slot 7 would be Test Port 5 on top, and Test Port 6 on bottom.

The first module, from left to right, is the Master module. To control the Reference, Triggering, and LO
signals for the Multiport VNA, you make settings on the first module. The other modules follow.

Module Number - A few remote commands require the module number. This is the order in which the
module appears in the Multiport VNA. In the above example, Module 1 is in slot 5, module 2 is in slot 6, and
so forth.

The software supports up to 16 modules connected together to form a 32-port VNA.

See Also: Programming Multiport and Multisite configurations

Multisite VNA (M937xA only)

While the 6-port VNA is running, you can also create a different, fully-functioning VNA which would

run at the same time as the 6-port VNA. The only practical limit to the number of VNA instances is the

CPU speed of the host controller. The benefit of creating Multisite VNAs is measurement throughput.

You could test multiple devices at the same time.

Here is how to create a Multisite VNA:

With the first VNA already running, again click the desktop icon, which restarts the Launcher dialog.1.

2.
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1.

The Launcher dialog shows the same selected slots as the previous time. The selection is 'sticky' to allow
you to quickly run the same configuration as before.

2.

Click each to unselect the previously-selected slots.3.

Then select one or more of the previously-unused VNA modules. In our example, this would be slots 8, 15,
and 16.

4.

Click Run and another SFP display appears.5.
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N937xA Front Panel Tour

See Also

Soft Front Panel Tour

Status LED

The following LED colors indicate the M937xA status:

Green (solid) – Firmware is running but the M937xA is NOT sweeping.

Green (blinking) - Each blink indicates a measurement sweep. The M937xA may be sweeping faster than the
indicator can blink.

Amber – Power is ON but the firmware is not running.

25



Red – A hardware error has occurred.

Off – Power is OFF.

Test Ports

All M937xA models are available with 2 test ports.

See Specs for more information about the Test port connectors and Input damage levels.

Ref In / OUT

IN  When a 10 MHz external reference signal is detected at this port, it will be used as the instrument

frequency reference instead of the internal frequency reference.

OUT  This SMB(m) connector outputs a 10 MHz frequency reference signal for use by other

modules and test equipment.

Note: To use an external reference signal, you must make a setting in the M937xA.

From the soft front panel, click Utility, then System, then Configure, then check External

Reference.

From SCPI, use SENS:ROSC:SOUR

Trigger Lines

Trig IN  When enabled, the module accepts signals on this connector which indicates that the

external devices is ready to be triggered.

Trig OUT  When enabled, the module outputs signals on these connectors either before or after a

measurement.

Trig Ready  When enabled, the module outputs a 'READY' signal on this connector to other devices.

This indicates that the module is ready to be triggered.

Learn more about External Triggering

LO Out / LO In

For Daisy-chaining two or more modules. See the M937xA Installation Guide for more information.
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IO Module Front Panel

PXI I/O module M9341A/B can work with both M937xA and M9485A.

 

24 Bit Digital I/O

See Material Handler Interface for pin assignment

8 Bit Digital I/O

The ST40X-D sub 15 conversion cable is furnished with the M9341B option 001 Interface cables for

M9341B
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ST40X

Pin No.

D sub 15

Pin No.

Pin

Description

1 1 Data 1

2 2 Data 2

3 3 Data 3

4 4 Data 4

5 5 Data 5

6 6 Data 6

7 7 Data 7

8 8 Data 8

- 9 N/A

- 10 N/A

- 11 N/A

9 12 Vout

- 13 N/A

- 14 N/A

10 15 GND

Note for Vout

Vout can supply the source up to 100 mA.

This circuit does not sink the current. Hence, when the voltage setting of Vout is changed, it may take

time until the voltage reaches the setting value. The following figure shows the circuit diagram of Vout

and Data on 8 bit digital I/O.   
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Screen Tour

Click on image areas to learn more.

See Also

Marker Drag

Expanded Mouse capabilities

Learn how to Customize the Screen
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Active Entry

Allows you easily select the tools. Learn more .

Trace Status

Provides details of each trace in the window. Highlighted trace indicates the active trace. Learn more.

Entry Toolbar

Along with the softkeys, allows numeric values to be entered for settings. Learn about all toolbars.

Marker Readout

Provides stimulus and response information for markers. Learn about customizing the marker readout

area. See also Marker Drag.

Softkeys

The combination of hardkeys and softkeys allows easy access to all VNA features without a mouse.

SoftTabs

Pressing these tabs will display corresponding softkeys.

Hardkeys

Performs interface operations that are equivalent to those of keys in the INSTRUMENT keys,

RESPONSE keys, STIMULUS keys and UTILITY keys on the front panel of VNA. Learn more.

Window Number

Provides window identification which is useful for remote programmers.

Status Bar

Provides detail about all aspects of the status of the analyzer. Learn more.

Stimulus Range

Displays the start and stop values of the sweep range.

Softkey Toolbar

These icons provide shortcuts to quickly select the softkey tools. Learn more.

Marker Drag
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Drag a displayed marker across the trace using a r mouse. Learn more.

Expanded Mouse Capabilities

Cursor changes to a “hand” when hovering over a clickable object.

Right-click on the Entry toolbar to launch a mouse-compatible numeric pad.

Windows

Right-click or long press on a window area to make selections pertaining to that window.

Double-click on a window area to maximize the window. To return to original window configuration, right-click
on window area, then click Tile .

Left-click on X-axis annotation to select the active channel/trace.

Right-click on X-axis annotation and click Start/Stop/Center to change stimulus properties. Applications are
not fully supported.

Quickly change Scale, Reference Level, and Position. Learn how.

Right-click on Y-axis annotation and click Scale to change Scale.

Drag a trace from one window to another. Click or touch either the trace or the Trace Status . Drag the trace
to another window, then release the mouse or lift your finger.

Traces

Left-click a trace or Trace Status to make it the selected trace.

Double-click on a trace or Trace Status to maximize the trace. Double-click again to return to the original
trace configuration.

Set a preference to always widen the active trace.

Set a preference to briefly widen the active trace.

Drag a trace from one window to another. Click or touch either the trace or the Trace Status .  Drag the trace
to another window, then release the mouse or lift your finger.

Markers

Right-click on a trace or Trace Status to add a marker.

Right-click a marker to make selections pertaining to that marker, such as Marker Search or Function.
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Softkeys

Use the Touchscreen or adjacent buttons to select from eight dynamic softkey menu choices.

To Show the softkeys, press any front-panel hardkey and the corresponding softkey menu will be launched.

Softkey Annotations

Item Description

Menu ... Selection launches a dialog box.

Menu Selection launches another level of softkeys.

Item 
Indicates the item (marker, trace, window) is ON. Any number of objects can

be ON.

Item Indicates the item (marker, trace, window) is OFF. Click to turn item ON.

Item Indicates the item IS selected.

Item
Indicates the item is NOT selected. Click to select. Only one item in the

collection can be ON.

* Item Enter value in Entry toolbar.

Item
on |OFF

Capitalization indicates the current setting.
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Traces, Channels, Windows, and Sheets on the Analyzer

It is critical to understand the meaning of the following terms as they are used on the analyzer.

Traces - Managing

Channels - Managing

Windows - Managing

Sheets - Managing

Other Quick Start topics

Traces

Traces are a series of measured data points. There is no theoretical limit to the number of traces.

However, the practical limit is the maximum number of windows times the maximum number of traces per

window (24).

In addition, one memory trace can be stored and displayed for every data trace. Learn more about Math /
Memory traces.

Trace settings affect the presentation and mathematical operations of the measured data.

The following are Trace settings:

Parameter

Format and Scale

Smoothing

Correction ON / OFF

Electrical Delay

Phase Offset

Trace Math

Markers
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Time Domain (Opt S93010A/010)

Managing Traces

How to Add a trace

How to Select a trace

How to Delete a trace

How to Move a trace

How to Maximize a trace

How to perform Trace Hold (Max or Min)

How to Create a new trace

How to Change the trace parameter

How to display a custom trace title (separate topic)

How to display a wide active trace  (separate topic)

How to Add a trace

The only measurements that can be selected are those in the same measurement class as is currently

assigned to the channel. To select a measurement other than these, first select the appropriate

measurement class to a new or existing channel. Learn how.

A trace must be selected (active) before its trace settings can be changed.

How to know which trace is Active?
Using Hardkey/SoftTab/Softkey Using a mouse

For Traces 1-7, press Trace > Trace 1-7 > click left side Trace 1-7 small
button

1.

2.

3.

4.

Right click in the grid
box and then select

1.
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(Example: Click on left side Trace 1 small button and Trace 1 is active
when it turns green, so Trace 1 added).

1.

For Traces 8-15, press Trace > Trace 8-15 > click left side Trace 8-15
small button

2.

3.

4.

New Trace....

1.
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(Example: Click on left side Trace 9 small button and Trace 9 is active
when it turns green, so Trace 1 is added).

2.

Another method of adding traces is by pressing Trace > Trace 1-7 >
New Traces....

3.

For other traces numbers, press Trace > Trace Setup > Add Trace,
then select New Trace, New Trace + Channel, New Trace + Window,
New trace + Channel + Window, or New Traces....

4.

 

How to Select a Trace

The only measurements that can be selected are those in the same measurement class as is currently

assigned to the channel. To select a measurement other than these, first select the appropriate

measurement class to a new or existing channel. Learn how.

A trace must be selected (active) before its trace settings can be changed.

How to know which trace is Active?
Using Hardkey/SoftTab/Softkey Using a mouse

Press Trace > Trace Setup > Select.1.

Select a trace number which corresponds to the desired
measurement parameter.

2.

Click on Trace Status label of any
trace above the grid box.

1.
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How to Delete a Trace

Using Hardkey/SoftTab/Softkey Using a mouse

For Traces 1-7, press Trace > Trace 1-7 > click left side
Trace 1-7 small button

1.

2.

3.

Right-click the Trace Status label
above the grid box, then click Delete

1.
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(Example: Click on left side Trace 1 small button and
Trace 1 is inactive when it is not green).

1.

For Traces 9-16, press Trace > Trace 8-15 > click left
side Trace 8-15 small button

2.

3.

Trace.

1.
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(Example: Click on left side Trace 9 small button and
Trace 9 is inactive when it is not green).

2.

For other traces numbers, press Trace > Trace Setup >
Delete Trace, then select a trace number.

3.

 

How to Move a trace to a different Window

You can DRAG a trace from one window to another, or...

Using Hardkey/SoftTab/Softkey Using a mouse

Press Trace > Trace Setup > Move Trace....1.

Select a window number in the following dialog,
and then click OK.

2.

Right-click the Trace Status label above the
grid box, then click Move Trace....

1.

Select a window number in the following dialog,
and then click OK.

2.

 

Move Trace dialog box help  

1.
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Note: Only ONE trace can be moved at a time.

Click the Trace Status label to select the trace to move.1.
Move Trace N to window - Transfer the selected trace to any Window listed or to a New Window.2.

Trace Max

How to maximize the active trace - the active trace is the ONLY trace on the screen display. All other
traces are hidden.

Using Hardkey/SoftTab/Softkey Using a mouse

Press Trace > Trace Setup > Trace Maximize (ON).
With Trace Max (ON), select a different trace to make
that trace visible.

1.

To make all traces visible again, select Trace Maximize
(OFF).

2.

Right-click the Trace Status label

above the grid box, then click

Trace Maximize.

1.

Double click on the active trace

to make all traces visible again.

2.

Trace Hold

How to hold the active trace at the maximum or minimum points.

Using Hardkey/SoftTab/Softkey

Trace > Trace Setup > Trace Hold > OFF |
Max | Min.

1.

Restart resets the trace.2.

Using a mouse

Not available

Maximum/Minimum trace hold can be applied with several conditions:

Feature is applicable to any data trace, but NOT to memory traces.

When the stimulus or any data post processing setting is changed, the trace hold data will be reset.
These settings include:

Smoothing on/off.

Smoothing Aperture.

Gating on/off.
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Transform on/off.

Conversion state change, conversion type change.

Data Math Function (Data/Mem) change.

Equation Editor state change, formula change.

Parameter change.

Formatting change.

Minimum/maximum comparison is done with formatted data. For Smith and Polar formats,

absolute data is used and not phase.

Trace hold data can be recalled.

Data save files formats

SnP does NOT save trace hold data

Citifile, CSV, MDF, PRN DOES save trace hold data

Note: Citifiles can be recalled and viewed in the VNA.

Use SCPI commands to get trace hold data. If trace hold is active, then the data returned from

the remote interfaces will be the trace hold data.

Channels

Channels contain traces. The analyzer can have up to 150 independent channels.

Channel settings determine how the trace data is measured . All traces that are assigned to a channel

share the same channel settings. A channel must be selected (active) to modify its settings. To select a
channel, click the Trace Status button of a Trace in that channel. The following are channel settings:

Frequency range

Power level

Calibration

IF Bandwidth
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Number of Points

Sweep Settings

Average

Trigger (some settings are global)

Managing Channels

How to Select a Channel

A channel must be selected (active) before its settings can be changed.

To make a channel active, select a trace in that channel or click the Trace Status button of a Trace in

that channel.

 

How to Add a channel

Using Hardkey/SoftTab/Softkey

Press Channel > Channel 1-8 > click left side
Channel 1-8 small button

1.

2.

Using a mouse

Not available
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(Example: Click on left side Channel 1 small
button and Channel 1 is active when it turns
green, so Channel 1 is added).

1.

For other channel numbers, press Channel >
Channel Setup > Add Channel, then select
New Trace + Channel or New Trace +
Channel + Window.

2.

No programming commands are available for this feature

 

How to Delete a channel

Using Hardkey/SoftTab/Softkey

Press Channel > Channel 1-8 > click left side
Channel 1-8 small button

1.

2.

Using a mouse

Not available
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(Example: Click on left side Channel 1 small
button and Channel 1 is inactive when it is not
green).

1.

For other channel numbers, press Channel >
Channel Setup > Delete Channel, then select
a channel.

2.

Windows

Windows are used for viewing traces.

The analyzer can show an UNLIMITED number of windows on the screen with the following limitations:

The SCPI status register can track the status of up to 576 traces.

Each window can contain up to 24 traces.

Windows are completely independent of channels.

See Customize the analyzer screen to learn how to make other window settings.

The following is a window containing two traces. Both traces use the same channel 1 settings as

indicated by the annotation at the bottom of the window.

The window number shows in the lower-left corner of the window. The following shows window 5.
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Managing Windows

How to Add a window

Using Hardkey/SoftTab/Softkey Using a mouse

Press Display > Window 1-8 > click left side Channel 1-8 small
button

1.

2.

Right-click any area of grid
box and then select New

1.
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(Example: Click on left side Window 1 small button and Window 1 is
active when it turns green, so Window 1 is added).

1.

For other windows, press Display > Window Setup > Add
Window, then select New Window, New Trace + Window, or New
Trace + Channel + Window.

2.

Window.

1.

 

How to Delete a Window

Using Hardkey/SoftTab/Softkey Using a mouse

Press Display > Window 1-8 > click left side Channel 1-8
small button

1.

2.

Right-click any area of grid box and
then select Close Window.

1.
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(Example: Click on left side Window 1 small button and
Window 1 is inactive when it is not green).

1.

For other windows, press Display > Window Setup >
Delete Window, then select a window.

2.

1.

 

How to Move a Window to a different Sheet

Note: This featue is NOT available on M948xA and E5080A.

Using Hardkey/SoftTab/Softkey

Select a Window to move.1.

Press Display > Window Setup > Move Window...2.

Select a sheet number in the following dialog, and then click OK.3.

 

Move Window dialog box help  

Note: Only ONE window can be moved at a time.

Move Window N to Sheet N- Transfer the selected window to any sheet listed or to a New Sheet.1.
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How to Change Window Layout

Note: This featue is NOT available on M948xA and E5080A.

This is a window auto-layout option, for quicker selection instead of selecting the trace, channel,

window and sheet separately. 7 auto-layout options are available.

Using Hardkey/SoftTab/Softkey

Press Display > Window Setup > Window Layout.1.

Select 1 Window, 2 Windows, 3 Windows, 4 Windows, 1 Trace per Window, 1 Channel per
Window, or Tile Windows.

2.

 

How to maximize the active window - the active window is the ONLY window on the screen display.
All other windows are hidden.

Using Hardkey/SoftTab/Softkey Using a mouse

Press Display > Window Setup > Window Max (ON). With
Window Max (ON), select a different window to make that
window visible.

1.

To make all windows visible again, select Window Max (OFF).2.

Right-click in any area of the
grid box and then select
Maximize.

1.

Sheet

Sheets are used to group VNA windows. The sheet tabs provide an easy way to switch multiple display

settings quickly.

Features and actions that can performed with tabbed sheets:

Add/Delete/Select sheet

Move window to sheet

Measurement can be performed on traces/channels in inactive sheets

Easy setup for channel per window

48



Easy setup for channel per sheet

Managing Sheet

How to Add Sheet

Using Hardkey/SoftTab/Softkey Using a mouse

Press Display > Sheet Setup > Add Sheet.1.

The select one a New Sheet, New Trace +
Sheet or New Trace + Channel + Sheet.

2.

Click on the sheet tab.1.

 

How to Delete a Sheet

Using Hardkey/SoftTab/Softkey Using a mouse

Press Display > Sheet Setup > Delete Sheet.1.

Then select a sheet.2.

Click on the sheet tab.1.

 

How to View a Sheet

Using Hardkey/SoftTab/Softkey Using a mouse

Press Display > Sheet Setup > Select.1.

Then select a sheet.2.

Click on the sheet tab.1.

 

How to Change Sheet Title

Using Hardkey/SoftTab/Softkey

Press Display > Sheet Setup > Sheet Title....1.

In the pop up Sheet title box, enter the title and click OK.2.
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How to Change Sheet Layout

This is a sheet auto-layout option, for quicker selection instead of selecting the trace, channel,

window and sheet separately. 4 auto-layout options are available.

Using Hardkey/SoftTab/Softkey

Press Display > Sheet Setup > Sheet Layout.1.

Select 1 Sheet, 1 Trace per Sheet, 1 Channel per Sheet, or 1 Window per Sheet.2.

 

 

50



Quick Start Dialog

Quick start is a simple wizard which helps to setup the settings for typical measurements. This feature

allows users to select from a set of pre-configured measurement layouts.

How to Open Quick Start Dialog Box

Using Hardkey/SoftTab/Softkey

Press Setup > Main > Quick Start....1.

The measurement comprises the following THREE steps.

Step 1: Layout Templates

You are able to select a layout template for typical measurements.

 If "Create in new channel" checkbox is enabled, a new channel and window(s) will be created.
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 If "Create in new channel" checkbox is disabled, when a template is selected then the active

channel will be used for the new measurements. If the active trace is displayed in a window with traces

on other channels, then the trace will be deleted and a new window(s) will be opened for the new

measurements.

 

 If "Display Smith Chart" checkbox is enabled, the active trace in a window will turn to display

Smith Chart.

 If "Display Smith Chart" checkbox is disabled, no changes on the active trace in a window.

Step 2: Stimulus Settings Dialogs

This step is used to set stimulus for the measurement.

S-

Parameters

Option

Required:

None

Creates S11 and S21 measurements in a single channel and

window.

Enter:

Start/Stop frequency

Center Frequency

Span Frequency

Sweep Type:  Lin or Log Frequency

Power
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IF Bandwidth

Number of Points

Learn more about S-parameter measurements.

Differential

(Balanced)

Option

Required:

None

Creates Sdd11 and Sdd21 measurements in a single channel and

window.

 

Enter:

Start/Stop frequency

Center Frequency

Span Frequency

Sweep Type:  Lin or Log Frequency

Power

IF Bandwidth

Number of Points

Learn more about Differential (Balanced) measurements.

Creates R1 and B receiver measurements in a single channel and

window. This allows you to view the DUT input power (R1) and

output (B) power.
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Power

Frequency

Sweep

Option

Required:

None

Enter:

Start/Stop Frequency

Center Frequency

Span Frequency

Sweep Type:  Lin or Log Frequency

Power

IF Bandwidth

Number of Points

Learn more about Power Sweep measurements.

Power

Power

Sweep

Creates a power sweep while viewing R1, B, and S21

measurements in a single channel and window. This allows you to

view the DUT input power (R1), output power (B), and DUT gain

(S21).
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Power

Power

Sweep

Option

Required:

None

Enter:

Start/Stop Power

CW Frequency

IF Bandwidth

Number of Points

Learn more about Power Sweep measurements.

Receiver

Frequency

Offset

Option

Required:

080

Creates Frequency Offset Measurement while viewing R1 and B

receivers in a single channel and window.

Enter

Source Start
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Source Stop

Receiver Start

Receiver Stop

Power Level

IF Bandwidth

Number of Points

Learn more about FOM.

Time

Domain

Option

Required:

010

Creates an S11 measurement and enables Time Domain.

Enter:

Start/Stop Time

Transform Mode (Time Domain Settings dialog auto-select

the start frequency if a LPF transform mode is selected.)

Start/Stop Frequency

Power

IF Bandwidth

Number of Points

Learn more about Time Domain measurements.

If any one of the SMC Measurements is selected in Step 1, the Mixer
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Mixer

Option

Required:

080

Quick Settings dialog will appear.

Enter:

Equation: Output = Input - LO, Output = Input + LO, Output = LO -
Input.

Input, LO, and Output Frequencies and configuration.

Learn more about SMC Measurements

Steps 3: Cal Wizard Dialog (Optional)

 If "Calibrate this setup" checkbox is enabled, the Cal Wizard Dialog will appear when Stimulus
Settings Dialog is dismissed with the "OK" button.

 If "Calibrate this setup" checkbox is disabled, the Cal Wizard Dialog will NOT appear.
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Basic Measurement Sequence

The following process can be used to setup all analyzer measurements:

Step 1. Set Up Measurements

Reset the analyzer, create a measurement state, and adjust the display.

Step 2. Optimize Measurements

Improve measurement accuracy and throughput using techniques and functions.

Step 3. Perform a Measurement Calibration

Reduce the measurement errors by performing a calibration.

Step 4. Analyze Data

Analyze the measurement results using markers, math operations, and limit tests.

Step 5. Print, Save or Recall Data

Save or print the measurement data.
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Frequency Blanking

For security reasons, you can prevent frequency information from appearing on the screen and

printouts.

How to set Frequency Blanking

Using Hardkey/SoftTab/Softkey Using a mouse

Press System > Main > Security....1. Click Utility.1.

Select System.2.

Select Security....3.

 

Security Setting dialog box help

Notes

To learn how to erase memory before moving your analyzer out of a secure area, see
http://na.support.keysight.com/pna/security.html.

An ECal Data Wipe Utility destroys all user data per US DoD 5220.22-M. Learn more at
http://na.support.keysight.com/pna/apps/applications.htm

VNA 'Undo' is disabled with High and Extra security levels. Learn more.

Security Levels

None - All frequency information is displayed on the screen and printouts.  

Low security level - Frequency information is blanked from the following:

59

http://na.support.keysight.com/pna/security.html.
http://na.support.keysight.com/pna/apps/applications.htm


Display annotation

Calibration properties

All tables

All toolbars

All printouts

External sources - See Also: Preference to Deactivate External Devices on Preset.  Note: Frequency
Blanking is fully supported ONLY on Keysight MXG sources with option 006. On MXG models without
option 006 and all PSG models, the window state is turned OFF.  When the “local” button is clicked on
the source, then frequency is re-displayed.

High security level - Low security level settings PLUS:

GPIB console is inactive

Extra security level - High security level settings PLUS:

All ASCII data saving capability (.snp, .prn, .cti) is saved without frequency information. The X-axis
information is replaced with data point numbers. Before A.08.50, saving these file types was NOT
allowed.

Mixer setup files (*.mxr) can NOT be saved.

For ALL security levels:

Frequency information is NOT blanked from the following:

Service Adjustment Programs

Your COM or SCPI programs.

Instrument State and Cal Sets

The security level is always saved and recalled with an instrument state. However, the instrument

state may contain a Cal Set or link to a Cal Set. Learn more. This may influence the security level

when the instrument state is recalled. Here is how.

When a new Cal Set is created at the end of a calibration, the current system security level is stored with
it.

The only way to change an existing Cal Set’s security level is by writing a new calibration into the Cal Set.
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When later applied to a channel, if the Cal Set has a higher security level than the current system
security level, the system security level will become upgraded to that of the Cal Set.

When saving an instrument state to either a *.csa or *.cst file, the security levels of the system and Cal
Set are saved separately. When recalled, the higher security level of the two is applied.

To view the security level of a Cal Set, see Cal Set Properties.

Re-displaying frequency information

When in Low security level, do any of the following:

Revisit this dialog box and select None

Perform an instrument preset

Recall an Instrument State/Cal Set with security level of None.

When in High or Extra security level,  do any of the following:

Perform an instrument preset

Recall an Instrument State/Cal Set with security level of None.
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Preferences

Preferences are settings that survive a Preset or Shutdown.  Preferences are listed on this page with

links to locations that provide more information.

How to set Preferences

Using Hardkey/SoftTab/Softkey Using a mouse

Press System > System Setup > Preferences....1. Click Utility.1.

Select System.2.

Select System Setup.3.

Select Preferences.4.

 

Preferences  dialog box help  
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Preferences survive a Preset and a Shutdown.

A checked box makes the following statements true unless stated otherwise.

Note: The default setting is listed first.

 Avg: On PRESET set two-point group delay aperture  Group delay aperture is set to 11

points.

 Avg: On PRESET set two-point group delay aperture  Group delay aperture set to 2 points.
Learn more.

 Cal: Always use Internal Trigger during cal - Only use Internal Trigger source

 Cal: Always use Internal Trigger during cal (default) -use the other Trigger source

NOT implemented for M937x models.

 Cal: ECal Extrapolation for IMD

 Cal: ECal Extrapolation for IMD Allows Swept IMD and IMDx channels to be calibrated

beyond the stop frequency of the ECal module by extrapolating the error terms. Learn more.

 Cal: For Frequency Offset, use Primary Frequencies

 Cal: For Frequency Offset, use Primary Frequencies  Use when making mmWave

measurements without a test set. Learn more.

This setting only affects calibrations performed using SCPI. Cals performed from the User Interface

ALWAYS offer a choice to save to a named Cal Set.

 Cal: (SCPI only) Auto-generate a User Cal Set   Completed calibrations are automatically

saved to Cal Registers; NOT to User Cal Sets.

 Cal: (SCPI only) Auto-generate a User Cal Set  Completed calibrations are automatically

saved to an auto-named User Cal Set. Caution: this can cause a lot of saved User Cal Sets. Learn
more.

The following message appears when both the Cal Set choices above and below are selected:

"Cal: Auto-save preferences conflict "

Cal: (SCPI) Auto-save to User Cal Set (above)- or - Cal: (SCPI) Auto-save to current Cal Set

(below)

Uncheck one of these.

This setting only affects calibrations performed using SCPI. Cals performed from the User Interface

ALWAYS offer a choice to save to a named Cal Set.
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 Cal: (SCPI) Auto-save to current Cal Set - Always automatically save a completed Cal to the

Cal Set that is currently selected on the specified channel, which could be the channel Cal Register.

If the channel does not yet have a selected Cal Set, the Cal will be saved to a new User Cal Set with

an automatically-generated name.

 Cal: (SCPI) Auto-save to current Cal Set (default)- Do NOT automatically save a completed

Cal to the Cal Set that is currently selected on the specified channel.

 Display: Selected trace changes width briefly. The selected trace does NOT change width

briefly in order to improve visibility.

 Display: Selected trace changes width briefly.

 Display: Selected Trace is wider.  The selected trace is the narrow, default size.

 Display: Selected Trace is wider. The active (selected) trace is always wider.

NOT implemented for M937x models.

 Display: Touchscreen ON. Selections can be made by touching the screen.

 Display: Touchscreen ON. Selections can NOT be made by touching the screen.

NOT implemented for M937x models.

 Ext Device: De-activate on PRESET and recall. External devices are de-activated when the

VNA is Preset or when a Instrument State is recalled.

 Ext Device: De-activate on PRESET and recall. External devices remain active when the

VNA is Preset or when a Instrument State is recalled.

Learn more about External Devices.

 Limit: Draw failed trace segments in red Failed segments are drawn in red. Learn more.

 Limit: Draw failed trace segments in red  Failed data points (dots) are drawn in red.

 Limit: Draw Limit Lines in Red  Limit lines are drawn in the same color as the trace.

 Limit: Draw Limit Lines in Red All Limit limes are drawn in Red.

 Limit: Test the nearest measurement point - When the stimulus of measurement point is not

the same as the limit test point, the nearest limit test point is used for pass/fail judgement.

 Limit: Test the nearest measurement point - The pass/fail is judged at only the stimulus of

limit test point.

 Markers: Coupling controls on|off state of markers - Turning a marker on or off will have no

effect on the markers on other traces.

 Markers: Coupling controls on|off state of markers - With Coupled Markers ON, when a

marker is turned on, the same-numbered marker on all coupled traces will also be turned on.
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Likewise, turning off a marker will turn it off on all coupled traces.

 Markers: On Preset, Coupled Markers is ON - Coupled Markers is OFF after Preset

 Markers: On Preset, Coupled Markers is ON - Coupled Markers is ON after Preset

 Markers: On Preset, Coupling Method is Channel - Marker Coupling Method is set to ALL

after Preset.

 Markers: On Preset, Coupling Method is Channel - Marker Coupling Method is set to

Channel after Preset.

 Marker: On Preset, set BW/Notch search reference to Peak - BW/Notch marker search

reference is set to current marker position after Preset.

 Marker: On Preset, set BW/Notch search reference to Peak - BW/Notch marker search

reference is set to peak after Preset.

 Marker: Programming treats Mkr 10 as Reference  A marker programming command that includes

10 as its marker number argument will operate on the Reference Marker (NOT the general-purpose

Marker 10). See Marker commands.

 Marker: Programming treats Mkr 10 as Reference  A marker programming command that includes

10 as its marker number argument will operate on the general-purpose Marker 10 (NOT the

Reference marker).

 Marker: Use single marker for marker search (default) - Use one marker for marker search.

Sub Marker is displayed and used for Bandwidth, Notch searches.

 Marker: Use single marker for marker search - Use multi marker for marker search.

NOT implemented for M937x models.

 Meas: Mathematical offset for receiver attenuation  The reported test port receiver power is

mathematically offset by the amount of receiver attenuation.  Default for all models.

 Meas: Mathematical offset for receiver attenuation  The reported test port receiver power is

NOT mathematically offset by the amount of receiver attenuation.

Learn more.

NOT implemented for M937x models.

 Meas: Mathematical offset for source attenuation  The reported reference receiver power is

mathematically offset by the amount of source attenuation.

 Meas: Mathematical offset for source attenuation  The reported reference receiver power is
NOT mathematically offset by the amount of source attenuation.. Learn more.
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 Memory: Data Math 8510 Mode  Standard data processing chain.

 Memory: Data Math 8510 Mode Simulate the Keysight 8510 data processing chain as it

pertains to Trace Math and Memory. Learn more.

 Memory: Interpolate ON is default condition  Set memory interpolation to OFF as the default.

 Memory: Interpolate ON is default condition  Set memory interpolation to ON as the default.
Learn more.

 Power: On Preset turn power on  Instrument Preset always turns source power ON.

 Power: On Preset turn power on  When the current source power setting is OFF, source power

remains OFF after Preset. When the current power setting is ON, source power is turned ON after

Preset. Learn more.

NOT implemented for M937x models.

For SCPI behavior only. Learn more.

 Power: Report source unleveled events as errors  Source unleveled events are reported as

errors.

 Power: Report source unleveled events as errors  Source unleveled events are NOT reported

as errors.

NOT implemented for M937x models.

 Power: Report when receiver is overloaded  A warning message is displayed on the VNA

screen indicating that a receiver is overloaded or in compression. The displayed data is probably not

accurate. One error per sweep appears and is reported in the Error Log.

 Power: Report when receiver is overloaded  Do NOT show overload warnings on the screen

or report these errors in the error log.

NOT implemented for M937x models.

 Power: RF power On during frequency sweep retrace  Leave RF power ON during a retrace

of single-band frequency or segment sweeps.

 Power: RF power On during frequency sweep retrace  Turn RF power OFF during a retrace

of single-band frequency or segment sweeps. Learn more.

NOT implemented for M937x models.

 Power: Turn Source Power Off when receiver is overloaded. Power remains ON when a
receiver is overloaded.

 Power: Turn Source Power Off when receiver is overloaded. Turn OFF power to ALL ports

when a receiver is overloaded. A notification dialog appears. Click OK, then lower the power level,
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then turn power ON. (Click Stimulus, then Power)

NOT implemented for M937x models.

 Power: Use Start Power during Power Sweep retrace  At the end of a power sweep, while

waiting to trigger the next sweep, the VNA maintains source power at the start power level.

 Power: Use Start Power during Power Sweep retrace  Maintain source power at the STOP

power level. Learn more.

 Preset: Confirm preset - When Preset hardkey button is pressed, VNA firmware immediately

presets (Hardkey is required only).

 Preset: Confirm preset (defaul) - When Preset > Preset is pressed, VNA firmware

immediately presets (Hardkey and Softkey are required).

 Preset: On Preset show Quick Start dialog - Open Quick Start dialog on Preset.

 Preset: On Preset show Quick Start dialog - Do not open Quick Start dialog on Preset.

 Recall: Softkey order is most recently used - Recall softkey order which is most recently used.

 Recall: Softkey order is most recently used (default) - Do NOT recall softkey order which is

most recently used.

 Scale: On Preset Couple scale to Window - Scale coupling is set to Window when Preset.

 Scale: On Preset Couple scale to Window (default) - Scale coupling is set to Off by default

when Preset.

NOT implemented for M937x models.

 Sweep: On Preset set Sweep Mode to Stepped - Sweep Mode set to Stepped after Preset.

 Sweep: On Preset set Sweep Mode to Stepped - Sweep Mode set to Auto after Preset.

 Sweep: Use only ramp sweeps for Auto Sweep Mode - Auto Sweep Mode set to use

continuous ramp sweeps after Preset.

 Sweep: Use only ramp sweeps for Auto Sweep Mode - Auto Sweep Mode set to not use ramp

sweeps after Preset.

 System: Enable sound (default) - Instrument speaker turns ON.

 System: Enable sound - Instrument speaker turns OFF.

 System: On Power-on show Keys toolbar - Display softkey toolbar after power-on.

 System: On Power-on show Keys toolbar - Hide softkey toolbar after power-on.

NOT implemented for M937x models.

System: On VNA Start-up Run Self Tests (default) -  Module self tests and connection checks
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are executed at start up

System: On VNA Start-up Run Self Tests  -  Module self tests and connection checks are NOT

executed at start up

 System: Use keyboard to navigate softkeys - Enable the keyboard to browse the softkeys.

 System: Use keyboard to navigate softkeys (default) - Disable the keyboard to browse the

softkeys.

NOT implemented for M937x models.

Sets the scope of External Trigger Output signal properties. The VNA is Preset after changing this

setting.

 Trigger: External Trigger OUT is Global  Channels can have different External Trigger OUT

settings. Default for VNA-X and N522xA models. On the Trigger Setup dialog, Trigger Mode =

Point is ignored for external triggering.

 Trigger: External Trigger OUT is Global  All channels have same External Trigger OUT

settings. Default for VNA “C” and VNA-L models. Aux Trig OUT properties apply to all channels

except the Per Point setting.  To set Per Point for specific channels: On the Trigger Setup dialog, set

Trigger Scope = Channel, under Channel Trigger State, select the channel, and set Trigger

Mode = Point.

See External Triggering dialog.

 

The More buttons launch dialogs that contain predefined preferences:

Data Saves... -

Define Data Saves - While not explicitly called Preferences, all of these settings survive a

shutdown. Learn more.

Power Limit

Offsets and Limits - Sets Power Limits and Offsets. Learn more.

Transparency...

Dialog Transparency - Some dialogs can be viewed in various levels of transparency. Learn more.

Language...

Help - Sets the language of the built-in help (English or other localized language). Learn more.

User Preset...

User Preset - Specify the Instrument State file that the analyzer will use when Preset. Learn more.
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Page Setup...

Page Setup - Standard printer settings (Paper, Orientation, and Size) do NOT survive a shutdown.

All other settings DO survive a shutdown. Learn more.

Colors...

Display Colors - Sets display items to custom colors. Learn more.

Print Colors - Sets print items to custom colors. Learn more.

Toolbars...

Show Toolbars/Other Bars - Select toolbars to display.

Defaults - Restore preferences to their default values.

NOT implemented for M937x models.

Millimeter settings

Sets MM Wave configurations. Learn more.

 

Although they are called preferences, the following settings do NOT survive a shutdown.

Calibration UI Setting

Show or not, the first 'Method' Page of the Cal

Wizard.

Cal Preferences

Set and order default Cal Types Cal Preferences

Perform orientation of the ECal module during

calibration?

ECal Wizard

Specify ECal port mapping when orientation is

OFF

ECal Wizard

Show or hide custom Cal Windows during Cal Cal Window (remote commands only)
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Dialog Transparency

Most VNA dialogs can be made to appear with various amounts of transparency. This allows you to

view the VNA traces through the dialog as you make dialog settings.

How to set Transparency Level

There are three ways to make the transparency level setting:

1. Right-click in any non-control area of a dialog that allows transparency to see the following

selections:

2. In tabbed dialogs, cycle through the above transparency settings by pressing  multiple times.

3. Launch the Transparency dialog (below) from the Preferences dialog.

 

This setting is not programmable
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Dialog Transparency dialog box help  

Note: This single Transparency setting applies to ALL supported VNA dialogs.

Opaque (NOT Transparent) - Default setting

8% Transparency

25% Transparency

50% Transparency

Double-click changes transparency - When checked, cycle through the above transparency

settings by double-clicking in any non-control area of a dialog that allows transparency.

Notes

The transparency setting is stored as a VNA Preference.

The setting survives a VNA Shutdown and Preset.

It is NOT saved and recalled with instrument state.
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Keyboard Shortcuts

Function Shortcut

Instrument Keys  
PREV PAGE UP

SHIFT + CONTROL + LEFT ARROW SHIFT + CONTROL + COMMA

NEXT PAGE DOWN

SHIFT + CONTROL + RIGHT ARROW

SHIFT + CONTROL + PERIOD

TRACE SHIFT + CONTROL + T    

CHANNEL SHIFT + CONTROL + H    

DISPLAY        SHIFT + CONTROL + D      

SETUP SHIFT + CONTROL + U

Response Keys  
MEAS           SHIFT + CONTROL + M

FORMAT         SHIFT + CONTROL + F    

SCALE          SHIFT + CONTROL + S      

MATH > Memory SHIFT + CONTROL + O

MATH > Analysis SHIFT + CONTROL + N

AVG BW SHIFT + CONTROL + A   

CAL SHIFT + CONTROL + C     

MARKER SHIFT + CONTROL + R

SEARCH SHIFT + CONTROL + E

Stimulus Keys  
FREQ           SHIFT + CONTROL + Q

POWER            SHIFT + CONTROL + P   

SWEEP           SHIFT + CONTROL + W

TRIGGER       SHIFT + CONTROL + I

Utility Keys  
SAVE RECALL >Recall SHIFT + CONTROL + L

SAVE RECALL > Save SHIFT + CONTROL + Y

SYSTEM SHIFT + CONTROL + Y

MACRO          SHIFT + CONTROL + G

SYSTEM > Help          CONTROL + H

Undo CONTROL + Z

Redo CONTROL + Y

PRESET SHIFT + CONTROL + X

Other Features  
Trace 1     SHIFT + CONTROL + 1

Trace 2        SHIFT + CONTROL + 2

Trace 3         SHIFT + CONTROL + 3

Trace 4         SHIFT + CONTROL + 4  

Hardkeys Toolbar  SHIFT + CONTROL + K

Minimize Application             SHIFT + CONTROL + Z          

Mainframe Menu show/hide        SHIFT + CONTROL + B       

File Open dialog CONTROL + O

Save file      CONTROL + S
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Save As dialog   CONTROL + A

Print dialog      CONTROL + P 

Print to File dialog      CONTROL + T

Focus on Mainframe Menu ALT

Softkey 1 to 8 CONTROL + 1, to  CONTROL + 8
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Using Help

This topic discusses the following:

Documentation

Printing Help

Copying Help to your PC

Launching Help

Searching Help

Help Languages

Documentation Warranty

See Also

Help, About Network Analyzer

Other Quick Start Topics

Help Documentation

This Help file is the Users Guide and Programming Manual for the PXie VNA Soft Front Panel.

Hardcopies of this help file is NOT available for purchase.

All documentation, including the latest online Web Help version of this Help file, and a printable

.PDF version of the Help file, are available at http://na.support.keysight.com/pixvna/help

Printing Help

A printable .PDF version of this Help file is available at http://na.support.keysight.com/pixvna/help

Copying Help to your PC

With the Help system on your PC, you can read about the analyzer while away from it. You can also

Copy and Paste programming code from this Help system directly into your programming environment.
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The Help file is located on your analyzer hard-drive at C:/Program Files (x86)/Keysight/Network

Analyzer/Help/PNAHelp.chm. If both the analyzer and PC are connected to LAN, you can map a

drive and copy the file directly.

The Help file can also be downloaded from http://na.support.keysight.com/pna/help/index.html.

Launching Help

The Help system can be launched in the following ways:

From the Help drop-down menu.1.

From Dialog Box Help buttons.2.

Search Tab

TIP: To Search any topic for a keyword, press Ctrl and F.

The following rules apply for using full-text search:

Searches are not case-sensitive.

You can search for any combination of letters (a-z) and numbers (0-9).

Punctuation marks (period, colon, semicolon, comma, and hyphen) are ignored during a search.

You can group the words of your search using double quotes or parentheses. Examples: "response
calibration" or (response calibration). This requirement makes it impossible to search for quotation marks.

Use Wildcard expressions:

To search for one undefined character use a question mark (?). For example, searching for cal? will
find calc and calf.

To search for more than one undefined character use an asterisk (*). Searching for Cal* will find
calibration and calculate.

Use Boolean operators to define a relationship between two or more search words.
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Search for Example Results will show topics containing:

Two words in the same

topic

response

AND

calibration

Both the words "response" and "calibration".

Either of two words in a

topic

response OR

calibration

Either the word "response" or the word "calibration"

or both.

The first word without the

second word in a topic

response

NOT

calibration

The word "response" but not the word "calibration".

Both words in the same

topic, close together.

response

NEAR

calibration

The word "response" within eight words of the word

"callibration".

Help Languages

This help file is offered in English ONLY.

Glossary

The Glossary holds definitions of words, in alphabetical order.

 

Documentation Warranty

THE MATERIAL CONTAINED IN THIS DOCUMENT IS PROVIDED "AS IS," AND IS SUBJECT TO BEING
CHANGED, WITHOUT NOTICE, IN FUTURE EDITIONS.  FURTHER, TO THE MAXIMUM EXTENT PERMITTED
BY APPLICABLE LAW, KEYSIGHT DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED WITH
REGARD TO THIS MANUAL AND ANY INFORMATION CONTAINED HEREIN, INCLUDING BUT NOT LIMITED
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TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
 KEYSIGHT SHALL NOT BE LIABLE FOR ERRORS OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN
CONNECTION WITH THE FURNISHING, USE, OR PERFORMANCE OF THIS DOCUMENT OR ANY
INFORMATION CONTAINED HEREIN.  SHOULD KEYSIGHT AND THE USER HAVE A SEPARATE WRITTEN
AGREEMENT WITH WARRANTY TERMS COVERING THE MATERIAL IN THIS DOCUMENT THAT CONFLICT
WITH THESE TERMS, THE WARRANTY TERMS IN THE SEPARATE AGREEMENT WILL CONTROL.
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Help - About Network Analyzer

Click System > Help > About NA... to learn the capabilities of your analyzer.

Model number (see list of PXI models)

Frequency range

Serial number

Options (Learn how to install software options)

Application Code (firmware) Version

Computer Name - Full computer name of the Embedded Controller when used.
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Preset the Analyzer

When you Preset the analyzer, it is set to known, or preset conditions. You can use the factory default

preset conditions, or define your own User Preset conditions.

Preset (Default) Conditions

User Preset Conditions

See other 'Setup Measurements' topics

Preset Default Conditions

How to Preset the Analyzer

Using Hardkey/SoftTab/Softkey

Press Preset > Main > Preset.1.

When Confirm Preset is Off,

Press Preset.1.

User Preset Conditions

The analyzer can be preset to either factory default conditions or User Preset conditions.

How to set User Preset

Using Hardkey/SoftTab/Softkey

Press Preset > Main > User Preset.1.
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User Preset dialog box help

With a User Preset saved and enabled, when the VNA is Preset, the User Preset settings are recalled

instead of the factory default settings. Calibration data is NOT recalled with a User Preset. Learn
more about instrument state settings.

User Preset Enable

Check - The VNA is preset to User Preset conditions when the Preset button is pressed.

Clear - The VNA is preset to Default conditions when the Preset button is pressed.

Save current state as User Preset  Click to store the current instrument state as the User Preset

conditions. File is stored as c:\users\public\documents\network analyzer\UserPreset.sta.

Load existing file as User Preset  Click to retrieve an instrument state to be used as the User Preset

conditions.
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Measurement Classes

Measurement Classes are categories of measurements that can coexist on a channel.

 

What are Measurement Classes

How to assign a Measurement Class to a Channel

Measurement Class Dialog Box Help

Note: The M9370/71A/72A/73A/74A/75A does not support this function.

See other 'Setup Measurements' topics

What are Measurement Classes

The dialog below shows the Measurement Classes currently available for the VNA. Within each of

these classes there are a number of measurements.

Measurement Classes are categories of measurements that can coexist on a channel. A measurement

from one class can NOT reside in a channel with a measurement from another class. For example, a

Noise Figure measurement can NOT reside in a channel that is currently hosting Scalar Mixer

Measurements.

The Measurement Class dialog is accessed in the following ways:

How to assign a Measurement Class to a Channel

Using Hardkey/SoftTab/Softkey Using a mouse

Press Meas > S-Param > Meas Class...1. Click Instrument.1.

Select Meas Class....2.

 

Measurement Class dialog box help
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Measurement class dialog box shows the supported classes for your unit. The supported classes

depends on the product and installed options. The above dialog box shows an example of PNA.

Measurements in a measurement class can NOT coexist in a channel with a measurement of a

different measurement class.

Select a measurement class for the active channel or new measurement channel.

The Standard measurement class contains S-Parameters. Balanced parameters, and Receiver
measurements.

All other measurement classes are commonly called "Applications".

Title Bar Indicates the active channel to which the measurement class will be assigned.

Show setup dialog

Check to launch the selected Measurement Class dialog.

Clear (default setting) to not launch the selected Measurement Class dialog. This setting survives a
Preset and VNA Shutdown.

Confirm changes

Check (default setting) to launch the Confirm Measurement Class Change dialog.

Clear to perform the 'OK' actions without confirmation. This setting survives a Preset and VNA Shutdown.

New Channel Click to create the measurement class in a new channel and new window. A default

measurement for that class is created in the channel.

To change the measurement, click Trace, then select a new measurement.
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Choose to do the following:

OK -  Delete the existing measurements in the active channel. Create the new measurement class, and
default measurement, in that channel.

Cancel -  Do not create the new measurement class. Leave the old measurements (and class) in that
channel and return to the Measurement Class dialog box.
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Measurement Parameters

This topic contains the following information:

S-Parameters (pre-selected ratios)

Ratioed (choose your own ratio)

Unratioed Power (absolute power)

How to Select a Measurement Parameter

Learn about Balanced Measurements

See other 'Setup Measurements' topics

S-Parameters

S-parameters (scattering parameters) are used to describe the way a device modifies a signal. For a 2-

port device, there are four S-Parameters.  The syntax for each parameter is described by the

following:

S out - in

out = analyzer port number where the device signal output is measured (receiver)

in = analyzer port number where the signal is applied (incident) to the device (source)

 

Move the mouse over each S-parameter to see the signal flow:
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For two-port devices:

When the source goes into port 1, the measurement is said to be in the forward direction.

When the source goes into port 2, the measurement is said to be in the reverse direction.

The analyzer automatically switches the source and receiver to make a forward or reverse

measurement. Therefore, the analyzer can measure all four S-parameters for a two-port device with a

single connection.

See the block diagram (including receivers) of your VNA.

Common Measurements with S-Parameters

Reflection Measurements

(S11 and S22)

Transmission Measurements

(S21 and S12)

Return loss

Standing wave ratio (SWR)

Reflection coefficient

Impedance

S11, S22

Insertion loss

Transmission coefficient

Gain/Loss

Group delay

Deviation from linear phase

Electrical delay

S21, S12

Receiver Measurements

All analyzer models have test port receivers and reference receivers.

For 4-port models...

R1, R2, R3, and R4 are reference receivers. They measure the signal as it leaves the analyzer source.

R1 measures the signal out of Port 1

...

R4 measures the signal out of Port 4
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A, B, C, and D are test port receivers. They measure the signal out (or reflecting off ) of the DUT.

A measures the signal into VNA Port 1

B measures the signal into VNA Port 2

C measures the signal into VNA Port 3

D measures the signal into VNA Port 4

Models with more than 4 ports must specify receivers using Logical Receiver Notation. Learn more.

Ratioed Measurements

Ratioed measurements allow you to choose your own ratio of any two receivers that are available in

your analyzer. S-parameters are actually predefined ratio measurements. For example S11 is A/R1.

The following are common uses of ratioed measurements:

Comparing the phase between two paths of a device. An example could be something simple like a power
splitter or more complicated like a dual-channel receiver.

Measurements that require a higher dynamic range than the analyzer provides with S-parameters.

Unratioed (Absolute Power) Measurements

The unratioed power parameter measures the absolute power going into any of the receivers that are

available on your analyzer.

The reference receivers are internally configured to measure the source power for a specific analyzer

port.

Measuring phase using a single receiver yields meaningless data. Phase measurements must be a
comparison of two signals.

Averaging for Unratioed parameters is computed differently from ratioed parameters. Learn more.

To calibrate ratioed or unratioed receiver (power) parameters, the recommended method is the Guided
Power Calibration. The Unguided Response Calibration can also be used to calibrate a single unratioed or
ratioed parameter at a time.

New / Change Measurement dialog box help
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Note: The only measurements that are available are those in the measurement class currently

assigned to the active channel. Other measurements are NOT compatible.

To create a measurement other than these, first assign the appropriate measurement class to a

new or existing channel. Learn how.

 

Click a tab to create or change measurements.

When creating NEW measurements, you can choose more than one.

When changing an EXISTING measurement, you can choose ONLY one.

Tabs

S-Parameter  Select a predefined ratioed measurements. Learn more about S-parameters.

Balanced  Select a balanced measurement type.

Change  Click to invoke the Balanced DUT Topology / Logical Port mappings dialog box. Learn more
about Balanced Measurements.
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Receivers  Select receivers to make Ratioed and Unratioed (absolute power) measurements. Learn
more about receiver measurements.

Ratioed  Check Activate to create or change a measurement. Select a receiver for the Numerator,

select another receiver for the Denominator, then select a source port for the measurement.

The Source port is ALWAYS interpreted as a logical port number.

For convenience, the table is populated with common choices.

Learn more about Ratioed Measurements.

Unratioed  Same as Ratioed, but select 1 as the Denominator.

Learn More about Unratioed Measurements.
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Receiver Notation

Receivers can be also selected using logical receiver notation. This "8510-style" notation

makes it easy to refer to multi-port receivers.

aN - Reference receiver for logical port N

bN - Test port receiver for logical port N

For example:

For Ratioed measurements: "b12/a1" refers to the logical test port 12 receiver / the logical port 1
reference receiver.

For Unratioed measurements: "b10" refers to the logical test port 10 receiver.

The VNA-style notation (A, B, R1 and so forth) can still be used to refer to physical receivers

in less than 4 ports. Learn more.

However, ratioed measurements MUST use the same notation to refer to both receivers; either

the physical receiver notation (A, R1) or the logical receiver notation (aN, bN). For example,

the following mixed notation is NOT allowed: A/b3 and a5/R2.

Programming

When entering receiver letters using programming commands, neither logical or physical

receiver notation are case sensitive.

Channel / Window Selections

These selections are NOT AVAILABLE when changing an EXISTING measurement. Learn how to
change a measurement.

Channel Number  Select the channel for the new traces.

Create in New Window

Check to create new traces in a new window.
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Clear to create new traces in the active window. When the traces per window limitation has

been reached, no more traces are added.

About Measurement Parameters (top of page)

 

Balanced Source / Topology dialog box help

 

Create or edit DUT Topology and Logical Port Mapping.

A Logical Port is a term used to describe a physical analyzer test port that has been remapped to a

new port number. You can assign logical single-ended ports to logical balanced ports.

Note: These selections apply to ALL measurements in the channel. If the device topology is

changed, any existing measurements in the channel that are incompatible with the new topology

will be automatically changed to one that is compatible.

Topology:  Describes your DUT as you would like it tested. The following device topologies can be

measured by a multiport analyzer.

Balanced / Balanced
(2 logical ports - <4 actual ports>)

Single-ended / Balanced
(2 logical ports - <3 actual ports>)

Single-ended - Single-ended / Balanced
(3 logical ports - <4 actual ports>)

These topologies can be used in the reverse (<==) direction to measure:

Balanced / Single-ended topology
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Balanced / Single-ended - Single-ended topology

For example, to measure a Balanced / Single-ended topology, measure the S12 (reverse direction)

of a Single-ended / Balanced topology.

See Also

Learn more about Balanced Measurements

Balanced parameters can be saved to SNP files. Learn more.
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Frequency Range

Frequency range is the span of frequencies you specify for making a device measurement.

How to Set Frequency Range

Zoom

CW Frequencies

Frequency Resolution

See other 'Setup Measurements' topics

How to set Frequency Range

You can also make these settings and more from the Sweep Type dialog.

See the frequency ranges of all analyzer models.

Using Hardkey/SoftTab/Softkey Using a mouse

Press Freq> Main > Start, Stop, Center,
or Span.

1.

Enter desired frequency value.2.

Right click on the X-axis label or stimulus range area
under grid line.

1.

Click on Start/Stop/Center....2.

Frequency Start/Stop - Center/Span - Step

dialog box help

Either of the following pairs of settings determine the frequency range. The last value that you enter

determines the X-Axis labels. For example, if you enter the Start and Span values, the X-Axis will

show Center and Span labels.

Start /Stop - Specifies the beginning and end frequency of the swept measurement range.
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Center /Span - Specifies the value at the center and frequency range.

Either of the following settings determine the number of evenly-spaced data points across the

frequency range.

Points - Specifies the number of evenly-spaced data points across the frequency range. Learn more
about Data Points.

Step - Available ONLY in Linear sweep type. Specifies the frequency step size between evenly-

spaced data points. Changes to this setting will cause the Points setting to adjust to the closest

integer. Any 'remainder' will adjust either the Stop value or Span value depending on which is

displayed on the X-Axis label.

Zoom

Zoom allows you to easily change the start and stop frequencies or start and stop power levels in a

power sweep.

Zoom operates on the Active Trace and all traces in the same channel as the active trace, regardless of

the window in which they appear.

How to Zoom in a measurement window

Left-click the mouse or use a finger, then drag across a portion of a trace.1.

Release the mouse or lift the finger and the following menu appears:2.

Select from the following:3.

Zoom - changes the channel stimulus settings to the left and right border values of the Zoom

selection

Zoom xy - changes the channel stimulus settings as above. In addition, the Y-axis scale of

the active trace changes to the approximate scale of the Zoom selection.

Zoom Full Out - changes the channel stimulus settings to the full span of the current

calibration. If no calibration is ON, then the stimulus settings are changed to the full span of

the VNA model.

Notes

The stimulus settings are changed for ALL traces in the active channel, regardless of the window in
which they appear.

If markers are in the selected area, they remain in place.
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If markers are in the unselected area, they are moved to the right or left edge of the new span. When
Zoom Full Out is selected, the markers are moved back to their original location.

Zoom is NOT available for the following:

Smith Chart or Polar display formats

CW Time and Segment sweep type

CW Frequencies

Measurements with a CW Time sweep or Power sweep are made at a single frequency rather than over a

range of frequencies.

How to set CW Frequency

Using Hardkey/SoftTab/Softkey Using a mouse

Set Sweep Type to CW Time or Power
Sweep.

1.

Press Freq > Main > CW.2.
Enter desired CW frequency.3.

Set Sweep Type to CW Time or Power Sweep.1.

Right click on the stimulus range area under grid
box.

2.

Click on CW....3.

 

CW Frequency dialog box help

CW  Type a value and the first letter of the suffix (k,m,or g) or use the up and down arrows to

select any value within the range of the VNA.

Frequency Resolution

The resolution for setting frequency is 1 Hz.
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Power Level

Power level is the power of the source at the test ports.

How to make Power Settings

Power Dialog

Power and Attenuator Dialog

Power ON and OFF during Save / Recall and Preset

Power ON and OFF during Sweep and Retrace

See other 'Setup Measurements' topics

Power Settings

The test port output power is specified over frequency.

See the Power Range specifications for your analyzer.

How to make Power settings

Use one of the following methods to set port power.

Using Hardkey/SoftTab/Softkey Using a mouse

Press Power > Main > Power Level / Start Power / Stop Power to
enter desired power level.

1.

Press Power > Main > RF Power to turn ON or OFF the RF power.2.

Press Power > Leveling & Offsets > click left side Slope small
button to turn ON or OFF the slope (Green color means the slope is
turned ON; Grey color means the slope is turned OFF).

3.

Right click on the X-axis
label or stimulus range
area under grid line.

1.

Click Power.... and then
Power: Channel N
dialog box appears.

2.

 

Power dialog box help
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This dialog provides basic control of source power for a specific port.

See Power and Attenuators dialog box.

Power On (All Channels)  Check to enable source power for all channels. Only turns power ON if

channel power setting is ON or Auto.

Port 'n'  Active source port for which power is being set.

Port Power  Sets the power level for the specified port.

Power Sweep

Start / Stop Power  Set the start and stop power values of a power sweep.

These settings are only available when Sweep Type is set to Power Sweep.

Uncoupled power sweep power can be set from the Advanced Power dialog.

You can Zoom to easily change the start and stop power levels in a power sweep. Learn how.

Learn more about Power Sweep.

Power Slope

Helps compensate for cable and test fixture power losses at increased frequency.

Slope  Select to set the power slope. Clear to set power slope OFF. Learn more about power slope.
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How to make Power settings

Use one of the following methods to set port power.

Using Hardkey/SoftTab/Softkey

Press Power > Main > Power and Attenuators and then the Power and Attenuators dialog box
appears.

1.

Detailed settings for Power and Attenuators:

Press Power > Main > RF Power to turn ON or OFF the RF power.1.

Press Power > Port Power > Select Port x to active the selected port.2.

Press Power > Port Power > Power Level / Start Power / Stop Power to enter desired power level for
selected port.

3.

Press Power > Port Power > Source State to choose the source state either Auto, On or Off.4.

Press Power > Port Power > Coupling to turn ON or OFF Power Coupling.5.

Press Power > Leveling & Offsets > click left side Slope small button to turn ON or OFF the slope
(Green color means the slope is turned ON; Grey color means the slope is turned OFF).

6.

Power and Attenuators dialog box help

Defines and controls the source power and attenuation for the active channel.

External sources can be controlled from this dialog. Learn more.

Power On (All Channels)  Check to enable source power for all channels (same function as RF

Power). Only turns power ON if channel power setting is ON or Auto.

Port Powers Coupled

Coupled (checked)  The power levels are the same at each test port. Set power at any test

port and all test ports change to the same power level.

Uncoupled (cleared)  The power levels are set independently for each test port. Uncouple

power, for example, if you want to measure the gain and reverse-isolation of a high-gain

amplifier. The power required for the input port of the amplifier is much lower than the

power required for the output port. A power sweep can also be performed with uncoupled

power.
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Name  Lists the analyzer test ports.

State

Auto  Source power is turned ON at the specified test port when required by the measurement. This is
the most common (default) setting. See also Power ON and OFF during Save / Recall, User Preset, and
Preset.

ON  Source power is ALWAYS ON, regardless of measurements that are in process. Use this setting to
supply source power to a DUT port that always requires power, such as an LO port. This could turn OFF
power at another test port.

OFF  Source power is never ON, regardless of the measurement requirements. Use this setting to
prevent damage to a sensitive DUT test port.

Port Power  Sets the power level at the output of the source.

To accurately set the power level at any point after the test port, perform a Source Power Calibration.

See specified power range of VNA model.

See ECal Module Compression Level

Start / Stop Power  Available ONLY when sweep type is set to Power Sweep. Set the start and

stop power values of a power sweep. Learn how to set Power Sweep.

You can specify whether to maintain source power at either the start power or stop power

level at the end of a power sweep. Learn more.

A power sweep can be performed with uncoupled power. Different power ranges can be swept

in the forward and reverse directions.

Leveling Mode (ALC Hardware Softkey)- Refer to the following diagram:

Internal - ALC leveling. Power level within an attenuator setting is limited to the ALC

Range. See Source Unleveled.

Open Loop - No ALC and NO Receiver Leveling. (Used during pulse conditions with the

internal source modulators). NOT available on N523x models. No leveling is used in setting
the source power. The lowest settable power, without attenuation, is limited to -30dBm. The

source power level accuracy is very compromised. Use a source power calibration to make
the source power somewhat more accurate.
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Internal - (M937xA) Source correction factors are used to provide a flat output power

within specifications.  NO internal circuitry is used to level the output power. Therefore, the

source will NEVER become unleveled. (M9485A) ALC leveling

Open Loop - (M9485A) No ALC. The source power level accuracy is very compromised.

Receiver Rx - Receiver Leveling. Select a receiver to use for leveling the source. Learn more.
(Not supported for M9485A)

Channel Power Slope

Helps compensate for cable and test fixture power losses at increased frequency. With power

slope enabled, the port output power increases (enter positive value) or decreases (enter negative

value) as the sweep frequency increases.

Slope  Select to set the power slope. Clear to set power slope OFF.  

Power slope is computed and applied from 0 GHz – not from the measurement start frequency.

For example, with the following measurement settings:

Start / Stop Freq: 10 GHz to 20 GHz

Power level: 0 dBm

Slope: 1 dB/GHz

The power into the DUT from 10 GHz to 20 GHz is 10 dBm sloping to 20 dBm

Offset and Limits  Launches the Power Offset and Limits dialog.

Receiver Leveling  Launches the Receiver Leveling dialog.

Receiver Attenuator  Launches the Receiver Attenuator dialog.

Source Unleveled

When the power level that is required at a test port is higher than can be supplied, a Source Unleveled

error message appears on the screen and the letters LVL appear on the status bar.

To resolve an unleveled condition, change either the Test Port Power or Attenuator setting.

Important Note: The available power range can also be adjusted AUTOMATICALLY by a Source

Power Calibration, Guided Power Cal, or Power Compensation. If you are NOT seeing the range that

you expect, or the correct power level at your DUT, view the Power Offset column in the Power Limits
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and Offsets dialog.

 

Receiver Attenuators dialog box help

Receiver Attenuation is used to protect the VNA test port receivers from damage or compression.

 

M9485A

Attenuator level can be set either 0 dB or 35 dB for each receiver attenuator per channel. This

setting is valid when segment sweep mode is not selected. When the segment sweep mode is

selected, the setting in the segment is applied. Test attenuator and reference attenuator can be set

independently.

CAUTION! You can damage the analyzer receivers if the power levels exceed the maximum

values.

See Technical Specifications for the maximum input power to a receiver and receiver compression.

See Receiver attenuation values for your VNA model.

Power ON and OFF during Save / Recall, User Preset, and Preset

To protect your DUT from being inadvertently powered ON, the following RF Power ON/OFF settings

occur:

Instrument State Save/Recall

If power is OFF when an instrument state is saved, then power will always be OFF after the instrument
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state is recalled.

If power is ON when an instrument state is saved, and the current power setting is OFF, then power

will be OFF after the instrument state is recalled.

Preset

Instrument Preset sets power ON by default.

This can be changed with a Preference setting so that, if the current power setting is OFF, then power

will be OFF after Preset.

Power ON and OFF during Sweep and Retrace

Source power is NOT turned OFF during M937xA frequency band crossings or during sweep retrace.

Caution: Avoid expensive repairs to your analyzer. Read Electrostatic Discharge Protection.
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Receiver Leveling

Note: The M937xA does not support this function.

Receiver Leveling adjusts the source power until the measured receiver power is equal to the Port

Power.

In this topic:

Overview

Receiver Leveling Process

Features and Limitations

How to make Receiver Leveling settings

Receiver Leveling dialog box help

Initial Power Selection

See other 'Setup Measurements' topics

Overview

Receiver Leveling uses receiver measurements to adjust the source power level across a frequency or

power sweep. Before each measurement sweep, a variable number of background sweeps are

performed to repeatedly measure power at the receiver for each stimulus point.  Those power

measurements are then used to adjust the source power level and achieve greater source power level

accuracy.

This is similar to a Source Power Calibration which makes a single sweep to measure source power. The
source power correction values are applied for all subsequent measurement sweeps. Because Receiver

Leveling is performed for every measurement sweep, it provides more accurate source power levels,
but also takes longer to perform each measurement sweep.

Receiver Leveling Process

Leveling sweeps are performed in the background (not visible) before every measurement sweep to

measure and apply source correction data.

For each leveling sweep, source power is applied at each data point and measured by the specified receiver.1.

2.
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Learn how the initial power level is selected.
1.

The deviation is calculated between the measured power and the port power.2.

The deviation is applied to the current source power, and the updated source power levels are applied on the
following leveling sweep.

3.

This process continues until the receiver power at each data point has achieved the port power within the
specified tolerance value, or until the specified number of leveling sweeps (iterations) has been reached.

4.

Features and Limitations

Receiver Leveling can be used with most sweep types, including Segment sweep and Power sweep.

Receiver Leveling is ALWAYS enabled for the controlled source when Phase Control (Opt S93088A) is
enabled.

Receiver Leveling is available for standard S-parameter measurements and with FCA, GCA, and IMD
applications.

Turn ON Receiver Leveling before or after doing a Calibration. When turned ON before calibrating, it is
turned OFF during the calibration, then back ON after calibration.

Power Offset on the Offsets and Limits dialog can be used when there exists an additional attenuator or
booster amplifier in the source path. An offset should be set to improve the leveling speed. This power offset
is automatically used to set the port power.

Use Receiver Leveling for the following:

Correcting for short term drift when using an external component, such as a booster amplifier. The booster
amplifier must be connected to the front-panel jumpers, in front of the reference receiver. See the Block
diagram for your VNA, located at the end of every Specifications document.

Extending the accuracy of power leveling at very low powers where the internal detector may be too noisy.

Providing controlled power during Pulsed measurements in an open loop mode.

Controlling the power at the outputs of MM-Wave heads.
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How to make Receiver Leveling settings

Start the Power and Attenuators dialog box as follows:

Using Hardkey/SoftTab/Softkey Using a mouse

Press Power > Main > Power and
Attenuators....

1.

On the Power and Attenuators dialog, click
Receiver Leveling button.

2.

Click Stimulus, Power, then Power and
Attenuators.

1.

On the Power and Attenuators dialog, click
Receiver Leveling button.

2.

 

Receiver Leveling dialog box help
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Learn about Receiver Leveling (scroll up).

Define Controlled Source (Port)

Each source port to be leveled is configured individually. Select a source to be configured for
receiver leveling. Choose from: Port 1, Port 2, Port 3, Port 4, or any active external source. Learn
more about External Devices.

Leveling Receiver Setup

Receiver Type  Receiver type does an initial sort to make it easier to select a receiver. Choose

from: VNA Receiver or Ext. Device (PMAR).

Receiver  Select a receiver to be used to level the specified source.

For VNA Receiver type, choose from any VNA receiver using standard or receiver notation.
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To level power at the source output or DUT input choose the reference receiver for the source

port. For example, to level the source power at port 1, then choose "R1". To level power at the

DUT output, choose the receiver that is used to measure the DUT output. If the DUT output is

connected to port 2, then select "B" or 'b2". Learn about Receiver Notation.

When Phase Control is enabled, the ratioed receivers used in Phase Control are selected and can

NOT be changed. However, the Reference Source CAN also be selected for Receiver Leveling.

For Ext Device type, choose a configured PMAR device.

Level when this RF source is turned ON: The Controlled Source is selected automatically and

can NOT be changed.

Receiver frequency is determined by:  Available ONLY when the selected receiver is a VNA

Receiver or power meter. This setting determines which receiver frequencies are measured.

Choose from:

Auto - always uses the frequency range that is assigned to the measurement receiver.

FOM Receiver - FOM Receiver frequency range. Learn more about Frequency Offset Mode.

FOM Source - FOM Source frequency range.

DUT Input - Mixer/Converter input frequency range.

DUT Output - Mixer/Converter output frequency range.

Leveling Loop Tolerance  The source is considered leveled when each stimulus data point has

achieved the power level +/- (plus or minus) this tolerance value.

Leveling Loop Max Iterations  If every stimulus data point does NOT achieve the port power

after this number of leveling sweeps, the measurement sweep occurs using the correction values
obtained from the last leveling sweep. The message: Not settled, noisy trace appears when the

Max Iterations is reached. If you see this message, you can increase the Max Iterations, reduce the
IFBW, or increase the Tolerance setting.

Note: If the Max Iterations is set to zero, there will be no pre-sweep for the receiver leveling,

but the value of the receiver data will be used to correct the next sweep. In this way setting

the value to zero provides a post sweep correction and can be useful for correcting slow drift

in a system where a booster amplifier or open loop ALC is used, without adding pre-sweeps

to the sweep-acquisitions.

Leveling IFBW  Available only for VNA receivers. By default, the IFBW for the leveling sweeps

is set to 100 kHz. Learn more about IFBW.
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Increase this value to make faster, but noisier leveling sweeps.

Decrease this value to maker slower, more repeatable leveling sweeps.

Uncheck the box to use the same IFBW as the measurement sweeps.

Controlled Source Setup

Update source power calibration with leveling data  Available only when using an RF Source

and VNA receiver.

When checked, the latest correction data is copied to the Source Power Cal correction array.

When Leveling Mode is switched back to Internal (on the Power and Attenuators dialog),

Source Power Cal is automatically turned ON using this correction data.

When cleared, Source Power Cal is NOT turned ON when Leveling Mode is switched back

to Internal.

Enable Source ALC hardware circuit  NOT available with External sources.

Checked - Internal ALC leveling and Receiver Leveling (Recommended).

Cleared - NO ALC leveling; Receiver Leveling ONLY. NOT available on N523x models.

Enable Safe Mode while leveling

To protect your DUT, these settings control the extent to which the source power will be changed

to achieve the port power as measured at the reference receiver. These settings could be necessary

when using external components with a large variation in frequency response (flatness).

When checked:

The Min source output is used as the initial power level for the leveling loop process.

The controlled source is never stepped more than the Max source step size.
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When cleared:

The initial power for the leveling loop may be determined by the Min source output, the

Max source output, the last setting of the leveling loop, or the target value of the leveling

loop.  See Initial Power below.

The Max source step size is ignored.

Max source step size  When Safe Mode is enabled, the change in source power at each data point

from one sweep to the next is limited to this value. For example, assume Safe Mode is enabled,

and Max Power Step is set to 1 dB.  On the first leveling sweep, the first data point measures 3 dB

lower than the port power, then source power for data point 1 will be increased by 1 dB for the

next sweep, and likely for the following two sweeps.

Max port output  Always limits the maximum power out of the source to this value. The

message: Power set to Max Power appears when this limit is reached.

If the maximum port power out of the VNA is reached at any time during the leveling sweeps, the

following message appears: Power set to user power limit.

Min port output  Always limits the minimum power out of the source to this value. The

message: Power set to Min Power appears when this limit is reached. When Safe Mode is

enabled, this value is used as the initial power level for the leveling loop process

Initial Power Selection

For each displayed data point, the leveling algorithm must select an initial power to begin the

iteration process.  This value is chosen as follows:

Where:

PInit = the initial power for the iteration process.
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PFinal = the final power setting from the previous leveled sweep.

PMin = the minimum controlled source output level as specified in the Receiver leveling setup.

PMax = the maximum controlled source output level as specified in the Receiver leveling setup.

PTarget = the target power level for the selected leveling receiver.
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Sweep Settings

A sweep is a series of consecutive data point measurements taken over a specified sequence of stimulus

values. You can make the following sweep settings:

Number of Points (Separate topic)

Sweep Type

Linear / Log

Power Sweep

CW Time

Segment Sweep

Frequency Range: Start/Stop (Separate topic)

Power Sweep

Segment Sweep

How to make segment sweep settings

Segment Table dialog

X-Axis Point Spacing - Segment Sweep ONLY

Arbitrary Segment Sweep

Sweep Time

Sweep Setup

Auto vs Stepped

Fast Sweep

Dwell and Delay

Standard vs Point Sweep

See Triggering and other 'Setup Measurements' topics
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How to set Sweep Type

Using Hardkey/SoftTab/Softkey Using a mouse

Press Sweep > Main > Sweep Type.1. Right click on the stimulus range area under grid box.1.

Click Sweep Setup....2.

Select Sweep Type tab and select type.3.

Click Apply to implement the setting changes.4.

 

Sweep Type dialog box help

Note: Sweep Settings are not applied until either OK or Apply is pressed.

Channel  The active channel when Sweep Type was selected. Sweep settings will be applied to this
channel.

Sweep Type

Linear Frequency  Sets a linear frequency sweep that is displayed on a standard grid with ten equal

horizontal divisions.

Start  Sets the beginning value of the frequency sweep.
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Stop  Sets the end value of the frequency sweep.

Points  Sets the number of data points that the analyzer measures during a sweep. Range: 2 to
20001.(Default is 201).

Power - Sets the power level or the source. Learn more.

IF Bandwidth - Sets the IF (Receiver) bandwidth. Learn more.

Log Frequency  The source is stepped in logarithmic increments and the data is displayed on a

logarithmic x-axis. This is usually slower than a continuous sweep with the same number of points.

Start  Sets the beginning value of the frequency sweep.

Stop  Sets the end value of the frequency sweep.

Points  Sets the number of data points that the analyzer measures during a sweep. Range: 2 to 20001.
(Default is 201).

Power - Sets the power level or the source. Learn more.

IF Bandwidth - Sets the IF (Receiver) bandwidth. Learn more.

Power Sweep  Activates a power sweep at a single frequency that you specify.  Learn about power
sweep

Start  Sets the beginning value of the power sweep.

Stop  Sets the end value of the power sweep.

CW Frequency  Sets the single frequency where the analyzer remains during the measurement sweep.

Points  Sets the number of data points that the analyzer measures during a sweep. Range: 2 to 20001.
(Default is 201).

IF Bandwidth - Sets the IF (Receiver) bandwidth. Learn more.

CW Time  Sets the analyzer to a single frequency, and the data is displayed versus time. Learn more.

CW Frequency   Sets the frequency where the analyzer remains during the measurement.

Sweep Time  Sets the duration of the measurement, which is displayed on the X-axis.

Points  Sets the number of data points that the analyzer measures during a sweep. Range: 2 to
20001.(Default is 201).

IF Bandwidth - Sets the IF (Receiver) bandwidth. Learn more.
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Segment Sweep  Sets the analyzer to sweep through user-defined sweep segments.  Learn how to
make these settings.

 

OK  Applies setting changes and closes the dialog box.

Apply  Applies setting changes and leaves the dialog box open to make more setting changes.

Cancel  Closes the dialog. Setting changes that have been made since the last Apply button click

are NOT applied.

Help - Display the Sweep Type dialog box help.

 

Power Sweep

A power sweep either increases or decreases source power in discrete steps. Power sweep is used to

characterize power-sensitive circuits, with measurements such as gain compression.

In the Sweep Type dialog, specify Start power, Stop power, and CW Frequency. Power can be swept

over any attainable range within the analyzer ALC range.

The remaining power settings apply in power sweep mode:

Test Port Power setting is not available.

Port Power can be coupled or uncoupled.

Attenuator Control is always Manual.

Power Slope (dB/GHz) is ignored (output frequency is CW).

Press Sweep > Main > Number of Points to change the step size of the power sweep.

Notes:

Using a preference setting, you can specify whether to maintain source power at either the start power or
stop power level at the end of a power sweep.

Power Sweep is optimized for speed. For highest measurement accuracy during a power sweep, it may be
necessary to increase the Dwell Time to allow the source more time to settle.
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Segment Sweep

Segment Sweep activates a sweep which consists of frequency sub-sweeps, called segments. For each

segment you can define independent power levels, IF bandwidth, and sweep time.

Once a measurement calibration is performed on the entire sweep or across all segments, you can make

calibrated measurements for one or more segments.

In segment sweep type, the analyzer does the following:

Sorts all the defined segments in order of increasing frequency

Measures each point

Displays a single trace that is a composite of all data taken

Restrictions for segment sweep:

The frequency range of a segment is not allowed to overlap the frequency range of any other segment.

The number of segments is limited only by the combined number of data points for all segments in a sweep.

The combined number of data points for all segments in a sweep cannot exceed the max number of data
points per trace.

How to make segment sweep settings

Using Hardkey/SoftTab/Softkey Using a mouse

Press Sweep > Segment Table >
Segment Table...

1. Right click on the X-axis label or stimulus display
area under grid line.

1.

Click Sweep Setup... then select Segment Sweep
under sweep type.

2.

Click Segment Table....3.

Segment Table dialog box help

Segment Table Softkeys

Add Segment - adds a sweep segment at last segment.

Insert Segment - adds a sweep segment before the selected segment. You can also click the "down"

arrow on your keyboard to quickly add many segments.

115



Delete Segment - removes the selected segment.

Delete All Segments - removes all segments.

Note: At least ONE segment must be ON or Sweep Type is automatically set to Linear.

 

Segment Table dialog box

X-Axis Point Spacing - Check to scale the X-axis to include only the segments. Learn more.

Allow Arbitrary Segments - Check to allow arbitrary frequencies (overlapped or reverse sweep).

Learn more.

Display Center/Span Freq - Check to display the center/span frequency.

 

Independent Setting Per Segment

Power Level - Sets the Power level for the segment. Also, the test port power can UNCOUPLE. See

Power Coupling.

IF Bandwidth - Sets the IF Bandwidth for the segment.

IF Bandwidth Per Port - Sets the different bandwidth with different port for the segment.

Sweep Time - Sets the Sweep time for the segment.

Dwell Time - Specifies the time the source stays at each measurement point before the analyzer

takes the data.

Delay- Sets the time to wait just before acquisition begins for each segment.

Sweep Mode - Sets the sweep mode to auto or stepped.

Shift LO- Sets the state of Shift LO.

 

Save Table - Saves the setting changes in segment table.

Load Table - Apply the setting changes in segment table.

 

To Modify an Existing Segment
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To make the following menu settings available, the segment table must be displayed first. (Press

Sweep > Segment Table).

State - Click the box on the segment to be modified. Then, use the up/down arrow to turn the

segment ON or OFF.

Start - Sets start frequency for the segment. Click the box and type a value and the first letter of a

suffix (KHz, Mhz, GHz). Or double-click the box to select a value.

Stop - Sets stop frequency for the segment. Click the box and type a value and the first letter of a

suffix (KHz, Mhz, GHz). Or double-click the box to select a value.

Note: The segment table truncates the frequency resolution. To verify the frequency resolution that

you input, create a marker at the start or stop frequency settings.

Points - Sets number of data points for this segment. Insert a value or double-click the box to select

a value.

To set Power Level, IF Bandwidth/IF Bandwidth Per Port, Sweep Time, Delay, Receiver

Attenuator Per Port, Sweep Mode and Shift LO independently for each segment:

Press Sweep > Main > Sweep Type > Segment Sweep.1.

Click on Segment Table > Segment Table....2.

Check the box corresponding to the segment setting to set then click OK.3.

Click in the box at the bottom of the display and use the up/down arrows to enter a value or double-click
the box and select a value with the numeric keypad.

4.

Note: If the following are NOT set, the entire sweep uses the channel IFBW, Power, and Time

settings.

X-Axis Point Spacing  - Segment Sweep ONLY

This feature affects how a segment trace is drawn on the screen.
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How to select X-Axis Point Spacing

Using Hardkey/SoftTab/Softkey Using a mouse

Press Sweep > Segment Table. >
Segment Table....

1.

Check X-Axis Point Spacing.2.

Right click on the X-axis label or stimulus display
area under grid line.

1.

Click Sweep Setup... then select Segment
Sweep under sweep type.

2.

Click Segment Table....3.

Check X-Axis Point Spacing.4.

Without X-axis point spacing, a multi-segment sweep trace can sometimes result in squeezing many
measurement points into a narrow portion of the x-axis.
With X-axis point spacing, the x-axis position of each point is chosen so that all measurement points are
evenly spaced along the x-axis.

For example, given the following two segments:

Without X-Axis Point Spacing
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With X-Axis Point Spacing

Arbitrary Segment Sweep

This feature allows arbitrary frequencies to be entered into the segment sweep table. With this

capability, segments can have:

overlapping frequencies.
the stop frequency less than the start frequency (reverse sweep).

However, there are several limitation:

Sweep mode: Stepped only.

Sweep time: When reverse sweep is performed, the sweep time and the wait time before the

measurement point becomes longer.

How to enable Arbitrary Segment Sweep

Using Hardkey/SoftTab/Softkey Using a mouse

Press Sweep > Segment Table. >
Segment Table....

1.

Check Allow Arbitrary Segments.2.

Right click on the X-axis label or stimulus display
area under grid line.

1.

Click Sweep Setup... then select Segment
Sweep under sweep type.

2.

Click Segment Table....3.

Check Allow Arbitrary Segments.4.

Notes:
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Unusual results may occur when using arbitrary sweep segments with markers, display settings, limit lines,
formatting, and some calibration features.

When Allow Arbitrary Segments is checked, X-axis point spacing is automatically turned ON.

When the segment table has both forward and reverse frequency sweep, the correction interpolation may
not work properly. Use the same segment table setting for both correction and measurement. (Make a
measurement at the condition where "Cor" is displayed.)

When the measurement data size of segment table exceeds its limitation, an error occurs. In this case,
reduce the measurement data size (i.e., NOP, number of channels).

Sweep Time

The analyzer automatically maintains the fastest sweep time possible with the selected measurement

settings. However, you can increase the sweep time to perform a slower sweep.

How to set Sweep Time

Using Hardkey/SoftTab/Softkey Using a mouse

Press Sweep > Sweep Timing > Sweep
Time.

1.

Input the desired sweep time.2.

Right click on the X-axis label or stimulus range area
under grid line.

1.

Click on Sweep Setup....2.

Select Timing tab.3.

Deselect the Auto Sweep Time box.4.

Input the desired sweep time.5.

 

Time dialog box help

Sweep Time  Specifies the time the analyzer takes to acquire data for a sweep. The maximum

sweep time of the analyzer is 86400 seconds or 1 day. Learn about other settings that affect sweep
speed.

Note: Ignore CW time as labeled on the X-axis and marker readout. It is NOT at all accurate.

Sweep Setup
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How to make Sweep Setup settings

Using Hardkey/SoftTab/Softkey Using a mouse

Press Sweep > Sweep
Timing.

1. Right click on the X-axis label or stimulus range area under grid
line.

1.

Click on Sweep Setup....2.

Select Timing tab.3.

 

Sweep Setup dialog box help

Time

Sweep Time - same as Sweep Time Softtab Help.

Dwell Time - Specifies the time the source stays at each measurement point before the analyzer

takes the data. Only applies to stepped sweep. The maximum dwell time is 20 seconds. See also

Electrically Long Devices.

Sweep Delay - Specifies the time to wait just before acquisition begins for each sweep. This delay

is in addition to Dwell Time (per point) and External Trigger delay if enabled.

 

Sweep Mode

Auto -  Automatic adjusts the sweep time and dwell time. When "Auto Sweep Time" is checked,

the sweep time and dwell time will disable to edit.

Stepped  When checked (Stepped Sweep) the analyzer source is tuned, then waits the specified

Dwell time, then takes response data, then tunes the source to the next frequency point. This is
slower than Analog Sweep, but is more accurate when testing electrically-long devices.

When cleared (Analog Sweep) the analyzer takes response data AS the source is sweeping. The

sweep time is faster than Stepped, but could cause measurement errors when testing electrically-

long devices.

When the dialog check box is cleared, the analyzer could be in either Analog or Step mode. The
mode can change from sweep to sweep. There is NO way to determine whether the analyzer is in

Analog or Stepped Sweep. If you want to be sure what the current sweep mode is, then switch it to
Stepped.
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Stepped sweep is automatically selected for a number of reasons. Here are some of the reasons:

IF Bandwidth is at, or below, 5 kHz.

When step mode is a faster way to take the data.

Sweep Sequence

Note: This feature is not available on the M948xA and E5080A.

Standard Sweep  When checked, the analyzer sweeps all data points for each source port in turn.

For a 2-port analyzer, this means that all data points are swept in the forward direction, then all

data points are swept in the reverse direction.  Even when NO reverse parameters are displayed

(S22 or S12), reverse measurements are necessary when a full 2-port calibration is correcting the

channel. This is the default behavior.

Point Sweep  Available ONLY on standard S-parameter channels.  When checked, the analyzer

measures all parameters at each frequency point before stepping to the next frequency. The

display trace is updated as each data point is measured.

Point sweep usually results in slower sweeps and is useful only in rare circumstances.

Point sweep is the same as stepped sweep mode on the 8510 and 8530.  

Fast Sweep    Available ONLY with Opt. 103  When checked, in Analog Sweep mode the

analyzer source settling times are shortened in both frequency and power-control (ALC) circuits.

In Stepped Sweep mode, the settling time at ALL data points are shortened. This nearly doubles

the sweep speed at preset conditions, but at the expense of frequency accuracy and a few dB of

amplitude variation. For ratioed measurements, such as S-Parameters, these errors substantially

ratio out.

By default, Fast Sweep is always OFF to provide maximum accuracy and stability.

Fast Sweep is NOT allowed with Power Limit enabled.

Note: Performance specifications do NOT apply in Fast Sweep.
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Trigger

A trigger is a signal that causes the analyzer to make a measurement sweep. The analyzer offers great

flexibility in configuring the trigger function.

View the interactive Trigger Model animation to see how triggering works.

How to Set Trigger

Source

Scope

Channel Settings

Restart

External Triggering (separate topic)

See other 'Setup Measurements' topics

How to set Triggering

Using Hardkey/SoftTab/Softkey Using a mouse

Press Trigger > Main > Trigger....1. Right click on the Trig or Meas icons on the status bar.1.

Select Trigger....2.

Note: The Continuous, Single, and Hold settings apply ONLY to the active channel. These settings

are available from the Trigger menu, Active Entry keys, and softkeys

 

Trigger Setup dialog box help
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View the interactive Trigger Model animation to see how triggering works.

Trigger Source

These settings determine where the trigger signals originate for all existing channels. A valid

trigger signal can be generated only when the analyzer is not sweeping.

Internal  Continuous trigger signals are sent by the analyzer as soon as the previous measurement

is complete.

Manual  One trigger signal is sent when invoked by the Trigger button, the active toolbar, or a

programming command.

External (uses MEAS TRIG IN SMB)  Trigger signals sent out or received from various
connectors on the connector.

Manual Trigger! - Manually sends one trigger signal to the analyzer. Available ONLY when

Manual trigger is selected.

Trigger Scope

These settings determine what is triggered.
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Global  All channels not in Hold receive the trigger signal [Default setting]

Channel  Only the next channel that is not in Hold receives the trigger signal. This is not obvious

or useful unless Trigger Source is set to Manual. This setting enables Point Sweep mode.

Active Channel - Trigger are sent only to the active channel. The active channel does not change.

Channel Trigger State

These settings determine how many trigger signals the channel will accept.

Continuous  The channel accepts an infinite number of trigger signals.

Groups  The channel accepts only the number of trigger signals that is specified in the Number of

Groups text box, then goes into Hold.  Before selecting groups you must first increment the

Number of Groups text box to greater than one.

Number of Groups  Specify the number of triggers the channel accepts before going into Hold. If

in Point Sweep, an entire sweep is considered one group.

First increment to desired number, then select 'Groups'.

Single  The channel accepts ONE trigger signal, then goes into Hold.

Another way to trigger a single measurement is to set Trigger Source to Manual, then send a

Manual trigger. However, ALL channels are single triggered.

Hold  The channel accepts NO trigger signals.

Trigger Mode

These settings determine what EACH signal will trigger.

Sweep and Point modes are available ONLY when both Trigger Source = MANUAL or

EXTERNAL AND Trigger Scope = CHANNEL.

Channel  Each trigger signal causes ALL traces in that channel to be swept in the order
specified below.

Point  Each Manual or External trigger signal causes one data point to be measured.
Subsequent triggers go to the same trace until it is complete, then other traces in the same

channel are swept in the order specified below.  When in Groups or Single trigger, the count
is decremented by one after ALL data points on ALL traces in the channel are measured.

 See Also, the (point) Sweep Indicator and SCPI Triggering example for use with External.
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Trace  Available ONLY when Point Sweep is selected. Each trigger signal causes two

identical measurements to be triggered separately - one trigger signal is required for each

measurement. Other trigger mode settings cause two identical parameters to be measured

simultaneously.  Trace triggering is NOT permitted when a channel is using a 2 port (or

more) S-Parameter calibration.

Sweep  Each Manual or External trigger signal causes ALL traces that share a source

port to be swept in the order specified below.  When in Groups or Single trigger, the count

is decremented by one after ALL traces in ALL directions are swept.

When multiport correction is ON, which requires sweeps in more than one direction, traces

on the screen will not update until all of the relevant directions have been swept.  For

example, with all four 2-port S-Parameters displayed:

When Full 2-port correction is ON, trigger 1 causes NO traces to update; trigger 2

causes ALL S-Parameters to update. Learn more about sweeps with correction ON.

When correction is OFF, trigger 1 causes S11 and S21 to update; trigger 2 causes S22

and S12 to update.

Trace Sweep Order

For ALL Trigger Modes, trigger signals continue in the same channel until all traces in that

channel are complete. Triggering then continues to the next channel that is not in HOLD.

Traces within each channel are always swept in the following order:

Traces are swept sequentially in source-port order. For example, in a channel with all

four 2-port S-parameters, first the source port 1 traces (S11 and S21) are swept

simultaneously. Then the source port 2 traces (S22 and S12) are swept simultaneously.

In addition, when Alternate sweep is selected, traces are swept sequentially in source-port /

receiver-port order.  In the above example, first the S11 trace is swept, then S21, then

S12, then S22.

Restart  (Available only from the Trigger menu) Channels in Hold are set to single trigger (the
channel accepts a single trigger signal). All other settings are unaffected, including decrementing

trigger Groups.

See Also

External Triggering

Interactive Trigger Model animation
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External and Auxiliary Triggering

External and auxiliary triggering is used to synchronize the triggering of the analyzer with other

equipment.

Overview

How to make Trigger Settings:

Auxiliary Triggering

Meas Trig (IN) Dialog

See Also

Synchronizing an External Source

Internal Triggering

Overview

Ready Signals versus Trigger Signals

A 'Ready for Trigger' signal is different from a Trigger signal. The ready signal indicates that the

instrument sending the signal is ready for measurement. The instrument receiving the ready signal

would then send a trigger signal, indicating that the measurement will be, or has been, made. Usually

the slower instrument sends the trigger signal.

AUX TRIG OUT and AUX TRIG IN - These two pair of connectors and signals are highly configurable. Use
them to synchronize with any number of devices and equipment.

Meas (External) Trigger dialog box help

M9371A/72A/73A/74A/75A
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M9485A
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See how to access the Trigger Dialog

Trigger Ready and Trigger IN

The Trigger connectors are located on the front-panel. (Refer to I/O Connector (M9485A) for

M9485A)

These signals can be used when the VNA is communicating with a slow mechanical device. A

material handler is very mechanical and takes a relatively long time to load and discharge parts.

Here is how these signals work together to communicate:

The VNA sends a 'Ready' signal when it is ready to make a measurement.1.

The external device sends a trigger signal to the VNA when it is ready for a measurement.2.

Dialog Settings

To cause the VNA to respond to Meas Trig IN or Handler I/O signals, select External on the Trigger
Setup tab, Source setting.

Also on the Trigger Setup tab, Scope setting, choose whether one external trigger signal will apply

to ALL channels (Global) or one trigger signal per Channel. The following settings apply
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accordingly.

Main Trigger Input

Global / Channel Trigger Delay  After an external trigger is received, the start of the sweep is

held off for this specified amount of time plus any inherent latency.

When Trigger Scope = Channel, the delay value is applied to the specified channel.

When Trigger Scope = Global, the same delay value is applied to ALL channels.

Source  The VNA accepts Trigger IN signals through the following connectors:

Trig In SMB (on front panel of module)

Backplane (on front panel of embedded controller to use backplane trigger lines)

(M9371A/72A/73A/74A/75A only)

Handler I/O Pin 18 (This appears when the M9341A is included at launcher.)

Pulse3 (M9485A only)

Note: When Handler I/O Pin 18 is selected, the connection between Meas Trig In SMB and

M9341A is required. See M9341A Module Installation.

Level / Edge  

Positive Edge  After the VNA arms, it will trigger on the next positive edge.

Negative Edge  After the VNA arms, it will trigger on the next negative edge.

Ready for Trigger Indicator (Trigger Ready)

On the VNA, when External is selected on the Trigger Setup tab, then both Meas Trig IN and

Meas Trig Ready are enabled.

Choose a connector to send the VNA Ready OUT signal:

Handler I/O p21 (This appears when the M9341A is included at launcher.)

Choose Polarity of the 'Ready OUT' signal.
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Ready High - TTL High indicates the VNA is ready for trigger.

Ready Low - TTL Low indicates the VNA is ready for trigger (default setting).

See Also

Learn how to External Trigger during Calibration

 

Aux Trig 1 - Aux Trig 2 dialog box help

See how to access the Trigger Dialog

AUX TRIG OUT and AUX TRIG IN

 

In M9485A, when you assign the I/O 1 or 2 port on the M9376A/M9377A as AUX trigger port,

AUX Trig (1 & 2) Tag appears. See the I/O Connector (M9485A) for assignment of I/O port.
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These signals are highly configurable. They can be used with all types of external devices to send

and receive signals. However, it is important to note that either Aux Trig INPUT does NOT trigger

the VNA. That signal must be selected. See step 2 in the following procedure.

An external source sends a 'Ready' signal to the VNA (at the Aux Trig IN connector) when it is settled at
a frequency.

1.

After receiving the Ready signal, the VNA begins the measurement when it receives a Trigger signal from
the specified Trigger Source:

2.

Internal - Measurement begins immediately.

Manual - Measurement begins when the VNA Trigger button is pressed.

External - Measurement begins when Meas Trig In signal is received from an external device. This
must be configured independently.

The Aux Trig OUT signal can be configured to be sent either just BEFORE the measurement is made or
AFTER the measurement is complete. When communicating ONLY with an external source, the Aux Trig
OUT signal should be sent AFTER the measurement is complete to indicate that the external source can
setup for the next measurement.

3.

Dialog Settings

The Aux Trig 1 and Aux Trig 2 tabs are identical. Two pair of connectors are available to allow two

external devices to be controlled simultaneously.

Enable  Check to use the Aux1 or Aux2 connectors to output signals to an external device.

Channel:  This setting is controlled by a VNA Preference setting.

Global - ALL Aux Trig settings apply to ALL channels. The Per Point setting (see below) is made on the
Trigger Setup tab which also applies to ALL channels.

Channel - ALL Aux Trig settings apply to the specified channel. Each channel can be configured
independently.

AUX TRIG OUT (To Device)

The following settings control the properties of the signals sent out the rear panel AUX TRIG OUT

(1&2) connectors:

Polarity

Positive Pulse  Outgoing pulse is positive.
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Negative Pulse  Outgoing pulse is negative.

Position

Before Acquisition  Pulse is sent immediately before data acquisition begins.

After Acquisition  Pulse is sent immediately after data acquisition is complete.

Per Point  Check to cause a trigger output to be sent for each data point.  Clear to send a trigger

output for each sweep.

When the Aux Trig - "Global" VNA Preference is selected, then the Point setting is made on the

Trigger Setup tab. It then applies to ALL channels. When more than one channel is present, the

channel setting that was made last is used.

Pulse Duration  Specifies the duration of the positive or negative output trigger pulse.

 

Note: Guided and Unguided Calibration CAN be performed in External Trigger mode. With this

optional behavior, while Trigger Source is set to External, trigger signals must be sent for

Calibration sweeps. This behavior does not apply to FCA calibrations.

You can set a Preference to calibrate using Internal trigger signals while Trigger Source is set to

External.

The following dialog box appears on the screen while waiting for an External trigger signal.

Click Abort to cancel the wait for a trigger signal.
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Speedometer
Trigger Source

 Internal

 Manual 

Trigger Scope

 Global

Channel

Continuous

Groups 5

Single

 Hold

Point

Continuous

Groups 5

Single

Hold

Point

Continuous

Groups 5

Single

Hold

Point

About the trigger model

Read Text description of triggering behaviors.

This model does not include Sweep trigger mode.
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Data Format

A data format is the way the analyzer presents measurement data graphically. Pick a data format

appropriate to the information you want to learn about the test device.

How to set Format

Rectangular (Cartesian) Display Formats

Polar

Smith Chart

See other 'Setup Measurements' topics

How to set the Display Format

Using Hardkey/SoftTab/Softkey Using a mouse

Press Format > Format 1 or Format 2.1. Right-click on the trace status area above the grid box.1.

Click Format.2.

Select the desired format.3.
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Format dialog box help

Click a link to learn about that format:

Log Mag Polar Kelvin
Phase / Unwrapped Phase Linear Mag °F
Group Delay SWR °C
Smith / Inverse Smith Chart Real  

  Imaginary  

Format Unit

Only the following Formats allow a Unit selections:

Log Mag - Choose from:

dBm (Power)

dBmV (dB milli Volts) - used for unratioed receiver measurements.

dBmA (dB milli Amps) - used for unratioed receiver measurements.

Lin Mag - Choose from:

W (Watts), V, (volts), A (amps)

Rectangular Display Formats

Seven of the nine available data formats use a rectangular display to present measurement data. This

display is also known as Cartesian, X/Y, or rectilinear. The rectangular display is especially useful for

clearly displaying frequency response information of your test device.

Stimulus data (frequency, power, or time) appears on the X-axis, scaled linearly

Measured data appears on the Y-Axis.

Log Mag (Logarithmic Magnitude) Format

Displays Magnitude (no phase)

Y-axis: dB

Typical measurements:
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Return Loss

Insertion Loss or Gain

Phase Format

Measures the phase of a signal relative to the calibration reference plane with a range of +/- 180

degrees.

Displays Phase (no magnitude)

Y-axis: Phase (degrees)

The trace 'wraps' every 180 degrees for easier scaling.

Typical Measurements:

Deviation from Linear Phase

Unwrapped Phase

Same as Phase, but without 180 degree wrapping.

Note: Phase is unwrapped by comparing the phase from one data point to the next. If the phase

difference between two points is greater than 180 degrees, or if the phase of the first data point is

greater than 180 degrees from DC, than the phase measurement is probably NOT accurate.

Group Delay Format

Displays signal transmission (propagation) time through a device

Y-axis: Time (seconds)

Typical Measurements:

Group Delay

See Also:

Group Delay (Measurement)

Comparing the analyzer Delay Functions.

Phase Measurement Accuracy

Linear Magnitude Format
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Displays positive values only

Y-axis: Unitless (U) for ratioed measurements
Watts (W) for unratioed measurements.

Typical Measurements:

reflection and transmission coefficients (magnitude)

time domain transfer

SWR Format

Displays reflection measurement data calculated from the formula (1+ )/ (1- ) where  is reflection
coefficient.

Valid only for reflection measurements.

Y axis: Unitless

Typical Measurements:

SWR

Real Format

Displays only the real (resistive) portion of the measured complex data.

Can show both positive and negative values.

Y axis: Unitless

Typical Measurements:

time domain

auxiliary input voltage signal for service purposes

Imaginary Format

Displays only the imaginary (reactive) portion of the measured data.

Y - axis: Unitless

Typical Measurements:

139



impedance for designing matching network

Polar Format

Polar format is used to view the magnitude and phase of the reflection coefficient ( ) from your S11 or

S22 measurement.

You can use Markers to display the following:

Linear magnitude (in units) or log magnitude (in dB)

Phase (in degrees)

The dashed circles represent reflection coefficient. The outermost circle represents a reflection coefficient ( )
of 1, or total reflected signal. The center of the circle represents a reflection coefficient ( ) of 0, or no
reflected signal.

The radial lines show the phase angle of reflected signal. The right-most position corresponds to zero phase
angle, (that is, the reflected signal is at the same phase as the incident signal). Phase differences of 90°,
±180°, and -90° correspond to the top, left-most, and bottom positions on the polar display, respectively.

Smith Chart Format

The Smith chart is a tool that maps the complex reflection coefficient ( ) to the test device's

impedance.

In a Smith chart, the rectilinear impedance plane is reshaped to form a circular grid, from which the

series resistance and reactance can be read (R + jX).

You can use Markers to display the following:
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Resistance (in units of ohms)

Reactance as an equivalent capacitance (in units of farads) or inductance (in units of henrys)

Inverse Smith Chart (also known as Admittance)

Same as standard Smith Chart , except:

The plot graticule is reversed right-to-left.

Admittance (in units of siemens) instead of resistance.

Interpreting the Smith Chart
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Every point on the Smith Chart represents a complex impedance made up of a real resistance (r) and an
imaginary reactance (r+-jX)

The horizontal axis (the solid line) is the real portion of the impedance - the resistance. The center of the
horizontal axis always represents the system impedance. To the far right, the value is infinite ohms (open).
To the far left, the value is zero ohms (short)

The dashed circles that intersect the horizontal axis represent constant resistance.

The dashed arcs that are tangent to the horizontal axis represent constant reactance.

The upper half of the Smith chart is the area where the reactive component is positive and therefore
inductive.

The lower half is the area where the reactive component is negative and therefore capacitive.
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Scale

The Scale, Reference Level and Reference Position settings (along with Format) determine how the data

trace appears on the VNA screen.

Scale, Reference Level and Position

Scale Coupling

Magnify Mode and Zoom Preference

Electrical Delay (Separate topic)

Magnitude Offset & Magnitude Slope

Phase Offset (Separate topic)

See other 'Setup Measurements' topics

Scale, Reference Level and Position

The Scale, Reference Level and Reference Position settings (along with format) determine how the data

trace appears on the VNA screen.

How to set Scale, Reference Level, and Position

Using Hardkey/SoftTab/Softkey Using a mouse

Press Scale > Main > Scale / Reference Level /
Reference Position.

1.

Input the desired value.2.

Right-click on Y-axis annotation or the trace
status label above the grid box.

1.

Select Scale....2.

 

Scale dialog box help
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Note: The scale settings are set to couple with other traces in each window. The following settings

assume that Scale Coupling is set to OFF. Learn more about Scale Coupling.

Scale

Per Division  Sets the value of the vertical divisions of a rectangular display format. In Polar and

Smith Chart formats, scale sets the value of the outer circumference. Range: 0.001dB/div to 500

dB/div.

Tip: Click on the Y-axis labels, then use a mouse scroll wheel to change scale in preset

increments. Or Right-click on Y-axis annotation to change Scale.

Autoscale - Automatically sets value of the vertical divisions and reference value to fit the

ACTIVE data trace within the grid area of the screen. The stimulus values and reference position

are not affected.

The analyzer determines the smallest possible scale factor that will allow all the displayed data to

fit onto 80 percent of the vertical grid.

The reference value is chosen to center the trace on the screen.

Tip: Double click on the Y-axis labels to autoscale the active trace.

Autoscale All  Automatically scales ALL data traces in the ACTIVE WINDOW to fit vertically

within the grid area of the screen.

Reference

Level  In rectangular formats, sets the value of the reference line, denoted by  on the
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screen. Range: -500 dB to 500 dB.

In Polar and Smith chart formats, reference level is not applicable.

Tip: Click on the Y-axis labels, then drag up or down to change the reference level in preset

increments.

Position  In rectangular formats, sets the position of the reference line. Zero is the bottom line of

the screen and ten is the top line. Default position is five (middle).

In Polar and Smith chart formats, reference position is not applicable.

Tip: Click on the triangle , then drag up or down to change the reference position in

preset increments.

Scale Coupling

With Scale Coupling enabled, traces that have the same format will have the same Scale, Reference

Level, and Reference Position. You can choose to couple the scale of traces that are in the same

window, couple the scale of all traces in all windows, or to have NO coupling.

How to set Scale Coupling

Using Hardkey/SoftTab/Softkey Using a mouse

Press Scale > Main > Scale Coupling....1. Right-click on Y-axis annotation.1.

Select Scale Coupling....2.

 

Scale Coupling dialog box help
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Allows traces that share the same format to have the same Scale, Reference Level and Reference
Position.

Coupling Method

Off - No coupling. Traces are scaled individually. Default setting.

Window - All traces with the same format in each selected window share the same scale settings.

All - All traces in ALL selected windows with the same format share the same scale settings.

When Window or All coupling is enabled, the scale settings for the active trace are assumed by other
coupled traces with the same format.

When there are traces with a different format present, all traces with that format assume the trace
settings of the lowest-numbered trace of that format.

Once enabled, scale settings for all coupled traces with the same format can be changed with any
coupled trace being active.

Selected Windows

Available when either the Window or All method is selected. Selected windows will participate

in scale coupling. All windows are selected by default. Clear a checkbox to 'Opt-out' of scale

coupling for that window.
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About Autoscale and Scale Coupling

Autoscale (not Autoscale All) affects the active trace in the active window. All traces that are

coupled to this trace assume the new scale settings of the active trace. This could cause some

traces to NOT show on the screen.

Autoscale All with Coupling Method...

Off - All traces in the active window are autoscaled independently.

Window - All traces in each selected window are autoscaled to fit within a common set

of scaling factors.

All - All traces in all selected windows are autoscaled to fit within a common set of

scaling factors.

 

 

Magnify Mode and Zoom Preference

The magnify feature allows to magnify all traces in the active window. It allows to zoom into a portion

of the display to see the response in detail.

How to magnify the trace

Using Hardkey/SoftTab/Softkey Using a mouse

None
Left-click and select the area you want to
magnify

1.

Select Magnify from the pop-up menu.2.

Other methods to set the magnify mode includes:

When the Zoom Preference is set to Magnify, a 2-finger spread gesture will turn ON the Magnify
mode

Click on the Magnify icon at the top of the screen
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Enable the zoom box select mode and drag the zoom box to select an area, and then choose the

Magnify option in the popup menu.

When the Magnify Mode is turned on:

2-finger pinch on the display changes the x and y magnification. If magnification is pinched down to

1:1 scaling, the magnify mode will be turned off.

1-finger drag across display changes  the reference of the magnified x and y.

 

Zoom Preference Dialog Box Help

Zoom Preference allows you to decide the default operation of the 2-finger pinch gesture, from these

4 choices:

2-finger pinch automatically turns on magnify mode so that x and y-axis can be magnified/ This is

the default setting.

2-finger pinch changes y-axis scale.

2-finger pinch changes y-axis scale and x-axis stimulus.

2-finger pinch does nothing.

Magnitude Offset

Magnitude Offset allows you to offset the magnitude (not phase) data by a fixed and / or sloped value

in dB. If the display format is Linear Magnitude or Real (unitless), the conversion from dB is

performed and the correct amount of offset is implemented.

How to set Magnitude Offset

Using Hardkey/SoftTab/Softkey

Press Scale > Constants > Mag Offset / Mag Slope.1.
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Magnitude Offset dialog box help

Magnitude Offset allows you to offset the magnitude (not phase) data by a fixed and / or sloped

value in dB. If the display format is Linear Magnitude or Real (unitless), the conversion from dB is

performed and the correct amount of offset is implemented.

The Magnitude offset setting affects only the active trace.

Mag Offset  Offsets the entire data trace by the specified value.

Mag Slope  Offsets the data trace by a value that changes with frequency. The offset slope begins at

0 Hz.

For your convenience, the offset value at the start frequency is calculated and displayed.
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Customize the Analyzer Screen

You can customize your analyzer screen by showing or hiding the following display elements. All of

these selections are made from the Response > Display menu.

Windows (Separate topic)

Display Labels

Trace Status

Y-axis Labels

X-axis Labels

Marker Display (Separate topic)

Tables

Toolbars

Softkey

Hardkey

Port Extension

Transform

Marker

Cal Set Viewer

Title Bars

Active Entry

Status bars

System Date and Time

Display Colors (Separate topic)

Grid: SOLID | Dotted

Grid Lines
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Y-axis Divisions

Show Table

Tools

Colors

Window Title

Trace Title

Frequency/Stimulus

Minimize Application

See Also

Traces, Channels, and Windows

See other 'Setup Measurements' topics

Labels

You can display different labels for traces status, Y-axis and X-axis labels.

How to display labels

Using Hardkey /SoftTab /Softkey Using a mouse

Press Display > Display Setup > Customize Display... .1.

Select Labels tab.2.

OR

Press Marker > Marker Setup > Marker Display... .1.

Select Labels tab.2.

Right click on any window area.1.

Click Customize Display... .2.

Select Labels tab.3.

Labels tab Dialog Box Help
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Show Labels

Trace Status

Trace status is annotated at the top of each window.

The highlighted trace number indicates Active Trace .

Click the title to select a trace.

Trace Status shows the following:

Trace number (Tr x). This is the trace number of the channel; NOT the window trace number which is
used in many programming commands.

Measurement parameter. This can be replaced with a custom Trace Title .

Format

Scaling factor
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Reference level

How to show/hide Trace Status.

 

Y-axis Labels

" Y-axis Labels " - allows user to show or hide the y-axis labels.  

How to show/hide Y-axis Labels.

 

X-axis Labels

"X-axis Freq Resolution " - allows user to choose the resolution of the frequency display. The pull

down selects: 6-digit, GHz, MHz, kHz, Hz. It shows 1Hz resolution, but only shows significant

digits.
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How to show/hide X-axis Labels.

 

Grid

How to set VNA Grid and display tables.

Each window can display only one table at a time.

Using Hardkey /SoftTab /Softkey Using a mouse

Press Display > Display Setup > Customize
Display...

1.

Select Grid tab.2.

OR

Press Marker > Marker Setup > Marker

Display... .

1.

Select Grid tab.2.

Right click on any window area.1.

Click Customize Display... .2.

Select Grid tab.3.

Grid Dialog Box Help
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Grid Lines: Solid | Dotted - Set whether to display ALL open window grid lines in solid or dotted

lines. The selected setting is shown in CAPS. Once set, new windows are created using this setting.

Grid lines return to SOLID when the VNA is Preset.

Set the color of the grid using Display Colors.

How to display grid settings

 

Y-axis Divisions - Set the desired rows of Y-axis, it can shows 2 to 30.

 

Show Table

 

None - Turn OFF the table.
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Marker Table

You can display a table of marker settings. These settings include the:

Marker number

Marker reference (for delta measurements)

Frequency

Time and Distance (for Time Domain measurements)

Response

Learn more about Markers

Limit Line Table

You can display, set up, and modify a table of limit test settings. These include:

Type (MIN, MAX, or OFF)

Beginning and ending stimulus values

Beginning and ending response values

Learn more about Limit Lines .

Segment Sweep Table

You can display, set up, and modify a table of segment sweep settings. These include:

State (On/Off)

Start and Stop frequencies

Number of Points

IF Bandwidth (if independent levels)

Power Level (if independent levels)

Sweep Time (if independent levels)

Learn more about Segment Sweep .
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Toolbars

You can display different toolbars to allow you to easily set up and modify measurements.

How to display Toolbars

Using Hardkey /SoftTab /Softkey Using a mouse

Press Display > Display Setup > Customize
Display...

1.

Select Toolbars tab.2.

OR

Press Marker > Marker Setup > Marker
Display... .

1.

Select Toolbars tab.2.

Right click on any window area.1.

Click Customize Display... .2.

Select Toolbars tab.3.

Toolbars Dialog Box Help
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Show Toolbar

Note: There is also a Cal Set toolbar available for Monitoring Error Terms

Softkey
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Softkey is a combination of softkeys and SoftTabs. Softkeys are automatically turned ON when one

of the 'function' hardkeys is pressed. This setting allows you to turn the softkeys OFF to show more

measurement space on the screen. The softkeys will reappear when another function hardkey is

pressed.

 

Hardkey
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These keys also known as Front Keys, perform interface operations that are equivalent to those of

keys in the INSTRUMENT keys, RESPONSE keys, STIMULUS keys and UTILITY keys on the

front panel of VNA. Learn more.

 

Port Extensions Toolbar
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The Port Extension toolbar allows you to set Port Extensions while viewing the measurement trace.

Learn more about Port Extensions .

 

Transform (Time Domain) Toolbar

The Time Domain toolbar allows you to do the following:

Turn Transform and Gating ON/OFF.

Change the Start/Stop times for both Transform and Gating.

More... - Launches the Time Domain Transform dialog box.

? - Display the help file.

X - Closes the toolbar.

 

Markers Toolbar

The markers toolbar allows you to set up and modify markers. It shows:

Marker number

Stimulation value

Marker functions:

Delta

Max/Min

Start/Stop

Center/Span
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Tip: To use the Front Panel Knob to change marker position, first click the Stimulus field of the

marker toolbar and then turn the knob.

Learn more about Markers

 

Cal Set Viewer Toolbar

 

All Off (NOT on softkeys)

This allows you to hide all toolbars with a single selection. NOT available on sofkeys.

 

Other Bars

Main Title

The Main Title shows the title of VNA window and Minimize / Maximize icons.

 Checked - Title bars for all VNA window are shown.

 Cleared - Title bars for all VNA window are hidden. This allows more room to display measurement
results.

Active Entry Toolbar

When used with softkeys, this area allows numeric values to be entered for settings. From the

keyboard, enter G for Giga, M for Mega or milli, K for kilo and so forth.

 

Status Bar

2 Bars
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When enabled, the status bar is displayed along the bottom of the VNA screen. The primary status

bar shows the following:

Tip: Right-click on many of these items in the status bar for quick access to settings.

Active trace

Active channel

Trigger source

Channel Trigger State (Hold, Single, Continuous)

IF Bandwidth

Error correction for the active trace to the Basic cal, Smart cal and Calibrate All Channels.

F: Full Port Calibration, R: Response Calibration, -: Nothing

Source Power Calibration

Simulation

Service

RF power

Display Update

Error messages

GPIB status : Local (LCL), Remote Talker Listener (RMT), or System Controller (CTL).

System Date and Time - Can be set ON or OFF. How to show/hide the VNA clock.

Note: A second level status bar appears when using External Test Set Control or Interface control.

The status bar state (ON or OFF) will not change when the VNA is Preset.

 

Clock (System Date and Time)

The VNA system date and time can be shown in the far right corner of the status bar.

The format is: year-month-day  hr:min and can NOT be changed.
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To hide the clock, right click the mouse on the clock and then click Hide Clock .

Learn how to set the VNA time settings.

 

Display Sheet Tabs

Top - Display sheet tabs above display.

Bottom - Display sheet tabs below display.

 

 

Tools

How to set Tools settings

Using Hardkey /SoftTab /Softkey Using a mouse

Press Display > Display Setup > Customize
Display...

1.

Select Tools tab.2.

OR

Press Marker > Marker Setup > Marker

Display... .

1.

Select Tools tab.2.

Right click on any window area.1.

Click Customize Display... .2.

Select Tools tab.3.

Tools Dialog Box Help
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Tools function to create a shortcut icon to display on Active Entry or Softkey Toolbar. The

maximum icons can display on Active Entry is 9, while Softkey Toolbar is 12.

New Window - Create a new window.

New Channel - Create a new channel on active window.

New Channel + Window - Create a new trace and channel to a new window.

New Trace - Create a new trace on active window.
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New Trace + Window - Create a new trace to a new window, but the channel is remain.

New Sheet - Create a new sheet.

New Trace + Sheet - Create a new trace to a new sheet, but the channel is remain.

New Channel + Sheet - Create a new trace and channel to a new sheet.

Home - Display VNA Home softkeys.

Favorite - Set favorite application. To Add a Favorite, press and hold any softkey for three seconds

and select the desired Favorite number (Favorite 1 to 3).

Help - Shows Help file.

Show Task Bar - Shows Window bar.

Preference - Display preference dialog box.
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Tile Windows

Manages Files - Use to manage the saved files in the "D:\" drive folder. Learn more.

Minimize Application - Restore VNA screen. Learn more.

About Network Analyzer - Display About Network Analyzer dialog box.

Undo - Recover to previous version. Learn more.

Redo - Set to latest version. Learn more.

Screenshot - Save screen figure to "D:\" drive (D:\).

Delete - Delete the active window.
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Colors

How to set colors

Using Hardkey /SoftTab /Softkey Using a mouse

Press Display > Display Setup > Customize
Display...

1.

Select Colors tab.2.

Right click on any window area.1.

Click Customize Display... .2.

Select Colors tab.3.

Colors Dialog Box Help

Menu Color Theme - Select color theme

Display Colors... - See Display Colors

Print Colors... - See Print Preview
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Window Title

You can create and display a title for each window.

The limit is set by the number of windows that are displayed.

The title (My Window) is annotated in the upper-left of the window as follows:

How to enter a Window Title

Using Hardkey /SoftTab /Softkey Using a mouse

Press Display > Window Setup > Window
Title... .

1. Move a cursor in the grid and then right click.1.

Select Title... .2.

Window Title Dialog Box Help

Click Enable , then type the window title. Click Keyboard to type with a mouse.1.

To remove the window title, clear the Enable checkbox or delete the text from the dialog entry.2.

 

Trace Title

A Trace Title overwrites the Measurement Parameter in the Trace Status area, the Status Bar and

hardcopy prints .

This title has priority over Equation Editor titles.
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The practical limit is about 70 characters if there is only one trace.

Spaces are accepted but not displayed; use underscores.

The title is annotated as follows:

How to enter a Trace Title

Using Hardkey /SoftTab /Softkey Using a mouse

Press Trace > Trace Setup > Trace Title... .1. Move a cursor in the grid and then right click.1.

Select Trace Title... .2.

Trace Title Dialog Box Help

Click Enable , then type the window title. Click Keyboard to type with a mouse.1.

To remove the window title, clear the Enable checkbox or delete the text from the dialog entry.2.

 

Frequency/Stimulus

Frequency/stimulus information is displayed at the bottom of each window on the screen. It shows:

Channel number

Start value

Stop value
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How to show/hide Frequency/Stimulus information

 

Minimize Application

The Network Analyzer application can be minimized to show the desktop and Windows taskbar.

Click System > Main > Minimize Application .1.

To restore the VNA application, double-click the VNA application on the desktop.
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Copy Channels

Copy channels allows you to make a duplicate channel with the same stimulus conditions as an existing

channel.

Why Copy Channels

How to Copy Channels

List of Channel Settings

Other Setup Measurements Topics

Why Copy Channels

Copy channel settings if you need to create several channels that have slightly different settings.

For example, if you have an amplifier that you want to characterize over a frequency span with several

different input power levels.

Follow these steps:

Create one measurement with your optimized channel settings.1.

Copy that channel to new channels.2.

Change the power level on the new channels.3.

The alternative to using Copy Channels is to create new default measurements on new channels. Then

change every channel setting to your new requirement. This is very time consuming and thus shows the
benefit of the Copy Channels feature.

How to Copy Channels

Using Hardkey/SoftTab/Softkey

Press Channel > Channel Setup > Copy Channel.1.

Click Copy to Active Window/Copy to New Window/Copy Channel....2.
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Copy Channel dialog box help  

Copies an existing channel's settings to another channel.  Measurement traces from the source

channel are NOT copied.

Copy channel (also known as 'Source' channel):  Select a channel to copy.

to (also known as 'Destination' channel):  Scroll to select a channel to copy settings to.  Compatible

channel numbers that are currently being used are highlighted. They can be selected and

overwritten.

The following are compatible destination channels:

A channel that does not yet exist.  The new channel is created with the channel's default measurement.

A channel that contains no measurements.  Again, the destination channel is created with the channel's
default measurement.

Notes:

You can copy channel settings to ONLY one new or existing channel. Repeat this operation to copy to
more than one channel.

The source channel is ALWAYS copied to the Active window. If you want the destination channel in a
separate window, first create a compatible new measurement in a new window. Then make sure it is the
Active window before you copy the channel into it.

The measurement in the destination channel becomes the active measurement.

For example:

Source channel 1: Standard S21 measurement1.

Destination  NEW channel 22.

Result: Source channel 1, S21 Measurement AND channel 2, S11 measurement. Both with same3.
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2.

stimulus settings and in the same window.  Channel 2, S11 measurement is the active measurement.
3.

For more information see Traces, Channels, and Windows

List of Channel Settings

Frequency Span

Power

Cal Set usage

IF Bandwidth

Number of Points

Sweep Settings

Average

Trigger (some settings)
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DC Source Control

When a DC Source (power supply) is configured as an external device and an internal device, the new

DC source can be controlled from the VNA using this dialog. Internal DC Sources are also controlled

from this dialog.

How to start the DC Source Control dialog

The DC Source Control dialog box

The DC Limits dialog box

See Also

Configure the DC Source as an External Device

Internal DC Sources - ADC Measurements

M9341A/B Module Installation

Other Setup Measurements Topics

How to start the DC Source Control dialog

Using Hardkey/SoftTab/Softkey Using a mouse

Press Sweep > Source Control > DC Source....1. Click Stimulus.1.

Select Sweep.2.

Select Source Control.3.

Select DC Source.4.
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DC Source Control dialog box help  

Name  Lists the names of the configured DC Sources. In the above image:

AuxOut1 and AuxOut2 are internal VNA DC sources that are available

Analog Out 1 and 2 on the M9341B.

MyDCSupply is the name of an external DC Source. Learn how to setup and configure an External DC
Source and DC Meter.

State  Set the state of the DC source.

ON  DC Source is always ON.

OFF DC source is always OFF.

Per Port  The Name selection for that DC source expands to allow an Port <n> / N/A setting for each
VNA port. When the RF source for that port <n> is ON, then the DC source for port <n> is also ON.
Select 'N/A' to turn the DC Source OFF for that port.

Start / Stop DC   Set the start and stop voltages of the DC source. The VNA will step the voltage
of the DC source from Start to Stop in increments = (Stop - Start)/Number of data points.

Buttons

Limits  Click to start the DC Limits dialog.

Receiver Leveling  For future use.
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DC Limits dialog box help  

Select the Minimum and Maximum voltages to which the specified DC sources can be set by the

VNA. When the DC source level exceeds the limit, DC source is turned off, but measurement

sweep continues.

 

 

Analog Out dialog box help  

This tab is displayed only when the M9341B is installed.

 

Range  Selects the current range of output from 50 m or 500 mA

Over-current Protection  Shows the status of signal output, Output On or Output Off. Note that

when the protection turns off the output, the "DC Source" dialog the state of the analog output may
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still indicate that it is "on" because this state is independent of the protection.

Set Ouput Levels Displays DC source dialog box.

Reset Protection  Resets the over-current protection for all channels

Measurement Time   Specifies the measurement time. This can calculated by (Number of

Samples) x 20 nsec. This is the same entry in Analog In Tab.

Number of Samples  Specifies number of ADC samples for one point. One ADC sample takes 20

nsec. Increasing this number improves the stability of DC measurement. This is the same entry in

Analog In Tab.

Calibrate Analog Out  Executes the analog out calibration. No setup is required for calibration.

Validation of calibration: 1 hour and ±3 cº from previous  calibration.
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ADC Measurements

When M937xA and M9485A works with M9341B Anlog/Digital I/O, you can measure or output DC signal.

Analog Inputs (AI1 to AI4) can be used for measuring from -10V to +10V. These inputs can be

considered auxiliary measurement receivers and used in a similar way as S-Parameter receivers.

Analog Output  (AOC1 and AOC2) can be used to monitor the current of corresponding DC

output..

How to create ADC receiver measurements

Using Hardkey/SoftTab/Softkey Using a mouse

Press Trace > Trace Setup >
Measure....

1.

Select the Receivers tab.2.

Click Trace/Chan1.

then New Trace2.

 

New Trace (ADC) dialog box help  

Note: Sweep speed slows dramatically when measuring more than two ADC receivers.

On the New Trace dialog, click the Receivers tab.

Activate - check any empty line to create a trace.

Numerator - select from the following:
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AIx - Input x:  x is Input No.

AOCx -  Monitor the current in Amp. of DC output source x:  x is output No.

Denominator - NOT available (ONLY unratioed measurements)

Source Port - The ADC receiver is measured when the specified source port is sweeping. Select

None to always measure the ADC receiver.

 

How to Setup Analog Input

 

Using Hardkey/SoftTab/Softkey Using a mouse

Press Setup > Internal Hardware > PXI Device...1.

Click M9341 IO Control Setup..2.

Click Instrument1.
Select Setup2.

Select Internal Hardware3.

Select PXI Device..4.

Select  M9341 IO Control Setup..5.

 

Analog In dialog box help  

This tab is displayed only when the M9341B is installed.
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Range : Select from 1, 5 or 10 V. Smaller range has better resolution.

Measurement Time : DC measurement time for one point. This can calculated by (Number of

Samples) x 20 nsec.   

Number of Samples : Number of ADC samples for one point. One ADC sample takes 20 nsec.

Increasing this number improve the stability of DC measurement.

 

ADC receiver traces are labeled as shown in the following images:

The ADC1 input is being measured, with 2 as the source port.

The Y axis is U (unitless).

The default trace format is Real (linear).

ADC Traces and other useful VNA functions

Although most VNA functions work with ADC traces, the following may be especially useful.

Equation Editor can be used with the trace data. Although the VNA ADC is measuring voltage , by using a
trace formula, this voltage can represent other types of measurement parameters (such as current,
temperature, or a scaled voltage). See PAE example.

Trace averaging and Trace Smoothing can be used to remove trace noise.
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Dwell time can be used to allow for settling.

VNA Functions Not Supported

Calibration for ADC receivers is NOT supported.

Not supported in Noise Figure application
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Undo/Redo Settings

If you make an incorrect setting, you can quickly recover by selecting Undo. If you then incorrectly

Undo a setting, you can Redo the undone setting.

Undo and Redo applies ONLY to selected settings.

The Undo stack remembers 16 levels of Undo-able settings.

How to Undo or Redo a setting

Tips:

Click or touch the Undo and Redo Icons:

Undo Redo

With a mouse, right-click on the Softkeys or on the Entry toolbar.

With a keyboard:

Undo....Ctrl+Z

Redo....Ctrl+Y

Using Hardkey/SoftTab/Softkey Using a mouse

Press Undo > Main.1.

Click Undo or Redo.2.

Click Undo and Redo Icons on Active Entry or Softkey Toolbar.1.

SCPI and COM programming and Undo/Redo:

There are NO Programming commands to invoke Undo/Redo

Programing commands are NOT Undo-able.

The Undo stack is cleared when programming commands are sent to the VNA.

Return To Task
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To return to the previous task, press Undo > Main > Return To Task.

Clear Undo History

To clear the Undo stack, press Undo > Main > Clear Undo History.

Undo and Security

Undo/Redo is disabled with High and Extra security levels. Learn more.

State files that are saved for Undo/Redo purposes (for example: Preset) are deleted when any of the
following occur:

The Security level is changed

The Network Analyzer App is started or closed.

Selected Undo-able settings

You can Undo or Redo the following settings:

Note: There are several settings that are NOT Undo-able. Because of this, when you attempt to Undo a

long sequence of operations, it is unlikely that the original state can be recreated exactly.

Preset

File Recall

Frequency Settings

Turn off Marker and Marker All OFF

Number of Points

Power Level - most applications and S-parameters

Turn OFF Channel

Close Window

New Channel , new Window, and new Trace.

Delete Trace

Window Tile

Change Layout (1x, 2x, 3x, 4x)
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Move Trace, Drag Trace

Zoom XY, Zoom Out Full

Autoscale All, Autoscale

Scale, Reference Level, Reference Position

Scale Coupling dialog

Electrical Delay

Phase Offset

Measurement Setups dialog

Format

Sweep Type

Data->Memory

Single Marker Searches (Max, Min, Target, Peak…)

Multi-marker Searches (Bandwidth, Power Saturation, Normal Operating Pt)

Change a Marker’s stimulus value: softkeys, dialog or drag

Change cell in Segment Table

Mechanical Settings dialog
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Dynamic Range

Dynamic range is the difference between the analyzer receiver's maximum input power and the

minimum measurable power (noise floor). For a measurement to be valid, input signals must be within

these boundaries.

Increasing dynamic range is important if you need to measure very large variations in signal amplitude,

such as filter bandpass and rejection. The dynamic range is shown below for an example measurement.

To help reduce measurement uncertainty, the analyzer dynamic range should be greater than the

response that the DUT exhibits. For example, measurement accuracy is increased when the DUT

response is at least 10 dB above the noise floor. The following methods can help you increase the

dynamic range.

Increase the Device Input Power

Reduce the Receiver Noise Floor

Other topics about Optimizing Measurements

Increase Device Input Power

Increase the DUT input power so that the analyzer can more accurately detect and measure the DUT

output power. However, use caution - too much power can damage the analyzer receiver or cause

compression distortion.

Caution! Receiver input damage level: +15 dBm.

See how to increase input power to the device

Tip: You can further increase dynamic range by using an external booster amplifier to increase the input

power to the DUT. See High Power Amplifier Measurements.
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Reduce the Receiver Noise Floor

You can use the following techniques to lower the noise floor and increase the analyzer's dynamic range.

Reduce crosstalk between the VNA receivers when measuring signals close to the noise floor. See Receiver
Crosstalk.)

Use Sweep Averaging - learn more about Sweep Average

Reduce the IF Bandwidth - learn more about IF Bandwidth.

In Segment sweep mode each segment can have its own IF bandwidth. For example, when measuring a
filter:

In the passband, the IF bandwidth can be set wider for a fast sweep rate, as long as high-level trace
noise is kept sufficiently small.

In the reject band, where noise floor contributes significantly to measurement error, the IF bandwidth
can be set low enough to achieve the desired reduction in average noise level.
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Number of Points

A data point is a sample of data representing a measurement at a single stimulus value. You can specify

the number of data points that the analyzer measures across a sweep. (A "sweep" is a series of

consecutive data point measurements, taken over a sequence of stimulus values.)

The analyzer sweep time changes proportionally with the number of points. However, the overall

measurement cycle time does not. See Technical Specifications for more information on how the number

of points, and other settings, affect the sweep time.

How to change the number of data points

Select a number or click Custom to invoke a dialog box

Using Hardkey/SoftTab/Softkey

Press Sweep > Main > Number of Points.1.

 

Number of Points dialog box help

Specifies the number of data points that the analyzer gathers during a measurement sweep. You can

specify any number from 1 to 100,001. The default value is 201.

Two data points are required for Time Domain.

Tips:

To achieve the greatest trace resolution, use the maximum number of data points.

For faster throughput use the smallest number of data points that will give you acceptable resolution.

To find an optimized number of points, look for a value where there is not a significant difference in the
measurement when you increase the number of points.

To ensure an accurate measurement calibration, perform the calibration with the same number of points
that will be used for the measurement.

The number of points is the number of data items collected in one sweep. It can be set for each

channel independently.

To obtain a higher trace resolution against the stimulus value, choose a larger value for number of points.

188



To obtain higher throughput, keep the number of points to a smaller value within an allowable trace
resolution.

To obtain higher measurement accuracy after calibration, perform calibration using the same number of
points as in actual measurements.
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Phase Measurement Accuracy

You can increase the accuracy of phase measurements by using the following features.

Electrical Delay

Phase Offset

Spacing Between Frequency Points (Aliasing)

See Also

Port Extensions

Comparing the Delay Functions

Learn more about Phase measurements

Electrical Delay

Electrical delay is a mathematical function that simulates a variable length of lossless transmission line.

Use the electrical delay feature to compensate for the linear phase shift through a device. This feature allows you to look at
only the deviation from linear phase of the device.

You can set the electrical delay independently for each measurement trace.

How to set Electrical Delay

Using Hardkey/SoftTab/Softkey

Press Scale > Electrical Delay.1.
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Electrical Delay dialog box help

Electrical Delay  Specifies the value of delay added or removed, in Time or Distance.  This compensates

for the linear phase shift through a device. You can set the electrical delay independently for each measurement trace.

Velocity Factor  Specifies the velocity factor that applies to the medium of the device that was

inserted after the measurement calibration. The value for a polyethylene dielectric cable is 0.66 and

0.7 for PTFE dielectric. 1.0 corresponds to the speed of light in a vacuum.

Velocity factor can also be set from the Port Extensions dialog and Time Domain Distance Marker
Settings.

Softkey Display  Allows you to enter delay in either Time or Distance using the softkeys and Active
Entry toolbar.

Delay Distance  Changes the value when the Delay Time or Delay Distance values are changed.

Distance Units  Select from Meters, Inches, or Feet.  The step size will not change automatically

when this value is changed.

Media

Coax  Select if the added length is coax. Also specify the velocity factor of the coax.

Waveguide  Select if the added length is waveguide. Also specify the low frequency cutoff of the

waveguide.

Cutoff Freq  Low frequency cutoff of the waveguide.

Learn about Electrical Delay (scroll up)

 

Phase Offset

Phase offset mathematically adjusts the phase measurement by a specified amount, up to 360°. Use this

feature in the following ways:

Improve the display of a phase measurement. This is similar to the way you would change the reference
level in an amplitude measurement. Change the phase response to center or align the response on the
screen.

Emulate a projected phase shift in your measurement. For example, if you know that you need to add a
cable and that the length of that cable will add a certain phase shift to your measurement, you can use phase
offset to add that amount and simulate the complete device measurement.
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How to set Phase Offset

Using Hardkey/SoftTab/Softkey

Press Scale > Constants > Phase Offset.1.

 

Phase Offset dialog box help

Phase Offset Type a value or use the up and down arrows to select any value up to 360 degrees.

Learn about Phase Offset (scroll up)

Spacing Between Frequency Points (Aliasing)

The analyzer samples data at discrete frequency points, then connects the points, creating a trace on the

screen.

If the phase shift through a device is >180° between adjacent frequency points, the display can look like

the phase slope is reversed. This is because the data is undersampled and aliasing is occurring.

If you are measuring group delay and the slope of the phase is reversed, then the group delay will

change sign. For example, the following graphic shows a measurement of a SAW bandpass filter.

The left measurement has 51 points and indicates the group delay is negative, which is a physical
impossibility. That is, the response is below 0 seconds reference line.

The right measurement shows an increase to 201 points which indicates the group delay is positive. That is,
the response is above the 0 seconds reference line.
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Tip:  To check if aliasing might be occurring in a measurement, either increase the number of points or
reduce the frequency span.
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Electrically-Long Device Measurements

A signal coming out of a device under test may not be exactly the same frequency as the signal going in

to a device at a given instant in time. This can sometimes lead to inaccurate measurement results. You

can choose between two techniques to eliminate this situation and increase measurement accuracy.

Why Device Delay May Create Inaccurate Results

Solutions to Increase Measurement Accuracy

Slow the Sweep Speed

Other topics about Optimizing Measurements

Why Device Delay May Create Inaccurate Results

The following graphic shows an example of this situation:

In the network analyzer, the source and receiver are phase locked together and sweep simultaneously
through a span of frequencies.

The signal flow through the Device Under Test (DUT) is shown as different colors for different frequencies.

You can see as a stimulus frequency travels through the DUT, the analyzer tunes to a new frequency just
before the signal arrives at the receiver. This causes inaccurate measurement results.

..

If the analyzer is measuring a long cable, the signal frequency at the end of the cable will lag behind the network analyzer
source frequency. If the frequency shift is appreciable compared to the network analyzer's IF detection bandwidth (typically a
few kHz), then the measured result will be in error by the rolloff of the IF filter.

Note: There is no fixed electrical length of a device where this becomes an issue. This is because there

are many variables that lead to measurement speed. When high measurement accuracy is critical, lower

the sweep speed until measurement results no longer change.
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Solutions to Increase Measurement Accuracy

Choose from the following methods to compensate for the time delay of an electrically long device.

Slow the Sweep Speed

The following methods will slow the sweep speed.

Increase the Sweep Time

Increase the Number of Points

Use Stepped Sweep

Set Dwell Time
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Reflection Accuracy on Low-Loss 2-Port Devices

To make accurate reflection measurements that have a 1-port calibration, you should terminate the

unmeasured port.

Why Terminate the Unmeasured Port

How to Terminate the Unmeasured Port

Resulting Measurement Uncertainty

Other topics about Optimizing Measurements

Why Terminate the Unmeasured Port

A 2-port calibration corrects for all 12 twelve error terms. A 1-port calibration corrects for directivity,

source match and frequency response, but not load match. Therefore, for highest accuracy, you must

make the load match error as small as possible. This especially applies for low-loss, bi-directional

devices such as filter passbands and cables. You do not need to be concerned with load match when

you are measuring a device with high reverse isolation, such as an amplifier.

How to Terminate the Unmeasured Port

Use one of the following methods:

Connect a high-quality termination load (from a calibration kit, for example) to the unmeasured port of your
device. This technique yields measurement accuracy close to that of a Full SOLT 2-port calibration.

Connect the unmeasured port of your device directly to the analyzer, inserting a 10 dB precision attenuator
between the device output and the analyzer. This improves the effective load match of the analyzer by
approximately twice the value of the attenuator, or 20 dB.
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Resulting Measurement Uncertainty

The following graph illustrates the measurement uncertainty that results from terminating with and

without a precision 10 dB attenuator on the output of the test device.

 
 
 
 
 
 
Legend

  Filter Reflection

------------- Uncertainty with attenuator

................ Uncertainty without attenuator

 

The calculations below show how adding a high-quality 10 dB attenuator improves the load match of

the analyzer.
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Note: The corresponding linear value is shown in parentheses.

Network Analyzer:  

Load match (NALM)  = 18 dB (.126)

Directivity (NAD)  = 40 db (.010)

Filter:  

Insertion loss (FIL)  = 1dB (.891)

Return loss (FRL)  = 16 dB (.158)

Attenuator:  

Insertion loss (AIL)  = 10 dB (.316)

SWR (ASWR)  = 1.05 (.024)

32.26 dB Return Loss

Calculations:

  Without Attenuator With Attenuator

NA

 

= (FIL)*(NALM)*(FIL)

= (.891)*(.126)*(.891)

=.100

= (FIL)*(AIL)*(NALM)*(AIL)*(FIL)

= (.891)*(.316)*(.126)*(.316)*(.891)

= .010

Attenuator NA = (FIL)*(ASWR)*(FIL)

= (.891)*(.024)*(.891)

= .019

Worst Case

Error

(EWC)

NA
=.1

= NA + Attn.

=.01+.019

=.029

Uncertainty

Adds

= -20log(FRL)+(EWC)+(NAD)

= -20log(.158)+(.100)+(.010)

= 11.4 dB

= -20log(FRL)+(EWC)+(NAD)

= -20log(.158)+(.029)+(.010)

= 14.1 dB

Uncertainty

Subtracts

= -20log(FRL)-(EWC)-(NAD)

=-20log(.158)-(.100)-(.010)

= 26.4 dB

= -20log(FRL)-(EWC)-(NAD)

= -20log(.158)-(.029)-(.010)

= 18.5 dB
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Measurement Stability

There are several situations that can cause unstable measurements. To ensure that you are making

repeatable measurements, you can use various methods to create a stable measurement environment.

Frequency Drift

Temperature Drift

Inaccurate Measurement Calibrations

Device Connections

Other topics about Optimizing Measurements

Frequency Drift

The analyzer frequency accuracy is based on an internal 10 MHz frequency oscillator. See Technical
Specifications for stability and aging specifications.

If your measurement application requires better frequency accuracy and stability, you can override the

internal frequency standard and provide your own high-stability external frequency source through the

10 MHz Reference Input connector on the rear panel.

Temperature Drift

Thermal expansion and contraction changes the electrical characteristics of the following components:

Devices within the analyzer

Calibration kit standards

Test devices

Cables

Adapters

To reduce the effects of temperature drift on your measurements, do the following.

Switch on the analyzer 1/2 hour before performing a measurement calibration or making a device
measurement.
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One hour before you perform a measurement calibration, open the case of the calibration kit and take the
standards out of the protective foam.

Use a temperature-controlled environment. All specifications and characteristics apply over a 25 °C ±5 °C
range (unless otherwise stated).

Ensure the temperature stability of the calibration kit devices.

Avoid handling the calibration kit devices unnecessarily during the calibration procedure.

Ensure the ambient temperature is ±1°C of the measurement calibration temperature.

Inaccurate Measurement Calibrations

If a measurement calibration is inaccurate, you will not measure the true response of a device under test. To ensure that your
calibration is accurate, you should consider the following practices:

Perform a measurement calibration at the points where you connect the device under test, that is, the
reference plane.

If you insert any additional accessory (cable, adapter, attenuator) to the test setup after you have performed
a measurement calibration, use the port extensions function to compensate for the added electrical length
and delay.

Use calibration standards that match the definitions used in the calibration process.

Inspect, clean, and gage connectors. See Connector Care.

See Accurate Measurement Calibrations for more detailed information.

Device Connections

Good connections are necessary for repeatable measurements. To help make good connections, do the
following:

Inspect and clean the connectors for all of the components in the measurement setup.

Use proper connection techniques.

Avoid moving the cables during a measurement.
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Noise Reduction Techniques

Random electrical noise which shows up in the analyzer receiver chain can reduce measurement

accuracy. The following features help reduce trace noise and the noise floor which can lead to better

dynamic range and more accurate measurements.

Averaging

IF Bandwidth

Trace Smoothing

See Also

Group Delay

Increase Dynamic Range

Other topics about Optimizing Measurements

Averaging

Averaging is a feature that reduces the effects of random noise on a measurement. There are two types of averaging: Point or
Sweep.

The Point averaging type computes averaging on each data point before stepping to the next data point. You determine the
number of measurements by setting the averaging factor (enabled by clicking the Averaging button). The higher the averaging
factor, the greater the amount of noise reduction.

The Sweep averaging type computes averaging on subsequent sweeps until the required number of averaging sweeps are
performed.

Effects of Sweep Average

Both Averaging and IF Bandwidth can be used for the same benefit of general noise reduction. For minimizing very low

noise, Averaging is more effective than reducing IF bandwidth. Generally, Averaging takes slightly longer than IF bandwidth
reduction to lower noise, especially if many averages are required. Also, changing the IF bandwidth after calibration results in
uncertain accuracy.
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How to Set Averaging

Using Hardkey/SoftTab/Softkey Using a mouse

Press Avg BW > Main > Averaging.1.

Enter the Averaging number.2.

Click Response.1.

Select Avg BW.2.

Select Averaging....3.

Average dialog box help

Average ON   Check to enable Averaging.

Average Factor   Specifies the number of measurements that are averaged. Range of 1 to 65536

(2^16).

Average Type

Sweep  Each data point is based on the average of the same data point measured over consecutive sweeps. When the

number of sweeps = Average Factor, the averaging continues following the Sweep Averaging formula.

(Sweep) Restart   Begins a new set of measurements that are used for the average. Applies only

to Sweep averaging - NOT Point.

Point   Each data point is measured the number of times specified by the Average Factor, and then

averaged, before going to the next data point.  

On subsequent sweeps, averaging is automatically restarted by measuring each data point
again the number of times specified by the Average Factor.

Because measurements occur quickly in the background, the Average Counter is NOT updated.

Notes
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An Average Counter appears on the screen when Sweep averaging is selected, displaying the number of
sweeps that has been averaged. The effect on the signal trace can be viewed as the Average Factor
increases. This can assist in the selection of the optimum number of sweep averages. The Average Counter
is NOT updated for Point averaging.

Channel-wide scope- Averaging is enabled and the factor is set for all measurements in a channel. The
Average counter is displayed for each channel.

Calibration - Because averaging is a mathematical process that occurs after the raw measurement is made,
averaging can be turned ON before or after calibration without invalidating the error correction terms. If
averaging is ON before calibration, the measurement of calibration standards are averaged measurements.
More time is needed to perform the calibration, but there will be less noise in the resulting error correction
terms. Subsequent corrected measurements will also have less noise error. In addition, noise is further
reduced by turning Averaging ON after calibration.

Triggering is implemented separately from Averaging. For example, setting averaging factor to 4 has NO
effect on the number of triggers that are required to achieve 4 sweeps or 4 data points.

Unratioed measurements - Although averaging unratioed (single receiver) measurements is allowed, you
may see unexpected results.

The noise floor does not drop when averaging unratioed measurements as on ratioed measurements.

Phase results may tend toward 0.  This is because phase measurements are relative by nature.
Measuring absolute phase with a single receiver appears random. Averaging random positive and
negative numbers will tend toward 0.

Sweep Averaging Formula

NewAvg = (NewData/n) + [OldAvg*(n-1/n)] 'where n = average factor

From the formula, you can see that data from the first n sweeps continues to be included in the

results of subsequent sweeps. Its effect is increasingly smaller but never diminishes to zero.  For

example, with n = 5, the average of the 5 sweeps is displayed. On the 6th sweep, you see 4/5 the

average of the first 5 sweeps plus 1/5 the new sweep.

The effects of older data can be eliminated by clicking Restart.

Learn more about Averaging (scroll up)

IF Bandwidth

The received signal is converted from its source frequency to a lower intermediate frequency (IF). The bandwidth of the IF
bandpass filter is adjustable from 40 kHz (for most VNA models) down to a minimum of 1 Hz.

Reducing the IF receiver bandwidth reduces the effect of random noise on a measurement. Each tenfold reduction in IF
bandwidth lowers the noise floor by 10 dB. However, narrower IF bandwidths cause longer sweep times.
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Channel - IF bandwidth can be set independently for each channel

Segment sweep - IF bandwidth can be set independently for each segment of segment sweep.

Calibration - Changing the IF bandwidth after calibration will cause a 'C-delta' correction level, which means
that calibration accuracy is uncertain.

Effect of Reducing IF Bandwidth

 

How to set IF Bandwidth

Using Hardkey/SoftTab/Softkey Using a mouse

Press Avg BW > Main > IF Bandwidth.1.

Enter the IF Bandwidth value.2.

Right click on the BW icons on the status bar.1.

Select an IF Bandwidth....2.

IF Bandwidth dialog box help

IF Bandwidth  Specifies the IF (receiver) bandwidth. The value of IF bandwidth is selected by
scrolling through the values available in the IF bandwidth text box. The IF BW is set independently

for each channel.

The following is a list of selectable IF Bandwidths:

10 | 20 | 30 | 50 | 100 | 200 | 300 | 500 | 1k | 2k | 3k | 5k | 10k | 20k | 30k | 50k | 100k | 300k | 600k |

1.2M
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Learn about IF Bandwidth (scroll up)

Trace Smoothing

Trace smoothing averages a number of adjacent data points to smooth the displayed trace. The number

of adjacent data points that get averaged together is also known as the smoothing aperture. You can

specify aperture as either the number of data points or the percentage of the x-axis span.

Trace Smoothing reduces the peak-to-peak noise values on broadband measured data. It smooths trace

noise and does not increase measurement time significantly.

Because Trace Smoothing follows Format in the data processing map, the formatted data is smoothed.

Smoothing is automatically turned off if the format is Polar or Smith Chart.

Learn more about Data Format Types.

See the data processing map.

Tips:

Start with a high number of display points and reduce until you are confident that the trace is not giving
misleading results.

Do not use smoothing for high-resonance devices, or devices with wide trace variations. It may introduce
misleading information.

Smoothing is set independently for each trace.

Effects of Smoothing on a Trace

 

How to set Trace Smoothing

Using Hardkey/SoftTab/Softkey

Press Avg BW > Smoothing > Smoothing ON|OFF.1.
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Smoothing ON  When checked, applies smoothing to the displayed trace.

Percent of Span  Specify percent of the swept stimulus span to smooth. For example, for a trace that

contains 100 data points, and specify a percent of span = 11%, then the number of data points that are

averaged is 11.

Points  Specify the number of adjacent data points to average.

Learn about Trace Smoothing (scroll up)
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Crosstalk

Crosstalk is energy leakage between analyzer signal paths. This can be a problem with high-loss

transmission measurements. Although the crosstalk specification of the analyzer is exceptional, you can

reduce the effects of crosstalk by doing the following:

Set the Sweep to Alternate

Perform an Isolation Calibration

Other topics about Optimizing Measurements

Set the Sweep to Alternate

This selection is no longer available from the user interface. Learn more.

Perform an Isolation Calibration

For transmission measurements, a response and isolation measurement calibration helps reduce

crosstalk because the analyzer measures and then subtracts the leakage signal during the measurement

calibration. The calibration improves isolation so that it is limited only by the noise floor.

Note: Isolation is never performed on a Smart (Guided) Calibration. Learn more.

Generally, the isolation error falls below the noise floor. So when you are performing an isolation

calibration you should use a noise reduction technique such as sweep averages or reducing the IF

bandwidth.

 

207



Effects of Accessories

Accessories in a configuration may affect the results of a device measurement. You can choose

between these analyzer features that reduce ore remove the effects of accessories.

Power Slope to Compensate for Cable Loss

Gating to Selectively Remove Responses

De-embedding a 2-port device (separate topic)

Other topics about Optimizing Measurements

Power Slope to Compensate for Cable Loss

If you have a long cable or other accessory in a measurement configuration where a power loss occurs

over frequency, apply the power slope function. This function increases the analyzer source power by a

rate that you define (dB/GHz).

Press Power > Leveling & Offsets.1.

If the slope function is not already switched on, click the button beside Slope.2.

In the Slope box, enter the rate that you want the source power to increase over the frequency sweep.3.

Gating to Selectively Remove Responses

Gating is a feature in the time domain (option S93010A) that allows the analyzer to mathematically

remove responses. You can set the gate for either a reflection or transmission response, but you will see
different results.

Gating a reflection response isolates a desired response (such as a filter's return loss), from unwanted
responses (such as adapter reflections or connector mismatches).

Gating a transmission response isolates a specific path in a multipath device that has long electrical
lengths.

See Time Domain Gating for more information.
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Speed up PXIe VNA Measurements

The following features can be used together, or separately, to make faster VNA measurements:

Option 103 - Fast sweep mode.

Learn more about the feature.

See the SCPI command.

Use PXI-specific 'Trigger' commands

SCPI command to set index line logic.

SCPI command to efficiently trigger multiple channels.

Shared Memory Data Transfer

See SCPI commands

See Also

General VNA Measurement Speed Techniques
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Achieve Fastest Sweep

You can achieve the fastest measurement sweep by adjusting the following:

Sweep Settings

Noise Reduction Settings

Measurement Calibration Choice

Unnecessary Functions

Other topics about Optimizing Measurements

Sweep Settings

Consider changing each of the following settings as suggested.

Frequency Span - Measure only the frequencies that are necessary for your device.

Segment Sweep - Use segments to focus test data only where you need it.

Switch Off Stepped Sweep - Use linear swept mode to minimize sweep time when possible.

Auto Sweep Time - Use this default to sweep as quickly as possible for the current settings.

Number of Points - Use the minimum number of points required for the measurement.

For more information on how number of points and other settings affect sweep cycle time, see Technical
Specifications.

Noise Reduction Settings

Using a combination of these settings, you can decrease the sweep time while still achieving an

acceptable measurement.

IF Bandwidth. Use the widest IF bandwidth that will produce acceptable trace noise and dynamic range.

Average. Reduce the average factor, or switch Average off.
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Measurement Calibration Choice

Choose the appropriate type of calibration for the required level of accuracy.

When full 2-port error correction is applied, the analyzer takes both forward and reverse sweeps to

gather all 12 error correction terms. This occurs even with a single S11 measurement displayed. All

displayed measurements are updated as the second sweep is performed. Both sweeps are performed

using the specified sweep time.

When calibrating greater than 2 ports, the following formula is used to determine the number of sweeps

required:

N * (N-1) where N = the number of ports.

When full 3-port calibration is applied, 6 sweeps are required; forward and reverse for each port pair.

With full 4-port correction, 12 sweeps are required, and so forth.

To limit the measurement time, perform ONLY the level of calibration that your measurements require.

For example, if making only an S11 measurement, perform a 1-port calibration on that port.

Sweep speed is about the same for uncorrected measurements and measurements done using a response

calibration, or one-port calibration. For more information see Select a Calibration.

Unnecessary Functions

The analyzer must update information for all active functions. To achieve an additional increase in

sweep speed, switch off all of the analyzer functions that are not necessary for your measurement

application.

Delete Unwanted Traces

Switch Off Unwanted Markers

Switch Off Smoothing

Switch Off Limit Testing

Switch Off Math Functions

Analyzer sweep speed is dependent on various measurement settings. Experiment with the settings to

get the fastest sweep and the measurement results that you need.
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Switch Between Multiple Measurements

If you need to make multiple measurements to characterize a device, you can use various methods to

increase throughput. Experiment with these methods to find what is best for your measurement

application needs.

Set Up Measurements for Increased Throughput

Arrange Measurements in Sets

Use Segment Sweep

Trigger Measurements Selectively

Automate Changes Between Measurements

Recall Measurements Quickly

Other topics about Optimizing Measurements

Set Up Measurements for Increased Throughput

To achieve optimum throughput of devices that require multiple measurements, it is helpful to know

the operation of the analyzer. This knowledge allows you to set up the measurement scenarios that are

best for your applications.

Learn more about Traces, Channels, and Windows

Arrange Measurements in Sets

If you arrange measurements to keep the complete set of device measurements in one instrument state,

you can save them so that you can later recall a number of measurements with one recall function.

See Pre-configured Measurement Setups for more information.

Use Segment Sweep

Segment sweep is helpful if you need to change the following settings to characterize a device under

test.
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Frequency Range

Power Level

IF Bandwidth

Number of Points

Delay

Sweep Mode

LO Offset

The segment sweep allows you to define a set of frequency ranges that have independent attributes.

This allows you to use one measurement sweep to measure a device that has varying characteristics.

See Segment Sweep for more information.

Trigger Measurements Selectively

You can use the measurement trigger to make measurements as follows:

Continuously update only the measurements that have rapidly changing data.

Occasionally update measurements that have infrequently changing data.

For example, if you had four channels set up as follows:

Two channels measuring the data that is used to tune a filter

Two channels measuring the data for the out-of-band responses of the filter

You would want to constantly monitor only the measurement data that you use for tuning the filter. If

you continuously update all of the channels, this could slow the response of the analyzer so that you

would not be able to tune the filter as effectively.

Note: You must either trigger the infrequent measurement manually or with remote interface

commands.

 

To trigger measurements selectively:
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This procedure shows you how to set up two different measurements with the following behavior:

Channel 1 measurement will continuously update the data.

Channel 2 measurement will occasionally update the data.

Press Setup > Quick Start.1.

At the Quick Start dialog box, click Create in new channel.2.

Frequency Sweep dialog box shows. Enter the preferred sweep setting.3.

Set Up a Measurement Trigger for Continuous Updates

Press Trigger > Trigger Source and select Internal.1.

Press Trigger > Trigger....2.

At the Trigger dialog box under Channel Trigger State, select Channel 1, and click Continuous.3.

Set Up a Measurement Trigger for Occasional Updates

At the Trigger dialog box under Channel Trigger State, select Channel 2, and click Single, OK.1.

Press Trigger > Restart.2.

Update the Measurement

Click on the lower window to make Channel 2 the active channel.1.

On the active entry toolbar, click the type of trigger you set up.

Click Single if you set up the analyzer for a single sweep per trigger.

Click Groups if you set up the multiple sweeps per trigger.

2.

Note: A trace must be active for you to initiate a trigger for that measurement.

Automate Changes Between Measurements

If there are slight differences between the various measurements that you need to characterize a device,

you may find that it is faster to change the measurement settings using programming.

214



Recall Measurements Quickly

The most efficient way to recall measurements is to recall them as a set of measurements (instrument

state).

It only takes a short time longer to recall an instrument state that includes multiple measurements, than it
does to recall an instrument state with only one measurement.

Each recall function has time associated with it. You can eliminate that time by setting up the measurements
as a set so you can recall them as a set.

See Save and Recall Files for more information.
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Data Transfer Speed

When testing devices remotely using SCPI, the following techniques can be used to transfer data

quickly between the analyzer and remote computer, helping you achieve the best measurement

throughput.

Use single sweep (trigger) mode to ensure that a measurement is complete before starting a data transfer.

Transfer the minimum amount of data needed. For example, a trace with a few points, using segment
sweep rather than a full trace with many linearly spaced points. Also, use markers instead of trace transfers.

Choose the REAL data format to provide the fastest transfer speed when using SCPI programs for
automated applications.

Use SCPI over LAN for applications that are automated with SCPI programs.

Use Shared Memory Data Transfer. Learn how.

Other topics about Optimizing Measurements

216



Using Macros

Macros are executable programs that you write, load into the analyzer, and then run from the analyzer.

You can have up to 25 macros set up to run on the analyzer.

How to Setup Macros

How to Run Macros

Macro Example

How to Setup Macros

Using Hardkey/SoftTab/Softkey

Press Macro > Key Setup > Macro Setup....1.

In the Macro Setup dialog box:

Create an executable program and save it on the VNA hard drive. See SCPI or COM example programs in
VBscript.

1.

Use a mouse or the front-panel 'down-arrow' to select a blank line below the last entry. (There may be NO
entry.)

2.

Click Edit to start the Edit Macro Setup dialog.3.

In the Macro Title box, type a descriptive title for your macro.4.

Click Browse.5.

Change Files of Type.6.

Find and select your executable file. Change Files of Type if necessary.7.

Click OK on the Edit Macro Setup dialog.8.

Click OK on the Macro Setup dialog.9.

Press MACRO to run. It may be necessary to first Preset the VNA to see your macro in the menu.10.
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Macro Setup dialog box help

Macro setup allows you to create up to 25 macros that can be launched from the VNA application.

An external keyboard is required to enter the Macro Title and the Run string parameters.

To add a Macro, use a mouse or the front-panel 'down arrow' (NOT the 'Down' key) to select a

blank line. Then click Edit.

Macro Title  Shows the titles that appear in the softkeys and menu when you press the Macro key.

These titles are associated with the executable files and should be descriptive so you can easily

identify them.

Macro Executable  Lists the complete path to the executable file. To follow the example of

launching the Keysight VNA Series Home Page, the path to the executable could be "C:/Program

Files/Internet Explorer/iexplore.exe.

Macro Runstring Parameters  Lists the parameters that get passed to the program that is

referenced in the executable file. Again following the example of launching the VNA Series Home

Page, you could assign the runstring parameters "http://www.Keysight.com/find/pna".

Edit  Invokes the Macro Edit dialog box.

Delete  Deletes the selected macro.

Up  Allows you to reorder the macros, moving the selected macro up one line. This order

determines how they appear in the VNA Menu and in the softkeys and when you press the Macro

front-panel key.

Down  Moves the selection down one line in the list of macros.
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Macro Edit dialog box help

Macro Title  Add a title that appears in the softkeys and menu.

Macro Executable  Set the complete path to the macro executable file. Click Browse to navigate to

the macro executable file and establish the complete path to the file.

Macro run string parameters  Optionally add parameters that are passed to the program

referenced in the executable file.

See Macro Setup dialog box

 

How to Run Macros

Using Hardkey/SoftTab/Softkey

Press Macro > Macro<#>.1.

Macro Example

The following is an example Visual Basic Scripting (vbs) program that you can copy, install, and run
on your VNA.

Note: Print these instructions if viewing in the analyzer. This topic will be covered by the Macro Setup

dialog box.

Copy the following code into a Notepad file.1.

Save the file on the analyzer hard drive in the C:/Documents folder. Name the file FilterTest.vbs2.

Close Notepad3.

Setup the macro in the VNA4.
5.
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3.

4.
Run the macro5.

'Start copying here
'This program creates a S21 measurement
'It is written in VBscript using SCPI commands

Dim app
Dim scpi
'Create / Get the VNA application
Set app = CreateObject ("AgilentPNA835x.Application")
Set scpi = app.ScpiStringParser

'Preset the Analyzer.FPREset presets the setting and deletes all traces and windows
scpi.Execute ("SYST:FPReset")
'Create and turn on window 1
scpi.Execute ("DISPlay:WINDow1:STATE ON")
'Define a measurement name, parameter
scpi.Execute ("CALCulate:PARameter:DEFine:EXT 'MyMeas', 's21'")
'Associate ("FEED") the measurement name ('MyMeas') to WINDow (1), and give the new
TRACE a number (1).
scpi.Execute ("DISPlay:WINDow1:TRACe1:FEED 'MyMeas'")

'End copying here
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System Power Calibration (M9485A)

Overview

The system power calibration is required after the configuration setup for M9485A. After you installed

all modules, the system power calibration should be executed once.  The calibrated data is stored in

your PC with your configuration.  It is valid unless the configuration is changed. The purpose of

calibration and procedure are different depending on the receiver module. This feature is available only

on the M9485A.

M9376A

Purpose

Calibrate the source power level and linearity at the test ports.

Calibrate the source power for the parallel measurements.

Procedure

Calibration for power level only.

M9377A Direct Access Receiver configuration

Purpose

Calibrate the source power level and linearity at the M9377A source output ports.

Procedure

Calibration for power level only.

Combination of M9377A and M9378A

Purpose

Calibrate the source power level and linearity at the test ports.

Acquire 1 port error term.

Procedure

Calibration for power level, S parameters and absolute measurement parameters.
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In the procedure, one port is assigned as a reference port. The port is calibrated with a power

sensor, then the other ports are calibrated with the reference port. If your configuration has

any M9376As, the lowest number port of M9376A is assigned as the reference port. If your

configuration has sets of M9377A and M9378A only, two ports are assigned as reference

ports with the following priority (standard configuration, Wide Dynamic Range

configuration, High Power configuration, High Gain configuration).

Note: Error Terms of cal set does not include the error terms of both M9377A and

M9378A after user calibration.

Notes

Setting User Preset file is highly recommended when your configuration includes M9377A

and M9378A modules. This can avoid occurring power unleveled error after every boot up.

Procedure

When you restart the firmware, set start frequency and initial power level properly.

Then use the setting as “User preset status” from Preset > User Preset…, and select

Save current state as User Preset and check User Preset Enable.

Typical setting for each configuration:

Configuration / Start frequency / Power

STD / 50 MHz / 0 dBm

DA / 50 MHz / 0 dBm

WDR / 500 MHz / -15 dBm

HP / 50 MHz / -30 dBm

HG / 500 MHz / -35 dBm

Procedure

Required Equipment

50 Ù Termination (A 50 Ù Termination is equipped on the IF Out connector on M9376A and ATT out
connector on M9378A at factory shipment. ) (This is optional for M9377A Direct Access Receiver
configuration)
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Power Sensor and Power Meter (Supported Power Meters, excepts 437B/438A) and a cable about 50
cm/20 inch for connection (This is optional for M9376A)

Mechanical Calibration Kits or ECal (3.5mm, frequency range:1 M to 9 GHz) (This is required for a
combination of M9377A/M9378A.)

Using Hardkey/SoftTab/Softkey

Wait 45 minutes after power on for warm up1.

When a power sensor is used, execute the power sensor zeroing and calibration.2.

Confirm if the HiSlip is enabled and address is set at 0 by clicking System > System Setup... > Remote
Control....

3.

Press System > Service > System Power Cal....4.

When your configuration does not include any M9377As:

Click Ok1.

Follow the instruction to complete the calibration.2.

The calibration takes about 30 to 40 minutes depending the installed module configuration.3.

Software Front Panel must be restarted after the calibration is done.4.

When your configuration includes M9377A:

 Click Calibration button.1.

The System Power Calibration Dialog is displayed.2.

Confirm the installed module and port configuration for M9377A/M9378A. If the port configuration
change is required, click Edit Config. button.

3.

The required equipment is shown in the dialog.4.

Follow the instruction to complete the calibration.5.

The calibration takes about 30 to 50 minutes depending the installed module configuration.6.

Software Front Panel must be restarted after the calibration is done.7.

Note: If the system power calibration is aborted, restart the Software Front Panel.
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When the system power calibration and port configuration (for M9377A/78A) is not performed on the

current configuration, the one of following messages is displayed at power on.

Set configuration using Port config wizard. Port config data is not found and typical data of DA

config is used.

Port conifig data was found but corresponded system power cal file is not found. Typical system

power cal data is used.

When the configuration is changed such as the module is replaced, this message will be displayed again

and required to execute port configuration and system power calibration.
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Select a Calibration Type

The following calibration types are available in the VNA.

Cal Type Interface Accuracy Thru Methods allowed

TRL Family Both Very High All except Unknown Thru

SOLT Both High All

Enhanced Response SmartCal High Defined Thru or Flush Thru

QSOLT (Quick SOLT) SmartCal Medium Defined Thru or Flush Thru

1-Port Reflection Both High Not Applicable

Open/Short Response Unguided Low Not Applicable

Thru Response Unguided Low Known Thru or Flush Thru

Learn how to select a default Cal Type.

Other Cal Types (Separate Topic)

Source and Receiver Power Cals

See other Calibration Topics

TRL Family

Application: Used to accurately calibrate any pair of ports when calibration standards are not readily available.

Note: A Delta Match Cal may be required.

•  Learn more about TRL family cal
•  For more information on modifying standards, see Calibration Standards.

Calibration Method: SmartCal, Unguided Calibration

General Accuracy: Very High

Standards Required: THRU, REFLECT, LINE or similar combination

Systematic Errors Corrected:
•  Directivity
•  Source match
•  Isolation (see exceptions)
•  Load match
•  Frequency response transmission tracking
•  Frequency response reflection tracking
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SOLT

Application: Used to accurately calibrate any number of ports.

General Accuracy: High

Calibration Method: SmartCal, Unguided Calibration, ECal

Standards Required: (SHORT, OPEN, LOAD, THRU) or ECal module

Systematic Errors Corrected (on all ports):
•  Directivity
•  Source match
•  Isolation (see exceptions)
•  Load match
•  Frequency response transmission tracking
•  Frequency response reflection tracking

 

Enhanced Response

Application: Used to calibrate two ports when only measurements in one direction (forward OR reverse) are
required. Measurements are faster because a second sweep is NOT required.
•  Reflection Standards (OPEN, SHORT, LOAD) are connected to the source port to be calibrated.
•  Defined THRU or Flush THRU standard is connected between port pairs.

•  Much quicker than SOLT when using a mechanical cal kit. ECal can also be used.

To select Enhanced Response:

For a standard S-parameter Cal, select Cal > Main > Basic Cal....

Then, In the Basic Cal dialog box:

Under 'Cal Type', select Enh Response 1-> 2 Enh or Response 2-> 1.1.

General Accuracy: High

Calibration Method: SmartCal, ECal

Standards Required: (SHORT, OPEN, LOAD, Defined THRU or Flush THRU)

Systematic Errors Corrected:
•  Directivity (source port)
•  Source match (source port)
•  Isolation (see exceptions)
•  Load match (receiver port) - used only to produce transmission tracking term.
•  Frequency response transmission tracking (receiver port).
•  Frequency response reflection tracking (source port).
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QSOLT (Quick SOLT)

Application: Used to quickly calibrate any number of ports. Developed specifically for use with external
multiport test sets.

Note: A Delta Match Cal is required to cal test ports that do not have a dedicated reference receiver.

•  Reflection Standards (OPEN, SHORT, LOAD) are connected to only ONE of the ports to be calibrated. The
lower port number of the ports to be calibrated is selected by default. This can be changed through the Modify
Cal / Cal Type setting.
•  Defined THRU or Flush THRU standards are connected from the reflection standard port to the remaining ports to be
calibrated.

•  Much quicker than SOLT when using a mechanical cal kit.
•  Based on TRL math.

General Accuracy: Not as high as SOLT

Calibration Method: SmartCal, ECal

Standards Required: (SHORT, OPEN, LOAD, Defined THRU or Flush THRU)

Systematic Errors Corrected:
•  Directivity
•  Source match
•  Isolation (see exceptions)
•  Load match
•  Frequency response transmission tracking
•  Frequency response reflection tracking

 

1-Port (Reflection)

Application: Used to accurately calibrate any single test port for reflection measurements only.

Calibration Method: SmartCal, Unguided Calibration, ECal

General Accuracy: High

Standards Required: (SHORT, OPEN, LOAD) or ECal module

Systematic Errors Corrected:
•  Directivity
•  Source match
•  Frequency response reflection tracking
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Open / Short Response

Application: Used to quickly calibrate any single test port for reflection measurements only.

Calibration Method: Unguided Calibration

General Accuracy: Low

Standards Required: OPEN or SHORT

Systematic Errors Corrected:
Frequency response reflection tracking

 

Thru / Transmission Response (Isolation Optional)

Application: Used to quickly calibrate any pair of test ports for transmission measurements only.
Isolation is not usually recommended. Learn more about Isolation

Calibration Method: Unguided Calibration and Guided Cal from the 'Select DUT Connectors page', check
Modify Cal, then click Next.

General Accuracy: Low

Standards Required: THRU

Isolation: One LOAD for each VNA test port.

Systematic Errors Corrected:
•  Frequency response transmission tracking
•  Isolation
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Calibration Thru Methods

What is a Non-Insertable Device

Choosing a Thru Method

Flush Thru

Adapter Removal

Swap Adapters and Offset Delay (separate topic)

Defined Thru

Unknown Thru

ECal Thru Method Choices

Other Cal Topics

What is a Non-Insertable Device

To understand the Thru method choices, you must first understand what is meant by "Non-Insertable

device". These definitions also apply to ECal modules. Substitute "ECal module" for "device". Then

see ECal Thru Method Choices.

A non-insertable device is one whose connectors could NOT mate together. They either do not have

the same type of connector or they have the same gender. This also means that the test port cables

would not mate together, as in the following diagram.
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An insertable device is one whose connectors could mate together. They have the same type of

connector and opposite,or no, gender. This also means that the test port cables would mate together, as

in the following diagram.

 

Choosing a Thru Method of Calibration

The Thru method is selected from the Cal Wizard. Select the  Modify checkbox in the Select DUT
Connectors and Cal Kits dialog box.

Notes:

For ECal, the following choices have different meanings. See THRU methods for ECal.

For 4-port calibration, see How can we measure only 3 THRU connections?

Choice for Insertable Devices: FLUSH Thru (also known as Zero-length Thru)

When calibrating for an insertable device, the test ports at your measurement reference plane connect

directly together. This is called a zero-length THRU, or Flush THRU meaning that the THRU standard

has zero-length: no delay, no loss, no capacitance, and no inductance. Your calibration kit may not

have a physical THRU standard because it is assumed you have an insertable device and will be using a

zero-length THRU.

Choices for Non-Insertable Devices

The following methods calibrate for a non-insertable device:

Adapter Removal  Accurate, but least convenient.

Defined Thru

Unknown Thru Cal  Preferred method.
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Adapter Removal Calibration

The accuracy of the Adapter Removal calibration is very similar to the accuracy of the Unknown Thru

calibration. However, the Unknown Thru calibration has fewer connections and therefore has the

potential of being more accurate than the Adapter Removal calibration.

Two full 2-port calibrations are performed: one with the adapter connected at port 1, and the other with

the adapter connected to port 2. The result of the two calibrations is a single full 2-port calibration that

includes accurate characterization and removal of the mismatch caused by the adapter.

Performing an Adapter Removal Cal requires:

a THRU adapter with connectors that match those on the DUT.

calibration standards for both DUT connectors.

To select Adapter Removal during a SmartCal, select the  Modify checkbox in the Select DUT
Connectors and Cal Kits dialog box. The Cal Wizard will guide you through the steps.

Learn how to perform an Adapter Removal Cal using ECal.

Defined Thru (also known as Known Thru, Cal Kit Thru, ECal Thru, Characterized Thru)

Defined Thru uses the THRU definition that is stored in the Cal Kit file or ECal module. The THRU

standard may have worn over time, making it not as accurate as when it was new. Defined Thru is

usually more accurate than Adapter Removal, but not as accurate as Unknown Thru method.

Notes

If performing an ECal, this is the THRU standard in the ECal Module.

If Defined Thru appears as a potential THRU method in the SmartCal Wizard, this means that there is a
defined THRU standard in the selected Cal Kit. This could be a Zero-length Thru. The SmartCal Wizard
will prompt you to connect the required standard when appropriate.

To define a THRU standard in a Cal Kit (not ECal module):

Click Cal > Cal Sets & Cal Kits.1.

Click Cal Kit....2.

Select the Cal Kit from the list.3.

Click Edit....4.

5.

6.
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4.

Select the Standards tab.5.

Click Add....6.

Select THRU.7.

Complete the dialog box.8.

The next time you perform a Guided Cal, this Defined THRU standard will be available if the DUT

connector types match the THRU standard.

Unknown Thru Cal

Unknown Thru Cal is the preferred THRU method of calibrating the analyzer to measure a non-

insertable device.

The Unknown Thru calibration is also known as Short-Open-Load-Reciprocal Thru (SOLR)

calibration.

Very easy to perform.

Better accuracy than Defined Thru and usually better than Adapter Removal.

Does not rely on existing standard definitions that may no longer be accurate.

Causes minimal cable movement if the THRU standard has the same footprint as the DUT. In fact, the DUT
can often BE the THRU standard.

NOT recommended when there is 40 dB or more of combined loss in the Unknown Thru and calibration path.
This would NOT allow enough signal to accurately measure at the receiver.

About the Unknown Thru Process

SmartCal guides you through the process. Although the following process describes ports 1 and 2,
Unknown Thru can be performed on any two ports when using a multiport analyzer.

Perform 1-port cal on port 1.1.

Perform 1-port cal on port 2.2.

Connect Unknown Thru between ports 1 and 2.3.

Measure Unknown Thru.4.

Confirm Estimated Delay. This estimate may be wrong if there are too few frequency points over the given
frequency span. You can measure the delay value independently and enter that value in the dialog box.

5.
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5.

The Unknown Thru Standard

Can have up to 40 dB of combined loss in the Unknown Thru and calibration path.

Must be reciprocal: S21=S12.

Must know the phase response to within 1/4 wavelength (see step 5 above).

Can be the DUT if it meets these conditions.

Unknown Thru Limitations

Unknown Thru is NOT supported during a TRL calibration from the GUI.

Cable movement introduces measurement errors.

ECal Thru Method Choices

When the ECal module connectors exactly match the DUT connectors, choose from the following

THRU methods:

ECal Thru as Unknown Thru   Learn more about Unknown Thru.

Measures the THRU state of the ECal module as an Unknown Thru.

The default method when the ECal module connectors match the DUT.

Very accurate and easy.

Flush Thru (zero-length Thru)   Learn more about Flush Thru

Requires an insertable ECal module / DUT.

Remove the ECal module and connect the two reference planes directly together for a zero-length thru.

Accurate, but not as easy as 'ECal Thru as Unknown Thru'.

ECal (Defined Thru)

Measures the THRU state of the ECal module.

Very easy, but not as accurate as 'ECal Thru as Unknown Thru'
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Unknown Thru

Remove the ECal module.

Then connect a Thru adapter to be measured as Unknown Thru.

 

When the ECal module connectors do NOT exactly match the DUT connectors, choose from the

following two methods:

Adapter Removal

Can be used with ECal when your DUT is NON-insertable. However, the ECal module MUST be insertable,
and the adapter connectors must exactly match the connectors of the DUT as in the following diagram.

Adapter removal performs 2-port measurements on both sides of the adapter.

ECal User Characterization

In cases when adapter removal cannot be performed, ECal User Characterization is ALWAYS possible if

you have the right adapters. A User Characterization is performed once and stored in the ECal module.
However, accuracy is compromised every time you remove, then reconnect, the adapter with the ECal

module.
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Calibration Wizard

The Calibration Wizard allows you to choose a Calibration method and then perform the calibration.

How to Start Calibration Wizard

SmartCal (Guided Calibration)

Basic Calibration

Unguided Calibration

Saving a Calibration

Other Cal Topics

How to start Calibration Wizard

Using Hardkey/SoftTab/Softkey

Press Cal > Other Cals > Smart Cal....1.

 

The Calibration Window / Channel

During a Guided Calibration, a 'Cal Window' is created for you to view the connection of

calibration standards before standards are measured. This Cal Window uses a new Cal channel that

is created and duplicates the settings in the channel being calibrated.  Correction is ALWAYS OFF for
the displayed calibration channel. At the completion of the calibration, the calibration channel and

window are deleted.

The measurement of calibration standards can be performed while viewing any VNA window

configuration you choose. The Cal Window is appended to your Custom Cal Window setting, and

all windows are visible and sweeping below the Cal Wizard before the Measure (cal standard)

button is pressed. The windows to be viewed and channels to be swept during the cal process are

specified using Remote commands. See an example.

SmartCal (Guided Calibration)
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A Guided Calibration automatically determines the calibration type and suggests a calibration kit that

matches your DUT connectors.

Guided Calibration can perform the following Cal Types:

ALL Cals EXCEPT Open, Short, and Thru Response Cals.

ECal on one or more ports.

TRL - Learn how to do TRL cals

Note: SmartCal DOES allow you to measure calibration standards in any order. However, you must

click Next and Back without measuring standards until you get to the standard you want to measure.

The following dialog boxes appear when performing a Guided calibration on standard channels.

Select Ports for Guided Calibration dialog box help

Allows you to select ports to calibrate.

Cal Type Selection  Select the number of ports to calibrate.

N Port Cal Configuration  If not calibrating all ports, specify which ports to calibrate.

Show Advanced Settings (Orientation & Thru Cal Section)  Available only for ECal.

Back  Return to Cal Wizard Begin dialog.

 

Select DUT Connectors and Cal Kits dialog box help

Allows you to select the connector type and Cal Kit for each DUT port to be calibrated.

Connectors  To change selection, click the connector field for each DUT port.

If your DUT connectors are not listed, you can create your own connector type and calibration kit
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file. The VNA includes the following example cal kits  that can be used as a template. See

Calibration kits for more information.

If using a gendered (male and female) connector type, select Type A as the connector type.

If using a connectorless device such as on-wafer probes., select Type B as the connector type.

Cal Kits  Select the Cal Kit to be used to calibrate each test port. The list for each DUT Port

displays kits having the same connector type as the DUT.

Identical ECal models connected?  ECal modules can be distinguished by serial number. This can

have implications on your remote SCPI programs.

Cal Kit Notes

85056K

The 85056K definitions in the analyzer are for 2.92mm standards (2.4mm plus 2.92 adapters).

To calibrate 2.4 mm connectors using the 85056K cal kit, select 85056A as the cal kit when you

need the sliding load. Otherwise, select 85056D as the cal kit. Both the 85056A and the 85056D

kits contains exactly the same standards as the 85056K cal kit WITHOUT the adapters.

TRL

To perform a TRL Cal, assign a TRL Cal Kit to the lowest port number of each port pair.

Modify Cal  Check, then click Next, to Modify Cal (Standards AND Thru Method).
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Error dialog box help

The current cal kit does not cover the current frequency range of the measurement. Do one of the

following to correct the problem:

Cal Kit Class Category  Choose from SOLT and TRL. Not available with ECal modules. Click

Edit to modify the appropriate class assignments.

Frequency  Change the frequency range of the active channel.

Edit  Modify the class assignments so that a different standard is selected.

Back  Select a different Cal Kit that covers the required frequency range.

Cancel  Exit the Cal Wizard

 

Modify Cal dialog box help

Thru #n

Lists the proposed Thru connections to be made during the calibration process. You can change

these Thru connections to better suit your test setup.

The proposed Thru connections are listed automatically.

Additional Thru connections can be selected for higher accuracy. Learn more.
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Add Thru

Click to add a Thru connection. Learn more

Remove Thru

Select a Thru by clicking the "Thru #N" field or the "1st Port / 2nd Port" field. Then click "Remove

Thru". This selection is NOT available if the selected Thru is required for the calibration.

1st Port / 2nd Port

Click to select the two ports to be included in the Thru connection. The order of the port numbers is

not critical.

Thru Cal Method

Lists the available Thru Cal methods for the specified port pairs.

Learn about the Thru Cal Method choices.

Cal Type/ Stds

Click to invoke the View / Modify Properties of Cal dialog box

Do orientation - Appears ONLY if an ECal module is selected for use.

When this box is checked (default) the analyzer automatically senses the model and direction in

which an ECal module port is connected to the test ports. If power to the ECal module is too low, it

will appear as if there is no ECal module connected. If you use low power and are having this

problem, clear this check box to provide the orientation manually.

Orientation occurs first at the middle of the frequency range that you are calibrating. If a signal is

not detected, it tries again at the lowest frequency in the range.

View/Detect ECal Characterizations - Appears ONLY if an ECal module is selected for use.

Click to invoke the View ECal Modules and Characterizations dialog box. Displays a list of connected

ECal modules.
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View/Modify Properties of Cal for Ports... dialog box help

Select calibration type

Another chance to change the Thru method.

Learn about the Thru Cal Method choices.

Advanced

Select the cal method for each connector of the Thru pair.

TRL - Available ONLY when a TRL cal kit was selected for the lowest port number of the

port pair.

QSOLT  Available ONLY when "Defined Thru" or "Flush Thru" is selected. "QSOLT 2 <=

1" refers to the receive port 2 and source port 1(where reflection standards are connected).

Enhanced Response  Available ONLY when "Defined Thru" or "Flush Thru" is

selected."EnhResp 2 <= 1" refers to the receive port 2 and source port 1.

Transmission Response  Available ONLY when "Defined Thru" or "Flush Thru" is selected,

when Mechanical Cal is selected, and when 2 ports are being calibrated. "TransResp 2 <=

1" refers to the receive port 2 and source port 1.

View Modify  Click to invoke the Preview and Modify Calibration Selections dialog box.

Note: Changes made to the Cal Kit through this dialog are temporary that last only for this

calibration. To make permanent changes to the Cal Kit, perform Advanced Modify Cal Kits.
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Calibration Steps dialog box help

Note: Calibration can be performed with External triggers. Learn more.

As each new cal step prompt appears, the traces are setup for the next standard measurement. Also,

sweeps are triggered continuously until the Measure button is pressed. This way you can view the

integrity of the standard connection.

Prompts for standards to be measured.

Measure  Click to measure the standard.

Done  Click after a standard is re-measured and all measurements for the calibration are

complete.

Next  Click to continue to the next calibration step. Does NOT measure the standard.

If a standard is NOT measured, a warning appears and Done will not be available after the last Cal

step.

Note: Smart (Guided) Cal allows you to measure calibration standards in any order. However, you

must click Next and Back without measuring standards until you get to the standard you want to

measure.

 

Sliding Load Measurement dialog box help
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Allows you to measure the sliding load standard.

To Measure a Sliding Load:

Connect the sliding load to the measurement port following the procedure described in the

Calibration Kit User’s and Service Guide.

1.

Note: Do NOT set the center conductor to be an interference fit with the center conductor of

the testport.

Position the sliding element, then click Measure. Do not move the sliding element until

measurement is complete.

2.

Note: The direction in which the slide moves is NOT important. You can start with the slide

at the front and move it backward or start at the back and move it forward. To minimize

stability errors it is important to start at one end and move it in the same direction for each of

the measurement steps.

Measure the sliding load for at least five positions for best accuracy.3.

Note: The positions of the sliding element should cover the full length of the slide, but be

unequally spaced to reduce the possibility of overlapping data points. Most sliding loads have

marks for each slide position.

Click Done after the final measurement.4.

Disengage sliding load lock (if available), and remove sliding load from the measurement

port.

5.

Measure the remaining standards.6.

How to Verify Sliding Load Calibration Measurements

Once the calibration is completed, the sliding load can be measured again. The magnitude of the

return loss should remain nearly constant as the slide is moved. If the slide spacing was not

adequate due to slide position selections, there will be frequency ranges where the magnitude will

not remain nearly constant.
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Specify delay dialog box help

This dialog appears ONLY when Adapter Removal or Unknown Thru calibrations are performed.

The following values were estimated from the measurement. Most of the time, they are adequate.

However, for CW sweep or frequency sweep with large step sizes, the accuracy of the values may

be improved.

Adapter delay  To improve this value, measure and record the delay of the adapter with a dense

step size. Enter that value here. The required precision value is the accuracy that is required to

characterize the delay value.

Nominal phase offset  (Waveguide ONLY). To improve this value, measure and record the phase

offset of the Waveguide adapter with dense step size. Enter that value here.

When one connector is coax and the other connector is waveguide, the phase offset has an

ambiguity of 180 degrees. For consistency, the estimate provided here is always between 0 and 180

degrees. You can change this estimate to any value between -180 degrees and +180 degrees.

 

The Calibration Complete dialog box appears after all standards are measured.

Basic Calibration

Basic Calibration

Using Hardkey/SoftTab/Softkey

Press Cal > Main > Basic Cal....1.

 

It provides basic calibration. The limitations of basic calibration are:

one connector type
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one cal kit

one cal type

no isolation cal

no power calibration

Basic Cal dialog box help

Connector Type Allows user to select single connector type.

Cal Kit Allows users to select single Cal Kit. The displayed selection options are according to the

selected connector type.

Port  Allows users to select the port gender. No Connect indicates that no port is connected to the

VNA.

Cal Type Allows users to select calibration type. The displayed selection options are according to

the selected cal kit, connector type and gender.

 

Save As Calset... Its grayed out when calibration is incomplete. Once the calibration is completed,

press this button to save the calibration.
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Unguided Calibration

Note: Unguided Calibrations are NOT available in M948xA and E5080A.

Unguided Calibration

Using Hardkey/SoftTab/Softkey

Press Cal > Main > Other Cals > Response Cal....1.

 

The following dialog boxes appear when performing an Unguided calibration:

Select Calibration Type for Mechanical Standards dialog box help

Unguided calibration does NOT support cals greater than 2 ports or ECal calibrations.

Calibration Type Selection

2-Port SOLT

1-Port SOL

TRL - Learn more about TRL

Response - Reflection and Thru (if the active measurement is transmission)

Cal Configuration  If not calibrating all test ports, specify which ports to calibrate.

Back  Return to Cal Wizard Begin dialog.

View/Select Cal Kit  Click to invoke the Select Cal Kit dialog box.

Note:  When selecting a Cal Kit with an impedance other than 50 ohms (Waveguide = 1 ohm), it is
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NO LONGER NECESSARY to change the System Impedance setting before performing a

calibration. The impedance for the calibration is now derived from the Cal Kit impedance.

Next  Click to continue to Measure Mechanical Standards dialog box.

 

Select Cal Type dialog box help

This dialog box appears ONLY when the selected Cal Type is TRL in the previous dialog box.

TRL Reference Plane  Select which standard to use to establish the position of the measurement

reference plane.

THRU Standard  Select if the THRU standard is zero-length or very short.

REFLECT Standard  Select if the THRU standard is not appropriate AND the delay of the

REFLECT standard is well defined.

TRL Impedance

LINE Standard  Specifies that the characteristic impedance of the LINE standard should be used

as the system impedance.  This ignores any difference between Offset Z0, Offset Loss, and

System Z0.

SYSTEM Impedance  Transforms the LINE standard impedance and loss to that of the system

impedance for use with the calibration error terms. The TRL calibration will first compute the

error terms assuming the LINE standard impedance is the system's characteristic impedance (same

as previous LINE selection), then modify the error terms to include the impedance transformation.

This should only be used with coax since the skin effect model used is a coaxial model.

Learn how to change System Z0.

To learn to substitute other calibration kits, see Advanced Modify Cal Kits
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Select Cal Kit dialog box help

Displays the calibration kit files available for Unguided calibration. Select the desired calibration kit

file and click OK.

Choose class type

Edit Class Assignments  Allows modification of the selected Cal Kit class assignments.

To learn to substitute other calibration kits, see Advanced Modify Cal Kits

Unguided Cal can access only mechanical cal kits #1 through #95, although more cal kits can imported.
Learn how.

Note: When selecting a Cal Kit with an impedance other than 50 ohms (Waveguide = 1 ohm), it is

NO LONGER NECESSARY to change the System Impedance setting before performing a

calibration. The impedance for the calibration is now derived from the Cal Kit impedance.

 

Measure Mechanical Standards dialog box help

Note: Calibration can be performed with External triggers. Learn more.

Displays the calibration kit file and standards required for the calibration.

Standards may be connected and measured in any order.
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Connect the standard to the measurement port and click its associated green button. A check mark
indicates the standard has been measured.

If a standard type contains multiple standards, the Multiple Standards dialog box opens to display the
multiple standards included in the calibration kit file.

If a sliding load is included in the calibration kit file, the Sliding Load dialog box opens to perform the
measurement with the standard.

Reflection Response  Select EITHER Open or Short standard, then click Next.

Isolation  Requires one load for each test port. Learn more about Isolation.  Use when your
measurement requires maximum dynamic range (> 90 dB). See also Isolation Portion of 2-Port
Calibration.

Normalize  Available when performing a response cal for any measurement. After Normalize is pressed
and the Cal is complete, the data trace is flat when the same physical connections are present on the
port. This is similar to Data/Memory, except that the response cal is saved with Cal data and can be
applied to other like measurements. Data/Memory is still available after using Normalize. You would
usually connect a THRU standard when calibrating a transmission measurement, and a SHORT standard
when calibrating a reflection measurement.

Show Prompts  Check to provide a reminder for the required connection when you click on the

standard.

 

Multiple Standards dialog box help

Select the standards to be measured.

Note:  You may see both male and female standards. The Unguided cal has no knowledge of the

gender of your connector types. Choose the gender of your DUT connector; NOT the test port.

Then click OK.

To modify this calibration class to show only one standard, on the Calibration menu, click

Advanced Modify Cal Kits. Select the Cal kit and click Edit Kit. In Class Assignment, click

Edit. Learn more about Modify Calibration Class Assignments.

Connect the standard to the measurement port and click its associated button. A check mark in the
Acquired box indicates the standard has been measured.
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To cover the entire frequency range, you may need to measure more than one standard. The order in
which the standards are measured is important. The last standard that is measured will override the
others in respect to the frequency range of the standard definition. Example: In the case of measuring
both a broadband load and a sliding load, you would measure the sliding load last. This is because the
frequency range of the sliding load is a subset of the broadband load.

Saving a Calibration

SmartCal, ECal, and Unguided Calibrations end with the following dialog box:

Calibration Completed dialog box help

Finish  Save to the channel's calibration register.

Save As User Cal Set  Invokes the Save as User Cal Set dialog box AND save to the channel's

calibration register.

Cancel  Calibration is NOT applied or saved.

Learn about Calibration Registers.

Learn about User Cal Sets
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Save as User Cal Set dialog box help

Existing Cal Sets  - Lists the previously-saved Cal Set names.

Select Cal Set from list or type new name below  Specify a name for the new Cal Set. Either

accept the suggested new name, type a new name, or select a name from the list to overwrite an

existing name.

Edit Name  If there is no keyboard, click to start the typing tool that can be used from the front

panel.

Save  Saves the Cal Set to the new Cal Set name.

Learn about User Cal Sets
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Calibrate All Channels

"Cal All" allows you to calibrate multiple channels in a single calibration session.  This not only

reduces the number of connections that need to be made, but also the number of cal standard

measurements that must be performed.

In this topic:

Features

Limitations

How to perform a Cal All Channels Calibration

Select Channels dialog

Measurement Class Cal Properties dialog

Calibration Attenuator Settings dialog

Select DUT Connectors and Cal Kits dialog

Power Cal Settings dialog

Cal Steps dialog

Finish

Other Cal Topics

Features

Cal All offers a single, optimized calibration procedure for all channels (with some limitations, see

below).  The optimizations include:

Minimizing the number of physical connection of standards.

Minimizing the number of power meter calibration sweeps.

User-settable power levels for S-Parameter as well as power calibration steps.

Accounting for different switch and attenuator settings among different channels. This reduces the number of
measurements required to characterize different switch/attenuator settings (channel setup differences).
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Cal All will produce the same number and format of Cal Sets (error terms) that would be realized had the
calibrations been performed one at a time.

Calibrate External Sources that are connected to the analyzer using Configure an External Source.

Limitations

Cal All is performed at one IFBW.

All channels that are calibrated are forced into stepped sweep mode.  

All channels to be calibrated MUST have the same cal reference plane. In other words, Cal All cannot
compensate for any path changes that occur external to the analyzer.

How to perform a Cal All Channels Calibration

Using Hardkey/SoftTab/Softkey

Press Cal > Other Cals > Cal All....1.

 

Selected Channels dialog box help

Check the channels to be calibrated.1.

Check the ports to be calibrated. Click on the Apply to all channels button to apply the port selections to
all channels.

2.

3.
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2.

Click Next>3.

Note: In M9485A, Only ports 1 to 4 can be set even if your unit has more than 4-port configuration.

 

Measurement Class Cal Properties dialog box help

Confirm or change the following unique cal properties for each channel to be calibrated. Click a

link to learn about these properties.

The properties with (NOT available in Cal All) are NOT available in a Cal All calibration as they

are in a stand-alone calibration.

SMC

Mixer Delay "Mixer Delay" Real number indicating delay

value.

Receiver Characterization

Cal Set

"Calset" String of Cal Set Name

Characterized mixer (s2p

file)

(NOT available in Cal All)

   

Standard Channel

  Programming

UI Setting Property Value

Include Power Calibration "Include Power Calibration" "true" or "false"

The power cal is optional only if none of the selected channels require a power cal.

 

Calibration Attenuator Settings dialog box help
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This dialog shows the Power, Attenuator, and IFBW settings for the Cal All calibration. The default

values for the Cal All session are the preset values of a standard S-parameter channel. These values

are not necessarily the same as those of the channels that are selected for calibration. When there are

differences in measurement path (switch) settings between the Cal All channel and the selected

channels, these differences are detected by Cal All and additional measurements are made for each

path condition. These additional measurements allow Cal All to produce error terms appropriate for

each of the selected channels. In general, the Cal All session should be performed at a power level

that is high enough to prevent noise in the error terms. However, an increase in power could cause

compression or damage to the analyzer receivers. The following settings allow you to increase the

power level ONLY during the Cal All session.

Power Limit (Disable)

Cal All shows you when power limits are enabled.  This setting provides you a convenient way to

TEMPORARILY disable these limits in order to take advantage of the power settings available in

Cal All.  If power limits are on, your DUT is probably a high-gain device and the attenuator

settings in your channels are high resulting in lower power at the cal reference plane.  This lower

signal can result in noisier measurements during the acquisition of cal. This situation is precisely

what Cal All is intended to improve.  Cal All allows you to configure the calibration conditions

for better signal-to-noise performance during the cal while leaving your DUT conditions alone.

You can elect to clear the “Disable Power Limits during cal” checkbox when you prefer to

calibrate at a higher power level than is allowed by your limit. The limit is restored after the Cal

All session.

Source / Receiver Attenuator

By default, the Cal All calibration is performed with Source and Receiver attenuators set to 0.

Change the Source or Receiver attenuator settings when external hardware (such as a booster

amplifier) would cause the analyzer receivers to be compressed or damaged.

You may also want to change the attenuator or path configuration settings to force the cal channel
to match settings of the selected channels. If all of the selected channels are set to identical

hardware settings, it may be better to apply these settings to the cal channel. For example, if your
channels all use a 5 or 10 dB attenuator step at port 1, you might elect to change the Cal All
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channel to use the same low attenuator settings.  This will result in the cal measurements being

made under the same path conditions as the channel and it will eliminate the need to

mathematically compensate for the difference.  However, if large attenuator values are used, the

default Cal All settings will likely improve your results.

S-Parameter Cal Port Power

Set the power level at which the S-Parameter cal is performed.

Power Offsets

Power Offsets are channel-scoped. Consequently, offsets that you already set are NOT

automatically copied to the Cal All session.  This setting allows you to also apply a Power Offset

during the Cal All session. Learn about Power Offsets.

Noise Reduction

This button accesses the following dialog for settings that help reduce trace noise and the noise

floor which can lead to better dynamic range and more accurate measurements. Learn more.

IF Bandwidth

Set the IFBW used to perform the Cal All calibration. The default IFBW setting of 1 kHz

is a good nominal setting for most measurements. Lowering the IFBW removes noise from
the calibration measurement, but also causes slower sweeps.

Always ON

Check to enable averaging.

Average Factor

Specifies the number of measurements that are averaged. Range of 1 to 65536 (2^16).
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Average Type

Sweep  Each data point is based on the average of the same data point measured over

consecutive sweeps.

(Sweep) Restart   Begins a new set of measurements that are used for the average.

Applies only to Sweep averaging - NOT Point.

Point   Each data point is measured the number of times specified by the Average Factor,

and then averaged, before going to the next data point.

Reduce IF BW at Low Frequencies

When this box is checked, the VNA uses a smaller IF Bandwidth than the selected value.

Learn more.

 

Select DUT Connectors and Cal Kits dialog box help

For each DUT port:

Select the connector at the calibration reference plane (where the cal standards will be connected).

Select the cal kit to be used.

Check Modify Cal to change the Thru method. An Unknown Thru cal is performed by default.

Learn about THRU methods.

Learn more about this dialog.
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Power Cal Settings dialog box help

A guided power cal is performed on the source ports for the Cal All calibration.

This dialog is displayed for each source port to receive a power cal.

To perform an LO power cal for a mixer channel, set the LO port to a VNA or external source in the

Mixer Setup dialog. Then select that port in the Selected Channels dialog.

To use the same power sensor for all power cals, do NOT check Use Multiple Sensors.

To use different power sensors, check Use Multiple Sensors. The sensor must be configured as a
PMAR device. Learn how.

Learn about this dialog box.

 

Cal All Summary  dialog box help

This page is a summary of the Cal All settings. Confirm the settings, then click Next > or < Back to

change settings.
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Cal Steps  dialog box help

Follow the prompts to connect each standard. Then click Measure.

Click Re-measure if necessary.

Then click Next >

 

 

Finish Cal  dialog box help

Click Finish to save the Cal All session results to Cal Registers.

Or click Save As User CalSet, then enter a prefix title. The Meas Class and channel number are

appended to this prefix to save to a User Cal Set for each calibrated channel.

Learn more about this dialog.
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Using Calibration Sets

What are Cal Sets

Cal Registers and User Cal Sets

How to Manage and Apply Cal Sets

Calibration Selection dialog box help

Cal Set Properties dialog box help

Select Cal Set -- Choose Stimulus Settings dialog box help

Examples of Cal Set Usage

Archiving Cal Sets using .cal files

See Also

Save and Recall: Instrument States and Cal Set Data

See other Calibration Topics

What are Cal Sets

At the completion of a calibration, all calibration data is stored to a Cal Set. The Cal Set can be applied

later to any channel that has the same stimulus settings as the Cal Set, thereby saving the time it takes

to perform another calibration. The following data is saved to a Cal Set:

Name

Cal Set Description

Cal Set Attributes - stimulus settings, cal type, port association

Standards data - The “Standards data” container in the Cal Set is intended for internal use only.  External
access is provided for use in diagnosing calibration problems.  Users should not form any expectations as to
the presence of the data or the naming conventions used. 

Error term data

GUID (Globally Unique IDentifier)
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Cal Registers and User Cal Sets

There are two types of Cal Sets:

Cal Registers (channel specific)

User Cal Sets

Calibration data is automatically saved to a Cal Register at the end of every calibration. You can also

choose to save the cal data to a User Cal Set.

Calibration Registers

Calibration Registers are designed to simplify calibrations for most users. When a calibration is

complete, the data is automatically saved to the channel's Cal Register, overwriting (or appended to) the

previous cal data stored in that register. This concept is similar to 'legacy' Vector Network Analyzers.

Every channel has ONE dedicated Cal Register.  They are named CHn_CALREG, where n is the channel
number. The name cannot be changed.

Cal Registers are more volatile because they are overwritten (or appended) each time a calibration is
performed on that channel. The Cal data is always saved, but only temporarily.

Cal Registers can be applied to other measurements, but ONLY on the same channel as the Cal Register.

User Cal Sets

At the end of a calibration, you can choose to also save cal data to an existing or new User Cal Set.

User Cal Sets can be applied to any number of channels simultaneously.

User Cal Sets are named by you for easy identification.

You can have an unlimited number of User Cal Sets.

At any time, you can copy Cal Register data to create a User Cal Set. See Cal Set Properties.

Appending Data in a Cal Set

At the end of a calibration, data is saved to the channel's Cal Register and, if you choose, to a User Cal

Set. When you choose to save to an existing User Cal Set, the analyzer attempts to append the new

error terms to the existing User Cal Set.  The existing Cal Set data is completely overwritten UNLESS

the new data can coexist with the existing data according to the following two rules:

260



The stimulus settings of the new data must exactly match the existing data.

The new cal must involve different ports from the existing cal.

For example:

Case 1 - An existing Cal Set contains a full 2-port cal between ports 1 and 2. Using the same stimulus

settings, you perform a 1-port cal on port 3. At the end of the cal, you click Save As User Cal Set and

select the existing full 2-port User Cal Set.

Result: The 1-port cal is appended to the 2-port User Cal Set. There is NO overlap between them.

Case 2 - Same situation as Case 1, except the 1-port cal is performed on port 1.

Result:  The Cal Set will contain a 1 port cal on port1 and a 1 port cal on port 2. The overlapping

tracking terms are removed rendering the original full 2 port cal invalid.

How to Manage and Apply Cal Sets and Cal Types

The analyzer attempts to apply a Cal Set and turn error correction ON for ALL of the measurements on

the active channel. This may not always be possible. For example, suppose a channel contains both S11

(reflection) and S21 (transmission) measurements. If a Cal Set that contains only an S11 Cal Type is

applied to that channel, the Cal Set does not contain the error terms to correct the S21 measurement.

Error correction is turned ON for the S11 measurement and NOT turned on for the S21 measurement.

There are two ways to apply an existing Cal Set (Cal Register or User Cal Set) to a measurement:

Recalling an Instrument State with Cal data (.cst file) - A .cst file contains an Instrument State with all
measurement attributes AND a 'pointer' to the Cal Set that was used to calibrate the measurement. Before
saving a .cst file, be sure that a User Cal Set (NOT a Cal Register) is being used for the measurement.
Because Cal Registers are automatically overwritten when a new calibration is performed, it is likely that the
Cal Register data will change before the .cst file is recalled.

1.

Create a new measurement and select a Cal Set to apply to the active channel.2.

Note: NEVER copy or modify Cal Sets from Windows Explorer or other applications. Cal Sets should

only be accessed through the VNA Application.
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How to select and apply a Cal Set to the active channel

Using Hardkey/SoftTab/Softkey

Press Cal > Cal Sets & Cal Kits > Cal Set....1.

 

Calibration Selection dialog box help

This dialog allows you to manage and apply Cal Sets

Although the number of Cal Sets you can have is limited only by the amount of analyzer
memory, it is considered unusual to have more than about 10 existing Cal Sets, or one
current Cal Set for every unique channel setup. Old Cal Sets (with 'stale' data) should be
deleted or overwritten.

The active channel's Cal Register always appears, even if empty. Cal Registers that belong to other

channels appear in the list of Cal Sets only if the channel exists, and only if they contain data.

Learn about Cal Registers.

Learn how to View the Error Terms of a Cal Set.

To apply a Cal Set to the active channel, click a row to select that Cal Set, then click
Apply Cal.

Note: A Cal Set must have been generated from the same measurement class as the active channel in

order for it to Applied.

Columns  click a heading to sort by that column

Cal Set Name  Name to identify the Cal Set.
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Description  User-settable text to further identify the Cal Set.

Channels  Channel numbers that are currently using this Cal Set. A blank entry means it is not

currently in use.

CalType / Ports  Type of Cal contained in the Cal Set. Learn about applying appropriate Cal Types.

Cal Type Abbreviations:

1P, 2P, 3P, 4P... - Full n-Port calibration

+ - Indicates a Power Correction is included in the Cal Set

R - Response (instead of ports, shows the measurement type that it corrects.)

ER/x-y  Enhanced Response, where x is the receive port; y is the source port.

Modified  Date and time the Cal Set was last modified.

Buttons

Copy  Invokes the Save as User Cal Set dialog box. Type a name for the copy of the selected Cal

Set data.

Show / Edit Properties  Starts the Cal Set Properties dialog box. This allows you to view all of the

Cal Set properties.

Delete  Permanently deletes the Cal Set after you choose OK to a warning prompt.

Delete All  Permanently deletes ALL listed Cal Sets and Cal Registers after you choose OK to a

warning prompt.

Apply Cal   Applies the selected Cal Set to the active channel. If the stimulus settings of the Cal

Set and channel are different, a choice must be made.

Unselect  Available ONLY if the selected Cal Set is being used by the active channel. Click to

'Un-apply' the Cal Set, then click Close to exit with the Cal Set un-applied.

OK  Always APPLIES THE SELECTED CAL SET to the active channel, then closes the dialog
box.

Close   Exit the dialog box. Performs no further action.
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Cal Set Properties dialog box help

Allows you to view all of the Cal Set properties and create a duplicate User Cal Set from
an existing User Cal Set or Cal Register.

Name  Edit name of the User Cal Set. You can NOT change the name of a Cal Register.

Description  Descriptive text to further identify the Cal Set.

Cal Set Properties  Lists descriptive information and stimulus conditions of the Cal Set.

Learn how to View the Error Terms of a Cal Set.

 

Stimulus Setting Different between Cal Set and Measurement

264



Select Cal Set -- Choose Stimulus Settings dialog box help

The Cal Set contains the channel stimulus settings that were in place when the Cal Set was saved.

This dialog appears when the Cal Set channel settings are different than those of the channel to

which the Cal Set is being applied. Choose between the following options.. (See above image).

A. Keep the Active Channel Stimulus settings. Interpolate if possible.

If the Cal Set frequency range is greater the active channel, then Interpolation will be turned ON.
Learn more about Interpolation Accuracy

If the Cal Set frequency range is less than the active channel, then this option is not available.

B. Keep the Cal Set Stimulus settings. The Active Channel stimulus setting are changed.

OK  Make the change.

Cancel  Cal Set will NOT be applied.

 

Examples of Cal Set Usage

The following examples show how Cal Sets increase flexibility and speed in making analyzer

measurements.

Using one User Cal Set with many Channels
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Using one Measurement with many Cal Sets

Using one User Cal Set with many Channels

It is possible to do one calibration, then apply it to several channels.

An example:

During a manufacturing process, you may have many calibrated channels. You may wish to
continuously cycle through the measurements and examine them individually. Occasionally,
you may wish to refresh the calibration without having to recreate all the measurement state
files.

Here is how: Examine the stimulus settings for each channel. Then make the User Cal Set
stimulus range a super-set of the whole group. Each channel can then use the same User
Cal Set. Some calibrations will be interpolated. Note: Make sure that interpolation is turned on.

Notice in the following image, Cal Set 78 is used on more than one channel, in this case
Channel 5 and 16 .

    Channel                                        Cal Set

 

Using one Measurement with many Cal Sets

The drawback with having one very large User Cal Set associated with many instrument
states could be a loss of accuracy due to interpolation. In such cases, consider using one
User Cal Set for each stimulus setting.. The stimulus conditions can then be changed for a
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channel by applying different User Cal Sets.  Other settings (window setups, measurement
definitions, scaling, limits, markers) will not change.  This may result in faster state changes
than if you saved and recalled *.cst files for each set of stimulus conditions.

Example #1: An amplifier needs to be measured at several input power levels. Calibrate at
several power levels and save each calibration in a separate User Cal Set.  Then, apply the
User Cal Sets to the single measurement consecutively.

Example #2:  Making an S21 Measurement, you need to measure both wide span and
narrow span characteristics of the device. One Cal Set covers the wide span setup; another
the narrow span setup.

Archiving Cal Sets using .cal or .csa files

Because User Cal Sets can easily be deleted, provide extra backup by also saving your
calibration as a .cal or .csa file (see saving a .cal file).

Example:

One person performs a calibration, names and saves it as a User Cal Set. This Cal Set is
available for any other person to use. A second user could accidentally delete or modify the
User Cal Set requiring the originator to repeat the calibration.

Security can be provided for calibration data by saving the Cal Set to a .cal file or .csa file. At
a later time, the file could be recalled and the original calibration restored.
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Error Correction and Interpolation

Error Correction and Interpolation settings work together to provide you with the highest level of

calibration accuracy possible.

How to set Error Correction

Error Correction

Viewing Correction Levels

How to set Interpolation

Interpolation Accuracy

See other Calibration Topics

How to set Error Correction

Using Hardkey/SoftTab/Softkey

Press Cal > Main > Correction > Channel Correction On|Channel Correction Off.1.

Error Correction

The Error Correction ON setting means that the calibration error terms are applied to the measurement.

Error Correction is automatically turned ON when a calibration is performed or if a Cal Set is applied
to a measurement. The VNA attempts to turn error correction ON for ALL of the measurements on the

active channel. This may not always be possible when applying Cal Sets. For more information, see
Applying Cal Sets.

When full 2-port error correction is ON, both forward and reverse sweeps are required to gather all 12

error terms, even if only one reflection measurement is displayed. This may result in a higher

measurement speed than expected. Learn more.

You can always turn Error Correction OFF for the active measurement by clicking Correction OFF.
The VNA will turn Error Correction OFF automatically when making stimulus changes under some
conditions. To turn correction back ON, click Correction ON. Then:
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If Interpolation can NOT be performed, a dialog box will ask if you would like to change the stimulus settings
to those of the applied calibration. Click OK or Cancel.

If Interpolation can be performed, the stimulus setting will change and correction turned ON.

Viewing Correction Level

The correction level provides information about the accuracy of the active measurement. Correction

level notation is displayed on the status bar for different calibration types like response, full 2-port,

TRL, or power calibration.

To View Correction Levels:

Right-click in the display, select Customize Display, select Toolbars tab, then select Status Bar. The

status bar appears and displays the following items:

 

Correction Level Accuracy

C N-Port Full N Port Highest

C Enh Resp Enhanced Response

C Resp Response

No Cor No Correction Lowest

C* Interpolated Uncertain

C Changed Uncertain

 

C N-Port

Full N Port correction, where N is the number of fully calibrated ports.

This correction is applied to SParameters.

If the calibration was performed with a receiver power cal, this correction can be applied to receiver

measurements. (eg: a1, b1, A, R1, b1/a1). (See Correction Methods for the ability to control the level of

calibration applied to receiver measurements).
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C Enh Resp

Enhanced response cal is an aggregate of a 1 Port calibration and a transmission response cal. 

This correction is applied to reflection and transmission parameters in either the forward direction

(S11, S21) or the reverse direction (S12, S22) depending on how the calibration was performed.

For reflection measurements,  Enhanced Response correction is equivalent to  C 1-Port correction.  For

transmission measurements, the correction is equivalent to a match-corrected transmission response

cal.

C Resp

Response calibrations are one term calibrations that correct for the frequency response of the

measurement.  It does not correct for impedance mismatches.

No Corr   No Correction

The following will cause the VNA to turn Error Correction OFF for the channel:

Decrease the start frequency

Increase the stop frequency

Change start frequency, stop frequency, or number of points with Interpolation OFF.

Change sweep type

The correction pop up pane, accessed by right-clicking on the Correction item in the status bar,

indicates port by port correction methods for a VNA with 12 or less test ports. This table is updated

when the port subset correction is turned on to reflect the correction methods being applied. In the

image below, the pane indicates a full 4-port calibration. On the right, the table indicates the methods

after the correction was devolved to ports 1, 2, and 3.
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The F+ indicates that the port had the full error correction applied. The e+ indicates that the enhanced

response correction method was applied to the port.

C*  Interpolated Correction

"C star" appears in the status bar when a measurement is being interpolated. See Interpolation (above)

and Interpolation Accuracy.

C    Changed Settings

"C-delta" appears in the status bar when one or more of the following stimulus settings change. The

resulting measurement accuracy depends on which parameter has changed and how much it has

changed. For optimum accuracy, recalibrate using the new settings.

Sweep time

IF Bandwidth

Port power

Stepped sweep enabled/disabled
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How to set Interpolation

Using Hardkey/SoftTab/Softkey

Press Cal > Main > Interpolation ON|OFF.1.

Interpolation

Calibration interpolation adjusts calibration error terms to match changes to the following settings that

you make AFTER a calibration is performed or a Cal Set applied.

The Interpolation ON setting means that interpolation is enabled for the active measurement. This does

not necessarily mean that the measurement is interpolated. When enabled (ON), if interpolation

becomes necessary because you change any of the following stimulus settings, then interpolation will

be applied. When stimulus settings change while interpolation is OFF, interpolation is NOT applied but

instead, error correction is turned OFF.

Interpolation occurs (if enabled) when you change any of the following settings:

Start frequency increased

Stop frequency decreased

Number of points

Note: Decreasing the start frequency, or increasing the stop frequency will always turn correction OFF.

(Exception: Power Calibration DOES extrapolate to the start and stop frequencies.)

Interpolation Accuracy

When a measurement is interpolated, the accuracy of the measurements cannot be predicted. It may be

affected significantly or not at all. Identifying measurement errors in these cases must be determined on

a case-by-case basis. In general, the magnitude and phase stimulus from the VNA and the response

from the DUT need to be smooth and continuous for measurement interpolation to give accurate

results.

Significant measurement inaccuracy WILL occur when the phase shift response between measurement
points increases changes more than 180 degrees. The VNA will incorrectly interpolate the new phase

data. For more information, see phase accuracy.

In general, the chances of significant inaccuracy increases when interpolating measurements under the
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following conditions:

when frequency span between measurement points becomes much greater.

when measurement frequencies are above 10 GHz where phase changes happen more rapidly.

when interpolating across frequency band crossings.  Learn more about band crossings.

Note:  When the interpolation algorithm encounters an abrupt or large change in the response

magnitude or phase, such as can occur at band crossings, large interpolation errors can be included in

the displayed data.  These errors can be seen as steps or spikes.  If this occurs, consider turning off

interpolation, changing the measurement parameters, or creating sweep segments that skip over the band

crossings.
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Using ECal

This topic discusses all aspects of performing an ECal:

ECal Overview

Connect ECal Module to the Analyzer

How to Perform a Calibration Using ECal

See Also:

ECal User-Characterization

Perform a 4-Port Cal with ONE 2-Port ECal Module

Restore ECal Module Memory

See other Calibration Topics

ECal Overview

ECal is a complete solid-state calibration solution. Every ECal module contains electronic standards

that are automatically switched into position during a measurement calibration. These electronic

standards have been measured at the factory and the data stored within the memory of the ECal

module. The analyzer uses this stored data, along with the measured data, to calculate the error terms

for a measurement calibration.

ECal modules are available in 2-port and 4-port models and a variety of connector types, covering

many frequency ranges. See Analyzer Accessories for more about available ECal modules and ordering

information.

You can perform the following calibrations with ECal:

1-Port Reflection calibration

Full 2-Port calibration

Full 3-Port calibration

And so forth...

Verify the validity of a mechanical or ECal calibration with ECal confidence check.
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Care and Handling of ECal Modules

You can improve accuracy, repeatability, and avoid costly repair of equipment in the following ways.

Practice proper connector care. See Connector Care.

Protect equipment against ESD damage. Read Electrostatic Discharge Protection.

Power Level into an ECal module

NEVER exceed the following Damage levels to the ECal module.

For highest accuracy, do not exceed the following ECal Compression levels when calibrating:

Model Compression level Damage level

N469x series -5 dBm +10 dBm

N4432A series

N4433A series

-7 dBm +20 dBm

N4431x series +7 dBm +20 dBm

N755xA series -5 dBm +10 dBm

8509x series +9 dBm +20 dBm

The power level can be increased after calibration with minimal impact on measurement accuracy.

Connect ECal Module to the Analyzer

ECal modules are controlled and powered through a USB connection. When you connect the module,

the type of module, frequency range, and connector type are automatically recognized.

For PXI modules, connect the ECal module to a USB port on the remote or embedded controller.

 

Important Note: DO NOT connect/disconnect USB devices during ECal calibrations. Doing so may

cause problems with the calibration.

 

Notes:

Unused ECal modules that have completed a calibration may remain connected to the USB port.
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You can connect and disconnect the ECal module while the analyzer is operating. However, DO NOT
connect or disconnect the module while data transfer is in progress. This can result in damage or at least
corrupted data.

How to Perform a Calibration Using ECal

Select an ECal module that has connectors of the same type and gender as the DUT. If such an

ECal module is not available, a module with connectors different from the DUT can be used by

using Advanced Settings or User Characterization. See Also: Perform a 4-Port Cal with ONE 2-Port ECal
Module

Connect the ECal module ports to the analyzer ports. During the calibration process the analyzer

can either automatically detect how the ECal module is connected, or the orientation can be

performed manually.

Connect the ECal module USB cable to the analyzer USB. See Connect ECal Module to USB.1.

Allow the module to warm up until it indicates READY.2.

Enter the analyzer settings. See Set Up Measurements.3.

Do one of the following to start the Calibration Wizard4.

Using Hardkey/SoftTab/Softkey

Press Cal > Main > Other Cals > Ecal....1.

In the Guided Calibration Wizard dialog box (step 2), select ECal option from the Cal Kits combo box.2.
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Select Calibration Ports and ECal Module dialog box help

Allows you to select calibration type and settings.

Cal Type Selection / Configuration  Select the number of ports to calibrate.  Then select the port

number configuration.

4 Port ECal

3 Port ECal

2 Port ECal  

1 Port ECal- (Reflection)  Advanced Settings are not available.

View/Select ECal Module  Click to Select the ECal module if more than one ECal module is

connected to the USB. Also, Select the User Characterization within the module. Learn more about

User Characterization.

Show Advanced Settings  Check to display the Advanced Settings when Next is clicked.

Back  Return to Cal Wizard Begin dialog.

Note:  ECal isolation is not performed. The inherent isolation of the analyzer is better than that

attained with correction using an ECal module.

Note:  Terminate any unused ECal ports with a 50 ohm load. Refer to Determining Effects of Not
Terminating Unused ECal Ports.

Note:  Do not connect any USB memory during ECal calibration.
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ECal module not found dialog box help

When this dialog appears, the ECal module is not connected or has not been recognized by the

network analyzer.

Retry  Check the USB connections and click to continue.

Notes:

If your ECal module is not detected, try to unplug, then reconnect to the USB.

When the ECal module is connected to the network analyzer for the first time, it may take approximately 30
seconds for the analyzer to recognize the module and make it available for calibration.

For best accuracy, allow the ECal module to warm-up until it indicates READY.

See Connect ECal Module to USB.

 

Select Module and Characterization dialog box help

ECal Module  Select one of the ECal modules that are connected to the analyzer.

Detect Connected ECals  Click to rescan the USB for ECal modules.
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Available Characterizations  

ECal Module Memory - Displays the factory and user characterizations that are stored in the ECal

module.

Disk Memory - Displays the user characterizations that are stored in Disk Memory. Learn more User
Characterizations in Disk Memory.

Select either the characterization data to use for the calibration. Once selected, that characterization

becomes the default selection until the analyzer is turned OFF and restarted. When restarted,

Factory again becomes the default selection.

 

Error: Frequency Range dialog box help

When this dialog appears, the current cal standards (or ECAL module) does not cover the current

frequency range of the measurement. Do one of the following to correct the problem:

Cal Kit Class Category  Not available with ECal modules.

Frequency  Change the frequency range of the active channel.

Edit  Not available with ECal modules.

Back  Select a different characterization that covers the required frequency range.

Cancel  Re-characterize the module with an increased frequency range.
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Select DUT Connectors and Cal Kits dialog box help

If the ECal module or selected User Characterization has more than one connector type, then the

following dialog box is presented which allows you to describe the DUT connector type. Otherwise,

click next to proceed to Advanced Settings (if checked) or ECal Steps.

Connectors

The available connectors are listed for each DUT port.

 

Advanced Settings dialog box help

Thru #n

Lists the proposed Thru connections to be made during the calibration process. You can change
these Thru connections to better suit your test setup.

The proposed Thru connections are listed automatically.

Additional Thru connections can be selected for higher accuracy. Learn more.

For Balanced measurements, learn which Thru paths to select.

Add Thru

Click to add a Thru connection. Learn more

280



Remove Thru

Select a Thru by clicking the "Thru #N" field or the "1st Port / 2nd Port" field. Then click "Remove

Thru". This selection is NOT available if the selected Thru is required for the calibration.

1st Port / 2nd Port

Click to change the two ports to be included in the Thru connection. The order of the port numbers

(1st or 2nd) is not critical.

Thru Cal Method

Lists the available Thru Cal methods for the specified port pairs.

Learn about ECal Thru Methods

Cal Type/ Stds

Click to invoke the View / Modify Properties of Cal dialog box

Do orientation

When this box is checked (the default setting) the VNA automatically senses the model and

direction in which an ECal module port is connected to the VNA ports. If power to the ECal module

is too low, it will appear as if there is no ECal module connected. If you use low power and are

having this problem, clear this check box to provide the orientation manually.

Orientation occurs first at the middle of the frequency range that you are calibrating. If a signal is

not detected, it tries again at the lowest frequency in the range.

Choose delta match

Available only when a Delta Match Cal is required.

Check, then click Next to invoke the Select Cal Set for Delta Match dialog box.

Clear - The Cal Wizard uses the Global Delta Match Cal if available.
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Specify how the ECal module is connected dialog box help

This dialog box appears when the Do orientation checkbox in the previous dialog box is cleared.

Click the ECal Port that is connected to each VNA port.

 

Electronic Calibration Steps dialog box help

Note: Beginning in VNA Rev. 6.0, ECal can be performed with External triggers. Learn more.

Displays the instructions for each measurement required for calibration.

Measure  Measures the ECal standards.

Done  Click when last standard has been measured.

Saving an ECal Calibration

When complete, you can save the new calibration. Learn how.
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ECal User Characterization

Overview

How to Perform a User Characterization

Manage Disk Memory

Restore ECal Module Memory

See Also

Using ECal

Perform a 4-Port Cal with a 2-Port ECal Module

Other Calibration Topics

Overview

A user-characterized ECal module allows you to add adapters to the ECal module, re-measure the

standards in the ECal module, INCLUDING the adapters, then add that data to ECal memory or save it

to disk memory. This extends the reference plane from the module test ports to the adapters.

Compared to legacy ECal modules, the new N755xA ECal modules have greater flash memory.

 

Important Note: DO NOT connect/disconnect USB devices during ECal calibrations. Doing so may

cause problems with the calibration.

 

Why perform a User Characterization?

If you need to use adapters with your ECal module, you could characterize your ECal module with the
adapters attached and perform subsequent ECals in a single step.

If you have a 4-port ECal module, you could configure the module with adapters of different connector types,
then perform a User Characterization of the module. When you need to test a DUT with a pair of the
connector types on your module, calibrate the analyzer with a 1-step ECal using the same two connectors on
the User-characterized module.
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If you test devices in a fixture, you could embed the characterization of the fixture in the characterization of
the module. To do this, during the mechanical calibration portion of the User Characterization, calibrate at the
reference plane of the device as you would normally calibrate. Then remove the fixturing to be embedded
and insert the ECal module to be characterized.  When measuring the ECal module, the analyzer removes
the effects of the fixturing and stores the measurement results in the user characterized ECal module.
Subsequent calibrations with that user-characterized module will also remove the fixture effects.

Notes:

Both 2-port and 4-port ECal modules support User Characterization.

User Characterization does not delete the factory characterization data. The factory data is saved in the ECal
module in addition to the User Characterization data.

The ECal Data Wipe Utility is the only way that data can be deleted from the module. Learn more at
http://na.support.keysight.com/pna/apps/applications.htm.

A User Characterization can be performed beyond the frequency range of the ECal module. Although this
practice is allowed, calibration accuracy with the extended User Characterization is likely to be degraded. To
determine the level of degradation, compare measurements of a variety of devices with a mechanical cal kit
calibration versus an ECal extended User Characterization calibration.

You can save up to 12 User Characterizations in a single ECal module. Previous releases allowed up to 5.
There are memory limitations. The analyzer will determine if the contents of a User Characterization will fit
inside the module before it is performed.

A User Characterization can be performed remotely. See programming commands.

User Characterizations can be saved to Disk Memory. Learn how.

This feature provides the following benefits:

A User Characterization using connectors that are NOT included in the supported connector table can
NOT be stored to the ECal module. But when stored to disk memory, ANY connector type is allowed by
firmware using a description of any length for the User Characterization.

There is NO limit to the number of data points allowed in a User Characterization stored to disk memory.
When stored in the ECal module, the number of data points is limited to a maximum of 65535 per
characterization, or less as dictated by the remaining free memory in the module.

The number of User Characterizations that can be stored to disk memory is limited only by available disk
space.

User Characterizations stored to disk memory can be freely shared between analyzers.

Learn how to Manage User Characterization in Disk Memory.

284

http://na.support.keysight.com/pna/apps/applications.htm


How to Perform a User Characterization

SUMMARY  (A detailed procedure follows.)

1.  Select adapters for the module to match the connector configuration of the

DUT.

2.  Either calibrate the analyzer using mechanical standards or recall an existing

Cal Set.

3.  Measure the ECal module, including adapters, as though it were a DUT.

4.  The measurement results are the characterization data that then gets stored inside

the module or to disk.
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Note

A 2-port analyzer can be used to perform a User Characterization on a 4-port ECal module.

However, a 4-port ECal module has SIX different port pairs. The analyzer must be recalibrated for

each port pair that uses unique connecter types or gender.

If all 4 ECal module ports have the same connector type and gender, then only one calibration is required to
measure all six port pairs.

If all 4 ECal module ports have different connector types or gender, then 6 calibrations are required.

When more than one calibration is required during a User Characterization, then ALL calibrations

must be performed using the standard Cal Wizard, saved to Cal Sets, and then recalled from Cal Sets
DURING the User Characterization.

 

Detailed steps to Perform a User Characterization

Connect the ECal module to the network analyzer with the USB cable. See Connect ECal Module USB
to the analyzer USB.

1.

Allow the module to warm up until it indicates READY.2.

Preset the analyzer.3.

Set up the measurement.  For best accuracy, the IF bandwidth should be set to 1 kHz or less.4.

Start and complete the Characterize ECal Module Wizard:5.

Using Hardkey/SoftTab/Softkey

Press Cal > Cal Sets & Cal Kits > ECal > Characterize ECal....1.
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Select Module and Location dialog box help

ECal Module  Select one of the ECal modules that are connected to the analyzer.

Detect Connected ECals  Click to rescan the USB for ECal modules.

Location

ECal Module Memory  Click Next to see the following dialog.

Disk Memory  Enter a Characterization Name. This name appears when selecting a User
Characterization to be used with subsequent calibrations.

Learn how to manage characterizations that are stored to disk memory.

See the benefits of storing the User Characterization to disk Memory.

Keyboard  Launches a keypad that can be used to type a characterization name from the analyzer

front panel.

Next  Click to continue to the Select Connectors for the Characterization dialog box.

See note regarding extended frequency use.
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Select User Number for new characterization dialog box help

Scroll to view all of the parameters of the stored characterizations. Select an empty location or

select to overwrite an existing characterization.

Next  Click to continue to the Select Connectors for the Characterization dialog box.

See note regarding extended frequency use.

 

Select Connectors for the Characterization dialog box help

Connector Notes

When performing an ECal User Characterization, do NOT use a custom connector name that you

added to this list. If you need to use a custom-defined connector type, select "Type B", or one of

the "Type A" variations from the list of connectors for each port.

A User Characterization using connectors that are NOT included in the supported connector table
can NOT be stored to the ECal module. But when stored to disk memory, ANY connector type
is allowed.  Learn more about storing to Disk Memory.

Select the adapters for the ECal module test ports. Select No adapter if no adapter is used on a port.

PORT A  Lists the connector types available for Port A.

PORT B  Lists the connector types available for Port B.

PORT C  Lists the connector types available for Port C (available with a 4-port ECal module).
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PORT D  Lists the connector types available for Port D (available with a 4-port ECal module).

Next  Click to continue to the Calibrations to perform or recall dialog box.

 

Calibrations to perform or recall dialog box help

The analyzer must be calibrated before measuring the ECal module and necessary adapters. This

dialog box displays the number and types of mechanical calibrations required for the

characterization.

Guide me through this cal now  Click to perform a Guided calibration.  A calibration kit is

required for each connector type.

If more than one calibration is required, the following selection is not available. See Note.

Let me recall this cal from a cal set  Click to select an existing Cal Set. You cannot select a Cal

Set that is currently in use. Learn more about Using Cal Sets.

Next  Click to continue to either the Select Cal Kits or the Select Cal Set dialog box.
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Select Cal Kits dialog box help

Provides a list of calibration kits to perform the calibration. Select the Cal Kit you will use for each

port.

Enable Unknown Thru for characterizing the module  Check to enable. This reduces the

number of steps required to characterize the THRU standard.

Next  Click to continue to the Select Cal Set dialog box.

 

 

Select Cal Set dialog box help

The calibration that you perform will be written to a Cal Set. This dialog box allows you to select a

Cal Set to overwrite, or to write to a new Cal Set. The current choice is visible below the Select Cal

Set button.

Select Cal Set  Click to open the Select A Cal Set dialog box.

Create new Cal Set  Check to create a new Cal Set to store the calibration. Clear to select and

overwrite a stored Cal Set.

Next  Click to continue to the Guided Calibration Steps dialog box.

Note: Remember the Cal Set name for future reference.
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Guided Calibration Steps dialog box help

Instructs you to connect each calibration standard to the measurement port.

Measure  Click to measure the standard.

Back  Click to repeat one or more calibration steps.

Done  Click after a standard is re-measured and all measurements for the calibration are

complete.

Next  Click to continue to the next calibration step. (Does not measure the standard.)

Cancel  Exits Calibration Wizard.

The Specify nominal delay or Guided Calibration completed dialog box appears when the steps

are completed.

 

Specify nominal delay dialog box help

This dialog ONLY appears when Adapter Removal or Unknown Thru calibrations are performed.

The following values were estimated from the measurement. Most of the time, they are adequate.

However, for CW sweep or frequency sweep with large step sizes, the accuracy of the values may

be improved.

Nominal adapter delay  To improve this value, measure and record the delay of the adapter with a

dense step size. Enter that value here.
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Nominal phase offset  (Waveguide ONLY). To improve this value, measure and record the phase

offset of the Waveguide adapter with dense step size. Enter that value here.

When one connector is coax and the other connector is waveguide, the phase offset has an

ambiguity of 180 degrees. For consistency, the estimate provided here is always between 0 and 180

degrees. You can change this estimate to any value between -180 degrees and +180 degrees.

 

Guided Calibration completed dialog box help

Allows you to finish the calibration and continue to the next characterization steps.

No. Finish now  Select to save Cal Set data.

Yes  Allows selection of Save options.

Next  Click to continue to the Exit to Inspect Quality of Calibration dialog box.

 

Exit to Inspect Quality of Calibration dialog box help

Allows you to exit User Characterization to validate the calibration before proceeding with the

characterization.

Back  Allows you to repeat calibration.

Next  Click to continue to the Characterization Steps dialog box.
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Cancel  Exits the Calibration.  

To return to the current step:

Start User Characterization.1.

In the Select user number for new characterization dialog box, click Next.2.

In the Select Connectors for Characterization dialog box, click Next. (Previous entry is stored in
memory.)

3.

In the Calibrations to perform or recall dialog box, recall the Cal Set that you just performed.4.

 

Characterization Steps dialog box help

Describes the instructions for each measurement required for characterization.

Measure  Measures the ECal module.

Next  Click to continue to the Information for the New Characterization dialog box when

measurements are complete.

 

Information for the New Characterization dialog box help

Allows you to describe the properties of the User Characterization.
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Suggestions for connector abbreviations

To minimize the number of characters, we suggest using the following 3-character codes to describe

the connectors listed.

A User Characterization using connectors that are NOT included on this list can NOT be stored to

the ECal module. But when stored to disk memory, ANY connector type is allowed.  Learn more
about storing to Disk Memory.

Connector Type 3-Character Code

1.0 mm female 10F

1.0 mm male 10M

1.85 mm female 18F

1.85 mm male 18M

2.4 mm female 24F

2.4 mm male 24M

2.92 mm female 29F

2.92 mm male 29M

3.5 mm female 35F

3.5 mm male 35M

7-16 female 16F

7-16 male 16M

Type F female F7F

Type F male F7M

N50 female N5F

N50 male N5M

N75 female N7F

N75 male N7M

APC 7 7MM

K-band waveguide KBW

P-band waveguide PBW

Q-band waveguide QBW

R-band waveguide RBW

U-band waveguide UBW

V-band waveguide VBW

W-band waveguide WBW

X-band waveguide XBW
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Next  Click to continue to the Write Characterized Data to the ECal module dialog box.

 

Write Characterized Data dialog box help

User Characterization and factory characterization data is written to either the disk memory or the

ECal module memory.

Write  Click to write data.

The Summary of new User Characterization dialog box opens after data is saved to module.

Existing data will be overwritten is you selected a User Characterization number that already has data.
Learn more

For more information, see Restore ECal module memory.

The ECal Data Wipe Utility is the only way that data can be deleted from the module. Learn more at
http://na.support.keysight.com/pna/apps/applications.htm.

 

Summary of new User Characterization dialog box help

Verify the status of the ECal User Characterization.

ECal module model number

summary from User Characterization
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Cancel  Click to exit (characterization complete).

Finish  Click to exit (characterization complete).

Manage ECal User Characterizations in Disk Memory

Normally, User Characterizations that are stored in disk memory can be used indefinitely without

needing them to be managed. However, this dialog allows you to backup the characterizations in case

they are accidentally erased, or to save them to a file that can be moved to another analyzer.

How to Manage ECal User Characterizations in Disk Memory

Using Hardkey/SoftTab/Softkey

Press Cal > Cal Sets & Cal Kits > ECal > Manage ECal Disk Memory....1.

 

Manage ECal User Characterizations in Disk Memory  dialog box help

This dialog allows you to do either of the following:

Save an existing User Characterization in disk memory to an *.euc file.

Load a previously saved *.euc file for use on the analyzer with the specified ECal module.

Learn more about User Characterizations stored to Disk Memory.

ECal Module  Select an ECal Module from the list for which User Characterizations are currently

stored in disk memory.

296



Save As  Saves a User Characterization that is currently in disk memory to a *.euc file. This file can

be used as a backup in case the archive file is accidentally deleted, or allows you to move the file to

another analyzer to be used with the selected ECal Module.

Import  Loads a previously saved *.euc file for use on the analyzer with the specified ECal module.

Delete  Removes a User Characterization from disk memory.

Restore ECal Module Memory

When user-characterized data is written to the ECal module, the entire contents of ECal memory is also

written to the disk memory, including the factory ECal data. In the unlikely event that your ECal

module memory is lost, you can restore all ECal data to ECal memory.

Caution: If a new factory cal was performed after the ECal memory was written to disk memory, the

new factory cal data will also be overwritten.

Note: An ECal Data Wipe Utility destroys all user data per US DoD 5220.22-M. Learn more at
http://na.support.keysight.com/pna/apps/applications.htm

How to Restore ECal Module Memory

Using Hardkey/SoftTab/Softkey

Press Cal > Cal Sets & Cal Kits > ECal > Restore ECal Memory....1.

No Programming commands are available for this feature.

 

Module to be restored  dialog box help

Verify the serial number of the module to be restored. If two modules are connected, choose the one

to have data restored.

Next   Click to write data to the module. 
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Perform a 4-Port Cal with One 2-Port ECal Module

You can perform a 4-port calibration with a 2-Port ECal Module. When all four DUT connectors are

the same type and gender, the calibration can occur with only four connections, the same number of

connections you would make with a 4-port ECal module.

The ECal module must span the frequency range of the measurement.

The ECal module must have connectors that match the DUT connectors. Because we are using a 2-port
ECal module, this means that the DUT must have only TWO unique connector types and gender. When the
DUT has more than two connector types/genders, you can select a different cal kit for each port using
SmartCal.

Important Note: DO NOT connect/disconnect USB devices during ECal calibrations. Doing so may

cause problems with the calibration.

Procedure

Connect the 2-port ECal module to a VNA USB port.1.

Press Cal > Main > Other Cals > Smart Cal....2.

Select 4 Port Cal, then click Next to see the following dialog:3.

Select the DUT Connectors for each port. In this example, all four DUT connectors are Type N, female.4.

Select the attached ECal module. We are using a 85092-60007 ECal module.5.

Select Modify Cal (Show Advanced Settings for ECal) then click Next to see the following dialog:6.

For the fewest number of physical connections, select the default port assignments.7.
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The 1st Port selection for each port pair is 1.

For single-ended (standard) measurements, THREE is the minimum number of Thru connections. For
Balanced measurements, FOUR Thru connections should be made. Learn more.

For higher accuracy, select Add Thru. The Cal Wizard will add another port pair which results in more
physical connections.

7.

Select ECal Thru as Unknown. This is the most accurate and easiest Thru Cal Method. Learn more.8.

You may need to clear Do Orientation when calibrating at low power levels. Learn more. This will add
additional connection steps.

9.

Follow the prompts to complete the calibration:

Connect ECal to ports 1 and 2. Click Measure.1.

Connect ECal to ports 1 and 3. Click Measure.2.

Connect ECal to ports 1 and 4. Click Measure.3.

10.

At the Specify Delay dialogs, click OK. This is the measured delay for each of the Thru connections in the
ECal module. Learn more.

11.

Click either Save As User Cal Set, or Finish.12.
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TRL Calibration

TRL (Thru, Reflect, Line) represents a family of calibration techniques that measure two transmission

standards and one reflection standard to determine the 2-port 12-term error coefficients. For example,

TRM (Thru, Reflect, Match), LRL (Line, Reflect, Line), LRM (Line, Reflect, Match) are all included

in this family.

The traditional SOLT calibration measures one transmission standard (T) and three reflection standards

(SOL) to determine the same error coefficients.

Why Perform a TRL Cal?

The TRL Calibration Process

TRL Cal Kits

Cal Standards Used in TRL

TRL with an External Test Set

See other Calibration Topics

Why Perform a TRL Cal?

TRL calibration is extremely accurate, in most cases more accurate than an SOLT cal. However, very

few calibration kits contain TRL standards. TRL Cal is most often performed when you require a high

level of accuracy and do not have calibration standards in the same connector type as your DUT. This is

usually the case when using test fixtures, or making on-wafer measurements with probes. Therefore, in

some cases you must construct and characterize standards in the same media type as your DUT

configuration. It is easier to manufacture and characterize three TRL standards than the four SOLT

standards.

Another advantage of TRL calibration is that the TRL standards need not be defined as completely and
accurately as the SOLT standards. While SOLT standards are completely characterized and stored as

the standard definition, TRL standards are modeled, and not completely characterized. However, TRL
cal accuracy is directly proportional to the quality and repeatability of the TRL standards. Physical

discontinuities, such as bends in the transmission lines and beads in coaxial structures, will degrade the
TRL calibration. The connectors must be clean and allow repeatable connections.

To learn more about Cal Standard requirements, see Cal Standards Used in TRL.
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Note: Virtual Device describes a non-physical (connect the two test port reference planes together)

type of connection description during the calibration. So, in a cal kit definition, you should not define

more than one Thru standard with the same connector/gender pairing to each Virtual Device. This

could cause those Thru standards to all be treated as the same physical connection step during a

calibration, which would especially be a problem for TRL calibrations if a Thru standard and Line

standard were measured as the same connection step.

The TRL Cal Process

Although TRL can be performed using the Cal Wizard Unguided Cal selection, the following process

uses the easier SmartCal selection. Both selections require that you already have TRL calibration

standards defined and included in a VNA cal kit.

Preset the VNA1.

Set up a measurement and the desired stimulus settings.2.

Press Cal > Main > Other Cals > Smart Cal....3.

Select the DUT connectors and Cal Kit for each port. The LOWEST port number of each port pair MUST
include TRL standards. TRL appears as the Cal Method.

4.

Check Modify Cal, Next, then View/Modify to change default TRL options if necessary.5.

Follow the prompts to complete the calibration.6.

Check the accuracy of the calibration7.

TRL Cal Kits

Keysight Technologies offers two cal kits that include the required standards to perform a TRL
calibration: 85050C (APC 7mm) and 85052C (3.5mm). Both kits include the traditional Short, Open,

and Load standards. (The Thru standard, not actually supplied, assumes a zero-length Thru). In addition,
the kits include an airline which is used as the LINE standard. To use the airline, the kits include an

airline body, center conductor, and insertion / extraction tools. The APC 7 kit includes an adapter to
connect the airline to the APC connector.

Cal Standards Used in TRL

These standards must be defined in your TRL cal kit:

THRU
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Note: All THRU calibration methods are supported in a TRL Cal EXCEPT Unknown Thru.

The THRU standard can be either a zero-length or non-zero length. However, a zero-length THRU is more
accurate because it has zero loss and no reflections, by definition.

The THRU standard cannot be the same electrical length as the LINE standard.

If the insertion phase and electrical length are well-defined, the THRU standard may be used to set the
reference plane.

Characteristic impedance of the THRU and LINE standards defines the reference impedance of the
calibration.

If a THRU standard with the correct connectors is NOT available, an adapter removal cal can be performed.

REFLECT

The REFLECT standard can be anything with a high reflection, as long as it is the same when connected to
both VNA ports.

The actual magnitude of the reflection need not be known.

The phase of the reflection standard must be known within 1/4 wavelength.

If the magnitude and phase of the reflection standard are well-defined, the standard may be used to set the
reference plane.

LINE

The LINE and THRU standards establish the reference impedance for the measurement after the

calibration is completed.  TRL calibration is limited by the following restrictions of the LINE standard:

Must be of the same impedance and propagation constant as the THRU standard.

The electrical length need only be specified within 1/4 wavelength.

Cannot be the same length as the THRU standard.

A TRL cal with broad frequency coverage requires multiple LINE standards. For example, a span from 2 GHz
to 26 GHz requires two line standards.

Must be an appropriate electrical length for the frequency range: at each frequency, the phase difference
between the THRU and the LINE should be greater than 20 degrees and less than 160 degrees. This means
in practice that a single LINE standard is only usable over an 8:1 frequency range (Frequency Span / Start
Frequency). Therefore, for broad frequency coverage, multiple lines are required.

At low frequencies, the LINE standard can become too long for practical use. The optimal length of the LINE
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standard is 1/4 wavelength at the geometric mean of the frequency span (square root of f1 x f2).

Note: The TRL LINE standard must have a delay that is greater than 0 (zero) ps. Otherwise,

calibration correction calculations will contain unpredictable results.

MATCH

If the LINE standard of appropriate length or loss cannot be fabricated, a MATCH standard may be

used instead of the LINE.

The MATCH standard is a low-reflection termination connected to both Port 1 and Port 2.

The MATCH standard may be defined as an infinite length transmission line OR as a 1-port low reflect
termination, such as a load.

When defined as an infinite length transmission line, both test ports must be terminated by a MATCH
standard at the same time. When defined as a 1-port load standard, the loads are measured separately. The
loads are assumed to have the same characteristics.

The impedance of the MATCH standard becomes the reference impedance for the measurement. For best
results, use the same load on both ports. The load may be defined using the data-based definition, the
arbitrary impedance definition, or the fixed load definition.

See Also

See Modify Calibration Kits for detailed information about creating and modifying Calibration kit definitions.

For more information, read Specifying Calibration Standards and Kits for Keysight Vector Network Analyzers
(Application Note 1287-11)

TRL with an External Test Set  

Beginning with the VNA code revision 5.25, TRL CAN be performed with an External Test Set

enabled. Previously, a TRL calibration required a VNA with a reference receiver for each test port.
With the new TRL method, a Delta Match Calibration is first performed and applied.

Note: See Delta Match Calibration to learn which models require this.

The accuracy of this TRL cal greatly depends on the accuracy of the Delta Match Calibration. With an
accurate Delta Match Calibration, the difference in accuracy between a traditional TRL cal and this

TRL cal is negligible.

How to Perform a TRL Cal in these cases

Press Cal > Main > Other Cals > Smart Cal....1.

2.
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1.

Select a TRL cal kit for the ports to be calibrated.2.

During the calibration, the Cal Wizard prompts you for a valid Delta Match Cal.3.
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CalPod

Note: This feature is NOT available in M948xA and E5080A.

CalPod is a system that simplifies the process of recalibrating the VNA without requiring the removal

of the DUT or the physical connection of standards. This allows recalibration from a remote location

such as when the DUT is in a temperature chamber.

Note: This feature is available to GCA , GCX, IMS, IMD, NF , NFX, and standard (S-Parameter)

channels.

In this topic:

Overview

How to start the CalPod dialog

CalPod dialog

CalPod Setup dialog

CalPod Operational Check

See Also

CalPod as ECal

Other Calibration topics

Process Overview

Note: The following overview assumes the CalPod system has been installed and configured.  See the

CalPod User's Guide for installation instructions
at: http://na.support.keysight.com/pna/calpod/calpod_ug_85523-90005.pdf .

The following process assumes a 2-port DUT connected to the VNA ports 1 and 2 through CalPod

modules as follows:
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The   Blue  boxes represent CalPod modules with internal Thru, Short, Open, and Load states.

After configuring and assigning CalPod modules to VNA ports 1 and 2, connect the CalPod modules to the
VNA, directly or using short cables. Learn how to configure CalPod.

1.

Setup measurements on a channel.  An IFBW of 1 kHz or lower with eight averages is
recommended.  CalPod does not support measurements below 100 MHz.

2.

Perform a full 2-port calibration for the channel with the CalPod outputs as the reference plane.3.

Click Initialize Channel to automatically perform the following steps:

The OPEN, SHORT, AND LOAD states of both Calpod modules are switched in and S11/S22 are
measured.

a.

The resulting measurements are stored in the channel's Cal Set as additional standard measurements.
These measurements are used to characterize the Calpod states - they are NOT used at this time to
change the error correction.

b.

4.

Notes:

Because the OPEN, SHORT, AND LOAD states in the CalPods are measured, it is not
important what is connected to the CalPod when Initialize is pressed. Therefore, for highest
accuracy, click Initialize IMMEDIATELY and ONLY ONCE after performing the calibration -
before causing ANY cable movement.

If an adapter is required to connect the DUT to a CalPod, use a high-quality adapter. Any
temperature drift due to the adapter is NOT recorrected.

Always connect the DUT as close as possible to the CalPod modules.

5.
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Connect the DUT to the CalPod outputs.5.

Click Recorrect Channel or Recorrect All Channels whenever necessary.  Any of the following actions will
cause the current calibration to become invalid and require recorrection:

Moving the CalPod modules to the ends of long cables.a.

Changing the cables.b.

Extreme temperature variations.c.

Measurement drift over long time periods.d.

6.

The following steps occur automatically during recorrection for the active channel:

The OPEN, SHORT, AND LOAD states of both CalPod modules are switched in and S11/S22 are
measured.

a.

Additional (de-embedded) error terms are computed to compensate for changed conditions from the
Initialize measurements.

b.

Another Cal Set is created using the original name with the CalPod number appended. The modified
error terms are saved to that Cal Set and applied to the channel. The measurements are now fully
corrected.

c.

7.

How to start the CalPod dialog

Using Hardkey / SoftTab / Softkey

Press Cal > Cal Sets & Cal Kits > Cal Pod... .1.

CalPod dialog box help

Learn all about the CalPod process.(Scroll up)
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Initialize Channel  Calibrated measurements of the CalPod states are performed as initial reference

data points for the active channel.

Initialize All Channels  Calibrated measurements of the CalPod states are performed as initial

reference data points for all current channels.  This command is not recommended, it is generally

preferable to initialize each channel immediately following calibration.

Recorrect Channel  Recorrects the active channel Cal Set to match the initial reference.

Recorrect All Channels  Recorrects the Cal Sets on ALL channels that were initialized.

Correct Power  

This checkbox causes power to be recorrected ONLY when source power correction data is stored

as error terms in the CalSet. This occurs only when a Guided Power Cal is performed and when

an app channel is calibrated such as a FCA, GCA, IMD, and Noise Figure channel. This checkbox

has NO effect when a S-parameter Cal or a standard Source Power Cal has been performed,

because source power correction data is not stored in the CalSet.

When any of the above power cals have been performed, and when this box is checked, the power

output at the VNA port is adjusted to compensate for any change in path loss when Recorrect is

performed.  For example, if the path loss between the VNA port and the CalPod was increased by

two dB following initialization, then the VNA output power will be increased by two dB upon

recorrection.  Do this when you add a significant amount of loss in the calibration path, or when

the power level at the DUT is important.

When a significant amount of loss is introduced in the calibration path, it may not be possible to
increase the source power enough to overcome the loss. In this case, an Unleveled source

message may appear on the VNA screen.

When the checkbox is cleared, the source power level is not corrected.
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OSL Averages  Controls the number of sweeps worth of raw measurements to be measured and

averaged together for the recorrection computations for each state of each CalPod.

Assignment of CalPods to VNA Ports

For each VNA port, select a CalPod module.

CalPod Setup  Starts the CalPod Setup dialog

Delete All CalPod Cal Sets  Deletes all recorrection Cal Sets and reinstates the Initialization Cal

Set.

 

 

CalPod Setup dialog box help

To start this dialog, click CalPod Setup in the CalPod dialog box.

CalPod Serial Number   Type the CalPod module (without 'sn'), then click Add CalPod. The
new module is added to the list of available CalPod modules.

Serial # and CalPod Types
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Shows the list of available CalPod modules.  A CalPod module type may be STANDARD or

THERMAL.  A CalPod module will be listed as a STANDARD type unless the thermal

characterization data has previously been loaded into the VNA from a USB flash drive.

Buttons

Utilities  Launches the VNA CalPod Utilities used to configure the CalPod Controller and VNA

over LAN.

Note: Before using a CalPod Controller, the LAN MUST be set up using the CalPod Utilities or

an error message will be displayed indicating that the VNA is unable to communicate with the

CalPod Controller.

M9036A/M9037A PXI Controller Local Area Connection LAN to Static  Sets the Local

Area Connection adapter to a static IP address of 192.168.0.101.

M9036A/M9037A PXI Controller Local Area Connection 2 LAN to Static  Sets the
Local Area Connection 2 adapter to a static IP address of 192.168.0.102.

M9036A/M9037A PXI Controller Local Area Connection LAN to Obtain an IP

address automatically  Sets the Local Area Connection adapter to obtain an IP address

automatically.

M9036A/M9037A PXI Controller Local Area Connection LAN to Obtain an IP
address automatically  Sets the Local Area Connection 2 adapter to obtain an IP address

automatically.

Test  Click to test the connection between the controller and the selected CalPod module. The
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message box displays the connection status and temperature for both Ambient and Thermal

modules.  Only the Thermal module will apply test temperature for recorrection.

Delete  Removes the selected STANDARD CalPod module from the list.

To delete a THERMAL CalPod from the list:

Navigate to the c:/e-trak/adapters/itm directory.1.

Delete the .xml file associated with the CalPod serial number.2.

Exit all CalPod dialog boxes and restart the CalPod dialog.3.

The CalPod may now be removed using the Delete button.4.

About  Shows the CalPod software version information.

For more CalPod Setup information, see the CalPod web site:

http://na.support.keysight.com/pna/calpod . Click CalPod Controller Configuration .

CalPod Operator's Check

This program is provided as a convenience to help determine the operational status of each 855xxA

Series CalPod and its associated CalPod Controller. While this check is not intended to be a complete

test, it does check each unit enough to provide greater than 95% confidence that the CalPod is

functioning properly.

When the max frequency of the CalPod is higher than the max frequency of the VNA, the full frequency
range of the CalPod is not tested.

Up to four CalPod modules may be checked at once. All four devices must be of the same frequency range.

The software revision for the Operator’s Check code is displayed in the upper left-hand corner of the window

Before running Op Check

The CalPod system must be installed and configured on the VNA. 

See the CalPod User's Guide for instructions at:

http://na.support.keysight.com/pna/calpod/calpod_ug_85523-90005.pdf

Required equipment:

An appropriate ECal or mechanical Cal Kit.
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A high-quality cable.

A female-female adapter of the calibration connector type.

A fixed attenuator up to 10 dB (3 dB preferred) or other frequency insensitive device with similar loss.

How to perform CalPod Operators Check

Click Utility, then System , then Service, then Verification , then Operator's Check .

Click Setup Info to learn more about this dialog.

Also, click Cal Method or Connector for additional explanation for these areas.  

Configure

Enter information in the “Configure” area.  1.

Each time a 2-port cal is performed, the results are saved in a file.  The “Use Prior” selection uses the saved
calibration.

2.

When the calibration connector type does not mate with the CalPod connectors, perform the calibration and
then use adapters to connect to the CalPod module.

3.

Click Begin to start the Op Check.4.

Follow the prompts in the gray box.5.

Op Check Results

The Results area shows Op Check progress.

Click a test label for test information.
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When the check has finished, the results are saved to a text file. The default path and filename is:
C:/Program Files/Keysight/Network Analyzer/Service/calpodopchklog. txt. To save multiple results, rename
the file or save it to a different location.

For assistance in troubleshooting CalPod Operator's Check failures or for additional information, see the
appropriate FAQ at the CalPod web site: http://na.support.keysight.com/pna/calpod
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Calibration Preferences

Cal type preferences are set from this dialog.

How to change Cal Preferences

Programming commands are NOT available for the preference settings discussed in this topic,

although there are other Cal Preferences that can be set remotely.

Using a mouse

Click Response1.

Select Cal2.

Select Cal Sets & Cal Kits3.

Select Cal Preferences...4.

 

Cal Type Preferences dialog box help

This dialog is used to set which Cal Types are available, and the order in which they are selected as

the default choice, during a SmartCal with Mechanical Standards. This setting is also used to set the
default Cal Type for Guided calibrations using SCPI or COM.

Note: Your Cal Type settings are saved only until the NA application is closed. When re-opened,

the factory default settings are restored.

The specified Cal Type order should allow you to make fewer changes to the Cal Type during a

SmartCal with Mechanical Standards.

For example, in the above image, the first Cal Type on the list is TRL. When doing a SmartCal with

Mechanical Standards:
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If a TRL Cal Kit is available for the specified DUT connectors, then TRL becomes the default Cal Type.

If a TRL Cal Kit is NOT available, then the second Cal Type on the list (SOLT) is evaluated for
compatibility with the available Cal Kits, and so forth with the Cal Types that remain on the list.

If TRL is removed from the list, that Cal Type is NOT available for selection during a SmartCal with
Mechanical Standards.

Learn more about Cal Types.

See where you choose Cal Type during a SmartCal

 

Prioritized list of choices for default Cal Type  Shows the current list of Cal Types and the order

in which they will be selected for Mechanical calibrations.

Change  Click to invoke the Modify list of default Cal Types dialog.

Restore factory defaults  Returns the list to the original selections and order. The factory defaults

are in order of accuracy from highest (TRL) to lowest (QSOLT).

Cancel  Closes the dialog without making changes.

 

Modify list of default Cal Types dialog box help

Use this dialog to Add, Remove, and re-order the available Cal Types. There must be at least ONE
selected Cal Type to perform a SmartCal with Mechanical Standards.

Unselected Cal Types  Cal Types in this list will not be presented as a choice during a Calibration.
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Selected Cal Types  Cal Types in this list will be presented, in order, as the default choice during a

Calibration. Click a Cal Type to select it, then click the following buttons to perform that operation.

Add / Remove buttons  Click to Add and Remove the selected Cal Types from the Selected Cal

Types list.

Move Up / Down   Click to re-order the Selected Cal Types list.
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Cal Plane Manager (CPM)

Adapters, fixtures, and probes are often used for DUTs that have non-coaxial interfaces. This could

make it difficult to calibrate with traditional cal standards. Cal Plane Manager (CPM) allows you to

mathematically remove (de-embed), a characterized adapter, test fixture, or probe head from

measurements.

CPM is an enhancement of the existing Characterize Adaptor Macro.

In this topic:

Features

Using Cal Plan Manager

Cal Plane Manager

Characterize Adapter/Fixture and Apply

Calset Selection

Port Selection

Phase Pivot

Select Files

Apply De-embedding

Select Channels to De-embed

Select Calsets to De-embed

Other Actions

Reverse Port Order

Create a Transmission Only S2P File

Cascade Two S2P Files

Cascade an ENR file with an S2P file

Other Cal Topics
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Features

Characterizes adapters and fixtures in SnP files.

Applies the characterizations to existing Cal Sets and channels.

Writes to VNA power loss table using the S2P files of fixtures/adapters.

Reverses the port order of an existing S2P file.

Creates a forward-only S2P file from an existing S2P file.

Cascades two S2P files.

Important Notes

Adapter/fixture definition: Any physical 2-port device or component that is to be mathematically removed
from channel measurements or Cal Sets.

The adapter/fixture to be characterized MUST be reciprocal (S21 = S12).

Two Tier-1 cals must be performed and saved to Cal Sets BEFORE performing the CPM characterization.

Using Cal Plan Manager

How to start Cal Plane Manager

Using Hardkey / SoftTab / Softkey Using a mouse

Press Cal > Fixtures > Cal Plane Manager... .1. Click Response1.

Select Cal2.

Select Fixtures3.

Select Cal Plane Manager4.
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Cal Plane Manager dialog box help

Choose from the following, then click Next > :

Characterize Adapter/Fixture and Apply - Given that you have already performed calibrations both
before and after the adapter/fixture, SNP files are generated which characterize the adapter/fixture.
These files are then used to de-embed the fixture from the channel and a new calset. Learn how.

Apply Adapter/Fixture - The *.SNP files are already saved. Use these files to de-embed the fixture from
the channel and a new Cal Set.

Other Actions

 

Characterize Adapter/Fixture and Apply dialog box help

Requirements

You must have already performed a Tier 1 calibration at the input of the fixture/adapter(s) AND a Tier 2
calibration at the output of the fixture/adapter(s) as in the above image.

In addition, the calibrations must have been saved to Cal Sets on the analyzer.

Note: The mechanical switch / attenuator settings of the Tier 1 and Tier 2 cals for CPM MUST be the

same settings.  Also, when the span or number of points are different between the two cal tiers, there

must be sufficient data points to ensure that phase wrapping does NOT occur. This is accomplished

when the delta frequency for either calset is less than 12/combined length of the test port cables in

meters.

Applications

The following images show the calibration planes of the Tier 1 and Tier 2 calibrations:
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Probe Head on Wafer Probe Head on Fixture Waveguide Adapter

Procedure

Configuration   Select the number of adapter/fixtures to be characterized and de-embedded.

Choose One fixture when you have a single fixture/adapter on either the input or output of the DUT.

Choose Two fixtures when you have a fixture/adapter on BOTH the input AND output of the DUT.

Browse - Starts the following Calset Selection dialog.

DC Phase - Starts the Phase Pivot dialog .

Click Next >

 

Calset Selection dialog box help
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Choose from the listed Cal Sets on the analyzer to use for the Tier 1 and Tier 2 calibrations.

The Tier-1 calset MUST be from a calibration that was performed at the input to the adapter/fixture.

The Tier-2 calset MUST be from a calibration that was performed at the DUT reference plane.

Click Filter Calsets to start the following dialog.

Check Enable Filter , then provide advanced filter requirements to narrow the search for

appropriate Cal Sets.
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Filter Options

Measurement Class - The classes listed are those that are enabled on the analyzer.

Cal Type - Filter for 1P (one-port) or 2P (two-port) Cal Sets.

Calset Name Includes - Filter to include any text that appears in the calset name.

Calset Description Includes - Filter to include any text that appears in the calset description.

Cal Ports - Filter to include only the analyzer ports to be de-embedded.

Active Cals - Filter to include only the Cal Sets that are currently in use on the analyzer.

Last Modified Between - Filter to include only the Cal Sets that were last modified between the

two specified dates.

 

Port Selection dialog box help

In the previous dialog, when a multiport calset is selected for a characterization that involves fewer

ports, then select the port in the calset that is used to characterize the fixture/adapter.
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Phase Pivot dialog box help

For most devices, the projected phase of S21 at DC crosses the X-axis between 0° and -180°.

The phase pivot point specifies the center of the phase window. It is normally 1 Pi wide. The default

value of 0° should be adequate for the majority of adapters.

However, when characterizing electrically long cables, cables with significant mismatch, or high

noise in the measurements, it is possible that the projection of phase goes above 0°. This results in a

180° phase difference between the results computed by CPM versus the results you might get by

measuring the same adapter with a 2-port calibration.

In these cases, you may have to change the default value to capture the projected phase of S21 at

DC.

 

Select Files dialog box help

For each Fixture (A and B):

Click Browse , then navigate to the folder to where the S2P files are to be saved.

Enter a filename, then click S2P Format , then choose the format in which the data is to be saved:
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Log Magnitude & Angle (default)

Lin Magnitude & Angle

Real & Imaginary

Click Apply to continue to de-embed the fixture.

Click Finish to end with the characterization and close the dialog.

 

Apply De-embedding dialog box help

Given one S2P file for each fixture/adapter, this dialog will remove the effects of the fixture/adapter

from either:

one or more Calsets

or one or more channels.

For each Fixture (A and B)

Check to enable fixturing.1.

Select the VNA port the fixture is connected to.2.

Click Browse , then navigate to the S2P file that represents the fixture/adapter.3.

Reverse Ports - S2P files that are created using CPM ALWAYS reference port 1 of the fixture/adapter
on the side closest to the analyzer and port 2 of the fixture/adapter ALWAYS on the DUT side of the
device as in the following image. The application of the S2P file (this dialog) assumes this same
orientation. If your S2P files were created using a different (external) application, check the orientation
and check Reverse Port Order if necessary.

4.
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Choose one of the following De-embed Options5.

De-embed from Calsets - Starts the Select Calsets to De-embed dialog box.

De-embed from Channels - Starts the following Select Channels to De-embed dialog.

 

Select Channels to De-embed dialog box help

De-embedding is performed and applied to specified channels on the analyzer.

Select one more channels currently displayed on the analyzer from which to de-embed the

adapter/fixture.

 

Select Calsets to De-embed dialog box help
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This dialog appears when De-embed from Calsets is selected in the previous dialog.

De-embedding is performed and applied to specified Cal Sets. This allows you to easily apply de-

embedding in the future by simply applying the de-embedded calset to any channel.

Select Calsets :  Select the Cal Sets to which de-embedding will be applied.

Properties  View information about the corresponding calset.

Properties

Overwrite Selected Calsets - The selected Cal Sets are overwritten with the adapter/fixture de-
embedded.

Create New Calsets - Select the Cal Sets from which new Cal Sets will be created.

Click Options to start the following dialog.

Calset Name
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Auto Name - By default, a new calset will be created using the old calset name with the specified

text ("CPM" by default) appended to the beginning of the name.  You can change the specified text.

Ask me for each name - Starts the following dialog when OK is pressed.

Preserve Active Cal and Channel associations - When checked (default) the new de-embedded

Cal Sets will be used to correct the same displayed channels as the current Cal Sets.

The Existing Calsets that you selected for de-embedding appear in the left column.

The proposed New Calset names appear in the right column.

To change the new Calset name, select, then edit the name.

When finished, click OK .
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Other Actions dialog box help

Select one of the actions:

Reverse the Port Order of an S2P File .

Create a Transmission Only S2P File.

Cascade two S2P files .

Cascade an ENR file with an S2P file

Write to VNA power sensor loss table . Loads the S2P Frequency / Loss pairs into the VNA

Power Loss Compensation table to compensate for losses that occur when using the device to

connect a power sensor to the measurement port during a Source Power Cal.

Enable Power Sensor Loss Table  

Then choose from the following:

Compute fixture from Calsets .  Computes the transmission loss of the fixture based on the
selected Cal Sets. This choice is NOT available until two valid Cal Sets are selected.

Use an S2P file .  Uses the S21 data in an existing S2P file to build the VNA’s power loss table.
 Select, then click Browse , then navigate to the S2P file, then click Next > .

Note: In the VNA Power Loss Compensation table, loss is expressed as a positive

number. CPM assumes that any negative S21 value in the S2P file is a loss and

therefore multiplies the S21 values in the file by -1 to express that value as a positive

number. This ensures proper handling of the offset during a source power cal.
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Reverse Port Order dialog box help

S2P files that are created using CPM ALWAYS reference port 1 of the fixture/adapter on the side

closest to the analyzer and port 2 of the fixture/adapter ALWAYS on the DUT side of the device as

in the following image.  

This action causes ports to be reversed on an existing S2P file.

The data for S11 becomes the data for S22 and vice versa.

The data for S21 becomes the data for S12 and vice versa.

The resulting file is written in the standard S2P file format.

Original - Navigate to the S2P file to be reversed.1.

Reversed - Navigate to the folder where the new reversed S2P file will be saved. Enter a filename. By
default, the file is saved to the same folder using the filename: <old filename>_Reversed.s2p

2.

Click Finish. The Reversed file is saved to the specified location.3.
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Create a Transmission Only S2P File dialog box help

From an existing S2P file, this feature allows you to zero the S11, S22, or both data columns. The

original S21 and S12 data are preserved.  This is useful for Enhanced Response calibration / de-

embedding.

Original - Click Browse , then navigate to the file to be modified.

Modified - Click Browse , then navigate to the folder and enter or change the filename of the

resulting S2P file. The file select dialog allows you to change the format of the data. Click Format ,

then choose from the following:

Log Magnitude & Angle (default)

Lin Magnitude & Angle

Real & Imaginary

Modifications

Choose to Zero the S11, S22, or both data columns.

Click Finish. The transmission only file is saved to the specified location.
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Cascade Two S2P Files dialog box help

This dialog combines the losses and phase shift of two S2P files into a single S2P file.

The stimulus settings of the two input S2P files need not be identical. The frequency range of the

cascaded S2P file will be the frequency range that is common between the two input files. In

addition, the cascaded S2P file will use the data points of the input file with the denser data points.

For example:

S2P #1: Frequency range = 1 GHz to 5 GHz; 201 pts.

S2P #2: Frequency range = 2 GHz to 6 GHz; 1001 pts.

Cascaded S2P: Frequency range = 2 GHz to 5 GHz using the data points of S2P #2.

S2P #1 - Click Browse , then navigate to one of the S2P files to be cascaded.

S2P #2 - Click Browse , then navigate to the other S2P file to be cascaded.

Cascaded S2P - Click Browse , then navigate to a folder and enter the filename of the resulting

S2P file.

Click Finish . The cascaded file is saved to the specified location.
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Cascade ENR Files dialog box help

This dialog generates a new ENR file by embedding an adapter to an existing ENR file.

Input ENR - Click Browse , then navigate to ENR files to be cascaded.

Input S2P - Click Browse , then navigate to the S2P file to be cascaded.

Output ENR - Click Browse , then navigate to a folder and enter the filename of the resulting ENR

file.

Click Finish . The cascaded file is saved to the specified location.
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Port Subset Correction (Devolve Calibration)

It is often convenient to calibrate all the ports of the instrument so that corrected data is available at

every port.  However, applying the resulting calset results in every port being swept.  This level of

correction is appropriate if every port is connected to the DUT.  However, sweeping ports that are

disconnected unnecessarily slows down measurement throughput.  To remedy this situation, the user

can tell the instrument to exclude selected ports from the correction process.  This is called "port sub-

setting" or "devolve calibration". This process does not modify the calset in any way. There are two

settings associated with port sub-setting:  an on/off state, and the list of ports that should be included in

the correction for the channel.  

Port sub-setting values are independent of calset selection.  They are essentially a mask that is applied

to the calset.

Restricting correction to Enabled Ports

For example, on a 4 port instrument, the user is measuring two DUTs. Device #1 is connected to ports

1 and 2. Device #2 is connected to ports 3 and 4.  The two devices are not interconnected in any way.

Channel 1 is used to measure device #1. Channel 2 is used to measure device #2. If you apply a 4 port

calset to each of these channels, both channels will sweep all 4 ports. Port sub-setting can be used  to

reduce the level of the correction for each channel.

Channel Port subset values Measurements Correction applied

Channel 1 ON, ports 1 and 2 enabled S11, S21, S12, S22 Full 2 Port (1,2)

Channel 2 ON, ports 3 and 4 enabled S33, S43, S34, S44 Full 2 Port (3,4)

In this condition, when the user performs a 4 port calibration and applies the same user calset to both

channels.  Channel 1 sweeps ports 1 and 2.  Channel 2 sweeps ports 3 and 4.

Best Effort on Disabled Ports

If measurements are added to the channel that utilize ports that are disabled in port sub-setting, those

measurements will be corrected on a "best effort" basis:  some correction may be applied depending on
the contents of the calset. The level of correction is limited to enhanced response calibration or simple

response calibration.
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Channel Port subset values Measurements Correction applied

Channel 1 ON, ports 1 and 2 enabled
S11, S21, S12, S22 Full 2 Port (1,2)

S43 Enhanced Response(4,3)

Channel 2 ON, ports 3 and 4 enabled
S33, S43, S34, S44 Full 2P(3,4)

S11 1 Port (1)

This "best effort" correction cannot be turned off using the dialog.  But there are SCPI commands for

disabling this feature.

See SENS:CORR:METH:PORT:SUBS:FULL:VAL and SENS:CORR:METH:PORT:SUBS:RESP:VAL.

Click Cal > Main > Correction Methods.....

Correction Methods dialog box help

Enabling match correction on power measurement  Apply match correction on all receivers used

on this channel.  See Matching

Enable port subset correction  Enabling port subset correction to reduce the number of corrected

ports.

Define port subset  Selects which ports should be included in a full N-port correction. Un-selected
ports will be corrected on a “best effort” basis: In other words, these ports will be corrected with an

enhanced response calibration if the error terms are available in the calset.

Exclude all ports  Excludes all ports from correction. The button will change to Select all ports to

include all ports for correction.

The correction pop up pane, accessed from the status bar, indicates port by port correction methods for

VNA with 12 or less test ports. This table is updated when the port subset correction is turned on to

reflect the correction methods being applied. In the image below, the pane indicates a full 4 Port

calibration. On the right, the table indicates the methods after the correction was devolved to ports

1,2,3.
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Power Calibration

Note: Source and Receiver Power Calibrations are NOT available in M937xA PXI.

Source and Receiver Power Calibrations work together to provide very accurate power levels from the

source, and very accurate power measurements from the VNA receivers.

Source Power Calibration Overview

Supported Power Meters and Sensors

How to perform Source Power Calibration

Setup

Source Power Cal dialog

Source Power Calibration Options dialog

Power Meter Settings dialog

Power Loss Compensation dialog

Power Sensor Settings dialog (Zero / Calibrate)

Copy a Source Power Calibration to other Channels

Saving a Source Power Calibration

Reducing Time to Complete a Source Power Calibration

Receiver Power Calibration

Saving Receiver Cals

Other Source Power Cal choices

Guided Power Cal can be performed during an S-parameter Guided Calibration. Learn more.

Receiver Leveling can be used to provide 'real-time' source power cal. Learn more.

See Also: Configure an Power Meter As a Receiver (PMAR)

See other Calibration Topics
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Source Power Calibration Overview

Note: Source and Receiver Power Calibrations are NOT available in M937xA PXI.

Perform Source Power Calibration when you need accurate power levels at some point in the

measurement path between the VNA test ports. For example, you need to characterize the gain of an

amplifier across a frequency range at a specified input power. You would perform a source power cal at

the input of the amplifier to ensure the exact power level into the amplifier across the frequency range.

Using a Source Power Cal, you can expect the power at the point of calibration to be within the range

of the uncertainty of the power meter and sensor that is used.

Source Power Calibration...

Is independent of measurement type. It corrects the VNA source regardless of which receivers are being
used in a measurement. Therefore, it can be used with both ratio or non-ratio measurements.

Applies ONLY to those measurements on the selected channel that use the test port that was specified as
the Source for the calibration. For example, if you specify Channel 1 and Port 1 as the source to be
calibrated, only those measurements on channel 1 that use port 1 as the source will be corrected.

Can be used in conjunction with other measurement calibrations, such as a full 2-port calibration. For highest
accuracy, perform the measurement calibration AFTER the source calibration.

Can be used with Power Sweep type. Source Power Cal will correct the power at all power levels across the
power sweep.

Can be used with Port Power Uncoupled.

Forces sweep mode to Stepped on measurements with source power correction turned ON.

Beginning with VNA Rev. 7.50, an external source can be calibrated using Source Power Cal.

Overview of How it works:

See Important First-time USB connection note.

Click to see the detailed procedure

Specify the measurement settings (frequency range, IFBW and so forth).1.

Start Source Power Calibration.2.

Note: When using an Keysight 848X power sensor (sensors that do NOT have built-in

calibration factors), enter the Cal Factors using the Power Sensor Settings dialog, because the

VNA instructs the power meter to NOT use the Cal Factor tables internal to the power meter.

3.
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Connect a power meter sensor to the point at which you want a known power level. This may be at the input
or output of your device, or some other point between the test ports.

3.

The VNA source is stepped through the specified frequency range, and power is measured with the power
meter. At each data point, the source power is adjusted until the measured power is within your specified
accuracy level.

4.

When complete, the power meter is preset. The source power calibration can be saved as part of the
instrument state.

5.

The power meter is removed and the measurement path reconnected.6.

The calibration is automatically applied to the channel. All measurements on that channel using that source
port benefit from the source power cal.

7.

Perform an S-parameter calibration AFTER a Source Power Cal. The S-parameter cal is performed using the
corrected stimulus power levels for the relevant ports.

8.

Verify the source power calibration using the following procedure.

Connect the power meter as it was during the source power calibration.1.

Set the VNA to Point Trigger mode.2.

Trigger the VNA across the trace. Read about the behavior of the sweep indicator.3.

At each data point, the power meter should read the corrected power level within the specified tolerance.4.

Supported Power Meters and Sensors

See Keysight's Power Meters and Sensors Webpage.

USB Power Sensors

U848x Series USB Thermocouple Power Sensors (A.09.90.08 and later).

These include the following models: U8481A, U8485A, U8487A, U8488A

External Calibration (connecting the sensor to the 1 mW ref port) is NOT supported.

IMPORTANT: See http://na.support.keysight.com/pna/pseriesmeter.html

U2020 X-Series USB Peak and Average Power Sensors.

The VNA does NOT support peak mode in these sensors, but measures average power.
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U2000 Series USB Power Sensors.

U2040 X-Series USB and LAN Power Sensors.

USB Notes:

From a standard power cal (this topic), only one USB power sensor can be used to cover the

entire frequency span. To use multiple power sensors, perform a Guided Power Cal. Learn how.

To select a USB power sensor for a standard power cal:

Connect the sensor directly to one of the VNA USB ports.1.

From the Source Power Cal dialog, click Power Meter Config.2.

On the Power Meter Settings dialog, select USB.3.

See Important First-time USB connection note.

See note about Zeroing USB Power Sensors.

See also: Power Meters as Receivers (PMAR)

LAN Notes:

LAN power sensors can only be controlled via LAN.

Typical LAN ports found on a PC or Keysight instrument are used for data transfer and

communication only and will not power up a U2049XA LAN Power Sensor.

LAN power sensors must connect to a PoE port (Power over Ethernet), which will supply DC

power required to power up the sensor and to transfer data.

To select a LAN power sensor for a standard power cal:

Connect the sensor to a PoE/LAN connection.1.

From the Source Power Cal dialog, click Power Meter Config.2.

On the Power Meter Settings dialog, select LAN and enter the host name of the power sensor.3.

Power Meters
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P Series power meters (N1911A and N1912A) and all supported sensors.

EPM Series power meters (N1913A and N1914A) and all supported sensors.

EPM-P Series power meters (E4416A and E4417A) and all supported sensors.

E Series power meters (E4418 and E4419) and all supported sensors.

HP 437B / 438A power meters.

Power Meter Notes:

N1911A, 12A, 13A, and 14A power meters have a device-side USB connector  and are controlled by
the VNA exactly like a USB sensor. See USB Power Sensors (above).  Although these meters may also have
a front-panel USB port, USB power sensors must be connected directly to one of the VNA USB ports.

Source Power Calibration operates slowly with the Keysight E930x and E932x power sensors.

Some Keysight power meters have a mode that emulates the command set of the 437B or 438A power
meter. The VNA does NOT support this emulation mode.

The 82357A USB/GPIB Interface can be used to control power meters.

Create a Custom Power Meter Driver for use with other power meters.

Non-Keysight Power Sensors

Rohde and Schwarz NRP-Z power sensors (limited support). Learn how to install the drivers.

How to perform Source Power Calibration

Note: Guided Power Cal can be performed during an S-parameter Guided Calibration. Learn more.

Setup your measurement (sweep type, frequency range, IFBW, and so forth). By default, a Source
Power Cal is performed on the source port of the active measurement.

1.

Connect coax cable, GPIB cable, and power sensors to the VNA as shown in graphic below.  2.

This image does NOT apply to USB power sensors, which are connected directly to a VNA USB port.

See Important First-time USB connection note.
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Apply power to the power meter and allow 30 minutes warm-up time before beginning calibration.3.

Select Source Power Cal as follows:4.

Using Hardkey/SoftTab/Softkey

Press Cal > Main > Other Cals > Source Power Cal....1.

Complete the Source Power Cal dialog box (below), including Options, Loss Compensation and Power
Sensor Settings, as needed.

5.

Note: When using an Keysight 848X power sensor (sensors that do NOT have built-in

calibration factors), enter the Cal Factors using the Power Sensor Settings dialog, because the

VNA instructs the power meter to NOT use the Cal Factor tables internal to the power meter.

When complete, click Take a Cal Sweep in the Source Power Cal dialog box.6.

Follow the prompts to connect the sensors as required.7.

At this time you can change the Source Port setting and perform a Source Power Cal on a different port.8.

When calibration is finished, click OK. Correction is then applied and turned ON for the relevant ports on
the active channel.

9.

Remove sensor.10.

SrcPwrCal is displayed in the status bar when Source Power Correction is applied to the Active
Measurement.

11.

Perform a S-parameter calibration, which would use the corrected stimulus power levels for the relevant
ports.

12.
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To turn Source Power Correction OFF:

On the Calibration menu, point to Power Calibration, then click Source Power Correction on/OFF.

ONLY correction for the source port of the ACTIVE MEASUREMENT is turned OFF (regardless of port
power coupling setting.)

Interpolation or Extrapolation

If the original stimulus settings are changed, Interpolation or EXTRAPOLATION is applied and

SrcPwrCal* is displayed in the status bar. This is different from measurement calibration interpolation. For

example, if the frequency span is increased, the VNA will extrapolate new correction values rather than

turn correction off. This is to protect your test device from being overpowered by the source. If the

original settings are restored, then source power calibration returns to full correction.

 

Source Power Cal dialog box help

Note: Be sure that the frequency range of your power sensor covers the frequency range of your

measurement. This does NOT occur automatically.

Power

Cal Power  The calculated power (in dBm) at the calibration point. This value is the

specified VNA source power plus the Power Offset value.
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Power Offset  Allows you to specify a gain or loss (in dB) to account for components you

connect between the source and the reference plane of your measurement. These

components will remain during a measurement. For example, specify 10 dB to account for a

10 dB amplifier in the path to your DUT. Following the calibration, the VNA power

readouts are adjusted to this value.

To account for components that will be removed when the calibration is complete, use the Loss
Compensation table.

Channel and Port Selection

Channel  Specifies the channel on which to perform the calibration. This setting defaults to the

active channel.

Source Port  Specifies the source port to be corrected. This setting defaults to the source port for

the active measurement.

Note: External sources can be calibrated using his dialog. Learn more.

Accuracy

At each data point, power is measured using the specified Power Meter Settling Tolerance, then

adjusted until the reading is within this Accuracy Tolerance or the Max Number of Readings has

been met. The last power reading is plotted on the screen against the Tolerance limit lines.

Tolerance  Sets the maximum desired deviation from the specified Cal Power level in 0.005 dB

increments from 0 to 5 dB.

Max Number of Readings  Sets the maximum number of readings to take at each data point for

iterating the source power. Enter a value between 1 and 1000.

Calibration Status

Allows you to turn Source Power Cal ON | OFF and view Cal data for each port, regardless of the

active measurement. This feature allows the Internal Second Source to be calibrated and turned

ON | OFF, even when being used as an incidental source in a measurement, such as an LO.

Calibration ON  Check to turn Source Power Calibration ON for the specified source port.

The displayed text indicates when interpolation is applied for the calibration.

Buttons

Options  Invokes the Source Power Cal Options dialog. Label to the left of the button displays the
current 'Options' setting.
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Power Meter Config  Invokes the Power Meter Settings dialog box

Take Cal Sweep  Begins source power calibration measurement.

OK  Applies calibration. This button is disabled until the Take Cal Sweep has been pressed.

Cancel  If a sweep is in progress, cancels the sweep. Press again to close the dialog.

 

Attention please: the power meter is operating in 200 r/s mode.

During a measurement, some Keysight power meters may display this message on the screen: It

means that the meter is operating in 200 readings/sec which is the fastest speed setting for this

meter. This is normal operation.

Pass / Fail Limits

Limit lines are drawn on the Source Power Cal measurement graticule area. These lines are at the

Cal Power +/- the current setting of Accuracy Tolerance.  A FAIL during the Source Power Cal

sweep means that the VNA was unable to measure power to within the Accuracy Tolerance. Tight

tolerances are more difficult to achieve at lower Cal Power levels. When a FAIL indication appears,

increase the Max Number of Readings. If this does not cause a PASS condition, then decrease the

Accuracy Tolerance value.

See Also

Learn more about Source Power Cal

Learn about External Testsets and Source Power Cal.

 

Source Power Calibration Options dialog box help
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Provides options for measurement of the source power.

Note: At low power levels (less than -30 dBm) most power meters are not as accurate as a

VNA receiver.

Calibration Reference  Choose power meter/VNA receiver to use to measure power.

Use a power meter. Traditional source power calibration using only a power meter to measure the
source power at each data point. Most accurate (at higher power levels) and slowest method.

Note: Because the following two settings use VNA receivers to make power measurements,

they do NOT work correctly when a Frequency Offset value is being used.

Use a power meter once, then use the VNA reference receiver.  When checked, the first reading at
each data point uses a power meter to calibrate the reference receiver. Subsequent readings, if
necessary to meet your accuracy requirement, are measured using the reference receiver. This
technique is much faster than using the power meter, and more accurate when measuring low power
levels.

Note: Do NOT use this setting if there is a component before the power sensor that exhibits

non-linear behavior, such as a power amplifier in compression.  Use a power meter and

Calibrate the source at multiple power levels.

Use a receiver.  Select a VNA Receiver or a PMAR (Power Meter as Receiver).
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VNA receiver - For highest accuracy, first calibrate the receiver by performing a

source power cal using a power meter, then a receiver cal. That receiver can then be

used to quickly calibrate other VNA source ports, or used on another channel with

different stimulus settings. This would be useful, for example, if the power level of

the measurement was below the sensitivity of the power sensor. Calibrate the VNA

receiver using a source power cal that is within the sensitivity of the sensor. Then,

use the calibrated receiver to perform a second source power cal at the reduced

power level.

The VNA receiver is specified using either standard receiver notation or logical receiver notation.

It is best to use the reference receiver for the source port to be calibrated. For example, if
calibrating source port 2, specify "R2" or "a2" which is the same port 2 reference receiver using
logical receiver notation.

To ensure an accurate source power cal, the frequency range over which the receiver was
calibrated must be the same or larger than the "receiver only" source power calibration.

All accuracy and settling tolerance and number of reading settings apply just as they do with a
power meter reading.

PMAR Device -  The power meter/sensor must first be configured. Learn how to Configure a
PMAR device.

Use a power table and the VNA reference receiver  Used to provide power leveling with mmWave test
set and modules. Learn more.

Calibrate the source at multiple power levels   Used primarily with mmWave measurements.

This feature can also be used with standard VNA measurements when a component is used in the

source path such as a booster amp which does NOT have linear gain or loss over frequency. If this

is not true for your setup but want to improve your source power accuracy, consider using the

Receiver Leveling feature.

When checked, source power is measured using the specified 'Cal Reference' device (power
meter/sensor or VNA receiver) and iterated on a sweep-to-sweep basis to construct a 2-dimensional

power table: Power IN, Power OUT, over all frequencies.

Click Power Levels to launch the Source Cal Power Levels dialog box to set the power levels at which
source power is to be measured.

The source power cal is saved, but the power table is NOT accessible.

Calibrate the VNA reference receiver   Check to calibrate the appropriate reference receiver to
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the power level that is measured at the calibration plane. Do this to make very accurate

measurements using the calibrated reference receiver. This cal is done in addition to the standard

source power cal using the any of the methods listed above. At the end of the source power cal

measurement sweep, you can optionally save the reference receiver cal to a Cal Set to be recalled at

a later time. The Cal is saved when the OK button is clicked to close the Source Power Cal dialog.

 

Source Cal Power Levels dialog box help

This dialog appears when you click Power Levels on the Source Power Cal Options dialog.

Specify the power levels at which the Source Power will be calibrated. These values should be set

to a few dB more or less than the measurement power levels.

Max Power - The highest power level at which to calibrate. This value should be a few dB

higher than the highest power level of your measurement.

Note: Setting the Max Power will override power settings entered manually in a Power Table

(InputPower). Therefore, when using a power table, set the Max Power value to the same

value shown in the Power Table (InputPower).

Min Power - The lowest power level at which to calibrate.  This value should be a few dB lower
than the lowest power level of your measurement.

Power Step - Calibrate at every incremental power level, between the Max and Min Power

settings.

 

Power Meter Settings dialog box help
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This dialog appears when you click the Power Meter Config button on many dialog boxes.

Communication

GPIB / Address  Select GPIB power meter. Then select the address for the power meter. Default is 13.
The VNA will search VISA interfaces that are configured in the Keysight IO Libraries on the VNA. Note:
Use this selection when using a 82357A USB/GPIB Interface,

USB  VNA scans for USB power sensors or N191x device-side USB power meters. Select a power
sensor from the list. Only ONE USB power sensor can be configured to cover the entire frequency range
of the calibration.  To use multiple power sensors, perform a Guided Power Cal.

LAN  Specify the Hostname or IP address of the Power Meter.

Any  For future use.

Sensors  Invokes the power sensor settings dialog box.

Settling

These Settling settings do not apply when a VNA receiver is the power measurement device. Each

power meter reading is "settled" when either:

two consecutive meter readings are within this Tolerance value or

when the Max Number of Readings has been met.

349



The readings that were taken are averaged together to become the "settled" reading. The settled

reading is then compared to the Accuracy Tolerance requirements (tolerance and max readings)

specified on the Source Power Cal dialog box.

Tolerance  When consecutive power meter readings are within this value of each other, then

the reading is considered settled.

Max Number of Readings  Sets the maximum number of readings the power meter will take to

achieve settling.

Sensor Loss Compensation

Use Loss Table  Select this checkbox to apply loss data to Source Power calibration correction

(such as for an adapter on the power sensor).

Edit Table  Invokes the Power Loss Compensation dialog box.

 

Power Loss Compensation dialog box help

To Add a Row to the table, click on a row in the table and press the down arrow on either the VNA
front panel or keyboard.

To Edit a value, double-click in the cell to be edited.

Compensates for losses that occur when using an adapter or coupler to connect the power sensor to
the measurement port. These components will be removed when the calibration is complete. To

account for components that will remain during the measurement, use the Power Offset setting.

The Frequency / Loss pairs define the amount of loss for the entire frequency range. For example,

using the entries in the above dialog image:

0.5 dB is used to compensate power sensor measurements up to 1 GHz.
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Each data point between 1 GHz to 2 GHz is linearly interpolated between 0.5 dB and 1 dB.

1 dB is used above 2 GHz.

A single frequency/loss segment is applied to the entire frequency range.

Beginning with A.09.80, enter up to 9999 segments to achieve greater accuracy. Previously the

limit was 100.

These values can be loaded from an S2P file using the Characterize Adaptor Macro.

Note: Large segment counts with one or more power sensors can result in long load and close

times for the VNA Application.

 

Frequency  Enter a frequency in Hz.

Loss  Enter a loss as a POSITIVE value in dB.  To compensate for gain, use NEGATIVE values.

Delete Table Segment  Deletes row indicated in the field.

Delete All  Deletes all data in the table.

The Power Loss Compensation table survives VNA Preset and Power OFF. To NOT use Loss

compensation, clear the Use Loss table checkbox on the Power Meter Settings dialog.

 

Power Sensor Settings dialog box help

This dialog appears when you click the Sensors button on the Power Meter Settings dialog.
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Note: Be sure that the frequency range of your power sensor covers the frequency range of your

measurement. This does NOT occur automatically.

Sensor A (B)  Displays one of the following messages depending on type of sensor.

Not connected  The VNA is not detecting a power sensor.

Cal factors are contained within this sensor  This message is displayed when the Internal Reference
Cal Factor and Cal Factor data are contained in the sensor and automatically accessed.

Sensor Data  Allows the following entries for power sensor data:

Reference Cal Factor  Specifies the sensor's Reference Cal Factor.

Cal Factor Table  Specifies the frequency and corresponding Cal Factor for the sensor.

Delete Cal Factor  Deletes the indicated row in the table.

Delete All  Deletes all data in the table.

To Add a Row to the table, click on a row in the table and press the down arrow on either the VNA
front panel or keyboard. A row is added to the bottom of the table. The table is automatically sorted
by frequency when OK is pressed.

Load Cal Factors  Click to load cal factors from a *.csv file that you create from the cal factors

that appear on the sensor. The first line of the file MUST have the reference Cal Factor (typically

100), followed by Freq / Cal Factor pairs as show in the following image:

Save Cal Factors  Click to save the cal factor table to a *csv file.

Use this sensor only  Check this box to use this sensor over the entire frequency span of the

measurement, even if two sensors are connected to power meter.

Clear this box to allow entry of minimum and maximum frequencies for the sensor. Only ONE of
the two sensors can have this box checked. You will be prompted to connect the appropriate

sensor during the power calibration.

Minimum Frequency  Specifies the minimum frequency range for the sensor when using dual

sensors.

Maximum Frequency  Specifies the maximum frequency range for the sensor when using dual
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sensors.

Zero and Calibrate the Power Sensor

For highest accuracy, Zero AND Calibrate the power sensor before measuring data. Follow prompts

that may appear.

Zero - If the following settings are 'greyed', Internal or External zeroing is selected

automatically based on the power meter/sensor model. Otherwise, select the appropriate type

of zeroing to perform, then press Zero.

Internal Zero - A switch inside the power sensor removes the sensor from the incident power.

External Zero - Requires that you physically remove the sensor from incident power.

Note: For the U2000 Series USB power sensors

Calibration is NOT available. Select External Zero ONLY when the power to be measured is

below the specified level. Otherwise, the U2000 series performs internal zeroing automatically

when needed. See your power sensor documentation for more details.

U200xA - below -30 dBm

U200xH - below -20 dBm

U200xB - below 0 dBm

If your U2000 power sensor 'hangs' when external zeroing, upgrade the power sensor firmware

to Rev. A.01.02.00 or higher to fix this problem.

Note: For the U2020 X-Series USB power sensors

The U2020 X-Series support only internal zeroing. But like the U2000 series, they default to

performing zeroing automatically when needed.

Calibrate - Available when the selected sensor has calibration capability. Calibration involves
measuring an internal 1 mW source.

Keysight P-Series sensors and U2020 X-Series USB sensors have an internal reference so you can
calibrate them without connecting to a meter’s reference port.

Keysight U2000 USB power sensors do not require calibrating.

For other sensors, refer to the documentation to determine if it has calibration capability.

353



Press Calibrate, then follow the prompts.

Copy a Source Power Calibration to other Channels

A macro application is now available that copies a Source Power Calibration to other channels. Once

downloaded and installed on a VNA, the macro is automatically configured up. To learn more, click

Help on the application main dialog. Get the application from

http://na.support.keysight.com/pna/apps/applications.htm.

Saving a Source Power Calibration

Because Source Power Cal calibrates source hardware, the calibration data is saved as part of the

Instrument State, in either a .sta file or a .cst file. This correction is applied to all measurements on

the channel that uses the calibrated source. See Save Instrument State.

Reducing Time to Complete a Source Power Calibration

The time required to perform a Source Power Calibration depends on source power, number of points,

and number of readings taken. You can reduce this measurement time with the following methods:

Reduce number of points before calibration.  You can reduce the number of points before the
measurement, then return the number of points to its original value after calibration is complete and
correction is ON. The analyzer will perform a linear interpolation, although with some loss in accuracy.

Use an Keysight E-Series sensor.  You can obtain 40+ readings per second over GPIB with this type of
sensor on the VNA.

Increase power to the sensor.  Lower power may have longer settling time with some sensors.

Check Use Reference Receiver for Iteration.

Receiver Power Calibration

Note: Source and Receiver Power Calibrations are NOT available in M937xA PXI.

Note: A Guided Power Cal can be performed during an S-parameter Guided Calibration. Learn more.

Receiver power calibration mathematically removes frequency response errors in the specified VNA

receiver, and adjusts readings to the same, or a value offset from, the source power calibration level. It

is the same as doing a Response Cal or Data / Memory, (Normalization) but with the data shifted to

the Cal Power value.
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Use Receiver Power Calibration to make very accurate absolute power (amplitude) measurements.

Receiver Power Calibration:

Is ONLY allowed when making absolute power (unratioed) measurements.

Is most accurate when a source power calibration was performed first.

Applies to all unratioed measurements in the active channel using that receiver.

Can be saved in a Cal Set and later reapplied to a like measurement.

Interpolation

Like other calibration types, if the original stimulus settings are narrowed, interpolation is applied and

C* Rcvr Pwr is displayed in the status bar. If the original stimulus settings are made wider, the VNA

will turn Receiver Power Correction OFF.

If the original settings are restored, then receiver power calibration returns to full correction.

How to perform a Receiver Power Calibration

Perform a Source Power Calibration.1.

Set the active measurement to unratioed. Learn How.2.

Connect a THRU line from the source port to the receiver port.3.

When performing a receiver power cal on a reference receiver (source 1 and receiver R1), no
connection is necessary as the receiver is internally connected to the source.

When the source port and receiver port are the same (receiver A, source port 1), then connect an open
or short to get maximum power to the receiver. This practice is not recommended. It is best to use
different ports for the source and receiver.

Ensure correction for Source Power Calibration is ON as indicated by Src Pwr Cal or Src Pwr Cal* in
the status bar.

4.

Start the Calibration Wizard5.

Using Hardkey/SoftTab/Softkey

Set the active measurement to unratioed. Learn How.1.

Press Cal > Main > Other Cals > Receiver Power Cal....2.
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1.

2.

 

Select Calibration Type for Unratioed Measurement dialog box help

Cal Type Selection  Select Receiver Power

Receiver Power Configuration

Cal Power  Specifies the power level to be displayed on the measurement when complete. (Source

Port Power + Power Offset).

Source Port Power  Test port Power set for the measurement.  Learn how to change Test Port

Power

Power Offset  Allows you to specify a gain or loss (in dB) to account for components you connect

between the source and the reference plane of your measurement AFTER a source power cal has

been performed. Following the calibration, the VNA power readouts are adjusted to the Cal Power

value.

Next  Click to continue the Calibration Wizard.

Notes:

When Receiver Power Cal is finished, 'Response' is displayed in the status bar and correction data is
applied to subsequent sweeps. This is done because Receiver Power Cals are essentially Response
Cals once they are stored and applied. See Saving a Receiver Power Cal below.

To turn correction OFF, click Cal > Main > Correction > Channel Correction OFF.

Learn more about Receiver Power Cal (scroll up).

Saving a Receiver Power Calibration

Beginning with VNA Revision 5.0, Receiver Power Cal is saved to a Cal Register and optionally to a

User Cal Set. It can be applied to measurements in the same way as other Cal Types. Previously,
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Receiver Power Cal data was saved as part of an Instrument State and was only applied to the

measurement on which it was performed.

Learn more about Saving VNA files types.
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Fixture Simulator

The following features allow you to mathematically add (embed) or remove (de-embed) circuits to, or

from, your measurements. The mathematical models are applied to specific ports for all measurements

on the channel.

See Also

Procedures: To Embed or De-embed?

Characterize Adaptor Macro can be used to create S2P files from Cal Sets.

"De-embedding and Embedding S-Parameter Networks Using a Vector Network Analyzer" App note. for more
conceptual information on Fixture Simulation.

See an example of how these functions can be used to de-embed unwanted effects of a test fixture, and then
mathematically embed the DUT in the circuit in which it is used.

Order of Fixture Operations

Click to learn more about each operation.

First, the following Single-ended measurement functions are processed in this order:

Port Extensions1.

Ground loop de-embedding / embedding2.

2-Port De-embedding3.

Port Matching Circuit Embedding4.

Port Z (Impedance) Conversion5.

4-Port Network (single-ended) Embed/De-embed6.

Then, Balanced measurement functions are processed in this order:

Balanced Conversion6.

Differential / Common Mode Port Z Conversion7.

Differential Port Matching8.
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8.

Source power compensation is then optionally applied to compensate for the aggregate loss through all
enabled fixturing operations.

Notes

The fixturing operations are applied to the measurement results.

The order of operations 1 through 4 can be changed using the SCPI command:  CALC:FSIM:SEND:OORD.
Learn how to send this command from the GPIB Command Processor Console.

The order of the operations 5 through 8 can NOT be changed.

In the Data processing chain, the Fixture Simulator functions occur at the same time as the Apply Error
Terms block.

When fixturing is enabled, all of the enabled fixturing features are applied when snp files are saved.

How to select Fixturing Simulator

About Fixturing ON/off

BOTH of the following must occur to turn a fixturing selection ON.

EITHER ONE will turn a fixturing selection OFF.

Turn Apply Fixtures ON/off
Port Extensions is NOT affected by Fixturing ON/off.

1.

Check Enable on the individual fixturing selection dialog box.2.

Using Hardkey/SoftTab/Softkey

Press Cal > Fixtures > Apply Fixtures.1.

 

Port Matching dialog box help
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This function specifies a circuit to embed (add) to the measurement results.  See Order of Fixture
Operations.

Enable Port Matching  Check to apply the settings to the measurement results. Must also enable

Fixturing ON/off.

Port - Select Port in which to apply simulation.
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Circuit Model for Matching - Choose one of the following that best emulates your fixture at the

selected VNA port:

Series L - Shunt C

VNA DUT

Shunt C - Series L

VNA

 

DUT

Shunt L - Series C

VNA

 

DUT

Series C - Shunt L

VNA

 

DUT

Shunt L - Shunt C

VNA

 

DUT

User Defined (S2P File) Load a file that is specified with

User S2P File button.

None Use no circuit model.

User S2P File  Click to specify an S2P file of the circuit model to embed at the selected port. If the

normalized impedance value in a recalled User .S2P file is different from the port reference

impedance setting of the VNA, the VNA setting is used.  Characterize Adaptor Macro can be used

to create S2P files from Cal Sets.

Circuit Values

Capacitance (C), Inductance(L), Resistance(R), Conductance(G)  Values for the specific

components of the circuit type that models your fixture.

Reset  Restores the default values.

 

361



2 Port De-embedding dialog box help

De-Embed when you have performed a calibration and then added a fixture (an adapter, an

attenuator, a longer cable, etc.) that connects between the Cal reference plane and your DUT.  This

function removes the effects of a component or test fixture from the measurement results.

Note: De-embedding a component with more than 20 dB of loss becomes impractical because of an

inability to accurately measure the match of the DUT through such a device.

The de-embedding operation recalls an .s2p file (Touchstone format) which includes the electrical

characteristics of a 2-port fixture or device. The file can be in any standard format (real-imaginary,

magnitude-angle, dB-angle).
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Enable De-embedding  Check to apply the settings to the measurement results. Must also enable

Fixturing ON/off.

Enable Extrapolation  Check to apply a simple extrapolation when the S2P file has a narrower

frequency range than the channel. The values for the first and last data points are extended in either

direction to cover the frequency range of the measurement. The frequency ranges of both the

channel and the S2P file are displayed at the bottom of the dialog.

When extrapolation is necessary and enabled, a message is displayed showing the frequency range

to be extrapolated. When extrapolation is necessary and disabled, a message is displayed offering to

enable extrapolation.

This setting also causes 4-port Extrapolation to be enabled and disabled.

Port  The VNA port to which the recalled de-embedding file is applied.

From the drop-down menu, select User Defined (S2P File).

Reverse Adaptor Ports  Check to cause the Fixture/Adapter to be configured with Port 2

connected to the VNA and Port 1 to be connected to the DUT. The image in the dialog reflects that

change.

User S2P File  Click to specify an existing .S2P file. If the normalized impedance value in a

recalled User .S2P file is different from the port reference impedance setting of the VNA, the VNA

setting is used.  Characterize Adaptor Macro can be used to create S2P files from Cal Sets.

 

Port Z (Impedance) Conversion dialog box help

This function corrects the measurement and displays the results as if the measurement had been

made into the specified impedance value. However, the physical port termination is still

approximately 50 ohms.

The specified impedance value is applied to all of the measurements on ONLY the active channel.

See Order of Fixture Operations.

Enable Port Z Conversion  Check to apply the settings to the measurement results. Must also
enable Fixturing ON/off.
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R  Real part of the impedance value.

jX  Imaginary part of the impedance value.

Close  Applies the entries and closes the dialog box

Note:  Port Z (Impedance) conversion uses values in the following prioritized order:

Balanced (Differential or Common Mode) - if enabled, these values are always used.1.

Single Port Impedance - if enabled, this value is used if Balanced is not enabled.2.

System Impedance - if neither balanced or single port is enabled, this value is used.3.

 

 

4/6/8-Port Embed/De-embed dialog box help

This function specifies a single-ended 4-port circuit (*.S4P file) to embed (add) or de-embed

(remove) from the measurement results. Computation takes place BEFORE Balanced conversion.
See Order of Fixture Operations.

There is a single normalized impedance value for each port in the *.S4P file. This impedance value

must match the impedance of the previous Port Z setting, or the VNA port impedance.

The VNA will interpolate if the number of data points that are read is different from the current

VNA setting.
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Enable 4-Port Embed/De-embed  Check to apply the settings to the measurement results. Must

also enable Fixturing ON/off.

Enable Extrapolation  Check to apply a simple extrapolation when the S4P file has a narrower

frequency range than the channel. The values for the first and last data points are extended in either

direction to cover the frequency range of the measurement. The frequency ranges of both the

channel and the S4P file are displayed at the bottom of the dialog.

When extrapolation is necessary and enabled, a message is displayed showing the frequency range

to be extrapolated. When extrapolation is necessary and disabled, a message is displayed offering to

enable extrapolation.

This setting also causes 2-port Extrapolation to be enabled and disabled.

Topology

Select a DUT topology. Refer to the images on the 4-port embed/De-embed dialog box.

A - Network 1

B - Network 1/3

C - Network 1/2/4

NA Ports - Select the VNA Port that is connected to each circuit port.

Network Ports Select the network ports that represent the configuration of the S4P file.  By default,

ports 1 and 2 are connected to the VNA and ports 3 and 4 are connected to the DUT.

None, Embed, De-embed  For Network1 and Network2, select:

None - The same as disabling.

Embed - Add the specified network circuit to the measurement results. See 2-port Embed image.

De-embed - Remove the specified network circuit from the measurement results. See 2-port De-embed
image.

Browse  For both Network1 and Network2, navigate to find the .*S4P file to embed or de-embed.

OK  Applies the changes and closes the dialog box.

Cancel  Does NOT apply the changes and closes the dialog box.
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Differential Impedance Conversion dialog box help

This function sets the Differential impedance value for each balanced port.

The default value for R: is the SUM of the impedance values for both ports that make the logical

port. If Port Z Conversion is not enabled, then System Z0 values for both ports are summed.

See Order of Fixture Operations.

Enable Differential Z Conversion  Check to apply the settings to the measurement results. Must

also enable Fixturing ON/off.

Logical Port  Select the logical (balanced) port to receive impedance value. To see logical port

numbers, see the measurement topology.

R  Real part of the impedance value.

jX  Imaginary part of the impedance value.

Close  Closes the dialog box.

See note about Port Impedance priority.

 

Common Mode Impedance Conversion dialog box help

This function sets Common Mode Impedance value for each balanced port.

The default value for R: is calculated as follows.

(Z1 * Z2) / (Z1 + Z2)

Where ports 1 and 2 comprise the logical port:

Z1 = the Port Impedance values for port 1
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Z2 = the Port Impedance values for port 2

If Port Z Conversion is not enabled, then System Z0 values for port 1 and 2 are used in the

calculation.

See Order of Fixture Operations.

Enable Common Mode Z Conversion  Check to apply the settings to the measurement results.

Must also enable Fixturing ON/off.

Logical Port  Select the logical (balanced) port to receive impedance value. To see logical port

numbers, see the measurement topology.

R  Real part of the impedance value.

jX  Imaginary part of the impedance value.

Close  Closes the dialog box.

See note about Port Impedance priority.

 

Differential Port Matching dialog box help

This function allows the embedding of a differential matching circuit at a balanced port.

See Order of Fixture Operations.

Enable Differential Port Matching   Check to embed the selected matching circuit to the

measurement results. Must also enable Fixturing ON/off.
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Logical Port  Choose Logical DUT port to receive the selected matching circuit. To see logical port

numbers, see the measurement topology.

Select Circuit  Select a matching circuit. Choose from:

Shunt L - Shunt C  Predefined circuit.

Circuit Values  Choose from:

C  Capacitance value

G  Conductance value

L  Inductance value

R  Resistance value

User defined  Select an *.S2P file that represents the matching circuit. Then click Browse to navigate to
the *.S2P file.

Note: For the *.S2P file:

Port 1 of the circuit is assumed to be connected to the VNA

Port 2 of the circuit is assumed to be connected to the DUT.

None  No embedded circuit on selected port.

Close  Closes the dialog box.
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Power Compensation dialog help

This function adjusts the source power at the specified port to compensate for the combined amount

of gain or loss through ALL enabled fixturing operations. Use this function to set the power level at

the DUT input.

For example:

Your DUT requires a fixture on the input port which is connected to VNA port 1.

The fixture description (such as an S2P file at the 2-port De-embed function) indicates the fixture has
approximately 2 dB of loss across the frequency span.

You set source power to 0 dBm. But you want 0 dBm at the DUT input (the fixture output).

Check Power Compensation on Port 1 and enable Fixturing.

Power Compensation causes the source power to be increased by approximately 2 dB so that the power
at the fixture output plane will remain at 0 dBm.

Power Compensation affects all measurements in the channel.

Enable Fixturing to use Power Compensation.

Note: Use caution when applying power compensation.  Always test your setup without a DUT in a

place. If you are using S2P files, Recall your S2P file into the VNA so you can verify that the device

your S2P file describes is what you intended it to be. It is  too easy to misalign data in S2P files if

they are constructed by hand.

Ground Loop De-embedding / Embedding
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Ground loop de-embedding removes the effect of a non-ideal ground connection between the DUT’s ground and
the analyzer's ground reference. Typically, the non-ideal component is the parasitic inductance of the ground
contacts.

Ground loop embedding adds the effect of a non-ideal component on the ground contacts.

The Ground Loop De-embedding / Embedding can be specified by circuit model type or touchstone file.

Ground loop de-embedding / embedding is only available from SCPI remote interface.

Fixture Simulator Example

The following example shows a DUT and the matching circuit with which the DUT will be used in its

intended application. When the DUT is tested in a high-volume manufacturing environment, multiple

test fixtures are often required. The most accurate way to test the DUT and ensure measurement

consistency between the different test fixtures is to use a simple, repeatable, test fixture without the

actual matching elements.

To get the desired performance data, the parasitic effects of the fixture must first be removed (de-

embedded) from the measured data. Then a perfect "virtual" matching circuit must be simulated and

added mathematically (embedded) to the corrected, measured data. The result is an accurate display of

the DUT as though it was actually tested with a physical matching circuit, but without the uncertainties
of using real components.

Test Device and the circuit in which it will be used.
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Circuit Simulation

This diagram does NOT refer to the order in which operations are performed.

See Order of Fixture Operations.

Create a balanced measurement using single-ended to balanced (SE-Bal) topology. Include all relevant
measurement settings (IFBW, number of points, and so forth). Once the measurement is created and
calibrated, the measurement parameter can be easily changed. For example, Sdd22 to Sds21.

1.

Calibrate the measurement at the point where the simple test fixture is connected to the VNA. Use accurate
calibration standards and definitions.

2.

Remove the effects of the three uncalibrated transmission lines of the simple test fixture. This can be done in
several different methods. The easiest is to use manual or automatic Port Extensions to move the calibration
reference plane to the DUT. This removes the electrical length and loss of the fixture’s transmission lines, but
does not account for fixture mismatch. Another method is to de-embed previously-created *.S2p files of the 3
transmission lines. The files can be created using external ADS modeling software. Another alternative is to
create the *.S2P files by independently measuring all 3 ports of the test fixture and saving the results of each
to an S2P file.

3.

With the test fixture connected to the VNA and a DUT inserted, the measurement results now appear as
though calibration was performed at the connections to the DUT, and the device was measured in a 50-ohm
single-ended test environment. The following steps will cause the results to reflect the performance of the
device as though the device is embedded in the circuit in which it will be used.

4.

Port 1 of the device is a single-ended port and sees a source impedance the same as the VNA system
impedance, so no change is required. However, if Rs were a value other than 50 ohms, Port 1 Impedance
Conversion would be used to simulate the different impedance.

5.

Port Matching is used to simulate L1 inductance. Select any of the Shunt L circuits to embed (add) to the
measurement results. Enter the value of L and R. The C and G values can be entered as 0 (zero).

6.

Port Matching is used to simulate C1 and C2 capacitance. For both port 2 and port 3, select any of the7.
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Series C circuits to embed (add) to the measurement results. Enter the value of C and G. The L and R
values can be entered as 0 (zero).

7.

Balanced Conversion mathematically simulates the measurement in balanced mode.8.

Differential Port Matching is used to simulate L2 inductance. Select Shunt L- Shunt C and enter the
inductance / resistance value. The C and G values can be entered as 0 (zero).

9.

Finally, Differential Z Conversion is used to simulate a circuit termination of 200 ohms. If you are making
Common Mode measurements, specify Common Mode Z Conversion.

10.
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Port Extensions

Port extensions allow you to electrically move the measurement reference plane after you have performed a calibration.

Why and How to use Port Extensions

Manual Port Extensions Procedure

Port Extensions dialog and Toolbar

Step Size dialog

Automatic Port Extension dialog

See Also

Data Flow Map

Fixture Compensation features

Other Calibration Topics

Why use Port Extensions

You are unable to perform a calibration directly at your device because it is in a test fixture. Perform a
calibration at a convenient place, then use port extensions to compensate for the time delay (phase shift),
and optionally the loss, caused by the fixture.

1.

You have already performed a calibration, and then decide that you need to add a length of transmission line
in the measurement configuration. Use port extensions to "tell" the analyzer you have added the length to a
specific port.

2.
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2.

Important Note: Port Extensions and VNA Data Flow

See VNA Data Flow diagram

Normally, Port Extensions are applied to individual S-parameters in the Phase Correction process

and only applies to displayed S-parameters.

However, when Fixturing is ON or when making a Balanced Measurement, Port Extension

compensation is applied in the Apply Error Terms process which affects ALL S-parameters,

whether displayed or not. This allows all underlying S-parameters to have proper extensions

applied.  

Therefore, when using Port Extensions with features that require more than a single S-parameter

(such as k-factor in equation editor), do one of the following:

Enable Fixturing - Individual Fixturing features are NOT required to be enabled.

Use 8510 Mode Data Processing.

When Port Extension compensation is applied in the Apply Error Terms process, after a Data-to-
Memory operation has been performed, further changes to Port Extensions settings will NOT be

applied to the Memory trace.

 

How to use Port Extensions

If you know the electrical length of the fixture or additional transmission line, enter the value directly to the
Time setting.

If you know the physical length of the fixture or additional transmission line, enter the value directly to the
Distance setting.

If you do NOT know either the electrical or physical length of the fixture or additional transmission line, you
must be able to connect an OPEN or SHORT to the new reference plane - in place of the DUT. In most
cases, removing the DUT will leave a suitable OPEN at the new reference plane.

Port Extensions can then be added manually (as follows), or by using Automatic Port Extensions.

Manual Port Extensions Procedure

Select a calibrated S11 measurement.1.

Select Phase format.2.

3.
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1.

2.

With an OPEN or SHORT at the calibration reference plane, verify that the phase across the frequency span
is at or near zero.

3.

Connect the fixture or added transmission line and attach an OPEN or SHORT in place of the DUT. In most
cases, removing the DUT will leave a suitable OPEN at the new reference plane. On the Port Extension
toolbar or dialog, increase either Time or Distance until the phase response is flat across the frequency span
of interest.

4.

If you know the loss of the additional transmission line, enter the Loss Compensation values using either one
or two data points.

5.

Note: Most OPEN and SHORT standards have delay. Therefore, adjusting delay with this method

results in a delay equal to two times the delay of the OPEN or SHORT.

How to set Port Extensions

Using Hardkey/SoftTab/Softkey

Press Cal > Port Extension > Port Extensions....1.

 

Port Extensions dialog and Toolbar help  

Port extensions settings affect all measurements on the active channel that are associated with a particular port.

Learn Why and How to use Port Extensions (scroll up).

 

Port  Select a port for delay and loss values. Port Extensions settings affect ALL measurements on
the active channel that are associated with a particular port.
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Port Extension  Turns ON and OFF port extensions on all ports.

Show Toolbar  Check to show the Port Extensions toolbar. The toolbar allows you to make

adjustments to the port extensions while showing more of the screen.  This is the only way to show

or hide the toolbar.

Delay

Enter delay in either Distance or Time by entering a value or clicking the up/down arrows. Click

 to start the Step Size dialog.

Time  The amount of port extension delay in time. Enter a positive value.

Distance  The amount of port extension delay in physical length. Enter a positive value.

Distance Units  (Dialog ONLY) Select from Meters, Inches, or Feet. The Step Size setting will

not change automatically. Learn more.

Loss

The following settings allow the entire frequency span to be corrected for loss.

Loss at DC  Offsets the entire frequency span by this value. Loss1 or Use1 must also be checked.

To compensate for loss at DC, enter a positive value which causes the trace to shift in the positive

(up) direction.

Loss @Frequency  Check the box, and enter values for Loss and Frequency

When Loss1 or Loss1/Loss2 are used, a curved-fit algorithm is used as follows:

Loss1 ONLY:

Loss(f) = Loss1 * (f/Freq1) ^ 0.5

Loss1 and Loss2:

Set the lower frequency to Loss1, and the higher frequency to Loss2.

Loss(f) = Loss1 * (f/Freq1) ^ n

Where:

n = log10 [abs(Loss1/Loss2)] / log10 (Freq1/Freq2)

Note: abs = absolute value

Velocity
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Velocity Factor  For each port, sets the velocity factor that applies to the medium of the device

that was inserted after the measurement calibration. The value for a polyethylene dielectric cable

is 0.66 and 0.7 for PTFE dielectric. 1.0 corresponds to the speed of light in a vacuum.

Couple to system Velocity Factor  When unchecked, the Velocity Factor is set for only the

specified port and only for Port Extensions.  When checked, sets the Velocity Factor for all ports.

In addition, changing this value also changes this setting for the Electrical Delay and Time Domain
Distance Marker features.

Media

For each port, select the media of the added transmission line or fixturing.

Coax  Select when the fixture or added transmission line is coax. Also specify the velocity factor

of the coax.

Waveguide / Cutoff Frequency  Select when the fixture or added transmission line is

waveguide. Also enter cutoff (minimum) frequency of the waveguide.

Note: when using a Waveguide cal Kit, set System Z0 to 1 ohm before calibrating.

Couple to system Media Definition.  When unchecked, the Waveguide Cutoff Frequency is set

for only the specified port and only for Port Extensions.  When checked, sets the Waveguide

Cutoff Frequency for all ports. In addition, changing this value also changes this setting for the

Electrical Delay feature.

Reset   All port extensions settings are changed to preset values. The Port Extension ON / OFF state

is NOT affected.

Auto Ext.  Starts the Automatic Port Extensions dialog box

Note: Individual receiver port extensions (A,B, and so forth) cannot be set.
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Step Size  dialog box help  

Changes the step size that occurs when the Time or Dist up/down arrows are pressed on the Port

Extension toolbar. The Units for step size are changed on the Port Extension dialog.

Auto  Step Size is set to the default value.

User Defined  Enter a step size value, then click OK.

This value remains the same when the units are changed. For example if a step size of 12 is entered

on this dialog, then you change the units from Inches to Feet, the step size of 12 inches becomes 12

feet, not 1 feet. Therefore, change the units first, then set the step size.

Learn about Port Extensions (scroll up)

 

Automatic Port Extension dialog box help

Automatic Port Extension AUTOMATICALLY performs the same operation as Manual Port
Extension. By connecting a SHORT or OPEN, the reference plane is automatically moved to the

point at which the standard is connected. In addition, Automatic Port Extension will optionally
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measure and compensate for the loss of the additional transmission line.

Auto Port Extension is NOT available when:

Sweep type is set to power sweep

Frequency Offset is ON

Media is set to Waveguide

Note: Turn OFF Equations that may exist on the active trace when using Automatic Port Extensions.

Auto Port Extensions Procedure

Connect the added transmission line or fixture. Attach an OPEN or SHORT to all affected ports at the
new reference plane. In most cases, removing the DUT will leave a suitable OPEN at the new reference
plane.

1.

On the Port Extension toolbar, click Auto Port Ext. Click Show Configuration to make additional
settings.

2.

Click Measure to perform the port extension calculations. The resulting delay and loss settings are
entered into the port extension toolbar. These settings are saved with Instrument Save or you can
manually record the values and enter them again when required.

3.

Settings

Measure either OPEN, SHORT, or both  Press a button to make the measurement of the

reflection standard.

Measure either OPEN or SHORT depending on which is most convenient. An ideal OPEN and

SHORT, with zero loss and delay, is assumed. Therefore, accuracy is most affected by the quality of

the standard. In most cases, removing the DUT will leave a suitable OPEN at the new reference

plane. When measuring both OPEN and SHORT standards, the average of the two is used and will
slightly improve accuracy.

Selected Ports  Indicates the ports that currently have automatic port extension enabled. By default,

ALL analyzer ports are enabled. To disable a port, see Measure on Port Number below.

Note: Port Extensions settings affect ALL measurements on the active channel that are associated

with a particular port.

Show/Hide Configuration  Press to either show or hide the following configuration settings in the

dialog box.

Measure on Port Number
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Select port number to enable or disable automatic port extension.

Enable  Check to enable the specified port. All enabled ports will have their reference plane

automatically adjusted after performing Automatic Port Extension.

Include Loss   Check to automatically measure the loss in the additional transmission line and

apply compensation. To calculate loss compensation, frequencies at 1/4 and 3/4 through the

frequency range are usually used as Freq1 and Freq2 values. Learn more about Loss Compensation.

Adjust for Mismatch  Only available when Include Loss is checked. Mismatch adds ripple to the

S11 and S22 traces.  If the ripple is large, S11 and S22 can appear greater than 0 dB which leads to

numeric instabilities in using the S-parameters.  Adjust for mismatch increases the loss of the

fixture so that the peak of the ripples is below 0 dB.  While this adds more error (all the error is

negative) it does allow the S-parameters to be used in simulators without numerical instabilities.

Check - Offsets the trace to cause all of the data points to be at or below zero.

Clear - Most accurate application of the curve-fit calculation, but allows positive responses.

Prompt for Each Standard  Check to invoke a prompt when the Measure OPEN or SHORT

button is pressed. The prompt will indicate which standard to connect to which port.

Method

Select the span of data points which will be used to determine correction values for phase and loss

(optional). If a portion of the current frequency span does not have flat or linear response, you can

eliminate this portion from the calculations by using a reduced User Span.

To calculate loss compensation, Current Span and User Span methods usually use frequencies at 1/4

and 3/4 through the frequency range as Freq1 and Freq2 values. See Loss Compensation to learn more

about how loss is calculated.

Current Span   Use the entire frequency span to determine phase and loss values.

Active Marker  Use only the frequency at the active marker, and one data point higher in

frequency, to calculate phase and loss values. If a marker is not present, one will be created in the
center of the frequency span.

User Span   Use the following User Span settings to determine phase and loss values.

User Span

Start  Enter start frequency of the user span.

Stop  Enter stop frequency of the user span.
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Learn about Port Extensions (scroll up).

See also Comparing Delay Functions
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Swap Adapters and Offset Delay Calibration Methods

The Swap Adapters or Offset Delay calibration method is used when you do NOT have calibration

standards with the same connector type as your DUT. In this case, the Offset Delay is the preferred

calibration method over the Swap Adapters method.

The Swap Adapters calibration method (also known as Swap Equal Adapters and Equal Length

Adapters) was used in the past as a quick alternative to the more tedious adapter removal method. This

method requires that the adapters be of equal electrical length. There are two adapters for each port.

The swap equal adapter method implicitly assumes the adapters have identical return loss. The finite

return loss of each adapter on each port degrades both the residual directivity and residual match terms.

The offset delay calibration only has one adapter. The return loss of this one adapter will degrade the

residual directivity and residual match error terms.

Note:  For any other reason, these calibration methods are NOT recommended because the Unknown
Thru method is more convenient AND more accurate.

The Offset Delay calibration method uses the available standards for calibration then adds offset delay

to the measurement plane to account for each adapter used. This eliminates the need for adapters with

equal electrical length and is preferred over the Swap Adapters method.

Swap Adapters Procedure

The following is an example procedure showing how to perform a Swap Adapters 2-port calibration for

a non-insertable DUT. The DUT has 2.92 mm connectors. You do NOT have 2.92 mm calibration

standards, but you DO have 2.4 mm standards and adapters that have the same electrical delay as the

2.92 mm adapters.

Adapters A1 and A2 = test port to 2.4 mm adapters

Adapters B1 and B2 = test port to 2.92 mm adapters
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Start the Cal Wizard and select Guided (Smart) Cal.  Note: The VNA will NOT prompt you to connect the
adapters by name or when to swap the adapters.

1.

Specify the connector type and gender and Cal Kit of the adapter that you will be using (2.4 mm) - NOT
the connector type of the DUT (2.92 mm). By specifying the connector gender, you are also specifying the
Thru method (flush thru for insertable and Unknown Thru for non-insertable.) For example, when both
DUT ports have female connectors, we will perform an Unknown Thru cal.

2.

When prompted for reflection standards on port 1, connect
the Open, Short, and Load standards to Adapter A1.

3.

When prompted for reflection standards on port 2, connect
the Open, Short, and Load standards to Adapter A2.

4.

When prompted for a Thru connection, swap Adapter A1
and A2 for B1 and B2. Connect the Thru device. This
could be any device that meets the requirements of the
Unknown Thru standard. In the case of a non-insertable
DUT, connect B1 and B2.

5.

Make DUT measurements with Adapters B1 and B2 in
place.

6.

 

Offset Delay Procedure

The following is an example procedure showing how to perform a 2-port calibration for a non-
insertable DUT using Offset Delay to account for the added delay of two adapters. The DUT has 2.92
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mm connectors. You do NOT have 2.92 mm calibration standards, but you DO have 2.4 mm standards

and adapters.

Adapters = test port to 2.4 mm (female)-to-2.92 mm (male) adapters

Start the Cal Wizard and select Guided (Smart) Cal.1.

Specify the connector type and gender and Cal Kit that you will be using (2.4 mm) - NOT the connector
type of the DUT (2.92 mm). By specifying the connector gender, you are also specifying the Thru method
(flush thru for insertable and Unknown Thru for non-insertable.) For example, when both DUT ports have
female connectors, we will perform an Unknown Thru cal.

2.

When prompted for reflection
standards on port 1, connect the
Open, Short, and Load standards.

3.

When prompted for reflection
standards on port 2, connect the
Open, Short, and Load standards.

4.

When prompted for a Thru connection,
connect the Thru device between port
1 and port 2. This could be any device
that meets the requirements of the
Unknown Thru standard. In this
example of a non-insertable DUT, a
female-to-female 2.4 mm barrel
adapter is used as the Thru device.

5.

Click on Response, Cal, then select
Port Extension. The Port Extension
dialog is used to electrically move the
measurement reference plane after
you have performed a calibration to
account for the two adapters. Learn
more about Port Extensions.

6.

Select Port 1 and enter the delay of
the adapter connected to Port 1.

7.

Select Port 2 and enter the delay of

the adapter connected to Port 2.

8.

Click OK.9.
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9.

Make DUT measurements with
Adapters and DUT in place.

10.
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Calibration Overview

The following is discussed in this topic:

What Is Measurement Calibration?

Why Is Calibration Necessary?

Conditions Where Calibration Is Suggested

What Is ECal?

See other Calibration Topics

What Is Measurement Calibration?

Calibration removes one or more of the systematic errors using an equation called an error model.

Measurement of high quality standards (for example, a short, open, load, and thru) allows the analyzer

to solve for the error terms in the error model. See Measurement Errors.

You can choose from different calibration types, depending on the measurement you are making and

the level of accuracy you need for the measurement. See Select a Calibration Type.

The accuracy of the calibrated measurements is dependent on the quality of the standards in the

calibration kit and how accurately the standards are modeled (defined) in the calibration kit definition

file. The calibration-kit definition file is stored in the analyzer. In order to make accurate

measurements, the calibration-kit definition must match the actual calibration kit used. To learn more,

see Accurate Calibrations.

Calibration Wizard provides the different calibration methods used in the VNA. See Calibration Wizard.

There are quick checks you can do to ensure your measurement calibration is accurate. To learn more

see Validity of a Measurement Calibration

If you make your own custom-built calibration standards (for example, during in-fixture

measurements), then you must characterize the calibration standards and enter the definitions into a

user modified calibration-kit file. For more information on modifying calibration kit files, see

Calibration Standards.

Note: Instrument Calibration is ensuring the analyzer hardware is performing as specified. This is not the

same as measurement calibration.

Why Is Calibration Necessary?
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It is impossible to make perfect hardware that would not need any form of error correction. Even

making the hardware good enough to eliminate the need for error correction for most devices would be

extremely expensive.

The accuracy of network analysis is greatly influenced by factors external to the network analyzer.

Components of the measurement setup, such as interconnecting cables and adapters, introduce

variations in magnitude and phase that can mask the actual response of the device under test.

The best balance is to make the hardware as good as practically possible, balancing performance and

cost. Calibration is then a very useful tool to improve measurement accuracy.

Conditions Where Calibration Is Suggested

Generally, you should calibrate for making a measurement under the following circumstances:

You want the best accuracy possible.

You are adapting to a different connector type or impedance.

You are connecting a cable between the test device and an analyzer test port.

You are measuring across a wide frequency span or an electrically long device.

You are connecting an attenuator or other such device on the input or output of the test device.

If your test setup meets any of the conditions above, the following system characteristics may be

affected:

Amplitude at device input

Frequency response accuracy

Directivity

Crosstalk (isolation)

Source match

Load match

What Is ECAL

ECal is a complete solid-state calibration solution. It makes one port (Reflection), full two and three-

port calibrations fast and easy. See Using ECal.

387



It is less prone to operator error.

The various standards (located inside the calibration module) never wear out because they are switched with
PIN-diode or FET switches.

The calibration modules are characterized using a TRL-calibrated network analyzer.

ECal is not as accurate as a good TRL calibration.

For information about ordering ECal modules, see Analyzer Accessories or contact your Keysight Support
Representative
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Measurement Errors

You can improve accuracy by knowing how errors occur and how to correct for them. This topic

discusses the sources of measurement error and how to monitor error terms.

Drift Errors

Random Errors

Systematic Errors

3-Port Error Terms

4-Port Error Terms

Monitoring Error Terms

See other Calibration Topics

Drift Errors

Drift errors are due to the instrument or test-system performance changing after a calibration has been

done.

Drift errors are primarily caused by thermal expansion characteristics of interconnecting cables within

the test set and conversion stability of the microwave frequency converter and can be removed by re-

calibrating.

The time frame over which a calibration remains accurate is dependent on the rate of drift that the test

system undergoes in your test environment.

Providing a stable ambient temperature usually minimizes drift. For more information, see Measurement
Stability.

Random Errors

Random errors are not predictable and cannot be removed through  error correction. However,
there are things that can be done to minimize their impact on measurement accuracy. The
following explains the three main sources of random errors.

Instrument Noise Errors
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Noise is unwanted electrical disturbances generated in the components of the analyzer.
These disturbances include:

Low level noise due to the broadband noise floor of the receiver.

High level noise or jitter of the trace data due to the noise floor and the phase noise of the LO source inside
the test set.

You can reduce noise errors by doing one or more of the following:

Increase the source power to the device being measured - ONLY reduces low-level noise.

Narrow the IF bandwidth.

Apply several measurement sweep averages.

Switch Repeatability Errors

Mechanical RF switches are used in the analyzer to switch the source attenuator settings.

Sometimes when mechanical RF switches are activated, the contacts close differently from when they

were previously activated. When this occurs, it can adversely affect the accuracy of a measurement.

You can reduce the effects of switch repeatability errors by avoiding switching attenuator settings

during a critical measurement.

Connector Repeatability Errors

Connector wear causes changes in electrical performance. You can reduce connector
repeatability errors by practicing good connector care methods. See Connector Care.

Systematic Errors

Systematic errors are caused by imperfections in the analyzer and test setup.

They are repeatable (and therefore predictable), and are assumed to be time invariant.

They can be characterized during the calibration process and mathematically reduced during measurements.

They are never completely removed. There are always some residual errors due to limitations in the
calibration process. The residual (after measurement calibration) systematic errors result from:

imperfections in the calibration standards

connector interface
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interconnecting cables

instrumentation

Reflection measurements generate the following three systematic errors:

Directivity

Source Match

Frequency Response Reflection Tracking

Transmission measurements generate the following three systematic errors:

Isolation

Load Match

Frequency Response Transmission Tracking

Notes about the following Systematic Error descriptions:

The figures for the following six systematic errors show the relevant hardware configured for a forward
measurement. For reverse measurements, internal switching in the analyzer makes Port 2 the source and
Port 1 the receiver. 'A' becomes the transmitted receiver, 'B' becomes the reflected receiver, and 'R2'
becomes the reference receiver. These six systematic errors, times two directions, results in 12 systematic
errors for a two port device.

For simplicity, it may be stated that ONE standard is used to determine each systematic error. In reality, ALL
standards are used to determine ALL of the systematic errors.

The following describes an SOLT calibration. This does not apply to TRL or other types of calibration.

Directivity Error

All network analyzers make reflection measurements using directional couplers or bridges.

With an ideal coupler, only the reflected signal from the DUT appears at the 'A' receiver. In reality, a

small amount of incident signal leaks through the forward path of the coupler and into the 'A' receiver.

This leakage path, and any other path that allows energy to arrive at the 'A' receiver without reflecting

off the DUT, contributes to directivity error.
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How the Analyzer Measures and Reduces Directivity Error.

During calibration, a load standard is connected to Port 1. We assume no reflections from the load.1.

The signal measured at the 'A' receiver results from the incident signal leakage through the coupler and other
paths.

2.

Directivity error is mathematically removed from subsequent reflection measurements.3.

Isolation Error

Ideally, only signal transmitted through the DUT is measured at the 'B' receiver.

In reality, a small amount of signal leaks into the 'B' receiver through various paths in the analyzer.

The signal leakage, also known as crosstalk, is isolation error which can be characterized and reduced by

the analyzer.

How the Analyzer Measures and Reduces Isolation Error

1.

2.
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During calibration, load standards are connected to both Port 1 and Port 2.1.

The signal measured at the 'B' receiver is leakage through various paths in the analyzer.2.

This isolation error is mathematically removed from subsequent transmission measurements.3.

Source Match Error

Ideally in reflection measurements, all of the signal that is reflected off of the DUT is measured at the

'A' receiver.

In reality, some of the signal reflects off the DUT, and multiple internal reflections occur between the

analyzer and the DUT. These reflections combine with the incident signal and are measured at the 'A'

receiver, but not at the 'R' receiver.

This measurement error is called source match error which can be characterized and reduced by the

analyzer.

 

How the Analyzer Measures and Reduces Source Match Error

During calibration, all reflection standards are connected to Port 1. Known reflections from the standards are
measured at the 'A' receiver.

1.

Complex math is used to calculate source match error.2.

Source match error is mathematically removed from subsequent reflection and transmission measurements.3.

Load Match Error

Ideally in transmission measurements, an incident signal is transmitted through the DUT and is

measured at the 'B' receiver.

In reality, some of the signal is reflected off of Port 2 and other components and is not measured at the
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'B' receiver.

This measurement error is called load match error which can be characterized and reduced by the

analyzer.

How the Analyzer Measures and Reduces Load Match Error

The Port 1 and Port 2 test connectors are mated together for a perfect zero-length thru connection. If this is
not possible, a characterized thru adapter is inserted. This allows a known amount of incident signal at Port
2.

1.

The signal measured at the 'A' receiver is reflection signal off of Port 22.

The resulting load match error is mathematically removed from subsequent transmission and reflection
measurements.

3.

Frequency Response Reflection Tracking Error

Reflection measurements are made by comparing signal at the 'A' receiver to signal at the 'R1' receiver. This is called a ratio
measurement or "A over R1" (A/R1).

For ideal reflection measurements, the frequency response of the 'A' and 'R1' receivers would be identical.

In reality, they are not, causing a frequency response reflection tracking error. This is the vector sum of all test variations in
which magnitude and phase change as a function of frequency. This includes variations contributed by:

signal-separation devices

test cables

adapters

variations between the reference and test signal paths
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Frequency response reflection tracking error can be characterized and reduced by the analyzer.

How the Analyzer Measures and Reduces Frequency Response Reflection Tracking Error.

During calibration, all reflection standards are used to determine reflection tracking.1.

The average 'A' receiver response is compared with the 'R1' receiver response.2.

Complex math is used to calculate Frequency Response Reflection Tracking Error (see the following
diagram). This frequency response reflection tracking error is mathematically removed from subsequent DUT
measurements.

3.

Note: In reflection response calibrations, only a single calibration standard is measured (open or short)

and thus only its contribution to the error correction is used.

Frequency Response Transmission Tracking Error

Transmission measurements are made by comparing signal at the 'B' receiver to signal at the 'R1'

receiver. This is called a ratio measurement or "B over R1" (B/R1).

For ideal transmission measurements, the frequency response of the 'B' and 'R1' receivers would be

identical.
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In reality, they are not, causing a frequency response transmission tracking error. This is the vector sum

of all test variations in which magnitude and phase change as a function of frequency. This includes

variations contributed by:

signal-separation devices

test cables

adapters

variations between the reference and test signal paths

Frequency response transmission tracking error can be characterized and reduced by the analyzer.

How the Analyzer Measures and Reduces Frequency Response Transmission Tracking Error.

During calibration, the Port 1 and Port 2 test connectors are mated together for a perfect zero-length thru
connection. If this is not possible, a characterized thru adapter is inserted. This allows a known amount of
incident signal to reach Port 2.

1.

Measurements are made at the 'B' and 'R1' receivers.2.

Complex math is used to calculate Frequency Response Transmission Tracking Error (see the following
diagram). This frequency response transmission tracking error is mathematically removed from subsequent
DUT measurements.

3.
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3-Port Error Terms

The following flow diagram displays the 3-port error term model:

where:

E = error term

DIR = Directivity

MAT = Forward Source Match and Reverse Load Match

TRK = Forward Reflection Tracking and Reverse Transmission Tracking

 

4-Port error terms
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A full 4-port calibration requires the following terms:

Learn about the port numbering convention for error terms.

 

    Source Port

    1 2 3 4

R

e

c

 

P

o

r

t

1

DIR

1,1

RTRK

1,1

SRM

1,1

LDM 1,2

TTRK 1,2

XTLK 1,2

LDM 1,3

TTRK 1,3

XTLK 1,3

LDM

1,4

TTRK

1,4

XTLK

1,4

2

LDM

2,1

TTRK

2,1

XTLK

2,1

DIR 2,2

RTRK 2,2

SRM 2,2

LDM 2,3

TTRK 2,3

XTLK 2,3

LDM

2,4

TTRK

2,4

XTLK

2,4

3

LDM

3,1

TTRK

3,1

XTLK

3,1

LDM 3,2

TTRK 3,2

XTLK 3,2

DIR 3,3

RTRK 3,3

SRM 3,3

LDM

3,4

TTRK

3,4

XTLK

3,4

4

LDM

4,1

TTRK
4,1

XTLK

4,1

LDM 4,2

TTRK 4,2

XTLK 4,2

LDM 4,3

TTRK 4,3

XTLK 4,3

DIR

4,4

RTRK

4,4

SRM
4,4

Reflection terms

DIR: Directivity
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RTRK: Reflection Tracking

SRM: Source Match

Transmission terms

LDM:Load Match

TTRK: Transmission Tracking

XTLK: Cross Talk

How can we measure only 3 THRU connections?

On a 4-port VNA, a full 4-port cal can be performed while measuring only 3 THRU connections.

Measuring more than 3 THRU connections on a VNA with four native ports can give higher accuracy

under some conditions.

By measuring all of the reflection terms, and 3 transmission THRU connections, there is adequate

information available to calculate the remaining transmission terms. The following is a high level

explanation of the concept. The actual calculations are much more complex.

To simplify, let's substitute letters (A,B,C,D) for port numbers from the diagram above so that they can

be combined without confusion. Also for simplicity, let's assume that the source match and directivity

errors are zero.

 
  A B C D

A AA AB AC AD
B BA BB BC BD
C CA CB CC CD
D DA DB DC DD

The reflection errors are all measured (AA, BB, CC, DD).

Lets assume we measure a THRU between ports AB, AC, AD. The reverse direction for these THRUs are
also measured at the same time (BA, CA, DA).

The terms left to calculate are BC, CB, BD, DB, CD, DC.

The following shows how the BC term is calculated from BA and AC:
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Similarly:

CB is calculated from CA and AB
BD is calculated from BA and AD
DB is calculated from AB and DA
CD is calculated from CA and AD
DC is calculated from DA and AC

Monitoring Error Terms using Cal Set Viewer

You can use Cal Set Viewer to monitor the measured data and the calculated error term. This will help

to determine the health of your VNA and the accuracy of your measurements.

By printing or saving the error terms, you can periodically compare current error terms with previously

recorded error terms that have been generated by the same VNA, measurement setup, and calibration

kit. If previously generated values are not available, refer to Typical Error Term Data in Appendix A,

"Error Terms", of the Service Guide.

Note: The service guide for your VNA is available at http://www.Keysight.com/find/pna

A stable system should generate repeatable error terms over about six months.

A sudden shift in error terms over the same frequency range, power, and receiver settings, may indicate the
need for troubleshooting system components. For information on troubleshooting error terms, see Appendix
A , "Error Terms", of the Service Guide.

A subtle, long-term shift in error terms often reflects drift or connector and cable wear. The cure is often as
simple as cleaning and gauging connectors or inspecting cables.

Viewing Cal Set Data

Existing measurement traces are unaffected by the Cal Set Viewer.

The Cal Set data trace is presented in the highest unused channel number (usually 32) in the active window.

The Cal Set data trace is labeled as S11 in the status bar regardless of the type of error term or standard.

Only one Cal Set error term or standard data can be viewed at a time. However, a data trace can be stored
into memory and then compared to other data traces.

See the error terms equations.
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How to access Cal Set Viewer

Using Hardkey/SoftTab/Softkey

Press Cal > Cal Sets & Cal Kits > Cal Set Viewer ON|OFF1.

How to use Cal Set Viewer

Use the down arrow to select a Cal Set. Then click either:1.

Error Terms - calculated data.

Standards - the raw measurement data of the Standard. ONLY available with Unguided Cal (not
ECal or Guided Cal).

Use the down arrow to select an error term or standard to view.2.

Select the Enable check box to view the data on the VNA screen.3.

Port numbering convention for error terms is the same as for S-Parameters:

E Term (Receiver, Source) with the following exceptions:

Load Match (2,1) - The match of port 2 which is measured by making an S11 measurement.

Load Match (1,2) - The match of port 1 which is measured by making an S22 measurement.

Transmission Tracking (2,1) - The port 2 receiver relative to the port 1 reference. (source=port 1).

Transmission Tracking (1,2)  - The port 1 receiver relative to the port 2 reference. (source=port 2).

And so forth for multiport calibrations.
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Accurate Measurement Calibrations

Calibration accuracy is affected by the type of calibration, quality of the calibration standards, and the

care with which the calibration is performed. This section provides additional information about how to

make accurate calibrations.

Measurement Reference Plane

Effects of Using Wrong Calibration Standards

Data-based versus Polynomial Calibration Kits

Accuracy Level of Interpolated Measurement

Effects of Power Level

Using Port Extensions

Isolation Portion of 2-Port Calibration

Choosing a Thru Method

Learn how to determine the validity of your calibration.

See other Calibration Topics

Measurement Reference Plane

Most measurement setups will NOT allow you to connect a device under test (DUT) directly to the

analyzer front panel test ports. More likely, you would connect your device to test fixtures, adapters, or

cables that are connected to the analyzer.

A calibration takes place at the points where calibration standards are connected during the calibration

process. This is called the measurement reference plane (see graphic).  For the highest measurement

accuracy, make the calibration reference plane the place where your DUT is connected.  When this

occurs, the errors associated with the test setup (cables, test fixtures, and adapters used between the

analyzer ports and the reference plane) are measured and removed in the calibration process.
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Effects of Using Wrong Calibration Standards

Normally, a calibration is performed using a calibration kit that contains standards with connectors of

the same type and sex as your DUT.

However, your calibration kit may not always have the same connector type and gender as your device.

For example, suppose your device has 3.5mm connectors, but you have a Type-N calibration kit. If you

use an adapter to connect the Type-N standards to the 3.5mm test port, then the adapter becomes part of

the calibration and NOT part of the test setup. This will result in significant errors in your reflection

measurements.

Data-based versus Polynomial Calibration Kits

The Select DUT Connectors and Cal Kits dialog box offers a data-based model and a polynomial model for

the newest high-frequency cal kits. See Analyzer Accessories. The data-based models provide higher

accuracy for describing calibration standards than the polynomial models. It is RECOMMENDED that

the data-based model be used if the most accurate results are desired.

  Data-Based Model Polynomial Model

How accurate is the model? Provides highest calibration

accuracy. Eliminates the errors

that can be the result of

polynomial model

approximations.

Provides high calibration

accuracy.

How does the model define

calibration standards?

Uses S-Parameter

measurements.

Uses traditional four-term

polynomial calibration

standard modeling parameters.

How do I manually edit the

definitions of the calibration

standards when using the

model?

Use the Advanced Modify Cal Kit
function.

Use the Advanced Modify Cal Kit
function.
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How do I use the Calibration

Wizard with the model?

Use only the SmartCal

(Guided) Calibration method.

Use the SmartCal (Guided) or

the Unguided Mechanical

Calibration methods.

Learn about the “Expanded Math” feature.

Effects of Power Level

To attain the most accurate error correction, do NOT change the power level after a calibration is

performed. However, when changing power within the same attenuator range at which the

measurement calibration was performed, S-parameter measurements can be made with only a small

degradation of accuracy. If a different attenuator range is selected, the accuracy of error correction is

further degraded.

To check the accuracy of a calibration, see Validity of a Calibration.

Using Port Extensions

Use the port extensions feature after calibration to compensate for phase shift of an extended

measurement reference plane due to additions such as cables, adapters, or fixtures.

Port extensions is the simplest method to compensate for phase shift,  mismatch, and loss of the path between the calibration
reference plane and the DUT.

Learn how to apply port extensions.

Learn about characterizing a test fixture.

Isolation Portion of 2-Port Calibration

The isolation portion of a calibration corrects for crosstalk, the signal leakage between test ports when
no device is present. When performing an UNGUIDED 2-port calibration, you have the option of

omitting the isolation portion of the calibration.

Note: Isolation can be performed on a Smart (Guided) Calibration ONLY.

The uncorrected isolation between the test ports of the analyzer is exceptional (typically >100 dB).

Therefore, you should only perform the Isolation portion of a 2-port calibration when you require
isolation that is better than 100 dB. Perform an isolation calibration when you are testing a device with

high insertion loss, such as some filter stopbands or a switch in the open position.

The isolation calibration can add noise to the error model when the measurement is very close to the

noise floor of the analyzer. To improve measurement accuracy, set a narrow IF Bandwidth.
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How to perform an Isolation Calibration

Isolation is measured when the Load standards are connected to the analyzer test ports. For best

accuracy, connect Load standards to BOTH test ports each time you are prompted to connect a load

standard. If two Loads are not available, connect the untested analyzer port to any device that will

present a good match.

Choosing a Thru Method

When calibrating for a non-insertable device, you must choose a method to calibrate for the THRU

error terms. This can have a significant effect on measurement accuracy. Learn more about choosing a
thru method.
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Validity of a Calibration

This section helps you determine if your calibration is valid and how the analyzer displays correction

level information for your measurement.

Frequency Response of Calibration Standards

Validating a Calibration

Quick Check

ECal Confidence Check

Determining Effects of Not Terminating Unused ECal Ports

Verification Kit

See other Calibration Topics

Frequency Response of Calibration Standards

In order for the response of a calibration standard to show as a dot on the smith chart display format, it
must have no phase delay with respect to frequency. The only standards that exhibit such "perfect"

response are the following:

7-mm short (with no offset)

Type-N male short (with no offset)

There are two reasons why other types of calibration standards show phase delay after calibration:

The reference plane of the standard is electrically offset from the mating plane of the test port. Such
devices exhibit the properties of a small length of transmission line, including a certain amount of phase
shift.

1.

The standard is an open termination, which by definition exhibits a certain amount of fringe capacitance
and therefore phase shift. Open terminations which are offset from the mating plane will exhibit a phase
shift due to the offset in addition to the phase shift caused by the fringe capacitance.

2.

The most important point to remember is that all standards are measured in order to remove

systematic errors from subsequent device measurements. As a result, if calibration standards with
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delay and fringe capacitance are measured as a device after a calibration, they will NOT appear to

be "perfect". This is an indication that your analyzer is calibrated accurately and working

properly.

Validating a Calibration

At the completion of a calibration or selection of a stored Cal Set, validation can accomplish the

following:

Improve Measurement Accuracy – Once a measurement calibration has been performed, its

performance should be checked before making device measurements. There are several sources of error

that can invalidate a calibration: bad cables, dirty or worn calibration standards that no longer behave

like the modeled standards, and operator error.

Verify Accuracy of Interpolation – You should validate the calibration if you are testing a device and

the measurements are uncertain because of interpolation.  For more information see Interpolation
Accuracy.

Verify Accuracy of Cal Standards – To check accuracy, a device with a known magnitude and phase

response should be measured.

Quick Check

For this test, all you need are a few calibration standards. The device used should not be one of the

calibration standards; a measurement of one of these standards is merely a measure of repeatability.

The following reflection and transmission Quick Check tests can be applied to all test ports.

To verify reflection measurements, perform the following steps:

Connect either an OPEN or SHORT standard to port 1. The magnitude of S11 should be close to 0 dB (within
a few tenths of a dB).

1.

Connect a load calibration standard to port 1. The magnitude of S11 should be less than the specified
calibrated directivity of the analyzer (typically less than -30 dB).

2.

To verify transmission measurements:

Connect a THRU cable (or known device representative of your measurement) from port 1 to port 2. Verify
the loss characteristics are equivalent to the known performance of the cable or device.

1.

To verify S21 isolation, connect two loads: one on port 1 and one on port 2. Measure the magnitude of S21
and verify that it is less than the specified isolation (typically less than -80 dB).

2.
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2.

Note: To get a more accurate range of expected values for these measurements, consult the analyzer's

specifications.

ECal Confidence Check

ECal Confidence Check is a method to check the accuracy of a calibration performed with mechanical

standards or an ECal module. The confidence check allows you to measure an impedance state in the

ECal module (called the confidence state), and compare it with factory measured data stored in the

module.

In order for this test to be valid, the test ports of the ECal module must connect directly to the

calibration reference plane (without adapters).

Note: In the N469x series of 2-port ECal modules, from the module minimum frequency up to

approximately 2 GHz, the confidence state has a very high amount of transmission loss. In this

frequency range, calibrated measurements of transmission S-parameters for the confidence state may

vary much more than expected from the Keysight-characterized data in the measurement memory trace.

 When comparing the measurement trace and memory trace you, ignore the data for frequencies up to 2

GHz.

How to Perform ECal Confidence Check:

Connect ECal module to the analyzer with the USB cable. See Connect ECal Module to the VNA. Note:
Terminate any unused ECAL ports with a 50 ohm load. See below.

1.

Allow the module to warm up for 15 minutes or until the module indicates READY.2.

Do one of the following to start ECal Confidence Check3.

Using Hardkey/SoftTab/Softkey

Press Cal > Cal Sets & Cal Kits > ECal > ECal Confidence Check....1.

On the following ECal Confidence Check dialog box:

Click Read Module Data. The following occurs:2.

ECal module is set to "confidence state".

Analyzer reads and displays stored data.

Analyzer measures and displays "confidence state".

3.
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To view a different parameter, select Change Measurement and select the check box for the desired
parameter.  The default is the active channel parameter.

3.

Select the viewing option in the Trace View Options block.4.

Compare the stored and measured data for each measurement parameter.5.

Notes:  

After exiting ECal Confidence Check, the ECal module remains in the same impedance state and the
factory (or user-characterized) data is still stored in the memory trace. Therefore, you can save both the
data and memory trace as a *.csv files and import them to a spreadsheet. Learn how.

If the two traces show excessive difference, there may be a loose or dirty connection at the test ports or
damage to the test cables. Carefully inspect the cables and connections. Then clean and gage each
connector, and re-calibrate if needed.

The User Characterization setting selects the user-characterization data instead of the factory
characterization data (available when a User-Characterization is stored in the ECal module).

Determining Effects of Not Terminating Unused ECal Ports

The following procedure can be used to determine the calibration errors when unused ECal ports are

not terminated.

Connect the ECal module to one VNA test port through an adapter (eliminates the possibility of cable
movement errors being included) and leave the unconnected port(s) open.

1.

Perform a 1-port cal (use 100 Hz IFBW) then save the calset.2.

Connect a load(s) to the unconnected port(s) of the ECal module.3.

Perform a 1-port cal then save the calset.4.

Compare the calset in step 2 with the calset in step 4 using Calset Viewer to evaluate the effect of leaving
the unused ECal ports open.

5.

ECal Confidence Check dialog box help
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Compares the accuracy of corrected (calibrated) data with stored data in the ECal module. For the

check to be valid, the module test ports must connect directly to the calibration reference plane

(without an adapter). Learn more about ECal Confidence Check.

Measurement

Change Measurement  Opens the Measure dialog box.

 

Use ECal Module

Read Module Data

Copies stored data from the ECal module to Memory.

Changes state of ECal module to confidence state.

Measures and displays confidence state and Memory trace.

Displays the factory and user characterizations data stored in the ECal module. Learn more.

Scale  Opens the Scale dialog box.

Show Prompts  Check to show a reminder for the connection (default).

Trace View Options

Data and Memory Trace  Displays current measurement data and Memory trace.

Data / Memory  Performs an operation where the current measurement data is divided by the

data in memory.
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Data + Memory  Performs an operation where the current measurement data is added to the data

in memory.

Verification Kit

Measuring known devices, other than calibration standards, is a straightforward way of verifying that

the network analyzer system is operating properly. Verification kits use accurately known verification

standards with well-defined magnitude and phase response. These kits include precision airlines,

mismatch airlines, and precision fixed attenuators. Traceable measurement data is shipped with each kit

on disk and verification kits may be re-certified by Keysight.

See Analyzer Accessories for a list of Keysight verification kits.
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Calibration Standards

This following section explains the general principles and terms regarding calibration kit files. To learn

how to modify calibration kit files, See Modify Calibration Kits.

About Calibration Kits

Calibration Standards

Standard Type

Standard Definitions

Class Assignments

See other Calibration Topics

About Calibration Kits

A calibration kit contains a set of physical devices called standards. Each standard has a precisely

known or predictable magnitude and phase response as a function of frequency.  All Keysight Cal Kits

and their standard definitions are stored in the analyzer. For a list of Keysight calibration kits, see

Analyzer Accessories.

Calibration Standards

Calibration standards provide the reference for error-corrected measurements in the network analyzer.

Each standard has a precisely known definition that includes electrical delay, impedance, and loss. The

analyzer stores these definitions and uses them to calculate error correction terms.

During measurement calibration, the analyzer measures standards and mathematically compares the
results with the definitions ("ideal models") of those standards. The differences are separated into error

terms that are later removed from device measurements during error correction. See Systematic Errors.

Standard Type

A standard type is one of four basic types that define the form or structure of the model to be used with

that standard. The following are the four basic standard types:
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Standard Terminal Impedance

SHORT zero ohms

OPEN infinite ohms

LOAD system impedance, Z0

THRU/LINE no terminal impedance

Learn about other Calibration Standards:

Data-Based Standard

Sliding Load

Offset Load

Arbitrary Impedance Load

Standard Definitions

Standard definitions describe the electrical characteristics of the standards and the frequencies they will

be used. Standard definitions can be viewed from the Advanced Modify Cal Kit menu selection. Standard

definitions include:

Minimum Frequency  Specifies the minimum frequency the standard is used for calibration.

Maximum Frequency  Specifies the maximum frequency the standard is used for calibration.

Z0  Specifies the characteristic impedance of the standard (not the system characteristic impedance or the
terminal impedance of the standard).

Delay  Specifies a uniform length of transmission line between the standard being defined and the actual
calibration plane.

Type  Specifies type of standard (SHORT, OPEN, THRU/LINE, LOAD, ARBITRARY).

Loss  Specifies energy loss, due to skin effect, along a one-way length of coaxial cable.

Loss model equation:

The value of loss is entered as ohms/second at 1 GHz.

To compute the loss of the standard, measure the delay in seconds and the loss in dB at 1 GHz. Then use
the following formula:
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Capacitance model equation:

C0, C1, C2, C3. Specifies the fringing capacitance for the open standard.

C = (C0) + (C1 x F) + (C2 x F²) + (C3 x F³)

(F is the measurement frequency).

The terms in the equation are defined when specifying the open as follows:

C0 term is the constant term of the third-order polynomial and is expressed in Farads.

C1 term is expressed in F/Hz (Farads/Hz).

C2 term is expressed in F/Hz².

C3 term is expressed in F/Hz³.

Inductance model equation:

L0, L1, L2, L3. Specifies the residual inductance for the short standard.

L = (L0) + (L1 x F) + (L2 x F²) + (L3 x F³)

(F is the measurement frequency).

The terms in the equation are defined when specifying the short as follows:

L0 term is the constant term of the third-order polynomial and is expressed in Henries.

L1 term is expressed in H/Hz (Henries/Hz)

L2 term is expressed in H/Hz².

L3 term is expressed in H/Hz³.

Class Assignments

Once a standard is characterized, it must be assigned to a standard "class". A standard class is a group
of standards that are organized according to the calibration of the network analyzer error model.

The number of classes needed for a particular calibration type is equal to the number of error terms

being corrected.
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A class often consists of a single standard, but may be composed of multiple standards. These may be

required for accuracy or to cover a wide frequency range.

Example: A response calibration requires only one class, and the standards for that class may include

an OPEN, or SHORT, or THRU. A 1-port calibration requires three classes. A  2-port calibration

requires 10 classes, not including two for isolation.

The number of standards assigned to a given class may vary from one to seven for unguided

calibrations. Guided calibrations allow as many standards as needed.

Calibration Classes are assigned in the Advanced Modify Cal Kit menu, SOLT or TRL tab.

The different classes used in the analyzer

S11A, S11B, S11C (S22A, S22B, S22C and so forth)

These are the three classes for port 1-reflection calibrations (three classes also for S22 and S33). They

are used in the one-port calibrations and the full two-port calibration. They are required in removing the

directivity, source match, and reflection tracking errors. Typically, these classes might consist of an

open, a short and a load standard for each port.

Transmission and Match (forward and reverse)

These classes are used to perform a full two-port calibration.  The transmission class relates primarily

to the transmission tracking, while the match class refers to load match.  For both of these classes, the

typical standard is a thru or delay.

Isolation

The isolation classes are used to perform a full two-port and the TRL two-port calibrations. The

isolation classes apply to the forward and reverse crosstalk terms in the network analyzer error model.

TRL THRU

These are used to perform a TRL two-port calibration. The TRL thru class should contain a thru

standard or a short line.  If it contains a non-zero length thru standard, then the calibration type is called

LRL or LRM.

TRL REFLECT

This class is used to perform a TRL two-port calibration. The TRL reflect class should contain a

standard with a high reflection coefficient, typically an open or short.  The actual reflection coefficient

need not be known, but its phase angle should be specified approximately correctly (± 90 deg).  The

exact same reflection standard must be used on both ports in the TRL calibration process.

TRL LINE or MATCH
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These are used to perform a TRL two-port calibration. The TRL line or match class should contain line

standards, load standards, or both.  If a line standard is used, its phase shift must differ from that of the

TRL THRU standard by 20° to 160°.  This limits the useable frequency range to about 8 to 1.  Two or

more line standards of different lengths may be specified to get broader frequency coverage.  It is also

common to include a load standard for covering low frequencies, where the line's length would be

impractically long.  When a load is used, the calibration type is called TRM or LRM.

 

Note:  For more information, read Specifying Calibration Standards and Kits for Keysight Vector Network
Analyzers (Application Note 1287-11)
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Modify Calibration Kits

The following topics discuss Modifying Calibration Kits:

In this Topic

How to Modify Cal Kits

Manage Cal Kits dialog

Cal Kits and Firmware Upgrades

Import Kit dialog

Using VNA CalKit Editor

Connectors Tab

Standards Tab

SOLT Tab

TRL Tab

Concepts

Why Modify a Cal Kit

VNA Cal Kit File Types

Procedures

How to Create a New Cal Kit from an Existing Cal Kit

Creating Custom Calibration Kits using a New Connector Family

Noise Figure and TRL Cal (separate topic)
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How to Modify Cal Kits

The series of dialog boxes that follow allow you to modify the standard definitions or class

assignments of calibration kit files.

Using Hardkey/SoftTab/Softkey Using a mouse

Press Cal > Cal Sets & Cal Kits > Cal Kit...1. Click Response1.

Select Cal2.

Select Cal Sets & Cal Kits3.

Select Cal Kit...4.

Manage Cal Kits

Manage Cal Kits dialog box help

The Manage Cal Kits dialog allows you to define the cal kits in the active workspace. These cal kits
may be edited, created, or saved to a cal kit file.
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Cal Kits and Firmware Upgrades

If the firmware upgrade includes factory cal kits that are formatted differently than the factory cal kit
files in the instrument, then:

The factory cal kit files will be overwritten.

The custom cal kit files will not be changed.

A backup of the active workspace will be saved.

A new active workspace will be created and will contain only the new factory cal kit definitions.

Under these conditions, if you want to use your custom cal kit definitions, you will need to import
these files into the active workspace. Learn how to import cal kit files.

Uncertainty Cal Kits (Only for PNA)

Uncertainty Cal Kits... Opens the Uncertainty Cal Kit Manager (Option S93015A enabled).

Learn more about Dynamic Uncertainty.

Standard Cal Kits

This group box lists all cal kits in the active workspace.

Edit... Starts the Connectors tab of the Edit Kit dialog box to modify selected calibration kit

definitions.

Import... Starts the Import Kit dialog box to add a cal kit definition from a file into the active

workspace.

Save...  Saves the selected calibration kit definition into a cal kit file (using .xkt, .ckt, or .prn file

type). See VNA Cal Kit File Types.

Insert...  Starts a blank Edit Kit dialog box to create a new calibration kit.

Delete  Deletes selected calibration kit from the active workspace.

Print...  Prints the contents of the selected cal kit to a .prn file.

Cal Kit Workspace

The active cal kit workspace is a collection of standard cal kits that are accessible by the VNA for

calibrations.
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Save Workspace... Saves the active workspace to a workspace file (*.xkw or *.wks).

Recall Workspace... Recalls a workspace file into the active workspace.

Restore Defaults Restores the active workspace and the factory cal kit files (*.xkt) to their

factory default definitions.

For more information see Creating Custom Calibration Kits using a New Connector Family.

 

 

Import Cal Kit dialog box help

Note:  There is no limit to the number of cal kits that can be imported. However, during an Unguided
cal, you can access ONLY mechanical cal kits #1 through 95.

Imports a cal kit file into the active cal kit workspace.

Files of type  Select the file type of your Cal Kit. Learn more about VNA Cal Kit File Types

File name  Navigate and select your cal kit file name.

Open  Loads the selected file into the active cal kit workspace.

Note: See Cal Kits and Firmware Upgrades

Importing Cal Kits from "legacy" network analyzers

Cal kit files from "legacy" network analyzers (such as the 8510 or 8753) may not contain
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information that this VNA requires. Therefore, this VNA may modify the cal kit name, description,

standards, and class assignments. You may need to correct these modifications after importing your

legacy cal kit to meet your specific requirements.

"Legacy" cal kit files are referenced to the VNA test port gender while modern cal kit files are referenced
to the Device Under Test (DUT) connector gender. Therefore, when a legacy cal kit is imported, the
genders of the standards in the legacy cal kit will be automatically reversed in the new cal kit.

Legacy cal kits do not contain connector definitions. If a coaxial legacy kit is imported, then male and
female coax connector definitions will be added to the kit. If a waveguide legacy kit is imported, then a
genderless waveguide connector definition will be added to the kit.
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Why Modify a Cal Kit

For most applications, the default calibration kit models provide sufficient accuracy for your

calibration. However, several situations may exist that would require you to create a custom calibration

kit:

Using a connector interface different from those used in the predefined calibration kit models.

Using standards (or combinations of standards) that are different from the predefined calibration kits. For
example, using three offset SHORTs instead of an OPEN, SHORT, and LOAD to perform a 1-port
calibration.

Improving the accuracy of the models for predefined kits. When the model describes the actual performance
of the standard, the calibration is more accurate. For example: A 7 mm LOAD is determined to be 50.4 Ù
instead of 50.0 Ù.

Modifying the THRU definition when performing a calibration for a non-insertable device.

Performing a TRL calibration.
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Creating a New Connector Family

To create a custom calibration kit that uses a new connector type, you must first define the connector

family. The connector family is the name of the connector-type of the calibration kit, such as:

APC7

2.4 mm

Type-N (50Ù)

Although more than one connector family is allowed, it is best to limit each calibration kit to only one

connector family.

If you are using a connector family that has male and female connectors, include definitions of both

genders. If you are using a family with no gender, such as APC7, only one connector definition is

required.

Use the following steps to create a custom calibration kit:

Press Cal > Cal Sets & Cal Kits > Cal Kit....1.

Click Edit....2.

In the Connectors Tab, click Add to name the new connector family.3.

Enter the Kit Description for the custom cal kit.4.

Click Add in the Connectors section of the dialog box.5.

Enter a Connector Family name.6.

Enter a Description of the connector.  7.

Select the Gender of one of the connectors.  8.

Enter the minimum and maximum Frequency Range.9.

Enter the Impedance.10.

Click the down-arrow to select the Media.11.

Enter the cut-off frequency12.

Click Apply.  13.

14.
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12.

13.

Click OK.14.

If you need to add another connector gender, in the Connectors Tab, click Add in the Connectors section
again for the next connector gender.  

15.

If you are adding another connector gender, repeat step 3.16.

Note: If you have male and female versions of the connector family, you probably do NOT also have a

NO GENDER version.  

Enter Standards

Now that the connector family is added to the custom cal kit, you are ready to add new calibration

standards.

In the Standards Tab, under the list of standards, click Add.1.

Select the type of standard (OPEN, SHORT, LOAD, or THRU), then click OK.  2.

Complete the information in the dialog box for the standard you selected. Note that for banded standards, the
start and stop frequency may be different than the frequency range of the specified connector. Edit the start
and stop frequencies as needed. Click OK when all the settings are correct.

3.

Repeat steps 2 - 3, as necessary, to add all standards and definitions to the new custom cal kit.4.

Assign each of the standards to a calibration class. This is done through the TRL Tab or SOLT Tab5.

Save the Cal Kit.6.
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How to Create a New Cal Kit from an Existing Cal Kit

You can create a new custom Cal Kit using an existing Cal Kit as a starting point.

Here is how:

Press Cal > Cal Sets & Cal Kits > Cal Kit....1.

Immediately click Save... and change the file name. Select either *.xkt or *.ckt, *.prn file type. Learn more
about these file types.

2.

Make modifications to your new custom Cal Kit as required.3.

Routinely save your work by clicking Save.4.

See Also

About VNA Cal Kits and Firmware Upgrades
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VNA Cal Kit File Types

The VNA Cal Kit editor can open the following types of Cal Kit files:

VNA Families File Type

Cal Kits supported by current firmware of these

VNA models: PNA Series, ENA Series, FieldFox,

and PXI Series

*.xkt

Old PNA Series Cal Kits (PNA Firmware A.07.50

to A.09.90)

*.ckt

Old PNA Series Cal Kit (before A.07.50) *.ck1

Previous FieldFox format Cal Kits *.xml

Previous ENA format Cal Kits *.ckx

8510 Cal Kit .CK_*

8753, 8752, 8719, 8720, or 8722 Cal Kit *.ck

 

The current revision of Cal Kit files can be downloaded at
http://na.support.keysight.com/pna/caldefs/stddefs.html

File Save (As)

The VNA Cal Kit Editor can save Cal Kits in one of three file formats:

*.xkt - Newer format that is based on xml and is shared among VNA families.

*.ckt - VNA binary format, provided for backwards compatibility with older VNA firmware revisions and may
not support future new cal kit capabilities, which is expected of the *.xkt format.

*.prn - Cal kit print files. This is a text file format which can be read into spreadsheets, but the Cal Kit Editor
does not read-in these files. These files are only produced as a form of documentation.

About Opening Legacy VNA Kits

Cal kit files from Keysight "legacy" network analyzers (listed above) may not contain information that

the VNA requires. When loaded into the VNA Cal Kit Editor, the cal kit name and description, the cal

standards, and the cal class assignments will be modified in a best effort manner. You may need to

correct these modifications after importing your legacy cal kit to meet your specific requirements.

"Legacy" cal kit files are based on the analyzer test port sex. Modern VNA cal kits are based on the Device
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Under Test (DUT) connector sex.  Therefore, when the kit is imported the standard's label and description
are reversed and are noted as F- (female) and M- (male) .

When a Coaxial standard is detected in the kit file, a pair of male/female connectors is typically created.

Waveguide standards that are created as connector have no gender.

File Association

With the exception of *.xml, the above file types are automatically associated with the CalKit Editor if

they are not already associated with a different program. That means, after running CalKit Editor,

double-clicking any of the above file types (except *.xml) will open the file using CalKit Editor.

If you have already associated one of these file types with a different program and would like to change

it to CalKit Editor, do the following:

Right-click the file, then click Open With1.

Browse to the CalKitEditor install folder.

C:\Program Files (x86)\Agilent\VNA Cal Kit Editor

2.

Check Always use the selected program to open this kind of file.3.

Select CalKit Editor.4.
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Connectors Tab

Cal Kit Name  Allows you to change the Name of the selected calibration kit.

Cal Kit Description  Allows you to change the description of the selected calibration kit.

 

Connector Family .Click the down arrow to select the connector family associated with the Cal Kit.

Add  Starts the Add Connector dialog box which allows you to add new connector type to the calibration

kit.

Delete  Deletes - WITHOUT WARNING - the selected connector family.

Note: To modify a connector family or name, Add a new connector, then delete the old connector.

The following is the list of Factory-defined connector type strings:
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APC 3.5 female

APC 3.5 male

APC 2.4 female

APC 2.4 male

APC 7

Type N (50) female

Type N (50) male

Type N (75) female

Type N (75) male

Type F (75) female

Type F (75) male

Type A (50) female

Type A (50) male

Type B

7-16 female

7-16 male

2.92 mm female

2.92 mm male

1.85 mm female

1.85 mm male

1.0 mm female

1.0 mm male

X-band waveguide

P-band waveguide

K-band waveguide

Q-band waveguide

R-band waveguide

U-band waveguide

V-band waveguide

W-band waveguide

Frequency Range

Min  Allows you to define the lowest frequency at which the standard is used for calibration.

Max  Allows you to define the highest frequency at which the standard is used for calibration.

Gender

Gendered - The connector family contains both Male and Female connectors.

Genderless - The connector family does NOT contain Male and Female connectors. APC7

connectors are an example of this connector type.

Impedance

Specify the impedance of the standard.

Media

The medium (or 'geometry') of the connector (COAX or WAVEGUIDE).

Cutoff Frequency  If Media is Waveguide, type the low-end cutoff frequency.

Height/Width Ratio  Used to calculate waveguide loss. This value is usually on the data sheet for

waveguide devices.

About Waveguide Cal Kits

If modifying or creating a waveguide cal kit, be sure to make the following settings. You can create a
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custom waveguide cal kit using an existing factory waveguide Cal kit as a starting point. The factory cal

kits already have these settings.

Frequency Range: Min. frequency = Cutoff frequency.

Gender: No Gender

Impedance Z0: 1 ohm

Media: Waveguide

For waveguide, choose TRL (Thru-Reflect-Line) calibration type . These calibration types are more

accurate and take fewer steps than SOLT.

Add Connector Family

Enter a name for the new connector family. Then click OK.

Available at the bottom of every tab

Save As - Allows you to save the cal kit to a new file name and type.

Save - Saves the cal kit to the same file name and type.

Close - Closes the cal kit editing session. The file is NOT saved automatically.
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Standards Tab

Allows you to Add, Edit or Delete cal standards in a cal kit.

Add Standard (Open, Short, Load, Thru, or Data-based)

Add Standard dialog box help

Allows you to add standards to the calibration kit file.

Choose from:

OPEN

SHORT

LOAD

THRU

DATA-BASED

ISOLATION
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Standards dialog box help

The following fields apply to ALL standard types:

The other areas of the dialog change depending on the type of standard selected.

Identification

Standard ID  Number in list of standards

Label  Type of standard. This usually appears in prompts for standards.

Description  Description of standard.

 

The following fields apply to ALL standard types EXCEPT the Isolation type:

Connector

Indicates the type and gender (Male, Female, None) of the standard.

Thru and Isolation standards have two connectors.

Data-Based standards MAY have two connectors.

Frequency Range

Min  Defines the lowest frequency at which the standard is used for calibration.

Max  Defines the highest frequency at which the standard is used for calibration.
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The Delay Characteristics fields apply to MOST standard types:

Delay Characteristics

Delay  Defines the one-way travel time from the calibration plane to the standard in seconds.

Z0  Defines the impedance of the standard.

Loss  Defines energy loss in Gohms, due to skin effect, along a one-way length of coaxial cable.

 

Other fields are unique to standard type

Choose from:

OPEN

SHORT

LOAD

THRU

DATA-BASED

ISOLATION

 

Open Standard

C0, C1, C2, C3  Specifies the fringing capacitance.

These are the unique fields of the dialog. See the areas that are common to all standards.
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Short Standard

L0, L1, L2, L3  Specifies the residual inductance.

Load Standard

Choose from the following

Fixed Load  Specifies the load type as Fixed. The fixed load is assumed to be a perfect termination

without reflection.

Sliding Load

A sliding load is defined by making multiple measurements of the device with the sliding load

element positioned at various marked positions of a long transmission line. The transmission line is

assumed to have zero reflections and the load element has a finite reflection that can be

mathematically removed using a least squares circle fitting method.

A sliding load cal can be very accurate when performed perfectly. It can also be very inaccurate when
not using proper technique. For accurate results, closely follow the users manual instructions for

the sliding load.

Arbitrary Impedance  
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Specifies the load type that has an impedance value different from system Z0.  An arbitrary

impedance device is similar to a fixed load except that the load impedance is NOT perfect. Early

firmware releases of the VNA series used a fixed resistance value. A complex terminating impedance

has been added to allow for more accurate modeling of circuit board or on-wafer devices.

The following Complex Impedance settings are available ONLY when Arbitrary Impedance is

selected.

Real  The real portion of the impedance value.

Imaginary  The imaginary portion of the impedance value.

Offset Load

Using an Offset Load standard results in a more accurate calibration than with a Broadband Load.

Therefore, when performing a calibration using one of the modified Cal Kit definitions, you may be

prompted to connect more standards than before this change. To revert to using the Broadband Load

Standard without offset, do the following:

Press Cal > Cal Sets & Cal Kits > Cal Kit....1.

At the Manage Cal Kit dialog box, click Edit....2.

Select the SOLT tab.3.

Under the Calibration Kit Classes, select SC (Loads)4.

Under Selected Standards, select Broadband Load, then click Move Up until the standard is at the top of
the list. This will ensure that the Broadband Load is used first.

5.

About Offset Load

An offset load is a compound standard consisting of a load element and two known offset elements

(transmission lines) of different length. The shorter offset element can be a zero-length (Flush-thru)

offset. The load element is defined as a 1-port reflection standard. An offset load standard is used
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when the response of the offset elements are more precisely known than the response of the load

element. This is the case with waveguide. Measurement of an offset load standard consists of two

measurements, one with each of the two offset elements terminated by the load element. The

frequency range of the offset load standard should be set so that there will be at least a 20 degree

separation between the expected response of each measurement.

To specify more than two offset elements, define multiple offset load standards. In cases where more

than two offsets are used, the frequency range may be extended as the internal algorithm at each

frequency will search through all of the possible combinations of offsets to find the pair with the

widest expected separation to use in determining the actual response of the load element.

The following Offset Load settings are available ONLY when Offset Load is selected.

First Offset Standard

Second Offset Standard  

Load Standard  

Thru Standard

Connectors - Defines connector type at both ends of the Thru standard.

Virtual Device

Most cal kits have only one Thru standard definition for SOLT calibrations. For these cases, use the

default selections (checked for zero-length Thrus and cleared for non-zero-length Thrus).
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This checkbox is used to make forward and reverse measurements of your Thru standard for the same

pair of ports in two separate steps. This is NOT common for zero-length (Flush) Thru standards.

When checked, calibration prompts involving that Thru will omit the Description. For example

“Connect port 1 to port 2”. This is the common prompt for Flush-Thru standards.

When cleared, calibration prompts for that Thru will include the Description. For example “Connect

<standard description> between ports 1 and 2”.

To make forward and reverse measurements of your Thru standard for the same pair of ports as two

separate steps, do the following:

Create separate definitions of the Thru standard(s) using the same settings, except for the Label and
Description. Clear this checkbox for BOTH definitions.

1.

For one Thru definition, in the label and description include the word 'FORWARD' to prompt the operator to
use this standard for the forward measurement.  Assign this standard to the SOLT “FWD TRANS” and
“FWD MATCH” classes of the cal kit.

2.

For the Thru definition, in the label and description include the word 'REVERSE' to prompt the operator to
use this standard for the reverse measurement.  Assign this standard to the SOLT “REV TRANS” and
“REV MATCH” classes of the cal kit.

3.

When you perform SOLT calibrations using this cal kit, the forward measurements of the Thru will be
measured in one connection step, and the reverse measurements in another.  

4.

Data-Based Standard
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Note: To learn how to modify data-based standard files, visit http://na.support.keysight.com/pna/dbcal.html

Learn about the relative accuracy of Databased versus Polynomial Cal Kits.

The modified file can then be uploaded into the VNA.

Upload Data From File

Click Load Data File, then navigate to the *.dat or *.dsd file which is provided with the data-based

Cal Kit. Both Response data and Accuracy (Uncertainty) data is provided in a single *dat or *.dsd

file.

For Advanced Users

Response data can be loaded from a *.s2p or *.cti file.

Accuracy data can be loaded from a *.cti file.

Virtual Device

This checkbox is displayed for a Data-Based cal standard when the standard has been defined to have 2

ports.  

When Cleared (default) calibration prompts for that standard will include it’s Description. For example
“Connect <standard description> between ports 1 and 2”.  

When Checked, calibration prompts for that standard will NOT include its Description, so the prompt will be
worded as if the data-based standard is a zero-length Thru connection. For example “Connect port 1 to port
2”.

Isolation Standard

The pair of loads are considered one standard.
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Both loads are connected to the VNA and measured with the same prompt.

 

Available at the bottom of every tab

Save As - Allows you to save the cal kit to a new file name and type.

Save - Saves the cal kit to the same file name and type.

Close - Closes the cal kit editing session. The file is NOT saved automatically.
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SOLT Tab

Note: This dialog looks similar to the dialog that appears after the Cal Wizard View / Modify dialog.

However, setting changes in that dialog affect ONLY the calibration that is in progress. These settings,

accessed through Modify Cal Kit, changes the cal kit for all future calibrations that use this cal kit.

Allows you to assign single or multiple standards to SOLT Calibration Classes.

Click the TRL tab to assign standards to TRL Calibration Classes.

For each Cal Kit Class, select Available Standards from the left list, then click >> to copy the standard to the
Cal Kit.

1.

Use MOVE UP and MOVE DOWN to change the ORDER of the standards. The order is used in guided
calibrations to determine which standards in that class will be used in calibrations that involve the frequency
ranges over which the standards are defined. Guided cals will include standards in the order in which they
appear in this class list, and in the case where standards in the class list have frequency ranges that overlap,
the order also determines which standard is used for frequencies in the overlap range.  For example, let's

2.
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assume that you define a broadband Short from Min Freq.= 0 Hz and Max Freq.= 999 GHz, and that
standard is listed first in the SB or TRL REFLECT class. If you then list a frequency-banded Short with the
same connector below the broadband short in those same classes, then guided calibrations would not use
the frequency-banded Shorts because the broadband Shorts would always be given priority.

SOLT <cal class> Label

The cal standard category label that appears in the VNA’s user interface during unguided SOLT

calibrations.

Calibration Kit Classes

For each calibration class, select Available Standards, then click >> to move to the Selected

Standards list.

SA - OPEN Standards (standards in the SA class are not always Opens)

SB - SHORT Standards

SC - LOAD Standards

FWD / REV Trans and Match - THRU Standards. Most Cal Kits do NOT include a physical THRU standard,
but assume that an Insertable Thru will be used.

UNKNOWN THRU - Unknown Thru Cal is the preferred THRU method of calibrating the analyzer to
measure a non-insertable device. The Unknown Thru calibration is also known as Short-Open-Load-
Reciprocal Thru (SOLR) calibration. Learn more.

ISOLATION - Isolation standard.  For VNA analyzers, ISOLATION calibration is not usually recommended. It
could be beneficial in some situations where custom user-supplied test set hardware is being used.

Link FWD TRANS, FWD MATCH, REV TRANS, and REV MATCH  Check to automatically

assign the standard definition for FWD TRANS to FWD MATCH, REV MATCH, and REV TRANS.

Clear to separately assign FWD MATCH, REV MATCH and REV TRANS classes (SOLT calibrations

only).

Expanded Calibration

The following two check boxes apply ONLY during Guided Calibrations. For Unguided

Calibration, these check boxes are ignored, including the case where the multiple standards dialog box

is presented.

Measure all mateable standards in class  Check this box to attain the very highest accuracy
possible. For example, if a cal kit contains several load standards, during the calibration process you

will be prompted to measure each of the standards. This could require a significant amount of
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calibration time. When checked, the "Use expanded math when possible" box is also checked

automatically.

Use expanded math when possible  Some kits contain multiple calibration standards of the same

type that together cover a very wide frequency range. (For example: multiple shorts, or a lowband

load and a sliding load.) If a calibration requires more than one standard to cover the calibration

frequency range, there can be regions of overlapping measurements. When this checkbox is selected,

the VNA automatically computes the most accurate measurement in the overlap regions using a

"weighted least squares fit" algorithm. This function improves accuracy without slowing the

calibration speed.

Manually select this checkbox only when using a cal kit that contains multiple standards of the

same type. (For example: multiple shorts, or a lowband load and a sliding load.)

The checkbox is cleared by default when a polynomial model is selected from the cal kit menu.

The checkbox is selected by default when the 85058B or 85058E data-based model is selected

from the cal kit menu.

Available at the bottom of every tab

Save As - Allows you to save the cal kit to a new file name and type.

Save - Saves the cal kit to the same file name and type.

Close - Closes the cal kit editing session. The file is NOT saved automatically.
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TRL Tab

On the image below, click a setting area to learn more.

Allows you to assign single or multiple standards to Calibration Classes.

For each Cal Kit Class, select Available Standards from the left list, then click >> to copy the standard to the
Cal Kit.

1.

Use MOVE UP and MOVE DOWN to change the ORDER of the standards. The order is used in guided
calibrations to determine which standards in that class will be used in calibrations that involve the frequency
ranges over which the standards are defined. Guided cals will include standards in the order in which they
appear in this class list, and in the case where standards in the class list have frequency ranges that overlap,
the order also determines which standard is used for frequencies in the overlap range. For example, let's
assume that you define a broadband Short from Min Freq.= 0 Hz and Max Freq.= 999 GHz, and that
standard is listed first in the SB or TRL REFLECT class. If you then list a frequency-banded Short with the
same connector below the broadband short in those same classes, then guided calibrations would not use
the frequency-banded Shorts because the broadband Shorts would always be given priority.

2.

Note: The TRL LINE/MATCH class has a slight exception to these prioritization behaviors.  In

general, Line standards are given a higher priority than Match standards.  So if a Line standard and a

Match standard are defined to have the same frequency range and the Match standard is listed above

the Line standard in the class order, a guided TRL cal will still prefer to use the Line standard rather

than the Match standard.

TRL <cal class> Label

The cal standard category label that appears in the VNA’s user interface during unguided TRL

calibrations.

Cal Kit Classes
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For VNA analyzers, ISOLATION calibration is not usually recommended. It could be beneficial in some
situations where custom user-supplied test set hardware is being used.

TRL THRU

Note: All THRU calibration methods are supported in a TRL Cal EXCEPT Unknown Thru.

The THRU standard can be either a zero-length or non-zero length. However, a zero-length THRU is more
accurate because it has zero loss and no reflections, by definition.

The THRU standard cannot be the same electrical length as the LINE standard.

If the insertion phase and electrical length are well-defined, the THRU standard may be used to set the
reference plane.

The THRU standard and LINE standard have the same characteristic impedance and are perfectly matched.
They define the reference impedance of the calibration.

If a THRU standard with the correct connectors is NOT available, an adapter removal cal can be performed.

TRL REFLECT

The REFLECT standard can be anything with a high reflection, as long as it is the same when connected to
one or more VNA ports.

The REFLECT standard on each port is identical.

The actual magnitude of the reflection need not be known.

The phase of the reflection standard must be known within 1/4 wavelength.

If the magnitude and phase of the reflection standard are well-defined, the standard may be used to set the
reference plane.

TRL LINE

The LINE and THRU standards establish the reference impedance for the measurement after the

calibration is completed. TRL calibration is limited by the following restrictions of the LINE standard:

Must be of the same impedance and propagation constant as the THRU standard.

The electrical length need only be specified within 1/4 wavelength.

Cannot be the same length as the THRU standard.
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A TRL cal with broad frequency coverage requires multiple LINE standards. For example, a span from 2 GHz
to 26 GHz requires two line standards.

Must be an appropriate electrical length for the frequency range: at each frequency, the phase difference
between the THRU and the LINE should be greater than 20 degrees and less than 160 degrees. This means
in practice that a single LINE standard is only usable over an 8:1 frequency range (Frequency Span / Start
Frequency). Therefore, for broad frequency coverage, multiple lines are required.

At low frequencies, the LINE standard can become too long for practical use. The optimal length of the LINE
standard is 1/4 wavelength at the geometric mean of the frequency span (square root of f1 x f2).

Note: The TRL LINE standard must have a delay that is greater than 0 (zero) ps. Otherwise,

calibration correction calculations will contain unpredictable results.

TRL MATCH

If the LINE standard of appropriate length or loss cannot be fabricated, a MATCH standard may be

used instead of the LINE.

The MATCH standard is a low-reflection termination connected to both Port 1 and Port 2.

The MATCH standard may be defined as an infinite length transmission line OR as a 1-port low reflect
termination, such as a load.

When defined as an infinite length transmission line, both test ports must be terminated by a MATCH
standard at the same time. When defined as a 1-port load standard, the loads are measured separately. The
loads are assumed to have the same characteristics.

The impedance of the MATCH standard becomes the reference impedance for the measurement. For best
results, use the same load on both ports. The load may be defined using the data-based definition, the
arbitrary impedance definition, or the fixed load definition.

Calibration Reference Z0  (TRL only)

System Z0   The system impedance is used as the reference impedance. Choose when the desired test

port impedance differs from the impedance of the LINE standard. Also, choose when skin effect

impedance correction is desired for coax lines.

Line Z0  The impedance of the line standard is used as the reference impedance, or center of the

Smith Chart. Any reflection from the line standard is assumed to be part of the directivity error.

Testport Reference Plane  (TRL only)

Thru Standard  The THRU standard definition is used to establish the measurement reference

plane. Select if the THRU standard is zero-length or very short.

Reflect Standard  The REFLECT standard definition is used to establish the position of the
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measurement reference plane. Select if the THRU standard is not appropriate AND the delay of the

REFLECT standard is well defined.

Also, select If a flush short is used for the REFLECT standard because a flush short provides a more

accurate phase reference than a Thru standard.

LRL line auto characterization

Note: This setting ONLY applies if an LRL Cal Kit is being modified AND Testport Reference Plane

is set to Thru Standard AND the TRL Thru class standard and the TRL Line/Match class standard both

have the same values for Offset Z0 and Loss. Otherwise, this setting is ignored.

Check the box to allow the VNA to automatically correct for line loss and dispersion characteristics.

Clear the box if anomalies appear during a calibrated measurement which may indicate different loss and
impedance values for the Line standards.

Available at the bottom of every tab

Save As - Allows you to save the cal kit to a new file name and type.

Save - Saves the cal kit to the same file name and type.

Close - Closes the cal kit editing session. The file is NOT saved automatically.
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Markers

Markers provide a numerical readout of measured data, a search capability for specific values, and can

change stimulus settings. There are 15 regular markers and one Reference marker (used with Delta

markers) available per trace. This topic discusses all aspects of markers.

Note: Marker Readout can be turned ON/OFF and customized from the Customize Display dialog

box. Learn more.

Number of General Purpose and Reference Markers

Creating and Moving Markers

Marker Setup

Coupling Method

Searching with Markers

Maximum and Minimum Search

Peak Search

Multi Peak Search

Target Search

Multi Target Search

Bandwidth and Notch Search

Compression Search

PSAT Search

PNOP Search

Spectrum Analysis (SA) Markers (separate topic)

Band Power

Band Noise

Occupied BW Ratio
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Search Domain

Search Range Indicators

Marker Functions (Change Instrument Settings)

Marker Display

Marker Table

Note: Marker Readout can be turned ON / OFF and customized from the View/Display menu. Learn
more.

Other Analyze Data topics

Creating  and Moving Markers

How to Create Markers

Using Hardkey/SoftTab/Softkey Using a mouse

Press Marker > Marker 1-7 / Marker 8-15 /
Reference.

1.

Click left side Marker N or Reference small
button.

2.

Move the cursor on a trace.1.

Right-click on the trace then select Add
Marker....

2.

Moving a Marker

To move a marker, make the marker active by selecting its number in any of the previous 3 methods.

The active marker appears on the analyzer display as . All of the other markers are inactive and are
represented on the analyzer display as . Then change the stimulus value using any of the following

methods:

Type a value.

Scroll to a stimulus value using the up / down arrows. The resolution can not be changed.

Click the stimulus box, then use the front-panel knob.

Click and Drag Markers using a finger (touchscreen) or by left-clicking and holding a marker symbol.  Then
drag the marker to any point on the trace. This feature is NOT allowed in Smith Chart or Polar display formats
or with a Fixed Marker type.
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Marker Setup

How to set the Marker Setup.

Using Hardkey/SoftTab/Softkey Using a mouse

Press Marker > Marker Setup.1.

Set the value or select desired setting for each
softkey.

2.

Move the cursor on a marker.1.

Right-click on the marker then select
Marker....

2.

Marker dialog box help  

Marker  Specifies the current (active) marker number that you are defining.

On  Check to display the marker and corresponding data on the screen.

Stimulus  Specifies the X-axis value of the active marker. To change stimulus value, type a value,

use the up and down arrows, click in the text box and use the front-panel knob, or drag the marker

on the screen.

Delta (and Reference) Markers  Check to make the active marker display data that is relative to

the reference (R) marker.  There is only one reference marker per trace. All other markers can be

regular markers or delta markers. When a delta marker is created, if not already displayed, the

reference marker is displayed automatically. A delta marker can be activated from the Marker dialog
box or the Marker Toolbar. See Also: Number of General Purpose and Reference Markers.

Discrete Marker  Check to display values at only the discrete points where data is measured. Clear

to display values that are interpolated from the data points. The interpolated marker will report y-
axis data from ANY frequency value between the start and stop frequency.

Fixed  Check to cause the marker to have a fixed X-axis and Y-axis position based on its placement

on the trace when it was set to fixed. It does NOT move with trace data amplitude. It can be scrolled

left and right on the X-axis by changing the marker stimulus value. Use this marker type to quickly

monitor "before and after" changes to your test device. For example, you could use fixed markers to
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record the difference of test results before and after tuning a filter.

Clear the box to create a Normal marker, which has a fixed stimulus position (X-axis) and responds

to changes in data amplitude (Y-axis). It can be scrolled left and right on the X-axis by changing the

marker stimulus value. Use this marker type with one of the marker search types to locate the

desired data.

(Marker) Format  Displays the marker data in a format that you choose. The Trace Default setting

has the same marker and grid formats. Choose from the following:

Log/Phase Log Mag Real

Linear/Phase Linear Mag Imaginary

Real/Imag Phase Kelvin

R+jX (complex impedance) SWR Fahrenheit

G+jB (complex admittance) Delay Celsius

Noise Marker Format - Available ONLY in IMSpectrum and SA measurement classes. For

comparison purposes, electronic noise measurements are often displayed as though the

measurement was made in a 1 Hz Res BW. However, making an actual measurement at a 1 Hz Res

BW is impossible, and at 10 Hz, extremely slow.

A Noise Marker mathematically calculates the noise measurement at that single data point as

though it were made using a 1 Hz bandwidth.

To accurately measure noise, the Noise Marker should NOT be placed on, or too close to, a signal.

The distance from a signal depends on several factors. To know if an accurate reading is being

made, move the Noise Marker until consistent measurements are displayed in adjacent data points.

All Off  Switches OFF all markers on the active trace.

Coupled Markers

The coupled markers feature causes markers on different traces to line up with the markers on the

selected trace. Markers are coupled by marker number, 1 to 1, 2 to 2, 3 to 3, and so forth. If the x-

axis domain is the same (such as frequency or time), coupling occurs. Trace markers in a different

x-axis domain will not be coupled. If a trace marker has no marker to couple with on the selected

trace, the marker remains independent.

Coupling Method - Determines the scope of coupling. Choose from the following:

All - A marker on one trace is coupled to the same-numbered markers on all channels, all windows and
all traces.
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Channel - A marker on one trace is coupled to the same numbered markers on traces which share the
same channel number as the original trace.

Coupled Markers Model

This model simulates the use of coupled markers in the VNA:

          

Click Trace A or Trace B1.

Click Coupled Markers2.

Notice the following:3.

Markers on the unselected trace move to the x-axis position of the selected trace.

If a marker number on the unselected trace has no corresponding marker on the selected trace, no
movement occurs for that marker.

Click Reset to run the model again. There is no Reset for coupled markers on the VNA.4.

Searching with Markers

You can use markers to search and return data for the following trace criteria:

Max and Min: find the highest or lowest points on the trace

Peak, then move to other peaks (left, right, next highest)

Multi Peak

Target Value: find a specific Y-axis value

Multi Target:
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Bandwidth (Filters)

Notch (Filters)

Compression Point (Amplifiers)

About PSAT and PNOP Markers

Power Saturation (Amplifiers)

Power Normal Operating Point (Amplifiers)

Search Domain

Search Range Indicators

How to Search with Markers

Using Hardkey/SoftTab/Softkey Using a mouse

Press Search > Main / Peak / Target / Multi Peak
& Target / Bandwidth & Notch / Compression &
Saturation / Normal Op Pt.

1. Move the cursor on a marker.1.

Right-click on the marker then select
Search...to show the Marker Search
Dialog box for define the search
parameters.

2.

From Search Type of Marker Search
dialog box, select the desired search
function.

3.

Press Execute or check Tracking. Learn
more.

4.

Marker Search dialog box help  

Marker  Specifies the marker that you are defining. Not available for search types that deploy

specific markers.

Search Domain  Defines the area where the marker can move or search. For full span, the marker
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searches for specified values within the full measurement span. For user span, the marker searches

for specified values within a measurement span that you define. Learn more about Search Domain.

Search Type

Note  You must either press Target Search or check Tracking to initiate all search types.  If there

is no valid data match for the search type, the marker will not move from its current position.

Target Search  Click to cause the marker to search for the specified criteria.

Tracking  Check to cause the marker to search for the specified criteria with each new sweep. The
searches begin with the first sweep after Tracking has been checked, based on the current search type
and domain information. Therefore, make sure that the search criteria are in the desired state before
using the data. You cannot manually change the stimulus setting for a marker if Tracking is selected for
that marker.

Maximum  Marker locates the maximum (highest) data value.

Minimum  Marker locates the minimum (lowest) data value.

Next Peak  Marker locates the peak with the next lower amplitude value relative to its starting

position.

Peak Right  The marker locates the next valid peak to the right of its starting position on the X-

axis.

Peak Left  The marker locates the next valid peak to the left of its starting position on the X-axis.

Multi Peak - A function that search for peaks that match the multi-peak search excursion value and

multi-peak polarity value. Learn more about Multi Peak Search.

Threshold  - Minimum amplitude (dB). To be considered valid, the peak must be above the threshold
level. The valley on either side can be below the threshold level.

Excursion  The vertical distance (dB) between the peak and the valleys on both sides. To be considered
a peak, data values must "fall off" from the peak on both sides by the excursion value.

Target   A function that searches for a target that matches the pre-defined target value and

transition types (positive, negative or both (positive and negative)) and then moves the marker to

that target. Learn more about Multi Target Search.

Target Left - A function executes the search from the current marker position to the smaller

stimulus values and moves the marker to first target encountered.
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Target Right - A function executes the search from the current marker position to the larger

stimulus values and moves the marker to first target encountered.

Multi Target - A function that search for targets that are of the multi-target value and multi target

transition value. Learn more about Multi Target Search.

Target - Value in dB.

Compression - A function used the active marker to find the specified gain Compression Level.
Learn more about Compression Search.

Compression - Value in dB.

Bandwidth and Notch searches are accessed by pressing Search > Bandwidth & Notch > BW Ref to

or Search > Bandwidth & Notch > Notch Ref to.
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Bandwidth - A function for determining the bandwidth of the trace, center frequency, cut-off points

(on the higher frequency and the lower frequency sides), Q and insertion loss based on the position

of the active marker (if search mode set to Marker) or the peak marker (if search mode set to

Peak). Learn more about Bandwidth Search.

Bandwidth peak mode search

If level is negative, search is relative to the maximum peak.

If level is positive, search is relative to the minimum peak.

Bandwidth level in dB.

Notch -  A function is used to obtain the bandwidth, center frequency, cutoff points (high-frequency

side and low-frequency side), Q and insertion loss of a trace based on the position of the active

marker (if search mode set to Marker) or the peak (if search mode set to Peak). Learn more about
Notch Search.

Notch peak mode search

If level is negative, notch search is relative to the minimum peak.

If level is positive, notch search is relative to the maximum peak.

Notch level in dB.

The default behavior for searches based on the active marker or peak marker can be set using the

Marker: On Preset, set BW/Notch search reference to Peak  preference.

Power Saturation - Learn more about PSAT Search.

PMax Back-off -Value in dB.

Normal Operating Pt - The output power where the input is offset from the back-off input power

by the Pin Offset. Learn more about PNOP Search.

Back-off - Value in dB.

Pin Offset - X-axis value in dB.

Maximum and Minimum Search
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How to create Maximum and Minimum Search

Using Hardkey/SoftTab/Softkey Using a mouse

Press Search > Main.1.

Click Max Search or Min Search.2.

Optionally click Tracking to search for the
specified maximum or minimum level with each
sweep. Learn more.

3.

Move a cursor on a marker.1.

Right-click on the marker and then select
Search....

2.

From Search Type of Marker Search dialog
box, select Maximum / Minimum.

3.

Press Execute or check Tracking. Learn more.4.

You can search for the maximum or minimum measured value on the trace and move a marker to that

point.

Search for maximum (Max

Search)

Move active marker to point on trace where

measured value is greatest.

Search for minimum (Min
Search)

Move active marker to point on trace where
measured value is lowest.

Note: When the data format is in Smith chart or polar format, execute the search only for the main
response value.

Peak Search
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How to create Peak Search

Using Hardkey/SoftTab/Softkey Using a mouse

Press Search > Peak.1.

Click Peak Search to show the markers on the
peak.

2.

Click Peak Right >> Search, << Peak Left
Search or Next Peak Search to move the
marker to the peak.

3.

Click Threshold to enter the value of peak
threshold.

4.

Click Excursion to enter the lower limit value
of peak excursion.

5.

Click Peak Polarity to select a peak polarity.6.

Optionally click Tracking to search for the
specified peak level with each sweep. Learn
more.

7.

Move a cursor on a marker.1.

Right-click on the marker and then select
Search....

2.

From Search Type of Marker Search

dialog box, select Peak / Peak Left /

Peak Right / Next Peak.

3.

Enter the value of Threshold and Excursion.4.

Press Execute or check Tracking. Learn
more.

5.

A peak is a measurement point whose value is greater or smaller than the adjoining measurement

points on its right and left sides. Peaks are classified into the following two types depending on the

difference in magnitude from the measurement points on either side of it.

What Is a "Peak"?

You define what the analyzer considers a "peak" by selecting the following two peak criteria settings:

Threshold - Minimum amplitude (dB). To be considered valid, the peak must be above the threshold level.
The valley on either side can be below the threshold level.

Excursion - The vertical distance (dB) between the peak and the valleys on both sides. To be considered a
peak, data values must "fall off" from the peak on both sides by the excursion value.
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Peak

Polarity:
Definition:

Positive A peak whose measured value is greater than those of the

measurement points on either side of it.

Detect positive peaks which are larger than Threshold.

Negative A peak whose measured value is smaller than those of the

measurement points on either side of it.

Detect negative peaks which are smaller than Threshold.

Both A peak whose measured value is smaller and greater than those of

the measurement points on either side of it.

Threshold value is not used when polarity is set to both.

About Peak Excursion Value

The peak excursion value is the smaller of the differences in measured values from the adjoining peaks

of the opposite polarity.

Executing a Peak Search

The following 3 methods are available for executing the peak search:
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Next

Peak

Moves the marker to the maximum peak when peak polarity is Positive

or Both.

Moves the marker to the minimum peak when peak polarity is

Negative.

Peak

Left

Executes the search from current marker position to the smaller

stimulus values and moves the marker to first peak encountered.

Peak

Right

Executes the search from current marker position to the larger stimulus

values and moves the marker to first peak encountered.

Note: Peak right, peak left and next peak may not be tracked. If these searches are selected and then

tracking is turned on, the peak tracking is enabled.

         When the data format is in Smith chart or polar format, execute the search for the main response

value of the two marker response values.

         Changing the settings of peak excursion value or peak polarity executes new search for multiple

peak.

 

Example:

Threshold Setting: -10dB

Excursion Setting: 1dB

Scale = 1 dB / Division

Mouse over the graphic to find a valid peak.
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Peak A = Valid Peak (Above Threshold and Excursion Settings)

Peak B = Invalid Peak (Below Excursion Setting)

Peak C = Invalid Peak (Below Threshold Setting)

Multi Peak Search

How to create Multi Peak Search

Using Hardkey/SoftTab/Softkey Using a mouse

Press Search > Multi Peak & Target.1.

Click Multi Peak Search to show the markers
on the multi peaks.

2.

Click Peak Threshold to enter the value of
peak threshold.

3.

Click Peak Excursion to enter the lower limit
value of peak excursion.

4.

Click Peak Polarity to select a peak polarity.5.

Optionally click Tracking to search for the
specified multi peak level with each sweep.
Learn more.

6.

Move a cursor on a marker.1.

Right-click on the marker and then select
Search....

2.

From Search Type of Marker Search dialog
box, select Multi Peak.

3.

Enter the value of Threshold and Excursion.4.

Press Execute or check Tracking. Learn more.5.

The multi peak search function enables you to display markers on multiple peaks on traces. Depending
on the number of detected peaks, markers 1 through 15 are displayed from the start frequency. The

reference marker is not affected.
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Multiple peak search has threshold, excursion and polarity as user defined values. This search may have

tracking enabled.

When the multiple peak search is executed, previous markers search and tracking are disabled and the

settings for the multiple peak search are used.

Note: Do not use individual marker settings or marker domain.

         Put markers on each valid peak, using up to 15 markers.

Target Search

How to create Target Search

Using Hardkey/SoftTab/Softkey Using a mouse

Press Search > Target.1.

Click Target Search to enable the target
search.

2.

Click Target Right >> Search or << Target
Left Search to move the marker to the target.

3.

Click Target Value to input the value of target
search.

4.

Click Transition to select a transition type.5.

Optionally click Tracking to search for the
specified target level with each sweep. Learn
more.

6.

Move a cursor on a marker.1.

Right-click on the marker and then select
Search....

2.

From Search Type of Marker Search dialog
box, select Target/Target Left/Target Right.

3.

Enter the value of the Target.4.

Press Execute or check Tracking. Learn
more.

5.

The target search is a function that searches for a target that matches the pre-defined target value and
transition types (positive, negative or both positive and negative) and then moves the marker to that

target.
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Target Transition Types

A target is a point that has a specific measured value on the trace. Targets can be divided into the 3

groups shown below depending on their transition type.

Transition

Type:
Function:

Positive
The target value is larger than the measured value immediately

preceding it.

Negative
The target value is smaller than the measured value immediately

preceding it.

Both
The conditions for either Positive or Negative transition are

satisfied.

Executing a Target Search

The following 3 methods are available for executing the target search:

Target

Left

Executes the search from the current marker position to the smaller

stimulus values and moves the marker to first target encountered.

Target

Right

Executes the search from the current marker position to the larger

stimulus values and moves the marker to first target encountered.

Multi

Target

Executes the search for targets that are of the multi-target value and

multi target transition value. See Multi Target Search.
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Note: Target right and target left cannot have tracking enabled. If target left or target right is the

selected search and then tracking is enabled, target tracking is enabled.

         When the data format is in Smith chart or polar format, execute the search for the main response

value of the 2 marker response values.

         Changing the settings of target value or transition type executes new search for multiple target.

 

The marker moves to the first occurrence of the Target value to the right of its current position.

Subsequent presses of the Target Search softkey cause the marker to move to the next value to the right

that meets the Target value. When the marker reaches the upper end of the stimulus range, it will "wrap

around" and continue the search from the lower end of the stimulus range (left side of the window).
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If Discrete Marker is OFF, the marker locates the interpolated data point that equals the target

value.

If Discrete Marker is ON and there are two data points on either side of the target value, the

marker locates the data point closest to the Target value

Multi Target Search

How to create Peak Search

Using Hardkey/SoftTab/Softkey Using a mouse

Press Search > Multi Peak & Target.1.

Click Multi Target Search to show the markers
on the multi target.

2.

Click Target Value to enter the value of target.3.

Click Transition to select a transition type.4.

Optionally click Tracking to search for the
specified multi target level with each sweep.
Learn more.

5.

Move a cursor on a marker.1.

Right-click on the marker and then select
Search....

2.

From Search Type of Marker Search

dialog box, select Multi Target.

3.

Enter the value of the Target.4.

Press Execute or check Tracking. Learn
more.

5.

The multi target search is a function that searches for targets that match to pre-defined target value and

transition types (positive, negative or both of positive and negative) and displays markers on the targets

being searched.

Depending on the number of detected targets, markers 1 through 15 are displayed from the start

frequency. The reference marker is not affected.

When the multi target search is executed, search and tracking settings for markers 1 through 15 are

ignored and the settings for the multi target search are used.

Note: Put markers on each found target value, using up to fifteen markers. Reference marker is not

affected. Do not use individual marker settings or marker domain. Search range is applied.

Multiple target search has target and transition types as user defined values. This search may have

tracking enabled. When this search is executing, previous marker searches are disabled.

Bandwidth and Notch Search

Bandwidth and notch search behavior depends on whether the preference called Marker: Use single
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marker for marker search is set or not. When set, only one marker is used for a marker search. Sub

markers are displayed and used for Bandwidth and Notch searches. When cleared, multiple markers are

used for a marker search. The default is cleared.

How to create Bandwidth and Notch Search

Using Hardkey/SoftTab/Softkey Using a mouse

Press Search > Bandwidth & Notch.1.

Click left side Bandwidth Search or Notch
Search small button to turn it ON/OFF.

2.

For Bandwidth search, click BW Ref To >
Marker or Peak.

3.

For Notch search, click Notch Ref To > Marker
or Peak.

4.

Specify the BW Level or Notch Level in dB
from the peak or valley where bandwidth /
notch is measured.

5.

Optionally click Tracking to search for the
specified bandwidth or notch level with each
sweep. Learn more.

6.

Move a cursor on a marker.1.

Right-click on the marker and then select
Search....

2.

From Search Type of Marker Search

dialog, select Bandwidth or Notch.

3.

Specify the Level in dB from the peak or valley
where bandwidth / notch is measured.

4.

Press Execute or check Tracking. Learn
more.

5.

Bandwidth Search

The bandwidth search is a function for determining the bandwidth of the trace, center frequency, cut-

off points (on the higher frequency and the lower frequency sides), Q and insertion loss based on the

position of the active marker or peak marker. The definitions of the parameters determined through the

bandwidth search are shown in below.
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Notch Search

The notch search function is used to obtain the bandwidth, center frequency, cutoff points (high-

frequency side and low-frequency side), Q and insertion loss of a trace based on the active marker or

peak marker position. The notch search function starts from the left side of the active marker position

and ends when points that meet the conditions are found.

The figure and the table below shows the definition of parameters obtained by notch search function.

The notch value in figure below must be specified by the user.
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The following values are displayed for Bandwidth and Notch Search:

Bandwidth/Notch

Parameter:
Definition:

Bandwidth (BW)

The difference in frequency between the higher

frequency cut-off and lower frequency cut-off points

(High - Low).

Center frequency (cent)

Frequency at the middle point between the lower

frequency cut-off and higher frequency cut-off points.

(High + Low)/2.

Lower frequency cut-off

point (Low)

Lower frequency of 2 measurement points, both

separated by the defined bandwidth / notch value from

the active marker position.

Higher frequency cut-
off point (High)

Higher frequency of 2 measurement points, both

separated by the defined bandwidth / notch value from

the active marker position.

Q
Ratio of Center Frequency to Bandwidth (Center

Frequency / Bandwidth).

Insertion loss (loss)
The measured value of the position of the center
frequency at the time the bandwidth/notch search is

executed.

Bandwidth / Notch Search can be used ONLY with Log Mag display format.
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To use Bandwidth Search on a peak or valley other than the maximum or minimum values,

change the Search Domain.

Compression Search

Uses the active marker to find the specified gain Compression Level.

Note: Valid ONLY for S21 (Gain) measurements with a Power Sweep.  

How to create Compresssion Search

Using Hardkey/SoftTab/Softkey Using a mouse

Press Search > Comp & Sat.1.

Click Compression Search to turn ON/OFF.2.

Specify the Comp Level in dB.3.

Optionally click Tracking to search for the
specified compression level with each sweep.
Learn more.

4.

Move a cursor on a marker.1.

Right-click on the maker and then select
Search....

2.

From Search Type of Marker Search dialog
box, select Compression.

3.

Enter the Y-axis (Power OUT) difference
between the first point and the compression
marker.

4.

Press Execute or check Tracking. Learn
more.

5.

Linear gain is defined as the Y-axis value (gain) of the first data point of the Search Domain (Full Span

by default).

Marker > N - X-axis value and Y-axis value.

Comp Pin - Input power (marker X-axis value).
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Comp Pout - Output power (Pin + gain).

Comp Level - Compression level found.

When Discrete is OFF (default setting), the marker finds the exact specified compression,

interpolated between the two closest data points and calculates the Comp Pin and Comp Pout

value for that point.

The marker can move from one actual measurement point to another. Because it is interpolated,

it can also move in the space between measurement points.

When Discrete is ON (not interpolated), the marker resides on the closest data point to the

requested compression level.

A marker moves only between actual measurement points. When a specific marker stimulus

value is specified as a numerical value, the marker is placed at the measurement point closest to

the specified value. A marker that is placed between interpolated points with the discrete mode

off automatically moves to the nearest measurement point when the discrete mode is turned on.

Comp. Not Found - Displayed when the requested compression level is not found.

 

About PSAT and PNOP Search

Compression measurements based on the Pout vs Pin curves are common in the satellite test industry.

In the case of Travelling Wave Tube (TWT) amplifiers, PSAT markers identify the normal operating

point near saturation, and the amplifiers are operated with the power slightly backed-off

approximately 0.03 to 0.1 dB. For TWT amplifiers, the saturation curve always "folds over" and

produces a maximum power out.

For Solid State Power Amplifiers (SSPA), the saturation is not as well defined. A common reference is
the Normal Operating Point, which is a power backed-off by 8 to 10 dB from the maximum power. In

this case, the normal operating point marker replaces the Psat with the PNOP values. Also, because the
backoff is important, the backoff output and input powers are displayed (PBO Out), (PBO in) as well as

gain at back off (PBO Gain).

Power Saturation (PSAT) Search

If the Marker: Use single marker for marker search preference is cleared, this search uses Markers

1, 2, and 3 to quickly identify output power saturation parameters of an amplifier. If the Marker: Use

single marker for marker search preference is set, then only one marker is used for the search and 2

notational markers are displayed. The notational markers may not be moved. These markers are for
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display purposes only.

Back-off is a point at which the output power is sufficiently lower than the saturated output power so

that the device under test behaves in a more linear fashion.

Note: Valid ONLY for Power IN vs Power OUT measurements.  

How to make Power IN (X-axis) vs Power OUT (Y-axis) measurement

Using Hardkey/SoftTab/Softkey

Press Preset.1.

Press Sweep > Main > Sweep Type.2.

Select Power Sweep.3.

Press Trace > Trace Setup > Measure... and set Trace Meas to "B" Receiver4.

Connect DUT input to port 1.5.

Connect DUT output to port 2.6.

 

How to create PSAT Search

Using Hardkey/SoftTab/Softkey Using a mouse

Press Search > Comp & Sat.1.

Click left side Saturation Search small button
to turn ON/OFF.

2.

For PMax Back-Off, enter the Y-axis (Power
OUT) difference between the Max Power
marker (3) and the Back-off marker (2).

3.

Optionally click Tracking to search for the
specified power saturation level with each
sweep. Learn more.

4.

Move a cursor on a marker.1.

Right-click on the marker and then select
Search > Search....

2.

From Search Type of Marker Search dialog
box, select Power Saturation.

3.

For PMax Back-Off, enter the Y-axis (Power
OUT) difference between the Max Power
marker (3) and the Back-off marker (2).

4.

Press Execute or check Tracking. Learn
more.

5.
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This setting uses three markers to calculate and display 10 values.

The three markers:

Marker 1: Linear gain; the first data point in the sweep.

Marker 2: Specified output power Back-off from max power.

Marker 3: Max Power output; usually the last data point.

The 9 displayed values:

Param Description Calculated from...

PSat Out Output power at the saturation point. Marker 2 Y-axis value

PSat In Input power at the saturation point. Marker 2 X-axis value

Gain Sat Gain at the saturation point. Psat Out - Psat In

Comp Sat Compression at the saturation point. Gain Sat - Gain Linear

PMax Out Maximum output power. Marker 3 Y-axis value

PMax In Input power at the maximum output

power.

Marker 3 X-axis value

Gain Max Gain at the maximum output power. PMax Out - PMax In

Comp Max Compression at the maximum output

power.

Gain Max - Gain Linear

Gain

Linear

Linear gain at the first data point. Marker 1 - Y-axis value MINUS X-axis

value

Comp. Not Found is displayed when the requested Back-off point is not found.
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When Discrete marker is NOT selected (the default setting), the three markers find an interpolated value
between the two closest data points.

When Discrete marker is selected (NOT interpolated), the three markers reside on the closest data points.

Power Normal Operating Point (PNOP) Search

If the Marker: Use single marker for marker search preference is cleared, this search uses Markers

1, 2, 3, and 4 to quickly identify Normal Operating Point parameters of an amplifier. If the Marker:

Use single marker for marker search preference is set, then only one marker is used for the search

and 2 notational markers are displayed. The notational markers may not be moved. These markers are

for display purposes only.

Back-off is a point at which the output power is sufficiently lower than the saturated output power so

that the device under test behaves in a more linear fashion.

The power normal operating point is the output power where the input is offset from the back-off input

power by the Pin Offset.

Note: Valid ONLY for Power IN vs Power OUT measurements.

See Power Saturation to learn how to make a Power IN (X-axis) vs Power OUT (Y-axis) measurement.

How to create PNOP Search

Using Hardkey/SoftTab/Softkey Using a mouse

Press Search > Normal Op Pt.1.

Click left side Normal OP Search small button
to turn ON/OFF .

2.

For Back-Off, enter the Y-axis (Power OUT)
difference between the Max Power marker (3)
and the Back-off marker (2).

3.

For Pin Offset, enter the X-axis (Power IN)
difference between Back-off marker (2) and
PNOP marker (4).

4.

Optionally click Tracking to search for the
specified power normal operating point level
with each sweep. Learn more.

5.

Move a cursor on a marker.1.

Right-click on the marker and then select
Search > Search....

2.

From Search Type of Marker Search dialog
box, select Normal Operating Pt.

3.

For Back-Off, enter the Y-axis (Power OUT)
difference between the Max Power marker (3)
and the Back-off marker (2).

4.

For Pin Offset, enter the X-axis (Power IN)
difference between Back-off marker (2) and
PNOP marker (4).

5.

Press Execute or check Tracking. Learn
more.

6.

472



This setting uses four markers to calculate and display 12 values.

The four markers:

Marker 1: Linear gain; the first data point in the sweep.

Marker 2: Max Output Power MINUS the specified Output (Y-axis ) Back-off value in dB.

Marker 3: Max Output Power; usually the last data point in the sweep.

Marker 4: X-axis value of Back-off (Marker 2) plus the Pin Offset (X-axis) value in dB.

The 11 displayed values:

Param Description Calculated from...

Pnop Out Output power at the power normal operating point. Marker 4 Y-axis value

Pnop In Input power at the power normal operating point. Marker 4 X-axis value

Pnop Gain Gain at the power normal operating point. Pnop Out - Pnop In

Pnop Comp Compression at the power normal operating point. Pnop Gain - Linear Gain*

PMax Out Maximum output power. Marker 3 Y-axis value

PMax In Input power at the maximum output power. Marker 3 X-axis value

Gain Max Gain at the maximum output power. PMax Out - PMax In

Comp Max Compression at the maximum output power. Gain Max - Linear Gain*

PBO Out Output power at the back-off point. Marker 2 Y-axis

PBO In Input power at the back-off point. Marker 2 X-axis

PBO Gain Gain at the back-off point. PBO Out - PBO In

*Linear Gain (not shown): Marker 1 - Y-axis value MINUS X-axis value
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PNOP Not Found is displayed when the requested back-off level is not found.

When Discrete marker is NOT selected (the default setting), the four markers each find an interpolated value
between the two closest data points.

When Discrete marker is selected (NOT interpolated), the four markers each reside on the closest data point.

Search Domain

Search domain settings restrict the stimulus values (X-axis for rectangular format) to a specified span.

Set the Start and Stop stimulus settings of these User spans. If Start is greater than Stop, the marker

will not move. Learn how to set Search Domain.

The default domain of each new marker is "full span".

There are 16 user-defined domains for every channel.

The user-defined domains can overlap.

More than one marker can use a defined domain.

Search Domain settings are shared with Trace Statistics User Ranges

 The graphic below shows examples of search domains.

 

Search Range Indicators
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A search range will be indicated with a pair of small, outlined triangles sitting on the X-axis. Although

there can be multiple search ranges in use on various markers, only the current-selected search range

for the active marker is displayed. This rule prevents the possibility of the X-axis being cluttered with

many search range triangles. This rule applies even when there are multiple traces in a window.

Only one search range will be displayed on a grid at any time. The displayed search range will

correspond to the active trace and active marker. The color of the range indicators will match that of

the active trace.

Range indicators will appear automatically when appropriate and cannot be disabled. The mouse or

touchscreen can't be used to “click-and-drag” the position of the range indicators which will alter the

search range definition.

Search Within

The zoomed frequency range becomes the User 16 Search Domain span.

A marker is created if not already present on the trace. If markers are already present on the trace, the

lowest marker is moved to the found value.

Left-click the mouse or use a finger, then drag across a portion of a trace.1.

Release the mouse or lift the finger.2.

Select Search Within.3.

Then choose from the following:

Max - A marker moves to the HIGHEST value within the zoomed range.

Min - A marker moves to the LOWEST value within the zoomed range.

4.
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Target - A marker moves to the first value within the zoomed range that is currently set in the Marker
Search 'Target' setting. The same Discrete Marker rules apply as those for the standard Target Marker
Search.

Marker Functions - Change Instrument Settings

The following settings change the relevant VNA settings to the position of the active maker.

How to change Instrument settings using markers

Using Hardkey/SoftTab/Softkey Using a mouse

Press Marker > Marker->Functions.1. Move a cursor on a marker.1.

Right-click on the marker and then select
Functions.

2.

Select the desired search function.3.

Click Function... to show the Marker Function
Dialog box.

4.

Marker Function dialog box help  

Note: Marker Functions do not work with channels that are in CW or Segment Sweep mode.

Marker =>Start  Sets the start sweep setting to the value of the active marker.

Marker =>Stop  Sets the stop sweep setting to the value of the active marker.

Marker =>Center  Sets the center of the sweep to the value of the active marker.

Marker =>Ref Level  Sets the screen reference level to the value of the active marker.

Marker =>Delay  The phase slope at the active marker stimulus position is used to adjust the line
length to the receiver input. This effectively flattens the phase trace around the active marker.

Additional Electrical Delay  adjustments are required on devices without constant group delay over
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the measured frequency span. You can use this to measure the electrical length or deviation from

linear phase.

This feature adds phase delay to a variation in phase versus frequency; therefore, it is only

applicable for ratioed measurements. See Measurement Parameters.

Marker =>Span  Sets the sweep span to the span that is defined by the delta marker and the marker

that it references. Unavailable if there is no delta marker.

Marker =>CW Freq  Sets the CW frequency to the frequency of the active marker. NOT available

when the channel is in CW or Power Sweep. Use this function to first set the CW Frequency to a

value that is known to be within the current calibrated range, THEN set Sweep Type to Power or

CW.

Note: Some Marker Functions do not work with channels that are in certain Sweep Types.

Marker Function
Sweep Type

Lin/Log Freq. SegmentPower CW Time

Start, Stop, Center F   S  

Span S   S  

Ref Level F S S S

Delay F S S S

CW Freq. S S    

F: Available in both Standard and SMC classes

S: Available in only Standard Class

Marker Display

The marker display dialog allows you to change how markers and the associated readout is displayed

on the VNA screen. Several marker display features also apply to Statistics display.
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How to change Marker Display settings

Using Hardkey/SoftTab/Softkey Using a mouse

Press Marker > Marker Setup > Marker
Display....

1.

OR

Press Display > Display Settings >
Customize Display....

1.

Select Markers tab.2.

Move a cursor to the marker data area on top
right corner of grid box.

1.

Right click on the marker data display area.2.

Select Marker Display....3.

OR

Right click on any window area.1.

Click Customize Display....2.

Select Markers tab.3.

Customize Display dialog box help  

The following settings apply to readouts of ALL currently-displayed marker, bandwidth, and trace
statistics.
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These settings revert to their defaults on Preset but ARE stored with Instrument State and User Preset.

Marker Readout

Checked - Shows readout information.

Cleared - Shows NO readout information.

Large Readout

Checked - Shows the marker readout in large font size for easy reading. However, all readout

lines may not be visible.

Cleared - Shows the marker readout in normal font size.

Active Trace Only

Checked - Shows the marker readout for the active trace only.

Cleared - Shows all marker readouts.

Readouts Per Trace

Choose the quantity of marker readouts to show in the window for each trace. Choose to display up

to 16 readouts per trace, up to 20 readouts per window. When more markers are present than the

specified quantity of readouts, the marker numbers for which readouts are displayed can change

depending on the marker number that is active. Readouts Per Trace can be set independently for

each window.

Symbol

Choose from the following marker symbols.

Triangle

Flag
Line

Line symbols are NOT used on Smith or Polar display formats.

Symbols can be set independently for each window.

Symbols Above Trace

Cleared - ONLY the active marker is displayed above the trace. Inactive markers are displayed

below the trace.
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Checked - ALL marker symbols are displayed above the trace. The active marker is always filled

solid.

Decimal Places

Choose the marker readout resolution to display. These values also apply to the readouts that are

displayed in the marker table. Decimal Places can be set independently for each window.

Stimulus (X-axis)  - Choose from 2 to 6 places after the decimal point. Default is 3.

Response (Y-axis) - choose from 1 to 4 places after the decimal point. Default is 2.

Readout Position

Choose where to place the marker readouts.  Marker readouts are right-justified on the specified X-

axis and Y-axis position. The default position (10.0, 10.0) is the upper-right corner of the grid.

Position (1.0,1.0) is the lower-left corner. Readout position can also be set independently for each

window.

Note:  Readout Position can also be changed using a mouse by left-clicking on the top readout and

dragging to the new position.

Marker Colors  Starts the Display Colors dialog with only the marker colors available. Learn more.

Marker Table

You can display a table that provides a summary of marker data for the active trace. The marker data is

displayed in the specified format for each marker.

How to view the Marker Table

Using Hardkey/SoftTab/Softkey

Press Marker > Marker Setup > Marker Table.1.
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Using Math / Memory Operations

You can perform four types of math on the active trace versus a memory trace. In addition three

statistics (Mean, Standard Deviation and Peak to Peak) can be calculated and displayed for the active

data trace.

Trace Math

Trace Statistics

Note: Trace Math (described here) allows you to quickly apply one of four math operations using

memory traces. Equation Editor allows you to build custom equations using several types of traces from

the same, or different channels.

Other Analyze Data topics

Trace Math

To perform any of the math operations, you must first store a trace to memory. You can display the

memory trace using the View options.

Trace math is performed on the complex data before it is formatted for display. See the VNA data
processing map.

Markers can be used while viewing a memory trace.

How to select Trace Math

Using Hardkey/SoftTab/Softkey Using a mouse

Press Math > Memory.1. Right click on any trace status area above the grid
box.

1.

Select on Memory....2.

Normalize, available only from the Memory menu, (not on the Math / Memory dialog), performs
the same function as Data=>Memory, then Data / Memory.  

Math / Memory dialog box help
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Normalize, available only from the Memory menu, (not on the Math / Memory dialog), performs

the same function as Data=>Memory, then Data / Memory.  

Data=>Memory  Puts the active data trace into memory. You can store one memory trace for every

displayed trace.

Note: Many VNA features are NOT allowed on Memory traces. For example, Memory traces can

NOT be saved to any file type (PRN, SNP, CTI, CSV, MDF). However, you can restore a memory

trace to a data trace using the Memory-to-Data utility at the

http://na.support.keysight.com/pna/apps/applications.htm website.

Data Math

All math operations are performed on linear (real and imaginary) data before being formatted. See

the VNA Data flow.

Data (or OFF)  Does no mathematical operation.

Data / Memory - Current measurement data is divided by the data in memory. Use for ratio

comparison of two traces, such as measurements of gain or attenuation. Learn more.

Data – Memory - Data in memory is subtracted from the current measurement data. For example,

you can use this feature for storing a measured vector error,  then subtracting this error from the
DUT measurement. Learn more.

Data + Memory - Current measurement data is added to the data in memory. Learn more.
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Data * Memory - Current measurement data is multiplied by the data in memory. Learn more.

8510 Mode - Learn more.

Trace View Options

Data Trace  Displays ONLY the Data trace (with selected math operation applied).

Memory Trace  Displays ONLY the trace that was put in memory.

Data and Memory Trace  Displays BOTH the Data trace (with selected math operation applied),

and the trace that was put in memory.

Interpolate

Note: The E5080A and M9485A do not support this function.

After performing a Data->Memory operation, memory interpolation controls whether the
memory data is interpolated or not if the start frequency, stop frequency, or Number of
Points is subsequently changed. Using the GUI control, interpolate applies to the
currently active measurement. When using the remote interfaces ( SCPI or COM), the
commands apply to the specified measurement.

Note: Interpolate does not support the 8510 Mode.

The PNA will return to a default interpolation state after a Preset, creating a new trace,
or closing the PNA application. The default interpolation state is set in the Preferences
dialog by checking or unchecking the Memory: Interpolate ON is the default condition

preference. The factory default is unchecked. The default can also be set using the
remote interfaces (SCPI or COM).

 

  When unchecked, after a Data->Memory operation the memory trace's x-y positions will not

change if the start or stop frequency is subsequently changed. In addition, if the Number of
Points in the sweep is changed after a Data->Memory operation, the memory trace will be

invalidated and disappear. If the Number of Points is changed while using Data Math, the
Memory trace will be invalidated and Data Math will be forced to the "Off" condition.

  When checked, after a Data->Memory operation the memory trace's x-y positions will be

interpolated if the start or stop frequency is subsequently changed. In addition, if the Number

of Points in the sweep is changed after a Data->Memory operation, the memory trace will be

interpolated.

Note: The PNA will not extrapolate to stimulus values beyond the range that was present at

the time of the Data->Memory operation. Instead, the Memory data will be invalidated if the
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stimulus values exceed the original range.

Note: If Interpolate is checked (ON) and stimulus conditions are different than they
were at the time of Data->Memory operation, unchecking (OFF) Interpolate will
cause the Memory trace to be either updated (using both original and current
stimulus settings) or invalidated (if Number of Points changed since Data->Memory
operation). The Memory trace will remain disabled until either Interpolate is checked
(ON) or the stimulus settings corresponding to the Data->Memory operation are
restored.

Learn more about Trace Math (scroll up)

(Data / Memory) and (Data - Memory)

(Data / Memory) and (Data - Memory) math operations are performed on linear data before it is

formatted. Because data is often viewed in log format, it is not always clear which of the two math

operations should be used. Remember: dividing linear data is the same as subtracting logarithmic data.

The following illustrates, in general, when to use each operation.

Use Data / Memory for normalization purposes, such as when comparing S21 traces "before" and

"after" a change is made or measurement of trace noise. In the following table, the Data/Mem values

intuitively show the differences between traces. It is not obvious what Data-Mem is displaying.

S21 values to compare Data/Mem Data-Mem

0.5 dB and 0.6 dB 0.1 dB -39 dB

0.5 dB and 0.7 dB 0.2 dB -33 dB

Use Data - Memory to show the relative differences between two signals. Use for comparison of very

small signals, such as the S11 match of two connectors.

In the following table, Data/Mem shows both pairs of connectors to have the same 2 dB difference.

However, the second pair of connectors have much better S11 performance (-50 and -52) and the
relative significance is shown in the Data-Mem values.

S11 values to compare Data/Mem Data-Mem

 -10 dB and -12 dB 2 dB -24 dB

 -50 dB and -52 dB 2 dB -64 dB

Data * Memory and Data + Memory

Use Data * Memory and Data + Memory to perform math on an active data trace using data from

your own formulas or algorithms rather than data from a measurement. For example, if you want to
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simulate the gain of a theoretical amplifier placed in series before the DUT, you could do the

following:

Create an algorithm that would characterize the frequency response of the theoretical amplifier.1.

Enter complex data pairs that correspond to the number of data points for your data trace.2.

Load the data pairs into memory with SCPI or COM commands. The analyzer maps the complex pairs to
correspond to the stimulus values at the actual measurement points.

3.

Use the data + memory or data * memory function to add or multiply the frequency response data to the
measured data from the active data trace.

4.

Note: The data trace must be configured before you attempt to load the memory.

Trace Statistics

You can calculate and display statistics for the active data trace. These statistics are:

Mean

Standard deviation

Peak-to-peak values

You can calculate statistics for the full stimulus span or for part of it by using User Ranges.

You can define up to 16 user ranges per channel. These user ranges are the same as the Search Domain
specified for a marker search in that same channel. They use the same memory registers and thus share

the same stimulus spans.

The user ranges for a channel can overlap each other.

A convenient use for trace statistics is to find the peak-to-peak value of passband ripple without

searching separately for the minimum and maximum values.

The trace statistics are calculated based on the format used to display the data.

Rectangular data formats are calculated from the scalar data represented in the display

Polar or Smith Chart formats are calculated from the data as it would be displayed in Log Mag format

See how to make Trace Statistics display settings.
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How to activate Trace Statistics

Using Hardkey/SoftTab/Softkey

Press Math > Analysis > Statistics....1.

Trace Statistics dialog box help

See how to make Trace Statistics display settings.

Statistics  Check to display mean, standard deviation, and peak to peak values for the active trace.

Span  Specifies the span of the active trace where data is collected for a math operation. You can

select Full Span, or define up to 16 user spans per channel with Start and Stop. You can also define

the user spans from the Search Domain selector on the Marker Search dialog box.

Start  Defines the start of a user span.

Stop  Defines the stop of a user span.

Learn more about Trace Statistics (scroll up)
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8510 Mode

On the Trace Math dialog, check 8510 Mode to simulate the Keysight 8510 data processing chain as it

pertains to Trace Math and Memory. This setting applies to all channels. When the box is checked or

cleared, the analyzer performs an Instrument Preset and retains its setting through subsequent Instrument

Presets.

This setting can be saved as part of an instrument state. However, when recalled, this setting is assumed

only temporarily. When a subsequent analyzer Preset is performed, the analyzer reverts to the setting

that was in effect before the state was recalled.

You can set a preference to always use 8510 mode.

This image represents the relevant portion of the data flow.

See the entire analyzer data processing chain.

A settings change in any of the operations that occur after the Memory operation on the above analyzer

Data Flow diagram changes both the Data trace and the Memory trace. For example, after storing a

data trace to memory, when you change the format for the Data Trace, the format for the Memory Trace

is also changed to the same setting.

 

How to turn ON/OFF 8510 mode

Using Hardkey/SoftTab/Softkey

Press Math > Memory > 8510 Mode.1.

No programming are available for this feature
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Equation Editor

Equation Editor allows you to enter an algebraic equation that can mathematically manipulate

measured data. The results are displayed as a data trace. Data that is used in the equation can be from

the same or different channels.

Note: Equation Editor is available with M937x Option 102. Learn more.

Overview

How to start Equation Editor

Using Equation Editor

Data that is used in Equation Editor

Trace Settings, Error Correction, and an Example

Functions and Constants

Operators used in Equation Editor

Example Equations

Saving Equation Editor Data

See Also

Equation Editor and MATLAB

Equation Editor Import Functions

External DC Meter Data Conversion

BestFit.dll

EqnErrorTerms.dll

Expansion.dll

Other 'Analyze Data' topics

Overview
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Equation Editor allows you to enter an algebraic equation of standard mathematical operators and

functions, referencing data that is available in the analyzer.  Once a valid equation is entered and

enabled, the display of the active trace is replaced with the results of the equation, and updated in real-

time as new data is acquired.  For equations that can be expressed with Equation Editor's supported

functions, operators, and data, there is no need for off-line processing in a separate program.

For example, enter the equation S21 / (1 - S11). The resulting trace is computed as each S21 data point

divided by one minus the corresponding S11 data point.  For a 201 point sweep setup, the computation

is repeated 201 times, once for each point.

As another example, suppose you want the analyzer to make a directivity measurement of your 3-port

DUT.  This is not a native measurement, but can be achieved using the Equation Editor.  The desired

result is the sum and difference of LogMag formatted traces, expressed as: S12 + S23 - S13.  

Because Equation Editor operates on unformatted complex data, the required equation is:

DIR = S12 * S23 / S13

DIR becomes a display label to help you identify the computed data trace.

On the equation trace, set the format to LogMag.

How to start Equation Editor

Using Hardkey/SoftTab/Softkey

Press Math > Analysis > Equation Editor.1.

Equation Editor dialog box help
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Notes

Double-click, or type, the Functions, Operators, and Data to build an Equation.

Scroll down to learn more about Using Equation Editor

Equation: The field in which equations are built. Click the down arrow to the right to use or

modify equations that have been previously saved.  This is where equations are saved when you

press 'Store Equation'.

Enabled  Check this box to enable the equation that is currently in the Equation field. If the

Enabled box is not available, then the equation is not valid. If a data trace is used that is from a

different channel than the Equation trace, the channels MUST have the same number of data points

to be valid.

<-Backspace  Moves the cursor to the left while erasing characters.

<-  Moves the cursor to the left without erasing characters.

->  Moves the cursor to the right without erasing characters.

Store Equation  Press to save the current equation. To later recall the equation, click the down

arrow to the right of the equation.

Delete Equation  Removes the current equation from the drop-down list.

491



Functions/Constants:  See descriptions of Functions.

Select the "library" of functions to view.  The "built-in" library appears by default which includes

the standard functions of equation editor. Other functions that can appear here are functions that you

have written and imported.  Learn more.

Operators:  See descriptions of Operators.

Trace Data: Select from ALL of the currently displayed traces on ALL channels.

Parameter: Select from undisplayed data that is available ONLY from the active channel (same

channel as the equation trace).  See Data that is used in Equations.

Note: With an external test set enabled, only parameters involving ports 1 through 4 are listed.

However, all available parameters can be typed directly into the Equation field.  

Keypad: Provided to allow navigation of the entire dialog with a mouse.

Import...  Click to launch the Import Functions Dialog box.

Use Short Names  Some functions have shortened names that are entered automatically when

checked. Both long and short names can be used interchangeably.

Enable Matlab  Available when a full MATLAB version is installed by you on the analyzer. Learn
more.

Using Equation Editor

1. Pick a trace in which to enter the equation

Equation Editor works on the active trace.

Either create a new trace, or click the Trace Status button on an existing trace to make the trace active.

2. Enter an equation

Start Equation Editor See how.

The equation text can be in the form of an expression (S21)/(1-S11) or an equation (DIR = S12 * S23 / S13).
This topic refers to both types as equations.

Either type, or double-click the Functions, Operators, and Data to build an equation.

Functions and Constants ARE case-sensitive; Data names are NOT case sensitive.
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Learn more about referring to data traces.

3. Check for a valid equation

When a valid equation is entered, the Enabled checkbox becomes available for checking. When the

Enabled box is checked:

The Equation Trace becomes computed data.

The equation is visible on the Trace Status (up to about 10 characters).

The equation is visible in the trace Title area (up to about 45 characters) when the Equation trace is active.

The equation is visible in the Status Bar at the bottom of the display. This is updated only after the equation
is entered and the Trace Status button is clicked.

If an equation is NOT valid, and a trace from a different channel is used, make sure the number of data
points is the same for both channels.

Learn more about the Functions, Operators, and Data that are used in Equation Editor.

Data that is used in Equation Editor

Definitions

Equation trace  A trace in which an equation resides.

Referred trace  A trace that is used as data in an equation.

Example: eq=Tr2+S11 is entered into Tr1.

Tr1 becomes an equation trace.

Tr2 and S11 are both referred traces because they are used in the equation trace.

Notes

Referred traces are processed one data point at a time. For example, the expression S11/S21 means that for
each data point in S11 and S21, divide point N of S11 by point N of S21.

Once an equation is enabled, the trace is no longer identified by its original measurement parameter. It
becomes an equation trace.

An equation trace can NOT refer to itself. For example, an equation in Tr1 cannot refer to trace Tr1.

Referred traces can be selected from S-Parameters, Receiver data, and Memory traces.
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See note regarding External Test Sets.

See Using Noise Power Traces in Equation Editor

There are three ways to refer to traces:

The following distinction is important when discussing the three ways to refer to traces/data.

Trace - a sequential collection of data points that are displayed on the screen.

Data - analyzer measurements that are acquired but not displayed. When an equation trace refers to data
that is not displayed, the analyzer will automatically acquire the data.

1. Using TrX  Trace notation (for example, Tr2).

When a trace is created, check "Show Tr Annotation" to see the Tr number of that trace.

Simple - ALWAYS refers to displayed traces.

Must be used for referring to traces in a different channel as the equation trace.

All trace settings are preserved in the equation trace. If you do NOT want a trace setting to be used in the
equation trace, you must disable it in the referred trace.

If the referred trace is error corrected, then that data is corrected in the equation trace.

Used to refer to a memory trace (it must already be stored in memory). Append .MEM to the TrX trace
identifier. For example, Tr2.mem refers to the memory trace that is stored for Tr2.

2. Using S-parameter notation (for example, S11/S21)

Convenient - ALWAYS refers to data that is NOT displayed.

Refers to data that resides in the same channel as the equation.

NOT the same as referring to a displayed S11 trace using TrX notation. See Example.

The referred data includes NO trace settings.

If correction is applied to the channel, equation editor traces in that channel will attempt to use
corrected parameter data regardless if correction is on/off for the measurement. If there is no corrected
data available, then raw data will be used. TrX notation always ignores the correction state.

3. Using Receiver notation (for example AB_2); NOT case sensitive.

At least one receiver is required, followed by an underscore and a number.
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The letters before the underscore refer to the receivers.

Letters alone refer to physical receivers.

Letters immediately followed by numbers refer to logical receivers. Learn more.

If two receivers are referenced, they are ratioed.

The number after the underscore refers to the source port for the measurement.

Examples

AR1_2 = physical receiver A / physical receiver R1 with 2 as the source port.

a3b4_1 = reference receiver for port 3 / test port receiver for port 4 with 1 as the source port.

Learn more about ratioed and unratioed receiver measurements.

Receiver notation is like S-parameter notation in that:

Refers to data that is NOT displayed and resides in the same channel as the equation.

The referred data includes NO trace settings.

If correction is applied to the channel, equation editor traces in that channel will attempt to use corrected
parameter data regardless if correction is on/off for the measurement. If there is no corrected data available,
then raw data will be used. TrX notation always ignores the correction state.

Referring to Traces in a different channel

When the equation trace refers to a trace on a different channel:

The trace must already be displayed.

Must refer to the trace using TrX notation.

The Equation trace and the referred trace MUST have the same number of data points or the Enable
checkbox will not be available.

The Equation trace is updated when the last referred data in the same channel is acquired. Therefore, to
prevent 'stale' data from being used, the Equation trace must be on a higher numbered channel than the
referred trace. This is because the analyzer acquires data in ascending channel number order - first channel
1, then channel 2, and so forth. If the Equation trace is on channel 1, and it refers to a trace on channel 2,
the Equation trace will update after channel 1 is finished sweeping, using 'old' data for the channel 2 trace.
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Port Extensions and Equation Editor

When using port extension with an equation, turn Fixturing ON to ensure that the underlying

parameters have port extension properly applied. Learn more.

Trace Settings, Error Correction, and an Example

This discussion highlights the differences between using S-parameter / Receiver notation and TrX

notation when referring to traces. The key to understanding the differences is realizing that S-

parameter / Receiver notation ALWAYS refers to data that is NOT displayed.

Trace Settings  Normalization, Trace Math, Gating, Phase and Mag Offset, Electrical Delay, Time Domain.

Equation Editor processing occurs on the equation trace immediately after error correction.

Referred Data/Trace (used in the equation) is taken from the following locations:

When using TrX notation, data is taken immediately before formatting . These traces are always displayed
and include Trace Settings.

When using S-parameter / Receiver notation, data is taken immediately after error correction. This data is
NOT displayed and includes NO trace settings (see example).

Error-correction and Equation Editor

Using TrX notation:

The Trace Settings and Error-correction on the referred trace are used in the Equation trace.

If error correction is NOT ON, then the raw, uncorrected data is used in the equation trace.

To see if error correction is ON, make the trace active, then see the Correction level in the status bar.

496



Turning error correction ON/OFF on the equation trace has no meaning. The referred data that is used in the
equation is ALWAYS what determines its level of correction.

Using S-parameter and Receiver notation:

Because the data is not displayed, NO trace settings are used in the Equation trace.

If correction is applied to the channel, equation editor traces in that channel will attempt to use corrected
parameter data regardless if correction is on/off for the measurement. If there is no corrected data available,
then raw data will be used. TrX notation always ignores the correction state.

When using S-parameter and Receiver notation to refer to a trace on a channel that has been calibrated with
a Response Cal or Receiver Cal, correction can NOT be turned ON, even though the Status Bar indicates
otherwise. For example: Tr1 is an S11 measurement with a Response Cal. Tr2 is an equation trace that
refers to S11. The Tr2 equation trace is NOT corrected, even though the Status Bar may indicate that it is
corrected. However, if Tr2 refers to Tr1 (not S11), the Tr2 equation trace is corrected.

Example

This example illustrates the differences when referring to a trace using S-parameter notation and TrX

notation:

Tr1 is an S11 measurement with no equation, 2-port correction ON, and Time Domain transform ON.

Tr2 is an equation trace that refers to Tr1. Tr2 is corrected because Tr1 is corrected. Tr2 is transformed
because Tr1 is transformed. If transform is turned ON for Tr2, the data will be transformed AGAIN, which
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results in "unusual" data.

Tr3 is an equation trace that refers to S11. This is NOT the same as referring to Tr1. The S11 trace that is
referred to is a different instance of S11 that is NOT displayed, and has NO trace settings. Notice that Tr3
data is NOT transformed, although Tr1 is transformed. Correction for Tr3 can be turned ON and OFF
because a calibration was performed on the channel in which the S11 trace resides.

Note: X- axis annotation of the Equation trace is completely independent of the data that is presented. ONLY
the data values from a referred trace are used. For example, notice that the Equation trace Tr2 has
Frequency on the X-axis although the referred trace Tr1 is presented in Time.

Functions and Constants used in Equation Editor

ALL trace data that is used in Equation Editor is unformatted, complex data.

When using a mouse with the analyzer, hover over a function in the dialog to learn how it is used.

In the following table,

Function(scalar x) means that an automatic conversion from a complex number to its scalar magnitude is
performed before passing the value to the function.

Function(complex x) means that the entire complex value is used.

a, b, c, d are arguments that are used in the function.

 

Function/Constant Description

acos(scalar a) returns the arc cosine of a in radians

asin(scalar a) returns the arc sine of a in radians

atan(scalar a) returns the arc tangent of a in radians

atan2 returns the phase of complex a = (re,im) in radians

has the following  two argument sets:

atan2(complex a) - returns the phase in radians

atan2(scalar a, scalar b)

conj(complex a) takes a and returns the complex conjugate

cos(complex a) takes a in radians and returns the cosine

cpx(scalar a, scalar b) returns a complex value (a+ib) from two scalar values

e returns the constant =~ 2.71828...
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exp(complex a) returns the exponential of a

getNumPoints() returns the number of points for the current sweep

im(complex a) returns the imag part of a as the scalar part of the result (zeroes the

imag part)

kfac(complex a, complex b,

complex c, complex d )

when entered in EE:

kfac(S11,S21,S12,S22)

k-factor:

k = (1 - |a|^2 - |d|^2 + |a*d-b*c|^2 ) / (2 * |b*c|)

returns a scalar result - the imaginary part of the complex result is

always 0

ln(complex a) returns the natural logarithm of a

log10(complex a) returns the base 10 logarithm of a

mag(complex a) returns sqrt(a.re*a.re+a.im*a.im)

max(complex a, complex b,

...)

returns the complex value that has the largest magnitude of a list of

values.

max_hold(complex a) holds the current maximums of the sweep. Disable the equation to

reset. See example

median(complex a, complex

b,...)

returns the median of a list of complex values

The median is determined by sorting the values by magnitude, and
returning the middle one.

If an even number of values is passed, then the smaller of the two
middle values is returned.

min(complex a, complex b,

...)

returns the complex value that has the smallest magnitude of a list

of values.

min_hold(complex a) holds the current minimums of the sweep. Disable the equation to

reset. See example

mrkx(a,b) returns the x-axis value of marker number b on trace number a.

mrky(a,b) returns the y-axis value of marker number b on trace number a.

mu1(complex a, complex b,
complex c, complex d )

when entered in EE:

mu1(S11,S21,S12,S22)

mu1 = (1 - |a|^2) / ( |d - conj(a) * (a*d-b*c)| + |b*c| )

mu2( complex a, complex b,

complex c, complex d )

when entered in EE:
mu1(S11,S21,S12,S22)

mu2 = (1 - |d|^2) / ( |a - conj(d) * (a*d-b*c)| + |b*c| )
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for both mu1 and mu2

(Usually written with the

Greek character µ )

conj is the complex conjugate. For scalars a and b,   conj(a+ib) = (a-
ib)

returns a scalar result - the imaginary part of the complex result is
always 0

phase(complex a) returns atan2(a) in degrees

PI returns the numeric constant pi (3.141592), which is the ratio of

the circumference of a circle to its diameter

pow(complex a,complex b) returns a to the power b

re(complex a) returns the scalar part of a (zeroes the imag part)

sin(complex a) takes a in radians and returns the sine

sqrt(complex a) returns the square root of a, with phase angle in the half-open

interval (-pi/2, pi/2]

tan(complex a) takes a in radians and returns the tangent

traceDataArray(complex a) returns the entire set of points from a sweep. Function is intended

to be used as an argument in an custom function to allow access for

data array processing.

xAxisArray() or

xAxisArray(integer a)

returns the current value of the x-axis for this channel or from a

specified channel.

xAxisIndex() returns the current index in the sweep.

xAxisValue() or

xAxisValue(integer a)

returns the current value of the x-axis index for this channel or

from a specified channel.

Operators used in Equation Editor

Operator Description

+ Addition

- Subtraction

* Multiplication

/ Division

( Open parenthesis

) Close parenthesis

, Comma - separator for

arguments (as in S11,

S22)

= Equal (optional)

E Exponent (as in 23.45E6)
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Example Equations

The following examples may help you get started with Equation Editor.

Offset each data point in Tr2 from Tr1 by 2dB

Use the function: pow(complex a, complex b)  -- returns a to the power b.

20log(a) + 2 = 20log(x)

log( a ) + 2/20 = log( x ) // divide all by 20.

x = 10^(log(a) + 2/20)   // swap sides and take 10 to the power of both sides

x = 10^log(a) * 10^(2/20)

x = a * 10^(2/20)

The equation is entered into Tr2 as:

Offset=Tr1*pow(10, 2/20)

To offset by 5 dB

Offset=Tr1*pow(10, 5/20).

Balanced Match using a 2-port analyzer

SDD11 = (S11-S21-S12+S22)/2

Conversion loss

B_1/pow(10,-15/20)

B_1 is a receiver measurement;

-15 is the input power in dBm

Third-order intercept point (IP3 or TOI)

TR1*sqrt(Tr1/Tr3)

Tr1 = input signal power

Tr3 = intermodulation power (both traces measured with single receivers)

Harmonics in dBc

B_1/Tr2

B_1 is tuned to a harmonic frequency
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Tr2 = power at fundamental frequency, measured with B_1 receiver

PAE (Power Added Efficiency)

Pout - Pin / Pdc

Type the following equation into a new trace with an unratioed measurement, such as AI1. The data

format is REAL:

PAE = 100 * (.001*pow(mag(Tr1),2)-(.001*pow(mag(Tr1),2)/pow(mag(Tr2),2)))/(Tr3*Tr4)

Where:

Tr1 - a trace that measures unratioed B receiver.

Tr2 - a corrected S21 trace (amplifier gain)

Tr3 - a trace that measures voltage (AI1) across a sensing resistor.

Tr4 = an equation trace containing Isupp = (Tr3 / value of sensing resistor).

Data is displayed in Real format with units actually being watts.

1-port Insertion Loss

When it is not possible to connect both ends of a cable to the analyzer, a 1-port insertion loss

measurement can be made. However, the measured loss must be divided by 2 because the result

includes the loss going down and coming back through the cable. This assumes that the device is

terminated with a short or open to reflect all of the power. The 'divide by 2' operation (for dB) is

performed as follows using Equation Editor:

Tr1 - an S11 trace in log mag format.

Tr2 - an equation trace containing sqrt(Tr1)

Max and Min Hold

These two functions allow you to capture and display either the Maximum or Minimum values for each
data point over multiple sweeps.

Maxhold(S21) - displays the maximum value for each data point until reset. Reset by disabling, then

enabling the equation.  This example refers to an S21 trace that is not displayed.

Saving Equation Editor Data
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Equation data can be saved to the analyzer hard drive in the following formats:

Citifile (.cti) - Equation data is saved and recalled. The file header indicates the "underlying" s-parameter
trace type.

PRN - read by Spreadsheet software. Can NOT be recalled by the analyzer.

CSV - read by Spreadsheet software. Can NOT be recalled by the analyzer.

MDIF - compatible with Keysight ADS (Advanced Design System). Can NOT be recalled by the analyzer.

Print to File (bmp, jpg, png) - saves an image of the screen.

Equation data can NOT be saved in .SnP file format. When attempting to save an Equation trace in .SnP

format, the "underlying" S-parameter data is saved; not Equation data.
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Import Functions

Several additional functions are provided with the VNA. In addition, you can create custom functions

which are compiled into a DLL.  Import these functions for use in the Equation Editor.

How to Import Functions

Supplied User Functions

BestFit.dll

EqnErrorTerms.dll

Expansion.dll

See Also

Custom Equations In PNA.pdf  Detailed directions. (This link requires an internet connection.)

Create custom functions for Equation Editor Template. (This link requires an internet connection.)

Equation Editor Main topic.

How to Import Functions

From the main Equation Editor dialog, click Import Functions

Import Functions dialog box help

Imports and removes libraries that are used with Equation Editor. A library is a *.DLL file that

contains one or more functions.

Although not all functions are applicable to all channels or data sets, they will still appear in the
"Function/Constants" list.

Once imported, each library is automatically loaded when the VNA application starts. If a function

is not found or if an error occurs while loading, the VNA will not attempt to reload the library when

starting.

Import Library tab
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Browse  Click to navigate to the .DLL file on the VNA. The recommended location for the custom

equation DLLs is the “C:\Program Files (x86)\Keysight\Network Analyzer\UserFunctions”

directory on the VNA.

Library Preview  Lists the functions that are contained in the library.

Click OK or Apply to load the library.

Remove Library tab

Left pane  Lists the imported libraries. These also appear in the Equation Editor main dialog and

remain until removed from the VNA.

Arrows  Click the relevant arrows to move some ( >) or all ( >>) libraries from the VNA.

Right Pane Lists the libraries to remove.

Click OK or Apply to remove the library.

Supplied User Functions

The following functions are supplied with the VNA, but must be imported into Equation Editor. They

are available on the VNA at: 'C:\Program Files (x86)\Keysight\Network Analyzer\UserFunctions'.
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BestFit.dll

EqnErrorTerms.dll

Expansion.dll

BestFit.dll

d_best_fit_dB() d_best_fit_dB(getNumPoints(),xAxisIndex(),xAxisArray(),traceDataArray(PARAM))

Draws the best fit linear regression line to data specified by PARAM.  The best fit line minimizes the RSS (root-

sum-square) of the trace data in log-magnitude format. The phase of the regression line is identically zero.

d_channelPower() d_channelPower(FA,FB,CHANNELNUM,xAxisIndex(),TRACETYPE,traceDataArray(PARAM))

Computes the channel power for the specified measurement on the given channel number between the given

frequencies.

FA and FB specify the frequency start/stop values in Hz.

CHANNELNUM is the 1-based channel number to use.

PARAM indicates the measurement to compute channel power for.

TRACETYPE indicates how to display the computed result.

If TRACETYPE= 0, the display is a flat line with value equal to the channel power;

if TRACETYPE= 1 (default), the display is set to the trace minimum for frequencies outside the range from FA to FB.
See examples below .

If CHANNELNUM is hosting an IM Spectrum measurement, the channel power is computed from the formula:

channelPower = 10Log10( (area under PARAM trace between FA and FB)/resolutionBandwidth

For all other measurement types, the formula is:

channelPower = 10Log10( (area under PARAM trace between FA and FB)/IFBandwidth )

 

TraceType Example 1 : FA=7.75 GHz, FB=8.5 GHz, CHANNELNUM=1. TRACETYPE is 0. Computed channel

power is displayed over the entire frequency range.
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TraceType Example 2 : As above, but TRACETYPE is 1 (the default). Displayed result is set to trace minimum

outside of specified range.

d_DFLP() d_DFLP( FreqStart, FreqStop, xAxisIndex(), getNumPoints(), xAxisArray(), traceDataArray(PARAM))

Computes the deviation from linear phase data of the specified trace, PARAM, such that if the resulting trace is

displayed in Phase format, the displayed data will be residual phase response of the parameter after the group delay

slope has been removed.  The FreqStart and FreqStop arguments allow the user to specify a subset of the channel

span for this computation.  To cover the channel’s entire span, set the FreqStart to 0 and FreqStop to a very large

number such as 1E100.  
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d_flatness_dB() d_flatness_dB(getNumPoints(),xAxisIndex(),xAxisArray(),traceDataArray(PARAM))

Computes the magnitude flatness of the trace data in PARAM, by first removing any gain slope and then

normalizing the results to 0 dB.

d_mean() d_mean(traceNum)

Computes the mean of the specified trace and creates a resulting trace whose real part is the mean at each stimulus

point.  The traceNum argument should be replaced by an integer number that represents the existing trace number of

the trace for which you want to compute the mean.  This function does not operate on parameter names (such as

S11) or trace names (such as Tr1).  The result of this function is the same value displayed by the Trace Statistics

analysis function.

d_min_max_dev() d_min_max_dev(getNumPoints(),xAxisIndex(),xAxisArray(),traceDataArray(PARAM))

Computes the slope and intercept of the line which minimizes that maximum absolute deviation between the line

and the data specified by PARAM. This is done in two phases. First, the trace data in PARAM is converted to log

magnitude, and a minimum-deviation line is fitted to it. Second, the phase data in PARAM is unwrapped, and

another minimum-deviation line is fitted to that. The magnitude and phase values are then combined to form a

complex-valued trace. The displayed traces represent the deltas between the measured values in PARAM and the

best-fit data. This function is typically used when you wish to measure worst-case deviation from linear behavior.

d_min_max_dev_d2() d_min_max_dev_d2(getNumPoints(),xAxisIndex(),xAxisArray(),traceDataArray(PARAM))

Computes the parameters of the parabola which minimizes that maximum deviation between the parabola and the

data specified by PARAM. This is done in two phases. First, the trace data in PARAM is converted to log

magnitude, and a minimum-deviation quadratic is fitted to it. Second, the phase data in PARAM is unwrapped, and

another minimum-deviation quadratic is fitted to that. The magnitude and phase values are then combined to form a

complex-valued trace. The displayed traces represent the deltas between the measured values in PARAM and the

best-fit data. This function is typically used when you wish to measure worst-case deviation from quadratic

behavior.

d_min_max_dev_range() d_min_max_dev_range(FSTART,FSTOP,xAxisIndex(),getNumPoints(),xAxisArray(),traceDataArray(PARAM))

Identical to the function d_min_max_dev(), but only operates on data in the frequency range from FSTART to

FSTOP.

d_min_sum_dev() d_min_sum_dev(getNumPoints(),xAxisIndex(),xAxisArray(),traceDataArray(PARAM))

Computes the slope and intercept of the line which minimizes that sum of the absolute deviations between the line

and the data specified by PARAM. This is done in two phases. First, the trace data in PARAM is converted to log

magnitude, and a minimum-deviation line is fitted to it. Second, the phase data in PARAM is unwrapped, and

another minimum-deviation line is fitted to that. The magnitude and phase values are then combined to form a

complex-valued trace. The displayed trace represents the sum of the deviations. This function is less sensitive to

outliers than d_min_max_dev().

d_tilt_dB() d_tilt_dB(getNumPoints(),xAxisIndex(),xAxisArray(),traceDataArray(PARAM)) – The result of the tilt() function

when displayed in LogMag format is the total deltaY of the best fit line for the specified trace or parameter.
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d_unwrap() d_unwrap(getNumPoints(),xAxisIndex(),traceDataArray(PARAM))

The result of the unwrap() function when displayed in Real format is the unwrapped phase response of the specified

trace or Parameter in degrees.

EqnErrorTerms.dll

d_Corr1P() d_Corr1P(chan, xAxisIndex(),rcvr, src, RAWDATA )

Computes and displays 1 port corrected data for the trace data supplied in the

RAWDATA placeholder.

chan -  the channel of interest.

xAxisIndex() - the bucket (data point) number.

rcvr - the port number of the receiver used to acquire the data.

src - the port being driven.  The rcvr and src arguments are needed to select

the appropriate error terms used in the correction process.

RAWDATA - Select the data to be corrected by substituting in a trace number

or parameter name.

d_DIR() d_DIR(chanNum, xAxisIndex(), rcvr, src)

Displays the directivity term from the cal set used by the channel <chanNum>.

 

Set chanNum to the desired channel.

Set rcvr and src to the port number for the desired directivity term.

d_EnhResp() d_EnhResp(chan,xAxisIndex(),rcvr, src,RAWMATCH,RAWGAIN)

Computes the corrected gain using enhanced response correction techniques.

 This technique is useful in cases where you want to ignore the output match

of a device or the output match cannot be accurately measured.  In this the raw

input match and gain are supplied to equation (via RAWMATCH and

RAWGAIN placeholders).  To use this equation select a trace (TR n) or

parameter to use in place of the raw match and gain terms.

chan - the channel number

xAxisIndex() - the bucket number (do not modify)

rcv - The port where the data is acquired.
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Sr - The port being driven.  The src and rcvr ports are required so that the

appropriate error terms are used to calculate the result.

d_LDM() d_LDM(chanNum, xAxisIndex(), rcvr, src)

Displays the loadmatch term from the calset used by the channel <chanNum>.

 

Set chanNum to the desired channel.

Set rcvr to the load port, and src to the source port for the desired load match

term.  

LDM(ch, xAxisIndex(), 2,1) gives you the match presented by port 2 while

driving port 1.

d_RFT() d_RFT(chanNum, xAxisIndex(), rcvr, src)

Displays the reflection tracking term from the calset used by the channel

<chanNum>.  

Set chanNum to the desired channel.

Set rcvr and src to the port number for the desired reflection tracking term.

d_SRM() d_SRM(chanNum, xAxisIndex(), rcvr, src)

Displays the sourcematch term from the calset used by the channel

<chanNum>.  

Set chanNum to the desired channel.

Set rcvr and src to the port number for the desired source match term.

d_TRT() d_TRT(chanNum, xAxisIndex(), rcvr, src)

Displays the transmission tracking term from the calset used by the channel
<chanNum>.  

Set chanNum to the desired channel.

Set rcvr to the receive port and src to the source port such that TRT( ch,
xAxisIndex(), 2, 1) gives you the transmission tracking term for the port 2

input receiver driven by port 1, or in other words, the raw S21 tracking term.

d_XTLK() d_XTLK(chanNum, xAxisIndex(), rcvr, src)

Displays the isolation term from the calset used by the channel <chanNum>.  

Set chanNum to the desired channel.
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Set rcvr to the receive port and src to the source port such that XTLK( ch,

xAxisIndex(), 2, 1) gives you the isolation  term for the port 2 input receiver

while port 1 is on.

Expansion.dll

admittance(x) Admittance(x) = 1/x

Calculate the admittance

max_hold(x) (KEY, getNumPoints(),xAxisIndex(),PARAM)

Shows maximum value of each point

min_hold(x) (KEY, getNumPoints(), xAxisIndex(), PARAM)

Shows minimum value of each point.

PAE(B,S21,AI1,AI2,R,SCALE) .001 * (B - (B/S21)) / ( SCALE^2*AI1(AI1 - AI2)/R  )

Power Added Efficiency.

B - power out

S21 - corrected amplifier gain

AI1 - DC power supply

AI2 - DC power amp

R - resistance

SCALE - scale

reset(x) x - a number.

Resets the max_hold() or min_hold() function.

To reset a given max_hold() or min_hold() function, call

reset with the same key.

SDD11(S11,S21,S12,S22) (S11 - S21 - S12 + S22)/2

Differential mode reflection

SDC11(S11,S21,S12,S22) (S11 - S21 + S12 - S22)/2

C to D mode conversion reflection

SCD11(S11,S21,S12,S22) (S11 + S21 - S12 - S22)/2

D to C mode conversion reflection
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SCC11(S11,S21,S12,S22) (S21 + S12 + S11 + S22)/2

Common mode reflection

Use the following two equations to display impedance versus frequency.

Replace 'LOAD' with the value for Z0 (usually 50).

Note: You can read out impedance versus time (not using this function) by creating a marker on a

Time Domain trace, then changing the marker format to R+jX. Learn how .

zReflect(S11,LOAD) LOAD*(1 + S11)/(1-S11)

zTransfer(S21,LOAD) 2 * LOAD * (1 - S21)/S21
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External DC Meter Data Conversion

When creating equations using values from an external DC meter, it is important to understand how

these values are stored in the VNA's data buffers and the conversion that occurs when used in an

equation. For example, when a voltage is read from an external DC meter, the value is displayed on the

VNA as you would expect. That is, if you are reading a voltage level of 2 V from the DC meter in a

trace, the VNA will display a level of 2 V. However, the value stored in the VNA data buffers is not a

voltage but is a unit-less value. Voltage, Amperes, dBm, and Watts values from an external DC meter

are converted so that the format matches that of the data in the VNA internal receivers. In this way, all

of the formats within the VNA are the same. This information is important when performing analysis

using the Equation Editor because the trace data is the converted value.

See Also

Equation Editor

Configure a DC Device

 

The following table shows the formats (which are selected from the Type setting on the External DC

Meter Properties dialog) and corresponding equations that convert between external DC meter readings

and the VNA representation when using the trace data in an equation.

Note: Z0 is the characteristic impedance (typically 50 Ohms), dcMeter is the value from the external

DC meter, and pnaVal is the value stored in the VNA data buffers. All data types are REAL.

 

Formats
DC Meter to VNA Data

Conversion

VNA to DC Meter Data

Conversion

V (volts - default) +/-*sqrt((dcMeter*dcMeter/Z0)*1000) +/-*sqrt((pnaVal*pnaVal/1000)*Z0)
A (amperes) +/-*sqrt((dcMeter*dcMeter*Z0)*1000) +/-*sqrt((pnaVal*pnaVal/Z0)/1000)
dBm pow(10,dcMeter/20) 20*log(pnaVal)
W (watts) sqrt(dcMeter*1000) pnaVal*pnaVal/1000
K (kelvin) N/A N/A
F (degrees) N/A N/A
C (degrees) N/A N/A

External DC Meter Voltage Example

The following example shows how trace data is converted when used in an equation. In this example, a

1.
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level of 2 V is read from an external DC meter.

Configure the external DC meter as described in Configure a DC Device .1.
In the External DC Meter dialog, ensure that Type is set to V .2.
Press Trace > Trace Setup >Add Trace > New Trace... .3.
In the New Trace dialog, select the Receivers tab, check Activate , click on the corresponding down arrow
in the Numerator column, select the external DC meter from the drop down list, then click OK .

4.

 

Note: If the external DC meter is not displayed in the list, ensure that Active - Show in UI is

checked in the External Device Configuration dialog.

Trace 1 and Trace 2 should now be displayed on the VNA. Add markers to both traces. The Trace 2 marker
should read 2.00 V from the external DC meter.

5.

Select Trace 1, then select Response , Format , Lin Mag .6.
Select Response , Math , then Equation Editor... .7.
Enter the following Trace 1 equation to add a value of 2 to the Trace 2 data.8.
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7.
8.

Check Enable Equation, then click OK .9.
Note that instead of a voltage level of 4.00 V, the Trace 1 marker reads 10.94 U (unit-less value).10.

As shown in the table above, a voltage from an external DC meter is converted using

sqrt((dcMeter*dcMeter/Z0)*1000) . Therefore, substituting 2 for dcMeter in the equation and

using 50 as Z0 results in a value of 8.94. Adding a value of 2 to the Trace 2 data, as defined in

the Trace 1 equation, results in the displayed marker value of 10.94.

To ensure that the displayed value is 4 instead of 10.94, which is not useful, use the equation from the VNA
to DC Meter Data Conversion column of the table above as follows:

10.
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10.

The Trace 1 marker now displays a value of 4.00 U.11.
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Performing Parameter Conversion of Measurement Results

Overview

Selecting Conversion Target Parameter

Other 'Analyze Data' topics

Overview

You can use the parameter conversion function to convert the measurement results of the S-parameter

(Sab) to the following parameters.

 Equivalent impedance (Zr) and equivalent admittance (Yr) in reflection measurement

Equivalent impedance (Zt) and equivalent admittance (Yt) in transmission measurement

Inverse S-parameter (1/Sab)

where:

Z0a: Characteristic impedance of port a

Z0b: Characteristic impedance of port b

Z/Y Transmission Shunt
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Conjugation

Conjugation converts the measurement value to complex conjugate number.
 

When the fixture simulator function is ON and the port impedance function is ON, the value set in the

port impedance conversion is used. In other cases, the system Z0 (preset value: 50 &) is used.

Selecting Conversion Target Parameter

Press Meas > Meas Setup > Conversions1.

Select function.2.

Softkey Function
Off Off
Z-Reflection Impedance (Zr) in

reflection

measurement
Z-Transmit Impedance (Zt) in

transmission

measurement
Z-Trans-
Shunt

Impedance (Zt)

 Transmission Shunt
Y-Reflection Admittance (Yr) in

reflection

measurement
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Y-Transmit Admittance (Yt) in

transmission

measurement
Y-Trans-
Shunt

Admittance (Yt)

Transmission Shunt
1/S Inverse S-paramete
Conjugation Complex conjugate

number
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Using Limit Lines

Limit lines allow you to compare measurement data to performance constraints that you define.

Overview

Create and Edit Limit Lines

Display and Test with Limit Lines

Limit Test Setup

Point Limit Test

Saving/Recalling Limit Table

Displaying Judgement Result of Limit Test

Testing with Sufficient Data Points

Other Analyze Data topics

Overview

Limit lines are visual representations on the VNA screen of the specified limits for a measurement.

You can use limit lines to do the following:

Give the operator visual guides when tuning devices.

Provide standard criteria for meeting device specification.

Show the comparison of data versus specifications.

Limit testing compares the measured data with defined limits, and provides optional Pass or Fail

information for each measured data point.

You can have up to 100 discrete lines for each measurement trace allowing you to test all aspects of

your DUT response.

Limit lines and limit testing are NOT available with Smith Chart or Polar display format. If limit lines

are ON and you change to Smith Chart or Polar format, the analyzer will automatically disable the limit

lines and limit testing.
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By default, limit lines are drawn in the same color as the trace on which they are created. However, all

limit lines can be drawn in Red by setting a preference. Learn more.

Create and Edit Limit Lines

You can create limit lines for all measurement traces. The limit lines are the same color as the

measurement trace.

Limit lines are made up of discrete lines with four coordinates:

BEGIN and END stimulus - X-axis values.

BEGIN and END response - Y-axis values.

Limit Table

How to turn Limit Table ON/OFF

Using Hardkey/SoftTab/Softkey

Press Math > Analysis.1.

Click Limit Table > Limit to turn ON/OFF the Limit Table.2.

 

Note: To ADD a limit line to the table, change the last limit line to either MAX or MIN

In the Type area of the Limit Table, select MIN or MAX for Limit Line 1.

The MIN value will fail measurements BELOW this limit.

The MAX value will fail measurements ABOVE this limit.

1.

Click BEGIN STIMULUS for Limit Segment 1. Enter the desired value.2.

Click END STIMULUS for Limit Segment 1. Enter the desired value.3.

Click BEGIN RESPONSE for Limit Segment 1. Enter the desired value.4.

5.

6.
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4.

Click END RESPONSE for Limit Segment 1. Enter the desired value.5.

Repeat Steps 1-5 for each desired limit line.6.

Displaying and Testing with Limit Lines

After creating limit lines, you can then choose to display or hide them for each trace. The specified

limits remain valid even if limit lines are not displayed.

Limit testing cannot be performed on memory traces.

You can choose to provide a visual and / or audible PASS / FAIL indication.

With limit testing turned ON:

Any portion of the measurement trace that fails is displayed in red.

Any portion of the measurement trace that does NOT fail remains unchanged and silent.

Display failed trace points or trace segments

You can display the data points that fail limit line testing as red dots or as a red trace segment. The

default behavior (red trace) can be changed with a Preference setting. Learn how.

Red dots Red trace segment

PASS is the default mode of Pass / Fail testing.

A data point will FAIL only if a measured point falls outside of the limits.

If the limit line is set to OFF, the entire trace will PASS.

If there is no measured data point at a limit line stimulus setting, that point will PASS.

Limit Test Setup
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How to set Limit Test Setup

Using Hardkey/SoftTab/Softkey

Press Math > Analysis.1.

Click Limits... and then select Limit tab on the dialog box.2.

Limit Test dialog box help

Limit Test

Limit Test ON  Check the box to compare the data trace to the limits and display PASS or FAIL.

Limit Line ON  Check the box to make the limits visible on the screen. (Testing still occurs if the

limits are not visible.)

Sound ON Fail  Check the box to make the VNA beep when a point on the data trace fails the

limit test.

Pass/Fail Position

Sets the position of the Limit Line Pass/Fail status indicator on the VNA screen.

X - X-axis position. 0 is far left; 10 is far right.

Y - X-axis position. 0 is bottom; 10 is top.
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Show Table  Shows the table that allows you to create and edit limits.

Load Table - Recall the saved limit table. Learn more.

Save Table - Save the limit table. Learn more.

Note: To ADD a limit line to the table, change the last limit line to either MAX or MIN.

 

Global Pass/Fail

The Pass/Fail indicator provides an easy way to monitor the status of ALL measurements.

Global Pass/Fail ON  Check to display the Global Pass/Fail status.

Policy:  Choose which of the following must occur for the Global Pass/Fail status to display

PASS:

All Tests (with Limit Test ON) Must Pass - This setting reads the results from the Limit Tests. If all tests
(with Limit Test ON) PASS, then the Global Pass/Fail status will PASS.

All Measurements Must Pass -  This more critical setting shows FAIL unless all measured data points
fall within established test limits and Limit Test is ON. Note: In this mode, if one measurement does NOT
have Limit Test ON, Global Pass/Fail will show FAIL.

Note: In this mode, if one measurement does NOT have Limit Test ON, Global Pass/Fail will

show FAIL.

Learn more about displaying and testing with Limits (scroll up)

Saving/Recalling Limit Test Table

The limit test table can be saved in a file and recalled later for use on the screen. The file is saved in the

csv format (with the extension *.csv), and values are saved as a character string with the unit. The csv
formatted file can also be reused in spreadsheet software made for PCs.
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How to turn Save or Load Limit Test Table

Using Hardkey/SoftTab/Softkey

Press Math > Analysis.1.

Click Limits... and then select Limit tab on the dialog box.2.

Click Load Table to recall the saved Limit Table.3.

Click Save Table to save the Limit Table.4.

No Programming are available for this feature

 

Load Table

To recall the saved limit table, click Load Table from the Limit Test Setup dialog and a Recall

dialog box is open. At this time, CSV Files (with the extension *.csv) is selected as the file type.

1.

Specify the folder that contains the file and then select the file. Click Recall to recall the saved

limit table on the screen.

2.

Note: You can recall a limit table from a trace on any channel independently of the channel and trace

that were active when the limit table was saved to the file.

 

Save Table

To save the limit table, click Save Table from the Limit Test Setup dialog and a Save As dialog box is open.
At this time, CSV Files (with the extension *.csv) is selected as the file type.

1.

Specify any folder in which you want to save the file and enter the file name. Click Save to save the limit table
displayed on the screen to a file.

2.

The limit table is saved in the following format:

First line indicates the type of limit test of the instrument.

Second line indicates the revision of the limit test.

Third line indicates a header for the segment items that are output from the fourth line onward.

From the fourth line onward, the segment data are output.

525



Sample Limit table saved format:

"# E5080 Limit Test"

"# Revision: 1.00"

TYPE, BEGIN STIMULUS, END STIMULUS, BEGIN RESPONSE, END RESPONSE

MIN, 5.600000 GHz, 7.500000 GHz, -30.000000dB, -30.000000dB

MAX, 4.700000 GHz, 5.800000 GHz, -10.000000dB, -10.000000dB

MAX, 6.200000 GHz, 8.000000 GHz, -10.000000dB, -10.000000dB

OFF, 0.000000 Hz, 0.0000000 Hz, 0.00dB

Displaying Judgement Result of Limit Test

Judgment result of measurement points and trace

Measurement points that fail are displayed in red on the screen. The judgment result of the trace is

indicated by Pass or Fail displayed at the right bottom of screen by default and its position can be

edited.

Judgment Result of Channels

If a channel has a judgment result of fail, the result is displayed at Global Pass/Fail dialog box when the

Global Pass/Fail ON is checked (ON). It will be judged as failed if one or more unsatisfactory trace exists
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in any of the limit test within the channel.

How to turn ON/OFF Global Pass/Fail

Using Hardkey/SoftTab/Softkey

Press Math > Analysis.1.

Click Limits... and then select Limit tab on the dialog box.2.

Checked the box to turn ON the Global Pass/Fail.3.

Clear the box to turn OFF the Global Pass/Fail.4.

Testing with Sufficient Data Points

When System > System Setup > Preferences, Limit: Test the nearest measurement point is NOT

checked, limits are checked only at the actual measured data points. Therefore, It is possible for a

device to be out of specification without a limit test failure indication if the data point density is

insufficient.

The following image is a data trace of an actual filter using 11 data points (approximately one every

vertical graticule). The filter is being tested with a minimum limit line (any data point under the limit

line fails).

Although the data trace is clearly below the limit line on both sides of the filter skirts, there is a PASS

indication because there is no data point being measured at these frequencies.
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The following image shows the exact same conditions, except the number of data points is increased to

1601. The filter now fails the minimum limit test indicated by the red data trace.

 

When System > System Setup > Preferences, Limit: Test the nearest measurement point is checked,

the limit is compared with the nearest measurement point.
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Limit Test at certain  point

The limit test at a certain frequency point is available.  This function is the similar with one in the

E5071C. When (Begin Stimulus = End Stimulus) and (Begin Response = End Response) in the limit

test table, the point is defined as point limit test and v (for max) or ^ (for min) symbol is displayed.  

When you use the point limit test, confirm if System > System Setup > Preferences, Limit: Test the

nearest measurement point is checked. In this setting, even if the test point (= Begin Stimulus = End

Stimulus) is not located at measurement point, the result is determined using the nearest measurement

point.
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Use Ripple Limit Test

Overview

Concept of Ripple Limit Test

Create and Edit Ripple Limit Lines

Displaying Ripple Limit Test Results

Ripple Limit Test Setup

Saving/Recalling Ripple Limit Table

Other 'Analyze Data' topics

Overview

The ripple limit function can be executed independently of limit test function. Independently of the

limit test, you can evaluate the measurement results on a PASS/FAIL basis by setting a limit for the

ripple. This function is called the Ripple Limit Test.

In this picture, A is greater than B. Therefore, A is considered as the ripple of the specified stimulus

range.

The ripple limit function evaluates the measurement point values only. Interpolated values are not used.

Concept of Ripple Limit Test

The ripple limit test is a function for evaluating the results on a Pass/Fail basis based on the ripple
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limit, which is set using the ripple limit table. Ripple is defined as the difference between the largest

and smallest value within a specified stimulus range. You can specify up to 12 frequency bands, which

permits a test for each frequency band.

The ripple limit test judges the measurement as "Pass" when the ripple value specified with the ripple

limit is not exceeded by any of the measurement points on the trace; Otherwise, it judges the

measurement as "Fail." For the measurement points in a stimulus range without a specified ripple limit,

the test judges the measurement as "Pass."

Note: The measurement point alone is the target of evaluation for pass/fail. The interpolated part

between measurement points is not evaluated.

The ripple limit is defined with the start point stimulus value, end point stimulus value, ripple limit

value and type (on/off). For detailed information, see Ripple Limit Table.

While the ripple limit test function is turned on, the measurement points corresponding to a "FAIL"

judgment will be indicated in red on the screen and the trace's test results based on the results of each

measurement point will be displayed (judged as "Fail" if one or more red measurement point exist on

the trace). For information on how to display the results, see Ripple Limit Setup. You can also confirm the

channel test results on the screen (judged as "Fail" if one or more failed traces appear in the limit test,

ripple limit test or bandwidth limit test within the channel).

Create and Edit Ripple Limit Lines

You can create ripple limit lines for all measurement traces. The ripple limit lines are the same color as

the measurement trace.

Ripple limit lines are made up of discrete lines with three coordinates:

Begin Stimulus and End Stimulus - X-axis values.

Max Ripple - Y-axis values.

Ripple Limit Table

You must configure the ripple limit before you can use the ripple limit test function. You can specify a

ripple limit table for each trace, where up to 12 ripple limit bands (frequency bands) can be configured.
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How to turn ON/OFF Ripple Limit Table

Using Hardkey/SoftTab/Softkey

Press Math > Analysis.1.

Click Limit Table > Ripple to turn ON/OFF the Ripple Table.2.

Note: To ADD a frequency band to the ripple limit table, change the last ripple limit line to either ON

or OFF.

Note: No frequency band is provided in the ripple limit table by default.

In the Type area of the Ripple Limit Table, select ON or OFF for Ripple Limit Line 1.

ON - Band used for the ripple limit test.

OFF - Band not used for the ripple limit test.

1.

Click Begin Stimulus for Ripple Limit Segment 1. Enter the desired value.2.

Click End Stimulus for Ripple Limit Segment 1. Enter the desired value.3.

Click Max Ripple for Ripple Limit Segment 1. Enter the desired value.4.

Repeat Steps 1-4 for each desired ripple limit line.5.

How to turn ON/OFF the Ripple Limit Table

 

Note: Acceptable range for the stimulus value: -500G to +500G. If any out ranging value is specified, it

will be reset to fall within the range.

Note: Even if the VNA's sweep range is changed after the stimulus value has been set, the stimulus
value is not susceptible.

Example of ripple limit configuration

The individual frequency bands for the ripple limit test can overlap each other; in this case, the
ripple limit test is performed for each frequency band.

Even if the VNA's span value is set to zero, you must enter a parameter for both Begin Stimulus
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and End Stimulus.

If the data format is Smith chart or polar, the limit test is performed for the main response value

among the two marker response values.

Displaying Ripple Limit Test Results

Test result for trace

The test result for the trace will be indicated as Pass or Fail in the upper-left area of the graph. You can

also display the ripple value at the selected frequency band. If a trace is unsatisfactory, test results and

ripple lines are displayed by red color.

The result will be displayed as Ripln: Pass (or Fail) for each trace. n denotes the trace number. Bn will

be followed by the ripple value (if the ripple display is turned off, only Bn will be displayed without the

ripple value).

Global Pass/Fail

The Global Pass/Fail setting in the limit tab is applied to ripple limit test. It will be judged as failed if

one or more unsatisfactory trace exists in any of the ripple limit test within the channel).

Ripple Limit Test Setup
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How to set Ripple Limit Test Setup

Using Hardkey/SoftTab/Softkey

Press Channel or Trace to select the trace on which you want to apply the ripple limit test function.1.

Press Math > Analysis.2.

Click Limits... and then select Ripple tab on the dialog box.3.

(Ripple) Limit Test Setup Dialog Box Help

Ripple Test

Ripple Test ON - Check the box to set the ripple test ON or OFF and also display PASS or FAIL.

Ripple Line ON - Check the box to make the ripple limit line visible on the screen (Test still runs

even though the ripple line does not turns on).

 

Ripple Result

Type - Sets how the ripple values are displayed. Available settings are Off, Absolute value

(difference between maximum and minimum values within the band) display and Margin
(difference between absolute value of ripple and ripple limit) display.
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Segment - Enable to specify a ripple limit table up to 12 stimulus segment for each trace.

 

Ripple Table

Show Table - Check the box to show the table that allows you to create and edit limits.

Load Table - Recall the saved ripple limit table. Learn more.

Save Table - Save the ripple limit table. Learn more.

Saving/Recalling Ripple Limit Table

The ripple limit table can be saved in a file and recalled later for use on the screen. The file is saved in

the csv format (with the extension *.csv), and values are saved as a character string with the unit. The

csv formatted file can also be reused in spreadsheet software made for PCs.

How to set Ripple Limit Setup

Using Hardkey/SoftTab/Softkey

Press Math > Analysis.1.

Click Limits... and then select Ripple tab on the dialog box.2.

Click Load Table to recall the saved Ripple Limit Table.3.

Click Save Table to save the Ripple Limit Table.4.

No Programming are available for this feature

 

Load Table

To recall the saved ripple limit table, click Load Table from the Ripple Limit Test Setup dialog

and a Recall dialog box is open. At this time, CSV Files (with the extension *.csv) is selected as

the file type.

1.

Specify the folder that contains the file and then select the file. Click Recall to recall the saved

ripple limit table on the screen.

2.

Note: You can recall a ripple limit table from a trace on any channel independently of the channel and
trace that were active when the ripple limit table was saved to the file.
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Save Table

To save the ripple limit table, click Save Table from the Ripple Limit Test Setup dialog and a Save As dialog
box is open. At this time, CSV Files (with the extension *.csv) is selected as the file type.

1.

Specify any folder in which you want to save the file and enter the file name. Click Save to save the ripple
limit table displayed on the screen to a file.

2.

The ripple limit table is saved in the following format:

First line indicates the type of limit test of the instrument.

Second line indicates the revision of the limit test.

Third line indicates a header for the segment items that are output from the fourth line onward.

From the fourth line onward, the segment data are output.

Sample Ripple Limit table saved format:

"# E5080 Ripple Limit Test"

"# Revision: 1.00"

TYPE, BEGIN STIMULUS, END STIMULUS, MAX RIPPLE

ON, 933.0000000 MHz, 964.0000000 MHz, 1.5 dB

ON, 938.0000000 MHz, 953.0000000 MHz, 500 mdB

 

536



Use Bandwidth Limit Test

Overview

Displaying Bandwidth Limit Test Results

Bandwidth Limit Test Setup

Other 'Analyze Data' topics

Overview

The bandwidth limit test function can be used for testing bandwidth for the band-pass filters.

The bandwidth test find the peak of a signal in the passband and locates a point on each side of the

passband at an amplitude below the peak specified in test setup. The frequency between these two

points is the bandwidth of the filter. Then, the obtained bandwidth is compared to minimum and

maximum allowable bandwidth that you specify beforehand.

Displaying Bandwidth Limit Test Results

Test Result for Trace

The test result for the trace will be indicated as Pass, Wide or Narrow in the upper-left area of the graph

by following BWn. "n" denotes the trace number. You can also display the bandwidth value. If a trace

is unsatisfactory, test results and bandwidth markers are displayed by red color.
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Global Pass/Fail

The Global Pass/Fail setting in the limit tab is applied to bandwidth limit test. It will be judged as failed

if one or more unsatisfactory trace exists in any of the bandwidth test within the channel.

Bandwidth Limit Test Setup

You must set up the bandwidth threshold and the upper and lower limits before you can use the

bandwidth limit test function. You can specify the threshold, upper limit and lower limit for each trace.

How to set Bandwidth Limit Setup

Using Hardkey/SoftTab/Softkey

Press Channel or Trace to select the trace on which you want to apply the bandwidth limit test function.1.

Press Math > Analysis.2.

Click Limits... and then select Bandwidth tab on the dialog box.3.
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Bandwidth Test Setup Dialog Box Help

Bandwidth Test

Bandwidth Test ON - Check the box to set the bandwidth limit test ON or OFF.

Bandwidth Marker ON - Check the box to make the bandwidth marker visible on the screen (Test

still runs even though the bandwidth marker does not turns on).

Sound ON Fail - Check the box to turn ON when the bandwidth limit test is FAIL.

Target Bandwidth

N dB Points - Specify the bandwidth threshold in dB unit.

Min Bandwidth - Enter the lower limit for the bandwidth in Hz unit.

Max Bandwidth - Enter the upper limit for the bandwidth in Hz unit.

Note: If the data format is Smith chart or polar, the test is skipped.
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Save and Recall a File

You can save and recall files to and from an internal or external storage device in a variety of file

formats.

How to Save Instrument State

How to Save Measurement Data

How to Recall a File

About Instrument State and Calibration Data ( .csa, .cst, .sta, .cal)

About Measurement Data Files (.prn, .snp, .cti, .csv, .mdf)

Define Data Saves

Managing Files without a Mouse

Other Data Outputting topics

How to Save Instrument State and Calibration Files

Using Hardkey/SoftTab/Softkey

Press Save Recall > Save State or Save Other.1.
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Save State Softtab help

Learn all about VNA Instrument State files.

Save State - Immediately saves the VNA state, possibly calibration data and link to the selected

filename by depends on the Save Type. The selected filename is automatically generate in the

storage when you performed a save.

Auto Save - Saves state, calibration data and link to the storage. Saves state and calibration data to

the internal storage in the D: folder. A filename is generated automatically using the syntax "atxxx";

where xxx is a number that is increment by one when a new file is Auto Saved. The filename is

depends on the Save Type to save it in ".sta", ".csa" or ".cst".

Save State As... - Starts the Save As dialog box. (Not available on M948xA and E5080A.)

Save Register - Immediately saves the specified register (Register 1 to 8) to the selected filename

by depends on the Save Type. The selected filename is automatically generate in the storage when

you performed a save on selected register.

Save Type

State - Save VNA state in .sta filename.

State + Cal Data - Save VNA state and calibration data in .csa filename.

State + Cal Link - Save VNA state and calibration link in .cst filename.

 

Save Other Softtab help

Save Calset... & Save Screen... - Starts the Save As dialog box.

Save Data... - Starts the Save Data As dialog box.

Save User Preset... - Start the User Preset dialog box.
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Save As dialog box help

Save Allows you to navigate to the directory where you want to save the file.

File name  Displays the filename that you either typed in or clicked on in the directory contents

box.

Note: Filenames (not including the path name) MUST be limited to 64 characters.

Save as type

The following file types save Instrument states and Calibration data.   You can save, and later

recall, instrument settings and calibration data for all channels currently in use on the analyzer.

These file types are only recognized by Keysight VNA analyzers.

Learn more about these file types.

*.csa - save Instrument state and actual Cal Set data (cal/state archive) Default selection.

*.cst - save Instrument state and a link to the Cal Set data.

*.sta - save Instrument state ONLY (no calibration data)

*.cal - save actual Calibration data ONLY (no Instrument state)

Note: To save the screen as .bmp, .jpg, or .png graphics file types, click File / Print to File.  Learn
more.

Save  Saves the file to the specified file name and directory.

 

Save VNA Measurement Data

How to Save Measurement Data

Using Hardkey/SoftTab/Softkey

Press Save Recall > Save Other > Save Data....1.

Save Data As  Saves the current trace(s) to the specified type of file.

Note: This dialog now contains the settings previously selected from the old Define Data Save
dialog.
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Save Data As dialog box help

Note: Before saving measurement data, always trigger a single measurement, and then allow the

channel to go into Hold.  This ensures that the entire measurement trace is saved.

Note: Memory traces can NOT be saved to any file type (PRN, SNP, CTI, CSV, MDF).

Save in Allows you to navigate to the directory where you want to save the file.

File name  Displays the filename that you either typed in or clicked on in the directory contents

box.

Note: Filenames (not including the path name) MUST be limited to 64 characters.

Save as type  Choose from: (click each to learn more about each file type):  *.prn, *.SNP, *.SNPX.

*.cti (citifile), *.csv, *.mdf.

To save the screen as .bmp, .jpg, or .png graphics file types, click File / Print / Print to File.  Learn
more.

Save Uncertainty (Opt S93015A) data (*.u*p, *.dsd, *.sdatcv). Learn more.

Data Scope

Determines what traces are saved to a file. Available ONLY with *.cti, *.csv, and *.mdf.

Auto

When correction is OFF, saves the specified trace.

When correction is ON, saves all corrected parameters associated with the calibrated

ports in the Cal Set.

Single Trace - Saves the active trace.

Displayed Traces - Saves all displayed traces for all channels.

Channel Traces - Saves all displayed traces for active channels.

Format

Determines the format of the data. Available with (CTI Formatted, CSV, SNP, MDIF)

Auto - Data is saved in LogMag or LinMag if one of these is the currently selected display

format. If format is other than these, then data is saved in Real/Imag.
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LogMag/Angle (dB/deg), LinMag/Angle (unit/deg), Real/Imaginary - Select output

format.

The imaginary portion for all LogMag and LinMag data is saved in degrees (dB/deg).

Real/Imaginary data is never smoothed.

Displayed Format (CSV and MDIF only) - Data is saved in the format of the displayed

trace.

Note: .prn files can only save the active trace in the displayed format.

Save  Saves the file to the specified file name and directory.

Cancel - Closes the dialog.

Help - Displays Save Data As dialog box help.

 

Recall a file

How to Recall (open) a file

Using Hardkey/SoftTab/Softkey Using a mouse

Press Save Recall > Recall.1.
Click on File1.
Select Recall Data...2.

Save Recall > Recall Softtab Help

Recall State - Recall the specified filename.

Recall State - Select from a list of files shown on softkeys. The list can be sorted by 'most recently
used' or alphabetically depending on a preference. The preference setting appears at the bottom of

the second page of softkeys listing files to be recalled or on the Preference dialog.

Recall State... - Starts the Recall dialog box.

Recall Register - Recall the register (Register 1 to 8) which is saved in the D:\ drive (Only the saved

register will enable to recall).

Recall Calset... - Starts the Recall dialog box.

Recall Data... - Starts the Recall dialog box.

Recall Order - A list of files for recall can arrange according to NAME or RECENT files.
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Recall dialog box help

Look in  Allows you to select the directory that contains the file that you want to recall.

Filename  Displays the filename that you either typed in or clicked on in the directory contents box.

Files of type  Allows you view and select files that are listed in categories of a file type. The

following types of files can be recalled into the analyzer: All State files, Citi files, SNP files.

Recalling instrument state files

When an Instrument State file is recalled, the current state of the instrument is overwritten with the

recalled state. A *.cal file does not contain an instrument state, but only calibration data. Learn more
about Instrument States.

See also Power ON and OFF during Save / Recall, User Preset, and Preset.

Recalling Data files

Citi files and SNP files can be recalled and viewed in the analyzer.

Click File then Recall.  1.

Select Citifile Data or Snp.2.

Select the file to recall3.

Click Recall.4.

Note: Citi files that were saved in CW Time sweep can NOT be recalled into the VNA.

Note: Filenames (not including the path name) that are longer than 64 characters will NOT be

recalled.

Recalled data is ALWAYS displayed using LogMag format, regardless of how the file was stored.

The channel is placed in Trigger Hold. If triggering is resumed, the data will be overwritten.

SNP files are recalled as traces into a single window and channel, beginning at the highest available
channel number allowed on the analyzer.  For multi-port SNP files (greater than 4 ports), if the number
of S parameters in the file is beyond the maximum number of traces in a window, then new windows

will be created.

Citi files are recalled into the same window and channel configuration as when they were saved.

However, the new recalled channel numbers begin with the highest channel number allowed on the
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analyzer and decrement for each additional channel.

For example, when a citi file is saved, two traces are in window 1, channel 1 and two additional

traces are in window 2, channel 2. When recalled into a factory preset condition (1 trace in window

1, channel 1), the first two recalled traces appear in window 2, highest channel number, and the

second two traces appear in window 3, (highest channel number -1). See also Traces, Channels, and
Windows.

Recall  Recalls the file displayed in the file name box.

Instrument State / Calibration Files

You can save, and later recall, instrument settings and calibration data for all channels currently in use

on the analyzer.

An Instrument State contains almost every analyzer setting. The following settings are NOT saved

and recalled with Instrument State:

GPIB address

RF power ON/OFF (depends on current setting)

The following file types are used to save and recall instrument states and Cal Set information:

File Types Information that is stored for each channel

.csa

.cst

 

.sta

  Instrument State Information
    Channels/Traces Averaging
    Windows Markers
    Triggering Math/memory
    Format Limits
    Scale More...

 
  Stimulus Information:

 
  Frequency range Alternate sweep

 
  Number of points Port powers

 
  IF bandwidth Source attenuators

 
  Sweep type Receiver attenuators

 
  Sweep mode Test Set port map

   

Cal Set Information

    GUID (Globally Unique Identifier)

provides link to Cal Set
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.cal

      Name, Description, Modify date

      Stimulus Information:

      Frequency range Alternate sweep

      Number of points Port powers

      IF bandwidth Source attenuators

      Sweep type Receiver attenuators

      Sweep mode Test Set port map

      Error Terms: Directivity, Crosstalk, Source match, Load match,

Reflection tracking, Transmission tracking

File Type Descriptions and Recall

The following describes each file type, and what occurs when the file type is recalled.

*.sta files

Contain ONLY instrument state information - NOT Cal data.

When recalled, they always replace the current instrument state immediately.

*.cst files

Contain BOTH instrument state and a LINK to the Cal Sets. Learn more about Cal Sets.

The quickest and most flexible method of saving and recalling a calibrated instrument state.

Channels need not have cal data to save as .cst file.

When recalled, the state information is loaded first. Then the analyzer attempts to apply a Cal Set as you
would do manually. If the stimulus settings are different between the instrument state and the linked Cal Set,
the usual choice is presented (see Cal Sets). If the linked Cal Set has been deleted, a message is displayed,
but the state information remains in place.

Because only a link to the Cal Set is saved, the Cal Set can be shared with other measurements.

Note: Before saving a .cst file, be sure that a User Cal Set (NOT a Cal Register) is being used for the

calibration. Cal Registers are overwritten with new data whenever a calibration is performed, and may

not be accurate cal data when the .cst file is recalled. Learn more about Cal Sets.

*.cal files

Contain ONLY Cal Set information.

When recalled, the Cal Set is NOT automatically applied. Apply the calibration data to a channel as you
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would apply any Cal Set.

*.csa files

Contain ALL instrument state and the actual Cal Set; not a link to the Cal Set.

The safest method of saving and recalling a calibrated instrument state. However, the file size is larger than
a *cst file, and the save and recall times are longer. In addition, because the actual Cal Set is saved, it is
very difficult to share the cal data with other measurements.

Channels need not be calibrated to save as .cst file.

The Cal Set that is saved could be a Cal Register or a User Cal Set.

Note: *.pcs files are the internal file format used for storing cal sets. These files should never be

accessed or copied by the user.

Measurement Data Files

Measurement data is saved as ASCII file types for use in a spreadsheet or CAE programs.

Note: Before saving measurement data, always trigger a single measurement, and then allow the channel

to go into Hold.  This ensures that the entire measurement trace is saved.

Note: Memory traces can NOT be saved to any file type (PRN, SNP, CTI, CSV, MDF).

The following file types can be saved by the analyzer:

*.prn files

*.SNP (Touchstone)

*.cti (Citifile)

*.csv

*.mdf (MDIF)

*.prn Files

Prn files have the following attributes:

Comma-separated data which can be read into rows and columns by spreadsheet software, such as
Microsoft Excel. To avoid the "delimiting" dialog boxes, change the filename extension from .prn to .csv.
Then open directly into Microsoft Excel.
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Contain formatted and corrected stimulus and response data for the current active trace ONLY.

Are Output only - they cannot be read by the analyzer.

Cal Set Viewer data can be saved to *.prn files

How to Save PRN Trace Data (*.prn)

Using Hardkey/SoftTab/Softkey

Press Save Recall > Save Other > Save Data....1.

Under Save as type, select PRN Trace Data (*.prn).2.

 

Example:

"S11 Log Mag"  

"Frequency (Hz)", "dB"

3.000000e+005    , -3.528682e+001  ,

4.529850e+007    , -2.817913e+001  ,

9.029700e+007    , -3.216808e+001  ,

1.352955e+008    , -3.101017e+001  ,

.SNP Format (*.s1p, *.s2p, *.s3p. *.s4p, and so forth)

*.SNP file format, also known as Touchstone format, is specified by IBIS. See the Touchstone specification.

*.SNP file format is used by CAE programs such as Keysight's Microwave Design System (MDS) and
Advanced Design System (ADS).

*.SNP data is saved using the File, Save Data As dialog.

Before saving measurement data, always trigger a single measurement, and then allow the channel to go

into Hold.  This ensures that the entire measurement trace is saved.

*.SNP files and other analyzer settings

.SNP data can be recalled and viewed on the analyzer, or read by the embed/de-embed functions.
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When Fixturing is enabled, all of the enabled data transforms (De-embedding, Port Z Conversion, and so
forth) are applied to saved SNP files.

When Smoothing is applied to a trace, the smoothing is NOT saved when the format is Real, Imaginary (RI).
Select a different format to save the smoothed data.

Balanced parameters can be saved to *.SNP files. See the "Choose Ports " dialog.

IMPORTANT - ALL valid data is saved using the same format and settings (trace math, offset, delay, and so
forth) as the active measurement. This can cause the data that is saved for the non-active measurements to
be dramatically different from the data that is displayed. For example, when saving an S2P file, if the active
S11 measurement is set to Data/Mem (data divided by memory), then ALL 4 S-parameters are saved using
Data/Mem. The memory trace that is used in the Data/Mem operation is the same as that used in the active
(S11) measurement.

What is Saved

*.SNP data is generally used to gather all S-parameters for a fully corrected measurement.

The analyzer saves the data that is available on the channel of the active measurement.

File Type # of Ports # of S-parameters

saved

*.s1p 1 1 S-parameter

*.s2p 2 4 S-parameters

*.s3p 3 9 S-parameters

*.s4p 4 16 S-parameters

... ... ...

*.SNP N N^2 S-parameters

If correction for a Full N-port cal is applied, then valid data is returned for all corrected s-parameters.
Response cals will save uncorrected data.

If requesting less data than is available, the Choose ports for SNP data dialog appears.

If correction is NOT applied, the analyzer returns as much applicable raw data as possible using S-parameter
measurements on the selected channel. Data that is not available is zero-filled. For example, if correction is
NOT applied and the active measurement is S11, and an S21 measurement also exists on the channel, then
data is returned for the S11 and S21 measurements. Data for S12 and S22 is not available and therefore
returned as zeros in Real/Imaginary format. In Log Mag/Phase format, this appears as -200 dB and 45
degrees.
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How to Save .SNP Format (*.s1p, *.s2p, *.s3p. *.s4p)

Using Hardkey/SoftTab/Softkey

Press Save Recall > Save Other > Save Data....1.

Under Save as type, select Trace (*.s1p, *.s2p, *.s3p or *.s4p).2.

.SNP Data Output

.SNP files contain header information, stimulus data, a response data pair for EACH S-parameter

measurement. The only difference between .s1p, s2p, and so forth, is the number of S-parameters that

are saved.

The following is a sample of Header information:

!Keysight Technologies,E8362B,US42340026,Q.03.54
!Keysight E8362B: Q.03.54
!Date: Friday, April 25, 2003 13:46:41
!Correction: S11(Full 2 Port SOLT,1,2) S21(Full 2 Port SOLT,1,2) S12(Full 2 Port
SOLT,1,2) S22(Full 2 Port SOLT,1,2)
!S2P File: Measurements:S11,S21,S12,S22:  
# Hz  S RI R 50

Note: Although the following shows Real / Imag pairs, the format could also be LogMag / Phase or

LinMag / Phase

*.s1p Files

Each record contains 1 stimulus value and 1 S-parameter (total of 3 values)

Stim  Real (Sxx)  Imag(Sxx)

 

Example:

*.s2p Files
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Each record contains 1 stimulus value and 4 S-parameters (total of 9 values)

Stim  Real (S11)  Imag(S11)  Real(S21)  Imag(S21)  Real(S12)  Imag(S12)  Real(S22)  Imag(S22)

 

Example:

*.s3p Files

Each record contains 1 stimulus value and 9 S-parameters (total of 19 values)

Stim   Real (S11)  Imag(S11)  Real(S12)  Imag(S12)  Real(S13)  Imag(S13)
          Real (S21)  Imag(S21)  Real(S22)  Imag(S22)  Real(S23)  Imag(S23)

          Real (S31)  Imag(S31)  Real(S32)  Imag(S32)  Real(S33)  Imag(S33)

 

Example:

*.s4p Files (and so forth...)

Each record contains 1 stimulus value and 16 S-parameters (total of 33 values)

Stim   Real (S11)  Imag(S11)  Real(S12)  Imag(S12)  Real(S13)  Imag(S13)  Real(S14)  Imag(S14)

          Real (S21)  Imag(S21)  Real(S22)  Imag(S22)  Real(S23)  Imag(S23)  Real(S24)  Imag(S24)

          Real (S31)  Imag(S31)  Real(S32)  Imag(S32)  Real(S33)  Imag(S33)  Real(S34)  Imag(S34)

          Real (S41)  Imag(S41)  Real(S42)  Imag(S42)  Real(S43)  Imag(S43)  Real(S44)  Imag(S44)

 

Example:
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.S2PX Data Output

*.S2PX files are used for Segmented Mixer Data. Learn more.

The following ADDITIONAL columns precede parameter data:

SegIndex,InputFreq,OutputFreq,LO1Freq,InputPower,LO1Power, <parameter data>

 

Choose ports for SNP File dialog box help

This dialog appears when any of the following conditions exist while attempting to save data to an

*snp file:
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you request less data than is available

you want data for more than 4 ports

a balanced measurement is active

Number of ports  Select the number of ports for which data will be saved.

The following buttons appear ONLY when a Balanced measurement is displayed.

Normal  Click to save normal (single-ended) port data.

Mixed Mode  Click to save balanced (logical) port data. Choices are based on the topology
selection for current active parameter:

SE-Bal:  Choose from S1, D2, C2 (Single-ended port 1, Differential port 2, Common port 2)

SE, SE, Bal: Choose from S1, S2, D3, C3 (Single-ended port 1, Single-ended port 2, Differential port
3, Common port 3)

Bal-Bal: Choose from D1, C1, D2, C2 (Differential port 1, Common port 1, Differential port 2,
Common port 2)

For example, with SE-Bal topology, choose 2 ports, S1 for first, and D2 for second. The

following 4 parameters are saved: Sss11, Ssd12, Sds21, Sdd22.  

Arrow buttons  Click to Add or Remove ports from or to the following columns:

Available Ports  All test set ports are listed. There may NOT be valid data available for all of

these ports. Learn more.

Chosen Ports  When OK is clicked, SNP data is saved for these ports.

OK  Becomes available when the number of Chosen ports = the Number of ports to save. Click to

save to SNP file.

With Number of ports = 2, .s2p data is saved; with Number of ports = 3, .s3p data is saved, and

so forth. Learn more about SNP files

.cti CitiFiles

Citifile format is compatible with the Keysight 8510 Network Analyzer and Keysight's Microwave

Design System (MDS).

You can do the following using citifiles :

554



save the active trace, or all traces.

save formatted or unformatted citifile data

How to Save Citifile Formatted Data (*.cti)

Using Hardkey/SoftTab/Softkey

Press Save Recall > Save Other > Save Data....1.

Under Save as type, select Citifile Formatted Data (*cti).2.

*.csv files contain:

Header information

Stimulus data

Data pairs for EACH S-parameter measurement

The above image is a Citifile opened in Notepad.

There are two traces in separate channels - one is an

FCA trace. Each trace has 3 data points. The save

settings = Displayed Traces Content, and Auto

Format.

Format is identified by DBANGLE (log mag),

MAGANGLE (Lin Mag), or RI (real, imaginary -
NOT shown)  

On the data access map, Formatted data is taken from

location 2 or 4.
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How to Save Citifile Unformatted Data (*.cti)

Using Hardkey/SoftTab/Softkey

Press Save Recall > Save Other > Save Data....1.

Under Save as type, select Citifile Data Data (Real,imag) (*cti).2.

On the data access map, Unformatted data is taken from the block just before Format.

Citifiles can be recalled and viewed in the analyzer. Learn more.

*.csv Files

CSV files are read by spreadsheet programs such as Microsoft Excel.

 

How to Save CSV Formatted Data (*.csv)

Using Hardkey/SoftTab/Softkey

Press Save Recall > Save Other > Save Data....1.

Under Save as type, select CSV Formatted Data (.csv).2.

*.csv files contain: header information and the following Comma-Separated Values.

Stimulus data

Data pairs for EACH S-parameter
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*.mdf Files

MDIF files are compatible with Keysight ADS (Advanced Design System). Learn more at the Keysight
website.

 

How to Save MDIF Data (*.mdif)

Using Hardkey/SoftTab/Softkey

Press Save Recall > Save Other > Save Data....1.

Under Save as type, select MDIF Data (*.mdif).2.

*.mdf files contain: header information and space-separated data:

Stimulus data

Real and Imaginary data pair for EACH S-parameter measurement

Define Data Saves

Note: Although these settings are still supported, they are no longer necessary to save data files. The

Save Data As dialog box contains these settings.

How to select Define Data Saves

Using Hardkey/SoftTab/Softkey

Press System > System Setup > Preferences....1.

Click the Data Saves... button on the Preferences dialog box.2.
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Define Data Saves dialog box help

Note: Although these settings are still supported, they are no longer necessary to save data files.

The Save Data As dialog box contains these settings.

The following settings survive an Instrument Preset and Shutdown.

CitiFile, CSV, and MDIF Contents

Determines what is saved to a .cti file.

Auto - Saves the active trace. Additional traces are saved if correction is ON. For Full 2-port

calibration, 4 traces are saved; for Full 3-port calibration, 9 traces are saved, and so forth.

Single Trace - Saves the active trace.

Displayed Traces - Saves all displayed traces for all channels.

Citifile and CSV Format

Auto - Data is saved in LogMag or LinMag if one of these is the currently selected display

format. If format is other than these, then data is saved in Real/Imag.

LogMag, LinMag, Real/Imag - Select output format.

The imaginary portion for all LogMag and LinMag data is saved in degrees.

Real/ Imag data is never smoothed.

SnP Format (.s1p, .s2p, .s3p)

Learn more about SnP files.

Auto - Data is saved in LogMag or LinMag if one of these is the currently selected format. If

format is other than these, then data is saved in Real/Imag.

LogMag, LinMag, Real/Imag - Select output format.  The imaginary portion for all LogMag and
LinMag data is output is in degrees.

 

Manage Files without a Mouse
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How to Manage Files without a Mouse

Using Hardkey/SoftTab/Softkey

Press Save Recall > Save Other.1.

Click Manage Files... and then D:\ drive folder dialog box appears.2.

OR

Press System > Main.1.

Click Manage Files... and then D:\ drive folder dialog box appears.2.

Manage Files dialog box help

The Manage Files dialog box is designed to be used from the front panel. It performs the same

function as Windows Explorer, but can be used without the use of a mouse or keyboard.
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Print a Displayed Measurement

The analyzer allows you to print a displayed measurement to a printer or to a file. The printer can be

either networked or local.

Connecting a Printer

Printing

Other Outputting Data topics

Connecting a Printer

You can connect a printer to one of the VNA USB ports or to the LAN connector.

To Add a Printer

Note: If you try to print from the VNA application and the Add Printer Wizard appears, click Cancel

and add the printer using the following procedure.

From the VNA application, press System > Main > Minimize Application.1.

On the Windows taskbar, click Devices and Printers.2.

Double-click Add Printer.3.

Follow the instructions in the Add Printer Wizard.4.

For more information, refer to Microsoft Windows Help or your printer documentation.

Printing

Print a Hardcopy

Page Setup

Print to File

The measurement information on the screen can be printed to any local or networked printer that is

connected to the VNA. The graphic below shows an example of how a screen-capture image appears

when printed. The Page Setup settings allows you to customize the printed form of the measurement
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information.

 

How to Print a Hardcopy

Using Hardkey/SoftTab/Softkey

Press System > Print.1.

Click Print....2.

No programming commands are available for this feature.
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Note: For information on the choices in the Print dialog box, see Windows Help.

Page Setup

The Page Setup dialog allows flexibility in the appearance that measurement data is printed. After setting up the page, click
File, then Print... to obtain a hard-copy.

How to select Page Setup

Using Hardkey/SoftTab/Softkey

Press System > Print > Page Setup....1.

OR

Press System > System Setup > Preferences.....1.

Click the Page Setup... button on Preferences dialog box.2.

Page Setup dialog box help
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Paper, Orientation, and Margins

These settings do NOT survive a VNA shutdown.

See Windows Help for information on these settings.

Windows

The following VNA-specific settings DO survive a VNA shutdown:

Minimum vertical size  Adjust to change the amount of a page that the measurement window

fills. The adjustment range is from 40 to 100%.

One window per page  Check to print one window per page. Clear to print all selected windows

without a forced page break.

Only active window  Check to print only the active window. Clear to print all windows.

Instrument logo  Check to print the Keysight logo to the header.

Data and Time  Check to add the current date and time to the header.

Global Pass/Fail  Check to add the Global Pass/Fail status to the header.

Page Numbers  Check to add page numbers (1 of n) to the header.

Channel Settings Table

Print  Check to print the channel settings table.
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Segment data can no longer be printed.

Trace Attributes Table

Print  Check to print the Trace Attributes Table. The Trace Attributes are measurement type,

correction factors ON or OFF, smoothing, options, and marker details. The Trace Attributes are

listed by Trace ID#  for each window.

Each Trace ID# can have multiple entries depending on the number of markers associated with the trace. The marker

details are marker number, position and response. If there are multiple markers on a trace, the trace

attributes are only shown for the first marker. However, the trace attributes for the first marker

apply to all other markers on that trace.

The options column can have one or more options. D for Delay, M for Marker, G for Gating.
Multiple options selected would appear as follows: DMG.

Print marker data  Check to print all marker data. The amount of data depends on how many

markers are created.

Print to a File

The analyzer can save a screen-capture image in any of the following formats:

.png (preferred format)

.bmp (bitmap)

.jpg

The analyzer automatically saves the file to the current path. If not previously defined, the analyzer

automatically selects the default path D:\.

A .bmp file, like a .prn file, can be imported into software applications such as Microsoft Excel, Word,

or Paint to display a screen-capture image.

See Save and Recall files for more information.

How to Print to a File

Using Hardkey/SoftTab/Softkey

Press System > Print > Print to File....1.
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Programming Guide

Finding Programming Commands

Three ways to find programming commands:

1.   From simulated User Interface: Hardkeys , SoftTabs , and Softkeys .

Click on Command Finder to display the screen below. Clicking on one of the Hardkeys shown in

the online help screen opens the corresponding SoftTab and Softkey menus and corresponding

SCPI/COM commands.
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2.  From a simulated User Interface of the drop-down menus:

File  |  Instrument  |  Response  |  Stimulus  |  Utility  |  Cal  |  Apps  |  Remote ONLY

 

 

  GPIB / SCPI

3. Command Tree

See
Also

Example Programs

Learning about GPIB

See Also

Important  Programming the PXI VNA

New PXI Programming Commands

Remotely Specifying a Source Port

Your Programs on Windows 7

Using Macros

Data Access Map

567



SCPI Command Tree

See Also

Example Programs

Find commands using a simulated VNA UI

See list of all SCPI Errors.

See Calibrating the VNA Using SCPI

Synchronizing the Analyzer and Controller

IEEE- 488.2 Common Commands

Local Lockout

ABORt Stops all sweeps

+ CALCulate    Click to hide and show CALC branches
CORRection Electrical Delay and Phase Offset

CUSTom Custom measurements

DATA Sends and queries data

DTOPology Defines topology for a balanced measurement

EQUation Equation Editor

FILTer Time domain gating

FORMat Display format

FSIMulator Balanced measurements and Fixturing

FUNCtion Trace Statistics

GCData Read Gain compression data

GCMeas Gain Compression Analysis

GDELay Group Delay Aperture setting

HOLD Trace Hold

LIMit Limit lines for pass / fail testing

MARKer Marker settings

MATH Math / Memory

MEASure Measurement settings specific to a measurement number

    BLIMit Bandwidth threshold settings

    CONVersion Parameter conversion function

    CORRection Electrical delay settings

    DATA Sends and queries data
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    DEFine Creates a measurement

    DELete Deletes specified measurement

    EQUation Equation settings on selected measurement

    FILTer Gate filter settings

    FORMat Sets measurement format

    FUNCtion Trace Statistics

    GCData Read Gain compression data

    GCMeas Gain Compression Analysis

    GDELay Group Delay Aperture settings

    HOLD Trace Hold settings

    LIMit Limit line settings

    MARKer Marker settings

    MATH Math / Memory

    MIXer X-axis display for FCA measurements

    OFFSet Mag and Phase offset

    PARameter Balanced measurement parameter settings

    RDATa? Queries receiver data

    RLIMit Ripple limit settings

    SA Spectrum Analyzer markers

    SMOothing Smoothing settings

    TRANsform Time domain transform settings

    UNCertainty Uncertainty trace properties

    X X-Axis settings

MIXer X-axis display for FCA measurements

NORMalize Receiver power cal (Obsolete)

OFFSet Mag and Phase offset

PARameter Create and delete measurements

RDATa? Queries receiver data

SMOothing Point-to-point smoothing

TRANsform Time domain transform

UNCertainty Uncertainty Trace Properties

X:AXIS X-Axis Domain
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CALPod Controls CalPod units

CONTrol Interface control, ECal module state control, and Rear-panel connector control.

CONTrol:MULTiplexer Control the E5092A Configurable Multiport Test Set.

CSET Work with a Cal Set without having to select it into that channel.

DISPlay Display settings

FORMat Format for data transfer

HCOPy Hardcopy printing

INITiate Continuous or manual triggering

LXI LXI communications

MMEMory Saves and recalls instrument states

OUTPut Turns RF power ON and OFF

+ SENSe     Click to hide and show SENSe  branches

AMPLifier Control the M9379A

AVErage Sweep Averaging

BANDwidth IF Bandwidth

CLASs Returns measurement class name

CORRection Calibration and other correction settings

    | CKIT Manage Cal Kits and ECal modules

    | COLL:CKIT Edit Cal Kit definitions

    | COLL:GUIDed Perform Guided Cals

        | PSENsor Configure Guided Power Cal

        | SMC Perform SMC Cal

        | VMC Perform VMC Cal

    | CSET Manage Cal Sets

    | EXTension Port Extensions

COUPle Chopped or Alternate sweep

DUTControl Control M9341B

FOM Frequency Offset (opt 080)

FREQuency Frequency sweep settings

GCSetup Gain Compression App (opt 086)  

MIXer FCA measurements (opts S93082A and S93083A)

MULTiplexer Controls external test sets

NOISe Noise Figure (opt 028 / 029)

POWer Receiver attenuation and overpower protection

PULSe Configure internal pulse generators
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ROLE Assign sources to roles

ROSCillator Returns the source of the reference oscillator

SEGMent Segment sweep settings

SWEep Sweep types

SWITch Control the M9191D switch module

TEMPerature Returns the temperature on the receiver board

X:VALues Returns X-axis values for channel
 

SOURce Source power to the DUT

    DC DC Source control

    PHASe Phase control (Opt S93088A)

    POWer:CORR Source power calibration

        ALC:MODE:REC Receiver Leveling

STATus Reads the VNA status registers

SYSTem Misc VNA capabilities

    | CAL:All Calibrate All Channels

    | CAL:Phase Perform an SMC Phase Reference Cal

    | CAPability Reads various capabilities of the analyzer

    | CAP:HARD:MODule PXI module capabilities

    | COMMunicate Controls and queries VNA settings

    | CONF:EDEV Configure external devices

    | DATA:MEMory Shared memory commands

    | PREFerences VNA Preferences

    | SERV:PVER Instrument Cal dates

    | UNCertainty Dynamic Uncertainty

TRIGger Trigger measurements
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IEEE 488.2 Common Commands

*CLS - Clear Status

*ESE - Event Status Enable

*ESE? - Event Status Enable Query

*ESR? - Event Status Enable Register

*IDN? - Identify

*OPC - Operation complete command

*OPC? - Operation complete query

*OPT? - Identify Options Query

*RST - Reset

*SRE - Service Request Enable

*SRE? - Service Request Enable Query

*STB? - Status Byte Query

*TST? - Result of Self-test Query

*WAI - Wait

See Also

Example Programs

Synchronizing the Analyzer and Controller

SCPI Command Tree

*CLS - Clear Status

Clears the instrument status byte by emptying the error queue and clearing all event registers. Also

cancels any preceding *OPC command or query. See Status Commands and Reading the Analyzer's Status
Registers.

*ESE - Event Status Enable

Sets bits in the standard event status enable register. See Status Commands and Reading the Analyzer's
Status Registers.

*ESE? - Event Status Enable Query

Returns the results of the standard event enable register. The register is cleared after reading it. See

Status Commands and Reading the Analyzer's Status Registers.
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*ESR - Event Status Enable Register

Reads and clears event status enable register. See Status Commands and Reading the Analyzer's Status
Registers.

*IDN? - Identify

Returns a string that uniquely identifies the analyzer. The string is of the form "Keysight

Technologies",<model number>,<serial "number>,<software revision>" .

Note: Beginning with Rev 6.01, this command now returns the software revision with 6 digits instead

of 4. For example, A.06.01.02.

*OPC - Operation complete command

Generates the OPC message in the standard event status register when all pending overlapped

operations have been completed (for example, a sweep, or a Default). See Understanding Command
Synchronization.

*OPC? - Operation complete query

Returns an ASCII "+1" when all pending overlapped operations have been completed. See
Understanding Command Synchronization

*OPT? - Identify Options Query

Returns a comma-separated string identifying the analyzer option configuration. See a list of VNA options.

Refer also to the option number differences between the common option numbers and those returned

using this command.

*RST - Reset

Executes a device reset and cancels any pending *OPC command or query, exactly the same as a

SYSTem:PRESet with one exception: Syst:Preset does NOT reset Calc:FORMAT to ASCII. The contents

of the analyzer's non-volatile memory are not affected by this command.

*SRE - Service Request Enable

Before reading a status register, bits must be enabled. This command enables bits in the service request

register. The current setting is saved in non-volatile memory. See Status Commands and Reading the
Analyzer's Status Registers.

*SRE? - Service Request Enable Query

Reads the current state of the service request enable register. The register is cleared after reading it. The
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return value can be decoded using the table in Status Commands. See also Reading the Analyzer's Status
Registers.

*STB? - Status Byte Query

Reads the value of the instrument status byte. The register is cleared only when the registers feeding it

are cleared. See Status Commands and Reading the Analyzer's Status Registers.

*TST? - Result of Self-test Query

Returns the result of a query of the analyzer hardward status. An 0 indicates no failures found. Any

other value indicates one or more of the following conditions exist. The value returned is the Weight

(or sum of the Weights) of the existing conditions.  For example:

If 4 is returned from *TST?, an Overpower condition exists.
If 6 is returned, both Unleveled and Overpower conditions exists.

Bit Weight Description Bit is set to 1 when the following conditions exist:

0 1 Phase Unlock The source has lost phaselock. This could be caused by a

reference channel open or a hardware failure.

1 2 Unleveled The source power is unleveled. This could be a source is set

for more power than it can deliver at the tuned frequency. Or

it could be caused by a hardware failure.

2 4 Not used

3 8 EE Write Failed An attempted write to the EEPROM has failed. This is

possibly caused by a hardware failure.

4 16 YIG Cal Failed The analyzer was unable to calibrate the YIG. Either the

phaselock has been lost or there has been a hardware failure.

5 32 Ramp Cal Failed The analyzer was unable to calibrate the analog ramp

generator due to a possible hardware failure.

6 64 Not used

*WAI - Wait

Prohibits the instrument from executing any new commands until all pending overlapped commands

have been completed. See Understanding Command Synchronization

 

574



About Triggering

Abort Command

ABORt

Applicable Models: All

(Write-only) Stops all sweeps - then resume per current trigger settings. This command is the same as

INITtiate:IMMediate (restart) except if a channel is performing a single sweep, ABORt will stop the

sweep, but not initiate another sweep.

Learn about Synchronizing the Analyzer and Controller

Examples ABOR
abort

Query Syntax Not applicable

Default Not applicable
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Calculate:Correction Commands

Controls error correction functions.

These commands are Superseded by the CALCulate:MEASure:CORRection commands.

 
CALCulate:CORRection

EDELay

     | DISTance

     | TIME

     | MEDium

     | UNIT

     | WGCutoff

ERRor

     | [:STATe]

     | TYPE

[STATe]

     | INDicator?

TYPE

OFFSet

     | [MAGNitude]

     | PHASe

Click on a keyword to view the command details.

Blue keywords are superseded.

See Also

Example Programs

Calibrating with SCPI

Synchronizing the Analyzer and Controller
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SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

CALCulate<cnum>:CORRection:EDELay:DISTance <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the electrical delay in physical length (distance) for the selected measurement.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Electrical delay in distance.

First Specify units using CALC:CORR:EDEL:UNIT

Use SENS:CORR:RVEL:COAX <num> to set Velocity factor.

This parameter supports MIN and MAX as arguments. Learn more.

Examples CALC1:CORR:EDEL:DIST 5

calculate2:correction:distance .003

Query Syntax CALCulate:CORRection:EDELay:DISTance?

Return Type Numeric

Default 0

CALCulate<cnum>:CORRection:EDELay:MEDium <char>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the media used when calculating the electrical delay.  

Parameters  

<cnum> Any existing channel number.  If unspecified, value is set to 1.

<num> Choose from:  COAX for coaxial medium, WAVEguide for waveguide

medium.

Examples CALC:CORR:EDEL:MED COAX

calc3:corr:edelay:medium waveguide

Query Syntax CALCulate<cnum>:CORRection:EDELay:MEDium?

Return Type Character

Default COAX

CALCulate<cnum>:CORRection:EDELay:UNIT <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the units for specifying electrical delay in physical length (distance).   

Parameters  

<cnum> Any existing channel number.  If unspecified, value is set to 1.

<char> Units for delay in distance. Choose from:

METer

FEET

INCH

Examples CALC:CORR:EDEL:UNIT MET

calc3:corr:edelay:unit inch

Query Syntax CALCulate<cnum>:CORRection:EDELay:UNIT?

Return Type Character

Default METer

CALCulate<cnum>:CORRection:EDELay[:TIME] <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the electrical delay for the selected measurement.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Electrical delay in seconds. Choose any number between:

-10.00 and 10.00

Use SENS:CORR:RVEL:COAX <num> to set Velocity factor.

This parameter supports MIN and MAX as arguments. Learn more.

Examples CALC1:CORR:EDEL:TIME 1NS
calculate2:correction:time 0.5e-12

Query Syntax CALCulate:CORRection:EDELay[:TIME]?

Return Type Numeric

Default 0 seconds

CALCulate<cnum>:CORRection:EDELay:WGCutoff <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the waveguide cutoff frequency used when the electrical delay media is set to

WAVEguide.  (See CALCulate:CORRection:EDELay:MEDium <char>.)

Parameters  

<cnum> Any existing channel number.  If unspecified, value is set to 1.

<num> Waveguide cutoff frequency used with the electrical delay calculation.

This parameter supports MIN and MAX as arguments. Learn more.

Examples CALC:CORR:EDEL:WGC 18.067 GHz

calculate3:correction:edelay:wgcutoff 14.047 ghz

Query Syntax CALCulate<cnum>:CORRection:EDELay:WGCutoff?

Return Type Numeric

Default 45 MHz
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CALCulate<cnum>:CORRection:ERRor[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns error correction ON or OFF on the specified channel.

To turn error correction ON or OFF for a channel, use SENS:CORR:STATe.

See Critical Note

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<bool> Correction state. Choose from:

0 - Correction OFF

1 - Correction ON

Examples CALC:CORR:ERR ON

calculate:correction:error:state off

Query Syntax CALCulate<cnum>:CORRection:ERRor:STATe?

Return Type Boolean

Default Not Applicable

CALCulate<cnum>:CORRection:ERRor:TYPE <string>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the Cal Type on the specified channel. This is used when a Cal Set is applied. Learn
more about applying Cal Types.

Use SENS:CORR:TYPE:CAT? to list the Cal Types in the VNA.

Use SENS:CORR:CSET:TYPE:CAT? to list the Cal Types contained in the active Cal Set for the channel.

Use SENS:CORR:COLL:METH to set the Cal type to perform a new Unguided calibration,

See Critical Note

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<string> (String) Cal type. Case sensitive. Use one of the following:

For Full Calibrations (NO Power Cal included):
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This command does not distinguish between TRL and SOLT. The same

number of error terms is applied for both Cal Types.

"Full <n> Port(x,y,z...)"

where

<n> = the number of ports to calibrate

x,y,z = the port numbers to calibrate

For example:

"Full 4 Port(1,2,3,4)"

For Full Calibrations (including Power Cal):

After the Full <n> port, include the string, "with power"

For example:

"Full 4 Port with power(1,2,3,4)"

For Response Calibrations:

"Response(param)"  OR

"ResponseAndIsolation(param)"

Where param =  

S-parameter. For example"

"Response(S21)"

"ResponseAndIsolation(A/R)"

Single or ratioed receivers using either logical receiver notation or physical
receiver notation. For example:

"Response(A)"

"ResponseAndIsolation(a3/b4)"

For Enhanced Response Calibrations:

"EnhancedResp(sourcePort, recPort)

Where:
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sourcePort = stimulus port number

recPort = receiver port number

For FCA Calibrations:

Learn more about this setting.

"SMC_2P" (Response + Input + Output)  All four sweeps required. Most accurate.

"SMCRsp+IN"  No Output match. All four sweeps required.

"SMCRsp+OUT"  No Output match. All four sweeps required.

"SMCRsp"  No Input or Output match. Saves two sweeps.

For VMC, multiple Cal types are not available.

For Gain Compression Cal

where r = receive port; s = source port

"GCA 2P (r,s)”  - full 2-port cal

“GCA Enh Resp (r,s)”  - Enhanced Response Cal

Examples CALC:CORR:ERR:TYPE "Scalar Mixer Cal"

Query Syntax CALCulate<cnum>:CORRection:ERRor:TYPE?

Return Type String

Default Not Applicable

CALCulate<cnum>:CORRection[:STATe] <bool>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns error correction ON or OFF for the selected measurement on the specified

channel.

To turn error correction ON or OFF for a channel, use SENS:CORR:STATe.

See Critical Note

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<bool> Correction state. Choose from:

0 - Correction OFF

1 - Correction ON

Examples CALC:CORR ON

calculate:correction:state off

Query Syntax CALCulate<cnum>:CORRection:STATe?

Return Type Boolean

Default Not Applicable

CALCulate<cnum>:CORRection[:STATe]:INDicator?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the error correction state for the selected measurement on the specified channel.  

To turn error correction ON or OFF for a channel, use SENS:CORR:STATe.

See Critical Note

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

Examples CALC:CORR:IND?

calculate2:correction:state:indicator?

Return Type Character

NONE - No error correction

MAST (Master) - Original error correction terms
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INT - Error terms are interpolated. Learn more.

DELT - Delta Match calibration terms. Learn more.

INV - Error terms are not valid

Default NONE

CALCulate<cnum>:CORRection:TYPE <string>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the Cal Type for the selected measurement on the specified channel. This is used

when a Cal Set is applied. Learn more about applying Cal Types.

Use SENS:CORR:TYPE:CAT? to list the Cal Types in the VNA.

Use SENS:CORR:CSET:TYPE:CAT? to list the Cal Types contained in the active Cal Set for the channel.

Use SENS:CORR:COLL:METH to set the Cal type to perform a new Unguided calibration,

See Critical Note

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<string> (String) Cal type. Case sensitive. Use one of the following:

For Full Calibrations (NO Power Cal included):

This command does not distinguish between TRL and SOLT. The same

number of error terms is applied for both Cal Types.

"Full <n> Port(x,y,z...)"

where

<n> = the number of ports to calibrate

x,y,z = the port numbers to calibrate

For example:

"Full 4 Port(1,2,3,4)"

For Full Calibrations (including Power Cal):

After the Full <n> port, include the string, "with power"
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For example:

"Full 4 Port with power(1,2,3,4)"

For Response Calibrations:

"Response(param)"  OR

"ResponseAndIsolation(param)"

Where param =  

S-parameter. For example"

"Response(S21)"

"ResponseAndIsolation(A/R)"

Single or ratioed receivers using either logical receiver notation or physical
receiver notation. For example:

"Response(A)"

"ResponseAndIsolation(a3/b4)"

For Enhanced Response Calibrations:

"EnhancedResp(recPort, sourcePort)

Where:

recPort = receiver port number

sourcePort = stimulus port number

For FCA Calibrations:

Learn more about this setting.

"SMC_2P" (Response + Input + Output)  All four sweeps required. Most accurate.

"SMCRsp+IN"  No Output match. All four sweeps required.

"SMCRsp+OUT"  No Output match. All four sweeps required.

"SMCRsp"  No Input or Output match. Saves two sweeps.

For VMC, multiple Cal types are not available.
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For Gain Compression Cal

where r = receive port; s = source port

"GCA 2P (r,s)”  - full 2-port cal

“GCA Enh Resp (r,s)”  - Enhanced Response Cal

Examples CALC:CORR:TYPE "Scalar Mixer Cal"

Query Syntax CALCulate<cnum>:CORRection:TYPE?

Return Type String

Default Not Applicable

CALCulate<cnum>:CORRection:OFFSet[:MAGNitude] <num>  Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command is replaced with SENS:CORR:RPOWer:OFFSet[:AMPLitude].
To set data trace magnitude offset, use CALC:OFFS:MAGN
This command does NOT function for FCA measurements.

See an example of a Receiver Power Calibration.

 

(Read-Write)

For Receiver Power Calibration, specifies the power level to which the selected (unratioed)

measurement data is to be adjusted.  This command applies only when the selected measurement is of

unratioed power.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Cal power level in dBm. No limits are enforced on this value, but the VNA

receivers themselves have maximum and minimum power specifications (that

may differ between VNA models) which this value must comply with for a

valid receiver power cal.

Examples CALC:CORR:OFFS 10DBM
calculate1:correction:offset:magnitude maximum

Query Syntax CALCulate<cnum>:CORRection:OFFSet[:MAGNitude]?

Return Type Numeric

Default 0dBm
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CALCulate<cnum>:CORRection:OFFSet:PHASe <num>[<char>]    Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command is replaced with CALC:OFFS:PHASe

(Read-Write) Sets the phase offset for the selected measurement.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Offset phase value. Choose any number between:

-360 and 360

<char>

 

Units for phase. OPTIONAL. Choose either:

DEG - Degrees (default)

RAD - Radians

Examples CALC:CORR:OFFS:PHAS 10
calculate:correction:offset:phase 20rad

Query Syntax CALCulate:CORRection:OFFSet:PHASe?

Return Type Numeric, returned value always in degrees

Default 0 degrees
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Calculate:Custom Commands

Creates and modifies application measurements.

These commands are Superseded by the CALCulate:MEASure:DEFine and CALCulate:MEASure:PARameter
commands.

 

CALCulate:CUSTom:

DEFine

MODify

See Also

Example Programs

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<cnum>:CUSTom:DEFine <Mname>, <type> [,param]

Applicable Models: All

(Write-only)  Creates a custom measurement depending on the configurations and options. The custom

measurement is not automatically displayed. You must also do the following:

Use DISP:WIND:STATe to create a window if it doesn't already exist.·

Use DISP:WIND:TRAC:FEED to display the measurement

Select the measurement (CALC:PAR:SEL) before making additional settings.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<Mname> Name of the measurement. Any non-empty, unique string, enclosed in quotes.

<type> (string) - Choose from the following (click or scroll down to view valid

<params> for each type)

"Standard"
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"Vector Mixer/Converter"

"Scalar Mixer/Converter"

"Gain Compression"

"Gain Compression Converters"

"Noise Figure Cold Source"

"Noise Figure Converters"

"Swept IMD"

"IM Spectrum"

"Swept IMD Converters"

"IM Spectrum Converters"

"Differential I/Q"

"Spectrum Analyzer"

[param] (variant) Measurement names to create:

Meas Class Measurement Name Description

"Standard"

"S11", "S21", and

so forth

"A_1","A_2", and

so forth

S-parameter name

Unratioed parameter

names with notation:

"receiver_source port"

See Balanced S-
parameter measurement
names

"Vector
Mixer/Converter"

"S11"

"VC21"

"S22"

Learn about VMC

parameters

"Scalar

Mixer/Converter"

"S11"

"SC21"

"SC12"

"S22"

"Ipwr"

Learn about SMC
parameters

589



"RevIPwr"

"Opwr"

"RevOPwr"

"Gain Compression"

Learn more

"Gain Compression

Converters"

Learn more

GCA and GCX:

"CompIn21"
Input power at the

compression point.

"CompOut21"
Output power at the

compression point.

"CompGain21"
Gain at the compression
point.

"CompS11"
 Input Match at the
compression point

"RefS21" Linear Gain

"DeltaGain21" CompGain21 -Linear Gain

"S11", "S21",

"S12", "S22"

Standard S-parameters;
measured at port 1 and port
2

GCX - All Gain Compression parameters (except

S21 and S12) plus the following:

"S11"

"SC21"

"SC12"

"S22"

"Ipwr"

"RevIPwr"

"Opwr"

"RevOPwr"

Mixer parameters

Noise Figure AND NFX:

"NF" Noise figure

"ENR"
Validate noise source

measurements.

"T-Eff"
Effective noise

temperature.
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"Noise Figure Cold

Source"

Learn more

"Noise Figure

Converters"

Learn more

"DUTRNP"

"DUTRNPI"

DUT noise power

ratio. (Noise power

expressed in Kelvin

divided by 290).

"SYSRNP"

"SYSRNPI"

System noise power

ratio

"DUTNPD"

"DUTNPDI"

DUT noise power

density. (Noise power

expressed in dBm/Hz).

"SYSNPD"

"SYSNPDI"

System noise power

density.  

"OvrRng"

(Opt 029 Only)

Indication that the

noise receiver is being

over powered.

"T-Rcvr"

(Opt 029 Only)

Temperature reading

(in Kelvin) of the noise

receiver board.

Noise Figure ONLY - NOT NFX:

"S11", "S21",

"S12", "S22"

Standard S-parameters;

measured with the

port1 and port2 noise

switches set for noise

mode.

"A_1","A_2" ...and

so forth.

Unratioed parameters;

with notation:

"receiver, source port"

"GammaOpt"
Optimum Complex

Reflection Coefficient

"Rn" Noise Resistance

"NFMin"

Minimum noise figure

that occurs at

GammaOpt

NFX ONLY:

"S11"

"SC21"

"SC12"
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"S22"

"Ipwr"

"RevIPwr"

"Opwr"

"RevOPwr"

Mixer parameters

"ALO1"," BLO1"

...and so forth.

Test port receiver at

LO1 frequency

"R1_1", "B_2"

..and so forth.

Unratioed parameters

with notation:

"receiver_source port"

"Swept IMD"

"Swept IMD

Converters"

Learn more

There are over 150 possible Swept IMD

parameters, too many to list here.

Build the parameters with the Swept IMD

Parameter dialog, then copy the parameter

name to the remote command.

The following are a few example parameters:

"PwrMainLo"

Absolute power of the

Low tone at the DUT

output.

"IM3"

Power of the third

product relative to the

average power of the

f1 and f2 tones

measured at the DUT
output.

"OIP3"

Theoretical power

level at which the third
product will be the

same power level as
the average of the

main tones at the
output of the DUT.

"Output"

View signals OUT of

the DUT and into

VNA port 2 (B
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"IM Spectrum"

Learn more

receiver).

"Input"
View signals IN to the

DUT (R1 receiver).

"Reflection"

View signals reflected

off the DUT input and

back into VNA port 1

(A receiver)

"IMx Spectrum

Converters"

Learn more

"Output"

View signals OUT of

the DUT and into

VNA port 2 (B

receiver)

"Differential I/Q"

Learn more

Create custom parameters using

Sens:DIQ:Par:Def, then specify your custom

parameter name here.

The following are default parameters:

"IPwrF1"

"OPwrF1"

"GainF1"

Input Power over F1

range

Output Power over F1

range

Gain over F1 range

"Spectrum Analyzer"

Learn more

"a<n>"

"b<n>"

where <n> is the

port number to

measure

"ImageReject<n>"

where <n> is the

image reject trace

Reference receiver

Test port receiver

Examples CALC:CUST:DEF 'My VC21', 'Vector Mixer/Converter','S22'

calculate2:custom:define 'MyNF', 'NoiseFigure', 'NF'

Query Syntax Not applicable

Overlapped? No

Default Not applicable
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CALCulate<cnum>:CUSTom:MODify <param>

Applicable Models: All

(Write-only)  Changes the selected custom measurement to a different parameter. This is dependent

upon the configurations and options.

See an example using this command for a VMC and SMC measurement

Parameters  

<cnum> Channel of the custom measurement to be changed. First, select the

measurement using CALC:PAR:SEL.

<param> Parameter to change the custom measurement to. Select a parameter that is

valid for the type of measurement. Choose from the same arguments as

Calc:Cust:Def.

Examples SYST:PRES

CALC2:CUST:DEF 'My VC21', 'Vector Mixer/Converter'

CALC:PAR:SEL 'My VC21'

CALC2:CUST:MOD 'S22'

Query Syntax Not applicable

Overlapped? No

Default Not applicable
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Calculate:Data Commands

Controls writing and reading VNA measurement data.

These commands are Superseded by the CALCulate:MEASure:DATA commands.

CALCulate:DATA

       | CUSTom

             | CATalog?

       | MFData?

       | MSData?

       | SNP?

             | PORTs?

                  | SAVE

Click on a red keyword to view the command details.

Red is a superseded command.

See Also

Example Programs

Data Access Map

Synchronizing the Analyzer and Controller

To read receiver data, use CALC:RDATA?

To read error terms, use SENS:CORR:CSET:DATA

To read SnP measurement data, use CALC:DATA:SNP?

SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

(Write) CALCulate<cnum>:DATA <char>,<data>

(Read)  CALCulate<cnum>:DATA? <char>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

Reads or writes Measurement data, Memory data, or Normalization Divisor data from the Data
Access Map location.

For Measurement data, use FDATA, RDATA, or SDATA

For Memory data, use FMEM or SMEM. When querying memory, you must first store a trace into memory
using CALC:MATH:MEMorize.

For Normalization Divisor (Receiver Power Cal error term) data, use SDIV

Use FORMat:DATA to change the data type (<REAL,32>, <REAL,64> or <ASCii,0>).

Use FORMat:BORDer to change the byte order. Use “NORMal” when transferring a binary block from
LabView or Vee. For other programming languages, you may need to "SWAP" the byte order.

Equation Editor Notes:

When equation editor is active on a trace in a standard S-parameter channel, Calc:Data returns the data
from the parameter on the trace that was measured last. For example, for the equation "S22 + S33 +
S11”, then S33 is the last measured parameter because it uses source port 3.

In applications, if equation editor is active and the original parameter for the trace is not requested
anywhere in the channel, then zeros are returned. If the original parameter is being measured within the
channel, then data for the original parameter is returned.

In general, if an equation contains no measurement parameters, then data for the original parameter is
returned.

Note: The Calc:Data SCORR command to read / write error terms is Superseded with

SENS:CORR:CSET:DATA. SCORR commands do NOT accommodate greater than 12 error terms.

See Critical Note
Parameters    

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<char> FDATA Formatted measurement data to or from Data Access Map location

Display (access point 2).

Note: When querying FDATA, data is received in degrees. When

setting phase using FDATA, the command expects the data in radians.

Corrected data is returned when correction is ON.

Uncorrected data is returned when correction is OFF.

Returns TWO numbers per data point for Polar and Smith Chart format.
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Returns one number per data point for all other formats.

Format of the read data is same as the displayed format.
  RDATA Complex measurement data.

Writes data to Data Access Map location Raw Measurement (access

point 0).

When writing corrected data, and correction is ON, it will be corrected
again, resulting in meaningless data (Same behavior as SDATA).

Reads data from Data Access Map location Raw Measurement (access

point 0).

Returns TWO numbers per data point.

Returned numbers are uncorrected (regardless of correction state)
  SDATA Complex measurement data.

Writes data to Data Access Map location Raw Measurement (access

point 0).

When writing corrected data, and correction is ON, it will be corrected
again, resulting in meaningless data.

Reads data from Apply Error Terms (access point 1).

Returns TWO numbers per data point.

Corrected data is returned when correction is ON.

Uncorrected data is returned when correction is OFF.
  FMEM Formatted memory data to or from Data Access Map location Memory

result  (access point 4).

Returns TWO numbers per data point for Polar and Smith Chart format.

Returns one number per data point for all other formats.

Format of the read data is same as the displayed format.

Returned data reflects the correction level (On|OFF) when the data was
stored into memory.

  SMEM Complex measurement data to or from Data Access Map location
Memory  (access point 3).
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Returns  TWO numbers per data point.

Returned data reflects the correction level (On|OFF) when the data was
stored into memory.

Returned data reflects the correction level (On|OFF) when the data was
stored into memory.

  SDIV Complex data from Data Access Map location Normalization (5).

Returns TWO numbers per data point.

If normalization interpolation is ON and the number of points changes
after the initial normalization, the divisor data will then be interpolated.

When querying the normalization divisor, you must first store a divisor
trace using CALC:NORMalize[:IMMediate].

The following Calc:Data SCORR command to read / write error terms is Superseded with

SENS:CORR:CSET:DATA. These SCORR commands do NOT accommodate greater than 12 error terms.

For 2-Port

SOLT and

TRL

calibrations

Specify this

<char>

to get or put this Error Term...

SCORR1 Forward Directivity

SCORR2 Forward Source Match

SCORR3 Forward Reflection Tracking

SCORR4 Forward Isolation

SCORR5 Forward Load Match

SCORR6 Forward Transmission Tracking

SCORR7 Reverse Directivity

SCORR8 Reverse Source Match

SCORR9 Reverse Reflection Tracking

SCORR10 Reverse Isolation

SCORR11 Reverse Load Match

SCORR12 Reverse Transmission Tracking
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EXAMPLE

CALC:DATA FDATA,Data(x)
calculate2:data sdata,data(r,i)

See another example using this command.

Return Type: Block data

Default - Not Applicable

CALCulate<cnum>:DATA:CUSTom <name>,<data> Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command has been replaced by CALC:DATA: which can now be used with all VNA

applications.

(Read-Write) Reads or writes data from a custom-named measurement buffer.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<name> Name of the buffer to be read or written

<data> Data to be read or written to the custom buffer. Format as one number per data

point.

Examples CALC:DATA:CUST 'VectorResult0',0,1,2,3,4,5 'Write

CALC:DATA:CUST? 'VectorResult0' 'Read

Query Syntax CALCulate:DATA:CUSTom? <name>

Return Type Depends on Form:Data

Default Not Applicable

CALCulate<cnum>:DATA:CUSTom:CATalog?  Superseded
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Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command has been replaced by CALC:DATA:CAT which can now be used with all VNA

applications.

(Read-only) Reads the list of buffer names (comma separated list of string values) available from the

selected parameter. Specify the measurement using CALCulate:PARameter:SELect.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

Examples CALC:DATA:CUST:CAT?

calculate:data:custom:catalog?

Return Type String

Default Not Applicable

CALCulate<cnum>:DATA<data>:MFData <string>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M948xA

(Read-only) Gets the formatted data array of multiple traces (traces-n, m, .... to l) of the selected

channel.

This command gets multiple trace data with one command, while CALC:MEAS:DATA:FDAT returns only

one trace with one command.

Note: If valid data is not calculated because of the invalid measurement, “1.#QNB” is read out.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<data> Indicates the array data (formatted data array) of NOP (number of measurement

points)×2×(number of specified traces). Where n is an integer between 1 and NOP.

Data (n×2-2) : Data (primary value) at the n-th measurement point.

Data (n×2-1) : Data (secondary value) at the n-th measurement point. Always 0
when the data format is not the Smith chart format or the polar format.

The output trace data is listed according to the order of the specified trace number.
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The index of the array starts from 0.

Note: If there is no array data of NOP (number of measurement point)×2 when setting

a formatted data array, an error occurs when executed and the object is ignored.

<string> Trace number. "n, m, l, ..." where n, m, l are 1 to the maximum trace number.

Note: Use comma for separator of trace number.

Examples CALC:DATA:MFD

Return

Type

Not Applicable

Default Not Applicable

CALCulate<cnum>:DATA<data>:MSData <string>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M948xA

(Read-only) Gets the corrected data array of multiple traces (traces-n, m, .... to l) of the selected

channel.

This command is allows to get several corrected data with one command, while

CALC:MEAS:DATA:SDAT returns only one corrected data with one command.

Note: If valid data is not calculated because of the invalid measurement, “1.#QNB” is read out.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<data> Indicates the array data (corrected data array) of NOP (number of measurement

points)×2×(number of specified traces). Where n is an integer between 1 and NOP.

Data(n*2-2) : Real part of the data (complex number) at the n-th measurement point.

Data(n*2-1) : Imaginary part of the data (complex number) at the n-th measurement
point.

The output trace data is listed according to the order of the specified trace number.

The index of the array starts from 0.

Note: If there is no array data of NOP (number of measurement point)×2 when setting

a corrected data array, an error occurs when executed and the object is ignored.
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<string> Trace number. "n, m, l, ..." where n, m, l are 1 to the maximum trace number.

Note: Use comma for separator of trace number.

Examples CALC:DATA:MSD

Return

Type

Not Applicable

Default Not Applicable

CALCulate<cnum>:DATA:SNP? <n> Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command has been replaced by CALC:DATA:SNP:PORTs?

(Read-only) Reads SnP data from the selected measurement. Learn more about SnP data.

This command is valid ONLY with standard S-parameter measurements.

Notes

This command returns SNP data without header information, and in columns, not in rows as .SnP files.
This means that the data returned from this command sends all frequency data, then all Sx1 magnitude
or real data, then all Sx1 phase or imaginary data, and so forth.

To avoid frequency rounding errors, specify FORM:DATA <Real,64> or <ASCii, 0>

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<n> Amount of data to return. If unspecified, <n> is set to 2.  The number you

specify must be less than or equal to the number of available ports on the VNA.

Choose from:

1 (S1P) returns 1-Port data for the active measurement if the active

measurement is a reflection parameter such as S11 or S22. The behavior is

UNDEFINED if the active measurement is a transmission parameter such as an

S21.

2  (S2P)  returns data for the four 2 port parameters associated with the current
measurement. Default. Data that is not available is zero-filled.
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3  (S3P)  returns data for the nine 3 port parameters associated with the current

measurement. Data that is not available is zero-filled.

4 (S4P)   returns data for the sixteen 4 port parameters associated with the

current measurement.  Data that is not available is zero-filled.

SnP data can be output using several data formatting options.  See

MMEM:STORe:TRACe:FORMat:SNP.

See also MMEM:STOR <file>.<snp>

Examples CALC:PAR:DEF MyMeasurement, S11

CALC:PAR:SEL MyMeasurement

CALC:DATA:SNP? 1

Return Type Depends on FORMat:DATA.

Default Not Applicable

CALCulate<cnum>:DATA:SNP:PORTs? <"x,y,z".>

Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command replaces CALC:DATA:SNP?. This command is more explicit regarding the data to

be returned, and works for VNAs with multiport test sets.

(Read-only)  Reads SNP data from the selected measurement for the specified ports. Learn more about
SNP data.

This command is valid ONLY with standard S-parameter measurements.

Notes

This command returns SNP data without header information, and in columns, not in rows as .SnP files.
This means that the data returned from this command sends all frequency data, then all Sx1 magnitude
or real data, then all Sx1 phase or imaginary data, and so forth.

To avoid frequency rounding errors, specify FORM:DATA <Real,64> or <ASCii, 0>

Data that is not available is zero-filled.

For sweeps with a large number of data points, always follow this command with *OPC? Learn more.

See Critical Note

Parameters  
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<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<"x,y,z"> Comma or space delimited port numbers for which data is requested, enclosed

in quotes.

SNP data can be output using several data formatting options.  See

MMEM:STORe:TRACe:FORMat:SNP.

Examples CALC:DATA:SNP:PORTs? "1,2,4,5,7" 'read data for these ports

Return Type Depends on FORMat:DATA

Default Not Applicable

CALCulate<cnum>:DATA:SNP:PORTs:SAVE <"x,y,z">,<"filename">

Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command replaces MMEM:STOR sNp. This command is more explicit regarding the data to

be saved, and works for VNAs with multiport test sets.

(Write-only) Saves SNP data from the selected measurement for the specified ports.  Learn more about
SNP data.

The Normal vs Mixed Mode selection is NOT used as it is in the Choose Ports dialog. Instead, data is
returned as it is displayed on the trace. If the selected measurement is Mixed Mode (balanced), then
balanced data is returned. If the selected measurement is an S-parameter, then S-parameter data is
returned.

This command is valid ONLY with the Standard measurement class (NOT applications).

Data that is not available is zero-filled.

For sweeps with a large number of data points, always follow this command with *OPC? Learn more.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<"x,y,z"> String  Comma or space delimited port numbers for which data is requested,

enclosed in quotes.

<filename> String  Path, filename, and suffix of location to store the SNP data, enclosed in
quotes.  The suffix is not checked for accuracy. If saving 2 ports, specify

"filename.s2p"; If saving 4 ports, specify "filename.s4p.", and so forth.
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SNP data can be output using several data formatting options.  See

MMEM:STORe:TRACe:FORMat:SNP.

Examples CALC:DATA:SNP:PORTs:Save '1,2,4','D:\MyData.s3p';*OPC?

Return Type Depends on FORMat:DATA

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:RDATa? <char>

(Read-only) Returns receiver data for the selected measurement. To query measurement data, see
CALC:DATA?

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<char> Choose from any physical receiver in the VNA.

For example: "A"

Also, REF - returns data for either R1 or R2 data depending on the source port of the

selected measurement.

See the block diagram showing the receivers in VNA.

Note: Logical receiver notation is NOT allowed with this command. Learn more.

Example INITiate:CONTinuous OFF
INITiate:IMMediate;*wai
CALC:MEAS:RDATA? A

CALCulate:RDATA? REF

Return Type Depends on FORM:DATA command - Two numbers per data point

Default Not Applicable

Notes:

Generally when you query the analyzer for data, you expect that the number of data values returned will
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be consistent with the number of points in the sweep.

However, if you query receiver data while the instrument is sweeping, the returned values may contain

zeros. For example, if your request for receiver data is handled on the 45th point of a 201 point sweep,

the first 45 values will be valid data, and the remainder will contain complex zero.

This can be avoided by synchronizing this request with the end of a sweep or putting the channel in

hold mode.

Learn about Unratioed Measurements
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CALCulate<cnum>:DTOPology <device>,<topology>

Applicable Models: Multi-port systems with > 4 ports

(Read-Write)  Maps the physical VNA ports to a device of balanced and single-ended logical ports for

multi-port systems with greater than 4 ports. The device type is selected using

CALCulate:FSIMulator:BALun:DEVice.

See Also:

CALC:FSIM:BAL:PAR:CAT? - returns the list of measurement parameters available for the currently

selected topology.

CALC:FSIM:BAL:PAR:CUST:DEFine - defines measurement parameter corresponding to a custom

topology for systems where the port count is expandable beyond 4 ports.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<device> (String) Device type for the balanced measurement. ‘B’ means the Balanced port; ‘S’ means the
Single-ended port. Choose from:

B – 1 port balanced device (2 ports)

BB – Balanced - Balanced device (4 ports)

BS – Balanced - Single-ended device (3 ports)

SB – Single-ended - Balanced device (3 ports)

SSB – Single-ended - Single-ended - Balanced device (4 ports)

<topology> (Int array) Physical port numbers mapped to the logical ports, separated by ‘,’.

‘B’ (Balanced) requires 2 physical port numbers: <nPos>, <nNeg>.

‘S’ (Single-ended) requires 1 physical port number.

Examples 'The following example sets up 6 physical ports into 5 logical
ports:
'Logical port 1 is a single ended port mapped to physical port 1
'Logical port 2 is a single ended port mapped to physical port 2
'Logical port 3 is a balanced port mapped to physical ports 4
and 5
'Logical port 4 is a single ended port mapped to physical port 3
'Logical port 5 is a single ended port mapped to physical port 6

CALC:DTOP "SSBSS",1,2,4,5,3,6
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Query Syntax CALCulate<cnum>:DTOPology <device>,<topology>?

Return Type Int array

Default Not Applicable
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Calculate:Equation Commands

Controls Equation Editor capabilities.

CALCulate:EQUation:

LIBRary

    | FUNCtions

    | IMPort?

    | REMove

STATe

TEXT

VALid?

Click on a keyword to view the command details.

See Also

Example Programs

Learn about Equation Editor

Synchronizing the Analyzer and Controller

SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

CALCulate:EQUation:LIBRary:FUNCtions <string>
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Applicable Models: All

(Read-only)  Returns the functions in the specified DLL.

Parameters  

<string> Full path and filename of the *.dll to be read.

Examples functions = CALC:EQU:LIBR:FUNC “C:/Program
Files/Keysight/Network Analyzer/UserFunctions/Expansion.dll”

Query Syntax CALCulate:EQUation:LIBRary:FUNCtions?

Return Type Comma delimited string of function names.

Default Not Applicable

CALCulate:EQUation:LIBRary:IMPort <string>

Applicable Models: All

(Read-Write)  Imports the functions in the specified DLL and returns whether the functions have been

imported into the VNA.

Parameters  

<string> Full path and filename of the *.dll.

Examples 'Write - Imports functions

CALC:EQU:LIBR:IMPort “C:/Program Files/Keysight/Network
Analyzer/UserFunctions/Expansion.dll”  

'Read if Imported

functions = CALC:EQU:LIBR:IMPort “C:/Program
Files/Keysight/Network Analyzer/UserFunctions/Expansion.dll”

Query Syntax CALCulate:EQUation:LIBRary:IMPort?

Returns the following:

1 - Imported

0 - NOT imported

Return Type Boolean

Default Not Applicable
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CALCulate:EQUation:LIBRary:REMove <string>

Applicable Models: All

(Write-only)  Removes an imported an Equation Editor DLL from the VNA.

Parameters  

<string> Full path and filename of the *.dll.

Examples CALC:EQU:LIBR:REM “C:/Program Files/Keysight/Network
Analyzer/UserFunctions/Expansion.dll”  

Query Syntax Not Applicable

Default Not Applicable

CALCulate<cnum>:EQUation[:STATe] <bool>

Applicable Models: All

(Read-Write)  Turns ON and OFF the equation on selected measurement for the specified channel. If

the equation is not valid, then processing is not performed. Use CALC:EQUation:VALid? to ensure that

the equation is valid.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<bool> ON (or 1) - turns equation ON.

OFF (or 0) - turns equation OFF.

Examples CALC:EQU 1

calculate2:equation:state 0

Query Syntax CALCulate<cnum>:EQUation[:STATe]?

Return Type Boolean

Default OFF (0)

CALCulate<cnum>:EQUation:TEXT <string>
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Applicable Models: All

(Read-Write)  Specifies an equation or expression to be used on the selected measurement for the

specified channel.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<string> Any valid equation or expression. See Equation Editor.

Examples 'Equation (includes '=')

CALC:EQU:TEXT "foo=S11/S21"

'Expression
calculate2:equation:text "S11/S21"

Query Syntax CALCulate<cnum>:EQUation:TEXT?

Return Type String

Default Not Applicable

CALCulate<cnum>:EQUation:VALid?

Applicable Models: All

(Read-Only)  Returns a boolean value to indicate if the current equation on the selected measurement

for the specified channel is valid. For equation processing to occur, the equation must be valid and

ON (CALC:EQU:STAT 1).

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

Examples CALC:EQU:VAL?

calculate2:equation:valid?
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Return Type Boolean

1 - equation is valid

0 - equation is NOT valid

Default Not Applicable
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Calculate:Filter Commands

Controls the gating function used in time domain measurements. The gated range is specified with

either (start / stop) or (center / span) commands.

These commands are Superseded by the CALCulate:MEASure:FILTer commands.

 

 

Click on a keyword to view the command details.

See Also

Example Programs

Learn about Gating

Synchronizing the Analyzer and Controller

SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one
measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

CALCulate<cnum>:FILTer[:GATE]:COUPle:PARameters <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write)  Specifies the time domain gating parameters to be coupled. The settings for those

parameters will be copied from the selected measurement to all other measurements on the channel.

To enable Trace Coupling, use SENS:COUP:PAR

To specify Transform parameters to couple, use CALC:TRAN:COUP:PAR

Learn more about Time Domain Trace Coupling

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> (Numeric) Parameters to couple. To specify more than one parameter, add the

numbers.

1 - Gating Stimulus (Start, Stop, Center, and Span TIME settings.)

2 - Gating State (ON / OFF)

4 - Gating Shape  (Minimum, Normal, Wide, and Maximum)

8 - Gating Type  (Bandpass and Notch)

Examples 'To couple all parameters:

CALC:FILT:COUP:PAR 15

'To couple Stimulus and Type:
calculate2:filter:gate:couple:parameters 9

Query Syntax CALCulate<cnum>:FILTer:GATE:COUPle:PARameters?

Return Type Numeric

Default 13 (All parameters except 2 - Gating State)

CALCulate<cnum>:FILTer[:GATE]:TIME:CENTer <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the gate filter center time.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Center time in seconds; Choose any number between:

± (number of points-1) / frequency span

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:FILT:GATE:TIME:CENT -5 ns
calculate2:filter:time:center maximum

Query Syntax CALCulate<cnum>:FILTer[:GATE]:TIME:CENTer?

Return Type Numeric

Default 0

CALCulate<cnum>:FILTer[:GATE]:TIME:SHAPe <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the gating filter shape when in time domain.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<char> Choose from

MAXimum - the widest gate filter available

WIDE -

NORMal -

MINimum - the narrowest gate filter available

Examples CALC:FILT:GATE:TIME:SHAP MAX
calculate2:filter:time:shape normal

Query Syntax CALCulate<cnum>:FILTer[:GATE]:TIME:SHAPe?

Return Type Character
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Default NORMal

CALCulate<cnum>:FILTer[:GATE]:TIME:SPAN <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the gate filter span time.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Time span in seconds; Choose any number between:

0 and 2* [(number of points-1) / frequency span]

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:FILT:GATE:TIME:SPAN 5 ns
calculate2:filter:time:span maximum

Query Syntax CALCulate<cnum>:FILTer[:GATE]:TIME:SPAN?

Return Type Numeric

Default 20 ns

CALCulate<cnum>:FILTer[:GATE]:TIME:STATe <boolean>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns gating state ON or OFF.

See Critical Note

Note: Sweep type must be set to LInear Frequency in order to use Transform Gating.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<boolean> ON (or 1) - turns gating ON.

OFF (or 0) - turns gating OFF.

Examples CALC:FILT:TIME:STAT ON
calculate2:filter:gate:time:state off
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Query Syntax CALCulate<cnum>:FILTer[:GATE]:TIME:STATe?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:FILTer[:GATE]:TIME:STARt <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the gate filter start time.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Start time in seconds; any number between:

± (number of points-1) / frequency span

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:FILT:TIME:STAR 1e-8
calculate2:filter:gate:time:start minimum

Query Syntax CALCulate<cnum>:FILTer[:GATE]:TIME:STARt?

Return Type Numeric

Default 10 ns

CALCulate<cnum>:FILTer[:GATE]:TIME:STOP <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the gate filter stop time.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Stop time in seconds; any number between:

± (number of points-1) / frequency span

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:FILT:TIME:STOP -1 ns
calculate2:filter:gate:time:stop maximum

Query Syntax CALCulate<cnum>:FILTer[:GATE]:TIME:STOP?

Return Type Numeric

Default 10 ns

CALCulate<cnum>:FILTer[:GATE]:TIME[:TYPE] <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the type of gate filter used.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<char> Choose from:

BPASs - Includes (passes) the range between the start and stop times.

NOTCh - Excludes (attenuates) the range between the start and stop times.

Examples CALC:FILT:TIME BPAS
calculate2:filter:gate:time:type notch

Query Syntax CALCulate<cnum>:FILTer[:GATE]:TIME[:TYPE]?

Return Type Character

Default BPAS
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Calculate:Format Commands

These commands are Superseded by the CALCulate:MEASure:FORMat commands.

 

CALCulate:

| FORMat

    | UNIT

 

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

See Also

Example using this command.

Learn About Data Format

Synchronizing the Analyzer and Controller

CALCulate<cnum>:FORMat <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the display format for the measurement.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<char> Choose from:

MLINear

MLOGarithmic

PHASe

UPHase 'Unwrapped phase
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IMAGinary

REAL

POLar

SMITh

SADMittance 'Smith Admittance

SWR

GDELay 'Group Delay

KELVin

FAHRenheit

CELSius

PPHase 'Positive Phase

Examples CALC:FORM MLIN
calculate2:format polar

Query Syntax CALCulate<cnum>:FORMat?

Return Type Character

Default MLINear

CALCulate<cnum>:FORMat:UNIT <dataFormat>, <units>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the units for the specified data format.  Measurements with display

formats other than those specified are not affected.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<dataFormat> Choose from:

MLOG - Log magnitude

MLIN - Linear magnitude
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<units> For unratioed MLOG measurements, choose from:

DBM  Units are displayed in dBm.  0 dBm = 0.001 watt

DBMV Units are displayed in dBmV.  0 dBmV = 0.001 volt

DBMA Units are displayed in dBmA. 0 dBmA = 0.001 Ampere

For unratioed MLIN measurements, choose from:

W -Units are displayed in  Watts
V -Units are displayed in Volts
A -Units are displayed in Amperes

Examples CALC:FORM MLOG, DBM
calculate2:format mlog,dbmv

Query Syntax CALCulate<cnum>:FORMat:UNIT? <dataFormat>

Return Type Character

Default MLOG, DBM
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Calculate:FSimulator Commands

Specifies settings and fixturing for Balanced Measurements.

CALCulate:FSIMulator

BALun  More commands

EMBed  More commands

GLOop More commands

SENDed  More commands

SNP:EXTRapolate

STATe

Click a keyword to view the command details.

See Also

Example Programs

SCPI Command Tree

CALCulate<cnum>:FSIMulator:SNP:EXTRapolate <bool>

Applicable Models: All

(Read-Write)  Turns ON and OFF SNP file extrapolation for both 2-port and 4-port embedding/de-

embedding. Learn more.

Note:  This command affects ALL measurements on the specified channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<bool> Choose from:

ON or 1 - Turns Extrapolation ON

OFF or 0 - Turns Extrapolation OFF
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Examples CALC:FSIM:SNP:EXTR 1
calculate2:fsimulator:snp:extrapolate 0

Query Syntax CALCulate<cnum>:FSIMulator:SNP:EXTRapolate?

Return Type Boolean

Default OFF

CALCulate<cnum>:FSIMulator:STATe <bool>

Applicable Models: All

(Read-Write)  Turns all three fixturing functions (de-embedding, port matching, impedance

conversion) ON or OFF for all ports on the specified channel. Does not affect port extensions.

Note:  This command affects ALL measurements on the specified channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<bool> Choose from:

ON or 1 - Turns Fixturing ON

OFF or 0 - Turns Fixturing OFF

Examples CALC:FSIM:STAT 1
calculate2:fsimulator:state 0

Query Syntax CALCulate<cnum>:FSIMulator:STATe?

Return Type Boolean

Default OFF

CALCulate<cnum>:DTOPology <device>, <topology>

Applicable Models: E5080A, M9485A
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(Write-only) Defines the device type and the topology for a balanced measurement.

This command will replace the following commands:

CALC:FSIM:BAL:TOP:SBAL[:PPOR]

CALC:FSIM:BAL:TOP:SSB[:PPOR]

CALC:FSIM:BAL:TOP:BBAL[:PPOR]

CALC:FSIM:BAL:TOP:BALS[:PPOR]

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<device> (String) Device type for the balanced measurement. ‘B’ means the Balanced port; ‘S’ means the Single-
ended port. Choose from:

B – 1 port balanced device (2 ports)

BB – Balanced - Balanced device (4 ports)

BS – Balanced - Single-ended device (3 ports)

SB – Single-ended - Balanced device (3 ports)

SSB – Single-ended - Single-ended - Balanced device (4 ports)

<topology> (Int array) Physical port numbers mapped to the logical ports, separated by ‘,’.

‘B’ (Balanced) requires 2 physical port numbers: <nPos>, <nNeg>.

‘S’ (Single-ended) requires 1 physical port number.

Examples CALC:DTOP "SB", 2, 1, 4

calculate:dtopology "SB", 2, 1, 4

Query

Syntax

CALCulate<cnum>:DTOPology <device>, <topology>?

Return Type Not Applicable

Default Not Applicable
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Calculate:Function Commands

These commands are Superseded by the CALCulate:MEASure:FUNCtion commands.

 

Click on a keyword to view the command details.

See Also

Example Programs

Learn about Trace Statistics

Synchronizing the Analyzer and Controller

SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

CALCulate<cnum>:FUNCtion:DATA?
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the trace statistic data for the selected statistic type for the specified channel.

Select the type of statistic with CALC:FUNC:TYPE.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on

that channel. If unspecified, <cnum> is set to 1.

Return Type Depends on FORM:DATA

Example
CALCulate2:FUNCtion:DATA?

Default Not applicable

CALCulate<cnum>:FUNCtion:DOMain:USER[:RANGe] <range>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the range used to calculate trace statistics. Each channel has 16 user ranges. The x-

axis range is specified with the CALC:FUNC:DOM:USER:START and STOP commands.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<range> Range number. Choose from: 0 to 16

0 is Full Span of the current x-axis range

1 to 16 are user-specified ranges

Examples CALC:FUNC:DOM:USER 4
calculate2:function:domain:user:range 0

Query Syntax CALCulate<cnum>:FUNCtion:DOMain:USER[:RANGe]?

Return Type Numeric

Default 0 - Full Span

CALCulate<cnum>:FUNCtion:DOMain:USER:STARt <range>, <start>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the start of the specified user-domain range.

To apply this range, use CALC:FUNC:DOM:USER

To set the stop of the range, use CALC:FUNC:DOM:USER:STOP.

See Critical Note

Note: This command does the same as CALC:MARK:FUNC:DOM:USER:STAR

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<range> Range number that will receive the start value. Choose an integer between 1

and 16

<start> Start value of the specified range. Choose a real number between:

the analyzer's Minimum and Maximum x-axis value.

Examples CALC:FUNC:DOM:USER:STAR 1,1e9
calculate2:function:domain:user:start 2,2e9

Query Syntax CALCulate<cnum>:FUNCtion:DOMain:USER:STARt? <range>

Return Type Numeric

Default The analyzer's Minimum x-axis value

CALCulate<cnum>:FUNCtion:DOMain:USER:STOP <range>, <stop>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the stop value of the specified user-domain range.

To apply this range, use CALC:FUNC:DOM:USER.

To set the start of the range, use CALC:FUNC:DOM:USER:START

See Critical Note

Note: This command does the same as CALC:MARK:FUNC:DOM:USER:STOP

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.
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<range> Range number that will receive the stop value. Choose an integer between 1

and 16

<stop> Stop value of the specified range. Choose a real number between:

the analyzer's Minimum and Maximum x-axis value.

Examples CALC:FUNC:DOM:USER:STOP 4,5e9
calculate2:function:domain:user:stop 3,8e9

Query Syntax CALCulate<cnum>:FUNCtion:DOMain:USER:STOP? <range>

Return Type Numeric

Default The analyzer's Maximum x-axis value

CALCulate<cnum>:FUNCtion:EXECute

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) For the active trace of specified channel, executes the statistical analysis specified by the

CALC:FUNC:TYPE command.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

Examples CALC:FUNC:EXEC
calculate2:function:execute

Query Syntax Not Applicable

Default Not Applicable

CALCulate<cnum>:FUNCtion:STATistics[:STATe] <ON|OFF>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Displays and hides the trace statistics (peak-to-peak, mean, standard deviation) on the

screen.

The analyzer will display either measurement statistics or Filter Bandwidth statistics; not both.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<ON|OFF> ON - Displays trace statistics

OFF - Hides trace statistics

Examples CALC:FUNC:STAT ON
calculate2:function:statistics:state off

Query Syntax CALCulate<cnum>:FUNCtion:STATistics[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF (0)

CALCulate<cnum>:FUNCtion:TYPE <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets statistic TYPE that you can then query using CALC:FUNCtion:DATA?.

Note: This command affects only the selected measurement on the specified channel.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<char> Choose from:

PTPeak - the difference between the max and min data points on the trace.

STDEV - standard deviation of all data points on the trace

MEAN - mean (average) of all data points on the trace

MIN - lowest data point on the trace
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MAX - highest data point on the trace

Examples CALC:FUNC:TYPE PTP
calculate2:function:type stdev

Query Syntax CALCulate<cnum>:FUNCtion:TYPE?

Return Type Character

Default PTPeak
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Calc:GCData Commands

Reads Gain Compression data from the current Gain Compression acquisition.

These commands are Superseded by the CALCulate:MEASure:GCData commands.

CALCulate:GCData:

DATA?

IMAG?

ITERations?

REAL?

Click on a keyword to view the command details.

Other Gain Compression commands

The calibration commands listed in this topic are supplemental to the Guided Cal commands.

CALC:CUSTom:DEFine - creates a gain compression measurement.

SENS:GCSetup  - Most Gain Compression settings.

CALC:GCMeas:ANAL - Gain Compression Analysis settings

Gain compression data can also be saved to a *.csv file. Learn how.

See Also

Example Programs

Learn about Gain Compression Application

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<ch>:GCData:DATA? <param>

Applicable Models: N522xB, N524xB, M9485A

(Read-Only) Returns measurement data at all frequency and power data points for GCA SMART

sweeps and 2D sweeps.
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When using SMART sweep, ALL data is returned including ALL background iteration sweeps. Use
CALC:GCD:ITER to determine the number of iteration sweeps. The number of data points that are returned
is always going to be number of frequency points times the number of iteration sweeps.

When using 2D sweeps, ALL data is returned. The number of data points returned / freq may vary. Learn
more.

Use Calc:Data? to return just the displayed data results (not the background sweeps).

A compression parameter must be present. Learn more.

The format of the data is the same as the format of the measurement that you select using

Calc:Par:Select. If the measurement is scalar, than one number is returned per sweep per data point. If

complex (such as Smith Chart format) than both real and imaginary numbers are returned.

If correction is on, corrected data are returned. Otherwise, raw data are returned.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1

<param> (String) Parameter to read. NOT Case-sensitive. The specified parameter need

NOT be displayed or selected.  However, a compression parameter must be

present. Learn more.

Choose from:

"pin"  - (CompIn21) Input power at the compression point.

"pout" - (CompOut21) Output power at the compression point.

"gain" - (CompGain21) Device gain (S21) at the compression point.

"inputmatch" - (CompS11) Input match at the compression point.

"DeltaGain" - (DeltaGain21) Measured Gain (watts) / Ref Gain (watts). Learn
more.

"AI1" and "AI2" - ADC measurements at the specified compression level. Learn
more.

Learn more about GCA parameters.

Examples data = CALC:GCD:DATA? "pin"

data = calculate:gcdata:data? "pout"

Return Type Array of data

Default Not Applicable
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CALCulate<ch>:GCData:IMAG? <char>, <dpoint>, <param>

Applicable Models: N522xB, N524xB, M9485A

(Read-Only) For a specified data point, returns the imaginary part of the specified Gain Compression

data. If correction is on, corrected data are returned. Otherwise, raw data are returned. Can be used

with Smart and 2D sweeps.

For SMART sweep, the number of data points that are returned is always going to be the number of
iteration sweeps. Use CALC:GCD:ITER to determine the number of iteration sweeps.

For 2D sweeps, the number of data points returned / freq may vary. Learn more.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1

<char> Choose from:

FREQuency - for the specified frequency data point, returns all of the measured
data for each power stimulus.

POWer - for the specified power data point, returns all of the measured data for
each frequency stimulus.

<dPoint> Data point (FREQ or POWer) for which data is returned.

<param> (String) Parameter to read. NOT Case-sensitive. The specified parameter need

NOT be displayed. However, a compression parameter must be present. Learn
more.

"pin"  - (CompIn21) Input power at the compression point.

"pout" - (CompOut21) Output power at the compression point.

"gain" - (CompGain21) Device gain (S21) at the compression point.

"inputmatch" - (CompS11) Input match at the compression point.

"DeltaGain" - (DeltaGain21) Measured Gain (watts) / Ref Gain (watts). Learn
more.

"AI1" and "AI2" - ADC measurements at the specified compression level. Learn
more.

Examples For the fifth frequency data point, returns 'Power Output' imaginary (phase)
data from all power stimulus values.

For SmartSweep, if there are 30 power sweep points, 30 values are returned.

For 2D sweeps, 30 or 31 power sweep points may be returned. Learn more.
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data = CALC:GCD:IMAG? FREQ,5,"pout"

Return Type Array of data

Default Not Applicable

CALCulate<cnum>:GCData:ITERations?

Applicable Models: N522xB, N524xB, M9485A

(Read-only) In a SMART sweep, returns the max number of iterations that it took for ALL

frequencies to converge. Use this number to determine the size of the block data that is returned from

Gain Compression SMART sweep data queries.

For a 2D sweep, returns the number of power points.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

Examples data = CALC:GCD:ITER?

Return Type Numeric

Default Not Applicable

CALCulate<ch>:GCData:REAL? <char>, <dpoint>, <param>

Applicable Models: N522xB, N524xB, M9485A

(Read-Only) For a specified data point, returns the real part of the Gain Compression data. If

correction is on, corrected data are returned. Otherwise, raw data are returned.  Can be used with

Smart and 2D sweeps.

For SMART sweep, the number of data points that are returned is always going to be the number of
iteration sweeps. Use CALC:GCD:ITER to determine the number of iteration sweeps.

For 2D sweeps, the number of data points returned / freq may vary. Learn more.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1

<char> Choose from:

FREQuency - for the specified frequency data point, returns all of the measured
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data for each power stimulus.

POWer - for the specified power data point, returns all of the measured data for
each frequency stimulus.

<dPoint> Data point (FREQ or POWer) for which data is returned.

<param> (String) Parameter to read. NOT Case-sensitive. The specified parameter need

NOT be displayed. However, a compression parameter must be present. Learn
more.

"pin"  - (CompIn21) Input power at the compression point.

"pout" - (CompOut21) Output power at the compression point.

"gain" - (CompGain21) Device gain (S21) at the compression point.

"inputmatch" - (CompS11) Input match at the compression point.

"DeltaGain" - (DeltaGain21) Measured Gain (watts) / Ref Gain (watts). Learn
more.

"AI1" and "AI2" - ADC measurements at the specified compression level. Learn
more.

Examples For the fifth frequency data point, returns 'Power Output' real data from all

power stimulus values.

For SmartSweep, if there are 30 power sweep points, 30 values are returned.

For 2D sweeps, 30 or 31 power sweep points may be returned. Learn more.

data = CALC:GCD:REAL? FREQ,5,"pout"

Return Type Array of data

Default Not Applicable
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Gain Compression Analysis Commands

Sets and reads Gain Compression Analysis controls.

These commands are Superseded by the CALCulate:MEASure:GCMeas commands.

CALCulate:GCMeas:ANALysis

CWFRequency

ENABle

ISDisfreq

XAXis

Click on a keyword to view the command details.

Other Gain Compression commands

The calibration commands listed in this topic are supplemental to the Guided Cal commands.

CALC:CUSTom:DEFine - creates a gain compression measurement.

SENS:GCSetup  - Most Gain Compression settings.

GC:DATA - Gain Compression data commands

Gain compression data can also be saved to a *.csv file. Learn how.

See Also

Example Programs

Learn about Compression Analysis

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<cnum>:GCMeas:ANALysis:ENABle <bool>
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Applicable Models: N522xB, N524xB, M9485A

(Read-Write)  Enables and disables a compression analysis trace.

Parameters  

<cnum> Channel number of the GCA measurement. There must be a selected

measurement on that channel using Calc:Par:Sel. If unspecified, <cnum> is set

to 1.

<bool> ON (or 1) - Enable compression analysis.

OFF (or 0) - Disable compression analysis.

Examples CALC:GCM:ANAL:ENAB ON
calculate2:gcmeas:analysis:enable off

Query Syntax CALCulate<cnum>:GCMeas:ANALysis:ENABle?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:GCMeas:ANALysis:CWFRequency <num>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write)  Set and return the CW frequency for a compression analysis trace.

Parameters  

<cnum> Channel number of the GCA measurement. There must be a selected

measurement on that channel using Calc:Par:Sel. If unspecified, <cnum> is set

to 1.

<num> CW frequency in Hz. Choose a frequency within the range of the gain

compression channel.

Examples CALC:GCM:ANAL:CWFR 1e9
calculate2:gcmeas:analysis:cwfrequency 1e10

Query Syntax CALCulate<cnum>:GCMeas:ANALysis:CWFRequency?

Return Type Numeric

Default Not Applicable

CALCulate<cnum>:GCMeas:ANALysis:DISCrete | ISD[:STATe] <bool>
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Applicable Models: N522xB, N524xB, M9485A

(Read-Write)  Sets and returns whether the CW frequency for the compression analysis trace can be

set to only the discrete frequencies or provides interpolation.

Parameters  

<cnum> Channel number of the GCA measurement. There must be a selected

measurement on that channel using Calc:Par:Sel. If unspecified, <cnum> is set

to 1.

<bool> ON (or 1) - Discrete data points only.

OFF (or 0) - Interpolated data points.

Examples CALC:GCM:ANAL:ISD ON
calculate2:gcmeas:analysis:isdisfrequency off

Query Syntax CALCulate<cnum>:GCMeas:ANALysis:ISDisfrequency?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:GCMeas:ANALysis:XAXis <char>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write)  Sets and returns the type of data to display on the x-axis of a compression analysis

trace.

Parameters  

<cnum> Channel number of the GCA measurement. There must be a selected

measurement on that channel using Calc:Par:Sel. If unspecified, <cnum> is set

to 1.

<bool> Data to display on X-axis. Choose from:

PIN - Input power to the DUT.

PSOurce - power from the source.

Examples CALC:GCM:ANAL:XAX PIN
calculate2:gcmeas:analysis:xaxis psource

Query Syntax CALCulate<cnum>:GCMeas:ANALysis:XAXis?

Return Type Character

Default PIN
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Group Delay Aperture Commands

Controls the Aperture setting used to make Group Delay measurements.

These commands are Superseded by the CALCulate:MEASure:GDELay commands.

CALCulate:GDELay

FREQuency

PERCent

POINts

Click on a keyword to view the command details.

See Also

Learn about Group Delay Aperture

Example Programs

Synchronizing the Analyzer and Controller

SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

CALCulate<cnum>:GDELay:FREQuency <value>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets group delay aperture using a fixed frequency range.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement
on that channel. If unspecified, <cnum> is set to 1.

<value> Frequency range (in Hz) to use for the aperture setting. Choose between the

equivalent of two data points and the channel frequency span.

Examples CALC:GDEL:FREQ 1E6

Query Syntax CALCulate<cnum>:GDELay:FREQuency?
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Return Type Numeric

Default Frequency range that equates to 11 points. This can be changed to two points

with a preference setting.

CALCulate<cnum>:GDELay:PERCent <value>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets group delay aperture using a percent of the channel frequency span.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<value> Percent of frequency span to use for the aperture setting. Choose between the

equivalent of two data points and 100 percent of the channel frequency span.

Examples 'set to 25 percent of the channel frequency span

CALC:GDEL:PERC 25

Query Syntax CALCulate<cnum>:GDELay:PERCent?

Return Type Numeric

Default Percent of frequency span that equates to 11 points. This can be changed to two

points with a preference setting.

CALCulate<cnum>:GDELay:POINts <value>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets group delay aperture using a fixed number of data points.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<value> Number of data points to  use for the aperture setting. Choose between two

points and the number of points in the channel.

Examples 'set to 25 data points

CALC:GDEL:POIN 25

Query Syntax CALCulate<cnum>:GDELay:POINts?

Return Type Numeric

Default 11 points. This can be changed to two points with a preference setting.
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Calc:Limit Commands

Controls the limit segments used for pass / fail testing.

These commands are Superseded by the CALCulate:MEASure:LIMit commands.

CALCulate:LIMit:

DATA

       | DELete

DISPlay

       | [STATe]

FAIL?

REPort

       | ALL?

       | DATA?

       | POINts?

SEGMent

       | AMPLitude

            | STARt

            | STOP

       | COUNt?

       | STIMulus

            | STARt

            | STOP

       | TYPE

SOUNd

       | [STATe]

[STATe]

Click on a keyword to view the command details.
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See Also

Example Programs

Learn about Limit Lines

Synchronizing the Analyzer and Controller

SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

CALCulate<cnum>:LIMit:DATA <block>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets data for limit segments.

See Critical Note

Parameters  

<cnum> Channel number of the measurement for which limit lines are to be set. There

must be a selected measurement on that channel. If unspecified, <cnum> is set

to 1.

<block> Data for all limit segments in REAL,64 format. The following is the data

format for 1 segment:

Type,BegStim, EndStim, BegResp,EndResp

Type Type of limit segment. Choose from

0 - Off

1 - Max

2 - Min

BegStim Start of X-axis value (freq, power, time)

EndStim End of X-axis value

BegResp Y-axis value that corresponds with Start of X-axis value

EndResp Y-axis value that corresponds with End of X-axis value

Examples The following writes three max limit segments for a bandpass filter.

CALC:LIM:DATA 1,3e5,4e9,-60,0,1,4e9,7.5e9,0,0,1,7.5e9,9e9,0,-30

Query Syntax CALCulate<cnum>:LIMit:DATA?
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Return Type Depends on FORM:DATA - All 100 predefined limit segments are returned.

Default 100 limit segments - all values set to 0

CALCulate<cnum>:LIMit:DATA:DELete

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Deletes all limit line data for the selected measurement on the specified channel.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

Examples CALC2:LIM:DATA:DEL

Query Syntax Not Applicable

Default Not Applicable

CALCulate<cnum>:LIMit:DISPlay[:STATe] <ON | OFF>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns the display of limit segments ON or OFF (if the data trace is turned ON).

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<ON | OFF> ON (or 1) - turns the display of limit segments ON.

OFF (or 0) - turns the display of limit segments OFF.

Examples CALC:LIM:DISP:STAT ON
calculate2:limit:display:state off

Query Syntax CALCulate<cnum>:LIMit:DISPlay[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

CALCulate<cnum>:LIMit:FAIL?
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the Pass / Fail status of the limit line test. Returns 1 (Fail) if any data point fails

for any limit segment.

Limit display (CALC:LIM:DISP) does NOT have to be ON.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

Examples CALC:LIM:FAIL?

Return Type Boolean

0 is returned when Pass

1 is returned when Fail

Default Not Applicable

CALCulate<cnum>:LIMit:REPort:ALL? <block>

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Reads the bandwidth test results (stimulus value, limit test result, upper limit value and

lower limit value of all measurement points), for the active trace of selected channel.

See Critical Note
Parameters  

<cnum> Channel number of the measurement. There must be a selected

measurement on that channel. If unspecified, <cnum> is set to 1.

<block> Depends on FORM:DATA

If the number of the measurement points is N,

<Block> = <first stimulus>,<test result>,<upper limit>,<lower limit>, …, <Nth
stimulus>,<test result>,<upper limit>,<lower limit>

Where <test result>=   -1: No limit, 0:Fail, 1:Pass

Examples CALC:LIM:REP:ALL?

Return Type Variant

Default Depend on the preset status
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CALCulate<cnum>:LIMit:REPort[:DATA]? <block>

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Reads the stimulus values (frequency, power level or time) at all the measurement points

that failed the limit test, for the active trace of selected channel.

See Critical Note
Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<block> Depends on FORM:DATA

If the number of the measurement points that failed the limit test is N, <block>=<First

failed stimulus>, ..., <Nth failed stimulus>.

Examples CALC:LIM:REP:DATA?

Return Type Numeric
Default 9.91E37

CALCulate<cnum>:LIMit:REPort:POINts?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Reads the number of the measurement points that failed the limit test, for the active trace

of selected channel.

See Critical Note
Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

Examples CALC:LIM:REP:POIN?

Query
Syntax

Numeric

Default 0

CALCulate<cnum>:LIMit:SEGMent<snum>:AMPLitude:STARt <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the start (beginning) of the Y-axis amplitude (response) value.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<snum> Segment number; if unspecified, value is set to 1.

<num> Choose any number between: -500 and 500

Display value is limited to the Maximum and Minimum displayed Y-axis

values.

Examples CALC:LIM:SEGM1:AMPL:STAR 10
calculate2:limit:segment2:amplitude:start 10

Query Syntax CALCulate<cnum>:LIMit:SEGMent<snum>AMPLitude:STARt?

Return Type Numeric

Default 0

CALCulate<cnum>:LIMit:SEGMent<snum>:AMPLitude:STOP <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the stop (end) of the Y-axis amplitude (response) value.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<snum> Segment number; if unspecified, value is set to 1.

<num> Choose any number between: -500 and 500

Display value is limited to the Maximum and Minimum displayed Y-axis

values.

Examples CALC:LIM:SEGM1:AMPL:STOP 10
calculate2:limit:segment2:amplitude:stop 10

Query Syntax CALCulate<cnum>:LIMit:SEGMent<snum>AMPLitude:STOP?
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Return Type Numeric

Default 0

CALCulate<cnum>:LIMit:SEGMent:COUNt?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the number of segments used in a limit test. All segments are counted, whether

they are on or not.

Parameters Not Applicable

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

Examples CALC:LIM:SEGM:COUN?

Return Type Numeric

Default Not Applicable

CALCulate<cnum>:LIMit:SEGMent<snum>:STIMulus:STARt <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the start (beginning) of the X-axis stimulus value.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<snum> Segment number; if unspecified, value is set to 1.

<num> Choose any number within the X-axis span of the analyzer.

Examples CALC:LIM:SEGM1:STIM:STAR 10
calculate2:limit:segment2:stimulus:start 10

Query Syntax CALCulate<cnum>:LIMit:SEGMent<snum>STIMulus:STARt?

Return Type Numeric

Default 0

CALCulate<cnum>:LIMit:SEGMent<snum>:STIMulus:STOP <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the stop (end) of the X-axis stimulus value.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<snum> Segment number; if unspecified, value is set to 1.

<num> Choose any number within the X-axis span of the analyzer.

Examples CALC:LIM:SEGM1:AMPL:STOP 10
calculate2:limit:segment2:stimulus:stop 10

Query Syntax CALCulate<cnum>:LIMit:SEGMent<snum>STIMulus:STOP?

Return Type Numeric

Default 0

CALCulate<cnum>:LIMit:SEGMent<snum>:TYPE <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the type of limit segment.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<snum> Segment number. Choose any number between:

1 and 100
If unspecified, value is set to 1.

<char> Choose from:

LMAX - a MAX limit segment. Any response data exceeding the MAX value

will fail.

LMIN - a MIN limit segment. Any response data below the MIN value will

fail.

OFF - the limit segment (display and testing) is turned OFF.

652



Examples CALC:LIM:SEGM:TYPE LMIN
calculate2:limit:segment3:type lmax

Query Syntax CALCulate<cnum>:LIMit:SEGMent<snum>:TYPE?

Return Type Character

Default OFF

CALCulate<cnum>:LIMit:SOUNd[:STATe] <ON | OFF>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns limit testing fail sound ON or OFF.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<ON | OFF> ON (or 1) - turns sound ON.

OFF (or 0) - turns sound OFF.

Examples CALC:LIM:SOUN ON
calculate2:limit:sound:state off

Query Syntax CALCulate<cnum>:LIMit:SOUNd[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:LIMit[:STATe] <ON | OFF>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns limit segment testing ON or OFF.

Use CALC:LIM:DISP to turn ON and OFF the display of limit segments.

If using Global Pass/Fail status, trigger the VNA AFTER turning Limit testing ON.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<ON | OFF> ON (or 1) - turns limit testing ON.

OFF (or 0) - turns limit testing OFF.

Examples CALC:LIM:STAT ON
calculate2:limit:state off

Query Syntax CALCulate<cnum>:LIMit:STATe?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF
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Calculate:Marker Commands

Controls the marker settings used to remotely output specific data to the computer.

These commands are Superseded by the CALCulate:MEASure:MARKer commands.

 

CALCulate:MARKer:

AOFF

BUCKet

BWIDth

COMPression

       | LEVel

       | PIN?

       | POUT?

COUPling

       | METHod

       | [STATe]

DELTa

DISCrete

DISTance

FORMat

FUNCtion

       | APEak

            | EXCursion

            | THReshold

       | DOMain

            | USER
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                 | STARt

                 | STOP

       | EXECute

       | [SELect]

       | TRACking

PNOP more commands

PSATuration more commands

REFerence

       | [STATe]

       | X

       | Y?

SET

[STATe]

TARGet

TYPE

X

Y?

Click on a keyword to view the command details.

See Also

Marker example program

Marker Readout number and size commands.

Learn about Markers

Synchronizing the Analyzer and Controller

SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.
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Important: Learn about programming the reference marker.

CALCulate<cnum>:MARKer:AOFF

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Turns all markers off for selected measurement.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

Examples CALC:MARK:AOFF
calculate2:marker:aoff

Query Syntax Not applicable

Default Not applicable

CALCulate<cnum>:MARKer<n>:BUCKet <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and reads the data point (bucket) number of the trace on which the marker resides.

When the markers are interpolated (non-discrete), the returned value is the nearest marker bucket

position.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<n> Marker number to move or query. The marker must already exist. If

unspecified, <n> is set to 1.

<num> Data point (bucket) number. Choose any data point between: 0 and the number

of data points minus 1.

Examples CALC:MARK:BUCK 5

calculate2:marker2:bucket 200

Query Syntax CALCulate<cnum>:MARKer<n>:BUCKet?

Return Type Integer
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Default The first marker is set to the middle of the span. Subsequent markers are set to

the bucket number of the previously active marker.

CALCulate<cnum>:MARKer:BWIDth <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns on and sets markers 1 through 4 to calculate filter bandwidth. The <num>

parameter sets the value below the maximum bandwidth peak that establishes the bandwidth of a

filter. For example, if you want to determine the filter bandwidth 3 db below the bandpass peak value,

set <num> to -3.

To turn off the Bandwidth markers, either turn them off individually or turn them All Off.

The analyzer screen will show either Bandwidth statistics OR Trace statistics; not both.

To search a User Range with the bandwidth search, first activate marker 1 and set the desired User
Range. Then send the CALC:MARK:BWID command. The user range used with bandwidth search

only applies to marker 1 searching for the max value. The other markers may fall outside the user

range.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Target value below filter peak. Choose any number between :-500 and 500

Examples CALC:MARK:BWID -3
calculate2:marker:bwidth -2.513

Query Syntax CALCulate<cnum>:MARKer:BWIDth?
Returns the results of bandwith search:

Return Type Numeric - Four Character values separated by commas: bandwidth, center
Frequency, Q, loss.

Default -3

CALCulate<cnum>:MARKer<mkr>:COMPression:LEVel <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Set and read the marker compression level. A compression marker must already exist.

Use CALC:MARK ON and CALC:MARK:FUNC COMP to create compression markers.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any existing marker number from 1 to 10; if unspecified, value is set to 1.

<num> Compression level. Choose any number between: -500 dB to 500 dB

Standard gain compression values are positive.

Examples CALC:MARK:COMP:LEV 1
calculate2:marker:compression:level 1.5

Query Syntax CALCulate<cnum>:MARKer:COMPression:LEVel?

Return Type Numeric

Default +1

CALCulate<cnum>:MARKer<mkr>:COMPression:PIN?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only)  Reads the input power at the marker compression level. First send

CALC:MARK:FUNC:EXEC COMP or CALC:MARK:FUNC:TRAC ON

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any existing marker number from 1 to 10; if unspecified, value is set to 1.

Examples CALC:MARK:COMP:PIN?
calculate2:marker:compression:pin?

Return Type Numeric

Default Not applicable

CALCulate<cnum>:MARKer<mkr>:COMPression:POUT?

659



Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only)  Reads the output power at the marker compression level. First send

CALC:MARK:FUNC:EXEC COMP or CALC:MARK:FUNC:TRAC ON

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any existing marker number from 1 to 10; if unspecified, value is set to 1.

Examples CALC:MARK:COMP:POUT?
calculate2:marker2:compression:pout?

Return Type Numeric

Default Not applicable

CALCulate<cnum>:MARKer<mkr>:COUPling:METHod <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and reads the scope of Coupled Markers. This is a global setting that affects all

markers. Learn more.

Note: This command will not take effect until Coupled Markers is turned on using

CALC:MARK:COUP:STATe ON.

Note: The preset behavior of Coupled Markers depends on the setting of

SYSTem:PREFerences:ITEM:MCControl, SYSTem:PREFerences:ITEM:MCMethod, and

SYSTem:PREFerences:ITEM:MCPRest.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any existing marker number from 1 to 10; if unspecified, value is set to 1.

<char> CHANnel - Coupling is limited to traces in the same channel.

ALL - Coupling occurs across all channels.

Examples CALC:MARK:COUP:METH CHAN

calculate1:marker1:coupling all

Query Syntax CALCulate:MARKer:COUPling:METHod?
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Return Type Character

Default ALL

CALCulate<cnum>:MARKer<mkr>:COUPling[:STATe]<ON|OFF>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and reads the state of Coupled Markers (ON and OFF). The scope of coupled

markers can be changed with CALC:MARK:COUP:METH.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any existing marker number from 1 to 10; if unspecified, value is set to 1.

<ON|OFF> OFF (0) - Turns Coupled Markers OFF

ON (1) - Turns Coupled Markers ON

Examples CALC:MARK:COUP ON
calculate1:marker1:coupling off

Query Syntax CALCulate:MARKer:COUPling:[STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:MARKer<mkr>:DELTa <ON|OFF>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Specifies whether marker is relative to the Reference marker or absolute.

Note: The reference marker must already be turned ON with CALC:MARK:REF:STATE.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any existing marker number from 1 to 10; if unspecified, value is set to 1.

<ON|OFF> ON (or 1) - Specified marker is a Delta marker

OFF (or 0) - Specified marker is an ABSOLUTE marker

Examples CALC:MARK:DELT ON

calculate2:marker8:delta off

Query Syntax CALCulate<cnum>:MARKer<mkr>:DELTa?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:MARKer<mkr>:DISCrete <ON|OFF>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Makes the specified marker display either a calculated value between data points

(interpolated data) or the actual data points (discrete data).

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any existing marker number from 1 to 10; if unspecified, value is set to 1.

<ON|OFF> ON (or 1) - Specified marker displays the actual data points
OFF (or 0) - Specified marker displays calculated data between the actual data

points.

Examples CALC:MARK:DISC ON
calculate2:marker8:discrete off
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Query Syntax CALCulate<cnum>:MARKer<mkr>:DISCrete?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:MARKer<mkr>:DISTance <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Set or query marker distance on a time domain trace.

The Write command moves the marker to the specified distance value. Once moved, you can read the
Y axis value or read the X-axis time value. (Distance is calculated from the X-axis time value.)

The Read command reads the distance of the marker.

If the marker is set as delta, the WRITE and READ data is relative to the reference marker.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any existing marker number from 1 to 10; if unspecified, value is set to 1.

<num> Marker distance in the unit of measure specified with
CALC:TRAN:TIME:MARK:UNIT

Examples CALC:MARK:DIST .1
calculate2:marker8:distance 5

Query Syntax CALCulate<cnum>:MARKer<mkr>:DISTance?

Return Type Numeric

Default Not Applicable

CALCulate<cnum>:MARKer<mkr>:FORMat <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the format of the data that will be returned in a marker data query

CALC:MARK:Y? and the displayed value of the marker readout. The selection does not have to be

the same as the measurement's display format.

See Critical Note
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Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1

<char> Choose from:

DEFault - The format of the selected measurement

MLINear - Linear magnitude

MLOGarithmic - Logarithmic magnitude

IMPedance - (R+jX)

ADMittance - (G+jB)

PHASe - Phase

IMAGinary - Imaginary part (Im)

REAL - Real part (Re)

POLar - (Re, Im)

GDELay - Group Delay

LINPhase - Linear Magnitude and Phase

LOGPhase - Log Magnitude and Phase

KELVin - temperature

FAHRenheit - temperature

CELSius - - temperature

NOISe - Noise (available ONLY in IM Spectrum measurement class).

Examples CALC:MARK:FORMat MLIN
calculate2:marker8:format Character

Query Syntax CALCulate<cnum>:MARKer<mkr>:FORMat?

Return Type Character

Default DEFault
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CALCulate<cnum>:MARKer<mkr>:FUNCtion:APEak:EXCursion <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets amplitude peak excursion for the specified marker. The Excursion value determines

what is considered a "peak". This command applies to marker peak searches (Next peak, Peak Right,

Peak Left).

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any existing marker number from 1 to 10; if unspecified, value is set to 1.

<num> Excursion value. Choose any number between -500 and 500.

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:MARK:FUNC:APE:EXC 10
calculate2:marker8:function:apeak:excursion maximum

Query Syntax CALCulate<cnum>:MARKer<mkr>:FUNCtion:APEak:EXCursion?

Return Type Numeric

Default 3

CALCulate<cnum>:MARKer<mkr>:FUNCtion:APEak:THReshold <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets peak threshold for the specified marker. If a peak (using the criteria set with

:EXCursion) is below this reference value, it will not be considered when searching for peaks. This

command applies to marker peak searches (Next peak, Peak Right, Peak Left).

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1
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<num> Threshold value.Choose any number between -500 and 500.

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:MARK:FUNC:APE:THR -40
calculate2:marker8:function:apeak:threshold -55

Query Syntax CALCulate<cnum>:MARKer<mkr>:FUNCtion:APEak:THReshold?

Return Type Numeric

Default -100

CALCulate<cnum>:MARKer<mkr>:FUNCtion:DOMain:USER[:RANGe] <range>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Assigns the specified marker to a range number. The x-axis travel of the marker is

constrained to the range's span. The span is specified with the CALC:MARK:FUNC:DOM:USER:START
and STOP commands, unless range 0 is specified which is the full span of the analyzer.

Each channel has 16 user ranges. (Trace statistics use the same ranges.) More than one marker can use

a domain range.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1

<span> User span. Choose any Integer from 0 to 16

0 is Full Span of the analyzer

1 to 16 are available for user-defined x-axis span

Examples CALC:MARK:FUNC:DOM:USER 1
calculate2:marker8:function:domain:user:range 1

Query Syntax CALCulate<cnum>:MARKer<mkr>:FUNCtion:DOMain:USER[:RANGe]?

Returns the user span number that the specified marker is assigned to.

Return Type Numeric

Default 0 - Full Span
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CALCulate<cnum>:MARKer<mkr>:FUNCtion:DOMain:USER:STARt <start>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the start of the span that the specified marker's x-axis span will be constrained to.

Use CALC:MARK:FUNC:DOM:USER<range> to set range number

Use CALC:MARK:FUNC:DOM:USER:STOP to set the stop value.

Note: If the marker is assigned to range 0 (full span), the USER:STARt and STOP commands

generate an error. You cannot set the STARt and STOP values for "Full Span".

Note: This command does the same as CALC:FUNC:DOM:USER:STAR

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1

<start> The analyzer's Minimum x-axis value

Examples CALC:MARK:FUNC:DOM:USER:START 500E6
calculate2:marker8:function:domain:user:start 1e12

Query Syntax CALCulate<cnum>:MARKer<mkr>:FUNCtion:DOMain:USER:STARt?

Return Type Numeric

Default The analyzer's Minimum x-axis value

CALCulate<cnum>:MARKer<mkr>:FUNCtion:DOMain:USER:STOP <stop>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the stop of the span that the marker's x-axis travel will be constrained to.

Use CALC:MARK:FUNC:DOM:USER<range> to set range number

Use CALC:MARK:FUNC:DOM:USER:STARt to set the stop value.

Note: If the marker is assigned to range 0 (full span), the USER:STARt and STOP commands

generate an error. You cannot set the STARt and STOP values for "Full Span".

Note: This command does the same as CALC:FUNC:DOM:USER:STOP

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<stop> Stop value of x-axis span; Choose any number between the analyzer's MINimum and

MAXimum x-axis value.

Examples CALC:MARK:FUNC:DOM:USER:STOP 500e6
calculate2:marker8:function:domain1:user:stop 1e12

Query

Syntax

CALCulate<cnum>:MARKer<mkr>:FUNCtion:DOMain:USER:STOP?

Return Type Numeric

Default The analyzer's MAXimum x-axis value.

CALCulate<cnum>:MARKer<mkr>:FUNCtion:EXECute <func>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Immediately executes (performs) the specified search function.

Learn more about Marker Search

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<func> The function to be performed. Choose from:

MAXimum - finds the highest value

MINimum - finds the lowest value

RPEak - finds the next valid peak to the right

LPEak - finds the next valid peak to the left

NPEak - finds the next highest value among the valid peaks

TARGet - finds the target value to the right, wraps around to the left

LTARget - finds the next target value to the left of the marker

RTARget - finds the next target value to the right of the marker

COMPression - finds the compression level on a Power Swept S21 trace.

Examples CALC:MARK:FUNC:EXEC MAX
calculate2:marker2:function:execute maximum

Query Syntax Not applicable

Default Not applicable

CALCulate<cnum>:MARKer<mkr>:FUNCtion[:SELect] <char>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the search function that the specified marker will perform when executed. Use

CALC:MARK:FUNC:TRAC ON to automatically execute the search every sweep.

Learn more about Marker Search

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on

that channel. If unspecified, <cnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<char> Marker function. Choose from:

MAXimum - finds the highest value

MINimum - finds the lowest value

RPEak - finds the next valid peak to the right

LPEak - finds the next valid peak to the left

NPEak - finds the next highest value among the valid peaks

TARGet - finds the target value to the right, wraps around to the left

LTARget - finds the next target value to the left of the marker

RTARget - finds the next target value to the right of the marker

COMPression - finds the compression level on a power-swept S21 trace.

Examples CALC:MARK:FUNC MAX
calculate2:marker8:function:select ltarget

Query Syntax CALCulate<cnum>:MARKer<mkr>:FUNCtion[:SELect]?

Return Type Character

Default MAX

CALCulate<cnum>:MARKer<mkr>:TARGet[:VALue] <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the target value for the specified marker when doing Target Searches with

CALC:MARK:FUNC:SEL <TARGet | RTARget | LTARget>

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<num> Target value to search for; Units are NOT allowed.

Examples CALC:MARK:TARG 2.5
calculate2:marker8:target:value -10.3

Query Syntax CALCulate<cnum>:MARKer<mkr>:TARGet[:VALue]?

Return Type Numeric

Default 0

CALCulate<cnum>:MARKer<mkr>:FUNCtion:TRACking <ON | OFF>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the tracking capability for the specified marker. The tracking function finds the

selected search function every sweep. In effect, turning Tracking ON is the same as doing a

CALC:MARK:FUNC:EXECute command every sweep.

Learn more about Marker Search

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<ON | OFF> ON (or 1) - The specified marker will "Track" (find) the selected function

every sweep.

OFF (or 0) - The specified marker will find the selected function only when

the CALC:MARK:FUNC:EXECute command is sent.
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Examples CALC:MARK:FUNC:TRAC ON
calculate2:marker8:function:tracking off

Query Syntax CALCulate<cnum>:MARKer<mkr>:FUNCtion:TRACking?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:MARKer:REFerence[:STATe] <ON | OFF>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns the reference marker ON or OFF. When turned OFF, existing Delta markers

revert to general-purpose markers.

Important: Learn about programming the reference marker.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<ON | OFF> ON (or 1) - turns reference marker ON

OFF (or 0) - turns reference marker ON

Examples CALC:MARK:REF ON
calculate2:marker:reference:state OFF

Query Syntax CALCulate<cnum>:MARKer:REFerence[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:MARKer:REFerence:X <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the absolute x-axis value of the reference marker.

Important: Learn about programming the reference marker.

See Critical Note

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> X-axis value. Choose any number within the operating domain of the reference

marker.

Examples CALC:MARK:REF:X 1e9

calculate2:marker:reference:x 1e6

Query Syntax CALCulate<cnum>:MARKer:REFerence:X?

Return Type Numeric

Default If the first Marker, turns ON in the middle of the X-axis span. If not, turns ON

at the position of the active marker.

CALCulate<cnum>:MARKer:REFerence:Y?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the absolute Y-axis value of the reference marker.

Important: Learn about programming the reference marker.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

Examples CALC:MARK:REF:Y?

calculate2:marker:reference:y?

Return Type Character

Default Not applicable

CALCulate<cnum>:MARKer<mkr>:SET <char>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Sets the selected instrument setting to assume the value of the specified marker.

Marker Functions CENT, SPAN, STARt, and STOP do not work with channels that are in CW or

Segment Sweep mode.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1

<char> Choose from:

CENTer - changes center frequency to the value of the marker

SPAN -  changes the sweep span to the span that is defined by the delta marker
and the marker that it references. Unavailable if there is no delta marker.

STARt - changes the start frequency to the value of the marker

STOP - changes the stop frequency to the value of the marker

RLEVel - changes the reference level to the value of the marker

DELay - changes the line length at the receiver input to the phase slope at the
active marker stimulus position.

CWFReq - Sets the CW frequency to the frequency of the active marker. Does
NOT change sweep type. NOT available in CW or Power Sweep. Use this
argument to first set the CW Frequency to a value that is known to be within the
current calibrated range, THEN set Sweep:Type to POWer or CW.

Examples CALC:MARK:SET CENT
calculate2:marker8:set span

Query Syntax Not Applicable

Default Not Applicable

CALCulate<cnum>:MARKer<mkr>[:STATe] <ON|OFF>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns the specified marker ON or OFF. To turn all markers off, use

CALC:MARK:AOFF.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<ON|OFF> ON (or 1) - turns marker ON.

OFF (or 0) - turns marker OFF.

Examples CALC:MARK ON
calculate2:marker8 on

Query Syntax CALCulate<cnum>:MARKer<mkr>:STATe?

Return Type Boolean (1 = ON, 0 = OFF)

Default Off

CALCulate<cnum>:MARKer<mkr>:TYPE <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the type of the specified marker.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1

<char> Choose from:

NORMal - a marker that stays on the assigned X-axis position unless moved or
searching.

FIXed - a marker that will not leave the assigned X or current Y-axis position.

Examples CALC:MARK:TYPE NORM
calculate2:marker2:type fixed
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Query Syntax CALCulate<cnum>:MARKer<mkr>:TYPE?

Return Type Character

Default NORMal

CALCulate<cnum>:MARKer<mkr>:X <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the marker's X-axis value (frequency, power, or time). If the marker is set as delta,

the SET and QUERY data is relative to the reference marker.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<num> Any X-axis position within the measurement span of the marker.

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:MARK:X 100Mhz
calculate2:marker8:x maximum

Query Syntax CALCulate<cnum>:MARKer<mkr>:X?

Return Type Numeric

Default First Marker turns ON in the middle of the X-axis span. Subsequent markers

turn ON at the position of the active marker.

CALCulate<cnum>:MARKer<mkr>:Y?
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Reads the marker's Y-axis value. The format of the value depends on the current

CALC:MARKER:FORMAT setting. If the marker is set as delta, the data is relative to the reference

marker. The query always returns two numbers:

Smith and Polar formats - (Real, Imaginary)

LINPhase and LOGPhase - (Real, Imaginary)

All other formats - (Value,0)

Note: To accurately read the marker Y-axis value with trace smoothing applied, the requested format

must match the displayed format. Otherwise, the returned value is un-smoothed data. For example, to

read the smoothed marker value when measuring group delay, both the display format and the marker

format must be set to (Group) Delay.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

Examples CALC:MARK:Y?
calculate2:marker3:y?

Query Syntax CALCulate<cnum>:MARKer<mkr>:Y?

Return Type Numeric

Default Not applicable
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Calculate:Math Commands

Controls math operations on the currently selected measurement and memory.

These commands are Superseded by the CALCulate:MEASure:MATH commands.

 

CALCulate:MATH:

FUNCtion

INTerpolate

MEMorize

 

Click on a keyword to view the command details.

See Also

Example Programs

Learn about Math Operations

Synchronizing the Analyzer and Controller

SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

CALCulate<cnum>:MATH:FUNCtion <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets math operations on the currently selected measurement and the trace stored in

memory. (There MUST be a trace stored in Memory. See CALC:MATH MEM)

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<char> The math operation to be applied. Choose from the following:
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  NORMal Trace data only

  ADD Data + Memory

  SUBTract Data - Memory

  MULTiply Data * Memory

  DIVide Data / Memory

Examples CALC:MATH:FUNC NORM
calculate2:math:function subtract

Query Syntax CALCulate<cnum>:MATH:FUNCtion?

Return Type Character

Default NORMal

CALCulate<cnum>:MATH:INTerpolate <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and reads the state of the memory data interpolation. Learn more.

See Critical Note

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <ch> is set to 1.

<bool> Choose from:

0 - OFF - Turn memory data interpolation OFF.

1 - ON - Turn memory data interpolation ON.

Examples CALC2:MATH:INT 1

Query Syntax CALCulate<ch>:MATH:INTerpolate?

Return Type Boolean

Default 0

CALCulate<cnum>:MATH:MEMorize
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Puts the currently selected measurement trace into memory. (Data-> Memory).

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

Examples CALC:MATH:MEM
calculate2:math:memorize

Query Syntax Not applicable

Default Not applicable
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Measure

These commands are for setting up measurements.

CALCulate:MEASure

BLIMit More
commands

CONVersion

    | FUNCtion

CORRection More
commands

DATA More
commands

DEFine

DELete

    | ALL

EQUation

    | [:STATe]

    | TEXT

    | VALid?

FILTer More
commands

FORMat

    | UNIT

FUNCtion More
commands

GCData More
commands

GCMeas More
commands

GDELay More
commands

HOLD
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    | CLEar

    | [TYPE]

LIMit More
commands

MARKer More
commands

MATH

    | FUNCtion

    |
INTerpolate[:STATe]

    | MEMorize

MIXer

    | XAXis

OFFSet More
commands

PARameter More
commands

RDATa?

RLIMit More
commands

SMOothing More
commands

TRANsform More
commands

X More commands

Click a keyword to view the command details.

See Also

Calibrating with SCPI

Synchronizing the Analyzer and Controller

SCPI Command Tree
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CALCulate<cnum>:MEASure<mnum>:CONVersion:FUNCtion <char>

Applicable Models: All

(Read-Write) Sets or gets the parameter after conversion using the parameter conversion function, for

the active trace of selected channel.

Parameters  

<cnum>
Channel number of the measurement. There must be a selected measurement on

that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<char> Select from the following parameters after conversion:

"OFF"

"ZREFlection" - Specifies the equivalent impedance in reflection measurement.

"ZTRansmit" - Specifies the equivalent impedance (series) in transmission
measurement.

"ZTSHunt" - Specifies the equivalent impedance (shunt) in transmission
measurement.

"YREFlection" - Specifies the equivalent admittance in reflection measurement.

"YTRansmit" - Specifies the equivalent admittance (series) in transmission
measurement.

"YTSHunt" - Specifies the equivalent admittance (shunt) in transmission
measurement.

"INVersion" - Specifies the inverse S-parameter (1/S).

"CONJugation" - Specifies the conjugate.

Examples
CALC:MEAS1:CONV:FUNC ZTSH
calculate2:measure1:conversion:function conjugation

Query Syntax CALCulate<cnum>:MEASure<mnum>:CONVersion:FUNCtion?

Return Type Character

Default "OFF"

CALCulate<cnum>:MEASure<mnum>:DEFine <string>

Applicable Models: All

(Write-only) Creates a measurement but does NOT display it, on an existing or new channel. When a

new channel is created, any licensed measurement class can be used. Up to 580 measurements can be
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created.

Note that each display window can only display a limited number of traces. See Traces, Channels, and
Windows on the VNA.

Use DISP:WIND:STATe to create a window if it doesn't already exist.

Use DISP:MEAS<mnum>:FEED<wnum> to display the measurement in window <wnum>.

This command replaces the following commands:

CALCulate:PARameter[:DEFine]

CALCulate:PARameter[:DEFine]:EXTended

CALCulate:CUSTom:DEFine

Parameters  

<cnum> Channel number of the new measurement. If unspecified, value is set to 1.

If the specified channel does not exist, then a channel of the specified
type will be created. If no type of channel is specified, then a standard
channel will be created.

If the specified channel exists, then the parameter will be added to the channel

provided the existing channel supports the parameter (otherwise, an error will

be generated).

<mnum> Measurement number for the new measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

If the specified measurement number is already in use, an error will be

generated.

<string>

 

(String ) Measurement Parameter and optional measurement class name

separated by a ":" (colon). For example, "S21:Gain Compression" creates an
S21 measurement and selects the Gain Compression measurement class for the

channel.

Note: If a measurement class of a channel does not support the defined

measurement parameter, an error is generated.

Case sensitive.

For S-parameters:

Any S-parameter available in the VNA
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Single-digit port numbers CAN be separated by "_" (underscore). For

example: "S21" or "S2_1"

Double-digit port numbers MUST be separated by underscore. For

example: "S10_1"

For ratioed measurements:

Any two VNA physical receivers separated by forward slash '/' followed

by comma and source port.

For example: "A/R1, 3"

Learn more about ratioed measurements

See a block diagram showing the receivers in YOUR VNA.

For non-ratioed measurements:

Any VNA physical receiver followed by comma and source port.

For example: "A, 4"

Learn more about unratioed measurements.

See the block diagram showing the receivers in YOUR VNA.

Ratioed and Unratioed measurements can also use logical receiver notation

to refer to receivers. This notation makes it easy to refer to receivers with an

external test set connected to the VNA. You do not need to know which

physical receiver is used for each test port. Learn more.

For ADC measurements:

Any ADC receiver in the VNA followed by a comma, then the source
port.

For example: "AI1,2" indicates the Analog Input1 with source port of 2.

Learn more about ADC receiver measurements.

 

(string) - Choose from the following (click or scroll down to view valid

measurement parameters for each measurement class)

"Standard"
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"Vector Mixer/Converter"

"Scalar Mixer/Converter"

"Gain Compression"

"Gain Compression Converters"

"Noise Figure Cold Source"

"Noise Figure Converters"

"Swept IMD"

"IM Spectrum"

"Swept IMD Converters"

"IM Spectrum Converters"

"Differential I/Q"

"Spectrum Analyzer"

(variant) Measurement names to create:

Meas Class Measurement Name Description

"Standard"

"S11", "S21", and

so forth

"A_1","A_2", and

so forth

S-parameter name

Unratioed parameter

names with notation:

"receiver_source port"

See balanced parameter
names

"Vector

Mixer/Converter"

"S11"

"VC21"

"S22"

Learn about VMC

parameters

"Scalar

Mixer/Converter"

"S11"

"SC21"

"SC12"

"S22"

"Ipwr"

"RevIPwr"

Learn about SMC
parameters
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"Opwr"

"RevOPwr"

"Gain Compression"

Learn more

"Gain Compression

Converters"

Learn more

GCA and GCX:

"CompIn21"
Input power at the

compression point.

"CompOut21"
Output power at the

compression point.

"CompGain21"
Gain at the compression
point.

"CompS11"
 Input Match at the
compression point

"RefS21" Linear Gain

"DeltaGain21" CompGain21 -Linear Gain

"S11", "S21",

"S12", "S22"

Standard S-parameters;
measured at port 1 and port
2

GCX - All Gain Compression parameters (except

S21 and S12) plus the following:

"S11"

"SC21"

"SC12"

"S22"

"Ipwr"

"RevIPwr"

"Opwr"

"RevOPwr"

Mixer parameters

Noise Figure AND NFX:

"NF" Noise figure

"ENR"
Validate noise source

measurements.

"T-Eff"
Effective noise

temperature.
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"Noise Figure Cold

Source"

Learn more

"Noise Figure

Converters"

Learn more

"DUTRNP"

"DUTRNPI"

DUT noise power

ratio. (Noise power

expressed in Kelvin

divided by 290).

"SYSRNP"

"SYSRNPI"

System noise power

ratio

"DUTNPD"

"DUTNPDI"

DUT noise power

density. (Noise power

expressed in dBm/Hz).

"SYSNPD"

"SYSNPDI"

System noise power

density.  

"OvrRng"

(Opt 029 Only)

Indication that the

noise receiver is being

over powered.

"T-Rcvr"

(Opt 029 Only)

Temperature reading

(in Kelvin) of the noise

receiver board.

Noise Figure ONLY - NOT NFX:

"S11", "S21",

"S12", "S22"

Standard S-parameters;

measured with the

port1 and port2 noise

switches set for noise

mode.

"A_1","A_2" ...and

so forth.

Unratioed parameters;

with notation:

"receiver, source port"

"GammaOpt"
Optimum Complex

Reflection Coefficient

"Rn" Noise Resistance

"NFMin"

Minimum noise figure

that occurs at

GammaOpt

NFX ONLY:

"S11"

"SC21"

"SC12"
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"S22"

"Ipwr"

"RevIPwr"

"Opwr"

"RevOPwr"

Mixer parameters

"ALO1"," BLO1"

...and so forth.

Test port receiver at

LO1 frequency

"R1_1", "B_2"

..and so forth.

Unratioed parameters

with notation:

"receiver_source port"

"Swept IMD"

"Swept IMD

Converters"

Learn more

There are over 150 possible Swept IMD

parameters, too many to list here.

Build the parameters with the Swept IMD

Parameter dialog, then copy the parameter name

to the remote command.

The following are a few example parameters:

"PwrMainLo"

Absolute power of the

Low tone at the DUT

output.

"IM3"

Power of the third

product relative to the

average power of the

f1 and f2 tones

measured at the DUT
output.

"OIP3"

Theoretical power

level at which the third
product will be the

same power level as
the average of the main

tones at the output of
the DUT.

"Output"

View signals OUT of

the DUT and into

VNA port 2 (B
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"IM Spectrum"

Learn more

receiver).

"Input"
View signals IN to the

DUT (R1 receiver).

"Reflection"

View signals reflected

off the DUT input and

back into VNA port 1

(A receiver)

"IMx Spectrum

Converters"

Learn more

"Output"

View signals OUT of

the DUT and into

VNA port 2 (B

receiver)

"Differential I/Q"

Learn more

Create custom parameters using

Sens:DIQ:Par:Def, then specify your custom

parameter name here.

The following are default parameters:

"IPwrF1"

"OPwrF1"

"GainF1"

Input Power over F1

range

Output Power over F1

range

Gain over F1 range

"Spectrum Analyzer"

Learn more

"a<n>"

"b<n>"

where <n> is the port

number to measure

"ImageReject<n>"

where <n> is the

image reject trace

Reference receiver

Test port receiver

Examples CALC1:MEAS2:DEF "S11" 'Defines an S11 measurement for channel 1,
measurement number 2.

CALC4:MEAS3:DEF "S21:Gain Compression" 'Defines an S21
measurement for channel 4, measurement number 3, and creates a
GCA channel.

CALC2:MEAS:DEF "R1,1:Standard" 'Defines an R1,1 measurement for
channel 2, measurement number 1 (default), and creates a Standard
channel.
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Query Syntax Not Applicable

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:DELete <Mname>

Applicable Models: All 

(Write-only) Deletes the specified measurement.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<Mname> String - Name of the measurement

Examples CALC:MEAS:DEL 'TEST'
calculate2:measure2:delete 'test'

Query Syntax Not Applicable

Default Not Applicable

CALCulate:MEASure:DELete:ALL

Applicable Models: All

(Write-only) Deletes all measurements on the VNA.

Parameters  

Examples CALC:MEAS:DEL:ALL

Query Syntax Not Applicable

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:EQUation[:STATe] <bool>
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Applicable Models: All

(Read-Write)  Turns ON and OFF the equation on selected measurement for the specified channel. If

the equation is not valid, then processing is not performed. Use CALC:EQUation:VALid? to ensure that

the equation is valid.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<bool> ON (or 1) - turns equation ON.

OFF (or 0) - turns equation OFF.

Examples CALC:MEAS:EQU 1

calculate2:measure1:equation:state 0

Query Syntax CALCulate<cnum>:MEASure<mnum>:EQUation[:STATe]?

Return Type Boolean

Default OFF (0)

CALCulate<cnum>:MEASure<mnum>:EQUation:TEXT <string>

Applicable Models: All

(Read-Write)  Specifies an equation or expression to be used on the selected measurement for the

specified channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<string> Any valid equation or expression. See Equation Editor.
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Examples 'Equation (includes '=')

CALC:MEAS:EQU:TEXT "foo=S11/S21"

'Expression
calculate2:measure1:equation:text "S11/S21"

Query Syntax CALCulate<cnum>:MEASure<mnum>:EQUation:TEXT?

Return Type String

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:EQUation:VALid?

Applicable Models: All

(Read-Only)  Returns a boolean value to indicate if the current equation on the selected measurement

for the specified channel is valid. For equation processing to occur, the equation must be valid and

ON (CALC:EQU:STAT 1).

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS:EQU:VAL?

calculate2:measure1:equation:valid?

Return Type Boolean

1 - equation is valid

0 - equation is NOT valid

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:FORMat <char>
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Applicable Models: All

(Read-Write) Sets the display format for the measurement.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<char> Choose from:

MLINear

MLOGarithmic

PHASe

UPHase 'Unwrapped phase

IMAGinary

REAL

POLar

SMITh

SADMittance 'Smith Admittance

SWR

GDELay 'Group Delay

KELVin

FAHRenheit

CELSius

PPHase 'Positive Phase

Examples CALC:MEAS:FORM MLIN
calculate2:measure1:format polar

Query Syntax CALCulate<cnum>:MEASure<mnum>:FORMat?

Return Type Character

Default MLINear
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CALCulate<cnum>:MEASure<mnum>:FORMat:UNIT <dataFormat>, <units>

Applicable Models: All

(Read-Write) Sets and returns the units for the specified data format. Measurements with display

formats other than those specified are not affected.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<dataFormat> Choose from:

MLOG - Log magnitude

MLIN - Linear magnitude

<units> For unratioed MLOG measurements, choose from:

DBM  Units are displayed in dBm.  0 dBm = 0.001 watt

DBMV Units are displayed in dBmV.  0 dBmV = 0.001 volt

DBMA Units are displayed in dBmA. 0 dBmA = 0.001 Ampere

For unratioed MLIN measurements, choose from:

W -Units are displayed in  Watts
V -Units are displayed in Volts
A -Units are displayed in Amperes

Examples CALC:MEAS:FORM MLOG, DBM
calculate2:measure1:format mlog,dbmv

Query Syntax CALCulate<cnum>:MEASure<mnum>:FORMat:UNIT? <dataFormat>

Return Type Character

Default MLOG, DBM

CALCulate<ch>:MEASure<mnum>:HOLD:CLEar
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Applicable Models: All

(Write-only) Resets the currently-stored data points to the live data trace and restarts the currently-

selected Trace Hold type.

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS:HOLD:CLE

calculate2:measure1:hold:clear

Query Syntax Not Applicable

Default Not Applicable

CALCulate<ch>:MEASure<mnum>:HOLD:TYPE <value>

Applicable Models: All

(Read-Write) Sets the type of trace hold to perform.

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<value> Trace Hold type. Choose from:

OFF - Disables the Trace Hold feature.

MINimum - Sets Trace Hold to store the lowest measured data points.

MAXimum - Sets Trace Hold to store the highest measured data points.

Examples CALC:MEAS:HOLD:TYPE MAX

calculate2:measure1:hold:type minimum

Query Syntax CALCulate<ch>:MEASure<mnum>:HOLD:TYPE?

Return Type Character

Default OFF
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CALCulate<cnum>:MEASure<mnum>:MATH:FUNCtion <char>

Applicable Models: All

(Read-Write) Sets math operations on the currently selected measurement and the trace stored in

memory. (There MUST be a trace stored in Memory. See CALC:MEAS:MATH MEM)

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<char> The math operation to be applied. Choose from the following:

  NORMal Trace data only

  ADD Data + Memory

  SUBTract Data - Memory

  MULTiply Data * Memory

  DIVide Data / Memory

Examples CALC:MEAS:MATH:FUNC NORM
calculate2:measure1:math:function subtract

Query Syntax CALCulate<cnum>:MEASure<mnum>:MATH:FUNCtion?

Return Type Character

Default NORMal

CALCulate<cnum>:MEASure<mnum>:MATH:INTerpolate[:STATe]
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and reads the state of the memory data interpolation. Learn more.

Parameters 

<cnum>
Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <ch> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<bool>Choose from:

0 - OFF - Turn memory data interpolation OFF.

1 - ON - Turn memory data interpolation ON.

ExamplesCALC2:MEAS:MATH:INT 1

Query Syntax CALCulate<ch>:MEASure<mnum>:MATH:INTerpolate?

Return Type Boolean

Default 0

CALCulate<cnum>:MEASure<mnum>:MATH:MEMorize

Applicable Models: All

(Write-only) Puts the currently selected measurement trace into memory. (Data-> Memory).

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS:MATH:MEM
calculate2:measure1:math:memorize

Query Syntax Not applicable

Default Not applicable

CALCulate<ch>:MEASure<mnum>:MIXer:XAXis <char>
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Applicable Models: All

(Read-Write) Sets or returns the swept parameter to display on the X-axis for the selected FCA and

GCX measurement.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<char> Parameter to display on the X-axis. Choose from:

INPUT  - Input frequency span

OUTPUT  - Output frequency span

LO_1  - First LO frequency span

LO_2  - Second LO frequency span

Examples CALC:MEAS:MIX:XAX INPUT
calculate2:measure1:mixer:xaxis output

See an example that creates, selects, and calibrates an SMC and
VMC measurement using SCPI.

Query Syntax CALCulate<ch>:MEASure<mnum>:MIXer:XAXis?

Return Type Character

Default OUTPUT

CALCulate<cnum>:MEASure<mnum>:RDATA? <char>
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Applicable Models: All

(Read-only) Returns receiver data for the selected measurement.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<char> Choose from any physical receiver in the VNA.

For example: "A"

Also, REF - returns data for either R1 or R2 data depending on the source port

of the selected measurement.

See the block diagram showing the receivers in YOUR VNA.

Note: Logical receiver notation is NOT allowed with this command. Learn
more.

Example GPIB.Write "INITiate:CONTinuous OFF"
GPIB.Write "INITiate:IMMediate;*wai"
GPIB.Write "CALCulate:MEASure2:RDATA? A"

GPIB.Write "CALCulate:MEASure2:RDATA? REF"

Return Type Depends on FORM:DATA - Two numbers per data point

Default Not Applicable
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CALCulate:MEASure:BLIMit Commands

These commands are for setting up bandwidth tests.

CALCulate:MEASure:BLIMit

BWIDth

       | THReshold

DISPlay

       | MARKer

             | STATe

FAIL?

MAXimum

MINimum

REPort

       | [:DATA]?

[:STATe]

Click a keyword to view the command details.

See Also

Calibrating with SCPI

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<cnum>:MEASure<mnum>:BLIMit:BWIDth:THReshold <value>

701



Applicable Models: All

(Read-Write) Sets bandwidth threshold value (attenuation from the peak) of the bandwidth test.

Parameters  

<cnum>
Channel number of the measurement. There must be a selected measurement on

that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<value> Bandwidth N dB points

Examples
CALC:MEAS:BLIM:BWID:THR 5
calculate2:measure2:blimit:display:bwidth:threshold 5

Query Syntax CALCulate<cnum>:MEASure<mnum>:BLIMit:BWIDth:THReshold?

Return Type Numeric

Default 3

CALCulate<cnum>:MEASure<mnum>:BLIMit:DISPlay:MARKer:STATe <bool>

Applicable Models: All

(Read-Write) Turns ON/OFF the bandwidth value display of the bandwidth test, for the active trace of

selected channel.

Parameters  

<cnum>
Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<bool>
ON or 1 - Turns limit testing ON.

OFF or 0 - Turns limit testing OFF.

Examples
CALC:MEAS:BLIM:DISP:MARK:STAT ON
calculate2:measure2:blimit:display:marker:state off

Query Syntax CALCulate<cnum>:MEASure<mnum>:BLIMit:DISPLay:BWIDth:STATe?

Return Type Boolean

Default OFF

CALCulate<cnum>:MEASure<mnum>:BLIMit:FAIL?
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Applicable Models: All

(Read-only) Get the bandwidth limit test results, for the active trace of selected channel.

Parameters  

<cnum>
Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<bool> Boolean

0 is returned when Pass

1 is returned when Fail

Examples
CALC:MEAS:BLIM:FAIL?
calculate2:measure2:blimit:fail?

Query Syntax CALCulate<cnum>:MEASure<mnum>:BLIMit:FAIL?

Return Type Boolean

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:BLIMit:MAXimum <max>

Applicable Models: All

(Read-Write) Sets/gets the upper limit value of the bandwidth test, for the selected channel.

Parameters  

<cnum>
Channel number of the measurement. There must be a selected measurement on

that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<max> Maximum bandwidth

Examples
CALC:MEAS:BLIM:MAX 1E6
calculate2:measure2:blimit:maximum 1E6

Query Syntax CALCulate<cnum>:MEASure<mnum>:BLIMit:MAXimum?

Return Type Numeric

Default  

CALCulate<cnum>:MEASure<mnum>:BLIMit:MINimum <min>
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Applicable Models: All

(Read-Write) Sets or returns the lower limit value of the bandwidth test, for the selected channel.

Parameters  

<cnum>
Channel number of the measurement. There must be a selected measurement on

that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<min> Minimum bandwidth

Examples
CALC:MEAS:BLIM:MIN 1E6
calculate2:measure2:blimit:minimum 1E6

Query Syntax CALCulate<cnum>:MEASure<mnum>:BLIMit:MINimum?

Return Type Numeric

Default  

CALCulate<cnum>:MEASure<mnum>:BLIMit:REPort[:DATA]?

Applicable Models: All

(Read-only) Read the bandwidth value of the bandwidth test, for the active trace of selected channel.

Parameters  

<cnum>
Channel number of the measurement. There must be a selected measurement on

that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples
CALC:MEAS:BLIM:REP:DATA?
calculate2:measure2:blimit:report:data?

Query Syntax CALCulate<cnum>:MEASure<mnum>:BLIMit:REPort:DATA?

Return Type Variant

Default OFF

CALCulate<cnum>:MEASure<mnum>:BLIMit[:STATe]

704



Applicable Models: All

(Read-Write) Turns ON/OFF the bandwidth test function, for the active trace of selected channel.

Parameters  

<cnum>
Channel number of the measurement. There must be a selected measurement on

that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<bool>
ON or 1 - Turns limit testing ON.

OFF or 0 - Turns limit testing OFF.

Examples
CALC:MEAS:LIM:STAT ON
calculate2:measure2:limit:state off

Query Syntax CALCulate<cnum>:MEASure<mnum>:BLIMit:DIPLay:MARKer:STATe?

Return Type Boolean

Default OFF
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CALCulate:MEASure:Correction Commands

Controls error correction functions.

CALCulate:MEASure:CORRection

EDELay

       | DISTance

       | MEDium

       | [:TIME]

       | UNIT

       | WGCutoff

[:STATe]

       | INDicator?

TYPE

Click a keyword to view the command details.

See Also

Calibrating with SCPI

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<cnum>:MEASure<mnum>:CORRection:EDELay:DISTance <num>
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Applicable Models: All

(Read-Write) Sets the electrical delay in physical length (distance) for the selected measurement.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<num> Electrical delay in distance.

First Specify units using CALC:MEAS:CORR:EDEL:UNIT

Use SENS:CORR:RVEL:COAX <num> to set Velocity factor.

This parameter supports MIN and MAX as arguments. Learn more.

Examples CALC1:MEAS2:CORR:EDEL:DIST 5

calculate2:measure2:correction:edelay:distance .003

Query Syntax CALCulate<cnum>:MEASure<mnum>:CORRection:EDELay:DISTance?

Return Type Numeric

Default 0

CALCulate<cnum>:MEASure<mnum>:CORRection:EDELay:MEDium <char>

Applicable Models: All

(Read-Write) Sets the media used when calculating the electrical delay.  

Parameters  

<cnum> Any existing channel number. There must be a selected measurement on that
channel. If unspecified, value is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<num> Choose from:  COAX for coaxial medium, WAVEguide for waveguide

medium.

Examples CALC:MEAS2:CORR:EDEL:MED COAX

calc3:measure2:correction:edelay:medium waveguide

Query Syntax CALCulate<cnum>:MEASure<mnum>:CORRection:EDELay:MEDium?
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Return Type Character

Default COAX

CALCulate<cnum>:MEASure<mnum>:CORRection:EDELay[:TIME] <num>

Applicable Models: All

(Read-Write) Sets the electrical delay for the selected measurement.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<num> Electrical delay in seconds. Choose any number between:

-10.00 and 10.00

Use SENS:CORR:RVEL:COAX <num> to set Velocity factor.

This parameter supports MIN and MAX as arguments. Learn more.

Examples CALC1:MEAS2:CORR:EDEL:TIME 1NS
calculate2:measure2:correction:time 0.5e-12

Query Syntax CALCulate<cnum>:MEASure<mnum>:CORRection:EDELay[:TIME]?

Return Type Numeric

Default 0 seconds

CALCulate<cnum>:MEASure<mnum>:CORRection:EDELay:UNIT <char>
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Applicable Models: All

(Read-Write) Sets and returns the units for specifying electrical delay in physical length (distance).   

Parameters  

<cnum> Any existing channel number. There must be a selected measurement on that

channel. If unspecified, value is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<char> Units for delay in distance. Choose from:

METer

FEET

INCH

Examples CALC:MEAS2:CORR:EDEL:UNIT MET

calc3:meas2:corr:edelay:unit inch

Query Syntax CALCulate<cnum>:MEASure<mnum>:CORRection:EDELay:UNIT?

Return Type Character

Default METer

CALCulate<cnum>:MEASure<mnum>:CORRection:EDELay:WGCutoff <num>

Applicable Models: All

(Read-Write) Sets the waveguide cutoff frequency used when the electrical delay media is set to

WAVEguide.  (See CALCulate:MEAS:CORRection:EDELay:MEDium <char>.)

Parameters  

<cnum> Any existing channel number. There must be a selected measurement on that

channel. If unspecified, value is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<num> Waveguide cutoff frequency used with the electrical delay calculation.

This parameter supports MIN and MAX as arguments. Learn more.
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Examples CALC:MEAS2:CORR:EDEL:WGC 18.067 GHz

calculate3:measure2:correction:edelay:wgcutoff 14.047 ghz

Query Syntax CALCulate<cnum>:MEASure<mnum>:CORRection:EDELay:WGCutoff?

Return Type Numeric

Default 45 MHz

CALCulate<cnum>:MEASure<mnum>:CORRection[:STATe] <bool>

Applicable Models: All

(Read-Write) Turns error correction ON or OFF for the selected measurement on the specified

channel.

To turn error correction ON or OFF for a channel, use SENS:CORR:STATe.

Parameters  

<cnum> Any existing channel number. There must be a selected measurement on that

channel. If unspecified, value is set to 1

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<bool> Correction state. Choose from:

0 - Correction OFF

1 - Correction ON

Examples CALC:MEAS2:CORR ON

calculate:measure2:correction:state off

Query Syntax CALCulate<cnum>:MEASure<mnum>:CORRection:STATe?

Return Type Boolean

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:CORRection[:STATe]:INDicator?
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Applicable Models: All

(Read-only) Returns the error correction state for the selected measurement on the specified channel.  

To turn error correction ON or OFF for a channel, use SENS:CORR:STATe.

Parameters  

<cnum> Any existing channel number. There must be a selected measurement on that

channel. If unspecified, value is set to 1

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:CORR:IND?

calculate2:measure2:correction:state:indicator?

Return Type Character

NONE - No error correction

MAST (Master) - Original error correction terms

INT - Error terms are interpolated. Learn more.

DELT - Delta Match calibration terms. Learn more.

INV - Error terms are not valid

Default NONE

CALCulate<cnum>:MEASure<mnum>:CORRection:TYPE <string>

Applicable Models: All

(Read-Write) Sets the Cal Type for the selected measurement on the specified channel. This is used

when a Cal Set is applied. Learn more about applying Cal Types.

Use SENS:CORR:TYPE:CAT? to list the Cal Types in the VNA.

Use SENS:CORR:CSET:TYPE:CAT? to list the Cal Types contained in the active Cal Set for the channel.

Use SENS:CORR:COLL:METH to set the Cal type to perform a new Unguided calibration,

Parameters  

<cnum> Any existing channel number. There must be a selected measurement on that

channel. If unspecified, value is set to 1
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<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<string> (String) Cal type. Case sensitive. Use one of the following:

For Full Calibrations (NO Power Cal included):

This command does not distinguish between TRL and SOLT. The same

number of error terms is applied for both Cal Types.

"Full <n> Port(x,y,z...)"

where

<n> = the number of ports to calibrate

x,y,z = the port numbers to calibrate

For example:

"Full 4 Port(1,2,3,4)"

For Full Calibrations (including Power Cal):

After the Full <n> port, include the string, "with power"

For example:

"Full 4 Port with power(1,2,3,4)"

For Response Calibrations:

"Response(param)"  OR

"ResponseAndIsolation(param)"

Where param =  

S-parameter. For example"

"Response(S21)"

"ResponseAndIsolation(A/R)"

Single or ratioed receivers using either logical receiver notation or physical
receiver notation. For example:

"Response(A)"
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"ResponseAndIsolation(a3/b4)"

For Enhanced Response Calibrations:

"EnhancedResp(sourcePort, recPort)

Where:

sourcePort = stimulus port number

recPort = receiver port number

For FCA Calibrations:

Learn more about this setting.

"SMC_2P" (Response + Input + Output)  All four sweeps required. Most accurate.

"SMCRsp+IN"  No Output match. All four sweeps required.

"SMCRsp+OUT"  No Output match. All four sweeps required.

"SMCRsp"  No Input or Output match. Saves two sweeps.

For VMC, multiple Cal types are not available.

For Gain Compression Cal

where r = receive port; s = source port

"GCA 2P (r,s)”  - full 2-port cal

“GCA Enh Resp (r,s)”  - Enhanced Response Cal

Examples CALC:MEAS2:CORR:TYPE "Scalar Mixer Cal"

Query Syntax CALCulate<cnum>:MEASure<mnum>:CORRection:TYPE?

Return Type String

Default Not Applicable
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CALCulate:MEASure:DATA Commands

Controls writing and reading VNA measurement data.

CALCulate:MEASure:DATA

FDATa

FMEMory

SDATa

SMEMory

SNP?

       | PORTs?

             | SAVE

Click a keyword to view the command details.

See Also

Calibrating with SCPI

Synchronizing the Analyzer and Controller

SCPI Command Tree

(Write) CALCulate<cnum>:MEASure<mnum>:DATA:<char>,<data>

(Read) CALCulate<cnum>:MEASure<mnum>:DATA:<char>?

Applicable Models: All

Reads or writes Measurement data, Memory data, or Normalization Divisor data from the Data Access
Map location.

For Measurement data, use FDATA or SDATA

For Memory data, use FMEM or SMEM. When querying memory, you must first store a trace into memory
using CALC:MEAS:MATH:MEMorize.

For Normalization Divisor (Receiver Power Cal error term) data, use SDIV.

Use FORMat:DATA to change the data type (<REAL,32>, <REAL,64> or <ASCii,0>).
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Use FORMat:BORDer to change the byte order. Use “NORMal” when transferring a binary block from
LabView or VEE. For other programming languages, you may need to "SWAP" the byte order.

Equation Editor Notes:

When equation editor is active on a trace in a standard S-parameter channel, Calc:Data returns the data
from the parameter on the trace that was measured last. For example, for the equation "S22 + S33 + S11”,
then S33 is the last measured parameter because it uses source port 3.

In applications, if equation editor is active and the original parameter for the trace is not requested anywhere
in the channel, then zeros are returned. If the original parameter is being measured within the channel, then
data for the original parameter is returned.

In general, if an equation contains no measurement parameters, then data for the original parameter is
returned.

Note: The Calc:Data SCORR command to read/write error terms is Superseded with

SENS:CORR:CSET:DATA. SCORR commands do NOT accommodate greater than 12 error terms.

Parameters  

<cnum> Channel number of the measurement. There must be a selected

measurement on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<char> FDATA Formatted

measurement data to

or from Data Access
Map location. Display

(access point 2).

Note: When querying

FDATA, data is

received in degrees.
When setting phase

using FDATA, the
command expects the

data in radians.

Corrected data is
returned when
correction is ON.

Uncorrected data is
returned when
correction is OFF.

Returns TWO
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numbers per data
point for Polar and
Smith Chart format.

Returns one
number per data
point for all other
formats.

Format of the read
data is same as the
displayed format.

  SDATA Complex measurement

data.

Writes data to Data
Access Map location.

Raw Measurement

(access point 0).

When writing
corrected data, and
correction is ON, it
will be corrected
again, resulting in
meaningless data.

Reads data from

Apply Error Terms

(access point 1).

Returns TWO
numbers per data
point.

Corrected data is
returned when
correction is ON.

Uncorrected data is
returned when
correction is OFF.

  FMEM Formatted memory

data to or from Data
Access Map location.

Memory result  (access

point 4).
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Returns TWO
numbers per data
point for Polar and
Smith Chart format.

Returns one
number per data
point for all other
formats.

Format of the read
data is same as the
displayed format.

Returned data
reflects the
correction level
(ON|OFF) when the
data was stored
into memory.

  SMEM Complex memory data

to or from Data Access
Map location. Memory

 (access point 3).

Returns TWO
numbers per data
point.

Returned data
reflects the
correction level
(ON|OFF) when the
data was stored
into memory.

Returned data
reflects the
correction level
(ON|OFF) when the
data was stored
into memory.

Examples CALC:MEAS:DATA:FDATA Data(x)
calculate2:measure2:data:sdata data(r,i)

See another example using this command.

Return Type Block data  
Default Not Applicable  
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CALCulate<cnum>:MEASure<mnum>:DATA:SNP? <n>

Applicable Models: All

(Read-only) Reads SnP data from the selected measurement. Learn more about SnP data.

This command is valid ONLY with standard S-parameter measurements.

Notes

This command returns SNP data without header information, and in columns, not in rows as .SnP files.
This means that the data returned from this command sends all frequency data, then all Sx1 magnitude
or real data, then all Sx1 phase or imaginary data, and so forth.

To avoid frequency rounding errors, specify FORMat:DATA <Real,64> or <ASCii, 0>

 

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on

that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<n> Amount of data to return. If unspecified, <n> is set to 2.  The number you

specify must be less than or equal to the number of available ports on the VNA.

Choose from:

1 (S1P) returns 1-Port data for the active measurement if the active

measurement is a reflection parameter such as S11 or S22. The behavior is

UNDEFINED if the active measurement is a transmission parameter such as an

S21.

2  (S2P)  returns data for the four 2 port parameters associated with the current

measurement. Default. Data that is not available is zero-filled.

3  (S3P)  returns data for the nine 3 port parameters associated with the current

measurement. Data that is not available is zero-filled.

4 (S4P)   returns data for the sixteen 4 port parameters associated with the

current measurement.  Data that is not available is zero-filled.

SnP data can be output using several data formatting options.  See
MMEM:STORe:TRACe:FORMat:SNP.

See also MMEM:STOR <file>.<snp>
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Examples CALC:MEAS1:DATA:SNP? 1

Return Type Depends on FORMat:DATA.

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:DATA:SNP:PORTs? <"x,y,z".>

Applicable Models: All

(Read-only)  Reads SNP data from the selected measurement for the specified ports. Learn more about
SNP data.

This command is valid ONLY with standard S-parameter measurements.

Notes

This command returns SNP data without header information, and in columns, not in rows as .SnP files.
This means that the data returned from this command sends all frequency data, then all Sx1 magnitude
or real data, then all Sx1 phase or imaginary data, and so forth.

To avoid frequency rounding errors, specify FORM:DATA <Real,64> or <ASCii, 0>

Data that is not available is zero-filled.

For sweeps with a large number of data points, always follow this command with *OPC? Learn more.

 

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on

that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<"x,y,z"> Comma or space delimited port numbers for which data is requested, enclosed

in quotes.

SNP data can be output using several data formatting options.  See

MMEM:STORe:TRACe:FORMat:SNP.

Examples CALC:MEAS2:DATA:SNP:PORTs? "1,2,4,5,7" 'read data for these ports

Return Type Depends on FORMat:DATA

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:DATA:SNP:PORTs:SAVE <"x,y,z">,<filename>
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Applicable Models: All

(Write-only) Saves SNP data from the selected measurement for the specified ports.  Learn more about
SNP data.

The Normal vs Mixed Mode selection is NOT used as it is in the Choose Ports dialog. Instead, data is
returned as it is displayed on the trace. If the selected measurement is Mixed Mode (balanced), then
balanced data is returned. If the selected measurement is an S-parameter, then S-parameter data is
returned.

This command is valid ONLY with the Standard measurement class (NOT applications).

Data that is not available is zero-filled.

For sweeps with a large number of data points, always follow this command with *OPC? Learn more.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<"x,y,z"> String  Comma or space delimited port numbers for which data is requested,

enclosed in quotes.

<filename> String  Path, filename, and suffix of location to store the SNP data, enclosed in

quotes.  The suffix is not checked for accuracy. If saving 2 ports, specify

"filename.s2p"; If saving 4 ports, specify "filename.s4p.", and so forth.

SNP data can be output using several data formatting options.  See

MMEM:STORe:TRACe:FORMat:SNP.

Examples CALC:MEAS2:DATA:SNP:PORTs:Save '1,2,4','D:\MyData.s3p';*OPC?

Return Type Depends on FORMat:DATA

Default Not Applicable
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CALCulate:MEASure:FILter Commands

Controls the gating function used in time domain measurements. The gated range is specified with

either (start / stop) or (center / span) commands.

 

CALCulate:MEASure:FILter

[:GATE]

       | COUPle

             | PARameters

       | TIME

            | CENTer

            | SHAPe

            | SPAN

            | STARt

            | STATe

            | STOP

            | [:TYPE]

Click a keyword to view the command details.

See Also

Learn about Gating

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:COUPle:PARameters <num>
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Applicable Models: All

(Read-Write)  Specifies the time domain gating parameters to be coupled. The settings for those

parameters will be copied from the selected measurement to all other measurements on the channel.

To enable Trace Coupling, use SENS:COUP:PAR

To specify Transform parameters to couple, use CALC:MEAS:TRAN:COUP:PAR

Learn more about Time Domain Trace Coupling

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<num> (Numeric) Parameters to couple. To specify more than one parameter, add the

numbers.

1 - Gating Stimulus (Start, Stop, Center, and Span TIME settings.)

2 - Gating State (ON / OFF)

4 - Gating Shape  (Minimum, Normal, Wide, and Maximum)

8 - Gating Type  (Bandpass and Notch)

Examples 'To couple all parameters:

CALC:MEAS2:FILT:COUP:PAR 15

'To couple Stimulus and Type:
calculate2:measure2:filter:gate:couple:parameters 9

Query Syntax CALCulate<cnum>:MEASure<mnum>:FILTer:GATE:COUPle:PARameters?

Return Type Numeric

Default 13 (All parameters except 2 - Gating State)

CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:TIME:CENTer <num>
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Applicable Models: All

(Read-Write) Sets the gate filter center time.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<num> Center time in seconds; Choose any number between:

± (number of points-1) / frequency span

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:MEAS2:FILT:GATE:TIME:CENT -5 ns
calculate2:measure2:filter:time:center maximum

Query Syntax CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:TIME:CENTer?

Return Type Numeric

Default 0

CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:TIME:SHAPe <char>

Applicable Models: All

(Read-Write) Sets the gating filter shape when in time domain.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<char> Choose from

MAXimum - the widest gate filter available

WIDE -

NORMal -

MINimum - the narrowest gate filter available

Examples CALC:MEAS2:FILT:GATE:TIME:SHAP MAX
calculate2:measure2:filter:time:shape normal
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Query Syntax CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:TIME:SHAPe?

Return Type Character

Default NORMal

CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:TIME:SPAN <num>

Applicable Models: All

(Read-Write) Sets the gate filter span time.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<num> Time span in seconds; Choose any number between:

0 and 2* [(number of points-1) / frequency span]

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:MEAS2:FILT:GATE:TIME:SPAN 5 ns
calculate2:measure2:filter:time:span maximum

Query Syntax CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:TIME:SPAN?

Return Type Numeric

Default 20 ns

CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:TIME:STARt <num>
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Applicable Models: All

(Read-Write) Sets the gate filter start time.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<num> Start time in seconds; any number between:

± (number of points-1) / frequency span

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:MEAS2:FILT:TIME:STAR 1e-8
calculate2:measure2:filter:gate:time:start minimum

Query Syntax CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:TIME:STARt?

Return Type Numeric

Default 10 ns

CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:TIME:STATe <boolean>

Applicable Models: All

(Read-Write) Turns gating state ON or OFF.

Note: Sweep type must be set to LInear Frequency in order to use Transform Gating.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement
on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<boolean> ON (or 1) - turns gating ON.

OFF (or 0) - turns gating OFF.

Examples CALC:MEAS2:FILT:TIME:STAT ON
calculate2:measure2:filter:gate:time:state off

Query Syntax CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:TIME:STATe?
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Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:TIME:STOP <num>

Applicable Models: All

(Read-Write) Sets the gate filter stop time.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<num> Stop time in seconds; any number between:

± (number of points-1) / frequency span

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:MEAS2:FILT:TIME:STOP -1 ns
calculate2:measure2:filter:gate:time:stop maximum

Query Syntax CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:TIME:STOP?

Return Type Numeric

Default 10 ns

CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:TIME[:TYPE] <char>
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Applicable Models: All

(Read-Write) Sets the type of gate filter used.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<char> Choose from:

BPASs - Includes (passes) the range between the start and stop times.

NOTCh - Excludes (attenuates) the range between the start and stop times.

Examples CALC:MEAS2:FILT:TIME BPAS
calculate2:measure2:filter:gate:time:type notch

Query Syntax CALCulate<cnum>:MEASure<mnum>:FILTer[:GATE]:TIME[:TYPE]?

Return Type Character

Default BPAS
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CALCulate:MEASure:FUNCtion Commands

 

CALCulate:MEASure:FUNCtion

DATA?

DOMain

       | USER

             | [:RANGe]

             | STARt

             | STOP

EXECute

STATistics

            | [:STATe]

TYPE

Click a keyword to view the command details.

See Also

Learn about Trace Statistics

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<cnum>:MEASure<mnum>:FUNCtion:DATA?
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Applicable Models: All

(Read-only) Returns the trace statistic data for the selected statistic type for the specified channel.

Select the type of statistic with CALC:MEAS:FUNC:TYPE.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on

that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Return Type Depends on FORM:DATA

Example
CALCulate2:MEASure2:FUNCtion:DATA?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:FUNCtion:DOMain:USER[:RANGe] <range>

Applicable Models: All

(Read-Write) Sets the range used to calculate trace statistics. Each channel has 16 user ranges. The x-

axis range is specified with the CALC:MEAS:FUNC:DOM:USER:START and STOP commands.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<range> Range number. Choose from: 0 to 16

0 is Full Span of the current x-axis range

1 to 16 are user-specified ranges

Examples CALC:MEAS2:FUNC:DOM:USER 4
calculate2:measure2:function:domain:user:range 0

Query Syntax CALCulate<cnum>:MEASure<mnum>:FUNCtion:DOMain:USER[:RANGe]?

Return Type Numeric

Default 0 - Full Span
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CALCulate<cnum>:MEASure<mnum>:FUNCtion:DOMain:USER:STARt <range>, <start>

Applicable Models: All

(Read-Write) Sets the start of the specified user-domain range.

To apply this range, use CALC:MEAS:FUNC:DOM:USER

To set the stop of the range, use CALC:MEAS:FUNC:DOM:USER:STOP.

Note: This command does the same as CALC:MEAS:MARK:FUNC:DOM:USER:STAR

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<range> Range number that will receive the start value. Choose an integer between 1

and 16

<start> Start value of the specified range. Choose a real number between:

the analyzer's Minimum and Maximum x-axis value.

Examples CALC:MEAS2:FUNC:DOM:USER:STAR 1,1e9
calculate2:measure2:function:domain:user:start 2,2e9

Query Syntax CALCulate<cnum>:MEASure<mnum>:FUNCtion:DOMain:USER:STARt?

<range>

Return Type Numeric

Default The analyzer's Minimum x-axis value

CALCulate<cnum>:MEASure<mnum>:FUNCtion:DOMain:USER:STOP <range>, <stop>
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Applicable Models: All

(Read-Write) Sets the stop value of the specified user-domain range.

To apply this range, use CALC:MEAS:FUNC:DOM:USER.

To set the start of the range, use CALC:MEAS:MARK:FUNC:DOM:USER:STAR

Note: This command does the same as CALC:MEAS:MARK:FUNC:DOM:USER:STOP

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<range> Range number that will receive the stop value. Choose an integer between 1

and 16

<stop> Stop value of the specified range. Choose a real number between:

the analyzer's Minimum and Maximum x-axis value.

Examples CALC:MEAS2:FUNC:DOM:USER:STOP 4,5e9
calculate2:measure2:function:domain:user:stop 3,8e9

Query Syntax CALCulate<cnum>:MEASure<mnum>:FUNCtion:DOMain:USER:STOP?

<range>

Return Type Numeric

Default The analyzer's Maximum x-axis value

CALCulate<cnum>:MEASure<mnum>:FUNCtion:EXECute
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Applicable Models: All

(Write-only) For the active trace of specified channel, executes the statistical analysis specified by the

CALC:MEAS:FUNC:TYPE command.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:FUNC:EXEC
calculate2:measure2:function:execute

Query Syntax Not Applicable

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:FUNCtion:STATistics[:STATe] <ON|OFF>

Applicable Models: All

(Read-Write) Displays and hides the trace statistics (peak-to-peak, mean, standard deviation) on the

screen.

The analyzer will display either measurement statistics or Filter Bandwidth statistics; not both.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<ON|OFF> ON - Displays trace statistics

OFF - Hides trace statistics

Examples CALC:MEAS2:FUNC:STAT ON
calculate2:measure2:function:statistics:state off

Query Syntax CALCulate<cnum>:MEASure<mnum>:FUNCtion:STATistics[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF (0)
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CALCulate<cnum>:MEASure<mnum>:FUNCtion:TYPE <char>

Applicable Models: All

(Read-Write) Sets statistic TYPE that you can then query using CALC:MEAS:FUNCtion:DATA?.

Note: This command affects only the selected measurement on the specified channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<char> Choose from:

PTPeak - the difference between the max and min data points on the trace.

STDEV - standard deviation of all data points on the trace

MEAN - mean (average) of all data points on the trace

MIN - lowest data point on the trace

MAX - highest data point on the trace

Examples CALC:MEAS2:FUNC:TYPE PTP
calculate2:measure2:function:type stdev

Query Syntax CALCulate<cnum>:MEASure<mnum>:FUNCtion:TYPE?

Return Type Character

Default PTPeak
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CALCulate:MEASure:GCData Commands

Reads Gain Compression data from the current Gain Compression acquisition.

CALCulate:MEASure:GCData

DATA

IMAG

ITERations

REAL

Click a keyword to view the command details.

Other Gain Compression commands

The calibration commands listed in this topic are supplemental to the Guided Cal commands.

CALC:MEAS:DEFine - creates a gain compression measurement.

SENS:GCSetup  - Most Gain Compression settings.

CALC:MEAS:GCMeas:ANAL - Gain Compression Analysis settings

Gain compression data can also be saved to a *.csv file. Learn how.

See Also

Learn about Gain Compression Application

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<ch>:MEASure<mnum>:GCData:DATA? <param>

Applicable Models: N522xB, N524xB, M9485A

(Read-Only) Returns measurement data at all frequency and power data points for GCA SMART
sweeps and 2D sweeps.

When using SMART sweep, ALL data is returned including ALL background iteration sweeps. Use
CALC:MEAS:GCD:ITER to determine the number of iteration sweeps. The number of data points that are
returned is always going to be number of frequency points times the number of iteration sweeps.

When using 2D sweeps, ALL data is returned. The number of data points returned / freq may vary. Learn
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more.

Use CALC:MEAS:DATA? to return just the displayed data results (not the background sweeps).

A compression parameter must be present. Learn more.

The format of the data is the same as the format of the measurement that you select using

CALC:MEAS:PAR. If the measurement is scalar, than one number is returned per sweep per data point.

If complex (such as Smith Chart format) than both real and imaginary numbers are returned.

If correction is on, corrected data are returned. Otherwise, raw data are returned.

Parameters  

<ch> Any existing channel number. There must be a selected measurement on that

channel. If unspecified, value is set to 1

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<param> (String) Parameter to read. NOT Case-sensitive. The specified parameter need

NOT be displayed or selected.  However, a compression parameter must be

present. Learn more.

Choose from:

"pin"  - (CompIn21) Input power at the compression point.

"pout" - (CompOut21) Output power at the compression point.

"gain" - (CompGain21) Device gain (S21) at the compression point.

"inputmatch" - (CompS11) Input match at the compression point.

"DeltaGain" - (DeltaGain21) Measured Gain (watts) / Ref Gain (watts). Learn
more.

"AI1" and "AI2" - ADC measurements at the specified compression level. Learn
more.

Learn more about GCA parameters.

Examples data = CALC:MEAS2:GCD:DATA? "pin"

data = calculate:measure2:gcdata:data? "pout"

Return Type Array of data

Default Not Applicable
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CALCulate<ch>:MEASure<mnum>:GCData:IMAG? <char>, <dpoint>, <param>

Applicable Models: N522xB, N524xB, M9485A

(Read-Only) For a specified data point, returns the imaginary part of the specified Gain Compression

data. If correction is on, corrected data are returned. Otherwise, raw data are returned. Can be used

with Smart and 2D sweeps.

For SMART sweep, the number of data points that are returned is always going to be the number of
iteration sweeps. Use CALC:MEAS:GCD:ITER to determine the number of iteration sweeps.

For 2D sweeps, the number of data points returned / freq may vary. Learn more.

Parameters  

<ch> Any existing channel number. There must be a selected measurement on that

channel. If unspecified, value is set to 1

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<char> Choose from:

FREQuency - for the specified frequency data point, returns all of the measured
data for each power stimulus.

POWer - for the specified power data point, returns all of the measured data for
each frequency stimulus.

<dPoint> Data point (FREQ or POWer) for which data is returned.

<param> (String) Parameter to read. NOT Case-sensitive. The specified parameter need

NOT be displayed. However, a compression parameter must be present. Learn
more.

"pin"  - (CompIn21) Input power at the compression point.

"pout" - (CompOut21) Output power at the compression point.

"gain" - (CompGain21) Device gain (S21) at the compression point.

"inputmatch" - (CompS11) Input match at the compression point.

"DeltaGain" - (DeltaGain21) Measured Gain (watts) / Ref Gain (watts). Learn
more.

"AI1" and "AI2" - ADC measurements at the specified compression level. Learn
more.

Examples For the fifth frequency data point, returns 'Power Output' imaginary (phase)

data from all power stimulus values.
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For SmartSweep, if there are 30 power sweep points, 30 values are returned.

For 2D sweeps, 30 or 31 power sweep points may be returned. Learn more.

data = CALC:MEAS2:GCD:IMAG? FREQ,5,"pout"

Return Type Array of data

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:GCData:ITERations?

Applicable Models: N522xB, N524xB, M9485A

(Read-only) In a SMART sweep, returns the max number of iterations that it took for ALL

frequencies to converge. Use this number to determine the size of the block data that is returned from

Gain Compression SMART sweep data queries.

For a 2D sweep, returns the number of power points.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples data = CALC:MEAS2:GCD:ITER?

Return Type Numeric

Default Not Applicable

CALCulate<ch>:MEASure<mnum>:GCData:REAL? <char>, <dpoint>, <param>

Applicable Models: N522xB, N524xB, M9485A

(Read-Only) For a specified data point, returns the real part of the Gain Compression data. If

correction is on, corrected data are returned. Otherwise, raw data are returned.  Can be used with

Smart and 2D sweeps.

For SMART sweep, the number of data points that are returned is always going to be the number of
iteration sweeps. Use CALC:MEAS:GCD:ITER to determine the number of iteration sweeps.

For 2D sweeps, the number of data points returned / freq may vary. Learn more.
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Parameters  

<ch> Any existing channel number. There must be a selected measurement on that

channel. If unspecified, value is set to 1

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<char> Choose from:

FREQuency - for the specified frequency data point, returns all of the measured
data for each power stimulus.

POWer - for the specified power data point, returns all of the measured data for
each frequency stimulus.

<dPoint> Data point (FREQ or POWer) for which data is returned.

<param> (String) Parameter to read. NOT Case-sensitive. The specified parameter need

NOT be displayed. However, a compression parameter must be present. Learn
more.

"pin"  - (CompIn21) Input power at the compression point.

"pout" - (CompOut21) Output power at the compression point.

"gain" - (CompGain21) Device gain (S21) at the compression point.

"inputmatch" - (CompS11) Input match at the compression point.

"DeltaGain" - (DeltaGain21) Measured Gain (watts) / Ref Gain (watts). Learn
more.

"AI1" and "AI2" - ADC measurements at the specified compression level. Learn
more.

Examples For the fifth frequency data point, returns 'Power Output' real data from all

power stimulus values.

For SmartSweep, if there are 30 power sweep points, 30 values are returned.

For 2D sweeps, 30 or 31 power sweep points may be returned. Learn more.

data = CALC:MEAS2:GCD:REAL? FREQ,5,"pout"

Return Type Array of data

Default Not Applicable
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CALCulate:MEASure:GCMeas Commands

Sets and reads Gain Compression Analysis controls.

CALCulate:MEASure:GCMeas

ANAlysis

       | CWFRequency

       | DISCrete

             | [:STATe]

       | ENABle

       | XAXis

Click a keyword to view the command details.

Other Gain Compression commands

The calibration commands listed in this topic are supplemental to the Guided Cal commands.

CALC:MEAS:DEFine - creates a gain compression measurement.

SENS:GCSetup  - Most Gain Compression settings.

CALC:MEAS:GCData - Gain Compression data commands

Gain compression data can also be saved to a *.csv file. Learn how.

See Also

Learn about Gain Compression Application

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<cnum>:MEASure<mnum>:GCMeas:ANALysis:CWFRequency <num>
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Applicable Models: N522xB, N524xB, M9485A

(Read-Write)  Set and return the CW frequency for a compression analysis trace.

Parameters  

<cnum> Channel number of the GCA measurement. There must be a selected

measurement on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<num> CW frequency in Hz. Choose a frequency within the range of the gain

compression channel.

Examples CALC:MEAS2:GCM:ANAL:CWFR 1e9
calculate2:measure2:gcmeas:analysis:cwfrequency 1e10

Query Syntax CALCulate<cnum>:MEASure<mnum>:GCMeas:ANALysis:CWFRequency?

Return Type Numeric

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:GCMeas:ANALysis:DISCrete[:STATe] <bool>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write)  Sets and returns whether the CW frequency for the compression analysis trace can be

set to only the discrete frequencies or provides interpolation.

Parameters  

<cnum> Channel number of the GCA measurement. There must be a selected

measurement on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<bool> ON (or 1) - Discrete data points only.

OFF (or 0) - Interpolated data points.

Examples CALC:MEAS2:GCM:ANAL:ISD ON
calculate2:measure2:gcmeas:analysis:isdisfrequency off

Query Syntax CALCulate<cnum>:MEASure<mnum>:GCMeas:ANALysis:ISDisfrequency?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF
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CALCulate<cnum>:MEASure<mnum>:GCMeas:ANALysis:ENABle <bool>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write)  Enables and disables a compression analysis trace.

Parameters  

<cnum> Channel number of the GCA measurement. There must be a selected

measurement on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<bool> ON (or 1) - Enable compression analysis.

OFF (or 0) - Disable compression analysis.

Examples CALC:MEAS2:GCM:ANAL:ENAB ON
calculate2:measure2:gcmeas:analysis:enable off

Query Syntax CALCulate<cnum>:MEASure<mnum>:GCMeas:ANALysis:ENABle?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:MEASure<mnum>:GCMeas:ANALysis:XAXis <char>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write)  Sets and returns the type of data to display on the x-axis of a compression analysis

trace.

Parameters  

<cnum> Channel number of the GCA measurement. There must be a selected

measurement on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<bool> Data to display on X-axis. Choose from:

PIN - Input power to the DUT.

PSOurce - power from the source.

Examples CALC:MEAS2:GCM:ANAL:XAX PIN
calculate2:measure2:gcmeas:analysis:xaxis psource
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Query Syntax CALCulate<cnum>:MEASure<mnum>:GCMeas:ANALysis:XAXis?

Return Type Character

Default PIN
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CALCulate:MEASure:GDELay Commands

Controls the Aperture setting used to make Group Delay measurements.

CALCulate:MEASure:GDELay

FREQuency

PERCent

POINts

Click a keyword to view the command details.

See Also

Learn about Group Delay Aperture

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<cnum>:MEASure<mnum>:GDELay:FREQuency <value>

Applicable Models: All

(Read-Write) Sets group delay aperture using a fixed frequency range.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<value> Frequency range (in Hz) to use for the aperture setting. Choose between the

equivalent of two data points and the channel frequency span.

Examples CALC:MEAS2:GDEL:FREQ 1E6

Query Syntax CALCulate<cnum>:MEASure<mnum>:GDELay:FREQuency?

Return Type Numeric

Default Frequency range that equates to 11 points. This can be changed to two points

with a preference setting.
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CALCulate<cnum>:MEASure<mnum>:GDELay:PERCent <value>

Applicable Models: All

(Read-Write) Sets group delay aperture using a percent of the channel frequency span.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<value> Percent of frequency span to use for the aperture setting. Choose between the

equivalent of two data points and 100 percent of the channel frequency span.

Examples 'set to 25 percent of the channel frequency span

CALC:MEAS2:GDEL:PERC 25

Query Syntax CALCulate<cnum>:MEASure<mnum>:GDELay:PERCent?

Return Type Numeric

Default Percent of frequency span that equates to 11 points. This can be changed to two

points with a preference setting.

CALCulate<cnum>:MEASure<mnum>:GDELay:POINts <value>

Applicable Models: All

(Read-Write) Sets group delay aperture using a fixed number of data points.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<value> Number of data points to  use for the aperture setting. Choose between two

points and the number of points in the channel.

Examples 'set to 25 data points

CALC:MEAS2:GDEL:POIN 25

Query Syntax CALCulate<cnum>:MEASure<mnum>:GDELay:POINts?

Return Type Numeric
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Default 11 points. This can be changed to two points with a preference setting.
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CALCulate:MEASure:LIMit Commands

Controls the limit segments used for pass / fail testing.

CALCulate:MEASure:LIMit

DATA

       | DELete

DISPlay

       | [:STATe]

FAIL?

REPort

       | ALL?

       | [:DATA]?

       | POINts?

SEGMent

       | AMPLitude

            | STARt

            | STOP

       | COUNt?

       | STIMulus

            | STARt

            | STOP

       | TYPE

SOUNd

       | [:STATe]

[:STATe]

Click a keyword to view the command details.

See Also
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Learn about Limit Lines

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<cnum>:MEASure<mnum>:LIMit:DATA <block>

Applicable Models: All

(Read-Write) Sets data for limit segments.

Parameters  

<cnum> Channel number of the measurement for which limit lines are to be set. There

must be a selected measurement on that channel. If unspecified, <cnum> is set

to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<block> Data for all limit segments in REAL,64 format. The following is the data

format for 1 segment:

Type,BegStim, EndStim, BegResp,EndResp

Type Type of limit segment. Choose from

0 - Off

1 - Max

2 - Min

BegStim Start of X-axis value (freq, power, time)

EndStim End of X-axis value

BegResp Y-axis value that corresponds with Start of X-axis value

EndResp Y-axis value that corresponds with End of X-axis value

Examples The following writes three max limit segments for a bandpass filter.

CALC:MEAS2:LIM:DATA 1,3e5,4e9,-
60,0,1,4e9,7.5e9,0,0,1,7.5e9,9e9,0,-30

Query Syntax CALCulate<cnum>:MEASure<mnum>:LIMit:DATA?

Return Type Depends on FORM:DATA - All 100 predefined limit segments are returned.

Default 100 limit segments - all values set to 0
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CALCulate<cnum>:MEASure<mnum>:LIMit:DATA:DELete

Applicable Models: All

(Write-only) Deletes all limit line data for the selected measurement on the specified channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC2:MEAS2:LIM:DATA:DEL

Query Syntax Not Applicable

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:LIMit:DISPlay[:STATe] <ON | OFF>

Applicable Models: All

(Read-Write) Turns the display of limit segments ON or OFF (if the data trace is turned ON).

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<ON | OFF> ON (or 1) - turns the display of limit segments ON.

OFF (or 0) - turns the display of limit segments OFF.

Examples CALC:MEAS2:LIM:DISP:STAT ON
calculate2:limit:display:state off

Query Syntax CALCulate<cnum>:MEASure<mnum>:LIMit:DISPlay[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

CALCulate<cnum>:MEASure<mnum>:LIMit:FAIL?
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Applicable Models: All

(Read-only) Returns the Pass / Fail status of the limit line test. Returns 1 (Fail) if any data point fails

for any limit segment.

Limit display (CALC:LIM:DISP) does NOT have to be ON.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2LIM:FAIL?

Return Type Boolean

0 is returned when Pass

1 is returned when Fail

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:LIMit:REPort:ALL? <block>

Applicable Models: All

(Read-only) Reads the bandwidth test results (stimulus value, limit test result, upper limit value and

lower limit value of all measurement points), for the active trace of selected channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected

measurement on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected
measurement on the trace. If unspecified, <mnum> is set to 1.

<block> Depends on FORM:DATA

If the number of the measurement points is N,

<Block> = <first stimulus>,<test result>,<upper limit>,<lower limit>, …, <Nth
stimulus>,<test result>,<upper limit>,<lower limit>

Where <test result>=   -1: No limit, 0:Fail, 1:Pass

Examples CALC:MEAS:LIM:REP:ALL?

Return Type Variant

750



Default Depend on the preset status

CALCulate<cnum>:MEASure<mnum>:LIMit:REPort[:DATA]? <block>

Applicable Models: All

(Read-only) Reads the stimulus values (frequency, power level or time) at all the measurement points

that failed the limit test, for the active trace of selected channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<block> Depends on FORM:DATA

If the number of the measurement points that failed the limit test is N, <block>=<First

failed stimulus>, ..., <Nth failed stimulus>.

Examples CALC:MEAS:LIM:REP:DATA?

Return Type Numeric
Default 9.91E37

CALCulate<cnum>:MEASure<mnum>:LIMit:REPort:POINts?

Applicable Models: All

(Read-only) Reads the number of the measurement points that failed the limit test, for the active trace

of selected channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement
on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS:LIM:REP:POIN?

Query

Syntax
Numeric

Default 0

CALCulate<cnum>:MEASure<mnum>:LIMit:SEGMent<snum>:AMPLitude:STARt <num>
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Applicable Models: All

(Read-Write) Sets the start (beginning) of the Y-axis amplitude (response) value.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<snum> Segment number; if unspecified, value is set to 1.

<num> Choose any number between: -500 and 500

Display value is limited to the Maximum and Minimum displayed Y-axis values.

Examples CALC:MEAS2LIM:SEGM1:AMPL:STAR 10
calculate2:measure2:limit:segment2:amplitude:start 10

Query

Syntax

CALCulate<cnum>:MEASure<mnum>:LIMit:SEGMent<snum>AMPLitude:STARt?

Return

Type

Numeric

Default 0

CALCulate<cnum>:MEASure<mnum>:LIMit:SEGMent<snum>:AMPLitude:STOP <num>

Applicable Models: All

(Read-Write) Sets the stop (end) of the Y-axis amplitude (response) value.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<snum> Segment number; if unspecified, value is set to 1.

<num> Choose any number between: -500 and 500

Display value is limited to the Maximum and Minimum displayed Y-axis values.

Examples CALC:MEAS:LIM:SEGM1:AMPL:STOP 10
calculate2:measure2:limit:segment2:amplitude:stop 10
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Query

Syntax

CALCulate<cnum>:MEASure<mnum>:LIMit:SEGMent<snum>AMPLitude:STOP?

Return Type Numeric

Default 0

CALCulate:MEASure<mnum>:LIMit:SEGMent:COUNt?

Applicable Models: All

(Read-only) Returns the number of segments used in a limit test. All segments are counted, whether

they are on or not.

Parameters Not Applicable

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:LIM:SEGM:COUN?

Return Type Numeric

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:LIMit:SEGMent<snum>:STIMulus:STARt <num>

Applicable Models: All

(Read-Write) Sets the start (beginning) of the X-axis stimulus value.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<snum> Segment number; if unspecified, value is set to 1.

<num> Choose any number within the X-axis span of the analyzer.

Examples CALC:MEAS:LIM:SEGM1:STIM:STAR 10
calculate2:measure:limit:segment2:stimulus:start 10

Query Syntax CALCulate<cnum>:MEASure<mnum>:LIMit:SEGMent<snum>STIMulus:STARt?

Return Type Numeric

Default 0
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CALCulate<cnum>:MEASure<mnum>:LIMit:SEGMent<snum>:STIMulus:STOP <num>

Applicable Models: All

(Read-Write) Sets the stop (end) of the X-axis stimulus value.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on

that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<snum> Segment number; if unspecified, value is set to 1.

<num> Choose any number within the X-axis span of the analyzer.

Examples CALC:MEAS2:LIM:SEGM1:AMPL:STOP 10
calculate2:measure2:limit:segment2:stimulus:stop 10

Query Syntax CALCulate<cnum>:MEASure<mnum>:LIMit:SEGMent<snum>STIMulus:STOP?

Return Type Numeric

Default 0

CALCulate<cnum>:MEASure<mnum>:LIMit:SEGMent<snum>:TYPE <char>

Applicable Models: All

(Read-Write) Sets the type of limit segment.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<snum> Segment number. Choose any number between:

1 and 100

If unspecified, value is set to 1.

<char> Choose from:

LMAX - a MAX limit segment. Any response data exceeding the MAX value

will fail.

LMIN - a MIN limit segment. Any response data below the MIN value will
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fail.

OFF - the limit segment (display and testing) is turned OFF.

Examples CALC:MEAS2:LIM:SEGM:TYPE LMIN
calculate2:measure2:limit:segment3:type lmax

Query Syntax CALCulate<cnum>:MEASure<mnum>:LIMit:SEGMent<snum>:TYPE?

Return Type Character

Default OFF

CALCulate<cnum>:MEASure<mnum>:LIMit:SOUNd[:STATe] <ON | OFF>

Applicable Models: All

(Read-Write) Turns limit testing fail sound ON or OFF.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<ON | OFF> ON (or 1) - turns sound ON.

OFF (or 0) - turns sound OFF.

Examples CALC:MEAS2:LIM:SOUN ON
calculate2:measure2:limit:sound:state off

Query Syntax CALCulate<cnum>:MEASure<mnum>:LIMit:SOUNd[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:MEASure<mnum>:LIMit[:STATe] <ON | OFF>
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Applicable Models: All

(Read-Write) Turns limit segment testing ON or OFF.

Use CALCulate:MEASure:LIMit:DISPlay to turn ON and OFF the display of limit segments.

If using Global Pass/Fail status, trigger the VNA AFTER turning Limit testing ON.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<ON | OFF> ON (or 1) - turns limit testing ON.

OFF (or 0) - turns limit testing OFF.

Examples CALC:MEAS:LIM:STAT ON
calculate2:measure:limit:state off

Query Syntax CALCulate<cnum>:MEASure<mnum>:LIMit:STATe?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF
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CALCulate:MEASure:MARKer Commands

Controls the marker settings used to remotely output specific data to the computer.

CALCulate:MEASure:MARKer:

AOFF

BUCKet

BWIDth

       | DATA?

       | REF

       | [:STATe]

       | THReshold

COUPling

       | METHod

       | [STATe]

DELTa

DISCrete

DISTance

FORMat

FUNCtion

       | APEak:POLarity

       | COMPression

             | LEVel

             | PIN?

             | POUT?

             | [:STATe]

       | DOMain

            | USER

                 | [:RANGe]
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                 | STARt

                 | STOP

       | EXECute

       | MULTI

                 | EXECute

                 | PEAK

                       | EXCursion

                       | POLarity

                       | THReshold

                 | SELect

                 | TARGet

                       | TRANsition

                       | [:VALue]

                 | TRACking

       | PEAK

                 | EXCursion

                 | POLarity

                 | THReshold

       | [:SELect]

       | TARGet

                 | TRANsition

                 | [:VALue]

       | TRACking

NOTCh

       | DATA?

       | REF

       | [:STATe]

       | THReshold
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PNOP

       | BACKoff

                 | GAIN

                 | PIN

                 | POUT

       | COMPression

                 | MAXimum

       | GAIN

                 | MAXimum

       | PIN

                 | MAXimum

       | POFFset

       | POUT

                 | MAXimum

       | [:STATe]

PSATuration

       | BACKoff

       | COMPression

                 | MAXimum

                 | SATuration

       | GAIN

                 | LINear

                 | MAXimum

       | PIN

                 | MAXimum

       | POUT

                 | MAXimum

       | [:STATe]
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REFerence

       | [:STATe]

       | X

       | Y

SET

[:STATe]

TYPE

X

Y

Click a k eyword to view the command details.

S ee Also

Marker Readout number and size commands.

Learn about Markers

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<cnum>:MEASure<mnum>:MARKer:AOFF

Applicable Models: All

(Write-only) Turns all markers off for selected measurement.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:MARK:AOFF
calculate2:measure2:marker:aoff

Query Syntax Not applicable

Default Not applicable
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CALCulate<cnum>:MEASure<mnum>:MARKer<n>:BUCKet <num>

Applicable Models: All

(Read-Write) Sets and reads the data point (bucket) number of the trace on which the marker resides.

When the markers are interpolated (non-discrete ), the returned value is the nearest marker bucket

position.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<n> Marker number to move or query. The marker must already exist. If

unspecified, <n> is set to 1.

<num> Data point (bucket) number. Choose any data point between: 0 and the number

of data points minus 1.

Examples CALC:MEAS:MARK:BUCK 5

calculate2:measure2:marker2:bucket 200

Query Syntax CALCulate<cnum>:MEASure<mnum>:MARKer<n>:BUCKet?

Return Type Integer

Default The first marker is set to the middle of the span. Subsequent markers are set to

the bucket number of the previously active marker.

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:BWIDth:DATA?
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Applicable Models: All

(Read-only) Read the bandwidth search result of marker 1 to 15 and reference marker (Mkr :16), for

the active trace of selected channel.

I f the bandwidth search is impossible, an error occurs when executed and the object is ignored.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; If unspecified, value is set to 1.

 

Four Character values separated by commas => {numeric 1}, {numeric 2}, {numeric

3}, {numeric 4}

{numeric 1} : Bandwidth

{numeric 2} : Center point frequency of the 2 cutoff frequency points

{numeric 3} : Q value

{numeric 4} : Insertion loss
Examples CALC:MEAS:MARK:BWID:DATA?

calculate2:measure1:marker:bwidth:data?

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:BWIDth:DATA?

Return

Type
Numeric

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:BWIDth:REF <string>
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Applicable Models: All

(Read-Write) Set the bandwidth marker function reference to either MARKer or PEAK.

If the reference is set to MARKer, the active marker is not moved; the bandwidth search is computed

at the marker's current location.

If the reference is PEAK, the active marker is moved to the maximum or minimum peak on the trace

and then bandwidth search is computed.

If the bandwidth level is negative, the active marker is moved to the maximum peak.

If the bandwidth level is positive, the active marker is moved to the minimum peak.
Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<string> PEAK

MARKer

Examples CALC:MEAS:MARK:BWID:REF MARK
calculate2:measure1:marker:bwidth:ref peak

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer:BWIDth:REF?

Return

Type
String

Default MARKer

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:BWIDth[:STATe] <bool>
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Applicable Models: All

(Read-Write) Turns ON or OFF the bandwidth search result display, for the active trace of selected

channel .

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<bool> Bandwidth search result display:

ON or 1 - Turns ON the bandwidth search result display.

OFF or 0 - Turns OFF the bandwidth search result display.

Examples
CALC:MEAS:MARK:BWID ON
calculate2:measure1:marker:bwidth:state off

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer:BWIDth[:STATe]?

Return

Type
Boolean

Default OFF or 0

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:BWIDth:THReshold <value><unit>

Applicable Models: All

(Read-Write) Sets or returns the bandwidth definition value (the value to define the pass-band of the

filter) of marker 1 to 15 and reference marker (Mk :16), for the active trace of selected channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<value> Bandwidth definition value (the value to define the pass band of the filter) is between -

5E8 to 5E8.

<unit> Varies depending on the data format.

Log magnitude (MLOG): dB (decibel)
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Phase (PHAS), Expanded phase (UPH) or Positive phase (PPH): °    (degree)

Group delay (GDEL): s (second)

Others: No unit
Examples CALC:MEAS:MARK:BWID:THR -3

calculate2:measure1:marker:bwidth:threshold -3

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:BWIDth:THReshold?

Return

Type
Numeric

Default -3

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:COUPling:METHod <char>

Applicable Models: All

(Read-Write) Sets and reads the scope of Coupled Markers. This is a global setting that affects all

markers. Learn more.

Note: This command will not take effect until Coupled Markers is turned on using

CALC:MEAS:MARK:COUP:STATe ON .

Note: The preset behavior of Coupled Markers depends on the setting of

SYSTem:PREFerences:ITEM:MCControl , SYSTem:PREFerences:ITEM:MCMethod , and

SYSTem:PREFerences:ITEM:MCPRest .

Note: If any or all <cnum>, <mnum>, or <mkr> arguments are omitted, they are assumed to have the

value 1.

Parameters  

<cnum> Must be a valid channel number (unless a measurement number is provided),
but marker coupling is not set per channel.

<mnum> Must be a valid measurement number and must be displayed on the screen.

Marker coupling is not set per measurement.

<mkr> Not used. The marker number must still be in the range of 1-16, but marker

coupling is not set per marker.

<char> CHANnel - Coupling is limited to traces in the same channel.

ALL - Coupling occurs across all channels.

Examples CALC:MEAS:MARK:COUP:METH CHAN

calculate:measure:marker:coupling all
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Query Syntax CALCulate<cnum>:MEASure<mnum>:MARKer:COUPling:METHod?

Return Type Character

Default ALL

CALCulate:MEASure<mnum>:MARKer<mkr>:COUPling[:STATe]<ON|OFF>

Applicable Models: All

(Read-Write) Sets and reads the state of Coupled Markers (ON and OFF). The scope of coupled

markers can be changed with CALC:MEAS:MARK:COUP:METH .

Note: If the <mnum> or <mkr> argument is omitted, they are assumed to have the value 1.

Parameters  

<mnum> Must be a valid measurement number and must be displayed on the screen.

<mkr> Not used. The marker number must still be in the range of 1-16.

<ON|OFF> OFF (0 ) - Turns Coupled Markers OFF

ON (1) - Turns Coupled Markers ON

Examples CALC:MEAS:MARK:COUP ON
calculate:measure1:marker:coupling off

Query Syntax CALCulate<cnum>:MEASure<mnum>:MARKer:COUPling:[STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:DELTa <ON|OFF>
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Applicable Models: All

(Read-Write) Specifies whether marker is relative to the Reference marker or absolute.

Note: The reference marker must already be turned ON with CALC:MARK:REF:STATE .

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any existing marker number from 1 to 10; if unspecified, value is set to 1.

<ON|OFF> ON (or 1) - Specified marker is a Delta marker

OFF (or 0) - Specified marker is an ABSOLUTE marker

Examples CALC:MEAS:MARK:DELT ON

calculate2:measure1:marker8:delta off

Query Syntax CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:DELTa?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:DISCrete <ON|OFF>

Applicable Models: All

(Read-Write) Makes the specified marker display either a calculated value between data points

(interpolated data) or the actual data points (discrete data).

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any existing marker number from 1 to 10; if unspecified, value is set to 1.

<ON|OFF> ON (or 1) - Specified marker displays the actual data points
OFF (or 0) - Specified marker displays calculated data between the actual data

points.
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Examples CALC:MEAS:MARK:DISC ON
calculate2:measure2:marker8:discrete off

Query Syntax CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:DISCrete?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:DISTance <num>

Applicable Models: All

(Read-Write) Set or query marker distance on a time domain trace.

The Write command moves the marker to the specified distance value. Once moved, you can read the

Y axis value or read the X-axis time value. (Distance is calculated from the X-axis time value.)

The Read command reads the distance of the marker.

If the marker is set as delta, the WRITE and READ data is relative to the reference marker.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any existing marker number from 1 to 10; if unspecified, value is set to 1.

<num> Marker distance in the unit of measure specified with

CALC:TRAN:TIME:MARK:UNIT

Examples CALC:MEAS:MARK:DIST .1
calculate2:measure1:marker8:distance 5

Query Syntax CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:DISTance?

Return Type Numeric

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FORMat <char>

Applicable Models: All

(Read-Write) Sets the format of the data that will be returned in a marker data query
CALC:MARK:Y? and the displayed value of the marker readout. The selection does not have to be
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the same as the measurement's display format.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1

<char> Choose from:

DEFault - The format of the selected measurement

MLINear - Linear magnitude

MLOGarithmic - Logarithmic magnitude

IMPedance - (R+jX)

ADMittance - (G+jB)

PHASe - Phase

IMAGinary - Imaginary part (Im)

REAL - Real part (Re)

POLar - (Re, Im)

GDELay - Group Delay

LINPhase - Linear Magnitude and Phase

LOGPhase - Log Magnitude and Phase

KELVin - temperature

FAHRenheit - temperature

CELSius - - temperature

NOISe - Noise (available ONLY in IM Spectrum and SA measurement

classes).

Examples CALC:MEAS:MARK:FORMat MLIN
calculate2:measure:marker8:format Character

Query Syntax CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FORMat?
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Return Type Character

Default DEFault

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:APEak:POLarity <char>

Applicable Models: All

(Read-Write) Sets or returns polarity of the peak search with marker 1 to 15 and reference marker (Mk

:16), for the active trace of selected channel.

Learn more about Marker Search

Parameters  

 <cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<char> Polarity for peak search function to be performed. Choose from:

"NEGative" : Specifies the negative peak.

"POSitive" : Specifies the positive peak.

"BOTH" : Specifies both the positive peak and the negative peak.

Examples CALC:MEAS:MARK:FUNC:APE:POL NEG
calculate2:measure1:marker6:function:apeak:polarity both

Query

Syntax

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:APEak:POLarity?

Return

Type

Character

Default "POSitive"

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:COMPression:LEVel <num>
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Applicable Models: All

(Read-Write) Sets and read the marker compression level. A compression marker must already exist.

Use CALC:MARK ON and CALC:MEAS:MARK:FUNC COMP to create compression markers.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<mkr> Any existing marker number from 1 to 15; if unspecified, value is set to 1.

<num> Compression level. Choose any number between: -500 dB to 500 dB

Standard gain compression values are positive.

Examples CALC:MEAS:MARK:FUNC:COMP:LEV 1
calculate2:measure1:marker:function:compression:level 1.5

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:COMPression:LEVel?

Return

Type
Numeric

Default +1 dB

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:COMPression:PIN?

Applicable Models: All

(Read-only)  Read the input power at the marker compression level. First send

CALC:MEAS:MARK:FUNC:EXEC COMP or CALC:MEAS:MARK:FUNC:TRAC ON .

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any existing marker number from 1 to 15; if unspecified, value is set to 1.

Examples CALC:MEAS:MARK:FUNC:COMP:PIN?
calculate2:measure1:marker:function:compression:pin?

Return

Type
Numeric

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:COMPression:POUT?
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Applicable Models: All

(Read-only)  Read the output power at the marker compression level. First send

CALC:MEAS:MARK:FUNC:EXEC COMP or CALC:MEAS:MARK:FUNC:TRAC ON

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any existing marker number from 1 to 15; if unspecified, value is set to 1.

Examples CALC:MEAS:MARK:FUNC:COMP:POUT?
calculate2:measure1:marker:function:compression:pout?

Return

Type
Numeric

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:COMPression[:STATe]
<bool>

Applicable Models: All

(Read-Write) Turns ON or OFF the compression state.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<bool> Bandwidth search result display:

ON or 1 - Turns ON the compression.

OFF or 0 - Turns OFF the compression.

Examples
CALC:MEAS:MARK:FUNC:COMP:STAT ON
calculate2:measure1:marker:function:compression:state off

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer:FUNCtion:COMPression[:STATe]?

Return

Type
Boolean

Default OFF or 0
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CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:DOMain:USER[:RANGe]
<range>

Applicable Models: All

(Read-Write) Assigns the specified marker to a range number. The x-axis travel of the marker is

constrained to the range's span. The span is specified with the

CALC:MEAS:MARK:FUNC:DOM:USER:START and STOP commands, unless range 0 is specified

which is the full span of the analyzer.

Each channel has 16 user ranges. (Trace statistics use the same ranges.) More than one marker can use a

domain range.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that channel.

If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on the

trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<range> User span. Choose any Integer from 0 to 16.

0 is Full Span of the analyzer.

1 to 16 are available for user-defined x-axis span.

Examples CALC:MEAS:MARK:FUNC:DOM:USER:RANG 1
calculate2:measure1:marker8:function:domain:user:range 1

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:DOMain:USER:RANGe?

Return

Type
Numeric

Default 0 - Full Span

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:DOMain:USER:STARt
<start>
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Applicable Models: All

(Read-Write) Sets the start of the span that the specified marker's x-axis span will be constrained to.

Use CALC:MEAS:MARK:FUNC:DOM:USER<range> to set range number.

Use CALC:MEAS:MARK:FUNC:DOM:USER:STOP to set the stop value.

Note: If the marker is assigned to range 0 (full span), the USER:STARt and STOP commands generate an

error. You cannot set the STARt and STOP values for "Full Span".

Note: This command does the same as CALC:FUNC:DOM:USER:STAR

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on the

trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<start> The analyzer's Minimum x-axis value

Examples CALC:MEAS:MARK:FUNC:DOM:USER:START 500E6
calculate2:measure1:marker8:function:domain:user:start 1e12

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:DOMain:USER:STARt?

Return

Type
Numeric

Default The analyzer's Minimum x-axis value

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:DOMain:USER:STOP <stop>
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Applicable Models: All

(Read-Write) Sets the stop of the span that the marker's x-axis travel will be constrained to.

Use CALC:MEAS:MARK:FUNC:DOM:USER<range> to set range number.

Use CALC:MEAS:MARK:FUNC:DOM:USER:STARt to set the stop value.

Note: If the marker is assigned to range 0 (full span), the USER:STARt and STOP commands generate an

error. You cannot set the STARt and STOP values for "Full Span".

Note: This command does the same as CALC:FUNC:DOM:USER:STOP

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on the

trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<stop> Stop value of x-axis span; Choose any number between the analyzer's MINimum and

MAXimum x-axis value.

Examples CALC:MEAS:MARK:FUNC:DOM:USER:STOP 500e6
calculate2:measure1:marker8:function:domain1:user:stop 1e12

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:DOMain:USER:STOP?

Return

Type
Numeric

Default The analyzer's MAXimum x-axis value.

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:EXECute <func>

775



Applicable Models: All

(Write-only) Immediately executes (performs) the specified search function.

Learn more about Marker Search

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<func> The function to be performed. Choose from:

MAXimum - finds the highest value.

MINimum - finds the lowest value.

RPEak - finds the next valid peak to the right.

LPEak - finds the next valid peak to the left.

NPEak - finds the next highest value among the valid peaks.

TARGet - finds the target value to the right, wraps around to the left.

LTARget - finds the next target value to the left of the marker.

RTARget - finds the next target value to the right of the marker.

COMPression - finds the compression level on a Power Swept S21 trace.
Examples CALC:MEAS:MARK:FUNC:EXEC MAX

calculate2:measure1:marker2:function:execute maximum

Query

Syntax
Not Applicable

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:EXECute <func>
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Applicable Models: All

(Write-only) Immediately executes (performs) the specified multi search function.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<func> The function to be performed. Choose from:

OFF - function is disabled.

PEAK - finds the peak value of a multi-peak search.

TARGet - finds the target value to the right, wraps around to the left.
Examples CALC:MEAS:MARK:FUNC:MULT:EXEC PEAK

calculate2:measure1:marker2:function:multi:execute target

Query

Syntax
Not Applicable

Default OFF

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:PEAK:EXCursion
<num><unit>

Applicable Models: All

(Read-Write) Sets or returns the lower limit of peak excursion value of multi peak search, for the selected

channel and selected trace.

Learn more about Marker Search

Parameters  

 <cnum> Channel number of the measurement. There must be a selected measurement on that channel. If

unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on the

trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<num> Excursion value. Choose any number between -500 and 500.

Notes: If the specified variable is out of the allowable setup range, the minimum value (if the

lower limit of the range is not reached) or the maximum value (if the upper limit of the range is

exceeded) is set.
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This command will accept MIN or MAX instead of a numeric parameter. See SCPI Syntax for

more information.

<unit> Varies depending on the data format.

Log magnitude (MLOG): dB (decibel)

Phase (PHAS), Expanded phase (UPH) or Positive phase (PPH): ° (degree)

Group delay (GDEL): s (second)

Others: No unit
Examples CALC:MEAS:MARK:FUNC:MULT:PEAK:EXC 10

calculate2:measure2:marker8:function:multi:peak:excursion maximum

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:PEAK:EXCursion?

Return

Type
Numeric

Default 3

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:PEAK:POLarity
<func>

Applicable Models: All

(Read-Write) Sets or returns the peak polarity of the multi peak search, for the selected channel and

selected trace.

Learn more about Marker Search

Parameters  

 <cnum> Channel number of the measurement. There must be a selected measurement on that channel.

If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on the

trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<func> Polarity for multi peak search function to be performed. Choose from:

"NEGative : Specifies the negative peak.

"POSitive" : Specifies the positive peak.

"BOTH" : Specifies both the positive peak and the negative peak.
Examples CALC:MEAS:MARK:FUNC:MULT:PEAK:POL NEG

calculate2:measure1:marker6:function:multi:peak:polarity both
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Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:PEAK:POLarity?

Return

Type
Character

Default "POSitive"

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:PEAK:THReshold
<num>

Applicable Models: All

(Read-Write) Sets peak threshold for the specified marker. If a peak (using the criteria set with :EXCursion) is

below this reference value, it will not be considered when searching for peaks. This command applies to

marker peak searches (Next peak, Peak Right, Peak Left).

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that channel. If

unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on the

trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<num> Threshold value.Choose any number betwe en -500 and 500.

Note : This command will accept MIN or MAX instead of a numeric parameter. See SCPI

Syntax for more information.

Examples CALC:MEAS:MARK:FUNC:MULT:PEAK:THR -40
calculate2:measure1:marker8:function:multi:peak:threshold -55

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:PEAK:THReshold?

Return

Type
Numeric

Default -100

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:SELect<char>
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Applicable Models: All

(Read-Write) Sets or returns the search type of the multi search, for the selected channel and selected

trace.

Learn more about Marker Search

Parameters  

 <cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<char> Select from the following:

"OFF ": Turn OFF the multi search function.

"PEAK ": Sets the search type to the multi peak search.

"TARGet ": Sets the search type to the multi target search.
Examples CALC:MEAS:MARK:FUNC:MULT:SEL BOTH

calculate2:measure1:marker6:function:multi:select both

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:SELect?

Return Type Character

Default "OFF"

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:TARGet:TRANsition
<char>
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Applicable Models: All

(Read-Write) Sets the transition type of the multi target search.

Learn more about Marker Search

Parameters  

 <cnum> Channel number of the measurement. There must be a selected measurement on that channel. If

unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on the trace.

If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<char> Transition type of multi target search function to be performed. Choose from:

"NEGative" : Specifies the negative transition.

"POSitive" : Specifies the positive transition.

"BOTH" : Specifies both the positive transition and the negative transition.
Examples CALC:MEAS:MARK:FUNC:MULT:TARG:TRAN BOTH

calculate2:measure1:marker6:function:multi:target:transition both

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:TARGet:TRansition?

Return

Type
Character

Default "BOTH"

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:TARGet[:VALue]
<num><unit>
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Applicable Models: All

(Read-Write) Sets or returns the target value for the specified marker when doing Multi Target Search, for the

selected channel and selected trace.

Learn more about Marker Search

Parameters  

 <cnum> Channel number of the measurement. There must be a selected measurement on that channel.

If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on the

trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<num> Target value for multi target search to search for.

The range of target value is -5E8 to 5E8.

Notes: If the specified variable is out of the allowable setup range, the minimum value (if the

lower limit of the range is not reached) or the maximum value (if the upper limit of the range is

exceeded) is set.

<unit> Varies depending on the data format.

Log magnitude (MLOG): dB (decibel)

Phase (PHAS), Expanded phase (UPH) or Positive phase (PPH): ° (degree)

Group delay (GDEL): s (second)

Others: No unit
Examples CALC:MEAS:MARK:FUNC:MULT:TARG 2.5

calculate2:measure2:marker5:function:multi:target:value -10.3

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:TARGet[:VALue]?

Return

Type
Numeric

Default 0

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:TRACking <bool>
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Applicable Models: All

(Read-Write) Turns ON or OFF the search tracking capability (function to repeat search for each

sweep) of the multi search, for the selected channel and selected trace.

Learn more about Marker Search

Parameters  

 <cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<bool> ON or 1 - Turns ON the marker search tracking. The specified multi marker will "Track"

(find) the selected function every sweep.

OFF or 0 - Turns OFF the marker search tracking. The specified multi marker will find

the selected function only when the CALC:MEAS:MARK:FUNC:EXECute command is

sent.

Examples CALC:MEAS:MARK:FUNC:MULT:TRAC ON
calculate2:measure2:marker8:function:multi:tracking off

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:MULTi:TRACking?

Return

Type
Boolean

Default OFF or 0

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:PEAK:EXCursion <num>

Applicable Models: All

(Read-Write) Sets amplitude peak excursion for the specified marker. The Excursion value determines
what is considered a "peak". This command applies to marker peak searches (Next peak, Peak Right,

Peak Left).

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any existing marker number from 1 to 10; if unspecified, value is set to 1.
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<num> Excursion value. Choose any number between -500 and 500.

Note : This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:MEAS:MARK:FUNC:PEAK:EXC 10
calculate2:measure2:marker8:function:peak:excursion maximum

Query Syntax CALCulate<cnum>:MARKer<mkr>:FUNCtion:PEAK:EXCursion?

Return Type Numeric

Default 3

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:PEAK:POLarity <char>

Applicable Models: All

(Read-Write) Sets or returns polarity of the peak search with marker 1 to 15 and reference marker

(Mk :16), for the active trace of selected channel.

Learn more about Marker Search

Parameters  

 <cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<char> Polarity for peak search function to be performed. Choose from:

"NEGative" : Specifies the negative peak.

"POSitive" : Specifies the positive peak.

"BOTH" : Specifies both the positive peak and the negative peak.
Examples CALC:MEAS:MARK:FUNC:APE:POL NEG

calculate2:measure1:marker6:function:apeak:polarity both

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:APEak:POLarity?

Return

Type
Character

Default "POSitive"

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:PEAK:THReshold <num>
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Applicable Models: All

(Read-Write) Sets peak threshold for the specified marker. If a peak (using the criteria set with

:EXCursion) is below this reference value, it will not be considered when searching for peaks. This

command applies to marker peak searches (Next peak, Peak Right, Peak Left).

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1

<num> Threshold value.Choose any number betwe en -500 and 500.

Note : This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:MEAS:MARK:FUNC:APE:THR -40
calculate2:measure:marker8:function:apeak:threshold -55

Query Syntax CALCulate<cnum>:MARKer<mkr>:FUNCtion:APEak:THReshold?

Return Type Numeric

Default -100

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion[:SELect] <char>

Applicable Models: All

(Read-Write) Sets the search function that the specified marker will perform when executed. Use

CALC:MEAS:MARK:FUNC:TRAC ON to automatically execute the search every sweep.

Learn more about Marker Search

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that
channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<char> Marker function. Choose from:

MAXimum - finds the highest value
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MINimum - finds the lowest value

RPEak - finds the next valid peak to the right

LPEak - finds the next valid peak to the left

NPEak - finds the next highest value among the valid peaks

TARGet - finds the target value to the right, wraps around to the left

LTARget - finds the next target value to the left of the marker

RTARget - finds the next target value to the right of the marker

COMPression - finds the compression level on a power-swept S21 trace.
Examples CALC:MEAS:MARK:FUNC MAX

calculate2:measure1:marker8:function:select ltarget

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion[:SELect]?

Return

Type
Character

Default MAXimum

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:TARGet[:VALue]:TRANsition
<char>

Applicable Models: All

(Read-Write) Selects the transition type of the target search for specified marker (marker 1 to 15 and reference

marker (Mk :16)) of the active trace of selected channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that channel. If

unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on the trace. If
unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<char> Transition type for search function to be performed. Choose from:

"NEGative " : Specifies the negative transition.

"POSitive " : Specifies the positive transition.

"BOTH " : Specifies both the positive transition and the negative transition.
Examples CALC:MEAS:MARK:FUNC:TARG:TRAN POS

calculate2:measure1:marker8:function:target:value:transition both
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Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:TARGet[:VALue]:TRANsition?

Return

Type
Character

Default "BOTH"

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:TARGet[:VALue] <num>

Applicable Models: All

(Read-Write) Sets the target value for the specified marker when doing Target Searches with

CALC:MEAS:MARK:FUNC:SEL <TARGet | RTARget | LTARget>

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<num> Target value to search for.

The range of value is between -5E8 to 5E8.

Notes: If the specified variable is out of the allowable setup range, the minimum value

(if the lower limit of the range is not reached) or the maximum value (if the upper limit

of the range is exceeded) is set.

<unit> Varies depending on the data format.

Log magnitude (MLOG): dB (decibel)

Phase (PHAS), Expanded phase (UPH) or Positive phase (PPH): ° (degree)

Group delay (GDEL): s (second)

Others: No unit
Examples CALC:MEAS:MARK:FUNC:TARG 2.5

calculate2:measure1:marker8:function:target:value -10.3

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:TARGet[:VALue]?

Return

Type
Numeric

Default 0
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CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:TRACking <bool>

Applicable Models: All

(Read-Write) Turns ON or OFF the tracking search capability for the specified marker. The tracking

function finds the selected search function every sweep. In effect, turning Tracking ON is the same

as doing a CALC:MEAS:MARK:FUNC:EXECute command every sweep.

Learn more about Marker Search

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<bool> ON or 1 - Turns ON the search tracking. The specified marker will "Track" (find) the

selected function every sweep.

OFF or 0  - Turns OFF the search tracking. The specified marker will find the selected

function only when the CALC:MEAS:MARK:FUNC:EXECute command is sent.

Examples CALC:MEAS:MARK:FUNC:TRAC ON
calculate2:measure1:marker8:function:tracking off

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:FUNCtion:TRACking?

Return

Type
Boolean

Default OFF or 0

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:NOTCh:DATA?
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Applicable Models: All

(Read-only) Reads the notch search result of marker 1 to 15 and reference marker (Mk :16), for the

active trace of selected channel.

If the notch search is impossible, an error occurs and the command is ignored. In this case, no query

response is obtained.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

  Indicates 4-element array data (notch bandwidth search result). Four Character values

separated by commas => {Data 1}, {Data 2}, {Data 3}, {Data 4}

Data(0) :The bandwidth.

Data(1) :Center point frequency of the 2 cutoff frequency points.

Data(2) :The Q value.

Data(3) :Insertion loss

The index of the array starts from 0.

Examples CALC:MEAS:MARK:NOTC:DATA?
calculate2:measure1:marker:notch:data?

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:NOTCh:DATA?

Return

Type
Variant

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:NOTCh:REF <string>

789



Applicable Models: All

(Read-Write) Set the notch marker reference to either MARKer or PEAK.

If the reference is set to MARKer, the active marker is not moved; the notch search is computed at

the marker's current location.

If the reference is set to PEAK, the active marker is moved to the maximum or minimum peak on the

trace and then notch search is computed.

If the notch level is negative, the active marker is moved to the maximum peak.

If the notch level is positive, the active marker is moved to minimum peak.
Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<string> PEAK

MARKer

Examples CALC:MEAS:MARK:NOTCh:REF
calculate2:measure1:marker:notch:ref

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:NOTCh:REF?

Return

Type
String

Default MARKer

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:NOTCh[:STATe] <bool>
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Applicable Models: All

(Read-Write) Turns ON or OFF the notch search result display, for the active trace of selected

channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<bool> Notch search result display. Choose from:

ON or 1 - Turns ON the notch search result display.

OFF or 0 - Turns OFF the notch search result display.

Examples CALC:MEAS:MARK:NOTC ON
calculate2:measure1:marker:notch:state off

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:NOTCh[:STATe]?

Return

Type
Boolean

Default OFF or 0

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:NOTCh:THReshold <num>

Applicable Models: All

(Read-Write) Sets or returns the notch definition value of marker 1 to 15 and reference marker (Mk

:16), for the active trace of selected channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<num> The notch definition value range is between -5E8 to 5E8.

Notes: If the specified parameter is out of the allowable setup range, the minimum

value (if the lower limit of the range is not reached) or the maximum value (if the upper

limit of the range is exceeded) is set.

<unit> Varies depending on the data format as follows:
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Amplitude (MLOG):dB (decibel)

Phase (PHAS), Expanded phase (UPH),Positive phase (PPH): ° (degree)

Group delay (GDEL): s (second)

Others: No unit
Examples CALC:MEAS:MARK:NOTC:THR -3

calculate2:measure1:marker:notch:threshold -3

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:NOTCh:THReshold?

Return

Type
Numeric

Default -3

CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:BACKoff <num>

Applicable Models: All

(Read-Write) Turns on and sets markers 1, 2, 3, and 4 to calculate various PNOP parameters.

E ither this command, or the POFFset command, will initiate the PNOP search markers.

To turn off the PNOP markers, either turn them off individually or turn them All Off .

To search a User Range with the PNOP search, first activate marker 1 and set the desired User Range .

Then send CALC:MARK:PNOP:BACK.  The user range used with the PNOP search only applies to

marker 1 searching for the linear gain value. The other markers may fall outside the user range.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<num> Backoff value. Choose any number between :-500 and 500

Examples CALC:MEAS:MARK:PNOP:BACK?

calculate2:measure1:marker:pnop:backoff 10

Query Syntax CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:BACKoff?

Return Type Numeric

Default 0
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CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:BACKoff:GAIN?

Applicable Models: All

(Read-only) Reads the power backoff gain value from a PNOP marker search.

PBO Gain =  PBO Out - PBO In

Use CALC:MARK:PNOP:BACK or CALC:MARK:PNOP:POFF to initiate a PNOP search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS1:MARK:PNOP:BACK:GAIN?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:BACKoff:PIN?

Applicable Models: All

(Read-only) Reads the power backoff input value from a PNOP marker search.

PBO In =  Marker 2 X-axis

Use CALC:MARK:PNOP:BACK or CALC:MARK:PNOP:POFF to initiate a PNOP search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS1:MARK:PNOP:BACK:PIN?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:BACKoff:POUT?
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Applicable Models: All

(Read-only) Reads the power backoff output value from a PNOP marker search.

PBO Out =  Marker 2 Y-axis

Use CALC:MARK:PNOP:BACK or CALC:MARK:PNOP:POFF to initiate a PNOP search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS1:MARK:PNOP:BACK:POUT?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:COMPression?

Applicable Models: All

(Read-only) Reads the PNOP compression value from a PNOP marker search.

Pnop Comp =  Pnop Gain - Linear Gain (not shown on marker readout).

Use CALC:MARK:PNOP:BACK or CALC:MARK:PNOP:POFF to initiate a PNOP search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS1:MARK:PNOP:COMP?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:COMPression:MAXimum?
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Applicable Models: All

(Read-only) Reads the max compression value from a PNOP marker search.

Comp Max =  Gain Max - Linear Gain (not shown on marker readout).

Use CALC:MARK:PNOP:BACK or CALC:MARK:PNOP:POFF to initiate a PNOP search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS1:MARK:PNOP:COMP:MAX?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:GAIN?

Applicable Models: All

(Read-only) Reads the PNOP gain value from a PNOP marker search.

Pnop Gain =  Pnop Out - Pnop In.

Use CALC:MARK:PNOP:BACK or CALC:MARK:PNOP:POFF to initiate a PNOP search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS:MARK:PNOP:GAIN?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:GAIN:MAXimum?
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Applicable Models: All

(Read-only) Reads the max gain from a PNOP marker search.

Gain Max =  PMax Out - PMax In

Use CALC:MARK:PNOP:BACK or CALC:MARK:PNOP:POFF to initiate a PNOP search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS:MARK:PNOP:GAIN:MAX?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:PIN?

Applicable Models: All

(Read-only) Reads the PNOP input value from a PNOP marker search.

Pnop In =  Marker 4 X-axis value

Use CALC:MARK:PNOP:BACK or CALC:MARK:PNOP:POFF to initiate a PNOP search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS:MARK:PNOP:PIN?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:PIN:MAXimum?
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Applicable Models: All

(Read-only) Reads the max input power from a PNOP marker search.

PMax In =  Marker 3 X-axis value

Use CALC:MARK:PNOP:BACK or CALC:MARK:PNOP:POFF to initiate a PNOP search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS:MARK:PNOP:PIN:MAX?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:POFFset <num>

Applicable Models: All

(Read-Write) Turns on and sets markers 1, 2, 3, and 4 to calculate various PNOP parameters.

Either this command, or the Backoff command, will initiate the PNOP search markers.

To turn off the PNOP markers, either turn them off individually or turn them All Off .

To search a User Range with the PNOP search, first activate marker 1 and set the desired User Range .

Then send the CALC:MARK:PNOP:POFF command. The user range used with the PNOP search

only applies to marker 1 searching for the linear gain value. The other markers may fall outside the

user range.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<num> Power Offset  value in dB. Choose any number between :-500 and 500

Examples CALC:MEAS1:MARK:PNOP:POFF 3

calculate2:measure2:marker:pnop:poffset 10

Query Syntax CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:POFFset?
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Return Type Numeric

Default 0

CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:POUT?

Applicable Models: All

(Read-only) Reads the output power value of the offset marker from a PNOP marker search.

Pnop Out =  Marker 4 Y-axis value

Use CALC:MARK:PNOP:BACK or CALC:MARK:PNOP:POFF to initiate a PNOP search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:MARK:PNOP:POUT?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PNOP:POUT:MAXimum?

Applicable Models: All

(Read-only) Reads the max output power from a PNOP marker search.

PMax Out =  Marker 3 Y-axis value

Use CALC:MARK:PNOP:BACK or CALC:MARK:PNOP:POFF to initiate a PNOP search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement
on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:MARK:PNOP:POUT:MAX?

Default Not applicable
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CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:PNOP[:STATe] <ON|OFF>

Applicable Models: All

(Read-Write) Turns the PNOP marker search ON and OFF.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<ON|OFF> ON (or 1) - turns marker ON.

OFF (or 0) - turns marker OFF.

Examples CALC:MEAS1:MARK:PNOP ON
calculate2:measure2:marker8:pnop on

Query Syntax CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:PNOP:STATe?

Return Type Boolean (1 = ON, 0 = OFF)

Default Off

CALCulate<cnum>:MEASure<mnum>:MARKer:PSATuration:BACKoff <num>

Applicable Models: All

(Read-Write)  Turns on and sets markers 1, 2, and 3 to calculate various Power Saturation parameters.

The <num> parameter sets and reads the back-off value for a Power Saturation marker search.

To turn off the Power Saturation markers, either turn them off individually or turn them All Off .

To search a User Range with the PSAT search, first activate marker 1 and set the desired User Range .

Then send the CALC:MARK:PSAT:BACK command. The user range used with the PSAT search
only applies to marker 1 searching for the linear gain value. The other markers may fall outside the

user range.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected
measurement on the trace. If unspecified, <mnum> is set to 1.
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<num> Backoff value. Choose any number between :-500 and 500

Examples CALC:MEAS2:MARK:PSAT:BACK 3
calculate2:measure2:marker:psaturation:backoff 10

Query Syntax CALCulate<cnum>:MEASure<mnum>:MARKer:PSATuration:BACKoff?

Return Type Numeric

Default 0

CALCulate<cnum>:MEASure<mnum>:MARKer:PSATuration:COMPression:MAXimum?

Applicable Models: All

(Read-only) Reads the compression maximum value from a PSAT marker search.

Comp Max = Gain Max - Gain Linear

Use CALC:MARK:PSAT:BACK to initiate a PSAT search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:MARK:PSAT:COMP:MAX?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PSATuration:COMPression:SATuration?
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Applicable Models: All

(Read-only) Reads the compression saturation value from a PSAT marker search.

Comp Sat = Gain Sat - Gain Linear

Use CALC:MARK:PSAT:BACK to initiate a PSAT search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:MARK:PSAT:COMP:SAT?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PSATuration:GAIN?

Applicable Models: All

(Read-only) Reads the saturation gain value from a PSAT marker search.

Gain Sat = Psat Out - Psat In

Use CALC:MARK:PSAT:BACK to initiate a PSAT search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:MARK:PSAT:GAIN?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PSATuration:GAIN:LINear?
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Applicable Models: All

(Read-only) Reads the linear gain value from a PSAT marker search.

Gain Linear = Marker 1 - Y-axis value MINUS X-axis value.

Use CALC:MARK:PSAT:BACK to initiate a PSAT search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:MARK:PSAT:GAIN:LIN?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PSATuration:GAIN:MAXimum?

Applicable Models: All

(Read-only) Reads the maximum gain value from a PSAT marker search.

Gain Max = PMax Out - PMax In

Use CALC:MARK:PSAT:BACK to initiate a PSAT search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:MARK:PSAT:GAIN:MAX?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PSATuration:PIN?
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Applicable Models: All

(Read-only) Reads the power saturation input value from a PSAT marker search.

Psat In = Marker 2 X-axis value

Use CALC:MARK:PSAT:BACK to initiate a PSAT search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:MARK:PSAT:PIN?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PSATuration:PIN:MAXimum?

Applicable Models: All

(Read-only) Reads the maximum input power from a PSAT marker search.

PMax In = Marker 3 X-axis value

Use CALC:MARK:PSAT:BACK to initiate a PSAT search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:MARK:PSAT:PIN:MAX?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PSATuration:POUT?
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Applicable Models: All

(Read-only) Reads the back-off output power from a PSAT marker search.

PSat Out = Marker 2 Y-axis value

Use CALC:MARK:PSAT:BACK to initiate a PSAT search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:MARK:PSAT:POUT?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer:PSATuration:POUT:MAXimum?

Applicable Models: All

(Read-only) Reads the back-off output power from a PSAT marker search.

PMaxOut = Marker 3 Y-axis value

Use CALC:MARK:PSAT:BACK to initiate a PSAT search.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples CALC:MEAS2:MARK:PSAT:POUT:MAX?

Default Not applicable

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:PSATuration[:STATe] <ON|OFF>
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Applicable Models: All

(Read-Write) Turns the PSAT marker search ON and OFF.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on

that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<ON|OFF> ON (or 1) - turns marker ON.

OFF (or 0) - turns marker OFF.

Examples CALC:MEAS1:MARK:PSAT ON
calculate2:measure2:marker8:psaturation on

Query Syntax CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:PSATuration:STATe?

Return Type Boolean (1 = ON, 0 = OFF)

Default Off

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:REFerence[:STATe] <bool>

Applicable Models: All

(Read-Write) Turns ON or OFF the reference marker mode, for the active trace of selected channel.

When turned OFF, existing Delta markers revert to absolute markers.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<bool> ON or 1 - Turns reference marker mode ON.

OFF or 0 - Turns reference marker mode OFF.

Examples CALC:MEAS:MARK:REF ON
calculate2:measure1:marker:reference:state OFF

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:REFerence[:STATe]?

Return

Type
Boolean
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Default OFF or 0

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:REFerence:X <num>

Applicable Models: All

(Read-Write) Sets and returns the absolute x-axis value of the reference marker.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<num> X-axis value. Choose any number within the operating domain of the reference

marker.

Examples CALC:MEAS:MARK:REF:X 1e9

calculate2:measure1:marker:reference:x 1e6

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:REFerence:X?

Return

Type
Numeric

Default If the first Marker, turns ON in the middle of the X-axis span. If not, turns ON at the

position of the active marker.

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:REFerence:Y <num>

Applicable Models: All

(Read-Write) Sets and returns the absolute Y-axis value of the reference marker (Set the reference

marker Y position only when the marker is a fixed marker type).

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<num> Y-axis value. Choose any number within the operating domain of the reference

marker.

Examples CALC:MEAS:MARK:REF:Y 1e6

calculate2:measure1:marker:reference:y 1e9
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Return

Type
Numeric

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:SET <char>

Applicable Models: All

(Write-only) Sets the selected instrument setting to assume the value of the specified marker.

Marker Functions CENT, SPAN, STARt, and STOP do not work with channels that are in CW or

Segment Sweep mode.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1

<char> Choose from:

CENTer - changes center frequency to the value of the marker.

SPAN -   changes the sweep span to the span that is defined by the delta marker and the
marker that it references. Unavailable if there is no delta marker.

STARt - changes the start frequency to the value of the marker.

STOP - changes the stop frequency to the value of the marker.

RLEVel - changes the reference level to the value of the marker.

DELay - changes the line length at the receiver input to the phase slope at the active
marker stimulus position.

CWFReq - Sets the CW frequency to the frequency of the active marker. Does NOT
change sweep type. NOT available in CW or Power Sweep. Use this argument to first set
the CW Frequency to a value that is known to be within the current calibrated range, THEN
set Sweep:Type to POWer or CW.

Examples CALC:MEAS:MARK:SET CENT
calculate2:measure1:marker8:set span

Query

Syntax
Not Applicable

Default Not Applicable
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CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>[:STATe] <bool>

Applicable Models: All

(Read-Write) Turns ON or OFF the specified marker. Marker 16 is the Reference Marker. To turn all

markers OFF, use CALC:MEAS:MARK:AOFF .

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<bool> ON or 1 - Turns marker ON.

OFF or 0 - Turns marker OFF.

Examples CALC:MEAS:MARK ON
calculate2:measure1:marker8 off

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:STATe?

Return

Type
Boolean

Default OFF or 0

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:TYPE <char>

Applicable Models: All

(Read-Write) Sets the type of the specified marker.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1

<char> Choose from:

NORMal - a marker that stays on the assigned X-axis position unless moved or searching.

FIXed - a marker that will not leave the assigned X or current Y-axis position.
Examples CALC:MEAS:MARK:TYPE NORM

calculate2:measure1:marker2:type fixed

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:TYPE?
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Return

Type
Character

Default NORMal

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:X <num>

Applicable Models: All

(Read-Write) Sets the marker's X-axis value (frequency, power, or time). If the marker is set as delta,

the SET and QUERY data is relative to the reference marker.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

<num> Any X-axis position within the measurement span of the marker.

(When the span value of the sweep range is 0, the range is from 0 to sweep time value.)

Notes: If the specified variable is out of the allowable setup range, the minimum value

(if the lower limit of the range is not reached) or the maximum value (if the upper limit

of the range is exceeded) is set.

This command will accept MIN or MAX instead of a numeric parameter. See SCPI

Syntax for more information.

<unit> Hz (hertz), dBm or s (second)

Examples CALC:MEAS:MARK:X 100Mhz
calculate2:measure1:marker8:x maximum

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:X?

Return
Type

Numeric

Default First Marker turns ON in the middle of the X-axis span. Subsequent markers turn ON at

the position of the active marker.

(When the span value of the sweep range is 0, the preset value is 0.)

CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:Y?
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Applicable Models: All

(Read-only) Reads the marker's Y-axis value. The format of the value depends on the current

CALC:MEAS:MARK:FORMAT setting. If the marker is set as delta, the data is relative to the

reference marker. The query always returns two numbers:

Smith and Polar formats - (Real, Imaginary)

LINPhase and LOGPhase - (Real, Imaginary)

All other formats - (Value,0)

Note: To accurately read the marker Y-axis value with trace smoothing applied, the requested format

must match the displayed format . Otherwise, the returned value is un-smoothed data. For example, to

read the smoothed marker value when measuring group delay, both the display format and the marker

format must be set to (Group) Delay.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<mkr> Any marker number from 1 to 15; if unspecified, value is set to 1.

Examples CALC:MEAS:MARK:Y?
calculate2:measure1:marker3:y?

Query Syntax CALCulate<cnum>:MEASure<mnum>:MARKer<mkr>:Y?

Return Type Numeric

Default Not Applicable
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CALCulate:MEASure:OFFSet Commands

Allows the data trace magnitude and phase to be offset.

CALCulate:MEASure:OFFSet

MAGNitude

       | SLOPe

PHASe

Click a keyword to view the command details.

See Also

Learn about Magnitude Offset

Learn about Phase Offset

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<cnum>:MEASure<mnum>:OFFSet:MAGNitude <num>

Applicable Models: All

(Read-Write) Offsets the data trace magnitude by the specified value.

To offset the data trace magnitude to a slope value that changes with frequency, use
CALC:MEAS:OFFS:MAGN:SLOP
Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that
channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num> Offset value in dB.

Examples CALC:MEAS:OFFS:MAGN:4
calculate1:measure2:offset:magnitude -2

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:OFFSet:MAGNitude?

Return
Type

Numeric

Default 0
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CALCulate<cnum>:MEASure<mnum>:OFFSet:MAGNitude:SLOPe <num>

Applicable Models: All

(Read-Write) Offsets the data trace magnitude to a value that changes linearly with frequency. The

offset slope begins at 0 Hz.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num> Offset slope value in dB/ 1GHz.

Examples CALC:MEAS:OFFS:MAGN:SLOP 1 'Offset slope set to 1dB/GHz
calculate1:measure2:offset:magnitude:slope -2 'Offset slope set to -
2dB/GHz

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:OFFSet:MAGNitude:SLOPe?

Return

Type
Numeric

Default 0

CALCulate<cnum>:MEASure<mnum>:OFFSet:PHASe <num>[<char>]

Applicable Models: All

(Read-Write) Sets the phase offset for the selected measurement.

Parameters  

<cnum>
Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum>
Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num>
Offset phase value. Choose any number between:

-360 and 360

<char>

Units for phase. OPTIONAL. Choose either:

DEG - Degrees (default)

RAD - Radians

Examples
CALC:MEAS:OFFS:PHAS 10
calculate3:measure2:offset:phase 20rad

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:OFFSet:PHASe?
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Return

Type
Numeric, returned value always in degrees

Default 0 degrees
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CALCulate:MEASure:PARameter Commands

Selects a measurement parameter.

CALCulate:MEASure

PARameter

 

Click a keyword to view the command details.

See Also

Learn about Measurement Parameters

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<cnum>:MEASure<mnum>:PARameter <string>

Applicable Models: All

(Read-Write) Set/get a measurement parameter for the specified (cnum/mnum) measurement.

This command replaces the following commands:

CALC:CUST:MOD

CALC:PAR:MOD:EXT

CALC:FSIM:BAL:PAR:SBAL[:DEF]

CALC:FSIM:BAL:PAR:SSB[:DEF]

CALC:FSIM:BAL:PAR:BBAL[:DEF]

CALC:FSIM:BAL:PAR:BALS[:DEF]

CALC:FSIM:BAL:PAR:BAL[:DEF]

 

Note: For Application Measurements see CALCulate:MEASure:DEFine

Parameters  

<cnum> Channel number of the measurements to be listed. There must be a selected

measurement on that channel. If unspecified, <cnum> is set to 1.
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<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<string> (String ) Measurement Parameter to create. Case sensitive.

For S-parameters:

Any S-parameter available in the VNA

Single-digit port numbers CAN be separated by "_" (underscore). For example:

"S21" or "S2_1"

Double-digit port numbers MUST be separated by underscore. For example:

"S10_1"

For ratioed measurements:

Any two VNA physical receivers separated by forward slash '/' followed by

comma and source port.

For example: "A/R1, 3"

Learn more about ratioed measurements

See a block diagram showing the receivers in YOUR VNA.

For non-ratioed measurements:

Any VNA physical receiver followed by comma and source port.

For example: "A, 4"

Learn more about unratioed measurements.

See the block diagram showing the receivers in YOUR VNA.

Ratioed and Unratioed measurements can also use logical receiver notation to refer to

receivers. This notation makes it easy to refer to receivers with an external test set

connected to the VNA. You do not need to know which physical receiver is used for

each test port. Learn more.

For ADC measurements:

Any ADC receiver in the VNA followed by a comma, then the source port.

For example: "AI1,2" indicates the Analog Input1 with source port of 2.

Learn more about ADC receiver measurements.
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For Balanced Measurements:

For 1 port balanced measurement, choose from:

Sdd11, Scd11, Sdc11, Scc11

 

For Balanced - Single-ended measurement, choose from:

Sdd11, Scd11, Sdc11, Scc11, Ssd21, Ssc21, Sds12, Scs12, Sss22, Imb, CMMR1,

CMMR2

Imb = - S_1pos_2/S_1neg_2

CMMR1 = Ssd21/Ssc21

CMMR2 = Sds12/Scs12

For Single-ended - Balanced measurement, choose from:

Sss11, Sds21, Scs21, Ssd12, Ssc12, Sdd22, Scd22, Sdc22, Scc22, Imb, CMMR1,

CMMR2

Imb = - S_2pos_1/S_2neg_1

CMMR1 = Sds21/Scs21

CMMR2 = Ssd12/Ssc12

For Balanced - Balanced measurement, choose from:

Sdd11, Sdd21, Sdd12, Sdd22, Scd11, Scd21, Scd12, Scd22, Sdc11, Sdc21, Sdc12,

Sdc22,

Scc11, Scc21, Scc12, Scc22, Imb1, Imb2, CMMR

Imb1 = - (S_1pos_2pos – S_1pos_2neg)/(S_1neg_2pos – S_1neg_2neg)

Imb2 = - (S_2pos_1pos – S_2pos_1neg)/(S_2neg_1pos – S_2neg_1neg)

CMMR = - Sdd21/Scc21

For Single-ended - Single-ended - Balanced measurement, choose form:

Sss11, Sss21, Sss12, Sss22, Sds31, Scs31, Sds32, Scs32, Ssd13, Ssd23, Ssc13, Ssc23,

Sdd33, Scd33, Sdc33, Scc33, Imb1, Imb2, CMMR1, CMMR2
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Imb1 = - (S_1pos_2pos – S_1pos_2neg)/(S_1neg_2pos – S_1neg_2neg)

Imb2 = - (S_2pos_1pos – S_2pos_1neg)/(S_2neg_1pos – S_2neg_1neg)

Imb3 = - S_3pos_1/S_3neg_1

Imb4 = - S_3pos_2/S_3neg_2

CMMR1 = Sds31/Scs31

CMMR2 = Sds32/Scs32

Note: The right definition for SSB imbalance is added as Imb3, 4. The definition for

SSB Imb1, 2 seem a mistake, but keep it remained for backward compatibility.

Note: For Application Measurements see CALCulate:MEASure:DEFine

Examples CALC:MEAS:PAR "Sdd11"

calculate2:measure2:parameter "Sdd11"

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:PARameter?

Return

Type
String

Default "S11"
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CALCulate:MEASure:RLIMit Commands

These commands are for setting up ripple tests.

CALCulate:MEASure:RLIMit

DATA

DISPlay

       | LINE

             | STATe

       | SELect

       | TYPe

FAIL

REPort

       | DATA

STATe

Click a keyword to view the command details.

See Also

Learn about Ripple tests

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<cnum>:MEASure<mnum>:RLIMit:DATA <data>
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Applicable Models: All

(Read-Write) Sets or returns the ripple limit table for the active trace of selected channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<data> Indicates the array data (for ripple line) of 1 + Num (number of limit lines)* 4. Where n

is an integer between 1 and Num.

Data(0) :The number of limit lines you want to set. Specify an integer ranging 0 to 12. When
the number of limit lines is set to 0 (clears the limit table), the variable Data is only required
with Data(0).

Data(nx4-3) :The type of the n-th line.

Specify an integer 0 to 1 as follows.

0: OFF

1: ON

Data(nx4-2) :The value on the horizontal axis (frequency/power/time) of the start point of the
n-th line.

Data(nx4-1) :The value on the horizontal axis (frequency/power/time) of the end point of the
n-th line.

Data(nx4) :The ripple line value (dB) of the n-th line.

The index of the array starts from 0.

Examples CALC:MEAS:RLIM:DATA
calculate2:measure2:rlimit:data

Query

Syntax

CALCulate<cnum>:MEASure<mnum>:RLIMit:DATA?

Return

Type

Variant type Array

Default OFF

CALCulate<cnum>:MEASure<mnum>:RLIMit:DISPlay:LINE:STATe <bool>
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Applicable Models: All

(Read-Write) Turns ON/OFF the ripple limit line display, for the active trace of selected channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<bool> ON or 1 - Turns limit testing ON.

OFF or 0 - Turns limit testing OFF.

Examples CALC:MEAS:RLIM:DISP:LINE:STAT ON
calculate2:measure2:rlimit:display:line:state off

Query

Syntax

CALCulate<cnum>:MEASure<mnum>:RLIMit:DISPLay:LINE:STATe?

Return

Type

Boolean

Default OFF

CALCulate<cnum>:MEASure<mnum>:RLIMit:DISPlay:SELect <band>

Applicable Models: All

(Read-Write) Sets or gets the ripple limit band for ripple value display for selected channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<band>  1 to 12

Examples CALC:MEAS:RLIM:DISP:RIPP:SEL

calculate2:measure2:rlimit:display:ripple:select

Query

Syntax

CALCulate<cnum>:MEASure<mnum>:RLIMit:DISPlay:SELect?

Return
Type

Numeric

Default 1

CALCulate<cnum>:MEASure<mnum>:RLIMit:DISPlay:TYPE <typ>
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Applicable Models: All

(Read-Write) Sets/gets the display type of ripple value for the active trace of selected channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<typ> Select from the following:

"OFF": Specifies the display OFF.

"ABSolute": Specifies the absolute value for display type.

"MARgin": Specifies the margin for display type.
Examples CALC:MEAS:RLIM:DISP:TYPE

calculate2:measure2:rlimit:display:type

Query

Syntax

CALCulate<cnum>:MEASure<mnum>:RLIMit:DISPLay:TYPE?

Return

Type

Boolean

Default OFF

CALCulate<cnum>:MEASure<mnum>:RLIMit:FAIL

Applicable Models: All

(Read-only) Read the ripple test result for the active trace.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that
channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<bool> Boolean

0 is returned when Pass

1 is returned when Fail
Examples CALC:MEAS:RLIM:FAIL?

calculate2:measure2:rlimit:FAIL?

Query
Syntax

CALCulate<cnum>:MEASure<mnum>:RLIMit:FAIL?
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Return

Type

Boolean

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:RLIMit:REPort:DATA

Applicable Models: All

(Read-only) Reads the ripple value of the ripple test for the active trace.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<data> {numeric 1} ... {numeric NOP×3+1}<newline><^END>

NOP is the number of measurement points.

{numeric 1}: Number of ripple limit line

{numeric n×3-1} : Number of ripple limit bands.

{numeric n×3} : Ripple value.

{numeric n×3+1} : Ripple test result (1: Fail, 0: Pass)
Examples CALC:MEAS:RLIM:REP:DATA?

calculate2:measure2:rlimit:report:data?

Query

Syntax

CALCulate<cnum>:MEASure<mnum>:RLIMit:REPort:DATA?

Return

Type

Variant

Default OFF

CALCulate<cnum>:MEASure<mnum>:RLIMit:STATe <bool>
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Applicable Models: All

(Read-Write) Turns ON/OFF the ripple test function for the active trace of selected channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on

that channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<bool> ON (or 1) - turns limit testing ON.

OFF (or 0) - turns limit testing OFF.

Examples CALC:MEAS:RLIM:STAT ON
calculate2:measure2:rlimit:state off

Query Syntax CALCulate<cnum>:MEASure<mnum>:RLIMit:STATe?

Return Type Boolean
Default OFF
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CALCulate:MEASure:SA Commands

Controls the marker settings used in the SA application.

CALCulate:MEASure:SA:MARKer:

BNOise

       | DATA?

       | SPAN

       | [:STATe]

BPOWer

       | DATA?

       | SPAN

       | [:STATe]

OCCBand

        | CENTer?

        | PERCent

        | POWer?

        | SPAN?

        | [:STATe]

 

Click on a keyword to view the command details.

See Also

Marker Readout number and size commands.

Learn about Markers

Synchronizing the Analyzer and Controller

SCPI Command Tree
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Important: Learn about programming the reference marker.

CALCulate<ch>:MEASure<mnum>:SA:MARKer<n>:BNOise:DATA?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the band noise level in dBm/Hz from the band noise marker.

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <ch> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<n> Band noise marker number.

Examples CALC:MEAS2:SA:MARK:BNO:DATA?

calculate2:measure2:sa:marker2:bnoise:data?

Default Not applicable

CALCulate<ch>:MEASure<mnum>:SA:MARKer<n>:BNOise:SPAN <num>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and reads the frequency span of  the band noise marker. This area is marked by two

vertical dotted lines on the screen and the marker's y-axis value is set to the measured power value.

Noise and power on the same marker share the same span.

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <ch> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<n> Marker number.

<num> Choose a frequency span within the frequency range of the analyzer.

Examples CALC:MEAS2:SA:MARK:BNO:SPAN 1e6

Query Syntax CALCulate<ch>:MEASure<mnum>:SA:MARKer<n>:BNOise:SPAN?

Return Type Numeric

Default 1 MHz
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CALCulate<ch>:MEASure<mnum>:SA:MARKer<n>:BNOise[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and reads the state of the band noise marker. This command makes a band noise

marker from a generic marker. The generic marker must first be created using:
CALC:MEAS:MARK:STATe

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <ch> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<n> Marker number.

<bool> Choose from:

0 - OFF - Turn band noise marker OFF.

1 - ON - Turn band noise marker ON.

Examples 'Create marker3 on the specified measurement

CALC2:MEAS2:MARK3 ON

'Make it a band noise marker

CALC:MEAS2:SA:MARK:BNO:STAT 1

Query Syntax CALCulate<ch>:MEASure<mnum>:SA:MARKer<n>:BNOise?

Return Type Boolean

Default 0

CALCulate<ch>:MEASure<mnum>:SA:MARKer<n>:BPOWer:DATA?
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Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the band power level from the band power marker.

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <ch> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<n> Band power marker number.

Examples CALC:MEAS2:SA:MARK:BPOW:DATA?

calculate2:measure2:sa:marker2:bpower:data?

Default Not applicable

CALCulate<ch>:MEASure<mnum>:SA:MARKer<n>:BPOWer:SPAN <num>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and reads the frequency span of  the band power marker. This area is marked by

two vertical dotted lines on the screen and the marker's y-axis value is set to the measured power

value. Noise and power on the same marker share the same span.

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <ch> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<n> Marker number.

<num> Choose a frequency span within the frequency range of the analyzer.

Examples CALC:MEAS2:SA:MARK:BPOW:SPAN 1e6

Query Syntax CALCulate<ch>:MEASure<mnum>:SA:MARKer<n>:BPOWer:SPAN?

Return Type Numeric

Default 1 MHz

CALCulate<ch>:MEASure<mnum>:SA:MARKer<n>:BPOWer[:STATe] <bool>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and reads the state of the band power marker. This command makes a band power

marker from a generic marker. The generic marker must first be created using:
CALC:MEAS:MARK:STATe

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <ch> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<n> Marker number.

<bool> Choose from:

0 - OFF - Turn band power marker OFF.

1 - ON - Turn band power marker ON.

Examples 'Create marker3 on the specified measurement

CALC2:MEAS2:MARK3 ON

'Make it a band power marker

CALC:MEAS2:SA:MARK:BPOW:STAT 1

Query Syntax CALCulate<ch>:MEASure<mnum>:SA:MARKer<n>:BPOWer?

Return Type Boolean

Default 0
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CALCulate:MEASure:SMOothing Commands

Controls point-to-point smoothing. Smoothing is a noise reduction technique that averages adjacent

data points in a measurement trace. Choose the amount of smoothing by specifying either the number

of points or the aperture. Smoothing is not the same as CALC:AVERage which averages each data

point over a number of sweeps.

CALCulate:MEASure:SMOothing

APERture

POINts

[:STATe]

Click a keyword to view the command details.

See Also

Learn about Smoothing

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<cnum>:MEASure<mnum>:SMOothing:APERture <num>

Applicable Models: All

(Read-Write) Sets the amount of smoothing as a percentage of the number of data points in the

channel.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that
channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num> Percentage value. Choose any number between:

1 and 25

Examples CALC:MEAS:SMO:APER 2
calculate2:measure2:smoothing:aperture 20.7

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:SMOothing:APERture?

Return

Type
Numeric
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Default 1.5

CALCulate<cnum>:MEASure<mnum>:SMOothing:POINts <num>

Applicable Models: All

(Read-Write) Sets the number of adjacent data points to average.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num> Number of points from 1 point to maximum of 25% of data points in the channel. For

example: if number of points in a data trace = 401, the maximum value for points =

100. The points value is always rounded to the closest odd number.

Examples CALC:MEAS:SMO:POIN 50
calculate2:measure2:smoothing:points 21

Query

Syntax
CALCulate<cnum>:MEAsure<mnum>:SMOothing:POINts?

Return

Type
Numeric

Default 3

CALCulate<cnum>:MEASure<mnum>:SMOothing[:STATe] <bool>

Applicable Models: All

(Read-Write) Turns data smoothing ON or OFF.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<bool> ON or 1 - Turns smoothing ON.

OFF or 0 - Turns smoothing OFF.

Examples CALC:MEAS:SMO ON
calculate2:measure2:smoothing:state off

Query
Syntax

CALCulate<cnum>:MEASure<mnum>:SMOothing[:STATe]

Return

Type
Boolean (1 = ON, 0 = OFF)
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Default OFF

 

831



CALCulate:MEASure:TRANsform Commands

Specifies the settings for time domain transform.

CALCulate:MEASure:TRANsform

COUPle

       | PARameters

TIME

       | ALIGnment

       | CENTer

       | IMPulse

             | WIDTh

       | KBESsel

       | LPFRequency

       | MARKer

             | MODE

             | UNIT

       | SPAN

       | STARt

       | STATe

       | STEP

             | RTIMe

       | STOP

       | [:TYPE]

Click a keyword to view the command details.

See Also

Learn about Time Domain

Synchronizing the Analyzer and Controller

SCPI Command Tree
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CALCulate<cnum>:MEASure<mnum>:TRANsform:COUPle:PARameters <num>

Applicable Models: All

(Read-Write)  Specifies the time domain transform parameters to be coupled. The settings for those

parameters will be copied from the selected measurement to all other measurements on the channel.

To turn coupling ON and OFF, use SENS:COUP:PAR

To specify Gating parameters to couple, use CALC:MEAS:FILT:COUP:PAR

Learn more about Time Domain Trace Coupling

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num> (Numeric) Parameters to couple. To specify more than one parameter, add the numbers.

1 - Transform Stimulus (Start, Stop, Center, and Span TIME settings.)

2 - Transform State (ON / OFF)

4 - Transform Window (Kaiser Beta / Impulse Width)

8 - Transform Mode (Low Pass Impulse, Low Pass Step, Band Pass)

16 - Transform Distance Marker Units

Examples 'To couple all parameters:

CALC:MEAS:TRAN:COUP:PAR 31

'To couple Stimulus and Mode:
calculate2:measure2:transform:couple:parameters 9

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:TRANsform:COUPle:PARameters?

Return
Type

Numeric

Default 29 (All parameters except 2 - Transform State)

CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:ALIGnment <enum> 
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the way the PNA computes the DC value of the frequency-domain measurement.

The correct DC value is required for inverse-FFT accuracy, and if not estimated properly, can cause

distortions in the time-domain measurement in the form of an undesired slope in the waveform.

Parameters  

<cnum> Channel number of the measurements to be listed. If unspecified, <cnum> is

set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<enum> Choose from:

LEGacy - The DC value is extrapolated using three data points. The transform

offset is calculated using the delay of the first frequency point. This is the same

algorithm used in the HP 8510 network analyzer.

NORMalize - The DC value is extrapolated using three data points. The

transform offset is set to zero at t=0 minus six rise-times. This mode requires

that a good S-parameter calibration has been performed, which can be verified

by observing a flat time-domain response at t=0 when measuring a load located

at the physical point corresponding to t=0. Normalize mode is principally used

to help stabilize the time-domain trace at time t=0 to 50 ohms, to remove

bouncing of the response at t=0. This method is similar to that used with PLTS,

and is very useful in determining the time-domain-transform response of

transmission lines and printed-circuit-board characteristics.

Examples CALC:MEAS:TRAN:TIME:ALIG NORM
calculate2:measure2:transform:time:alignment?

Return Type Enumeration

Default LEGacy

CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:CENTer <num>
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Applicable Models: All

(Read-Write) Sets the center time for time domain measurements.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num> Center time in seconds; any number between:

± (number of points-1) / frequency span

Note: This command will accept MIN or MAX instead of a numeric parameter. See SCPI
Syntax for more information.

Examples CALC:MEAS:TRAN:TIME:CENT 1e-8
calculate2:measure2:transform:time:center 15 ps

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:CENTer?

Return

Type
Numeric

Default 0

CALCulate<cnum>:MEAsure<mnum>:TRANsform:TIME:IMPulse:WIDTh <num>

Applicable Models: All

(Read-Write) Sets the impulse width for the transform window.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num> Impulse width in seconds; Choose any number between:

.6 / frequency span and 1.39 / frequency span

Examples CALC:MEAS:TRAN:TIME:IMP:WIDTh 10
calculate2:measure2:transform:time:impulse:width 13

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:IMPulse:WIDTh?

Return

Type
Numeric

Default .98 / Default Span
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CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:KBESsel <num>

Applicable Models: All

(Read-Write) Sets the parametric window for the Kaiser Bessel window.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num> Window width for Kaiser Bessel in seconds; Choose any number between:

0.0 and 13.0

Examples CALC:MEAS:TRAN:TIME:KBES 10
calculate2:measure2:transform:time:kbessel 13

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:KBESsel?

Return

Type
Numeric

Default 6

CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:LPFREQuency

Applicable Models: All

(Write-only) Sets the start frequencies in LowPass Mode.

Parameters  

<cnum>
Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum>
Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

Examples
CALC:MEAS:TRAN:TIME:LPFR
calculate2:measure2:transform:time:lpfrequency

Query

Syntax
Not Applicable

Default Not Applicable

CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:MARKer:MODE <char>
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Applicable Models: All

(Read-Write)   Specifies the measurement type in order to determine the correct marker distance.

Select Auto for S-Parameter measurements.

Select Reflection or Transmission for arbitrary ratio or unratioed measurements.

This setting affects the display of ALL markers for only the ACTIVE measurement.

Learn more about Distance Markers.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<char> Choose from:

AUTO - If the active measurement is an S-Parameter, automatically chooses reflection or

transmission. If  non S-Parameter measurements, reflection is chosen.

REFLection - Displays the distance from the source to the receiver divided by two (to

compensate for the return trip.)

TRANsmission - Displays the distance from the source to the receiver.

Examples CALC:MEAS:TRAN:TIME:MARK:MODE REFL
calculate2:measure2:transform:time:marker:mode auto

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:MARKer:MODE?

Return

Type
Character

Default AUTO

CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:MARKer:UNIT <char>
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Applicable Models: All

(Read-Write)  Specifies the unit of measure for the display of marker distance values. This settings

affects the display of ALL markers for only the ACTIVE measurement (unless Distance Maker Units

are coupled using CALC:MEAS:TRAN:COUP:PAR.

Learn more about Distance Markers.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<char> Choose from:

METRs

FEET

INCHes

Examples CALC:MEAS:TRAN:TIME:MARK:UNIT INCH
calculate2:measure2:transform:time:marker:unit feet

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:MARKer:UNIT?

Return

Type
Character

Default METRs

CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:SPAN <num>
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Applicable Models: All

(Read-Write) Sets the span time for time domain measurements.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num> Span time in seconds; any number between:

0 and 2* [(number of points-1) / frequency span]

Note: This command will accept MIN or MAX instead of a numeric parameter. See SCPI
Syntax for more information.

Examples CALC:MEAS:TRAN:TIME:SPAN 1e-8
calculate2:measure2:transform:time:span maximum

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:SPAN?

Return

Type
Numeric

Default 20 ns

CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:STARt <num>

Applicable Models: All

(Read-Write) Sets the start time for time domain measurements.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num> Start time in seconds; any number between:

± (number of points-1) / frequency span

Note: This command will accept MIN or MAX instead of a numeric parameter. See SCPI
Syntax for more information.

Examples CALC:MEAS:TRAN:TIME:STAR 1e-8
calculate2:measure2:transform:time:start minimum

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:STARt?

Return

Type
Numeric
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Default -10 ns

CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:STATe <bool>

Applicable Models: All

(Read-Write) Turns the time domain transform capability ON or OFF.

Note: Sweep type must be set to Linear Frequency in order to use Time Domain Transform.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<bool> ON (or 1) - turns time domain ON.

OFF (or 0) - turns time domain OFF.

Examples CALC:MEAS:TRAN:TIME:STAT ON
calculate2:measure2:transform:time:state off

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:STATe?

Return

Type
Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:STEP:RTIMe <num>

Applicable Models: All

(Read-Write) Sets the step rise time for the transform window.

Parameters  

<cnum>
Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum>
Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num>
Rise time in seconds; Choose any number between:

.45 / frequency span and 1.48 / frequency span

Examples
CALC:MEAS:TRAN:TIME:STEP:RTIM 1e-8
calculate2:measure2:transform:time:step:rtime 15 ps

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:STEP:RTIMe?
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Return

Type
Numeric

Default .99 / Default Span

CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:STOP <num>

Applicable Models: All

(Read-Write) Sets the stop time for time domain measurements.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num> Stop time in seconds; any number between:

± (number of points-1) / frequency span

Note: This command will accept MIN or MAX instead of a numeric parameter. See SCPI
Syntax for more information.

Examples CALC:MEAS:TRAN:TIME:STOP 1e-8
calculate2:measure2:transform:time:stop maximum

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME:STOP?

Return

Type
Numeric

Default 10 ns

CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME[:TYPE] <char>
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Applicable Models: All

(Read-Write) Sets the type of time domain measurement.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement on that

channel. If unspecified, <cnum> is set to 1.

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<char> Type of measurement. Choose from:

BPASs - Set transform mode to band pass.

LPSTep - Set transform mode to low pass step.

LPIMpulse - Set transform mode to low pass impulse.

Learn about these settings.

Examples CALC:MEAS:TRAN:TIME BPAS
calculate2:measure2:transform:time:type bpas

Query

Syntax
CALCulate<cnum>:MEASure<mnum>:TRANsform:TIME[:TYPE]?

Return

Type
Character

Default BPAS
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CALCulate:MEASure:X Commands

Controls the display of X-axis for various measurements.

CALCulate:MEASure:X

AXIS

       | DOMain

[:VALues]

Click a keyword to view the command details.

See Also

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALCulate<ch>:MEASure<mnum>:X:AXIS <string>

Applicable Models: All

(Write-Read) Sets the X-axis of the selected measurement to a DC Source. This command does not

change the default setting for new traces.

Parameters  

<ch> Channel number of the selected measurement. There must be a selected

measurement on that channel. If unspecified, value is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

<string> String - (Not case-sensitive) For all channels EXCEPT DIQ, choose from the

following:

"Default" - The default X-axis setting for the selected measurement. For

Application measurements, the X-Axis domain is set with specific commands.

"AO1" - Internal DC source #1

"AO2" - Internal DC source #2

 

Note: For DIQ channels, see CALC:MEAS:X:AXIS:DOMain
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Examples CALC:MEAS2:X:AXIS 'Default'

calculate:measure2:x:axis "AO1"

Query Syntax CALCulate<ch>:MEASure<mnum>:X:AXIS?

Return Type String
Default "Default"

CALCulate<ch>:MEASure<mnum>:X:AXIS:DOMain <string>

Applicable Models: All

(Write-Read) Sets and returns the X-Axis domain of the selected DIQ measurement.

Parameters  

<ch> The Differential IQ channel number. There must be a selected measurement on

that channel. If unspecified, value is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

   

Choose one

of these:

Then set X-Axis Source

(CALC:MEAS:X:AXIS) using one

of these as the argument.

"Frequency" "F1", "F2", etc.

"Power" Source port: "Port 1", "Port 2",

etc.

"Phase" Source port: "Port 1", "Port 2",

etc.

"DC" DC Source:"AO1", "AO2"

"Points" "Points"

Example 1. CALC:MEAS2:X:AXIS:DOM "Power"

2. CALC:MEAS2:X:AXIS "Port 1"

Query Syntax CALCulate<ch>:MEASure<mnum>:X:AXIS:DOMain?

Return Type String
Default CALC:MEAS:X:AXIS:DOMain:  "Frequency"

CALC:MEAS:X:AXIS:  "F1"
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CALCulate<cnum>:MEASure<mnum>:X[:VALues]?

Applicable Models: All

(Read-only) Returns the stimulus values for the selected measurement in the current units.

This command can be used for all Measurement Classes.

Note: To avoid frequency rounding errors, specify FORM:DATA <Real,64> or <ASCii, 0>

Parameters  

<cnum> Any existing channel number; There must be a selected measurement on that

channel. if unspecified, value is set to 1.

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples 1. Calc:MEAS2:Par:Sel "MyGCATrace"
2. CALC:MEAS2:X?

Return Type Depends on FORM:DATA command

Default Not applicable
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Calculate:Mixer Command

This command is Superseded by the CALCulate:MEASure:MIXer:XAXis command.

 

CALCulate<ch>:MIXer:XAXis <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets or returns the swept parameter to display on the X-axis for the selected FCA and

GCX measurement.

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<char> Parameter to display on the X-axis. Choose from:

INPUT  - Input frequency span

OUTPUT  - Output frequency span

LO_1  - First LO frequency span

LO_2  - Second LO frequency span

Examples CALC:MIX:XAX INPUT
calc2:mixer:xaxis output

See an example that creates, selects, and calibrates an SMC and
VMC measurement using SCPI.

Query Syntax CALCulate<ch>:MIXer:XAXis?

Return Type Character

Default OUTPUT
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Calculate:Normalize Commands

Specifies the normalization features used for a receiver power calibration.

These commands are Superseded (Sept 2004).

See the replacement commands in a new Receiver Power Cal example.

Click on a keyword to view the command details.

See Also

Example Programs

Learn about Receiver Cal

SCPI Command Tree

Save and recall your receiver power calibration (which use .CST file commands):

SENS:CORR:CSET:SAVE

SENS:CORR:CSET[:SEL]

Or use these two commands and specify either .STA or .CST file extensions:

MMEM:LOAD

MMEM:STOR

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:Select

CALCulate<cnum>:NORMalize[:IMMediate]   Superseded
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Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command is replaced with SENS:CORR:COLL:METH RPOWer and SENS:CORR:COLL[:ACQ]
POWer

See an example of a Receiver Power Calibration.

(Write only) Stores the selected measurement’s data to that measurement’s “divisor” buffer for use by

the Normalization data processing algorithm. This command is not compatible with ratioed

measurements such as S-parameters. It is intended for receiver power calibration when the selected

measurement is of an unratioed power type.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

Examples CALC:NORM
calculate1:normalize:immediate

Query Syntax Not Applicable

Default Not Applicable

CALCulate<cnum>:NORMalize:STATe <ON | OFF>   Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command is replaced with SENS:CORR[:STATe] ON|OFF

(Read-Write)  Specifies whether or not normalization is applied to the measurement. Normalization is

enabled only for measurements of unratioed power where it serves as a receiver power calibration.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<ON | OFF> ON (or 1) - normalization is applied to the measurement.

OFF (or 0) – normalization is NOT applied to the measurement.

Examples CALC:NORM:STAT ON
calculate2:normalize:state off

Query Syntax CALCulate<cnum>:NORMalize:STATe?
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Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:NORMalize:INTerpolate[:STATe] <ON | OFF>   Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command is replaced with SENS:CORR:INT[:STATe] ON|OFF

(Read-Write)  Turns normalization interpolation ON or OFF. Normalization is enabled only for

measurements of unratioed power, where it serves as a receiver power calibration.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<ON | OFF> ON (or 1) – turns interpolation ON.

OFF (or 0) – turns interpolation OFF.

Examples CALC:NORM:INT ON
calculate2:normalize:interpolate:state off

Query Syntax CALCulate<cnum>:NORMalize:INTerpolate[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON
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Calculate:Offset Commands

Allows the data trace magnitude and phase to be offset.

These commands are Superseded by the CALCulate:MEASure:OFFSet commands.

 

Click on a keyword to view the command details.

See Also

Example Programs

Learn about Magnitude Offset

Learn about Phase Offset

Synchronizing the Analyzer and Controller

SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

CALCulate<cnum>:OFFSet:MAGNitude <num>
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Applicable Models: All

(Read-Write) Offsets the data trace magnitude by the specified value.

To offset the data trace magnitude to a slope value that changes with frequency, use
CALC:OFFS:MAGN:SLOP
See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Offset value in dB.

Examples CALC:OFFS:MAGN:4
calculate1:offset:magnitude -2

Query Syntax CALCulate<cnum>:OFFSet:MAGNitude?

Return Type Numeric

Default 0

CALCulate<cnum>:OFFSet:MAGNitude:SLOPe <num>

Applicable Models: All

(Read-Write) Offsets the data trace magnitude to a value that changes linearly with frequency. The

offset slope begins at 0 Hz.
See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Offset slope value in dB/ 1GHz.

Examples CALC:OFFS:MAGN:SLOP 1 'Offset slope set to 1dB/GHz
calculate1:offset:magnitude:slope -2 'Offset slope set to -
2dB/GHz

Query Syntax CALCulate<cnum>:OFFSet:MAGNitude:SLOPe?

Return Type Numeric

Default 0

CALCulate<cnum>:OFFSet:PHASe <num>[<char>]
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Applicable Models: All

(Read-Write) Sets the phase offset for the selected measurement.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Offset phase value. Choose any number between:

-360 and 360

<char> Units for phase. OPTIONAL. Choose either:

DEG - Degrees (default)

RAD - Radians

Examples CALC:OFFS:PHAS 10
calculate:offset:phase 20rad

Query Syntax CALCulate:OFFSet:PHASe?

Return Type Numeric, returned value always in degrees

Default 0 degrees
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Calculate:Parameter Commands

Lists, creates, selects, and deletes measurements.

For application measurements, use Calc:Custom commands.

CALCulate:PARameter:

CATalog

       | EXTended

COUNt

DEFine

       | EXTended

DELete

       | ALL

MNUMber

       | [SELect]

MODify

       | EXTended

SELect

TAG

       | NEXT?

TNUMber?

WNUMber?

Click on a keyword to view the command details.

Blue commands are superseded.

See Also

Example Programs

Learn about Measurement Parameters

Synchronizing the Analyzer and Controller
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SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

CALCulate<cnum>:PARameter:CATalog? <enum> Superseded

Applicable Models: All

Note: This command is replaced with CALC:PAR:CAT:EXTended? which lists parameters with "_"

instead of "," allowing the list to be parsed easily. This command will continue to work.

(Read-only) Returns the names and parameters of existing measurements for the specified channel.

Note: For Balanced Measurements: CALC:PAR:CAT? may have an unexpected behavior. Learn more.

See Critical Note

Parameters  

<cnum> Channel number of the measurements to be listed. If unspecified, <cnum> is

set to 1.

<enum> Choose from:

NORMal - This is the default if no parameter is specified. If a trace title is

defined in a standard channel, then the "name" returned is the same as the trace

title. For non standard channels, the "name" returned is the underlying

parameter name, regardless of whether the user has turned on a trace title or

not.

DISPlay - If a trace title is defined, then the "name" returned is the same as the

trace title.

DEFine - The "name" returned is always the same as the underlying parameter
name, regardless of whether the trace title is turned on or not.

Examples CALC:PAR:CAT? DISP
calculate2:parameter:catalog?

Return Type String - "<measurement name>,<parameter>,[<measurement

name>,<parameter>...]"

Default "CH1_S11_1,S11"

CALCulate<cnum>:PARameter:CATalog:EXTended? <enum>
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Applicable Models: All

(Read-only) Returns the names and parameters of existing measurements for the specified channel.

 This command lists receiver parameters with "_" such that R1,1 is reported as R1_1. This makes the

returned string a true "comma-delimited" list all the time.

The returned string of this command is easily parsed and used to create measurements using the

CALC:PAR:EXT command.

Parameters  

<cnum> Channel number of the measurements to be listed. If unspecified, <cnum> is

set to 1.

<enum> Choose from:

NORMal - This is the default if no parameter is specified. If a trace title is

defined in a standard channel, then the "name" returned is the same as the trace

title. For non standard channels, the "name" returned is the underlying

parameter name, regardless of whether the user has turned on a trace title or

not.

DISPlay - If a trace title is defined, then the "name" returned is the same as the

trace title.

DEFine - The "name" returned is always the same as the underlying parameter

name, regardless of whether the trace title is turned on or not.

Examples CALC:PAR:CAT:EXT? DEF

calculate2:parameter:catalog:extended?

Return Type String - "<measurement name>,<parameter>,[<measurement

name>,<parameter>...]"

Default "CH1_S11_1,S11"

CALCulate<cnum>:PARameter:COUNt <value>
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Applicable Models: N522xB, N523xB, N524xB, E5080A, M948xA

(Write-only) Sets or gets the number of traces of selected channel.

Parameters 

<cnum> Channel number of the measurements to be listed. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<value> Number of traces that should be present on the selected channel. Varies depending on the

upper limit setting for the channel/trace number.

Note: This command will delete measurements if the specified value is less than the

current value.

ExamplesCALC:PAR:COUN 1

Query

Syntax
Numeric

Default1

CALCulate<cnum>:PARameter[:DEFine] <Mname>,<param>[,port]   Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command is replaced with CALC:PAR:DEFine:EXTended. This command will continue to

work for up to 4-port parameters.

(Write-only)  Creates a measurement but does NOT display it.

There is no limit to the number of measurements that can be created. However, there is a limit to the

number of measurements that can be displayed. See Traces, Channels, and Windows on the VNA.

Use DISP:WIND:STATe to create a window if it doesn't already exist.

Use DISP:WIND<wnum>:TRAC<tnum>:FEED <Mname> to display the measurement.

For Application Measurements see CALC:CUST:DEF

You must select the measurement (CALC<cnum>:PAR:SEL <mname>) before making additional

settings.

See Critical Note

Parameters  

<cnum> Channel number of the new measurement. If unspecified, value is set to 1.

<Mname> Name of the measurement. Any non-empty, unique string, enclosed in quotes.

<param> Parameter to be measured. Quotes are optional.
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  For S-parameters:

Any S-parameter available in the VNA

For ratioed measurements:

Any two receivers that are available in the VNA. (See the block diagram
showing the receivers in YOUR VNA.)

For example: AR1 (this means A/R1)

For non-ratioed measurements:

Any receiver that is available in the VNA. (See the block diagram showing

the receivers in YOUR VNA.)

For example: A

For Balanced Measurements:

First create an S-parameter measurement, then change the measurement

using CALC:FSIM:BAL commands. See an example.

For Applications see CALC:CUST:DEF.

[port] Optional argument;

For multi-port reflection S-parameter measurements:  specifies the VNA port

which will provide the load for the calibration. This argument is ignored if a

transmission S-parameter is specified.

For all non S-parameter measurements: specifies the source port for the

measurement.

Examples CALC4:PAR 'ch4_S33',S33,2 'Defines an S33 measurement with a load
on port2 of the analyzer.

calculate2:parameter:define 'ch1_a', a, 1 'unratioed meas

calculate2:parameter:define 'ch1_a', ar1,1 'ratioed meas

Query Syntax Not Applicable; see Calc:Par:Cat?

Default Not Applicable

CALCulate<cnum>:PARameter[:DEFine]:EXTended <Mname>,<param>

Applicable Models: N522xB, N523xB, N524xB, M937xA
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Note: This command replaces CALC:PAR:DEF as it allows the creating of measurements using external

multiport testsets.

(Write-only) Creates a measurement but does NOT display it.

There is no limit to the number of measurements that can be created. However, there is a limit to the

number of measurements that can be displayed. See Traces, Channels, and Windows on the VNA.

Use DISP:WIND:STATe to create a window if it doesn't already exist.

Use DISP:WIND<wnum>:TRAC<tnum>:FEED <Mname> to display the measurement.

Note: For Application Measurements see CALC:CUST:DEF

You must select the measurement using CALC:PAR:SELect before making additional settings.

See Critical Note

Parameters  

<cnum> Channel number of the new measurement. If unspecified, value is set to 1.

<Mname> (String) Name of the measurement. Any non-empty, unique string, enclosed in

quotes.

<param>

 

(String ) Measurement Parameter to create. Case sensitive.

For S-parameters:

Any S-parameter available in the VNA

Single-digit port numbers CAN be separated by "_" (underscore). For

example: "S21" or "S2_1"

Double-digit port numbers MUST be separated by underscore. For

example: "S10_1"

For ratioed measurements:

Any two VNA physical receivers separated by forward slash '/' followed by

comma and source port.

For example: "A/R1, 3"

Learn more about ratioed measurements

See a block diagram showing the receivers in YOUR VNA.

For non-ratioed measurements:
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Any VNA physical receiver followed by comma and source port.

For example: "A, 4"

Learn more about unratioed measurements.

See the block diagram showing the receivers in YOUR VNA.

Ratioed and Unratioed measurements can also use logical receiver notation to

refer to receivers. This notation makes it easy to refer to receivers with an

external test set connected to the VNA. You do not need to know which physical

receiver is used for each test port. Learn more.

For ADC measurements:

Any ADC receiver in the VNA followed by a comma, then the source port.

For example: "AI1,2" indicates the Analog Input1 with source port of 2.

Learn more about ADC receiver measurements.

For Balanced Measurements:

First create an S-parameter measurement, then change the measurement

using CALC:FSIM:BAL "define" commands. See an example.

Note: For Application Measurements see CALC:CUST:DEF

Examples CALC4:PAR:EXT 'ch4_S33', 'S33' 'Defines an S33 measurement

calculate2:parameter:define:extended 'ch1_a', 'b9, 1' 'logical
receiver notation for unratioed meas of test port 9 receiver with
source port 1.

calculate2:parameter:define:extended 'ch1_a', 'b9/a10,1' 'logical
receiver notation for ratioed meas of test port 9 receiver divided
by the reference receiver for port 10 using source port 1

Query Syntax Not Applicable; see Calc:Par:Cat?

Default Not Applicable

CALCulate<cnum>:PARameter:DELete[:NAME] <Mname>
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Applicable Models: All

(Write-only) Deletes the specified measurement.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<Mname> String - Name of the measurement

Examples CALC:PAR:DEL 'TEST'
calculate2:parameter:delete 'test'

Query Syntax Not Applicable

Default Not Applicable

CALCulate:PARameter:DELete:ALL

Applicable Models: All

(Write-only) Deletes all measurements on the VNA.

See Critical Note

Parameters  

Examples CALC:PAR:DEL:ALL

Query Syntax Not Applicable

Default Not Applicable

CALCulate<cnum>:PARameter:MNUMber[:SELect] <n>[,fast]
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the selected measurement for the channel using the Tr#. Most CALC:

commands require that this, or CALC:PAR:SEL, be sent before a setting change is made to that

measurement. Each channel can have one selected measurement.

Parameters  

<cnum> Channel number of the measurement to be selected. If unspecified, <cnum> is

set to 1.

<n> Numeric - Measurement number. These are the same numbers you see in the

“Tr1”, “Tr2”  annotation next to the parameter name on the VNA screen.

[fast] Optional. The VNA display is NOT updated. Therefore, do not use this

argument when an operator is using the VNA display. Otherwise, sending this

argument results in much faster sweep speeds. There is NO other reason to

NOT send this argument.

Examples CALC:PAR:MNUM 2

calculate2:parameter:mnumber:select 3,fast

Query Syntax CALCulate<cnum>:PARameter:MNUMber[:SELect]?

There is NO query available to determine if the FAST argument has been set.

Return Type Numeric

Default 1 (Trace number when factory preset is performed)

CALCulate<cnum>:PARameter:MODify <param>  Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command is replaced with CALC:PAR:MOD:EXT. This command will continue to work for
up to 4 port parameters. 

(Write-only) Modifies a standard measurement using the same arguments as CALC:PAR:DEF.  To

modify an FCA measurement, use CALC:CUST:MOD.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. The selected measurement on that

channel will be changed. If unspecified, <cnum> is set to 1.
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<param> Measurement parameter to change to. Use the same <param> arguments as

CALC:PAR:DEF.

Examples SYST:PRESET

CALC:PAR:DEF "MyMeas", S11

CALC:PAR:SEL "MyMeas"

CALC:PAR:MOD AR1 'changes the selected S11 measurement to an A/R1
measurement

Query Syntax Not Applicable

Default Not Applicable

CALCulate<cnum>:PARameter:MODify:EXTended <param>

Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command replaces CALC:PAR:MOD as it allows modification of measurements using

external multiport testsets.

(Write-only) Modifies a standard measurement using the same arguments as CALC:PAR:DEF:EXT.  

To modify an Application measurement, use CALC:CUST:MOD.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. The selected measurement on that

channel will be changed. If unspecified, <cnum> is set to 1.

<param> (String) New measurement parameter. Use the same <param> arguments as

CALC:PAR:DEF:EXT.

Examples SYST:PRESET

CALC:PAR:DEF:EXT "MyMeas", "S10_1"

CALC:PAR:SEL "MyMeas"

CALC:PAR:MOD:EXT "a4b4,1" 'changes the selected S10_1
measurement to an a4/b4 measurement with source port 1

Query Syntax Not Applicable

Default Not Applicable
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CALCulate<cnum>:PARameter:TAG:NEXT?

Applicable Models: E5080A, M9485A

(Read-only)

Parameters  

<cnum> Channel number of the measurement. The selected measurement on that channel will

be changed. If unspecified, <cnum> is set to 1.

Examples CALC:PAR:TAG:NEXT

Query

Syntax

Not Applicable

Default Not Applicable

CALCulate<cnum>:PARameter:SELect <Mname>[,fast]

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the selected measurement. Most CALC: commands require that this command be

sent before a setting change is made. One measurement on each channel can be selected at the same

time.

Use CALC:PAR:MNUM to select a measurement by Tr# number. Learn more.

To obtain a list of currently named measurements, use CALC:PAR:CAT?

Parameters  

<cnum> Channel number of the measurement to be selected. If unspecified, <cnum> is

set to 1.

<Mname> String - Name of the measurement. CASE-SENSITIVE. Do NOT include the
parameter name that is returned with Calc:Par:Cat?

[fast] Optional. The VNA display is NOT updated. Therefore, do not use this
argument when an operator is using the VNA display. Otherwise, sending this

argument results in much faster sweep speeds. There is NO other reason to
NOT send this argument.

Examples CALC:PAR:SEL 'TEST'

calculate2:parameter:select 'test',fast

Query Syntax CALCulate:PARameter:SELect?

There is NO query available to determine if the FAST argument has been set.
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Return Type String

Default "CH1_S11_1" (Trace name when factory preset is performed)

CALCulate<cnum>:PARameter:TAG:NEXT?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns a string that is guaranteed to be unique and valid for use with CALC:PAR:DEF.

Parameters  

<cnum> Channel number of the trace. If unspecified, <cnum> is set to 1.

Examples CALC:PAR:TAG:NEXT?
calculate2:parameter:tag:next?

Return Type String

Default Not Applicable

CALCulate<cnum>:PARameter:TNUMber?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the trace number of the selected trace. Select a trace using Calc:Par:Select.

Parameters  

<cnum> Channel number of the trace. If unspecified, <cnum> is set to 1.

Examples CALC:PAR:TNUM?
calculate2:parameter:tnumber?

Return Type Numeric

Default Not Applicable

CALCulate<cnum>:PARameter:WNUMber?
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the window number of the selected trace. Select a trace using Calc:Par:Select.

Parameters  

<cnum> Channel number of the selected trace. If unspecified, <cnum> is set to 1.

Examples CALC:PAR:WNUM?
calculate2:parameter:wnumber?

Return Type Numeric

Default Not Applicable
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Calculate:RData? Command

This command is Superseded by the CALCulate:MEASure:RDATa command.

 

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

CALCulate<cnum>:RDATA? <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns receiver data for the selected measurement. To query measurement data, see
CALC:DATA?

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<char> Choose from any physical receiver in the VNA.

For example: "A"

Also, REF - returns data for either R1 or R2 data depending on the source port

of the selected measurement.

See the block diagram showing the receivers in YOUR VNA.

Note: Logical receiver notation is NOT allowed with this command. Learn
more.

Example GPIB.Write "INITiate:CONTinuous OFF"
GPIB.Write "INITiate:IMMediate;*wai"
GPIB.Write "CALCulate:RDATA? A"

GPIB.Write "CALCulate:RDATA? REF"

Return Type Depends on FORM:DATA - Two numbers per data point

Default Not Applicable

Notes:

Generally when you query the analyzer for data, you expect that the number of data values returned will

be consistent with the number of points in the sweep.

However, if you query receiver data while the instrument is sweeping, the returned values may contain
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zeros. For example, if your request for receiver data is handled on the 45th point of a 201 point sweep,

the first 45 values will be valid data, and the remainder will contain complex zero.

This can be avoided by synchronizing this request with the end of a sweep or putting the channel in

hold mode.

Learn about Unratioed Measurements
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CALCulate:SA:MARKer commands

Controls the marker settings used in the SA application.

These commands are Superseded by the CALCulate:MEASure:SA commands.

 

CALCulate:SA:MARKer:

BNOise

       | DATA?

       | SPAN

       | [:STATe]

BPOWer

       | DATA?

       | SPAN

       | [:STATe]

OCCBand

        | CENTer?

        | PERCent

        | POWer?

        | SPAN?

        | [:STATe]

 

Click on a keyword to view the command details.

See Also

Marker Readout number and size commands.

Learn about Markers
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Synchronizing the Analyzer and Controller

SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

Important: Learn about programming the reference marker.

CALCulate<ch>:SA:MARKer<n>:BNOise:DATA?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the band noise level in dBm/Hz from the band noise marker.

See Critical Note

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement

on that SA channel. If unspecified, <ch> is set to 1.

<n> Band noise marker number.

Examples CALC:SA:MARK:BNO:DATA?

calculate2:sa:marker2:bnoise:data?

Default Not applicable

CALCulate<ch>:SA:MARKer<n>:BNOise:SPAN <num>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and reads the frequency span of  the band noise marker. This area is marked by two

vertical dotted lines on the screen and the marker's y-axis value is set to the measured power value.

Noise and power on the same marker share the same span.

See Critical Note

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <ch> is set to 1.

<n> Marker number.

<num> Choose a frequency span within the frequency range of the analyzer.

Examples CALC:SA:MARK:BNO:SPAN 1e6

Query Syntax CALCulate<ch>:SA:MARKer<n>:BNOise:SPAN?

Return Type Numeric

Default 1 MHz

CALCulate<ch>:SA:MARKer<n>:BNOise[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and reads the state of the band noise marker. This command makes a band noise

marker from a generic marker. The generic marker must first be created using: CALC:MARK:STATe

See Critical Note

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement
on that channel. If unspecified, <ch> is set to 1.

<n> Marker number.

<bool> Choose from:

0 - OFF - Turn band noise marker OFF.

1 - ON - Turn band noise marker ON.

Examples 'Select the measurement

CALC2:PAR:SEL "M2SA_CH2_A"
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'Create marker3 on that measurement

CALC2:MARK3 ON

'Make it a band noise marker

CALC:SA:MARK:BNO:STAT 1

Query Syntax CALCulate<ch>:SA:MARKer<n>:BNOise?

Return Type Boolean

Default 0

CALCulate<ch>:SA:MARKer<n>:BPOWer:DATA?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the band power level from the band power marker.

See Critical Note

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement

on that SA channel. If unspecified, <ch> is set to 1.

<n> Band power marker number.

Examples CALC:SA:MARK:BPOW:DATA?

calculate2:sa:marker2:bpower:data?

Default Not applicable

CALCulate<ch>:SA:MARKer<n>:BPOWer:SPAN <num>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and reads the frequency span of  the band power marker. This area is marked by

two vertical dotted lines on the screen and the marker's y-axis value is set to the measured power

value. Noise and power on the same marker share the same span.

See Critical Note

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <ch> is set to 1.

<n> Marker number.

<num> Choose a frequency span within the frequency range of the analyzer.

Examples CALC:SA:MARK:BPOW:SPAN 1e6

Query Syntax CALCulate<ch>:SA:MARKer<n>:BPOWer:SPAN?

Return Type Numeric

Default 1 MHz

CALCulate<ch>:SA:MARKer<n>:BPOWer[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and reads the state of the band power marker. This command makes a band power

marker from a generic marker. The generic marker must first be created using: CALC:MARK:STATe

See Critical Note

Parameters  

<ch> Channel number of the measurement. There must be a selected measurement
on that channel. If unspecified, <ch> is set to 1.

<n> Marker number.

<bool> Choose from:

0 - OFF - Turn band power marker OFF.

1 - ON - Turn band power marker ON.

Examples 'Select the measurement

CALC2:PAR:SEL "M2SA_CH2_A"
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'Create marker3 on that measurement

CALC2:MARK3 ON

'Make it a band power marker

CALC:SA:MARK:BPOW:STAT 1

Query Syntax CALCulate<ch>:SA:MARKer<n>:BPOWer?

Return Type Boolean

Default 0
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Calculate:Smoothing Commands

Controls point-to-point smoothing. Smoothing is a noise reduction technique that averages adjacent

data points in a measurement trace. Choose the amount of smoothing by specifying either the number

of points or the aperture. Smoothing is not the same as CALC:AVERage which averages each data

point over a number of sweeps.

These commands are Superseded by the CALCulate:MEASure:SMOothing commands.

 

Click on a keyword to view the command details.

See Also

Example Programs

Learn about Smoothing

Synchronizing the Analyzer and Controller

SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

CALCulate<cnum>:SMOothing:APERture <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the amount of smoothing as a percentage of the number of data points in the

channel.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Percentage value. Choose any number between:

1 and 25

Examples CALC:SMO:APER 2

calculate2:smoothing:aperture 20.7

Query Syntax CALCulate<cnum>:SMOothing:APERture?

Return Type Numeric

Default 1.5

CALCulate<cnum>:SMOothing:POINts <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the number of adjacent data points to average.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Number of points from 1 point to maximum of 25% of data points in the

channel. For example: if number of points in a data trace = 401, the maximum

value for points = 100. The points value is always rounded to the closest odd

number.

Examples CALC:SMO:POIN 50

calculate2:smoothing:points 21

Query Syntax CALCulate<cnum>:SMOothing:POINts?

Return Type Numeric

Default 3
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CALCulate<cnum>:SMOothing[:STATe] <ON | OFF>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns data smoothing ON or OFF.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<ON | OFF> ON (or 1) - turns smoothing ON.

OFF (or 0) - turns smoothing OFF.

Examples CALC:SMO ON

calculate2:smoothing:state off

Query Syntax CALCulate<cnum>:SMOothing[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF
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CALC:HOLD Commands

Controls the Trace Hold settings.

These commands are Superseded by the CALCulate:MEASure:HOLD commands.

 

CALCulate:HOLD

TYPE

CLEar

Click on a keyword to view the command details.

See Also

Learn about Trace Hold

Example Programs

Synchronizing the Analyzer and Controller

SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

CALCulate<cnum>:HOLD:TYPE <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the type of trace hold to perform.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<char> Trace Hold type. Choose from:

OFF - Disables the Trace Hold feature.

MINimum - Sets Trace Hold to store the lowest measured data points.
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MAXimum - Sets Trace Hold to store the highest measured data points.

Examples CALC:HOLD:TYPE MAX

calculate2:hold:type minimum

Query Syntax CALCulate<ch>:HOLD:TYPE?

Return Type Character

Default OFF

CALCulate<cnum>:HOLD:CLEar

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Resets the currently-stored data points to the live data trace and restarts the currently-

selected Trace Hold type.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

Examples CALC:HOLD:CLE

calculate2:hold:clear

Query Syntax Not Applicable

Default Not Applicable
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Calculate:Transform Commands

Specifies the settings for time domain transform.

These commands are Superseded by the CALCulate:MEASure:TRANsform commands.

CALCulate:TRANsform

COUple:

     | PARameters

TIME:

     | ALIGnment

     | CENTer

     | IMPulse

          | WIDTh

     | KBESsel

     | LPFRequency

     | MARKer

          | MODE

          | UNIT

     | SPAN

     | STARt

     | STATe

     | STEP

          | RTIMe

     | STIMulus

     | STOP

     | [:TYPE]

 

Click on a keyword to view the command details.
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See Also

Example Programs

Learn about Time Domain

Synchronizing the Analyzer and Controller

SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select.

CALCulate<cnum>:TRANsform:COUPle:PARameters <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write)  Specifies the time domain transform parameters to be coupled. The settings for those

parameters will be copied from the selected measurement to all other measurements on the channel.

To turn coupling ON and OFF, use SENS:COUP:PAR

To specify Gating parameters to couple, use CALC:FILT:COUP:PAR

Learn more about Time Domain Trace Coupling

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> (Numeric) Parameters to couple. To specify more than one parameter, add the

numbers.

1 - Transform Stimulus (Start, Stop, Center, and Span TIME settings.)

2 - Transform State (ON / OFF)

4 - Transform Window (Kaiser Beta / Impulse Width)

8 - Transform Mode (Low Pass Impulse, Low Pass Step, Band Pass)

16 - Transform Distance Marker Units
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Examples 'To couple all parameters:

CALC:TRAN:COUP:PAR 31

'To couple Stimulus and Mode:
calculate2:transform:couple:parameters 9

Query Syntax CALCulate<cnum>:TRANsform:COUPle:PARameters?

Return Type Numeric

Default 29 (All parameters except 2 - Transform State)

CALCulate<cnum>:TRANsform:TIME:CENTer <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the center time for time domain measurements.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Center time in seconds; any number between:

± (number of points-1) / frequency span

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:TRAN:TIME:CENT 1e-8
calculate2:transform:time:center 15 ps

Query Syntax CALCulate<cnum>:TRANsform:TIME:CENTer?

Return Type Numeric

Default 0

CALCulate<cnum>:TRANsform:TIME:IMPulse:WIDTh <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the impulse width for the transform window.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Impulse width in seconds; Choose any number between:

.6 / frequency span and 1.39 / frequency span

Examples CALC:TRAN:TIME:IMP:WIDTh 10
calculate2:transform:time:impulse:width 13

Query Syntax CALCulate<cnum>:TRANsform:TIME:IMPulse:WIDTh?

Return Type Numeric

Default .98 / Default Span

CALCulate<cnum>:TRANsform:TIME:KBESsel <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the parametric window for the Kaiser Bessel window.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Window width for Kaiser Bessel in seconds; Choose any number between:

0.0 and 13.0

Examples CALC:TRAN:TIME:KBES 10
calculate2:transform:time:kbessel 13

Query Syntax CALCulate<cnum>:TRANsform:TIME:KBESsel?

Return Type Numeric

Default 6

CALCulate<cnum>:TRANsform:TIME:LPFREQuency
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Sets the start frequencies in LowPass Mode.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

Examples CALC:TRAN:TIME:LPFR
calculate2:transform:time:lpfrequency

Query Syntax Not applicable

Default Not applicable

CALCulate<cnum>:TRANsform:TIME:MARKer:MODE <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write)   Specifies the measurement type in order to determine the correct marker distance.

Select Auto for S-Parameter measurements.

Select Reflection or Transmission for arbitrary ratio or unratioed measurements.

This setting affects the display of ALL markers for only the ACTIVE measurement.

Learn more about Distance Markers.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement
on that channel. If unspecified, <cnum> is set to 1.

<char> Choose from:

AUTO  If the active measurement is an S-Parameter, automatically chooses

reflection or transmission. If  non S-Parameter measurements, reflection is

chosen.

REFLection  Displays the distance from the source to the receiver divided by

two (to compensate for the return trip.)

TRANsmission  Displays the distance from the source to the receiver.
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Examples CALC:TRAN:TIME:MARK:MODE REFL
calculate2:transform:time:marker:mode auto

Query Syntax CALCulate<cnum>:TRANsform:TIME:MARKer:MODE?

Return Type Character

Default Auto

CALCulate<cnum>:TRANsform:TIME:MARKer:UNIT <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write)  Specifies the unit of measure for the display of marker distance values. This settings

affects the display of ALL markers for only the ACTIVE measurement (unless Distance Maker Units

are coupled using CALC:TRAN:COUP:PAR.

Learn more about Distance Markers.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<char> Choose from:

METRs

FEET

INCHes

Examples CALC:TRAN:TIME:MARK:UNIT INCH
calculate2:transform:time:marker:unit feet

Query Syntax CALCulate<cnum>:TRANsform:TIME:MARKer:UNIT?

Return Type Character

Default METRs

CALCulate<cnum>:TRANsform:TIME:SPAN <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the span time for time domain measurements.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Span time in seconds; any number between:

0 and 2* [(number of points-1) / frequency span]

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:TRAN:TIME:SPAN 1e-8
calculate2:transform:time:span maximum

Query Syntax CALCulate<cnum>:TRANsform:TIME:SPAN?

Return Type Numeric

Default 20 ns

CALCulate<cnum>:TRANsform:TIME:STARt <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the start time for time domain measurements.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Start time in seconds; any number between:

± (number of points-1) / frequency span

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:TRAN:TIME:STAR 1e-8
calculate2:transform:time:start minimum

Query Syntax CALCulate<cnum>:TRANsform:TIME:STARt?

Return Type Numeric
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Default -10 ns

CALCulate<cnum>:TRANsform:TIME:STATe <ON | OFF>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns the time domain transform capability ON or OFF.

See Critical Note

Note: Sweep type must be set to Linear Frequency in order to use Time Domain Transform.

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<ON|OFF> ON (or 1) - turns time domain ON.

OFF (or 0) - turns time domain OFF.

Examples CALC:TRAN:TIME:STAT ON
calculate2:transform:time:state off

Query Syntax CALCulate<cnum>:TRANsform:TIME:STATe?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

CALCulate<cnum>:TRANsform:TIME:STOP <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the stop time for time domain measurements.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Stop time in seconds; any number between:

± (number of points-1) / frequency span

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples CALC:TRAN:TIME:STOP 1e-8
calculate2:transform:time:stop maximum
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Query Syntax CALCulate<cnum>:TRANsform:TIME:STOP?

Return Type Numeric

Default 10 ns

CALCulate<cnum>:TRANsform:TIME:STEP:RTIMe <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the step rise time for the transform window.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<num> Rise time in seconds; Choose any number between:

.45 / frequency span and 1.48 / frequency span

Examples CALC:TRAN:TIME:STEP:RTIM 1e-8
calculate2:transform:time:step:rtime 15 ps

Query Syntax CALCulate<cnum>:TRANsform:TIME:STEP:RTIMe?

Return Type Numeric

Default .99 / Default Span

CALCulate<cnum>:TRANsform:TIME:STIMulus <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the type of simulated stimulus that will be incident on the DUT.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<char> Choose from:

STEP - simulates a step DUT stimulus

IMPulse - simulates a pulse DUT stimulus

STEP can ONLY be used when CALC:TRAN:TIME:TYPE is set to LPASs

(Lowpass). (STEP cannot be used with TYPE = BPASs.)
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:STIM STEP will set :TYPE to LPASs

:TYPE BPASs will set :STIM to IMPulse

Examples CALC:TRAN:TIME:STIM STEP
calculate2:transform:time:stimulus impulse

Query Syntax CALCulate<cnum>:TRANsform:TIME:STIMulus?

Return Type Character

Default IMPulse

CALCulate<cnum>:TRANsform:TIME:ALIGnment <enum> 

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Selects the way the PNA computes the DC value of the frequency-domain measurement.

The correct DC value is required for inverse-FFT accuracy, and if not estimated properly, can cause

distortions in the time-domain measurement in the form of an undesired slope in the waveform.

See Critical Note

Parameters  

<cnum> Channel number of the measurements to be listed. If unspecified, <cnum> is

set to 1.

<enum> Choose from:

LEGacy - The DC value is extrapolated using three data points. The transform

offset is calculated using the delay of the first frequency point. This is the same

algorithm used in the HP 8510 network analyzer.

NORMalize - The DC value is extrapolated using three data points. The

transform offset is set to zero at t=0 minus six rise-times. This mode requires

that a good S-parameter calibration has been performed, which can be verified

by observing a flat time-domain response at t=0 when measuring a load located

at the physical point corresponding to t=0. Setting the time domain trace to

zero at a time before t=0 stabilizes the trace for determining impedances after

time t=0, resulting in improved behavior compared to Legacy mode. This

method is similar to that used with PLTS, and is very useful in determining the

time-domain-transform response of transmission lines and printed-circuit-board

characteristics.

Examples CALC:TRAN:TIME:ALIG NORM
calculate2:transform:time:alignment?
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Return Type Enumeration

Default LEGacy

CALCulate<cnum>:TRANsform:TIME[:TYPE] <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the type of time domain measurement.

See Critical Note

Parameters  

<cnum> Channel number of the measurement. There must be a selected measurement

on that channel. If unspecified, <cnum> is set to 1.

<char> Type of measurement. Choose from:

LPASs - Lowpass; Must also send CALC:TRAN:TIME:LPFRequency before

calibrating.

BPASs - Bandpass;

BPASs can only be used when CALC:TRAN:TIME:STIM is set to IMPulse.

(BPASs cannot be used with :STIM = STEP)

:STIM STEP will set :TYPE to LPASs

:TYPE BPASs will set :STIM to IMPulse

Examples CALC:TRAN:TIME LPAS
calculate2:transform:time:type bpas

Query Syntax CALCulate<cnum>:TRANsform:TIME[:TYPE]?

Return Type Character

Default BPAS
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CALCulate:X (Axis) Commands

Controls the display of X-axis for various measurements.

These commands are Superseded by the CALCulate:MEASure:X commands.

 

CALCulate:X:

AXIS

       | :DOMain

[:VALues]

Click on a keyword to view the command details.

See Also

Example Programs

Synchronizing the Analyzer and Controller

SCPI Command Tree

Critical Note: CALCulate commands act on the selected measurement. You can select one

measurement for each channel using Calc:Par:MNUM or Calc:Par:Select. Learn more.

CALCulate<ch>:X:AXiS <string>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-Read) Sets the X-axis of the selected measurement to a DC Source.  This command does not

change the default setting for new traces.

Parameters  

<ch> Channel number of the selected measurement. If unspecified, value is set to 1.

<string> String - (Not case-sensitive) For all channels EXCEPT DIQ, choose from the

following:

"Default" - The default X-axis setting for the selected measurement. For

Application measurements, the X-Axis domain is set with specific commands.

"AO1" - Internal DC source #1
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"AO2" - Internal DC source #2

 

Note: For DIQ channels, see CALC:X:AXIS:DOMain

Examples CALC:X:AXIS 'Default'

calculate:x:axis "AO1"

Query Syntax CALCulate<ch>:X:AXIS?

Return Type String
Default "Default"

CALCulate<ch>:X:AXIS:DOMain <string>

Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the X-Axis domain of the selected DIQ measurement.

Parameters  

<ch> The Differential IQ channel number. If unspecified, value is set to 1.

   

Choose one of

these:

Then set X-Axis Source

(CALC:X:AXIS) using one of

these as the argument.

"Frequency" "F1", "F2", etc.

"Power" Source port: "Port 1", "Port 2",

etc.

"Phase" Source port: "Port 1", "Port 2",

etc.

"DC" DC Source:"AO1", "AO2"

"Points" "Points"

Example 1. CALC:X:AXIS:DOM "Power"

2. CALC:X:AXIS "Port 1"

Query Syntax CALCulate<ch>:X:AXIS:DOMain?

Return Type String
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Default CALC:X:AXIS:DOMain:  "Frequency"

CALC:X:AXIS:  "F1"

CALCulate<cnum>:X[:VALues]?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the stimulus values for the selected measurement in the current units. You can

select one measurement for each channel using Calc:Par:MNUM or Calc:Par:Select.  Learn more.

This command can be used for all Measurement Classes.

Note: To avoid frequency rounding errors, specify FORM:DATA <Real,64> or <ASCii, 0>

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

Examples 1. Calc:Par:Sel "MyGCATrace"
2. CALC:X?

Return Type Depends on FORM:DATA command

Default Not applicable
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CalPod Commands

The following commands are sent as a string argument from:

CONTrol:CALPod:COMMand <string>

CALPod

DISable

ENABle

HIDE

INITialize

     | ACTive

     | ALL

LAUNch

RECorrect

     | ACTive

     | ALL

SHOW

STATe

TEMP?

Click on a blue keyword to view the command details.

In addition to the above Calpod commands, the following IEE 488 Common Commands can also be
sent as a string argument:

*CLS - Clears all errors and event data from the error/event queue.

*IDN? - Returns the instrument identification information.

*OPC? - Operation complete query.  This query immediately returns a value, independent of whether or not
the operation is complete.  A return value of 0 indicates the operation is not complete.  A value of +1
indicates the operation is complete. Typically this command is used in a loop with a 0.25 second delay when
waiting for an operation to complete.

*TST? - Performs a communication test on all the currently enabled Calpods. 0 = Test failed on one or more
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enabled Calpods.  1 = All enabled Calpods working.

SYSTem:ERRor? - Queries the Event/Error queue and returns the most recent error element.

Important Notes

ALL commands on this page are sent as a string argument from: CONTrol:CALPod:COMMand <string>

Use single quotes ONLY (NOT double quotes) for the CONT:CALP:COMM string arguments.

Sending queries requires TWO question marks. See following note as example.

To read errors with the commands on this page, use the Calpod query:
CONT:CALP:COMM? 'SYSTem:ERRor?'

ALL queries return strings.

See Also

Example Programs

Synchronizing the Analyzer and Controller

SCPI Command Tree

CALPod:DISable <port>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only)  Unassign Calpod serial number from the specified VNA port.

See important notes.

Parameters  

<port> VNA port number to un-assign.

Examples CONT:CALP:COMM 'CALP:DIS 2'

Query Syntax Not Applicable

Default Not Applicable

CALPod:ENABle <port>,<sn>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-read)  Assign or return the Calpod serial number for the specified VNA port. If a Calpod

module is already assigned to the specified VNA port, this assignment will replace the existing

assignment.

See important notes.

Parameters  

<port> VNA port number to be assigned the Calpod serial number.

<sn> Calpod serial number.

Examples CONT:CALP:COMM 'CALP:ENAB 2, 0001234' 'WRITE

CONT:CALP:COMM? 'CALP:ENAB? 2'  'READ

Query Syntax CONTrol:CALPod:COMMand? 'CALPod:ENABle? <port>'

Return Type String

Default Not Applicable

CALPod:HIDE

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only)  Hides the Calpod setup dialog.

See important notes.

Parameters None

Examples CONT:CALP:COMM 'CALP:HIDE'

Query Syntax Not Applicable

Default Not Applicable

CALPod:INITialize:ACTive
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only)  Performs the initialize process for the active (selected) channel. Select a channel using

CALCulate:MEASure:PARameter.

See important notes.

Parameters None

Examples CONT:CALP:COMM 'CALP:INIT:ACT'

Query Syntax Not Applicable

Default Not Applicable

CALPod:INITialize:ALL

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only)  Performs the initialize ALL channels process.

See important notes.

Parameters None

Examples CONT:CALP:COMM 'CALP:INIT:ALL'

Query Syntax Not Applicable

Default Not Applicable

CALPod:LAUNch

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only)  Starts the Calpod software. The Calpod software can be started using this (Launch)

command or by activating the Calpod user interface.  Once the Calpod software is started it remains

active until the VNA application is terminated.

Send this command first in your program, then wait a couple seconds while the software starts before

sending the next command.

See important notes.

Parameters None

Examples CONT:CALP:COMM 'CALP:LAUN'

wait 3
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Query Syntax Not Applicable

Default Not Applicable

CALPod:RECorrect:ACTive

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only)  Performs the recorrect process for the active (selected) channel. Select a channel using

CALCulate:MEASure:PARameter.

See important notes.

Parameters None

Examples CONT:CALP:COMM 'CALP:REC:ACT'

Query Syntax Not Applicable

Default Not Applicable

CALPod:RECorrect:ALL

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only)  Performs the recorrect process for ALL channels.

See important notes.

Parameters None

Examples CONT:CALP:COMM 'CALP:REC:ALL'

Query Syntax Not Applicable

Default Not Applicable

CALPod:SHOW
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only)  Shows the Calpod setup dialog.

See important notes.

Parameters None

Examples CONT:CALP:COMM 'CALP:SHOW'

Query Syntax Not Applicable

Default Not Applicable

CALPod:STATe <sn>,<state>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only)  Sets the specified Calpod module to specified impedance state.

See important notes.

Parameters  

<sn> Serial number of the Calpod module.  When set to 1, all modules are set to the

specified state.

<state> Impedance state. Not case sensitive. Choose from:

Short, Open, Load, or Thru

Examples CONT:CALP:COMM 'CALPod:STATe 0001234,thru'

Query Syntax Not Applicable

Default Thru

CALPod:TEMP? <sn>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only)  Returns the temperature of the specified Calpod module in degrees Celsius.

See important notes.

Parameters  

<sn> Serial number of the Calpod module.

Examples CONT:CALP:COMM? 'CALPod:TEMP? 0001234'

Query Syntax Not Applicable

Return Type String

Default Not Applicable
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Control Commands

Specifies the settings to remotely control the rear panel connectors, an external test set, Calpod

modules, and ECal Module state.

CONTrol

AUXiliary - More Commands

CALPod:COMMand  

CHANnel:INTerface:CONTrol:

     | CONFig:RECall

     | [STATe]

ECAL:MODule:

     | PATH:

          | COUNt?

          | STATe

     | STATe

EXTernal:TESTset - More Commands

HANDler - More Commands

NOISe:SOURce[:STATe]

SIGNal:

     | TRIGger

          | ATBA

          |

Click on a keyword to view the command details.

Blue command is superseded.

See Also
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SCPI Command Tree

Material Handler IO connector

CONTrol:CALPod:COMMand <string>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-Read)  Sends commands that control a Calpod module. Reads query versions Calpod

commands.

See ALL Calpod commands.

Learn more about Calpod.

Parameters  

<string> Calpod command. See ALL Calpod commands that can be used in this string.

Write Example CONT:CALP:COMM 'CALP:INIT:ACT'

'Enclose all strings in SINGLE quotes (NOT double quotes)

Query Syntax CONTrol:CALPod:COMMand? <string>

Relevant only for query strings.

Read Example CONT:CALP:COMM? '*OPC?'

'returns 0 if the calpod software is currently processing an
operation

'returns 1 if operations are complete

Return Type String

Default Not Applicable

CONTrol:CHANnel:INTerface:CONTrol:CONFig:RECall[:STATe] <string>
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Applicable Models: N522xB, N523xB, N524xB, E5080A

(Write-only)  Recalls an Interface Control configuration file.  Learn more about Interface Control.

Parameters  

<string> File name and extension (.xml) of the configuration file to recall. Files are

typically stored in the default folder "D:\". To recall from a different folder,

specify the full path name.

Examples CONT:CHAN:INT:CONT:CONF:REC 'MyConfigFile.xml'

control:channel:interface:control:config:recall:state
'D:\MyFile.xml'

Query Syntax Not Applicable

Default Not Applicable

CONTrol:CHANnel:INTerface:CONTrol[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Write)  Enables and disables ALL Interface Control settings. To send data, the individual

interfaces must also be enabled. Learn more about Interface Control.

Parameters  

<bool> Boolean

OFF (0) - Interface Control is disabled;NO control data is sent.

ON (1) - Interface Control is enabled.

Examples CONT:CHAN:INT:CONT 1

control:channel:interface:control:state 0

Query Syntax CONTrol:CHANnel:INTerface:CONTrol[:STATe]?

Return Type Boolean

Default OFF (0)

CONTrol:ECAL:MODule<num>:PATH:COUNt? <name>

Applicable Models: All

(Read-only)  Returns the number of unique states that exist for the specified path name on the selected

ECal module.
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This command performs exactly the same function as SENS:CORR:CKIT:ECAL:PATH:COUNt?

Use the CONT:ECAL:MOD:PATH:STAT command to set the module into one of those states.  

Use SENS:CORR:CKIT:ECAL:PATH:DATA? to read the data for a state.

Parameters  

[num] Optional argument. USB number of the ECal module.  If unspecified (only one

ECal module is connected to the USB), <num> is set to 1. If two or more

modules are connected, use SENS:CORR:CKIT:ECAL:LIST? to determine how

many, and SENS:CORR:CKIT:ECAL:INF? to verify their identities.

<name> Name of the path for which to read number of states.  Choose from:

Reflection paths

A

B

C (4-port modules)

D (4-port modules)

Transmission paths

AB

AC (4-port modules)

AD (4-port modules)

BC (4-port modules)

BD (4-port modules)

CD (4-port modules)

Note: For each transmission path, the first of the available states is the through

state, the second is the confidence (attenuator) state.

Examples CONT:ECAL:MOD:PATH:COUNt? A

control:ecal:module2:path:count? cd

See example program

Return Type Integer

Default Not Applicable
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CONTrol:ECAL:MODule<num>:PATH:STATe <path>, <stateNum>

Applicable Models: All

(Write-only) Sets the internal state of the selected ECAL module. This command supersedes

CONT:ECAL:MOD:STAT.

Use CONT:ECAL:MOD:PATH:COUN? to read the number of unique states that exist for the specified path
name on the module.

Use SENS:CORR:CKIT:ECAL:PATH:DATA? to read the data for a state (from the module memory)
corresponding to the stimulus values of a channel.

Parameters  

[num] Optional argument. USB number of the ECal module.  If unspecified (only one

ECal module is connected to the USB), <num> is set to 1. If two or more

modules are connected, use SENS:CORR:CKIT:ECAL:LIST? to determine how

many, and SENS:CORR:CKIT:ECAL:INF? to verify their identities.

<path> Path name for which to set a state.  

Note: The impedance paths are not independent. For example, changing the

impedance presented on path A will cause a change to the impedance on path

B.

Choose from:

Reflection paths

A

B

C (4-port modules)

D (4-port modules)

Transmission paths

AB

AC (4-port modules)

AD (4-port modules)

BC (4-port modules)
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BD (4-port modules)

CD (4-port modules)

<stateNum> Number of the state to set. Refer to the following table to associate the

<stateNum> with a state in your ECal module.

In addition, CONT:ECAL:MOD:PATH:COUNt? returns the number of states in the

specified ECal module.

<stateNum> N4432A

and

N4433A

States

N4431A

States

N469x and

N755x

States**

8509x

States

One-Port Reflection States

1 Open Open Impedance

1

Open

2 Short Short Impedance

2

Short

3 Impedance

1

Impedance

1

Impedance

3

Impedance

1

4 Impedance

2

Impedance

2

Impedance

4

Impedance

2

5     Impedance

5

 

6     Impedance

6

 

7     Impedance

7

 

Two-Port Transmission States

1 Thru Thru Thru Thru

2 Confidence Confidence Confidence Confidence

** The following modules have only FOUR Impedance states (1, 2, 3, 4):

N4690B ,N4691B ,N4692A ,N4696B, N7550A - N7556A.

Examples CONT:ECAL:MOD:PATH:STATe A,5

control:ecal:module2:state BC,1

See example program

Query Syntax Not Applicable
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Default Not Applicable

CONTrol:ECAL:MODule<num>:STATe <value> Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

This command is replaced with  CONT:ECAL:MOD:PATH:STATe.

(Write-only) Sets the internal state of the selected ECAL module.

Parameters  

[num] Optional argument. USB number of the ECal module.  If unspecified (only one

ECal module is connected to the USB), <num> is set to 1.  If two or more

modules are connected, use SENS:CORR:COLL:CKIT:INF? to verify their identity.

<value> Integer code for switching the module. The following are codes for Keysight

ECal modules.

8509x Modules

State Port A Port B

Open 0 0

Short 43 43

Load 33 33

Mismatch 4 16

Thru 84

Confidence 20

 

N469x and N755x Modules

State Port A Port B

Open 36 33

Short 39 45

Load 37 37

Mismatch

(Offset short)

53 53

Impedance 5

(Offset open)

5 5

Impedance 6

(Offset short)

21 21
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Impedance 7

(Offset short)

38 41

Thru 42

Confidence 40

 

N4431A Modules

State Port A Port B Port C Port D

Open -1398 -1384 -2774 -2654

Short -1350 -1381 -2582 -2642

Load 26985 -26986 -26986 26985

Mismatch -26986 26985 26985 -26986

Path Thru Confidence

AB Path -2590 -598

AC Path -4011 85

AD Path -2517 16042

BC Path -1650 -598

BD Path -4011 85

CD Path -1352 16042

 

N4432A and N4433A Modules

State Port A Port B Port C Port D

Open -6971 -11835 -14895 -14876

Short -14395 -12859 -14899 -14905

Load -14907 -14907 -14907 -14907

Offset Short -9787 -6459 -14874 -14887

Path Thru Confidence

AB Path 13765 30069

AC Path -10519 -2327

AD Path -10538 -2346

BC Path -5655 -1559

BD Path -5674 -1578

CD Path -15051 30069

Examples CONT:ECAL:MOD:STAT 36
control:ecal:module2:state 38
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Query Syntax Not Applicable

Default Not Applicable

CONTrol:MULTiplexer<id>:OUTPut:<grp>[:DATA] <num>

Applicable Models: E5080A

(Read-Write) Sets or returns the output port data for specified group with id of the E5092A multiport

test set.

Notes: This command is available only for E5092A multiport test set.

Parameters  

<id> Id of the multiport test set either 1 or 2. If unspecified, Id is assumed to be 1.

<grp> A | B | C | D

<num> An integer specifying the decimal value of the control line. Values are obtained by

adding weights from the following table that correspond to individual lines.

The output port data range is between 0 to 255 (0=All line are turns OFF and 255 all

lines are turn ON).

Line Weight

1 1

2 2

3 4

4 8

5 16

6 32

7 64

8 128

Examples CONT:MULT1:OUTP:B 8

Query

Syntax
CONTrol:MULTiplexer<id>:OUTPut:<grp>[:DATa]?

Return

Type
Numeric

Default 0
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CONTrol:MULTiplexer<id>:OUTPut:<grp>VOLTage[:DATA] <volt>

Applicable Models: E5080A

(Read-Write) Sets or returns the output voltage for specified group with id of the E5092A multiport

test set.

Notes: This command is available only for E5092A multiport test set.

Parameters  

<id> Id of the multiport test set either 1 or 2. If unspecified, Id is assumed to be 1.

<grp> A | B | C | D

<volt> Output voltage range for <grp> is between 0 to 5.2V and resolution is 10mV.

Examples CONT:MULT1:OUTP:B:VOLT 4.2

Query Syntax CONTrol:MULTiplexer<id>:OUTPut:<grp>:VOLtage[:DATa]?

Return Type Numeric

Default 0 V

CONTrol:NOISe:SOURce[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write)  Set and read the noise source (28V) ON and OFF.

Parameters  

<bool> Boolean

OFF (0) - Noise Source OFF

ON (1) - Noise Source ON

Examples CONT:NOIS:SOUR 1

control:noise:source:state 0

Query Syntax CONTrol:NOISe:SOURce[:STATe]?

Return Type Boolean

Default For VNA models with a Noise Figure option (028/029/H29), the 28V line is ON

at application start and after a preset.  The ON/OFF state is also available from
a VNA softkey menu.

For VNA models WITHOUT a Noise Figure option (028/029/H29), the 28V

line is OFF at application start and its state is not affected by a preset. The
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ON/OFF state is NOT available from a VNA softkey menu.

CONTrol:SIGNal <conn>,<char>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write)  Configures external triggering in the VNA.

Note: To configure external triggering in the current VNA models, use the Trigger commands.

To control BNC1 and BNC2 with this command, then you MUST have TRIG:PREF:AIGLobal = ON. Learn
more

Trigger:Sequence:Source is automatically set to External when CONTrol:SIGNal is sent.

Edge triggering is only available on some Microwave VNA models.  

For more information, see External Triggering in the VNA.

Parameters  

<conn> Rear Panel connector to send or receive trigger signals. Choose from:

BNC1  Trigger IN from rear-panel Trigger IN BNC connector

Note: Only one of the input connectors is active at a time. When a command is

sent to one, the VNA automatically makes the other INACTIVE.

BNC2  Trigger OUT to rear-panel Trigger OUT BNC connector.

MATHtrigger - Trigger IN from rear-panel Material Handler connector Pin 18

RDY - Ready for trigger OUT.

VNA-X:  Meas Trig RDY

VNA-L: Handler I/O p21 (Some models)

<char> INACTIVE - Disables the specified connector <conn>.

Choose from ONLY the following when <conn> is set to BNC1 or AUXT

or MATHtrigger:

TIENEGATIVE - (Trigger In Edge Negative) - Triggers the VNA when receiving a
negative going signal

TIEPOSITIVE - (Trigger In Edge Positive) - Triggers the VNA when receiving a
positive going signal

910



TILLOW - (Trigger In Level Low) - Triggers the VNA when receiving a low level
signal

TILHIGH - (Trigger In Level High) - Triggers the VNA when receiving a High-level
signal

Choose from ONLY the following when <conn> is set to BNC2:

Use CONTrol:SIGNal:TRIGger:OUTP to enable the BNC2 output.

The following selections send a positive or negative pulse before or after each

trigger acquisition. This normally occurs each sweep unless a channel is in point
trigger mode.

TOPPAFTER - (Trigger Out Pulse Positive After) - Sends a POSITIVE going TTL
pulse at the END of each trigger acquisition.

TOPPBEFORE - (Trigger Out Pulse Positive Before) - Sends a POSITIVE going
TTL pulse at the START of each trigger acquisition.

TOPNAFTER - (Trigger Out Pulse Negative After) - Sends a NEGATIVE going
TTL pulse at the END of each trigger acquisition.

TOPNBEFORE - (Trigger Out Pulse Negative Before) - Sends a NEGATIVE going
TTL pulse at the START of each trigger acquisition.

Choose from ONLY the following when <conn> is set to RDY:

LOW   Outputs a TTL low when the VNA is ready for trigger. (Default setting)

HIGH  Outputs a TTL high when the VNA is ready for trigger.

Examples CONT:SIGN BNC1,TIENEGATIVE
control:signal bnc2,toppbefore

CONT:SIGN RDY,LOW

Query Syntax CONTrol:SIGNal? <conn>

In addition to the arguments listed above, the following is also a possible

returned value:

NAVAILABLE - This feature is not available on this VNA

Return Type Character

Default At Preset:

BNC1 = INACTIVE

BNC2 = INACTIVE
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AUXT = TILHIGH

When Output is enabled:

BNC1 = INACTIVE

BNC2 = TOPPAFTER

AUXT = TILHIGH

CONTrol:SIGNal:TRIGger:ATBA <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write)  Accept Trigger Before Armed  Determines what happens to an EDGE trigger signal if

it occurs before the VNA is ready to be triggered. (LEVEL trigger signals are always ignored.)  For

more information, see External triggering.

Parameters  

<bool> Boolean

OFF (0) - A trigger signal is ignored if it occurs before the VNA is ready to be

triggered.

ON (1) - A trigger signal is remembered and then used when the VNA becomes

armed (ready to be triggered). The VNA remembers only one trigger signal.

Examples CONT:SIGN:TRIG:ATBA 0
control:signal:trigger:atba ON

Query Syntax CONTrol:SIGNal:TRIGger:ATBA?

Return Type Boolean

Default OFF

CONTrol:SIGNal:TRIGger:OUTP <bool>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write)  Output Enabled  The VNA can be enabled to send trigger signals out the rear-panel

TRIGGER OUT BNC connector. Use CONTrol:SIGNal to configure for output triggers.

Note: To configure external triggering in the current VNA models, use the Trigger commands.

For more information, see External triggering.

Parameters  

<bool> Boolean

OFF (0) - VNA does NOT output trigger signals.

ON (1) - VNA DOES output trigger signals.

Examples CONT:SIGN:TRIG:OUTP 1

control:signal:trigger:outp OFF

Query Syntax CONTrol:SIGNal:TRIGger:OUTP?

Return Type Boolean

Default OFF
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Control:Multiplexer Commands

Controls the E5092A Configurable Multiport Test Set.

 

CONTrol:MULTiplexer:

OUTPut

| A|B|C|D[DATA]

| A|B|C|D:VOLTage[DATA]

PORT

| [:SELect]

 

 

Click on a keyword to view the command details.

See Also

Learn about External Test Set Control

Synchronizing the Analyzer and Controller

SCPI Command Tree

CONTrol:MULTiplexer<id>:OUTPut:<grp>[:DATA] <num>
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Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Write) Sets or returns the output port data for specified group with id of the E5092A multiport

test set.

Note: This command performs an immediate setting of the specified data on the indicated test set, as opposed
to the SENSe<cnum>:MULTiplexer<id>:OUTPut:<grp>[:DATA] <num> command which sets the data only at
the beginning of each sweep of the specified channel number ‘cnum’.

Parameters  

<id> Id of the external test set either 1 or 2. If unspecified, Id is assumed to be 1. Must be

previously set by the SENS:MULT:TYPE command.

<grp> A | B | C | D

<num> An integer specifying the decimal value of the control line. Values are obtained by

adding weights from the following table that correspond to individual lines.

The output port data range is between 0 to 255 (0=All lines are turned OFF and 255

all lines are turned ON).

Line Weight

1 1

2 2

3 4

4 8

5 16

6 32

7 64

8 128

Examples CONT:MULT1:OUTP:B 8

Query

Syntax
CONTrol:MULTiplexer<id>:OUTPut:<grp>[:DATa]?

Return Type Numeric

Default 0

CONTrol:MULTiplexer<id>:OUTPut:<grp>:VOLTage[:DATA] <volt>
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Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Write) Sets or returns the output voltage for specified group with id of the E5092A multiport

test set.

Note: This command performs an immediate setting of the specified voltage on the indicated test set, as
opposed to the SENSe<cnum>:MULTiplexer<id>:OUTPut:<grp>:VOLTage[:DATA] <volt> command which
sets the voltage only at the beginning of each sweep of the specified channel number ‘cnum’.

Parameters  

<id> Id of the external test set either 1 or 2. If unspecified, Id is assumed to be 1. Must be

previously set by the SENS:MULT:TYPE command.

<grp> A | B | C | D

<volt> Output voltage range for <grp> is between 0 to 5.2V and resolution is 10mV.

Examples CONT:MULT1:OUTP:B:VOLT 4.2

Query

Syntax
CONTrol:MULTiplexer<id>:OUTPut:<grp>:VOLtage[:DATa]?

Return Type Numeric

Default 0 V

CONTrol:MULTiplexer<id>:PORT<pnum>[:SELect] <string>

Applicable Models: N522xB, N523xB, N524xB, E5080A

(Write-Only) Sets the multiport test set port. If this command creates a conflict with an existing port,

the VNA will resolve the conflict.

Note: This command performs an immediate setting of the specified port on the indicated test set, as opposed
to the SENSe<cnum>:MULTiplexer<id>:PORT<pnum>:SELect <string> command which sets the port only at
the beginning of each sweep of the specified channel number ‘cnum’.

Parameters  

<id> Id of the external test set. If unspecified, Id is assumed to be 1. Must be

previously set by the SENSe:MULT:TYPE command.

<pnum> Integer - Logical port number. The range is 1 to 20.

<string> Physical port number.

Examples CONT:MULT1:PORT3:SEL "4" 'sets logical port 3 to physical port
4.

Return Type String
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Default Not Applicable

 

917



CONTrol:HANDler:EXT:INDex:LOGic  <char>

Applicable Models: M937xA

(Read-Write) Sets the logic of the index line ("Trig Out" port) on the last PXIe module. There is no

soft front-panel element for this feature.

Parameters  

<char> Choose from:

POSitive - Causes the Index line to have positive logic (Low signal indicates

that the measurement is complete)

NEGative - Causes the Index lines to have negative logic (High signal

indicates that the measurement is complete).

Examples CONT:HAND:EXT:INDEX:LOG POS

control:handler:ext:index:logic negative

Query Syntax CONTrol:HANDler:EXT:INDex:LOGic?

Return Type Character

Default POSitive
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CSET:Fixture Commands

Manages several aspects of Cal Sets.

CSET:

     | CATalog?

     | COPY

     | DALL

     | DATE?

     | DELete

     | EXISts?

     | ETERm:

          | CATalog?

          | [:DATA]

          | X:VALues

     | FIXTure:

          | CASCade

          | CHARacterize

          | DEEMbed

          | EMBed

          | ENR:EMBed

     | TIME?

Click on a keyword to view the command details.

Note: There is no user-interface equivalent for some of these commands.

S ee Also

Example Programs
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Synchronizing the Analyzer and Controller

SCPI Command Tree

CSET:CATalog?

Applicable Models: All

This command replaces SENS:CORR:CSET:CAT?

(Read-only) Returns the names of Cal Sets stored on the VNA.

Parameters None

Examples CSET:CAT?

Returns:

"CalSet_0913,CalSet_1,CalSet_2,CalSet_3,CalSet_4,CH1_CALREG,CH31_CALR

EG,MyCalAll_SMC_002,MyCalAll_STD_001"

Return Type Comma-separated string of names

Default Not Applicable

CSET:COPY <string>,<string>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Creates a new Cal Set and copies the current Cal Set data into it.  Use this command to

manipulate data on a Cal Set without corrupting the original cal data.

Parameters  

<string>,<string> The first string is the name of the current Cal Set. The second string is the
name of the new Cal Set copy.

Examples CSET:COPY 'My2Port','My2PortCopy'

Query Syntax Not Applicable

Default Not Applicable

CSET:DALL
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Applicable Models: All

(Write-only) Deletes ALL Cal Sets from the VNA, including phase reference and Global Delta Match

Cal Sets.

Parameters None

Examples CSET:DALL

Query Syntax Not Applicable

Default Not Applicable

CSET:DATE? <string>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the (year, month, day) that the specified Cal Set was last saved.  

See Also

MMEM:DATE?

MMEM:TIME?

CSET:TIME?

Parameters  

<string> Cal Set name.

Examples CSET:DATE? "CalSet_11"

'Returns:

+2013,+5,+1

Return Type Comma-separated integers.

Default Not Applicable

CSET:DEL <string>
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Applicable Models: All

This command replaces SENS:CORR:CSET:DELete

(Write-only) Deletes the specified Cal Set from the VNA.

If the Cal Set is currently being used by a channel, the Cal Set is deleted and correction for the channel is
turned off.

If the Cal Set is not found, no error is returned.

Parameters  

<string> Name of the Cal Set to delete. Not case-sensitive.

Examples CSET:DEL "MyCalSet"

Query Syntax Not Applicable

Default Not Applicable

CSET:EXISts? <string>

Applicable Models: All

(Read-only) Returns whether or not the specified Cal Set exists on the VNA.

Parameters  

<string> Name or GUID of the Cal Set enclosed in quotes.

The GUID must also be enclosed in curly brackets.

Examples dim check

check = CSET:EXISts? "MyCalSet"

check = CSET:EXISts? "{7C4EEA5E-40D2-4D70-A048-33BFFE704163}"

Return Type Boolean

ON or 1 - Cal Set exists.

OFF or 0 - Cal Set does NOT exist.

Default Not Applicable

CSET:ETERm:CATalog? <CSET Name>[,<errorTermFilter>]
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns a list of error term names for the given Cal Set.

Parameters  

<CSET Name> (String) Name of Cal Set to query.

<errorTermFilter> (Optional argument) CSET:ETER:CAT? <CSETName>, “<errorTermFilter>”

will return only the error term names with the filter string in them. For

example, if it is a full 2-port cal, then CSET:ETER:CAT? <CSETName>,

“cross” would return all “Crosstalk(n,n)” error terms. (Note that the filter is not

case sensitive.)

Entering CSET:ETER:CAT? <CSETName> "" or  CSET:ETER:CAT?

<CSETName> will return all error terms for the given Cal Set.

Examples CSET:ETER:CAT? "CalSet_1"

CSET:ETER:CAT? "CalSet_1", "trans"

Return Type Variant

Default Not Applicable

CSET:ETERm[:DATA] <CSET Name>,<ETerm Name>,<data>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the error term data (real, imaginary pairs) for the given Cal Set and

error term name.

Parameters  

<CSET Name> (String) Name of Cal Set to manipulate.

<ETerm Name> (String)  Name used to identify an error term in the Cal Set.

<data> (Block) Error term data - a real/imaginary data pair for each data point.

Examples CSET:ETER "CalSet_1","Directivity(1,1)", 0.237,-1.422, 0.513,
0.895
CSET:ETER? "CalSet_1","Directivity(1,1)"  'read

Query Syntax CSET:ETERm:DATA? <CSET Name>,<ETerm Name>

Return Type Block data

Default Not Applicable
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CSET:ETERm:X:VALues <CSET Name>,<ETerm Name>,<freqlist>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the x-axis frequencies for the given Cal Set and error term name. This command
requires that the error term already be in existence either from a calibration session or having been created
with CSET:ETER:DATA .

T his command requires that the frequency array length match the existing size of the error term. For example , if the
error term is 3 buckets long (3 complex numbers), then the frequency list must be 3 values long.

Parameters  

<CSET
Name>

(String) Name of Cal Set to manipulate.

<ETerm
Name>

(String)  Name used to identify an error term in the Cal Set.

<freqlist> (Block) X-axis frequencies associated with the error term.

Examples 'Query error term data from calset named "Calset1"
CSET:ETER:DATA? "Calset7","Directivity(1,1)"

'If needed, change or upload the data for the "Directivity" error term (example of a
three point eterm)
CSET:ETER:DATA "Calset7","Directivity(1,1)",-3.86251918972E-002,+5.34659661353E-
002,+2.90613174438E-002,-2.16645095497E-002,-1.38868670911E-003,+3.30922640860E-002

'Query what the frequency values are for the error term
CSET:ETER:X:VAL? "Calset7","Directivity(1,1)"

'If needed, change the frequency values for the error term
CSET:ETER:X:VAL
"Calset7","Directivity(1,1)",1.00000000000E+007,1.42450000000E+008,2.74900000000E+008

Query

Syntax

CSET:ETERm:X:VALues? <CSET Name>,<ETerm Name>

Return

Type

Block data

Default Not Applicable

CSET:FIXTure:CASCade <s2p1>,<s2p2>,<s2pResult>,<char>
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Applicable Models: All

(Write-only) Combines the losses and phase shift of two S2P files into a single S2P file.  Learn more.

Parameters  

<s2p1> (String)  Path and filename of one of the S2P files to be combined.

<s2p2> (String)  Path and filename of the other S2P file to be combined.

<s2pResult> (String) Path and filename of the combined S2P file.

<char> (Character ) Format. Choose from:

REIM - Real, imaginary data pairs

LOG - Log magnitude, phase

LINear - Linear magnitude, phase

Examples CSET:FIXT:CASC "D:\a.s2p","D:\b.s2p","D:\c.s2p",LOG

Query Syntax Not Applicable

Default Not Applicable

CSET:FIXTure:CHARacterize <cs1>,<cs2>,<port>,<s2p>,<char>[,<pivot>]

Applicable Models: All

(Write-only) Characterizes a fixture based on two Cal Sets. The stimulus settings of the two Cal Sets

do NOT have to be identical, but they MUST have a common frequency range for interpolation. A

new S2P file is created.  Learn more about Cal Plane Manager.

Parameters  

<cs1> (String)  Name of an existing Cal Set 1 which describes the cal closest to the
VNA. The Cal Set must reside on the VNA.

<cs2> (String)  Name of an existing Cal Set 2 which describes the cal closest to the

DUT. The Cal Set must reside on the VNA.

<port> (Numeric) Port number described in the Cal Sets.

<s2p> (String) Name of the S2P file containing the adapter/fixture characterization.

<char> (Character ) Format. Choose from:

REIM - Real, imaginary data pairs

LOG - Log magnitude, phase
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LINear - Linear magnitude, phase

[<pivot>] (Numeric) Optional argument. Phase value for the specified port.

Examples CSET:FIXT:CHAR "CalSet1","CalSet2",1,"Fixture.s2p"

cset:fixture:characterize "CalSet1","CalSet2",2,"Fixture.s2p",90

Query Syntax Not Applicable

Default Not Applicable

CSET:FIXTure:DEEMbed <cs1>,<cs2>,<s2p>,<port>, <compPwr>[,extrap]

Applicable Models: All

(Write-only) De-embeds a fixture from an existing Cal Set based on an S2P file. A new Cal Set is

created with the effects of the fixture removed.

When the new Cal Set is applied to a channel, the effects of fixturing are removed from the

measurement data. Do NOT enable fixturing. The effects of the fixture are removed when the new Cal

Set is selected and correction is turned ON.

Parameters  

<cs1> (String)  Name of an existing Cal Set which resides on the VNA.

<cs2> (String)  Name of new Cal Set which contains updated error terms with fixture

de-embedded.

<s2p> (String) Name of the S2P file which characterizes the adapter/fixture.

<port> (Numeric) Port number from which fixture will be de-embedded.

<compPwr> ( Boolean)

ON (1) - When the Cal Set contains a power correction array for the fixture

port, that array will be compensated for the fixture loss.  

Warning: enabling power compensation can result in an increase in test port
power and consequently, increased power to the DUT. Use with caution.

OFF (0) - Do not compensate for loss in source power through the fixture.

[extrap] (Boolean) Optional argument.

ON (1) -Applies a simple extrapolation when the S2P file has a narrower

frequency range than the Cal Set. The values for the first and last data points

are extended in either direction to cover the frequency range of the Cal Set.
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OFF (0) - Extrapolation is NOT performed (default setting).

Examples CSET:FIXT:DEEM "MyCalSet","MyNewCalSet","Fixture.s2p",1,1

cset:fixture:deembed
"MyCalSet","MyNewCalSet","Fixture.s2p",1,1,1 'extrapolation is
performed if the s2p frequency range is narrower than that of
the Cal Set.

Query Syntax Not Applicable

Default Not Applicable

CSET:FIXTure:EMBed <cs1>,<cs2>,<s2p>,<port>, <compPwr>[,extrap]

Applicable Models: All

(Write-only) Embeds a fixture (usually a matching network) into an existing Cal Set based on an S2P

file. A new Cal Set is created with the effects of the matching network included in the correction data.

When the new Cal Set is applied to a channel, the effects of the fixture are included in the

measurement data. Do NOT enable  fixturing. The effects of the matching network are included when

the new Cal Set is selected and correction is turned ON.

Parameters  

<cs1> (String)  Name of an existing Cal Set which resides on the VNA.

<cs2> (String)  Name of new Cal Set which contains updated error terms with fixture

embedded.

<s2p> (String) Name of the S2P file which characterizes the fixture / matching

network.

<port> (Numeric) Port number to which fixture will be added.

<compPwr> (Boolean)

ON (1) - Increase the source power to compensate for the loss through the

fixture. The result is that the specified power level will be correct at the DUT

input.

Warning: enabling power compensation can result in an increase in test port
power and consequently, increased power to the DUT. Use with caution.

OFF (0) - Do not compensate for loss in source power through the matching

network.

[extrap] (Boolean) Optional argument.
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ON (1) -Applies a simple extrapolation when the S2P file has a narrower

frequency range than the Cal Set. The values for the first and last data points

are extended in either direction to cover the frequency range of the Cal Set.

OFF (0) - Extrapolation is NOT performed (default setting).

Examples CSET:FIXT:EMB "MyCalSet","MyNewCalSet","Fixture.s2p",1,1

cset:fixture:embed "MyCalSet","MyNewCalSet","Fixture.s2p",1,1,1
'extrapolation is performed if the s2p frequency range is
narrower than that of the Cal Set.

Query Syntax Not Applicable

Default Not Applicable

CSET:FIXTure:ENR:EMBed <inEnr>,<s2p>,<outEnr>

Applicable Models: All

(Write-only) Generate a new ENR file by embedding an adapter to an existing ENR file.

Parameters  

<inEnr> (String) Path and filename of original ENR file.

<s2p> (String) Path and filename of the S2P file which characterizes the

adapter/fixture network.

<outEnr> (String) Path and filename of new ENR file to output

Examples CSET:FIXT:EMB "D:\Original.enr","D:\adapter.s2p","D:\new.enr"

Query Syntax Not Applicable

Default Not Applicable

CSET:TIME? <string>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the (hour, minute, second) that the specified Cal Set was last saved. The time is

returned in local time as setup in the VNA operating system.  

See Also

CSET:DATE?

MMEM:DATE?

MMEM:TIME?

Parameters  

<string> Cal Set name.

Examples CSET:TIME? "CalSet_11"

'Returns:

+13,+6,+1

Return Type Comma-separated integers.

Default Not Applicable
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Display Commands

Controls the settings of the front panel screen.

DISPlay:

ANNotation

       |
FREQuency[:STATE]

       | MESSage:STATe

       | [:STATus]

ARRange

CATalog?

COLor  More
Commands

ENABle

FSIGn

MEASure

       | DELete

       | FEED

       | MEMory

            | [:STATe]

       | MOVE

       | SELect

       | [:STATe]

       | TITLe

            | DATA

            | [:STATe]

       | Y[:SCALe]

            | AUTO

            | PDIVision

            | RLEVel

            | RPOSition

SHEet

       | ARRange

       | CATalog

       | STATe

       | TITle:DATA

SPLit

STATus

       | LOG

           | CLEar

TMAX
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TILE

TOOLbar

       | CSET[:STATe]

       | ENTRy[:STATe]

       |
EXTensions[:STATe]

       | KEYS[:STATe]

       | MARKer[:STATe]

       | MEAS[:STATe]

       | STIMulus[:STATe]

       | SWEep[:STATe]

       |
TRANsform[:STATe]

UPDate

       | IMMediate

       | [:STATe]

VISible

WINDow

       | ANNotation

            | LIMit

                 | XPOSition

                 | YPOSition

            | MARKer

                 | COUPle

                 | NUMBer

                 | MEASre

     |
XPOSition

                        | YPOSition

                 | NUMBer

                 | RESolution

                       | RESPonse

                       | STIMulus

                 |
SINGle[:STATe]

                 | SIZE

                 | STATe

                 | SYMBol

                       |
ABOVe[:STATe]

                 | VISible

                 | XPOSition

                 | YPOSition
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            | [:STATe]

            | TRACe[:STATe]

            | Y[:STATe]

       | CATalog?

       | ENABle

       | FEED

       | NEXT[:NUMBer]?

       | SIZE

       | [STATe]

       | TABLe

       | TITLe

            | DATA

            | [STATe]

       | TRACe

           | DELete

           | FEED

                 | MNUMber

           |
GRATicule:GRID:LTYPe

           | MEMory[:STATe]

           | MOVE

           | NEXT[:NUMBer]?

           | SELect

           | [STATe]

           | TITLe

                 | DATA

                 | [:STATe]

           | Y[:SCALe]

                 | AUTO

                 | COUPle

                      | METHod

                      | [STATe]

                 | PDIVision

                 | RLEVel

                 | RPOSition

       | Y:AUTO

       | Y[:SCALe]

            | DIVisions

Click on a keyword to view the command details.

Blue keywords are superseded.

See Also
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Referring to Traces Channels Windows and Meas Using SCPI

See an example using some of these commands

Synchronizing the Analyzer and Controller

Learn about Screen Setup

SCPI Command Tree

DISPlay:ANNotation:FREQuency[:STATe] <ON | OFF>

Applicable Models: All

(Read-Write) Turns frequency information on the display title bar ON or OFF for all windows.

Parameters  

<ON | OFF> ON (or 1) - turns frequency annotation ON.

OFF (or 0) - turns frequency annotation OFF.

Examples DISP:ANN:FREQ ON
display:annotation:frequency:state off

Query Syntax DISPlay:ANNotation:FREQuency[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON (1)

DISPlay:ANNotation:MESSage:STATe <ON | OFF>

Applicable Models: All

(Read-Write) Enables and disables error pop-up messages on the display.

Parameters  

<ON | OFF> ON (or 1) - enables error pop-up messages
OFF (or 0) - disables error pop-up messages

Examples DISP:ANN:MESS:STAT ON
display:annotation:message:state off

Query Syntax DISPlay:ANNotation:MESSage:STATe?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON (1)
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DISPlay:ANNotation[:STATus] <ON | OFF>

Applicable Models: All

(Read-Write) Turns the status bar at the bottom of the screen ON or OFF. The status bar displays

information for the active window.

Parameters  

<ON | OFF> ON (or 1) - turns status bar ON.

OFF (or 0) - turns status bar OFF.

Examples DISP:ANN ON
display:annotation:status off

Query Syntax DISPlay:ANNotation[:STATus]?

Return Type Boolean (1 = ON, 0 = OFF)

Default Last state that was set

DISPlay:ARRange <char>

Applicable Models: All

(Write-only) Places EXISTING measurements into pre-configured window arrangements. Overlay,

Stack(2), Split(3), and Quad(4) creates new windows. To learn more, see Window Layout.

Parameters  

<char> Window arrangement. Choose from:

TILE - tiles existing windows

CASCade - overlaps existing windows

OVERlay - all traces placed in 1 window

STACk - 2 windows

SPLit - 3 windows

QUAD - 4 windows

MEASure - 1 measurement per window

CHANnel - 1 channel per window

Examples DISP:ARR CASC
display:arrange cascade

Query Syntax Not Applicable
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Default TILE

DISPlay:CATalog?

Applicable Models: All

(Read-only) Returns the existing Window numbers.

To read the window number of the selected trace, use Calc:Par:WNUM.

Return Type String of Character values, separated by commas

Example Two windows with numbers 1 and 2 returns:
"1,2"

Default Not applicable

DISPlay:ENABle <ON | OFF>

Applicable Models: All

(Read-Write) Specifies whether to disable or enable all analyzer display information in all windows

in the analyzer application. Marker data is not updated. More CPU time is spent making

measurements instead of updating the display.

Parameters  

<ON | OFF> ON (or 1) - turns the display ON.

OFF (or 0) - turns the display OFF.

Examples DISP:ENAB ON
display:enable off

Query Syntax DISPlay:ENABle?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:FSIGn <ON | OFF>
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Applicable Models: All

(Read-Write) Shows or hides the window which displays global pass/fail results.

Parameters  

<ON | OFF> ON (or 1) - displays the pass/fail dialog

OFF (or 0) - hides the pass/fail dialog

Examples DISP:FSIG ON
display:fsign off

Query Syntax DISPlay:FSIGn?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

DISPlay:MEASure<mnum>:DELete

 Applicable Models: All

(Write-only) Deletes the trace associated with the specified measurement number.

Note: The measurement is not deleted. This command does the reverse of DISP:MEAS:FEED.

Parameters  

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

Examples DISP:MEAS:DEL
display:measure2:delete

Query

Syntax
DISPlay:MEASure<mnum>:DELete?

Return
Type

Not Applicable

Default Not Applicable

DISPlay:MEASure<mnum>:FEED <wnum>
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Applicable Models: All

(Write-only) This command creates a new trace in the specified window and connects the trace to

measurement which results in the trace displaying the data from measurement.

Parameters  

<mnum> Measurement number for the measurement. If unspecified, <mnum> is set to 1.

<wnum> Display the measurement in a specified Window number. The window must be turned

on. In addition, a window number must be specified. The range is 1 to 160.

Examples DISP:MEAS2:FEED 10
display:measure:feed 90

Return

Type
Not Applicable

Default Not Applicable

DISPlay:MEASure<mnum>:MEMory[:STATe] <bool>

Applicable Models: All

(Read-Write) Turns the memory trace ON or OFF for the specified measurement.

Note: DISP:MEAS:FEED must first be done to feed the measurement to a trace. This command behaves

the same as DISP:WIND:TRAC:MEM[:STAT] except that it only requires the measurement number.

Parameters  

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<bool> ON or 1 - Turns the memory trace ON.

OFF or 0 - Turns the memory trace OFF.

Examples DISP:MEAS:MEM ON
display:measure:memory:state off

Query

Syntax
DISPlay:MEASure<mnum>:MEMory[:STATe]?

Return Type Boolean
Default OFF

DISPlay:MEASure<mnum>:MOVE <toWin>
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Applicable Models: All

(Write-only) Moves a trace associated with measurement number to the specified window. If the

window is OFF, it will be turn ON.

Parameters  

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<toWin> Number of the window to which the specified measurement is moved. If the

window does not exist, it will be created.

Examples DISP:MEAS:MOVE 2
display:measure:move 1

Query

Syntax
Not Applicable

Default Not Applicable

DISPlay:MEASure<mnum>:SELect

Applicable Models: All

(Write-only) Activates the specified measurement to be selected.

Parameters  

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

Examples DISP:MEAS:SEL
display:measure:select

Query

Syntax
Not Applicable

Default Not Applicable

DISPlay:MEASure<mnum>[:STATe] <bool>
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Applicable Models: All

(Read-Write) Turns ON or OFF the display of a trace associated with the specified

measurement. When OFF, the measurement behind the trace is still active.

Note: A trace must first be created (via FEED), then the visibility of the trace can be affected with

this command. If the trace has not been created, an error is generated: 107,Requested trace not found.

Parameters  

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<bool> ON or 1 - Turns the trace ON.

OFF or 0 - Turns the trace OFF.

Examples DISP:MEAS:STAT ON
display:measure off

Query Syntax DISPlay:MEASure<mnum>[:STATe]?

Return Type Boolean
Default ON or 1

DISPlay:MEASure<mnum>:TITLe:DATA <string>

Applicable Models: All

(Read-Write) Sets or gets the title for the specified measurement. The trace title is embedded in the

trace status field. Learn more about Trace Titles.

Newer entries replace (not append) older entries. The title is turned ON and OFF with

DISP:WIND:TRAC:TITL:STAT.

Parameters  

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<string> Used as the title to be displayed for the measurement. Any characters (not
spaces) enclosed with quotes.

Examples DISP:MEAS:TITL:DATA 'MyNewMeas'
display:measure:title:data 'hello'

Query

Syntax
DISPlay:MEASure<mnum>:TITLe:DATA?

Return

Type
String

Default Not Applicable

DISPlay:MEASure<mnum>:TITLe[:STATe] <bool>
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Applicable Models: All

(Read-Write) Turns ON or OFF the measurement title. 

Note: The measurement and trace need to exist. When turned OFF, the previous trace title returns.

Set a new trace title using DISP:WIND:TRAC:TITL:DATA

Learn more about Trace Titles
Parameters  

<mnum> Measurement number for each measurement. There must be a selected measurement

on the trace. If unspecified, <mnum> is set to 1.

<bool> ON or 1 - turns the title ON.

OFF or 0 - turns the title OFF.

Examples DISP:MEAS:TITL ON
Display:measure:title:state off

Query

Syntax
DISPlay:MEAS<mnum>:TITLe[:STATe]?

Return Type Boolean
Default OFF or 0

DISPlay:MEASure<mnum>:Y[:SCALe]:AUTO

Applicable Models: All

(Write-only) Performs an Autoscale on the specified trace in the specified measurement, providing

the best fit display.

Autoscale is performed only when the command is sent; it does NOT keep the trace autoscaled

indefinitely.

Autoscale behaves differently when scale coupling is enabled. How it behaves depends on the scale

coupling method. Learn more.

See Also, DISPlay:WINDow:Y:AUTO which performs an Autoscale All.

Parameters  

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

Examples DISP:MEAS:Y:AUTO
display:measure:y:scale:auto

Query

Syntax
Not Applicable

Default Not Applicable
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DISPlay:MEASure<mnum>:Y[:SCALe]:PDIVision <num>

Applicable Models: All

(Read-Write) Sets the Y axis Scale Per Division value of the specified trace associated with the

specified measurement.

Note: The measurement and trace need to exist.

Parameters  

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num> Units / division value (Real value). The range of acceptable values is dependent on

format and domain.

Note: This command will accept MIN or MAX instead of a numeric parameter. See

SCPI Syntax for more information.

Examples DISP:MEAS:Y:PDIV 1
display:measure:y:scale:pdivision maximum

Query

Syntax
DISPlay:MEASure<mnum>:Y[:SCALe]:PDIVision?

Return

Type
Numeric

Default 10

DISPlay:MEASure<mnum>:Y[:SCALe]:RLEVel <num>

Applicable Models: All

(Read-Write) Sets the Y axis Reference Level of the specified trace associated with the specified

measurement.

Note: The measurement and trace need to exist.

Parameters  

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num> Reference level value (Real value). The range of acceptable values is dependent on

format and domain.

Note: This command will accept MIN or MAX instead of a numeric parameter. See
SCPI Syntax for more information.

Examples DISP:MEAS:Y:RLEV 0
display:measure:y:scale:rlevel minimum
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Query

Syntax
DISPlay:MEASure<mnum>:Y[:SCALe]:RLEVel?

Return

Type
Numeric

Default 0

DISPlay:MEASure<mnum>:Y[:SCALe]:RPOSition <num>

Applicable Models: All

(Read-Write) Sets the Reference Position of the specified trace associated with the specified

measurement.

Note: The measurement and trace need to exist.

Parameters  

<mnum> Measurement number for each measurement. There must be a selected measurement on

the trace. If unspecified, <mnum> is set to 1.

<num> Reference position on the screen measured in horizontal graticules from the bottom

(Real value). The range of acceptable values is dependent on format and domain.

Note: This command will accept MIN or MAX instead of a numeric parameter. See

SCPI Syntax for more information.

Examples DISP:MEAS:Y:RPOS 0
display:measure:y:rposition maximum

Query

Syntax
DISPlay:MEASure<mnum>:Y[:SCALe]:RPOSition?

Return

Type
Numeric

Default 5

DISPlay:SHEet<num>:ARRange <char>
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Applicable Models: All

(Write-only) This command arranges existing windows to sheets.

 

Parameters  

<num> Sheet number

<char> Sheet arrangement. Choose from:

WINDow: one sheet per window

CHANnel: one sheet per channel

TRACe: one channel per sheet

ONE: merge all windows into one sheet

Examples DISP:SHE:ARR CHAN
display:sheet:arrange channel

Query Syntax Not Applicable

Return Type Not Applicable

Default One sheet per window

DISPlay:SHEet<num>:CATalog?

Applicable Models: All

(Read-only) This command reads and displays comma separated list of window numbers which the

sheet contains.

Parameters  

<num> Sheet number

Examples DISP:SHE:CAT?
display:sheet:catalog?

Return Type Character

Default 1

DISPlay:SHEet<num>:STATe
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Applicable Models: All

(Write-only) Sets the sheet visible and invisible:

ON: If OFF, sets the sheet visible with a new window.

OFF: If ON, sets the sheet invisible with all the containing window state OFF

(DISPlay:WINDow:STATe OFF)

Parameters  

<num> Sheet number

Examples DISP:SHE:STAT ON

display:sheet:state off

Query Syntax DISPlay:SHEet:STATe?

Return Type Bool

Default OFF except for Sheet 1

DISPlay:SHEet<num>:TITLe:DATA <char>

Applicable Models: All

(Read-Write) This command sets or gets the sheet label.

Parameters  

<num> Sheet number

<char> The label of the sheets. Default and present value is "Sheet 1"

Examples DISP:SHE:TITL:DATA "Sheet 1"
display:sheet:title:data "Sheet 1"

Query Syntax DISPlay:SHEet:TITLe:DATA?

Return Type Character

Default "Sheet 1"

DISPlay:SPLit <num>
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Applicable Models: All

(Write-only) Destroys all existing traces, channels and windows, then creates N windows. No

channels are created.

Parameters  

<num> N is 1 or greater.

Examples DISP:SPL
display:split

Query Syntax DISPlay:SPLit?

Return Type Numeric
Default Not Applicable

DISPlay:STATus:LOG:CLEar

Applicable Models: All

(Write-only) Clears the message region in the status bar.

Parameters  

Examples DISP:STAT:LOG:CLE
display:status:log:clear

Query Syntax Not Applicable

Default Not Applicable

DISPlay:TMAX <bool>

Applicable Models: All

(Read-Write) Maximizes (isolates) or restores the active trace in the active window. When turned ON,

the active trace is the ONLY trace on the display. All other traces are hidden. Learn more.

Parameters  

<bool> ON (or 1) - Maximize /  isolates the active trace.

OFF (or 0) - Restores other traces to the normal window setting.

Examples DISP:TMAX ON
display:tmax 0

Query Syntax DISPlay:TMAX?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF
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DISPlay[:TILE]  - Superseded

This command is replaced by DISP:ARRange

(Write-only) Tiles the windows on the screen.

Examples DISP
display:tile

Default Not Applicable

DISPlay:TOOLbar:CSET[:STATe] <bool>

Applicable Models: All

(Read-Write) Show or hide the calset toolbar.

Parameters  

<bool> ON (or 1) - Toolbar ON.

OFF (or 0) - Toolbar OFF.

Examples DISP:TOOL:CSET ON

display:toolbar:cset:state off

Query Syntax DISPlay:TOOLbar:CSET[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:TOOLbar:ENTRy[:STATe] <bool>
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Applicable Models: All

(Read-Write) Specifies whether to show or hide the active entry toolbar. See this toolbar.

Parameters  

<bool> ON (or 1) - Toolbar ON.

OFF (or 0) - Toolbar OFF.

Examples DISP:TOOL:ENTR ON

display:toolbar:entry:state off

Query Syntax DISPlay:TOOLbar:ENTRy[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:TOOLbar:EXTensions[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Specifies whether to show or hide the port extensions toolbar. See this toolbar.

Parameters  

<bool> ON (or 1) - Toolbar ON.

OFF (or 0) - Toolbar OFF.

Examples DISP:TOOL:EXT ON

display:toolbar:extensions:state off

Query Syntax DISPlay:TOOLbar:EXTensions[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:TOOLbar:KEYS[:STATe] <bool>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Specifies whether to show or hide the virtual hardkeys on the VNA display. These are

primarily used when the VNA is accessed remotely using VNC or Windows Remote Desktop.

Parameters  

<bool> ON (or 1) - Keys ON.

OFF (or 0) - Keys  OFF.

Examples DISP:TOOL:KEYS ON

display:toolbar:keys:state off

Query Syntax DISPlay:TOOLbar:KEYS [:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:TOOLbar:MARKer[:STATe] <bool>

Applicable Models: All

(Read-Write) Specifies whether to show or hide the marker toolbar. See this toolbar.

Parameters  

<bool> ON (or 1) - Toolbar ON.

OFF (or 0) - Toolbar OFF.

Examples DISP:TOOL:MARK ON

display:toolbar:marker:state off

Query Syntax DISPlay:TOOLbar:MARKer[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:TOOLbar:MEASurement[:STATe] <bool> OBSOLETE
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This toolbar was eliminated with A.10.00

(Read-Write) Specifies whether to show or hide the measurement toolbar.

Parameters  

<bool> ON (or 1) - Toolbar ON.

OFF (or 0) - Toolbar OFF.

Examples DISP:TOOL:MEAS ON

display:toolbar:measurement:state off

Query Syntax DISPlay:TOOLbar:MEASurement[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:TOOLbar:STIMulus[:STATe] <bool> OBSOLETE

This toolbar was eliminated with A.10.00

(Read-Write) Specifies whether to show or hide the stimulus toolbar.

Parameters  

<bool> ON (or 1) - Toolbar ON.

OFF (or 0) - Toolbar OFF.

Examples DISP:TOOL:STIM ON

display:toolbar:stimulus:state off

Query Syntax DISPlay:TOOLbar:STIMulus[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:TOOLbar:SWEep[:STATe] <bool> OBSOLETE
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This toolbar was eliminated with A.10.00

(Read-Write) Specifies whether to show or hide the sweep control toolbar.

Parameters  

<bool> ON (or 1) - Toolbar ON.

OFF (or 0) - Toolbar OFF.

Examples DISP:TOOL:SWE ON

display:toolbar:sweep:state off

Query Syntax DISPlay:TOOLbar:SWEep[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:TOOLbar:TRANsform[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Specifies whether to show or hide the Time Domain toolbar. See this toolbar.

Parameters  

<bool> ON (or 1) - Toolbar ON.

OFF (or 0) - Toolbar OFF.

Examples DISP:TOOL:TRAN ON

display:toolbar:transform:state off

Query Syntax DISPlay:TOOLbar:TRANsform[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:UPDate[:STATe] <bool>
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Applicable Models: All

(Read-Write) Enables or disables display updates. Disabling display updates improves measurement

performance. When disabled, the display windows (traces, markers, etc.) are frozen.

Parameters  

<bool> ON (or 1) - Toolbar ON.

OFF (or 0) - Toolbar OFF.

Examples DISP:UPD ON

display:update:state off

Query Syntax DISPlay:UPDate[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:UPDate:IMMediate

Applicable Models: All

(Write-only) Executes the display update once when the display update of the LCD screen is set to

OFF (specifying False with the DISPlay:ENABle object).

Parameters  

Examples DISP:UPD:IMM
display:update:immediate

Query Syntax Not Applicable

Return Type Not Applicable
Default Not Applicable

DISPlay:VISible <ON | OFF>
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Applicable Models: All

(Read-Write) Makes the VNA application visible or not visible. In the Not Visible state, the analyzer

cycle time for making measurements, and especially data transfer, can be significantly faster because

the display does not process data.

Parameters  

<ON | OFF> ON (or 1) - VNA app is visible

OFF (or 0) - VNA app is NOT visible

Examples DISP:VIS ON
display:visible off

Query Syntax DISPlay:VISible?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:WINDow<wnum>:ANNotation:LIMit:XPOSition <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the X-axis position of the Limit Line Pass/Fail indicator on the VNA

screen. The lower-left corner of the Pass/Fail indicator is the point of reference for positioning.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<num> X-axis position. Choose a value between 0 (far left) and 10 (far right).

Examples DISP:WIND:ANN:LIM:XPOS 1.5

display:window:annotation:limit:xposition 5

Query Syntax DISPlay:WINDow:ANNotation:LIMit:XPOSition?

Return Type Numeric

Default 7

DISPlay:WINDow<wnum>:ANNotation:LIMit:YPOSition <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the Y-axis position of the Limit Line Pass/Fail indicator on the VNA

screen. The lower-left corner of the Pass/Fail indicator is the point of reference for positioning.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<num> Y-axis position. The maximum position is limited to the current Y-axis

division value. Choose a value between 2 (bottom) and 30 (top).

Examples DISP:WIND:ANN:LIM:YPOS 1.5

display:window:annotation:limit:yposition 5

Query Syntax DISPlay:WINDow:ANNotation:LIMit:YPOSition?

Return Type Numeric

Default 0

DISPlay:WINDow<wnum>:ANNotation:MARKer:COUPle[:STATe] <bool>

Applicable Models: All

(Read-Write) Sets the marker readouts to coupled (one combination annotation) or not coupled (one

annotation per trace). This setting is per Window scope.

See other SCPI Marker commands. Learn more about Marker readout.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<bool> ON (or 1) - Marker readouts are coupled

OFF (or 0) - Marker readouts are not coupled

Examples DISP:WIND:ANN:MARK:COUP ON
display:window:annotation:marker:couple on

Query Syntax DISPlay:WINDow:ANNotation:MARKer:COUPle?

Return Type Boolean

Default ON

DISPlay:WINDow<wnum>:ANNotation:MARKer:NUMBer <num>
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Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

This command replaces DISP:WIND:ANN:MARK:SINGle

(Read-Write) Sets the number of marker readouts to display per trace. Display up to 20 marker

readouts per window.

See other SCPI Marker commands. Learn more about Marker readout.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<num> Number of marker readouts to display. Choose a value between 1 and 16.

Examples DISP:WIND:ANN:MARK:NUMB 7
display:window:annotation:marker:number 2

Query Syntax DISPlay:WINDow:ANNotation:MARKer:NUMBer?

Return Type Numeric

Default 5

DISPlay:WINDow:ANNotation:MARKer:MEASure<mnum>:XPOSition <num>

Applicable Models: E5080A, M9485A

(Read-Write) Sets the X-axis position of marker readouts. Readouts are right-justified at the specified

position. This function is used when :DISP:WIND:ANN:MARK:COUP:STAT is off. Use

:DISP:WIND:ANN:MARK:XPOS is used when :DISP:WIND:ANN:MARK:COUP:STAT is on.

See other SCPI Marker commands. Learn more about Marker readout.

Parameters  

<mnum> Measurement. If unspecified, value is set to 1.

<num> X-axis position. Choose a value between 1 (far left) and 10 (far right).

Examples DISP:WIND:ANN:MARK:MEAS:XPOS 1.5
display:window:annotation:marker:measure:xposition 5

Query Syntax DISPlay:WINDow:ANNotation:MARKer:MEASure:XPOSition?

Return Type Numeric

Default 10

DISPlay:WINDow:ANNotation:MARKer:MEASure<mnum>:YPOSition <num>
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Applicable Models: E5080A, M9485A

(Read-Write) Sets the Y-axis position of marker readouts. Readouts are top-justified at the specified

position. This function is used when :DISP:WIND:ANN:MARK:COUP:STAT is off. Use

:DISP:WIND:ANN:MARK:YPOS is used when :DISP:WIND:ANN:MARK:COUP:STAT is on.

See other SCPI Marker commands. Learn more about Marker readout.

Parameters  

<mnum> Measurement. If unspecified, value is set to 1.

<num> Y-axis position. Choose a value between 1 (bottom) and 10 (top).

Examples DISP:WIND:ANN:MARK:MEAS:YPOS 1.5
display:window:annotation:marker:measure:yposition 5

Query Syntax DISPlay:WINDow:ANNotation:MARKer:MEASure:YPOSition?

Return Type Numeric

Default 10

DISPlay:WINDow<wnum>:ANNotation:MARKer:RESolution:STIMulus <num>

Applicable Models: All

(Read-Write) For the X-axis (stimulus), sets the number digits to display after the decimal point in

marker readouts.

See other SCPI Marker commands. Learn more about Marker readout.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<num> Number of digits to display. Choose a value between 2 and 6.

Examples DISP:WIND:ANN:MARK:RES:STIM 2
display:window:annotation:marker:resolution:stimulus 4

Query Syntax DISPlay:WINDow:ANNotation:MARKer:RESolution:STIMulus?

Return Type Numeric

Default 3

DISPlay:WINDow<wnum>:ANNotation:MARKer:RESolution:RESPonse <num>
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Applicable Models: All

(Read-Write) For the Y-axis (response), sets the number digits to display after the decimal point in

marker readouts.

See other SCPI Marker commands. Learn more about Marker readout.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<num> Number of digits to display. Choose a value between 1 and 4.

Examples DISP:WIND:ANN:MARK:RES:RESP 1
display:window:annotation:marker:resolution:stimulus 2

Query Syntax DISPlay:WINDow:ANNotation:MARKer:RESolution:RESPonse?

Return Type Numeric

Default 2

DISPlay:WINDow<wnum>:ANNotation:MARKer:SINGle[:STATe] <bool> - Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command is replaced by DISP:WIND:ANN:MARK:NUMB

(Read-Write) Either shows marker readout of only the active trace or other traces simultaneously.

See other SCPI Marker commands. Learn more about Marker readout.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<bool> ON (or 1) - Shows the readout of only the active marker for each trace.

OFF (or 0) - Shows up to 5 marker readouts per trace, up to 20 total readouts.

Examples DISP:WIND:ANN:MARK:SING ON
display:window:annotation:marker:single off

Query Syntax DISPlay:WINDow:ANNotation:MARKer:SINGle?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

DISPlay:WINDow<wnum>:ANNotation:MARKer:SIZE <char>
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Applicable Models: All

(Read-Write) Specifies the size of the marker readout text. See other SCPI Marker commands. Learn

more about Marker readout.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<char> Readout text size. Choose from:NORMal | LARGe

Examples DISP:WIND:ANN:MARK:SIZE LARG
display:window:annotation:marker:size normal

Query Syntax DISPlay:WINDow:ANNotation:MARKer:SIZE?

Return Type Character

Default NORMal

DISPlay:WINDow<wnum>:ANNotation:MARKer[:STATe] <ON | OFF>

Applicable Models: All

(Read-Write) Specifies whether to show or hide the Marker readout (when markers are ON) on the

selected window. See other SCPI Marker commands. Learn more about Marker readout.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<ON | OFF> ON (or 1) - turns marker readout ON.

OFF (or 0) - turns marker readout OFF.

Examples DISP:WIND:ANN:MARK ON
display:window:annotation:marker:state off

Query Syntax DISPlay:WINDow:ANNotation:MARKer[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:WINDow<wnum>:ANNotation:MARKer:SYMBol <char>
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Applicable Models: All

(Read-Write) Sets the symbol to display for marker position.

See other SCPI Marker commands.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<char> Marker symbol. Choose from:

TRIangle

FLAG

LINE

See pictures of each

Examples DISP:WIND:ANN:MARK:SYMB TRI

display:window:annotation:marker:symbol line

Query Syntax DISPlay:WINDow:ANNotation:MARKer:SYMBol?

Return Type Character

Default TRIangle

DISPlay:WINDow<wnum>:ANNotation:MARKer:VISible <char>

Applicable Models: All

(Read-Write) Shows the marker readouts only for active trace or for all traces. This setting is per

Window scope. See this toolbars

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<char> ACTive  - readout is turned on for active trace only.

ALL - readout is turned on for all traces.

Examples DISP:WIND:ANN:MARK:VIS ACT

display:windows:annotation:marker:visible all

Query Syntax DISPlay:WINDow:ANNotation:MARKer:VISible?

Return Type Character
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Default ALL

DISPlay:WINDow<wnum>:ANNotation:MARKer:SYMBol:ABOVe[:STATe] <ON | OFF>

Applicable Models: E5080A, M9485A

(Read-Write) Specifies whether or not to force marker symbols to be displayed above the trace. When ON, all
marker symbols will be displayed above the trace and the active marker will be filled solid. See other SCPI

Marker commands.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<ON | OFF> ON (or 1) - ALL marker symbols are displayed above the trace. Only the

active marker is filled solid.

OFF (or 0) - ONLY the active marker is displayed above the trace. The active

marker is not filled solid.

Examples DISP:WIND:ANN:MARK:SYMB:ABOV ON
display:window:annotation:marker:symbol:above:state off

Query Syntax DISPlay:WINDow:ANNotation:MARKer:SYMBol:ABOVe[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF - ON in IM Spectrum and SA measurement classes

DISPlay:WINDow<wnum>:ANNotation:MARKer:XPOSition <num>

Applicable Models: All

(Read-Write) Sets the X-axis position of marker readouts. Readouts are right-justified at the specified

position.

See other SCPI Marker commands. Learn more about Marker readout.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<num> X-axis position. Choose a value between 1 (far left) and 10 (far right).

Examples DISP:WIND:ANN:MARK:XPOS 1.5
display:window:annotation:marker:xposition 5

Query Syntax DISPlay:WINDow:ANNotation:MARKer:XPOSition?

Return Type Numeric

959



Default 10

DISPlay:WINDow<wnum>:ANNotation:MARKer:YPOSition <num>

Applicable Models: All

(Read-Write) Sets the Y-axis position of marker readouts. Readouts are top-justified at the specified

position.

See other SCPI Marker commands. Learn more about Marker readout.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<num> Y-axis position. Choose a value between 1 (bottom) and 10 (top).

Examples DISP:WIND:ANN:MARK:YPOS 1.5
display:window:annotation:marker:yposition 5

Query Syntax DISPlay:WINDow:ANNotation:MARKer:YPOSition?

Return Type Numeric

Default 10

DISPlay:WINDow<wnum>:ANNotation[:TRACe][:STATe] <ON | OFF>

Applicable Models: All

(Read-Write) Specifies whether to show or hide the Trace Status buttons on the left of the display.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<ON | OFF> ON (or 1) - turns the buttons ON.
OFF (or 0) - turns the buttons OFF.

Examples DISP:WIND:ANN ON
display:window:annotation:trace:state off

Query Syntax DISPlay:WINDow:ANNotation[:TRACe][:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:WINDow<wnum>:ANNotation: Y[:STATe] <bool>
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Applicable Models: All

(Read-Write) Turns ON or OFF the Y-axis scale label in display window.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<bool> ON or 1 - Turns ON the Y-axis scale.

OFF or 0 - Turns OFF the Y-axis scale.

Examples DISP:WIND:ANN:Y ON
display:window:annotation:y off

Query Syntax DISPlay:WINDow:ANNotation:Y?

Return Type Boolean

Default ON or 1

DISPlay:WINDow<wnum>:CATalog?

Applicable Models: All

(Read-only) Returns the trace numbers for the specified window.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

Example Window 1 with four traces:
DISPlay:WINDow1:CATalog?
Returns:
"1,2,3,4"

Return Type String of Character values separated by commas

Default Not applicable

DISPlay:WINDow<wnum>:ENABle <ON | OFF>
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Applicable Models: All

(Read-Write) Specifies whether to disable or enable all analyzer display information in the specified

window. Marker data is not updated. More CPU time is spent making measurements instead of

updating the display.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<ON | OFF> ON (or 1) - turns the display ON.

OFF (or 0) - turns the display OFF.

Examples DISP:WIND:ENABle ON
display:window1:enable off

Query Syntax DISPlay:WINDow<wnum>:ENABle?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:WINDow<wnum>:FEED <snum>

Applicable Models: All

(Write-only) This command feeds a specified window to the sheet. If there is a window in the sheet,

the sheet is visible. If there is no window in the sheet, the sheet is not visible. If no windows exists in

the system, one empty sheet is visible.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<snum> Sheet number

Examples DISP:WIND:FEED 5
display:window:feed 5

Return Type Not Applicable

Default Not Applicable

DISPlay:WINDow<wnum>:NEXT[:NUMBer]?
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Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-only) Returns the lowest window number which has less than the maximum number of traces.

Basically, returns the first window which has room for another trace. Note that the window may need

to be turned on first (i.e. disp:wind:stat ON may be needed).

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

Examples DISP:WIND:NEXT
display:window1:NEXT

Query Syntax DISPlay:WINDow<wnum>:NEXT?

Return Type Not Applicable

Default Not Applicable

DISPlay:WINDow<wnum>:SIZE <char>

Applicable Models: All

(Read-Write) Sets or returns the window setting of Maximized, Minimized, or Normal. To arrange all

of the windows, use DISP:ARR.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1

<char> Window size. Choose from:

MIN | MAX | NORM

Examples DISP:WIND:SIZE MAX
display:window:size norm

Query Syntax DISPlay:WINDow:SIZE?

Default Not Applicable

DISPlay:WINDow<wnum>[:STATe] <ON | OFF>
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Applicable Models: All

(Read-Write) Write to create or delete a window on the screen or Read whether a window is present.

Parameters  

<wnum> Window number to create; choose any integer between 1 and the maximum
number of windows allowed in the  VNA.

<ON | OFF> ON (or 1) - The window <wnum> is created.

OFF (or 0) - The window <wnum> is deleted.

Examples DISP:WIND ON
display:window2:state off

Query Syntax DISPlay:WINDow<wnum>[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default Window number "1" ON

DISPlay:WINDow<wnum>:TABLe <char>

Applicable Models: All

(Read-Write) Write to show the specified table at the bottom of the analyzer screen or Read to

determine what table is visible.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1

<char> Table to show. Choose from:

OFF | MARKer | LIMit | SEGMent

Examples DISP:WIND:TABLe SEGM
display:window:table off

Query Syntax DISPlay:WINDow:TABLe?

Default OFF

DISPlay:WINDow<wnum>:TITLe:DATA <string>
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Applicable Models: All

(Read-Write) Sets data in the window title area. The title is turned ON and OFF with

DISP:WIND:TITL:STAT OFF. 

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<string> Title to be displayed. Any characters, enclosed with quotes. If the title string

exceeds 50 characters, an error will be generated and the title not accepted.

Newer entries replace (not append) older entries.

Examples DISP:WIND:TITL:DATA 'hello'
display:window2:title:data 'hello'

Query Syntax DISPlay:WINDow<wnum>:TITLe:DATA?

Return Type String

Default NA

DISPlay:WINDow<wnum>:TITLe[:STATe] <ON | OFF>

Applicable Models: All

(Read-Write) Turns display of the title string ON or OFF.  When OFF, the string remains, ready to be

redisplayed when turned back ON.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<ON | OFF> ON (or 1) - turns the title string ON.

OFF (or 0) - turns the title string OFF.

Examples DISP:WIND:TITL ON
Display:window1:title:state off

Query Syntax DISPlay:WINDow<wnum>:TITLe[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:WINDow<wnum>:TRACe<tnum>:DELete
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Applicable Models: All

(Write-only) Deletes the specified trace from the specified window. The measurement parameter

associated with the trace is not deleted.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<tnum> The number of the trace to be deleted; if unspecified, value is set to 1.

Note: This is NOT the trace number of the channel which appears as the Tr

annotation on the Trace Status display. This <tnum> is the trace number within

the specified window, and is used ONLY for remote programs.

Examples DISP:WIND:TRAC:DEL
display:window2:trace2:delete

Query Syntax Not Applicable

Default Not Applicable

DISPlay:WINDow<wnum>:TRACe<tnum>:FEED <name>

Applicable Models: All

(Write-only) Creates a new trace <tnum> and associates (feeds) a measurement <name> to the

specified window<wnum>. This command should be executed immediately after creating a new

measurement with CALCulate:MEASure:DEFine.

To feed the same measurement to multiple traces, create another measurement with the same

<parameter>, but different <name>, using the CALC:PAR:DEF command. The analyzer will collect

the data only once.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<tnum> Trace number to be created. Choose any Integer between 1 and the VNA

maximum number of traces per window allowed.

Note: This is NOT the trace number of the channel which appears as the Tr

annotation on the Trace Status display. This <tnum> is the trace number within

the specified window, and is used ONLY for remote programs.

<name> Name of the measurement that was defined with

CALC:PAR:DEF<name>,<parameter>

966



Examples DISP:WIND:TRAC:FEED 'test'
display:window2:trace2:feed 'test'

Query Syntax Not applicable

Default "CH1_S11"

DISPlay:WINDow<wnum>:TRACe<tnum>:FEED:MNUMber <int>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Creates a new trace <tnum> for an existing measurement (MNUM) and associates

(feeds) the measurement number to the specified window<wnum>. A measurement is created using

the CALC:MEAS:DEF command.

Measurements created in the system all have unique numbers. Similarly, every window has a unique

number and the numbers are displayed in the lower-left corner of each window. Every window has the

capacity to hold a finite number of traces from 1 to N, where N is the maximum number of traces per

window. Each window uses the same range of trace numbers. For example, window 1 can have a trace

1 and so can window 2.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<tnum> Trace number to be created. Choose any Integer between 1 and the VNA

maximum number of traces per window allowed.

Note: After executing the DISP:WIND:TRAC:FEED:MNUM command, a

new trace is added to the specified window and the trace number of the channel

which appears as the Tr annotation on the Trace Status display is the actual

measurement number.

<int> Number of an existing measurement. The range is 1 to 2000.

Examples CALC:MEAS2:DEF "S22"
DISP:WIND:TRAC4:FEED:MNUM 2

Query Syntax Not applicable

Default Not applicable

DISPlay:WINDow:TRACe:GRATicule:GRID:LTYPE <value>
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Applicable Models: All

(Read-Write) Sets and returns the grid line type (solid | dotted) for all open windows. Grid is returned

to solid when the VNA is Preset. Learn more.

Parameters  

<value> Line type. Choose from:

SOLid - solid lines

DOTTed - dotted lines

Examples DISP:WIND:TRAC:GREAT:GRID:LTYPE SOL
display:window:trace:graticule:grid:ltype dotted

Query Syntax DISPlay:WINDow:TRACe:GRATicule:GRID:LTYPE?

Return Type Character

Default SOLID

DISPlay:WINDow<wnum>:TRACe<tnum>:MEMory[:STATe] <ON | OFF>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns the memory trace ON or OFF.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

<tnum> Any existing trace number; if unspecified, value is set to 1.

Note: This is NOT the trace number of the channel which appears as the Tr

annotation on the Trace Status display. This <tnum> is the trace number within

the specified window, and is used ONLY for remote programs.

<ON | OFF> ON (or 1) - turns the memory trace ON.

OFF (or 0) - turns the memory trace OFF.

Examples DISP:WIND:TRAC:MEM ON
display:window2:trace2:memory:state off

Query Syntax DISPlay:WIND<wnum>:TRACe<tnum>:MEMory[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF
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DISPlay:WINDow<fromWin>:TRACe<tnum>:MOVE <toWin>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Moves a trace from one window to another window.

Parameters  

<fromWin> Window number to move the trace from. If unspecified, value is set to 1.

Use Disp:Cat? to read the existing window numbers.

<tnum> Trace number to be moved. If unspecified, value is set to 1.

Use Disp:Wind:Cat? to read the trace numbers in an existing window.

Note: This is NOT the trace number of the channel which appears as the Tr

annotation on the Trace Status display. This <tnum> is the trace number within

the specified window, and is used ONLY for remote programs.

<toWin> Number of the window to move the trace to. If the window does not exist, it

will be created.

Examples DISP:WIND:TRAC2:MOVE 2
display:window2:trace2:move 1

Query Syntax Not applicable

Default Not applicable

DISPlay:WINDow<wnum>:TRACe:NEXT[:NUMBer]?

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-only) Returns the next unused trace number. For example, if trace #1, #2, and #3 are being

used, then this command will return 4.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

Examples DISP:WIND:TRAC:NEXT?
display:window1:trace:NEXT?

Return Type Integer

Default Not Applicable

DISPlay:WINDow<wnum>:TRACe<tnum>:SELect
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Activates the specified trace in the specified window for front panel use.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

Use Disp:Cat? to read the existing window numbers.

<tnum> Any existing trace number; if unspecified, value is set to 1.

Note: This is NOT the trace number of the channel which appears as the Tr

annotation on the Trace Status display. This <tnum> is the trace number within

the specified window, and is used ONLY for remote programs.

Examples DISP:WIND:TRAC:SEL
display:window2:trace2:select

Query Syntax Not applicable

Default NA

DISPlay:WINDow<wnum>:TRACe<tnum>[:STATe] <ON | OFF>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns the display of the specified trace in the specified window ON or OFF. When OFF,

the measurement behind the trace is still active.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

Use Disp:Cat? to read the existing window numbers.

<tnum> Any existing trace number; if unspecified, value is set to 1.

Use Disp:Wind:Cat? to read the trace numbers in an existing window.

Note: This is NOT the trace number of the channel which appears as the Tr

annotation on the Trace Status display. This <tnum> is the trace number within

the specified window, and is used ONLY for remote programs.

<ON | OFF> ON (or 1) - turns the trace ON.

OFF (or 0) - turns the trace OFF.

Examples DISP:WIND:TRAC ON
display:window2:trace2:state off

Query Syntax DISPlay:WIND<wnum>:TRACe<tnum>[:STATe]?
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Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:WINDow<wnum>:TRACe<tnum>:TITLe:DATA <string>

Applicable Models: All

(Read-Write) Writes and read data to the trace title area. The trace title is embedded in the trace status

field. Learn more about Trace Titles.

Newer entries replace (not append) older entries. The title is turned ON and OFF with

DISP:WIND:TRAC:TITL:STAT.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

Use Disp:Cat? to read the existing window numbers.

<tnum> Trace number of the specified window. If unspecified, value is set to 1. Use

Display:Cat? to read the window numbers. Use Disp:Window:Cat? to read the

trace numbers of the specified window.

Note: This is NOT the trace number of the channel which appears as the Tr

annotation on the Trace Status display. This <tnum> is the trace number within

the specified window, and is used ONLY for remote programs.

<string> Title to be displayed. Any characters (not spaces) enclosed with quotes.

Examples DISP:WIND:TRAC:TITL:DATA 'MyNewMeas'
display:window2:trace3:title:data 'hello'

Query Syntax DISPlay:WINDow<wnum>:TRACe<tnum>TITLe:DATA?

Return Type String

Default Not Applicable

DISPlay:WINDow<wnum>:TRACe<tnum>:TITLe[:STATe] <bool>
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Applicable Models: All

(Read-Write) Turns display of the Trace Title ON or OFF.  When turned OFF, the previous trace title

returns. Set a new trace title using DISP:WIND:TRAC:TITL:DATA

Learn more about Trace Titles

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1

Use Disp:Cat? to read the existing window numbers.

<tnum> Trace number of the specified window. If unspecified, value is set to 1. Use

Display:Cat? to read the window numbers. Use Disp:Window:Cat? to read the trace

numbers of the specified window.

Note: This is NOT the trace number of the channel which appears as the Tr

annotation on the Trace Status display. This <tnum> is the trace number within

the specified window, and is used ONLY for remote programs.

<bool> ON (or 1) - turns the title ON.

OFF (or 0) - turns the title OFF.

Examples DISP:WIND:TRAC:TITL ON
Display:window2:trace3:title:state off

Query Syntax DISPlay:WINDow<wnum>:TRACe<tnum>:TITLe[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:AUTO
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Performs an Autoscale on the specified trace in the specified window, providing the best

fit display.

Autoscale is performed only when the command is sent; it does NOT keep the trace autoscaled

indefinitely.

Autoscale behaves differently when scale coupling is enabled. How it behaves depends on the scale

coupling method. Learn more.

See Also, DISPlay:WINDow:Y:AUTO which performs an Autoscale All.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

Use Disp:Cat? to read the existing window numbers.

<tnum> Any existing trace number; if unspecified, value is set to 1.

Use Disp:Wind:Cat? to read the trace numbers in an existing window.

Note: This is NOT the trace number of the channel which appears as the Tr

annotation on the Trace Status display. This <tnum> is the trace number within

the specified window, and is used ONLY for remote programs.

Examples DISP:WIND:TRAC:Y:AUTO
display:window2:trace2:y:scale:auto

Query Syntax Not applicable

Default Not applicable

DISPlay:WINDow:TRACe:Y[:SCALe]:COUPle:METHod <char>

973



Applicable Models: All

(Read-Write) Sets and returns the method of scale coupling. Learn more about Scale coupling.

Parameters  

<char> OFF - NO scale coupling for any windows.

WINDow - Scale settings are coupled for traces in each window.

ALL - Scale settings are coupled for traces in ALL selected windows.

Enable the selected windows using DISP:WIND:TRAC:Y:COUP ON

Examples DISP:WIND:TRAC:Y:COUP:METH ALL

Display:window2:trace:y:scale:method window

Query Syntax DISPlay:WINDow:TRACe:Y[:SCALe]:COUPle:METHod?

Return Type Character

Default OFF

DISPlay:WINDow<wnum>:TRACe:Y[:SCALe]:COUPle[:STATe] <bool>

Applicable Models: All

(Read-Write) Enables and disables scale coupling for the specified window. Learn more about Scale

coupling.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1

Use Disp:Cat? to read the existing window numbers.

<bool> ON (or 1) - Scale coupling enabled for specified window.

OFF (or 0) - Scale coupling disabled for specified window.

Examples DISP:WIND:TRAC:Y:COUP ON

Display:window2:trace:y:scale:couple:state off

Query Syntax DISPlay:WINDow<wnum>:TRACe:Y[:SCALe]:COUPle[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON
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DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:PDIVision <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the Y axis Per Division value of the specified trace in the specified window.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

Use Disp:Cat? to read the existing window numbers.

<tnum> Any existing trace number; if unspecified, value is set to 1.

Use Disp:Wind:Cat? to read the trace numbers in an existing window.

Note: This is NOT the trace number of the channel which appears as the Tr

annotation on the Trace Status display. This <tnum> is the trace number within

the specified window, and is used ONLY for remote programs.

<num> Units / division value. The range of acceptable values is dependent on format

and domain.

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples DISP:WIND:TRAC:Y:PDIV 1
display:window2:trace2:y:scale:pdivision maximum

Query Syntax DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:PDIVision?

Return Type Numeric

Default 10

DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RLEVel <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the Y axis Reference Level of the specified trace in the specified window.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

Use Disp:Cat? to read the existing window numbers.

<tnum> Any existing trace number; if unspecified, value is set to 1.

Use Disp:Wind:Cat? to read the trace numbers in an existing window.

Note: This is NOT the trace number of the channel which appears as the Tr

annotation on the Trace Status display. This <tnum> is the trace number within

the specified window, and is used ONLY for remote programs.

<num> Reference level value. The range of acceptable values is dependent on format

and domain.

Note: This command will accept MIN or MAX instead of a numeric parameter.

See SCPI Syntax for more information.

Examples DISP:WIND:TRAC:Y:RLEV 0
display:window2:trace2:y:scale:rlevel minimum

Query Syntax DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RLEVel?

Return Type Numeric

Default Not Applicable

DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RPOSition <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the Reference Position of the specified trace in the specified window.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

Use Disp:Cat? to read the existing window numbers.

<tnum> Any existing trace number; if unspecified, value is set to 1.

Use Disp:Wind:Cat? to read the trace numbers in an existing window.

Note: This is NOT the trace number of the channel which appears as the Tr

annotation on the Trace Status display. This <tnum> is the trace number within

the specified window, and is used ONLY for remote programs.

<num> Reference position on the screen measured in horizontal graticules from the

bottom. Choose a value between 0 and 10.

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples DISP:WIND:TRAC:Y:RPOS 0

display:window2:trace2:y:rposition maximum

Query Syntax DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RPOSition?

Return Type Numeric

Default 5

DISPlay:WINDow<wnum>:Y:AUTO
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Applicable Models: All

(Write-only) Scales ALL of the traces to fit in the same window. This is equivalent to "Autoscale All"

from the front panel.

Autoscale behaves differently when scale coupling is enabled. How it behaves depends on the scale

coupling method. Learn more.

Autoscale is performed only when the command is sent; it does NOT keep the trace autoscaled

indefinitely.

See Also, DISPlay:WINDow:TRACe:Y:AUTO which Autoscales only the specified trace.

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1.

Use Disp:Cat? to read the existing window numbers.

Examples DISP:WIND:Y:AUTO
display:window2:y:auto

Query Syntax Not applicable

Default Not applicable

DISPlay:WINDow<wnum>:Y[:SCALe]:DIVisions <num>

Applicable Models: All

(Read-Write) Sets or returns the number of divisions in all the graphs, for the selected channel

Parameters  

<wnum> Any existing window number. If unspecified, value is set to 1

Use Disp:Cat? to read the existing window numbers.

<bool> ON or 1 - Scale coupling enabled for specified window.

OFF or 0 - Scale coupling disabled for specified window.

<num> Number of divisions is between 4 to 30.

Units / division value. The range of acceptable values is dependent on format and
domain.

Note: This command will accept MIN or MAX instead of a numeric parameter. See

SCPI Syntax for more information.
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Examples DISP:WIND:Y:DIV 12

Display:window2:y:scale:divisions 12

Query

Syntax
DISPlay:WINDow<wnum>:Y[:SCALe]:DIVisions?

Return

Type
Boolean

Default 10
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Format Commands

Specifies the way that data will be transferred when moving large amounts of data.

Click on a keyword to view the command details.

See Also

Example Programs

Synchronizing the Analyzer and Controller

SCPI Command Tree

FORMat:BORDer <char>

Applicable Models: All

(Read-Write) Set the byte order used for GPIB data transfer. Some computers read data from the

analyzer in the reverse order. This command is only implemented if FORMAT:DATA is set to

:REAL.

If FORMAT:DATA is set to :ASCII, the swapped command is ignored.

Parameters  

<char> Choose from:

NORMal - Use when your controller is anything other than an IBM compatible

computers.

SWAPped - for IBM compatible computers.

Note: Use NORMal if you are using VEE, LabView, or T&M Tool kit.

Examples FORM:BORD SWAP
format:border normal
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Query Syntax
FORMat:BORDer?

Return Type Character

Default Normal

FORMat[:DATA] <char>

Applicable Models: All

(Read-Write) Sets the data format for transferring measurement data and frequency data.

To transfer measurement data, use CALC:MEAS:DATA.

To transfer Cal Set data, use SENS:CORR:CSET:DATA

To transfer Source Power correction data, use:

SOURce:POWer:CORRection:COLLect:TABLe:DATA

SOURce:POWer:CORRection:COLLect:TABLe:FREQuency

SOURce:POWer:CORRection:DATA

To transfer FIFO buffer data, use SYST:FIFO:DATA?

The following commands transfer frequency data. Use <REAL, 64>

CALC:MEAS:DATA:SNP?

CALC:MEAS:X?

SENS:X?

Use FORMat:BORDer to change the byte order. Use “NORMal” when transferring a binary block from

LabView or Vee. For other programming languages, you may need to SWAP the byte order.

 

Parameters  

<char> In the VNA, measurement data is stored as 32 bit and frequencies stored as 64

bit. Therefore, use REAL,32 when getting data and REAL,64 when getting

frequencies. That way you are guaranteed to avoid losing any precision as well

as getting the maximum speed on the data transfer.

Choose from:

981



REAL,32 - (default value for REAL) Best for transferring large amounts of
measurement data.  Can cause rounding errors in frequency data.

REAL,64 - Slower but has more significant digits than REAL,32.  REQUIRED to
accurately represent frequency data. See above list for commands which transfer
frequency information.

ASCii,0 - The easiest to implement, but very slow. Use when you have small
amounts of data to transfer.

Note  The REAL,32 and REAL,64 arguments transfer data in block format as

explained in Transferring Measurement Data.

Examples FORM REAL,64
format:data ascii

Query Syntax FORMat:DATA?

Return Type Character,Character

Default ASCii,0

Syst:Preset does NOT reset this command.

However, *RST does reset this command to ASCii,0
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Hardcopy Command

Controls printing of the VNA screen and optional data to a printer or a file.

HCOPy:

DPRinter

FILE

[IMMediate]

ITEM

     | AWINdow

     | CTABle

     | GPFail

     | LOGO

     | MKRData

     | PNUMber

     | SEGData

     | SWINdow

     | TIME

     | TTABle

     | WFRaction

     | WINDows

PAGE

     | DIMension

           | LLEFt

           | URIGht

     | ORIentation

     | SIZE

SDUMP

     | DATA?

           | FORMat

PRINters?

Click on a keyword to view the command details.

Blue commands are superseded or obsolete.

See Also

Learn more about VNA Printing

Example Programs

983



Synchronizing the Analyzer and Controller

HCOPy:DPRinter <string>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the default printer and selects as the current printer. Use HCOPy:PRINters? to return

a list of locally installed printers.

This setting survives instrument preset and VNA application restart.

Parameters  

<string> Name of the printer to become the default.

Examples HCOP:DPR "MyPrinter"

hcopy:dprinter "YourPrinter"

Query Syntax HCOPy:DPRinter?

Return Type String

Default Not Applicable

HCOPy:FILE <filename>

Applicable Models: All

(Write-only) Saves the screen image to a file. The image does NOT include the optional print data

invoked by many HCOPy commands.

Parameters  

<filename> Name of the file to save the screen to.  The file is saved to the current working

directory unless a valid full path name is specified.

Use one of the following suffixes:

.bmp - not recommended due to large file size

.jpg - not recommended due to poor quality

.png - recommended

Examples HCOPY:FILE "myFile.png"

hcopy:file "c:/data/myfile.png"

Query Syntax Not Applicable
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Default Not Applicable

HCOPy[:IMMediate]

Applicable Models: All

(Write-only) Prints the screen to the default printer.

Examples HCOP
hcopy:immediate

Query Syntax Not applicable

Default Not Applicable

HCOPy:ITEM:AWINdow[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) When ON, prints only the Active window. When OFF, prints all windows.

This setting survives instrument preset and VNA application restart.

Parameters  

<bool> Active window state. Chose from:

OFF or (0) - Print ALL windows.

ON or (1) - Print Active window only.

Examples HCOP:ITEM:AWIN 1

hcopy:item:awindow:state off

Query Syntax HCOPy:ITEM:AWINdow[:STATe]?

Return Type Boolean

Default OFF (0)

HCOPy:ITEM:CTABle[:STATe] <bool>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) When ON, prints the channel settings table.

This setting survives instrument preset and VNA application restart.

Parameters  

<bool> Channel table print state. Chose from:

OFF or (0) - Does NOT print the channel settings table.

ON or (1) - Prints channel settings table.

Examples HCOP:ITEM:CTAB 1

hcopy:item:ctable:state off

Query Syntax HCOPy:ITEM:CTABle[:STATe]?

Return Type Boolean

Default OFF (0)

HCOPy:ITEM:GPFail[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) When ON, prints the Global Pass/Fail status in the page header.

This setting survives instrument preset and VNA application restart.

Parameters  

<bool> Pass / Fail print state. Chose from:

OFF or (0) - Does NOT print Pass / Fail status.

ON or (1) - Print Pass / Fail status

Examples HCOP:ITEM:GPF 1

hcopy:item:gpfail:state off

Query Syntax HCOPy:ITEM:GPFail[:STATe]?

Return Type Boolean

Default OFF (0)

HCOPy:ITEM:LOGO[:STATe] <bool>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) When ON, prints the Keysight Technologies logo in the page header.

This setting survives instrument preset and VNA application restart.

Parameters  

<bool> Keysight logo print state. Chose from:

OFF or (0) - Prints the Keysight logo.

ON or (1) - Does NOT print the Keysight logo.

Examples HCOP:ITEM:LOGO 1

hcopy:item:logo:state off

Query Syntax HCOPy:ITEM:LOGO[:STATe]?

Return Type Boolean

Default OFF (0)

HCOPy:ITEM:MKRData[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) When ON, includes marker data as part of the trace attributes table.

To print marker data, HCOP:ITEM:TTABle must also be set to ON.

This setting does not affect the limited marker readout data that can be displayed in the measurement

window.

This setting survives instrument preset and VNA application restart.

Parameters  

<bool> Marker data print state. Chose from:

OFF or (0) - Does NOT print Marker data.

ON or (1) - Print Marker data.

Examples HCOP:ITEM:MKRD 1

hcopy:item:mkrdata:state off

Query Syntax HCOPy:ITEM:MKRData[:STATe]?
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Return Type Boolean

Default OFF (0)

HCOPy:ITEM:PNUMber[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) When ON, prints page numbers (1 of n) in the header at the top of each page.

This setting survives instrument preset and VNA application restart.

Parameters  

<bool> Page number print state. Chose from:

OFF or (0) - Does NOT print page numbers.

ON or (1) - Print page numbers.

Examples HCOP:ITEM:PNUM 1

hcopy:item:pnumber:state off

Query Syntax HCOPy:ITEM:PNUMber[:STATe]?

Return Type Boolean

Default OFF (0)

HCOPy:ITEM:SEGData[:STATe] <bool> - Obsolete

Note: This command no longer works beginning with A.09.40

(Read-Write) When ON, includes ALL segment data as part of the channel settings table.

To print ALL segment data, HCOP:ITEM:CTAB must also be set to ON.

This setting survives instrument preset and VNA application restart.

Parameters  

<bool> Expanded segment data print state. Chose from:

OFF or (0) - Does NOT print expanded segment data, but summary data is

printed.

ON or (1) - Print expanded segment data.
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Examples HCOP:ITEM:SEGD 1

hcopy:item:segdata:state off

Query Syntax HCOPy:ITEM:SEGData[:STATe]?

Return Type Boolean

Default OFF (0)

HCOPy:ITEM:SWINdow[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) When ON, prints a single measurement window per page. When OFF, prints up to four

measurement windows per page.

This setting survives instrument preset and VNA application restart.

Parameters  

<bool> Single window print state. Chose from:

OFF or (0) - Print up to four windows per page.

ON or (1) - Print only one window per page.

Examples HCOP:ITEM:SWIN 1

hcopy:item:swindow:state off

Query Syntax HCOPy:ITEM:SWINdow[:STATe]?

Return Type Boolean

Default OFF (0)

HCOPy:ITEM:TIME[:STATe] <bool>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) When ON, prints the VNA computer date and time in the header.

This setting survives instrument preset and VNA application restart.

Parameters  

<bool> Time stamp print state. Chose from:

OFF or (0) - Does NOT print time stamp.

ON or (1) - Print time stamp.

Examples HCOP:ITEM:TIME 1

hcopy:item:time:state off

Query Syntax HCOPy:ITEM:TIME:[STATe]?

Return Type Boolean

Default OFF (0)

HCOPy:ITEM:TTABle[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) When ON, prints the trace attributes table.

This setting survives instrument preset and VNA application restart.

Parameters  

<bool> Trace attributes table print state. Chose from:

OFF or (0) - Does NOT print the trace attributes table.

ON or (1) - Print the trace attributes table.

Examples HCOP:ITEM:TTABle 1

hcopy:item:ttable:state off

Query Syntax HCOPy:ITEM:TTABle[:STATe]?

Return Type Boolean

Default OFF (0)

HCOPy:ITEM:WFRaction <value>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the vertical amount of a page that is filled by the measurement windows.

This setting survives instrument preset and VNA application restart.

Parameters  

<value> Window size as a fraction of the page. Chose a value from .4 (40%) to 1.0

(100%)

Examples HCOP:ITEM:WFR .8

hcopy:item:wfraction .5

Query Syntax HCOPy:ITEM:WFRaction?

Return Type Numeric

Default .4

HCOPy:ITEM:WINDows[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) When ON, prints measurement windows.

Use HCOPy:ITEM:AWINdow to specify all windows or only the active window.

This setting survives instrument preset and VNA application restart.

Parameters  

<bool> Windows print state. Chose from:

OFF or (0) - Does not print measurement windows.

ON or (1) - Print measurement windows.

Examples HCOP:ITEM:WIND 1

hcopy:item:windows:state off

Query Syntax HCOPy:ITEM:WINDows[:STATe]?

Return Type Boolean

Default OFF (0)

HCOPy:PAGE:DIMensions:LLEFt <left, lower>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the left and lower page margins.

This setting survives instrument preset and VNA application restart.

Parameters  

<left> Left page margin as a percentage of entire page width. Value must be between

0 and 1.

<lower> Lower page margin as a percentage of entire page length. Value must be

between 0 and 1.

Examples HCOP:PAGE:DIM:LLEF .10,.10

hcopy:page:dimensions:lleft .5,.7

Query Syntax HCOPy:PAGE:DIMensions:LLEFt?

Return Type Numeric, Numeric

Default Depends on selected page size

HCOPy:PAGE:DIMensions:URIGht <right, upper>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the right and upper page margins.

This setting survives instrument preset and VNA application restart.

Parameters  

<right> Right page margin as a percentage of entire page width. Value must be between

0 and 1.

<upper> Upper page margin as a percentage of entire page length. Value must be

between 0 and 1.

Examples HCOP:PAGE:DIM:URIG .10,.10

hcopy:page:dimensions:uright .5,.7

Query Syntax HCOPy:PAGE:DIMensions:URIGht?

Return Type Numeric, Numeric

Default Depends on selected page size

HCOPy:PAGE:ORIentation <char>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the page orientation.

This setting survives instrument preset and VNA application restart.

Parameters  

<char> Choose from:

PORTrait

LANDscape

Examples HCOP:PAGE:ORI PORT

hcopy:page:orientation landscape

Query Syntax HCOPy:PAGE:ORIentation?

Return Type Character

Default PORTrait

HCOPy:PAGE:SIZE <int>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the paper type, which implies the page size.

This setting survives instrument preset and VNA application restart.

Parameters  

<int> Choose from:I
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Integer Description

1 Letter 8 1/2 x 11 in

2 Letter Small 8 1/2 x 11 in

3 Tabloid 11 x 17 in

4 Ledger 17 x 11 in

5 Legal 8 1/2 x 14 in

6 Statement 5 1/2 x 8 1/2 in

7 Executive 7 1/4 x 10 1/2 in

8 A3 297 x 420 mm

9 A4 210 x 297 mm

10 A4 Small 210 x 297 mm

11 A5 148 x 210 mm

12 B4 (JIS) 250 x 354

13 B5 (JIS) 182 x 257 mm

For more paper type choices, see Microsoft's "wingdi.h" file, which can be

downloaded as part of the Platform SDK.

Examples HCOP:PAGE:SIZE 2

hcopy:page:size 5

Query Syntax HCOPy:PAGE:SIZE?

Return Type Integer

Default 1

HCOPy:SDUMp:DATA?

Applicable Models: All

(Read-only) Returns the display image in a definite-length arbitrary binary block. The format of the

data is PNG by default.  Use HCOP:SDUMp:DATA:FORMat to change the format.

This command is equivalent to saving an image to the VNA (HCOPy:FILE) and then using MMEM:TRAN
to transfer the file to the computer.

Examples HCOP:SDUM?

hcopy:sdump?

Return Type A definite-length arbitrary binary block

Default Not Applicable
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HCOPy:SDUMp:DATA:FORMat <char>

Applicable Models: All

(Read-Write) Sets the graphic format for HCOPy:SDUMp:DATA?

Parameters  

<char> Choose from: JPG | BMP | PNG

Examples HCOP:SDUMp:DATA:FORMat BMP

Query Syntax HCOPy:SDUMp:DATA:FORMat?

Return Type Character

Default PNG

HCOPy:PRINters?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns a comma-separated list of printers installed on the VNA. Select a printer using

HCOPy:DPRinter.

This setting survives instrument preset and VNA application restart.

Examples HCOP:PRIN?

hcopy:printers?

Query Syntax HCOPy:PRINters?

Return Type String

Default Not Applicable
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Initiate Commands

Controls triggering signals

Click on a red keyword to view the command details.

See Also

Example  Triggering the VNA

Learn about Triggering

Synchronizing the Analyzer and Controller

SCPI Command Tree

INITiate:CONTinuous <boolean>

Applicable Models: All

(Read-Write) Specifies whether the VNA trigger source is set to Internal (continuous) or Manual.

For SIMPLE, single-triggering of a single channel, use Sens:Sweep:Mode SINGle which sets the number of
trigger signals each channel will ACCEPT (Continuous, Groups, Single, or HOLD - none.)

This command is a subset of TRIG:SEQ:SOURce, which can also set the trigger source to External.

See a map of user interface to SCPI triggering commands.

For more information on triggering, see the VNA Trigger Model.

See the Example program:  Triggering the VNA using SCPI.

Parameters  

<boolean> ON (or 1) - Internal (continuous) trigger.

OFF (or 0) - Manual sweep. Use INIT:IMMediate to send a trigger signal

Examples INIT:CONT ON
initiate:continuous off

Query Syntax INITiate:CONTinuous?

Return Type Boolean (1 = ON, 0 = OFF)

996



Default ON

INITiate<cnum>[:IMMediate]

Applicable Models: All

(Write-only) Stops the current sweeps and immediately sends a trigger. (Same as Trigger! on the VNA

front panel).

This command requires Trigger:Source to be set to Manual. This causes ONE trigger signal to be SENT
each time INIT:IMM is issued.

For SIMPLE, single-triggering of a single channel, use Sens:Sweep:Mode SINGle which sets the number of
trigger signals each channel will ACCEPT (Continuous, Groups, Single, or HOLD - none.)

See the Example program:  Triggering the VNA using SCPI

Note: An SMC Fixed Output measurement cannot be triggered using this command. For more

information, see the example program.

To trigger ALL channels in turn:

Set ALL channels to Sens<ch>:Sweep:Mode Continuous.  The <ch> argument in INIT<ch>:IMM is

ignored.

Then…

TRIG:SCOP ALL triggers ALL channels (in sequence) each time Init:Imm is sent.

TRIG:SCOP CURRent triggers ONLY the NEXT channel each time Init:Imm is sent.

To trigger ONLY a specified channel:

Set ALL channels to Sens<ch>:Sweep:Mode HOLD1.

Send TRIG:SCOP CURRent2.

Send Init<ch>:Imm where <ch> is the channel to be triggered.3.

Advanced   Situations that require some channels to be in CONT and others in HOLD are rare. The

following describes the behavior of the Init:Imm command in these situations:

When Trigger:Scope = Global:

If the SPECIFIED <cnum> channel is in hold mode, it is put in single trigger (accepts 1 trigger signal) and
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goes to the end of the queue of channels to be triggered. The other 'non-hold' channels are triggered. The
next Init:Imm triggers the specified channel first.

For example: ch1 is in Hold, ch2 and ch3 are in CONT and we send INIT1:IMM

On the first INIT:IMM, ch2 and ch3 is triggered.

next INIT:IMM, ch1, ch2, ch3 is triggered.

next INIT:IMM, ch2 and ch3 is triggered.

next INIT:IMM, ch1, ch2, ch3 is triggered, and so forth.

When Trigger:Scope = Channel

Only ONE channel is triggered for each issued INIT<ch>:IMM command.

If the specified channel is in hold, it is put in single trigger (accepts 1 trigger signal) and goes the end of the
queue of channels to be triggered as in the 'Global' example.

This is one of the VNA overlapped commands. Learn more.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

Examples INIT
initiate2:immediate

Query Syntax Not applicable

Default Not applicable
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Memory Commands

The memory commands control saving and loading instrument states and measurement trace data to the

hard drive. To read and write trace data in GPIB format, see CALC:MEAS:DATA.

MMEMory:

CATalog?

CDIRectory

COPY

DATE?

DELete

LOAD

     | ASCFactor

     | BSCFactor

     | CORRection

     | CSARchive

     | ENR

     | [:FILE]

     | LIMit

     | PLOSs

     | RLIMit

     | SEGMent

     | STATe

MDIRectory

MOVE

RDIRectory

STORe

     | ASCFactor

     | BSCFactor

     | CORRection

     | CSARchive

     | CSTate

     | CITI

            | DATA

            | FORMat

     | CSV:FORMat

       | DATA

       | ENR

     | [:FILE]

     | LIMit
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     | PLOSs

     | RLIMit

     | SEGMent

     | SSCReen

     | STATe

            | TRACe

       | TRACe

            | CONTents

                 | CITIfile

            | FORMat

                 | CITIfile

                 | SNP

TIME?

TRANsfer

Click on a keyword to view the command details.

Blue commands are superseded.

See Also

Example Programs

Learn about Save / Recall and File Types

Synchronizing the Analyzer and Controller

SCPI Command Tree

Specifying Path Names

The MMEM commands use the following rules to specify path names:

The default folder is "D:\". Learn more.

You can change the active directory using MMEMory:CDIRectory.

Specify only the file name if using the active directory.

You can also use an absolute path name to specify the folder and file.

MMEMory:CATalog[:<char>]? [<folder>]
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Applicable Models: All

(Read-only) Returns a comma-separated string of file names that are in the specified folder. If there

are no files of the specified type, "NO CATALOG" is returned.  Learn about File Types

Parameters  

<char> The type of files to list. Choose from:

STATe - Instrument states (.sta)

CORRection - Calibration Data (.cal)

CSARchive - Instrument state and calibration data (.csa)

CSTate - Instrument state and link to Calibration data (.cst)

[:File]

If unspecified then ALL file types (even unknown types) are listed.

<folder> String - Any existing folder name. See Specifying Path Names

Examples MMEM:CAT? 'lists all files from the current folder
mmemory:catalog:correction? 'D:\' 'lists .cal files from the
specified folder

Default Not applicable

MMEMory:CDIRectory <folder>

Applicable Models: All

(Read-Write) Changes the folder name.

Parameters  

<folder> Any drive and folder name that already exists.

If the same level as the default path, then no punctuation is required.

MMEM:CDIR Service

If the new folder is at a different level than the default, use a slash (/) before the

folder name and enclose in quotes.

mmemory:cdirectory '/automation' 'changes default directory up
one level.

You can use an absolute path to specify the new folder.
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mmemory:cdirectory 'C:/automation/service'

Query Syntax MMEMory:CDIRectory? 'Returns the current folder name

Return Type String

Default See Specifying Path Names

MMEMory:COPY <file1>,<file2>

Applicable Models: All

(Write-only) Copies file1 to file2. Extensions must be specified.

Parameters  

<file1> String - Name of the file to be copied. See Specifying Path Names

<file2> String - Name of the file to be created from file1.

Examples MMEM:COPY 'MyFile.cst','YourFile.cst'

Query Syntax Not applicable

Default Not applicable

MMEMory:DATE? <fileName>

Applicable Models: All

(Read-only) Returns the (year, month, day) that the specified file was last saved.

To query the last date and time a cal set was modified, use CSET DATE? and CSET:TIME?

See Also

MMEM:TIME?

Parameters  

<fileName> String - File name. See Specifying Path Names

Example MMEM:DATE? "myFile.txt"

'Returns

+2013,+4,+12

mmemory:date? "D:\Calset_18.pcs"

'Returns
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+2013,+4,+12

Return Type Comma-separated integers

Default Not applicable

MMEMory:DELete <file>

Applicable Models: All

(Write-only) Deletes file. Extensions must be specified.

Parameters  

<file> String - Name of the file to be deleted. See Specifying Path Names

Examples MMEM:DEL 'MyFile.cst'

Query Syntax Not applicable

Default Not applicable

MMEMory:LOAD[:<char>] <file>

Applicable Models: All

(Write-only) Loads the specified file. Learn about File Types

Parameters  

<char> The type of file to load. Choose from:

ASCFactor

BSCFactor

STATe - Instrument states (.sta)

CORRection - Calibration Data (.cal)

CSARchive - Instrument state and calibration data (.csa)

CSTate - Instrument state and link to Calibration data (.cst)

ENR - Excess Noise Source data (Noise Figure App only)\

SEGMent

[:File]

When <char> is ENR, then include CAL, -  See example below.
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*.sNp files CAN be recalled to the VNA although no <char> is used. See example
below.

If <char> is unspecified, the extension must be included in the filename.

If an extension is specified in <file> that does not agree with <char> then no

action is taken.

<file> String - Name of the file to be loaded. See Specifying Path Names

Examples MMEM:LOAD 'MyFile.cst'
mmemory:load:state 'MyInstState'

MMEM:LOAD:ENR CAL, "D:/data/calset/346C_16500.enr"

MMEM:LOAD "MyFile.s2p"

Query Syntax Not applicable

Default Not applicable

MMEMory:LOAD:LIMit <file>

Applicable Models: All

(Write-only) Load limit test data from a CSV file.

Parameters  

<file> A file path by string format.

The CSV file shall have header lines and a title row as follows.

  "# E5080 Limit Test"

  "# Revision: 1.00"

  TYPE,BEGIN STIMULUS,END STIMULUS,BEGIN RESPONSE,END

RESPONSE

Examples MMEM:LOAD:LIM 'MyFile.csv'

Query

Syntax

Not Applicable

Default Not Applicable

MMEMory:LOAD:RLIMit <file>
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Applicable Models: All

(Write-only) Load ripple limit test data from a CSV file.

Parameters  

<file> A file path by string format.

The CSV file shall have header lines and a title row as follows.

  "# E5080 Ripple Limit Test"

  "# Revision: 1.00"

  TYPE,BEGIN STIMULUS,END STIMULUS,MAX RIPPLE

Examples MMEM:LOAD:RLIM 'MyFile.csv'

Query Syntax Not Applicable

Default Not Applicable

MMEMory:MDIRectory <folder>

Applicable Models: All

(Write-only) Makes a folder.

Parameters  

<folder> String - Name of the folder to make. See Specifying Path Names

Examples MMEM:MDIR 'MyFolder'

mmemory:mdirectory 'D:/NewFolder'

Query Syntax Not applicable

Default Not applicable

MMEMory:MOVE <file1>,<file2>
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Applicable Models: All

(Write-only) Renames <file1> to <file2>. File extensions must be specified.

Parameters  

<file1> String - Name of the file to be renamed. See Specifying Path Names

<file2> String - Name of the new file.

Examples MMEM:MOVE 'MyFile.cst','YourFile.cst'

Query Syntax Not applicable

Default Not applicable

MMEMory:RDIRectory <folder>

Applicable Models: All

(Write-only) Removes the specified folder.

Parameters  

<folder> String - Name of the folder to remove. See Specifying Path Names

Examples MMEM:RDIR 'MyFolder'

Query Syntax Not applicable

Default Not applicable

MMEMory:STORe[:<char>] <file>

Applicable Models: All

(Write-only) Stores the specified file (.sta, .cal, .cst, .csa, .snp, s2px).

Learn about saving SNP files on the VNA.

Learn about saving S2Px files on the VNA.

To save other data files, use MMEM:STOR:DATA.

To save ENR files, use MMEMory:STORe:ENR

Parameters  

<char> Optional argument. The type of file to store. Choose from:
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ASCFactor

BSCFactor

CORRection - Calibration Data (.cal)

CSARchive - Instrument state and calibration data (.csa)

CSTate - Instrument state and link to Calibration data (.cst)

CSV:FORMat

ENR

[:File]

PLOSs

SEGMent

SSCReen

STATe - Instrument states (.sta)

STATe:TRACe

TRACe

No <char> is specified for s1p, s2p, s2px and so forth.

Include either <char> or the file extension. If both <char> and the extension are

specified, they must agree or an error is returned and no action is taken. See

examples below.

Learn about File Types

<file> String - Name of any valid file that does not already exist. See Specifying Path
Names

Examples MMEM:STOR:STAT 'myState'

mmemory:store 'c:/bin/myState.sta'

MMEM:STOR 'MyData.S2P'

Query Syntax Not applicable

Default Not applicable

MMEMory:STORe:CITifile:DATA <filename> - Superseded
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Applicable Models: N522xB, N523xB, N524xB, M937xA

This command is replaced with MMEMory:STORe:DATA.

(Write only)  Saves UNFORMATTED trace data to .cti file. Learn more.

Parameters  

<filename> Any path that already exists with filename.

If the same level as the default, then no path is required.

MMEM:STOR:CIT:DATA 'MYFile.cti'

Of you can specify an absolute path and filename:

mmemory:store:citifile:data "D:\myFile.cti'

Query Syntax Not Applicable

Default See Specifying Path Names

MMEMory:STORe:CITifile:FORMat <filename> - Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

This command is replaced with MMEMory:STORe:DATA.

(Write only)  Saves FORMATTED trace data to .cti file. Learn more.

Parameters  

<filename> Any path that already exists with filename.

If the same level, then no path is required

MMEM:STOR:CIT:FORM 'MYFile.cti'

Of you can specify an absolute path and filename:

mmemory:store:citifile:format "D:\myFile.cti'

Query Syntax Not Applicable

Default See Specifying Path Names

MMEMory:STORe:DATA <filename>,<type>,<scope>,<format>,<selector>

Applicable Models: All
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(Write-only) Stores trace data to the following file types: *.prn, *.cti, *.csv, *.mdf   

To save snp files, use CALC:MEAS:Data:SNP:PORTs:SAVE

To save state and calibration files, use MMEM:STORe

This command replaces the following:

MMEMory:STORe:CITifile:DATA

MMEMory:STORe:CITifile:FORMat

MMEMory:STORe:TRACe:FORMat:CITifile

MMEMory:STORe:TRACe:CONTent:CITifile

NOTE: Not all choices are valid with other arguments. See Valid parameter combinations below.

Parameters  

<filename> (String) Name and extension of the file to which data will be saved. If the

extension does not agree with the file type, an error is NOT returned but the

data may NOT be what you expect.

See rules for specifying a filename.

<type> (String) File type to save. Choose from:

"PRN Trace Data" - *.prn data. Learn more.

"Citifile Data Data" - unformatted *.cti data. Learn more.

"Citifile Formatted Data" - formatted *.cti data.

"CSV Formatted Data" - formatted *.csv data. Learn more.

"MDIF Data" - *.mdf data. Learn more.

"GCA Sweep Data" - Gain compression data. Learn more.

"IMD Sweep Data" - Swept IMD data. Learn more.

<scope> (String) How much data to save. Choose from:

"Trace" - only the specified measurement number is saved.

"Displayed" - all displayed measurements are saved.

"Channel" - all measurements that are in the channel in which the selected
measurement reside are saved.
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"Auto"

For all Standard Meas Class (S-parameter) channels:

When correction is OFF, the specified trace is saved.

When correction is ON, all corrected parameters associated with the calibrated
ports in the Cal Set are saved.

For all other channels:

When correction is OFF or ON, the specified trace is saved.

<format> The format in which data is saved. Choose from:

"Displayed" - the format is the same as that in which it is displayed on the

VNA screen.

"RI" - Real / Imaginary

"MA" - Magnitude / Angle

"DB" - LogMag / Degrees

<selector> (Integer) Choose from:

-1  Use when <scope> = "Displayed" (does NOT require a selected trace).

<measurement number>  Use for all other <scope> selections.  Use

Calc:Par:MNUM? to read the measurement number of the selected trace.

The following are valid parameter combinations for ALL measurement classes:

Parameters

<type>

(String)

<scope>

(String)

<format>

(String)

<selector>

(Numeric)

"PRN Trace Data" "Trace" "Displayed" Measurement number

 Example: MMEMory:STORe:DATA "myData.prn","PRN Trace Data","Trace","Displayed",2

"Citifile Data Data"

"Trace" or "Auto" or

"Channel"

"RI" Measurement number

"Displayed" "RI" -1

Example: MMEMory:STORe:DATA "myData.cti","Citifile Data Data","AUTO","RI",3
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"Citifile Formatted

Data"

"Trace" or "Auto" "RI" or "MA" or "DB" Measurement number

"Channel" "RI" or "MA" or "DB"

or "Displayed"

Measurement number

"Displayed" "RI" or "MA" or "DB"

or "Displayed"

-1

Example: MMEMory:STORe:DATA "myData.cti","Citifile Formatted Data","AUTO","MA",3

"CSV Formatted Data"

"Trace" or "Auto" or

"Channel"

"RI" or "MA" or "DB"

or "Displayed"

Measurement number

"Displayed" "RI" or "MA" or "DB" -1

Example: MMEMory:STORe:DATA "myData.csv","CSV Formatted Data","displayed","RI",-1

"MDIF Data"

"Trace" or "Auto" "RI" or "Displayed"  or

"Channel"

Measurement number

"Displayed" "RI" or "Displayed" -1

Example: MMEMory:STORe:DATA "myData.mdf","MDIF Data","displayed","displayed",-1

 

The following parameter combinations save *.csv files in specific formats for GCA and Swept

IMD classes:

Parameters

<type>

(String)

<scope>

(String)

<format>

(String)

<selector>

(Numeric)

"GCA Sweep Data" "Auto" "DB" GCA channel number

Example: MMEMory:STORe:DATA "myData","gca sweep
data","displayed","displayed",-1

"IMD Sweep Data" "Auto" "DB" Swept IMD channel

number

Example: MMEMory:STORe:DATA "myData.mdf","MDIF
Data","displayed","displayed",-1

Query Syntax Not applicable

Default Not applicable

MMEMory:STORe:ENR CAL, <file>
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Applicable Models: All

(Write-only) Stores an ENR (Excess Noise Source) data. (Noise Figure App only)

To set and read ENR data, use SENS:CORR:ENR:CAL:TABLE:DATA.

Parameters  

<file> String - Name of any valid file that is not already in existence. See Specifying
Path Names

Examples MMEM:STOR:ENR CAL, "C:/data/calset/346C_16500.enr"

Query Syntax Not applicable

Default Not applicable

MMEMory:STORe:LIMit <file>

Applicable Models: All

(Write-only) Saves limit test data into a CSV file.

Parameters  

<file> A file path by string format.

The CSV file shall have header lines and a title row as follows.

  "# VNA Limit Test"

  "# Revision: 1.00"

  TYPE,BEGIN STIMULUS,END STIMULUS,BEGIN RESPONSE,END

RESPONSE

Examples MMEM:STOR:LIM 'MyFile.csv'

Query

Syntax

Not Applicable

Default Not Applicable

MMEMory:STORe:RLIMit <file>
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Applicable Models: All

(Write-only) Saves ripple limit test data into a CSV file.

Parameters  

<file> A file path by string format.

The CSV file shall have header lines and a title row as follows.

  "# VNA Ripple Limit Test"

  "# Revision: 1.00"
  TYPE,BEGIN STIMULUS,END STIMULUS,MAX RIPPLE

Examples MMEM:STOR:RLIM 'MyFile.csv'

Query Syntax Not Applicable

Default Not Applicable

MMEMory:STORe:TRACe:FORMat:CITifile <char> - Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

This command is replaced with MMEMory:STORe:DATA.

(Read-Write)  Specifies the format of subsequent citifile save statements.

Parameters  

<char> Format in which the citifile will be saved with subsequent

MMEMory:STORe:CIT:FORMat statements. Choose from:

MA - Linear Magnitude / degrees

DB - Log Magnitude / degrees

RI - Real / Imaginary

AUTO - Format in which the trace is already displayed.  If other than Log
Mag, Linear Magnitude, or Real/Imag, then the format will be in Real/Imag.

DISP - Displayed format.

Examples MMEM:STOR:TRAC:FORM:CIT MA

Query Syntax MMEMory:STORe:TRACe:FORMat:CITifile?

Return Type Character
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Default Auto

MMEMory:STORe:TRACe:CONTents:CITifile <char> - Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

This command is replaced with MMEMory:STORe:DATA.

(Read-Write)  Specifies the contents of subsequent citifile save statements. (See Data Define Saves)

Parameters  

<char> Choose from:

SING - Single trace

DISP - All displayed traces

AUTO - All displayed traces

Examples MMEM:STOR:TRAC:CONT:CIT SING

Query Syntax MMEMory:STORe:TRACe:CONTents?

Return Type Character

Default Auto

MMEMory:STORe:TRACe:FORMat:SNP <char>

Applicable Models: All

(Read-Write)  Specifies the format of subsequent .s1p, .s2p, .s3p; s4p save statements. Learn more.

To save SNP data, use CALC:MEAS:DATA:SNP:PORTs:SAVE

Parameters  

<char> Choose from:

MA - Linear Magnitude / degrees

DB - Log Magnitude / degrees

RI - Real / Imaginary

AUTO - data is output in currently selected trace format. If other than LogMag,
LinMag, or Real/Imag, then output is in Real/Imag.
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Examples MMEM:STOR:TRAC:FORM:SNP MA

Query Syntax MMEMory:STORe:TRACe:FORMat:SNP?

Return Type Character

Default Auto'

MMEMory:TIME? <fileName>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the (hour, minute, second) that the specified file was last saved.  The time is

returned in local time as setup in the VNA operating system.  

To query the last date and time a cal set was modified, use CSET DATE? and CSET:TIME?

See Also

MMEM:DATE?

Parameters  

<fileName> String - File name. See Specifying Path Names

Example MMEM:TIME? "myFile.txt"

'returns

+12,+34,+12

mmemory:time? "D:\Calset_18.pcs"

'returns

+12,+34,+12

Return Type Comma-separated integers

Default Not applicable

MMEMory:TRANsfer <fileName>,<dataBlock>

Applicable Models: All

(Read-Write) Transfers data between the VNA and an external controller. Other MMEM commands

transfer data between the VNA application and the VNA hard drive.  If <fileName> already exists, it

will be overwritten. The file must be no larger than 20MB.

To read trace data from the VNA in block format, use CALC:MEAS:DATA.

1015



Parameters  

<fileName> String - File name. See Specifying Path Names

<dataBlock> Block Data - The contents of the file.

The data block is a block of binary data. Use the following syntax:

#<num digits><byte count><data bytes><NL><END>

where:

<num_digits> specifies how many digits are contained in <byte_count>

<byte_count> specifies how many data bytes will follow in <data bytes>

 

Example:

#210ABCDE+WXYZ<nl><end>

Where:

# - always sent before definite block data

2 - specifies that the byte count is two digits (2)

10 - specifies the number of data bytes that will follow, not counting

<NL><END>

ABCDE+WXYZ - 10 digits of data

<NL><END> - always sent at the end of block data

Example See example program

Query Syntax MMEMory:TRANsfer? <fileName>

Reads block data from the specified file location.

Default Not applicable
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Output Commands

Controls two output functions: RF power and Noise Source.

OUTPut:

     |
MANual:NOISe[:STATe]

     | [:STATe]

Click on a red keyword to view the command details.

See Also

Example Programs

Synchronizing the Analyzer and Controller

SCPI Command Tree

OUTPut:MANual:NOISe[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and reads the noise source (28V) ON or OFF.

Parameters  

<bool> ON (1) - Noise source ON

OFF (0) - Noise source OFF

Examples OUTP:MAN:NOIS 0
output:manual:noise:state 1

Query Syntax OUTPut:MANual:NOISe[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default For VNA models with a Noise Figure option (028/029/H29), the 28V line is

always ON. The ON/OFF state is also available from a VNA softkey menu.

For VNA models WITHOUT a Noise Figure option (028/029/H29), the 28V

line is OFF by default and survives a preset. The ON/OFF state is NOT

available from a VNA softkey menu.

OUTPut[:STATe] <ON | OFF>
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Applicable Models: All

(Read-Write) Turns RF power from the source ON or OFF.

See note about source power state with instrument state save and recall.

Parameters  

<ON | OFF> ON (or 1) - turns RF power ON

OFF (or 0) - turns RF power OFF

Examples OUTP ON
output:state off

Query Syntax OUTPut[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON
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Sense Amplifier

When you use the M9485A, you can control the M9379A amplifier through the VNA firmware. The

following commands are available when the launcher  includes the M9379A.

SENSe:AMPLifier:M9379

       | COUNt?

       | MODule

           | :ATTenuation

           | :CHASsis

           | :CONTrol[:STATe]

           | :PATH

           | :POWer[:STATe]

           | :SLOT

           | :SWITch:PATH

     

Click on a keyword to view the command details.

 

SENSe<cnum>:AMPLifier:M9379:COUNt?

Applicable Models: M9485A

(Read-only) Returns the total number of M9379A amplifier modules that are connected to the VNA

firmware.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command

is common for all channels and the setting is ignored.

Examples SENS:AMPL:M9379:COUN?
sense2:amplifier:m9379:count

Return Type Numeric

Default Not applicable
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SENSe<cnum>:AMPLifier:M9379:MODule<mod>:ATTenuation <att>

Applicable Models: M9485A

(Read-Write) Sets and reads the attenuation of the M9379A amplifier 1.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<mod> Module number of M9379A. The number starts from 1 for the leftmost module

of M9379A.

<att> Attenuation in dB  from 0 to 28 with 2 step

Examples SENS:AMPL:M9379:MOD1:ATT 10
sense2:amplifier:m9379:module2:attenuation 5

Query Syntax SENSe<cnum>:AMPLifier:M9379:MODule<mod>:ATTenuation?

Return Type Numeric

Default 28

SENSe<cnum>:AMPLifier:M9379:MODule<mod>:CHASsis?

Applicable Models: M9485A

(Read Only) Returns the chassis number where the specified M9379A module is located.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command

is common for all channels and the setting is ignored.

<mod> Module number of M9379A. The number starts from 1 for the leftmost module

of M9379A.

Examples SENS:AMPL:M9379:MOD1:CHAS?

sense2:amplifier:m9379:module2:chassis?

Return Type Numeric

Default Not applicable

SENSe<cnum>:AMPLifier:M9379:MODule<mod>:CONTrol[:STATe] <bool>
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Applicable Models: M9485A

(Read-Write) Sets and reads the status of M9379A control.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<mod> Module number of M9379A. The number starts from 1 for the leftmost module

of M9379A.

<bool> Module control state. Choose from:

O or OFF - Skips to control the M9379A at the specified channel.

1 or ON - Enables to control the M9379A at the specified channel.

Examples SENS:AMPL:M9379:MOD1:CONT ON

sense2:amplifier:m9379:module2:control 0

Query Syntax SENSe<cnum>:AMPLifier:M9379:MODule<mod>:CONTrol[:STATe]?

Return Type Boolean

Default 1 or ON

SENSe<cnum>:AMPLifier:M9379:MODule<mod>:PATH <char>

Applicable Models: M9485A

(Read-Write) Sets and reads the path for the M9379A amplifier 1.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<mod> Module number of M9379A. The number starts from 1 for the leftmost module

of M9379A.

<char> Path. Choose from:

THRU - Through.

AMPLifier - amplifier 1.

NFPort1 to NFPort24 - NF port 1 to 24 (NF measurement only)

Examples SENS:AMPL:M9379:MOD1:PATH THRU

sense2:amplifier:m9379:module2:path amplifier
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Query Syntax SENSe<cnum>:AMPLifier:M9379:MODule<mod>:PATH?

Return Type Char

Default THRU

SENSe<cnum>:AMPLifier:M9379:MODule<mod>:POWer[:STATe] <bool>

Applicable Models: M9485A

(Read-Write) Sets and reads the status of M9379A power.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command

is common for all channels and the setting is ignored.

<mod> Module number of M9379A. The number starts from 1 for the leftmost module

of M9379A.

<bool> power control state. Choose from:

0 or OFF - Power off

1 or ON - Power on

Examples SENS:AMPL:M9379:MOD1:POW ON

sense2:amplifier:m9379:module2:power 0

Query Syntax SENSe<cnum>:AMPLifier:M9379:MODule<mod>:POWer[:STATe]?

Return Type Boolean

Default 0 or OFF

SENSe<cnum>:AMPLifier:M9379:MODule<mod>:SLOT?
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Applicable Models: M9485A

(Read Only) Reads the slot number where the M9379A is located.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command

is common for all channels and the setting is ignored.

<mod> Module number of M9379A. The number starts from 1 for the leftmost module

of M9379A.

Examples SENS:AMPL:M9379:MOD1:SLOT?

sense2:amplifier:m9379:module2:slot?

Return Type Numeric

Default Not applicable

SENSe<cnum>:AMPLifier:M9379:MODule<mod>:SWITch:PATH <char>

Applicable Models: M9485A

(Read-Write) Sets and reads the path for the M9379A switch

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<mod> Module number of M9379A. The number starts from 1 for the leftmost module

of M9379A.

<char> Path. Choose from:

A - Path A

B - Path B

NFRFout - NF RF Out port (NF measurement only)

NFLO2 - NF LO 2 (Option 720 only)

NFPort1 to NFPort24 - NF port 1 to 24 (NF measurement only)

Examples SENS:AMPL:M9379:MOD1:SWIT:PATH A

sense2:amplifier:m9379:module2:switch:path b

Query Syntax SENSe<cnum>:AMPLifier:M9379:MODule<mod>:SWITch:PATH?
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Return Type <char>

Default A
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Sense:Average Commands

Sets sweep-to-sweep averaging parameters. Averaging is a noise reduction technique that averages

each data point over a user-specified number of sweeps. Averaging affects all of the measurements in

the channel.

SENSe:AVERage

       | CLEar

       | COUNt

       | MODE

       | [STATe]

Click on a keyword to view the command details.

See Also

Example using some of these commands.

Learn about Averaging

Synchronizing the Analyzer and Controller

SCPI Command Tree

SENSe<cnum>:AVERage:CLEar

Applicable Models: All

(Write-only) Clears and restarts averaging of the measurement data. Does NOT apply to point

averaging.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

Examples SENS:AVER:CLE
sense2:average:clear

Query Syntax Not applicable

Default Not applicable

SENSe<cnum>:AVERage:COUNt <num>
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Applicable Models: All

(Read-Write) Sets the number of measurements to combine for an average. Must also set
SENS:AVER[:STATe] ON

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<num> Number of measurements to average. Choose any number between 1 and

65536 (2^16).

Examples SENS:AVER:COUN 999
sense2:average:count 73

Query Syntax SENSe<cnum>:AVERage:COUNt?

Return Type Numeric

Default 1

SENSe<cnum>:AVERage:MODE <char>

Applicable Models: All

(Read-Write) Sets the type of averaging to perform: Point or Sweep.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<num> Averaging Type. Choose from:

POINt - Averaging measurements are made on each data point before stepping

to the next data point.

SWEEP - Averaging measurements are made on subsequent sweeps until the
required number of averaging sweeps are performed.

Examples SENS:AVER:MODE POIN
sense2:average:mode sweep

Query Syntax SENSe<cnum>:AVERage:MODE?

Return Type Character

Default Sweep

SENSe<cnum>:AVERage[:STATe] <ON | OFF>
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Applicable Models: All

(Read-Write) Turns trace averaging ON or OFF.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<ON | OFF> ON (or 1) - turns averaging ON.

OFF (or 0) - turns averaging OFF.

Examples SENS:AVER ON
sense2:average:state off

Query Syntax SENSe<cnum>:AVERage[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default Off

1027



Sense:Bandwidth Commands

SENSe:BANDwidth:

RESolution <num>

TRACk <bool>

See Also

Example Programs

Learn about IF Bandwidth

Synchronizing the Analyzer and Controller

SCPI Command Tree

SENSe<cnum>:BANDwidth | BWIDth[:RESolution] <num>

Applicable Models: All

(Read-Write) Sets the bandwidth of the digital IF filter to be used in the measurement. (Use either

Sense:Bandwidth or Sense:Bwidth)

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> IF Bandwidth in Hz. The list of valid IF Bandwidths is different depending on

the VNA model. (Click to see the lists.) If an invalid number is specified, the

analyzer will round up to the closest valid number.

This parameter supports MIN and MAX as arguments. Learn more.

Examples SENS:BWID 1KHZ
sense2:bandwidth:resolution 1000

Query Syntax SENSe<cnum>:BANDwidth | BWIDth[:RESolution]?

Return Type Numeric

Default Varies with VNA model.

SENSe<cnum>:BANDwidth | BWIDth:TRACk <bool>
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Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Write) Sets and returns the state of the Reduce IF BW at Low Frequencies feature.

(Use either Sense:Bandwidth:Track or Sense:Bwidth:Track).

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<bool> Choose from:

ON or 1 -  Reduce IF BW at Low Frequencies is set ON

OFF or 0 - Reduce IF BW at Low Frequencies is set OFF

Examples SENS:BWID:TRAC OFF
sense2:bandwidth:track 1

Query Syntax SENSe<cnum>:BANDwidth | BWIDth:TRACk?

Return Type Boolean

Default ON
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Sense:Class Command

SENSe:CLASs:

NAME?

Click on a keyword to view the command details.

See Also

Learn about Measurement Class

Synchronizing the Analyzer and Controller

SCPI Command Tree

SENSe<cnum>:CLASs:NAME?

Applicable Models: All

(Read-only) Returns the measurement class name of the specified channel. Use

CALCulate:MEASure:DEFine and CALCulate:MEASure:PARameter commands to create measurements.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

Examples SENS:CLAS:NAME?
sense2:class:name?

For a standard S-Parameter channel, returns...
"Standard"

Default Not applicable
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Sense:Correction Commands

Performs and applies calibration and other error correction features.

To perform a Guided Calibration, use ONLY the Sens:Corr Coll:GUIDed commands.

To perform an Unguided Calibration, do NOT use the Sens:Corr:Coll:Guided commands.

See the "Unguided" example programs for clarification.

SENSe:CORRection

CCHeck

     | [ACQuire]

     | DONE

     | PARameter

CKIT - More Commands

COLLect

     | [ACQuire]

     | APPLy

     | CKIT - More Commands

     | DISPlay:WINDow

          | AOFF

          | [STATe]

     | GUIDed - More Commands

     | ISOLation:

| AVER:INCRement

          | ECAL:[:STATe]

     | METHod

          | PORT:SUBS:

               | FULL:VAL

               | RESet

               | RESPonse:VAL

               | STAT

     | NOISe

| ENR:ADAP:DEEMbed[:STATe]

| LO:PCAL[:STATe]

| PSEN:ADAP:DEEMbed[:STATe]

     | SAVE

     | SWEep:CHANnel

          | AOFF

          | [STATe]

CSET - More Commands
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ENR:CALibration:TABLe

     | DATA

     | ID:DATA

     | SERial:DATA

EXTension - More Commands

GCSetup

     | POWer

     | SENSor:

          | CKIT

          | CONNector

IMPedance:INPut

     | MAGNitude

INTerpolate[:STATe]

ISOLation[:STATe]

METHods

      | MATCh

      | PORT

          | SUBSet

               | FULL[:VALue]

               | RESet

               | RESPonse[:VALue]

               | [:STATe]

PREFerence

     | CALibration

          | [FOM:]RANGe

     | CSET

          | SAVE

          | SAVUser

     | ECAL

          | ORIentation

          | OVERrange[:STATe]

          | PMAP

     | SIMCal

     | TRIG:FREE

RPOWer:OFFSet

     | [AMPLitude]

RVELocity

     | COAX

SFOWard

     | [STATe]
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[STATe]

TCOLd:USER:VALue

TSTandards

     | [STATe]

TYPE

     | CATalog?

Click on a keyword to view the command details.

Blue commands are superseded.

See Also

Example Programs

New See Calibrating the VNA Using SCPI
 Learn about Measurement Calibration

Synchronizing the Analyzer and Controller

SCPI Command Tree

SENSe<cnum>:CORRection:CCHeck[:ACQuire] <mod>[,char]

Applicable Models: All

(Write-only) Reads the 'confidence data' associated with the specified ECal module and puts it into

memory. The measurement is selected using SENS:CORR:CCH:PAR.  This command is compatible

with *OPC.

Note: A confidence check can NOT be performed remotely from User Characterizations that are

stored on the VNA disk.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<mod> ECAL Module that contains the confidence data. Choose from:

ECAL1

..through..

ECAL50

[char] Optional argument.  Specifies which characterization within the ECal module

that the confidence data will be read from.

CHAR0   Factory characterization (data that was stored in the ECal module by
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Keysight). Default if not specified.

CHAR1   User characterization #1

CHAR2   User characterization #2

...and so forth up to:

CHAR12   User characterization #12

Examples SENS:CORR:CCHeck ECAL2

sense2:correction:ccheck:acquire ecal1,char1

Query Syntax Not applicable

Default Not applicable

SENSe<cnum>:CORRection:CCHeck:DONE

Applicable Models: All

(Write-only) Concludes the Confidence Check and sets the ECal module back into the idle state.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

Examples SENS:CORR:CCH:DONE
sense2:correction:ccheck:done

Query Syntax Not applicable

Default Not applicable

SENSe<cnum>:CORRection:CCHeck:PARameter <Mname>
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Applicable Models: All

(Read-Write) Specifies an existing measurement to be used for the Confidence Check.

Note: A confidence check can NOT be performed remotely from User Characterizations that are

stored on the VNA disk.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<Mname> Name of the measurement you are selecting for the confidence check. The

measurement must already exist.

Examples SENS:CORR:CCH:PAR 'TEST'
'selects the measurement "test" on channel 1 for the confidence
check

sense2:correction:ccheck:parameter 'test'
'selects the measurement "test" on channel 2 for the confidence
check

Query Syntax SENSe<cnum>:CORRection:CCHeck:PARameter?

Returns the name of the selected measurement on channel <cnum>.

Return Type String

Default Not applicable

SENSe<cnum>:CORRection:COLLect[:ACQuire] <class>[,subclass][,sync]

Applicable Models: All

(Write-only) For UNGUIDED calibration, measures the specified standards from the selected

calibration kit. The calibration kit is selected using the Sense:Correction:Collect:CKIT command.

For using two sets of standards, see SENS:CORR:TST.

Note: Before using this command you must select two items:

1. Select a calibration method using SENS:CORR:COLL:METH
2. Select a measurement using CALCulate:MEASure:DEFine. You can select one measurement for each

channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<class> Measures the standards associated with these class labels. Choose from:
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  Label SOLT

(Forward)

SOLT

(Reverse)

TRL

  STAN1 SA SA TRL "R"

  STAN2 SB SB N/A

  STAN3 SC SC TRL "L"

  STAN4 FWD TRANS REV TRANS TRL "T"

  STAN5 Generic Isolation; not associated with calibration kit definition.

  ECAL1

through

ECAL50

ECAL modules

  RESPonse Same as Normalize selection in Unguided Cal. (subclass is ignored)

  POWer Take a receiver power cal sweep and turn correction ON

  SLSET Sets 'sliding load type', and increments the "number of slides" count. The total

number of slides is critical to the correct calculation of the sliding load

algorithm. See a sliding load cal example.

  SLDONE Computes the sliding load using a circle fit algorithm.

[subclass] Optional argument. For mechanical calibration kits, choose from the following to specify

the standard to be acquired from the SENS:CORR:COLL:CKIT:ORDer list. If not specified,

subclass is set to SST1.

  SST1 First standard in the order list

  SST2 Second standard in the order list

  SST3 Third standard in the order list

  SST4 Fourth standard in the order list

  SST5 Fifth standard in the order list

  SST6 Sixth standard in the order list

  SST7 Seventh standard in the order list

  If an ECAL module (1 through 8) is specified for <class>, choose one of the

following for specifying which characterization within the ECal module will be

used for the acquire.  If not specified, the default is CHAR0.
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  CHAR0 Factory characterization (data that was stored in the ECal module by

Keysight)

  CHAR1 User characterization #1

  CHAR2 User characterization #2

 
...and so forth up to:

  CHAR12 User characterization #12

[sync] Optional argument. Choose from:

SYNChronous - blocks SCPI commands during standard measurement (default

behavior)

ASYNchronous - does NOT block SCPI commands during standard

measurement.

Learn more about this argument

Examples SENS:CORR:COLL STAN1
 

'If SENS:CORR:COLL:CKIT:ORDer2 5,3,7
was specified, the following command measures standard 3 (the
second in the order list)
sense1:correction:collect:acquire stan3,sst2

SENS:CORR:COLL ECAL4,ASYN; *OPC?

sense2:correction:collect:acquire ecal2,char1

Query Syntax Not applicable

Default Not applicable

SENSe<cnum>:CORRection:COLLect:APPLy
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Applicable Models: All

(Write-only) Applies error terms to the measurement that is selected using

CALCulate:MEASure:PARameter.

Note: Before using this command you must select a measurement using CALCulate:MEASure:DEFine.

You can select one measurement for each channel.

Note: This command is only necessary if you need to modify error terms. If you do not need to modify

error terms, SENSe<cnum>:CORRection:COLLect:SAVE calculates and then automatically applies error

terms after you use SENS:CORR:COLL:ACQuire to measure cal standards.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

Example
CALCulate2:PARameter:SELect S21_2 'select the measurement to
apply terms to

1.

SENSe2:CORRection:COLLect:METHod SPARSOLT 'set type of cal
method.

2.

CALCulate2:DATA? SCORR1 'download the error term of interest3.

'Modify the error term here4.

CALCulate2:DATA SCORR1 'upload the error term of interest5.

SENSe2:CORRection:COLLect:APPLy 'applies the error terms to
the measurement

6.

Query Syntax Not applicable

Default Not applicable

SENSe:CORRection:COLLect:DISPlay:WINDow:AOFF
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Applicable Models: All

(Write-only) Clears the flags for windows to be shown during calibrations.  To flag a window to be

shown see SENS:CORR:COLL:DISP:WIND.

Examples SENS:CORR:COLL:DISP:WIND:AOFF

sense:correction:collect:display:window:aoff

See an example using this command.

Query Syntax Not Applicable

Default Not Applicable

SENSe:CORRection:COLLect:DISPlay:WINDow<wNum>[:STATe] <bool>

Applicable Models: All

(Write-only) Set the 'show' state of the window to be displayed during a calibration to view the

measurements/channels.  Learn more.

When this command is sent, the specified window is 'flagged' to be shown during calibration.  The

flag is cleared when the window is closed. A Preset or Instrument State Recall also closes the

window. If the same window number is reopened, this command must be sent again to show the

window during a calibration.  The flag is NOT saved with an instrument state.

Send this command for each additional window to show during a calibration.

Parameters  

<wNum> Window number to show during a calibration. The calibration window will

also be shown with this window.

The window must already be created.

Use DISPlay:CATalog? to read all existing window numbers.

<bool> Window state. Choose from:

ON (or 1) - Show the specified window during calibration.

OFF (or 0) - Do NOT show the specified window during calibration.

Examples SENS:CORR:COLL:DISP:WIND1 1

sense:correction:collect:display:window2:state off

See an example using this command.

1039



Query Syntax Not Applicable

Default OFF

SENSe:CORRection:COLLect:ISOLation:AVERage:INCRement <num>

Applicable Models: All

(Read-Write) Specifies amount to increment (increase) the channel averaging factor during isolation

measurement of the ECal module during an unguided ECal calibration.

Note: if the channel currently has averaging turned OFF and <num> is greater than 1, averaging will

be turned ON only during the isolation measurements and with the averaging factor equal to <num>.

Parameters  

<num> Incremental Averaging factor. The maximum averaging factor is 65536 (2^16).

Examples SENS:CORR:COLL:ISOL:AVER:INCR 16

sense:correction:collect:isolation:average:increment 0

Query Syntax SENSe:CORRection:COLLect:ISOLation:AVERage:INCRement?

Return Type Numeric

Default 8 - If this command is NOT sent, but ECal isolation is measured, then averaging

will be turned ON with factor set to 8 during the isolation measurement.

SENSe<cnum>:CORRection:COLLect:ISOLation:ECAL[:STATe] <bool>

Applicable Models: All

(Read-Write) Specifies whether or not the isolation state of the ECal module will be measured as part

of an unguided ECal calibration.

An unguided calibration is performed using the SENS:CORR:COLL:METH and

SENS:CORR:COLL:ACQ commands.

Note: The inherent isolation of the VNA is better than that attained with this command. ONLY use

this command when using an external test set, and ONLY using a 8509x ECal module.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<bool> ON (or 1) - isolation is measured during the unguided ECal calibration.

OFF (or 0) isolation is NOT measured during the unguided ECal calibration.

1040



Examples SENS1:CORR:COLL:ISOL:ECAL ON

sense2:correction:collect:isolation:ecal:state 0

Query Syntax SENSe:CORRection:COLLect:ISOLation:ECAL:STATe?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

SENSe<cnum>:CORRection:COLLect:METHod <char>

Applicable Models: All

(Read-Write) For UNGUIDED calibration, sets the calibration method (also known as 'Calibration

Type' on calibration dialog box.) To select a Cal Type from a Cal Set, use CALC:MEAS:CORR:TYPE.

Note: Before using this command you must select a measurement using

CALCulate:MEASure:PARameter. You can select one measurement for each channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<char> Choose from:

  Method Description

  NONE No Cal method

  REFL1OPEN Response Open

   REFL1SHORT or

REFL1

Response Short

  REFL3 Full 1 port

  RESPonse Same as Normalize selection in Unguided Cal.

  RPOWer Receiver Power Cal - Used only with receiver

measurements.

  TRAN1 Response Thru - Requires a Thru standard.

  TRAN2 Response Thru and Isolation - Requires a Thru

standard.

  SPARSOLT Full SOLT 2 port

  SPARSOLT3 Full SOLT 3 port

  SPARTRL TRL Cal (Delta Match Cal may be required)
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Examples SENS:CORR:COLL:METH REFL1
sense2:correction:collect:method sparsolt

Query Syntax SENSe<cnum>:CORRection:COLLect:METHod?

Return Type Character

Default Not Applicable

SENSe<cnum>:CORRection:COLLect:METHod:PORT:SUBS:FULL:VAL <port numbers>

Applicable Models: M9485A

(Read-Write) :  Specify the ports allowed to participate in a multiport calibration.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<port numbers> comma separated list of ports

Examples SENS:CORR:COLL:METH:PORT:SUBS:FULL:VAL 1,2,3
sense2:correction:collect:method:port:subs:full:val 1,2,3

 

Calset is 16 port VNA with a 16 port calibration.

Full 3Port (1,2,3) error correction on ports 1,2,3

All other port parameters are uncorrected.

Query Syntax SENSe<cnum>:CORRection:COLLect:METHod:PORT:SUBS:FULL:VAL?

Return Type Character

Default Not Applicable

SENSe<cnum>:CORRection:COLLect:METHod:PORT:SUBS:RESet

Applicable Models: M9485A

(Write Only) :  Reset the the full and response list of the port subset correction.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

1042



Examples SENS:CORR:COLL:METH:PORT:SUBS:RES

Query Syntax Not Applicable

Return Type Not Applicable

Default Not Applicable

SENSe<cnum>:CORRection:COLLect:METHod:PORT:SUBS:RESPonse:VAL <port
numbers>

Applicable Models: M9485A

(Read-Write) :  Specify the ports that can be corrected using lesser corrections (enhanced response).

This list is not allowed to overlap with the full multiport calibration list specified by

:SENS:CORR:COLL:METH:PORT:FULL:VAL.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<port numbers> comma separated list of ports

Examples Calset: 16 port VNA with a 16 port calibration

Example 1

SENS:CORR:METH:PORT:SUBS:FULL:VAL 1,2,3,4,5,6

SENS:CORR:METH:PORT:SUBS:RESP:VAL 7,8,

Full 6 Port on ports 1 to 6

Enhanced Response for parameters involving ports 7 and 8

No correction for ports 9 to 16

 

Example 2

SENS:CORR:METH:PORT:SUBS:FULL:VAL 0

SENS:CORR:METH:PORT:SUBS:RESP:VAL
1,2,3,4,5,6,7,8,9,10,11,12,13,14,15,16

All parameters are enhance response corrected

Query Syntax SENSe<cnum>:CORRection:COLLect:METHod:PORT:SUBS:RESPonse:VAL?

Return Type Character
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Default Not Applicable

SENSe<cnum>:CORRection:COLLect:METHod:PORT:SUBS:STAT <bool>

Applicable Models: M9485A

(Read-Write) Enabling the port subset correction

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<bool> Devolve Calibration state. Choose from:

OFF or 0 - Off .

ON or 1 - On

Examples SENS:CORR:COLL:METH:PORT:SUBS:STAT ON
sense2:correction:collect:method:port:subs:stat 1

Query Syntax SENSe<cnum>:CORRection:COLLect:METHod:PORT:SUBS:STAT?

Return Type Boolean

Default Not Applicable

SENSe<ch>:CORRection:COLLect:NOISe:ENR:ADAPter:DEEMbed:[STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, M9485A

(Read-Write) Set and read the state of ENR Adapter de-embedding. Learn more.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1

<bool> ENR Adapter de-embed state. Choose from:

OFF or 0 - Do not force de-embedding.

ON or 1 - Force de-embedding.

Examples SENS:CORR:COLL:NOIS:ENR:ADAP:DEEM 0

sense2:correction:collect:noise:enr:adapter:deembed:state ON

Query Syntax SENSe:CORRection:COLLect:NOISe:ENR:ADAPter:DEEMbed:[STATe]?

Return Type Boolean
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Default O - OFF

SENSe<ch>:CORRection:COLLect:NOISe:LO<n>:PCAL[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, M9485A

(Read-Write) Enables and disables LO power calibration for NFX.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1

<n> LO Stage (number). Choose 1 for NFX.

<bool> LO Power Cal state. Choose from:

OFF or 0 - Disable LO Power Cal

ON or 1 - Enable LO Power Cal

Examples SENS:CORR:COLL:NOIS:LO1:PCAL 0

sense2:correction:collect:noise:lo1:pcal:state ON

Query Syntax SENSe:CORRection:COLLect:NOISe:LO<n>:PCAL:STATe?

Return Type Boolean

Default O - OFF

SENSe<ch>:CORRection:COLLect:NOISe:PSENsor:ADAPter:DEEMbed:[STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, M9485A

(Read-Write) Set and read the state of power sensor adapter de-embedding. Learn more.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1

<bool> Power sensor adapter de-embed state. Choose from:

OFF or 0 - Do not force de-embedding.

ON or 1 - Force de-embedding.

Examples SENS:CORR:COLL:NOIS:PSEN:ADAP:DEEM 0

sense2:correction:collect:noise:psensor:adapter:deembed:state ON
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Query

Syntax

SENSe:CORRection:COLLect:NOISe:PSENsor:ADAPter:DEEMbed:[STATe]?

Return

Type

Boolean

Default O - OFF

SENSe<cnum>:CORRection:COLLect:SAVE

Applicable Models: All

(Write-only) For UNGUIDED calibrations ONLY. This command does the following:

calculates the error terms using the selected :METHod

applies the error terms to the selected measurement (turns error correction ON.)

saves the calibration error-terms to the channels Cal Register or a User Cal Set.

The Cal Register or User Cal Set is determined by the setting of the

SENS:CORR:PREFerence:CSET:SAVE command.

 

Do NOT use this command during an ECAL.  When performing an ECAL calibration using

SENS:CORR:COLL:ACQuire, this SAVE operation is performed automatically before the completion of

a successful ACQuire.

Before using this command you must select a measurement using CALCulate:MEASure:PARameter. You

can select one measurement for each channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

Examples SENS:CORR:COLL:SAVE
sense2:correction:collect:save

Query Syntax Not applicable

Default Not applicable

SENSe:CORRection:COLLect:SWEep:CHANnel:AOFF
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Applicable Models: All

(Write-only) Clears ALL flags for channels to sweep during calibration. To flag a channel, see

SENS:CORR:COLL:SWE:CHAN.

Examples SENS:CORR:COLL:SWE:CHAN:AOFF

sense:correction:collect:sweep:channel:aoff

See an example using this command.

Default Not applicable

SENSe<cnum>:CORRection:COLLect:SWEep:CHANnel<cnum2>[:STATe] <bool>

Applicable Models: All

(Write-only) Specifies the channel to sweep during a Calibration.

When this command is sent, the <cnum2> channel is 'flagged' to be swept during calibration.  

The flag is cleared when the channel is deleted, if the Measurement Class is changed, or if all

measurements are deleted from the channel.

If the same channel number is recreated, this command must be sent again to sweep the channel

during a calibration.  The flag is NOT saved with an instrument state.

A Preset or Instrument State Recall deletes the channel.

Parameters  

<cnum> The channel to be calibrated.  If unspecified, value is set to 1.

<cnum2> The channel to sweep when waiting to measure a standard.

This channel must already exist with at least one measurement in the channel.

If this channel is in continuous sweep mode, it must have the same attenuator

settings and path configuration (VNA-X only).

<bool> Channel sweep state. Choose from:

ON (or 1) - Sweep the channel during calibration.

OFF (or 0) - Do NOT sweep the channel during calibration.

Examples SENS:CORR:COLL:SWE:CHAN2 1

sense2:correction:collect:sweep:channel3:state off

See an example using this command.
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Query Syntax Not Applicable

Default OFF

SENSe:CORRection:ENR:CALibration:TABLe:DATA <freq, value, freq, value...>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Set and read the ENR calibration data. All of the frequency and ENR data must be sent

at the same time. Use MMEM:LOAD to load, and MMEM:STORE:ENR CAL to save ENR table data from

disk. Learn more about Noise Source ENR files.

Parameters  

<freq, value> (Numeric) ENR data. Frequency value in Hz followed by a ENR noise value in

dB. Enter as many pairs as necessary.

Examples SENS:CORR:ENR:CAL:TABL:DATA 1.0E9,14.37,2.5E9,15.28
sense:correction:enr:calibration:table:data
1.0E9,14.37,2.5E9,15.28

Query Syntax SENSe:CORRection:ENR:CALibration:TABLe:DATA?

Return Type Comma separated numeric values
Default Not Applicable

SENSe:CORRection:ENR:CALibration:TABLe:ID:DATA <id>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns ID of ENR table. While this is for informational purposes only, it can

be used to record the model of the noise source. Learn more about ENR files.

Parameters  

<id> (String)  Identifier for the ENR table.

Examples SENS:CORR:ENR:CAL:TABL:ID:DATA "346C"
sense:correction:enr:calibration:table:id:data "ENR Table"

Query Syntax SENSe:CORRection:ENR:CALibration:TABLe:ID:DATA?

Return Type String
Default Not Applicable

SENSe:CORRection:ENR:CALibration:TABLe:SERial:DATA <sn>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the serial number of noise source. This is for informational purposes

only to identify the specific noise source for which the data pertains. Learn more about ENR files.

Parameters  

<sn> Serial number of the noise source for which the data applies, enclosed in

quotes.

Examples SENS:CORR:ENR:CAL:TABL:SER:DATA "ABCD1234"
sense:correction:enr:calibration:table:serial:data "ABCD1234"

Query Syntax SENSe:CORRection:ENR:CALibration:TABLe:SERial:DATA?

Return Type String
Default Not Applicable

SENSe<ch>:CORRection:GCSetup:POWer <num>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the power level at which to perform the Source Power Cal portion of a

Gain Compression (Opt S93086A) Calibration.  Learn more about this setting.

Parameters  

<num> Power level in dB. Choose a value from +30 to (-30).

Examples SENS:CORR:GCS:POW 0
sense:correction:gcsetup:power 5

Query Syntax SENSe:CORRection:GCSetup:POWer?

Return Type Numeric
Default 0

SENSe<ch>:CORRection:GCSetup:SENSor:CKIT <string>
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Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the cal kit to be used for calibrating at the port 1 reference plane when the

power sensor connector is different from the DUT port 1.  Learn more.

Parameters  

<string> Cal Kit. Use SENS:CORR:COLL:GUID:CKIT:PORT1:CAT? to return a list of valid

cal kits.

Examples SENS:CORR:GCS:SENS:CKIT "85052B"

Query Syntax SENSe:CORRection:GCSetup:SENSor:CKIT?

Return Type String

Default Not Applicable

SENSe<ch>:CORRection:GCSetup:SENSor:CONNector<string>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the power sensor connector type which is used to perform the Source

Power Cal portion of a Gain Compression Calibration.  Learn more.

Parameters  

<string> Power sensor connector type. Use SENS:CORR:COLL:GUID:CONN:CAT? to return

a list of valid connector types.

Select "Ignored" to NOT compensate for the adapter.

Examples SENS:CORR:GCS:SENS:CKIT "3.5 mm (50) male"

Query Syntax SENSe:CORRection:GCSetup:SENSor:CKIT?

Return Type String

Default Not Applicable

SENSe:CORRection:IMPedance:INPut:MAGNitude <num>
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Applicable Models: All

(Read-Write) Sets and returns the system impedance value for the analyzer.

Parameters  

<num> System Impedance value in ohms. Choose any number between 0 and 1000

ohms.

Examples SENS:CORR:IMP:INP:MAGN 75
sense:correction:impedance:input:magnitude 50.5

Query Syntax SENSe:CORRection:IMPedance:INPut:MAGNitude?

Return Type Numeric
Default 50

SENSe<ch>:CORRection:INTerpolate[:STATe] <ON | OFF>

Applicable Models: All

(Read-Write) Turns correction interpolation ON or OFF.

Note: Before using this command you must select a measurement using CALC:PAR:SEL. You can

select one measurement for each channel.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<ON | OFF> ON (or 1) - turns interpolation ON.

OFF (or 0) - turns interpolation OFF.

Examples SENS:CORR:INT ON
sense2:correction:interpolate:state off

Query Syntax SENSe<cnum>:CORRection:INTerpolate[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

SENSe<ch>:CORRection:ISOLation[:STATe] <ON | OFF>   OBSOLETE
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This command no longer works beginning in the VNA 5.2 release. The set and query of this command

will NOT return an error.

To perform isolation as part of an unguided calibration, you must explicitly measure the isolation

standard using SENS:CORR:COLL:ACQ Stan5.

To measure isolation as part of an ECal, use SENS:CORR:COLL:ISOL:ECAL.

(Read-Write) Turns isolation cal ON or OFF during Full 2-port calibration. If this command is not

sent, the default state is to disable Isolation.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<ON | OFF> ON (or 1) - turns isolation ON.

OFF (or 0) - turns isolation OFF.

Examples SENS:CORR:ISOL ON

sense2:correction:isolation:state off

Query Syntax SENSe<cnum>:CORRection:ISOLation[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF - (Isolation disabled)

SENSe<ch>:CORRection:METHods:MATCh <bool>

Applicable Models: All

(Read-Write) Turns match-correction ON or OFF. Use this command AFTER performing an Guided

Power Cal. Learn more.

Parameters  

<ch> Channel number on which Guided Power Cal was performed. If unspecified,

value is set to 1.

<bool> ON (or 1) - Turns match-correction ON

OFF (or 0) -  Turns match-correction OFF.

Examples SENS:CORR:METH:MATC 0
sense2:correction:methods:match off

Query Syntax SENSe<cnum>:CORRection:METHods:MATCh?

Return Type Boolean (1 = ON, 0 = OFF)
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Default ON

SENSe<ch>:CORRection:METHods:PORT:SUBSet:FULL[:VALue] <port numbers>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the selected ports to include in a full NPort correction. All other ports

are corrected with enhanced response calibration if available. Learn more.

Note: The SENSe:CORRection:METHods:PORT:SUBSet:[:STATe] must be set to ON to enable the full

command.

Parameters  

<ch> Channel number.

<port numbers> Comma separated list of ports to include in the full correction.

Examples 16-port VNA with an active 16-port calibration

SENS:CORR:METH:PORT:SUBS:STAT 1
SENS:CORR:METH:PORT:SUBS:FULL:VAL 1,2,3
sense2:correction:methods:port:subset:full:value 1,2,3

Result: Full correction on ports 1, 2, and 3
All other port parameters are uncorrected

Query Syntax SENSe<cnum>:CORRection:METHods:PORT:SUBSet:FULL[:VALue]?

Return Type Array_int

Default All ports included

SENSe<ch>:CORRection:METHods:PORT:SUBSet:RESet

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write) Resets the full and response list to their default values. Learn more.

Parameters  

<ch> Channel number.

Examples SENS:CORR:METH:PORT:SUBS:RES
sense2:correction:methods:port:subset:reset

Return Type Not applicable

Default Not applicable
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SENSe<ch>:CORRection:METHods:PORT:SUBSet:RESPonse[:VALue] <port numbers>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the selected ports to be corrected with enhanced response calibration.

Learn more.

Note: The SENSe:CORRection:METHods:PORT:SUBSet:[:STATe] must be set to ON to enable the

response command.

Parameters  

<ch> Channel number.

<port numbers> Comma separated list of ports to include for enhanced response correction.

Examples Example #1:
16-port VNA with an active 16-port calibration

SENS:CORR:METH:PORT:SUBS:STAT 1
SENS:CORR:METH:PORT:SUBS:FULL:VAL 1,2,3,4,5,6
SENS:CORR:METH:PORT:SUBS:RESP:VAL 7,8

Result: Full correction on ports 1-6
Enhanced response corrected for parameters involving ports 7 and
8
No correction for ports 9-16
 

Example #2:
16-port VNA with an active 16-port calibration

SENS:CORR:METH:PORT:SUBS:FULL:VAL 0
SENS:CORR:METH:PORT:SUBS:RESP:VAL
1,2,3,4,5,6,7,8,9,10,11,12,13,14,15,16
Result: Enhanced response correction for parameters involving
any ports

Query Syntax SENSe<cnum>:CORRection:METHods:PORT:SUBSet:RESPonse[:VALue]?

Return Type Array_int

Default Empty list

SENSe<ch>:CORRection:METHods:PORT:SUBSet[:STATe] <bool>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Set and return the ON/OFF subset correction state. Learn more.

Parameters  

<ch> Channel number.

<bool> Choose from:

0 - OFF - Subset correction OFF.

1 - ON - Subset correction ON.

Examples SENS:CORR:METH:PORT:SUBS:STAT 1

sense2:correction:methods:port:subset:state 1

Query Syntax SENSe<cnum>:CORRection:METHods:PORT:SUBSet:[:STATe]?

Return Type Boolean

Default 0

SENSe:CORRection:PREFerence:CALibration[:FOM]:RANGe <char>

Applicable Models: All

(Read-Write)  Specifies the FOM frequency range to use when performing calibration.

Parameters  

<char> Choose from:

PRIMary - Used for calibrating at the mmWave frequencies when NOT using

a test set. Learn more.

AUTO - All other calibration situations.

Examples SENS:CORR:PREF:CAL:RANG PRIM
sense:correction:preference:calibration:fom:range auto

Query Syntax SENSe:CORRection:PREFerence:CALibration[:FOM]:RANGe?

Return Type Character

Default AUTO

SENSe:CORRection:PREFerence:CSET:SAVE <char>
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Applicable Models: All

Important Notes:

This command replaces SENS:CORR:PREF:CSET:SAVU

With 6.0 we implemented a change that defaults to saving completed calibrations to Cal Registers instead
of User Cal Sets. To revert to the old behavior, send this command with the USER argument.

(Read-Write)  Specifies the default manner in which calibrations that are performed using SCPI or

COM are to be stored. Cal data is ALWAYS stored to the channel Cal Register regardless of this

setting.

This setting survives instrument preset and reboot. It remains until changed by another execution of

this command.

Note: Cal Set arguments used with commands such as SENS:CORR:COLL:GUID:INIT,

SENS:CORR:COLL:GUID:SAVE and SENS:CORR:COLL:GUID:SAVE:CSET will override of any of these

default preference settings.

Learn about Cal Registers and User Cal Sets.

Parameters  

<char> CALRegister - Each Cal is saved ONLY to the channel Cal Register. If the

error terms from a new Cal can co-exist with those in the Cal Register, they are

appended.

USER - Each Cal is saved to its own new User Cal Set file. The Cal Set name

is automatically generated. To change the name, send SENS:CORR:CSET:NAME
after the cal is complete. This reverts to pre-6.0 behavior.

REUSe - The cal is saved to the Cal Set that is currently selected on the

specified channel, which could be the channel Cal Register. If the channel does

not yet have a selected Cal Set, the cal will be saved to a new User Cal Set with

an automatically-generated name. If the error terms from a new Cal can co-

exist with those in the Cal Set, they are appended.

Examples SENS:CORR:PREF:CSET:SAVE USER
sense:correction:preference:cset:save reuse

Query Syntax SENSe:CORRection:PREFerence:CSET:SAVE?

Return Type Character

Default CALRegister
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SENSe:CORRection:PREFerence:CSET:SAVUser <bool> Superseded

Applicable Models: N522xB, N523xB, N524xB, M9485A

This command is replaced with SENS:CORR:PREF:CSET:SAVE

NOTE: With 6.0 we implemented a change that defaults to saving completed calibrations to Cal

Registers instead of User Cal Sets. To revert to the old behavior, send this command as ON (1). For

UI and COM use, this can be done from the GPIB console.

(Read-Write)  Specifies whether cal data is automatically saved to a User Cal Set file after performing

a SCPI calibration. Cal data is always saved to a Cal Register regardless of this setting.

This setting survives instrument preset and reboot. It remains until changed by another execution of

this command.

Learn about Cal Registers and User Cal Sets.

Parameters  

<bool> ON or 1 - Cal is automatically saved to a User Cal Set file when performing a

SCPI calibration. The Cal Set name is automatically generated. To change the

name, send SENS:CORR:CSET:NAME after the cal is complete. Reverts to pre-

6.0 behavior.

OFF or 0 - Cal is NOT automatically saved to a User Cal Set. To save a

calibration to a User Cal Set, use SENS:CORR:COLL:GUID:INIT.

Examples SENS:CORR:PREF:CSET:SAVU 1
sense:correction:preference:cset:savuser 0

Query Syntax SENSe:CORRection:PREFerence:CSET:SAVUser?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF (0)

SENSe:CORRection:PREFerence:ECAL:ORIentation[:STATe] <ON|OFF>
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Applicable Models: All

(Read-Write)  Specifies whether or not the VNA should perform orientation of the ECal module

during calibration.  Orientation is a technique by which the VNA automatically determines which

ports of the module are connected to which ports of the VNA.  Orientation begins to fail at very low

power levels or if there is much attenuation in the path between the VNA and the ECal module.  If

orientation is turned OFF, the SENS:CORR:PREF:ECAL:PMAP command must be used to specify the

port connections before performing a cal.  

Note: For 3-port or 4-port measurements, when orientation is OFF, you are not allowed to specify

how the ECAL module is connected. Instead, the VNA determines the orientation. Use

SENS:CORR:COLL:GUID:DESC? to query the orientation. The VNA does not verify that you made the

connection properly.

This setting remains until the VNA is restarted or this command is sent again.

Parameters  

<bool>  ECAL orientation state. Choose from:

ON or 1 - VNA performs orientation of the ECal module.

OFF or 0 - VNA does NOT performs orientation of the ECal module.

Examples SENS:CORR:PREF:ECAL:ORI OFF

sense:correction:preference:ecal:orientation:state on

Query Syntax SENSe:CORRection:PREFerence:ECAL:ORIentation[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON (1)

SENSe:CORRection:PREFerence:ECAL:OVERrange[:STATe] <ON|OFF>
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Applicable Models: N522xB, N523xB, N524xB, M9485A

(Read-Write)  Sets and returns the ECAL over range state.

Parameters  

<bool>  ECAL over range state. Choose from:

ON or 1 - Enable ECAL over range.

OFF or 0 - Disable ECAL over range.

Examples SENS:CORR:PREF:ECAL:OVER OFF

sense:correction:preference:ecal:overrange:state on

Query Syntax SENSe:CORRection:PREFerence:ECAL:OVERrange[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON (1)

SENSe:CORRection:PREFerence:ECAL:PMAP <module>,<string>

Applicable Models: All

(Read-Write) When ECal module orientation is turned OFF (SENS:CORR:PREF:ECAL:ORI), this

command specifies the port mapping (which ports of the module are connected to which ports of the

VNA) prior to performing ECal calibrations.

This setting remains until the VNA is restarted or this command is sent again.

Parameters  

<module> Specifies which ECal module this port map is being applied to.  Choose from:

ECAL1

.through.

ECAL50

<string> Format this parameter in the following manner:

Aw,Bx,Cy,Dz

where

A, B, C, and D are literal ports on the ECAL module
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w,x,y, and z are substituted for VNA port numbers to which the ECAL module port
is connected.

Ports of the module which are not used are omitted from the string.

For example, on a 4-port ECal module with

port A connected to VNA port 2

port B connected to VNA port 3

port C not connected

port D connected to VNA port 1

the string would be: A2,B3,D1

If either the receive port or source port (or load port for 2-port cal) of the

CALC:PAR:SELected measurement is not in this string and orientation is OFF,

an attempt to perform an ECal calibration will fail.

Examples SENS:CORR:PREF:ECAL:PMAP ECAL2, 'A1,B2'
sense:correction:preference:ecal:pmap ecal3, 'a2,b1,c3'

Query Syntax SENSe:CORRection:PREFerence:ECAL:PMAP? <module>

Return Type String

Default Null string ()

SENSe:CORRection:PREFerence:SIMCal <bool> Obsolete

This command is no longer supported. Learn more about old and new behaviors.

(Read-Write) Sets and returns a preference for the Unguided Cal behavior described below. This

setting persists until it is changed.

This preference can also be set ON by executing the script on the VNA at C:/Program

Files/Keysight/Network Analyzer/System/wincal32.reg.

Parameters  

<bool> Boolean - Choose from:

0 - OFF - Reverts to new (preferred) behavior. An error is returned if standard

data is not acquired before sending SENS:CORR:COLL:SAVE.

1 - ON - (WinCal compatible)  Prevents SENS:CORR:COLL:SAVE from failing

when standard data has not, and will not, be acquired.
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Examples SENS:CORR:PREF:SIMC 0

sense:correction:preference:simcal 1

Query Syntax SENSe:CORRection:PREFerence:SIMCal?

Return Type Boolean

Default 0

SENSe:CORRection:PREFerence:TRIG:FREE <char>, <bool>

Applicable Models: All

(Read-Write) Sets and returns the preference for the trigger behavior during a calibration. This setting

persists until it is changed.

Note: If TRIGger:SOURce = Manual, during a calibration the VNA ALWAYS switches to Internal for

one trigger, then back to Manual, regardless of this preference command.

Parameters  

<char> Character - Calibration type. Choose from:

GUIDed - preference setting pertains to a Guided calibration.

UNGuided - preference setting pertains to an Unguided calibration.

<bool> Boolean - Choose from:

0 - OFF - The trigger behavior during the specified calibration type DOES

respect the setting of the TRIGger:SOURce command. For example,when Trigger

source = External, the single trigger method will wait for the External trigger

signal and then allow only one sweep.

1 - ON - (Pre-6.0 behavior) The trigger behavior during the specified

calibration type does NOT respect the setting of the TRIGger:SOURce command.

For example, when Trigger source = External, during calibration the VNA

switches to Internal sweep, responds to one trigger signal to measure the

standard, then switches back to External.

Examples SENS:CORR:PREF:TRIG:FREE GUID,1

sense:correction:preference:trig:free unguided,0

Query Syntax SENSe:CORRection:PREFerence:TRIG:FREE? <char>

Return Type Boolean

Default OFF for both calibration types.
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SENSe<cnum>:CORRection:RPOWer:OFFSet[:AMPLitude] <num>

Applicable Models: All

(Read-Write)  Adjusts a receiver power cal to account for components or adapters that are added

between the source port and receiver while performing this cal. For more information, see Receiver
Cal.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Offset Value in dB. Specify loss as a negative number; and gain as a positive

number. Choose a number between -200 and 200.

Examples SENS:CORR:RPOW:OFFS .5
sense2:correction:rpower:offset:amplitude .-5

Query Syntax SENSe<cnum>:CORRection:RPOWer:OFFSet[:AMPLitude]?

Return Type Numeric
Default 0

SENSe<cnum>:CORRection:RVELocity:COAX <num>

Applicable Models: All

(Read-Write) Sets the velocity factor to be used with Electrical Delay and Port Extensions.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Velocity factor. Choose a number between 0 and 10

(.66 polyethylene dielectric; .7 PTFE dielectric)

Examples SENS:CORR:RVEL:COAX .66
sense2:correction:rvelocity:coax .70

Query Syntax SENSe<cnum>:CORRection:RVELocity:COAX?

Return Type Numeric
Default 1

SENSe<cnum>:CORRection:SFORward[:STATe] <boolean>
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Applicable Models: All

(Read-Write) Sets the direction a calibration will be performed when only one set of standards is used.

Use SENSe:CORRection:TSTandards[:STATe] OFF to specify that only one set of standards will be used.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<boolean> ON (1) - FORWARD direction of a 2-port calibration will be performed

OFF (0) - REVERSE direction of a 2-port calibration will be performed

Examples SENS:CORR:SFOR 1
sense2:correction:sforward:state 0

See an example using this command

Query Syntax SENSe<cnum>:CORRection:SFORward[:STATe]?

Return Type Boolean

Default ON

SENSe<cnum>:CORRection[:STATe] <ON | OFF>

Applicable Models: All

(Read-Write) Turns error correction ON and OFF for the specified channel.

Note: Before using this command you must select a measurement using

CALCulate:MEASure:PARameter. You can select one measurement for each channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<ON | OFF> ON (or 1) - correction is applied to the channel.

OFF (or 0) - correction is NOT applied to the channel.

Examples SENS:CORR ON
sense2:correction:state off

Query Syntax SENSe<cnum>:CORRection[:STATe]?

To query the error correction state for a measurement, use
CALC:MEAS:CORR:STATe?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF
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SENSe<cnum>:CORRection:TCOLd:USER:VALue <num>

Applicable Models: All

(Read-Write) Sets and returns the temperature of the noise source connector. Learn more about Noise
Figure Calibration.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<num> Noise source temperature in Kelvin.

Examples SENS:CORR:TCOL:USER:VAL 295

sense2:correction:tcold:user:value 298

See an example using this command

Query Syntax SENSe<cnum>:CORRection:TCOLd:USER:VALue?

Return Type Numeric

Default Not Applicable

SENSe<cnum>:CORRection:TSTandards[:STATe] <boolean>

Applicable Models: All

(Read-Write) Specifies the acquisition of calibration data using ONE or TWO sets of standards.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<boolean> ON (1) - TWO identical sets of standards will be used to simultaneously

calibrate two ports (for both Forward and Reverse parameters).

OFF (0)- ONE set of standards will be used to perform a full 2-port calibration,

one port at a time.

When specifying ON (use two sets), the SENS:CORR:COLL:ACQuire command

uses the same standard index for each calibration class. To specify the

calibration standard gender for each port, you must first ensure that the order of

calibration class accurately reflects the configuration of your DUT.  For

example, for a DUT with a male connector on port 1 and a female connector on

port 2, order the devices within the S11 classes (A, B, and C) such that the

MALE standards are first in the list.  Then order the S22 classes specifying the

FEMALE standards as the first in the list.
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Examples SENS:CORR:TST 1
sense2:correction:tstandard:state 0

See an example using this command

Query Syntax SENSe<cnum>:CORRection:TSTandards[:STATe]?

Return Type Boolean

Default ON

SENSe:CORRection:TYPE:CATalog? <char>

Applicable Models: All

(Read-Write) Lists the Cal Types in the VNA by either GUID or registered name. Learn more about
applying Cal Type using SCPI.

Note: Before using this command you must select a measurement using

CALCulate:MEASure:PARameter. You can select one measurement for each channel.

Parameters  

<char> Specifies the type of list. Choose from:

GUID -  the registered GUID of the Cal Type

NAME -  the registered name of the Cal Type

Examples SENS:CORR:TYPE:CAT? GUID

Query Syntax SENSe<cnum>:CORRection:TYPE:CATalog? <char>

Return Type Comma-separated string

Default Not Applicable
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Sense:Correction:CKIT Commands

Manages the list of cal kits that are installed in the VNA.  

SENSe:CORR:CKIT

CLEar

COUNt?

ECAL

       | CHARacterize More commands

       | CLISt?

       | DMEMory

            | CLEar

            | IMPort

       | EXPort

       | INFormation

       | KNAMe

            | INFormation

       | LIST?

       | ORIent?

       | PATH

            | COUNt?

            | DATA?

EXPort

IMPort

INITialize

LOAD

Click on a red keyword to view the command details.

Red is a superseded command
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New See Calibrating the VNA Using SCPI

Learn about Modifying Cal Kits

Synchronizing the Analyzer and Controller

SCPI Command Tree

SENSe:CORRection:CKIT:CLEar[:IMMediate] [ckit]

Applicable Models: All

(Write-only)  Deletes installed cal kits.

Parameters  

[ckit] Optional String. Cal Kit to delete. If not specified, all VNA Cal kits are

deleted, including custom kits.

Examples SENS:CORR:CKIT:CLE

sense:correction:ckit:clear:immediate "85052B"

Query Syntax Not Applicable

Default Not Applicable

SENSe:CORRection:CKIT:COUNt?

Applicable Models: All

(Read-only) Returns the number of installed cal kits.

Examples SENS:CORR:CKIT:COUNt?

Query Syntax SENS:CORR:CKIT:COUNt?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:CKIT:ECAL<mod>:CLISt?
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Applicable Models: All

(Read-only) Returns a list of characterizations stored in the specified ECal module.

Parameters  

<mod> ECal module from which to read user characterization numbers. Choose from 1

to 50. If unspecified, value is set to 1.

Examples Module 1 contains User Characterizations 1 and 3.

SENSe:CORRection:CKIT:ECAL:CLIST?

'Returns the following (0 always indicates the factory
characterization):

0,1,3

Return Type Numeric list, separated by commas.

Default Not Applicable

SENSe:CORRection:CKIT:ECAL:DMEMory:CLEar <kitName>

Applicable Models: All

(Write-only) Deletes user characterizations from VNA disk memory.

Parameters  

<kitName> Optional String argument.  ECal Model, User Characterization name + " ECal",

and serial number of the ECal module, separated by spaces. See examples

below.

If unspecified, ALL User Characterizations that are stored in VNA disk

memory are deleted.

Examples 'These examples all use "MyUserChar" as the User
characterization name.

'The "My User Char" characterization is deleted from disk
memory.

SENS:CORR:CKIT:ECAL:DMEM:CLE "N4433A MyUserChar ECal 00001"

'All User characterizations are deleted from disk memory.

SENS:CORR:CKIT:ECAL:DMEM:CLE

Query Syntax Not Applicable

Default Not Applicable
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SENSe:CORRection:CKIT:ECAL:DMEMory:IMPort <file>

Applicable Models: All

(Write-only) After the VNA disk memory is Exported to a file, use this command to Import the file

into VNA disk memory, which allows the User Characterization to be used with the VNA and ECal

module.

Note: An ECal confidence check can NOT be performed remotely from User Characterizations that

are stored on the VNA disk.

Parameters  

<file> String. Full path and file name of file that was exported.

Examples SENS:CORR:CKIT:ECAL:DMEM:IMP "D:\myDiskUserChar.euc"

Query Syntax Not Applicable

Default Not Applicable

SENSe:CORRection:CKIT:ECAL:EXPort <kit>[,<file>][,<NewName>]]

Applicable Models: All

(Write-only) Saves an existing ECal characterization to a file. Use this command to archive the user

characterization or to move the characterization to a different VNA for use with the specified ECal

module. After exporting the user characterization, use SENS:CORR:CKIT:ECAL:DMEM:IMPort to make

the user characterization available for use.

Parameters  

<kit> String. Not case sensitive. ECal Model, User char name + " ECal", and serial

number of the ECal module used for the characterization, separated by spaces.

See examples below.

If the model and serial number of the module is not found, an error is returned.

[<file>] Optional String argument. Path and filename of the user characterization. If not
specified, the file is saved using characterization name + ".euc". If the path is

not specified, it is stored in C:/Program Files/Keysight/Network Analyzer/ECal
User Characterizations/. The extension ".euc" is appended if one is not

specified.

[<NewName>] Optional String argument. This allows you to change the name for the User

Characterization. When specified, the new name is saved in the file with the

characterization. If unspecified, the existing user characterization name is
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saved.

Note: If this argument is specified, the second argument (<file>) must also be

specified.

Examples 'These examples all use "MyUserChar" as the User
characterization name.

'All parameters specified

SENS:CORR:CKIT:ECAL:EXP "N4433A MyUserChar ECal
00001","myUserChar.euc","NewUserChar"

'First two parameters are specified

sense:correction:ckit:ecal:export "N4691B MyUserChar ECal
00500","myUserChar.euc"

'Only first parameter is specified

SENS:CORR:CKIT:ECAL:EXP "N4433A MyUserChar ECal 00001"

Query Syntax Not Applicable

Default Not Applicable

SENSe:CORRection:CKIT:ECAL<mod>:INFormation? [<char>]

Applicable Models: All

(Read-only)  Reads the identification and characterization information from the specified ECal

module.

Note: To read user-characterization information that is stored in VNA disk memory, then use
SENS:CORR:CKIT:ECAL:KNAM:INF?

Parameters  

<mod> ECal module from which to read characterizations. Choose from 1 through 50.
If unspecified, value is set to 1.

Do NOT assume the <mod> number is the order in which ECal modules were

connected.

Use SENS:CORR:CKIT:ECAL:LIST? to read a list of <mod> numbers of currently-

attached ECal modules.

<char> Optional argument. Specifies which characterization to read information from.

 If not specified, value is set to CHAR0.
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Choose from:

CHAR0   Factory characterization (data that was stored in the ECal module by
Keysight)

CHAR1   User characterization #1

CHAR2   User characterization #2

 - through -

CHAR12   User characterization #12

Examples SENS:CORR:CKIT:ECAL2:INFormation? char5

'Example return string:

"ModelNumber: 85092-60007, SerialNumber: 01386, ConnectorType:
N5FN5F, PortAConnector: Type N (50) female, PortBConnector: Type
N (50) female, MinFreq: 30000, MaxFreq: 9100000000,
NumberOfPoints: 250, Calibrated: July 4 2002"

Return Type Character

Default Not Applicable

SENSe:CORRection:CKIT:ECAL:KNAMe:INFormation? <kitName>

Applicable Models: All

(Read-only) Reads the identification and characterization information from the specified ECal module

or VNA disk memory.

Learn more about User Characterization in VNA Disk Memory.

Parameters  

<kitName> String. ECal model and characterization to read information from, enclosed in

quotes, in the following format:

<model> <name> ECal <serial number>

Where:

<model>: Always required

<name>:

For the factory characterization, do not specify.
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For a user-characterization stored in the module, use User <n> in the string,
where <n> is the user-characterization number. Not case sensitive. Separate
User and <n> with a space.

For a user-characterization stored in VNA disk memory, use <charName>
from SENS:CORR:CKIT:ECAL:CHAR:DMEM:SAVE <charName>

ECal - not case sensitive

<serial number>: Optional. Include when two or more ECal modules with

same model number are attached to the VNA,

Each item is separated with a space.

Examples 'For a factory characterization in module memory:
SENS:CORR:CKIT:ECAL:KNAM:INF? "N4433A ECal"

'For user characterization in module memory with optional serial
number:
SENS:CORR:CKIT:ECAL:KNAM:INF? "N4433A User 1 ECal 00028"

'For user characterization "foo" in disk memory:
SENS:CORR:CKIT:ECAL:KNAM:INF? "N4433A foo ECal 00028"

'Example return string:

"ModelNumber: N4433A, SerialNumber: 00028, ConnectorType:
N5FN5F, PortAConnector: Type N (50) female, PortBConnector: Type
N (50) female, MinFreq: 30000, MaxFreq: 9100000000,
NumberOfPoints: 250, Calibrated: July 4 2002"

Return Type String

Default Not Applicable

SENSe:CORRection:CKIT:ECAL:LIST?
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Applicable Models: All

(Read-only) Returns a list of index numbers for ECal modules that are currently attached to the VNA.

Use these numbers (called <mod> in VNAHelp) to refer to the ECal module using SCPI commands.

Examples SENS:CORR:CKIT:ECAL:LIST?

'If 2 modules are attached to the VNA
'then the returned list will be:

+1,+2

'If NO modules are attached to the VNA
'then the returned list will be:

+0

See example program using this command.

Return Type Numeric list, separated by commas.

Default Not Applicable

SENSe<ch>:CORRection:CKIT:ECAL<n>:ORIent? <pnaPort>[,<charN>]

Applicable Models: All

(Read-only) Returns the ECal port that is connected to the specified VNA port. A calibration does not

have to be in process.

<ch> Channel number that contains the frequency range to be calibrated.

<n> ECal module number.  Choose from 1 through 50.

If unspecified (only one ECal module is connected to the USB), <n> is set to 1.

 If two or more modules are connected, use SENS:CORR:CKIT:ECAL:LIST? to

determine how many, and SENS:CORR:CKIT:ECAL:INF? to verify their identities.

<pnaPort> VNA port number.

<charN> Optional argument. If unspecified, factory data (CHAR0) is used. User

Characterization number that matches the physical adapters/fixtures that are on

the ECal module. This aids in determining the orientation of the ECal module.

Choose from:

CHAR0   Factory characterization (data that was stored in the ECal module by
Keysight)

CHAR1   User characterization #1
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CHAR2   User characterization #2

and so forth up to:

CHAR12   User characterization #12

Beginning with A.08.33, up to 12 User Characterizations can be stored in a

single ECal module. Previous releases allowed up to 5. Learn more.

Examples SENS1:CORR:CKIT:ECAL1:ORI? 2

sense2:correction:ckit,ecal1:orient? 2, char2

Return Type The returned ECal port number is a 1-based number: 1 = Port A, 2 = Port B, 3

= Port C, 4 = Port D.

Zero (0) is returned when the auto-orientation routine is unable to resolve the

orientation.

Default Not Applicable

SENSe:CORRection:CKIT:ECAL<n>:PATH:COUNt? <path>

Applicable Models: All

(Read-only)  Returns the number of unique states that exist for the specified path name on the selected

ECal module.

This command performs exactly the same function as CONT:ECAL:MOD:PATH:COUNt?

Use the CONT:ECAL:MOD:PATH:STAT command to set the module into one of those states.  

Use SENS:CORR:CKIT:ECAL:PATH:DATA? to read the data for a state.

Parameters  

<n> USB number of the ECal module.  Choose from 1 to 50.

If unspecified (only one ECal module is connected to the USB), <n> is set to 1.
If two or more modules are connected, use SENS:CORR:CKIT:ECAL:LIST? to

determine how many, and SENS:CORR:CKIT:ECAL:INF? to verify their identities.

<path> Name of the path for which to read number of states.  Choose from:

Reflection paths

A
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B

C (4-port modules)

D (4-port modules)

Transmission paths

AB

AC (4-port modules)

AD (4-port modules)

BC (4-port modules)

BD (4-port modules)

CD (4-port modules)

Examples CONT:ECAL:MOD:PATH:COUNt?
control:ecal:module2:path:count?

Return Type Integer

Default Not Applicable

SENSe<ch>:CORRection:CKIT:ECAL<num>:PATH:DATA? <path>, <stateNum>[,<char>]

Applicable Models: All

(Read-only)  Returns the data for a state from the memory of the selected ECal module. The returned

data is interpolated if necessary to have the same stimulus values as the specified channel <ch>.

For a reflection path state, the data is reflection S-parameter data. The number of values equals the
number of stimulus points on the channel multiplied by 2 (because they are complex numbers).

For a transmission path state, the data is all 4 S-parameters of the state. The number of values returned is
4 times that of a reflection state.

The data is returned in the same format as CALC:MEAS:DATA:SNP?

Note: This command returns SNP data without header information, and in columns, not in rows as
.SnP files. This means that the data returned from this command sends all frequency data, then all Sx1

magnitude or real data, then all Sx1 phase or imaginary data, and so forth.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.
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<num> Optional argument. USB number of the ECal module. Choose from 1 through

50.

If unspecified (only one ECal module is connected to the USB), <num> is set

to 1. If two or more modules are connected, use SENS:CORR:CKIT:ECAL:LIST?
to determine how many, and SENS:CORR:CKIT:ECAL:INF? to verify their

identities.

<path> Name of the path for which to read number of states.  Choose from:

Reflection paths

A

B

C (4-port modules)

D (4-port modules)

Transmission paths

AB

AC (4-port modules)

AD (4-port modules)

BC (4-port modules)

BD (4-port modules)

CD (4-port modules)

<stateNum> Number of the state to set. Refer to the following table to associate the

<stateNum> with a state in your ECal module.

In addition, CONT:ECAL:MOD:PATH:COUNt? returns the number of states in the

specified ECal module.
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<stateNum> N4432A

and

N4433A

States

N4431A

States

N469x and

N755x

States**

8509x

States

One-Port Reflection States

1 Open Open Impedance

1

Open

2 Short Short Impedance

2

Short

3 Impedance

1

Impedance

1

Impedance

3

Impedance

1

4 Impedance

2

Impedance

2

Impedance

4

Impedance

2

5     Impedance

5

 

6     Impedance

6

 

7     Impedance

7

 

Two-Port Transmission States

1 Thru Thru Thru Thru

2 Confidence Confidence Confidence Confidence

** The following modules have only FOUR Impedance states (1, 2, 3, 4):

N4690B ,N4691B ,N4692A ,N4696B, N7550A - N7556A.

<char> Optional argument. Specifies which characterization within the ECal module to

read information from.  If  not specified, value is set to CHAR0.

Choose from:

CHAR0   Factory characterization (data that was stored in the ECal module by
Keysight)

CHAR1   User characterization #1

CHAR2   User characterization #2

and so forth up to:

CHAR12   User characterization #12
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Examples SENS:CORR:CKIT:ECAL1:PATH:DATA? A,1

Return Type S1P or S2P

Default Not Applicable

SENSe:CORRection:CKIT:EXPort <kit>[,<file>]

Applicable Models: All

(Write-only) Saves an existing cal kit definitions to a file. Use this command to archive or move a

user-defined or modified cal kit to a different VNA. After exporting the cal kit, use

SENS:CORR:CKIT:IMPort to make the cal kit available for use on the VNA. This command provides the

same behavior as the Installed Kits - Save As button on the Edit VNA Cal Kits dialog.

Parameters  

<kit> String. Not case sensitive. Name of the cal kit to export, as seen in the Cal Kits

field of the Select DUT Connectors and Cal Kits dialog of a SMART Cal.

<file> Optional String argument. Path and filename to where the Cal Kit file is to be

saved. If not specified, the file is saved using <kit> + ".ckt". If the path is not

specified, it is stored in C:/Program Files/Keysight/Network

Analyzer/PNACalKits/User.

Examples 'File unspecified

SENS:CORR:CKIT:EXP "MyCalKit"

'Both parameters are specified

sense:correction:ckit:export "MyCalKit","C:/myBackupCalKit.ckt"

Query Syntax Not Applicable

Default Not Applicable

SENSe:CORRection:CKIT:IMPort <string>
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Applicable Models: All

(Write-only) Imports the specified cal kit (.ckt file) and appends the imported kit to the end of the list

of kits.

Note:  Although there is no limit to the number of cal kits that can be imported, during an Unguided
cal, you can access ONLY mechanical cal kits #1 through #95.

Parameters  

<string> Path and cal kit name.

Examples SENSe:CORRection:CKIT:IMPort "c:\users\public\network
analyzer\documents/85033D.ckt"

Query Syntax Not Applicable

Default Not Applicable

SENSe:CORRection:CKIT:INITialize[:IMMediate] [ckit]

Applicable Models: All

(Write-only) Restores default factory installed cal kits. This command also selects kit number 1, as

you would using SENS:CORR:COLL:CKIT:SEL 1. Therefore, if you intend to work with a Cal Kit

remotely, select the Cal Kit AFTER sending this command.

Note: This command can also delete all existing User-defined Cal Kits. However, if saved using Save

As, these kits can be restored in the same manner as after a VNA firmware upgrade. Learn more about
saving modified Cal Kits.

Parameters  

[ckit] Optional String. Cal Kit to restore. If not specified, all VNA factory Cal kits

are restored.

Examples SENS:CORR:CKIT:INITialize

sense:correction:ckit:initialize:immediate "85052B"

Query Syntax Not Applicable

Default Not Applicable

SENSe:CORRection:CKIT:LOAD <string>
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Applicable Models: All

(Write-only) Loads the specified collection of cal kits from a .wks file. You can make your own

collection of cal kits from the Advanced Modify Cal Kit menu.

Parameters  

<string> Path and file name of the cal kit collection.

Examples sense:correction:ckit:load "C:/Program Files/Keysight/Network
Analyzer/PnaCalKits/factory/wMyCalKits.wks"

Query Syntax Not Applicable

Default Not Applicable
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Sense:Correction:Collect:Ckit Commands

Use to change the definitions of calibration kit standards.

SENSe:CORRection:COLLect:CKIT:

       | CATalog?

       | CONNector

             | ADD

             | CATalog?

             | DELete

             | FNAMe

             | SNAMe

       | DESCription

       | INFormation?

       | NAME

       | OLAB

       | OLISt?

       | ORDer

       | PORT[:SELect]

       | RESet

       | SELect

       | STANdard

             | CO, C1, C2, C3

             | CHARacter

             | DELay

             | FMAXimum

             | FMINimum

             | IMPedance

             | LO, L1, L2, L3
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             | LABel

             | LOSS

             | REMove

             | SDEScription

             | [SELect]

             | TYPE

             | TZReal

             | TZImag

       | TRLoption

             | IMPedance

             | LRLChar

             | RPLane

 

Click on a keyword to view the command details.

Blue keywords are superseded commands.

Most of these commands act on the currently selected standard from the currently selected calibration

kit.

To select a Calibration kit, use SENS:CORR:COLL:CKIT:SEL.

To select a Calibration standard, use SENS:CORR:COLL:CKIT:STAN:SEL

See an example program that CREATES a New Cal Kit

See an example program that MODIFIES an Existing Cal Kit

Learn about Modifying Cal Kits

Synchronizing the Analyzer and Controller

SCPI Command Tree

Note: You should provide data for every definition field - for every standard in your calibration kit. If a
field is not set, the default value may not be what you expect.

For more information, read Specifying Calibration Standards and Kits for Keysight Vector Network Analyzers
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(Application Note 1287-11)

SENSe:CORRection:COLLect:CKIT:CATalog?

Applicable Models: All

(Read-only) Returns the names of the first 95 mechanical cal kits in your VNA that can be used for

unguided calibrations.  

Examples SENS:CORR:COLL:CKIT:CAT?

Return Type A comma-separated string

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:CONNector:ADD
<family>,<start>,<stop>,<z0>,<gender>,<media>,<cutoff>

Applicable Models: All

(Write only) Creates a new connector.  The connector is automatically added to the list of available

connectors for the currently selected cal kit.  If a connector includes both male and female connectors,

each connector must be added separately.

Parameters  

<family> (String) Name of connector family. Limited to 50 characters.

<start> Start frequency

<stop> Stop frequency

<z0> Characteristic Impedance of the connector in ohms.

<gender> Connector gender. Choose from:
MALE

FEMALE
NONE

<media> Media of the connector. Choose from:

COAX - coaxial

WAVE - waveguide

<cutoff> Cutoff frequency of the connector (waveguide only).

Examples SENS:CORR:COLL:CKIT:CONN:ADD "PSC 1.8 mm",0 HZ,999.9
GHZ,50,FEMALE,COAX,0.0
SENS:CORR:COLL:CKIT:CONN:ADD "PSC 1.8 mm",0 HZ,999.9
GHZ,50,MALE,COAX,0.0
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Query Syntax Not applicable

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:CONNector:CATalog?

Applicable Models: All

(Read-only) Returns a comma-separated list of all connectors defined within the currently selected cal

kit.  The returned string includes the connector family name followed by the connector gender, if any.

 Kits may include a primary connector family name and additional connector family names.

Connector family names are case sensitive.  A connector family named "PSC 2.4" is different from a

connector family named "psc 2.4".

Learn more about Connector Family Name.

Examples SENS:CORR:COLL:CKIT:CONN:CAT?

'Returned string

"Type-N (50) male, Type-N (50) female"

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:CONNector:DELete

Applicable Models: All

(Write-only) Deletes the primary connector family name from the selected kit.  The VNA allows

multiple connector families for each kit.  If a kit includes multiple connector families, only the first

listed (primary) connector family name is deleted.  

Once the connector family is deleted, the connector may not be assigned to any new or existing

standard within the kit.  

The previously defined standards retain their association to the deleted connector name. To reassign
standards to a new connector family name, use SENS:CORR:COLL:CKIT:CONN:SNAMe.

Examples SENS:CORR:COLL:CKIT:CONN:DEL

Query Syntax Not Applicable
Default Not Applicable

SENSe:CORRection:COLLect:CKIT:CONNector:FNAMe <name>
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Applicable Models: All

(Read-Write)  Replaces the primary connector family name from the selected kit with a new connector

family name.  The connector family name is replaced in all standards in the kit that share that name.

 The VNA allows multiple connector families for each kit.  If a kit includes multiple connector

families, only the first listed (primary) connector family name is replaced.  Use the query form of this

command to return the name of the primary connector family.

Parameters  

<name> New connector family name.  Limited to 50 characters.

Examples SENS:CORR:COLL:CKIT:CONN:FNAM 'MYPSC35'

Sense:correction:collect:ckit:connector:name 'My Type N'

Query Syntax SENSe:CORRection:COLLect:CKIT:CONNector:FNAMe?

Return Type String

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:CONNector:SNAMe <family>,<gender>,<port>

Applicable Models: All

(Read-Write)  Assigns a family name to the currently selected standard from the currently selected kit.

Specify each port of a 2-port standard individually. Use the query form of this command to read the

connector family name assigned to the current standard.  The name is not assigned unless the

connector family name is previously defined within the selected kit.

Parameters  

<family> String. Connector family name.

<gender> Connector gender. Choose from:

MALE

FEMALE

NONE

<port> Number of the connector port to be assigned the connector family name. 2-port

standards such as a thru line must be assigned separately. It is not relevant

which connector is port 1 or port 2.

1  Specifies a 1-port standard or the first port of a 2-port standard.

2  Specifies the second port of a 2-port standard.

Examples SENS:CORR:COLL:CKIT:CONN:SNAMe "Type-N (50)",MALE,1
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Query Syntax SENSe:CORRection:COLLect:CKIT:CONNector:SNAMe?

Return Type String

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:DESCription <string>

Applicable Models: All

(Read-Write) Modifies the cal kit description field of the selected kit. This description appears in the

Edit VNA Cal Kit dialog box.

Parameters  

<string> Description of the cal kit. Limited to 50 characters.

Examples SENS:CORR:COLL:CKIT:DESC "My New CalKit"

Query Syntax SENSe:CORRection:COLLect:CKIT:DESCription?

Return Type String

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:INFormation? <module>[,char]

Applicable Models: All

(Read Only)  Reads characterization information from an ECal module.

Parameters  

<module> Specifies which ECal module to read from.  Choose from:

ECAL1

.through.

ECAL50

[char]

 

Optional argument.

Specifies which characterization within the ECal module to read information

from.  If this argument is not used, the default is CHAR0.  CHAR1 through

CHAR5 are for user characterizations that may have been written to the

module by the User Characterization feature on the VNA.  Choose from:

CHAR0   Factory characterization (data that was stored in the ECal module by

1086



Keysight)

CHAR1   User characterization #1

CHAR2   User characterization #2

- through -

CHAR12   User characterization #12

Examples SENS:CORR:COLL:CKIT:INF? ECAL4
sense:correction:collect:ckit:information? ecal2,char1

  Example return string:

  ModelNumber: 85092-60007, SerialNumber: 01386, ConnectorType:
N5FN5F, PortAConnector: Type N (50) female, PortBConnector: Type
N (50) female, MinFreq: 30000, MaxFreq: 9100000000,
NumberOfPoints: 250, Calibrated: July 4 2002

Return Type Character

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:NAME <name>

Applicable Models: All

(Read-Write) Sets a name for the selected calibration kit.

Parameters  

<name> Calibration Kit name. Any string name, can include numerics, period, and

spaces; any length (although the dialog box display is limited to about 30

characters).

Examples SENS:CORR:COLL:CKIT:NAME 'MYAPC35'
sense:correction:collect:ckit:name 'mytypen'

Query Syntax SENSe:CORRection:COLLect:CKIT:NAME?

Return Type String

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:OLABel<class> <name>
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Applicable Models: All

(Read-Write) Sets the label for the calibration class designated by <class>.  The label is used in the

prompts for connecting the calibration standards associated with that <class>.

Parameters  

<class> Number of the calibration class. Choose a number between:  1 and 18.  The

<class> numbers are associated with the following calibration Classes:

  Class Description

Port 1    

1 SA Reflection standard

2 SB Reflection standard

3 SC Reflection standard

4 FWD TRANS Thru/Delay standard

Port 2    

5 SA Reflection standard

6 SB Reflection standard

7 SC Reflection standard

8 REV TRANS Thru/Delay standard

3-port analyzers only

Port 3    

9 S33A Reflection standard

10 S33B Reflection standard

11 S33C Reflection standard

12 S32T Thru/Delay standard

13 S23T Thru/Delay standard

14 S31T Thru/Delay standard

15 S13T Thru/Delay standard

TRL Calibrations

16 TRL "T" Thru standard

17 TRL "R" Reflect standard

18 TRL "L" Line standard
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<name> Label for the calibration class.  Must be enclosed in quotes.  Any string

between 1 and 12 characters long.  Cannot begin with a numeric.

Examples SENS:CORR:COLL:CKIT:OLAB3 'LOADS'

sense:correction:collect:ckit:olabel4 'Thru'

Return Type String

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:OLISt[class]?

Applicable Models: All

(Read-only) Returns seven values of standards that are assigned to the specified class.

This command ALWAYS applies to the Cal Kit that is selected (using SENS:CORR:COLL:CKIT:SEL)

when this ORDer command is sent.

Parameters  

<class> Number of the calibration class to be queried. The <class> numbers are

associated with the following calibration Classes:

  Class Description

Port 1    

1 SA Reflection standard

2 SB Reflection standard

3 SC Reflection standard

4 FWD TRANS Thru/Delay standard

Port 2    

5 SA Reflection standard

6 SB Reflection standard

7 SC Reflection standard

8 REV TRANS Thru/Delay standard

3-port analyzers ONLY (N3381A/2A/3A)

4-port analyzers use S11 and S22 classes (see example program)

Port 3    

9 S33A Reflection standard

10 S33B Reflection standard

11 S33C Reflection standard
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12 S32T Thru/Delay standard

13 S23T Thru/Delay standard

14 S31T Thru/Delay standard

15 S13T Thru/Delay standard

TRL Calibration

16 TRL "T" Thru standard

17 TRL "R" Reflect standard

18 TRL "L" Line standard

Examples SENS:CORR:COLL:CKIT:OLIS8?

Always returns 7 standard numbers. Unassigned standards return 0

Return Type Numeric; returns the <class> number of the selected standard.

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:ORDer<class> <std> [,<std>] [,<std>] [,<std>] [,<std>]
[,<std>] [,<std>]

Applicable Models: All

(Read-Write) Sets a standard number to a calibration class. This command does NOT set or dictate

the order for measuring the standards. For more information, see Assigning Standards to a Calibration

Class.

This command ALWAYS applies to the Cal Kit that is selected (using SENS:CORR:COLL:CKIT:SEL)

when this ORDer command is sent.

Parameters  

<class> Number of the calibration class that is assigned to <standard>. Choose a

number between: 1 and 18.  The <class> numbers are associated with the
following calibration Classes:
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  Class Description STAN#

Port 1      

1 SA Reflection standard STAN1

2 SB Reflection standard STAN2

3 SC Reflection standard STAN3

4 FWD TRANS Thru/Delay standard STAN4

Port 2      

5 SA Reflection standard STAN1

6 SB Reflection standard STAN2

7 SC Reflection standard STAN3

8 REV TRANS Thru/Delay standard STAN4

3-port analyzers ONLY (N3381A/2A/3A)

4-port analyzers use S11 and S22 classes (see example program)

Port 3      

9 S33A Reflection standard STAN1

10 S33B Reflection standard STAN2

11 S33C Reflection standard STAN3

12 S32T Thru/Delay standard STAN4

13 S23T Thru/Delay standard STAN4

14 S31T Thru/Delay standard STAN4

15 S13T Thru/Delay standard STAN4

TRL Calibration

16 TRL "T" Thru standard STAN4

17 TRL "R" Reflect standard STAN1

18 TRL "L" Line standard STAN3
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<std> Standard number to be assigned to the class; Choose a standard between 1 and

30. One standard is mandatory; up to six additional standards are optional.

Examples 'Assigns standard 3 to S11A class:
SENS:CORR:COLL:CKIT:ORD1 3

'Assigns standard 2 and 5 to S21T class class:
sense:correction:collect:ckit:order4 2,5

Query Syntax SENSe:CORRection:COLLect:CKIT:ORDer<class>?

'Returns only the first standard assigned to the specified class. To
query the remaining standards, use
SENSe:CORRection:COLLect:CKIT:OLIST[1-15]?

Return Type Numeric

Default Not Applicable

SENSe<cnum>:CORRection:COLLect:CKIT:PORT<n>[:SELect] <string>

Applicable Models: All

(Read-Write)  Sets and returns the name of the Cal Kit to use for Unguided cal.

This command effectively does the same task as SENS:CORR:COLL:CKIT but specifies the cal kit by

name.

Note:  During an Unguided cal, you can access ONLY mechanical cal kits #1 through #95. However,

there is no limit to the number of cal kits that can be imported.

Parameters  

<cnum> Currently not used. The unguided cal kit selection is for all ports on all

channels.

<n> Currently not used. The unguided cal kit selection is for all ports on all

channels.

<string>

 

Cal Kit name enclosed in quotes. Use SENS:CORR:COLL:CKIT:CAT? to read a list

of all available Cal Kits in the VNA.

Examples SENS:CORR:COLL:CKIT:PORT "85052B"
sense2:correction:collect:ckit:port:select "85052D"

Query Syntax SENSe<cnum>:CORRection:COLLect:CKIT:PORT<n>:SELECT?

Return Type String

Default Last kit selected
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SENSe:CORRection:COLLect:CKIT:RESet <num> - Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

This command is replaced by Sens:Corr:Ckit:Init.

(Write-only) Resets the selected calibration kit to factory default definition values.

Parameters  

<num> The number of the calibration kit to be reset. Choose any integer between:

1 and 8

Examples SENS:CORR:COLL:CKIT:RESet 1
sense:correction:collect:ckit:reset 4

Query Syntax Not Applicable

Default Not Applicable

SENSe<cnum>:CORRection:COLLect:CKIT[:SELect] <num>

Applicable Models: All

(Read-Write)  Selects (makes active) a calibration kit for performing an UNGUIDED calibration or

for modifying standards. All subsequent "CKIT" commands that are sent apply to this selected

calibration kit. Select a calibration standard using SENS:CORR:COLL:CKIT:STAN <num>. Kits 1 to

approximately kit 37 are factory installed Cal Kits.

Note:  During an Unguided cal, you can access ONLY mechanical cal kits #1 through #95. However,

there is no limit to the number of cal kits that can be imported.

This command effectively does the same task as SENS:CORR:COLL:CKIT:PORT which specifies the cal

kit by name instead of this command which specifies by number.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<num> The number of the calibration kit. Choose from:

Use SENSe:CORRection:COLLect:CKIT:RESet to restore Cal Kits to default

values.

  Name

1 Cal Kit 1

2 Cal Kit 2

3 Cal Kit 3
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           ''

           ''

94 Cal Kit 94

95 Cal Kit 95

99 ECal module

Note: Always check the list of available cal kits using

SENSe:CORRection:COLLect:CKIT:CATalog? to ensure that the correct cal kit is

selected.

Examples SENS:CORR:COLL:CKIT 2
sense2:correction:collect:ckit:select 7

Query Syntax SENSe<cnum>:CORRection:COLLect:CKIT?

Return Type Numeric

Default Last kit selected

SENSe:CORRection:COLLect:CKIT:STANdard:C0 <num>

Applicable Models: All

(Read-Write) Sets the C0 value (the first capacitance value) for the selected standard. For a detailed

discussion of this value, search for App Note 8510-5B at www.Keysight.com.

Parameters  

<num> Value for C0 in femtofarads (1E-15)

Examples The following commands set C0=15 femtofarads:

SENS:CORR:COLL:CKIT:STAN:C0 15
sense:correction:collect:ckit:standard:c0 15

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:C0?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:C1 <num>
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Applicable Models: All

(Read-Write) Sets the C1 value (the second capacitance value) for the selected standard. For a detailed

discussion of this value, search for App Note 8510-5B at www.Keysight.com.

Parameters  

<num> Value for C1.

Examples The following two commands set C1=15:

SENS:CORR:COLL:CKIT:STAN:C1 15
sense:correction:collect:ckit:standard:c1 15

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:C1?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:C2 <num>

Applicable Models: All

(Read-Write) Sets the C2 value (the third capacitance value) for the selected standard. For a detailed

discussion of this value, search for App Note 8510-5B at www.Keysight.com.

Parameters  

<num> Value for C2.

Examples The following two commands set C2:

SENS:CORR:COLL:CKIT:STAN:C2 15
sense:correction:collect:ckit:standard:c2 15

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:C2?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:C3 <num>
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Applicable Models: All

(Read-Write) Sets the C3 value (the fourth capacitance value) for the selected standard. For a detailed

discussion of this value, search for App Note 8510-5B at www.Keysight.com.

Parameters  

<num> Value for C3.

Examples The following two commands set C3

SENS:CORR:COLL:CKIT:STAN:C3 15
sense:correction:collect:ckit:standard:c3 15

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:C3?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:CHARacter <char>

Applicable Models: All

(Read-Write) Sets the media type of the selected calibration standard.

Parameters  

<char> Media type of the standard. Choose from:

Coax - Coaxial Cable

Wave - Waveguide

Examples SENS:CORR:COLL:CKIT:STAN:CHAR COAX
sense:correction:collect:ckit:standard:character wave

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:CHARacter?

Return Type Numeric

Default Coax

SENSe:CORRection:COLLect:CKIT:STANdard:DELay <num>
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Applicable Models: All

(Read-Write) Sets the electrical delay value for the selected standard.

Parameters  

<num> Electrical delay in picoseconds

Examples The following two commands set delay to 50 picoseconds

SENS:CORR:COLL:CKIT:STAN:DEL 50e-12
sense2:correction:collect:ckit:standard:delay 50ps

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:DELay?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:FMAXimum <num>

Applicable Models: All

(Read-Write) Sets the maximum frequency for the selected standard.

Parameters  

<num> Maximum frequency in Hertz.

Examples SENS:CORR:COLL:CKIT:STAN:FMAX 9e9
sense:correction:collect:ckit:standard:fmaximum 9Ghz

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:FMAXimum?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:FMINimum <num>
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Applicable Models: All

(Read-Write) Sets the minimum frequency for the selected standard.

Parameters  

<num> Minimum frequency in Hertz.

Examples SENS:CORR:COLL:CKIT:STAN:FMIN 1e3
sense:correction:collect:ckit:standard:fminimum 1khz

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:FMINimum?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:IMPedance <num>

Applicable Models: All

(Read-Write) Sets the characteristic impedance for the selected standard.

Parameters  

<num> Impedance in Ohms

Examples SENS:CORR:COLL:CKIT:STAN:IMP 75
sense:correction:collect:ckit:standard:impedance 50.3

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:IMPedance?

Return Type Numeric

Default 50

SENSe:CORRection:COLLect:CKIT:STANdard:L0 <num>
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Applicable Models: All

(Read-Write) Sets the L0 value (the first inductance value) for the selected standard. For a detailed

discussion of this value, search for App Note 8510-5B at www.Keysight.com.

Parameters  

<num> Value for L0 in femtohenries (1E-15)

Examples The following two commands set L0=15  femtohenries:

SENS:CORR:COLL:CKIT:STAN:L0 15
sense:correction:collect:ckit:standard:l0 15

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:L0?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:L1 <num>

Applicable Models: All

(Read-Write) Sets the L1 value (the second inductance value) for the selected standard. For a detailed

discussion of this value, search for App Note 8510-5B at www.Keysight.com.

Parameters  

<num> Value for L1.

Examples The following two commands set L1=15:

SENS:CORR:COLL:CKIT:STAN:L1 15
sense:correction:collect:ckit:standard:l1 15

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:L1?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:L2 <num>
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Applicable Models: All

(Read-Write) Sets the L2 value (the third inductance value) for the selected standard. For a detailed

discussion of this value, search for App Note 8510-5B at www.Keysight.com.

Parameters  

<num> Value for L2.

Examples The following two commands set L2=15:

SENS:CORR:COLL:CKIT:STAN:L2 15
sense:correction:collect:ckit:standard:l2 15

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:L2?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:L3 <num>

Applicable Models: All

(Read-Write) Sets the L3 value (the fourth inductance value) for the selected standard. For a detailed

discussion of this value, search for App Note 8510-5B at www.Keysight.com.

Parameters  

<num> Value for L3.

Examples The following two commands set L3=15:

SENS:CORR:COLL:CKIT:STAN:L3 15
sense:correction:collect:ckit:standard:l3 15

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:L3?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:LABel <name>
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Applicable Models: All

(Read-Write) Sets the label for the selected standard. The label is used to prompt the user to connect

the specified standard.

Parameters  

<name> Label for the standard; Must be enclosed in quotes. Any string between 1 and

12 characters long. Cannot begin with a numeric.

Examples SENS:CORR:COLL:CKIT:STAN:LAB 'OPEN'
sense:correction:collect:ckit:standard:label 'Short2'

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:LABel?

Return Type String

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:LOSS <num>

Applicable Models: All

(Read-Write) Sets the insertion loss for the selected standard.

Parameters  

<num> Insertion loss in Gohms / sec. (GigaOhms per second of electrical delay)

Examples SENS:CORR:COLL:CKIT:STAN:LOSS 3.5e9
sense:correction:collect:ckit:standard:loss 3

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:LOSS?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:REMove

Applicable Models: All

(Write only) Deletes the selected standard from the selected cal kit.

Examples SENS:CORR:COLL:CKIT:STAN:REMove

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:SDEScription <string>
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Applicable Models: All

(Read-Write) Modifies the description of the selected standard of the selected kit. This description

appears in the edit kit dialog box.

Parameters  

<string> Description of the standard.

Examples SENS:CORR:COLL:CKIT:STAN:SDES "My New Standard"

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:SDEScription?

Return Type String

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard[:SELECT] <num>

Applicable Models: All

(Read-Write) Selects the calibration standard. All subsequent "CKIT" commands to modify a standard

will apply to the selected standard. Select a calibration kit using SENS:CORR:COLL:CKIT:SEL

Parameters  

<num> Number of the standard. Choose any number between:

1 and 30

Examples SENS:CORR:COLL:CKIT:STAN 3
sense:correction:collect:ckit:standard:select 8

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard[:SELect]?

Return Type Numeric

Default 1

SENSe:CORRection:COLLect:CKIT:STANdard:TYPE <char>
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Applicable Models: All

(Read-Write) Sets the type for the selected standard.

Parameters  

<char> Choose from:

OPEN

SHORT

LOAD

SLOAD (sliding load)

THRU (through)

ARBI (arbitrary)

DATabased (data-based)

Examples SENS:CORR:COLL:CKIT:STAN:TYPE LOAD
sense:correction:collect:ckit:standard:type short

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:TYPE?

Return Type Character

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:STANdard:TZReal <num>

Applicable Models: All

(Read-Write) Sets the TZReal component value of the Terminal Impedance for the selected standard.

Note: Only applicable when the Standard Type is set to ARBI

Parameters  

<num> Value for TZReal in Ohms

Examples The following commands set TZReal=15 Ohms:

SENS:CORR:COLL:CKIT:STAN:TZReal 15
sense:correction:collect:ckit:standard:TZReal 15

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:TZReal?

Return Type Numeric

Default Not Applicable

1103



SENSe:CORRection:COLLect:CKIT:STANdard:TZImag <num>

Applicable Models: All

(Read-Write) Sets the TZImag component value of the Terminal Impedance for the selected standard.

Note: Only applicable when the Standard Type is set to ARBI

Parameters  

<num> Value for TZImag in Ohms

Examples The following two commands set TZImag=15 Ohms:

SENS:CORR:COLL:CKIT:STAN:TZImag 15
sense:correction:collect:ckit:standard:TZImag 15

Query Syntax SENSe:CORRection:COLLect:CKIT:STANdard:TZImag?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance <char>

Applicable Models: All

(Read-Write) Sets the reference impedance when using this TRL cal kit. Learn more.

Before sending this command, select a cal kit using SENS:CORR:COLL:CKIT:SELect.

Parameters  

<char> Choose from:

SYSTem - The system impedance is used as the reference impedance. During a

Guided or Unguided Cal, the Z0 of the Cal standard's connector definition sets

the System Z0.

Make this selection when the desired test port impedance differs from the
impedance of the LINE standard. Also, make this selection when skin effect

impedance correction is desired for coax lines.

LINE  The impedance of the line standard is used as the reference impedance,

or center of the Smith Chart. Any reflection from the line standard is assumed

to be part of the directivity error.

Examples SENS:CORR:COLL:CKIT:TRL:IMP SYST

sense:correction:collect:ckit:trloption:impedance line

1104



Query Syntax SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance?

Return Type Character

Default LINE

SENSe:CORRection:COLLect:CKIT:TRLoption:LRLChar <bool>

 Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write)  This setting ONLY applies if an LRL Cal Kit is being modified AND Testport

Reference Plane is set to THRU AND the TRL Thru class standard and the TRL Line/Match class

standard both have the same values for Offset Z0 and Loss. Otherwise, this setting is ignored.

Before sending this command, select a cal kit using SENS:CORR:COLL:CKIT:SELect.

Parameters  

<bool> Choose from:

1 or ON - Automatically correct for line loss and dispersion characteristics.

0 or OFF - Select when anomalies appear during a calibrated measurement

which may indicate different loss and impedance values for the Line standards.

Examples SENS:CORR:COLL:CKIT:TRL:LRLC 1

sense:correction:collect:ckit:trloption:lrlchar off

Query Syntax SENSe:CORRection:COLLect:CKIT:TRLoption:LRLChar?

Return Type Boolean
Default OFF

SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane <char>
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Applicable Models: All

(Read-Write) Sets the reference impedance when using this cal kit. Learn more.

Before sending this command, select a cal kit using SENS:CORR:COLL:CKIT:SELect.

Parameters  

<char> Choose from:

THRU  The THRU standard definition is used to establish the measurement

reference plane. Select if the THRU standard is zero-length or very short.

REFLect  The REFLECT standard definition is used to establish the position

of the measurement reference plane. Select if the THRU standard is not

appropriate AND the delay of the REFLECT standard is well defined.  Also,

select If a flush short is used for the REFLECT standard because a flush short

provides a more accurate phase reference than a Thru standard.

Examples SENS:CORR:COLL:CKIT:TRL:RPL THRU

sense:correction:collect:ckit:trloption:rplane reflect

Query Syntax SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane?

Return Type Character

Default THRU
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Sense:Correction:Cset Commands

Performs actions on calibration sets.  

SENSe:CORRection:CSET

ACTivate

CATalog?

COPY

CREate

     | DEFault

DATA

DEACtivate

DELete

DESCription

ETERm

     | CATalog?

     | [DATA]

FLATten

GENerate

     | RECeiver

GUID

ITEM

     | CAT?

     | [:DATA]?

NAME

SAVE

[SELect]
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STANdard

STIMulus?

TSET

     | ALLPorts?

     | TYPE?

TYPE

     | CATalog?

Click on a keyword to view the command details.

Blue keywords are superseded commands. Learn more.

See Also

Creating Cal Sets

Example Programs

Learn about Cal Sets

Synchronizing the Analyzer and Controller

SENSe<cnum>:CORRection:CSET:ACTivate <string>, <bool>

Applicable Models: All

This command replaces SENS:CORR:CSET:GUID

(Read-Write) Selects and applies a Cal Set to the specified channel.

Use SENS:CORR:CSET:CAT? to list the Cal Sets.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<string> Cal Set to make active. Specify the Cal Set by GUID or Name. Use

SENS:CORR:CSET:CAT? to list the available Cal Sets in either format.

<bool> Should the Cal Set stimulus values be applied to the channel. Choose from:

ON (1)   Apply the Cal Set stimulus values to the channel.
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OFF (0)  Do NOT apply the Cal Set stimulus values. If the Cal Set stimulus

values do not match the channel stimulus values, then the following will occur:

If interpolation is ON, then interpolation will be attempted. This may fail if the
channel frequency is outside the range of the Cal Set.

If interpolation is OFF, the selection will be abandoned and an error is returned:

Examples SENS:CORR:CSET:ACT "My2Port",1

sense:correction:cset:activate? name
'returns
"My2Port"

Query Syntax SENSe<cnum>:CORRection:CSET:ACTivate? [GUID|NAME]

Returns the name of the Cal Set that is applied to the specified channel. Choose

from GUID or NAME to specify which string is returned. If unspecified, the

GUID of the Cal Set is returned. If no Cal Set is applied to the specified

channel, then "No Calset Selected" is returned.

Return Type String

Default Not Applicable

SENSe:CORRection:CSET:CATalog? [char] - Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

This command is replaced by CSET:CAT?

(Read-only) Returns a list of Cal Sets.

Parameters  

<char> Optional argument. The list is returned in one of the following formats. Both

return comma-separated string lists.

GUID  Cal Sets are listed by GUID (Default if unspecified).

NAME  Cal Sets are listed by Name

Examples SENS:CORR:CSET:CAT?

'Returns:
{FD6F863E-9719-11d5-8D6C-00108334AE96},{1B03B2CE-971A-11d5-8D6C-
00108334AE96}

sense2:correction:cset:catalog? name
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Default Not Applicable

SENSe<cnum>:CORRection:CSET:COPY <string>

Applicable Models: All

(Write-only) Creates a new Cal Set and copies the current Cal Set data into it.  Use this command to

manipulate data on a Cal Set without corrupting the original cal data.

Parameters  

<cnum> Channel number using the Cal Set to be copied. If unspecified, value is set to 1

<string> Name of the new Cal Set.

Examples SENS2:CORR:CSET:COPY 'My2Port'

Query Syntax Not Applicable
Default Not Applicable

SENSe<cnum>:CORRection:CSET:CREate [name]

Applicable Models: All

(Write-only) Creates an empty Cal Set and attaches it to the specified channel. This command is

ONLY necessary before remotely filling the Cal Set with error term data. (For Advanced Users).

A Cal Set is automatically created, applied to the channel, and saved at the completion of a guided cal

according to the preference setting SENS:CORR:PREF:CSET:SAVE.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

[name] Optional argument. Name of the Cal Set. Spaces or punctuation are NOT

allowed. If unspecified, a unique name is chosen in the form "Calset_N" where

N is a unique number.

Examples SENS:CORR:CSET:CRE 'My2Port'

Query Syntax Not Applicable
Default Not Applicable

SENSe<cnum>:CORRection:CSET:CREate:DEFault [<csetname>], [<correctiontype>]
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Creates a unity Cal Set useful for debugging or to quickly test a prototype of automation

software.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

[<csetname>] Optional argument. Name of the Cal Set. Spaces or punctuation are NOT

allowed. If unspecified, a unique name is chosen in the form "Calset_N" where

N is a unique number.

[<correctiontype>] Optional argument. Specifies the correction type to use as the default. Use the

SENSe:CORRection:TYPE:CATalog? command for a list of correction types.

Examples 'This example applies 2-port error correction as if the system
were perfect.
'All error terms will be 1 or 0.
SENS:CORR:CSET:CRE:DEF 'My2Port', 'Full 2 Port(1,2)'

Query Syntax Not Applicable
Default Not Applicable

SENSe<cnum>:CORRection:CSET:DATA <eterm, portA, portB,>[<rec>,] <block>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write)  Read or Write a specific error term from/to the Cal Set currently attached to the

specified channel. (For Advanced Users).  The command can be used only for the error terms listed.

See SENS:CORR:CSET:ETERM to get and put error term data using a string argument for all error

terms.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<eterm, portA,
portB>

Error Term, Port pair of the specified error term.

Although not all error terms use two port numbers, two are required by the

VNA in all cases. Each port number must be between 1 and the number of

ports on the VNA.

EDIR -  directivity

portA: the port at which directivity is measured.

portB: Not used, but must be a valid VNA port number.
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  ESRM - source match

portA: the port at which source match is measured.

portB: Not used, but must be a valid VNA port number.

  ERFT - reflection tracking

portA: the port at which reflection tracking is measured.

portB: Not used, but must be a valid VNA port number.

  ELDM - load match

portA: the port at which load match is measured.

portB: the source port.

Load match is measured with a cable connected between the measured port

(portA) and the source port (portB).

The cal system requires that the complete matrix of loadmatch arrays be filled.

 In most cases you can measure loadmatch once at a port, driven by any other

port.  Then use that data for all variations of the receive port. (The exception is

the 3-port VNA models, which requires the loadmatch-measured port to be

driven by every other port.)

For example: Measure the loadmatch at port2 while driving port1. Then upload

this same data to the following arrays:

        ELDM,2,1,<data>

        ELDM,2,3,<data>

        ELDM,2,4,<data>

  ETRT -  transmission tracking

portA: the receive port

portB: the source port for this measurement

  EXTLK - crosstalk

portA: the receive port

portB: the source port for this measurement
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  ERSPT - response tracking.

portA: Not used, but must be a valid VNA port number.

portB: Not used, but must be a valid VNA port number.

  ERSPI - response isolation.

portA: Not used, but must be a valid VNA port number.

portB: Not used, but must be a valid VNA port number.

<rec> <string> - Specify the VNA receiver for which the Eterm applies.

Required ONLY when Eterm is response tracking (ERSPT) or response

isolation (ERSPI).

Logical receiver notation is allowed.

  A full 4-port calibration requires the following terms be uploaded:

    PORT B

    1 2 3 4

P

O

R

T

 

A

1

EDIR,1,1

ERFT,1,1

ESRM,1,1

ELDM,1,2

ETRT,1,2

EXTLK,1,2

ELDM,1,3

ETRT,1,3

EXTLK,1,3

ELDM,1,4

ETRT,1,4

EXTLK,1,4

2

ELDM,2,1

ETRT,2,1

EXTLK,2,1

EDIR,2,2

ERFT,2,2

ESRM,2,2

ELDM,2,3

ETRT,2,3

EXTLK,2,3

ELDM,2,4

ETRT,2,4

EXTLK,2,4

3

ELDM,3,1

ETRT,3,1

EXTLK,3,1

ELDM,3,2

ETRT,3,2

EXTLK,3,2

EDIR,3,3

ERFT,3,3

ESRM,3,3

ELDM,3,4

ETRT,3,4

EXTLK,3,4

4

ELDM,4,1

ETRT,4,1

EXTLK,4,1

ELDM,4,2

ETRT,4,2

EXTLK,4,2

ELDM,4,3

ETRT,4,3

EXTLK,4,3

EDIR,4,4

ERFT,4,4

ESRM,4,4

Reflection terms

Transmission terms
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<block> (Block). Error term data. A Real / Imaginary data pair for each data point.

Format is set using FORM:DATA command.

For REAL binary formats, refer to Getting Data from the Analyzer using SCPI

Example 'Set the directivity term with a cal set using 5 points

SENS1:CORR:CSET:DATA EDIR, 1, 1, +6.12569600000E-002,-
7.27163800000E-003,-3.63812000000E-003,+1.33521800000E-002,-
4.36775100000E-003,+1.87792400000E-002,-4.09239100000E-
003,+4.24291200000E-002,-2.03784900000E-002,+3.21425100000E-002"

Query Syntax SENSe<cnum>:CORRection:CSET:DATA? <eterm,portA,
portB>,<rec>

Query Examples 'Read the response isolation eterms for the port 1 reference
receiver

sens:corr:cset:data? ERSPI,1,1,’R1’

'Same receiver using logical receiver notation

sens:corr:cset:data? ERSPI,1,1,’a1’

Return Type Block data

Default Not Applicable

SENSe<cnum>:CORRection:CSET:DEACtivate

Applicable Models: All

(Write-only) Unselects a Cal Set from the specified channel.

Parameters  

<cnum> Channel number to have Cal Set unselected.

Examples SENS:CORR:CSET:DEAC

sense2:correction:cset:deactivate

Query Syntax Not Applicable
Default Not Applicable

SENSe:CORRection:CSET:DELete <string> - Superseded
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Applicable Models: N522xB, N523xB, N524xB, M937xA

This command is replaced by CSET:DEL.

(Write-only)Deletes a Cal Set from the set of available Cal Sets.  This method immediately updates

the Cal Set file on the hard drive. If the Cal Set is currently being used by a channel or does not exist,

this request will be denied and an error is returned.

Parameters  

<string> Cal Set to be deleted. Specify the Cal Set by GUID or Name. Use

SENS:CORR:CSET:CAT? to list the available Cal Sets in either format.

Examples SENS:CORR:CSET:DEL '{2B893E7A-971A-11d5-8D6C-00108334AE96}'
sense2:correction:cset:delete 'MyCalSet'

Query Syntax Not Applicable
Default Not Applicable

SENSe<cnum>:CORRection:CSET:DESCription <string>

Applicable Models: All

(Read-Write) Sets or returns the descriptive string assigned to the selected Cal Set. Change this string

so that you can easily identify each Cal Set. Apply and select the Cal Set using SENS:CORR:CSET:ACT.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<string> The descriptive string associated with the currently-selected Cal Set

Examples SENS:CORR:CSET:DESC 'MyCalSet'
sense2:correction:cset:description 'thisCalSet'

Query Syntax SENSe<cnum>:CORRection:CSET:DESCription?

Return Type String

Default Not Applicable

SENSe<cnum>:CORRection:CSET:ETERm[:DATA] <string>,<data>
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Applicable Models: All

(Read-Write) Sets or returns error term data for all VNA measurements.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<string> (String) Error term to read or write. The error term is specified using the

EXACT case-sensitive string displayed in the Cal Set Viewer utility.  See

SENS:CORR:CSET:DATA for a description of port numbers.

The following Noise figure error terms are listed for convenience:

RcvNoiseCorr_m_n  Noise correlation matrix of the noise receiver (a 2x2
complex matrix). The row and column indices m and n range from 1 to 2.

RcvT_m_n   T-matrix of the noise receiver (a 2x2 complex matrix). The row and
column indices m and n range from 1 to 2.

GammaTuner_n  Reflection coefficient for impedance state n of the embedded
noise tuner (Ecal module) in the port 1 source path. For the Keysight 4691 family
of Ecal modules, n can range from 1 to 7.

<data> (Block) Error term data. A Real / Imaginary data pair for each data point.

Format is set using FORM:DATA command.

For REAL binary formats, refer to Getting Data from the Analyzer using SCPI

Examples SENS:CORR:CSET:ETERM "Directivity(1,1)", 0.237,-1.422, 0.513,
0.895  ' set directivity(source error term for 2 points
SENS:CORR:CSET:ETERM? "Directivity(1,1)"  'read

Query Syntax SENSe<cnum>:CORRection:CSET:ETERm[:DATA]? <string>

Return Type Block data

Default Not Applicable

SENSe<cnum>:CORRection:CSET:ETERm:CATalog?
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Applicable Models: All

(Read-only) Returns a list of error term names found in the current Cal Set that is applied to the

specified channel.

Parameters  

Examples SENS:CORR:CSET:ETER:CAT?

'For a 1-port cal, returns

"Directivity(1,1),ReflectionTracking(1,1),SourceMatch(1,1)"

Return Type String

Default Not Applicable

SENSe<cnum>:CORRection:CSET:FLATten <string>

Applicable Models: All

(Write-only)  When a Cal Set that was produced by a calibration has been interpolated or otherwise

modified (for example, by Fixturing operations) this command saves the modified Cal Set to the VNA

hard drive so that it can be reused. There is no User Interface equivalent for this command.

Background

When a Cal Set is selected for use by a channel, the channel reads the Cal Set from disk (master Cal

Set). If the channel aligns perfectly with the Cal Set, the master Cal Set is used directly. In this case,

the active Cal Set is the master Cal Set.

When processing occurs on the error terms due to interpolation or modification due to the use of

fixturing, the channel will generate a temporary "memory-resident" Cal Set.  In this case, the active

Cal Set is the memory-resident Cal Set. This FLATten command allows you to save the active Cal Set
to disk.

Depending on the measurement conditions, this flattening of the Cal Set can improve performance,

especially if the Cal Set is applied often (using multiple recall states) or used by many channels.

 Flattening a version of the Cal Set for each channel can avoid the interpolation or the fixturing

processing that would otherwise occur when the Cal Set is selected or the instrument state is recalled.

 

You will have to manage the application of such a Cal Set as the VNA itself will have no way to
determine what processing had been done once the flatten command is used.  For example, if fixture

de-embedding occurred prior to the flatten command, that Cal Set should then be applied WITHOUT
fixturing on, because fixturing is already embedded in that Cal Set.  It is your responsibility to apply

1117



the Cal Set properly.

If you want to repeatedly de-embed multiple networks (i.e. concatenate multiple 2-port de-embedding

files) you can use the flatten command to create a new master Cal Set after each de-embed, and

sequentially add additional de-embed networks.

Parameters  

<cnum> Channel number on which the modified Cal Set resides. If unspecified, value is

set to 1

<string> Name of the new Cal Set. Spaces or punctuation NOT allowed.

Examples SENS:CORR:CSET:FLAT "MyCalSet"

Query Syntax Not Applicable

Default Not Applicable

SENSe<cnum>:CORRection:CSET:GENerate:RECeiver <receiverName>

Applicable Models: M937xA

This command converts the selected Cal Set from an S-parameter Cal Set to an S-parameter+Power

Cal Set. This command requires a Cal Set to be selected.

There are 2 modes for using this command:

Mode 1:

The <receiverName> is optional. If not specified, then ResponseTracking(a1) is set to 0,
and the rest of ResponseTracking() terms are computed to be consistent with the S-
parameter calibration terms.

Mode 2:

Use this pattern when there is already a receiver calibration for one of the receivers. In that
case, this command can be used to transfer the receiver calibration to the other receivers.

If <receiverName> is specified, it must be either 'a1','a2','a3', etc or 'b1','b2','b3'. The
ResponseTracking term for this receiver must already be added to the Cal Set, or else this
command will generate an error. This command will then compute the ResponseTracking()
terms for all of the other receivers in a manner consistent with the S-parameter calibration
terms.

Parameters  

<cnum> Channel number on which the modified Cal Set resides. If unspecified, value is

set to 1.
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<receiverName> Name of the receiver ('a1', 'a2', 'a3', etc., or 'b1', 'b2', 'b3', etc.)

Examples SENS:CORR:CSET:GEN:REC 'a1'

Query Syntax SENSe<cnum>:CORRection:CSET:GENerate:RECeiver?

Default Not Applicable

SENSe<cnum>:CORRection:CSET:GUID <string>  Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

This command is replaced by SENS:CORR:CSET:ACTivate.

(Read-Write) Selects the Cal Set identified by the string parameter (GUID) and applies it to the

specified channel.

A Cal Set cannot be selected for a channel which is not ON.

If the stimulus settings of the selected Cal Set differ from those of the selected channel, the instrument will
automatically change the channel's settings to match the Cal Set.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<string> GUID of the desired Cal Set. The curly brackets and hyphens must be included.

Examples SENS:CORR:CSET:GUID '{2B893E7A-971A-11d5-8D6C-00108334AE96}'
sense2:correction:cset:guid '{2B893E7A-971A-11d5-8D6C-
00108334AE96}'

Query Syntax SENSe<cnum>:CORRection:CSET:GUID?

Returns the GUID of the currently-selected Cal Set for the specified
channel.

Return Type String

Default Not Applicable

SENSe<cnum>:CORRection:CSET:ITEM:CATalog?
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns a list of all name-value pairs (items) in the Cal Set.

Parameters  

Examples SENS:CORR:CSET:ITEM:CAT?

Return Type String

Default Not Applicable

SENSe<cnum>:CORRection:CSET:ITEM[:DATA] <string>,<data>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Add or change a name-value pair in the Cal Set, or read the value associated with a

name.

After editing, Save the CalSet to the VNA.

About Name-Value pairs

A Cal Set name-value pair is a general purpose data structure that maps a name to a value. This

command allows you to associate a name with a value. Then, using this same command, you can read

the value using the name.

For example, one of the items added by the VNA firmware to every Cal Set is named  'Created By'.

The value attached to this item is the name of the VNA App that created the Cal Set. When an SMC

cal is performed, you can query the Cal Set for the 'Create By' item, and it will return 'Scalar

Mixer/Converter'. The same query on an NFx channel returns 'Noise Figure Converters'.

Warning - Do NOT change the name or value of any Items that you did NOT create. Otherwise, the

VNA firmware may behave unpredictably.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<string> (String) Name of the name-value pair.

<data> (Variant) - Can be an integer, float, double, string, or a single-dimensioned
array of integer, float, double, string.

Examples SENS:CORR:CSET:ITEM

Query Syntax SENSe<cnum>:CORRection:CSET:ITEM[:DATA]? <string>

Return Type Variant
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Default Not Applicable

SENSe<cnum>:CORRection:CSET:NAME <string>

Applicable Models: All

(Read-Write) Sets or queries the name of the Cal Set currently applied to the specified channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<string> Name of the Cal Set. Spaces or punctuation NOT allowed.

Examples SENS:CORR:CSET:NAME 'MyCalSet'
sense2:correction:cset:name 'thisCalSet'

Query Syntax SENSe<cnum>:CORRection:CSET:NAME?

Return Type String

Default Not Applicable

SENSe<cnum>:CORRection:CSET:SAVE [<char>]

Applicable Models: All

This command is NOT necessary after completion of a calibration. A Cal Set is automatically created,

applied to the channel, and saved at the completion of a guided cal according to the preference setting

SENS:CORR:PREF:CSET:SAVE.

(Read Write)

Saves the channel's Cal Set to the VNA hard drive. For example, use this command after writing data

to a Cal Set using SENS:CORR:CSET:DATA (For Advanced Users).

The file name is saved as "CSETx.cst" where x is the user number assigned to <char>, and .cst

specifies a Cal Set and instrument state. This is not the same syntax as a file saved through the default

choices from the front panel, which is "at00x.cst". For more information on the file naming syntax,

see the MMEMory subsystem. Learn more about Instrument/Cal States.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

[<char>] Optional argument. Choose from:

USER01
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USER02...

and so forth, until...

USER10

If <char> is NOT specified, changes that may have been made are saved to the

cal set and NOT to the *cst file.

Examples SENS:CORR:CSET:SAVE USER03
sense2:correction:cset:save user09

'save changes to only the cal set

SENS:CORR:CSET:SAVE

Query Syntax SENSe<cnum>:CORRection:CSET:SAVE?

Queries the last correction set saved.

Return Type Character

Default Not applicable

SENSe<cnum>:CORRection:CSET[:SELect] <char>  Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

This command is replaced by MMEM:LOAD

(Read-Write) Recalls a *.cst file from memory. The file name is "CSETx.cst" where x is the user

number assigned to <char>. Learn more about .cst files

For more information on the file naming syntax, see the MMEMory subsystem.

Note: This command does NOT select a Cal Set for a channel. To select a Cal Set, use
SENS:CORR:CSET:ACTivate

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<char> Choose from:

DEF - Presets the analyzer

USER01 - Restores User01 calibration data

USER02 - Restores User02 calibration data

 through...
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USER10 - Restores User10 calibration data

Examples SENS:CORR:CSET DEF
sense2:correction:cset:select user02

Query Syntax SENSe<cnum>:CORRection:CSET[:SELect]?

Return Type Character

Default DEF

SENSe<cnum>:CORRection:CSET:STANdard <string>,<data>

Applicable Models: All

(Read-Write) Sets or returns standard data.  Standard data is available for Unguided Cals ONLY.

Note: The “Standards data” container in the calset is intended for internal use only.  External access is

provided for use in diagnosing calibration problems.  Users should not form any expectations as to the

presence of the data or the naming conventions used.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<string> (String) Cal standard to read or write. The standard is specified using the

EXACT case-sensitive string displayed in the Cal Set Viewer utility.  See

SENS:CORR:CSET:DATA for a description of port numbers.

<data> (Block). Acquisition data. A Real / Imaginary data pair for each data point.

Format is set using FORM:DATA command.

For REAL binary formats, refer to Getting Data from the Analyzer using SCPI

Examples SENS:CORR:CSET:STAN 'S11C(1,1), 0.237,-1.422, 0.513, 0.895  '
Set acquisition data for two points.

SENS:CORR:CSET:STAN? "S11C(1,1)"  'Read data

Query Syntax SENSe<cnum>:CORRection:CSET:STANdard? (string)

Return Type Block data

Default Not Applicable

SENSe<ch>:CORRection:CSET:STIMulus? [num]
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Applicable Models: All

(Read-only) Returns the source or response stimulus values for the Cal Set that is currently used by

channel <ch>. Values are returned in the format specified by FORM:DATA  (Block or ASCII).

Parameters  

<ch> Channel number to query Cal Set stimulus values. If unspecified, value is set to

1

[num] Optional argument.  Range of frequencies to return. These values would be

different when FOM (Opt S93080A) is enabled.

0 - returns source frequencies. Default setting if not specified.

1 - returns response frequencies.

2 - returns primary frequencies.

Examples SENS:CORR:CSET:STIM?

sense:correction:cset:stimulus 1

Return Type Numeric

Default Not Applicable

SENSe:CORRection:CSET:TSET:ALLPorts? <cset>

Applicable Models: All

(Read-only) Reads the port mapping used for the specified Cal Set. The returned values are the

physical ports. The POSITION of the returned values corresponds to the logical ports.

For example, with an N44xx test set, if the returned string is "PNA 1,TS 2,PNA 2, TS 4" this means:

VNA 1 is assigned to logical port 1

TS 2 is assigned to logical port 2

VNA 2 is assigned to logical port 3

TS 4 is assigned to logical port 4

Parameters  

 <cset> (String) Name or GUID of the Cal Set. Use SENS:CORR:CSET:CAT? to read the

list of available Cal Set names or GUIDs.
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Examples SENS:CORR:CSET:TSET:ALLP? "MyCalSet"
sens:correction:cset:tset:allports? "{2B893E7A-971A-11d5-8D6C-
00108334AE96}"

Return Type String

Default Not Applicable

SENSe:CORRection:CSET:TSET:TYPE? <cset>

Applicable Models: All

(Read-only) Reads the test set type (model) used for the specified Cal Set.

Parameters  

 <cset> (String) Name or GUID of the Cal Set. Use SENS:CORR:CSET:CAT? to read the

list of available Cal Set names or GUIDs.

Examples SENS:CORR:CSET:TSET:TYPE? "MyCalSet"

'returns "N44xx"

sens:correction:cset:tset:type? "{2B893E7A-971A-11d5-8D6C-
00108334AE96}"

Return Type String

Default Not Applicable

SENSe<ch>:CORRection:CSET:TYPE:CATalog? [format]

Applicable Models: All

(Read-only) Query the Cal Types available in the selected Cal Set. The output is a comma separated

list of Guids or a Cal Type names. Learn more about applying Cal Types using SCPI.

Use CALC:MEAS:CORR:TYPE to apply a Cal Type.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1

[format] (Optional) Format of the output of cal types. choose from:

NAME - (default) returns a list of cal type string names.

GUID - returns a list of cal type GUIDs
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Examples SENS:CORR:CSET:TYPE:CAT? NAME

SENS2:CORRection:CSET:TYPE:CAT?

Return Type String

Default Not Applicable
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Sense:Correction:Extension Commands

Performs and applies Port Extensions.

SENSe:CORRection:EXTension:

AUTO

     | CONFig

     | DCOFfset

     | LOSS

     | MEASure

     | PORT

     | RESet

     | STARt

     | STOP

PORT

     | DISTance

     | FREQuency

     | INCLude

          | [STATe]

     | LDC

     | LOSS

     | MEDium

     | SYSMedia

     | SYSVelocity

     | [TIME]

     | UNIT
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     | VELFactor

     | WGCutoff

RECeiver

     | [TIME]

[STATe]

Click on a keyword to view the command details.

See Also

Example Programs

Learn about Port Extensions

Synchronizing the Analyzer and Controller

SCPI Command Tree

SENSe<cnum>:CORRection:EXTension:AUTO:CONFig <char>

Applicable Models: All

(Read-Write)  Sets the frequencies used to calculate Automatic Port Extension. Learn more about
calculating Automatic Port Extension.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<char> Frequencies to be used:

CSPN  Use current frequency span.

AMKR - Use active marker frequency.

USPN - Use custom user span. Use SENS:CORR:EXT:AUTO:STAR and

SENS:CORR:EXT:AUTO:STOP to specify start and stop frequency.

Examples SENS:CORR:EXT:AUTO:CONF CSPN
sense2:correction:extension:auto:config amkr

Query Syntax SENSe<cnum>:CORRection:EXTension:AUTO:CONFig ?

Return Type Character

Default CSPN
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SENSe<cnum>:CORRection:EXTension:AUTO:DCOFfset <bool>

Applicable Models: All

(Read-Write) Specifies whether or not to include DC Offset as part of automatic port extension. Learn
more about Automatic DC Offset. Only allowed when SENS:CORR:EXT:AUTO:LOSS is set to ON.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<bool> ON (or 1) - Includes DC Offset correction.

OFF (or 0) - Does NOT include DC Offset correction.

Examples SENS:CORR:EXT:AUTO:DCOF 1
sense2:correction:extension:auto:dcoffset off

Query Syntax SENSe<cnum>:CORRection:EXTension:AUTO:DCOFfset?

Return Type Boolean

Default OFF (0)

SENSe<cnum>:CORRection:EXTension:AUTO:LOSS <bool>

Applicable Models: All

(Read-Write) Specifies whether or not to include loss correction as part of automatic port extension.

Learn more about Loss Compensation in port extension.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<bool> ON (or 1) - Includes Loss correction.

OFF (or 0) - Does NOT include Loss correction.

Examples SENS:CORR:EXT:AUTO:LOSS 1
sense2:correction:extension:auto:loss off

Query Syntax SENSe<cnum>:CORRection:EXTension:AUTO:LOSS?

Return Type Boolean

Default OFF (0)

SENSe<cnum>:CORRection:EXTension:AUTO:MEASure <char>
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Applicable Models: All

(Write-only) Measures either an OPEN or SHORT standard. When this command is sent, the VNA

acquires the measurement with which to set automatic port extensions. This command should be

preceded by the CALCulate:PARameter:MNUMber <num> where num is the trace number of a

measurement on the specified channel. Learn more about which standard to measure.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<char> Standard to be measured. Choose from:

OPEN  Measure OPEN standard

SHORt  Measure SHORT standard

Examples SENS:CORR:EXT:AUTO:MEAS OPEN
sense2:correction:extension:auto:measure short

Query Syntax Not Applicable
Default Not Applicable

SENSe<cnum>:CORRection:EXTension:AUTO:PORT<n> <bool>

Applicable Models: All

(Read-Write) Enables and disables automatic port extensions on the specified port.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<n> VNA Port number to enable or disable for automatic port extensions.

<bool> ON (or 1) - Enable

OFF (or 0) - Disable

Examples SENS:CORR:EXT:AUTO:PORT2 0
sense2:correction:extension:auto:port4 on

Query Syntax SENSe<cnum>:CORRection:EXTension:AUTO:PORT<n>?

Return Type Boolean

Default All ports ON (enabled)

SENSe<cnum>:CORRection:EXTension:AUTO:RESet
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Applicable Models: All

(Write-only) Clears old port extension delay and loss data in preparation for acquiring new data. Send

this command prior to sending a new series of SENS:CORR:EXT:AUTO:MEAS. If acquiring both OPEN

and SHORT standards, do not send this command between those acquisitions.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

Examples SENS:CORR:EXT:AUTO:RES
sense2:correction:extension:auto:reset

Query Syntax Not Applicable
Default Not Applicable

SENSe<cnum>:CORRection:EXTension:AUTO:STARt <value>

Applicable Models: All

(Read-Write) Set the start frequency for custom user span. Learn more about User Span.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<value> User span start value. Must be within the frequency range of the active channel

and less than the value set by SENS:CORR:EXT:AUTO:STOP.

Examples SENS:CORR:EXT:AUTO:STAR 1E9
sense2:correction:extension:auto:start 200e6

Query Syntax SENSe<cnum>:CORRection:EXTension:AUTO:STARt <value>?

Return Type Numeric

Default Start frequency of the current active channel.

SENSe<cnum>:CORRection:EXTension:AUTO:STOP <value>
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Applicable Models: All

(Read-Write) Set the stop frequency for custom user span. Learn more about User Span.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<value> User span stop value. Must be within the frequency range of the active channel

and greater than the value set by SENS:CORR:EXT:AUTO:STARt

Examples SENS:CORR:EXT:AUTO:STOP 1E9
sense2:correction:extension:auto:stop 200e6

Query Syntax SENSe<cnum>:CORRection:EXTension:AUTO:STOP <value>?

Return Type Numeric

Default Stop frequency of the current active channel.

SENSe<cnum>:CORRection:EXTension:PORT<pnum>:DISTance <value>

Applicable Models: All

(Read-Write) Sets and returns the port extension delay in physical length (distance).

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<pnum> Port Number that will receive the delay setting. If unspecified, value is set to 1.

<value> Physical length of fixture of added transmission line. First specify units with

SENS:CORR:EXT:PORT:UNIT.

Examples SENS:CORR:EXT:PORT1:DIST 12
sense2:correction:extension:port2:distance .003

Query Syntax SENSe<cnum>:CORRection:EXTension:PORT<pnum>:DISTance?

Return Type Numeric
Default 0

SENSe<cnum>:CORRection:EXTension:PORT<pnum>:FREQuency<n> <value>
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Applicable Models: All

(Read-Write) Sets and returns the frequency for the Freq and Loss pair number and for the specified

port number.

Learn about Loss Compensation values.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<pnum> Port Number that will receive the freq/loss settings. If unspecified, value is set

to 1.

<n> Freq and Loss pair number. Choose from 1 or 2.  If unspecified, value is set to

1.

<value> Frequency value. Choose a frequency within the frequency span of the VNA.

Examples SENS:CORR:EXT:PORT1:FREQ1 10E9
sense2:correction:extension:port2:freq2 2E10

Query Syntax SENSe<cnum>:CORRection:EXTension:PORT<pnum>:FREQuency<n>?

Return Type Numeric
Default 1 GHz

SENSe<cnum>:CORRection:EXTension:PORT<pnum>:INCLude<n>[:STATe] <bool>

Applicable Models: All

(Read-Write) Sets and returns the ON/OFF state for the Freq and Loss pair number and for the

specified port number.

Learn about Loss Compensation values.

Note:  This command affects ALL measurements on the specified channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<pnum> Port Number that will receive the Freq/Loss settings. If unspecified, value is set to

1.

<n> Freq and Loss pair. Choose from 1 or 2. If unspecified, value is set to 1.
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<value> State of Freq and Loss values for port extension.

0 or OFF  Specified Freq and Loss values are OFF

1 or ON  Specified Freq and Loss values are ON

Examples SENS:CORR:EXT:PORT:INCL 0
sense2:correction:extension:port2:include2:state on

Query Syntax SENSe<cnum>:CORRection:EXTension:PORT<pnum>:INCLude[:STATe]?

Return Type Boolean

Default OFF

SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LDC <value>

Applicable Models: All

(Read-Write) Sets and returns the Port Loss at DC value for the specified port number.

Learn about Loss Compensation values.

Note:  This command affects ALL measurements on the specified channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<pnum> Port number to receive Loss value. If unspecified, value is set to 1.

<value> Loss in dB. Choose a value between -90 and 90

Examples SENS:CORR:EXT:PORT:LDC 1.5

sense2:correction:extension:port2:ldc .1

Query Syntax SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LDC?

Return Type Numeric
Default 0

SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LOSS<n> <value>
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Applicable Models: All

(Read-Write) Sets and returns the Loss value for the specified port number.

Learn about Loss Compensation values.

Note:  This command affects ALL measurements on the specified channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<pnum> Port Number that will receive the Freq/Loss settings. If unspecified, value is set

to 1.

<n> Loss "Use" number. Choose from 1 or 2. If unspecified, value is set to 1.

<value> Loss in dB. Choose a value between -90 and 90

Examples SENS:CORR:EXT:PORT:LOSS1 1

sense2:correction:extension:port2:loss2 .1

Query Syntax SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LOSS<n>?

Return Type Numeric
Default 0

SENSe<cnum>:CORRection:EXTension:PORT<pnum>:MEDium <char>

Applicable Models: All

(Read-Write) Sets and returns the media type of the added fixture or transmission line.

See also SENS:CORR:EXT:PORT:SYSMedia

Note:  This command affects ALL measurements on the specified channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<pnum> Port Number for which media type is being set. If unspecified, value is set to 1.

<char> Medium type. Choose from:

COAX

WAVEguide
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Examples SENS:CORR:EXT:PORT:MED COAX

sense2:correction:extension:port2:medium waveguide

Query Syntax SENSe<cnum>:CORRection:EXTension:PORT<pnum>:MEDium?

Return Type Character

Default COAX

SENSe<cnum>:CORRection:EXTension:PORT<pnum>:SYSMedia <bool>

Applicable Models: All

(Read-Write) Sets and returns the state of coupling with the system Media type. Learn more.

Note:  This command potentially affects ALL measurements on the VNA.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<pnum> Port Number for which system Velocity Factor coupling is being set. If

unspecified, value is set to 1.

<bool> Coupling state. Choose from:

ON (or 1) - Media type is coupled with the system setting.

OFF (or 0) - Media type is NOT coupled with the system setting.

Examples SENS:CORR:EXT:PORT:SYSM 1

sense2:correction:extension:port2:sysmedia off

Query Syntax SENSe<cnum>:CORRection:EXTension:PORT<pnum>:SYSMedia?

Return Type Boolean

Default 1 or ON (Coupled)

SENSe<cnum>:CORRection:EXTension:PORT<pnum>:SYSVelocity <bool>
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Applicable Models: All

(Read-Write) Sets and returns the state of coupling with the system Velocity Factor value. Learn more.

Note:  This command potentially affects ALL measurements on the VNA.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<pnum> Port Number for which system Velocity Factor coupling is being set. If

unspecified, value is set to 1.

<bool> Coupling state. Choose from:

ON (or 1) - Velocity Factor is coupled with the system setting.

OFF (or 0) - Velocity Factor is NOT coupled with the system setting.

Examples SENS:CORR:EXT:PORT:SYSV 1

sense2:correction:extension:port2:sysvelocity off

Query Syntax SENSe<cnum>:CORRection:EXTension:PORT<pnum>:SYSVelocity?

Return Type Boolean

Default 1 or ON (Coupled)

SENSe<cnum>:CORRection:EXTension:PORT<pnum>[:TIME] <num>

Applicable Models: All

(Read-Write) Sets the extension delay value in time at the specified port. Must also set

SENS:CORR:EXT ON.

Note:  This command affects ALL measurements on the specified channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<pnum> Port Number that will receive the extension. If unspecified, value is set to 1.

<num> The port extension in seconds; may include suffix. Choose a number between:

-1E18 and 1E18

Examples SENS:CORR:EXT:PORT 2MS
sense2:correction:extension:port2 .00025

Query Syntax SENSe<cnum>:CORRection:EXTension:PORT<pnum> [:TIME]?
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Return Type Numeric
Default 0

SENSe<cnum>:CORRection:EXTension:PORT:UNIT <char>

Applicable Models: All

(Read-Write) Sets and returns the units for specifying port extension delay in physical length

(distance).

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<char> Units for delay in distance. Choose from:

METer

FEET

INCH

Examples SENS:CORR:EXT:PORT:UNIT MET
sense2:correction:extension:port:unit inch

Query Syntax SENSe<cnum>:CORRection:EXTension:PORT:UNIT?

Return Type Character

Default METer

SENSe<cnum>:CORRection:EXTension:PORT<pnum>:VELFactor <value>
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Applicable Models: All

(Read-Write) Sets and returns the velocity factor of the fixture or added transmission line.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<pnum> Port Number for which velocity factor is being set. If unspecified, value is set

to 1.

<value> Velocity Factor.

Set SENS:CORR:EXT:PORT:SYSV to use the system velocity factor.

Examples SENS:CORR:EXT:PORT:VELF .6

sense2:correction:extension:port2:velfactor 1

Query Syntax SENSe<cnum>:CORRection:EXTension:PORT<pnum>:VELFactor?

Return Type Numeric

Default System Velocity Factor

SENSe<cnum>:CORRection:EXTension:PORT<pnum>:WGCutoff <value>

Applicable Models: All

(Read-Write) Sets and returns the cuttoff (minimum) frequency of the added waveguide fixture or

transmission line.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<pnum> Port Number for which media type is being set. If unspecified, value is set to 1.

<value> Cutoff frequency in Hz.

This value is ignored when SENS:CORR:EXT:PORT:MED is set to COAX for the

same port.

Examples SENS:CORR:EXT:PORT:WGC 1e8

sense2:correction:extension:port2:wgcutoff 100Mhz

Query Syntax SENSe<cnum>:CORRection:EXTension:PORT<pnum>:WGCutoff?

Return Type Numeric

Default System Media Cutoff Frequency
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SENSe<cnum>:CORRection:EXTension:RECeiver<Rnum>[:TIME] <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the extension value at the specified receiver. Must also set SENS:CORR:EXT ON.

Note: Before using this command you must select a measurement using CALC:MEAS:DEFine. You can

select one measurement for each channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<Rnum> Number of the receiver that will receive the extension. If unspecified, value is

set to 1

Choose from:

1 for Receiver A

2 for Receiver B

<num> The electrical length in seconds; may include suffix. Choose a number

between:

-10 and 10

Examples SENS:CORR:EXT:REC 2MS
sense2:correction:extension:receiver2:time .00025

Query Syntax SENSe<cnum>:CORRection:EXTension:RECeiver<Rnum> [:TIME]?

Return Type Numeric
Default 0

SENSe<cnum>:CORRection:EXTension[:STATe] <ON | OFF>
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Applicable Models: All

(Read-Write) Turns port extensions ON or OFF.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<ON | OFF> ON (or 1) - turns port extensions ON.

OFF (or 0) - turns port extensions is OFF.

Examples SENS:CORR:EXT ON
sense2:correction:extension:state off

Query Syntax SENSe<cnum>:CORRection:EXTension[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF
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Sense:Correction:Collect:Guided Commands

Performs and applies a SmartCal (Guided) calibration and other error correction features.

Important Notes:

To perform a Guided Calibration , use ONLY Sens:Corr:Coll:Guided commands. See the "Guided" example
programs for clarification.

ALWAYS send ALL measurement setup commands BEFORE initializing a remote calibration.

SENSe:CORRection:COLLect:GUIDed:

ABORt

ACQuire

ADAPter

     | COUNt

          | ZERO

     | CREate?

     | DELay

     | DESCription

     | PATHs

CHANnel:MODE

CKIT

     | CATalog?

     | PORT

          | CATalog?

          | [SELect]

CONNector

     | CATalog?

     | PORT

          | [SELect]

DATA

    | CATalog?

DESCription

ECal

     | ACQuire
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     | SELect

ETERms

     | COMPute

     | LOAD[:CSET]

INITiate

ISOLation

     | AVERage

          | INCRement

     | PATHs

ITERations

     | COUNt?

     | MINimum?

     | RESet

LIST

     | COUNt?

     | STEP

          | COUNt?

          | DESCription?

          | LABel?

          | PORTs?

          | STANdard

                  | LABel?

                  | PORTs?

                  | STYPe?

                  | TPORts?

          | STYPe?

          | TPORts?

METHod

PACQuire

PATH

     | CMEThod
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     | TMEThod

PORTs?

PREFerence

     | SLIDingload

PSENsor - More commands

SAVE

     | CSET

SMC - More commands

STEPS?

THRU

Click on a keyword to view the command details.

Blue keywords are superseded commands.

S ee Also

ECal Orientation commands

Examples using these commands.

Calibrating the VNA Using SCPI
Learn about Measurement Calibration

Synchronizing the Analyzer and Controller

SENSe<ch>:CORRection:COLLect:GUIDed:ABORt

Applicable Models: All

(Write-only) Aborts the acquiring of a guided calibration that has been INITialized but has not yet

been concluded using the SAVE command.  If at least one Cal standard has already been measured,

and the Calibration Window is being displayed, this command also closes the Calibration Window
and re-tiles the other measurement windows.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

Examples SENS:CORR:COLL:GUID:ABOR
sense2:correction:collect:guided:abort

Query Syntax Not Applicable

Default Not Applicable
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SENSe:<ch>CORRection:COLLect:GUIDed[:ACQuire] STAN<n>[,sync]

Applicable Models: All

(Write-only) Initiates the measurement of the specified calibration standard. Executing this command

with an unnecessary standard has no affect.

The measured data is stored and used for subsequent calculations of error correction coefficients. All

standards must be measured before a calibration can be completed.  Any measurement can be repeated

until the SENS:CORR:COLL:GUID:SAVE command is executed.

Query the user prompt description using SENS:CORR:COLL:GUID:DESC ?

Query the required calibration steps using SENS:CORR:COLL:GUID:STEP?

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

STAN<n> Choose from:STAN1, STAN2, etc. through STANn where n is the number of

cal standard connection steps for the calibration.

Note: You do not necessarily have to invoke these connection steps in

sequential order, but you must issue this command for all of the steps to be able

to complete the calibration.

[sync] Optional argument. Choose from:

SYNChronous - blocks SCPI commands during standard measurement

(default behavior).

ASYNchronous - does NOT block SCPI commands during standard

measurement.

Learn more about this argument

Examples SENS:CORR:COLL:GUID STAN1
sense2:correction:collect:guided:acquire stan1

Query Syntax Not Applicable

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:ADAPter:CREate? <conn1>, <conn2>
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Applicable Models: All

(Read-only) Specifies the use of a THRU adapter to be used during the Guided Cal Unknown THRU

and Adapter Removal Cal. Returns an adapter index <n> which is used to refer to the adapter in

several related commands. See Cal Thru Methods. While the choice of which end of the adapter is

<conn1> and <conn2> is arbitrary, it is necessary to remember which will be used on each test port.

The settings for this command remain until Preset, or the command is sent using a different setting, or

until the ZERO command is sent.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<conn1> Adapter port 1 connector type. Use SENS:CORR:COLL:GUID:CONN:CAT?

to return a list of valid connector types.

<conn2> Adapter port 2 connector type.

Examples See example using this command.

Return Type Numeric

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:ADAPter:COUNt?

Applicable Models: All

(Read-Only)   Returns the number of THRU adapters that have been created for this calibration using

SENS:CORR:COLL:GUID:ADAP:CREate .

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

Examples See example using this command.

Return Type Numeric

Default Not Applicable

SENSe:<ch>CORRection:COLLect:GUIDed:ADAPter:COUNt:ZERO
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Applicable Models: All

(Write-only) Removes all adapters that have been defined for calibrations on the specified channel

using SENS:CORR:COLL:GUID:ADAP:CREate .

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

Examples SENS:CORR:COLL:GUID:ADAP:COUNt:ZERO
sense2:correction:collect:guided:adapter:count:zero

Query Syntax Not Applicable

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:ADAPter<n>:DELay <coax>, [w phase,  wdelay]

Applicable Models: All

(Write-only) Specifies the adapter delay. and optionally waveguide delay and optional phase offset

(degrees) of adapter <n>.

The settings for this command remain until Preset, or the command is sent using a different setting, or

until the ZERO command is sent.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<n> Adapter index number that was returned from

SENS:CORR:COLL:GUID:ADAP:CREate?

<coax> Delay value of coax adapter <n> in seconds. If the adapter has no coax

connector, enter 0.

<wphase> Waveguide phase offset in degrees. If the adapter has no waveguide connector,

do not enter a value.

<wdelay> Waveguide delay in seconds. If the adapter has no waveguide connector, do not

enter a value.

Examples See example using this command.

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:ADAPter<n>:DESCription <string>
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Applicable Models: All

(Write-only) Specifies the adapter description for use as the guided cal connection prompts.

The settings for this command remain until Preset, or the command is sent using a different setting, or

until the ZERO command is sent.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<n> Adapter index number that was returned from

SENS:CORR:COLL:GUID:ADAP:CREate?

<string> Adapter description.

Examples See example using this command.

Query Syntax Not Applicable

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:ADAPter<n>:PATHs <port pairs>

Applicable Models: All

(Write-only) Specifies the port pairs for which the adapter will be used for a THRU connection.

For example, for a 3-port cal on channel 1 using ports 1,2,and 3), to use adapter 1 between the ports (1

to 2) and (1 to 3) the following command is used: SENS1:CORR:COLL:GUID:ADAP1:PATH

1,2,1,3.

The adapter must have the same DUT connectors as the ports that are already specified for these ports.

The settings for this command remain until Preset, or the command is sent using a different setting, or

until the ZERO command is sent.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<n> Adapter index number that was returned from

SENS:CORR:COLL:GUID:ADAP:CREate?

<port pair> Ports for which the adapter will be used. The orientation is not critical, as the

VNA will align the connector types as necessary. The minimum number of

Thru connections required is the number of ports to calibrated -1.
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Examples See example using this command.

Query Syntax Not Applicable

Default Not Applicable

SENSe:CORRection:COLLect:GUIDed:CHANnel:MODE <bool>

Applicable Models: All

(Read-Write) Determines whether or not to honor the channel <ch> argument in guided calibration

SCPI commands.

Parameters  

<bool> OFF (0)    Honor all <ch> arguments. This means the <ch> channel is

calibrated regardless of which channel is currently active.

ON (1)   Legacy behavior. Behavior is specified by the following table:

<ch> channel type

Std or App

Active channel type

Std or App

Behavior

Std Std Active chan cal'd

Std App "Channel not found"

error

App Std <ch> chan cal'd

App App <ch> chan cal'd

Learn about Standard vs Application channels.

Examples SENS:CORR:COLL:GUID:CHAN:MODE 0

sense:correction:collect:guided:channel:mode ON

Query Syntax SENSe:CORRection:COLLect:GUIDed:CHANnel:MODE?

Return Type Boolean

Default OFF - This is the default beginning with A.09.50

ON - Default before A.09.50

SENSe:CORRection:COLLect:GUIDed:CKIT:CATalog? <connector>
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Applicable Models: All

(Read-only) This command replaces SENS:CORR:COLL:GUID:CKIT:PORT:CAT?

Returns a comma-separated list of valid kits that use the specified connector type. This includes

mechanical cal kits, applicable characterizations found within ECal modules currently connected to

the VNA, and all user characterizations stored in VNA disk memory. For ECal modules, the

returned list includes the serial numbers.  See ECal User Characterization commands.

Use items in the list to select the kit to be used with the SENS:CORR:COLL:GUID:CKIT:PORT  and

SENSe<ch>:CORRection:COLLect:GUIDed:PSENsor<pnum>:CKIT  commands.

Parameters  

<conn> String. Connector type. Use SENS:CORR:COLL:GUID:CONN:CAT? to

return a list of valid connector types.

Examples SENSe:CORR:COLL:GUID:CKIT:CAT? "Type N (50) male"

Return Type String

Default Not Applicable

SENSe:CORRection:COLLect:GUIDed:CKIT:PORT<pnum>:CATalog? Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) This command is replaced by SENSe:CORR:COLL:GUID:CKIT:CAT? .

Returns a comma-separated list of valid kits for the specified VNA port. In addition to mechanical

calibration kits, this will include applicable characterizations found within ECal modules currently

connected to the VNA.

Use items in the list to select the kit to be used with the SENS:CORR:COLL:GUID:CKIT:PORT

command.

Note: The serial number is returned for ALL ECal modules that are connected with the connector type

of the specified port. Previously, the returned list would include the serial numbers to distinguish the

ECal modules only when two or more identical ECal models were connected to the VNA.

Parameters  

<pnum> Any existing port number.  If unspecified, value is set to 1

Examples SENS:CORR:COLL:GUID:CKIT:PORT1:CAT?
'When "Type N (50) male" is specified for connector type,
returns:

"85054D, 85032F"
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'When two identical ECal modules are connected for the connector
type,
'the return string includes serial numbers

"85092-60010 ECal 10675, 85092-60010 ECal 00758"

Return Type String

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:CKIT:PORT<pnum>[:SELect] <kit>

Applicable Models: All

(Read-Write) Specifies the calibration kit (mechanical or ECal) for each port to be used during a

guided calibration. An unused port does NOT need to have a specified Cal Kit.

Specify the connector type for the port with SENS:CORR:COLL:GUID:CONN:PORT .1.

Query the valid available kits for the connector on each port with
SENS:CORR:COLL:GUID:CKIT:PORT:CAT?

2.

Specify the kit using this command.3.

Perform a query of this command. If the <kit> parameter was incorrectly entered, an error will be returned.4.

When using this command to specify the cal kit for the output of a VMC calibration mixer, specify

port 3. If port 3 is already used for the output of the DUT mixer, then specify port 4. Learn more.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<pnum> Any existing port number. If unspecified, value is set to 1

<kit> Calibration kit to be used for the specified port. Case-sensitive.

When using an ECal module, include the characterization name in the <kit>

string. Use SENSe:CORR:COLL:GUID:CKIT:CAT? to read the list of
characterizations available in the module and in VNA disk memory.

If two or more identical ECal modules are connected to the VNA, the serial

number must be included to distinguish the ECal modules.

Examples 'Note: All of the following examples specify port 1 only

' Mechanical Cal kit

SENS:CORR:COLL:GUID:CKIT:PORT1 '85055A'
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 ' Standard ECal modules

SENS:CORR:COLL:GUID:CKIT:PORT1 "N4691-60004 ECal"

' Non-factory ECal characterizations are specified as follows:

SENS:CORR:COLL:GUID:CKIT:PORT1 "N4691-60004 User 1 ECal"

' When two or more ECal modules with the same model number are

' connected, also specify the serial number as follows:

SENS:CORR:COLL:GUID:CKIT:PORT1 "N4691-60004 ECal 01234"

' When Disk Memory ECal user characterizations are used,

' specify both the User char and the serial number as follows:

SENS:CORR:COLL:GUID:CKIT:PORT1 "N4691-60004 MyDskChar ECal
01234"

Query Syntax SENSe:CORRection:COLLect:GUIDed:CKIT:PORT<pnum>[:SELect]?

Return Type String - If the <kit> parameter was incorrectly entered while writing, an error

will be returned.

Default Not Applicable

SENSe:CORRection:COLLect:GUIDed:CONNector:CATalog?

Applicable Models: All

(Read only) Returns a list of valid connectors based on the connector descriptions of the available cal

kits. Use an item from the returned list to specify a connector for

SENS:CORR:COLL:GUID:CONN:PORT

Here are the more common connector types:
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W-band waveguide

V-band waveguide

U-band waveguide

R-band waveguide

Q-band waveguide

K-band waveguide

P-band waveguide

X-band waveguide

7-16 female

7-16 male

Type B

Type A (50) female

Type A (50) male

Type F (75) female

Type F (75) male

Type N (75) female

Type N (75) male

Type N (50) female

Type N (50) male

1.00 mm female

1.00 mm male

1.85 mm male

1.85 mm female

2.92 mm female

2.92 mm male

APC 2.4 female

APC 2.4 male

APC 3.5 female

APC 3.5 male

APC 7

 

Examples SENS:CORR:COLL:GUID:CONN:CAT?
Returns:

Type N (50) female, Type N (50) male, APC 7 (50), 3.5 mm (50)
male, 3.5 mm (50) female, User Connector A

Return Type Comma separated string values

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:CONNector:PORT<pnum>[:SELect] <conn>

Applicable Models: All

(Read-Write) Specifies a DUT connector type for every port during the Guided Calibration procedure.

Valid DUT connector names are stored within calibration kits. Some cal kits may include both male

and female DUT connectors. Therefore, specifying the DUT connector gender may be required.

The VNA remembers previous Guided Cal settings. Therefore, for completeness, unused ports can
either be defined as "Not used" or use the SENS:CORR:COLL:GUID:ABORt command to clear all

ports. The ABORt command is a more thorough approach and more convenient. See Guided Cal
examples.
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A single port with a valid <conn> name indicates  a 1-Port calibration will be performed.  

Two ports with valid <conn> names indicate either a 2-Port SOLT or TRL calibration will be performed
depending on the standards definition found within the cal kit and the capability of the VNA.

Three ports with valid <conn> names indicate a 3-Port calibration will be performed, and so forth.

Follow these steps to ensure port connectors are specified correctly:

Use SENS:CORR:COLL:GUID:CONN:CAT? to query available connectors before specifying the port
connector.

1.

Set a connector type for each port using this command.2.

Perform a query of this command. If the connector type was incorrectly entered, an error will be
returned.

3.

Specify the cal kit to use for each port with SENS:CORR:COLL:GUID:CKIT:PORT4.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<pnum> Any existing port number. If unspecified, value is set to 1.

<conn> String - DUT connector type to connect with VNA port <pnum>. Case-

sensitive.

Examples 'Specifying a 2-port cal (1 & 2) on a 4-port VNA

SENS:CORR:COLL:GUID:CONN:PORT1 'Type N (50) female'
SENS:CORR:COLL:GUID:CONN:PORT2 'Type N (50) male'
SENS:CORR:COLL:GUID:CONN:PORT3 'Not used'
SENS:CORR:COLL:GUID:CONN:PORT4 'Not used'

Query Syntax SENSe:CORRection:COLLect:GUIDed:CONNector:PORT<pnum>[:SELect]?

Return Type String

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:DATA STAN<n>, <meas parameter>, [<ECal state
num>]
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Applicable Models: All

(Read-Write) Sets and returns the measurement data for a specified measurement parameter of a

particular step of a guided cal (and for a specific state of an ECal if the step is an ECal step). The

measurement data is complex real-and-imaginary pairs where the number of points is the current

number of points on the channel, and is in ASCII or binary format as dictated by the current setting of

the FORMat:DATA command.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

STAN<n> Choose from:STAN1, STAN2, etc. through STANn where n is the number of

cal standard connection steps for the calibration.

Note: You do not necessarily have to invoke these connection steps in

sequential order.

<meas parameter> Measurement parameters for standard S-parameter channels.

[<ECal state num>] ECal state number.

Examples See an example that uses this command.

Query Syntax SENSe:CORRection:COLLect:GUIDed::DATA? STAN<n>, <meas

parameter>, [<ECal state num>]

Return Type  

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:DATA:CATalog? STAN<n>

Applicable Models: All

(Read-only) Returns a comma-delimited string of measurement parameters that have to be measured

in the specified step number of a guided calibration.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

STAN<n> Choose from:STAN1, STAN2, etc. through STANn where n is the number of

cal standard connection steps for the calibration.

Note: You do not necessarily have to invoke these connection steps in

sequential order.

Examples SENS:CORR:COLL:GUID:DATA:CAT? STAN1
See an example that uses this command.
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Return Type String

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:DESCription? <step>

Applicable Models: All

(Read-only) Returns the connection description for the specified calibration step.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<step> A number from 1 to the number of steps required to complete the calibration

(Use SENS:CORR:COLL:GUID:STEP? to query the number of steps )

Examples SENS:CORR:COLL:GUID:DESC? 10

'Returns:
Connect APC 7 Open to port3

Return Type String

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:ECAL:ACQ <cal method>. <port list>, [calset]

Applicable Models: All

(Write only) Execute the Ecal calibration with specified Ecal using

SENS:CORR:COLL:GUID:ECAL:SEL . If ECal module is not specified, the first Ecal in the list is

used. One item that we discussed is that this command needs to be overlapped. That's because it can

be quite slow to finish an ecal, and slow operations need to be implemented using overlapped SCPI.

Otherwise, the client will time out and will be unable to poll for completion. So, the command must

be followed with either a *OPC? or a *OPC and serial poll.

Parameters  

<ch> Channel to be calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<cal method> String  Calibration Method.

SOLT: using defined through

SOLR: using undefined through
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ERESponse: Enhanced Response

<port list> Array  Port number to be calibrated. If enhanced response (ERESponse) is

selected, the first port number is the stimulus port and the second port number

is the response port.

[calset] Optional argument. Cal Set name

If NOT specified, behavior depends on the

SENS:CORR:PREFerence:CSET:SAVE setting.

If specified, choose an existing Cal Set, either by name or by GUID.

By Cal Set name: include quotes.

By Cal Set GUID in the form: "{GUID}"; including quotes and curly brackets.

Query all Cal Set GUIDs with SENS:CORR:CSET:CAT?

An error is reported if the Cal Set is not found.

The Cal Set is either supplemented or overwritten depending on the method,

connectors, and ports selected. Learn more about Cal Sets.

Examples ' Full 2 port cal with defined through for ports 2 and 3

SENS:CORR:COLL:GUID:ECAL:ACQ SOLT,2,3

' Enhance Response Cal for ports 4 (Stimulus) and 1 (Response)

SENS:CORR:COLL:GUID:ECAL:ACQ ERES,4,1

' Full 2 port cal with calset and undefined through for ports 1
to 4

SENS:CORR:COLL:GUID:ECAL:ACQ SOLR,1,2,3,4,"MyCalSet"

Query Syntax Not Applicable

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:ECAL[:SELect] <ecal kit>

Applicable Models: All
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(Read-Write) Specifies the Ecal Kit for Ecal Calibration. This is a new command that specifies the

ECal kit to be used in the new 1-shot ECal execution command.  If not specified, the 1-shot command

will internally select the top one from the connected ECal kits (like the basic cal and start cal dialogs

are doing.)

The top ecal kit in the list can be determined in two ways:  by an internal module number that is

dependent on the order in which the ecals are enumerated on the USB.  Or it could be an alphabetical

sorting by name.  This default selection will allow the user to use generic test code but only if there is

only one ECal connected.

Parameters  

<ch> Channel to be calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<ecal kit> Ecal kit to be used for the specified port. Case-sensitive.

Include the characterization name in the <kit> string. Use

SENSe:CORR:COLL:GUID:CKIT:CAT? to read the list of characterizations

available in the module and in VNA disk memory.

If two or more identical ECal modules are connected to the VNA, the serial

number must be included to distinguish the ECal modules.

Examples  ' Standard ECal modules

SENS:CORR:COLL:GUID:ECAL "N4691-60004 ECal"

' Non-factory ECal characterizations are specified as follows:

SENS:CORR:COLL:GUID:ECAL "N4691-60004 User 1 ECal"

' When two or more ECal modules with the same model number are

' connected, also specify the serial number as follows:

SENS:CORR:COLL:GUID:ECAL "N4691-60004 ECal 01234"

' When Disk Memory ECal user characterizations are used,

' specify both the User char and the serial number as follows:

SENS:CORR:COLL:GUID:ECAL "N4691-60004 MyDskChar ECal 01234"

Query Syntax SENSe:CORRection:COLLect:GUIDed:ECAL[:SELect]?

Return Type String - If the <kit> parameter was incorrectly entered while writing, an error

will be returned.

Default Not Applicable
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SENSe<ch>:CORRection:COLLect:GUIDed:ETERms:COMPute [cal set name]

Applicable Models: All

(Write-only) Computes the error correction terms, turns Correction ON, and saves the calibration to

an existing, specified Cal Set.

The cal acquisition process does not conclude as with the SAVE command. This command leaves the

cal acquisition in memory to allow re-measuring/re-computing. To conclude the cal acquisition

process, use the SENS:CORR:COLL:GUID:ABOR . command.

Learn all about Cal Sets.

Note: This command is NOT supported for application channels (Gain Compression, SMC/VMC,

Noise Figure, IMD and so forth). Use SENS:CORR:COLL:GUID:SAVE and save to a cal register.

You can then use SENS:CORR:CSET:COPY to copy the cal register to a named Cal Set.

Use this command instead of specifying the optional name or GUID argument in
SENS:CORR:COLL:GUID:INIT .

Use SENS:CORRection:CSET commands to get names of existing Cal Sets.

The cal data is also saved to the channel Cal Register.

If all of the required standards have not been measured, the calibration will not complete properly.

For Calibrate All Channels

When this command is used during a Cal All session, the <cal set name> argument sets the User Cal

Set prefix.  All generated Cal Sets will be preceded with this string name.

Cal Set prefix can also be set using SYST:CAL:ALL:CSET:PREFix . When the Cal Set prefix has already
been set with SYST:CAL:ALL:CSET:PREFix , this command overwrites it.

When <cal set name> is an empty string, a User Cal Set will not be saved.  Only Cal Registers will be
saved.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If
unspecified, value is set to 1.

<cal set name> String - Name of an existing Cal Set to be overwritten.

See Calibrate All Channels note (above).
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Examples SENS:CORR:COLL:GUID:ETER:COMP "{2B893E7A-971A-11d5-8D6C-
00108334AE96}"

sense:correction:collect:guided:eterms:compute "MyCalSet"

Query Syntax Not Applicable

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:ETERms:LOAD[:CSET] <cset>,<calPort> [,csPort]

Applicable Models: All

(Write-only)  Loads 1-port error terms from a Cal Set into the current Guided Cal sequence. When the

Cal steps are recomputed, connection steps are removed due to the loading of the error terms.

This command must be sent after the INIT command. This command was implemented to facilitate

calibrating a large matrix of external ports and most users will not need to use this command.

See example of how to use this command.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<cset> String  Name of User Cal Set in which the error terms reside.

<pnum> Integer  Port number of the current cal to receive error terms.

[csPort] Integer  Optional argument. Port number associated with the error terms in the

Cal Set. If unspecified, the same port number as <calPort> is used.

Examples See example

Query Syntax Not Applicable

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:INITiate[:IMMediate] [string][, bool][,char]

Applicable Models: All

(Write-only) Initiates a guided calibration.

The VNA determines the measurements needed to perform the calibration using the settings specified from
the SENS:CORR:COLL:GUID:CONN:PORT and SENS:CORR:COLL:GUID:CKIT:PORT commands.

After this command is executed, subsequent commands can be used to query the number of measurement
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steps, issue the acquisition commands, query the connection description strings, and subsequently
complete a guided calibration. See example calibration programs .

Parameters  

<ch> Channel to be calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

[string] Optional argument. Cal Set name or GUID enclosed in quotes.

If NOT specified, behavior depends on the

SENS:CORR:PREFerence:CSET:SAVE setting.

If specified, choose an existing Cal Set, either by name or by GUID.

By Cal Set name: include quotes.

By Cal Set GUID in the form: "{GUID}"; including quotes and curly brackets.

Query all Cal Set GUIDs with SENS:CORR:CSET:CAT?

An error is reported if the Cal Set is not found.

The Cal Set is either supplemented or overwritten depending on the method,

connectors, and ports selected. Learn more about Cal Sets.

[bool] Optional argument. To set this argument, also set the first optional argument.

See example below.

OFF (0)    If Cal Set stimulus settings differ from the existing channel, do not

change channel stimulus settings. The Cal Set is saved to the current setting of

the SENS:CORR:PREF:CSET:SAVE command. This is the default setting if

not specified.

ON (1)   If Cal Set stimulus settings differ from the existing channel, change
the channel stimulus settings to match the Cal Set settings.

[char] Optional argument. To set this argument, also set the first two optional

arguments. See example below.

SYNChronous - blocks further SCPI commands while processing this
command.. (default setting).

ASYNchronous - does NOT block further SCPI commands while processing

this command.

Learn more about this argument

Examples SENS:CORR:COLL:GUID:INIT
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'set first optional argument

SENS:CORR:COLL:GUID:INIT "MyCalSet"

'set two optional arguments

SENS:CORR:COLL:GUID:INIT " ",1

'set all optional arguments

SENS:CORR:COLL:GUID:INIT "MyCalSet",1,ASYN

Query Syntax Not Applicable

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:ISOLation:AVERage:INCRement <num>

Applicable Models: All

(Read-Write) Specifies amount to increment (increase) the channels averaging factor during

measurement of isolation standards in a guided calibration.

Note: If the channel has averaging turned OFF and the value of <num> is greater than 1, averaging

will be turned ON only during the isolation measurements and with the averaging factor equal to

<num>.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<num> Amount to increment the averaging factor for the isolation measurement. The

maximum averaging factor for the channel is  65536 (2^16).

Examples 'Measure isolation on all paths for the cal

SENS:CORR:COLL:GUID:ISOL ALL

'Remove the port pairs 1-to-2 and 1-to-3 from the list of paths on
which to measure isolation

sense:correction:collect:guided:isolation:paths REMove,1,2,1,3

Query Syntax SENSe<ch>:CORRection:COLLect:GUIDed:ISOLation:AVERage:INCRement?

Return Type Numeric

Default 8 - If this command is NOT sent, but isolation is measured , then averaging will

be turned ON with factor set to 8 during the isolation measurements.
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SENSe<ch>:CORRection:COLLect:GUIDed:ISOLation[:PATHs] <char>[,<p1a, p1b, p2a, p2b>]

Applicable Models: All

(Read-Write) Specifies the paths (port pairs) to make isolation measurements on during a guided

calibration.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<char> ALL Measure isolation on all pairings of the ports that are to be calibrated.

NONE Do not measure isolation on any pairing of the ports to be calibrated.

(Default behavior).

ADD Add one or more specific pairings of ports to the list of port pairings for

which isolation will be measured.

REMove Remove one or more specific pairings of ports from the list of port

pairings for which isolation will be measured. If many paths are to be

measured, it may be easier to first send ALL, then REMove and specify the

paths to remove.

<p1a, p2a...> For use when <char> is ADD or REMove .

Specify Port numbers in pairs:

For 3-port cals, specify up to 3 pairs.

For 4-port cals, specify up to 6 pairs.

p1a, p1b  (Path1 - port A and port B)

p2a, p2b  (Path2 - port A and port B)

p3a, p3b  (Path3 - port A and port B)

Examples 'Measure isolation on all paths for the cal

SENS:CORR:COLL:GUID:ISOL ALL

'Remove the port pairs 1-to-2 and 1-to-3 from the list of paths
on which to measure isolation

sense:correction:collect:guided:isolation:paths REMove,1,2,1,3
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Query Syntax SENSe<ch>:CORRection:COLLect:GUIDed:ISOLation:PATHs?

Note: if isolation is not be measured on any of the paths, the query returns 0

Return Type Numeric

Default 0 - Isolation not measured on any paths.

SENSe<ch>:CORRection:COLLect:GUIDed:ITERations:COUNt? <step>

Applicable Models: All

(Read-only)  Designed to be used for an iterative cal standard such as a sliding load, this command

returns the number of iterative measurement acquisitions that has been made for the specified step.

Zero (0) is returned if the step has not yet been measured.

For most cal steps that have already been measured, this command returns 1.

Set SENS:CORR:COLL:GUID:PREF:SLID ITER to count acquisition steps.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<step> Guided Cal step number for which the acquisition number will be returned.

Use SENS:CORR:COLL:GUID:STEP? to query the number of steps in the

calibration.

Examples SENS:CORR:COLL:GUID:ITER:COUN? 4

'Example return:

5

See example program

Return Type Numeric

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:ITERations:MINimum? <step>
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Applicable Models: All

(Read-only) Designed to be used for an iterative cal standard such as a sliding load, this command

returns the minimum number of required iterative measurement acquisitions for the specified step.

For most connection steps this will return 1, but for an iterative cal standard such as a sliding load, it

will return a number such as 5.

Set SENS:CORR:COLL:GUID:PREF:SLID ITER to count acquisition steps.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<step> Guided Cal step number for which to return the number of iterative

measurement acquisitions that have been made. Use

SENS:CORR:COLL:GUID:STEP? to query the number of steps in the

calibration.

Examples SENS:CORR:COLL:GUID:ITER:MIN? 4

'Example return:

5

See example program

Return Type Numeric

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:ITERations:RESet <step>
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Applicable Models: All

(Write-only) Resets the specified guided cal connection step as unmeasured. This clears all previous

measurements made for that step.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<step> Guided Cal step number to reset. Use SENS:CORR:COLL:GUID:STEP? to

query the number of steps in the calibration.

Examples SENS:CORR:COLL:GUID:ITER:RESet? 4

See example program

Return Type Not Applicable

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:LIST:COUNt?

Applicable Models: All

(Read-only) Returns the number of measurement steps required to complete the current guided

calibration. This command is the same as the SENS:CORR:COLL:GUID:STEP command.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

Examples SENS:CORR:COLL:GUID:LIST:COUN?
sense2:correction:collect:guided:list:count?

Return Type Numeric

Default 0

SENSe<ch>:CORRection:COLLect:GUIDed:LIST:STEP<ListCount>:COUNt?
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Applicable Models: All

(Read-only) Returns the number of standards for step[n]. This is generally 1 unless the standard is an

isolation standard or a composite standard.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<ListCount> Step number from 1 to 1000.

Examples SENS:CORR:COLL:GUID:LIST:STEP:COUN?
sense2:correction:collect:guided:list:step1:count?

Return Type Numeric

Default 1

SENSe<ch>:CORRection:COLLect:GUIDed:LIST:STEP<ListCount>:DESCription?

Applicable Models: All

(Read-only) Returns the step description.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<ListCount> Step number from 1 to 1000.

Examples SENS:CORR:COLL:GUID:LIST:STEP:DESC?
sense2:correction:collect:guided:list:step1:description?

Return Type String

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:LIST:STEP<ListCount>:LABel?
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Applicable Models: All

(Read-only) Returns the label for the complete standard used in the step. If the standard is a composite

standard, the label is for the composite device.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<ListCount> Step number from 1 to 1000.

Examples SENS:CORR:COLL:GUID:LIST:STEP:LAB?
sense2:correction:collect:guided:list:step1:label?

Return Type String

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:LIST:STEP<ListCount>:PORTs?

Applicable Models: All

(Read-only) Returns the number of ports on the standard used in the step. If the standard is a

composite standard, the number of ports applies to the composite.  So if the composite standard is an

offset line connected to a load, the composite device is a 1  port device.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<ListCount> Step number from 1 to 1000.

Examples SENS:CORR:COLL:GUID:LIST:STEP:PORT?
sense2:correction:collect:guided:list:step1:ports?

Return Type Numeric

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:LIST:STEP<ListCount>:STANdard<StandardCount>:LABel?
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Applicable Models: All

(Read-only) Returns the label for the one of the standards used in the step.  If the step contains only a

single standard, the response to this query is identical to

SENS:CORR:COLL:GUID:LIST:STEP:LAB?

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<ListCount> Step number from 1 to 1000.

<StandardCount> Standard number from 1 to 3.

Examples SENS:CORR:COLL:GUID:LIST:STEP:STAN:LAB?
sense2:correction:collect:guided:list:step1:standard2:label?

Return Type String

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:LIST:STEP<ListCount>:STANdard<StandardCount>:PORTs?

Applicable Models: All

(Read-only) Returns the number of ports on one of the standard used in the step. If the step contains

only a single standard, the response to this query is identical to

SENS:CORR:COLL:GUID:LIST:STEP:PORT?

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<ListCount> Step number from 1 to 1000.

<StandardCount> Standard number from 1 to 3.

Examples SENS:CORR:COLL:GUID:LIST:STEP:STAN:PORT?
sense2:correction:collect:guided:list:step1:standard2:ports?

Return Type Numeric

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:LIST:STEP<ListCount>:STANdard<StandardCount>:STYPe?
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Applicable Models: All

(Read-only) Returns the enumeration for the type of standard that describes one of the standard

devices used in the step.  If the step contains only a single standard, the response to this query is

identical to SENS:CORR:COLL:GUID:LIST:STEP:STYP?

The following list of enumerations is currently defined:

OPEN | SHORt | LOAD | REFLection | THRU | LINE | ECAL | ISOLation | COMPosite | SENSor |

PHASeref | MIXer

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<ListCount> Step number from 1 to 1000.

<StandardCount> Standard number from 1 to 3.

Examples SENS:CORR:COLL:GUID:LIST:STEP:STAN:STYP?
sense2:correction:collect:guided:list:step1:standard2:stype?

Return Type Enumeration

Default OPEN

SENSe<ch>:CORRection:COLLect:GUIDed:LIST:STEP<ListCount>:STANdard<StandardCount>:TPORts?

Applicable Models: All

(Read-only) Returns the list of VNA test ports to which one of the standards is attached. If the step

contains only a single standard, the response to this query is identical to

 SENS:CORR:COLL:GUID:LIST:STEP:TPORts?

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<ListCount> Step number from 1 to 1000.

<StandardCount> Standard number from 1 to 3.

Examples SENS:CORR:COLL:GUID:LIST:STEP:STAN:TPOR?
sense2:correction:collect:guided:list:step1:standard2:tports?

Return Type Numeric

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:LIST:STEP<ListCount>:STYPe?
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Applicable Models: All

(Read-only) Returns the enumeration for the type of standard device used in the step. 

The following list of enumerations is currently defined:

OPEN | SHORt | LOAD | REFLection | THRU | LINE | ECAL | ISOLation | COMPosite | SENSor |

PHASeref | MIXer

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<ListCount> Step number from 1 to 1000.

Examples SENS:CORR:COLL:GUID:LIST:STEP:STYP?
sense2:correction:collect:guided:list:step1:stype?

Return Type Enumeration

Default OPEN

SENSe<ch>:CORRection:COLLect:GUIDed:LIST:STEP<ListCount>:TPORts?

Applicable Models: All

(Read-only) Returns the list of VNA test ports to which the standard(s) in this step is attached.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<ListCount> Step number from 1 to 1000.

Examples SENS:CORR:COLL:GUID:LIST:STEP:TPOR?
sense2:correction:collect:guided:list:step1:tports?

Return Type Numeric

Default Not Applicable

SENSe:CORRection:COLLect:GUIDed:METHod <char> Superseded

1171



Applicable Models: N522xB, N523xB, N524xB, M937xA

This command is replaced with SENS:CORR:COLL:GUID:PATH:CMEThod and

SENS:CORR:COLL:GUID:PATH:TMEThod.

(Read-Write) Selects from one of several algorithms available for performing the THRU portion of a

guided calibration. Learn more about THRU methods.

Parameters  

<char> DEFAULT - Informs guided calibrations to use the default algorithm when

computing the number of needed standards acquisition steps. (default selection

if omitted.)

ADAP - Use the adapter removal algorithm

FLUSH - Use with insertable devices.

UNKN - Use the Unknown THRU algorithm with calibrations for non-

insertable devices.

DEFined  - Use the THRU definition that you stored in the cal kit file, or ECal

module.

TRL - Select TRL Cal Type for guided cals.  Valid for "TRL ready" Cal Kits

with properly assigned TRL cal classes.

SOLT  - Select SOLT Cal Type for guided cals.  Valid for any kit with

properly assigned SOLT cal classes.

Examples SENS:CORR:COLL:GUID:METH ADAP
sense:correction:collect:guided:method unkn 

Query Syntax SENSe:CORRection:COLLect:GUIDed:METHod?

Return Type Character

Default DEFAULT

SENSe<ch>:CORRection:COLLect:GUIDed:PACQuire STAN<n>
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Applicable Models: All

(Write-only) Show the Cal Window , and optionally one or more other specific windows before

acquiring a Cal standard. This command will cause the Cal Window to display the specific

measurements that are to be made for that particular Cal standard to facilitate the connection of

standards.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

STAN<n> Choose from:STAN1, STAN2, etc. through STANn where n is the number of

cal standard connection steps for the calibration.

Note: You do not necessarily have to invoke these connection steps in

sequential order.

Examples SENS:CORR:COLL:GUID:PACQuire STAN2

sense:correction:collect:guided:pacquire STAN5

See an example that uses this command.

Query Syntax Not Applicable

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:PATH:CMEThod
<port1>,<port2>,<caltype1[,caltype2]>

Applicable Models: All

Note: This command replaces SENS:CORR:COLL:GUID:METH .

(Read-Write) Specifies the calibration method for each port pair.

Note: Sending this command will overwrite the VNAs SmartCal determinations for the most accurate

cal method for your connector settings and Cal Kits.  Send this command ONLY if you have a

deliberate reason for overwriting the SmartCal logic. You can send the query form of this command to

learn the cal method determined by SmartCal.

See Thru Pairs Sequence to learn how to send this and other Thru commands.

After sending this command, send the query form to be sure that the command was accepted. If not,

then the chosen Cal method is not compatible with the specified Thru method. For example, if the

specified Thru method is Unknown Thru, an attempt to set Enhanced Response Cal should be
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rejected.

Learn more about Thru Methods.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<port1> First port of the pair to be calibrated.

<port2> Second port of the pair to be calibrated.

<caltype1[caltype2]> (String) Cal type for the port pair, enclosed in a single pair of quotes.  NOT

case-sensitive.

caltype1 Choose from:

TRL

SOLT

QSOLTN

EnhRespN

TransRespN

For the last two arguments, replace N with the port to be used as the source

port, which MUST be one of the port pair.

caltype2  Optional argument. Use only when performing an adapter

removal cal on the pair. This argument specifies the Cal type on the

second port.  Caltype1 then specifies the Cal type of the first port.

Choose from the same arguments as caltype1.

Examples SENS:CORR:COLL:GUID:PATH:CMEThod 2,3,"QSOLT2"

sense:correction:collect:guided:path:cmethod 2,3,"solt,trl"

Query Syntax SENSe<ch>:CORRection:COLLect:GUIDed:PATH:CMEThod?

<port1>,<port2>

If only one caltype is returned then its NOT adapter removal.

Return Type String

Default The most accurate Cal method for the current cal.
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SENSe<ch>:CORRection:COLLect:GUIDed:PATH:TMEThod
<port1>,<port2>,<thruType1[,thruType2]>

Applicable Models: All

Note: This command replaces SENS:CORR:COLL:GUID:METH .

(Read-Write) Specifies the calibration THRU method for each port pair.

Note: Sending this command will overwrite the VNAs SmartCal determination for the thru method.

 Send this command ONLY if you have a deliberate reason for overwriting the SmartCal logic.   You

can send the query form of this command to learn the THRU method determined by SmartCal.

See Thru Pairs Sequence to learn how to send this and other Thru commands.

Learn more about Thru methods.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<port1> First port of the port pair to be calibrated.

<port2> Second port of the port pair to be calibrated.

<thruType1[,thruType2]> (String) Thru methods for port pair, enclosed in a single pair of quotes.

 NOT case-sensitive.

thruType1  Calibration Thru method. Choose from:

Defined Thru  Measures a Thru for which there is a stored definition in the
Cal kit of the lowest-numbered port of the pair. For example, if the port pair
is 1,2, then the cal kit for port 1 MUST contain a Defined Thru.

Zero Thru  Measures a Zero length Thru, also known as Flush-Thru.

Undefined Thru  (Also known as Unknown Thru)  A Thru type for which
there is NOT a stored definition in the Cal Kit. Valid ONLY for SOLT cal
type.

Undefined Thru using a Defined Thru  (ECal modules ONLY) Measures
the internal Thru as an Unknown Thru.

thruType2  Optional argument. Use ONLY when Adapter Removal Cal

is specified for the pair using

SENS:CORR:COLL:GUID:PATH:CMEThod . When specifying

ThruType2, this is the only valid argument: "Defined Thru, Defined

Thru"
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Examples SENS:CORR:COLL:GUID:PATH:TMEThod 2,3,"Zero Thru"
sense:correction:collect:guided:path:tmethod 2,3,"Defined
Thru,Defined Thru"

Query Syntax SENSe<ch>:CORRection:COLLect:GUIDed:PATH:TMEThod?

<port1>,<port2>

Always returns two parts:

If the second part of the string is empty, adapter removal is NOT being

performed.

If the string is "Defined Thru, Defined Thru", adapter removal IS being

performed.

Return Type String

Default The most accurate Thru method for the current cal.

SENSe<ch>:CORRection:COLLect:GUIDed:PORTs?

Applicable Models: All

(Read-only) Returns the list of ports being calibrated by an active calibration session.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

Examples SENS:CORR:COLL:GUID:PORT?
sense2:correction:collect:guided:ports?

Return Type List of numbers

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:PREFerence:SLIDingload <char>
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Applicable Models: All

(Read-Write) Specifies the behavior for guided cal steps that involve a sliding load in a cal that is

about to be performed. Send this command BEFORE sending the Guided INIT command.

Although the term 'Preference' is used in the command, this is NOT a VNA preference. This setting

does NOT survive instrument preset or reboot. It remains ONLY for the duration of the Guided Cal.

Parameters  

<char> Behavior when measurements of sliding load are acquired. Choose from:

DIALog - The Sliding load dialog box appears when the acquire command is

received for a sliding load step.  All slide positions are measured (with a user-

interface prompt) from a single invocation of the acquire command.

ITERate - Each invocation of the acquire command for a sliding load step

measures a single slide position and increments the slide position counter. No

Move Sliding Load prompt is presented on the VNA screen.

Examples SENS:CORR:COLL:GUID:PREF:SLID ITER

See example program

Query Syntax SENSe<ch>:CORRection:COLLect:GUIDed:PREFerence:SLIDingload?

Return Type Character

Default DIALog

SENSe<ch>:CORRection:COLLect:GUIDed:SAVE[:IMMediate] [bool]

Applicable Models: All

(Write-only) Completes the guided cal by computing the error correction terms, turning Correction
ON, and saving the calibration to a Cal Set. If all of the required standards have not been measured,

the calibration will not complete properly.

Learn all about Cal Sets.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

[bool] Optional argument. If unspecified, the default behavior is the current VNA

preference setting of SENSe:CORRection:PREFerence:CSET:SAVE .

OFF (0)    Save cal data ONLY to a Cal Register.
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ON (1)   Save cal data to a Cal Register and a User Cal Set. The filename is

automatically generated.

For application channels (Gain Compression, SMC/VMC, Noise Figure, IMD and
so forth), this command saves ONLY to a Cal Register. Use
SENS:CORR:CSET:COPY to copy the cal register to a named calset.

For a Calibrate All Channels session, this argument is ignored.  Instead, use
SYST:CAL:ALL:CSET:PREFix .

Examples SENS:CORR:COLL:GUID:SAVE
sense2:correction:collect:guided:save:immediate 0

Query Syntax Not Applicable

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:SAVE:CSET <cal set name or guid>

Applicable Models: All

(Write-only) Completes the guided cal by computing the error correction terms, turning Correction

ON, and saving the calibration to an existing, specified Cal Set. This command performs the same

function as SENSe:CORRection:COLLect:GUIDed:SAVE , except this command allows the name or

GUID of the Cal Set to be specified.

Learn all about Cal Sets.

Note: This command is NOT supported for application channels (Gain Compression, SMC/VMC,

Noise Figure, IMD and so forth). Use SENS:CORR:COLL:GUID:SAVE and save to a cal register.

You can then use SENS:CORR:CSET:COPY to copy the cal register to a named Cal Set.

Use this command instead of specifying the optional name or GUID argument in
SENS:CORR:COLL:GUID:INIT .

Use SENS:CORRection:CSET commands to get names or GUIDs of existing Cal Sets.

The cal data is also saved to the channel Cal Register.

If all of the required standards have not been measured, the calibration will not complete properly.

For Calibrate All Channels

When this command is used during a Cal All session, the <cal set name> argument sets the User Cal

Set prefix.  All generated Cal Sets will be preceded with this string name.
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Cal Set prefix can also be set using SYST:CAL:ALL:CSET:PREFix . When the Cal Set prefix has already
been set with SYST:CAL:ALL:CSET:PREFix , this command overwrites it.

When <cal set name> is an empty string, a User Cal Set will not be saved.  Only Cal Registers will be
saved.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<cal set name or

guid>

String - Name or GUID of an existing Cal Set to be overwritten. If specifying a

GUID, curly brackets must be included.

See Calibrate All Channels note (above).

Examples SENS:CORR:COLL:GUID:SAVE:CSET "{2B893E7A-971A-11d5-8D6C-
00108334AE96}"

sense:correction:collect:guided:save:cset "MyCalSet"

Query Syntax Not Applicable

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:STEPs?

Applicable Models: All

(Read-only) Returns the number of measurement steps required to complete the current guided

calibration. This command is sent after the SENS:CORR:COLL:GUID:INIT ,

SENS:CORR:COLL:GUID:CONN:PORT and SENS:CORR:COLL:GUID:CKIT:PORT commands.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

Examples SENS:CORR:COLL:GUID:STEP?
sense2:correction:collect:guided:steps?

Return Type Numeric

Default Not Applicable

SENSe<ch>:CORRection:COLLect:GUIDed:THRU:PORTs <t1a, t1b, t2a, t2b, t3a, t3b...>
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Applicable Models: All

(Read-Write) For calibrating more than 2-ports ONLY. Specifies the port pairs for the Thru

connections of the calibration.  Send the query form of this command to learn the Thru pairs

determined by SmartCal.

Note: Sending this command will overwrite the VNAs SmartCal determinations for the thru ports.

 Send this command ONLY if you have a deliberate reason for overwriting the SmartCal logic.

See Thru Pairs Sequence to learn how to send this and other Thru commands.

Parameters  

<ch> Channel being calibrated, depending on the CHAN:MODE setting.  If

unspecified, value is set to 1.

<t1a,t1b...> Always specify port numbers in pairs: For example: 1,2 or 1,2,1,3

For 3-port cals, specify two or three pairs.

For 4-port cals, specify from three up to six pairs.

Examples SENS:CORR:COLL:GUID:THRU:PORT 1,2,1,3,1,4 '4-port measurement

sense:correction:collect:guided:thru:ports 1,2,2,3 '3-port
measurement

Query Syntax SENSe<ch>:CORRection:COLLect:GUIDed:THRU:PORTs?

Return Type Numeric

Default Port pairings that were used in the previous cal.

THRU Pairs sequence

The SmartCal logic always determines the best calibration based on your specified connectors and

ports.

The following three commands overwrite the SmartCal logic. Send these commands ONLY if you have
a deliberate reason for overwriting the SmartCal logic.

sens:corr:coll:guid:THRU:PORTS <p1, p2>    

sens:corr:coll:guid:path:tmet <p1,p2, thrutype>

sens:corr:coll:guid:path:cmet <p1,p2, calmethod>

When sending one or more of these commands, they must be sent in the following sequence with the

other commands listed here.
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Note: The GUID:INIT command is sent before and after these commands.

SENS:CORR:COLL:GUID:CONN:PORT(N)1.

SENS:CORR:COLL:GUID:CKIT:PORT (N)2.

SENS:CORR:COLL:GUID:INIT3.

SENS:CORR:COLL:GUID:THRU:PORTS <P1, P2>  4.

SENS:CORR:COLL:GUID:PATH:TMET <P1,P2, THRUTYPE>5.

SENS:CORR:COLL:GUID:PATH:CMET <P1,P2, CALMETHOD>6.

SENS:CORR:COLL:GUID:PATH:CMET ? <P1,P2> (RECOMMENDED)7.

SENS:CORR:COLL:GUID:INIT8.
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Sense:Couple Commands

Click on a keyword to view the command details.

See Also

Example Programs

Synchronizing the Analyzer and Controller

SCPI Command Tree

SENSe<cnum>:COUPle <ALL | NONE>

Applicable Models: All

(Read-Write) Sets the sweep mode as Chopped or Alternate.

Learn about Alternate Sweep

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<ALL | NONE> ALL - Sweep mode set to Chopped - reflection and transmission measured on

the same sweep.

NONE - Sweep mode set to Alternate - reflection and transmission measured

on separate sweeps. Improves Mixer bounce and Isolation measurements.

Increases sweep time

Examples SENS:COUP ALL
sense2:couple none

Query Syntax SENSe<cnum>:COUPle?

Return Type Character

Default ALL

SENSe<cnum>:COUPle:PARameter[:STATe] <bool>
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Applicable Models: All

(Read-Write)  Turns ON and OFF Time Domain Trace Coupling. All of the measurements in the

specified channel are coupled.

To select Transform parameters to couple, use CALC:MEAS:TRAN:COUP:PAR

To select Gating parameters to couple, use CALC:MEAS:FILT:COUP:PAR

Learn more about Time Domain Trace Coupling.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<bool> ON (or 1) - Turns ON Time Domain Trace Coupling.

OFF (or 0) - Turns OFF Time Domain Trace Coupling.

Examples SENS:COUP:PAR 0
sense2:couple:parameter:state on

Query Syntax SENSe<cnum>:COUPle:PARameter[:STATe]?

Return Type Boolean

Default ON (or 1)

 

1183



Sense DC

Controls the PXI DC measurement.

SENSe:DC:

    | CURRent:RANGe

| SAMPles

    | DPOint

    | POINts

    | TIME

| VOLTage:RANGe

Click on a keyword to view the command details.

 

SENSe<ch>:DC:CURRent:RANGe <name>, <num>

Applicable Models: M937xA, M9485A

(Read-Write) Sets and reads the range (in Amps) used for sensing current, which must be higher than

the maximum current you expect to measure. This command is available for PXI SMU only. This is

the same function with “IKtM911xMeasurement Interface” section, “SenseCurrentRange” property of

the M911x driver.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<name> String. DC Meter Name.

 "SMU*C” or “SMU*V” represents the SMU DC Meter name. “*” is the SMU

module number. “C” means current measurement, “V” means voltage

measurement.

<num> Range in Amps (3, 0.001 or 0.0001)

Examples SOUR:DC:CURR:RANG "SMU1", 10

Query Syntax SENSe<ch>:DC:CURRent:RANGe? <name>

Return Type Numeric
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Default 3

SENSe<ch>:DC:SAMPles:DPOint <name>, <num>

Applicable Models: M937xA, M9485A

(Read-Write) Sets and reads the trigger offset in the measurement sweep. A negative value specifies

pre-trigger samples, and a positive value specifies post-trigger delay samples.  This command is

available for PXI SMU only. This is the same function with “IKtM911xMeasurementSweep

Interface” section, “OffsetPoints” property of the M911x driver.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<name> String. DC Meter Name.

 "SMU*C” or “SMU*V” represents the SMU DC Meter name. “*” is the SMU

module number. “C” means current measurement, “V” means voltage

measurement.

<num> Offset points value. Value range: 1 to 100000, step 1,  

Examples SOUR:DC:SAMP:DPO "SMU1", 10

Query Syntax SENSe<ch>:DC:SAMPLes:DPOint? <name>

Return Type Numeric

Default 0

SENSe<ch>:DC:SAMPles:POINTs <name>, <num>
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Applicable Models: M937xA, M9485A

(Read-Write) Sets and reads the DC measurement number of sample counts per one point

measurement. This command is available for both PXI SMU and Digital/Analog I/O M9341B. For

PXI SMU, this is the same function with “IKtM911xMeasurementSweep Interface” section, “Points”

property of the M911x driver.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<name> String. DC Meter Name.

[SMU] "SMU*C” or “SMU*V” represents the SMU DC Meter name. “*” is

the SMU module number. “C” means current measurement, “V” means voltage

measurement.

[M9341B]  "AI1", "AI2", "AI3", "AI4", "AOC1" or" AOC2"

<num> Sample count value. Value range: 1 to 100000, step 1 (SMU),  

Examples SOUR:DC:SAMP:POINT "SMU1", 1000

Query Syntax SENSe<ch>:DC:SAMPLes:POINTs? <name>

Return Type Numeric

Default 3255 (SMU), 500000 (M9341B)

SENSe<ch>:DC:SAMPles:TIME <name>, <num>

Applicable Models: M937xA, M9485A

(Read-Write) Sets and reads the DC measurement time per one point measurement . The value of

SENSe:DC:SAMPles:POINts can be calculated by this value. This command allows you to have the
same measurement time for different kind of modules whose sample rates are different. This

command is available for both PXI SMU and Digital/Analog I/O M9341B.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<name> String. DC Meter Name.

[SMU] "SMU*C” or “SMU*V” represents the SMU DC Meter name. “*” is
the SMU module number. “C” means current measurement, “V” means voltage

measurement.
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[M9341B]  "AI1", "AI2", "AI3", "AI4", "AOC1" or" AOC2",

<num> Measurement time in seconds

[SMU] M9111A sample time is 5.12usec per point.

[M9341B] Only one value can be set for one M9341B module. It sample time

is 20 nsec per point.

Examples SOUR:DC:SAMP:TIME "SMU1C", 1000

Query Syntax SENSe<ch>:DC:SAMPLes:TIME? <name>

Return Type Numeric

Default 0.0166656  (SMU), 0.01 (M9341B)

SENSe<ch>:DC:VOLTage:RANGe <name>, <num>

Applicable Models: M937xA, M9485A, E5080A

(Read-Write) Sets and reads the range (in Volts) used for sensing voltage, which must be higher than

the maximum voltage you expect to measure.  This command is available for M937xA, M9485A with

Digital/Analog I/O M9341B or E5080A.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<name> String. DC Meter Name.

 "AI1", "AI2", "AI3", or "AI4"

<num> Range in Volts (M937xA, M9485A: 1, 5 or 10) (E5080A: 1or 10)

Examples SOUR:DC:CURR:RANG "AI1", 10

Query Syntax SENSe<ch>:DC:VOLTage:RANGe? <name>

Return Type Numeric

Default 10
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DUT Control

When you use the M9485A and M93xxA, you can control the M9341B 8 bit IO through the VNA

firmware. The following commands are available when the launcher includes the M9341B.

SENSe:DUTControl:M9341:[MODule]

       | [:STATe]

       | :IOTYpe

       | :LEVel

       | :PIO

           | :TYPE

           | :LEVel

        | :RFFE

           | :CLOCk

           | :CSEQuence

               | :SADDress

               | :TYPE

               | :BCOunt

               | :ADDRess

               | [:WRITe]:DATA

               | :READ:DATA

               | :COUNt

Click on a keyword to view the command details.

 

SENSe<cnum>:DUTControl:M9341[:MODule<mod>][:STATe] <bool>
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Applicable Models: M9485A, M937xA

(Read-Write) Sets and reads the DUT Control function state for each channel.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command

is common for all channels and the setting is ignored.

<mod> Module number of M9341B. The number starts from 1 for the leftmost module

of M9341B.

<bool> Module control state. Choose from:

O or OFF - Skips to control the M9341A/B at the specified channel.

1 or ON - Enables to control the M9341A/B at the specified channel.

Examples SENS:DUTC:M9341
sense2:dutcontrol:m9341?

Query Syntax :SENSe<cnum>:DUTControl:M9341[:MODule<mnum>][:STATe]?

Return Type Boolean

Default OFF or 0

:SENSe<cnum>:DUTControl:M9341[:MODule<mod>]:IOTYpe<iogroup> <iofunc>

Applicable Models: M9485A, M937xA

(Read-Write) Sets and returns I/O function type of the 8 bit Input/Output pins, for each I/O group.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command

is common for all channels and the setting is ignored.

<mod> Module number of M9341B. The number starts from 1 for the leftmost module

of M9341B.

<iogroup> IO group number. Value range, 1 to 4.

1: Group 1 (pins No. 1 and 2)

2: Group 2 (pins No. 3 and 4)

3: Group 3 (pins No. 5 and 6)

4: Group 4 (pins No. 7 and 8)
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<iofunc> set the IO function for the io group. <PARallel | RFFE>.

Examples SENS:DUTC:M9341:IOTY1 PAR
sense2:dutcontrol:m9341:module2:iotype RFFE

Return Type Char

Default PARallel

:SENSe<cnum>:DUTControl:M9341[:MODule<mod>]:LEVel <lvl>

Applicable Models: M9485A, M937xA

(Read-Write) Sets and reads the output voltage level of the M9341B 8bit I/O

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<mod> Module number of M9341B. The number starts from 1 for the leftmost module

of M9341B.

<lvl> IO level in volt. Value range: 0.9 to 3.5. Step 0.05.

Examples SENS:DUTC:M9341:LEV 1.5
sense2:dutcontrol:m9341:module2:level?

Query Syntax :SENSe<cnum>:DUTControl:M9341[:MODule<mnum>]:LEVel?

Return Type Numeric

Default 1.2

:SENSe<cnum>:DUTControl:M9341[:MODule<mod>]:PIO<iopin>:TYPE <dir>
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Applicable Models: M9485A, M937xA

(Read-Write) Sets and reads the signal direction type of Parallel IO, for each IO pin. This setting is

valid when the io pin function is selected as parallel IO.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<mod> Module number of M9341B. The number starts from 1 for the leftmost module

of M9341B.

<iopin> IO pin number

<dir> IO direction. Choose from: IN or OUT

Examples SENS:DUTC:M9341:PIO:TYPE IN
sense2:dutcontrol:m9341:module2:pio2:type?

Query Syntax :SENSe<cnum>:DUTControl:M9341[:MODule<mnum>]:PIO<iopin>:TYPE?

Return Type Character

Default OUT

:SENSe<cnum>:DUTControl:M9341[:MODule<mod>]:PIO<iopin>:LEVel <lvl>

Applicable Models: M9485A, M937xA

(Read-Write) Sets and reads the signal level of IO pin, high or low. This setting is valid when the io

pin function is selected as parallel IO.

If the IO type is IN, this command shall be a read-only command. Write command will cause error.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<mod> Module number of M9341B. The number starts from 1 for the leftmost module

of M9341B.

<iopin> IO pin number

<lvlr> Signal level. Choose from: HIGH or LOW

Examples SENS:DUTC:M9341:PIO:LEV LOW
sense2:dutcontrol:m9341:module2:pio2:level?

Query Syntax :SENSe<cnum>:DUTControl:M9341[:MODule<mnum>]:PIO<iopin>:LEVel?

Return Type Char
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Default LOW

:SENSe<cnum>:DUTControl: M9341[:MODule<mod>]:RFFE:CLOCk <clk>

Applicable Models: M9485A, M937xA

(Read-Write) Sets and reads the RFFE clock rate.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command

is common for all channels and the setting is ignored.

<mod> Module number of M9341B. The number starts from 1 for the leftmost module

of M9341B.

<clk> Clock rate in Hz. Value range, 25kHz to 25000kHz. Possible values are

50000/n, with integer n, 2000 to 2. User can use suffix such as “kHz” and so

on.

Examples :SENS:DUTC:M9341:RFFE:CLOCk 25KHZ

sense2:dutcontrol:m9341:module2:rffe:clock?

Query Syntax :SENSe<cnum>:DUTControl: M9341[:MODule<mnum>]:RFFE:CLOCk?

Return Type numeric

Default 50000

:SENSe<cnum>:DUTControl:M9341[:MODule<mod>]:RFFE<rffech>:CSEQuence<csnum>:SADDress
<adrs>
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Applicable Models: M9485A, M937xA

(Read-Write) Sets and reads the Slave Address (“SA” in GUI) for the specified command sequence.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command is common for all channels

and the setting is ignored.

<mod> Module number of M9341B. The number starts from 1 for the leftmost module of M9341B.

<rffech> RFFE channel number. 1 to 4

<csnum> RFFE command sequence number. 1 to 16.

<adrs> DUT RFFE Slave Address. 0 to 15.

Examples :SENS:DUTC:M9341:RFFE:CSEQ:SADD 2

sense2:dutcontrol:m9341:module2:rffe:csequence2:saddress?

Query

Syntax

:SENSe<cnum>:DUTControl:M9341[:MODule<mnum>]:RFFE<rffech>:CSEQuence<csnum>:SADDress?

Return

Type

numeric

Default 0

:SENSe<cnum>:DUTControl:M9341[:MODule<mod>]:RFFE<rffech>:CSEQuence<csnum>:TYPE
<typ>

Applicable Models: M9485A, M937xA

(Read-Write) Sets and reads the command sequence type for the specified command sequence.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command is common for all

channels and the setting is ignored.

<mod> Module number of M9341B. The number starts from 1 for the leftmost module of M9341B.

<rffech> RFFE channel number. 1 to 4

<csnum> RFFE command sequence number. 1 to 16.

<adrs> RFFE command sequence type. Choose from:

R0WRite : Register 0 Write

RREad : Register Read
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RWRite : Register Write

ERRead : Extended Register Read

ERWRite : Extended Register Write

Examples :SENS:DUTC:M9341:RFFE:CSEQ:TYPE R0WR

sense2:dutcontrol:m9341:module2:rffe:csequence2:type?

Query

Syntax

:SENSe<cnum>:DUTControl:M9341[:MODule<mnum>]:RFFE<rffech>:CSEQuence<csnum>:TYPE?

Return

Type

Char

Default RREad

:SENSe<cnum>:DUTControl:M9341[:MODule<mod>]:RFFE<rffech>:CSEQuence<csnum>:BCOunt
<byt>

Applicable Models: M9485A, M937xA

(Read-Write) Sets and reads the byte count for the specified command sequence.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command is common for all channels

and the setting is ignored.

<mod> Module number of M9341B. The number starts from 1 for the leftmost module of M9341B.

<rffech> RFFE channel number. 1 to 4

<csnum> RFFE command sequence number. 1 to 16.

<byt> Byte Count value. Integer value. The value range is coupled with command sequence type setting.

Command sequence type Byte count range

Register 0 Write

Register Read

Register Write

1

Extended Register Write

Extended Register Read

1 to 16
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Examples :SENS:DUTC:M9341:RFFE:CSEQ:BCO 4

sense2:dutcontrol:m9341:module2:rffe:csequence2:bcount?

Query

Syntax

:SENSe<cnum>:DUTControl:M9341[:MODule<mnum>]:RFFE<rffech>:CSEQuence<csnum>:BCOUnt?

Return

Type

Numeric

Default 1

SENSe<cnum>:DUTControl:M9341[:MODule<mod>]:RFFE<rffech>:CSEQuence<csnum>:ADDRess
<adrs>

Applicable Models: M9485A, M937xA

(Read-Write) Sets and reads the address value for the specified command sequence..

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command is common for all channels

and the setting is ignored.

<mod> Module number of M9341B. The number starts from 1 for the leftmost module of M9341B.

<rffech> RFFE channel number. 1 to 4

<csnum> RFFE command sequence number. 1 to 16.

<adrs> Address value. Integer value. The value range is coupled with command sequence type setting.

Command sequence type Byte count range

Register 0 Write 0 (fixed)

Register Read

Register Write

#h00 to #h1F (0-31)

Extended Register Write

Extended Register Read

#h00 to #hFF (0-255)

 

Examples :SENS:DUTC:M9341:RFFE:CSEQ:ADDR 2

sense2:dutcontrol:m9341:module2:rffe:csequence2:address?

Query

Syntax

:SENSe<cnum>:DUTControl:M9341[:MODule<mnum>]:RFFE<rffech>:CSEQuence<csnum>:ADDRess?
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Return

Type

Numeric

Default 0

SENSe<cnum>:DUTControl:M9341[:MODule<mnum>]:RFFE<rffech>:CSEQuence<csnum>[:WRITe]:DATA
<data>

Applicable Models: M9485A, M937xA

(Read-Write) Sets and reads  the data values for the specified command sequence.

This command works if the command sequence type is “Register 0 Write” or “Register Write” or “Extended Register Write”. If

the command sequence type is “Register Read” or ”Extended Register Read”, this command will cause error.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command is common for all channels and the

setting is ignored.

<mod> Module number of M9341B. The number starts from 1 for the leftmost module of M9341B.

<rffech> RFFE channel number. 1 to 4

<csnum> RFFE command sequence number. 1 to 16.

<adrs> comma separated list of data values. The value length is coupled with byte count setting. If data list length does

not match with byte count setting, write command  will cause error.

Examples :SENS:DUTC:M9341:RFFE:CSEQ:WRIT:DATA 10

sense2:dutcontrol:m9341:module2:rffe:csequence2:write:data?

Query

Syntax

:SENSe<cnum>:DUTControl:M9341[:MODule<mnum>]:RFFE<rffech>:CSEQuence<csnum>[:WRITe]:DATA?

Return

Type

Comma separated numeric values

Default 0

SENSe<cnum>:DUTControl:M9341[:MODule<mnum>]:RFFE<rffech>:CSEQuence<csnum>:READ:DATA?
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Applicable Models: M9485A, M937xA

(Read only) Reads the data and parity value pairs from DUT for the specified command sequence.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command is common for all channels and

the setting is ignored.

<mod> Module number of M9341B. The number starts from 1 for the leftmost module of M9341B.

<rffech> RFFE channel number. 1 to 4

<csnum> RFFE command sequence number. 1 to 16.

Examples :SENS:DUTC:M9341:RFFE:CSEQ:READ:DATA?

sense2:dutcontrol:m9341:module2:rffe:csequence2:read:data?

Query

Syntax

:SENSe<cnum>:DUTControl:M9341[:MODule<mnum>]:RFFE<rffech>:CSEQuence<csnum>:READ:DATA?

Return

Type

Comma separated numeric values,  list of data and parity pairs.

Ex. Byte count is 3 case, return values are below:

[data#1],[parity#1],[data#2],[parity#2],[data#3],[parity#3]

Default Not applicable

SENSe<cnum>:DUTControl:M9341[:MODule<mnum>]:RFFE<rffech>:CSEQuence<csnum>:COUNt
<cnt>

Applicable Models: M9485A, M937xA

(Read-Write) Sets and reads the the number of RFFE Command Sequence. If user set the larger value than previously
set, new RFFE command sequences will be added with the default parameter value.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command is common for all channels

and the setting is ignored.

<mod> Module number of M9341B. The number starts from 1 for the leftmost module of M9341B.

<rffech> RFFE channel number. 1 to 4

<cnt> RFFE Command Sequence count. 1 to 16.

Examples :SENS:DUTC:M9341:RFFE:CSEQ:COUN 10

sense2:dutcontrol:m9341:module2:rffe:csequence2:count?
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Query

Syntax

:SENSe<cnum>:DUTControl:M9341[:MODule<mnum>]:RFFE<rffech>:CSEQuence<csnum>:COUNt?

Return

Type

Numeric

Default 0
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Sense:FOM (Frequency Offset) Commands

Controls the frequency offset settings which cause stimulus and response frequencies to be different.

Note: These commands replace the previous FOM commands. Although the old commands will

continue to work, they can NOT be mixed with these new commands.

Click on a red keyword to view the command details.

See Also

FOM Example Program

Learn about Frequency Offset

Synchronizing the Analyzer and Controller

SCPI Command Tree

SENSe<cnum>:FOM[:STATe] <bool>
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Applicable Models: All

(Read-Write) Turns Frequency Offset ON and OFF. Frequency offset settings are not enabled until

this setting is ON.

Send this command (FOM ON) AFTER sending other FOM settings to avoid 'out-or-range' errors.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<bool> ON (or 1) - turns FOM ON.

OFF (or 0) - turns FOM OFF.

Examples SENS:FOM 1
sense2:fom:state on

Query Syntax SENSe<cnum>:FOM:STATe?

Return Type Boolean

Default OFF

SENSe<cnum>:FOM:CATalog?

Applicable Models: All

(Read-only) Returns a comma-separated list of available range names in the VNA.

Use SENS:FOM:CAT? to see a list of available range names.

Use SENS:FOM:COUNt? to see a list of available range numbers.

Use SENS:FOM:RNUM? to see the range number for a specific name.

Use SENS:FOM:RANG:NAME? to see the range name for a specific number.

External devices can appear in the list of range names. Learn more.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

Examples SENS:FOM:CAT?

'returns

"Primary, Source, Receivers"

Return Type String
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Default Not Applicable

SENSe<cnum>:FOM:COUNt?

Applicable Models: All

(Read-only) Returns the number of valid range numbers in the VNA.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

Examples SENS:FOM:COUN?
sense2:fom:count?

Query Syntax SENSe<cnum>:FOM:COUNt?

Return Type Numeric

Default Not Applicable

SENSe<cnum>:FOM:DISPlay:SELect <string>

Applicable Models: All

(Read-Write) Select the range to be displayed on the VNA x-axis. All traces in the channel have this

same x-axis scaling.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<string> Range name. Case insensitive. Use SENSe:FOM:CAT? to see a list of available

frequency range names.

Examples SENS:FOM:DISPlay:SELect "source2"
sense2:fom:display:select "source"

Query Syntax SENSe<cnum>:FOM:DISPlay:SELect?

Return Type String

Default Receivers

SENSe<cnum>:FOM:RNUM? <string>
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Applicable Models: All

(Read-only) Returns the number of a specified range name.

The FOM range items are typically numbered as follows:

Primary1.

Source2.

Receivers3.

Source2 (if present)4.

Use SENS:FOM:CAT? to see a list of available range names.

Use SENS:FOM:COUNt? to see a list of available range numbers.

Use SENS:FOM:RANG:NAME? to see the range name for a specific number.

External devices can appear in the list of range names. Learn more.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<string> Range name for which a number is being queried. Case insensitive.

Examples SENS:FOM:RNUM? "receivers"
sense2:fom:rnum? "Source2"

Return Type Numeric

Default Not Applicable

SENSe<cnum>:FOM:RANGe<n>:COUPled <bool>
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Applicable Models: All

(Read-Write) Sets and returns the state of coupling (ON or OFF) of the specified range to the primary

range.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number to couple to primary range. An error is returned when

attempting to couple to the Primary range (1).

Use SENS:FOM:CAT? to see a list of available range names.

Use SENS:FOM:COUNt? to see a list of available range numbers.

Use SENS:FOM:RNUM? to see the range number for a specific name.

Use SENS:FOM:RANG:NAME? to see the range name for a specific number.

<bool> ON (or 1) - Couple range to primary range.

OFF (or 0) - Do NOT couple to primary range.

Examples SENS:FOM:RANG:COUP 1
sense2:fom:range2:coupled 0

Query Syntax SENSe<cnum>:FOM:RANGe<n>:COUPled?

Return Type Boolean

Default ON (or 1) Coupled

SENSe<cnum>:FOM:RANGe<n>:FREQuency:CW <num>
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Applicable Models: All

(Read-Write) Sets and returns the CW frequency.

This setting is valid for the primary range, or if the specified range is already uncoupled from the

primary range and if the sweep type is CW.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number.  If unspecified, value is set to 1.

Use SENS:FOM:CAT? to see a list of available range names.

Use SENS:FOM:COUNt? to see a list of available range numbers.

Use SENS:FOM:RNUM? to see the range number for a specific name.

Use SENS:FOM:RANG:NAME? to see the range name for a specific number.

<num> CW frequency value in Hz. Choose any frequency within the range of the

VNA.

Examples SENS:FOM:RANG:FREQ:CW 1e9
sense2:fom:range2:frequency:cw 10000000

Query Syntax SENSe<cnum>:FOM:RANGe:<n>:FREQuency:CW?

Return Type Numeric

Default Center frequency of the VNA.

SENSe<cnum>:FOM:RANGe<n>:FREQuency:DIVisor <num>

1204



Applicable Models: All

(Read-Write) Sets and returns the divisor value.

This setting is valid only if the specified range is coupled to the primary range.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number.  If unspecified, value is set to 1.

Use SENS:FOM:CAT? to see a list of available range names.

Use SENS:FOM:COUNt? to see a list of available range numbers.

Use SENS:FOM:RNUM? to see the range number for a specific name.

Use SENS:FOM:RANG:NAME? to see the range name for a specific number.

<num> Divisor value (unitless).

Examples SENS:FOM:RANG:FREQ:DIV 3
sense2:fom:range2:frequency:divisor 0

Query Syntax SENSe<cnum>:FOM:RANGe<n>:FREQuency:DIVisor?

Return Type Numeric

Default 1

SENSe<cnum>:FOM:RANGe<n>:FREQuency:MULTiplier <num>

Applicable Models: All

(Read-Write) Sets and returns the multiplier value to be used when coupling this range to the primary

range.

This setting is valid only if the specified range is coupled to the primary range.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number.  If unspecified, value is set to 1.

Use SENS:FOM:CAT? to see a list of available range names.

Use SENS:FOM:COUNt? to see a list of available range numbers.

Use SENS:FOM:RNUM? to see the range number for a specific name.
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Use SENS:FOM:RANG:NAME? to see the range name for a specific number.

<num> Multiplier value. (Unitless)

Examples SENS:FOM:RANG:FREQ:MULT 1
sense2:fom:range2:frequency:multiplier 2

Query Syntax SENSe<cnum>:FOM:RANGe<n>:FREQuency:MULTiplier?

Return Type Numeric

Default 1

SENSe<cnum>:FOM:RANGe<n>:FREQuency:OFFSet <num>

Applicable Models: All

(Read-Write) Sets and returns the offset value to be used when coupling this range to the primary

range. Learn more about offset value.

This setting is valid only if the specified range is coupled to the primary range.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number.  If unspecified, value is set to 1.

Use SENS:FOM:CAT? to see a list of available range names.

Use SENS:FOM:COUNt? to see a list of available range numbers.

Use SENS:FOM:RNUM? to see the range number for a specific name.

Use SENS:FOM:RANG:NAME? to see the range name for a specific number.

<num> Offset value. (Unitless)

Examples SENS:FOM:RANG:FREQ:OFFS 1E9
sense2:fom:range2:frequency:offset 10000000

Query Syntax SENSe<cnum>:FOM:RANGe<n>:FREQuency:OFFSet?

Return Type Numeric

Default 0

SENSe<cnum>:FOM:RANGe<n>:FREQuency:STARt <num>
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Applicable Models: All

(Read-Write) Sets and returns the Start value of frequency range. Also specify Stop frequency.

This setting is valid for the primary range, or if the specified range is already uncoupled from the

primary range and if the sweep type is LOG or LINear.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number.  If unspecified, value is set to 1.

Use SENS:FOM:CAT? to see a list of available range names.

Use SENS:FOM:COUNt? to see a list of available range numbers.

Use SENS:FOM:RNUM? to see the range number for a specific name.

Use SENS:FOM:RANG:NAME? to see the range name for a specific number.

<num> Start value in Hz. Choose any frequency within the range of the VNA.

Examples SENS:FOM:RANG:FREQ:STAR 1GHz
sense2:fom:range2:frequency:start 100000000

Query Syntax SENSe<cnum>:FOM:RANGe<n>:FREQuency:STARt?

Return Type Numeric

Default Minimum frequency of the VNA.

SENSe<cnum>:FOM:RANGe<n>:FREQuency:STOP <num>

Applicable Models: All

(Read-Write) Sets and returns the Stop value of frequency range. Also specify Start frequency.

This setting is valid for the primary range, or if the specified range is already uncoupled from the

primary range and if the sweep type is LOG or LINear.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number.  If unspecified, value is set to 1.

Use SENS:FOM:CAT? to see a list of available range names.

Use SENS:FOM:COUNt? to see a list of available range numbers.
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Use SENS:FOM:RNUM? to see the range number for a specific name.

Use SENS:FOM:RANG:NAME? to see the range name for a specific number.

<num> Stop value in Hz. Choose any frequency within the range of the VNA.

Examples SENS:FOM:RANG:FREQ:STOP 1e12
sense2:fom:range2:frequency:stop 10000000000

Query Syntax SENSe<cnum>:FOM:RANGe<n>:FREQuency:STOP?

Return Type Numeric

Default Maximum frequency of the VNA.

SENSe<cnum>:FOM:RANGe<n>:NAME?

Applicable Models: All

(Read-only) Returns the name of range<n>.

The FOM range items are typically named as follows:

Primary1.

Source2.

Receivers3.

Source2 (if present)4.

Use SENS:FOM:CAT? to see a list of available range names.

Use SENS:FOM:COUNt? to see a list of available range numbers.

Use SENS:FOM:RNUM? to see the range number for a specific name.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number.  If unspecified, value is set to 1.

Examples SENS:FOM:RANG:NAME?
sense2:fom:range2:name?

Return Type String

Default Not Applicable
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SENSe<cnum>:FOM:RANGe<n>:SWEep:TYPE <char>

Applicable Models: All

(Read-Write) Sets and returns the sweep type to be used with the specified range.

This setting is valid only if the specified range is already uncoupled from the primary range.

Learn about Unsupported Sweep Type combinations.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number.  If unspecified, value is set to 1.

Use SENS:FOM:CAT? to see a list of available range names.

Use SENS:FOM:COUNt? to see a list of available range numbers.

Use SENS:FOM:RNUM? to see the range number for a specific name.

Use SENS:FOM:RANG:NAME? to see the range name for a specific number.

<char> Sweep type. Choose from:

CW - Also specify CW frequency.

LINear - Also specify frequency Start/Stop or Center/Span

LOG -  Also specify frequency Start/Stop or Center/Span

PHASe - See all Phase sweep settings.

POWer -  Also specify power Start/Stop or Center/Span

SEGMent - Also specify segment sweep settings.

Examples SENS:FOM:RANG:SWE:TYPE LOG
sense2:fom:range2:sweep:type linear:

Query Syntax SENSe<cnum>:FOM:RANGe<n>:SWEep:TYPE?

Return Type Character

Default Linear
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Sense:FOM:Range:Segment Commands

Constructs a segment table for a specified UNCOUPLED FOM range.

Note: Do NOT use Sens:Segment commands for FOM segment sweep.

Click on a red keyword to view the command details.

See Also

Other SENSe:FOM Commands

Example Programs

Synchronizing the Analyzer and Controller

SCPI Command Tree

SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:ADD
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Applicable Models: All

(Write-only) Adds a segment.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

<s> Segment number to add.  If unspecified, value is set to 1. Segment numbers

must be sequential. If a new number is added where one currently exists, the

existing segment and those following are incremented by one.

Examples Two Segments exist (1 and 2). The following command will add a new segment (1). The
existing (1 and 2) will become (2 and 3) respectively.

sense2:fom:range2:segment:add

Query Syntax Not Applicable

Default Not Applicable

SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:BWIDth[:RESolution] <num>

Applicable Models: All

(Read-Write) Sets the IF Bandwidth for the specified segment. First set

SENS:FOM:RANGe:SEGM:BWIDth:CONTrol ON. All subsequent segments that are added assume the new

IF Bandwidth value.

Valid either for Receiver range or for Primary range when coupled to Receiver.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

<s> Segment number for which to set independent IF Bandwidth.

<num> IF Bandwidth in Hz. The list of valid IF Bandwidths is different depending on

the VNA model. See the list of valid IFBW values . If an invalid number is

specified, the analyzer will round up to the closest valid number.

Examples SENS:FOM:RANG:SEGM:BWIDth 100

sense2:fom:range2:segment4:bwidth:resolution 1e3

Query Syntax SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:BWIDth[:RESolution]?

Return Type Numeric
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Default Varies with model.

SENSe<cnum>:FOM:RANGe<n>:SEGMent:BWIDth[:RESolution]:CONTrol <bool>

Applicable Models: All

(Read-Write) Specifies whether the IF Bandwidth resolution can be set independently for each

segment. When set, each segment added after this will be set to ON automatically.

Valid either for Receiver range or for Primary range. Primary range value is ignored unless Receiver

is coupled to Primary.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

<bool> ON (or 1) - turns Bandwidth control ON. Bandwidth can be set for each

segment

OFF (or 0) - turns Bandwidth control OFF. Use the channel IF bandwidth

setting instead.

Examples SENS:FOM:RANG:SEGM:BWIDth:CONT 0

sense2:fom:range2:segment:bwidth:resolution:control 1

Query Syntax SENSe<cnum>:FOM:RANGe<n>:SEGMent:BWIDth[:RESolution]:CONTrol?

Return Type Boolean

Default OFF

SENSe<cnum>:FOM:RANGe<n>:SEGMent:COUNt?
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Applicable Models: All

(Read-only) Returns the number of segments that exist for the specified range.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

Examples SENS:FOM:RANG:SEGM:COUN?

sense2:fom:range2:segment:count?

Return Type Numeric

Default Not Applicable

SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:DELete

Applicable Models: All

(Write-only) Deletes the specified sweep segment.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

<s> Number of the segment to delete. If unspecified, value is set to 1.

Examples SENS:FOM:RANG:SEGM3:DEL

sense2:fom:range2:segment4:delete

Query Syntax Not Applicable

Default Not Applicable

SENSe<cnum>:FOM:RANGe<n>:SEGMent:DELete:ALL

1213



Applicable Models: All

(Write-only) Deletes all sweep segments in the specified range.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

Examples SENS:FOM:RANG:SEGM:DEL:ALL

sense2:fom:range2:segment:delete:all

Query Syntax Not Applicable

Default Not Applicable

SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:FREQuency:CENTer <num>

Applicable Models: All

(Read-Write) Sets and returns the center frequency for the specified sweep segment. Also specify

segment frequency span.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

<s> Segment number to modify. Choose any existing segment number.

<num> Center Frequency in Hz. Choose any number between the minimum and

maximum frequency of the analyzer.

Examples SENS:FOM:RANG:SEGM:FREQ:CENT 1GHz

sense2:fom:range2:segment4:frequency:center 1e9

Query Syntax SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:FREQuency:CENTer?

Return Type Numeric

Default Stop Frequency of the previous segment. If first segment, start frequency of the

analyzer.

SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:FREQuency:SPAN <num>
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Applicable Models: All

(Read-Write) Sets and returns the span frequency for the specified sweep segment. Also specify

segment center frequency.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

<s> Segment number to modify. Choose any existing segment number.

<num> Frequency span in Hz. Choose any number between the minimum and

maximum frequency of the analyzer.

Examples SENS:FOM:RANG:SEGM:FREQ:SPAN 1GHz

sense2:fom:range2:segment4:frequency:span 1e9

Query Syntax SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:FREQuency:SPAN?

Return Type Numeric

Default If first segment, frequency span of the analyzer. Otherwise 0.

SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:FREQuency:STARt <num>

Applicable Models: All

(Read-Write) Sets and returns the start frequency for the specified sweep segment. Also specify

segment stop frequency.

All other segment Start and Stop Frequency values that are larger than this frequency are changed to

this frequency.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

<s> Segment number to modify. Choose any existing segment number.

<num> Start frequency in Hz. Choose any number between the minimum and

maximum frequency of the analyzer.

Examples SENS:FOM:RANG:SEGM:FREQ:STAR 1GHz

sense2:fom:range2:segment4:frequency:start 1e9

Query Syntax SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:FREQuency:STARt?
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Return Type Numeric

Default Stop Frequency of the previous segment. If first segment, start frequency of the

analyzer.

SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:FREQuency:STOP <num>

Applicable Models: All

(Read-Write) Sets and returns the stop frequency for the specified sweep segment. Also specify

segment start frequency.

All other segment Start and Stop Frequency values that are larger than this frequency are changed to

this frequency.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

<s> Segment number to modify. Choose any existing segment number.

<num> Stop frequency in Hz. Choose any number between the minimum and

maximum frequency of the analyzer.

Examples SENS:FOM:RANG:SEGM:FREQ:STOP 1GHz

sense2:fom:range2:segment4:frequency:stop 1e9

Query Syntax SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:FREQuency:STOP?

Return Type Numeric

Default Stop Frequency of the previous segment. If first segment, start frequency of the

analyzer.

SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:POWer<p>[:LEVel] <num>
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Applicable Models: All

(Read-Write) Sets the Port Power level for the specified sweep segment. First set

SENS:FOM:RANG:SEGM:POW:CONTrol ON.

When port power is Coupled, setting port power for one port will apply port power for all source ports.

All subsequent segments that are added assume the new Power Level value.

Valid either for Source ranges or for Primary range when coupled to the source.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

<s> Segment number to modify. Choose any existing segment number.

<p> Port number of the source. If unspecified, value is set to 1.

<num> Power level in dBm.

Note: The range of settable power values depends on the VNA model and if

source attenuators are installed. To determine the range of values, send

SOUR:POW? MAX and SOUR:POW? MIN. (SOUR:POW:ATT:AUTO must be

set to ON).

Actual achievable leveled power depends on frequency.

Examples SENS:FOM:RANG:SEGM:POW -5

sense2:fom:range2:segment4:power2:level 5

Query Syntax SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:POWer<p>[:LEVel]?

Return Type Numeric

Default 0

SENSe<cnum>:FOM:RANGe<n>:SEGMent:POWer[:LEVel]:CONTrol <bool>
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Applicable Models: All

(Read-Write) Specifies whether Power Level is to be set independently for each segment.

Valid either for Source ranges or for Primary range. Primary range value is ignored unless Source is

coupled to Primary.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

<bool> ON (or 1) - Power level will be set for each segment.

OFF (or 0) - Use the channel power level setting.

Examples SENS:FOM:RANG:SEGM:POW:CONT 0

sense2:fom:range2:segment:power:control on

Query Syntax SENSe<cnum>:FOM:RANGe<n>:SEGMent:POWer[:LEVel]:CONTrol?

Return Type Boolean

Default OFF (or 0)

SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>[:STATe] <bool>

Applicable Models: All

(Read-Write) Turns the specified sweep segment ON or OFF.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

<s> Segment number to be turned ON or OFF. Choose any existing segment

number.

<bool> ON (or 1) - turns segment ON.

OFF (or 0) - turns segment OFF.

Examples SENS:FOM:RANG:SEGM 0

sense2:fom:range2:segment4:state on

Query Syntax SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>[STATe]?

Return Type Boolean
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Default OFF (or 0)

SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:SWEep:POINts <num>

Applicable Models: All

(Read-Write) Sets the number of data points for the specified sweep segment.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

<s> Segment number to modify. Choose any existing segment number.

<num> Number of points in the segment. The total number of points in all segments

cannot exceed 20001. A segment can have as few as 1 point.

Examples SENS:FOM:RANG:SEGM:SWE:POIN 101

sense2:fom:range2:segment4:sweep:points 201

Query Syntax SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:SWEep:POINts?

Return Type Numeric

Default 21

SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:SWEep:TIME <num>

Applicable Models: All

(Read-Write) Sets the time the VNA takes to sweep the specified segment.

Valid ONLY for receiver ranges.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

<s> Segment number for which to set sweep time.

<num> Sweep time in seconds. Choose a number between 0 and 100

Examples SENS:FOM:RANG:SEGM:SWE:TIME 1

sense2:fom:range2:segment3:sweep:time .1

Query Syntax SENSe<cnum>:FOM:RANGe<n>:SEGMent<s>:SWEep:TIME?

1219



Return Type Numeric

Default Not Applicable

SENSe<cnum>:FOM:RANGe<n>:SEGMent:SWEep:TIME:CONTrol <bool>

Applicable Models: All

(Read-Write) Specifies whether Sweep Time can be set independently for each sweep segment.

Valid either for Receiver ranges or for Primary range. Primary range value is ignored unless Receiver

is coupled to Primary.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<n> Range number. If unspecified, value is set to 1.

<bool> ON (or 1) - Sweep time  will be set for each segment.

OFF (or 0) - Use the channel sweep time setting.

Examples SENS:FOM:RANG:SEGM:SWE:TIME:CONT 1

sense2:fom:range2:segment:sweep:time:control off

Query Syntax SENSe<cnum>:FOM:RANGe<n>:SEGMent:SWEep:TIME:CONTrol?

Return Type Boolean

Default OFF
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Sense:Frequency Commands

Sets the sweep frequencies of the analyzer.

SENSe:FREQuency

       | CENTer

       | CW | FIXed

       | SPAN

       | STARt

       | STOP

Click on a keyword to view the command details.

See Also

Example using some of these commands.

Learn about Frequency Sweep

Synchronizing the Analyzer and Controller

SCPI Command Tree

SENSe<cnum>:FREQuency:CENTer <num>

Applicable Models: All

(Read-Write) Sets the center frequency of the analyzer.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Center frequency. Choose any number between the minimum and maximum

frequency limits of the analyzer. Units are Hz.

This command will accept MIN or MAX instead of a numeric parameter. See

SCPI Syntax for more information.
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Examples SENS:FREQ:CENT 1000000

sense2:frequency:center 1mhz

sense2:frequency:center 1e6

Query Syntax SENSe<cnum>:FREQuency:CENTer?

Return Type Numeric

Default Center of the analyzer's frequency span

SENSe<cnum>:FREQuency[:CW |:FIXed] <num>

Applicable Models: All

(Read-Write) Sets the Continuous Wave (or Fixed) frequency. Must also send SENS:SWEEP:TYPE CW
to put the analyzer into CW sweep mode.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> CW frequency. Choose any number between the minimum and maximum

frequency limits of the analyzer. Units are Hz.

This command will accept MIN or MAX instead of a numeric parameter. See

SCPI Syntax for more information.

Examples SENS:FREQ 1000000
SENS:FREQ:CW MIN
sense2:frequency:fixed 1mhz

Query Syntax SENSe<cnum>:FREQuency[:CW | :FIXed]?

Return Type Numeric

Default 1 GHz

SENSe<cnum>:FREQuency:SPAN <num>
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Applicable Models: All

(Read-Write) Sets the frequency span of the analyzer.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Frequency span in Hz. Choose any number from 70 (minimum) and the

maximum frequency span of the analyzer.

This command will accept MIN or MAX instead of a numeric parameter. See

SCPI Syntax for more information.

Examples SENS:FREQ:SPAN 1000000
sense2:frequency:span max

Query Syntax SENSe<cnum>:FREQuency:SPAN?

Return Type Numeric

Default Maximum frequency span of the analyzer

SENSe<cnum>:FREQuency:STARt <num>

Applicable Models: All

(Read-Write) Sets the start frequency of the analyzer.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Start frequency. Choose any number between the MIN and MAX frequency

limits of the analyzer. Units are Hz.

If FREQ:START is set greater than FREQ:STOP, then the stop frequency is set

to the start frequency + frequency span.

This command will accept MIN or MAX instead of a numeric parameter. See

SCPI Syntax for more information.

Examples SENS:FREQ:STAR 1000000

sense2:frequency:start MIN

Query Syntax SENSe<cnum>:FREQuency:STARt?

Return Type Numeric

Default Minimum frequency of the analyzer
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SENSe<cnum>:FREQuency:STOP <num>

Applicable Models: All

(Read-Write) Sets the stop frequency of the analyzer.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Stop frequency. Choose any number between 70 (minimum) and maximum

frequency limits of the analyzer. Units are Hz.

If FREQ:STOP is set less than FREQ:START, then the start frequency is set to the

stop frequency - frequency span.

This command will accept MIN or MAX instead of a numeric parameter. See

SCPI Syntax for more information.

Examples SENS:FREQ:STOP 1000000

sense2:frequency:stop max

Query Syntax SENSe<cnum>:FREQuency:STOP?

Return Type Numeric

Default Maximum frequency of the analyzer
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SENSe:GCSetup Commands

Controls the Gain Compression configuration.

SENSe:GCSetup:

AMODe <char>

COMPression:

       | ALGorithm <char>

       | BACKoff:LEVel <num>

       | DELTa:X <num>

       | DELTa:Y <num>

       | INTerpolate

               | [:STATe]

       | LEVel <num>

       | SATuration:LEVel

EOSoperation <string>

PMAP

       | INPut?

       | OUTPut?

POWer:

       | LINear:INPut:LEVel <num>

       | REVerse:LEVel <num>

       | STARt:LEVel <num>

       | STOP:LEVel <num>

SAFE:

       | CPADjustment <num>

       | ENABle <bool>

       | FPADjustment <num>

       | FTHReshold <num>
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       | MLIMit <num>

SFA?

SMARt:

       | CDC

       | MITerations <num>

       | SITerations <bool>

       | STIMe <num>

       | TOLerance <num>

SWEep:

       | FREQuency:POINts <num>

       | POWer:POINts <num>

Click on a keyword to view the command details.

See Also

Other Gain Compression commands

CALCulate:MEASure:DEFine - creates a gain compression measurement.

CALC:MEAS:GCMeas:ANAL - Gain Compression Analysis settings

GCA Calibration uses the Guided Calibration commands, except for the following:

Sens:Corr:GCS:Power - sets power level for Source Power Cal

GCX

Setup Mixer using Sense:Mixer commands

Calibrate using SMC commands and Guided commands

Example Programs

Create and Cal a Gain Compression Measurement

Create and Cal a GCX Measurement

Learn about Gain Compression Application

Synchronizing the Analyzer and Controller
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SCPI Command Tree

SENSe<ch>:GCSetup:AMODe <char>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the method by which gain compression data is acquired.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<char> Choose from:

PFREQuency - 2D Power Per Frequency

FPOWer - 2D Frequency Per Power

SMARtsweep - Smart Sweep

Examples SENS:GCS:AMOD SMAR

sense:gcsetup:amode pfrequency

Query Syntax SENSe<ch>:GCSetup:AMODe ?

Return Type Character

Default SMARtsweep

SENSe<ch>:GCSetup:COMPression:ALGorithm <char>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the algorithm method used to compute gain compression.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<char> Algorithm method. Choose from:

CFLG - compression from linear gain

CFMG - compression from maximum gain

BACKoff - compression from BackOff

XYCOM - X/Y Compression

SAT - compression from saturation
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Examples SENS:GCS:COMP:ALG BACK

sense:gcsetup:compression:algorithm XYcom

Query Syntax SENSe<ch>:GCSetup:COMPression:ALGorithm?

Return Type Character

Default CFLG

SENSe<ch>:GCSetup:COMPression:BACKoff:LEVel <num>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read value for the BackOff compression algorithm.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Backoff value in dB. Choose a value between 1 and 99.

Examples SENS:GCS:COMP:BACK:LEV 10

sense:gcsetup:compression:backoff:level 5

Query Syntax SENSe<ch>:GCSetup:COMPression:BACKoff:LEVel?

Return Type Numeric

Default 10

SENSe<ch>:GCSetup:COMPression:DELTa:X <num>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the 'X" value in the delta X/Y compression algorithm.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> X value in dB. Choose a value from .01 to 10.

Examples SENS:GCS:COMP:DELT:X 9

sense:gcsetup:compression:delta:X 8

Query Syntax SENSe<ch>:GCSetup:COMPression:DELTa:X?

Return Type Numeric

Default 10
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SENSe<ch>:GCSetup:COMPression:DELTa:Y <num>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the 'Y" value in the delta X/Y compression algorithm.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Y value in dB. Choose a value from .01 to 10.

Examples SENS:GCS:COMP:DELT:Y 9

sense:gcsetup:compression:delta:Y 8

Query Syntax SENSe<ch>:GCSetup:COMPression:DELTa:Y?

Return Type Numeric

Default 9

SENSe<ch>:GCSetup:COMPression:INTerpolate[:STATe] <bool>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Sets whether or not interpolation should be performed on 2D measured compression

data. Applies ONLY to 2D acquisition modes.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<bool> Choose from:

ON or (1)  Interpolate the results

OFF or (0)  Do NOT interpolate the results but return the value closest to
compression.

Examples SENS:GCS:COMP:INT 1

sense:gcsetup:compression:interpolate off

Query Syntax SENSe<ch>:GCSetup:COMPression:INTerpolation?

Return Type Boolean

Default OFF
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SENSe<ch>:GCSetup:COMPression:LEVel <num>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the desired gain reduction (from reference gain).

This value is used for Compression from Linear Gain and Compression from Maximum Gain.

Use SENS:GCS:COMP:ALG CFLG to set this compression algorithm.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Compression level in dB.  Choose a value between .01 and 100.

Examples SENS:GCS:COMP:LEV 1

sense:gcsetup:compression:level 3

Query Syntax SENSe<ch>:GCSetup:COMPression:LEVel?

Return Type Numeric

Default 1

SENSe<ch>:GCSetup:COMPression:SATuration:LEVel <num>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the deviation dB from the maximum Pout. This is the point of saturation.

Use SENS:GCS:COMP:ALG CFLG to set this compression algorithm.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Saturation level in dB.  Choose a value between .01 and 10.

Examples SENS:GCS:COMP:SAT:LEV 1

sense:gcsetup:compression:saturation:level 3

Query Syntax SENSe<ch>:GCSetup:COMPressionSATuration:LEVel?

Return Type Numeric

Default .1 dB

SENSe<ch>:GCSetup:EOSoperation <char>
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Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the This setting is used to protect a sensitive device from too much power

during the sweep retrace. Other instrument settings or channels may over-ride this setting.  Learn more.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<char> End Of Sweep operation. Choose from:

STANdard  Use the default VNA method.  Learn more.

POFF  Always turn power OFF while waiting.

PSTArt  Sweep Start power

PSTOp  Sweep Stop power.

Examples SENS:GCS:EOS PSTA

sense:gcsetup:eosoperation standard

Query Syntax SENSe<ch>:GCSetup:EOSoperation?

Return Type Character

Default STANdard

SENSe<ch>:GCSetup:PMAP <in>,<out>

Applicable Models: N522xB, N524xB, M9485A

(Write-only) Set the DUT-to-VNA port mapping for the Gain Compression measurement.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<in> VNA port which is connected to the DUT input.

<out> VNA port which is connected to the DUT output.

Examples SENS:GCS:PMAP 1,2

sense:gcsetup:pmap 2,1

Query Syntax Not Applicable
Default 1,2
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SENSe<ch>:GCSetup:PMAP:INPut?

Applicable Models: N522xB, N524xB, M9485A

(Read-only) Read the VNA port number to be connected to the DUT Input.

Use SENS:GCS:PORTMap to set the port mapping.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

Examples SENS:GCS:PMAP:INP?

sense:gcsetup:pmap:input?

Return Type Numeric

Default 1

SENSe<ch>:GCSetup:PMAP:OUTPut?

Applicable Models: N522xB, N524xB, M9485A

(Read-only) Read the VNA port number to be connected to the DUT Output.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

Examples SENS:GCS:PMAP:OUTP?

sense:gcsetup:pmap:output?

Return Type Numeric

Default 2

SENSe<ch>:GCSetup:POWer:LINear:INPut:LEVel <num>
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Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the input power at which Linear Gain and all S-parameters are measured.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Input power level in dBm. Choose a value from +30 to (-30).

Examples SENS:GCS:POW:LIN:INP:LEV 0

sense:gcsetup:power:linear:input:level -10

Query Syntax SENSe<ch>:GCSetup:POWer:LINear:INPut:LEVel?

Return Type Numeric

Default -25 dBm

SENSe<ch>:GCSetup:POWer:REVerse:LEVel <num>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the reverse power level to the DUT. This is applied to the DUT output port

when making reverse measurements like S22.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Reverse power level in dBm. Choose a value from +30 to (-30).

Examples SENS:GCS:POW:REV:LEV 0

sense:gcsetup:power:reverse:level -5

Query Syntax SENSe<ch>:GCSetup:POWer:REVerse:LEVel?

Return Type Numeric

Default -5

SENSe<ch>:GCSetup:POWer:STARt:LEVel <num>
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Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the start power level.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Start power level in dBm. Choose a value from +30 to (-30).

Examples SENS:GCS:POW:STAR:LEV 0

sense:gcsetup:power:start:level -5

Query Syntax SENSe<ch>:GCSetup:POWer:STARt:LEVel?

Return Type Numeric

Default -25

SENSe<ch>:GCSetup:POWer:STOP:LEVel <num>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the stop power level.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Stop power level in dBm. Choose a value from +30 to (-30).

Examples SENS:GCS:POW:STOP:LEV 0

sense:gcsetup:power:stop:level -5

Query Syntax SENSe<ch>:GCSetup:POWer:STOP:LEVel?

Return Type Numeric

Default -5

SENSe<ch>:GCSetup:SAFE:CPADjustment <num>
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Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the Safe Sweep COARSE power adjustment.  Learn more.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Coarse power adjustment setting in dBm. Choose a value between 0 and 6.

Examples SENS:GCS:SAFE:CPAD 2

sense:gcsetup:safe:cpadjustment 3.5

Query Syntax SENSe<ch>:GCSetup:SAFE:CPADjustment?

Return Type Numeric

Default 3.0

SENSe<ch>:GCSetup:SAFE:ENABle <bool>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the (ON | OFF) state of Safe Sweep mode.  Learn more

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> (Boolean) - Safe Sweep state. Choose from:

OFF (or 0) - Disable Safe Sweep

ON (or 1) - Enable Safe Sweep

Examples SENS:GCS:SAFE:ENAB 0

sense:gcsetup:safe:enable 1

Query Syntax SENSe<ch>:GCSetup:SAFE:ENABle?

Return Type Boolean

Default 0

SENSe<ch>:GCSetup:SAFE:FPADjustment <num>
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Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the Safe Sweep FINE power adjustment.  Learn more

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Fine power adjustment setting in dBm. Choose a value between 0 and 3.

Examples SENS:GCS:SAFE:FPAD 2

sense:gcsetup:safe:fpadjustment .5

Query Syntax SENSe<ch>:GCSetup:SAFE:FPADjustment?

Return Type Numeric

Default 1.0 dBm

SENSe<ch>:GCSetup:SAFE:FTHReshold <num>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the compression level in which Safe Sweep changes from the COARSE

power adjustment to the FINE power adjustment.  Learn more

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Threshold setting in dB. Choose a value between 0 and 3.

Examples SENS:GCS:SAFE:FTHR .1

sense:gcsetup:safe:fthreshold .75

Query Syntax SENSe<ch>:GCSetup:SAFE:FTHReshold?

Return Type Numeric

Default 0.5 dB

SENSe<ch>:GCSetup:SAFE:MLimit <num>
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Applicable Models: N522xB, N524xB, M9485A

(Read-Write) When the VNA port that is connected to the DUT Output measures this value, the input

power to the DUT is no longer incremented at that frequency. Safe Mode must be enabled with

SENS:GCS:SAFE:ENAB ON  Learn more

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Maximum power limit in dBm. Choose a value from -100 to +100

Examples SENS:GCS:SAFE:MLIM 20

sense:gcsetup:safe:mlimit 30

Query Syntax SENSe<ch>:GCSetup:SAFE:MLIMit?

Return Type Numeric

Default 30

SENSe<ch>:GCSetup:SFAilures?

Applicable Models: N522xB, N524xB, M9485A

(Read-only) Returns a comma-separated list of the frequency indexes that were out of tolerance for

SMART Sweep mode, or at the power limit for 2D acquisition modes. Zero (0) is the first frequency

data point.  

Must be Single triggered. Invalid results occur if the GCA channel is continuously sweeping.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

Examples SENS:GCS:SFA?

sense:gcsetup:sfailures?

Return Type Comma-separated list of frequency indexes.

Default Not Applicable

SENSe<ch>:GCSetup:SMARt:CDC <bool>
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Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the DC readings at the compression point in the last iteration of a smart

sweep. Taking only these DC readings improves measurement speed.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<bool> Choose from:

ON or (1)  Enable reading DC value at compression point in the last iteration

of a smart sweep.

OFF or (0)  Disable reading DC value at compression point in the last iteration

of a smart sweep.

Examples SENS:GCS:SMAR:CDC 1

sense:gcsetup:smart:cdc off

Query Syntax SENSe<ch>:GCSetup:SMARt:CDC?

Return Type Boolean

Default OFF

SENSe<ch>:GCSetup:SMARt:MITerations <num>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the maximum permitted number of iterations which SMART Sweep may

utilize to find the desired compression level, to within the specified tolerance.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Maximum number of iterations. Choose a value between 1 and 500

Examples SENS:GCS:SMAR:MIT 5

sense:gcsetup:smart:miterations 3

Query Syntax SENSe<ch>:GCSetup:SMARt:MITerations?

Return Type Numeric

Default 20

SENSe<ch>:GCSetup:SMARt:SITerations <bool>
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Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read enable for showing intermediate results for each iteration of SMART

Sweep

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<bool> Choose from:

ON or (1)  Compression traces are updated after each iteration.

OFF or (0)  Compression traces are updated after ALL iterations are complete.

Examples SENS:GCS:SMAR:SIT 1

sense:gcsetup:smart:siterations off

Query Syntax SENSe<ch>:GCSetup:SMARt:SITerations?

Return Type Boolean

Default OFF

SENSe<ch>:GCSetup:SMARt:STIMe <num>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the amount of time SMART Sweep will dwell at the first point where the

input power changes by the Backoff or X level. Applies only to SMART Sweep when Backoff or XY

compression methods are selected. Learn more.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Settling time in seconds. Choose any positive value.

Examples SENS:GCS:SMAR:STIM 1

sense:gcsetup:smart:stime .1

Query Syntax SENSe<ch>:GCSetup:SMARt:STIMe?

Return Type Numeric

Default 0

SENSe<ch>:GCSetup:SMARt:TOLerance <num>
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Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the acceptable range SMART Sweep will allow for the measured

compression level.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Tolerance level in dBm. Choose a value between .01 and 10

Examples SENS:GCS:SMAR:TOL .1

sense:gcsetup:smart:tolerance .05

Query Syntax SENSe<ch>:GCSetup:SMARt:TOLerance?

Return Type Numeric

Default .05

SENSe<ch>:GCSetup:SWEep:FREQuency:POINts <num>

Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the number of data points in each frequency sweep.  Learn more

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Frequency points. Do not exceed the max number of data points.

See Data Points Limit

Examples SENS:GCS:SWE:FREQ:POIN 201

sense:gcsetup:sweep:frequency:points 101

Query Syntax SENSe<ch>:GCSetup:SWEep:FREQuency:POINts?

Return Type Numeric

Default 201

SENSe<ch>:GCSetup:SWEep:POWer:POINts <num>
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Applicable Models: N522xB, N524xB, M9485A

(Read-Write) Set and read the number of data points in each power sweep. Applies ONLY to 2D
acquisition modes.

Parameters  

<ch> Any existing GCA channel. If unspecified, value is set to 1.

<num> Power points. Do not exceed the max number of data points.

See Data Points Limit

Examples SENS:GCS:SWE:POW:POIN 50

sense:gcsetup:sweep:power:points 21

Query Syntax SENSe<ch>:GCSetup:SWEep:POWer:POINts?

Return Type Numeric

Default 21
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Sense:Mixer Commands

Performs Mixer setup and configuration.

SENSe:MIXer:

APPLy

AVOidspurs

CALCulate

DISCard

IF:FREQ:

       | SIDeband

       | STARt

       | STOP

INPut:FREQ:

       | DENominator

       | FIXed

       | MODE

       | NUMerator

       | STARt

       | STOP

INPut:POWer

       | STARt

       | STOP

       | USENominal

LO:FREQ:

       | DENominator

       | FIXed

       | ILTI

       | MODE

       | NUMerator

       | STARt

       | STOP

LO:NAME

LO:POWer

       | STARt

       | STOP

LOAD

NORMalize:POINt

OUTPut:FREQ:

       | FIXed

       | MODE

       | SIDeband

       | STARt
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       | STOP

PHASe

PMAP

       | INPut

       | OUTPut

RECalculate

REVerse

ROLE

       | CATalog?

       | DEVice

SAVE

SEGMent More Commands
STAGe (number of LOs)

XAXis

Click on a keyword to view the command details.

See Also

Example Programs

Learn about the Frequency Converter Application

Synchronizing the Analyzer and Controller

SCPI Command Tree

Note:  If you are changing several mixer configuration settings, you can make all the changes first and

then issue the Calculate and Apply commands as you would do from the user interface.

SENSe<ch>:MIXer:APPLy

Applicable Models: All

(Write only) Applies the mixer setup settings and turns the channel ON. (Performs the same function
as the Apply button on the mixer setup dialog box).

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1

Examples SENS:MIX:APPL

Query Syntax Not Applicable

Default Not Applicable
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SENSe<ch>:MIXer:AVOidspurs <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read Write)  Sets and returns the state of the avoid spurs feature. Learn more about avoid spurs.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1

<bool> Avoid spurs state. Choose from

0 - Avoid spurs OFF

1 - Avoid spurs ON

Examples SENS:MIX:AVO

sense2:mixer:avoidspurs 1

Query Syntax SENSe<ch>:MIXer:AVOidspurs?

Return Type Boolean

Default 0  (OFF)

SENSe<ch>:MIXer:CALCulate <char>

Applicable Models: All

(Write only) Calculates the Input, IF, or Output frequencies of the mixer setup and updates the

channel settings.

Note: The target mode must be swept. This command does not allow calculation of fixed values.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1

<char> Mixer port to be calculated. Choose from:
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<char> 1st or only stage

requires:

In addition, 2nd stage

requires:

INPut
Output Start/Stop/Fixed
frequencies

LO Start/Stop/Fixed
frequencies

Output sideband (High or
Low)

IF Start/Stop/Fixed
frequencies

2nd Start/Stop/Fixed
frequencies

IF sideband (High or Low)

BOTH NA
IF Start/Stop/Fixed
frequencies

Both Start/Stop/Fixed
frequencies

OUTPut
Input Start/Stop/Fixed
frequencies

LO Start/Stop/Fixed
frequencies

Output sideband (High or
Low)

IF Start/Stop/Fixed
frequencies

2nd Start/Stop/Fixed
frequencies

IF sideband (High or Low)

LO_1
Input Start/Stop/Fixed
frequencies

Output Start/Stop/Fixed
frequencies

Output sideband (High or
Low)

IF Start/Stop/Fixed
frequencies

2nd Start/Stop/Fixed
frequencies

IF sideband (High or Low)

LO_2 NA
Input Start/Stop/Fixed
frequencies

1st LO Start/Stop/Fixed
frequencies

Output Start/Stop/Fixed
frequencies

IF sideband(High or Low

Output sideband(High or
Low)

Examples SENS:MIX:CALC Output
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Query Syntax Not Applicable

Default Not Applicable

SENSe<ch>:MIXer:DISCard

Applicable Models: All

(Write only) Cancels changes that have been made to the Converter setup and reverts to the

previously-saved setup. Same as the Cancel button on the mixer setup dialog box.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1

Examples SENS:MIX:DISC

Query Syntax Not Applicable

Default Not Applicable

SENSe<ch>:MIXer:IF:FREQuency:SIDeband <char>

Applicable Models: All

(Read-Write)  When two LO stages are used, sets or returns whether to select the sum or difference for

the IF1 product. (Input + or - LO1 = IF1)

This setting corresponds to the  buttons on LO1 on the Mixer setup dialog

This setting is ignored when ONE LO stage is selected.

Also set SENS:MIX:OUTP:FREQ:SID  to LOW or HIGH to determine the output frequency of the mixer.

See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<char> Sideband value. Choose from

LOW - Difference (-)

HIGH - Sum (+)

Examples SENS:MIX:IF:FREQ:SID LOW
SENSe2:MIXer:IF:FREQ:SIDeband HIGH
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Query Syntax SENSe<ch>:MIXer:IF:FREQuency:SIDeband?

Return Type Character

Default LOW

SENSe<ch>:MIXer:IF:FREQuency:STARt <num>

Applicable Models: All

(Read-Write) Sets or returns the IF start frequency value of the mixer. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<num> IF Start Frequency value

Examples SENS:MIX:IF:FREQ:STAR 1e9
SENSe2:MIXer:IF:FREQ:STARt 1000000000

Query Syntax SENSe<ch>:MIXer:IF:FREQuency:STARt?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:IF:FREQuency:STOP <num>

Applicable Models: All

(Read-Write) Sets or returns the stop frequency value of the mixer IF frequency. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<num> IF Stop Frequency value

Examples SENS:MIX:IF:FREQ:STOP 2e9
SENSe2:MIXer:IF:FREQ:STOP 2000000000

Query Syntax SENSe<ch>:MIXer:IF:FREQuency:STOP?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:INPut:FREQuency:DENominator <value>
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Applicable Models: All

(Read-Write) Sets or returns the denominator value of the Input Fractional Multiplier. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<value> Input denominator value.

Examples SENS:MIX:INP:FREQ:DEN 5
SENS2:MIXer:INPut:FREQ:DENominator 4

Query Syntax SENSe<ch>:MIXer:INPut:FREQuency:DENominator?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:INPut:FREQuency:FIXed<value>

Applicable Models: All

(Read-Write) Sets or returns the fixed frequency of the input. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<value> Input frequency.

Examples SENSe:MIXer:INPut:FREQ:FIXed 1e9
SENSe2:MIXer:INPut:FREQ:FIXed 1000000000

Query Syntax SENSe<ch>:MIXer:INPut:FREQuency:FIXed?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:INPut:FREQuency:MODE <char>
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Applicable Models: All

(Read-Write) Sets or returns the Input sweep mode.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<char> Input sweep mode. Choose either FIXED or SWEPT

Examples SENS:MIX:INP:FREQ:MODE FIXED
SENSe2:MIXer:INP:FREQ:MODE swept

Query Syntax SENSe<ch>:MIXer:INPut:FREQuency:MODE?

Return Type Character

Default Fixed

SENSe<ch>:MIXer:INPut:FREQuency:NUMerator <value>

Applicable Models: All

(Read-Write) Sets or returns the numerator value of the Input Fractional Multiplier. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<value> Input numerator value.

Examples SENS:MIX:INP:FREQ:NUM 3
SENSe2:MIXer:INPut:FREQ:NUMerator 1

Query Syntax SENSe<ch>:MIXer:INPut:FREQ:NUMerator?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:INPut:FREQuency:STARt <value>
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Applicable Models: All

(Read-Write) Sets or returns the Input start frequency value of the mixer. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<value> Input Start frequency

Examples SENS:MIX:INP:FREQ:STAR 1e9
SENSe2:MIXer:INPut:FREQ:STARt 1000000000

Query Syntax SENSe<ch>:MIXer:INPut:FREQuency:STARt?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:INPut:FREQuency:STOP <value>

Applicable Models: All

(Read-Write) Sets or returns the Input stop frequency value of the mixer. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<value> Input stop frequency

Examples SENS:MIX:INP:FREQ:STOP 2e9
SENSe2:MIXer:INPut:FREQ:STOP 2000000000

Query Syntax SENSe<ch>:MIXer:INPut:FREQuency:STOP?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:INPut:POWer <value>
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Applicable Models: All

(Read-Write) Sets or returns the value of the Input Power.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<value> Input power in dBm.

Examples SENS:MIX:INP:POW 9
SENSe2:MIXer:INPut:POWer 5

Query Syntax SENSe<ch>:MIXer:INPut:POWer?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:INPut:POWer:STARt <value>

Applicable Models: All

(Read-Write) Sets the input start power for a power sweep in a mixer channel like SMC. The value is

only used when the sweep type is power sweep.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<value> Input power value in units of dBm.

Examples SENS:MIX:INP:POW STAR 6
SENSe2:MIXer:INPut:POWer:STARt 5

Query Syntax SENSe<ch>:MIXer:INPut:POWer:STARt?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:INPut:POWer:STOP <value>

Applicable Models: All
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(Read-Write) Sets the input stop power for a power sweep in a mixer channel . The value is only used

when the sweep type is power sweep.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<value> Input power value in units of dBm.

Examples SENS:MIX:INP:POW STOP 9
SENSe2:MIXer:INPut:POWer:STOP 5

Query Syntax SENSe<ch>:MIXer:INPut:POWer:STOP?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:INPut:POWer:USENominal <bool>

Applicable Models: All

(Read-Write) Toggles the Use Nominal Incident Power setting ON and OFF. This setting is ONLY to

be used with SMC measurements. Learn more about Nominal Incident Power.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<value> (boolean) - Nominal Incident Power State. Choose from:

ON (1) - Turn nominal incident power ON

OFF (0) - Turn nominal incident power OFF

Examples SENS:MIX:INP:POW:USEN 1
SENSe2:MIXer:INPut:POWer:USENominal OFF

Query Syntax SENSe<ch>:MIXer:INPut:POWer:USENominal?

Return Type Boolean

Default OFF

SENSe<ch>:MIXer:LO<n>:FREQuency:DENominator <value>
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Applicable Models: All

(Read-Write) Sets or returns the denominator value of the LO Fractional Multiplier. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<n> LO stage number. Choose 1 or 2.

<value> LO denominator.

Examples SENS:MIX:LO:FREQ:DEN 5
SENSe2:MIXer:LO2:FREQ:DENominator 4

Query Syntax SENSe<ch>:MIXer:LO<n>:FREQuency:DENominator?

Return Type Numeric

Default 1

SENSe<ch>:MIXer:LO<n>:FREQuency:FIXed <value>

Applicable Models: All

(Read-Write) Sets or returns the fixed frequency of the specified mixer LO. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<n> LO stage number. Choose 1 or 2

<value> LO frequency.

Examples SENS:MIX:LO:FREQ:FIX 1e9
SENSe2:MIXer:LO2:FREQ:FIXed 1000000000

Query Syntax SENSe<ch>:MIXer:LO<n>:FREQuency:FIXed?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:LO<n>:FREQuency:ILTI <bool>
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Applicable Models: All

(Read-Write) Specifies whether to use the Input frequency that is greater than the LO or less than

the LO. To learn more, see the mixer setup dialog box help.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<n> LO stage number. Choose 1 or 2

<bool> ON (1) - Use the Input that is Greater than the specified LO.

OFF (0) - Use the Input that is Less than the specified LO.

Examples SENS:MIX:LO1:FREQ:ILTI 1
sense2:mixer:lo2:frequency:ilti ON

Query Syntax SENSe<ch>:MIXer:LO<n>:FREQuency:ILTI?

Return Type Boolean

Default OFF

SENSe<ch>:MIXer:LO<n>:FREQuency:MODE <char>

Applicable Models: All

(Read-Write) Sets or returns the LO sweep mode.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<n> LO stage number. Choose 1 or 2

<char> LO sweep mode. Choose either FIXED or SWEPT

Examples SENS:MIX:LO:FREQ:MODE FIXED
SENSe2:MIXer:LO2:FREQ:MODE swept

Query Syntax SENSe<ch>:MIXer:LO<n>:FREQuency:MODE?

Return Type Character

Default Fixed

SENSe<ch>:MIXer:LO<n>:FREQuency:NUMerator <value>
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Applicable Models: All

(Read-Write) Sets or returns the numerator value of the LO Fractional Multiplier. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<n> LO stage number. Choose 1 or 2

<value> LO Numerator.

Examples SENS:MIX:LO:FREQ:NUM 5
SENSe2:MIXer:LO2:FREQ:NUMerator 4

Query Syntax SENSe<ch>:MIXer:LO<n>:FREQuency:NUMerator?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:LO<n>:FREQuency:STARt <value>

Applicable Models: All

(Read-Write) Sets or returns the LO start frequency value. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<n> LO stage number. Choose 1 or 2

<value> LO Start Frequency in Hertz.

Examples SENS:MIX:LO:FREQ:STAR 5E9

Query Syntax SENSe<ch>:MIXer:LO<n>:FREQuency:STARt?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:LO<n>:FREQuency:STOP <value>
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Applicable Models: All

(Read-Write) Sets or returns the LO stop frequency value. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<n> LO stage number. Choose 1 or 2

<value> LO Stop Frequency in Hertz.

Examples SENS:MIX:LO:FREQ:STOP 5E9

Query Syntax SENSe<ch>:MIXer:LO<n>:FREQuency:STOP?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:LO<n>:NAME <value>

Applicable Models: All

(Read-Write)  Sets or returns the name of the VNA internal source or external source to use as the LO

in a converter measurement.

Important Note: This setting is immediately send to the channel configuration. First set and apply

mixer frequency settings, then send this command. Otherwise, 'invalid setting' errors may occur.

See Remotely Specifying a Source Port.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<n> LO stage number. Choose 1 or 2.

<value> (string) - LO Source name. Use Source:CAT? to return a list of valid source

ports. An external source must be configured and selected to be valid. Learn
more about external source configuration.

Examples SENS:MIX:LO:NAME "MySource"

Query Syntax SENSe<ch>:MIXer:LO<n>:NAME?

Return Type String

Default "Not Controlled"

SENSe<ch>:MIXer:LO<n>:POWer <value>
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Applicable Models: All

(Read-Write) Sets or returns the LO Power fixed value.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<n> LO stage. Choose 1 or 2

<value> LO Power in dBm

Examples SENS:MIX:LO:POW 9

Query Syntax SENSe<ch>:MIXer:LO<n>:POWer?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:LO<n>:POWer:STARt <value>

Applicable Models: All

(Read-Write) For an LO power sweep, sets or returns the LO power start value.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<n> LO stage. Choose 1

<value> LO start power in dBm

Examples SENS:MIX:LO1:POW:STAR -10

Query Syntax SENSe<ch>:MIXer:LO1:POWer:STARt?

Return Type Numeric

Default - 20 dBm

SENSe<ch>:MIXer:LO<n>:POWer:STOP <value>
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Applicable Models: All

(Read-Write) For an LO power sweep, sets or returns the LO power stop value.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<n> LO stage. Choose 1

<value> LO stop power in dBm

Examples SENS:MIX:LO1:POW:STOP 10

Query Syntax SENSe<ch>:MIXer:LO1:POWer:STOP?

Return Type Numeric

Default -10 dBm

SENSe<ch>:MIXer:LOAD <name>

Applicable Models: All

(Write-only) Loads a previously-configured mixer attributes file (.mxr)

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<name> Path and file name (including .mxr extension) to load.

Examples SENSe:MIXer:LOAD "C:/Program Files/Keysight/Network
Analyzer/Documents/Mixer/MyMixer.mxr"

Default Not Applicable

SENSe<ch>:MIXer:NORMalize:POINt <value>
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Applicable Models: All

(Read-Write) Sets or returns the data point for normalizing the phase measurement. Learn more.

Parameters  

<ch> Channel number of the SMC measurement. If unspecified, value is set to 1.

<value> Normalization data point.  Choose a data point number between 1 and the max

number of data points in the sweep that has the least amount of expected noise.

Examples SENS:MIX:NORM:POIN 101

sense2:mixer:normalize:point 50

Query Syntax SENSe<ch>:MIXer:NORMalize:POINt?

Return Type Numeric

Default Middle point in the sweep

SENSe<ch>:MIXer:OUTPut:FREQuency:FIXed <value>

Applicable Models: All

(Read-Write) Sets or returns the output fixed frequency of the mixer. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<value> Output fixed frequency in Hertz.

Examples SENS:MIX:OUTP:FREQ:FIX 5e9

Query Syntax SENSe<ch>:MIXer:OUTPut:FREQuency:FIXed?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:OUTPut:FREQuency:MODE <char>
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Applicable Models: All

(Read-Write) Sets or returns the Output sweep mode.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<char> Output sweep mode. Choose either FIXED or SWEPT

Examples SENS:MIX:OUTP:FREQ:MODE FIXED
SENSe2:MIXer:OUTput:FREQuency:MODE swept

Query Syntax SENSe<ch>:MIXer:OUTPut:FREQuency:MODE?

Return Type Character

Default Fixed

SENSe<ch>:MIXer:OUTPut:FREQuency:SIDeband <value>

Applicable Models: All

(Read-Write) Specify whether to select the sum (High) or difference (Low) products.

When one LO is used: Input + or - LO1 = Output frequency

When two LOs are used: IF1 + or - LO2 = Output frequency

Use SENS:MIX:IF:FREQ:SID when two LOs are used to determine the IF1 frequency.

Use Sens:Mixer:Stage to set 1 or 2 LOs

See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<value> Sideband value. Choose from

LOW - Low or Difference (-)

HIGH - High or Sum (+)

Examples SENS:MIX:OUTP:FREQ:SID LOW
SENSe2:MIXer:OUTPut:FREQ:SIDeband HIGH

Query Syntax SENSe<ch>:MIXer:OUTPut:FREQuency:SIDeband?

Return Type Character
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Default LOW

SENSe<ch>:MIXer:OUTPut:FREQuency:STARt <value>

Applicable Models: All

(Read-Write) Sets or returns the Output start frequency of the mixer. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<value> Output start frequency

Examples SENS:MIX:OUTP:FREQ:STAR 1e9
SENSe2:MIXer:OUTPut:FREQ:STARt 1000000000

Query Syntax SENSe<ch>:MIXer:OUTPut:FREQuency:STARt?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:OUTPut:FREQuency:STOP <value>

Applicable Models: All

(Read-Write) Sets or returns the Output stop frequency of the mixer. See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<value> Output stop frequency

Examples SENS:MIX:OUTP:FREQ:STOP 1e9
SENSe2:MIXer:OUTPut:FREQ:STOP 1000000000

Query Syntax SENSe<ch>:MIXer:OUTPut:FREQuency:STOP?

Return Type Numeric

Default Not Applicable

SENSe<ch>:MIXer:PHASe <bool>
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Applicable Models: N522xB, N523xB, N524xB

(Read Write)  Sets and returns the state of SMC Phase measurements and calibrations. Learn more.

In the User Interface, there are two "enable phase" checkboxes: in the Phase Settings dialog and in the

Calibration Wizard. Checking one enables both. This single command also enables both.  

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1

<bool> Include Phase measurement state. Choose from

ON or 1 - Include phase in SMC measurements

OFF or 0 - Do NOT include phase in SMC measurements

Examples SENS:MIX:PHAS 1

sense2:mixer:phase off

Query Syntax SENSe<ch>:MIXer:PHASe?

Return Type Boolean

Default 0  (OFF)

SENSe<ch>:MIXer:PMAP <in>,<out>

Applicable Models: All

(Write-only) Sets the VNA to DUT port map for FCA measurements. Use SENS:MIX:PMAP:INP?

and SENS:MIX:PMAP:OUTP? to read these values.  Learn about selectable FCA DUT ports.

Changing the ports may limit your ability to use an internal second source. If a selected port is shared

by one of the sources, then that source will not be available as an LO source. Learn more about

Internal second sources.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<in> VNA port to connect to the DUT input.

For SMC, choose any unused VNA port.

For VMC, set to 1.

<out> VNA port to connect to the DUT output. Choose any unused port for SMC and

VMC.
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Examples SENS:MIX:PMAP 2,1
sense2:mixer:pmap 4,2

Query Syntax Not Applicable

Default 1,2

SENSe<ch>:MIXer:PMAP:INPut?

Applicable Models: All

(Read-only) Returns the VNA port that is mapped to the DUT input. Use SENS:MIX:PMAP to set this

value.

Learn about selectable FCA DUT ports.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

Examples SENS:MIX:PMAP:INP?
sense2:mixer:pmap:input?

Default 1

SENSe<ch>:MIXer:PMAP:OUTPut?

Applicable Models: All

(Read-only) Returns the VNA port that is mapped to the DUT output. Use SENS:MIX:PMAP to set this

value.

Learn about selectable FCA DUT ports.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

Examples SENS:MIX:PMAP:OUTP?
sense2:mixer:pmap:output?

Default 2

SENSe<ch>:MIXer:RECalculate
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Applicable Models: All

(Write only) Repeats the last calculation that was performed, including all ON (state) segments in

segment table.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1

Examples SENS:MIX:REC

Query Syntax Not Applicable

Default Not Applicable

SENSe<ch>:MIXer:REVerse <bool>

Applicable Models: All

(Read-Write) Sets whether to include SC12 sweeps during measurements.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<bool> (Boolean)   Choose from:

ON (1) - Include the SC12 (reverse) sweep.

OFF (0) - Do NOT Include the SC12 (reverse) sweep.

Examples SENS:MIX:REV 1
sense2:mixer:reverse ON

Query Syntax SENSe<ch>:MIXer:REVerse?

Return Type Boolean

Default ON (1)

SENSe<ch>:MIXer:ROLE:CATalog? - Superseded
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Applicable Models: All

(Read-only) This command is replaced with SENSe:ROLE:CATalog which can be used by all

channels.

Returns a list of valid roles for the IMD Converter application.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

Examples SENS:MIX:ROLE:CAT?
sense2:mixer:role:catalog?

Default Not Applicable

SENSe<ch>:MIXer:ROLE:DEVice <role>,<source> Superseded

Applicable Models: All

(Read-Write) This command is replaced with SENSe:ROLE:DEVice which can be used by all

channels.

Assigns a configured external source to the specified role for the converter application.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<role> (String)  Role to which the external source is assigned. Choose from:

For IMDX and IMSX, choose from:

"RF2"

"LO1"

"LO2"

For all other converter applications, choose from:

"LO1"

"LO2"

<source> String) Source name from Source Configuration dialog.

Examples SENS:MIX:ROLE:DEV "LO1","LO1Name"
sense2:mixer:role:device "LO1","LO1Name"

Query Syntax SENSe<ch>:MIXer:ROLE:DEVice? <source>
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Return Type String

Default Not Applicable

SENSe<ch>:MIXer:SAVE <name>

Applicable Models: All

(Write-only) Saves the settings for the mixer/converter test setup to a mixer attributes file.

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<name> Path and file name (including .mxrx extension) to save.

Examples SENSe:MIXer:SAVE "C:/Program Files/Keysight/Network
Analyzer/Documents/Mixer/MyMixer.mxrx"

Default Not Applicable

SENSe<ch>:MIXer:STAGe <n>

Applicable Models: All

(Read-Write) Number of IF stages (LOs) used in the mixer.  See Note

Parameters  

<ch> Any existing channel number. If unspecified, value is set to 1.

<n> Number of stages. Choose either 1 or 2

Examples SENSe1:MIXer:LO1:FREQ:NUMerator 6
SENSe1:BWID 1000
SENSe1:MIXer:SEGMent1:ADD 165
'New segments will reset stage to single stage mode. Therefore,
always add dual stage setting after adding segments
SENSe1:MIXer:STAGE 2  

Query Syntax SENSe<ch>:MIXer:STAGe?

Return Type Numeric

Default 1

SENSe<ch>:MIXer:XAXis <char>
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Applicable Models: All

(Read-Write) Sets or returns the swept frequency range to display on the X-axis for the IMDx or NFx

channel.

For FCA and GCX measurements, use CALC:MEAS:MIXer:XAXis

Parameters  

<ch> Channel number of the IMDx or NFx Converter measurement. If unspecified,

value is set to 1.

<char> Frequency range to display on the X-Axis. NOT case-sensitive. Choose from:

INPUT - Input frequency range

LO_1 - LO frequency range

LO_2 - LO 2 frequency range

OUTPUT - Output frequency range

If the specified frequency range is not swept, the default swept range is used.

Examples SENSe:MIXer:XAXis INPUT

sense2:mixer:xaxis LO_1

Return Type Character

Default Search is made in the following order until a swept range is found:

OUTPUT1.

INPUT (If the OUTPUT is fixed)2.

Number of Points (If ALL ranges are fixed)3.
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Sense:Multiplexer Commands

Controls External Test Sets (N44xx, E5092A, "Z", and "H" series).

 

SENSe:MULTiplexer:

ADDRess

ALLPorts

CATalog?

COUNt?

DISPlay

INCount?

LABel

OUTPut

| A|B|C|D[DATA]

| A|B|C|D:VOLTage[DATA]

| [DATA]

PORT

| CATalog?

| SELect

STATe

TSET9

| OUTPut

| PORT1

| PORT2

| PORT3

| PORT4

TYPE
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Click on a keyword to view the command details.

Red commands are superseded.

See Also

See an example program using these commands.

Learn about External Test Set Control

Synchronizing the Analyzer and Controller

SCPI Command Tree

SENSe:MULTiplexer<id>:ADDRess <address>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and returns the address for the external test set at the specified ID. This command

should be immediately preceded by the SENSe:MULT:TYPE command.

Note: This command is not applicable to the E509xA USB test sets, on which the address is set by

DIP switches on the rear panel.

Parameters  

<id> Id of the external test set. If unspecified, Id is assumed to be 1. Must be

previously set by the SENSe:MULT:TYPE command.

<address> Integer  The test set address.

For a GPIB test set (N44xx and some specials), this is the GPIB address.

For a test set I/O test set (some specials), it is the position of the test set in the chain
(starting at 0).

Examples SENS:MULT1:TYPE "Z5623A_K66" ' use K66 test set, and reference it
through ID 1

SENS:MULT1:ADDR 0 ' first test set in sequence

' All subsequent commands using SENS:MULT1 will refer to this
test set

Query Syntax SENSe:MULTiplexer<id>:ADDRess?

Return Type Numeric

Default Not Applicable
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SENSe<cnum>:MULTiplexer<id>:ALLPorts <string>

Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Write)  Sets or gets the port selections for all available ports on the specified channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<id> Id of the external test set. If unspecified, Id is assumed to be 1. Must be

previously set by the SENSe:MULT:TYPE command.

<string> Comma-separated list of port selections, one for each port. Each port selection

must correspond to one of the values returned by SENS:MULT:PORT:CAT?.

Do NOT include + and - .

Examples ' for channel 5 and test set 1, set port 1 to T1,

' port 2 to A, port 3 to R2+, port 4 to R3-.

SENS5:MULT1:ALLP "T1,A,R2,R3 "

Query Syntax SENSe<cnum>:MULTiplexer<id>:ALLPorts?

Return Type STRING

Default Not Applicable

SENSe:MULTiplexer:CATalog?

Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Only) Returns a comma-separated list of the external test sets models that are currently

supported. Choose one of these items to send SENS:MULT1:TYPE.

Examples SENS:MULT:CAT?

Return Type String

Default Not Applicable

SENSe:MULTiplexer<id>:COUNt?
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Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Only) Returns the total number of ports of the specified test set.

Returns 0 if no test set is connected (GPIB test sets only).

Parameters  

<id> Id of the external test set. If unspecified, Id is assumed to be 1. Must be

previously set by the SENSe:MULT:TYPE command.

Examples SENS:MULT1:COUN?
sense:multiplexer2:count?

Return Type Numeric

Default Not Applicable

SENSe:MULTiplexer<id>:DISPlay[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Write) Turns ON and OFF the display of the test set control status bar. This status bar indicates

the test set that is being controlled and the current port mappings. This setting is turned ON

automatically when the test set is enabled.

Parameters  

<id> Id of the external test set. If unspecified, Id is assumed to be 1. Must be

previously set by the SENSe:MULT:TYPE command.

<bool> ON(1)  Turns ON the display.

OFF (0)  Turns OFF the display.

Examples SENS:MULT1:DISP 1
sense:multiplexer2:display:state on

Query Syntax SENSe:MULTiplexer<id>:DISPlay[:STATe]?

Return Type Boolean

Default OFF (0)

SENSe:MULTiplexer<id>:INCount?
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Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Only) Returns the number of input ports for the specified test set.

For test sets such as the E5092A that do NOT use jumper cables to route the stimulus and response signals,
this command returns the number of test set ports that can be connected to the VNA.

For test sets that DO use jumper cables to route the stimulus and response signals, such as the N44xx, the
return value is not valid.

Parameters  

<id> Id of the external test set. If unspecified, Id is assumed to be 1. Must be

previously set by the SENSe:MULT:TYPE command.

Examples SENS3:MULT1:INC?  ' returns the number of input ports for test
set 1 on channel 3

Return Type Numeric

Default Not Applicable

SENSe<cnum>:MULTiplexer:LABel <string>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and returns the display label for the testset on the specified channel. The label

appears in a status bar at the bottom of the VNA display when SENS:MULT:DISP is set to ON.

Note: This command does not apply to the use of the E509xA test sets.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<string> Display label text.

Examples SENS3:MULT:LAB 'High-power output'

Query Syntax SENSe<cnum>:MULTiplexer:LABel?

Return Type String

Default Not Applicable

SENSe<cnum>:MULTiplexer<id>:OUTPut:<grp>[:DATA] <num>
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Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Write) Sets or returns the output port data for specified group with id of the E5092A multiport

test set.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<id> Id of the external test set either 1 or 2. If unspecified, Id is assumed to be 1. Must be

previously set by the SENS:MULT:TYPE command.

<grp> A | B | C | D

<num> An integer specifying the decimal value of the control line. Values are obtained by

adding weights from the following table that correspond to individual lines.

The output port data range is between 0 to 255 (0=All lines are turned OFF and 255 all

lines are turned ON).

Line Weight

1 1

2 2

3 4

4 8

5 16

6 32

7 64

8 128

Examples SENS3:MULT1:OUTP:B 8

Query

Syntax
SENSe<cnum>:MULTiplexer<id>:OUTPut:<grp>[:DATa]?

Return

Type
Numeric

Default 0

SENSe<cnum>:MULTiplexer<id>:OUTPut:<grp>:VOLTage[:DATA] <volt>
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Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Write) Sets or returns the output voltage for specified group with id of the E5092A multiport

test set.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<id> Id of the external test set either 1 or 2. If unspecified, Id is assumed to be 1. Must be

previously set by the SENS:MULT:TYPE command.

<grp> A | B | C | D

<volt> Output voltage range for <grp> is between 0 to 5.2V and resolution is 10mV.

Examples SENS3:MULT1:OUTP:B:VOLT 4.2

Query

Syntax
SENSe<cnum>:MULTiplexer<id>:OUTPut:<grp>:VOLtage[:DATa]?

Return

Type
Numeric

Default 0 V

SENSe<cnum>:MULTiplexer<id>:OUTPut[:DATa] <num>

Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Write) Sets or returns the control line value for the specified channel. If this command is used

when the selected test set type is an E5092A test set type, then it reads/writes data just for "group A"

of the test set's output lines.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<id> Id of the external test set. If unspecified, Id is assumed to be 1. Must be

previously set by the SENSe:MULT:TYPE command.

<numr> An integer specifying the decimal value of the control line. Values are obtained

by adding weights from the following table that correspond to individual lines.
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Line Weight

1 1

2 2

3 4

4 8

5 16

6 32

7 64

8 128

 

Note:

The E5092A interprets SENS:MULT1:OUTP 0 as all lines OFF.

All "Z"and "H" series test sets interpret SENS:MULT1:OUTP 0 as all lines ON.

Refer to your test set documentation for setting control line values.

 

Examples SENS3:MULT1:OUTP 48  'For Z5623A K64, lines 5 and 6 are OFF; all
other lines are set to ON state.

Query Syntax SENSe<cnum>:MULTiplexer<id>:OUTPut[:DATa]?

Return Type Numeric

Default Not Applicable

SENSe:MULTiplexer<id>:PORT<pnum>:CATalog?
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Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Only) Returns a comma-separated list of valid port selections for the specified port.

Parameters  

<id> Id of the external test set. If unspecified, Id is assumed to be 1. Must be

previously set by the SENSe:MULT:TYPE command.

<pnum> Integer - Input port number for which to return valid Output port selections.

Read the number of input ports for the test set using SENS:MULT:INCount?

Examples SENS:MULT1:PORT3:CAT?  ' returns the valid port selections for
port 3

Return Type String

Default Not Applicable

SENSe<cnum>:MULTiplexer<id>:PORT<pnum>:SELect <string>

Applicable Models: N522xB, N523xB, N524xB, E5080A

(Write-Only) Sets a port mapping for a single port. If this command creates a conflict with an existing

port, the VNA will resolve the conflict.

Note: This command is not supported for the Z5623AK44.

Parameters  

<cnum> Channel number of the measurement. If unspecified, value is set to 1.

<id> Id of the external test set. If unspecified, Id is assumed to be 1. Must be

previously set by the SENSe:MULT:TYPE command.

<pnum> Integer - Logical port number.

<string> Physical port number.

Examples SENS:MULT1:PORT3:SEL "4" 'sets logical port 3 to physical port
4.

Return Type String

Default Not Applicable

SENSe:MULTiplexer<id>:STATe <bool>
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Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Write) Enables and disables (ON/OFF) the port mapping and control line output of the

specified test set.

If the specified test set is not connected or not ON, then setting State ON will report an error. All other

properties can be set when the test set is not connected.

When this command is set to ON, then the display of the test set status bar (SENS:MULT:DISP) is also

set to ON.

Parameters  

<id> Id of the external test set. If unspecified, Id is assumed to be 1. Must be

previously set by the SENSe:MULT:TYPE command.

<bool> ON(1)  Enables test set control.

OFF (0)  Disables test set control.

Examples SENS:MULT1:STAT 1
sense2:multiplexer2:state on

Query Syntax SENSe<cnum>:MULTiplexer<id>:STATe?

Return Type Boolean

Default OFF (0)

SENSe<cnum>:MULTiplexer<id>:TSET9:OUTPut[:DATA] <data> Superseded

Applicable Models: N522xB, N523xB, N524xB, E5080A

Note: This command is replaced with SENS:MULT:OUTP

(Read-Write) Sets the control lines of the specified E5091A. Control lines, provided through a
E5091A front panel connector, are used to control external equipment such as a part handler. See your

E5091A documentation to learn more about control lines.

Parameters  

<cnum> Channel number of the measurement. If unspecified, value is set to 1.

<id> Id of the E5091A test set. Choose from 1 or 2. Learn how to set ID value.

<data> Data value used to set control lines. Values are obtained by adding weights

from the following table that correspond to individual lines. HIGH =1;

LOW=0.
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Line Weight

1 1

2 2

3 4

4 8

5 16

6 32

7 64

8 128

0 - Sets all lines low

255 - Sets all lines high

Examples 'The following sets line 3 and 4 high. All other lines low.

SENS:MULT1:TSET9:OUTP 12

Query Syntax SENSe<cnum>:MULTiplexer<id>:TSET9:OUTPut[:DATA]?

Return Type Numeric

Default 0

SENSe<cnum>:MULTiplexer<id>:TSET9:PORT1 <char> Superseded

Applicable Models: N522xB, N523xB, N524xB, E5080A

Note: This command is replaced with SENS:MULT:ALLPorts which sets ALL ports to the specified

outputs.

(Read-Write)  Switches Port 1 of the specified E5091A to one of the available outputs.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<id> Id of the E5091A test set. Choose from 1 or 2. Learn how to set ID value.

<char> Output port to be switched to. Choose from:

A

T1 - (If Port 2 already is connected to T1, then Port 2 will be switched to T2.)

Examples SENS:MULT1:TSET9:PORT1 A
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Query Syntax SENSe<cnum>:MULTiplexer<id>:TSET9:PORT1?

Return Type Character

Default A

SENSe<cnum>:MULTiplexer<id>:TSET9:PORT2 <char> Superseded

Applicable Models: N522xB, N523xB, N524xB, E5080A

Note: This command is replaced with SENS:MULT:ALLPorts which sets ALL ports to the specified

outputs.

(Read-Write)  Switches Port 2 of the specified E5091A to one of the available outputs.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<id> Id of the E5091A test set. Choose from 1 or 2. Learn how to set ID value.

<char> Output port to be switched to. Choose from:

T1 - If Port 1 already is connected to T1, then Port 1 will be switched to A.

T2

Examples SENS:MULT1:TSET9:PORT2 T2

Query Syntax SENSe<cnum>:MULTiplexer<id>:TSET9:PORT2?

Return Type Character

Default T1

SENSe<cnum>:MULTiplexer<id>:TSET9:PORT3 <char> Superseded
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Applicable Models: N522xB, N523xB, N524xB, E5080A

Note: This command is replaced with SENS:MULT:ALLPorts which sets ALL ports to the specified

outputs.

(Read-Write)  Switches Port 3 of the specified E5091A to one of the available outputs.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<id> Id of the E5091A test set. Choose from 1 or 2. Learn how to set ID value.

<char> Output port to be switched to. Choose from:

R1 (R1+)

R2 (R2+)

R3  (R3+) If option 007 (7port), R2 is selected.

Examples SENS:MULT1:TSET9:PORT3 R2

Query Syntax SENSe<cnum>:MULTiplexer<id>:TSET9:PORT3?

Return Type Character

Default R1

SENSe<cnum>:MULTiplexer<id>:TSET9:PORT4 <char> Superseded

Applicable Models: N522xB, N523xB, N524xB, E5080A

Note: This command is replaced with SENS:MULT:ALLPorts which sets ALL ports to the specified

outputs.

(Read-Write)  Switches Port 4 of the specified E5091A to one of the available outputs.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<id> Id of the E5091A test set. Choose from 1 or 2. Learn how to set ID value.

<char> Output port to be switched to. Choose from:

R1 (R1-)

R2 (R2-)

R3 (R3-) If option 007 (7port), R2 is selected.
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Examples SENS:MULT1:TSET9:PORT4 R2

Query Syntax SENSe<cnum>:MULTiplexer<id>:TSET9:PORT4?

Return Type Character

Default R1

SENSe:MULTiplexer<id>:TYPe <name>

Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Write) If any E509xA test set is connected to the VNA’s USB, or the VNA has no Test Set I/O hardware
interface, then this command is expected to specify which configuration of E509xA test set is to be used.
Otherwise if the VNA has a Test Set I/O hardware interface, this command loads a configuration file for the
specified type of external test set.

If the selected test set type is not one of the E509xA configurations, then this command should be

immediately followed by the SENSe:MULT:ADDRess command.

Parameters  

<name>

 

String  The name of the type of test set. Must be one of the items in the list

returned by the SENSe:MULT:CATalog? query.

<id> Id of the external test set. Set by this command. Use consecutive values starting

at 1.

Examples SENS:MULT1:TYPE "Z5623AK66"   ' use K66 test set, and reference
it through ID 1

Query Syntax SENSe:MULTiplexer<id>:TYPe?

Return Type String

Default Not Applicable
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SENSe:NOISe Commands

Controls the Noise Figure / NFX configuration and calibration.

SENSe:NOISe:

AVERage <num>

       | STATe <bool>

BWIDth <num>

CALibration:

       | METHod <string>

       | RMEThod <string>

ENR:FILename
<string>

EXDC:NAME

GAIN <num>

       | CTCheck

IMPedance:COUNt
<num>

NARRowband[:STATe]
<bool>

PMAP <in>,<out>

       | INPut?

       | OUTPut?

PULL[:STATe] <bool>

RECeiver <char>

SNP? <string>

       | SAVE <string>

SOURce:

       | CKIT <string>

       | CONNector
<string>
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SWEep

       | TIMe?

TEMPerature:AMBient
<num>

TUNer:

       | ID  <string>

       | INPut <string>

       | ORIent[:STATe]

       | OUTPut <string>

Click on a keyword to view the command details.

Other Noise Figure SCPI commands

The calibration commands listed in this topic are supplemental to the Guided Cal commands.

CALCulate:MEASure:DEFine - creates a noise figure measurement.

CONTrol:NOISe:SOURce or OUTPut:MANual:NOISe[:STATe]  - turns the Noise Source ON and OFF.

MMEMory:LOAD:ENR and MMEM:STORe:ENR - load and save ENR files.

SENSe:PATH:CONF:ELEMent[:STATe] - sets the port 1 and port 2 noise switches.

SENS:CORR:ENR:CAL:-  manage ENR data - usually not necessary.

SYST:PREF:ITEM:SWIT:DEF - Sets the default setting of the Noise Tuner switch

SENS:CORR:NOISe commands - noise calibration

SENS:CORR:Guided commands - performs most of noise cal.

See Also

Examples:

Create and Cal a Noise Figure Measurement

Create and Cal an NFX Measurement

Learn about Noise Figure Application

Synchronizing the Analyzer and Controller

SCPI Command Tree
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SENSe<ch>:NOISe:AVERage[:COUNt] <num>

Applicable Models: N524xB, M9485A

(Read-Write) Set and read the averaging factor for the noise receiver. Learn more

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<num> Averaging value. Choose any number from 1 to 99.

Examples SENS:NOIS:AVER 20

sense:noise:average:count 10

Query Syntax SENSe:NOISe:AVERage[:COUNt]?

Return Type Numeric

Default 1

SENSe<ch>:NOISe:AVERage:STATe <bool>

Applicable Models: N524xB, M9485A

(Read-Write) Turns noise averaging ON and OFF.

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<bool> Averaging state. Choose from

0 - Noise averaging OFF

1 - Noise averaging ON

Examples SENS:NOIS:AVER:STAT 0

sense:noise:average:state 1

Query Syntax SENSe:NOISe:AVERage:STATe?

Return Type Boolean

Default O - OFF

SENSe<ch>:NOISe:BWIDth[:RESolution] <num>
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Applicable Models: N524xB, M9485A

(Read-Write) Set and read the bandwidth of the noise receiver. Learn more

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<num> Bandwidth value. Choose from:

For Sens:Noise:Receiver = NOISe (Opt 029) choose from: 800 KHz, 2 MHz, 4

MHz, 8 MHz, or 24 MHz or the numerical equivalent, such as 8e6 and so forth.

For Sens:Noise:Receiver = NORMal (Opt 028) choose from: 720 kHz or 1.2

MHz

If the value does not match one of these, it is rounded up to the next valid

bandwidth value.

Examples SENS:NOIS:BWID 2e6

sense:noise:bwidth:resolution 8mhz

Query Syntax SENSe:NOISe:BWIDth[:RESolution]?

Return Type Numeric

Default 4 MHz for Noise Receiver

1.2 MHz for Normal Receiver

SENSe<ch>:NOISe:CALibration:METHod <string>

Applicable Models: N524xB, M9485A

(Read-Write) Set and read the method for performing a calibration on a noise channel.

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<string> Calibration method. NOT case-sensitive. Choose from:

"VectorFull" or "Vector"

"SParameter" (Not available for NFX measurements)

"ScalarFull" or "Scalar"
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Examples SENS:NOIS:CAL:METH "Vector"

sense:noise:calibration:method "SParameter"

Query Syntax SENSe:NOISe:CALibration:METHod?

Return Type String

Default "VectorFull"

SENSe<ch>:NOISe:CALibration:RMEThod <string>

Applicable Models: N524xB, M9485A

(Read-Write) Set and read the method used to characterize the noise receivers. Learn more.

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<string> Receiver characterization method. NOT case-sensitive. Choose from:

"NoiseSource” - Use a noise source. This selection is NOT allowed when a
standard VNA receiver is used as the noise receiver (SENS:NOIS:REC NORM).

“PowerMeter” - Use a power meter. NOTE:  This selection is NOT allowed when
the Noise Bandwidth is 8 MHz or 24 MHz.

Examples SENS:NOIS:CAL:RMET "PowerMeter"

sense:noise:calibration:rmethod "noisesource"

Query Syntax SENSe:NOISe:CALibration:RMEThod?

Return Type String

Default "NoiseSource"

SENSe<ch>:NOISe:ENR:FILename <string>
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Applicable Models: N524xB, M9485A

(Read-Write) Set and read the path and name of the ENR file associated with the noise source.

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<string> Full path, filename, and extension of the ENR file.

Examples SENS:NOIS:ENR:FIL "c:/ProgramFiles/Keysight/Network
Analyzer/Documents/ENR/346C.enr"

sense:noise:enr:filename "c:/ProgramFiles/Keysight/Network
Analyzer/Documents/ENR/346C.enr"

Query Syntax SENSe:NOISe:ENR:FILename?

Return Type String

Default Not applicable

SENSe<ch>:NOISe:EXDC:NAME <string>

Applicable Models: N524xB, M9485A

(Read-Write) Set and read the external DC source name in order to control the noise source.

Parameters  

<ch> Noise Figure channel number but this number is ignored for this command.

<string> DC source name. The DC source should be defined in the external device

dialog in advance.

Examples Add DC-biased Noise Source named "NoiseSource1". Open NF channel
before sending following commands.

SYSTem:CONFigure:EDEVice:ADD "NoiseSource1"

SYSTem:CONFigure:EDEVice:DTYPE "NoiseSource1","DC Source"

SYSTem:CONFigure:EDEVice:DRIVer "NoiseSource1", "DC Source"

SYSTem:CONFigure:EDEVice:IOConfig "NoiseSource1",
"GPIB0::23::INSTR"

SYSTem:CONFigure:EDEVice:LOAD "NoiseSourceSettings.xml",
"NoiseSource1"

SENSe:NOISe:EXDC:NAME "NoiseSource1"

NOTE: NoiseSourceSettings.xml has setting information about
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waiting time and SCPI commands to DC Source. Create this xml
file before sending SCPI commands.

Query Syntax SENSe:NOISe:EXDC:NAME?

Return Type String

Default ""

SENSe<ch>:NOISe:GAIN <num>

Applicable Models: N524xB, M9485A

(Read-Write) Set and read the amount of gain for the noise receiver. This setting is NOT used when

Sens:Noise:Receiver = NORMal (Opt 028)

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<num> Gain value. Choose from:

0 - Low gain;select if the gain of your DUT is relatively high (>35 dB).

15 - Medium gain; select if the gain of your DUT is about average (20 dB to 45 dB)

30 - High gain;.select if the gain of your DUT is relatively low (<30 dB).

Learn more about Noise Receiver Gain setting.

If the value does not match one of these, it is rounded up to the next legal

value.

Examples SENS:NOIS:GAIN 15

sense:noise:gain 0

Query Syntax SENSe:NOISe:GAIN?

Return Type Numeric

Default 30

SENSe<ch>:NOISe:GAIN:CTCheck <bool>
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Applicable Models: N524xB, M9485A

(Read-Write) Turns noise threshold checking ON and OFF.

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<bool> Threshold checking state. Choose from

0 - Noise threshold checking OFF

1 - Noise threshold checking ON

Examples SENS:NOIS:GAIN:CTC 0

sense:noise:gain:ctcheck 1

Query Syntax SENSe:NOISe:GAIN:CTCheck?

Return Type Boolean

Default O - OFF

SENSe<ch>:NOISe:IMPedance:COUNt <num>

Applicable Models: N524xB, M9485A

(Read-Write) Sets the number of impedance states to use during calibrated measurements.

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<num> Number of impedance states to use. Choose between 4 and the maximum

number allowed by the noise tuner device. The more states that are used, the

more accurate, and slower, the measurement.  If the specified number exceeds

the capability of the device, the measurement will use the maximum number of

states the device allows.  

Examples SENS:NOIS:IMP:COUN 5

sense:noise:impedance:count 7

Query Syntax SENSe:NOISe:IMPedance:COUNt?

Return Type Numeric

Default 4

SENSe<ch>:NOISe:NARRowband[:STATe] <bool>
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Applicable Models: N524xB, M9485A

(Read-Write) Turns narrowband noise figure compensation ON and OFF

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<bool> Compensation state. Choose from

0 or OFF - Narrowband noise compensation OFF

1 or ON - Narrowband noise compensation ON

Examples SENS:NOIS:NARR 0

sense:noise:narrowband:state 1

Query Syntax SENSe:NOISe:NARRowband[:STATe]?

Return Type Boolean

Default O - OFF

SENSe<ch>:NOISe:PMAP <in>,<out>

Applicable Models: N524xB, M9485A

(Write-only) Set and read the DUT-to-VNA port mapping for Noise Figure. Port mapping is allowed

ONLY when SENS:NOIS:REC is set to NORM (standard VNA-X receiver).

Parameters  

<ch> Any existing NF or NFX channel. If unspecified, value is set to 1.

<in> VNA port which is connected to the DUT input.

<out> VNA port which is connected to the DUT output.

Examples SENS:NOIS:PMAP 1,2

sense:noise:pmap 2,1

See example program

Query Syntax Not Applicable
Default 1,2

SENSe<ch>:NOISe:PMAP:INPut?
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Applicable Models: N524xB, M9485A

(Read-only) Read the VNA port number to be connected to the DUT Input.

Use SENS:NOISe:PMap to set the port mapping.

Parameters  

<ch> Any existing NF or NFX channel. If unspecified, value is set to 1.

Examples SENS:NOIS:PMAP:INP?

sense:noise:pmap:input?

Return Type Numeric

Default 1

SENSe<ch>:NOISe:PMAP:OUTPut?

Applicable Models: N524xB, M9485A

(Read-only) Read the VNA port number to be connected to the DUT Output.

Parameters  

<ch> Any existing NF or NFX channel. If unspecified, value is set to 1.

Examples SENS:NOIS:PMAP:OUTP?

sense:noise:pmap:output?

Return Type Numeric

Default 2

SENSe<ch>:NOISe:PULL[:STATe] <bool>
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Applicable Models: N524xB, M9485A

(Read-Write) Enables and disables the use of source pull technique to compute S22. Learn more.

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<bool> Source pull technique state. Choose from:

OFF or 0 - Disable use of source pull technique.

ON or 1 - Enable use of source pull technique.

Examples SENS:NOIS:PULL 0

sense2:noise:pull:state ON

Query Syntax SENSe:NOISe:PULL[:STATe]?

Return Type Boolean

Default 0 - OFF

SENSe<ch>:NOISe:RECeiver <char>

Applicable Models: N524xB, M9485A

(Read-Write) Sets and returns the noise receiver to use for noise measurements.

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<char> Noise receiver. Choose from:

NORMal The standard VNA receiver. (Opt 028 and Opt 029)

NOISe  The low-noise receivers. (Opt 029 only)

Examples SENS:NOIS:REC NORM

sense2:noise:receiver noise

Query Syntax SENSe:NOISe:RECeiver?

Return Type Character

Default NOISe

SENSe<ch>:NOISe:SNP? [string]
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Applicable Models: N524xB, M9485A

(Read-Only) Returns S-parameter and noise parameter data for vector noise figure measurements.

Noise parameters are NOT valid for NFX or Scalar noise figure measurements. Learn more about

noise parameters.

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

[string] Optional parameter. Choose "NoiseParameter" - Noise parameter data.

If unspecified, only S-parameter data is saved.

Examples SENS:NOIS:SNP?

sense2:noise:snp? "NoiseParameter"

Return Type Comma-separated values

Data is returned in this order:

1. <all frequencies | point number>

2. <real S11> <imag S11> <real S21> <imag S21> <real S12> <imag S12>

<real S22> <imag S22>

Then if noise parameters are specified:

3. <NFMin dB> <mag GammaOpt> <phase GammaOpt> <Rn/Z0>

The data display format depends on MMEM:STOR:TRAC:FORM:SNP

Default Not Applicable

SENSe<ch>:NOISe:SNP:SAVE <filename>, [data]

Applicable Models: N524xB, M9485A

(Write-only) Saves the S-parameters and vector noise parameters to an S2P file. For NFX channels,

mixer setup information is included as comments at the beginning of the file.

Learn more about noise parameters.  

The format of the snp data is set with MMEM:STOR:TRAC:FORM:SNP.  

The following is sample data for two data points from a Noise Figure measurement:
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! Keysight Technologies,N5242A,USxxxxxxx,A.09.85

! pnan-nn Thu Nov 01 12:26:27 2012

# HZ S MA R 50

!freq (Hz)   S11M            S11A           S21M         S21A           S12M          S12A         S22M

          S22A

2000000000 9.038147e-001 6.241193e+001 5.855965e+000 -6.116778e+001 2.232653e-002 -

1.475392e+002 5.275644e-001 1.750775e+002

8000000000 6.951366e-001 -1.458202e+002 5.307699e+000 -7.055212e+001 7.838612e-002 -

1.460951e+002 3.986142e-001 -2.226317e+001

! Noise Parameters

!freq (Hz)   NFMin(dB)      Rho_opt(Mag)      Rho_opt(deg)      Rn/Z0

2000000000 1.251697e+000 2.172018e-001 -8.765875e+001 1.806663e-001

8000000000 1.583849e+000 2.015185e-001 1.029875e+002 1.320403e-001

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<filename> Path (optional), filename and suffix of location to store SNP data. If path is not

specified, the current path is used.

[data] String. Optional parameter. Choose "NoiseParameter" - Noise parameter

data.

If unspecified, only S-parameter data is saved.

Examples SENS:NOIS:SNP:SAVE "MySparams.s2p"

sense2:noise:snp:save "C:/Program Files/Keysight/Network
Analyzer/Documents/MyNoiseParams.s2p", "NoiseParameter"

Query Syntax Not Applicable

Default Not Applicable

SENSe<ch>:NOISe:SOURce:CKIT <string>
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Applicable Models: N524xB, M9485A

(Read-Write) Set and read the Cal Kit that will be used for the Noise Source adapter.

An adapter is always necessary to connect a 346C Noise Source to the VNA port 2. Select a Cal Kit

that is the same type and gender as the noise source connector.

If the Noise Source mates directly to VNA port 2, then set this type to "None".

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<string> Cal Kit. Case sensitive.

To read possible cal kit strings for the adapter:

Change the port connector type to that of the noise source using:
SENS:CORR:COLL:GUID:CONN:PORT<n>

Then read the possible cal kit strings for that port using:
SENS:CORR:COLL:GUID:CKIT:PORT<n>:CAT?

Examples SENS:NOIS:SOUR:CKIT "N4691-60004 ECal"

sense:noise:source:ckit "

Query Syntax SENSe:NOISe:SOURce:CKIT?

Return Type String

Default Not applicable

SENSe<ch>:NOISe:SOURce:CONNector <string>
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Applicable Models: N524xB, M9485A

(Read-Write) Set and read the Noise Source connector type and gender. The Keysight 346C has an

"APC 3.5 male" connector.

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<string> Noise source connector type and gender. Case sensitive.

Use SENS:CORR:COLL:GUID:CONN:CAT? to read possible connector strings.

Examples SENS:NOIS:SOUR:CONN "APC 3.5 male"

sense:noise:source:connector "APC 3.5 female"

Query Syntax SENSe:NOISe:SOURce:CONNector?

Return Type String

Default Not applicable

SENSe<ch>:NOISe:SWEep:TIMe?

Applicable Models: N524xB, M9485A

(Read-only) Returns the APPROXIMATE time the channel will take to make one noise receiver

sweep given the current setup. This, along with the sweep time for a  standard receiver measurement

and the following calculations, can tell you how long a “single” sweep would take so that you can set

an appropriate "timeout" in your program.

To calculate the total sweep time:

Noise Figure on amplifiers (Vector Correction ON):

2*SSwpTime + X*NoiseReceiverSweepTime

Where X = the number of noise receiver impedance state sweeps. (Default is 4).

Noise Figure on converters (NFX) correction on - increased number of sweeps due to extra mixer

sweeps and source pulling:

4*SSwpTime + X*NoiseReceiverSweepTime (without source pulling)

8*SSwpTime + X*NoiseReceiverSweepTime (with source pulling)

Where X = the number of noise receiver impedance state sweeps. (Default is 4).
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Note: The number of sweeps to perform a noise measurement is annotated at the bottom of the Noise

Figure screen.

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

Examples SENS:NOIS:SWE:TIM?

sense:noise:sweep:time?

Return Type Double

Default Not applicable

SENSe<ch>:NOISe:TEMPerature:AMBient <num>

Applicable Models: N524xB, M9485A

(Read-Write) Sets the temperature at which the current noise measurement is occurring. Learn more

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<num> Ambient temperature in Kelvin.

Examples SENS:NOIS:TEMP:AMB 292

sense:noise:temperature 289

Query Syntax SENSe:NOISe:TEMPerature:AMBient?

Return Type Numeric

Default 295

SENSe<ch>:NOISe:TUNer:ID <string>
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Applicable Models: N524xB, M9485A

(Read-Write) Set and read the identity of the noise tuner. This is an ECal model and serial number

string. To read the identities of the connected ECal modules,  use SENSe:CORRection:CKIT:ECAL:LIST?
and SENSe:CORRection:CKIT:ECAL<mod>:INFormation?

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<string> ECal model and serial number string. The ECal module must be connected

when this command is sent.

Examples SENS:NOIS:TUN:ID "N4691-60004 ECal 02822"

sense:noise:tuner:id ""N4691-60004 ECal 02822"

Query Syntax SENSe:NOISe:TUNer:ID?

Return Type String

Default Not applicable

SENSe<ch>:NOISe:TUNer:INPut <string>

Applicable Models: N524xB, M9485A

(Read-Write) Sets and reads the port of the ECal noise tuner that is connected to the VNA SOURCE

OUT.

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<string> ECal port identifier. Case sensitive.

Examples SENS:NOIS:TUN:INP "B"

sense:noise:tuner:input "A"

Query Syntax SENSe:NOISe:TUNer:INPut?

Return Type String

Default "B"

SENSe<ch>:NOISe:TUNer:ORIent[:STATe] <bool>
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Applicable Models: N524xB, M9485A

(Read-Write) Sets the state of auto orientation for a noise tuner during Noise Figure for NFX.

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<bool> Auto-orientation state. Choose from:

OFF or 0 - Disable Auto-orientation

ON or 1 - Enable Auto-orientation

Examples SENS:NOIS:TUN:ORI 0

sense2:noise:tuner:orient:state ON

Query Syntax SENSe:NOISe:TUNer:ORIent[:STATe]?

Return Type Boolean

Default 1 - ON

SENSe<ch>:NOISe:TUNer:OUTPut <string>

Applicable Models: N524xB, M9485A

(Read-Write) Sets and reads the port of the ECal noise tuner that is connected to the CPLR THRU.

Parameters  

<ch> Noise Figure channel number. If unspecified, value is set to 1.

<string> ECal port identifier. Case sensitive.

Examples SENS:NOIS:TUN:OUTP "B"

sense:noise:tuner:output "A"

Query Syntax SENSe:NOISe:TUNer:OUTput?

Return Type String

Default "A"
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Sense:Power Command

Learn about Receiver Attenuation

SENSe<cnum>:POWer:ATTenuator <recvr>,<num>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the attenuation level for the specified receiver.

Note: Attenuation cannot be set with Sweep Type set to Power

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<recvr> Receiver to get attenuation. Choose from:

ARECeiver - receiver A

BRECeiver - receiver B

CRECeiver - receiver C

DRECeiver - receiver D

Receiver attenuation can NOT be set using logical receiver notation.

<num> Attenuation value in dB.  To determine how many receiver attenuators, the

maximum receiver attenuation, and attenuation step size,  for a VNA model,

see VNA Models and Options.

If a number other than these is entered, the analyzer will select the next lower

valid value. For example, if 19 is entered for the E8361A/C, then 10 dB

attenuation will be selected.

Examples SENS:POW:ATT AREC,10
sense2:power:attenuator breceiver,30

Query Syntax SENSe<cnum>:POWer:ATTenuator? <rec>

Return Type Numeric

Default 0
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Sense:Pulse Commands

Configures the 5 pulse generators in the VNA-X.

Beginning with A.09.50, these commands can also be used to control an external Pulse Generator.

Learn more.

SENSe:PULSe

| CATalog?

| DELay

| DINCrement

| INVert

| OPTion:PULSe4

| PERiod

| STATe

| SUBPointtrig

| TPOLarity

| TTYPe

| WIDTh

Click on a keyword to view the command details.

To make other Pulse settings, such as enabling the internal pulse modulators, use this command:

SENSe<ch>:PATH:CONFig:ELEMent[:STATe] <elem>, <setting>

At that command help topic, click the IF Configuration elements and values link to see the Pulse
element and setting (in the middle box ) to configure.

See Also

SENS:SWEep:PULSE - configures the channel for pulse measurements

External Pulse Generator configuration commands

SENS:IF configuration commands

Example Programs
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VNA-X Integrated Pulse Application

Synchronizing the Analyzer and Controller

SCPI Command Tree

 

Pulse Definitions

D = Delay; the time before each pulse begins

W = Width; the time the pulse is ON

P = Period; one complete pulse cycle

Duty Cycle = W/P

Important: If D + W is greater than P, then undefined VNA behavior results. There is NO error

message or warning.

SENSe:PULSe:CATalog?

Applicable Models: N524xB

(Read-only) Returns the string names of internal and configured external pulse generators.

Parameters None

Examples SENS:PULS:CAT?

Default Not Applicable

SENSe<ch>:PULSe<n>:DELay <value>[,<name>]
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Applicable Models: N524xB

(Read-Write) Sets the pulse delay. The amount of time before a new pulse begins.

See Pulse Definition diagram.

Parameters  

<ch> Any existing channel number; if unspecified, value is set to 1.

<n> Internal pulse generator number. Choose from 0 to 4.

0 is the generator that pulses the ADC.

<value> Delay value in seconds. Choose a value from about 33ns to about 70 seconds.

<name> Optional. String name of the pulse generator.

Required for use with external pulse generators.

Use SENSe:PULSe:CAT? to return the names of configured pulse generators.

If specified, <n> is ignored.

If unspecified, <n> is required for internal pulse generators.

Examples SENS:PULS1:DEL .5

SENS:PULS:DEL .5, "My81110"

Query Syntax SENSe<ch>:PULSe<n>:DELay? [<name>]

Return Type Numeric

Default 0

SENSe<ch>:PULSe<n>:DINCrement <value>[,<name>]
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Applicable Models: N524xB

(Read-Write) Sets the pulse delay increment. The delay increments with each pulse by the <value>

amount.

For example, in this diagram the delay starts as 1.  On the second pulse, delay=2. On the third pulse,

delay=3.

Important: If D + W is greater than P, then undefined VNA behavior results. There is NO error

message or warning. Delay includes the incremented value.

This is useful for pulse profiling.

See Pulse Definition diagram.

Parameters  

<ch> Any existing channel number; if unspecified, value is set to 1.

<n> Pulse generator number. Choose from 0 to 4.

0 is the generator that pulses the ADC.

<value> Delay increment value in seconds.

<name> Optional. String name of the pulse generator.

Required for use with external pulse generators.

Use SENSe:PULSe:CAT? to return the names of configured pulse generators.

If specified, <n> is ignored.

If unspecified, <n> is required for internal pulse generators.

Examples SENS:PULS1:DINC .5

SENS:PULS:DINC .5, "My81110"

Query Syntax SENSe<ch>:PULSe<n>:DINCrement? [<name>]

Return Type Numeric

Default 0

1304



SENSe<ch>:PULSe<n>:INVert <value>[,<name>]

Applicable Models: N524xB

(Read-Write) Sets whether to invert the polarity of the pulse.

Parameters  

<ch> Any existing channel number; if unspecified, value is set to 1.

<n> Pulse generator number. Choose from 0 to 4.

0 is the generator that pulses the ADC.

<value> Boolean

ON (or 1) - Invert the pulse generator polarity. This causes the pulse ON time

to be active low and OFF be active high.

OFF (or 0) - Do NOT Invert the pulse generator polarity.

<name> Optional. String name of the pulse generator.

Required for use with external pulse generators.

Use SENSe:PULSe:CAT? to return the names of configured pulse generators.

If specified, <n> is ignored.

If unspecified, <n> is required for internal pulse generators.

Examples SENS:PULS1:INV 1

SENS:PULS:INV 1, "My81110"

Query Syntax SENSe<ch>:PULSe:INVert? [<name>]

Return Type Boolean

Default OFF (0)

SENSe<ch>:PULSe4:OPTion <bool>
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Applicable Models: N524xB

(Read-Write) Turns pulse4 output ON and OFF. Enable pulse4 to use an oscilloscope connected to

pin 13 of the PULSE I/O connector on the rear panel of the VNA to display when the ADC is making

measurements.

Note: The pulse output must be on using SENSe:PULSe4[:STATE] ON to view ADC activity.

Parameters  

<ch> Any existing channel number; if unspecified, value is set to 1.

<bool> Choose from:

ON (or 1) - Pulse 4 output pin indicates ADC activity.

OFF (or 0) - Pulse 4 output pin indicates legacy behavior (pulse generator

number 4 output).

Examples SENS:PULS4:OPT 1

Query Syntax SENSe<ch>:PULSe4:OPTion?

Return Type Boolean

Default OFF

SENSe<ch>:PULSe:PERiod <value>[,<name>]

Applicable Models: N524xB

(Read-Write) Sets the pulse-period (1/PRF) for ALL pulse generators.

The resolution of the period is:

DSP version: 4.0 = 16.667nS.

DSP version: 5.0 = 10nS

Learn more about DSP version.

See Pulse Definition diagram.

Parameters  

<ch> Any existing channel number; if unspecified, value is set to 1.

<value> Pulse period in seconds. Choose a value from about 33ns to about 70 seconds.

<name> Required for use with an external pulse generator.
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String name of the external pulse generator.

If unspecified, the period for the internal pulse generators are set.

Use SENSe:PULSe:CAT? to return the names of configured pulse generators.

Examples SENS:PULS:PERiod .05

SENS:PULS:PER .01, "My81110"

Query Syntax SENSe<ch>:PULSe:PERiod? [<name>]

Return Type Numeric

Default 1e-3 sec

SENSe<ch>:PULSe<n>[:STATe] <value>[,<name>]

Applicable Models: N524xB

(Read-Write) Turns the pulse output ON and OFF.

Parameters  

<ch> Any existing channel number; if unspecified, value is set to 1.

<n> Pulse generator number. Choose from 0 to 4.

0 is the generator that pulses the ADC.

<value> Boolean

ON (or 1) - turns pulse output ON.

OFF (or 0) - turns pulse output OFF.

<name> Optional. String name of the pulse generator.

Required for use with external pulse generators.

Use SENSe:PULSe:CAT? to return the names of configured pulse generators.

If specified, <n> is ignored.

If unspecified, <n> is required for internal pulse generators.

Examples SENS:PULS1 1

SENS:PULS 1, "My81110"

Query Syntax SENSe<ch>:PULSe[:STATe]? [<name>]
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Return Type Boolean

Default OFF

SENSe<ch>:PULSe<n>:SUBPointtrig <bool>

Applicable Models: N524xB

(Read-Write) Enables / Disables subpoint triggering. When enabled and performing Point Averaging,

Each rising edge of P0 triggers a subpoint (one of N acquisitions in an N point average). Must also

enable the P0 generator using SENS:PULS0:STAT.

Learn more about the VNA-X pulse generators.

Parameters  

<ch> Any existing channel number; if unspecified, value is set to 1.

<n> Pulse generator number. Must be 0 as this is the generator that triggers the

ADC.

<bool> ON (or 1) - turns subpoint triggering ON.

OFF (or 0) - turns subpoint triggering OFF.

Examples SENS:PULS0:SUBP 1

Query Syntax SENSe<ch>:PULSe0:SUBPointtrig?

Return Type Boolean

Default OFF

SENSe<ch>:PULSe:TPOLarity <char>
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Applicable Models: N524xB

(Read-Write) Sets the polarity of the trigger signal to which the internal pulse generators will respond

when being externally triggered at the PulseSyncIn pin.

Note: This feature requires DSP version: 4.0 FPGA: 34 or higher. Learn more.

Learn more about the VNA-X pulse generators.

Parameters  

<ch> Any existing channel number; if unspecified, value is set to 1.

<char> Pulse polarity. Choose from:

POSitive - VNA responds to rising edge or HIGH level

NEGative - VNA responds to falling edge or LOW level.

Set Edge or Level triggering using SENS:PULS:TTYPe.

Examples SENS:PULS:TPOL NEG

Query Syntax SENSe<ch>:PULSe:TPOLarity?

Return Type Character

Default POSitive - Also the polarity used when the VNA-X does not have the required

DSP hardware.

SENSe<ch>:PULSe<n>:TTYPe <char>

Applicable Models: N524xB

(Read-Write) Sets the type of trigger signal to which the internal pulse generators will respond when

being externally triggered at the PulseSyncIn pin.

Note: This feature requires DSP version: 4.0 FPGA: 34 or higher. Learn more.

Learn more about the VNA-X pulse generators.

Parameters  

<ch> Any existing channel number; if unspecified, value is set to 1.

<char> Trigger type. Choose from:

EDGE - VNA responds to the edge (rising or falling) of a signal

LEVel - VNA responds to the level (HIGH or LOW) of a signal
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Set polarity using SENS:PULS:TPOL

Examples SENS:PULS:TTYP EDGE

Query Syntax SENSe<ch>:PULSe:TTYPe?

Return Type Character

Default LEVel - Also the type used when the VNA-X does not have the required DSP

hardware.

SENSe<ch>:PULSe<n>:WIDTh <value>[,<name>]

Applicable Models: N524xB

(Read-Write) Sets the pulse width. The amount of time that the pulse is ON.

See Pulse Definition diagram.

Parameters  

<ch> Any existing channel number; if unspecified, value is set to 1.

<n> Pulse generator number. Choose from 0 to 4.

0 is the generator that pulses the ADC.

<value> Pulse width in seconds. Choose a value from about 33ns to about 70 seconds.

<name> Optional. String name of the pulse generator.

Required for use with external pulse generators.

Use SENSe:PULSe:CAT? to return the names of configured pulse generators.

If specified, <n> is ignored.

If unspecified, <n> is required for internal pulse generators.

Examples SENS:PULS:WIDT .5

SENS:PULS:WIDT .5, "My81110"

Query Syntax SENSe<ch>:PULSe<n>:WIDTh? [<name>]

Return Type Numeric

Default 1e-4 sec
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Sense:Roscillator Command

Learn about the Reference Osc.

See the rear-panel 10 MHz connector.

SENSe:ROSCillator:SOURce?

Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-only) Applying a 10 MHz signal to the Reference Oscillator connector automatically sets the

Reference Oscillator to EXTernal. This command allows you to check that it worked.

EXT is returned when a signal is present at the 10 MHz Reference Oscillator connector.

INT is returned when NO signal is present at the 10 MHz Reference Oscillator connector.

Examples SENS:ROSC:SOUR?
sense:roscillator:source?

Return Type Character

Default Not applicable

SENSe:ROSCillator:SOURce <state>

Applicable Models: M937xA

(Write-only) Set and read 10 MHz Reference Oscillator state.

Note: This setting is NOT cleared with Preset. However, it does clear when the M937xA software is

restarted.

Parameters  

<state> Choose from the following:

INTernal - Use the internal 10 MHz Reference Oscillator

EXTernal - Use an external Reference Oscillator. Use
SENSe:ROSCillator:SOURce:CONDition? to determine if the M937xA is locked to

the external oscillator.

Examples SENS:ROSC:SOUR INT

sense:roscillator:source external

Query Syntax Not applicable

1311



Return Type Not applicable

Default INTernal

SENSe:ROSCillator:SOURce:CONDition?

Applicable Models: M937xA

(Read-only)  Reads the 10 MHz Reference Oscillator 'locked' condition.

When SENS:ROSC:SOUR is set to Internal, this command will always return "LOCKed".

When SENS:ROSC:SOUR is set to External, then this function takes about 100 usec to read the state

of the hardware.

Examples SENS:ROSC:SOUR
sense:roscillator:source?

Return Type Character

Default Not applicable
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Spectrum Analyzer Commands

Controls the Spectrum Analyzer Application.

SA Application - SA Setup tab

SENSe:SA:SOURce:SWEep:TYPE

SENSe:SA:BANDwidth:[RESolution]

SENSe:SA:BANDwidth:[RESolution]:AUTO

SENSe:SA:BANDwidth:RESolution MIN

SENSe:SA:BANDwidth:RESolution MAX

SENSe:SA:BANDwidth:VIDeo

SENSe:SA:BANDwidth:VIDeo:AUTO

SENSe:SA:BANDwidth:VIDeo MIN

SENSe:SA:BANDwidth:VIDeo MAX

SENSe:SA:DETector:FUNCtion

SENSe:SA:DETector:BYPass:[STATe]

SENSe:SA:BANDwidth:VIDEO:AVERage:TYPE

SENSe:SA:BANDwidth:VIDEO:AVERage:COUNt?

 

Source Setup tab

1313



SENSe:SA:SOURce:FREQuency:STARt

SENSe:SA:SOURce:FREQuency:STOP

SENSe:SA:SOURce:FREQuency:CW

SENSe:SA:SOURce:POW:SWEep:POINt:COUNt

SENSe:SA:SOURce:POW:SWEep:REPeat:COUNt

SENSe:SA:SOURce:POWer:STARt

SENSe:SA:SOURce:POWer:STOP

SENSe:SA:SOURce:POWer[:VALue]

SENSe:SA:SOURce:SWEep:FIRst[:DIMension]

SENSe:SA:SOURce:SWEep:POINt:COUNt

SENSe:SA:SOURce:SWEep:REPeat:COUNt

 

Advanced Setup tab

SENSe:SA:BANDwidth:SHAPe

SENSe:SA:IMAGe:REJect

SENSe:SA:IMAGe:STRENgth

SENSe:SA:BANDwidth:VIDeo:RATio

SENSe:SA:FREQuency:SPAN:BANDwidth[:RESolution]:RATio

SENSe:SA:SOURce:DC:SWEep[:STATe]

SENSe:SA:SOURce:DC:SWEep:POINt

SENSe:SA:FREQuency:TUNE:IMMediate

SENSe:SA:SOURce:DC:SWEep:FIRst[:DIMension]
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IF Setup tab

SENSe:SA:ADC:FILTer

SENSe:SA:ADC:FILTer:AUTO

SENSe:SA:DFT:BANDwidth:AUTO

SENSe:SA:DFT:BANDwidth:NARRow:MIN

SENSe:SA:DFT:BANDwidth:NARRow:MAX

SENSe:SA:DFT:BANDwidth:WIDE:MIN

SENSe:SA:DFT:BANDwidth:WIDE:MAX

 

Trigger Setup tab
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SENSe:SA:TRIGer:LEVel[:STATe]

SENSe:SA:TRIGer:LEVel:VALue

SENSe:SA:TRIGer:PERCounter[:STATe]

SENSe:SA:TRIGer:PERCounter:VALue

 

Processing Setup tab

SENSe:SA:DFT:TYPE

SENSe:SA:TRACe:IMAGe[:STATe]

SENSe:SA:ADC:ACQTime?

SENSe:SA:LO:COUNt?

SENSe:SA:SPAN:BINS:COUNt?

SENSe:SA:DFT:RESolution?

SENSe:SA:DFT:RECord:SIZE?

SENSe:SA:ADC:RECord:SIZE:VALue?
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ADC & LO Setup tab

SENSe:SA:ADC:SAMPle:RATE

SENSe:SA:ADC:SAMPle:RATE:AUTO

SENSe:SA:ADC:SAMPle:DECimation:FIR

SENSe:SA:ADC:DITHer:[STATe]

SENSe:SA:ADC:RECord:SIZE:VALue?

SENSe:SA:ADC:RECord:FORCe

SENSe:SA:ADC:STACking:VALue

SENSe:SA:ADC:STACking:STATe

SENSe:SA:ADC:MREC:SIZE

SENSe:SA:ADC:MREC:PERiod

SENSe:SA:ADC:MREC[:STATe]

SENSe:SA:LO:RANDom:[STATe]

SENSe:SA:LO:FREQ:FORCe

SENSe:SA:LO:FREQ:VALue

 

Other SA SCPI commands

SA Application - Setup tab
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SENS:FREQ:STAR

SENS:FREQ:STOP

SENS:FREQ:CENT

SENS:FREQ:SPAN

SENS:FREQ:SPAN:FULL

SENS:FREQ:CENT:STEP:SIZE

SENS:FREQ:CENT:STEP:AUTO

SENS:FREQ:CW

SENS:SWE:POIN

SENS:POWer:ATT

IF Gain Settings SENS:PATH:CONFig:ELEM

 

SA Marker Settings

Marker to SA CALC:MEAS:MARKer:SET SA
Read Band
Power

CALC:MEAS:SA:MARK:BPOWer:DATA?

Set and read
Band Power
Span

CALC:MEAS:SA:MARK:BPOWer:SPAN

Set Band
Power State

CALC:MEAS:SA:MARK:BPOWer[:STATe]

Read Band
Noise

CALC:MEAS:SA:MARK:BNOise:DATA?

Set and read
Band Noise
Span

CALC:MEAS:SA:MARK:BNOise:SPAN

Set Band
Noise State

CALC:MEAS:SA:MARK:BNOise[:STATe]

Other SA commands

CALCulate:MEASure:DEFine - creates an SA measurement.
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SA Calibration uses the Guided Calibration commands.

See Also

Example Program: Create an SA Measurement

Learn about SA Application

Synchronizing the Analyzer and Controller

SCPI Command Tree

SENSe<ch>:SA:ADC:ACQTime?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the LO acquisition time which is the ADC Record Size x ADC Sampling

Frequency (10 nsec or 40 nsec) x (1 + Stacking) x (Video Average.Coefficient).

Parameters  

<ch> Channel number of the measurement. If unspecified,value is set to 1.

Examples SENS:SA:ADC:ACQT?

sense2:sa:adc:acqtime?

Default Not applicable

SENSe<ch>:SA:ADC:DITHer[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the ON/OFF state of the dither setting

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF - Dither OFF.

1 - ON - Dither ON.

Learn about these settings.

Examples SENS:SA:ADC:DITH 1
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Query Syntax SENSe<ch>:SA:ADC:DITH?

Return Type Boolean

Default 0

SENSe<ch>:SA:ADC:FILTer <num>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the ADC filter cutoff frequency. The entered frequency value is rounded to

the closest value supported by the VNA (11 MHz or 38 MHz).

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<num> Choose 11 MHz or 38 MHz.

Learn about these settings.

Examples SENS:SA:ADC:FILTer 11MHz

Query Syntax SENSe<ch>:SA:ADC:FILTer?

Return Type Numeric

Default 11 MHz

SENSe<ch>:SA:ADC:FILTer:AUTO <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read how the ADC filter is set. When ON, the ADC filter is set based on the

start and stop frequencies and the ADC sampling frequency.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 0.

<bool> Choose from:

0 - OFF - ADC filter is set manually using SENS:SA:ADC:FILT .

1 - ON - ADC filter is set automatically.

Learn about these settings.

Examples SENS:SA:ADC:FILT:AUTO ON
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Query Syntax SENSe<ch>:SA:ADC:FILTer:AUTO?

Return Type Boolean

Default 1

SENSe<ch>:SA:ADC:MREC:PERiod <value>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the period to wait between ADC record chunks.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<value> Choose a value between 64 and 33554432

Learn about these settings.

Examples SENS:SA:ADC:MREC:PER 256

Query Syntax SENSe<ch>:SA:ADC:MREC:PERiod?

Return Type Integer

Default 64

SENSe<ch>:SA:ADC:MREC:SIZE <value>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the size of the ADC record chunks.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<value> Choose a value between 1 and (ADC record size / 2).

Learn about these settings.

Examples SENS:SA:ADC:MREC:SIZE 256

Query Syntax SENSe<ch>:SA:ADC:MREC:SIZE?

Return Type Integer

Default 32
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SENSe:SA:ADC:MREC[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the ON/OFF state of the multiple recording function. Multiple recording

allows the ADC Record Size to be divided and acquired in smaller "chunks" and also to specify a wait

period between these acquisitions.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF - ADC record size "chunking" OFF.

1 - ON - ADC record size "chunking" ON.

Learn about these settings.

Examples SENS:SA:ADC:MREC 0

Query Syntax SENSe<ch>:SA:ADC:MREC[:STATe]?

Return Type Boolean

Default 0

SENSe<ch>:SA:ADC:RECord:FORCe <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the ADC record size mode.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF - ADC record size set automatically.

1 - ON - Manually set ADC record to specified size.

Learn about these settings.

Examples SENS:SA:ADC:REC:FORC 1

Query Syntax SENSe<ch>:SA:ADC:REC:FORC?

Return Type Boolean
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Default 0

SENSe<ch>:SA:ADC:RECord:SIZE:VALue?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Read ADC record size value.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

Examples SENS:SA:ADC:REC:SIZE:VAL? 256

Return Type Integer

Default Not applicable

SENSe<ch>:SA:ADC:SAMPle:DECimation:FIR <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the FIR filter for 25 MHz decimation.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF -Disable 25 MHz FIR filter.

1 - ON - Enable 25 MHz FIR filter.

Examples SENS:SA:ADC:SAMPle:DECimation:FIR 1

Query Syntax SENSe<ch>:SA:ADC:SAMPle:DECimation:FIR?

Return Type Boolean

Default 0

SENSe<ch>:SA:ADC:SAMPle:RATE <num>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the ADC sampling frequency. The entered frequency is rounded to the

closest value supported by the VNA (25 MHz or 100 MHz).

Parameters  

<ch> Any existing SA channel.

<num> Choose from 100 MHz or 25 MHz.

Learn about these settings.

Examples SENS:SA:ADC:SAMP:RATE 100MHz

Query Syntax SENSe<ch>:SA:ADC:SAMP:RATE?

Return Type Numeric

Default 100 MHz

SENSe<ch>:SA:ADC:SAMPle:RATE:AUTO <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the ADC sample rate mode.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF - Manually set ADC sampling rate using

SENSe:SA:ADC:SAMPle:RATE .

1 - ON - ADC sampling rate set automatically.

Learn about these settings.

Examples SENS:SA:ADC:SAMP:RATE:AUTO 1

Query Syntax SENSe<ch>:SA:ADC:SAMPle:RATE:AUTO?

Return Type Boolean

Default 1

SENSe:SA:ADC:STACking:STATe <bool>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the ON/OFF state of the ADC sample stacking.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF - ADC sample stacking OFF.

1 - ON - ADC sample stacking ON.

Learn about these settings.

Examples SENS:SA:ADC:STAC:STAT 0

Query Syntax SENSe<ch>:SA:ADC:STACking:STATe?

Return Type Boolean

Default 0

SENSe<ch>:SA:ADC:STACking:VALue <value>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the ADC stacking value.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 0 (no stacking).

<value> Choose a value between 0 and 65535.

Learn about these settings.

Examples SENS:SA:ADC:STAC:VAL 1

Query Syntax SENSe<ch>:SA:ADC:STACking:VALue?

Return Type Integer

Default 0

SENSe<ch>:SA:BANDwidth[:RESolution] <num>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the resolution bandwidth. Also set SENS:SA:BAND:AUTO OFF.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<num> Choose a value between 6 Hz and 3 MHz. Attempting to set the bandwidth

outside these bounds will force the bandwidth to the nearest bound.

Learn about these settings.

Examples SENS:SA:BAND 1e3

Query Syntax SENSe<ch>:SA:BANDwidth[:RESolution]?

Return Type Numeric

Default 300 kHz

SENSe<ch>:SA:BANDwidth:RESolution <enum>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the minimum and maximum resolution bandwidth.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<enum> Choose from:

MAX

MIN

Examples SENS:SA:BAND:RES MAX

Query Syntax SENSe<ch>:SA:BANDwidth:RESolution? MIN

Return Type Double

Default N/A

SENSe<ch>:SA:BANDwidth[:RESolution]:AUTO <bool>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read how the resolution bandwidth is set. When ON, the resolution bandwidth is

set based on Span/RBW ratio.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF - Res. BW is set manually using SENS:SA:BAND .

1 - ON - Res. BW is set automatically.

Learn about these settings.

Examples SENS:SA:BAND:AUTO 1

Query Syntax SENSe<ch>:SA:BANDwidth[:RESolution]:AUTO?

Return Type Boolean

Default 1

SENSe<ch>:SA:BANDwidth:SHAPe <enum>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the resolution bandwidth shape.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<enum> Choose from:

GAUSsian

FLATtop

KAISer

BLACkman

NONE

Learn about these settings.

Examples SENS:SA:BAND:SHAP GAUS
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Query Syntax SENSe<ch>:SA:BANDwidth:SHAPe?

Return Type Enumeration

Default GAUSsian

SENSe<ch>:SA:BANDwidth:VIDeo <enum>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the minimum and maximum video bandwidth.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<enum> Choose from:

MAX

MIN

Examples SENS:SA:BAND:VID MAX

Query Syntax SENSe<ch>:SA:BANDwidth:VIDeo? MIN

Return Type Double

Default N/A

SENSe<ch>:SA:BANDwidth:VIDeo <num>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the Video bandwidth. Also set SENS:SA:BAND:VID:AUTO OFF.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<num> Choose a value between 3 Hz and 3 MHz. Going outside this range places the

trace into a hold mode.

Learn about these settings.

Examples SENS:SA:BAND:VID 1e5

Query Syntax SENSe<ch>:SA:BANDwidth:VIDeo?

Return Type Numeric
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Default 300 kHz

SENSe<ch>:SA:BANDwidth:VIDeo:AUTO <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read how the video bandwidth is set. When ON, video bandwidth is set based

on RBW/VBW ratio.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF - Video BW is set manually using SENS:SA:BAND .

1 - ON - Video BW is set automatically.

Learn about these settings.

Examples SENS:SA:BAND:VID:AUTO 1

Query Syntax SENSe<ch>:SA:BANDwidth:VIDeo:AUTO?

Return Type Boolean

Default 1

SENSe<ch>:SA:BANDwidth:VIDeo:AVERage:COUNt?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Reads the number of Video bandwidth sweeps that are averaged together. This readout is

displayed on the SA setup page.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

Examples SENS:SA:BAND:VID:AVER:COUNt?

Query Syntax SENSe<ch>:SA:BANDwidth:VIDeo:AVER:COUNt?

Return Type Numeric

Default 1

1329



SENSe<ch>:SA:BANDwidth:VIDeo:AVER:TYPE <enum>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the averaging type.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<enum> Choose from:

VOLTage

POWer

LOG

VMAX (Voltage Max)

VMIN (Voltage Min)

Learn about these settings.

Examples SENS:SA:BAND:VID:AVER:TYPE VOLT

Query Syntax SENSe<ch>:SA:BANDwidth:VIDeo:AVER:TYPE?

Return Type Enumeration

Default POWer

SENSe<ch>:SA:BANDwidth:VIDeo:RATio <num>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the RBW / VBW ratio.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<num> RBW / VBW ratio.

Learn about these settings.

Examples SENS:SA:BAND:VID:RAT

Query Syntax SENSe<ch>:SA:BANDwidth:VIDeo:RATio?

Return Type Numeric
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Default 1.0

SENSe:SA:DETector:BYPass:[STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the ON/OFF state of the detector bypass setting.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF - Detector bypass OFF.

1 - ON - Detector bypass ON.

Learn about these settings.

Examples SENS:SA:DET:BYP 0

Query Syntax SENSe<ch>:SA:DETector:BYPass:[STATe]?

Return Type Boolean

Default 0

SENSe<ch>:SA:DETector:FUNCtion <enum>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the detector type.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<enum> Choose from:

PEAK

AVERage

SAMPle

NORMal

NEGPeak
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PSAMple (Peak Sample)

PAVerage (Peak Average)

L earn about these settings.

Examples SENS:SA:DET:FUNC AVER

Query Syntax SENSe<ch>:SA:DETector:FUNCtion?

Return Type Enumeration

Default PEAK

SENSe<ch>:SA:DFT:BANDwidth:AUTO <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the default values for DFT bandwidth.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF -DFT minimum and maximum values are set manually:

Narrow - 500 kHz to 11 MHz

Wide - 500 kHz to 44 MHz

1 - ON - DFT minimum and maximum values are set to their default values:

Narrow - 1 MHz to 10 MHz

Wide - 1 MHz to 34 MHz

Examples SENS:SA:DFT:BAND:AUTO 0

Query Syntax SENSe<ch>:SA:DFT:BANDwidth:AUTO?

Return Type Boolean

Default 1

SENSe<ch>:SA:DFT:BANDwidth:NARRow:MAX <num>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the maximum value for narrow DFT bandwidth. The maximum narrow

DFT bandwidth setting is 11 MHz. The SENSe:SA:DFT:BANDwidth:AUTO must be set to OFF to

set this value manually.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<num> Max narrow DFT bandwidth.

Examples SENS:SA:DFT:BAND:NARR:MAX 11e6

Query Syntax SENSe<ch>:SA:DFT:BANDwidth:NARRow:MAX?

Return Type Double

Default 10e6

SENSe<ch>:SA:DFT:BANDwidth:NARRow:MIN <num>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the minimum value for narrow DFT bandwidth. The minimum narrow

DFT bandwidth setting is 500 kHz. The SENSe:SA:DFT:BANDwidth:AUTO must be set to OFF to

set this value manually.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<num> Minimum narrow DFT bandwidth.

Examples SENS:SA:DFT:BAND:NARR:MIN 5e5

Query Syntax SENSe<ch>:SA:DFT:BANDwidth:NARRow:MIN?

Return Type Double

Default 1e6

SENSe<ch>:SA:DFT:BANDwidth:WIDE:MAX <num>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the maximum value for wide DFT bandwidth. The maximum wide DFT

bandwidth setting is 44 MHz. The SENSe:SA:DFT:BANDwidth:AUTO must be set to OFF to set this

value manually.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<num> Max wide DFT bandwidth.

Examples SENS:SA:DFT:BAND:WIDE:MAX 44e6

Query Syntax SENSe<ch>:SA:DFT:BANDwidth:WIDE:MAX?

Return Type Double

Default 34e6

SENSe<ch>:SA:DFT:BANDwidth:WIDE:MIN <num>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the minimum value for wide DFT bandwidth. The minimum wide DFT

bandwidth setting is 500 kHz. The SENSe:SA:DFT:BANDwidth:AUTO must be set to OFF to set

this value manually.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<num> Minimum wide DFT bandwidth.

Examples SENS:SA:DFT:BAND:WIDE:MIN 5e5

Query Syntax SENSe<ch>:SA:DFT:BANDwidth:WIDE:MIN?

Return Type Double

Default 1e6

SENSe<ch>:SA:DFT:RECord:SIZE?
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Applicable Models: N522xB, N523xB, N524xB

(Read-only) Read the current DFT record size. This value is based on the

SENSe:SA:ADC:RECord:SIZE:VALue and SENSe:SA:DFT:TYPE settings.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

Examples SENS:SA:DFT:REC:SIZE?

Return Type Integer

Default Not applicable

SENSe<ch>:SA:DFT:RESolution?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Read the DFT resolution.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

Examples SENS:SA:DFT:RES?

Default Not applicable

SENSe<ch>:SA:DFT:TYPE <enum>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and return the DFT record size type. The DFT SENSe:SA:DFT:RECord:SIZE is

based on the SENSe:SA:ADC:RECord:SIZE:VALue and the DFT record size type.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<enum> Choose from:

POW2 - Sets the DFT record size to the next power of 2 greater than or equal

to the current ADC record size.

RADix - Sets the DFT to the nearest equal or larger integer that can
be decomposed with 2, 3, 5, 7, 11 ,13 radixes.
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ARBitrary -  Sets DFT record size equal to the ADC record size. If the current
ADC record size is a large prime number, then the DFT can be very slow.

FASTest - Sets the DFT record size as close as possible to the ADC record

size (larger or equal) while optimizing processing speed.

Examples SENS:SA:DFT:TYPE ARB

Query Syntax SENSe<ch>:SA:DFT:TYPE?

Return Type Enumeration

Default FASTest

Note: In previous releases the default was POW2.

SENSe<ch>:SA:FFT:DITHer[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the ON/OFF state of the FFT grid dither setting

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF - Dither OFF.

1 - ON - Dither ON.

Examples SENS:SA:FFT:DITH ON

Query Syntax SENSe<ch>:SA:FFT:DITH?

Return Type Boolean

Default 0

SENSe<ch>:SA:FFT:RES?
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Applicable Models: N522xB, N523xB, N524xB

(Read-only) Read the FFT resolution.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

Examples SENS:SA:FFT:RES?

Default Not applicable

SENSe<ch>:SA:FREQuency:SPAN:BANDwidth[:RESolution]:RATio <value>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the Frequency Span / RBW ratio.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<value> Frequency Span / RBW ratio. Choose a value between 1 and 200e9.

Learn about these settings.

Examples SENS:SA:FREQ:SPAN:BAND:RAT 100

Query Syntax SENSe<ch>:SA:FREQuency:SPAN:BANDwidth[:RESolution]:RATio ?

Return Type Integer

Default 106

SENSe<ch>:SA:IMAGe:REJect <enum>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the image reject mode.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<enum> Choose from:

NHIGh

NLOW

MIN

NORMal

BETter

MAX

Learn about these settings.

Examples SENS:SA:IMAG:REJ NLOW

Query Syntax SENSe<ch>:SA:IMAGe:REJect?

Return Type Enumeration

Default NORMal

SENSe<ch>:SA:IMAGe:STRENgth <enum>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and returns the image rejection strength. During the image rejection process,

several LO acquisitions overlap at the same RF frequency. As a result, different RF signal values can

be returned. This command sets the acceptable power differences between LOs in determining actual

signals.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<enum> Choose from:

WEAK: 3 dB (approximate number, depends on RBW)

MEDium: 1 dB (approximate number, depends on RBW)

STROng: 0.5 dB (approximate number, depends on RBW)

Examples SENS:SA:IMAG:STREN STROng

Query Syntax SENSe<ch>:SA:IMAGe:STRENgth?

Return Type Enumeration

Default MEDium

SENSe<ch>:SA:LO:FREQ:FORCe <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read enable force LO to frequency mode.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF - Force LO to frequency is disabled.

1 - ON - Manually set LO to specified frequency using

SENSe:SA:LO:FREQ:VALue . Only applied if Image Reject is set to None,

LO High or None, LO Low.

Learn about these settings.

Examples SENS:SA:LO:FREQ:FORC 1
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Query Syntax SENSe<ch>:SA:LO:FREQ:FORC?

Return Type Boolean

Default 0

SENSe<ch>:SA:LO:FREQ:VALue <num>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read enable force LO to frequency.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<num> Frequency in Hz. Choose a value within the frequency range of the analyzer.

Learn about these settings.

Examples SENS:SA:LO:FREQ:VAL 1e9

Query Syntax SENSe<ch>:SA:LO:FREQ:VAL?

Return Type Numeric

Default 1 GHz

SENSe<ch>:SA:LO:COUNt?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the number of LO acquisitions determined by the Image Reject selection and the

span.

Parameters  

<ch> Channel number of the measurement. If unspecified,value is set to 1.

Examples SENS:SA:LO:COUN?

sense2:sa:lo:count?

Default Not applicable

SENSe<ch>:SA:LO:RANDom[:STATe] <bool>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the LO randomize state.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<char> Choose from:

0 - OFF - LO Randomize is set to OFF.

1 - ON - LO Randomize is set to ON.

Learn about these settings.

Examples SENS:SA:LO:RAND 1

Query Syntax SENSe<ch>:SA:LO:RANDom[:STATe]?

Return Type Boolean

Default 1

SENSe<ch>:SA:SOURce:DC:SWEep:FIRst[:DIMension] <enum>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the DC sweep order. The SA may be programmed to loop through a
series of spectrum measurements at multiple RF source frequencies, multiple RF source
powers, and multiple DC voltages.   These settings determine whether the DC sources are
swept before the RF power and frequencies are swept, or whether the DC sources are
swept after the RF power and frequencies are swept.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<enum> DC sweep order. Choose from:

DC - Sweep through each DC voltage step first then sweep through the next

frequency.

RF - Sweep through each frequency step first then sweep through the next DC
voltage.

Learn about these settings

Examples SENS:SA:SOUR:DC:SWE:FIR DC
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Query Syntax SENSe<ch>:SA:SOUR:DC:SWEep:FIRst?

Return Type Enumeration

Default DC

SENSe<ch>:SA:SOURce:DC:SWEep:POINt <value>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the number of steps the source will make across the specified source DC

range. This setting is common to all sources.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<value> Point count. Choose an integer value of 1 or higher.

Learn about these settings

Examples SENS:SA:SOUR:DC:SWE:POIN 100

Query Syntax SENSe<ch>:SA:SOUR:DC:SWEep:POINt?

Return Type Integer

Default 1

SENSe:SA:SOURce:DC:SWEep[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the ON/OFF state of the DC sources. If ON, the DC sources sweep

between their start and stop voltages. If OFF, the DC sources are set to their start voltages.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF - DC sweep OFF.

1 - ON - DC sweep ON.

Learn about these settings.

Examples SENS:SA:SOUR:DC:SWE 1
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Query Syntax SENSe<ch>:SA:SOURce:DC:SWEep[:STATe]?

Return Type Boolean

Default 0

SENSe<ch>:SA:SOURce<port>:FREQuency:CW <num>[,src]

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the source CW frequency.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<port> Source port number of the VNA. If unspecified, value is set to 1. To make

settings for ports that are not simple numbers, use the [src] argument.

<num> CW frequency in Hz. Choose a value within the frequency range of the

analyzer.

[,src] String . (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to

return a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source , or one of the Source 2 outputs on

the 2-port 2-source VNA-X model such as "Port 1 Src2". Otherwise, the <port>

argument performs the same function. If both arguments are specified, [src]

takes priority.

Examples SENS:SA:SOUR:FREQ:CW 1e10

sense2:sa:source:frequency:cw 1e9,"Port 1 Src2"

Query Syntax SENSe<ch>:SA:SOURce<port>:FREQuency:CW?

Return Type Numeric

Default Center frequency of the analyzer.

SENSe<ch>:SA:SOURce<port>:FREQuency:STARt <num>[,src]
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the source start frequency.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<port> Source port number of the VNA. If unspecified, value is set to 1. To make

settings for ports that are not simple numbers, use the [src] argument.

<num> Start frequency in Hz. Choose a value within the frequency range of the

analyzer.

[,src] String . (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to

return a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source , or one of the Source 2 outputs on

the 2-port 2-source VNA-X model such as "Port 1 Src2". Otherwise, the <port>

argument performs the same function. If both arguments are specified, [src]

takes priority.

Examples SENS:SA:SOUR:FREQ:STAR 1e9

sense2:sa:source:frequency:start 1e9,"Port 1 Src2"

Query Syntax SENSe<ch>:SA:SOURce<port>:FREQuency:STARt?

Return Type Numeric

Default Start frequency of the analyzer.

SENSe<ch>:SA:SOURce<port>:FREQuency:STOP <num>[,src]
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the source stop frequency.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<port> Source port number of the VNA. If unspecified, value is set to 1. To make

settings for ports that are not simple numbers, use the [src] argument.

<num> Stop frequency in Hz. Choose a value within the frequency range of the

analyzer.

[,src] String . (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to

return a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source , or one of the Source 2 outputs on

the 2-port 2-source VNA-X model such as "Port 1 Src2". Otherwise, the <port>

argument performs the same function. If both arguments are specified, [src]

takes priority.

Examples SENS:SA:SOUR:FREQ:STOP 1e10

sense2:sa:source:frequency:stop 1e9,"Port 1 Src2"

Query Syntax SENSe<ch>:SA:SOURce<port>:FREQuency:STOP?

Return Type Numeric

Default Stop frequency of the analyzer.

SENSe<ch>:SA:SOURce:POW:SWEep:POINt:COUNt <value>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the number of steps the source will make across the specified source power

range. This setting is common to all sources.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<value> Point count. Choose an integer value of 1 or higher.

Examples SENS:SA:SOUR:POW:SWE:POIN:COUN 100

Query Syntax SENSe<ch>:SA:SOUR:POW:SWEep:POINt:COUNt?

Return Type Integer

Default 1

SENSe<ch>:SA:SOURce:POW:SWEep:REPeat:COUNt <value>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the number of SA (receiver) sweeps for each Source Step. This setting is

common to all sources.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<value> Repeat count. Choose an integer value of 1 or higher.

Examples SENS:SA:SOUR:POW:SWE:REP:COUN 5

Query Syntax SENSe<ch>:SA:SOUR:POW:SWEep:REPeat:COUNt?

Return Type Integer

Default 1

SENSe<ch>:SA:SOURce<port>:POWer:STARt <dBm>[,src]
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the source start power level. This command applies to Power or LFPower

sweep types.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<port> Source port number of the VNA. If unspecified, value is set to 1. To make

settings for ports that are not simple numbers, use the [src] argument.

<dBm> Start power level in dBm. Choose a value within the power range of the source.

[,src] String . (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to

return a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source , or one of the Source 2 outputs on

the 2-port 2-source VNA-X model such as "Port 1 Src2". Otherwise, the <port>

argument performs the same function. If both arguments are specified, [src]

takes priority.

Examples SENS:SA:SOUR:POW:STAR 0

Query Syntax SENSe<ch>:SA:SOURce<port>:POWer:STARt?

Return Type Numeric

Default Default of source

SENSe<ch>:SA:SOURce<port>:POWer:STOP <dBm>[,src]

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the source stop power level. This command applies to Power or LFPower

sweep types.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<port> Source port number of the VNA. If unspecified, value is set to 1. To make
settings for ports that are not simple numbers, use the [src] argument.

<dBm> Stop power level in dBm. Choose a value within the power range of the source.

[,src] String . (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to

return a list of valid port names.
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While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source , or one of the Source 2 outputs on

the 2-port 2-source VNA-X model such as "Port 1 Src2". Otherwise, the <port>

argument performs the same function. If both arguments are specified, [src]

takes priority.

Examples SENS:SA:SOUR:POW:STOP -5

Query Syntax SENSe<ch>:SA:SOURce<port>:POWer:STOP?

Return Type Numeric

Default Default of source

SENSe<ch>:SA:SOURce<port>:POWer[:VALue] <dBm>[,src]

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the source output power level. This command applies to CW or LINear

sweep types.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<port> Source port number of the VNA. If unspecified, value is set to 1. To make

settings for ports that are not simple numbers, use the [src] argument.

<dBm> Source output power level in dBm. Choose a value within the power range of

the source.

[,src] String . (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to

return a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source , or one of the Source 2 outputs on
the 2-port 2-source VNA-X model such as "Port 1 Src2". Otherwise, the <port>

argument performs the same function. If both arguments are specified, [src]
takes priority.

Examples SENS:SA:SOUR:POW -5

Query Syntax SENSe<ch>:SA:SOURce<port>:POWer?

Return Type Numeric

Default Default of source
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SENSe<ch>:SA:SOURce:SWEep:FIRst[:DIMension] <enum>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the sweep order. This command applies whenever frequency and power are

being swept (LFPower sweep type). Otherwise, this setting is ignored. For example, if all the active

sources are set to CW and/or LINear sweep type, or if all the active sources are set to CW and/or

POWer sweep type, the sweep order is ignored. If any active source is set to LFPower sweep type, or

if an active source is set to LINear sweep type and another active source is set to POWer sweep type,

then the sweep order setting will be used.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<enum> Sweep order. Choose from:

FREQ - Sweep from Start to Stop frequency first followed by a power sweep.

POWer - Sweep power first then sweep from Start to Stop frequency.

Examples SENS:SA:SOUR:SWE:FIR POW

Query Syntax SENSe<ch>:SA:SOUR:SWEep:FIRst?

Return Type Enumeration

Default FREQ

SENSe<ch>:SA:SOURce<port>:SWEep:POINt:COUNt <value>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the number of steps the source will make across the specified source

frequency range.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<port> Source port number of the VNA. If unspecified, value is set to 1. To make

settings for ports that are not simple numbers, use the [src] argument.

<value> Point count. Choose a value between 1 and 2e9.

Examples SENS:SA:SOUR:SWE:POIN:COUN 100

Query Syntax SENSe<ch>:SA:SOUR:SWEep:POINt:COUNt?

Return Type Integer
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Default 1

SENSe<ch>:SA:SOURce<port>:SWEep:REPeat:COUNt <value>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the number of SA (receiver) sweeps for each Source Step. This setting is

common to all sources.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<port> Source port number of the VNA. If unspecified, value is set to 1. To make

settings for ports that are not simple numbers, use the [src] argument.

<value> Repeat count. Choose a value between 1 and 2e9.

Examples SENS:SA:SOUR:SWE:REP:COUN 5

Query Syntax SENSe<ch>:SA:SOUR:SWEep:REPeat:COUNt?

Return Type Integer

Default 1

SENSe<ch>:SA:SOURce<port>:SWEep:TYPE <enum>[,src]

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the source sweep type.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<port> Source port number of the VNA. If unspecified, value is set to 1. To make

settings for ports that are not simple numbers, use the [src] argument.

<enum> Sweep type. Choose from:

CW - SA source is at a single frequency, set with SENS:SA:SOUR:FREQ:CW

.

LINear - SA source sweeps from Start to Stop in linear steps.

POWer - SA source is set to a power sweep.

LFPower - SA source is set to sweep from the Start to Stop frequency and
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power sweep. The order is determined by the SENS:SA:SOUR:SWEep:FIRst

command.

[,src] String . (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to

return a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source , or one of the Source 2 outputs on

the 2-port 2-source VNA-X model such as "Port 1 Src2". Otherwise, the <port>

argument performs the same function. If both arguments are specified, [src]

takes priority.

Examples SENS:SA:SOUR:SWE:TYPE CW

sense2:sa:source:sweep:type linear,"Port 1 Src2"

Query Syntax SENSe<ch>:SA:SOURce<port>:SWEep:TYPE?

Return Type Enumeration

Default CW

SENSe<ch>:SA:SPAN:BINS:COUNt?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Read the current span DFT bin count.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

Examples SENS:SA:SPAN:BINS:COUN?

Return Type Integer

Default Not applicable

SENSe<ch>:SA:TRACe:IMAGe[:STATe] <bool>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the show / hide state of the image reject traces in the measurement

parameters dialog.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF -Disable image reject traces.

1 - ON - Enable image reject traces and set mode using SENS:SA:IMAG:REJ .

Learn about these settings.

Examples SENS:SA:TRAC:IMAG ON

Query Syntax SENSe<ch>:SA:TRACe:IMAGe[:STATe]?

Return Type Boolean

Default 0

SENSe:SA:TRIGer:LEVel[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the ON/OFF state of a measurement trigger event that will occur whenever

the ADC level is greater than the value specified using the SENSe:SA:TRIGer:LEVel:VALue

command.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF - ADC measurement trigger OFF.

1 - ON - ADC measurement trigger ON.

Learn about these settings.

Examples SENS:SA:TRIG:LEV 0

Query Syntax SENSe<ch>:SA:TRIGer:LEVel[:STATe]?

Return Type Boolean
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Default 0

SENSe<ch>:SA:TRIGer:LEVel:VALue <value>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the ADC trigger level.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<value> Choose a value between 0 and 16383.

Learn about these settings.

Examples SENS:SA:TRIG:LEV:VAL 10

Query Syntax SENSe<ch>:SA:TRIGer:LEVel:VALue?

Return Type Integer

Default 100

SENSe:SA:TRIGer:PERCounter[:STATe] <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the ON/OFF state of a measurement trigger event based on the specified

period set using the SENSe:SA:TRIGer:PERCounter:VALue command.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<bool> Choose from:

0 - OFF - Periodic counter OFF.

1 - ON - Periodic counter ON.

Learn about these settings.

Examples SENS:SA:TRIG:PERC 0

Query Syntax SENSe<ch>:SA:TRIGer:PERCounter[:STATe]?

Return Type Boolean

Default 0
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SENSe<ch>:SA:TRIGer:PERCounter:VALue <value>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and read the periodic counter value. This command initiates a measurement trigger

event based on the specified period.

Parameters  

<ch> Any existing SA channel. If unspecified, value is set to 1.

<value> Choose a value between 0 and 2147483647.

Learn about these settings.

Examples SENS:SA:TRIG:PERC:VAL 64

Query Syntax SENSe<ch>:SA:TRIGer:PERCounter:VALue?

Return Type Integer

Default 256
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Sense:Segment Commands

Defines the segment sweep settings.

Enable segment sweep with SENS:SWE:TYPE SEGMent.

SENSe:Segment

       | ADD

       | ARBitrary

       | BWIDth

             | PORT

                   | [:RESolution]

                           | CONTrol

             | [RESolution]

                   | CONTrol

       | COUNt

       | DELete

             | ALL

       | FREQuency

             | CENTer

             | SPAN

             | STARt

             | STOP

       | LIST

       | POWer

           | ATTenuation

                 | RECeiver

                      | CONTrol

                      | REFerence

                      | TEST
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             | [LEVel]

                   | CONTrol

      | SHLO

      | CONTrol

       | [STATe]

       | SWEep

             | DELay

                   | CONTrol

             | DWELl

                   | CONTrol

             | GENeration

                   | CONTrol

             | POINts

                   | TOTal?

             | TIME

                   | CONTrol

                   | TOTal?

       | X

             | SPACing

Click on a keyword to view the command details.

S ee Also

Example: Upload and Download a Segment List

Learn about Segment Sweep

Synchronizing the Analyzer and Controller

SCPI Command Tree

SENSe<cnum>:SEGMent<snum>:ADD
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Applicable Models: All

(Write-only) Adds a segment.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Segment number to add. If unspecified, value is set to 1 . Segment numbers

must be sequential. If a new number is added where one currently exists, the

existing segment and those following are incremented by one.

Examples Two Segments exist (1 and 2). The following command will add a new segment (1). The
existing (1 and 2) will become (2 and 3) respectively .

SENS:SEGM1:ADD
sense2:segment1:add

Query Syntax Not applicable. Use Sense:Segment:Count to determine the number of segments in a
trace.

Default Not Applicable

SENSe<cnum>:SEGMent:ARBitrary <ON | OFF>

Applicable Models: All

(Read-Write) Enables you to setup a segment sweep with arbitrary frequencies. The start and stop

frequencies of each segment can overlap other segments. Also, each segment can have a start

frequency that is greater than its stop frequency which causes a reverse sweep over that segment.

Learn more about Arbitrary Segment Sweep .

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<ON | OFF> ON (or 1) - Allows the setup of arbitrary segment sweep.

OFF (or 0) - Prevents the setup of arbitrary segment sweep.

Examples SENS:SEGM:ARB ON
sense2:segment:arbitrary off

Query Syntax SENSe<cnum>:SEGMent:ARBitrary?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

SENSe<cnum>:SEGMent<snum>:BWIDth:PORT<pnum>[:RESolution] <num>
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Applicable Models: All

(Read-Write) Specifies whether the IF Bandwidth resolution can be set independently for each

segment for the selected port and channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Segment number to modify. Choose any existing segment number.

<pnum> Individual port number of the source: Port 1 to Port 2/Port 4. If unspecified, value is

set to 1.

<num> IF Bandwidth of each segment in Hz. The list of valid IF Bandwidths is different

depending on the VNA model. (Click to see the lists.) If an invalid number is

specified, the analyzer will round up to the closest valid number.

Note : This command will accept MIN or MAX instead of a numeric parameter. See

SCPI Syntax for more information.

Examples SENS:SEGM:BWID:PORT1 1KHZ

sense2:segment2:bandwidth:PORT2:resolution max

Query

Syntax

SENSe<cnum>:SEGMent<snum>:BWIDth \
BANDwidth:PORT<pnum>[:RESolution]?

Return

Type

Numeric

Default Varies with VNA model.

SENSe<cnum>:SEGMent:BANDwidth | BWIDth:PORT<pnum>[:RESolution]:CONTrol <bool>
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Applicable Models: All

(Read-Write) Turns ON or OFF the individual (Port 1 to Port 2/Port 4) IF Bandwidth control in the

segment sweep table.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<pnum> Individual port number of the source: Port 1 to Port 2/Port 4. If unspecified, value is

set to 1.

<bool> Specified the individual IFBW control, either ON or OFF.

ON or 1 - Turns ON the individual port IFBW control.

OFF or 0 - Turns OFF the individual port IFBW control.

Examples SENS:SEGM:BWID:PORT1:CONT ON

sense2:segment2:bandwidth:PORT2:resolution:control off

Query

Syntax

SENSe<cnum>:SEGMent<snum>:BWIDth |
BANDwidth:PORT<pnum>[:RESolution]:CONTrol?

Return Type Boolean

Default OFF or 0

SENSe<cnum>:SEGMent<snum>:BWIDth[:RESolution] <num>

Applicable Models: All

(Read-Write) Sets the IF Bandwidth for the specified segment. First set

SENS:SEGM:BWIDth:CONTrol ON. All subsequent segments that are added assume the new IF

Bandwidth value.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Segment number to modify. Choose any existing segment number.

<num> IF Bandwidth in Hz. The list of valid IF Bandwidths is different depending on

the VNA model. (Click to see the lists.) If an invalid number is specified, the
analyzer will round up to the closest valid number.

Note : This command will accept MIN or MAX instead of a numeric parameter.

See SCPI Syntax for more information.
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Examples SENS:SEGM:BWID 1KHZ

sense2:segment2:bwidth:resolution max

Query Syntax SENSe<cnum>:SEGMent<snum>:BWIDth[:RESolution]?

Return Type Numeric

Default Varies with VNA model.

SENSe<cnum>:SEGMent:BWIDth[:RESolution]:CONTrol <ON | OFF>

Applicable Models: All

(Read-Write) Specifies whether the IF Bandwidth resolution can be set independently for each

segment.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<ON | OFF> ON (or 1) - turns Bandwidth control ON. Bandwidth can be independently set

for each segment.

OFF (or 0) - turns Bandwidth control OFF. Use the channel IF bandwidth

setting SENS:BWID .

Examples SENS:SEGM:BWID:CONT ON

sense2:segment:bwidth:control off

Query Syntax SENSe<cnum>:SEGMent:BWIDth[:RESolution]:CONTrol?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

SENSe<cnum>:SEGMent:COUNt?
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Applicable Models: All

(Read-only) Queries the number of segments that exist in the specified channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

Examples SENS:SEGM:COUNt?
sense2:segment:count?

Return Type Numeric

Default 1 segment

SENSe<cnum>:SEGMent<snum>:DELete

Applicable Models: All

(Write-only) Deletes the specified sweep segment. When ALL segments are deleted,

SENS:SWE:TYPE is automatically set to Linear because there are no segments to sweep.

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Number of the segment to delete. If unspecified, value is set to 1

Examples SENS:SEGM:DEL
sense2:segment2:delete

Query Syntax Not applicable

Default Not Applicable

SENSe<cnum>:SEGMent:DELete:ALL

Applicable Models: All

(Write-only) Deletes all sweep segments. When this command is executed, SENS:SWE:TYPE is

automatically set to Linear because there are no segments to sweep.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

Examples SENS:SEGM:DEL:ALL
sense2:segment:delete:all

Query Syntax Not applicable

Default Not Applicable
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SENSe<cnum>:SEGMent<snum>:FREQuency:CENTer <num>

Applicable Models: All

(Read-Write) Sets the Center Frequency for the specified segment. The Frequency Span of the

segment remains the same. The Start and Stop Frequencies change accordingly.

Note : All previous segment's Start and Stop Frequencies that are larger than the new Start Frequency

are changed to the new Start Frequency. All following segment's start and stop frequencies that are

smaller than the new Stop Frequency are changed to the new Stop Frequency.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Segment number to modify. Choose any existing segment number.

<num> Center Frequency in Hz. Choose any number between the minimum and

maximum frequency of the analyzer.

Note : This command will accept MIN or MAX instead of a numeric parameter.

See SCPI Syntax for more information.

Examples SENS:SEGM:FREQ:CENT 1MHZ
sense2:segment2:frequency:center 1e9

Query Syntax SENSe<cnum>:SEGMent<snum>:FREQuency:CENTer?

Return Type Numeric

Default Stop Frequency of the previous segment. If first segment, start frequency of the

analyzer.

SENSe<cnum>:SEGMent<snum>:FREQuency:SPAN <num>
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Applicable Models: All

(Read-Write) Sets the Frequency Span for the specified segment. The center frequency of the segment

remains the same. The start and stop frequencies change accordingly.

Note: All previous segment's Start and Stop Frequencies that are larger than the new Start Frequency

are changed to the new Start Frequency. All following segment's start and stop frequencies that are

smaller than the new Stop Frequency are changed to the new Stop Frequency.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Segment number to modify. Choose any existing segment number.

<num> Frequency Span in Hz. Choose any number between the minimum and

maximum frequency of the analyzer.

Note : This command will accept MIN or MAX instead of a numeric parameter.

See SCPI Syntax for more information.

Examples SENS:SEGM:FREQ:SPAN 1MHZ
sense2:segment2:frequency:span max

Query Syntax SENSe<cnum>:SEGMent<snum>:FREQuency:SPAN?

Return Type Numeric

Default If first segment, frequency span of the analyzer. Otherwise 0.

SENSe<cnum>:SEGMent<snum>:FREQuency:START <num>

Applicable Models: All

(Read-Write) Sets the Start Frequency for the specified sweep segment.

Notes

All other segment Start and Stop Frequency values that are larger than this frequency are changed to
this frequency.

To return the start and stop frequency of the entire sweep (all segments), Use SENS:FREQ:STARt?

and SENS:FREQ:STOP?

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Segment number to modify. Choose any existing segment number.
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<num> Start Frequency in Hz. Choose any number between the minimum and

maximum frequency of the analyzer.

Note : This command will accept MIN or MAX instead of a numeric parameter.

See SCPI Syntax for more information.

Examples SENS:SEGM:FREQ:STAR 1MHZ
sense2:segment2:frequency:start minimum

Query Syntax SENSe<cnum>:SEGMent<snum>:FREQuency:STARt?

Return Type Numeric

Default Stop Frequency of the previous segment. If first segment, start frequency of the

analyzer.

SENSe<cnum>:SEGMent<snum>:FREQuency:STOP <num>

Applicable Models: All

(Read-Write) Sets the Stop Frequency for the specified sweep segment.

Notes

All other segment Start and Stop Frequency values that are larger than this frequency are changed to

this frequency.

To return the start and stop frequency of the entire sweep (all segments), Use SENS:FREQ:STARt?

and SENS:FREQ:STOP?

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Segment number to modify. Choose any existing segment number.

<num> Stop Frequency in Hz. Choose any number between the minimum and
maximum frequency of the analyzer.

Note : This command will accept MIN or MAX instead of a numeric parameter.

See SCPI Syntax for more information.

Examples SENS:SEGM:FREQ:STOP 1MHZ
sense2:segment2:frequency:stop maximum

Query Syntax SENSe<cnum>:SEGMent<snum>:FREQuency:STOP?

Return Type Numeric

Default If first segment, stop frequency of the analyzer. Otherwise, start frequency of the
segment.
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SENSe<cnum>:SEGMent:LIST <char>,<numSegs>,<data>

Applicable Models: All

(Read-Write) Reads or writes the entire list of values in the segment sweep table.   

Note: For binary data transfer, specify 64-bit instead of 32-bit using FORMat[:DATA] .  This is

because higher frequencies used on VNA exceed the maximum value that can be represented by a 32-

bit floating point number.

When sending/receiving this data as binary (FORMat[:DATA] REAL,64), use FORMat:BORDer to

specify the correct 'endianness' (byte ordering) corresponding to your programming environment /

computer platform.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<char> Choose from:

SSTOP -  Frequency values are Start and Stop for each segment.  

CSPAN -  Frequency values are Center and Span for each segment.

<numSegs> Total number of sweep segments being input.  This allows the VNA to

determine how many values per-each-segment are in the input <data> block.

<data> A list of segments specified using either a comma-separated string of data, or an array
of double (real,64) depending on the state of FORM:DATA. Each segment is specified
with a minimum of 4 and maximum of 7 values consecutively.   The set of values that

specify each segment should be in the following order :

Segment state (Boolean 1 for ON and 0 for OFF)1.

Number of Points in the segment2.

Start Freq (when <char> is SSTOP), or Center Freq (when <char> is CSPAN)3.

Stop Freq (when <char> is SSTOP), or Freq Span (when <char> is CSPAN)4.

IFBW (optional for the Write)5.

Dwell Time (optional for the Write)6.

Power (optional for the Write) - see below.7.

The first four data elements must always be supplied. After those values, data

must be supplied for successive optional elements. For example, to set dwell
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time values, you must also supply IFBW values, because IFBW (#5) precedes

dwell time (#6) in the array order.

The IF Bandwidth , Sweep Time and Source Power Control settings do NOT

affect the order in which elements are interpreted.

The number of elements to supply for Power depends on the following two

settings:

Source Power Option - ON allows segments to have independent power levels.1.

Couple Ports = Off allows different power levels for each test port.2.

CouplePorts SourcePowerOption Number of Elements

False False Each port has its own channel-

wide power setting, which is set

using SOURce:POWer[:LEVel] .

Provide exactly 7 elements per

segment. The last element (power)

is ignored.

False True Provide 6 elements + total number

of ports.  The first 7 elements are

still interpreted the same.

The remaining elements (in-order)

are interpreted as the power levels

to set on that segment for Ports 2

through N, where N is the total

number of ports currently enabled

for the VNA or for a VNA with

multiport external test set.

True False Provide exactly 7 elements per

segment. The last element (power)

is ignored.

True True Provide exactly 7 elements per

segment. The last element (power)

is honored.

 

Examples SENS:SEGM:LIST SSTOP,1,1,201,10E6,26.5E9,1E3,0,-10 1 segment,
state ON, 201 points, 10 MHz to 26.5 GHz, 1kHz IFBW, 0 dwell
time, -10 dBm (port powers coupled)
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sense2:segment:list? cspan

See Upload and Download a Segment List  example program

Query Syntax SENSe<cnum>:SEGMent:LIST? [char].

If unspecified, char is set to SSTOP.

The number of data elements per segment returned will be 6 + total number of

source ports, regardless of the IF Bandwidth , Sweep Time and Source Power

Control settings.  For the N5264B, which has no source ports, the query will

return just 6 values per segment. For all other VNA models, the last elements

in each segment correspond to the power level for each port.

Return Type Returns block data in the format specified by FORMat[:DATA] .

Default Not Applicable

SENSe<cnum>:SEGMent:POWer:ATTenuation:RECeiver:CONTrol <bool>

Applicable Models: N522xB, N523xB, N524xB, M9485A

(Read-Write) Turns ON or OFF the individual receiver attenuator control in the segment sweep table.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<bool> ON or 1 - Turns ON the individual receiver attenuator control.

OFF or 0 - Turns OFF the individual receiver attenuator control

Examples SENS:SEGM:POW:ATT:REC:REC:CONT ON

sense:segment:power:attenuation:receiver:control 1

Query Syntax SENSe<cnum>:SEGMent:POWer:ATTenuation:RECeiver:CONTrol?

Return Type Boolean. If querying for the standard (M9376A) port, the return value is 0

Default OFF or 0

SENSe<cnum>:SEGMent<snum>:POWer<port>:ATTenuation:RECeiver:REFerence <num>

Applicable Models: N522xB, N523xB, N524xB, M9485A
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(Read-Write) Sets the attenuation level for the specified reference attenuator for each segment.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<snum> Segment number to modify. Choose any existing segment number. If unspecified, value is set to

1.

<port> Port number of the VNA. If unspecified, value is set to 1.

<num> Attenuation value in dB. 0dB or 35dB.

If a number other than these is entered, the analyzer will select the next lower valid value. For

example, if 19dB is entered, then 0dB attenuation will be selected.

Examples SENS:SEGM:POW2:ATT:REC:REF 0

sense:segment:power:attenuation:receiver:reference 35

Query

Syntax

SENSe<cnum>:SEGMent<snum>:POWer<port>:ATTenuattion:RECeiver:REFerence?

Return

Type

Numeric. If querying for the standard (M9376A) port, the return value is 0

Default 35

SENSe<cnum>:SEGMent<snum>:POWer<port>:ATTenuation:RECeiver:TEST <num>

Applicable Models: N522xB, N523xB, N524xB, M9485A

(Read-Write) Sets the attenuation level for the specified test attenuator for each segment.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<snum> Segment number to modify. Choose any existing segment number. If unspecified, value

is set to 1.

<port> Port number of the VNA. If unspecified, value is set to 1.

<num> Attenuation value in dB. 0dB or 35dB.

If a number other than these is entered, the analyzer will select the next lower valid
value. For example, if 19dB is entered, then 0dB attenuation will be selected.

Examples SENS:SEGM:POW2:ATT:REC:TEST 0

sense:segment:power:attenuation:receiver:test 35
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Query

Syntax

SENSe<cnum>:SEGMent<snum>:POWer<port>:ATTenuation:RECeiver:TEST?

Return

Type

Numeric. If querying for the standard (M9376A) port, the return value is 0

Default 35

SENSe<cnum>:SEGMent<snum>:POWer[<port>][:LEVel] <num>

Applicable Models: All

(Read-Write) Sets the Port Power level for the specified sweep segment. First set

SENS:SEGM:POW:CONTrol ON.

W hen port power is Coupled , setting port power for one port will apply port power for all source

ports.

All subsequent segments that are added assume the new Power Level value.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Segment number to modify. Choose any existing segment number.

<port> Port number of the source. If unspecified, value is set to 1.

<num> Power level.

Note: The range of settable power values depends on the VNA model and if

source attenuators are installed. To determine the range of values, send

SOUR:POW? MAX and SOUR:POW? MIN. (SOUR:POW:ATT:AUTO must

be set to ON).

Actual achievable leveled power depends on frequency.

Examples SENS:SEGM:POW 0
sense2:segment2:power1:level -10

Query Syntax SENSe<cnum>:SEGMent<snum>:POWer[<port>][:LEVel]?

Return Type Numeric

Default 0

SENSe<cnum>:SEGMent:POWer[:LEVel]:CONTrol <ON | OFF>
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Applicable Models: All

(Read-Write) Specifies whether Power Level can be set independently for each segment.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<ON | OFF> ON (or 1) - turns Power Level control ON. Power level can be set for each

segment.

OFF (or 0) - turns Power Level control OFF. Use the channel power level

setting.

Examples SENS:SEGM:POW:CONT ON
sense2:segment:power:level:control off

Query Syntax SENSe<cnum>:SEGMent:POWer[:LEVel]:CONTrol?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

SENSe<cnum>:SEGMent<snum>[:STATe] <ON | OFF>

Applicable Models: All

(Read-Write) Turns the specified sweep segment ON or OFF. At least ONE segment must be ON or

Sweep Mode is automatically set to Linear .

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Segment number to be turned ON or OFF

<ON | OFF> ON (or 1) - turns segment ON.

OFF (or 0) - turns segment OFF.

Examples SENS:SEGM ON
sense2:segment2:state off

Query Syntax SENSe<cnum>:SEGMent<snum>[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

SENSe<cnum>:SEGMent<snum>:SHLO

Applicable Models: N522xB, N523xB, N524xB, E5080A
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(Read-Write) Sets or returns the Shift LO state of each segment in the segment sweep table for the

selected channel.

Notes: The SENS:SEGM:SHLO:CONT command must first be set to ON before using this

command.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Any existing segment number.

Examples SENS:SEGM:SHLO
sense2:segment2:shlo

Query Syntax SENSe<cnum>:SEGMent<snum>:SHLO?

Return Type Numeric

Default Not Applicable

SENSe<cnum>:SEGMent<snum>:SHLO:CONTrol <bool>

Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Write) Turns ON or OFF the individual Shift LO state control in the segment sweep table.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Any existing segment number.

<bool> ON or 1 - Turns ON the individual Shift LO state control.

OFF or 0 - Turns OFF the individual Shift LO state control.

Examples SENS:SEGM:SHLO:CONT ON
sense2:segment2:shlo:control off

Query Syntax SENSe<cnum>:SEGMent<snum>:SHLO:CONTrol?

Return Type Boolean

Default OFF or 0

SENSe<cnum>:SEGMent<snum>:SWEep:DELay <num>

1371



Applicable Models: All

(Read-Write) Sets or returns the sweep delay time of the specified sweep segment.

Notes: The SENS:SEGM:SWE:DEL:CONT command must first be set to ON before using this

command.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Any existing segment number.

<num> Range of sweep delay time is between 0 to 1 and the resolution is 0.001.

Notes: If the specified variable is out of the allowable setup range, the minimum value

(if the lower limit of the range is not reached) or the maximum value (if the upper limit

of the range is exceeded) is set.

<unit> s (second)

Examples SENS:SEGM:SWE:DEL
sense2:segment2:sweep:delay

Query

Syntax

SENSe<cnum>:SEGMent<snum>:SWEep:DELay?

Return

Type

Numeric / Double precision floating point

Default 0

SENSe<cnum>:SEGMent<snum>:SWEep:DELay:CONTrol <bool>

Applicable Models: All

(Read-Write) Turns ON or OFF the sweep delay time of the specified sweep segment.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Any existing segment number.

<bool> ON or 1 - Turns ON sweep delay time.

OFF or 0 - Turns OFF sweep delay time.

Examples SENS:SEGM:SWE:DEL:CONT ON
sense2:segment2:sweep:delay:control off

Query Syntax SENSe<cnum>:SEGMent<snum>:SWEep:DELay:CONTrol?
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Return Type Boolean

Default OFF or 0

SENSe<cnum>:SEGMent<snum>:SWEep:DWELl <num>

Applicable Models: All

(Read-Write) Sets or returns the sweep dwell time of the specified sweep segment.

Notes: The SENS:SEGM:SWE:DWELl:CONT command must first be set to ON before using this

command.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Any existing segment number.

<num> Range of sweep dwell time

Notes: If the specified variable is out of the allowable setup range, the minimum value

(if the lower limit of the range is not reached) or the maximum value (if the upper limit

of the range is exceeded) is set.

<unit> s (second)

Examples SENS:SEGM:SWE:DWEL
sense2:segment2:sweep:dwell

Query

Syntax

SENSe<cnum>:SEGMent<snum>:SWEep:DWELl?

Return

Type

Numeric / Double precision floating point

Default 0

SENSe<cnum>:SEGMent<snum>:SWEep:DWELl:CONTrol <bool>
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Applicable Models: All

(Read-Write) Turns ON or OFF the sweep dwell time of the specified sweep segment.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Any existing segment number.

<bool> ON or 1 - Turns ON sweep dwell time.

OFF or 0 - Turns OFF sweep dwell time.

Examples SENS:SEGM:SWE:DWEL:CONT ON
sense2:segment2:sweep:dwell:control off

Query Syntax SENSe<cnum>:SEGMent<snum>:SWEep:DWELl:CONTrol?

Return Type Boolean

Default OFF or 0

SENSe<cnum>:SEGMent<snum>:SWEep:GENeration <char>

Applicable Models: All

(Read-Write) Sets or returns the sweep mode of the specified sweep segment.

Notes: The SENS:SEGM:SWE:GEN:CONT command must first be set to ON before using this

command.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<snum> Any existing segment number.

<char> Select sweep mode from either of the following:

"AUTO": Sets the sweep mode to the swept mode.

"STEPped": Sets the sweep mode to the stepped mode.

Examples SENS:SEGM:SWE:GEN AUTO
sense2:segment2:sweep:generation stepped

Query Syntax SENSe<cnum>:SEGMent<snum>:SWEep:GENeration?

Return Type Character

Default "AUTO"
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SENSe<cnum>:SEGMent<snum>:SWEep:GENeration:CONTrol <bool>

Applicable Models: All

(Read-Write) Turns ON or OFF the sweep mode of the specified sweep segment.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<snum> Any existing segment number.

<bool> ON or 1 - Turn ON sweep mode.

OFF or 0 - Turn OFF sweep mode.

Examples SENS:SEGM:SWE:GEN:CONT ON
sense2:segment2:sweep:generation:control off

Query Syntax SENSe<cnum>:SEGMent<snum>:SWEep:GENeration:CONTrol?

Return Type Boolean

Default OFF or 0

SENSe<cnum>:SEGMent<snum>:SWEep:POINts <num>

Applicable Models: All

(Read-Write) Sets the number of data points for the specified sweep segment.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Any existing segment number. If unspecified, value is set to 1

<num> Number of points in the segment. The total number of points in all segments

cannot exceed 20001. A segment can have as few as 1 point.

Note : This command will accept MIN or MAX instead of a numeric parameter.

See SCPI Syntax for more information.

Examples SENS:SEGM:SWE:POIN 51
sense2:segment2:sweep:points maximum

Query Syntax SENSe<cnum>:SEGMent<snum>:S WEep:POINts ?

Return Type Numeric

Default 21

SENSe<cnum>:SEGMent<snum>:SWEep:POINts:TOTal? <totalPoints>
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Applicable Models: All

(Read-only) Queries the total point count from the active segments or from all segments.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Any existing segment number.

<totalPoints> Choose from:

ACTive - Returns the total point count of the active segments.

ALL - Returns the total point count of all segments.

Examples SENS:SEGM:SWE:POIN:TOT? ACT
sense2:segment:sweep:points:total? all

Return Type Numeric

Default 21

SENSe<cnum>:SEGMent<snum>:SWEep:TIME <num>

Applicable Models: All

(Read-Write) Sets the time the analyzer takes to sweep the specified sweep segment.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Any existing segment number.

<num> Sweep time in seconds. Choose a number between 0 and 100

Note : This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

Examples SENS:SEGM:SWE:TIME 1ms
sense2:segment2:sweep:time .001

Query Syntax SENSe<cnum>:SEGMent<snum>:S WEep:TIME?

Return Type Numeric

Default Not Applicable

SENSe<cnum>:SEGMent:SWEep:TIME:CONTrol <ON | OFF>
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Applicable Models: All

(Read-Write) Specifies whether Sweep Time can be set independently for each sweep segment.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<ON | OFF> ON (or 1) - turns Sweep Time control ON. Sweep Time can be set for each

segment.

OFF (or 0) - turns Sweep Time control OFF. Uses the channel Sweep Time

setting.

Examples SENS:SEGM:SWE:TIME:CONT ON
sense2:segment:sweep:time:control off

Query Syntax SENSe<cnum>:SEGMent:SWEep:TIME:CONTrol?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

SENSe<cnum>:SEGMent<snum>:SWEep:TIME:TOTal? <totalTime>

Applicable Models: All

(Read-only) Queries the total sweep time of the active segments or of all segments.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<snum> Any existing segment number.

<totalTime> Choose from:

ACTive - Returns the total sweep time of the active segments.

ALL - Returns the total sweep time of all segments.

Examples SENS:SEGM:SWE:TIME:TOT? ACT
sense2:segment:sweep:time:total? all

Return Type Numeric

Default 0

SENSe<cnum>:SEGMent:X:SPACing <char>
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Applicable Models: All

(Read-Write)  Sets X-axis spacing ON or OFF

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<char> LINear - turns X-axis point spacing OFF

OBASe - turns X-axis point spacing ON

Examples SENS:SEGM:X:SPACing LIN
sense2:segment:spacing obase

Query Syntax SENSe<cnum>:SEGMent:X:SPACing?

Return Type Character

Default LINear

 

1378



Sense:Sweep Commands

Specifies the sweep functions of the analyzer.

SENSe:SWEep:

BLOCked

DWELl

       | AUTO

       | SDELay

GENeration

       | POINtsweep

GROups

       | COUNt

MODE

POINts

PULSe More commands

SLOCal

       | MAXimum

       | STATe

SPEed

SRCPort

STEP

TIME

       | AUTO

TRIGger

       | DELAY

       | MODE

       | POINt

TYPE
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       | FACW

Click on a keyword to view the command details.

See Also

Example Programs

Example  Triggering the VNA using SCPI

Learn about Sweeping

Synchronizing the Analyzer and Controller

SCPI Command Tree

SENSe<cnum>:SWEep:BLOCked?

Applicable Models: N522xB, N523xB, N524xB, M937xA, M9485A

(Read-only) Reads whether the specified channel is currently 'blocked' from sweeping. Learn more

about the Mechanical Devices dialog.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

Examples SENS:SWE:BLOC?

sense2:sweep:blocked?

Return Type Boolean

0 - No, the channel is NOT blocked.

1 - Yes, the channel is blocked.

Default N/A

SENSe<cnum>:SWEep:DWELl <num>
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Applicable Models: All

(Read-Write) Sets the dwell time between each sweep point.

Dwell time is ONLY available with SENSe:SWEep:GENeration set to STEPped; It is Not available in
ANALOG.

Sending dwell = 0 is the same as setting SENS:SWE:DWEL:AUTO ON. Sending a dwell time > 0 sets
SENS:SWE:DWEL:AUTO OFF.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Dwell time in seconds.

This command will accept MIN or MAX instead of a numeric parameter. See

SCPI Syntax for more information.

Examples SENS:SWE:DWEL .1
sense2:sweep:dwell min

Query Syntax SENSe<cnum>:SWEep:DWELl?

Return Type Numeric

Default 0 - (Note: dwell time set to 0 is the same as dwell:auto ON)

SENSe<cnum>:SWEep:DWELl:AUTO <ON | OFF>

Applicable Models: All

(Read-Write) Specifies whether or not to automatically calculate and set the minimum possible dwell

time. Setting Auto ON has the same effect as setting dwell time to 0.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<ON | OFF> ON (or 1) - turns dwell ON.

OFF (or 0) - turns dwell OFF.

Examples SENS:SWE:DWEL:AUTO ON
sense2:sweep:dwell:auto off

Query Syntax SENSe<cnum>:SWEep:DWELl:AUTO?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON
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SENSe<cnum>:SWEep:DWELl:SDELay <num>

Applicable Models: All

(Read-Write) Specifies the time to wait just before acquisition begins for each sweep. This delay is in

addition to Dwell Time and the following two External Trigger delays if enabled.

Trig:Delay (global scope)

Sens:Swe:Trig:Delay  (channel scope)

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Sweep delay in seconds.

This command will accept MIN or MAX instead of a numeric parameter. See

SCPI Syntax for more information.

Examples SENS:SWE:DWEL:SDEL .1
sense2:sweep:dwell:sdelay .5

Query Syntax SENSe<cnum>:SWEep:DWELl:SDELay?

Return Type Numeric

Default 0

SENSe<cnum>:SWEep:GENeration <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets sweep as Stepped or Analog.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<char> Choose from:

STEPped - source frequency is CONSTANT during measurement of eah

displayed point. More accurate than ANALog. Dwell time can be set in this

mode.

ANALog - source frequency is continuously RAMPING during measurement

of each displayed point. Faster than STEPped. Sweep time (not dwell time) can
be set in this mode.
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Examples SENS:SWE:GEN STEP
sense2:sweep:generation analog

Query Syntax SENSe<cnum>:SWEep:GENeration?

Return Type Character

Default Analog

SENSe<cnum>:SWEep:GENeration:POINtsweep <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns ON and OFF point sweep mode. When enabled, the VNA measures both the

forward and reverse parameters at each frequency point before stepping to the next frequency. Learn
more.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<char> Choose from:

ON or (1) - Enable point sweep mode.

OFF or (0) - Disable point sweep mode.

Examples SENS:SWE:GEN:POIN 1

sense2:sweep:generation:pointsweep off

Query Syntax SENSe<cnum>:SWEep:GENeration:POINtsweep?

Return Type Boolean

Default OFF

SENSe<cnum>:SWEep:GROups:COUNt <num>
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Applicable Models: All

(Read-Write) Sets the trigger count (groups) for the specified channel. Set trigger mode to group after

setting this count.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Count (groups) number. Choose any number between:

1 and 2e6 (1 is the same as single trigger)

Examples SENS:SWE:GRO:COUN 10
sense2:sweep:groups:count 50

Query Syntax SENSe<cnum>:SWEep:GROups:COUNt?

Return Type Numeric

Default 1

SENSe<cnum>:SWEep:MODE <char>

Applicable Models: All

(Read-Write) Sets the number of trigger signals the specified channel will ACCEPT.

See Triggering the VNA Using SCPI.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<char> Trigger mode. Choose from:

HOLD - channel will not trigger

CONTinuous - channel triggers indefinitely

GROups - channel accepts the number of triggers specified with the last

SENS:SWE:GRO:COUN <num>. This is one of the VNA overlapped commands.
Learn more.

SINGle - channel accepts ONE trigger, then goes to HOLD.

Note: To perform simple, single-triggering, use SINGle which requires that

TRIG:SOURce remain in the default (internal) setting.

Examples SENS:SWE:MODE CONT
sense2:sweep:mode hold
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Query Syntax SENSe<cnum>:SWEep:MODE?

Return Type Character

Default CONTinuous

SENSe<cnum>:SWEep:POINts <num>

Applicable Models: All

(Read-Write) Sets the number of data points for the measurement.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Choose any number between 1 and the VNA maximum number of points.

This command will accept MIN or MAX instead of a numeric parameter. See

SCPI Syntax for more information.

Examples SENS:SWE:POIN 51
sense2:sweep:points max

Query Syntax SENSe<cnum>:SWEep:POINts?

Return Type Numeric

Default 201

SENSe<cnum>:SWEep:SLOCal:MAXimum <num>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) Sets the Shift LO maximum frequency for the selected channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Range of shift LO maximum frequency is 1.5E8 to Maximum frequency.

Examples SENS:SWE:SCLOC:MAX 1.5E8
sense2:sweep:slocal:maximum 1.5E8

Query Syntax SENSe<cnum>:SWEep:SLOCal:MAXimum?

Return Type Numeric / Double precision floating point

Default Maximum frequency
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SENSe<cnum>:SWEep:SLOCal:STATe <bool>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) Turns ON or OFF the Shift LO mode for the selected channel.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<bool> Select shoft LO mode from either of the following:

ON or 1 - Turns ON the Shift LO mode.

OFF or 0 - Turns OFF the Shift LO mode.

Examples SENS:SWE:SLOC:STAT ON
sense2:sweep:slocal:state off

Query Syntax SENSe<cnum>:SWEep:SLOCal:STATe?

Return Type Boolean

Default OFF or 0

SENSe<cnum>:SWEep:SRCPort <1 | 2>  Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

This command is superseded. The Calc:Par:Def:Ext and Calc:Par:Mod:Ext can now optionally include the

source port.

(Read-Write) Sets the source port when making non S-parameter measurements. Has no effect on S-

parameter measurements.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<1 | 2> 1 - Source power comes out Port 1

2 - Source power comes out Port 2

Examples SENS:SWE:SRCP 1
sense2:sweep:srcport 2

Query Syntax SENSe<cnum>:SWEep:SRCPort?

Return Type Character

Default 1
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SENSe<cnum>:SWEep:SPEed <char>

Applicable Models: All

(Read-Write) Sets and returns the state of Fast Sweep mode. Learn more about Fast Sweep.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<char> Fast Sweep mode. Choose from:

FAST - turns Fast Sweep Mode ON

NORMal - turns Fast Sweep Mode OFF (Normal Mode).

Examples SENS:SWE:SPE NORM
sense2:sweep:speed fast

Query Syntax SENSe<cnum>:SWEep:SPEed?

Return Type Character

Default NORMal

SENSe<cnum>:SWEep:STEP <num>

Applicable Models: All

(Read-Write) Sets the frequency step size across the selected frequency range. This effectively sets the

number of data points. Available ONLY when Sweep Type = Linear.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Frequency step size in Hz. Select any value up to the frequency range of the

analyzer.

Examples SENS:SWE:STEP 1e6
sense2:sweep:step 1000000

Query Syntax SENSe<cnum>:SWEep:STEP?

Return Type Numeric

Default NA

SENSe<cnum>:SWEep:TIME <num>
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Applicable Models: All

(Read-Write) Sets the time the analyzer takes to complete one sweep. If sweep time accuracy is

critical, use ONLY the values that are attained using the up and down arrows next to the sweep time

entry box. See Sweep Time.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Sweep time in seconds.

To select the fastest sweep speed, either send MIN as an argument to this

command, or send SENS:SWE:TIME:AUTO 1.

This command will accept MIN or MAX instead of a numeric parameter. See

SCPI Syntax for more information.

The MAX value will change based on point count, IFBW, and dwell time.

Examples SENS:SWE:TIME 1ms
sense2:sweep:time .001

Query Syntax SENSe<cnum>:SWEep:TIME?

Return Type Numeric

Default NA

SENSe<cnum>:SWEep:TIME:AUTO <ON | OFF>

Applicable Models: All

(Read-Write) Turns the automatic sweep time function ON or OFF.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<ON | OFF> ON (or 1) - turns the automatic sweep time ON.

OFF (or 0) - turns the automatic sweep time OFF.

Examples SENS:SWE:TIME:AUTO
sense2:sweep:time:auto off

Query Syntax SENSe<cnum>:SWEep:TIME:AUTO?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON
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SENSe<cnum>:SWEep:TRIGger:DELay <num>

Applicable Models: All

(Read-Write) Sets and reads the trigger delay for all measurements in the specified CHANNEL. This

delay is only applied while TRIG:SOURce EXTernal and TRIG:SCOP CURRent .  After an external trigger

is applied, the start of the sweep is delayed for the specified delay value plus any inherent latency.

To apply a trigger delay for all channels (Global), use TRIG:DEL

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Trigger delay value in seconds. Range is from 0 to 3 seconds

Examples SENS:SWE:TRIG:DELay .003
sense2:sweep:trigger:delay 1

Query Syntax SENSe<cnum>:SWEep:TRIGger:DELay?

Return Type Numeric

Default 0

SENSe<cnum>:SWEep:TRIGger:MODE <char>

Applicable Models: All

(Read-Write) Sets and reads the trigger mode for the specified channel. This determines what EACH

signal will trigger.  Learn more.

Note: Setting Point and Sweep mode forces Trigger:SCOPe = CURRent

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<char> Trigger mode. choose from:

CHANnel - Each trigger signal causes ALL traces in that channel to be swept.

SWEep - Each Manual or External trigger signal causes ALL traces that share a
source port to be swept.

POINt -- Each Manual or External trigger signal causes one data point to be
measured.

TRACe - Allowed ONLY when SENS:SWE:GEN:POIN is enabled. Each trigger
signal causes two identical measurements to be triggered separately - one trigger
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signal is required for each measurement. Other trigger mode settings cause two
identical parameters to be measured simultaneously.

Examples SENS:SWE:TRIG:MODE SWE
sense2:sweep:trigger:mode point

Query Syntax SENSe<cnum>:SWEep:TRIGger:MODE?

Return Type Character

Default Channel

SENSe<cnum>:SWEep:TRIGger:POINt <ON | OFF>  Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

This command is replaced with SENS:SWE:TRIG:MODE POINT

(Read-Write) Specifies whether the specified channel will measure one point for each trigger or all of

the measurements in the channel. Setting any channel to POINt mode will automatically set the

TRIGger:SCOPe = CURRent.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<ON | OFF> ON (or 1) - Channel measures one data point per trigger.

OFF (or 0) - All measurements in the channel made per trigger.

Examples SENS:SWE:TRIG:POIN ON
sense2:sweep:trigger:point off

Query Syntax SENSe<cnum>:SWEep:TRIGger:POINt?

Return Type Boolean (1 = Point, 0 = Measurement)

Default 0 - Measurement

SENSe<cnum>:SWEep:TYPE <char>
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Applicable Models: All

(Read-Write) Sets the type of analyzer sweep mode.  First set sweep type, then set sweep parameters

such as frequency or power settings.

See Also: FCA Segment Sweep commands

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<char> Choose from:

LINear | LOGarithmic | POWer | CW | SEGMent

Note: SWEep TYPE cannot be set to SEGMent if there are no segments turned

ON. A segment is automatically turned ON when the analyzer is started.

Examples SENS:SWE:TYPE LIN

sense2:sweep:type segment

Query Syntax SENSe<cnum>:SWEep:TYPE?

Return Type Character

Default LINear

SENSe<cnum>:SWEep:TYPE:FACW <num>

Applicable Models: N522xB, N524xB, M937xA

(Read-Write) Enables Fast CW sweep and sets the number of data points for the channel. Sweep Type
must already be set to CW and FIFO must already be enabled.

See Also

FIFO commands

Example program

N5264B Measurement Receiver

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Number of data points to measure in Fast CW mode. This setting overwrites

the standard number of points setting for the channel. The minimum value is 1.

The maximum value is 232 - 1 = 2,147,483,647. The "-1" indicates infinite
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point count (i.e., go forever). Any other value will produce invalid results.

If the data acquisition rate exceeds 400,000 points per second, the upper limit

on the number of points is 11e6. The following are conditions that can cause

the higher data rate:

IFBW's >= 1 MHz and internally triggered.
fastCW sweeps that are externally triggered at a rate faster than 400,000 points
per second.

Set to 0 to disable Fast CW.

Examples SENS:SWE:TYPE:FACW 1e6
sense2:sweep:type facw 1e3

Query Syntax SENSe<cnum>:SWEep:TYPE:FACW?

Return Type Numeric

Default 0 - Disabled
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Sense Switch

When you use the M9485A, you can control the M9161D switch through the VNA firmware. The

following commands are available when the launcher  includes the M9161D.

SENSe:SWITch:M9161

       | COUNt?

       | MODule

           | :CHASsis

           | :CONTrol[:STATe]

           | :RESet:IMMediate

           | :SLOT

           | :SWITch:PATH

     

Click on a keyword to view the command details.

 

SENSe<cnum>:SWITch:M9161:COUNt?

Applicable Models: M9485A

(Read-only) Returns the total number of M9161D switch modules that are connected to the VNA

firmware.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command

is common for all channels and the setting is ignored.

Examples SENS:SWIT:M9161:COUN?
sense:switch:m9161:count

Return Type Numeric

Default Not applicable

SENSe<cnum>:SWITch:M9161:MODule<mod>:CHASsis?
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Applicable Models: M9485A

(Read Only) Returns the chassis number where the specified M9161D module is located.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command

is common for all channels and the setting is ignored.

<mod> Module number of M9161D. The number starts from 1 for the leftmost module

of M9161D.

Examples SENS:SWIT:M9161:MOD1:CHAS?

sense:SWITch:m9161:module2:chassis?

Return Type Numeric

Default Not applicable

SENSe<cnum>:SWITch:M9161:MODule<mod>:CONTrol[:STATe] <bool>

Applicable Models: M9485A

(Read-Write) Sets and reads the status of M9161D control.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<mod> Module number of M9161D. The number starts from 1 for the leftmost module

of M9161D.

<bool> Module control state. Choose from:

O or OFF - Skips to control the M9161D at the specified channel.

1 or ON - Enables to control the M9161D at the specified channel.

Examples SENS:SWIT:M9161:MOD1:CONT ON

sense2:SWITch:M9161:module2:control 0

Query Syntax SENSe<cnum>:SWITch:M9161:MODule<mod>:CONTrol[:STATe]?

Return Type Boolean

Default 1 or ON

SENSe<cnum>:SWITch:M9161:MODule<mod>:RESet:IMMediate

1394



Applicable Models: M9485A

(Write Only) Resets the switches in the specified module to "All Open" state immediately.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command

is common for all channels and the setting is ignored.

<mod> Module number of M9161D. The number starts from 1 for the leftmost module

of M9161D.

Examples SENS:SWIT:M9161:MOD1:RES:IMM

sense:SWITch:M9161:module2:reset:immediate

Query Syntax Not applicable

Return Type Not applicable

Default Not applicable

SENSe<cnum>:SWITch:M9161:MODule<mod>:SLOT?

Applicable Models: M9485A

(Read Only) Reads the slot number where the specified M9161D is located.

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1. This command

is common for all channels and the setting is ignored.

<mod> Module number of M9161D. The number starts from 1 for the leftmost module

of M9161D.

Examples SENS:SWIT:M9161:MOD1:SLOT?

sense:SWITch:M9161:module2:slot?

Return Type Numeric

Default Not applicable

SENSe<cnum>:SWITch:M9161:MODule<mod>:SWITch:PATH <char>
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Applicable Models: M9485A

(Read-Write) Sets and reads the path for the M9161D switch

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

<mod> Module number of M9161D. The number starts from 1 for the leftmost module

of M9161D.

<char> Path. Choose from:

STATe1 to STATe4 - State 1 to 4

NFRFout - NF RF Out port (NF measurement only)

NFLO2 - NF LO 2 (Option 720 only)

NFPort1 to NFPort24 - NF port 1 to 24 (NF measurement only)

Examples SENS:SWIT:M9161:MOD1:SWIT:PATH A

sense2:SWITch:M9161:module2:switch:path b

Query Syntax SENSe<cnum>:SWITch:M9161:MODule<mod>:SWITch:PATH?

Return Type <char>

Default STATe1
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X Values Command

SENSe<cnum>:X[:VALues]? - Superseded

Applicable Models: N522xB, N523xB, N524xB, M937xA

Replaced with CALC:X?

(Read-only) Returns the stimulus values for the specified channel. If the channel is sweeping the

source backwards, the values will be in descending order.

Note: To avoid frequency rounding errors, specify FORM:DATA <Real,64> or <ASCii, 0>

Parameters  

<cnum> Any existing channel number; if unspecified, value is set to 1.

Examples SENS:X?
sense2:x:values?

Return Type Depends on FORM:DATA command

Default Not applicable
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Source Commands

Controls the power delivered to the DUT.

SOURce:

CATalog?

DC - More commands

PHASe - More commands

POWer

       | ALC:MODE

            | CATalog?

            | RECeiver - More commands

       | ATTenuation

            | AUTO

            | RECeiver

                 | REFerence

                 | TEST

       | CENTer

       | CORRection - More commands

       | COUPle

       | DETector

       | [LEVel]

            | [IMMediate][AMPLitude]

            | SLOPe

                 | STATe

       | MODE

       | PORT

            | STARt

            | STOP

       | SPAN

       | STARt

       | STOP

Click on a keyword to view the command details.

See Also

Example Programs

Learn about Power Settings

Synchronizing the Analyzer and Controller
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SCPI Command Tree

Remotely Specifying a Source Port

SOURce<cnum>:CATalog?

Applicable Models: All

(Read-only) Returns a list of valid port names that can be controlled. Some ports only have string

names, NOT numbers. All commands that require a port argument have provisions for specifying

either a port number OR a string name.

See also: Remotely Specifying a Source Port.

Parameters  

Examples SOUR:CAT?
source:catalog

'Some VNA-X models return
"Port 1,Port 2,Port 3,Port 4,Port 1 Src2"

Return Type Comma-separated list of strings.

Default Not applicable

SOURce<cnum>:PORT:NUM? <string>

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns a port number for a named source.

All source ports have string names: "Port 1", " Port 2", etc. All external sources have customized

names.

To convert a string name to a port number use this query.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<string> String names.

Examples SOUR:PORT:NUM? "MVG"
source:port:num "port 1"

Return Type String

Default Not Applicable
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SOURce<cnum>:POWer<port>:ALC[:MODE] <char>, [src]

Applicable Models: N522xB, N523xB, N524xB, M9485A

(Read-Write) Sets and returns the ALC mode for the specified channel and port. Use

SOUR:POW:ALC:MODE:CAT? to return a list of valid ALC modes for the VNA.

Learn more about ALC mode.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<port> Source port number of the VNA. If unspecified, value is set to 1. To make

settings for ports that are not simple numbers, use the [src] argument.

<char> ALC Mode.

For the VNA-X choose from:

INTernal  Standard ALC loop

OPENloop  No ALC loop

To set Leveling Mode to Receiver Leveling, use the Receiver Leveling commands.

[src] String. (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to return

a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source, true mode balanced port, or one of the

Source 2 outputs on the 2-port 2-source VNA-X model such as "Port 1 Src2".

Otherwise, the <port> argument performs the same function. If both arguments

are specified, [src] takes priority.

Examples SOUR:POW:ALC INT

source2:power2:alc:mode openloop

source:power:alc:mode openloop,"Port 1 Src2"

Query Syntax SOURce<cnum>:POWer<port>:ALC:MODE? [src]

Return Type Character

Default INTernal

SOURce<cnum>:POWer<port>:ALC[:MODE]:CATalog? [src]
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Applicable Models: N522xB, N523xB, N524xB, M9485A

(Read-only) Returns a list of valid ALC modes for the specified channel and port number. Use the

returned values to set SOUR:POW:ALC:MODE.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<port> Source port number of the VNA. If unspecified, value is set to 1. To make

settings for ports that are not simple numbers, use the [src] argument.

[src] String. (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to return

a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source, true mode balanced port, or one of the

Source 2 outputs on the 2-port 2-source VNA-X model such as "Port 1 Src2".

Otherwise, the <port> argument performs the same function. If both arguments

are specified, [src] takes priority.

Examples SOUR:POW:ALC:CAT?

source2:power2:alc:mode:catalog?

source:power:alc:mode:catalog? "Port 1 Src2"

Return Type Comma-separated list of strings.

Default Not applicable

SOURce<cnum>:POWer<port>:ATTenuation <num>, [src]

Applicable Models: All

(Read-Write) Sets the attenuation level for the selected channel. Sending this command turns

automatic attenuation control (SOUR:POW:ATT:AUTO) to OFF. If the ports are coupled, changing

the attenuation on one port will also change the attenuation on all other ports. To turn port coupling

OFF use SOURce:POWer:COUPle OFF.

Note: Attenuation cannot be set with Sweep Type set to Power

See Sens:Power:ATT to change receiver attenuation.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1
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<port> Source port number of the VNA. If unspecified, value is set to 1. To make

settings for ports that are not simple numbers, use the [src] argument.

<num> Attenuation value.  The range of settable values depends on the VNA model.

To determine the valid settings, do one of the following:

See VNA models and options to see the range and step size for each model /
option.

Perform a query using MAX, then MIN, as an argument. Example:
SOURce:POWer:ATT? Max  However, this will not tell you the attenuation step
size.

If an invalid attenuation setting is entered, the VNA will select the next lower

valid value. For example, if 19 is entered, then for an E8361A,  10 dB

attenuation will be selected.

Note: This command will accept MIN or MAX instead of a numeric

parameter. See SCPI Syntax for more information.

[src] String. (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to return

a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source, true mode balanced port, or one of the

Source 2 outputs on the 2-port 2-source VNA-X model such as "Port 1 Src2".

Otherwise, the <port> argument performs the same function. If both arguments

are specified, [src] takes priority.

Examples SOUR:POW:ATT 10

source2:power2:attenuation maximum

source:power:att 20, "Port 1 Src2"

Query Syntax SOURce<cnum>:POWer<port>:ATTenuation? [min/max] [src]

[min/max,src]

Return Type Numeric

Default 0

SOURce<cnum>:POWer<port>:ATTenuation:AUTO <bool>, [src]
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Turns automatic attenuation control ON or OFF. Setting an attenuation value (using

SOURce:POWer:ATTenuation <num>) sets AUTO OFF.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<port> Source port number of the VNA. If unspecified, value is set to 1.To make

settings for ports that are not simple numbers, use the [src] argument.

<bool> ON (or 1) - turns coupling ON. The analyzer automatically selects the

appropriate attenuation level to meet the specified power level.

OFF (or 0) - turns coupling OFF. Attenuation level must be set using
SOURce:POWer:ATTenuation <num>.

[src] String. (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to return

a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source, true mode balanced port, or one of the

Source 2 outputs on the 2-port 2-source VNA-X model such as "Port 1 Src2".

Otherwise, the <port> argument performs the same function. If both arguments

are specified, [src] takes priority.

Examples SOUR:POW2:ATT:Auto On

source2:power:attentuation:auto off

sour:pow:att:auto 1, "Port 1 Src2"

Query Syntax SOURce<cnum>:POWer:ATTenuation:Auto? [src]

Return Type Boolean (1 = ON, 0 = OFF)

Default ON

SOURce<cnum>:POWer<port>:ATTenuation:RECeiver:REFerence <num>
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Applicable Models: N522xB, N523xB, N524xB, M9485A

(Read-Write) Sets the attenuation level for the specified reference attenuator.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<port> Port number of the VNA. If unspecified, value is set to 1.

<num> Attenuation value in dB. 0dB or 35dB.

If a number other than these is entered, the analyzer will select the next lower valid

value. For example, if 19dB is entered, then 0dB attenuation will be selected.

Examples SOUR:POW2:ATT:REC:REF 0

source:power:attenuation:receiver:reference 35

Query

Syntax

SOURce<cnum>:POWer<port>:ATTenuation:RECeiver:REFerence?

Return

Type

Numeric. If querying for the standard port, the return value is 0

Default 35

SOURce<cnum>:POWer<port>:ATTenuation:RECeiver:TEST <num>

Applicable Models: N522xB, N523xB, N524xB, M9485A

(Read-Write) Sets the attenuation level for the specified test attenuator.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<port> Source port number of the VNA. If unspecified, value is set to 1.

<num> Attenuation value in dB. 0dB or 35dB.

If a number other than these is entered, the analyzer will select the next lower valid

value. For example, if 19dB is entered, then 0dB attenuation will be selected.

Examples SOUR:POW2:ATT:REC:TEST 0

source:power:attenuation:receiver:test 35

Query

Syntax

SOURce<cnum>:POWer<port>:ATTenuation:RECeiver:TEST?
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Return

Type

Numeric. If querying for the standard port, the return value is 0

Default 35

SOURce<cnum>:POWer<port>:CENTer <num>

Applicable Models: All

(Read-Write) Sets the power sweep center power. Must also set:

SENS:SWE:TYPE POWer and SOURce:POWer:SPAN <num>.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Center power. Actual achievable leveled power depends on frequency.

<port> If provided, this argument is ignored by the VNA.

Examples SOUR:POW:CENT -15
source2:power:center -7

Query Syntax SOURce<cnum>:POWer:CENTer?

Return Type Numeric

Default 0 dBm

SOURce<cnum>:POWer<port>:COUPle <ON | OFF>

Applicable Models: All

(Read-Write) Turns Port Power Coupling ON or OFF.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<ON | OFF> ON (or 1) - turns coupling ON. The same power level is used for both source

ports.

OFF (or 0) - turns coupling OFF.  Power level can be set individually for each
source port.

Examples SOUR:POW:COUP ON
source2:power:couple off

Query Syntax SOURce<cnum>:POWer:COUPle?

Return Type Boolean (1 = ON, 0 = OFF)
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Default ON

SOURce<cnum>:POWer:DETector <char> OBSOLETE

(Read-Write) The VNA models with external leveling are now OBSOLETE.

Sets the source leveling loop as Internal or External.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<char> INTernal - Internal leveling is applied to the source

EXTernal - External leveling is applied to the source through a rear-panel

connector.  ONLY provided on 3 GHz, 6 GHz, and 9 GHz VNA models.

Examples SOUR:POW:DET INT
source2:power:detector external

Query Syntax SOURce<cnum>:POWer:DETector?

Return Type Character

Default INTernal

SOURce<cnum>:POWer<port>[:LEVel][:IMMediate][:AMPLitude] <num>, [src]

Applicable Models: All

(Read-Write) Sets the RF power output level.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<port> Source port number of the VNA. If unspecified, value is set to 1. To make
settings for ports that are not simple numbers, use the [src] argument.

<num> Source power in dBm.

Note: The range of settable power values depends on the VNA model and if

source attenuators are installed. To determine the range of values, perform a

query using MAX, then MIN, as an argument. (SOUR:POW:ATT:AUTO must be

set to ON)  Example: SOURce:POWer? Max

Actual achievable leveled power depends on frequency.

[src] String. (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to return

1406



a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source, true mode balanced port, or one of the

Source 2 outputs on the 2-port 2-source VNA-X model such as "Port 1 Src2".

Otherwise, the <port> argument performs the same function. If both arguments

are specified, [src] takes priority.

Examples SOUR:POW1 5
source2:power:level:immediate:amplitude maximum

sour:pow 5, "Port 1 Src2"

Query Syntax SOURce<cnum>:POWer[:LEVel][:IMMediate][:AMPLitude]? [src]

Return Type Numeric

Default 0 dBm

SOURce<cnum>:POWer<port>[:LEVel]:SLOPe <num>

Applicable Models: All

(Read-Write) Sets the RF power slope value.

Also enable the slope state using SOUR:POW:SLOP:STAT ON.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Slope value in db/GHz. Choose any value between -2 and 2 (0 is no slope).

<port> If provided, this argument is ignored by the VNA.

Examples SOUR:POW:SLOP .5234434

source2:power:level slope -1.345

Query Syntax SOURce<cnum>:POWer[:LEVel]:SLOPe?

Return Type Numeric

Default 0

SOURce<cnum>:POWer<port>[:LEVel]:SLOPe:STATe <ON | OFF>
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Applicable Models: All

(Read-Write) Turns Power Slope ON or OFF. Set the slope using SOUR:POW:SLOP.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<ON|OFF> ON (or 1) - turns slope ON.

OFF (or 0) - turns slope OFF.

<port> If provided, this argument is ignored by the VNA.

Examples SOUR:POW:SLOP:STAT ON
source2:power:slope:state off

Query Syntax SOURce<cnum>:POWer[:LEVel]:SLOPe:STATe?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF

SOURce<cnum>:POWer<port>:MODE <state>, [src]

Applicable Models: All

(Read-Write) Sets the state of VNA source for the specified port.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<port> Source port number of the VNA. If unspecified, <port> is set to 1. To make

settings for ports that are not simple numbers, use the [src] argument.

<state> Source state. Choose from:

AUTO  Source power is turned ON when required for a measurement.

ON  Source power is always ON regardless of the measurement.

OFF  Source power is always OFF regardless of the measurement.

NOCTL  Do not send OFF commands to the external sources. If an external
source is in the OFF state, this option is used to stop sending OFF commands to
the external source to increase sweep speed.

[src] String. (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to return

a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed
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to access ports such as an external source, true mode balanced port, or one of the

Source 2 outputs on the 2-port 2-source VNA-X model such as "Port 1 Src2".

Otherwise, the <port> argument performs the same function. If both arguments

are specified, [src] takes priority.

Examples SOUR:POW:MODE ON

source2:power4:mode OFF

sour:pow:mode on, "Port 1 Src2"

Query Syntax SOURce<cnum>:POWer<port>:MODE? [src]

Return Type Character

Default Auto

SOURce<cnum>:POWer<port>:PORT:STARt <num>, [src]

Applicable Models: All

(Read-Write) Sets and reads the power sweep start power value for a specific port. This allows

uncoupled forward and reverse power sweep ranges. Must also set SENS:SWE:TYPE POWer and

SOUR:POW:COUPle OFF.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<port> Source port number of the VNA. If unspecified, <port> is set to 1. To make

settings for ports that are not simple numbers, use the [src] argument.

<num> Start power in dBm.

Note: The range of settable power values depends on the VNA model and if

source attenuators are installed. To determine the range of values, perform a

query using MAX, then MIN, as an argument. (SOUR:POW:ATT:AUTO must be

set to ON)  Example: SOURce:POWer:STARt? MIN

Actual achievable leveled power depends on frequency.

[src] String. (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to return

a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source, true mode balanced port, or one of the

Source 2 outputs on the 2-port 2-source VNA-X model such as "Port 1 Src2".

Otherwise, the <port> argument performs the same function. If both arguments

are specified, [src] takes priority.
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Examples SOUR:POW1:PORT:STAR -15
source2:power:port:start 5, "bal port 1"

Query Syntax SOURce<cnum>:POWer<port>:PORT:STARt? [src]

Return Type Numeric

Default -10 dBm

SOURce<cnum>:POWer<port>:PORT:STOP <num>, [src]

Applicable Models: All

(Read-Write) Sets and reads the power sweep stop power value for a specific port. This allows

uncoupled forward and reverse power sweep ranges. Must also set SENS:SWE:TYPE POWer and

SOUR:POW:COUPle OFF.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<port> Source port number of the VNA. If unspecified, <port> is set to 1. To make

settings for ports that are not simple numbers, use the [src] argument.

<num> Stop power in dBm.

Note: The range of settable power values depends on the VNA model and if

source attenuators are installed. To determine the range of values, perform a

query using MAX, then MIN, as an argument. (SOUR:POW:ATT:AUTO must be

set to ON)  Example: SOURce:POWer:STARt? MIN

Actual achievable leveled power depends on frequency.

[src] String. (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to return

a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source, true mode balanced port, or one of the

Source 2 outputs on the 2-port 2-source VNA-X model such as "Port 1 Src2".

Otherwise, the <port> argument performs the same function. If both arguments

are specified, [src] takes priority.

Examples SOUR:POW1:PORT:STOP -15
source2:power:port:stop 5, "bal port 1"

Query Syntax SOURce<cnum>:POWer<port>:PORT:STOP? [src]

Return Type Numeric

Default 0 dBm
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SOURce<cnum>:POWer<port>:SPAN <num>

Applicable Models: All

(Read-Write) Sets the power sweep span power. Must also set:

SENS:SWE:TYPE POWer and SOURce:POWer:CENTer <num>.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1.

<num> Span power. Actual achievable leveled power depends on frequency.

<port> If provided, this argument is ignored by the VNA.

Examples SOUR:POW:SPAN -15
source2:power:span -7

Query Syntax SOURce<cnum>:POWer:SPAN?

Return Type Numeric

Default 0 dBm

SOURce<cnum>:POWer<port>:STARt <num>

Applicable Models: All

(Read-Write) Sets the power sweep start power for ALL ports being used by the specified channel.

Must also set:

SENS:SWE:TYPE POWer and SOURce:POWer:STOP <num>.

To set start power for a specific port, use SOUR:POW:PORT:STARt.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Start power.

Note: The range of settable power values depends on the VNA model and if
source attenuators are installed. To determine the range of values, perform a

query using MAX, then MIN, as an argument. (SOUR:POW:ATT:AUTO must be
set to ON)  Example: SOURce:POWer:STARt? MIN

Actual achievable leveled power depends on frequency.
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<port> If provided, this argument is ignored by the VNA.

Examples SOUR:POW:STAR -15
source2:power:start -7

Query Syntax SOURce<cnum>:POWer:STARt?

Return Type Numeric

Default 0 dBm

SOURce<cnum>:POWer<port>:STOP <num>

Applicable Models: All

(Read-Write) Sets the power sweep stop power for ALL ports being used by the specified channel..

Must also set: SENS:SWE:TYPE POWer and SOURce:POWer:START <num>.

To set start power for a specific port, use SOUR:POW:PORT:STOP.

Parameters  

<cnum> Any existing channel number. If unspecified, value is set to 1

<num> Stop power.

Note: The range of settable power values depends on the VNA model and if

source attenuators are installed. To determine the range of values, perform a

query using MAX, then MIN, as an argument. (SOUR:POW:ATT:AUTO must be

set to ON)  Example: SOURce:POWer:STOP? MAX

Actual achievable leveled power depends on frequency.

<port> If provided, this argument is ignored by the VNA.

Examples SOUR:POW:STOP -15

source2:power:stop -7

Query Syntax SOURce<cnum>:POWer:STOP?

Return Type Numeric

Default 0 dBm
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Source:Power:Correction Commands

Used to perform source power calibration on internal and external sources.

Note: Only ONE Source Power Cal can be performed at a time.

SOURce:POWer:CORRection

COLLect

       | ABORt

       | ACQuire

       | AVERage

            | [COUNt]

            | NTOLerance

       | DISPlay

            | [STATe]

       | FCHeck]

            | [STATe]

       | ITERation

            | [COUNt]

            | NTOLerance

       | METHod

       | SAVE

       | SENSor

            | [FRANge]

            | RCFactor

            | SELect

       | TABLe

            | DATA

            | FREQuency

            | LOSS

                 | [STATe]

            | POINts?

            | [SELect]

       | WARN

DATA

       | PRIor
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LEVel [AMPlitude]

OFFSet

       | [MAGNitude ]

[STATe]

Click on a keyword to view the command details.

Blue commands are superseded.

S ee Also

Example program using these commands.

Template for creating your own Power Meter Driver

Learn about Source Power Cal

Synchronizing the Analyzer and Controller

SCPI Command Tree

Note : The SOURce:POWer:CORRection:COLLect:ACQuire command, used to step the VNA and read a

power meter, cannot be sent over the GPIB unless the power meter is connected to a different GPIB

interface.  See the alternative methods described in the command details.

SOURce<ch>:POWer<port>:CORRection:COLLect:ABORt

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Write-only) Aborts a source power calibration sweep that is in progress.

To use this ABORt command, you MUST use the ASYNchronous argument with

SOUR:POW:CORR:COLL:ACQ

After aborting, this message appears in the error log: +243,"Requested operation was canceled".

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> Port number to correct for source power. If unspecified, value is set to 1.

Examples SOUR:POW:CORR:COLL:ABOR
source1:power2:correction:collect:abort

Query Syntax Not Applicable

Default Not Applicable
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SOURce<ch>:POWer<port>:CORRection:COLLect[:ACQuire] <char>,<id>[,src][,sync]

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Write-only) Initiates a source power cal acquisition sweep using the power sensor attached to the

specified channel (A or B) on the power meter, using a USB power sensor, or using the specified

VNA receiver.  

For source power cal, the power meter can NOT be controlled by the VNA using the GPIB

Talker/Listener interface. Instead use one of the following methods:

If present, use the GPIB dedicated controller port.

Connect the power meter to the VNA using a USB / GPIB interface (Keysight 82357A).

SCPI programming of the VNA using a LAN Client interface (see example).

Send SCPI commands through the COM interface using the SCPI String Parser object.

Directly control the Power Meter and VNA to step frequency; then acquire and store the Power reading.
(see example).

Configure the Power Meter/Sensor as a PMAR Device. Learn how . See SCPI commands .

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> Port number to correct for source power. If unspecified, value is set to 1.

<char> Acquisition Choose from:

PMETer - Power Meter is used for all readings.

PMReceiver - Power meter for the first iteration; then use the reference receiver
for remaining readings if necessary (same as "fast iteration" box checked on
dialog box )

RECeiver -  Use VNA measurement receiver for all readings.

<id> String  (Not case sensitive). The power sensor or VNA receiver to use for

measuring power.

For PMETer or PMRECeiver , choose from:

"ASENSOR" or "BSENSOR" . For U series USB sensors, always specify
"ASENSOR"

For RECeiver , choose from:
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Any VNA receiver to acquire readings using physical or logical receiver notation .

Any configured PMAR device name. Learn more about PMAR Devices . See
PMAR commands .

[src] Optional argument. String . (NOT case sensitive). Source port.  Use

SOUR:CAT? to return a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports that are not simple numbers, such as "Port 1 Src2". Otherwise,

the <port> argument performs the same function. If both arguments are

specified, [src] takes priority.

[sync] If this argument is specified, must also specify [src].

Choose from:

SYNChronous - Blocks SCPI commands during standard measurement (default
behavior).

ASYNchronous - Does NOT block SCPI commands during standard
measurement.

Learn more about this argument

Examples SOUR:POW:CORR:COLL PMET,"ASENSOR","Port 1",ASYN  'acquires power
meter readings using the A sensor, source port 1, asynchronous.
source1:power2:correction:collect:acquire receiver,"a1"
'acquires source cal readings using the reference receiver for
port 1.

Query Syntax Not Applicable

Default Not Applicable

SOURce:POWer<port>:CORRection:COLLect:AVERage[:COUNt] <num>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) This command, along with SOUR:POW:CORR:COLL:AVER:NTOLerance , allows for

settling of the power sensor READINGS.

Note: This command is global and does not depend on a specific channel number.

Sets the maximum number of acquisitions that will be used to acquire one settled reading from the

power meter.

These settings affect every use of the power meter (PMAR and source power cal).
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T his setting and corresponding SOUR:POW:CORR:COLL:AVER:NTOLerance command only

effect the settled reading of the currently selected legacy power meter.

Note: To set the COUNT/NTOLerance of a specific PMAR, use the

SYST:CONF:EDEV:PMAR:READ:COUNT and SYST:CONF:EDEV:PMAR:READ:NTOLerance

commands.

Users may want to adjust this number if they know the signal is noisy as these settings set a threshold

that determines when the power meter reading is done.

Each reading is averaged with the previous readings. When this average meets the

Average:NTOLerance value or this number of readings has been made, the average is returned as the

valid reading.

Learn more.

Parameters  

<port> If provided, this argument is ignored by the VNA.

<num> Maximum number of readings to make to allow for settling. Choose any

number between 3 and 1000.

Examples // configure the power meter settling (up to 2 acquisitions to
produce one settled meter reading)

SOUR:POW:CORR:COLL:AVER 2
SOUR:POW:CORR:COLL:AVER:NTOL .05

// configure the number of (settled) readings to acquire at each
frequency point.

// 3 settled readings are averaged to produce one bucket of data
per frequency

SOUR:POW:CORR:COLL:ITER 3
SOUR:POW:CORR:COLL:ITER:NTOL .005

Query Syntax SOURce:POWer:CORRection:COLLect:AVERage[:COUNt]?

Return Type Numeric

Default 3

SOURce:POWer<port>:CORRection:COLLect:AVERage:NTOLerance <num>
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Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write)  This command, along with SOUR:POW:CORR:COLL:AVER:COUNT , allows for

settling of the power sensor READINGS.

Note: This command is global and does not depend on a specific channel number.

This setting and corresponding SOUR:POW:CORR:COLL:AVER:COUNT command only effect the

settled reading of the currently selected legacy power meter.

Note: To set the COUNT/NTOLerance of a specific PMAR, use the

SYST:CONF:EDEV:PMAR:READ:COUNT and SYST:CONF:EDEV:PMAR:READ:NTOLerance

commands.

Each power reading is averaged with the previous readings. When the average meets this nominal

tolerance value or the max number of readings has been made, the average is returned as the valid

reading.

Learn more.

Parameters  

<port> If provided, this argument is ignored by the VNA.

<num> Power measurement settling tolerance value in dB. Choose any number

between 0 and 5.

Examples // configure the power meter settling (up to 2 acquisitions to
produce one settled meter reading)

SOUR:POW:CORR:COLL:AVER 2
SOUR:POW:CORR:COLL:AVER:NTOL .05

// configure the number of (settled) readings to acquire at each
frequency point.

// 3 settled readings are averaged to produce one bucket of data
per frequency

SOUR:POW:CORR:COLL:ITER 3
SOUR:POW:CORR:COLL:ITER:NTOL .005

Query Syntax SOURce:POWer:CORRection:COLLect:AVERage:NTOLerance?

Return Type Numeric

Default .050 dBm
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SOURce<ch>:POWer<port>:CORRection:COLLect:DISPlay[:STATe] <ON | OFF>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write)  Enables and disables the display of power readings on the VNA screen. Send this

command BEFORE you begin a source power cal acquisition. After the source power cal data is

acquired, this setting is reset to ON.

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> If provided, this argument is ignored by the VNA.

<ON|OFF> ON (1)  Source power calibration dialog box is shown on the VNA screen.

Power  readings are plotted against the Tolerance value as limit lines.

OFF (0) - Source power calibration dialog box is NOT shown on the VNA

screen.

Examples SOUR:POW:CORR:COLL:DISP ON
source1:power2:correction:collect:display:state off

Query Syntax SOURce:POWer:CORRection:COLLect:DISPlay[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default ON (1)

SOURce<ch>:POWer<port>:CORRection:COLLect:FCHeck[:STATe] <ON | OFF>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write)  Enables and disables frequency checking of source power cal acquisition sweeps.

ONLY use when you have more than one power sensor.

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> If provided, this argument is ignored by the VNA.

<ON|OFF> ON (1) turns source power cal frequency checking ON. A requested

acquisition will only succeed for those frequency points which fall within a

frequency range specified for the power sensor being used. An acquisition will

pause in mid-sweep if the frequency is about to exceed the maximum

frequency limit specified for that sensor. When the sweep is paused in this

manner, a sensor connected to the other channel input of the power meter can

be connected to the measurement port in place of the previous sensor, and used

to complete the sweep. However, the maximum frequency specified for the
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second sensor would need to be sufficient for the sweep to complete.

Frequency limits are specified using the SOUR:POW:CORR:COLL:SEN

command.

OFF (0) - turns source power cal frequency checking OFF. An acquisition will

use just one power sensor for the entire sweep, regardless of frequency.

Examples SOUR:POW:CORR:COLL:FCH ON
source1:power2:correction:collect:fcheck:state off

Query Syntax SOURce:POWer:CORRection:COLLect:FCHeck[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF (0)

SOURce<ch>:POWer<port>:CORRection:COLLect:ITERation[:COUNt] <num>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) This command, along with SOUR:POW:CORR:COLL:ITER:NTOL control the number

of settled readings taken to produce a single power point during source power cal.

The source power cal reads the power (performed by SOUR:POW:CORR:COLL:AVER:COUNT and

SOUR:POW:CORR:COLL:AVER:NTOLerance ) and makes internal adjustments to set the power to

a desired level. These settings determine how many attempts (COUNt) the analyzer will make in an

attempt to get close enough (NTOLerance ) to the target power level.

Learn more.

Parameters  

<ch> If provided, this argument is ignored by the VNA.

<port> If provided, this argument is ignored by the VNA.

<num> Maximum number of readings. Choose any number between 1 and 1000.

Examples // configure the power meter settling (up to 2 acquisitions to
produce one settled meter reading)

SOUR:POW:CORR:COLL:AVER 2
SOUR:POW:CORR:COLL:AVER:NTOL .05

// configure the number of (settled) readings to acquire at each
frequency point.

// 3 settled readings are averaged to produce one bucket of data
per frequency

SOUR:POW:CORR:COLL:ITER 3
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SOUR:POW:CORR:COLL:ITER:NTOL .005

Query Syntax SOURce:POWer:CORRection:COLLect:ITERation[:COUNt]?

Return Type Numeric

Default 1

SOURce<ch>:POWer<port>:CORRection:COLLect:ITERation:NTOLerance <num>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) This command, along with SOUR:POW:CORR:COLL:ITER:COUNT describes the

number of adjustments to make to the source power.

Sets the maximum desired deviation from the sum of the test port power and the offset value.  Power

READINGS (performed by SOUR:POW:CORR:COLL:AVER:COUNT and

SOUR:POW:CORR:COLL:AVER:NTOLerance ) will continue to be made, and source power

adjusted, until a measurement is within this tolerance value or the max number of measurements has

been met. The last value is the valid measurement for that data point.

Learn more.

Parameters  

<ch> If provided, this argument is ignored by the VNA.

<port> If provided, this argument is ignored by the VNA.

<num> Tolerance value in dBm. Choose any number between 0 and 5

Examples // configure the power meter settling (up to 2 acquisitions to
produce one settled meter reading)

SOUR:POW:CORR:COLL:AVER 2
SOUR:POW:CORR:COLL:AVER:NTOL .05

// configure the number of (settled) readings to acquire at each
frequency point.

// 3 settled readings are averaged to produce one bucket of data
per frequency

SOUR:POW:CORR:COLL:ITER 3
SOUR:POW:CORR:COLL:ITER:NTOL .005

Query Syntax SOURce:POWer:CORRection:COLLect:ITERation:NTOLerance?

Return Type Numeric
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Default .05

SOURce<ch>:POWer<port>:CORRection:COLLect:METHod <char> Superseded

Applicable Models: N522xB, N523xB, N524xB

This command is replaced with SOUR:POW:CORR:COLLect[:ACQuire] which now specifies the

method and the device. The only parameter required by that command was either ASENsor or

BSENsor which are still supported but not documented.

(Read-Write) Selects the calibration method to be used for the source power cal acquisition.

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> Port number to correct for source power. If unspecified, value is set to 1.

<char> Choose from:

NONE - No Cal method

PMETer - Power Meter is used for all readings. (same as "fast iteration" box

not checked on dialog box )

PMReceiver - Power meter for the first iteration; then use the reference

receiver for remaining readings if necessary (same as "fast iteration" box

checked on dialog box )

Examples SOUR:POW:CORR:COLL:METH PMET
source1:power2:correction:collect:method pmreceiver

Query Syntax SOURce:POWer:CORRection:COLLect:METHod?

Return Type Character

Default NONE

SOURce<ch>:POWer<port:CORRection:COLLect:SAVE [<RREC>]
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Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Write-only) Applies the array of correction values after a source power calibration sweep has

completed. The source power correction will then be active on the specified source port for channel

<ch>. This command does NOT save the correction values. To save correction values, save an

instrument / calibration state (*.cst file) after performing a source power cal.

Parameters  

<ch> If provided, this argument is ignored by the VNA.

<port> If provided, this argument is ignored by the VNA.

<RREC> Optional argument.

RRECeiver  In addition to a source Power Cal, perform a calibration of the

reference receiver used in the measurement.  ONLY the Reference Receiver

calibration is then saved to a Cal Set or Cal Register as specified by the current

setting of SENS:CORR:PREF:CSET:SAVE .

This argument only applies to standard S-parameter channels.

Examples SOUR:POW:CORR:COLL:SAVE
source:power:correction:collect:save rreceiver

Query Syntax Not Applicable

Default Not Applicable

SOURce<ch>:POWer<port>:CORRection:COLLect:<pmChan>SENsor[:FRANge]
<num1>,<num2>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) Specifies the frequency range over which the power sensors connected to the specified

channels (A and B) of the power meter can be used (minimum frequency, maximum frequency). If the

power meter has only a single channel, that channel is considered channel A.

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> If provided, this argument is ignored by the VNA. (It is required for query).

<pmChan> Power Meter channel. Choose from:

A - Channel A

B - Channel B
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<num1> Minimum frequency for the sensor. If a frequency unit is not specified, Hz is

assumed.

<num2> Maximum frequency for the sensor. If a frequency unit is not specified, Hz is

assumed.

Examples SOUR:POW:CORR:COLL:ASEN 100E3, 3E9
source1:power:correction:collect:bsensor:frange 10 MHz, 18 GHz

Query Syntax SOURce<ch>:POWer<port>:CORRection:COLLect:ASENsor[:FRANge]?

SOURce<ch>:POWer<port>:CORRection:COLLect:BSENsor[:FRANge]?

Return Type Numeric

Default 0,0

SOURce<ch>:POWer<port>:CORRection:COLLect:<pmChan>SENsor:RCFactor <num>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) ) Specifies the reference cal factor for the power sensor connected to channel A or B of

the power meter. If the power meter has only a single channel, that channel is considered channel A.

Note : If the sensor connected to the specified channel of the power meter contains cal factors in

EPROM (such as the Keysight E-series power sensors), those will be the cal factors used during the

calibration sweep. The reference cal factor value associated with this command, and any cal factors

entered into the VNA for that sensor channel, will not be used.

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> If provided, this argument is ignored by the VNA.

<pmChan> Power Meter channel. Choose from:

A - Channel A

B - Channel B

<num> Reference cal factor in percent.  Choose any number between 1 and 150.

Examples SOUR:POW:CORR:COLL:ASEN:RCF 98.7
source1:power2:correction:collect:bsensor:rcfactor 105

Query Syntax SOURce:POWer:CORRection:COLLect:ASENsor:RCFactor?

SOURce:POWer:CORRection:COLLect:BSENsor:RCFactor?

Return Type Numeric
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Default 100

SOURce<ch>:POWer<port>:CORRection:COLLect:<pmChan>SENsor:SELect

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) Sets and returns the power sensor channel (A or B) to be used.  This performs the same

function as the Use this sensor only checkbox in the Power Sensor Settings dialog .

Notes:

This command is NOT necessary when performing a Guided Power Cal using Multiple Sensors.

This command can be used with Application channels .

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> If provided, this argument is ignored by the VNA.

<pmChan> Power Meter channel. Choose from:

A - Channel A

B - Channel B

Examples SOUR:POW:CORR:COLL:<pmChan>SEN:SEL 'Write

source1:power2:correction:collect:bsensor:select? 1e9 'Read

Query Syntax SOURce:POWer:CORRection:COLLect:ASENsor:SELect? <Frequency>

SOURce:POWer:CORRection:COLLect:BSENsor:SELect? <Frequency>

Returns a boolean 1 or 0 (ON or OFF) indicating whether the sensor is to be

used at the specified frequency.

If frequency checking is OFF, then the <Frequency> parameter is ignored. The

query returns if the sensor is selected for ALL frequencies.

Return Type Numeric

Default Not Applicable

SOURce<ch>:POWer<port>:CORRection:COLLect:TABLe:DATA <data>
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Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) Read or write data into the selected table. Use

SOUR:POW:CORR:COLL:TABL:SELect to select a table.

When the power sensor table is selected, the data is interpreted as cal factors in percent .

When the loss table is selected, POSITIVE values in dB are interpreted as LOSS.  To compensate for gain,
use negative values.  

Each table can contain up to 9999 segments. Values can be loaded using the Characterize Adapter macro.

Learn more about Power Loss Compensation .

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> If provided, this argument is ignored by the VNA.

<data> Data to write into the selected table.

Examples SOURce:POWer:CORRection:COLLect:TABLe:DATA 0.12, 0.34, 0.56

Query Syntax SOURce<ch>:POWer:CORRection:COLLect:TABLe:DATA?

If the selected table is currently empty, no data is returned.

Return Type Numeric - one number per table segment.

Default Not Applicable

SOURce<ch>:POWer<port>:CORRection:COLLect:TABLe:FREQuency <data>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) Read or write frequency values for the selected table (cal factor table for a power sensor,

or the loss compensation table). Use SOUR:POW:CORR:COLL:TABL:SELect to select a table.

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> If provided, this argument is ignored by the VNA.

<data> Frequency data to write into the selected table.

Examples SOURce:POWer:CORRection:COLLect:TABLe:FREQuency 10E6, 1.5E9, 9E9

Query Syntax SOURce<ch>:POWer:CORRection:COLLect:TABLe:FREQuency?

If the selected table is currently empty, no data is returned.
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Return Type Numeric - one number per table segment

Default Not Applicable

SOURce<ch>:POWer<port>:CORRection:COLLect:TABLe:LOSS[:STATe] <ON | OFF>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) Indicates whether or not to adjust the power readings using the values in the loss table

during a source power cal sweep.  Learn more about Power Loss Compensation .

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> If provided, this argument is ignored by the VNA.

<ON|OFF> ON (or 1) -  turns use of the loss table ON.

OFF (or 0) - turns use of the loss table OFF.

Examples SOUR:POW:CORR:COLL:TABL:LOSS ON
source1:power2:correction:collect:table:loss:state off

Query Syntax SOURce:POWer:CORRection:COLLect:TABLe:LOSS[:STATe]?

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF (0)

SOURce<ch>:POWer<port>:CORRection:COLLect:TABLe:POINts?

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-only) Returns the number of segments that are currently in the selected table.

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> If provided, this argument is ignored by the VNA.

Examples SOUR:POW:CORR:COLL:TABL:POIN?
source1:power2:correction:collect:table:points?

Return Type Numeric

Default 0

SOURce<ch>:POWer<port>:CORRection:COLLect:TABLe[:SELect] <char>
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Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) Selects which table you want to write to or read from. Read or write using

SOURce:POWer:CORRection:COLLect:TABLe:FREQuency and

SOURce:POWer:CORRection:COLLect:TABLe:DATA

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> If provided, this argument is ignored by the VNA.

<char> Choose from:  

NONE - No table selected

ASENsor - Cal Factor table for Power Sensor A

BSENsor - Cal Factor table for Power Sensor B

LOSS - Loss compensation table

Examples SOUR:POW:CORR:COLL:TABL ASEN
source1:power2:correction:collect:table:select bsensor

Query Syntax SOURce:POWer:CORRection:COLLect:TABLe[:SELect]?

Return Type Character

Default NONE

SOURce<ch>:POWer<port>:CORRection:COLLect:WARN <bool>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) Enables/disables the use of error messages during a source calibration if the calibration

fails to achieve the desired power level at the power sensor.

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> If provided, this argument is ignored by the VNA.

<bool> ON (or 1) -  enables SCPI error on source power calibration failure.

OFF (or 0) - disables SCPI error on source power calibration failure.

Examples SOUR:POW:CORR:COLL:WARN ON
source1:power2:correction:collect:warn off

Query Syntax SOURce:POWer:CORRection:COLLect:WARN?
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Return Type Boolean (1 = ON, 0 = OFF)

Default OFF (0)

SOURce<ch>:POWer<port>:CORRection:DATA <data>[,src]

Applicable Models: All

(Read-Write) Writes and reads source power calibration data.

The effect from this command on the channel is immediate. Do NOT send

SOUR:POW:CORR:COLL:SAVE after this command as it may invalidate the uploaded data.

When querying source power calibration data, if no source power cal data exists for the specified

channel and source port, then no data is returned.

If a change in the instrument state causes interpolation and/or extrapolation of the source power cal,

the correction data associated with this command correspond to the new instrument state (interpolated

and/or extrapolated data).

If the channel is sweeping the source backwards, then the first data point is the highest frequency

value; the last data point is the lowest. Use the SENS:X:VALues? command to return the X-axis

values in the displayed order.

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> Port number to correct for source power. If unspecified, value is set to 1.

<data> Correction Data

[src] String . (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to

return a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports that are not simple numbers, such as "Port 1 Src2". Otherwise,

the <port> argument performs the same function. If both arguments are

specified, [src] takes priority.

Examples SOURce1:POWer2:CORRection:DATA 0.12, -0.34, 0.56

Query Syntax SOURce<ch>:POWer<port>:CORRection:DATA? [src]

Return Type Depends on FORMat:DATA command

Default Not Applicable
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SOURce<ch>:POWer<port>:CORRection:DATA:PRIor <data>[,src]

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) Writes and reads power correction values from the previous iteration of the source

power cal. Data for which the first power meter reading were within the tolerance limit, the prior

correction value is 0.

In all other respects, this command is the same as SOUR:POW:CORR:DATA .

This command can be used to determine the final power reading at each point of the power cal, for a

cal that did not pass tolerance limits.  The formula for determining the power reading (in dB):

Power reading = Target power at the source port + specified power cal offset value + prior iteration

corr value actual power corr value.

The "actual" value in this equation is returned with SOUR:POW:CORR:DATA?

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> Port number to correct for source power. If unspecified, value is set to 1.

<data> Correction Data

[src] String . (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to

return a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports that are not simple numbers, such as "Port 1 Src2". Otherwise,

the <port> argument performs the same function. If both arguments are

specified, [src] takes priority.

Examples SOURce1:POWer2:CORRection:DATA:PRIor 0.12, -0.34, 0.56

Query Syntax SOURce<ch>:POWer<port>:CORRection:DATA:PRIor? [src]

Return Type Depends on FORMat:DATA command

Default Not Applicable

SOURce<ch>:POWer<port>:CORRection:LEVel[:AMPLitude] <num>[,src]
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Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) Specifies the power level that is expected at the desired reference plane (DUT input or

output). This is not used for segment sweep with independent power levels or power sweeps .

Note: Although this command still works, it is recommended that you specify cal power by setting the

test port power and offset value.

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> Port number to correct for source power. If unspecified, value is set to 1.

<num> Cal power level in dBm. Because this could potentially be at the output of a

device-under-test, no limits are placed on this value here. It is realistically

limited by the specifications of the device (power sensor) that will be used for

measuring the power. The power delivered to the VNA receiver must never

exceed VNA specifications for the receiver!

[src] String . (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to

return a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports that are not simple numbers, such as "Port 1 Src2". Otherwise,

the <port> argument performs the same function. If both arguments are

specified, [src] takes priority.

Examples SOUR:POW:CORR:LEV 10
source1:power2:correction:level:amplitude 0 dbm

Query Syntax SOURce:POWer:CORRection:LEVel[:AMPLitude]? [src]

Return Type Numeric

Default 0 dBm

SOURce<ch>:POWer<port>:CORRection:OFFSet[:MAGNitude] <num>[,src]
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Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write)  Sets or returns a power level offset from the VNA test port power. This can be a gain or

loss value (in dB) to account for components you connect between the source and the reference plane

of your measurement. For example, specify 10 dB to account for a 10 dB amplifier at the input of your

DUT.

Cal power is the sum of the test port power setting and this offset value. Following the calibration, the

VNA power readouts are adjusted to the cal power.

Parameters  

<ch> Channel number of the source power cal. If unspecified, value is set to 1

<port> Port number to correct for source power. If unspecified, value is set to 1.

<num> Gain or loss value in dB. Choose a value between -200 and 200

[src] String . (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to

return a list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports that are not simple numbers, such as "Port 1 Src2". Otherwise,

the <port> argument performs the same function. If both arguments are

specified, [src] takes priority.

Examples SOUR:POW:CORR:OFFS 10
source1:power2:correction:offset:magnitude -3

Query Syntax SOURce:POWer:CORRection:OFFSet[:MAGNitude]? [src]

Return Type Numeric

Default 0 dB

SOURce<ch>:POWer<port>:CORRection[:STATe] <bool>[,src]
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Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write) Enables and disables source power correction for the specified port on

the specified channel.

Parameters  

<ch> Channel number of the source power cal. If unspecified, value

is set to 1

<port> Port number to correct for source power. If unspecified, value

is set to 1.

<bool> ON (or 1) turns source power correction ON.

OFF (or 0) - turns source power correction OFF.

[src] String . (NOT case sensitive). Source port. Optional. Use

SOUR:CAT? to return a list of valid port names.

While this argument can be used to make settings for ALL

ports, it is designed to access ports that are not simple

numbers, such as "Port 1 Src2". Otherwise, the <port>

argument performs the same function. If both arguments are

specified, [src] takes priority.

Examples SOUR:POW:CORR ON
source1:power2:correction:state off, "MXG N5183A"

Query Syntax SOURce:POWer:CORRection[:STATe]? "MXG N5183A"

Return Type Boolean (1 = ON, 0 = OFF)

Default OFF (0)
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Status Register Commands

The status registers enable you to query the state of selected events that occur in the analyzer.

Note: This documentation requires familiarity with the "Standard Status Data Structure - Register

Model" as defined in IEEE Std 488.2-1992.  Also, first read Learn about Status Registers

STATus:

    OPERation

        | AVERaging

        | DEFine

                | USER

        | DEVice

    PRESet

    QUEStionable

        | DEFine
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                | USER

        | INTegrity

                | HARDware

                | MEASurement

        | LIMit

        | LSUMmary

                | BLIMit

                | LIMit

                | RLIMit

    Standard Events

    Status Byte

 

Click on a red keyword to view the command details.

See Also

Example Programs

Learn about Status Registers

Synchronizing the Analyzer and Controller

SCPI Command Tree

Notes:

Any bit not shown in the registers is not used but may be reserved for future use.

The SCPIStringParser can NOT be used with SCPI Status Reporting. However, the *OPC? will work.
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STATus:OPERation<keyword>

Applicable Models: All

Summarizes conditions in the Averaging and Operation:Define:User<1|2|3> event registers.

<keyword> Example

:CONDition? STAT:OPER:COND?

:ENABle <bits> STAT:OPER:ENAB 1024

[:EVENt]? STAT:OPER?

:NTRansition <bits> STAT:OPER:NTR 1024

:PTRansition <bits> STAT:OPER:PTR 0

Bit Weight Description Bit is set to 1 when the following conditions exist:

8 256 Averaging

summary

either enabled bit in the Averaging summary event register is set

to 1

9 512 User Defined

summary

 

10 1024 Device

summary

either enabled bit in the Device summary event register is set to

1

STATus:OPERation:AVERaging<n> <keyword>

 Applicable Models: All

Monitors and summarizes the status of Averaging on traces 1 to 580. When averaging for a trace is

complete, the representative bit is set to 1.

Bit 0 is used to summarize the status in the registers that follow. For example, Average Register 3, bit
0, summarizes the status from registers 4 through 42.

All enable bits are set to 1 by default.

To find the measurement number, use Calc:Par:Mnum.

<n> Averaging Register. Choose from 1 to 42

<keyword> Example

:CONDition? STAT:OPER:AVER1:COND?

:ENABle <bits> STAT:OPER:AVER1:ENAB 1024
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[:EVENt]? STAT:OPER:AVER1?

:NTRansition <bits> STAT:OPER:AVER1:NTR 1024

:PTRansition <bits> STAT:OPER:AVER1:PTR 0

    Averaging Register <n>  

Bit Weight 1 2 3 4 5 6 7 8 ... 41 42 Bit is set to 1 when the

following conditions exist:

0 1 2-

42

3-

42

4-

42

5-

42

6-

42

7-

42

8-

42

9-

42

... 42 -- Summary Bit - If any bit

from that register fails, it

propagates to the previous

register, bit 0.

    Trace Numbers  

1 2 1 15 29 43 57 71 85 99 ... 561 575 Averaging on this trace is

complete

2 4 2 16 30 44 58 72 86 100 ... 562 576 Averaging on this trace is

complete

3 8 3 17 31 45 59 73 87 101 ... 563 577 Averaging on this trace is

complete

4 16 4 18 32 46 60 74 88 102 ... 564 578 Averaging on this trace is

complete

5 32 5 19 33 47 61 75 89 103 ... 565 579 Averaging on this trace is

complete

6 64 6 20 34 48 62 76 90 104 ... 566 580 Averaging on this trace is

complete

7 128 7 21 35 49 63 77 91 105 ... 567 -- Averaging on this trace is
complete

8 256 8 22 36 50 64 78 92 106 ... 568 -- Averaging on this trace is

complete

9 512 9 23 37 51 65 79 93 107 ... 569 -- Averaging on this trace is

complete

10 1024 10 24 38 52 66 80 94 108 ... 570 -- Averaging on this trace is

complete

11 2048 11 25 39 53 67 81 95 109 ... 571 -- Averaging on this trace is

complete
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12 4096 12 26 40 54 68 82 96 110 ... 572 -- Averaging on this trace is

complete

13 8192 13 27 41 55 69 83 97 111 ... 573 -- Averaging on this trace is

complete

14 16384 14 28 42 56 70 84 98 112 ... 574 -- Averaging on this trace is

complete

To determine Register, Bit number, and Weight for trace numbers between 113 and 560 (not shown in

the above table) use the following calculations.

The averaging status for trace numbers higher than 580 can NOT be tracked.

The following example calculates the Register, Bit number, and Bit Weight for trace # 400:

To determine Register number, use ((Trace # - 1) / 14) + 1.

To determine Bit Number, use the remainder +1 of the above calculation.

((400-1)/14) + 1 = Register# r+1Bit

399/14 = 28 r7

28+1= Register 29

7+1= Bit number 8

To determine Bit Weight: Use above table. For example: Bit  8 = 256

STATus:OPERation:DEFine<keyword>

Applicable Models: N522xB, N523xB, N524xB, M937xA

Summarizes conditions in the OPERation:Define:User<1|2|3> event registers.

<keyword> Example

:CONDition? STAT:OPER:DEF:COND?

:ENABle <bits> STAT:OPER:DEF:ENAB 12

[:EVENt]? STAT:OPER:DEF?

:NTRansition <bits> STAT:OPER:DEF:NTR 12

:PTRansition <bits> STAT:OPER:DEF:PTR 0
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Bit Weight Description Bit is set to 1 when the following conditions exist:

1 2 USER1 any bit in the USER1 event register is set to 1

2 4 USER2 any bit in the USER2 event register is set to 1

3 8 USER3 any bit in the USER3 event register is set to 1

STATus:OPERation:DEFine:USER<1|2|3><keyword>

Applicable Models: N522xB, N523xB, N524xB, M937xA

Monitors conditions that you define and map in any of the three OPER:DEF:USER event registers.

<keyword> Example

:CONDition? STAT:OPER:DEF:USER1:COND?

:ENABle <bits> STAT:OPER:DEF:USER1:ENAB 1024

[:EVENt]? STAT:OPER:DEF:USER1?

:MAP <bit>,<error> STAT:OPER:DEF:USER1:MAP 0,-113 'when error -113 occurs,
bit 0 in USER1 will set to 1.

:NTRansition <bits> STAT:OPER:DEF:USER1:NTR 12

:PTRansition <bits> STAT:OPER:DEF:PTR 0

Bit Weight Description Bit is set to 1 when the following conditions exist:

0 1 for user user defined

1 2 for user user defined

2 4 for user user defined

3 8 for user user defined

4 16 for user user defined

5 32 for user user defined

6 64 for user user defined

7 128 for user user defined

8 256 for user user defined

9 512 for user user defined

10 1024 for user user defined

11 2048 for user user defined
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12 4096 for user user defined

13 8192 for user user defined

14 16384 for user user defined

STATus:OPERation:DEVice<keyword>

Applicable Models: All

Summarizes conditions in the OPERation:DEVice event registers.

<keyword> Example

:CONDition? STAT:OPER:DEV:COND?

:ENABle <bits> STAT:OPER:DEV:ENAB 16

[:EVENt]? STAT:OPER:DEV?

:NTRansition <bits> STAT:OPER:DEV:NTR 16

:PTRansition <bits> STAT:OPER:DEV:PTR 0

Bit Weight Description Bit is set to 1 when the following conditions exist:

0 1 Unused  

1 2 Unused  

2 4 Unused  

3 8 Unused  

4 16 Sweep Completed When sweep is complete

5 32 Unused  

6 64 Unused  

7 128 Unused  

8 256 Unused  

9 512 Unused  

10 1024 Unused  

11 2048 Unused  

12 4096 Unused  

13 8192 Unused  

14 16384 Unused  
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STATus:PRESet

Applicable Models: All

(Write-only) Initializes all the status registers.

Example STAT:PRES

STATus:QUEStionable:<keyword>

Applicable Models: All

Summarizes conditions that monitor the quality of measurement data.

<keyword> Example

:CONDition? STAT:QUES:COND?

:ENABle
<bits>

STAT:QUES:ENAB 1024

[:EVENt]? STAT:QUES?

:NTRansition
<bits>

STAT:QUES:NTR 1024

:PTRansition
<bits>

STAT:QUES:PTR 0

Bit Weight Description Bit is set to 1 when the following conditions exist:

9 512 Integrity Reg

summary

any enabled bit in the Integrity event register is set to 1

10 1024 Limit Registers

summary

any enabled bit in the Limit event registers is set to 1

11 2048 Define Registers

summary

any enabled bit in the Define event registers is set to 1
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STATus:QUEStionable:DEFine<keyword>

Applicable Models: N522xB, N523xB, N524xB, M937xA

Summarizes conditions in the Questionable:Define:User<1|2|3> event registers.

<keyword> Example

:CONDition? STAT:QUES:DEF:COND?

:ENABle <bits> STAT:QUES:DEF:ENAB 1024

[:EVENt]? STAT:QUES:DEF?

:NTRansition <bits> STAT:QUES:DEF:NTR 1024

:PTRansition <bits> STAT:QUES:DEF:PTR 0

Bit Weight Description Bit is set to 1 when the following conditions exist:

1 2 USER1 any bit in the USER1 event register is set to 1

2 4 USER2 any bit in the USER2 event register is set to 1

3 8 USER3 any bit in the USER3 event register is set to 1

STATus:QUEStionable:DEFine:USER<1|2|3><keyword>

Applicable Models: N522xB, N523xB, N524xB, M937xA

Monitors conditions that you define and map in any of the three QUES:DEF:USER event registers.

<keyword> Example

:CONDition? STAT:QUES:DEF:USER1:COND?

:ENABle <bits> STAT:QUES:DEF:USER1:ENABle 1024

[:EVENt]? STAT:QUES:DEF:USER1?

:MAP <bit>,<error> STAT:QUES:DEF:USER1:MAP 0,-113 'when error -113 occurs,
bit 0 in USER1 will set to 1.

:NTRansition <bits> STAT:QUES:DEF:USER1:NTR 1024

:PTRansition <bits> STAT:QUES:DEF:USER1:PTR 0
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Bit Weight Description Bit is set to 1 when the following conditions exist:

0 1 for user user defined

1 2 for user user defined

2 4 for user user defined

3 8 for user user defined

4 16 for user user defined

5 32 for user user defined

6 64 for user user defined

7 128 for user user defined

8 256 for user user defined

9 512 for user user defined

10 1024 for user user defined

11 2048 for user user defined

12 4096 for user user defined

13 8192 for user user defined

14 16384 for user user defined

STATus:QUEStionable:INTegrity <keyword>

Applicable Models: All

Summarizes conditions in the Measurement Integrity register.

<keyword> Example

:CONDition? STAT:QUES:INT:COND?

:ENABle <bits> STAT:QUES:INT:ENAB 1024

[:EVENt]? STAT:QUES:INT?

:NTRansition <bits> STAT:QUES:INT:NTR 1024

:PTRansition <bits> STAT:QUES:INT:PTR 0
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Bit Weight Description Bit is set to 1 when the following conditions exist:

0 1 Measurement

Summary

any bit in the Measurement Integrity event register is set to

1

2 4 Hardware

Summary

any bit in the Hardware event register is set to 1

STATus:QUEStionable:INTegrity:HARDware<keyword>

Applicable Models: N522xB, N523xB, N524xB, M937xA

Monitors the status of hardware failures.

<keyword> Example

:CONDition? STAT:QUES:INT:HARD:COND?

:ENABle <bits> STAT:QUES:INT:HARD:ENAB 1024

[:EVENt]? STAT:QUES:INT:HARD?

:NTRansition <bits> STAT:QUES:INT:HARD:NTR 1024

:PTRansition <bits> STAT:QUES:INT:HARD:PTR 0

Bit Weight Description Bit is set to 1 when the following conditions exist:

1 2 Phase Unlock the source has lost phaselock, possibly caused by a reference

channel open or a hardware failure.

2 4 Unleveled the source power is unleveled. This could be caused by a

source set for more power than it can deliver at the tuned

frequency. Or it could be caused by a hardware failure.

3 8 Not used N/A

4 16 EE Write Failed an attempted write to the EEPROM has failed, possibly

caused by a hardware failure.

5 32 Not used N/A

6 64 Ramp Cal Failed the analyzer was unable to calibrate the analog ramp

generator due to a possible hardware failure.

7 128 Not used N/A
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STATus:QUEStionable:INTegrity:MEASurement<n> <keyword>

Applicable Models: All

Note: This register can be used ONLY with standard S-parameter measurements.

Monitors the lag between changing a channel setting and when the data is ready to query.

When you change the channel state (start/stop freq, bandwidth, and so forth), then the questionable bit

for that channel is set. This indicates that your desired channel state does not yet match the data you

would get if querying a data trace. When the next sweep is complete (without aborting in the middle),

and the data trace matches the channel state that produced it, the bit is cleared for that channel.

<n> Measurement register number. Choose from 1 to 3

<keyword> Example

:CONDition? STAT:QUES:INT:MEAS1:COND?

:ENABle <bits> STAT:QUES:INT:MEAS2:ENAB 1024

[:EVENt]? STAT:QUES:INT:MEAS3?

:NTRansition <bits> STAT:QUES:INT:MEAS2:NTR 1024

:PTRansition <bits> STAT:QUES:INT:MEAS1:PTR 0

    Measurement Register <n>  

Bit Weight 1 2 3 Bit is set to 1 when the following conditions exist:

0 1 1 Summary

from

Meas

Reg 3

  a setting change on this channel has occurred and the

data does not yet reflect that change.

1 2 2 15 29 a setting change on this channel has occurred and the

data does not yet reflect that change.

2 4 3 16 30 a setting change on this channel has occurred and the

data does not yet reflect that change.

3 8 4 17 31 a setting change on this channel has occurred and the

data does not yet reflect that change.

4 16 5 18 32 a setting change on this channel has occurred and the

data does not yet reflect that change.

5 32 6 19   a setting change on this channel has occurred and the

data does not yet reflect that change.
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6 64 7 20   a setting change on this channel has occurred and the

data does not yet reflect that change.

7 128 8 21   a setting change on this channel has occurred and the

data does not yet reflect that change.

8 256 9 22   a setting change on this channel has occurred and the

data does not yet reflect that change.

9 512 10 23   a setting change on this channel has occurred and the

data does not yet reflect that change.

10 1024 11 24   a setting change on this channel has occurred and the

data does not yet reflect that change.

11 2048 12 25   a setting change on this channel has occurred and the

data does not yet reflect that change.

12 4096 13 26   a setting change on this channel has occurred and the

data does not yet reflect that change.

13 8192 14 27   a setting change on this channel has occurred and the

data does not yet reflect that change.

14 16384 Summary

from

Meas

Reg 2

28   a setting change on this channel has occurred and the

data does not yet reflect that change.

STATus:QUEStionable:LIMit<n> <keyword>

Applicable Models: N522xB, N523xB, N524xB, M937xA

Monitors and summarizes the status of limit line failures. When a trace fails, the representative bit is
set to 1.

Bit 0 is used to summarize failures in the registers that follow. For example, Limit Register 3, bit 0,

summarizes the failures from registers 4 through 42.

All enable bits are set to 1 by default.

To find the measurement number, use Calc:Par:Mnum

<n> Limit register: Choose from 1 to 42.

<keyword> Example

:CONDition? STAT:QUES:LIM4:COND?

:ENABle <bits> STAT:QUES:LIM1:ENAB 1024
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[:EVENt]? STAT:QUES:LIM3?

:NTRansition <bits> STAT:QUES:LIM2:NTR 1024

:NTRansition? STAT:QUES:LIM1:NTR?

:PTRansition <bits> STAT:QUES:LIM5:PTR 0

:PTRansition? STAT:QUES:LIM1:PTR?

    Limit Register <n>  

Bit Weight 1 2 3 4 5 6 7 8 ... 41 42 Bit is set to 1 when the

following conditions exist:

0 1 2-

42

3-

42

4-

42

5-

42

6-

42

7-

42

8-

42

9-

42

... 42 -- Summary Bit - If any bit

from that register fails, it

propagates to the previous

register, bit 0.

    Trace Numbers  

1 2 1 15 29 43 57 71 85 99 ... 561 575 any point on trace fails the

limit test

2 4 2 16 30 44 58 72 86 100 ... 562 576 any point on trace fails the

limit test

3 8 3 17 31 45 59 73 87 101 ... 563 577 any point on trace fails the

limit test

4 16 4 18 32 46 60 74 88 102 ... 564 578 any point on trace fails the

limit test

5 32 5 19 33 47 61 75 89 103 ... 565 579 any point on trace fails the

limit test

6 64 6 20 34 48 62 76 90 104 ... 566 580 any point on trace fails the
limit test

7 128 7 21 35 49 63 77 91 105 ... 567 -- any point on trace fails the

limit test

8 256 8 22 36 50 64 78 92 106 ... 568 -- any point on trace fails the

limit test

9 512 9 23 37 51 65 79 93 107 ... 569 -- any point on trace fails the

limit test

10 1024 10 24 38 52 66 80 94 108 ... 570 -- any point on trace fails the

limit test
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11 2048 11 25 39 53 67 81 95 109 ... 571 -- any point on trace fails the

limit test

12 4096 12 26 40 54 68 82 96 110 ... 572 -- any point on trace fails the

limit test

13 8192 13 27 41 55 69 83 97 111 ... 573 -- any point on trace fails the

limit test

14 16384 14 28 42 56 70 84 98 112 ... 574 -- any point on trace fails the

limit test

To determine Register, Bit number, and Weight for trace numbers between 113 and 560 (not shown in

the above table) use the following calculations.

The limit status for trace numbers higher than 580 can NOT be tracked.

The following example calculates the Register, Bit number, and Bit Weight for trace # 400:

To determine Limit Register number, use ((Trace # - 1) / 14) + 1.

To determine Limit Bit Number, use the remainder +1 of the above calculation.

((400-1)/14) + 1 = Register# r+1Bit

399/14 = 28 r7

28+1= Register 29

7+1= Bit number 8

To determine Limit Bit Weight: Use above table. For example: Bit  8 = 256

STATus:QUEStionable:LSUMmary:<keyword>

Applicable Models: All

Summary register of limit test, ripple test and bandwidth test. bit 0: summary bit for the limit test. bit
1: summary bit for the ripple limit test. bit 2: summary bit for the bandwidth limit test.

<keyword> Example

:CONDition? STAT:QUES:LSUM:COND?

:ENABle <bits> STAT:QUES:LSUM:ENAB 8

[:EVENt]? STAT:QUES:LSUM?

:NTRansition <bits> STAT:QUES:LSUM:NTR 8

:PTRansition <bits> STAT:QUES:LSUM:PTR 0
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STATus:QUEStionable:LSUMmary:BLIMit <n>:<keyword>

Applicable Models: All

Monitors and summarizes the status of bandwidth limit line failures. When a trace fails, the

representative bit is set to 1.

Bit 0 is used to summarize failures in the registers that follow. Refer the

STATus:QUEStionable:LSUMmary:LIMit for the trace number information.

All enable bits are set to 1 by default.

To find the measurement number, use Calc:Par:Mnum

<n> Bandwidth Limit register. Choose from 1 to 42..

<keyword> Example

:CONDition? STAT:QUES:LSUM:BLIM:COND?

:ENABle <bits> STAT:QUES:LSUM:BLIM:ENAB 1024

[:EVENt]? STAT:QUES:LSUM:BLIM?

:NTRansition <bits> STAT:QUES:LSUM:BLIM:NTR 1024

:PTRansition <bits> STAT:QUES:LSUM:BLIM:PTR 0

STATus:QUEStionable:LSUMmary:LIMit<n>: <keyword>

Applicable Models: All

Monitors and summarizes the status of limit line failures. When a trace fails, the representative bit is

set to 1.

Bit 0 is used to summarize failures in the registers that follow. For example, Limit Register 3, bit 0,

summarizes the failures from registers 4 through 42.

All enable bits are set to 1 by default.

To find the measurement number, use Calc:Par:Mnum

<n> Limit register. Choose from 1 to 42.

<keyword> Example

:CONDition? STAT:QUES:LSUM:LIM4:COND?

:ENABle <bits> STAT:QUES:LSUM:LIM1:ENAB 1024

[:EVENt]? STAT:QUES:LSUM:LIM3?
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:NTRansition <bits> STAT:QUES:LSUM:LIM2:NTR 1024

:NTRansition? STAT:QUES:LSUM:LIM1:NTR?

:PTRansition <bits> STAT:QUES:LSUM:LIM5:PTR 0

:PTRansition? STAT:QUES:LSUM:LIM1:PTR?

    Limit Register <n>  

Bit Weight 1 2 3 4 5 6 7 8 ... 41 42 Bit is set to 1 when the

following conditions exist:

0 1 2-

42

3-

42

4-

42

5-

42

6-

42

7-

42

8-

42

9-

42

... 42 -- Summary Bit - If any bit

from that register fails, it

propagates to the previous

register, bit 0.

    Trace Numbers  

1 2 1 15 29 43 57 71 85 99 ... 561 575 any point on trace fails the

limit test

2 4 2 16 30 44 58 72 86 100 ... 562 576 any point on trace fails the

limit test

3 8 3 17 31 45 59 73 87 101 ... 563 577 any point on trace fails the

limit test

4 16 4 18 32 46 60 74 88 102 ... 564 578 any point on trace fails the

limit test

5 32 5 19 33 47 61 75 89 103 ... 565 579 any point on trace fails the

limit test

6 64 6 20 34 48 62 76 90 104 ... 566 580 any point on trace fails the

limit test

7 128 7 21 35 49 63 77 91 105 ... 567 -- any point on trace fails the
limit test

8 256 8 22 36 50 64 78 92 106 ... 568 -- any point on trace fails the

limit test

9 512 9 23 37 51 65 79 93 107 ... 569 -- any point on trace fails the

limit test

10 1024 10 24 38 52 66 80 94 108 ... 570 -- any point on trace fails the

limit test

1450



11 2048 11 25 39 53 67 81 95 109 ... 571 -- any point on trace fails the

limit test

12 4096 12 26 40 54 68 82 96 110 ... 572 -- any point on trace fails the

limit test

13 8192 13 27 41 55 69 83 97 111 ... 573 -- any point on trace fails the

limit test

14 16384 14 28 42 56 70 84 98 112 ... 574 -- any point on trace fails the

limit test

To determine Register, Bit number, and Weight for trace numbers between 113 and 560 (not shown in

the above table) use the following calculations.

The limit status for trace numbers higher than 580 can NOT be tracked.

The following example calculates the Register, Bit number, and Bit Weight for trace # 400:

To determine Limit Register number, use ((Trace # - 1) / 14) + 1.

To determine Limit Bit Number, use the remainder +1 of the above calculation.

((400-1)/14) + 1 = Register# r+1Bit

399/14 = 28 r7

28+1= Register 29

7+1= Bit number 8

To determine Limit Bit Weight: Use above table. For example: Bit  8 = 256

STATus:QUEStionable:LSUMmary:RLIMit <cnum>:<keyword>

Applicable Models: All

Monitors and summarizes the status of ripple limit line failures. When a trace fails, the representative
bit is set to 1.

Bit 0 is used to summarize failures in the registers that follow. Refer the

STATus:QUEStionable:LSUMmary:LIMit for the trace number information.

All enable bits are set to 1 by default.

To find the measurement number, use Calc:Par:Mnum
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<n> Ripple limit channel status register.  Choose from 1 to 42.

<keyword> Example

:CONDition? STAT:QUES:LSUM:RLIM:COND?

:ENABle <bits> STAT:QUES:LSUM:RLIM:ENAB 1024

[:EVENt]? STAT:QUES:LSUM:RLIM?

:NTRansition <bits> STAT:QUES:LSUM:RLIM:NTR 1024

:PTRansition <bits> STAT:QUES:LSUM:RLIM:PTR 0

Standard Event Status Register

Applicable Models: All

Monitors "standard" events that occur in the analyzer. This register can only be cleared by:

a Clear Command (*CLS).

reading the Standard Enable Status Register (*ESE?).

a power-on transition. The analyzer clears the register and then records any transitions that occur, including
setting the Power On bit (7).

Commands Description

*ESE?
Reads the settings of the standard event ENABLE register.

*ESE

<bits>

Sets bits in the standard event ENABLE register. The current setting is saved in

non-volatile memory.

<bits> The sum of weighted bits in the register. Use *ESE 0 to clear the enable

register.

*ESR?
Reads and clears the EVENT settings in the Standard Event Status register.

*OPC Sets bit 0 when the overlapped command is complete. (see Understanding

Command Synchronization / OPC).

*OPC? Operation complete query - read the Operation Complete bit (0).
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Bit Weight Description Bit is set to 1 when the following conditions exist:

0 1 Operation

Complete

the two following events occur in order:

the *OPC command is sent to the analyzer1.

the analyzer completes all pending overlapped commands2.

1 NA Request

Control

Not Supported - the analyzer application is not configured to

control GPIB operation

2 4 Query Error a query error is detected indicating:

- an attempt to read data from the output queue when no data was

present OR

- data in the output queue was lost, as in an overflow

4 16 Execution

Error

an execution error is detected indicating:

- a <PROGRAM DATA> element was outside the legal range or

inconsistent with the operation of the analyzer OR

- the analyzer could not execute a valid command due to some

internal condition

5 32 Command

Error

a command error is detected indicating that the analyzer received

a command that:

did not follow proper syntax

was misspelled

was an optional command it does not implement

7 128 Power ON Power to the analyzer has been turned OFF and then ON since the

last time this register was read.
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Status Byte Register

Applicable Models: All

Summarizes the states of the other registers and monitors the VNA output queue. It also generates

service requests. The Enable register is called the Service Request Enable Register.

Commands Description

*CLS Clears ALL "event" registers and the SCPI Error / Event queue. The corresponding

ENABLE registers are unaffected.

*STB? Reads the value of the analyzer's status byte. The byte remains after being read.

*SRE? Reads the current state of the Service Request Enable Register.

*SRE <num> Sets bits in the Service Request Enable register. The current setting of the SRE

register is stored in non-volatile memory. Use *SRE 0 to clear the enable.

<num> Combined value of the weights for bits to be set.

Bit Weight Description Bit is set to 1 when the following conditions exist:

2  4 Error / Event

queue Summary

(EAV)

the Error / Event queue is not empty. To read the error

message, use SYST:ERR?

3 8 Questionable

Register Summary

any enabled bit in the questionable event status register is

set to 1

4 16 Message Available the output queue is not empty

5 32 Standard Event

Register Summary

any enabled bit in the standard event status register is set to

1

6 64 Request Service any of the other bits in the status byte register is set to 1

(used to alert the controller of a service request within the

analyzer). This bit cannot be disabled.

7 128 Operation Register

Summary

any enabled bit in the standard operation event status

register is set to 1
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System Commands

Controls and queries settings that affect the VNA system.

SYSTem:

ABORt:THReshold

ACTive

       | CHANnel

       | MEASurement

                | NUMBer?

       | SHEet?

BEEPer

       | COMPlete:IMMediate

       | STATe

       | VOLume

       | WARNing:IMMediate

CAL:ALL  More commands

CAL:PHASe  More commands
CAPability More commands

CHANnels

       | CATalog?

       | COUPle[:STATe]

       | COUPle:GROup

       | COUPle:PARallel[:ENABle]

       | COUPle:PARallel:STATe?

       | NOISe:PARallel[:ENABle]

       | NOISe:PARallel:GROup

       | NOISe:PARallel:GROup:LIST

       | NOISe:PARallel:STATe?
       | DELete

       | HOLD

       | RESume

       | SINGle

       | SINGle:COMBine
CLOCk[:STATe]

COMMunicate   More commands

CONFigure

       | DIRectory

       | MWAVe   More commands

       | REVision

   | CPU?

   | DSP?

   | DSPFpga?

CONFiguration:EDEVice More commands
CORRection
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       | INTerpolate:LINear More commands
       | WIZard[:IMMediate ]

DATE?

DISK:REVision?

ERRor?

       | COUNt?

       | REPort

   | SUNLeveled

FCORrection:CHANnel:COUPler[:STATe]
FIFO  More commands

FPReset

ISPControl

       | [:STATe]

MACRO:COPY

       | CHANnel[:TO]

    | SOURce

MCLass

       | CATalog?

       | PARameter:CATalog?

MEASure

       | CATalog?

       | NAME?

       | TRACe?

       | WINDow?

PERSona

       | MANufacturer

               | DEFault

       | MODel

               | DEFault

POFF

POWer:

      | LIMit

    | LOCK

    | STATe

PREFerences More commands

PRESet

SECurity

       | [LEVel]

SET

SHEets:CATalog?

SHORtcut

       | ARGuments

       | DELete

       | EXECute

       | PATH

       | TITLe

TIME?
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TOUChscreen[:STATe]

UPReset

       | FPANel[:STATe]

       | LOAD[:FILE]

       |
WINDows

       | CATalog?

Click on a red keyword to view the command details.

S ee Also

Referring to Traces Channels Windows and Meas Using SCPI

Learn about VNA Preferences

Example Programs

Synchronizing the Analyzer and Controller

SCPI Command Tree

SYSTem:ABORt:THReshold <value>

Applicable Models: All

(Read-Write) When a VNA setting is made while a sweep is in progress, the sweep is immediately

aborted by default. This command allows you to change that behavior by specifying a time threshold.

When a setting change is made during a sweep and if the total sweep time is less than the threshold

time, then the sweep is allowed to finish instead of immediately aborting.

In general, VNA setting changes that could cause an aborted sweep are changes that affect how a

measurement is made, such as changes in stimulus conditions.

For example, with a threshold setting of 60 seconds:

Sweeps that require 60 seconds or less from start to finish will be allowed to complete if a VNA setting
change is made at any time during the sweep.

Sweeps that require MORE than 60 seconds from start to finish will be immediately aborted when a VNA
setting change is made at any time during the sweep.

Notes:

Preset clears this setting.
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Save state saves this setting.

Sweep times are estimated.

This setting affects ALL channels.

Parameters  

<value> Threshold time in seconds. Set to 0 to immediately abort a sweep when a VNA

setting is made.

Examples SYST:ABOR:THR 10

'When a setting is made during a sweep, if that sweep requires
less than 10 seconds more to complete, it will be allowed to
finish instead of aborting.

Query Syntax SYSTem:ABORt:THReshold?

Default 0 - No threshold time; all sweeps are immediately aborted.

SYSTem:ACTive:CHANnel?

Applicable Models: All

(Read-only) Returns the number of the active channel. The active channel is the channel number that

contains the active measurement. The active measurement is the trace that has a highlighted Tr# in

the Trace Status area.

If there is no active channel, 0 is returned.

Examples SYST:PRES

SYST:ACT:CHAN?

'Returns 1

Return Type Integer

Default Not Applicable

SYSTem:ACTive:MEASurement?
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Applicable Models: All

(Read-only) Returns the name of the active measurement. While looking at the VNA display, the

active measurement is the trace that has a highlighted Tr#  in the Trace Status area. Only displayed

measurements can be active.

If there is no active measurement, " " (empty string) is returned.

Examples SYST:PRES
SYST:ACT:MEAS?

'Returns "CH1_S11_1"

Return Type String

Default Not Applicable

SYSTem:ACTive:MEASurement:NUMBer? <mnum>

Applicable Models: All

(Read-only) Returns the active measurement number.

Parameters  

<mnum> Measurement number for each measurement. There must be a selected

measurement on the trace. If unspecified, <mnum> is set to 1.

Examples SYST:PRES
SYST:ACT:MEAS:NUMB?

Return Type Integer

Default 1

SYSTem:ACTive:SHEet?

Applicable Models: E5080A

(Read-only) Returns the active sheet number.

Examples SYST:ACT:SHE?

'Returns "1"

Return Type String

Default 1
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SYSTem:BEEPer:COMPlete:IMMediate

Applicable Models: All

(Write-only)  This command generates a beep for the notification of the completion of an operation.

Parameters None

Examples SYST:BEEP:COMP:IMM

Query Syntax Not Applicable

Default Not Applicable

SYSTem:BEEPer:STATe <num>

Applicable Models: All

(Read-Write) Sets the beeper on or off.

Parameters  

<num> Set the beeper volume on (1) or off (0).

Examples SYST:BEEP:STAT 1

Query Syntax SYSTem:BEEPer:STAT?

Default 0

SYSTem:BEEPer:VOLume <num>

Applicable Models: N522xB, N523xB, N524xB, M937xA, M9485A

(Read-Write) Sets and reads the volume of the internal speaker.

Parameters  

<num> Relative volume of the internal speaker.

Choose a volume between 0 (off) and 100.

Examples SYST:BEEP:VOL 5

system:beeper:volume

Query Syntax SYSTem:BEEPer:VOLume?

Default 0

SYSTem:BEEPer:WARNing:IMMediate
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Applicable Models: All

(Write-only)  This command generates a beep for the notification of warning/limit test results.

Parameters None

Examples SYST:BEEP:WARN:IMM

Query Syntax Not Applicable

Default Not Applicable

SYSTem:CHANnels:CATalog?

Applicable Models: All

(Read-only) Returns the channel numbers currently in use.

Examples SYST:CHAN:CAT?

system:channels:catalog?

'Returns:

"1,2,3"

Return Type String of comma-separated numbers

Default Not Applicable

SYSTem:CHANnels:COUPle[:STATe] <bool>
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Applicable Models: All

(Read-Write) Sets and reads the state of channel coupling. This causes the VNA to emulate Keysight

8720 channel coupling.

When set to ON, all existing S-parameter channels receive the stimulus settings of the active channel.

Subsequent changes made to any coupled channel are changed on all coupled channels.

Channels with applications such as SMC, VMC, GCA, Noise, IMD are not affected.

Coupling is primarily aimed at stimulus settings (such as start, stop, points, power) but also applies to

many trigger settings and to Cal Set pointers.

Parameters  

<bool> ON (or 1)  Channels are coupled

OFF (or 0)  Channels are NOT coupled

Examples SYST:CHAN:COUP 1

system:channels:couple:state OFF

Query Syntax SYSTem:CHANnels:COUPle[:STATe]?

Default OFF

SYSTem:CHANnels:COUPle:GROup <iarray>

Applicable Models: N522xB, N523xB, N524xB, M937xA, M9485A

(Read-Write) Sets and reads the group of channels for the mult-DUT parallel measurement.

Parameters  

<array> {<number of group>, <start channel No.>, <end channel No.>, ... }

The first item means number or groups.

Next pairs show start/end channel numbers of the group. 1 pair for 1 group.

Example:

{0}          Global coupling (default setting)

{1, 1,4}    Couples channel 1-4

{2, 1,3, 5,7} Couples channel 1-3 and 5-7 independently

1462



Examples SYST:CHAN:COUP:GRO 2,1,3,5,7

system:channels:couple:group 1,1,4

Query Syntax SYSTem:CHANnels:COUPle:GROup?

Default 0

SYSTem:CHANnels:COUPle:PARallel[:ENABle] <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA, M9485A

(Read-Write) Sets and reads the Multi DUT parallel measurement state. SYST:CHAN:COUP should

be also turned on when Multi DUT parallel measurement is performed.

Parameters  

<bool> ON (or 1)  Multi DUT parallel measurement are enabled

OFF (or 0)   Multi DUT parallel measurement are NOT enabled

Examples SYST:CHAN:COUP:PAR 1

system:channels:couple:parallel OFF

Query Syntax SYSTem:CHANnels:COUPle:PARallel[:ENABle]?

Default OFF

SYSTem:CHANnels:COUPle:PARallel:STATe? <value>

Applicable Models: N522xB, N523xB, N524xB, M937xA, M9485A

(Read Only) Gets the information if the parallel measurement is executed in the last sweep, for the

targeted channel.

Parameters  

<value> Channel number

Examples SYST:CHAN:COUP:PAR:STAT? 1

system:channels:couple:parallel:state? 2

Query Syntax SYSTem:CHANnels:COUPle:PARallel:STATe?

Default Not Applicable

SYSTem:CHANnels:NOISe:PARallel[:ENABle] <bool>
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Applicable Models: M9485A

(Read-Write) Sets and reads the Noise Figure Dual-band Parallel Measurement state.

SYST:CHAN:COUP should be also turned on when Noise Figure Dual-band Parallel Measurement is

performed. This function is supported only for M9385A which has options both 028 and 720.

Parameters  

<bool> ON (or 1)  Noise Figure Dual-band parallel measurement are enabled

OFF (or 0)   Noise Figure Dual-band parallel measurement are NOT enabled

Examples SYST:CHAN:NOIS:PAR 1

system:channels:noise:parallel OFF

Query Syntax SYSTem:CHANnels:NOISe:PARallel[:ENABle]?

Default OFF

SYSTem:CHANnels:NOISe:PARallel:GROup <iarray>

Applicable Models: M9485A

(Read-Write) Sets and reads the group of channels for the Noise Figure Dual-band Parallel

Measurement. This function is supported only for M9385A which has options both 028 and 720.

Parameters  

<iarray> <num of groups>, <first channel of group #1>, <second channel of group

#1>,<first channel of group #2>, <second channel of group #2>, … ,<first

channel of group #n>, <second  channel of group #n>

Two consecutive channels can be assigned into one group.

Example:

{1, 1,2}     measures NF channels 1 and 2 in parallel.

{2, 3,4, 8,9}  measures NF channels 3 and  4, then 8 and 9 in parallel.

Examples SYST:CHAN:NOIS:PAR:GRO 1,1,2

system:channels:noise:parallel:group 1,1,2

Query Syntax SYSTem:CHANnels:NOISe:PARallel:GROup?

Default 0
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SYSTem:CHANnels:NOISe:PARallel:GROup:LIST <iarray>

Applicable Models: M9485A

(Read-Write) Sets and reads the group of channels for the Noise Figure Dual-band Parallel

Measurement. This command allows you to setup any two channels in one group. This function is

supported only for M9385A which has options both 028 and 720.

Parameters  

<iarray> <num of groups>,
<num of channels in group #1>, <channel>, <channel>,...
<num of channels in group #2>, <channel>, <channel>,...

Several channels can be assigned to one group

Example:

{1, 2,1,3}          measures NF channels 1 and 3 in parallel.
{2, 2,1,3, 2,5,7}    measures NF channels 1 and 3, then 5 and 7 in parallel.

Examples SYST:CHAN:NOIS:GRO:PAR:LIST 2, 3,1,3, 2,5,7

system:channels:noise:parallel:group:list 2, 2,1,3, 2,5,7

Query Syntax SYSTem:CHANnels:NOISe:PARallel:GROup:LIST?

Default 0

SYSTem:CHANnels:NOISe:PARallel:STATe? <value>

Applicable Models: M9485A

(Read Only) Gets the information if the parallel measurement is executed in the last sweep, for the

targeted channel. This function is supported only for M9385A which has options both 028 and 720.

Parameters  

<value> Channel number

Examples SYST:CHAN:NOIS:PAR:STAT? 1

system:channels:noise:parallel:state? 2

Query Syntax SYSTem:CHANnels:NOISe:PARallel:STATe?

Default Not Applicable
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SYSTem:CHANnels:DELete <value>

Applicable Models: All

(Write-only)  Deletes the specified channel.

Parameters  

<value> Channel number to delete

Examples SYST:CHAN:DEL 2

Query Syntax Not Applicable

Default Not Applicable

SYSTem:CHANnels:HOLD

Applicable Models: All

(Write-only)  Places all channels in hold mode. To place a single channel in hold mode, use

SENS:SWE:MODE .

Examples SYST:CHAN:HOLD

Query Syntax Not Applicable

Default Not Applicable

SYSTem:CHANnels:RESume

Applicable Models: All

(Write-only)  Resumes the trigger mode of all channels that was in effect before sending

SYSTem:CHANnels:HOLD (must be sent before SYST:CHAN:RESume).

Examples SYST:CHAN:RES

Query Syntax Not Applicable

Default Not Applicable

SYSTem:CHANnels:SINGle <chanNums>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only)  Sets up multiple channels for manual trigger and provides a method of triggering

multiple channels using manual trigger. There are several prerequisites for using this command:

Manual trigger mode must be used (INIT:CONT OFF)
All channels in HOLD (SENS:SWE:MODE HOLD), not just the channels being triggered
No acquisitions currently running (instrument is NOT sweeping - see ABORt:THReshold )
All specified channels must exist

If the above conditions are not met, then the command will generate an error which describes what is

at fault. If the above conditions are met, then the trigger count for the specified channels is set to 1.

Issuing an *OPC? query will indicate when the first channel is armed (ready for manual trigger). It is

not necessary to wait for *OPC? before sending INIT:IMM to trigger the first channel. After the first

channel is triggered, *OPC? will indicate when all armed channels have finished acquiring data.

Channels will be sorted by channel number, and acquire in order from lowest channel number first to

highest channel number last.

Parameters  

<chanNums> Existing comma separated list of channel numbers.

Examples SYST:CHAN:SING 1,3,4

System:channels:single 1,3,4

Query Syntax Not Applicable

Default Not Applicable

SYSTem:CHANnels:SINGle:COMBine <chanNums>

Applicable Models: M937xA

(Write-only)  Sets the trigger count on the list of channels to ONE, and then combines the channels
into a single efficient acquisition. The index line stays high during the entire acquisition.

Parameters  

<chanNums> Existing comma separated list of channel numbers to combine.

Examples SYST:CHAN:SING:COMB 1,3,4

System:channels:single:combine 1,3,4

Query Syntax Not Applicable

Default Not Applicable
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SYSTem:CLOCk[:STATe] <bool>

Applicable Models: All

(Read-Write) Sets and reads the clock visibility state in the VNA status bar.

Parameters  

<bool> ON (or 1)  Clock is visible in the VNA status bar.

OFF (or 0)  Clock is NOT visible in the VNA status bar.

Examples SYST:CLOC 1

system:clock:state OFF

Query Syntax SYSTem:CLOCk[:STATe]?

Default ON

SYSTem:CONFigure <model>,<address>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Restarts as an "N-port" VNA using the specified multiport test set.

Learn more about VNA Multiport capability.

See other commands to configure multiport test sets.

Parameters  

<model> String - Model of the test set with which to restart.

Use "Native" to restart without a test set.

To see a list of supported test sets, use SENS:MULT:CAT?

<address> Numeric - GPIB Address of the test set. Ignored when model = "Native".

Examples SYST:CONF "NATIVE",0

system:configure "N44xx",18

Query Syntax Not Applicable

Default Not Applicable

SYSTem:CONFigure:DIRectory? <char>
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Applicable Models: All

(Read-only) Returns the directory path location for the specified file type.

Parameters None

<char> Type of file. Choose from:

STATe - This is the location for the storage of state files.

APPLication - This is the location of the VNA firmware executable files.

SUPPort - This is the location of private support files for the VNA firmware.

See these file locations.

Example SYST:CONF:DIR? SUPP

Return Type String

Default Not applicable

SYSTem:CONFigure:REVision:CPU?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns a number that corresponds to the VNA CPU speed that is visible in the Help,

About Network Analyzer dialog box. Learn more.

Use the following table to learn the clock speed using the returned value.

Reported CPU version  - Clock speed

1.0 - 266 MHz

2.0 - 500 MHz

3.0 - 1100 MHz

4.0 - 1600 MHz

5.0 - 2000 MHz

6.0 - 2000 MHz dual core.

7.0 - 2200 MHz dual core.

Parameters None
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Example SYST:CONF:REV:CPU?

Return Type String

Default Not applicable

SYSTem:CONFigure:REVision:DSP?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the DSP Revision number that is visible in the Help, About Network Analyzer

dialog box. Learn more.

Parameters None

Example SYST:CONF:REV:DSP?

Return Type String

Default Not applicable

SYSTem:CONFigure:REVision:DSPFpga?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the DSP FPGA Revision number that is visible in the Help, About Network

Analyzer dialog box. Learn more.

Parameters None

Example SYST:CONF:REV:DSPF?

Return Type String

Default Not applicable

SYSTem:CORRection:WIZard[:IMMediate] <char>
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Applicable Models: All

(Write-only) Launches either the Calibration Wizard or the Version 2 Calibration Kit File Manager

dialog box.

Remote operation returns immediately after the dialog is launched. This is done to avoid timeout

issues with I/O protocols such as VISA. Although it is possible to send commands to the VNA while

the dialog is open, this is not encouraged. Application programs should wait until the dialog is closed

before resuming remote operations.

Parameters  

<char> Choose from:

MAIN - Launches the Calibration Wizard which matches the current channel,

such as standard S-params, NoiseFigure, GCA, and so forth.

CKIT - Launches the Version 2 Calibration Kit File Manager dialog box.

Both display on the VNA screen.

Examples SYST:CORR:WIZ MAIN
system:correction:wizard:immediate ckit

Query Syntax Not Applicable

Default Not Applicable

SYSTem:DATE?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the system date.

Parameters None

Example SYST:DATE?

Return Type Comma separated numbers representing year, month, day.

Default Not applicable

SYSTem:DISK:REVision?
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Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the disk drive version. The format is S.XX.YY.ZZ.

Parameters None

Example SYST:DISK:REV?

Return Type Comma separated numbers representing year, month, day.

Default Not applicable

SYSTem:ERRor?

Applicable Models: All

(Read-only) Returns the next error in the error queue. Each time the analyzer detects an error, it places

a message in the error queue. When the SYSTEM:ERROR? query is sent, one message is moved from

the error queue to the output queue so it can be read by the controller. Error messages are delivered to

the output queue in the order they were received. The error queue is cleared when any of the following

conditions occur:

When the analyzer is switched ON.

When the *CLS command is sent to the analyzer.

When all of the errors are read.

If the error queue overflows, the last error is replaced with a "Queue Overflow" error . The

oldest errors remain in the queue and the most recent error is discarded.

See list of all SCPI Errors.

Examples SYST:ERR?
system:error?

Default Not Applicable

SYSTem:ERRor:COUNt?
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Applicable Models: All

(Read-only) Returns the number of errors in the error queue. Use SYST:ERR? to read an error.

See list of all SCPI Errors.

Examples SYST:ERR:COUN?
system:error:count?

Default Not Applicable

SYSTem:ERRor:REPort:SUNLeveled <bool>

Applicable Models: All

(Read-Write) Specifies whether or not to report Source Unleveled errors to the SCPI system error

buffer.

This setting will NOT revert to the default (OFF) setting on Instrument Preset. Use the

SYSTem:PREFerences:DEFault command to reset the preferences to their default settings.

Parameters  

<bool> ON (or 1)  Report Source Unleveled Errors. Read errors from the system error

buffer using SYST:ERR?

OFF (or 0)  Do NOT report Source Unleveled Errors.

Examples SYST:ERR:REP:SUNL 1

system:error:report:sunleveled ON

Query Syntax SYSTem:ERRor:REPort:UNLeveled?

Default OFF

SYSTem:FCORrection:CHANnel<cnum>:COUPler[:STATe] <char>
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Applicable Models: All

(Read-Write) Sets and returns the coupler state. This command is not effective for SMC class.

Parameters  

<char> Choose from:

OFF  

AUTO    

Examples SYST:FCOR:CHAN:COUP AUTO
system:fcorrection:channel1:coupler OFF

Query Syntax SYSTem:FCORrection:CHANnel<cnum>:COUPler[:STATe]?

Return Type Character

Default AUTO

SYSTem:FPReset

Applicable Models: All

(Write-only) Performs a standard Preset , then deletes the default trace, measurement, and window.

The VNA screen becomes blank.

Examples SYST:FPR
system:fpreset

Default Not applicable

SYSTem:ISPContol[:STATe] <bool>
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Applicable Models: All

(Read-Write) Sets and reads the status of the Initial Source Port Control feature (to switch the

stimulus output in the trigger hold state to a test port).  

Parameters  

<bool> ON (or 1) Source is outputted only when measurement is done .Source is not

outputted during hold state.

OFF (or 0) Source is always outputted.

Examples SYST:ISPC 1

system:ispcontrol OFF

Query Syntax SYSTem:ISPControl[:STATe]?

Default ON

SYSTem:MACRo:COPY:CHANnel<cnum>[:TO] <num>

Applicable Models: All

(Write-only) Copies ALL settings from <cnum> channel to <num> channel.  Learn more about copy

channels.

Use SENS:PATH:CONF:COPY to copy ONLY mechanical switch and attenuator settings.

Parameters  

<cnum> Channel number to copy settings from. If unspecified, value is set to 1.

<num> Channel number to copy settings to.

Examples SYST:MACR:COPY:CHAN1 2

system:macro:copy:channel2:to 3

Query Syntax Not Applicable

Default Not Applicable

SYSTem:MACRo:COPY:CHANnel<fromChannel>:STATe
<toChannel>,<toWindow>,[<copyScope>]

Applicable Models: All
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(Write-only) Copies settings only, or settings and measurements, traces, markers, and limit lines from

an existing channel, <fromChannel>, to a new channel, <toChannel>. Traces can be copied into the

Active Window, a user specified window, or a new (next available) window. .

Parameters  

<fromChannel> Channel number to copy settings from. If unspecified, value is 1.

<toChannel> 0 for next available channel, or N for channel number to copy settings to.

<toWindow> -1 will create a new window, 0 will use the active window, and N will use the

specified window N. <toWindow> is ignored when <copyScope> is "stimulus"

<copyScope> must be "stimulus" which copies only settings, or "state" which copies settings,

measurements, traces, markers, and limit lines.

Examples SYST:MACR:COPY:CHAN1:STAT 2,0,"stimulus"

Copies only settings from channel #1 to channel #2. This is
equivalent to SYST:MACR:COPY:CHAN1 2

 

SYST:MACR:COPY:CHAN1:STAT 2,-1,"state"

Copies settings, measurements, traces, etc. from channel #1 to
channel #2. Traces are placed into a new window (next available
window), and additional windows will be created as necessary so
that all traces are copied.

 

SYST:MACR:COPY:CHAN1:STAT 0,-1

Copies settings, measurements, etc. from channel #1 to the next
available channel and places traces into the next avaialble new
window.

Query Syntax Not Applicable

Default Not Applicable

 

SYSTem:MACRo:COPY:CHANnel<fromChan>:SOURce <fromPort>,<toChan>,<toPort>
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Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Write-only) Copies and applies an existing Source Power Calibration to another channel. Learn more

about source power calibration .

Parameters  

<fromChan> Channel number of the existing source power correction.

<fromPort> Port number of the existing source power correction.

<toChan> Channel number to which the source power correction will be copied.

<toPort> Port number to which the source power correction will be applied.

Examples SYST:MACR:COPY:CHAN1:SOUR 1,2,1

system:macro:copy:channel2:source 2,1,2

Query Syntax Not Applicable

Default Not Applicable

SYSTem:MCLass:CATalog?

Applicable Models: All

(Read-only) Returns measurement classes available on the VNA. Learn more about Measurement

Classes .

Parameters None

Examples SYST:MCLass:CAT?

Return Type String of comma-separated measurement class names. See the complete list of

measurement class names .

Default Not Applicable

SYSTem:MCLass:PARameter:CATalog? <name>
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Applicable Models: All

(Read-only) Returns ALL parameters that are supported by the specified measurement class.

Parameters  

<name> String. Measurement Class name. See the complete list of measurement class names .

Examples 'Returns all parameters for Gain Compression.

SYST:MCL:PAR:CAT? "Gain Compression"

Return:

"S11,S12,S13,S14,S21,S22,S23,S24,S31,S32,S33,S34,S41,S42,S43,S44,A,B,C,D,R,R1,R2,R3,R4"

Return

Type

String of comma-separated parameters

Default Not Applicable

SYSTem:MEASurement:CATalog? [chan]

Applicable Models: All

(Read-only) Returns ALL measurement numbers, or measurement numbers from a specified channel.

Parameters  

[chan] Optional. Channel number to catalog. If not specified, all measurement

numbers are returned.

Examples 'Returns all measurement numbers

SYST:MEAS:CAT?

'Returns the measurement numbers on channel 2

system:measurement:catalog? 2

Return Type String of comma-separated numbers

For example: "1,2"

Default Not Applicable

SYSTem:MEASurement<n>:NAME?
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Applicable Models: All

(Read-only) Returns the name of the specified measurement.

Parameters  

<n> Measurement number for which to return the measurement name. If

unspecified, value is set to 1.

Examples 'Returns the name of measurement 2

SYST:MEAS2:NAME?

Return Type String

Default Not Applicable

SYSTem:MEASurement<n>:TRACe?

Applicable Models: All

(Read-only) Returns the trace number of the specified measurement number. Trace numbers restart

for each window while measurement numbers are always unique.

Parameters  

<n> Measurement number for which to return the trace number.  If unspecified,

value is set to 1.

Examples 'Returns the trace number of measurement 1

SYST:MEAS1:TRAC?

Return Type Numeric

Default Not Applicable

SYSTem:MEASure<n>:WINDow?
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Applicable Models: All

(Read-only) Returns the window number of the specified measurement number.

Parameters  

<n> Measurement number for which to return the window number.  If unspecified,

value is set to 1.

Examples 'Returns the window number of measurement 2

SYST:MEAS2:WIND?

Return Type Numeric

Default Not Applicable

SYSTem:PERSona:MANufacturer <string>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) This command allows you to modify the manufacturer name returned by the

instrument’s *IDN query response. This is intended to be used for Agilent backward identity

compatibility. For example, "Agilent Technologies” or “Agilent”. However, it could be used for other

purposes such as emulation of another vendor’s instrument.

The change to the manufacturer string will not take effect until after an instrument reboot.

The manufacturer string does not allow commas in the name. If a comma is detected an error is

returned. Also, if an invalid manufacturer is detected, an error is returned.

The manufacturer string used for Keysight is “Keysight Technologies”.

Parameters  

<string> Name of the manufacturer.

Examples SYST:PERS:MAN "Keysight Technologies"

Query Syntax SYSTem:PERSona:MANufacturer?

Return Type String

Default Not Applicable

SYSTem:PERSona:MANufacturer:DEFault
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the instrument's original manufacturer identification state following the

next instrument reboot.

Parameters None

Examples SYST:PERS:MAN:DEF

Query Syntax SYSTem:PERSona:MANufacturer:DEFault?

Return Type String

Default Not Applicable

SYSTem:PERSona:MODel <string>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) This command allows you to modify the product model returned by the instrument’s

*IDN query response. This is intended to be used for model compatibility. If not specified, the default

model of the instrument is used.

The change to the model string will not take effect until after an instrument reboot.

The model string does not allow commas in the name. If a comma is detected an error is returned.

Also, if an invalid model is detected, an error is returned.

Parameters  

<string> Product model name.

Examples SYST:PERS:MOD "33220A"

Query Syntax SYSTem:PERSona:MANufacturer?

Return Type String

Default Not Applicable

SYSTem:PERSona:MODel:DEFault
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the instrument's original product model name following the next

instrument reboot.

Parameters None

Examples SYST:PERS:MOD:DEF

Query Syntax SYSTem:PERSona:MODel:DEFault?

Return Type String

Default Not Applicable

SYSTem:POFF

Applicable Models: All

(Write-only) Shuts down the system.

Parameters  

<n> Shutdown or restart. Choose from:

1 - Restart.

0 - Shutdown .

Examples 'Shuts down the system

SYST:POFF

Default 0 (Shutdown)

SYSTem:POWer<pnum>:LIMit <value>
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Applicable Models: All

(Read-Write) Sets and returns the power limit for the specified port. Learn more about Power Limit.

Parameters  

<pnum> Port number. Choose any VNA port.

<value> Power limit in dBm

Examples SYST:POW1:LIM 5

system:power2:limit 0

Query Syntax SYSTem:POWer<pnum>:LIMit?

Return Type Numeric

Default 100 dBm

SYSTem:POWer:LIMit:LOCK <bool>

Applicable Models: All

(Read-Write) Enables or disables the ability to change the power limit values through the user

interface. Learn more about Power Limit.

Parameters  

<bool> Power limit lock. Choose from:

ON or 1 - Disables the ability to change the power limit values from the user

interface.

OFF or 0 - Enables the ability to change the power limit values from the user

interface.

Examples SYST:POW:LIM:LOCK 1

system:power:limit:lock OFF

Query Syntax SYSTem:POWer:LIMit:LOCK?

Return Type Boolean

Default OFF

SYSTem:POWer<pnum>:LIMit:STATe <bool>
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Applicable Models: All

(Read-Write) Enables or disables the power limit for the specified port. Learn more about Power

Limit.

Parameters  

<pnum> Port number. Choose any VNA port.

<value> Power limit state. Choose from:

ON or 1   Enables the power limit for the port<pnum>.

OFF or 0   Disables the power limit for the port<pnum>.

Examples SYST:POW1:LIM:STAT ON

system:power2:limit:state 0

Query Syntax SYSTem:POWer<pnum>:LIMit:STATe?

Return Type Boolean

Default OFF

SYSTem:PRESet

Applicable Models: All

(Write-only) Deletes all traces, measurements, and windows. In addition, resets the analyzer to factory

defined default settings and creates a S11 measurement named "CH1_S11_1". For a list of default

settings, see Preset .

Regardless of the state of the User Preset Enable checkbox, the SYST:PRESet command will always

preset the VNA to the factory preset settings, and SYST:UPReset will always perform a User Preset.

If the VNA display is disabled with DISP:ENAB OFF then SYST:PRES will NOT enable the display.

This command performs the same function as *RST with one exception: Syst:Preset does NOT reset

Calc:FORMAT to ASCII as does *RST.

Examples SYST:PRES
system:preset

Default Not applicable

SYSTem:SECurity[:LEVel] <char>
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Applicable Models: All

(Read-Write) Sets and returns the display of frequency information on the VNA screen and printouts.

Learn more about security level.

Parameters  

<char> Choose from:

NONE -  ALL frequency information is displayed.

LOW - NO frequency information is displayed. Frequency information can be

redisplayed using the Security Setting dialog box or this command.

HIGH - LOW setting plus GPIB console is disabled. Frequency information

can be redisplayed ONLY by performing a Preset, recalling an instrument state

with None or Low security settings, or using this command.

EXTRa - HIGH setting plus:

ASCII data saving is disabled. Same method to redisplay frequency information as
HIGH setting.

Mixer setup files (*.mxr) can NOT be saved.

Examples SYST:SEC LOW
system:security:level high

Query Syntax SYSTem:SECurity[:LEVel]?

Return Type Character

Default None

SYSTem:SET <block>
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Applicable Models: All

(Read-Write) Sends a definite-length binary block Instrument state and sets the VNA with those

settings. This command does the same as saving a *.sta file to the VNA (MMEM:STOR STATE ) and

then MMEM:TRAN to transfer the file to the computer.

Parameters  

<block> The  Instrument state file as definite-length arbitrary binary block.  

Examples SYST:SET <block>

Query Syntax SYSTem:SET?  (This saves the instrument state file to the remote computer.)

Return Type Definite-length arbitrary binary block.

Default Not Applicable

SYSTem:SHEets:CATalog?

Applicable Models: N522xB, N523xB, N524xB, E5080A, M937xA

(Read-only) Returns comma separated list of visible sheets.

Parameters  

Examples SYST:SHE:CAT?

'Returns:

"1,2,3"

Return Type String of comma-separated numbers

Default 1

SYSTem:SHORtcut<n>:ARGuments<string>
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Applicable Models: N522xB, N523xB, N524xB, M937xA, M9485A

(Read-Write) Reads and writes the arguments for the specified macro. On the Edit Macro Dialog , this

is called the "Macro run string parameters".

Parameters  

<n> Numeric. Number of the macro that is stored in the VNA.

To find the number of a macro, either open the Macro Setup dialog and count

the line number of the desired macro, or query the titles of all of the macros for

the desired macro title.

<string> Arguments for the specified macro.

Examples SYST:SHOR1:ARG
"http://na.support.keysight.com/pna/help/PNAWebHelp/help.htm"

Query Syntax SYSTem:SHORtcut<n>:ARGuments?

Default Not Applicable

SYSTem:SHORtcut<n>:DELete

Applicable Models: N522xB, N523xB, N524xB, M937xA, M9485A

(Write-only) Removes the specified macro from the list of macros in the VNA. Does not delete the

macro executable file.

Parameters  

<n> Numeric. Number of the macro that is stored in the VNA.

To find the number of a macro, either open the Macro Setup dialog and count

the line number of the desired macro, or query the titles of all of the macros for

the desired macro title.

Examples SYST:SHOR1:DEL

Query Syntax Not Applicable

Default Not Applicable

SYSTem:SHORtcut<n>:EXECute
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Applicable Models: N522xB, N523xB, N524xB, M937xA, M9485A

(Write-only) Executes (runs) the specified Macro (shortcut) that is stored in the VNA.

Parameters  

<n> Numeric. Number of the macro that is stored in the VNA.

To find the number of a macro, either open the Macro Setup dialog and count

the line number of the desired macro, or query the titles of all of the macros for

the desired macro title.

Examples SYST:SHOR1:EXEC

Query Syntax Not Applicable

Default Not Applicable

SYSTem:SHORtcut<n>:PATH <string>

Applicable Models: N522xB, N523xB, N524xB, M937xA, M9485A

(Read-Write) Defines a Macro (shortcut) by linking a path and file name to the Macro number. To be

executed, the executable file must be put in the VNA at the location indicated by this command.

Parameters  

<n> Numeric. Number of the macro to be stored in the analyzer. If the index

number already exists, the existing macro is replaced with the new macro.

<string> Full path, file name, and extension, of the existing macro "executable" file.

To find the number of a macro, either open the Macro Setup dialog and count

the line number of the desired macro, or query the titles of all of the macros for

the desired macro title.

Examples SYST:SHOR1:PATH "C:/Program Files/Keysight/Network
Analyzer/Documents/unguideMultiple.vbs"

Query Syntax SYSTem:SHORtcut<n>:PATH?

Default Not Applicable

SYSTem:SHORtcut<n>:TITLe<string>
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Applicable Models: N522xB, N523xB, N524xB, M937xA, M9485A

(Read-Write) Reads and writes the name of the specified macro.

Parameters  

<n> Numeric. Number of the macro that is stored in the VNA.

To find the number of a macro, either open the Macro Setup dialog and count

the line number of the desired macro, or query the titles of all of the macros for

the desired macro title.

<string> The name to be assigned to the macro.

Examples SYST:SHOR1:TITL "Guided 4-Port Cal"

Query Syntax SYSTem:SHORtcut<n>:TITLe?

Default Not Applicable

SYSTem:TIME?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the system time.

Parameters None

Example SYST:TIME?

Return Type Comma separated numbers representing hours, minutes, seconds.

Default Not applicable

SYSTem:TOUChscreen[:STATe] <bool>
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Applicable Models: N522xB, N523xB, N524xB, E5080A

(Read-Write) Enables and disables the VNA-X touchscreen.

This setting remains until changed again from the front-panel or remotely, or until the hard drive is

changed or reformatted.

Parameters  

<bool> Choose from:

ON (1) Enables the touchscreen.

OFF (0) Disables the touchscreen.

Examples SYST:TOUC 1
system:touchscreen:state OFF

Query Syntax SYSTem:TOUChscreen[:STATe]?

Return Type Boolean

Default ON when shipped from factory.

SYSTem:UPReset

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Write-only) Performs a User Preset. There must be an active User Preset state file (see Load and Save

) or an error will be returned.  Learn more about User Preset.

Regardless of the state of the User Preset Enable checkbox, the SYST:PRESet command will always

preset the VNA to the factory preset settings, and SYST:UPReset will always perform a User Preset.

Examples SYST:UPReset

system:upreset

Query Syntax Not Applicable

Default Not Applicable

SYSTem:UPReset:FPANel[:STATe] <bool>

1490



Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Read-Write)   'Checks' and 'clears' the enable box on the User Preset dialog box . This only affects

subsequent Presets from the front panel user interface.

Regardless of the state of the User Preset Enable checkbox, the SYST:PRESet command will always

preset the VNA to the factory preset settings, and SYST:UPReset will always perform a User Preset.

Parameters  

<bool> Front Panel User Preset State.  Choose from:

0 User Preset OFF

1 User Preset ON

Examples SYST:UPR:FPAN 1

system:upreset:fpanel:state 0

Query Syntax SYSTem:UPREset:FPANel[:STATe]?

Return Type Boolean

Default 0

SYSTem:UPReset:LOAD[:FILE] <file>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Write-only) Loads an existing instrument state file (.sta or .cst) to be used for User Preset.

Subsequent execution of SYSTem:UPReset will cause the VNA to assume this instrument state.

Regardless of the state of the User Preset Enable checkbox, the SYST:PRESet command will always

preset the VNA to the factory preset settings, and SYST:UPReset will always perform a User Preset.

Learn more about User Preset.

Parameters  

<file> String - Name of the file to be loaded. The default folder "C:/Program

Files/Keysight/Network Analyzer/Documents" is used if unspecified.  Change

the default folder name using MMEMory:CDIRectory .

Examples SYST:UPR:LOAD '1MHzto20GHzUserPreset.cst'

system:upreset:load:file 'C:/Documents and
Settings/Administrator/My Documents/NewUserPreset.cst'

Query Syntax Not Applicable
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Default Not Applicable

SYSTem:UPReset:SAVE[:STATe]

Applicable Models: N522xB, N523xB, N524xB, E5080A, M9485A

(Write-only) Saves the current instrument settings as UserPreset.sta.  Subsequent execution of

SYSTem:UPReset will cause the VNA to assume this instrument state.

Regardless of the state of the User Preset Enable checkbox, the SYST:PRESet command will always

preset the VNA to the factory preset settings, and SYST:UPReset will always perform a User Preset.

Learn more about User Preset.

Examples SYST:UPR:SAVE

system:upreset:save:state

Query Syntax Not Applicable

Default Not Applicable

SYSTem:WINDows:CATalog?

Applicable Models: All

(Read-only) Returns the window numbers that are currently being used.

Examples SYST:WIND:CAT?

system:windows:catalog?

Return Type String of comma-separated numbers.

For example: "1,2"

Default Not Applicable
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SYSTem:CALibrate:ALL Commands

Contains the settings to configure a "Cal All" Calibration.

Use the Guided Cal interface to perform the calibration.

SYSTem:CALibrate:ALL:

CHANnel:

     | PORTs[:SELect]

CSET:

     | CATalog?

     | PREFix

GUIDed:

     | CHANnel?

     | PORTs?

IFBW

MCLass:

     | PROPerty:

         | NAME:CATalog?

         | VALue:

             | CATalog?

             | [STATe]

PORT<n>:

     | RECeiver:ATTen

     | SOURce:POWer:

         | ATTen

         | OFFSet

         | [VALue]

RESet

SELect

 

Click on a red keyword to view the command details.

See Also

About Calibrate All Channels
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Example Programs

Guided Cal commands

Synchronizing the Analyzer and Controller

SCPI Command Tree

SYSTem:CALibrate:ALL:CHANnel<ch>:PORTs[:SELect] <value>

Applicable Models: All

(Write-Read) For each channel to be calibrated, sets and returns the ports to be calibrated.  Specify

port numbers ONLY for standard channels.  Application channels are not necessary because they have

designated input/output/LO ports.  

Parameters  

<ch> Channel number to be calibrated.

<value> Ports to be calibrated for the specified channel. Select any of the native VNA

ports (1,2,3,4).

Examples SYST:CAL:ALL:CHAN2:PORT 1,2,3

Query Syntax SYSTem:CALibrate:ALL:CHANnel<ch>:PORTs[:SELect]?

Return Type Comma-separated port numbers.

Default 1,2

SYSTem:CALibrate:ALL:CSET:CATalog?

Applicable Models: All

(Read-only) Returns the User Cal Set or cal register names that were produced by the cal all session.

Parameters None

Examples SYST:CAL:ALL:CSET:CATalog?

'returns this format:

"MyCalAll_STD_001, MyCalAll_SMC_002"

See example program

Return Type String of comma-separated Cal Set or cal register names

Default Not Applicable
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SYSTem:CALibrate:ALL:CSET:PREFix<value>

Applicable Models: All

(Write-Read) Sets and returns the prefix to be used when saving User Cal Sets that result from the Cal

All session. The Meas Class and channel number are appended to this prefix for each calibrated

channel.  Use SYST:CAL:ALL:CSET:CATalog? to read the saved cal set names.

SENS:CORR:COLL:GUID:SAVE:CSET can also be used to set the Cal Set prefix.

If a Cal Set prefix is NOT set using either command, the cal data for each channel will be saved only to cal
registers. Learn about cal registers.

Parameters  

<value> (String) User Cal Set prefix.

Examples SYST:CAL:ALL:CSET:PREFix "MyCalAll"

Query Syntax SYSTem:CALibrate:ALL:CSET:PREFix?

Return Type String

Default " " (Empty string)

SYSTem:CALibrate:ALL:GUIDed:CHANnel?

Applicable Models: All

(Read-only) Reads the channel number of the Cal All Calibration. Use this value as the <ch>

argument for the subsequent Guided:Cal commands.

Parameters None

Examples chan = SYST:CAL:ALL:GUID:CHAN?

Return Type Numeric

Default Not applicable

SYSTem:CALibrate:ALL:GUIDed:PORTs?
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Applicable Models: All

(Read-only) Returns the ports to be calibrated during the Cal All Channels calibration.  Specify

connectors and cal kits for these ports using the Guided:Cal commands.

Specify the ports to be calibrated for each channel using SYST:CAL:ALL:CHAN<ch>:PORT.

Parameters None

Examples ports = SYST:CAL:ALL:GUID:PORT?

Return Type Comma-separated list of port numbers

Default Not applicable

SYSTem:CALibrate:ALL:IFBW <value>

Applicable Models: All

(Write-Read) Sets and returns the IFBW for a Cal All calibration. Learn more about this setting.

Parameters  

<value> IF Bandwidth in Hz. The list of valid IF Bandwidths is different depending on

the VNA model. See the list of valid settings. If an invalid number is specified,

the VNA will round up to the closest valid setting.

This command supports MIN and MAX as arguments. Learn more.

Examples SYST:CAL:ALL:IFBW 10e3

Query Syntax SYSTem:CALibrate:ALL:IFBW?

Return Type Numeric

Default 1 kHz

SYSTem:CAL:ALL:MCLass:PROPerty:NAME:CATalog? [mclass]
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Applicable Models: All

(Read-only) Returns the unique, settable properties for the current cal all session.

See a list of valid properties and values for each measurement class.

Parameters  

[mclass] Optional argument. String name of the measurement class for which properties

are to be returned. See a list of valid measurement class Application names. The

measurement class must be included in the current Cal All calibration.

Examples SYST:CAL:ALL:MCL:PROP:NAME:CAT?

'with NFX app, returns:

"Noise Cal Method,Noise Tuner,AutoOrient Tuner,Tuner In,Tuner
Out,Receiver Characterization Method,ENR File,Noise Source
Connector,Noise Source CalKit"

Return Type String of comma-separated properties.

Default Not applicable

SYSTem:CAL:ALL:MCLass:PROPerty:VALue:CATalog? <prop>

Applicable Models: All

(Read-only) Returns the valid property values for a specific property name.

See a list of valid properties and values for each measurement class.

Parameters  

<prop> (String) Property name for which valid values are to be returned.

Examples SYST:CAL:ALL:MCL:PROP:VAL:CAT? "Noise Cal Method"

'with NFX app, returns:

"Scalar,Vector"

Return Type String of comma-separated values

Default Not applicable

SYSTem:CALibrate:ALL:MCLass:PROPerty:VALue[:STATe] <prop>,<value>
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Applicable Models: All

(Write-Read) Sets and returns the property value for a specific property name.

See a list of valid properties and values for each measurement class.

Parameters  

<prop> (String) Property name for which value is to be set or returned.

<value> Property value. To read a list of valid values, use
SYST:CAL:ALL:MCL:PROP:VAL:CAT?

Examples SYST:CAL:ALL:MCL:PROP:VAL "Noise Cal Method","Noise:Scalar"

SYST:CAL:ALL:MCL:PROP:VAL? "Noise Source Connector"

Query Syntax SYSTem:CALibrate:ALL:MCLass:PROPerty:VALue[:STATe]? <prop>

Return Type String

Default Varies with the property name.

SYSTem:CALibrate:ALL:PORT<n>:RECeiver:ATTen<value>[,src]

Applicable Models: All

(Write-Read) Sets and returns the Receiver Attenuator setting for a Cal All calibration.

Parameters  

<n> Receiver port number.

<value> Attenuation value in dB for a Cal All calibration. Choose a valid value for the

VNA model. See valid settings.

 [src] String. (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to return a

list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source, true mode balanced port, or one of

the Source 2 outputs on the 2-port 2-source VNA-X model such as "Port 1

Src2". Otherwise, the <port> argument performs the same function. If both

arguments are specified, [src] takes priority.

Examples SYST:CAL:ALL:PORT2:REC:ATT 10

Query Syntax SYSTem:CALibrate:ALL:PORT<n>:RECeiver:ATTen?

Return Type Numeric

Default 0
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SYSTem:CALibrate:ALL:PORT<n>:RECeiver:ATTen:REFerence<num>

Applicable Models: N522xB, N523xB, N524xB, M9485A

(Write-Read) Sets and returns the reference attenuator setting for a Cal All calibration.

Parameters  

<n> Receiver port number.

<num> Attenuation value in dB for a Cal All calibration. 0dB or 35dB.

If a number other than these is entered, the analyzer will select the next lower

valid value. For example, if 19dB is entered, then 0dB attenuation will be

selected.

Examples SYST:CAL:ALL:PORT2:REC:ATT:REF 0

Query Syntax SYSTem:CALibrate:ALL:PORT<n>:RECeiver:ATTen:REFerence?

Return Type Numeric. If querying for the standard (M9376A) port, the return value is 0

Default 35

SYSTem:CALibrate:ALL:PORT<n>:RECeiver:ATTen:TEST<num>

Applicable Models: N522xB, N523xB, N524xB, M9485A

(Write-Read) Sets and returns the test attenuator setting for a Cal All calibration.

Parameters  

<n> Receiver port number.

<num> Attenuation value in dB for a Cal All calibration. 0dB or 35dB.

If a number other than these is entered, the analyzer will select the next lower

valid value. For example, if 19dB is entered, then 0dB attenuation will be
selected.

Examples SYST:CAL:ALL:PORT2:REC:ATT:TEST 0

Query Syntax SYSTem:CALibrate:ALL:PORT<n>:RECeiver:ATTen:TEST?

Return Type Numeric. If querying for the standard (M9376A) port, the return value is 0.

Default 35
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SYSTem:CALibrate:ALL:PORT<n>:SOURce:POWer:ATTen<value>[,src]

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-Read) Sets and returns the Source Attenuator setting for the Cal All calibration.

Parameters  

<n> Source port number.

<value> Attenuation value in dB for the Cal All calibration. Choose a valid value for

the VNA model. See valid settings.

[src] String. (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to return a

list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source, true mode balanced port, or one of

the Source 2 outputs on the 2-port 2-source VNA-X model such as "Port 1

Src2". Otherwise, the <port> argument performs the same function. If both

arguments are specified, [src] takes priority.

Examples SYST:CAL:ALL:PORT2:SOUR:POW:ATT 10

Query Syntax SYSTem:CALibrate:ALL:PORT<n>:SOURce:POWer:ATTen?

Return Type Numeric

Default 0

SYSTem:CALibrate:ALL:PORT<n>:SOURce:POWer:OFFSet <value>[,src]

Applicable Models: All

(Write-Read) Sets and returns the power offset value for a Cal All calibration.

Power Offset provides a method of compensating port power for added attenuation or amplification in

the source path. The result is that power at the specified port reflects the added components.

Parameters  

<n> Source port number.

<value> Power offset value in dB for a Cal All calibration.

For amplification, use positive offset.

For attenuation, use negative offset.

[src] String. (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to return a
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list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source, true mode balanced port, or one of

the Source 2 outputs on the 2-port 2-source VNA-X model such as "Port 1

Src2". Otherwise, the <port> argument performs the same function. If both

arguments are specified, [src] takes priority.

Examples SYST:CAL:ALL:PORT2:SOUR:POW:OFFS 10

Query Syntax SYSTem:CALibrate:ALL:PORT<n>:SOURce:POWer:OFFSet?

Return Type Numeric

Default 0

SYSTem:CALibrate:ALL:PORT<n>:SOURce:POWer[:VALue] <value>[,src]

Applicable Models: All

(Write-Read) Sets and returns the power level at which a Cal All calibration is to be performed.

Parameters  

<n> Source port number.

<value> Power level at which the calibration is to be performed.

[src] String. (NOT case sensitive). Source port. Optional. Use SOUR:CAT? to return a

list of valid port names.

While this argument can be used to make settings for ALL ports, it is designed

to access ports such as an external source, true mode balanced port, or one of

the Source 2 outputs on the 2-port 2-source VNA-X model such as "Port 1

Src2". Otherwise, the <port> argument performs the same function. If both

arguments are specified, [src] takes priority.

Examples SYST:CAL:ALL:PORT2:SOUR:POW 0

Query Syntax SYSTem:CALibrate:ALL:PORT<n>:SOURce:POWer[:VALue]?

Return Type Numeric

Default Preset power of the VNA model.

See the data sheet for the power level for each model.

SYSTem:CALibrate:ALL:RESet
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Applicable Models: All

(Write-only) Resets all properties associated with the Cal All session to their default values.

Parameters None

Examples SYST:CAL:ALL:RES

Query Syntax Not Applicable

Default Not Applicable

SYSTem:CALibrate:ALL:SELect <value>

Applicable Models: All

(Write-Read) Sets and returns the list of channels to be calibrated during the Cal All session.

Parameters  

<value> Channel numbers to be calibrated. These channels must already exist.

Examples SYST:CAL:ALL:SEL 1,2,3

Query Syntax SYSTem:CALibrate:ALL:SELect?

Return Type Comma-separated channel numbers.

Default Existing channels
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System:Calibrate:Phase

Contains the settings to perform an SMC Phase Reference Calibration.

SYSTem:CALibrate:PHASe

CKIT

CONNector

DEEMbed

FREQuency:

     | STARt

     | STOP

GUIDed:

     | CHANnel?

PORT

POWer:ATTenuator

REFerence:

     | CATalog?

RESet

UNKNown:

     | INCLude

     | INPut:POWer

     | LO

          | FREQuency

          | POWer

Click on a red keyword to view the command details.

Important Notes

It is NOT necessary to create an SMC measurement before performing a remote Phase Reference Cal.
It is necessary when performed from the user interface.

Before A..09.90, port selection was made remotely by selecting connectors and Cal Kits for the ports to
be included in the SOLT calibration. With A.09.90, port selection is made explicitly with the commands in
this node.

 

See Also
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SCPI Command Tree

SYSTem:CALibrate:PHASe:CKIT <string>

Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the Cal Kit that will be used to perform the S-parameter Cal.

To read a list of valid Cal Kits, use SENSe:CORR:COLL:GUID:CKIT:CAT?

Parameters  

<string> Cal Kit.

Examples SYST:CAL:PHAS:CKIT "85052D"

Query Syntax SYSTem:CALibrate:PHASe:CKIT?

Return Type String

Default " "

SYSTem:CALibrate:PHASe:CONNector <string>

Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the connector type and gender of your Cal Kit.

To read a list of valid connector types, use SENS:CORR:COLL:GUID:CONN:CAT?

Parameters  

<string> Connector type.

Examples SYST:CAL:PHAS:CONN "APC 3.5 female"

Query Syntax SYSTem:CALibrate:PHASe:CONNector?

Return Type String

Default " "
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SYSTem:CALibrate:PHASe:DEEMbed <bool>

Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the state of de-embedding (reversing) the port 2 coupler.

Parameters  

<bool> Port 2 coupler de-embed state. Choose from:

ON (or 1) - Configures the calibration to include additional measurements to

de-embed the effects of reversing the coupler. (This is the same as clearing the

“Omit Coupler” checkbox.)

OFF (or 0) - Excludes additional measurements for de-embedding the effects

of reversing the coupler.

Examples SYST:CAL:PHAS:DEEM 1

Query Syntax SYSTem:CALibrate:PHASe:DEEMbed?

Return Type Boolean

Default ON or 1

SYSTem:CALibrate:PHASe:FREQuency:STARt <value>

Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the phase reference cal start frequency.

Parameters  

<value> Start frequency. Choose any frequency from 10 MHz to the stop frequency of

the VNA.

Examples SYST:CAL:PHAS:FREQ:STAR 17.5e6

Query Syntax SYSTem:CALibrate:PHASe:FREQuency:STARt?

Return Type Numeric

Default Start frequency of the VNA

SYSTem:CALibrate:PHASe:FREQuency:STOP <value>
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Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the phase reference cal stop frequency.

Parameters  

<value> Stop frequency. Choose any frequency within the range of the VNA.

Examples SYST:CAL:PHAS:FREQ:STOP 26.5e9

Query Syntax SYSTem:CALibrate:PHASe:FREQuency:STOP?

Return Type Numeric

Default Stop frequency of the VNA

SYSTem:CALibrate:PHASe:GUIDed:CHANnel?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Reads the channel number of the Phase Reference Calibration. Use this value as the <ch>

argument for the subsequent Guided:Cal commands.

Parameters None

Examples chan = SYST:CAL:PHAS:GUID:CHAN?

Return Type Numeric

Default Not applicable

SYSTem:CALibrate:PHASe:PORT<n> <bool>

Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the enable state for the specified port.

Parameters  

<n> Port number to enable or disable.

<bool> Port enable state. Choose from:

ON (or 1) - Enable port <n>

OFF (or 0) - Disable port <n>

Examples SYST:CAL:PHAS:PORT2 1

Query Syntax SYSTem:CALibrate:PHASe:PORT<n>?
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Return Type Boolean

Default Ports 1 and 2 are enabled.

Ports 3 and 4 (if present) are disabled

SYSTem:CALibrate:PHASe:POWer:ATTenuator <value>

Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the Source Attenuator setting for the Phase Reference calibration.

Note: This setting MUST match the source attenuator setting at the mixer input port for subsequent

SMC+Phase measurements.

Parameters  

<value> Attenuation value in dB. Choose a valid value for the VNA model. See valid
settings.

Examples SYST:CAL:PHAS:POW:ATT 10

Query Syntax SYSTem:CALibrate:PHASe:POWER:ATTenuator?

Return Type Numeric

Default 10 dB

SYSTem:CALibrate:PHASe:REFerence <string>

Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the Phase Reference ID to be used for the Phase Reference calibration.

 Use SYST:CAL:PHAS:REF:CAT? to read the phase references currently connected to the VNA
USB.

Parameters  

<string> Phase reference ID string.

Examples SYST:CAL:PHAS:REF "MYPRT0001"

Query Syntax SYSTem:CALibrate:PHASe:REFerence?

Return Type String

Default Not Applicable
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SYSTem:CALibrate:PHASe:REFerence:CATalog?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Reads the ID strings of the phase references that are currently connected to the VNA

USB.

Parameters None

Examples pRef = SYST:CAL:PHAS:REF:CAT?

Return Type Comma-separated string

Default Not Applicable

SYSTem:CALibrate:PHASe:RESet

Applicable Models: N522xB, N523xB, N524xB

(Write-only) Resets all properties associated with the Phase Reference Cal to their default values.

Parameters None

Examples SYST:CAL:ALL:PHAS:RES

Query Syntax Not Applicable

Default Not Applicable

SYSTem:CALibrate:PHASe:UNKNown:INCLude <bool>

Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the state of Unknown Mixer calibration.

Parameters  

<bool> Unknown Mixer cal state. Choose from:

ON (or 1) - Enable Unknown Mixer cal. The start frequency becomes 10 MHz

and can NOT be changed.

OFF (or 0) - Disable Unknown Mixer cal.

Examples SYST:CAL:PHAS:UNKN:INCL 1

Query Syntax SYSTem:CALibrate:PHASe:UNKNown:INCLude?

Return Type Boolean

Default OFF or 0
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SYSTem:CALibrate:PHASe:UNKNown:INPut:POWer <value>

Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the input power level to the unknown mixer.

Parameters  

<value> Input power level in dBm.

Examples SYST:CAL:PHAS:UNKN:INP:POW -5

Query Syntax SYSTem:CALibrate:PHASe:UNKNown:INPut:POWer?

Return Type Numeric

Default -15 dBm

SYSTem:CALibrate:PHASe:UNKNown:LO:FREQuency <value>

Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the LO frequency to the unknown mixer.

Parameters  

<value> LO frequency in Hz. Choose a value between 3 GHz and (Max Frequency

minus 1GHz).

For a 26.5 GHz VNA, the range is 3 GHz to 25.5 GHz.

For best results, use the default LO frequency. 3.351Ghz. This frequency

produces no spurs from the input/LO frequency. And also the Input frequency

will have no band breaks.

Examples SYST:CAL:PHAS:UNKN:LO:FREQ 3.351e9

Query Syntax SYSTem:CALibrate:PHASe:UNKNown:LO:FREQuency?

Return Type Numeric

Default 3.351 GHz

SYSTem:CALibrate:PHASe:UNKNown:LO:POWer <value>
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Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the LO power level to the unknown mixer.

Parameters  

<value> LO power level in dBm.

Examples SYST:CAL:PHAS:UNKN:LO:POW 10

Query Syntax SYSTem:CALibrate:PHASe:UNKNown:LO:POWer?

Return Type Numeric

Default 10 dBm
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SYSTem:CAPability Commands

Reads various capabilities of the analyzer.

SYSTem:CAPability:

ALC:POWer:

     | MAXimum[:LEVel]?

     | MINimum[:LEVel]?

CHANnels:MAXimum[:COUNt]?

DELay

     | TRIGger

            | MAX?

            | MIN?

FOM:EXISts?

FREQuency

     | MAXimum?

     | MINimum?

HARDware:

     | ATTenuator:RECeiver:

          | EXISts?

          | MAXimum?

          | STEP[:SIZE]?

     | ATTenuator:SOURce:

          | MAXimum?

          | STEP[:SIZE]?

     | DC:RECeiver

          | INTernal:CATalog?

          | INTernal:COUNt?

     | DC:SOURce

          | INTernal:CATalog?

          | INTernal:COUNt?

     | IF

            | MAXimum?

            | MINimum?
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     | PORTs:

          | CATalog?

          | COUNt?

          | INTernal

               | CATalog?

               | COUNt?

          | PNUMber?

          | SOURce

               | CATalog?

               | COUNt?

               | INTernal

                    | CATalog?

                    | COUNt?

     | POWer

            | DISCrete

                   | FREQuency

                         | LIST

                   | MAXimum?

                         | LIST?

                   | MINimum?

                         | LIST?

            | PATH

                   | CONFig

                         | ELEMent

                               | CATalog?

                               | [:STATe]

                               | VALue

                                     | CATalog?

            | PORT

            | RANGe

                   | FREQuency

                         | STARt

                         | STOP
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                   | MAXimum?

                   | MINimum?

            | RESet

            | TYPE

     | RBSWitch:EXISts?

     | RECeiver:

               | INTernal

                   | COUNt?

               | DACCess?

     | SOURce:COUNt?

IFBW:CATalog?

IFBW

     | MAXimum?

     | MINimum?

LICenses:

     | CATalog?

NBW:

     | NOISe:CATalog?

     | STD:CATalog?

POINts:

     | MAXimum?

     | MINimum?

PRESet:FREQuency:

     | MAXimum?

     | MINimum?

RBW:IMS:CATalog?

RBW:SA:CATalog?

WINDows

     | MAXimum[:COUNt]?

     | TRACes:MAXimum[:COUNt]?

 

Click on a red keyword to view the command details.
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SYSTem:CAPability:HARDware:POWer Commands

These commands provide access to data sheet specified and typical, max and min power
levels (in dBm). Max power refers to the maximum leveled source power at the specified port.
Min power is calculated by subtracting the power sweep range from the max leveled power.
This information is stored by frequency band in a power specification file. These commands
provide access to the file’s contents and provide an interface to configure the port number
and RF signal path of interest.

Power data is available as either the most restrictive value across a range of frequencies (when

SYST:CAP:HARD:POW:RANG:MAX and SYST:CAP:HARD:POW:RANG:MIN  are used) or for discrete CW

frequencies (when SYST:CAP:HARD:POW:DISC:MAX and SYST:CAP:HARD:POW:DISC:MIN are used).

No measurement of instrument-specific dynamic range is performed; all power levels are equivalent to

power data published in device data sheets. Power levels are valid only for measurement configurations

where the front panel jumpers are in their standard positions, as originally shipped. Internal source

attenuation and any calibrated external path loss/gain due to cables, fixtures, switches or booster

amplifiers are not included in the reported min/max leveled power values. It remains the users’

responsibility to transform the reported factory power range data to a value corresponding to the

specific calibration plane of their setups.

The power range data files contain both specified min/max leveled power values and the
corresponding “typical” values. Some paths, that are not part of the specifications of the
instrument may only have typical data. Only the “Specified” power range data is guaranteed
for an instrument with an up-to-date calibration certificate.

 

See Also

Example Programs

Synchronizing the Analyzer and Controller

SCPI Command Tree

SYSTem:CAPability:DELay:TRIGger:MAX?
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Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the maximum trigger delay of the analyzer.

Parameters None

Examples SYST:CAP:DEL:TRIG:MAX?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:DELay:TRIGger:MIN?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the minimum trigger delay of the analyzer.

Parameters None

Examples SYST:CAP:DEL:TRIG:MIN?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:ALC:POWer:MAXimum[:LEVel]? <srcNum>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the maximum leveled source power setting in dB. Learn more about leveled source
power.

Parameters  

<srcNum> Source Number. Choose from 1 or 2.

Examples SYST:CAP:ALC:POW:MAX? 1

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:ALC:POWer:MINimum[:LEVel]? <srcNum>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the minimum leveled source power setting in dB with 0 dB attenuation. Learn
more about leveled source power.

Parameters  

<srcNum> Source Number. Choose from 1 or 2.

Examples SYST:CAP:ALC:POW:MIN? 1

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:CHANnels:MAXimum[:COUNt]?

Applicable Models: All

(Read-only) Returns the maximum possible number of channels. Learn more about Channels.

Parameters None

Examples SYST:CAP:CHAN:MAX?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:FOM:EXISts?

Applicable Models: All

(Read-only) Returns whether or not the analyzer has FOM installed. Learn more.

Parameters None

Examples SYST:CAP:FOM:EXIS?

Return Type Boolean

1 - Yes, FOM is installed.

0 - No, FOM is NOT installed.

Default Not Applicable
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SYSTem:CAPability:FREQuency:MAXimum?

Applicable Models: All

(Read-only) Returns the maximum frequency of the analyzer, including any over-sweep. Over-sweep

frequencies can be set but are not specified.

Parameters None

Examples SYST:CAP:FREQ:MAX?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:FREQuency:MINimum?

Applicable Models: All

(Read-only) Returns the minimum frequency of the analyzer, including any under-sweep. Under-

sweep frequencies can be set but are not specified.

Parameters None

Examples SYST:CAP:FREQ:MIN?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:ATTenuator:RECeiver:EXISts? <portNum>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns whether or not there is a receiver attenuator on the specified port.

Parameters  

<portNum> Port number. Choose from the number of test ports on the analyzer.

Examples SYST:CAP:HARD:ATT:REC:EXIS? 2

Return Type Boolean

1 - Yes, the test port has a receiver attenuator.

0 - No, the test port does NOT have a receiver attenuator.

Default Not Applicable
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SYSTem:CAPability:HARDware:ATTenuator:RECeiver:MAXimum? <portNum>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the maximum amount of receiver attenuation on the specified port.

Parameters  

<portNum> Port number. Choose from the number of test ports on the analyzer.

Examples SYST:CAP:HARD:ATT:REC:MAX? 2

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:ATTenuator:RECeiver:STEP[:SIZE]? <portNum>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the step size of the receiver attenuator on the specified port.

Parameters  

<portNum> Port number. Choose from the number of test ports on the analyzer.

Examples SYST:CAP:HARD:ATT:REC:STEP? 2

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:ATTenuator:SOURce:MAXimum? <portNum>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the maximum amount of source attenuation on the specified port.

Parameters  

<portNum> Port number. Choose from the number of test ports on the analyzer.

Examples SYST:CAP:HARD:ATT:SOUR:MAX? 2

Return Type Numeric

Default Not Applicable
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SYSTem:CAPability:HARDware:ATTenuator:SOURce:STEP[:SIZE]? <portNum>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the step size of the source attenuator on the specified port.

Parameters  

<portNum> Port number. Choose from the number of test ports on the analyzer.

Examples SYST:CAP:HARD:ATT:SOUR:STEP? 2

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:DC:RECeiver:INTernal:CATalog?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns a list of names of the internal DC receivers.

Parameters None

Examples SYST:CAP:HARD:DC:REC:INT:CAT?

Return Type String of internal DC receivers separated by commas.

For example, "AI1,AI2,AIG,AOS1,AOS2"

Default Not Applicable

SYSTem:CAPability:HARDware:DC:RECeiver:INTernal:COUNt?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the number of internal DC receivers in the analyzer.

Parameters None

Examples SYST:CAP:HARD:DC:REC:INT:COUN?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:DC:SOURce:INTernal:CATalog?
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns a list of names of the internal DC sources.

Parameters None

Examples SYST:CAP:HARD:DC:SOUR:INT:CAT?

Return Type String of internal DC sources separated by commas.

For example, "AO1,AO2"

Default Not Applicable

SYSTem:CAPability:HARDware:DC:SOURce:INTernal:COUNt?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the number of internal DC sources in the analyzer.

Parameters None

Examples SYST:CAP:HARD:DC:SOUR:INT:COUN?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:IF:MAXimum?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the maximum IF frequency the instrument supports.

Parameters None

Examples SYST:CAP:HARD:IF:MAX?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:IF:MINimum?
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Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the minimum IF frequency the instrument supports.

Parameters None

Examples SYST:CAP:HARD:IF:MIN?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:PORTs:CATalog?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns a list of test port names including external testset ports.

Parameters None

Examples SYST:CAP:HARD:PORT:CAT?

Return Type String of port names separated by commas.

For example, "Port 1,Port 2,Port 3,Port 4".

Default Not Applicable

SYSTem:CAPability:HARDware:PORTs:COUNt?

Applicable Models:

(Read-only) Returns the number of test ports including external testset ports.

Parameters None

Examples SYST:CAP:HARD:PORT:COUN?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:PORTs:INTernal:CATalog?
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns a list of internal test port names.

Parameters None

Examples SYST:CAP:HARD:PORT:INT:CAT?

Return Type String of port names separated by commas.

For example, "Port 1,Port 2,Port 3,Port 4".

Default Not Applicable

SYSTem:CAPability:HARDware:PORTs:INTernal:COUNt?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the number of internal test ports.

Parameters None

Examples SYST:CAP:HARD:PORT:INT:COUN?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:PORTs:PNUMber? <portName>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the port number associated with the specified port name.

Parameters None

<portName> String. Port name. Use SYST:CAP:HARD:PORT:CAT? to return a list of valid port

names.

Examples SYST:CAP:HARD:PORT:PNUM? "Port 1"

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:PORTs:SOURce:CATalog?
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns a list of source port names, including any configured external sources.

Parameters None

Examples SYST:CAP:HARD:PORT:SOUR:CAT?

Return Type String of source port names separated by commas.

For example, "Port 1,Port 2,Port 3,Port 4, Port 1 Src 2".

Default Not Applicable

SYSTem:CAPability:HARDware:PORTs:SOURce:COUNt?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the number of source ports, including any configured external sources.

Parameters None

Examples SYST:CAP:HARD:PORT:SOUR:COUN?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:PORTs:SOURce:INTernal:CATalog?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns a list of internal source port names.

Parameters None

Examples SYST:CAP:HARD:PORT:SOUR:INT:CAT?

Return Type String of internal source port names separated by commas.

For example, "Port 1,Port 2,Port 3,Port 4, Port 1 Src 2"

Default Not Applicable

SYSTem:CAPability:HARDware:PORTs:SOURce:INTernal:COUNt?
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the number of internal source ports.

Parameters None

Examples SYST:CAP:HARD:PORT:SOUR:INT:COUN?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:POWer:DISCrete:FREQuency:LIST <freqList>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets or returns the list of discrete frequencies corresponding to the powers returned by

the discrete min and max power list functions.

Parameters  

<freqList> List of frequencies for which power is returned.

Examples SYST:CAP:HARD:POW:DISC:FREQ:LIST 1e9,2e9,3e9,4e9

system:capability:hardware:power:discrete:frequency:list
10e6,100e6,1e9,10e9

Query Syntax SYSTem:CAPability:HARDware:POWer:DISCrete:FREQuency:LIST?

Return Type Array

Default Not Applicable

SYSTem:CAPability:HARDware:POWer:DISCrete:MAXimum?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns a single max leveled power value (in dBm) indicating the most restrictive

maximum for all discrete maximum powers (the minimum of all max leveled powers).

Parameters None

Examples SYST:CAP:HARD:POW:DISC:MAX?

System:capability:hardware:power:discrete:maximum?

Return Type Double

Default Not Applicable
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SYSTem:CAPability:HARDware:POWer:DISCrete:MAXimum:LIST?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns an array of max leveled power values (in dBm), where each element corresponds

to the maximum leveled power possible for CW stimulus at the corresponding frequency set by the

SYSTem:CAPability:HARDware:POWer:DISCrete:FREQuency:LIST command.

Parameters None

Examples SYST:CAP:HARD:POW:DISC:MAX:LIST?

system:capability:hardware:power:discrete:maximum:list?

Return Type Array

Default Not Applicable

SYSTem:CAPability:HARDware:POWer:DISCrete:MINimum?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns a single minimum power value (in dBm) indicating the most restrictive

minimum for all discrete minimum powers (the maximum of all minimum powers).

Parameters None

Examples SYST:CAP:HARD:POW:DISC:MIN?

system:capability:hardware:power:discrete:minimum?

Return Type Double

Default Not Applicable

SYSTem:CAPability:HARDware:POWer:DISCrete:MINimum:LIST?
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Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns an array of minimum power values (in dBm), where each element corresponds to

the minimum power possible for CW stimulus at the corresponding frequency set by the

SYSTem:CAPability:HARDware:POWer:DISCrete:FREQuency:LIST command.

Parameters None

Examples SYST:CAP:HARD:POW:DISC:MIN:LIST?

System:capability:hardware:power:discrete:minimum:list?

Return Type Array

Default Not Applicable

SYSTem:CAPability:HARDware:POWer:PATH:CONFig:ELEMent:CATalog?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns a string with the names of all valid RF path configuration elements.

Parameters None

Examples SYST:CAP:HARD:POW:PATH:CONF:ELEM:CAT?

syst:capability:hardware:power:path:conf:element:catalog?

Return Type String

Default Not Applicable

SYSTem:CAPability:HARDware:POWer:PATH:CONFig:ELEMent[:STATe]
<element>,<setting>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Returns the name of the value for the given path element name or sets the value of a

path element.

Parameters  

<element> String - Choose from all path elements listed with

SYST:CAP:HARD:POW:PATH:CONF:ELEM:CAT?.

<setting> String - Choose from all element settings listed with

SYST:CAP:HARD:POW:PATH:CONF:ELEM:VAL:CAT?.

Examples SYST:CAP:HARD:POW:PATH:CONF:ELEM “Src1Out1LowBand”,“HiPwr”

SYST:CAP:HARD:POW:PATH:CONF:ELEM:STAT “Port1Bypass”,“Thru”

Query Syntax SYSTem:CAPability:HARDware:POWer:PATH:CONFig:ELEMent:STATe?

“Src2Out1LowBand”

Returns the setting for the specified element.

Return Type String

Default Not Applicable

SYSTem:CAPability:HARDware:POWer:PATH:CONFig:ELEMent:VALue:CATalog?
<PathElementName>

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns all valid values for the given path configuration element.

Parameters  

<PathElementName> (String) Chose from all path elements (see PATH:CONF:ELEM:CAT?)

Examples SYST:CAP:HARD:POW:PATH:CONF:ELEM:VAL:CAT?

syst:capability:hardware:power:path:conf:element:value:catalog?

Return Type String

Default Not Applicable

SYSTem:CAPability:HARDware:POWer:PORT <portNum>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and reads the port number for power range data. When two sources are available in

combiner mode, refer to the portNum selections below.

Parameters  

<portNum> Port number. Choose from:

1 - Port 1.

2 - Port 2.

3 - Port 3 (4-port instrument) or Src2-Out1 (2-port instrument with option 224).

4 - Port 4 (4-port instrument) or Src2-Out2 (2-port instrument with option 423).

5 - Src2Out1LowBand (2-port with option 224 or 4-port with option 423).

Examples SYST:CAP:HARD:POW:PORT 1

Query Syntax SYSTem:CAPability:HARDware:POWer:PORT?

Return Type Integer

Default Not Applicable

SYSTem:CAPability:HARDware:POWer:RANGe:FREQuency:STARt <num>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets or returns the lower bound of the frequency range used for range based power min

and max.

Parameters  

<num> Start frequency. Choose a number within the frequency limits of the analyzer.

Units are Hz.

Examples SYST:CAP:HARD:POW:RANG:FREQ:STAR 1e9

system:capability:hardware:power:range:frequency:start 1e9

Query Syntax SYSTem:CAPability:HARDware:POWer:RANGe:FREQuency:STARt?

Return Type Double

Default Not Applicable
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SYSTem:CAPability:HARDware:POWer:RANGe:FREQuency:STOP <num>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets or returns the upper bound of the frequency range used for range based power min

and max.

Parameters  

<num> Stop frequency. Choose a number within the frequency limits of the analyzer.

Units are Hz.

Examples SYST:CAP:HARD:POW:RANG:FREQ:STOP 2e9

Query Syntax SYST:CAP:HARD:POW:RANG:FREQ:STOP?

Return Type Double

Default Not Applicable

SYSTem:CAPability:HARDware:POWer:RANGe:MAXimum?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the minimum of all max leveled power values (in dBm) from range start

frequency to stop frequency (inclusive).

Parameters None

Examples SYST:CAP:HARD:POW:RANG:MAX?

Return Type Double

Default Not Applicable

SYSTem:CAPability:HARDware:POWer:RANGe:MINimum?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) The maximum of all min power values (in dBm) from range start frequency to stop
frequency (inclusive).

Parameters  

Examples SYST:CAP:HARD:POW:RANG:MIN?

Return Type Double

Default Not Applicable
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SYSTem:CAPability:HARDware:POWer:RESet

Applicable Models: N522xB, N523xB, N524xB

(Write-only) Resets all power range properties to default values, as if the instrument had been preset.

Power range type is set to SPECified, port number is set to 1 with all path configuration elements in

their default states.

Parameters None

Examples SYST:CAP:HARD:POW:RES

system:capability:hardware:power:reset

Default Not Applicable

SYSTem:CAPability:HARDware:POWer:TYPE <enum>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and reads the type of power range data (specified or typical) to be returned.

Parameters  

<enum> Choose from:

SPECified - Warranted performance.

TYPical - Typical performance.

Examples SYST:CAP:HARD:POW:TYPE SPEC

system:capability:hardware:power:type typical

Query Syntax SYSTem:CAPability:HARDware:POWer:TYPE?

Return Type Enumeration

Default SPECified

SYSTem:CAPability:HARDware:RBSWitch:EXISts? <portNum>

1530



Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns whether or not the specified port number has a reference bypass switch.

Parameters  

<portNum> Port number. Choose from the number of test ports on the analyzer.

Examples SYST:CAP:HARD:RBSW:EXIS? 2

Return Type Boolean

1 - Yes, the test port has a reference bypass switch.

0 - No, the test port does NOT have a reference bypass switch.

Default Not Applicable

SYSTem:CAPability:HARDware:RECeiver:INTernal:COUNt?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the number of receivers in the analyzer.

Parameters None

Examples SYST:CAP:HARD:REC:INT:COUN?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:RECeiver:DACCess?
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Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns whether or not the analyzer has direct receiver access (front-panel jumpers).

Parameters None

<bool> Choose from:

1 - Yes, the analyzer has direct receiver access.

0 - No, the analyzer does NOT have direct receiver access.

Examples SYST:CAP:HARD:REC:DACC?

Return Type Boolean

Default Not Applicable

SYSTem:CAPability:HARDware:SOURce:COUNt?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the number of sources in the analyzer.

Parameters None

Examples SYST:CAP:HARD:SOUR:COUN?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:IFBW:CATalog?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the list of supported IFBW values.

Parameters None

Examples SYST:CAP:IFBW:CAT?

Return Type Variant array of string values

Default Not Applicable

SYSTem:CAPability:IFBW:MAXimum?
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Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the maximum IFBW for the standard IF filter.

Parameters None

Examples SYST:CAP:IFBW:MAX?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:IFBW:MINimum?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the minimum IFBW for the standard IF filter.

Parameters None

Examples SYST:CAP:IFBW:MIN?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:LICenses:CATalog? <selection>

Applicable Models: All

(Read-only) Returns the list of licenses. See a list of common licenses.

Parameters  

<selection> Choose from:

VALID - Return a list of licenses which have enabled VNA software features.

ALL - Return a list of all installed licenses including the ones not related to the

VNA software.

IGNORED - Return a list of VNA software licenses which are either invalid or
ignored. This can occur when a transportable license is transported

to an instrument that does not support the license feature. In
addition, this can occur when multiple licenses for the same base

feature are installed and only the least restrictive license is used (the
more restrictive licenses are ignored). For example, when
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transporting multiple Spectrum Analyzer licenses to the same

instrument, the license with the greatest frequency range is used and

the other licenses are ignored.

Note: Licenses not related to the VNA software but installed on the

instrument are not reported as ignored when using IGNORED.

Examples SYST:CAP:LIC:CAT? ALL

“N5242B-423,N5242B-020,N5242B-021,N5242B-022,S93029A-1FP”

Return Type Variant array of string values

Default Not Applicable

SYSTem:CAPability:NBW:NOISe:CATalog?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the list of supported Noise Bandwidth values when using a noise receiver (option

029). Learn more about Opt. 029.

Parameters None

Examples SYST:CAP:NBW:NOIS:CAT?

Return Type Variant array of string values

Default Not Applicable

SYSTem:CAPability:NBW:STD:CATalog?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the list of supported Noise Bandwidth values when using the NA receiver for

noise measurements (option 028). Learn more about Opt 028.

Parameters None

Examples SYST:CAP:NBW:STD:CAT?

Return Type Variant array of string values

Default Not Applicable

SYSTem:CAPability:POINts:MAXimum?
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Applicable Models: All

(Read-only) Returns the maximum number of points.

Parameters None

Examples SYST:CAP:POIN:MAX?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:POINts:MINimum?

Applicable Models: All

(Read-only) Returns the minimum number of points.

Parameters None

Examples SYST:CAP:POIN:MIN?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:PRESet:FREQuency:MAXimum?

Applicable Models: All

(Read-only) Returns the maximum specified frequency of the analyzer. Does not include any over-

sweep. See also: SYST:CAP:FREQ:MAX?

Parameters None

Examples SYST:CAP:PRES:FREQ:MAX?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:PRESet:FREQuency:MINimum?
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Applicable Models: All

(Read-only) Returns the minimum specified frequency of the analyzer. Does not include any under-

sweep. See also: SYST:CAP:FREQ:MIN?

Parameters None

Examples SYST:CAP:PRES:FREQ:MIN?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:RBW:IMS:CATalog?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the list of supported Resolution BW values for the IMSpectrum channel. Learn

more about IMSpectrum.

Parameters None

Examples SYST:CAP:RBW:IMS:CAT?

Return Type Variant array of string values

Default Not Applicable

SYSTem:CAPability:RBW:SA:CATalog?

Applicable Models: N522xB, N523xB, N524xB

(Read-only) Returns the list of supported Resolution BW values for the SA channel. Learn more

about the SA application.

Parameters None

Examples SYST:CAP:RBW:SA:CAT?

Return Type Variant array of string values

Default Not Applicable

SYSTem:CAPability:WINDows:MAXimum[:COUNt]?

1536



Applicable Models: All

(Read-only) Returns the maximum number of windows. Learn more.

Parameters None

Examples SYST:CAP:WIND:MAX?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:WINDows:TRACes:MAXimum[:COUNt]?

Applicable Models: All

(Read-only) Returns the maximum number of traces per window. Learn more.

Parameters None

Examples SYST:CAP:WIND:TRAC:MAX?

Return Type Numeric

Default Not Applicable

 

1537



SYSTem:CAPability:HARDware:MODule Commands

Returns various capabilities of the PXIe Module.

SYSTem:CAPability:HARDware:MODule:

COUNt?

SERial?

MODel?

OPT?

FPGA?

     | COUNt?

Click on a red keyword to view the command details.

See Also

Example Programs

Guided Cal commands

Synchronizing the Analyzer and Controller

SCPI Command Tree

SYSTem:CAPability:HARDware:MODule:COUNt?

Applicable Models: M937xA

(Read-only) Returns the number of modules that are part of the current VNA instance. Learn more
about Multiport VNA.

Parameters None

Examples SYST:CAP:HARD:MOD:COUNt?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:MODule<n>:SERial?
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Applicable Models: M937xA, M9485A

(Read-only) Returns the serial number of the specified module.

Parameters  

<n> Module number. This is the order in which the module appears in the Multiport

VNA. Learn more about module number.

Examples SYST:CAP:HARD:MOD3:SERial?

Return Type String

Default Not Applicable

SYSTem:CAPability:HARDware:MODule<n>:MODel?

Applicable Models: M937xA, M9485A

(Read-only) Returns the model number of the specified module. See frequency ranges of VNA models.

Parameters  

<n> Module number. This is the order in which the module appears in the Multiport

VNA. Learn more about module number.

Examples SYST:CAP:HARD:MOD3:MODel?

Return Type String

Default Not Applicable

SYSTem:CAPability:HARDware:MODule<n>:OPT?

Applicable Models: M937xA, M9485A

(Read-only) Returns the options that are installed in the specified module. See a list of VNA options.

Parameters  

<n> Module number. This is the order in which the module appears in the Multiport

VNA. Learn more about module number.

Examples SYST:CAP:HARD:MOD3:OPT?

'Possible return string: "010,551"

Return Type A comma-separated string.

Default Not Applicable
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SYSTem:CAPability:HARDware:MODule<n>:FPGA:COUNt?

Applicable Models: M937xA

(Read-only) Returns the number of FPGA boards in the module.

Parameters  

<n> Module number. This is the order in which the module appears in the Multiport

VNA. Learn more about module number.

Examples SYST:CAP:HARD:MOD3:FPGA:COUNt?

Return Type Numeric

Default Not Applicable

SYSTem:CAPability:HARDware:MODule<n>:FPGA<x>?

Applicable Models: M937xA

(Read-only) Returns the version number of specified FPGA board.

Parameters  

<n> Module number. This is the order in which the module appears in the Multiport

VNA. Learn more about module number.

<x> FPGA board number. Choose from 1 to the value returned by
SYST:CAP:HARD:MOD<n>:FPGA:COUNt?

Examples SYST:CAP:HARD:MOD3:FPGA2?

Return Type String

Default Not Applicable
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SYSTem: COMMunicate Commands

Controls and queries settings that affect the VNA system.

SYSTem:COMMunicate:

ECAL

    | CATalog?

    | CLISt?

    | COUNt?

    | DMEMory

        | CLEar

        | IMPort

    | EXPort

        | SNP

    | INFormation?

    | KNAMe:INFormation?

    | LIST?

    | PATH:COUNt?

GPIB

    | PMETer

    | ADDRess

    | RDEVice

           | CLOSe

           | OPEN

           | READ?

           | RESet

           | WBINary

           | WBLock

           | WRITe

LAN:HOSTname

PSENsor

TCPip:CONTrol?

USB:PMETer:CAT?

VISA

    | RDEVice

           | FIND?

           | TIMeout

Click on a keyword to view the command details.

See Also

Referring to Traces Channels Windows and Meas Using SCPI

Example Programs

Synchronizing the Analyzer and Controller
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SCPI Command Tree

SYSTem:COMMunicate:ECAL:CATalog?

Applicable Models: All

(Read-only) Returns the ID string of ECals that are connected to the VNA USB. Use the list to select

a Ecal for Ecal calibration.

Parameters  

Examples SYST:COMM:ECAL:CAT?

system:communicate:ecal:catalog?

Return Type Comma-delimited strings.

Default Not applicable

SYSTem:COMMunicate:ECAL<mod>:CLISt?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns a list of characterizations stored in the specified ECal module.

Parameters  

<mod> ECal module from which to read user characterization numbers. Choose from 1

to 50. If unspecified, value is set to 1.

Examples Module 1 contains User Characterizations 1 and 3.

SYST:COMM:ECAL:CLIST?

'Returns the following (0 always indicates the factory
characterization):

0,1,3

Return Type Numeric list, separated by commas.

Default Not Applicable

SYSTem:COMMunicate:ECAL:COUNt?
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns the number of installed cal kits.

Examples SYST:COMM:ECAL:COUNt?

Query Syntax SYST:COMM:ECAL:COUNt?

Return Type Numeric

Default Not Applicable

SYSTem:COMMunicate:ECAL:DMEMory:CLEar <kitName>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Deletes user characterizations from VNA disk memory.

Parameters  

<kitName> Optional String argument.  ECal Model, User Characterization name + " ECal",

and serial number of the ECal module, separated by spaces. See examples

below.

If unspecified, ALL User Characterizations that are stored in VNA disk

memory are deleted.

Examples 'These examples all use "MyUserChar" as the User
characterization name.

'The "My User Char" characterization is deleted from disk
memory.

SYST:COMM:ECAL:DMEM:CLE "N4433A MyUserChar ECal 00001"

'All User characterizations are deleted from disk memory.

SYST:COMM:ECAL:DMEM:CLE

Query Syntax Not Applicable

Default Not Applicable

SYSTem:COMMunicate:ECAL:DMEMory:IMPort <file>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) After the VNA disk memory is Exported to a file, use this command to Import the file

into VNA disk memory, which allows the User Characterization to be used with the VNA and ECal

module.

Note: An ECal confidence check can NOT be performed remotely from User Characterizations that

are stored on the VNA disk.

Parameters  

<file> String. Full path and file name of file that was exported.

Examples SYST:COMM:ECAL:DMEM:IMP "c:\users\public\network analyzer\ECal
User Characterizations/myDiskUserChar.euc"

Query Syntax Not Applicable

Default Not Applicable

SYSTem:COMMunicate:ECAL:EXPort <kit>[,<file>][,<NewName>]]

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Saves an existing ECal characterization to a file. Use this command to archive the user

characterization or to move the characterization to a different VNA for use with the specified ECal

module. After exporting the user characterization, use SYST:COMM:ECAL:DMEM:IMPort to make the

user characterization available for use.

Parameters  

<kit> String. Not case sensitive. ECal Model, User char name + " ECal", and serial

number of the ECal module used for the characterization, separated by spaces.

See examples below.

If the model and serial number of the module is not found, an error is returned.

[<file>] Optional String argument. Path and filename of the user characterization. If not

specified, the file is saved using characterization name + ".euc". If the path is

not specified, it is stored in C:/Program Files/Keysight/Network Analyzer/ECal

User Characterizations/. The extension ".euc" is appended if one is not

specified.

[<NewName>] Optional String argument. This allows you to change the name for the User

Characterization. When specified, the new name is saved in the file with the

characterization. If unspecified, the existing user characterization name is

saved.
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Note: If this argument is specified, the second argument (<file>) must also be

specified.

Examples 'These examples all use "MyUserChar" as the User
characterization name.

'All parameters specified

SYST:COMM:ECAL:EXP "N4433A MyUserChar ECal
00001","myUserChar.euc","NewUserChar"

'First two parameters are specified

system:communicate:ecal:export "N4691B MyUserChar ECal
00500","myUserChar.euc"

'Only first parameter is specified

SYST:COMM:ECAL:EXP "N4433A MyUserChar ECal 00001"

Query Syntax Not Applicable

Default Not Applicable

 

SYSTem:COMMunicate:ECAL:EXPort:SNP <kit>,<ecalState>,<snpFileName>

Applicable Models: All

(Write-only) Read S parameter of ECal Thru from the ECal memory and save it as s2p file.

Parameters  

<kit> String. Not case sensitive. ECal Model, User char name + " ECal", and serial

number of the ECal module used for the characterization, separated by spaces.

See examples below.

If the model and serial number of the module is not found, an error is returned.

<ecalState> ECal transmission path.  Choose from AB, AC, AD, BA, BC, BD, CA, CB,

CD, DA, DB or DC. Not case sensitive.

<snpFileName> Path and filename of the output s2p file name.

Examples SYST:COMM:ECAL:EXP "N4433A ECal 00001","BC","D:\ecalthru.s2p"

Query Syntax Not Applicable

Default Not Applicable
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SYSTem:COMMunicate:ECAL<mod>:INFormation? [<char>]

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only)  Reads the identification and characterization information from the specified ECal

module.

Note: To read user-characterization information that is stored in VNA disk memory, then use
SYST:COMM:ECAL:KNAM:INF?

Parameters  

<mod> ECal module from which to read characterizations. Choose from 1 through 50.

If unspecified, value is set to 1.

Do NOT assume the <mod> number is the order in which ECal modules were

connected.

Use SYST:COMM:ECAL:LIST? to read a list of <mod> numbers of currently-

attached ECal modules.

<char> Optional argument. Specifies which characterization to read information from.

 If not specified, value is set to CHAR0.

Choose from:

CHAR0   Factory characterization (data that was stored in the ECal module by
Keysight)

CHAR1   User characterization #1

CHAR2   User characterization #2

 - through -

CHAR12   User characterization #12

Examples SYST:COMM:ECAL2:INFormation? char5

'Example return string:

"ModelNumber: 85092-60007, SerialNumber: 01386, ConnectorType:
N5FN5F, PortAConnector: Type N (50) female, PortBConnector: Type
N (50) female, MinFreq: 30000, MaxFreq: 9100000000,
NumberOfPoints: 250, Calibrated: July 4 2002"

Return Type Character

Default Not Applicable
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SYSTem:COMMunicate:ECAL:KNAMe:INFormation? <kitName>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Reads the identification and characterization information from the specified ECal module

or VNA disk memory.

Learn more about User Characterization in VNA Disk Memory.

Parameters  

<kitName> String. ECal model and characterization to read information from, enclosed in

quotes, in the following format:

<model> <name> ECal <serial number>

Where:

<model>: Always required

<name>:

For the factory characterization, do not specify.

For a user-characterization stored in the module, use User <n> in the string,
where <n> is the user-characterization number. Not case sensitive. Separate
User and <n> with a space.

For a user-characterization stored in VNA disk memory, use <charName>
from SENS:CORR:CKIT:ECAL:CHAR:DMEM:SAVE <charName>

ECal - not case sensitive

<serial number>: Optional. Include when two or more ECal modules with
same model number are attached to the VNA,

Each item is separated with a space.

Examples 'For a factory characterization in module memory:
SYST:COMM:ECAL:KNAM:INF? "N4433A ECal"

'For user characterization in module memory with optional serial
number:
SYST:COMM:ECAL:KNAM:INF? "N4433A User 1 ECal 00028"

'For user characterization "foo" in disk memory:
SYST:COMM:ECAL:KNAM:INF? "N4433A foo ECal 00028"

'Example return string:
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"ModelNumber: N4433A, SerialNumber: 00028, ConnectorType:
N5FN5F, PortAConnector: Type N (50) female, PortBConnector: Type
N (50) female, MinFreq: 30000, MaxFreq: 9100000000,
NumberOfPoints: 250, Calibrated: July 4 2002"

Return Type String

Default Not Applicable

SYSTem:COMMunicate:ECAL:LIST?

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns a list of index numbers for ECal modules that are currently attached to the VNA.

Use these numbers (called <mod> in VNAHelp) to refer to the ECal module using SCPI commands.

Examples SYST:COMM:ECAL:LIST?

'If 2 modules are attached to the VNA
'then the returned list will be:

+1,+2

'If NO modules are attached to the VNA
'then the returned list will be:

+0

Return Type Numeric list, separated by commas.

Default Not Applicable

SYSTem:COMMunicate:ECAL<n>:PATH:COUNt? <path>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only)  Returns the number of unique states that exist for the specified path name on the selected

ECal module.

This command performs exactly the same function as CONT:ECAL:MOD:PATH:COUNt?

Use the CONT:ECAL:MOD:PATH:STAT command to set the module into one of those states.  

Use SENS:CORR:CKIT:ECAL:PATH:DATA? to read the data for a state.

Parameters  

<n> USB number of the ECal module.  Choose from 1 to 50.

If unspecified (only one ECal module is connected to the USB), <n> is set to 1.
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If two or more modules are connected, use SYST:COMM:ECAL:LIST? to

determine how many, and SYST:COMM:ECAL:INF? to verify their identities.

<path> Name of the path for which to read number of states.  Choose from:

Reflection paths

A

B

C (4-port modules)

D (4-port modules)

Transmission paths

AB

AC (4-port modules)

AD (4-port modules)

BC (4-port modules)

BD (4-port modules)

CD (4-port modules)

Examples SYST:COMM:ECAL:PATH:COUNt?
system:communicate:ecal:path:count?

Return Type Integer

Default Not Applicable

SYSTem:COMMunicate:GPIB:PMETer[:ADDRess] <num>  Superseded
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Applicable Models: N522xB, N523xB, N524xB, M937xA

Note: This command is replaced with SYST:COMM:PSENsor

(Read-Write) Specifies the GPIB address of the power meter to be used in a source power calibration.

When performing a source power cal, the VNA will search VISA interfaces that are configured in the

Keysight IO LIbraries on the VNA.

Parameters  

<num> GPIB address of the power meter. Choose any integer between 0 and 30.

Examples SYST:COMM:GPIB:PMET 13

system:communicate:gpib:pmeter:address 14

Query Syntax SYSTem:COMMunicate:GPIB:PMETer[:ADDRess]?

Return Type Numeric

Default 13

SYSTem:COMMunicate:GPIB:RDEVice:CLOSe <ID>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write only) Closes the remote GPIB session. This command should be sent when ending every

successful OPEN session.

Parameters  

<ID> Session identification number that was returned with the OPEN? command.

Examples See an example program

Query Syntax Not Applicable

Default Not Applicable

SYSTem:COMMunicate:GPIB:RDEVice:OPEN <bus>, <addr>, <timeout>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Initiates a GPIB pass-through session. First send this OPEN command, then send the

OPEN query to read the session ID number. An existing GPIB pass-through session remains open

after an instrument preset.

To learn more about GPIB pass-through capability, see the example program.

Parameters  

<bus> Bus ID number.

You can find the USB-GPIB adapter bus number by looking at the dialog that

appears when the USB-GPIB device is connected. Error 1073 indicates the bus

or address number is incorrect.

Use 0 (zero) when connected using a GPIB cable to the VNA controller port.

<addr> GPIB Address of the device to be controlled

<timeout> The amount of time (in milliseconds) to wait for a response from the remote

device after sending a command.  A "timeout" error is displayed after this time

has passed without a response.

Examples See an example program

Query Syntax SYSTem:COMMunicate:GPIB:RDEVice:OPEN?

Returns the session identification number that is used when communicating

with this device.

Return Type Numeric

Default Not Applicable

SYSTem:COMMunicate:GPIB:RDEVice:READ? <ID>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns data from the GPIB pass-through device.

Parameters  

<ID> Session identification number that was returned with the OPEN? command.

Examples See an example program

Return Type String

Default Not Applicable
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SYSTem:COMMunicate:GPIB:RDEVice:RESet

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only)   Performs the same function as SYST:COMM:GPIB:RDEV:CLOS except that ALL pass-

through sessions are closed.

Examples SYST:COMM:GPIB:RDEV:RES

Query Syntax Not Applicable

Default Not Applicable

SYSTem:COMMunicate:GPIB:RDEVice:WBINary <ID>,<data>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only)  Sends data to a GPIB pass-through device. This command requires a header that

specifies the size of the data to be written. The header (described below) is not passed along to the

device.

Use this command if too many embedded quotes prevent you from using

SYST:COMM:GPIB:RDEV:WRIT.

Use SYST:COMM:GPIB:RDEV:OPEN to open the pass through session.

Parameters  

<ID> Session identification number that was returned with the OPEN? command.

<data> Data to be sent to the GPIB pass-through device. Use the following syntax:

#<num digits><byte count><data bytes><NL><END>

<num_digits> specifies how many digits are contained in <byte_count>

<byte_count> specifies how many data bytes will follow in <data bytes>

Examples SYSTem:COMMunicate:GPIB:RDEVice:WBINary 101,#17ABC+XYZ<nl><end>

# - always sent before data.

1 - specifies that the byte count is one digit (7).

7 - specifies the number of data bytes that will follow, not counting

<NL><END>.

ABC+XYZ - Data block
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<nl><end> - always sent at the end of block data.

 

The following example sends a line feed at the end.

SYST:COMM:GPIB:RDEV:WBIN 1,#210SYST:PRES<EOL>

The <EOL> represents your linefeed character.

Query Syntax Not Applicable

Default Not Applicable

SYSTem:COMMunicate:GPIB:RDEVice:WBLock <ID>,<data>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only)  Same as SYSTem:COMM:GPIB:RDEV:WBIN (above) but the header IS passed along to the

device.

Use this command if too many embedded quotes prevent you from using

SYST:COMM:GPIB:RDEV:WRIT.

Parameters  

<ID> Session identification number that was returned with the OPEN? command.

<data> Data to be sent to the GPIB pass-through device. See previous command.

Examples See previous example.

Query Syntax Not Applicable

Default Not Applicable

SYSTem:COMMunicate:GPIB:RDEVice:WRITe <ID>,<string>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Write-only) Sends ASCII string data to the GPIB pass-through device.

A line feed is NOT appended to the string data. To send a line feed, see the example in

SYST:COMM:GPIB:RDEV:WBIN.

Parameters  

<ID> Session identification number that was returned with the OPEN? command.

<string> Commands to be sent to the GPIB pass-through device.

Examples See an example program

Query Syntax Not Applicable

Default Not Applicable

SYSTem:COMMunicate:LAN:HOSTname?

Applicable Models: All

(Read-only) Returns the LAN hostname that is visible in the Help, About Network Analyzer dialog

box. Learn more. This is the same information that is visible on the LXI compliance dialog.

Parameters None

Example SYST:COMM:LAN:HOSTname?

Return Type String

Default Not applicable

SYSTem:COMMunicate:PSENsor <char>, <string>
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Applicable Models: All

This command replaces SYST:COMM:GPIB:PMET:ADDR.

(Read-Write) Specifies the type and location of the power meter to be used in a source power

calibration.

Parameters  

<char> Type of power meter/ sensor. Choose from:

GPIB  GPIB power meter

USB  USB power sensor or USB power sensor

LAN  LAN enabled power meter

ANY  Any VISA resource string or a visa alias

<string> For GPIB, address of the power meter. Choose any integer between 0 and 30.

For USB, the ID string of the power meter or power sensor. Use

SYST:COMM:USB:PMET:CAT? to see a list of ID strings of connected power

meters and sensors.

For LAN, the hostname or IP address of the power meter.

For ANY,  any VISA resource string or a visa alias.

Examples SYST:COMM:PSEN gpib, "14"

system:communicate:psensor usb, "Keysight
Technologies,U2000A,MY12345678"

syst:comm:psen lan, "mymeter.Keysight.com"

syst:comm:psen any, "TCPIP0::mymeter.Keysight.com::5025::SOCKET"

Query Syntax SYSTem:COMMunicate:PSENsor?

Return Type Character / String

Default GPIB

SYSTem:COMMunicate:USB:PMETer:CATalog?
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Applicable Models: All

(Read-only) Returns the ID string of power meters / sensors that are connected to the VNA USB. Use

the list to select a power sensor for a source power cal.

These meter/sensor ID strings can NOT be used as the resource string for configuring a USB-based

PMAR (SYST:CONF:EDEV:IOConfig).

Parameters  

Examples SYST:COMM:USB:PMET:CAT?

system:communicate:usb:pmeter:catalog?

Return Type Comma-delimited strings. Two power sensor strings are separate by a

semicolon.

Default Not applicable

SYSTem:COMMunicate:TCPip:CONTrol?

Applicable Models: All

(Read-only) Queries the TCP/IP port number to use for opening a TCP/IP socket control connection

to the VNA.  The control connection is used for two purposes:

To perform a Device Clear operation on the VNA1.

To detect when a Service Request (SRQ) event occurs on the VNA.2.

The port number can range from 5000 to 5099. The VNA will skip over 5025 as it is being used for

the primary socket connection.

To detect an SRQ, your program sends the appropriate commands via the regular socket connection to

set up for a SRQ event to occur the same sequence of commands as if you were sending them via

GPIB.  You write your program so that while your program is doing SCPI transactions on the standard

socket connection, a second thread of execution in your program detects the SRQ on the control

connection and responds to the event.  When the SRQ event occurs, the VNA sends a SRQ +xxx/n

message on the control connection (where /n is linefeed character, ASCII value 10 decimal).  The xxx

value in the SRQ +xxx/n string is the IEEE 488.2 status byte at the time the SRQ was generated.  So

listening for that on the control connection is how your program detects the event.  If for your socket

communication youre using a software API that provides for asynchronous communication via a

callback mechanism (for example, if youre using Microsofts winsock API, or their .NET Socket class

as in the example program below), in that case your listener execution thread is created implicitly for

you so your program doesnt have to create one explicitly.
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Note: If this SCPI query is sent to the VNA via a SCPI parser other than a TCP/IP socket connection

(for example, if sent via GPIB), the query is not applicable in that case and will return value of 0.

Parameters None

Example See example program

Return Type Integer

Default Not applicable

SYSTem:COMMunicate:VISA:RDEVice:FIND? <VISA regex> [,<ADDRess|ALIas>]

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-only) Returns a comma separated list of either VISA address strings or aliases.

Parameters  

<VISA regex> (String) VISA regular expressions are expressions defined by the user to find

devices that have been set up on the VISA interface. The following are

examples of VISA regular expressions:

Interface Expression

GPIB GPIB[0-9]*::?
*INSTR

PXI PXI?*INSTR
VXI VXI?*INSTR
GPIB-VXI GPIB-VXI?*INSTR
GPIB and GPIB-
VXI

GPIB?*INSTR

All VXI ?*VXI[0-9]*::?
*INSTR

ASRL ASRL[0-9]*::?
*INSTR

All ?*INSTR  or  ?*

Note that using "INSTR" in the VISA regular expression finds "instruments."

To search all interfaces, use "?*".

<ADDRess|ALIas> Optional. Determines whether addresses or aliases are returned.

Note: The list of aliases may have less�or more�entries than the list of
addresses because not all addresses will have aliases, and one address can have

more than one alias.

Examples SYST:COMM:VISA:RDEV:FIND? "?*",ADDR

system:communicate:visa:rdevice:find? '?*INSTR',alias
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Return Type Variant

Default Addresses returned if no return-type specified

SYSTem:COMMunicate:VISA:RDEVice:TIMeout <ID>, <timeout>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets or returns the timeout value (in milliseconds) for VISA pass-through commands for

the specified VISA session ID.

Parameters  

<ID> VISA session number that was returned with the OPEN? command.

<timeout> The amount of time (in milliseconds) to wait for a response from the remote

device after sending a command. A "timeout" error is displayed after this time

has passed without a response.

Examples SYST:COMM:VISA:RDEV:TIM 1,6000

system:communicate:visa:rdevice:timeout 3,6000

Query Syntax SYSTem:COMMunicate:VISA:RDEVice:TIMeout? <ID>

Returns the timeout value for the specified session ID.

Return Type Numeric

Default 2000
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External Device Commands

Configures and makes settings for an external device.

SYST:CONF:EDEVice:

| ADD

| CAT?

| DRIVer

| DTYPe

| EXISts?

| IOConfig

| IOENable

| LOAD

| REMove

| SAVE

| STATe

| TOUT

 

| DC  More commands

| PMAR  More commands

| PULSe  More commands

 

| SOURce:

     | DPP

     | MODulation

          | CONTrol

               | :STATe

     | TMODe

     | TPORt

 

Click on a red keyword to view the command details.

See Also

Learn about: Configure an External Source

Learn about: Configure a PMAR Device

Example: Configure an External Source

Example: Configure a PMAR Device

SYST:PREF:ITEM:EDEV:DPOL - Determines whether external devices remain activated or are de-activated when
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the VNA is Preset or when a Instrument State is recalled.

Synchronizing the Analyzer and Controller

SCPI Command Tree

SYSTem:CONFigure:EDEVice:ADD <name>

Applicable Models: All

(Write-only) Adds an external device to the list of configured devices.  This is the same as pressing

New on the Select an external device dialog.

Upon creation, all settings on the new device are set to the defaults. The device is not active until set

using SYST:CONF:EDEV:STAT

Parameters  

<name> String - Model and type of the external device.

To see a list of configured external devices, use SYST:CONF:EDEV:CAT?

Examples SYST:CONF:EDEV:ADD "myDevice"

system:configure:edevice:add "myDevice"

Query Syntax Not Applicable

Default Not Applicable

SYSTem:CONFigure:EDEVice:CAT?

Applicable Models: All

(Read-only) Returns a list of names of all configured devices. These are devices that appear in the

external devices dialog.

Use SENS:FOM:CAT? to report all active devices.

Use Source:CAT? to report all active sources.

Parameters None

Example SYST:CONF:EDEV:CAT?

system:configure:edevice:cat

Return Type String of comma-separated devices. "Device0:Driver0, Device1:Driver1"

Default Not applicable
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SYSTem:CONFigure:EDEVice:DRIVer <name>,<value>

Applicable Models: All

(Read-Write) Sets and returns the external device driver (model).

Parameters  

<name> String - Name of the device.

<value> String - External device driver (model). Choose from the following:

"AGPM" for all power meters.

"AGPULSEGEN" for supported pulse generators.

"DCSource" for all supported DC Sources

"DCMeter" for all supported DC Meters

See a list of supported external source drivers.

Examples SYST:CONF:EDEV:DRIV "myDevice","AGPM"

system:configure:edevice:driver "myDevice","AGESG"

Query Syntax SYSTem:CONFigure:EDEVice:DRIVer? <name>

Return Type String

Default "AGGeneric"

SYSTem:CONFigure:EDEVice:DTYPE <name>,<type>

Applicable Models: All

(Read-Write) Sets and returns the Device Type for the external device.

Parameters  

<name> String - Name of the device to modify.

<type> String - Device type - not case sensitive. Choose from:

"Source" - external source

"Power Meter" - power meter

"DC Meter" - DC voltmeter

"DC Source" - DC power supply
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"Pulse Generator" - external pulse generator

Examples SYST:CONF:EDEV:DTYP "myDevice","Power Meter"

system:configure:edevice:dtype "myDevice","Source"

Query Syntax SYSTem:CONFigure:EDEVice:DTYPe? <name>

Return Type String

Default None

SYSTem:CONFigure:EDEVice:EXISts? <string>

Applicable Models: All

(Read-only) Returns whether the named device is present on the bus for which it is configured.

Parameters  

<string> Name of the external device.

Example SYST:CONF:EDEV:EXIS? "MyPowerMeter"

Return Type Boolean

0 - The device is not in the collection or the device fails to respond and times out
when communication is attempted.

1 - The device responds when communication is attempted.

Default Not applicable

SYSTem:CONFigure:EDEVice:IOConfig <name>,<value>
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Applicable Models: All

(Read-Write) Sets and return the configuration path for the specified external device.

Parameters  

<name> String - Name of the device.

<value> String - Configuration path. Any valid VISA resource shown in the IO

Configuration field of the external devices dialog, enclosed in quotes.

Do NOT use the ID string of a PMAR USB power sensor as the resource

string. The ID string is returned by SYST:COMM:USB:PMET:CAT?

Examples SYST:CONF:EDEV:IOC "myDevice","GPIB0::13::INSTR"

system:configure:edevice:ioconfig "myDevice","GPIB0::13::INSTR"

Query Syntax SYSTem:CONFigure:EDEVice:IOConfig? <name>

Return Type String

Default " " Empty String

SYSTem:CONFigure:EDEVice:IOENable <name>,<value>

Applicable Models: All

(Read-Write)  Enable or disable communication with an external device.

When disabled (OFF), the VNA will NOT attempt to connect to the external device regardless of the

instrument state command (SYST:CONF:EDEV:STATe).  Therefore, no errors will be produced if the

device is not connected.

This command is useful for debugging and testing states when the external device is not connected.

This command is unnecessary in ordinary operation (when the device is connected).

Parameters  

<name> String - Name of the device.

<value> Boolean - Choose from:

OFF or 0 - Device communication disabled

ON or 1 - Device communication enabled

Examples SYST:CONF:EDEV:IOEN "myDevice", ON

system:configure:edevice:ioenable "myDevice", 0
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Query Syntax SYSTem:CONFigure:EDEVice:IOENable? <name>

Return Type Boolean

Default ON

SYSTem:CONFigure:EDEVice:LOAD <file>,<name>

Applicable Models: All

(Write-only) Recalls an external device configuration file from the VNA hard drive.

Currently, only DC Supply and DC Meter configuration files are supported. See more DC Device
commands.

Use SYST:CONF:EDEV:SAVE to save a configuration file.

Parameters  

<file> String - Filename of the external device configuration file.

<name> String - Name of the external device. Currently, only DC Supply and DC Meter

configuration files are supported.

Examples SYST:CONF:EDEV:LOAD "myDevice.xml","MyDCMeter"

Query Syntax Not Applicable

Default Not Applicable

SYSTem:CONFigure:EDEVice:REMove <name>

Applicable Models: All

(Write-only) Removes the specified device from the list of configured devices.  If the device is a
Source and both Active and I/O Enabled is checked (ON), then the RF power state is set to OFF. Learn
more.

Parameters  

<name> String - Name of the device. Not case sensitive. Use SYST:CONF:EDEV:CAT? to

return a list of configured devices.

Examples SYST:CONF:EDEV:REM "myDevice"

system:configure:edevice:remove "myDevice"

Query Syntax Not Applicable

Default Not Applicable
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SYSTem:CONFigure:EDEVice:SAVE <file>,<name>

Applicable Models: All

(Write-only) Saves an external device configuration file to the VNA hard drive.

Currently, only DC Supply and DC Meter configuration files are supported. See more DC Device
commands.

Use SYST:CONF:EDEV:LOAD to recall a configuration file.

Parameters  

<file> String - Filename of the external device configuration file.

<name> String - Name of the external device.  Currently, only DC Supply and DC

Meter configuration files are supported.

Examples SYST:CONF:EDEV:SAVE "myDevice.xml","MyDCSupply"

Query Syntax Not Applicable

Default Not Applicable

SYSTem:CONFigure:EDEVice:STATe <name>,<state>

Applicable Models: All

(Read-Write)  Set and return the state of activation of the device. When SYST:CONF:EDEV:IOEN = ON,

and this command is set to ON, the VNA will attempt communication with the external device.

Send this command AFTER sending other external device settings (especially

SYST:CONF:EDEV:DTYP) to avoid communicating with the device before it has been fully configured.

See Also: SYST:PREF:ITEM:EDEV:DPOL - Determines whether external devices remain activated or are de-
activated when the VNA is Preset or when a Instrument State is recalled.

Parameters  

<name> String - Name of the device.

<state> Boolean - Choose from:

OFF or 0 - Device is NOT activated

ON or 1 - Device is activated.

Examples SYST:CONF:EDEV:STAT "myDevice", ON

system:configure:edevice:state "myDevice", 0
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Query Syntax SYSTem:CONFigure:EDEVice:STATe? <name>

Return Type Boolean

Default OFF - When configured using the front panel user interface, the device is ON

(activated) by default.

SYSTem:CONFigure:EDEVice:TOUT <name>,<value>

Applicable Models: All

(Read-Write) Set and return the time out value for the specified external device. This is the time

allowed for communication with the device before an error is generated.

Parameters  

<name> String - Name of the device.

<value> Time out value in seconds.

Examples SYST:CONF:EDEV:TOUT "myDevice",2

system:configure:edevice:tout "myDevice",5

Query Syntax SYSTem:CONFigure:EDEVice:TOUT? <name>

Return Type Numeric

Default 20

SYSTem:CONFigure:EDEVice:SOURce:DPP <name>,<value>

Applicable Models: All

(Read-Write) Sets and returns the amount of time the VNA should wait after for an external source to

settle before making a measurement at each data point. This setting applies to all channels that use

this external source.

Parameters  

<name> String - Name of the device.

<value> Dwell time in seconds.

Examples SYST:CONF:EDEV:SOUR:DPP "myDevice",2

system:configure:edevice:source:dpp "myDevice",.1

Query Syntax SYSTem:CONFigure:EDEVice:SOURce:DPP? <name>

Return Type Numeric
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Default 3.114 e-3

SYSTem:CONFigure:EDEVice:SOURce:MODulation:CONTrol:STATe <name>,<state>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and reads the state of the modulation control. Modulation control must be ON to

control the modulation of an external source.

Parameters  

<name> String - Name of the device.

<state> ON (or 1)  Enable control of external modulation.

OFF (or 0)  Disable control of external modulation.

Learn about these settings and about adding an external source.

Examples SYST:CONF:EDEV:SOUR:MOD:CONT:STAT "qasmxg",1

system:configure:edevice:source:modulation:control:state
"qasmxg",OFF

Query Syntax SYSTem:CONFigure:EDEVice:SOURce:MODulation:CONTrol:STATe?

"qasmxg"

Default OFF

SYSTem:CONFigure:EDEVice:SOURce:TMODe <name>,<value>

Applicable Models: All

(Read-Write) Sets and returns the trigger mode for an external source. Learn more.

Parameters  

<name> String - Name of the device.

<value> Trigger Mode. Choose from:

CW - Software CW mode

HW - Hardware list mode

Examples SYST:CONF:EDEV:SOUR:TMOD "myDevice",CW

system:configure:edevice:source:tmode "myDevice",hw

Query Syntax SYSTem:CONFigure:EDEVice:SOURce:TMODe? "myDevice"
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Return Type Character

Default Depends on Source and VNA Model

SYSTem:CONFigure:EDEVice:SOURce:TPORt <name>,<value>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the VNA port through which an external source is to be triggered.

Parameters  

<name> String - Name of the device.

<value> Trigger Port. Choose from aux1 or aux2

Examples system:configure:edevice:source:tport "myDevice",aux1

Query Syntax SYSTem:CONFigure:EDEVice:SOURce:TPORt? <name>

Return Type Character

Default aux1

 

1568



SYSTem:CONF:EDEVice:DC Commands

Configures external SMU, DC Meter, and DC Source properties.

SYST:CONF:EDEVice:DC

| CORRection

| DPOint

| DSWeep

| LIMit

     | CURRent

     | VOLTage

| OFFSet

| SCALe

| TYPE

Click on a red keyword to view the command details.

See Also

All SYST:CONF:EDEV commands

SOURce:DC commands (make DC sweep settings)

Learn about: Configure an External DC Device

Learn about Configure an External Device

SYST:PREF:ITEM:EDEV:DPOL - Determines whether External Devices remain activated or are de-activated when
the VNA is Preset or when a Instrument State is recalled.

Synchronizing the Analyzer and Controller

SCPI Command Tree

SYSTem:CONFigure:EDEVice:DC:CORRection <name>,<value>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the correction ON/OFF state for a DC Meter and a DC Source.

Parameters  

<name> String - Name of the device.

<value> Correction ON/OFF state. Choose from:

ON or 1 - Turn Correction ON

OFF or 0 - Turn Correction OFF

Examples SYST:CONF:EDEV:DC:CORR "myDCDevice",1

system:configure:edevice:dc:correction "myDCDevice",OFF

Query Syntax SYSTem:CONFigure:EDEVice:DC:CORRection? <name>

Return Type Boolean

Default OFF

SYSTem:CONFigure:EDEVice:DC:DPOint <name>,<value>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the "Dwell Before/After Point" value for an external DC Device which

can be configured as either a DC Meter or a DC Source.

Parameters  

<name> String - Name of the device.

<value> For DC Meter, the dwell time (in seconds) before making a data point

measurement.

For DC Source, the dwell time (in seconds) after making a data point setting.

Examples SYST:CONF:EDEV:DC:DPO "myDCDevice",10e-3

system:configure:edevice:dc:dpoint "myDCDevice",.01

Query Syntax SYSTem:CONFigure:EDEVice:DC:DPOint? <name>

Return Type Numeric

Default 3 milliseconds

SYSTem:CONFigure:EDEVice:DC:DSWeep <name>,<value>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the "Dwell Before Sweep" value for an external DC Device which can

be configured as either a DC Meter or a DC Source.

Parameters  

<name> String - Name of the device.

<value> The dwell time (in seconds) before making a new sweep.

Examples SYST:CONF:EDEV:DC:DSW "myDCDevice",10e-3

system:configure:edevice:dc:dsweep "myDCDevice",.01

Query Syntax SYSTem:CONFigure:EDEVice:DC:DSWeep? <name>

Return Type Numeric

Default 1 millisecond

SYSTem:CONFigure:EDEVice:DC:LIMit:CURRent <name>, <value>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the maximum output current value of the external DC Source. This

command supports Keysight B2900A and N6700 series devices only.

Parameters  

<name> String - Name of the device.

<value> Current limit value.

Examples SYST:CONF:EDEV:DC:LIM:CURR "myDCDevice",4

system:configure:edevice:dc:limit:current "myDCDevice",1.25

Query Syntax SYSTem:CONFigure:EDEVice:DC:LIMit:CURRent? <name>

Return Type Double

Default 0

SYSTem:CONFigure:EDEVice:DC:LIMit:VOLTage <name>, <value>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the maximum output voltage value of the external DC Source. This

command supports Keysight B2900A and N6700 series devices only.

Parameters  

<name> String - Name of the device.

<value> Voltage limit value.

Examples SYST:CONF:EDEV:DC:LIM:VOLT "myDCDevice",4

system:configure:edevice:dc:limit:voltage "myDCDevice",1.25

Query Syntax SYSTem:CONFigure:EDEVice:DC:LIMit:VOLTage? <name>

Return Type Double

Default 0

SYSTem:CONFigure:EDEVice:DC:OFFSet <name>,<value>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the offset correction value for an external DC Device which can be

configured as either a DC Meter or a DC Source.

Parameters  

<name> String - Name of the device.

<value> DC offset value.

The VNA will display readings from a DC Meter as:

Display = (Meas'd value - Offset) * Scale

The VNA will adjust the output from a DC Source as:

Output = (Set value - Offset) * Scale

Examples SYST:CONF:EDEV:DC:OFFS "myDCDevice",4

system:configure:edevice:dc:offset "myDCDevice",1.25

Query Syntax SYSTem:CONFigure:EDEVice:DC:OFFSet? <name>

Return Type Numeric

Default 0
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SYSTem:CONFigure:EDEVice:DC:SCALe <name>,<value>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the scale correction value for an external DC Device which can be

configured as either a DC Meter or a DC Source.

Parameters  

<name> String - Name of the device.

<value> DC Scale value.

The VNA will display readings from a DC Meter as:

Display = (Meas'd value - Offset) * Scale

The VNA will adjust the output from a DC Source as:

Output = (Set value - Offset) * Scale

Examples SYST:CONF:EDEV:DC:SCAL "myDCDevice",1.2

system:configure:edevice:dc:scale "myDCDevice",.5

Query Syntax SYSTem:CONFigure:EDEVice:DC:SCALe? <name>

Return Type Numeric

Default 1

SYSTem:CONFigure:EDEVice:DC:TYPE <name>,<value>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets and returns the DC Type for an external DC Device which can be configured as

either a DC Meter or a DC Source. This setting is used as the units for display on the VNA X-axis.

Parameters  

<name> String - Name of the device.

<value> DC type. Choose from:

"dBm", "A", "V", "W", "K", "F", "C"

Examples SYST:CONF:EDEV:DC:TYPE "myDCDevice","A"

system:configure:edevice:dc:type "myDCDevice","w"

Query Syntax SYSTem:CONFigure:EDEVice:DC:TYPE? <name>

Return Type String
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Default "V"
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SYST:CONF:EDEVice:PMAR Commands

Configures and makes settings for an external Power Meter as Receiver.

SYSTem:CONFigure:EDEVice:PMAR

| CALibrate

| FLIMit

| FMAXimum

| FMINimum

| CFACtors

     | STATe

| READing:

     | COUNt

     | NTOLerance

| SENSor

| TABLe:

     | CFAC:

          | DATA

          | FREQuency

     | LOSS:

          | DATA

          | FREQuency

          | STATe

     | RFACtor

| ZERO

Click on a keyword to view the command details.

See Also

Learn about: Configure a Power Meter As Receiver

See root SYST:CONF:EDEV commands

Learn about Configure and External Device

SYST:PREF:ITEM:EDEV:DPOL - Determines whether External Devices remain activated or are de-activated when
the VNA is Preset or when a Instrument State is recalled.

Synchronizing the Analyzer and Controller

SCPI Command Tree
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SYSTem:CONFigure:EDEVice:PMAR:CALibrate <name>

Applicable Models: All

(Write-only)  Performs a calibration of the power sensor. Calibration usually involves connecting the

power sensor to the meter's 1 mW reference.

Keysight P-Series sensors have an internal reference so you can calibrate them using this command
without connecting to the meters reference port.

Keysight USB power sensors do not require calibrating.

For other sensors, refer to the documentation to determine if it has calibration capability.

This command is always synchronous, so *OPC? is the only way to determine that the operation is

complete. Set an I/O timeout of at least 20 seconds.

Parameters  

<name> String - Name of the power meter.

Examples SYST:CONF:EDEV:PMAR:CAL "myDevice"

system:configure:edevice:pmar:calibrate "myDevice"

Query Syntax Not Applicable

Default Not Applicable

SYSTem:CONFigure:EDEVice:PMAR:FLIMit <name>,<value>

Applicable Models: All

(Read-Write) Enable or disable the power meter min and max frequencies.

Parameters  

<name> String - Name of the power meter.

<value> Boolean. State of min and max frequency. Choose from:

OFF or 0 - Min and max frequencies disabled.

ON or 1 - Min and max frequencies enabled.

Examples SYST:CONF:EDEV:PMAR:FLIM "myDevice", 0

system:configure:edevice:pmar:flimit "myDevice", ON

See example program

Query Syntax SYSTem:CONFigure:EDEVice:PMAR:FLIMit? <name>
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Return Type Boolean

Default OFF

SYSTem:CONFigure:EDEVice:PMAR:FMAXimum <name>,<value>

Applicable Models: All

(Read-Write) Set and return the maximum frequency of the power meter.

Parameters  

<name> String - Name of the power meter.

<value> Numeric - Max frequency in Hz.

Examples SYST:CONF:EDEV:PMAR:FMAX "myDevice", 1e10

system:configure:edevice:pmar:fmaximum "myDevice", 3e9

See example program

Query Syntax SYSTem:CONFigure:EDEVice:PMAR:FMAXimum?  <name>

Return Type Numeric

Default Not Applicable

SYSTem:CONFigure:EDEVice:PMAR:FMINimum <name>,<value>

Applicable Models: All

(Read-Write) Set and return the minimum frequency of the power meter.

Parameters  

<name> String - Name of the power meter.

<value> Numeric - Min frequency in Hz.

Examples SYST:CONF:EDEV:PMAR:FMIN "myDevice", 1e10

system:configure:edevice:pmar:fminumum "myDevice", 3e9

See example program

Query Syntax SYSTem:CONFigure:EDEVice:PMAR:FMAXimum? <name>

Return Type Numeric

Default Not Applicable
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SYSTem:CONFigure:EDEVice:PMAR:CFACtors:STATe<name> <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Enables/disables use of internal calibration factors for power sensors with built-in

calibration factors and reads the current state.

Parameters  

<name> String - Name of the power meter.

<bool> Choose from:

0 - OFF - Disables the use of internal calibration factors.

1 - ON - Enables the use of internal calibration factors.

Learn about these settings.

Examples ' This example script demonstrates the SCPI set/get of the "Use
Internal Cal Factors" property

' for an existing PMAR named 'MyPMAR'.

Option Explicit

dim app

Set app = CreateObject("AgilentPNA835x.Application")

dim scpi

Set scpi = app.ScpiStringParser

Dim opcReply

opcReply = scpi.Parse("SYST:PRES;*OPC?")

opcReply = scpi.Parse("SENS1:SWE:MODE HOLD;*OPC?")

scpi.Parse "SENS1:FREQ:CW 1E9"

scpi.Parse "SENS1:SWE:TYPE CW"

scpi.Parse "SENS1:SWE:POIN 3"

' Activate the PMAR and change the default trace to measure that
PMAR connected to port 3

scpi.Parse "SYST:CONF:EDEV:STAT 'MyPMAR', ON"

scpi.Parse "CALC1:PAR:SEL 'CH1_S11_1'"

scpi.Parse "CALC1:PAR:MOD:EXT 'MyPMAR,3'"
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scpi.Parse "CALC1:FUNC:TYPE MEAN"

' Disable use of the sensor's internal cal factors, take a sweep
and report the Mean

scpi.Parse "SYST:CONF:EDEV:PMAR:CFAC:STAT 'MyPMAR', OFF"

scpi.Parse "SYST:CONF:EDEV:IOENable 'MyPMAR', ON"

opcReply = scpi.Parse("SENS1:SWE:MODE SING;*OPC?")

MsgBox "Use Internal Cal Factors = " &
scpi.Parse("SYST:CONF:EDEV:PMAR:CFAC:STAT? 'MyPMAR'") & ", Mean
measured val = " & scpi.Parse("CALC1:FUNC:EXEC;DATA?")

' Enable use of the sensor's internal cal factors, take another
sweep and report the Mean again

scpi.Parse "SYST:CONF:EDEV:IOENable 'MyPMAR', OFF"

scpi.Parse "SYST:CONF:EDEV:PMAR:CFAC:STAT 'MyPMAR', ON"

scpi.Parse "SYST:CONF:EDEV:IOENable 'MyPMAR', ON"

opcReply = scpi.Parse("SENS1:SWE:MODE SING;*OPC?")

MsgBox "Use Internal Cal Factors = " &
scpi.Parse("SYST:CONF:EDEV:PMAR:CFAC:STAT? 'MyPMAR'") & ", Mean
measured val = " & scpi.Parse("CALC1:FUNC:EXEC;DATA?")

Query Syntax SYSTem:CONFigure:EDEVice:PMAR:CFACtors:STATe?

Return Type Boolean

Default 1

SYSTem:CONFigure:EDEVice:PMAR:READing:COUNt <name>,<value>
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Applicable Models: All

(Read-Write) This command, along with SYST:CONF:EDEV:PMAR:READ:NTOL, allows for

settling of the power sensor READINGS.

Set and return the maximum number of power readings that are taken at each stimulus point to allow

for measurement settling. Each reading is averaged with the previous readings at that stimulus point.

When this average meets the Average:NTOLerance value or this number of readings has been made,

the average is returned as the valid reading.

Parameters  

<name> String - Name of the power meter.

<value> Number of readings. Choose a value between 1 and 25

Examples SYST:CONF:EDEV:PMAR:READ:COUN "myDevice", 20

system:configure:edevice:pmar:reading:count "myDevice", 10

See example program

Query Syntax SYSTem:CONFigure:EDEVice:PMAR:READing:COUNt? <name>

Return Type Numeric

Default 3

SYSTem:CONFigure:EDEVice:PMAR:READing:NTOLerance <name>,<value>

Applicable Models: All

(Read-Write) This command, along with SYST:CONF:EDEV:PMAR:READ:COUN, allows for

settling of the power sensor READINGS.

Each power reading is averaged with the previous readings at each stimulus point. When the average

meets this nominal tolerance value, or the max number of readings has been made, the average is

returned as the valid reading.

Parameters  

<name> String - Name of the power meter.

<value> Power measurement settling tolerance value in dB. Choose any number

between 0 and 5.
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Examples SYST:CONF:EDEV:PMAR:READ:NTOL "myDevice", .5

system:configure:edevice:pmar:reading:ntolerance "myDevice",.01

See example program

Query Syntax SYSTem:CONFigure:EDEVice:PMAR:READing:NTOLerance? <name>

Return Type Numeric

Default .05

SYSTem:CONFigure:EDEVice:PMAR:SENSor <name>,<value>

Applicable Models: All

(Read-Write) Sets and returns the power sensor channel (1 or 2) to be used.  This performs the same

function as the Use this sensor only checkbox.

Parameters  

<name> String - Name of the power meter.

<value> Power Meter channel.

1 - Channel A

2 - Channel B

Examples SYST:CONF:EDEV:PMAR:SENS "myDevice",2

system:configure:edevice:pmar:sensor "myDevice",1

See example program

Query Syntax SYSTem:CONFigure:EDEVice:PMAR:SENSor? <name>

Return Type Numeric

Default 1

SYSTem:CONFigure:EDEVice:PMAR:TABLe:CFAC:DATA <name>,<value>[,value]
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Applicable Models: All

(Read-Write) Sets and returns the cal factor data for the power sensor.

Parameters  

<name> String - Name of the power meter.

<value>[,value] Cal factor data in percent. For each frequency used with

SYST:CONF:EDEV:PMAR:TABL:CFAC:FREQ, enter a cal factor number

between 1 and 100.

Examples SYST:CONF:EDEV:PMAR:TABL:CFAC:DATA "myDevice", 98,99,99

system:configure:edevice:pmar:table:cfac:data "myDevice",
97,97,97

See example program

Query Syntax SYSTem:CONFigure:EDEVice:PMAR:TABLe:CFAC:DATA? <name>

Return Type Numeric - one number per table segment.

Default Not Applicable

SYSTem:CONFigure:EDEVice:PMAR:TABLe:CFAC:FREQuency <name>,<value>[,value]

Applicable Models: All

(Read-Write) Sets and returns the cal factor frequencies for the power sensor.

Parameters  

<name> String - Name of the power meter.

<value>[,value] Cal factor frequencies in Hz.

Examples SYST:CONF:EDEV:PMAR:TABL:CFAC:FREQ "myDevice", 1e7,1e8,1e9

system:configure:edevice:pmar:table:cfac:frequency "myDevice",
5e7,5e8,5e9

See example program

Query Syntax SYSTem:CONFigure:EDEVice:PMAR:TABLe:CFAC:FREQuency?<name>

Return Type Numeric - one number per table segment.

Default Not Applicable

SYSTem:CONFigure:EDEVice:PMAR:TABLe:LOSS:DATA <name>,<value>[,value]
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Applicable Models: All

(Read-Write) Sets and returns the power loss data for the power sensor.

Each table can contain up to 9999 segments. Values can also be loaded using the Characterize

Adapter macro.

Parameters  

<name> String - Name of the power meter.

<value>[,value] Loss data in dB. POSITIVE values in dB are interpreted as LOSS.  To

compensate for gain, use negative values.

For each frequency used with

SYST:CONF:EDEV:PMAR:TABL:LOSS:FREQ, enter a cal factor number

between 1 and 100.

Examples SYST:CONF:EDEV:PMAR:TABL:LOSS:DATA "myDevice",.01,.02,.03

system:configure:edevice:pmar:table:loss:data "myDevice",
.04,.05,.06

See example program

Query Syntax SYSTem:CONFigure:EDEVice:PMAR:TABLe:CFAC:DATA? <name>

Return Type Numeric - one number per table segment.

Default Not Applicable

SYSTem:CONFigure:EDEVice:PMAR:TABLe:LOSS:FREQuency <name>,<value>[,value]

Applicable Models: All

(Read-Write) Sets and returns frequencies for the power loss data.

Parameters  

<name> String - Name of the power meter.

<value>[,value] Power Loss frequencies in Hz.

Examples SYST:CONF:EDEV:PMAR:TABL:LOSS:FREQ "myDevice",1e7,1e8,1e9

system:configure:edevice:pmar:table:loss:frequency
"myDevice",5e7,5e8,5e9

See example program

Query Syntax SYSTem:CONFigure:EDEVice:PMAR:TABLe:LOSS:FREQuency? <name>
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Return Type Numeric - one number per table segment.

Default Not Applicable

SYSTem:CONFigure:EDEVice:PMAR:TABLe:LOSS:STATe <name>,<value>

Applicable Models: All

(Read-Write) Sets and returns whether to use the power loss table.

Parameters  

<name> String - Name of the power meter.

<value> Boolean. State of the power loss table. Choose from:

OFF or 0 - Power loss table not used.

ON or 1 - Power loss table used.

Examples SYST:CONF:EDEV:PMAR:TABL:LOSS:STAT "myDevice",1

system:configure:edevice:pmar:table:loss:state "myDevice",1

See example program

Query Syntax SYSTem:CONFigure:EDEVice:PMAR:TABLe:LOSS:STATe? <name>

Return Type Boolean

Default OFF

SYSTem:CONFigure:EDEVice:PMAR:TABLe:RFACtor <name>,<value>
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Applicable Models: All

(Read-Write) Sets and returns the reference cal factor for the power sensor.

Note: If the sensor connected to the power meter contains cal factors in EPROM (such as the Keysight

E-series power sensors), those will be the cal factors used. The reference cal factor value associated

with this command, and any cal factors entered into the VNA for that sensor channel, will not be used.

Parameters  

<name> String - Name of the power meter.

<value> Reference cal factor in percent.  Choose any number between 1 and 150.

Examples SYST:CONF:EDEV:PMAR:TABL:RFAC "myDevice", 1

system:configure:edevice:pmar:table:rfactor "myDevice", 1

See example program

Query Syntax SYSTem:CONFigure:EDEVice:PMAR:TABLe:RFACtor? <name>

Return Type Numeric

Default 100

SYSTem:CONFigure:EDEVice:PMAR:ZERO <name>[,SYNC,<value>]

Applicable Models: All

(Write-only) Performs a zeroing of the PMAR device.

This command is always synchronous, so *OPC? is the only way to determine that the operation is

complete. Set an I/O timeout of at least 20 seconds.

Keysight P-Series sensors do ONLY Internal zeroing. These, and Keysight USB power sensors when
Internal is selected, do NOT require disconnecting from the measurement path before zeroing.

All other Keysight sensors do ONLY External zeroing.

Parameters  

<name> String - Name of the power meter.

[,SYNC,<value>] Optional argument for use with power sensors that support both internal and

external types of zeroing such as Keysight USB power sensors.

Choose from:

SYNC,INTernal - Internal zeroing. Power is automatically removed from the sensor input
before zeroing occurs (Default setting).
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SYNC,EXTernal - External zeroing. First remove the sensor input, then send this command.
External zeroing is recommended for powers below -30 dBm with the U2000-Series sensors (-
20 dBm for the H models).

Examples SYST:CONF:EDEV:PMAR:ZERO "myDevice"

system:configure:edevice:pmar:zero "myDevice",sync,internal

Query Syntax Not Applicable

Default Not Applicable
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SYSTem:CONF:EDEVice:PULSe Commands

Configures and makes settings for an external Keysight 81110A Pulse Generator.

SYST:CONF:EDEVice:PULSe

     | CHAN

     | HAMP

     | LAMP

     | LIMP

     | MMODe

     | SIMP

Click on a keyword to view the command details.

See Also

Root SYST:CONF:EDEV commands

All Integrated Pulse App commands

Learn about: Configure an External Pulse Generator

Learn about Configure and External Device

SYST:PREF:ITEM:EDEV:DPOL - Determines whether External Devices remain activated or are de-activated when
the VNA is Preset or when a Instrument State is recalled.

Synchronizing the Analyzer and Controller

SCPI Command Tree

SYSTem:CONFigure:EDEVice:PULSe:CHAN <name>,<value>
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Applicable Models: All

(Read-Write) Sets and returns the output channel of the pulse generator.

Parameters  

<name> String - Name of the external pulse generator.

<value> Pulse Generator output port. Choose from 1 or 2.

Examples SYST:CONF:EDEV:PULS:CHAN "81110",1

system:configure:edevice:pulse:chan "myPG",2

Query Syntax SYSTem:CONFigure:EDEVice:DC:PULSe:CHAN? <name>

Return Type Numeric

Default 1

SYSTem:CONFigure:EDEVice:PULSe:HAMP <name>,<value>

Applicable Models: All

(Read-Write) Sets and returns the High amplitude (voltage) of the pulse generator.

Parameters  

<name> String - Name of the external pulse generator.

<value> Pulse Generator high amplitude voltage.

Examples SYST:CONF:EDEV:PULS:HAMP "81110",3

system:configure:edevice:pulse:HAMP "myPG",4

Query Syntax SYSTem:CONFigure:EDEVice:DC:PULSe:HAMP? <name>

Return Type Numeric

Default 5

SYSTem:CONFigure:EDEVice:PULSe:LAMP <name>,<value>
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Applicable Models: All

(Read-Write) Pulse Generator low amplitude voltage.

Parameters  

<name> String - Name of the external pulse generator.

<value> Pulse Generator low amplitude voltage.

Examples SYST:CONF:EDEV:PULS:LAMP "81110",.2

system:configure:edevice:pulse:lamp "myPG",1

Query Syntax SYSTem:CONFigure:EDEVice:DC:PULSe:LAMP? <name>

Return Type Numeric

Default 0

SYSTem:CONFigure:EDEVice:PULSe:LIMP <name>,<value>

Applicable Models: All

(Read-Write) Sets and returns the load impedance of the pulse generator.

Parameters  

<name> String - Name of the external pulse generator.

<value> Pulse generator load impedance.

Examples SYST:CONF:EDEV:PULS:LIMP "81110",52

system:configure:edevice:pulse:limp "myPG",49

Query Syntax SYSTem:CONFigure:EDEVice:DC:PULSe:LIMP? <name>

Return Type Numeric

Default 50

SYSTem:CONFigure:EDEVice:PULSe:MMODe <name>,<bool>
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Applicable Models: All

(Read-Write) Sets and returns the Master (On/Off) setting of the external pulse generator. The ON

setting allows the external pulse generator to set the master clock frequency for the other pulse

generators.

Parameters  

<name> String - Name of the external pulse generator.

<bool> Master setting. Choose from:

ON or 1 - Use the external pulse generator becomes the master clock

frequency.

OFF or 0 - Use the internal pulse generator as the master clock frequency.

Examples SYST:CONF:EDEV:PULS:MMOD "81110",OFF

system:configure:edevice:pulse:mmode "myPG",1

Query Syntax SYSTem:CONFigure:EDEVice:DC:PULSe:MMODe? <name>

Return Type Boolean

Default OFF or 0

SYSTem:CONFigure:EDEVice:PULSe:SIMP <name>,<value>

Applicable Models: All

(Read-Write) Sets and returns the source impedance of the pulse generator.

Parameters  

<name> String - Name of the external pulse generator.

<value> Pulse generator source impedance.

Examples SYST:CONF:EDEV:PULS:SIMP "81110",52

system:configure:edevice:pulse:simp "myPG",49

Query Syntax SYSTem:CONFigure:EDEVice:DC:PULSe:SIMP? <name>

Return Type Numeric

Default 50
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System:FIFO Commands

The 4 GB FIFO data buffer is available with Option S93118A or Option S930900A on the VNA and

N5264B. These commands control data in and out of FIFO data buffer. The FIFO can be emptied as it is

being filled, which means that the VNA can be used to acquire an infinite amount of data.

The data placed into the FIFO is the raw data after averaging and ratioing has been applied, but prior to

any calibration, formatting, or data analysis functions.

SYSTem:FIFO

DATA

       | BYTe?

            | COUNt?

       | CLEar

       | COUNT?

[:STATe]

Click on a red keyword to view the command details.

See Also

FIFO and other Antenna Features

Fast CW command

FIFO Example Program

Synchronizing the Analyzer and Controller

SCPI Command Tree

SYSTem:FIFO:DATA? <dpoints>
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Applicable Models: N522xB, N524xB

(Read-only) Reads the next specified number of data points from the FIFO buffer. Each data point is

returned as a real/imaginary pair. Data is cleared as it is read.

Parameters  

<dPoints> Number of data points to read. An error is returned if the amount of requested

data is larger than the available data.

Examples SYST:FIFO:DATA? 1e6

system:fifo:data? 1e3

Return Type Use FORMat:DATA to change the data type (<REAL,32>, <REAL,64> or

<ASCii,0>). For best results, use REAL,32

Use FORMat:BORDer to change the byte order. Use “NORMal” when

transferring a binary block from LabView or Vee. For other programming

languages, you may need to "SWAP" the byte order.

Each data point is returned as a real/imaginary pair.

Default Not applicable

SYSTem:FIFO:DATA:BYTe? <X>

Applicable Models: N522xB, N524xB

(Read-only) Returns a specific number of bytes to read.

Parameters  

<X> Number of bytes to read.

Examples SYST:FIFO:DATA:BYTe? 4096

system:fifo:data:byte? 4096

Return Type IEEE binary block

Default Not applicable

SYSTem:FIFO:DATA:BYTe:COUNt?
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Applicable Models: N522xB, N524xB

(Read-only) Returns a specific number of bytes to read.

Parameters  

Examples SYST:FIFO:DATA:BYTe:COUNt?

system:fifo:data:byte:count?

Return Type Integer

Default Not applicable

SYSTem:FIFO:DATA:CLEar

Applicable Models: N522xB, N524xB

(Write-only) Clears the data from the FIFO buffer.

Parameters None

Examples SYST:FIFO:DATA:CLE

system:fifo:data:clear

Return Type None

Default Not applicable

SYSTem:FIFO:DATA:COUNt?

Applicable Models: N522xB, N524xB

(Read-only) Returns the total number of data points in the FIFO buffer.

Parameters None

Examples SYST:FIFO:DATA:COUN?

' returns 5.07e6

Return Type Numeric

Default Not applicable

SYSTem:FIFO[:STATe] <bool>
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Applicable Models: N522xB, N524xB

(Write-Read) Sets and returns the state of data storage to the FIFO buffer. Syst:Preset or an instrument

state recall also ends storage to the FIFO buffer.  The FIFO buffer is cleared when set to OFF.

Parameters  

<bool> FIFO buffer state. Choose from:

ON or 1  Data is stored in the FIFO buffer.

OFF or 0 Data is NOT stored in the FIFO buffer.

Examples SYST:FIFO 1

system:fifo:state off

Query Syntax SYSTem:FIFO[:STATE]?

Return Type Boolean

Default 0 OFF
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System Preferences Commands

Sets and reads the VNA Preferences settings.

SYSTem:PREFerences

| DEFault

| ITEM

     | ASMRamp

     | EEXTrapolate

     | EDEV: DPOLicy

     | GDELay:TWOPoint

     | KEYS

     | MARKer:BANDwidth:SEARch

     | MARKer:SINGle

     | MCControl

     | MCMethod

     | MCPreset

     | MRU

     | OFFSet

           | RCV

           | SRC

     | PRESet:CONFirm

     | PRESet:POWer:STATe

     | PSRTrace

     | QSTart

     | RECeivers

           | CERRor

           | OVERload:POWer

     | REDLimits

     | REFMarker

     | RETRace:POWer

     | RTOF

     | SOFTkeys:NAVigation

     | SWITch:DEF

 

Click on a keyword to view the command details.

See Also
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SENS:CORRection:PREFerences

Learn about VNA Preferences

Example Programs

Synchronizing the Analyzer and Controller

SCPI Command Tree

SYSTem:PREFerences:ITEM:ASMRamp <bool>

Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Set and return whether ramp sweep is used whenever possible when sweep mode is in

Auto.

Parameters  

<bool> Choose from:

ON (1) Enable ramp sweep.

OFF (0) Disable ramp sweep.

Examples SYST:PREF:ITEM:ASMR 1
system:preferences:item:asmramp OFF

Query Syntax SYSTem:PREFerences:ITEM:ASMRamp?

Return Type Boolean

Default OFF

SYSTem:PREFerences:DEFault

Applicable Models: All

(Write-only) Resets the VNA preferences to their default settings.  Some default settings vary

depending on the VNA Model. Learn more about VNA Preferences.

Examples SYST:PREF:DEF
system:preferences:default

Query Syntax Not Applicable

Default Not Applicable
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SYSTem:PREFerences:ITEM:EDEV:DPOLicy <bool>

Applicable Models: All

(Read-Write) Set and return whether External Devices remain activated or are de-activated when the

VNA is Preset or when a Instrument State is recalled.

This setting remains until changed again using this command, or until the hard drive is changed or

reformatted.

Parameters  

<bool> Choose from:

OFF (0)  External devices remain active when the VNA is Preset or when a

Instrument State is recalled.

ON (1)  External devices are de-activated (SYST:CONF:EDEV:STAT to OFF)

when the VNA is Preset or when a Instrument State is recalled.

Examples SYST:PREF:ITEM:EDEV:DPOL 1
system:preferences:item:edev:dpolicy OFF

Query Syntax SYSTem:PREFerences:ITEM:EDEV:DPOLicy?

Return Type Boolean

Default ON or 1

SYSTem:PREFerences:ITEM:EEXTrapolate <bool>

Applicable Models: All

(Read-Write) Sets whether a Swept IMD or IMDx calibration can exceed the stop frequency limit of

an ECal module. Learn more.

Parameters  

<bool> Choose from:

ON (1)  Allow extrapolation.

OFF (0) Do NOT allow extrapolation.

Examples SYST:PREF:ITEM:EEXT 1

system:preferences:item:eextrapolate OFF

Query Syntax SYSTem:PREFerences:ITEM:EEXTrapolate?

Return Type Boolean
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Default OFF

SYSTem:PREFerences:ITEM:GDELay:TWOPoint <bool>

Applicable Models: All

(Read-Write) Sets the default group delay aperture setting. Learn more about group delay aperture.

Parameters  

<bool> Choose from:

ON (1)  Sets default group delay aperture to 2 points.

OFF (0) Sets default group delay aperture to 11 points.

Examples SYST:PREF:ITEM:GDELay:TWOPoint 1
system:preferences:item:gdelay:twopoint OFF

Query Syntax SYSTem:PREFerences:ITEM:GDELay:TWOPoint?

Return Type Boolean

Default OFF

SYSTem:PREFerences:ITEM:KEYS <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Set and return whether the keys are displayed or not.

Parameters  

<bool> Choose from:

ON (1) – Turn keys on.

OFF (0) – Turn keys off.

Examples SYST:PREF:ITEM:KEYS 1

system:preferences:item:keys OFF

Query Syntax SYSTem:PREFerences:ITEM:KEYS?

Return Type Boolean

Default OFF (0)
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SYSTem:PREFerences:ITEM:MARKer:BANDwidth:SEARch <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Sets the bandwidth search preference to start a bandwidth or notch search in either peak

or marker mode.

Parameters  

<bool> Choose from:

ON (1) Search starts at the x and y position of the active marker.

OFF (0) Search starts at the maximum y-value of the full sweep of data.

Examples SYST:PREF:ITEM:MARK:BAND:SEAR 1
system:preferences:item:marker:bandwidth:search OFF

Query Syntax SYSTem:PREFerences:ITEM:MARKer:BANDwidth:SEARch?

Return Type Boolean

Default OFF

SYSTem:PREFerences:ITEM:MARKer:SINGle <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Set and return whether to use one marker for marker search.

Enabled behavior:

Only one marker is used for bandwidth, notch, PNOP, and PSAT marker searches. The points of interest
are marked with a notational UI element, i.e. a small triangle.
Bandwidth, notch, PNOP, and PSAT marker searches are always tracking. Tracking cannot be disabled.
One basic search and one advanced search may be set per marker.
The advanced search is enabled until the user disables the search or a multi-peak or multi-target search is
executed.

Disabled behavior:

Bandwidth, notch, PSAT, and PNOP marker searches use multiple markers.
One advanced marker search is allowed per trace.
A marker may only perform a basic search or be part of an advanced search. Not both.
If an advanced marker search is enabled on a trace and then the user performs a basic search, the
advanced search is automatically disabled.
Advanced searches may enable or disable tracking. Only one search may be tracked.

Parameters  
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<bool> Choose from:

ON (1) Enable single marker search.

OFF (0) Disable single marker search.

Examples SYST:PREF:ITEM:MARK:SING 1
system:preferences:item:marker:single OFF

Query Syntax SYSTem:PREFerences:ITEM:MARKer:SINGle?

Return Type Boolean

Default ON

SYSTem:PREFerences:ITEM:MCControl <bool>

Applicable Models: All

(Read-Write) Set and return whether the Coupled Markers setting controls the ON|OFF state of

markers that are coupled. Learn more about Coupled Markers. Refer also to

CALC:MEAS:MARK:COUP:STATe ON.

Parameters  

<bool> Choose from:

ON (1) – With Coupled Markers ON, when a marker is turned on, the same-

numbered marker on all coupled traces will also be turned on. Likewise,

turning off a marker will turn it off on all coupled traces.

OFF (0) – Turning a marker on or off will have no effect on the markers on

other traces.

Examples SYST:PREF:ITEM:MCC 1

system:preferences:item:mccontrol OFF

Query Syntax SYSTem:PREFerences:ITEM:MCControl?

Return Type Boolean

Default OFF (0)

SYSTem:PREFerences:ITEM:MCMethod <bool>
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Applicable Models: All

(Read-Write) Set and return whether Coupled Markers is set to Channel or All after Preset. Learn more
about Coupled Markers. Refer also to CALC:MEAS:MARK:COUP:STATe ON and SYST:PREF:ITEM:MCPR
ON.

Parameters  

<bool> Choose from:

ON (1) – Marker Coupling Method is set to Channel after Preset.

OFF (0) – Marker Coupling Method is set to ALL after Preset.

Examples SYST:PREF:ITEM:MCM 1

system:preferences:item:mcmethod OFF

Query Syntax SYSTem:PREFerences:ITEM:MCMethod?

Return Type Boolean

Default OFF (0)

SYSTem:PREFerences:ITEM:MCPRest <bool>

Applicable Models: All

(Read-Write) Set and return whether Coupled Markers is set to ON or OFF after Preset. Learn more
about Coupled Markers.

Parameters  

<bool> Choose from:

OFF (0) – Coupled Markers is OFF after Preset.

ON (1) – Coupled Markers is ON after Preset.

Examples SYST:PREF:ITEM:MCPR 1

system:preferences:item:mcpreset OFF

Query Syntax SYSTem:PREFerences:ITEM:MCPReset?

Return Type Boolean

Default OFF (0)

SYSTem:PREFerences:ITEM:MINTerpolate <bool>
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Applicable Models: N522xB, N523xB, N524xB

(Read-Write) Sets and reads the state of the memory data interpolation default preference . The

PNA will return to the default interpolation state after a Preset, creating a new trace, or closing the

PNA application. Learn more.

Parameters  

<bool> Choose from:

0 - OFF - Set memory interpolation to OFF as the default.

1 - ON - Set memory interpolation to ON as the default.

Examples SYST:PREF:ITEM:MINT 1

Query Syntax SYSTem:PREFerences:ITEM:MINTerpolate?

Return Type Boolean

Default 0

SYSTem:PREFerences:ITEM:MRU <bool>

Applicable Models: All

(Read-Write) Set and return whether to list files for recall on softkeys by most-recently used or

alphabetically.

Parameters  

<bool> Choose from:

ON (1) – Recall softkeys show most recently-used files.

OFF (0) – Recall softkeys show alphabetically-ordered files.

Examples SYST:PREF:ITEM:MRU 1

system:preferences:item:mru OFF

Query Syntax SYSTem:PREFerences:ITEM:MRU?

Return Type Boolean

Default OFF (0)

SYSTem:PREFerences:ITEM:OFFSet:RCV <bool>
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Applicable Models: All

(Read-Write) Set and return whether to offset the test port receivers by the amount of receiver

attenuation. Learn more.

To send this command using the VNA front panel, open the GPIB Command Processor Console, then

type either of the following examples at the command prompt. Then type the Query Syntax and press

enter to be sure the VNA took the command.

This setting remains until changed again using this command, or until the hard drive is changed or

reformatted.

Parameters  

<bool> Choose from:

ON (1) Offset the test port receivers

OFF (0) Do NOT offset the test port receivers

Examples SYST:PREF:ITEM:OFFS:RCV 1
system:preferences:item:offset:rcv OFF

Query Syntax SYSTem:PREFerences:ITEM:OFFSet:RCV?

Return Type Boolean

Default VNA-L and E836xB: OFF (does NOT offset the display).

VNA-X: ON (offsets the display).

SYSTem:PREFerences:ITEM:OFFSet:SRC <bool>

Applicable Models: All

(Read-Write) Set and return whether to offset the reference receiver by the amount of source

attenuation. Learn more.

To send this command using the VNA front panel, open the GPIB Command Processor Console, then

type either of the following examples at the command prompt. Then type the Query Syntax and press
enter to be sure the VNA took the command.

This setting remains until changed again using this command, or until the hard drive is changed or

reformatted.

Parameters  
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<bool> Choose from:

ON (1) Offset the reference receivers.

OFF (0) Do NOT Offset the reference receivers.

Examples SYST:PREF:ITEM:OFFS:SRC 1
system:preferences:item:offset:src OFF

Query Syntax SYSTem:PREFerences:ITEM:OFFSet:SRC?

Return Type Boolean

Default All models: ON (offset the display).

SYSTem:PREFerences:ITEM:PRESet:CONFirm <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Set and return preset confirmation. If preset confirmation is OFF, pressing the green

PRESET key presets the instrument and opens the Preset softkey menu. If preset confirmation is ON,

pressing the green PRESET causes the Preset menu to appear.

Parameters  

<bool> Choose from:

ON (1) Enable preset confirmation.

OFF (0) Disable preset confirmation.

Examples SYST:PREF:ITEM:PRES:CONF 1
system:preferences:item:preset:confirm OFF

Query Syntax SYSTem:PREFerences:ITEM:PRESet:CONFirm?

Return Type Boolean

Default ON

SYSTem:PREFerences:ITEM:PRESet:POWer[:STATe] <char>
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Applicable Models: All

(Read-Write) Set and return the Preset Power ON/OFF state.  Learn more.

This setting remains until changed again using this command, or until the hard drive is changed or

reformatted.

Parameters  

<char> Choose from:

ON - Instrument Preset always turns RF power ON.

AUTO -  When the current power setting is OFF, leave power OFF after

Preset. When the current power setting is ON, turn power ON after Preset.

Examples SYST:PREF:ITEM:PRE:POW ON
system:preferences:item:preset:power:state auto

Query Syntax SYSTem:PREFerences:ITEM:PREset:POWer[:STATe]?

Return Type Character

Default ON

SYSTem:PREFerences:ITEM:PSRTrace <char>

Applicable Models: All

(Read-Write) At the end of a power sweep, while waiting to trigger the next sweep, maintain source

power at either the start power level or at the stop power level.

To send this command using the VNA front panel, open the GPIB Command Processor Console, then

type either of the following examples at the command prompt. Then type the Query Syntax and press

enter to be sure the VNA took the command.

This setting remains until changed again using this command, or until the hard drive is changed or
reformatted.

Parameters  

<char> Choose from:

STARt -  Maintain source power at the start power level.

STOP -  Maintain source power at the stop power level.

Examples SYST:PREF:ITEM:PSRT STOP
system:preferences:item:psrtrace start
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Query Syntax SYSTem:PREFerences:ITEM:PSRTrace?

Return Type Character

Default STARt

SYSTem:PREFerences:ITEM:QSTart <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) This command controls the on/off state of the preference, "On PRESET show Quick

Start dialog".

Parameters  

<bool> Choose from:

ON (1)  Display the Quick Start dialog on PRESET.

OFF (0) Do not display the Quick Start dialog on PRESET.

Examples SYST:PREF:ITEM:QST 1
system:preferences:item:qstart OFF

Query Syntax SYSTem:PREFerences:ITEM:QST?

Return Type Boolean

Default OFF

SYSTem:PREFerences:ITEM:RECeivers:CERRor[:STATe] <bool>

Applicable Models: All

(Read-Write) Set and return whether to display receiver overload warnings. Learn more.

Parameters  

<bool> Choose from:

ON (1)  Display overload warnings,

OFF (0) Do NOT display overload warnings.

Examples SYST:PREF:ITEM:REC:CERR 1

system:preferences:item:receivers:cerror:state OFF

Query Syntax SYSTem:PREFerences:ITEM:RECeivers:CERRor[:STATe]?

Return Type Boolean
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Default ON

SYSTem:PREFerences:ITEM:RECeivers:OVERload:POWer[:STATe] <bool>

Applicable Models: All

(Read-Write) Set and return whether to turn source power OFF when a receiver is overloaded. Learn
more.

Parameters  

<bool> Choose from:

ON (1)  Turn OFF source power to ALL ports when a receiver is overloaded.

OFF (0)  Power remains ON when a receiver is overloaded.

Examples SYST:PREF:ITEM:REC:OVER:POW 1

system:preferences:item:receivers:overload:power:state OFF

Query Syntax SYSTem:PREFerences:ITEM:RECeivers:OVERload:POWer[:STATe]?

Return Type Boolean

Default OFF (0)

SYSTem:PREFerences:ITEM:REDLimits <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Set and return whether to draw limits lines in Red or the trace color.

Parameters  

<bool> Choose from:

ON (1)  All Limit lines are drawn in Red.

OFF (0)  Limit lines are drawn the same color as the trace.

Examples SYST:PREF:ITEM:REDL 1

system:preferences:item:redlimits OFF

Query Syntax SYSTem:PREFerences:ITEM:REDLimits?

Return Type Boolean

Default OFF
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SYSTem:PREFerences:ITEM:REFMarker <bool>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) Set and return whether to treat marker 10 as a reference marker. Learn more.

Parameters  

<bool> Choose from:

ON (1)  Marker 10 is always a reference marker (Pre A.10.40 behavior).

OFF (0)  Marker 10 is just another marker. See Reference Marker commands

Examples SYST:PREF:ITEM:REFM 1

system:preferences:item:refmarker OFF

Query Syntax SYSTem:PREFerences:ITEM:REFMarker?

Return Type Boolean

Default OFF

SYSTem:PREFerences:ITEM:RETRace:POWer <char>

Applicable Models: All

(Read-Write) For single-band frequency or segment sweeps ONLY, specify whether to turn RF power

ON or OFF during a retrace. Learn more about RF power during sweep retrace.

To send this command using the VNA front panel, open the GPIB Command Processor Console, then

type either of the following examples at the command prompt. Then type the Query Syntax and press

enter to be sure the VNA took the command.

This setting remains until changed using this command, or until the hard drive is changed or

reformatted.

Parameters  

<char> Choose from:

AUTO: Power is left ON during retrace of single-band frequency or segment

sweeps ONLY.

OFF: Power is turned OFF during retrace of single-band frequency or segment

sweeps ONLY.
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Examples SYST:PREF:ITEM:RETR:POW OFF

system:preferences:item:retrace:power auto

Query Syntax SYSTem:PREFerences:ITEM:RETRace:POWer?

Return Type Character

Default AUTO

SYSTem:PREFerences:ITEM:RTOF <bool>

Applicable Models: All

(Read-Write) Set and return whether to display limit line failures as red trace segments or red data

points (dots). Learn more.

Parameters  

<bool> Choose from:

ON (1)  Display failures as red trace segments. (Red Trace On Fail).

OFF (0) Display failures as red data points (dots).

Examples SYST:PREF:ITEM:RTOF 1
system:preferences:item:rtof OFF

Query Syntax SYSTem:PREFerences:ITEM:RTOF?

Return Type Boolean

Default OFF

SYSTem:PREFerences:ITEM:SOFTkeys:NAVigation <bool>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write) This command controls the on/off state of the preference, "Use keyboard to navigate

softkeys".

Parameters  

<bool> Choose from:

ON (1)  Enable softkey navigation with keyboard.

OFF (0) Disable softkey navigation with keyboard.

Examples SYST:PREF:ITEM:SOFT:NAV 1
system:preferences:item:softkeys:navigation OFF

Query Syntax SYSTem:PREFerences:ITEM:SOFTkeys:NAVigation?

Return Type Boolean

Default OFF

SYSTem:PREFerences:ITEM:SWITch:DEF <string>, <int>

Applicable Models: All

(Read-Write) Sets the default setting for the Noise Tuner switch. This is the setting that occurs when a

new channel is created. Learn more.

This command will return an error on VNA models with a built-in Noise tuner.

To send this command using the VNA front panel, open the GPIB Command Processor Console, then

type either of the following examples at the command prompt. Then type the Query Syntax and press

enter to be sure the VNA took the command.

This setting remains until changed using this command, or until the hard drive is changed or

reformatted.

Parameters  

<string> Name of the switch to set. Choose from:

"Port1NoiseTuner"

<int> Value to set. Choose from:

0  Sets the default (preset) to INTERNAL

1  Sets the default (preset) to EXTERNAL
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Examples SYST:PREF:ITEM:SWIT:DEF "Port1NoiseTuner" 1 'Write

system:preferences:item:switch:def? "Port1NoiseTuner" 'Read

Query Syntax SYSTem:PREFerences:ITEM:SWITch:DEF? <switch>

Return Type Integer

Default 1  (External)
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PXI Shared Memory Data Transfer

The fastest way to transfer data out of a PXIe VNA is to use shared memory. Due to the nature of

shared memory, these commands can ONLY be used to transfer data between your program and the

VNA when your program runs locally on the same computer as the VNA.

Shared Memory Background: Usually, each process has its own memory, and anything saved in one

process isn't visible to another process. With shared memory, both processes actually connect to the

same memory, so what happens in one process is now visible to another process.

How to setup Shared Memory

Send SYST:DATA:MEM:INITialize. This tells the VNA to prepare for the creation of shared memory.1.

Decide which measurements to include in the shared memory. For each of those measurements, send
SYST:DATA:MEM:ADD. This adds a request to copy the contents of those measurements into the shared
memory. This does not start adding data.

2.

Send SYST:DATA:MEM:COMMit. This command tells the VNA to create the Windows shared memory
resource and to give that shared memory resource a name.

3.

You can now create a handle to the shared memory and start reading the data from that shared memory.
Once setup, the VNA remembers the setup, and the shared memory will be filled on each sweep. You do not
send any more SCPI commands unless you need to change the list of requested measurements to include in
the shared memory.

4.

See C# example

SYSTem: DATA:MEMory Commands

Controls Shared Memory.

The commands are listed in order of recommended use.
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SYSTem:DATA:MEMory:

INITialize

ADD

OFFSet?

NAME?

COMMit

SIZE?

DELete

RESet

 

Click on a keyword to view the command details.

See Also

SCPI Command Tree

SYSTem:DATA:MEMory:INITialize

Applicable Models: M9485A, M937xA

(Write only) Initializes the shared memory setup buffers.

Parameters None

Examples See an example program

Query Syntax Not Applicable

Default Not Applicable

SYSTem:DATA:MEMory:ADD <string>

Applicable Models: M9485A, M937xA

(Write only) Add a request to copy the contents of the specified measurement into shared memory.

Call this command once for each measurement definition. Once the shared memory is setup, there is

no need to send more SCPI commands. The shared memory is filled automatically on every sweep.

Parameters  

<string> The following elements separated with colons (:).
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<Ch>:<MeasNum>:<dataFormat>:<numPoints>

where:

<Ch> - Channel number of the measurement to share memory. Use
SYST:ACTive:CHAN to return the active channel number. Use SYST:CHAN:CAT?
to return the channel numbers in use.

<MeasNum> - Measurement (Tr) number to share memory. Use
CALC<ch>:PAR:MNUM? just after the trace is created to read the measurement
number. See also: Referring to Traces, Measurements, Channels, and Windows
Using SCPI.

<dataFormat> - Choose from:

SDATA - Complex measurement data.

Reads data from Apply Error Terms (access point 1). Returns TWO
numbers per data point. Corrected data is returned when correction is
ON. Uncorrected data is returned when correction is OFF.

FDATA - Formatted measurement data to or from Data Access Map
location Display (access point 2).

Corrected data is returned when correction is ON.

Uncorrected data is returned when correction is OFF.

Returns one number per data point for all other formats.

Format of the read data is same as the displayed format.

<numPoints> - Number of data points in the measurement trace.

Examples SYSTem:DATA:MEMory:ADD "2:3:SDATA:201"

'copies the data for channel #2, measurement #3, complex data, 201 points into
the shared memory buffer.

See an example program

Query Syntax Not Applicable

Default Not Applicable

SYSTem:DATA:MEMory:OFFSet?

1614



Applicable Models: M9485A, M937xA

(Read only) The shared memory is a contiguous block of memory. Each measurement takes up a

subset of this contiguous block.  This command returns the offset (in bytes) into the shared memory

for the most recently added parameter. The offset is a number that specifies the starting index (in

bytes) of the data.

This query can be sent after sending SYST:DATA:MEM:ADD.

Parameters None

Examples See an example program

Return Type Numeric

Default Not Applicable

SYSTem:DATA:MEMory:NAME?

Applicable Models: M9485A, M937xA

(Read only) Returns a unique, auto-generated name that can be used in the COMMIt command. By

using this generated name, a client can be sure not to conflict with any other used shared memory

regions.

Parameters None

Examples See an example program

Return Type String

Default Not Applicable

SYSTem:DATA:MEMory:COMMit <memName>
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Applicable Models: M9485A, M937xA

(Write only) Allocates the memory mapped buffer.

Parameters  

<memName> String. Name of the memory mapped buffer. This must be a unique name, and

cannot conflict with other shared memory buffer names. Use this command in

your program when connecting to the shared memory.

See SYSTem:DATA:MEMory:NAME?

Examples See an example program

Query Syntax Not Applicable

Default Not Applicable

SYSTem:DATA:MEMory:SIZE?

Applicable Models: M9485A, M937xA

(Read only) Returns the size of the memory mapped region. Send this immediately after

SYST:DATA:MEM:COMMit. The result is the total size (in bytes) of all the measurements in the shared

memory region.

Parameters None

Examples See an example program

Return Type Numeric

Default Not Applicable

SYSTem:DATA:MEMory:CATalog?

Applicable Models: M9485A, M937xA

(Read only) Returns a list of all the allocated shared memory buffers

Parameters None

Examples See an example program

Return Type String

Default Not Applicable
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SYSTem:DATA:MEMory:RESet

Applicable Models: M9485A, M937xA

(Write only) Deletes all allocated shared memory buffers

Parameters None

Examples See an example program

Query Syntax Not Applicable

Default Not Applicable

SYSTem:DATA:MEMory:DELete <memName>

Applicable Models: M9485A, M937xA

(Write only) Allocates the specified memory mapped buffer.

Parameters  

<memName> String. Name of the memory mapped buffer. This is the unique name that is

used in the COMMit command.

Examples See an example program

Query Syntax Not Applicable

Default Not Applicable

Example Program

 

    static void Main(string[] args)

    {

        // Connect to the hislip VISA address of localhost

        ResourceManager resourceManager = new ResourceManager();

        FormattedIO488 formattedIO = new FormattedIO488();

        formattedIO.IO =
(IMessage)resourceManager.Open("TCPIP0::localhost::hislip0::INSTR");

 

        // Destroy all measurements and add a window
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        formattedIO.WriteString("SYST:FPR\n");

        formattedIO.WriteString("DISP:WIND:STAT 1");

 

        // initialize memory mapped structures in VNA

        formattedIO.WriteString("SYST:DATA:MEM:INIT\n");

 

        // Create 4 SParameters

        string[] parameters = new string[] { "S11", "S21", "S12", "S22" };

        int[] offsets_for_complex_data = new int[parameters.Length];

        int[] offsets_for_formatted_data = new int[parameters.Length];

        for (int i = 0; i < parameters.Length; i++)

        {

            // Create a new parameter

            formattedIO.WriteString("CALC:PAR:DEF '" + parameters[i] + "'," +
parameters[i]);

            formattedIO.WriteString("DISP:WIND:TRAC" + (i + 1).ToString() + ":FEED '" +
parameters[i] + "'");

 

            // Configure a new section of the memory map to monitor the complex data of
this parameter

            formattedIO.WriteString("SYST:DATA:MEM:ADD '1:" + (i + 1).ToString() +
":SDATA:201'"); // add parameter to memory mapped

            formattedIO.WriteString("SYST:DATA:MEM:OFFSet?");

            offsets_for_complex_data[i] = int.Parse(formattedIO.ReadString());

 

            // Configure a new section of the memory map to monitor the formatted data of
this parameter

            formattedIO.WriteString("SYST:DATA:MEM:ADD '1:" + (i + 1).ToString() +
":FDATA:201'"); // add parameter to memory mapped

            formattedIO.WriteString("SYST:DATA:MEM:OFFSet?");

            offsets_for_formatted_data[i] = int.Parse(formattedIO.ReadString());
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        }

 

        // Tell the VNA to allocate the memory map. Name it "VNA_MemoryMap"

        formattedIO.WriteString("SYST:DATA:MEM:COMM 'VNA_MemoryMap'");

 

        // Query the size of the memory map

        formattedIO.WriteString("SYST:DATA:MEM:SIZE?");

        int size = int.Parse(formattedIO.ReadString());

 

        // Create the memory map in C#. This requires .NET 4.5 framework

        MemoryMappedFile mappedFile = MemoryMappedFile.CreateOrOpen("VNA_MemoryMap", size);

        MemoryMappedViewAccessor mappedFileView = mappedFile.CreateViewAccessor();

 

        // Trigger a single sweep, and wait for it to complete

        formattedIO.WriteString("SENS:SWE:MODE SING");

        formattedIO.WriteString("*OPC?");

        formattedIO.ReadString();

 

        // Allocate buffers to hold the output data

        float[][] complexData = new float[parameters.Length][];

        for (int i = 0; i < complexData.Length; i++)

        {

            complexData[i] = new float[402];

        }

 

        float[][] formattedData = new float[parameters.Length][];

        for (int i = 0; i < formattedData.Length; i++)

        {
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            formattedData[i] = new float[201];

        }

 

        // Copy the data from the memory map into the output buffers

        // These copy the data from the in-process memory map.

        // This runs very fast - and is just a "memcpy" under the hood

        for (int i = 0; i < parameters.Length; i++)

        {

            ReadBytes(mappedFileView,offsets_for_complex_data[i],402,complexData[i]);

            ReadBytes(mappedFileView, offsets_for_formatted_data[i], 201,
formattedData[i]);

        }

 

        // Output some data to show that it worked

        System.Console.WriteLine(complexData[0][0].ToString()); // Output first point of
S11 in complex

        System.Console.WriteLine(formattedData[3][200].ToString()); // Output last point of
S22 as formatted

    }

 

 

    static public unsafe void ReadBytes(MemoryMappedViewAccessor mappedFileView,

        int offset, int num, float[] arr)

    {

        // This is equivalent to:

        //         //m_mappedFileView.ReadArray<float>(m_sharedMemoryOffsets[i-1],
complexArray, 0, points*2);

        // But, using this "unsafe" code is 30 times faster. 100usec versus 3ms

        byte* ptr = (byte*)0;

        mappedFileView.SafeMemoryMappedViewHandle.AcquirePointer(ref ptr);
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        System.Runtime.InteropServices.Marshal.Copy(IntPtr.Add(new IntPtr(ptr), offset),
arr, 0, num);

        mappedFileView.SafeMemoryMappedViewHandle.ReleasePointer();

    }

 

}
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SYSTem:UNCertainty

Contains the settings to create and control Dynamic Uncertainty for S-Parameters (Opt. S93015A).

Setup Options

SYST:UNC:ETER:NOIS:ENAB

SYST:UNC:ETER:CABL:REP

SYST:UNC:ETER:SDEF

SYST:UNC:POIN:MAX

Noise Characterization

Clear noise data on specified port SYST:UNC:PORT<p>:NOISe:RESet

Clear noise data on all ports SYST:UNC:PORT:NOISe:RESet

Copy noise from a port to all ports SYST:UNC:PORT:NOISe:ALL:COPY

Start Noise char SENS:CORR:COLL:GUIDed:UNC:CHAR:NOISe

Cables Characterization

List cables SYST:UNC:CABLe:CATalog?

Assign Cable to all ports SYST:UNC:PORT:CABLe:ALL

Assign Cable to specified port SYST:UNC:PORT<p>:CABLe

Reset repeatability SYST:UNC:CABL:REP:RES

Start Cable char SENS:CORR:COLL:GUIDed:UNC:CHAR:CABLe

Uncertainty workspace

Load workspace SYST:UNC:LOAD

Save workspace SYST:UNC:STORe

Enable a Guided Cal to include Uncertainties

Checkbox on Guided Cal Select Ports page SENS:CORR:COLL:GUID:UNC
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Trace Properties

CALC:MEAS:UNC:DISP:TYPE

CALC:MEAS:UNC:DISP:CFAC

CALC:MEAS:UNC:MOD:NOIS

CALC:MEAS:UNC:MODE:CABL:REP

CALC:MEAS:UNC:MOD:ETER

Apply to all traces None

Add Trace None

Save uncertainty data CALC:MEAS:UNC:SAVE

 

Limitations

Calibrations can be performed for ONLY ONE channel at a time.

Putting Error Term data into Uncertainty Cal Sets using remote commands is NOT supported.

See Also

Trace Commands for Dynamic Uncertainty

Learn more about Dynamic Uncertainty

Example Program

Guided Cal commands

Synchronizing the Analyzer and Controller

SCPI Command Tree

SYSTem:UNCertainty:CABLe:CATalog?
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Applicable Models: N522xB, N523xB, N524xB

(Read-only)  Returns a comma-delimited list of names of cables that are defined in the Uncertainty

Manager application.

Parameters None

Examples SYST:UNC:CABL:CAT?

Return Type Comma-delimited string

Default Not Applicable

SYSTem:UNCertainty:CABLe:REPeat:RESet <cableName>

Applicable Models: N522xB, N523xB, N524xB

(Write-only) Resets (clears) the characterized repeatability data associated with the specified cable.

Parameters  

<cableName> String. Name of the cable for which data is to be reset.

Examples SYST:UNC:CABL:REP:RES "MyCable"

Query Syntax Not Applicable

Default Not Applicable

SYSTem:UNCertainty:PORT:CABLe:ALL[:SELect] <cableName>

Applicable Models: N522xB, N523xB, N524xB

(Write-only) Sets the name of the cable to be associated with all the ports currently enabled on the

VNA

Parameters  

<cableName> String. Name of the cable.

Examples SYST:UNC:PORT:CABL:ALL "MyCable"

Query Syntax Not Applicable

Default Not Applicable

SYSTem:UNCertainty:PORT<pNum>:CABLe[:SELect] <cableName>
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Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the name of the cable to be associated with the specified port number

on the VNA

Parameters  

<pNum> VNA port number.

<cableName> String. Name of the cable.

Examples SYST:UNC:PORT3:CABL "MyCable"

Query Syntax SYSTem:UNCertainty:PORT<pNum>:CABLe[:SELect]?

Return Type String

Default Not Applicable

SYSTem:UNCertainty:PORT:NOISe:ALL:COPY <pNum>

Applicable Models: N522xB, N523xB, N524xB

(Write-only) Copies the characterized noise data associated with the specified port, to all the other

ports

Parameters  

<pNum> VNA port number for which noise data will be copied.

Examples SYST:UNC:PORT:NOIS:ALL:COPY 2

Query Syntax Not Applicable

Default Not Applicable

SYSTem:UNCertainty:PORT:NOISe:ALL:RESet

Applicable Models: N522xB, N523xB, N524xB

(Write-only) Resets (clears) the characterized noise data for all currently enabled VNA ports.

Parameters None

Examples SYST:UNC:PORT:NOIS:ALL:RESet

Query Syntax Not Applicable

Default Not Applicable
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SYSTem:UNCertainty:PORT<pNum>:NOISe:RESet

Applicable Models: N522xB, N523xB, N524xB

(Write-only) Resets (clears) the characterized noise data for the specified VNA port.

Parameters None

<pNum> VNA port number for which noise data will be reset.

Examples SYST:UNC:PORT2:NOIS:RESet

Query Syntax Not Applicable

Default Not Applicable

SYSTem:UNCertainty:LOAD <filename>

Applicable Models: N522xB, N523xB, N524xB

(Write-only) Loads an uncertainty ‘workspace’ (*.ml4) file into the Uncertainty Manager.

Parameters None

<filename> String. Full path, filename, and extension of the uncertainty workspace file,

enclosed in quotes.

Examples SYST:UNC:LOAD "C:\MyUncert.ml4"

Query Syntax Not Applicable

Default Not Applicable

SYSTem:UNCertainty:STORe [filename]

1626



Applicable Models: N522xB, N523xB, N524xB

(Write-only) Saves the current uncertainty ‘workspace’ of the Uncertainty Manager to a (‘.ml4’) file. 

Parameters None

<filename> String. Optional argument. Full path, filename, and extension of the uncertainty

workspace file, enclosed in quotes. 

If filename is not specified, the current workspace is saved to the default

workspace (*.ml4) file.

Examples SYST:UNC:STORe "C:\MyUncert.ml4"

Query Syntax Not Applicable

Default Not Applicable

SYSTem:UNCertainty:POINts:MAXimum <num>

Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the maximum number of points (“decimation value”) for which

uncertainties are to be computed for subsequent calibrations that are performed using Dynamic

Uncertainty for S-Parameters.

Parameters  

<num> Max number of points. Specify an integer between 0 and 501.

Examples SYST:UNC:POIN:MAX 201

Query Syntax SYSTem:UNCertainty:POINts:MAXimum?

Return Type Numeric

Default 500

SYSTem:UNCertainty:ETERm:NOISe:ENABle <bool>
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Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the ON/OFF state of allowing noise data to contribute to the uncertainty

of a calibration performed using Dynamic Uncertainty for S-Parameters. Noise data must also be

present for the ports at the time the calibration is performed.

Parameters  

<bool> Enable ON/OFF state. Choose from:

ON or 1 - Noise uncertainty ON.

OFF or 0 - Noise uncertainty OFF.

Examples SYST:UNC:ETER:NOIS:ENAB ON

Query Syntax SYSTem:UNCertainty:ETERm:NOISe:ENABle?

Return Type Boolean

Default ON

SYSTem:UNCertainty:ETERm:CABLe:REPeat[:ENABle] <bool>

Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the ON/OFF state of allowing cable repeatability data to contribute to

the uncertainty of a calibration performed using Dynamic Uncertainty for S-

Parameters. Repeatability data must also be present for the ports at the time the calibration is

performed.

Parameters  

<bool> Enable ON/OFF state. Choose from:

ON or 1 - Cable repeatability uncertainty ON.

OFF or 0 - Cable repeatability uncertainty OFF.

Examples SYST:UNC:ETER:CABL:REP ON

Query Syntax SYSTem:UNCertainty:ETERm:CABLe:REPeat[:ENABle]?

Return Type Boolean

Default ON

SYSTem:UNCertainty:ETERm:SDEFinitions[:ENABle] <bool>
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Applicable Models: N522xB, N523xB, N524xB

(Write-Read) Sets and returns the ON/OFF state of allowing the uncertainty associated with the

standard definitions in the cal kits to contribute to the uncertainty of a calibration performed using

Dynamic Uncertainty for S-Parameters.  The uncertainty data for the Cal standards must also be

present at the time the calibration is performed.

Parameters  

<bool> Enable ON/OFF state. Choose from:

ON or 1 - Standard definition uncertainty ON.

OFF or 0 - Standard definition uncertainty OFF.

Examples SYST:UNC:ETER:SDEF ON

Query Syntax SYSTem:UNCertainty:ETERm:SDEFinitions[:ENABle]?

Return Type Boolean

Default ON
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SYSTem:SERVice:PVERify Commands

Controls and queries settings for editing the Instrument Calibration Verification field on the Help

About dialog. Learn more.

SYSTem:SERVice:PVERify

INTerval

LAST

NEXT

 

Click on a keyword to view the command details.

See Also

SCPI Command Tree

SYSTem:SERVice:PVERify:INTerval <days>,<mod>

Applicable Models: M937xA, M9485A

(Read-Write) Sets and reads the interval between Instrument Calibrations. One year (365 days) is

recommended.

Parameters  

<days> (Integer) Interval in days.

<mod> (Integer) Slot number in which the module resides.

Examples 'Set 1 year interval

SYST:SERV:PVER:INT 365,1

Query Syntax SYSTem:SERVice:PVERify:INTerval? <mod>

Return Type Numeric

Default 0

SYSTem:SERVice:PVERify:LAST <date>,<mod>
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Applicable Models: M937xA, M9485A

(Read-Write) Sets and reads the date of the last Instrument Calibration.

Parameters  

<date> Date in the form: yyyy,mm,dd

<mod> (Integer) Slot number in which the module resides.

Examples 'The following sets the date of the last calibration for the
module in slot 1 to July 19, 2014

SYST:SERV:PVER:LAST 2014,07,19,1

The following reads the previous setting

SYST:SERV:PVER:LAST? 1

'2014,7,9

Query Syntax SYSTem:SERVice:PVERify:LAST? <mod>

Return Type Comma-separated integers

Default 0,0,0 (not set)

SYSTem:SERVice:PVERify:NEXT? <mod>

Applicable Models: M937xA

(Read-only)  Reads the due date of the next Instrument Calibration.

Parameters  

<mod> (Integer) Slot number in which the module resides.

Examples SYST:SERV:PVER:NEXT? 1

'returns: 2015,7,9

Return Type Numeric in the form: yyyy,mm,dd

Default Not Applicable
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Trigger Commands

Controls External Triggering.

TRIGger:

AUXiliary

       | COUNt

CHANnel:AUXiliary

       | DELay

       | DURation

       | [ENABle]

       | HANDshake

       | INTerval

       | IPOLarity

       | OPOLarity

       | POSition

       | TYPE

DELay

PREFerence

       | AIGLobal

READy:POLarity

[SEQuence]

       | LEVel

       | ROUTE

             | INPut

             | READy

       | SCOPe

       | SOURce

       | SLOPe
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       | TYPE

STATus

       | READy?

Click on a keyword to view the command details.

Blue commands are superseded.

See Also

Example program Triggering the VNA

See other SCPI Triggering commands

Learn about External / Aux Triggering

Synchronizing the Analyzer and Controller

SCPI Command Tree

TRIGger:AUXiliary:COUNt?

Applicable Models: N522xB, N523xB, N524xB, E5080A, M937xA, M9485A

(Read-only)  Returns the number of AUX trigger input / output connector pairs in the instrument.

Parameters  

Examples TRIG:AUX:COUN?

trigger:auxiliary:count?

Return Type Numeric

Default Not Applicable

TRIGger:CHANnel<ch>:AUXiliary<n>:DELay <num>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write)  Specifies the delay that should be applied by the VNA after the Aux trigger input is

received and before the acquisition is made.

Parameters  

<ch> Any existing channel number.  If unspecified, value is set to 1.

<n> AUX Trigger connector used to send or receive signals.

Choose from 1 (AUX TRIG 1) or 2 (AUX TRIG 2)

If unspecified, value is set to 1.

<num> Delay value in seconds. Choose a value between 0 and 3.0 seconds.

Examples TRIG:CHAN:AUX:DEL .5

trigger:channel2:aux2:delay 1.5

Query Syntax TRIGger:CHANnel<ch>:AUXiliary<n>:DELay?

Return Type Numeric

Default 0

TRIGger:CHANnel<ch>:AUXiliary<n>:DURation <num>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M937xA, M9485A

(Read-Write)  Specifies the width of the output pulse, which is the time that the Aux trigger output

will be asserted.

Parameters  

<ch> Any existing channel number.  If unspecified, value is set to 1.

<n> AUX Trigger connector used to send or receive signals.

Choose from 1 (AUX TRIG 1) or 2 (AUX TRIG 2)

If unspecified, value is set to 1.

<num> Duration value in seconds. Choose a value between 1us (1E-6) and 1

Examples TRIG:CHAN:AUX:DUR .1

trigger:channel2:aux2:duration .01

Query Syntax TRIGger:CHANnel<ch>:AUXiliary<n>:DURation?

Return Type Numeric
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Default 1E-6

TRIGger:CHANnel<ch>:AUXiliary<n>[:ENABle] <bool>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M937xA, M9485A

(Read-Write)   Turns ON / OFF the trigger output.

Parameters  

<ch> Any existing channel number.  If unspecified, value is set to 1.

<n> AUX Trigger connector used to send or receive signals.

Choose from 1 (AUX TRIG 1) or 2 (AUX TRIG 2)

If unspecified, value is set to 1.

<bool> ON (or 1) - turns trigger output ON.

OFF (or 0) - turns trigger output OFF.

Examples TRIG:CHAN:AUX 1

trigger:channel2:aux2:enable off

Query Syntax TRIGger:CHANnel<ch>:AUXiliary<n>:[ENABle]?

Return Type Boolean

Default OFF

TRIGger:CHANnel<ch>:AUXiliary<n>:HANDshake <bool>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write)  Turns handshake ON / OFF.

To enable handshake, the main trigger enable must also be set using TRIG:CHAN:AUX:ENAB.

When ON, VNA waits indefinitely for the input line to be asserted before continuing with the

acquisition. When OFF, the VNA acquires data without waiting.

Parameters  

<ch> Any existing channel number.  If unspecified, value is set to 1.

<n> AUX Trigger connector used to send or receive signals.

Choose from 1 (AUX TRIG 1) or 2 (AUX TRIG 2)

If unspecified, value is set to 1.

<bool> ON (or 1) - turns handshaking ON.

OFF (or 0) - turns handshaking OFF.

Examples TRIG:CHAN:AUX:HAND 1

trigger:channel2:aux2:handshake off

Query Syntax TRIGger:CHANnel<ch>:AUXiliary<n>:HANDshake?

Return Type Boolean

Default OFF

TRIGger:CHANnel<ch>:AUXiliary<n>:INTerval <char>

1636



Applicable Models: N522xB, N523xB, N524xB, E5080A, M937xA, M9485A

(Read-Write)  Specifies how often a trigger output signal is sent.

Parameters  

<ch> Any existing channel number.  If unspecified, value is set to 1.

<n> AUX Trigger connector used to send or receive signals.

Choose from 1 (AUX TRIG 1) or 2 (AUX TRIG 2)

If unspecified, value is set to 1.

<char> Choose from:

POINt   Trigger signal is sent every data point. (effectively the same as Point
sweep)

SWEep  Trigger signal is sent once every sweep.

Examples TRIG:CHAN:AUX:INT POI

trigger:channel2:aux2:interval sweep

Query Syntax TRIGger:CHANnel<ch>:AUXiliary<n>:INTerval?

Return Type Character

Default SWEep

TRIGger:CHANnel<ch>:AUXiliary<n>:IPOLarity  <char>

Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write)  Specifies the polarity of the trigger IN signal to which the VNA will respond.

Parameters  

<ch> Any existing channel number.  If unspecified, value is set to 1.

<n> AUX Trigger connector used to send or receive signals.

Choose from 1 (AUX TRIG 1) or 2 (AUX TRIG 2)

If unspecified, value is set to 1.

<char> Choose from:

POSitive  VNA responds to leading edge or HIGH level
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NEGative  VNA responds to trailing edge or LOW level.

Set Edge or Level triggering using TRIG:CHAN:AUX:TYPE

Examples TRIG:CHAN:AUX:IPOL POS

trigger:channel2:aux2:ipolarity negative

Query Syntax TRIGger:CHANnel<ch>:AUXiliary<n>:IPOLarity?

Return Type Character

Default NEGative

TRIGger:CHANnel<ch>:AUXiliary<n>:OPOLarity  <char>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M937xA, M9485A

(Read-Write)  Specifies the polarity of the Aux Output signal being supplied by the VNA.

Parameters  

<ch> Any existing channel number.  If unspecified, value is set to 1.

<n> AUX Trigger connector used to send or receive signals.

Choose from 1 (AUX TRIG 1) or 2 (AUX TRIG 2)

If unspecified, value is set to 1.

<char> Choose from:

POSitive  VNA sends positive going pulse.

NEGative  VNA sends negative going pulse.

Examples TRIG:CHAN:AUX:OPOL NEG

trigger:channel2:aux2:opolarity positive

Query Syntax TRIGger:CHANnel<ch>:AUXiliary<n>:OPOLarity?

Return Type Character

Default NEGative

TRIGger:CHANnel<ch>:AUXiliary<n>:POSition <char>
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Appplicable Models: N522xB, N523xB, N524xB, E5080A, M937xA, M9485A

(Read-Write)  Specifies whether the aux trigger out signal is sent BEFore or AFTer the acquisition.

Parameters  

<ch> Any existing channel number.  If unspecified, value is set to 1.

<n> AUX Trigger connector used to send or receive signals.

Choose from 1 (AUX TRIG 1) or 2 (AUX TRIG 2)

If unspecified, value is set to 1.

<char> Choose from:

BEFore  Use if the external device needs to be triggered before the data is
acquired, such as a power meter.

AFTer  Use if the external device needs to be triggered just after data has been
acquired, such as an external source. This could be more efficient since it allows
the external device to get ready for the next acquisition at the same time as the
VNA.

Examples TRIG:CHAN:AUX:POS BEF

trigger:channel2:aux2:position after

Query Syntax TRIGger:CHANnel<ch>:AUXiliary<n>:POSition?

Return Type Character

Default AFTer

TRIGger:CHANnel<ch>:AUXiliary<n>:TYPE  <char>
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Appplicable Models: N522xB, N523xB, N524xB, E5080A, M937xA

(Read-Write)  Specifies the type of Aux input detection that the VNA will employ.

Parameters  

<ch> Any existing channel number.  If unspecified, value is set to 1.

<n> AUX Trigger connector used to send or receive signals.

Choose from 1 (AUX TRIG 1) or 2 (AUX TRIG 2)

If unspecified, value is set to 1.

<char> Choose from:

EDGE  VNA responds to the leading edge of a signal

LEVel  VNA responds to the level (HIGH or LOW) of a signal

Examples TRIG:CHAN:AUX:TYPE EDGE

trigger:channel2:aux2:type level

Query Syntax TRIGger:CHANnel<ch>:AUXiliary<n>:TYPE?

Return Type Character

Default EDGE

TRIGger:DELay <num>

Applicable Models: All

(Read-Write) Sets and reads the trigger delay for ALL channels (globally). This delay is only applied

while TRIG:SOURce = EXTernal and TRIG:SCOP = ALL   After an external trigger is applied, the start

of the sweep is held off for an amount of time equal to the delay setting plus any inherent latency.

To apply a trigger delay for the specified channel ONLY, use SENS:SWE:TRIG:DELay

Parameters  

<num> Delay value in seconds. Choose from 0 to 3.

Examples TRIG:DEL .0003

Sets the trigger delay to 300 microseconds. The sweep will not
start until approximately 300 microseconds after an external
trigger is applied.

Query Syntax TRIGger:DELay?
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Return Type Numeric

Default 0

TRIGger:PREFerence:AIGLobal <bool>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M937xA, M9485A

(Read-Write)  Sets the Trigger OUT behavior to either Global or Channel. Learn more about this setting.

This command will cause the VNA to Preset.

This setting remains until changed again using this command, or until the hard drive is changed or

reformatted.

To send this command using the VNA GUI, open the GPIB Command Processor Console, then type

either of the following examples at the command prompt. Then type the Query Syntax and press enter

to be sure the VNA took the command.

Parameters  

<bool> Choose from:

ON (or 1) - Trigger properties apply to ALL channels (Global).

Allows use of CONT:SIGNal command to configure the external trigger
properties.

"Per Point" trigger property is not settable. Use the channel's Point trigger
setting.

OFF (or 0) - External Trigger properties apply to each channel independently.

Must use TRIG:CHAN:AUX commands to configure the external trigger
properties. CONT:SIGNal will NOT work.

"Per Point" trigger output property is set using the channel's Point trigger
setting AND TRIG:CHAN:AUX:INTerval.

Examples TRIG:PREF:AIGL 1

trigger:preference:aiglobal 0

Query Syntax TRIGger:PREFerence:AIGLobal?

Return Type Boolean

Default 0
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TRIGger:READy:POLarity <char>

Applicable Models: N522xB, N523xB, N524xB, E5080A, M937xA

(Read-Write)  Specifies the polarity of Ready for Trigger output.

All existing Ready for Trigger outputs are configured simultaneously with this command.

Parameters  

<char> LOW - Outputs a TTL low when the VNA is ready for trigger.

HIGH - Outputs a TTL high when the VNA is ready for trigger.

Examples TRIG:READ:POL HIGH

trigger:ready:polarity low

Query Syntax TRIGger:READy:POLarity?

Return Type Character

Default Low

TRIGger[:SEQuence]:LEVel <char>  - Superseded

This command is replaced with CONTrol:SIGNal

(Read-Write) Triggers either on a High or Low level trigger signal. This setting only has an effect

when TRIG:SOURce EXTernal is selected.

Parameters  

<char> Choose from:

HIGH - analyzer triggers on TTL High

LOW - analyzer triggers on TTL Low

Examples TRIG:LEV HIGH
trigger:sequence:level low

Query Syntax TRIGger[:SEQuence]:LEVel?

Return Type Character

Default LOW

TRIGger[:SEQuence]:ROUTE:INPut <char>
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Applicable Models: All

(Read-Write)  Specifies the connector to use for the external trigger input.

Parameters  

<char> Choose from:

MATH - handler I/O Pin 18 on M9341A

PULSE3 - Internal routing of  pulse 3 output to the MEAS TRIG IN on the

rear panel (M9385A)

SMB – Meas Trig In SMB

(The M9370A/71A/72A/73A/74A/75A support the following parameters for

backplane trigger.)

DSTARB – Backplane Trigger Lines (PXIe DSTARB)

STAR – Backplane Trigger Lines (PXI STAR)

TRIG0 – Backplane Trigger Lines (PXI TRIG0)

TRIG1 – Backplane Trigger Lines (PXI TRIG1)

TRIG2 – Backplane Trigger Lines (PXI TRIG2)

TRIG3 – Backplane Trigger Lines (PXI TRIG3)

TRIG4 – Backplane Trigger Lines (PXI TRIG4)

TRIG5 – Backplane Trigger Lines (PXI TRIG5)

TRIG6 – Backplane Trigger Lines (PXI TRIG6)

TRIG7 – Backplane Trigger Lines (PXI TRIG7)

Examples TRIG:ROUTE:INP SMB

trigger:sequence:route:input smb

Query Syntax TRIGger[:SEQuence]:ROUTE:INPut?

Return Type Character

Default SMB

TRIGger[:SEQuence]:ROUTE:READy <char>
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Applicable Models: N522xB, N523xB, N524xB, M937xA

(Read-Write)  Specifies the connector to use for the trigger OUT ready line.

Note: (M9341A) The trigger signal is always outputted from tge receiver SMB connector if  trigger

source is set at external (:TRIG:SOUR) despite  this setup. When you use handler pin 21 on M9341A,

the SMB cable connection is required.

Parameters  

<char> Choose from:

SMB: Meas Trigger in SMB connector

MATH - handler pin 21 on M9341A/B

Examples TRIG:ROUTE:READ MATH

trigger:sequence:route:ready math

Query Syntax TRIGger[:SEQuence]:ROUTE:READy?

Return Type Character

Default SMB

TRIGger[:SEQuence]:SCOPe <char>

Applicable Models: All

(Read-Write) Specifies whether a trigger signal is sent to all channels or only the current channel.

See Triggering the VNA using SCPI.

Parameters  

<char> Choose from:

ALL - trigger signal is sent to all channels. Also sets SENS:SWEep:TRIG:POINt
OFF on ALL channels.

CURRent - trigger signal is sent to only one channel at a time. With each trigger
signal, the channel is incremented to the next triggerable channel.

Examples TRIG:SCOP ALL
trigger:sequence:scope current

Query Syntax TRIGger[:SEQuence]:SCOPe?

Return Type Character
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Default ALL

TRIGger[:SEQuence]:SLOPe <char>

Applicable Models: All

(Read-Write)  Specifies the polarity expected by the external trigger input circuitry. Also specify

TRIG:TYPE (Level |Edge).

See Triggering the VNA using SCPI.

Parameters  

<char> Choose from:

POSitive (rising Edge) or High Level

NEGative (falling Edge) or Low Level

Examples TRIG:SLOP NEG
trigger:sequence:slope positive

Query Syntax TRIGger[:SEQuence]:SLOPe?

Return Type Character

Default POSitive

TRIGger[:SEQuence]:SOURce <char>

Applicable Models: All

(Read-Write) Sets the source of the sweep trigger signal. This command is a super-set of

INITiate:CONTinuous which can NOT set the source to External.

See Triggering the VNA using SCPI.

Parameters  

<char> Choose from:

EXTernal - external (rear panel) source.

IMMediate - internal source sends continuous trigger signals

MANual - sends one trigger signal when manually triggered from the front panel or
INIT:IMM is sent.

1645



Examples TRIG:SOUR EXT
trigger:sequence:source immediate

Query Syntax TRIGger[:SEQuence]:SOURce?

Return Type Character

Default IMMediate

TRIGger[:SEQuence]:TYPE <char>

Applicable Models: All

(Read-Write)  Specifies the type of EXTERNAL trigger input detection used to listen for signals on

the Meas Trig IN connectors. Edge triggers are most commonly used.

Parameters  

<char> Choose from:

EDGE  VNA responds to the rising and falling edge of a signal.

LEVel  VNA responds to a level (HIGH or LOW).

Use TRIG:SLOPe to specify Rising or falling - High or Low.

Examples TRIG:TYPE EDGE

trigger:sequence:type level

Query Syntax TRIGger[:SEQuence]:TYPE?

Return Type Character

Default LEVel

TRIGger:STATus:READy? <char>

1646



Applicable Models: N522xB, N523xB, N524xB

(Read-only)  Checks if the PNA is ready for a hardware trigger.

This command is not intended to be used in a dynamic triggering situation where the ready status is

constantly changing. Instead, the expected use is a more static situation where you are expecting the

PNA to transition from not ready to ready, and then wait for a trigger. The PNA is polled until it

becomes ready and then an operation that triggers the PNA is performed.

Note: This command is only supported on the PNA-L, PNA, and PNA-X with DSP5 installed. Any

other model will return an error.

Parameters  

<char> ANY - Check if the PNA is ready for any of the following hardware triggers.

MEAS - Check if the PNA is ready for an External trigger from the Meas Trig

In BNC, Handler IO Pin 18, or Pulse 3 line.

AUX1 - Check if the PNA is ready for a trigger from the AUX TRIG 1 IN on

the rear panel.

AUX2 - Check if the PNA is ready for a trigger from the AUX TRIG 2 IN on

the rear panel.

Examples TRIG:STAT:READ? MEAS

trigger:status:ready? aux1

Return Type Boolean

Default Not applicable
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Perform a Cal All Channels Calibration

There are two sets of commands used to automate a Cal All Channels Calibration: SYST:CAL:ALL

<commands> and SENS<chan>:CORR:COLL:GUIDed <commands>.

SYST:CAL:ALL <commands>

The general sequence for setting up the Cal All session is as follows:

Select the channels to calibrate using the SYST:CAL:ALL:SEL command.1.

Select the ports to calibrate using the SYST:CAL:ALL:CHAN:PORTs command.2.

Set the properties that are available in Cal All that are relevant to the channels you are calibrating using the
SYST:CAL:ALL:MCLass:PROP:VAL <name>,<val> command. For example, setting <name> to "Include
Power Calibration" and <val> to "true" will include a source and receiver power calibration in the Cal All
calibration.

3.

Query the channel number to use for the remaining cal commands. This channel is used for the sole purpose
of acquiring cal data and finds the highest available channel number.

4.

Note: You must query this number – do not assume that it will always be a particular value. For example:
a.chan = SYST:CAL:ALL:GUIDed:CHAN?

SENS<chan>:CORR:COLL:GUIDed <commands>

These commands are identical to the command used for a single channel calibration. However, the number used
for the SENSe header is determined by the SYST:CAL:ALL:GUIDed:CHAN? command. The general sequence is
as follows:

Set up the power sensor using the SENS:CORR:COLL:GUID:PSENsor commands if you will be performing
a power calibration (source and receiver power cal).

1.

Set up the connector family and gender per port using the SENS:CORR:COLL:GUID:CONN:PORT
command.

2.

Set up the cal kit per port using the SENS:CORR:COLL:GUID:CKIT:PORT command.3.

Initialize the session using the SENS:CORR:COLL:GUID:INIT command.4.

Query the number of steps using the SENS:CORR:COLL:GUID:STEPs? command.5.

Acquire each step using the SENS:CORR:COLL:GUID:ACQ command.6.

Save the calset using the SENS:CORR:COLL:GUID:SAVE command.7.
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6.

7.

Cal All Examples

1-Port, 1-Channel, no Power Cal, with ECal Module

2-Port, 1-Channel, no Power Cal, with ECal Module

2-Port, 1-Channel, with Power Cal, with ECal Module

2-Port, 2-Channel, with Power Cal, with ECal Module

Noise Figure Cal All

SMC Cal All

IMD 2nd Order Cal All

 

Each VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the code into a text

editor file, such as Notepad, and save it on the VNA hard drive as *.vbs.

Learn how to setup and run the macro.

See CalAll SCPI commands

Learn about Cal All

See Other SCPI Example Programs
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Catalog Measurements using SCPI

This Visual Basic Program does the following:

Catalogs the currently defined measurements, windows, and traces
Selects a measurement for further definition

Adds a Title to the window

To run this program, you need:

An established GPIB interface connection

See Other SCPI Example Programs

Dim Meas as String
Dim Win as String
Dim Trace as String

'Read the current measurements in Channel 1
GPIB.Write "CALCulate1:PARameter:CATalog?"
Meas = GPIB.Read
MsgBox ("Ch1 Measurments: " & Meas)

'Read the current windows
GPIB.Write "DISPlay:CATalog?"
Win = GPIB.Read
MsgBox ("Windows: " & Win)

'Read current traces in window 1
GPIB.Write "DISPlay:WINDow1:CATalog?"
Trace = GPIB.Read
MsgBox ("Traces in Window1: " & Win)
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Channels, Windows, and Measurements using SCPI

This VBScript program does the following:

Presets the analyzer, deleting the default trace

Create 2 windows

Create 2 Measurements

Feed the measurements to windows / traces

Change frequency ranges for channels

Select both measurements

Turn marker 1 ON for each measurement

The following notes explain the basic structure of the SCPI tree on the analyzer:

SOURce: and most SENSe: commands act on the channel that is specified in the command. Channel 1 is
default if not specified.

Most DISPlay: commands act on the window and trace specified in the command. Window1 and Trace1
are default if not specified.

CALCulate: commands act on the selected measurement in the specified channel. Select the
measurement for each channel using
CALCulate<channel number>:PARameter:SELect <meas name>. You can select one measurement in each
channel.

See Traces, Channels, and Windows on the Analyzer

How to run this program:

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the analyzer. To do this, copy the following

code into a text editor file such as Notepad and save it on the analyzer hard drive as NewMeas.vbs.
Learn how to setup and run the macro.

See Other SCPI Example Programs
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Dim app

Dim scpi

' Create / Get the VNA application.

Set app = CreateObject("AgilentPNA835x.Application")

Set scpi = app.ScpiStringParser

'Preset the analyzer

'This command also deletes the default trace

scpi.execute "SYSTem:FPReset"

'Create Measurements

scpi.execute "CALCulate1:PARameter:DEFine:EXT 'Meas1','S11'"

scpi.execute "CALCulate2:PARameter:DEFine:EXT 'Meas2','S21'"

' Turn on windows - creates if new

scpi.execute "DISPlay:WINDow1:STATE ON"

scpi.execute "DISPlay:WINDow2:STATE ON"

'Associate ("FEED") the measurement name('Meas1') to WINDow(1), and give the new
TRACe a number(1).

scpi.execute "DISPlay:WINDow1:TRACe1:FEED 'Meas1'"

scpi.execute "DISPlay:WINDow2:TRACe2:FEED 'Meas2'"

'Change each channel's frequency range

scpi.execute "SENSe1:FREQuency:SPAN 1e9"

scpi.execute "SENSe2:FREQuency:SPAN 2e9"

'Select both measurements

scpi.execute "CALCulate1:PARameter:SELect 'Meas1'"

scpi.execute "CALCulate2:PARameter:SELect 'Meas2'"

'Turn marker 1 ON for each measurement

scpi.execute "CALCulate1:MARKer:STATe ON"

scpi.execute "CALCulate2:MARKer:STATE ON"
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VNA as Controller and Talker / Listener

This Visual Basic Program uses VISA to do the following:

Control the VNA using a VISA LAN Client interface on the VNA.
Control another instrument using the VNA as GPIB controller.

Queries both the analyzer and other instrument to identify themselves with *IDN?

Note: This program can be modified to work from a remote PC to control both instruments. In that

case, set up the VNA to be a talker/listener.

To run this program, you need to do the following:

Add module visa32.bas  to the VB project.

Configure the VNA for VISA / SICL

Set up the VNA to be GPIB system controller.

Connect another instrument to the analyzer through a GPIB cable with Primary address of 13 on GPIB0
interface

See Other SCPI Example Programs

Sub main()
 
'This application run from onboard the VNA
'can control both the VNA and another GPIB instrument.
'
'To run this program the module visa32.bas must be added
'to the project.
 
'VISA function status return code
Dim status As Long
'Session to Default Resource Manager
Dim defRM As Long
'Session to instrument
Dim viPNA As Long
'Session to other GPIB instrument
Dim viInstrument As Long
'String to hold results
Dim strRes As String * 200
On Error GoTo ErrorHandler
 
status = viOpenDefaultRM(defRM)
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If (status < VI_SUCCESS) Then GoTo VisaErrorHandler
 
 
'Open the session to the VNA
status = viOpen(defRM, "GPIB1::16::INSTR", 0, 0, viPNA)
If (status < VI_SUCCESS) Then GoTo VisaErrorHandler
 
'Ask for the VNA's ID.
status = viVPrintf(viPNA, "*IDN?" + Chr$(10), 0)
If (status < VI_SUCCESS) Then GoTo VisaErrorHandler
 
'Read the ID as a string.
status = viVScanf(viPNA, "%t", strRes)
If (status < VI_SUCCESS) Then GoTo VisaErrorHandler
'Display the results
MsgBox "PNA is: " + strRes
 
 
'Open the session to the other instrument
status = viOpen(defRM, "GPIB0::13::INSTR", 0, 0, viInstrument)
If (status < VI_SUCCESS) Then GoTo VisaErrorHandler
 
'Ask for the instrument's ID.
status = viVPrintf(viInstrument, "*IDN?" + Chr$(10), 0)
If (status < VI_SUCCESS) Then GoTo VisaErrorHandler
 
'Read the ID as a string.
status = viVScanf(viPNA, "%t", strRes)
If (status < VI_SUCCESS) Then GoTo VisaErrorHandler
 
'Display the results
MsgBox "Other instrument is: " + strRes
' Close the resource manager session (which closes everything)
Call viClose(defRM)
End
 
ErrorHandler:
'Display the error message
MsgBox "*** Error : " + Error$, MB_ICONEXCLAMATION
End
 
VisaErrorHandler:
Dim strVisaErr As String * 200
Call viStatusDesc(defRM, status, strVisaErr)
MsgBox "*** Error : " + strVisaErr
 
End
End Sub
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Create a Balanced Measurement using SCPI

This example program does the following:

creates several Balanced measurements in separate windows
generates markers
calculates statistics
sets limit lines and queries results
queries a measurement to determine if we have a balanced parameter and what type it is.

Note: By their nature, balanced measurements are extremely sensitive to phase differences between the

two RF paths that make up the balanced port, especially at higher frequencies. A good calibration (not

performed in this example) is critical to achieving good balanced measurement results.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as Balanced.vbs. Learn how to
setup and run the macro.

See Other SCPI Example Programs

Dim app

Dim scpi

' Create / Get the VNA application.

Set app = CreateObject("AgilentPNA835x.Application")

Set scpi = app.ScpiStringParser

' A comment

scpi.Parse("SYST:FPRESET")

' This example uses DUT topology Bal-Bal -

' a DUT with a balanced input and balanced output.

'

' Port mapping for our DUT:

' logical port 1 = physical ports 1 and 4
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' logical port 2 = physical ports 2 and 3

' The default is:

' logical port 1 = physical ports 1 and 2

' logical port 2 = physical ports 3 and 4

'

'  logical 1             logical 2

'          ___________

' 1 ------|           |------ 2 +

'         |    DUT    |

' 4 ------|___________|------ 3 -

 

' Turn on Four windows

scpi.Parse("DISP:WIND1:STATe ON")

scpi.Parse("DISP:WIND2:STATe ON")

scpi.Parse("DISP:WIND3:STATe ON")

scpi.Parse("DISP:WIND4:STATe ON")

' Create a trace called "sdd21", and for that trace turn on the balanced

' transformation and set the balanced transformation to BBAL SDD21.

scpi.Parse("CALC:PAR:DEF:EXT ""sdd21"",S11")

scpi.Parse("CALC:PAR:SEL ""sdd21""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SDD21")

' Feed the sdd21 trace to window 1, trace 1

scpi.Parse("DISP:WIND1:TRAC1:FEED ""sdd21""")

' Similarly create 3 more balanced transmission/conversion parameters

' Create Scd21

scpi.Parse("CALC:PAR:DEF:EXT ""scd21"",S11")

scpi.Parse("CALC:PAR:SEL ""scd21""")
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scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SCD21")

scpi.Parse("DISP:WIND1:TRAC2:FEED ""scd21""")

' Create Sdc21

scpi.Parse("CALC:PAR:DEF:EXT ""sdc21"",S11")

scpi.Parse("CALC:PAR:SEL ""sdc21""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SDC21")

scpi.Parse("DISP:WIND1:TRAC3:FEED ""sdc21""")

' Create Scc21

scpi.Parse("CALC:PAR:DEF:EXT ""scc21"",S11")

scpi.Parse("CALC:PAR:SEL ""scc21""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SCC21")

scpi.Parse("DISP:WIND1:TRAC4:FEED ""scc21""")

' Now create logical port 1 reflection parameters, and place them in window 2

scpi.Parse("CALC:PAR:DEF:EXT ""sdd11"",S11")

scpi.Parse("CALC:PAR:SEL ""sdd11""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SDD11")

' Feed the sdd11 trace to window 2, trace 1

scpi.Parse("DISP:WIND2:TRAC1:FEED ""sdd11""")

' Similarly create 3 more balanced reflection/conversion parameters

scpi.Parse("CALC:PAR:DEF:EXT ""scd11"",S11")

scpi.Parse("CALC:PAR:SEL ""scd11""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SCD11")

scpi.Parse("DISP:WIND2:TRAC2:FEED ""scd11""")
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scpi.Parse("CALC:PAR:DEF:EXT ""sdc11"",S11")

scpi.Parse("CALC:PAR:SEL ""sdc11""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SDC11")

scpi.Parse("DISP:WIND2:TRAC3:FEED ""sdc11""")

scpi.Parse("CALC:PAR:DEF:EXT ""scc11"",S11")

scpi.Parse("CALC:PAR:SEL ""scc11""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SCC11")

scpi.Parse("DISP:WIND2:TRAC4:FEED ""scc11""")

' Now create reverse transmission parameters, and place them in window 3

scpi.Parse("CALC:PAR:DEF:EXT ""sdd12"",S11")

scpi.Parse("CALC:PAR:SEL ""sdd12""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SDD12")

' Feed the sdd11 trace to window 3, trace 1

scpi.Parse("DISP:WIND3:TRAC1:FEED ""sdd12""")

' Similarly create 3 more balanced reverse transmission/conversion parameters

scpi.Parse("CALC:PAR:DEF:EXT ""scd12"",S11")

scpi.Parse("CALC:PAR:SEL ""scd12""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SCD12")

scpi.Parse("DISP:WIND3:TRAC2:FEED ""scd12""")

scpi.Parse("CALC:PAR:DEF:EXT ""sdc12"",S11")

scpi.Parse("CALC:PAR:SEL ""sdc12""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SDC12")

scpi.Parse("DISP:WIND3:TRAC3:FEED ""sdc12""")
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scpi.Parse("CALC:PAR:DEF:EXT ""scc12"",S11")

scpi.Parse("CALC:PAR:SEL ""scc12""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SCC12")

scpi.Parse("DISP:WIND3:TRAC4:FEED ""scc12""")

' Now create reverse reflection parameters, and place them in window 4

scpi.Parse("CALC:PAR:DEF:EXT ""sdd22"",S11")

scpi.Parse("CALC:PAR:SEL ""sdd22""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SDD22")

' Feed the sdd11 trace to window 3, trace 1

scpi.Parse("DISP:WIND4:TRAC1:FEED ""sdd22""")

' Similarly create 3 more balanced reverse reflection parameters

scpi.Parse("CALC:PAR:DEF:EXT ""scd22"",S11")

scpi.Parse("CALC:PAR:SEL ""scd22""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SCD22")

scpi.Parse("DISP:WIND4:TRAC2:FEED ""scd22""")

scpi.Parse("CALC:PAR:DEF:EXT ""sdc22"",S11")

scpi.Parse("CALC:PAR:SEL ""sdc22""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SDC22")

scpi.Parse("DISP:WIND4:TRAC3:FEED ""sdc22""")

scpi.Parse("CALC:PAR:DEF:EXT ""scc22"",S11")

scpi.Parse("CALC:PAR:SEL ""scc22""")

scpi.Parse("CALC:FSIM:BAL:PAR:STATe ON")

scpi.Parse("CALC:FSIM:BAL:PAR:BBAL:DEF SCC22")

scpi.Parse("DISP:WIND4:TRAC4:FEED ""scc22""")
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scpi.Parse("CALC:FSIM:BAL:DEVice BBALanced")

scpi.Parse("CALC:FSIM:BAL:TOPology:BBAL:PPORts 1,4,2,3")

' Set up stimulus

scpi.Parse("SENS:SWE:POINts 801")

scpi.Parse("SENS:FREQ:STARt 10e6")

scpi.Parse("SENS:FREQ:STOP  1e9")

' Here we demonstrate how to determine if we have

' a balanced parameter and what type it is.

' Read back one parameter to verify its type

scpi.Parse("CALC:PAR:SEL ""sdd21""")

' Is this a balanced parameter?

isbal = scpi.Parse("CALC:FSIM:BAL:PAR?")

' Which topology/device is set?

device = scpi.Parse("CALC:FSIM:BAL:DEV?")

device = Left( device, Len(device)-1 ) ' strip off newline

' Which parameter are we measuring within that topology?

balparam = scpi.Parse("CALC:FSIM:BAL:PAR:" & device & ":DEF?")

balparam = Left( balparam, Len(balparam)-1 ) ' strip off newline

If isbal Then

WScript.Echo "Balanced Parameter: " & balparam & " in topology: " & device & "."

Else

WScript.Echo "Parameter not balanced."

End If
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Create a Measurement using SCPI

This VBScript program creates a new S21 measurement and displays it on the VNA screen.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as NewMeas.vbs. Learn how to
setup and run the macro.

 See Other SCPI Example Programs

Dim app
Dim scpi
' Create / Get the VNA application.
Set app = CreateObject("AgilentPNA835x.Application")
Set scpi = app.ScpiStringParser

' A comment
'Preset the analyzer
scpi.Execute ("SYST:FPReset")
' Create and turn on window 1
scpi.Execute ("DISPlay:WINDow1:STATE ON")
'Define a measurement name, parameter
scpi.Execute ("CALCulate:PARameter:DEFine:EXT 'MyMeas',S21")
'Associate ("FEED") the measurement name ('MyMeas') to WINDow (1), and give the new
TRACe a number (1).
scpi.Execute ("DISPlay:WINDow1:TRACe1:FEED 'MyMeas'")

Example

Dim app
Dim scpi
' Create / Get the VNA application.
Set app = CreateObject("AgilentPNA835x.Application")
Set scpi = app.ScpiStringParser

' A comment
'Preset the analyzer
scpi.Execute ("SYST:PREset")
'Define a measurement parameter
scpi.Execute ("CALCulate:MEASure1:PARameter 'S21'")
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Create New Cal Kit using SCPI

When creating new cal kits programmatically, the order in which cal kit commands are sent
can be important.
For example to create a kit with opens, shorts, loads, and thrus. Be sure to use the following
sequence for each newly defined standard.

Programmatically select the standard number1.
Programmatically select the standard type.  2.
Program the cal standard's values.3.
Repeat steps 1, 2, 3 for additional new standards being defined.4.

 
 
10   !
20   !
30   ! This example program demonstrates how to create
40   ! new PNA calibration kits.
50   !
60   ! 1) Select a kit not previously defined
70   ! 2) Define open, short, load, and thru cal standards
80   !    Note:  Each of the newly defined standards is assigned
90   !    a default connector name.  These default connector names
100  !    will be replaced in subsequent steps.
110  ! 3) Use the delete connector command to remove default
120  !    connector names.
130  ! 4) Add connectors.  Specify:
140  !      Start and Stop Freq
150  !      Z - Impedance
160  !      sex - MALE, FEMALE, NONE
170  !      media - COAX, WAVE
180  !      cutoff - Frequency for waveguide
190  ! 5) Assign the appropriate connector to each standard
200  ! 6) Modify the class assignments for the standards defined
210  ! 7) Verify the kit values
220  !
230  ! Additional Note:  After setting each new cal kit value, it is
240  ! recommended that the program periodically perform queries to
250  ! verify the new values.
260  !
270  ! This will prevent program synchronization issues that can
affect
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280  ! final values stored within new cal kits.
290  !
300  !------------------------------------------------------------
310  !
320  ! Set up I/O path
330   ASSIGN @Na TO 716
340   DIM Calkname$[80],Conn$[80]
350   INTEGER Calkitnum
360  !
370   CLEAR SCREEN
380  !
390  !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
400  ! Designate the kit selection to be used for performing cal's
410   OUTPUT @Na;":sens:corr:ckit:count?"
420   ENTER @Na;Calkitnum
430   Calkitnum=Calkitnum+1
440   OUTPUT @Na;":sens:corr:coll:ckit "&VAL$(Calkitnum)
450  !
460  ! Name this kit with your own name
470   OUTPUT @Na;":sens:corr:coll:ckit:name ""Special 2.4 mm Model
85056"""
480  !
490  !
500   DISP "Defining kit std 1..."
510  ! Now set up standard #1
520   OUTPUT @Na;":sens:corr:coll:ckit:stan 1"
530   OUTPUT @Na;":sens:corr:coll:ckit:stan:type SHORT"
540   Get_std
550   OUTPUT @Na;":sens:corr:coll:ckit:stan:char coax"
560   OUTPUT @Na;":sens:corr:coll:ckit:stan:label ""My Short"""
570   Get_label
580  !
590   DISP "Defining kit std 2..."
600  ! Now set up standard #2
610   OUTPUT @Na;":sens:corr:coll:ckit:stan 2"
620   OUTPUT @Na;":sens:corr:coll:ckit:stan:type OPEN"
630   Get_std
640   OUTPUT @Na;":sens:corr:coll:ckit:stan:char coax"
650   OUTPUT @Na;":sens:corr:coll:ckit:stan:label ""My Open"""
660   Get_label
670  !
680   DISP "Defining kit std 3..."
690  ! Now set up standard #3
700   OUTPUT @Na;":sens:corr:coll:ckit:stan 3"
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710   OUTPUT @Na;":sens:corr:coll:ckit:stan:type LOAD"
720   Get_std
730   OUTPUT @Na;":sens:corr:coll:ckit:stan:char coax"
740   OUTPUT @Na;":sens:corr:coll:ckit:stan:label ""My Fixed Load"""
750   Get_label
760  !
770   DISP "Defining kit std 4..."
780  ! Now set up standard #4
790   OUTPUT @Na;":sens:corr:coll:ckit:stan 4"
800   OUTPUT @Na;":sens:corr:coll:ckit:stan:type THRU"
810   Get_std
820   OUTPUT @Na;":sens:corr:coll:ckit:stan:char coax"
830   OUTPUT @Na;":sens:corr:coll:ckit:stan:label ""My Thru"""
840   Get_label
850  !
860   DISP "Defining kit std 5..."
870  ! Now set up standard #5
880   OUTPUT @Na;":sens:corr:coll:ckit:stan 5"
890   OUTPUT @Na;":sens:corr:coll:ckit:stan:type SLOAD"
900   Get_std
910   OUTPUT @Na;":sens:corr:coll:ckit:stan:char coax"
920   OUTPUT @Na;":sens:corr:coll:ckit:stan:label ""Sliding Load"""
930   Get_label
940  !
950   DISP "Defining kit std 6..."
960  ! Now set up standard #6
970  !
980   OUTPUT @Na;":sens:corr:coll:ckit:stan 6"
990   OUTPUT @Na;":sens:corr:coll:ckit:stan:type SHORT"
1000  Get_std
1010  OUTPUT @Na;":sens:corr:coll:ckit:stan:char coax"
1020  OUTPUT @Na;":sens:corr:coll:ckit:stan:label ""Short"""
1030  Get_label
1040 !
1050  DISP "Defining kit std 7..."
1060 ! Now set up standard #7
1070  OUTPUT @Na;":sens:corr:coll:ckit:stan 7"
1080  OUTPUT @Na;":sens:corr:coll:ckit:stan:type SHORT"
1090  Get_std
1100  OUTPUT @Na;":sens:corr:coll:ckit:stan:char coax"
1110  OUTPUT @Na;":sens:corr:coll:ckit:stan:label ""Short"""
1120  Get_label
1130 !
1140  DISP "Defining kit std 8..."
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1150 ! Now set up standard #8
1160 !
1170  OUTPUT @Na;":sens:corr:coll:ckit:stan 8"
1190  OUTPUT @Na;":sens:corr:coll:ckit:stan:type ARBI"
1200  Get_std
1210  OUTPUT @Na;":sens:corr:coll:ckit:stan:char coax"
1220  OUTPUT @Na;":sens:corr:coll:ckit:stan:TZR 15;"
1230  OUTPUT @Na;":sens:corr:coll:ckit:stan:TZI -9;"
1240  OUTPUT @Na;":sens:corr:coll:ckit:stan:label ""Z Load"""
1250  Get_label
1260 !
1270 !
1280 !
1290 ! First remove any old connector names
1300  OUTPUT @Na;":sens:corr:coll:ckit:conn:del"
1310 ! Verify that no connectors are currently installed
1320  OUTPUT @Na;":sens:corr:coll:ckit:conn:cat?"
1330  ENTER @Na;Conn$
1340  PRINT "Verify empty list: ";Conn$
1350 !
1360 ! Define your new connectors
1370  OUTPUT @Na;":sens:corr:coll:ckit:conn:add ""PSC
2.4"",0HZ,999GHZ,50.0,MALE,COAX,0.0"
1380  OUTPUT @Na;":sens:corr:coll:ckit:conn:add ""PSC
2.4"",0HZ,999GHZ,50.0,FEMALE,COAX,0.0"
1390 !
1400 ! Verify that the new connectors are installed
1410  OUTPUT @Na;":sens:corr:coll:ckit:conn:cat?"
1420  ENTER @Na;Conn$
1430  PRINT "Verify new connectors: ";Conn$
1440  DISP ""
1450 !
1460  DISP "Defining conn std 1..."
1470 ! Now set up standard #1
1480  OUTPUT @Na;":sens:corr:coll:ckit:stan 1"
1490  Verify_std
1500  OUTPUT @Na;":sens:corr:coll:ckit:conn:snam ""PSC
2.4"",FEMALE,1"
1510  Print_connector
1520 !
1530  DISP "Defining conn std 2..."
1540 ! Now set up standard #2
1550  OUTPUT @Na;":sens:corr:coll:ckit:stan 2"
1560  Verify_std
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1570  OUTPUT @Na;":sens:corr:coll:ckit:conn:snam ""PSC
2.4"",FEMALE,1"
1580  Print_connector
1590 !
1600  DISP "Defining conn std 3..."
1610 ! Now set up standard #3
1620  OUTPUT @Na;":sens:corr:coll:ckit:stan 3"
1630  Verify_std
1640  OUTPUT @Na;":sens:corr:coll:ckit:conn:snam ""PSC
2.4"",FEMALE,1"
1650  Print_connector
1660 !
1670  DISP "Defining conn std 4..."
1680 ! Now set up standard #4
1690  OUTPUT @Na;":sens:corr:coll:ckit:stan 4"
1700  Verify_std
1710  OUTPUT @Na;":sens:corr:coll:ckit:conn:snam ""PSC
2.4"",FEMALE,1"
1720  OUTPUT @Na;":sens:corr:coll:ckit:conn:snam ""PSC 2.4"",MALE,2"
1730  Print_connector
1740 !
1750  DISP "Defining conn std 5..."
1760 ! Now set up standard #5
1770  OUTPUT @Na;":sens:corr:coll:ckit:stan 5"
1780  OUTPUT @Na;":sens:corr:coll:ckit:stan:label ""Sliding Load"""
1790  Verify_std
1800  OUTPUT @Na;":sens:corr:coll:ckit:conn:snam ""PSC 2.4"",MALE,1"
1810  Print_connector
1820 !
1830  DISP "Defining conn std 6..."
1840 ! Now set up standard #6
1850 !
1860  OUTPUT @Na;":sens:corr:coll:ckit:stan 6"
1870  Verify_std
1880  OUTPUT @Na;":sens:corr:coll:ckit:conn:snam ""PSC 2.4"",MALE,1"
1890  Print_connector
1900 !
1910  DISP "Defining conn std 7..."
1920 ! Now set up standard #7
1930  OUTPUT @Na;":sens:corr:coll:ckit:stan 7"
1940  Verify_std
1950  OUTPUT @Na;":sens:corr:coll:ckit:conn:snam ""PSC 2.4"",MALE,1"
1960  Print_connector
1970 !

1667



1980  DISP "Defining conn std 8..."
1990 ! Now set up standard #8
2000  OUTPUT @Na;":sens:corr:coll:ckit:stan 8"
2010  Verify_std
2020  OUTPUT @Na;":sens:corr:coll:ckit:conn:snam ""PSC 2.4"",MALE,1"
2030  Print_connector
2040 !
2050  DISP "Class assignments..."
2060 !
2070 ! Designate the "order" associated with measuring the standards
2080 !
2090 !    Set Port 1, 1st standard measured to be standard #2
2100  OUTPUT @Na;":sens:corr:coll:ckit:order1 2"
2110 !    Set Port 1, 2nd standard measured to be standard #1
2120  OUTPUT @Na;":sens:corr:coll:ckit:order2 1,6,7"
2130 !    Set Port 1, 3nd standard measured to be standard #3 and #5
2140  OUTPUT @Na;":sens:corr:coll:ckit:order3 3,5"
2150 !    Set Port 1, 4th standard measured to be standard #4
2160  OUTPUT @Na;":sens:corr:coll:ckit:order4 4"
2170 !
2180 !    Set Port 2, 1st standard measured to be standard #2
2190  OUTPUT @Na;":sens:corr:coll:ckit:order5 2"
2200 !    Set Port 2, 2nd standard measured to be standard #1
2210  OUTPUT @Na;":sens:corr:coll:ckit:order6 1,6,7"
2220 !    Set Port 2, 3nd standard measured to be standard #3 and #6
2230  OUTPUT @Na;":sens:corr:coll:ckit:order7 3,5"
2240 !    Set Port 2, 4th standard measured to be standard #4
2250  OUTPUT @Na;":sens:corr:coll:ckit:order8 4"
2260 !
2270 !    Set Port 1, 1st standard
2280  OUTPUT @Na;":sens:corr:coll:ckit:olabel1 ""MyOpen1"""
2290 !    Set Port 1, 2nd standard
2300  OUTPUT @Na;":sens:corr:coll:ckit:olabel2 ""MyShorts1"""
2310 !    Set Port 1, 3nd standard
2320  OUTPUT @Na;":sens:corr:coll:ckit:olabel3 ""MyLoads1"""
2330 !    Set Port 1, 4th standard measured to be standard #4
2340  OUTPUT @Na;":sens:corr:coll:ckit:olabel4 ""MyThru1"""
2350 !
2360 !    Set Port 2, 1st standard
2370  OUTPUT @Na;":sens:corr:coll:ckit:olabel5 ""MyOpen2"""
2380 !    Set Port 2, 2nd standard
2390  OUTPUT @Na;":sens:corr:coll:ckit:olabel6 ""MyShorts2"""
2400 !    Set Port 2, 3nd standard
2410  OUTPUT @Na;":sens:corr:coll:ckit:olabel7 ""MyLoads2"""
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2420 !    Set Port 2, 4th standard
2430  OUTPUT @Na;":sens:corr:coll:ckit:olabel8 ""MyThrus2"""
2440 !
2450  BEEP
2460  DISP "Done!"
2470  END
2480  SUB Get_label
2490    OUTPUT 716;":sens:corr:coll:ckit:stan:label?"
2500    ENTER 716;Label$
2510    PRINT Label$
2520  SUBEND
2530 !
2540  SUB Get_std
2550    OUTPUT 716;":sens:corr:coll:ckit:stan:type?"
2560    ENTER 716;Type$
2570    PRINT Type$
2580  SUBEND
2590 !
2600  SUB Print_connector
2610    DIM Nam$[40]
2620    OUTPUT 716;":sens:corr:coll:ckit:conn:sname?"
2630    ENTER 716;Nam$
2640    PRINT Nam$
2650  SUBEND
2660 !
2670  SUB Verify_std
2680    OUTPUT 716;":sens:corr:coll:ckit:stan:label?"
2690    ENTER 716;Label$
2700  SUBEND
2710 !
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ECALConfidence Check using SCPI

This Visual Basic program performs a complete ECAL confidence check.

To run this program, you need:

An established GPIB interface connection

Keysight's VISA or National Instrument's VISA installed on your PC

The module visa32.bas added to your VB project.

A form with two buttons: cmdRun and cmdQuit

A calibrated S11 1-port or N-port measurement active on Channel 1

Window 1 is visible

Note: A confidence check can NOT be performed remotely from User Characterizations that are stored

on the VNA disk.

See Other SCPI Example Programs

'Session to VISA Default Resource Manager
Private defRM As Long            
'Session to VNA
Private viPNA As Long             
'VISA function status return code
Private status As Long            
 
Private Sub Form_Load()
   defRM = 0
End Sub
 
Private Sub cmdRun_Click()
'String to receive data from the VNA
Dim strReply As String * 200  
 
' Open the VISA default resource manager
status = viOpenDefaultRM(defRM)
If (status < VI_SUCCESS) Then HandleVISAError
 
' Open a VISA session (viPNA) to the VNA at GPIB address 16.
status = viOpen(defRM, "GPIB0::16::INSTR", 0, 0, viPNA)
If (status < VI_SUCCESS) Then HandleVISAError
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' Need to set the VISA timeout value to give all our GPIB Reads
' sufficient time to complete before a timeout error occurs.
' For this example, let's try setting the limit to
' 10000 milliseconds (10 seconds).
status = viSetAttribute(viPNA, VI_ATTR_TMO_VALUE, 10000)
If (status < VI_SUCCESS) Then HandleVISAError
   
' Get the catalog of all the measurements currently on Channel 1.
status = myGPIBWrite(viPNA, "CALC1:PAR:CAT?")
If (status < VI_SUCCESS) Then HandleVISAError
status = myGPIBRead(viPNA, strReply)
If (status < VI_SUCCESS) Then HandleVISAError
   
' If an S11 measurement named "MY_S11" doesn't already exist,
' then create it.
If InStr(strReply, "MY_S11") = 0 Then
   status = myGPIBWrite(viPNA, "CALC1:PAR:DEF:EXT MY_S11,S11")
   If (status < VI_SUCCESS) Then HandleVISAError
End If
strReply = ""
   
' Get the catalog of all the trace numbers currently active
' in Window 1.
status = myGPIBWrite(viPNA, "DISP:WIND1:CAT?")
If (status < VI_SUCCESS) Then HandleVISAError
 
status = myGPIBRead(viPNA, strReply)
If (status < VI_SUCCESS) Then HandleVISAError
   
' If a trace number 4 already exists in Window 1, then this
' will remove it.
If InStr(strReply, "4") > 0 Then
   status = myGPIBWrite(viPNA, "DISP:WIND1:TRAC4:DEL")
   If (status < VI_SUCCESS) Then HandleVISAError
End If
   
' Set trace number 4 to MY_S11.
status = myGPIBWrite(viPNA, "DISP:WIND1:TRAC4:FEED MY_S11")
If (status < VI_SUCCESS) Then HandleVISAError
   
' Set up trace view so we are viewing only the data trace.
status = myGPIBWrite(viPNA, "DISP:WIND1:TRAC4 ON")
If (status < VI_SUCCESS) Then HandleVISAError
status = myGPIBWrite(viPNA, "DISP:WIND1:TRAC4:MEM OFF")
If (status < VI_SUCCESS) Then HandleVISAError
   
' Select MY_S11 as the measurement to be used for the
' Confidence Check.
status = myGPIBWrite(viPNA, "SENS1:CORR:CCH:PAR MY_S11")
If (status < VI_SUCCESS) Then HandleVISAError
  
' Acquire the S11 confidence check data from ECal Module A
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' into the memory buffer (asking for an OPC reply when it's done).
status = myGPIBWrite(viPNA, "SENS1:CORR:CCH:ACQ ECAL1;*OPC?")
If (status < VI_SUCCESS) Then HandleVISAError
   
' The VNA sends an OPC reply ("+1") when the confidence data
' acquisition into memory is complete, so this Read is waiting on
' the reply until it is received.
status = myGPIBRead(viPNA, strReply)
If (status < VI_SUCCESS) Then HandleVISAError
 
' Turn on trace math so the trace shows data divided by memory.
' You can be confident the S11 calibration is reasonably good if
' the displayed trace varies no more than a few tenths of a dB
' from 0 dB across the entire span.
status = myGPIBWrite(viPNA, "CALC1:PAR:SEL MY_S11")
If (status < VI_SUCCESS) Then HandleVISAError
status = myGPIBWrite(viPNA, "CALC1:MATH:FUNC DIV")
If (status < VI_SUCCESS) Then HandleVISAError
End Sub
 
Private Sub cmdQuit_Click()
' Turn off trace math
status = myGPIBWrite(viPNA, "CALC1:MATH:FUNC NORM")
If (status < VI_SUCCESS) Then HandleVISAError
   
' Conclude the confidence check to set the ECal module
' back to it's idle state.
status = myGPIBWrite(viPNA, "SENS1:CORR:CCH:DONE")
If (status < VI_SUCCESS) Then HandleVISAError
   
' Close the resource manager session (which also closes
' the session to the VNA).
If defRM <> 0 Then Call viClose(defRM)
   
' End the program
End
End Sub
 
Private Function myGPIBWrite(ByVal viHandle As Long, ByVal strOut As String) As Long
' The "+ Chr$(10)" appends an ASCII linefeed character to the output, for
' terminating the write transaction.
myGPIBWrite = viVPrintf(viHandle, strOut + Chr$(10), 0)
End Function
 
Private Function myGPIBRead(ByVal viHandle As Long, strIn As String) As Long
myGPIBRead = viVScanf(viHandle, "%t", strIn)
End Function
 
Sub HandleVISAError()
Dim strVisaErr As String * 200
Call viStatusDesc(defRM, status, strVisaErr)
MsgBox "*** Error : " + strVisaErr, vbExclamation
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End
End Sub
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Establish a VISA Session

This Visual Basic program demonstrates how to send a SCPI command using VISA and the Keysight

IO libraries. To run this program, you need:

Your PC and VNA both connected to a LAN (for communicating with each other).

The SICL and VISA components of Keysight’s I/O Libraries software installed on your PC. Both are included
when you install the software, unless you already have another vendor's VISA installed. Then specify Full
SICL and VISA installation to overwrite the other vendor's VISA.

The module visa32.bas added to your VB project. After you install VISA, the module will be located at
C:/VXIPNP/WINNT (or equivalent)/INCLUDE/Visa32.bas

A form with two buttons: cmdRun and cmdQuit.

Your PC configured to be a VISA LAN Client, and the SICL Server capability enabled on the analyzer. See
Configure for VISA and SICL

See Other SCPI Example Programs

Note: This example is a piece of a larger VISA program that performs a source power calibration.

'Session to VISA Default Resource Manager
Private defRM As Long
'Session to VNA
Private viPNA As Long
'VISA function status return code
Private status As Long

Private Sub Form_Load()
defRM = 0
End Sub

Private Sub cmdRun_Click()
' String to receive data from the VNA.
' Dimensioned large enough to receive scalar comma-delimited values
' for 21 frequency points (20 ASCII characters per point)
Dim strReply As String * 420

' Open the VISA default resource manager
status = viOpenDefaultRM(defRM)
If (status < VI_SUCCESS) Then HandleVISAError

' Open a VISA session (viPNA) to the SICL LAN server
' at “address 16” on the VNA pointed to by the “GPIB0”
' VISA LAN Client on this PC.
' CHANGE GPIB0 TO WHATEVER YOU VNA IS SET TO
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status = viOpen(defRM, "GPIB0::16::INSTR", 0, 0, viPNA)
If (status < VI_SUCCESS) Then HandleVISAError

' Need to set the VISA timeout value to give all our calls to
' myGPIBRead sufficient time to complete before a timeout
' error occurs.
' For this example, let's try setting the limit to
' 30000 milliseconds (30 seconds).
status = viSetAttribute(viPNA, VI_ATTR_TMO_VALUE, 30000)
If (status < VI_SUCCESS) Then HandleVISAError

' Preset the VNA
status = myGPIBWrite(viPNA, "SYST:PRES")
If (status < VI_SUCCESS) Then HandleVISAError

' Print the data using a message box
MsgBox strReply
End Sub

Private Sub cmdQuit_Click()
' Close the resource manager session (which also closes
' the session to the VNA).
If defRM <> 0 Then Call viClose(defRM)

' End the program
End
End Sub

Private Function myGPIBWrite(ByVal viHandle As Long, ByVal strOut As String) As Long
' The "+ Chr$(10)" appends an ASCII linefeed character to the
' output, for terminating the write transaction.
myGPIBWrite = viVPrintf(viHandle, strOut + Chr$(10), 0)
End Function

Private Function myGPIBRead(ByVal viHandle As Long, strIn As String) As Long
myGPIBRead = viVScanf(viHandle, "%t", strIn)
End Function

Sub HandleVISAError()
Dim strVisaErr As String * 200
Call viStatusDesc(defRM, status, strVisaErr)
MsgBox "*** Error : " + strVisaErr, vbExclamation
End
End Sub
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External Test Set Control using SCPI

This program demonstrates the use of several External Test Set Control commands.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as ExtTS.vbs. Learn how to
setup and run the macro.

' Demonstrate some SCPI commands for external testsets.

Dim pna

Set pna = CreateObject("AgilentPNA835x.Application")

Set scpi = pna.ScpiStringParser

' The K64 testset is only usable on a 4-port VNA

If (pna.NumberOfPorts <> 4) Then

MsgBox("This program only runs on 4-port analyzers.")

Else

'If Help is active, show the measurement window and help

scpi.Execute("DISP:ARR TILE")

'Return the list of supported test sets

list=scpi.Execute("SENS:MULT:CATalog?")

MsgBox(list)

'************* K64 *****************

'The K64 is connected using the Testset I/O

'connector. There is no handshake information.

'Therefore, a testset need not be connected.

' Load a configuration file.

scpi.Execute("SENS:MULT1:TYPE 'Z5623AK64'")

scpi.Execute("SENS:MULT1:ADDR 0")

1676



'return stuff about the test set

' Returns number of input ports

Inports=scpi.Execute("SENS:MULT1:INCount?")

MsgBox("Input Ports: " & CStr(Inports))

' Returns number of output ports

ports=scpi.Execute("SENS:MULT1:COUNt?")

MsgBox("Output Ports: " & CStr(ports))

' Returns valid output ports for each input port

For portNum = 1 To Inports

ports=scpi.Execute("SENS:MULT1:PORT" & CStr(portNum) & ":CAT?")

MsgBox("Port " & CStr(portNum) & " catalog: " & (ports))

Next

'Set different port mapping

scpi.Execute("SENS:MULT1:ALLPorts '1 ext R,2 ext R,3 ext R,4 ext R'")

'Return port mapping

portMap=scpi.Execute("SENS:MULT1:ALLPorts?")

MsgBox("Ports will be mapped to " & CStr(portMap))

' Enable external testset control and execute port mapping. This automatically
enables status bar display as well.

scpi.Execute("SENS:MULT1:STATe 1")

MsgBox("Z5623A K64 Enabled")

End If
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Getting and Putting Data using SCPI

This Visual Basic Program does the following:

Reads data from the analyzer
Puts the data back into memory
To see the data on the analyzer after running the program, from the front panel click:
Trace - Math/Memory - Memory Trace

To run this program, you need:

An established GPIB interface connection

 See Other SCPI Example Programs

Note: To change the read and write location of data, removing the comment from the beginning of

ONE of the lines, and replace the comment in the beginning of the SDATA and SMEM lines.

Private Sub ReadWrite_Click()
Dim i As Integer
Dim t As Integer
Dim q As Integer
Dim dat As String
Dim cmd As String
Dim datum() As Double

GPIB.Configure
GPIB.Write "SYSTem:PRESet;*wai"

'Select the measurement
GPIB.Write "CALCulate:PARameter:SELect 'CH1_S11_1'"

'Read the number of data points
GPIB.Write "SENSe1:SWEep:POIN?"
numpts = GPIB.Read

'Turn continuous sweep off
GPIB.Write "INITiate:CONTinuous OFF"

'Take a sweep
GPIB.Write "INITiate:IMMediate;*wai"

'Ask for the Data

'PICK ONE OF THESE LOCATIONS TO READ
'GPIB.Write "CALCulate:DATA? FDATA" 'Formatted Meas
'GPIB.Write "CALCulate:DATA? FMEM" 'Formatted Memory
GPIB.Write "CALCulate:DATA? SDATA" 'Corrected, Complex Meas
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'GPIB.Write "CALCulate:DATA? SMEM" 'Corrected, Complex Memory
'GPIB.Write "CALCulate:DATA? SCORR1" 'Error-Term Directivity

'Number of values returned per data point
'q = 1 ' Pick this if reading FDATA or FMEM
q = 2 ' Otherwise pick this

'Parse the data
ReDim datum(q, numpts)
For i = 0 To numpts - 1
  For t = 0 To q - 1
  'Read the Data
  dat = GPIB.Read(20)
  'Parse it into an array
  datum(t, i) = Val(dat)
  Next t
Next i

'PUT THE DATA BACK IN
GPIB.Write "format ascii"

'PICK ONE OF THESE LOCATIONS TO PUT THE DATA
'cmd = "CALCulate:DATA FDATA," 'Formatted Meas
'cmd = "CALCulate:DATA FMEM," 'Formatted Memory
'cmd = "CALCulate:DATA SDATA," 'Corrected, Complex Meas
cmd = "CALCulate:DATA SMEM," 'Corrected, Complex Memory
'cmd = "CALCulate:DATA SCORR1," 'Error-Term Directivity

For i = 0 To numpts - 1
  For t = 0 To q - 1
  If i = numpts - 1 And t = q - 1 Then
  cmd = cmd & Format(datum(t, i))
  Else
  cmd = cmd & Format(datum(t, i)) & ","
  End If
  Next t
Next i

GPIB.Write cmd
End Sub

 

This Excel VBA Program with VISA-COM does the following:

Reads data from the analyzer
Puts the data back into memory

Note: To change the read and write location of data, removing the comment from the beginning of

ONE of the lines, and replace the comment in the beginning of the FDATA lines.
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Sub SampleGetPutData()
   '*** The variables of the resource manager and the instrument I/O are declared.
   Dim ioMgr As VisaComLib.ResourceManager
   Dim GPIB As VisaComLib.FormattedIO488
   '*** The memory area of the resource manager and the instrument I/O are acquired.
   Set ioMgr = New VisaComLib.ResourceManager
   Set GPIB = New VisaComLib.FormattedIO488
   '*** Open the instrument.
   Set GPIB.IO = ioMgr.Open("GPIB0::16::INSTR")
   GPIB.IO.timeout = 10000

   Dim Numpts As Long
   Dim Datam As Variant
     
   'Select the measurement
   GPIB.WriteString "CALCulate1:MEASure1:PARameter 'S21'", True
   'Read the number of data points
   GPIB.WriteString "SENSe1:SWEep:POINts?", True
   Numpts = GPIB.ReadNumber
   'Turn continuous sweep off
   GPIB.WriteString "INITiate:CONTinuous OFF", True
   'Take a sweep
   GPIB.WriteString "INITiate1:IMMediate;*WAI", True
   'Ask for the Data
   'PICK ONE OF THESE LOCATIONS TO READ
   GPIB.WriteString "CALCulate1:MEASure1:DATA:FDATA?", True
                        ' Formatted Meas
   'GPIB.WriteString "CALCulate1:MEASure1:DATA:FMEM?", True
                         ' Formatted Memory
   'GPIB.WriteString "CALCulate1:MEASure1:DATA:SDATA?", True
                        ' Corrected, Complex Meas
   'GPIB.WriteString "CALCulate1:MEASure1:DATA:SMEM?", True
                         ' Corrected, Complex Memory
   'GPIB.WriteString "SENSe1:CORRection:CSET:ETERm:DATA? 'Directivity(1,1)'", True
  ' Error-Term Directivity

   'Parse the data
   Datam = GPIB.ReadList(ASCIIType_R8, ",")

   'PUT THE DATA BACK IN
   GPIB.WriteString "CALCulate1:MEASure1:DATA:FDATA ", False
                       ' Formatted Meas
   'GPIB.WriteString "CALCulate1:MEASure1:DATA:FMEM ", False
                        ' Formatted Memory
   'GPIB.WriteString "CALCulate1:MEASure1:DATA:SDATA ", False
                       ' Corrected, Complex Meas
   'GPIB.WriteString "CALCulate1:MEASure1:DATA:SMEM ", False
                        ' Corrected, Complex Memory
   'GPIB.WriteString "SENSe1:CORRection:CSET:ETERm:DATA 'Directivity(1,1)',", False
 ' Error-Term Directivity
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   GPIB.WriteList Datam, ASCIIType_R8, ",", True

   '*** End procedure
   GPIB.IO.Close
End Sub
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GPIB Pass-Through Example

The SCPI SYSTem commands used in this example allow you to send GPIB commands to another

GPIB device through the VNA. The other device would typically be connected to the VNA through the

System Controller GPIB port on the VNA rear-panel or alternatively be connected using a USB/GPIB
interface. Uncomment the line in Blue text in the example to open a session for a USB/GPIB interface.

This VB Script example uses the COM SCPIStringParser object. However, this is not critical to the use

of these commands; they can be sent using the normal syntax of your programming environment. Using

the SCPIStringParser over LAN allows you to communicate with GPIB devices without requiring your

remote PC to have a GPIB interface card installed.

Although this method of pass-through works for most applications, there are a couple of limitations:

All data is transferred using ASCII format. Therefore, transferring large blocks of data is very slow.

Only read and write functions are possible. Service Interrupts are not supported.

See Other SCPI Example Programs

option explicit
dim app
set app = CreateObject("AgilentPNA835x.Application")

dim p
set p = app.ScpiStringParser

' Open a new GPIB session on Bus:0 Device:14 Timeout: 100ms
p.Parse "SYST:COMM:GPIB:RDEV:OPEN 0,14,100"
' The following commented-out line shows opening the same session but
' for a USB/GPIB interface with VISA interface number GPIB4
'p.Parse "SYST:COMM:GPIB:RDEV:OPEN 4,14,100"
dim handleAsStr

' Retrieve the handle (ID number)
handleAsStr = p.Parse ("SYST:COMM:GPIB:RDEV:OPEN?")

' Convert the handle to an integer
dim handleAsInt
handleAsInt = CInt(handleAsStr)

' Send the "*IDN?" query
p.Parse "SYST:COMM:GPIB:RDEV:WRITE " & handleAsInt & ",'*IDN?'"

' Read its results
dim idn
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idn = p.Parse("SYST:COMM:GPIB:RDEV:READ? " & handleAsInt)
msgbox idn

' Close the GPIB session
p.Parse "SYST:COMM:GPIB:RDEV:CLOSE " & handleAsInt
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GPIB using Visual C++

 See Other SCPI Example Programs

/*
 * This example assumes the user's PC has a National Instruments GPIB board. The
example is comprised of three basic parts:
 *
 * 1. Initialization
 * 2. Main Body
 * 3. Cleanup
 *
 * The Initialization portion consists of getting a handle to the VNA and then doing
a GPIB clear of the VNA.
 *
 * The Main Body consists of the VNA SCPI example.
 *
 * The last step, Cleanup, releases the VNA for front panel control.
 */

#include <stdio.h>
#include <stdlib.h>

/*
 * Include the WINDOWS.H and DECL-32.H files. The standard Windows
 * header file, WINDOWS.H, contains definitions used by DECL-32.H and
 * DECL-32.H contains prototypes for the NI GPIB routines and constants.
 */
#include <windows.h>
#include "decl-32.h"

#define ERRMSGSIZE 1024 // Maximum size of SCPI command string
#define ARRAYSIZE 1024 // Size of read buffer

#define BDINDEX 0 // Board Index of GPIB board
#define PRIMARY_ADDR_OF_PNA 16 // GPIB address of VNA
#define NO_SECONDARY_ADDR 0 // VNA has no Secondary address
#define TIMEOUT T10s // Timeout value = 10 seconds
#define EOTMODE 1 // Enable the END message
#define EOSMODE 0 // Disable the EOS mode

int pna;
char ValueStr[ARRAYSIZE + 1];
char ErrorMnemonic[21][5] = {"EDVR", "ECIC", "ENOL", "EADR", "EARG",
  "ESAC", "EABO", "ENEB", "EDMA", "",
  "EOIP", "ECAP", "EFSO", "", "EBUS",
  "ESTB", "ESRQ", "", "", "", "ETAB"};

void GPIBWrite(char* SCPIcmd);
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char *GPIBRead(void);
void GPIBCleanup(int Dev, char* ErrorMsg);

int main()
{

char *opc;
char *result;
char *value;

/*
 * =========================================
* INITIALIZATION SECTION
 * =========================================
 */

  /*
  * The application brings the VNA online using ibdev. A device handle,VNA, is
returned and is used in all subsequent calls to the VNA.
  */
  pna = ibdev(BDINDEX, PRIMARY_ADDR_OF_PNA, NO_SECONDARY_ADDR,
  TIMEOUT, EOTMODE, EOSMODE);
  if (ibsta & ERR)
  {
  printf("Unable to open handle to PNA/nibsta = 0x%x iberr = %d/n",
  ibsta, iberr);
  return 1;
  }

  /*
  * Do a GPIB Clear of the VNA. If the error bit ERR is set in ibsta, call
GPIBCleanup with an error message.
  */
  ibclr (pna);
  if (ibsta & ERR)
  {
  GPIBCleanup(pna, "Unable to perform GPIB clear of the PNA");
  return 1;
  }

/*
 * =========================================
 * MAIN BODY SECTION
 * =========================================
 */

  // Reset the analyzer to instrument preset
  GPIBWrite("SYSTem:FPRESET");
 
  // Create S11 measurement
  GPIBWrite("CALCulate1:PARameter:DEFine:EXT 'My_S11',S11");
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  // Turn on Window #1
  GPIBWrite("DISPlay:WINDow1:STATe ON");
 
  // Put a trace (Trace #1) into Window #1 and 'feed' it from the measurement
  GPIBWrite("DISPlay:WINDow1:TRACe1:FEED 'My_S11'");
 
  // Setup the channel for single sweep trigger
  GPIBWrite("INITiate1:CONTinuous OFF;*OPC?");
  opc = GPIBRead();
  GPIBWrite("SENSe1:SWEep:TRIGger:POINt OFF");

  // Set channel parameters
  GPIBWrite("SENSe1:SWEep:POINts 11");
  GPIBWrite("SENSe1:FREQuency:STARt 1000000000");
  GPIBWrite("SENSe1:FREQuency:STOP 2000000000");

  // Send a trigger to initiate a single sweep
  GPIBWrite("INITiate1;*OPC?");
  opc = GPIBRead();
 
  // Must select the measurement before we can read the data
  GPIBWrite("CALCulate1:PARameter:SELect 'My_S11'");
 
  // Read the measurement data into the "result" string variable
  GPIBWrite("FORMat ASCII");
  GPIBWrite("CALCulate1:DATA? FDATA");
  result = GPIBRead();
 
  // Print the data to the display console window
printf("S11(dB) - Visual C++ SCPI Example for PNA/n/n");
  value = strtok(result, ",");
while (value != NULL)
  {
  printf("%s/n", value);
  value = strtok(NULL, ",");
  }

/*
 * =========================================
 * CLEANUP SECTION
 * =========================================
 */

  /* The VNA is returned to front panel control. */
  ibonl(pna, 0);

  return 0;
}

/*
 * Write to the VNA
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 */
void GPIBWrite(char* SCPIcmd)
{
int length;
char ErrorMsg[ERRMSGSIZE + 1];
length = strlen(SCPIcmd) ;

  ibwrt (pna, SCPIcmd, length);
  if (ibsta & ERR)
  {
  strcpy(ErrorMsg, "Unable to write this command to PNA:/n");
  strcat(ErrorMsg, SCPIcmd);

  GPIBCleanup(pna, ErrorMsg);
  exit(1);
  }
}

/*
 * Read from the VNA
 */
char* GPIBRead(void)
{
  ibrd (pna, ValueStr, ARRAYSIZE);
  if (ibsta & ERR)
  {
  GPIBCleanup(pna, "Unable to read from the PNA");
  exit(1);
  }
else
  return ValueStr;
}

/*
 * After each GPIB call, the application checks whether the call succeeded. If an
NI-488.2 call fails, the GPIB driver sets the corresponding bit in the global status
variable. If the call failed, this procedure prints an error message, takes the VNA
offline and exits.
 */
void GPIBCleanup(int Dev, char* ErrorMsg)
{
  printf("Error : %s/nibsta = 0x%x iberr = %d (%s)/n",
  ErrorMsg, ibsta, iberr, ErrorMnemonic[iberr]);
  if (Dev != -1)
  {
  printf("Cleanup: Returning PNA to front panel control/n");
  ibonl (Dev, 0);
  }
}
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Load Error Terms during a Cal Sequence

This example requires that you already have a Cal Set named "foo" that contains a 1-port cal on port 1

and a 1-port cal on port 2.

This example starts a Guided Calibration specifying an Unknown Thru. It loads the 1-port Cals from

the existing "foo" Cal Set, then recalculates the number of steps required to complete the cal. After

loading the 1-port cals, only the Unknown Thru standard is left to acquire.

SENS:CORR:COLL:GUID:CONN:PORT1 "APC 3.5 female"

SENS:CORR:COLL:GUID:CONN:PORT2 "APC 3.5 female"

SENS:CORR:COLL:GUID:CKIT:PORT1 "85033D/E"

SENS:CORR:COLL:GUID:CKIT:PORT2 "85033D/E"

SENS:CORR:COLL:GUID:METH UNKN

' auto-create user calsets for SCPI

SENS:CORR:PREF:CSET:SAVU 1

SENS:CORR:COLL:GUID:INIT

' should return the number 7

SENS:CORR:COLL:GUID:STEPS?

' to port 1, from port 1 in calset

SENS:CORR:COLL:GUID:ETER:LOAD "foo",1,1

' to port 2, from port 2 in calset

SENS:CORR:COLL:GUID:ETER:LOAD "foo",2,2

' should now return the number 1

SENS:CORR:COLL:GUID:STEPS?

' measure the unknown thru

SENS:CORR:COLL:GUID:ACQ STAN1

' save the cal to new user calset

SENS:CORR:COLL:GUID:SAVE
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Modify a Calibration Kit using SCPI

This Visual Basic program:

Modifies Calibration kit number 3

Completely defines standard #4 (thru)

To run this program, you need:

An established GPIB interface connection

 See Other SCPI Example Programs

'Modifying cal kit number 3
Calkitnum = 3

'Designate the kit selection to be used for performing cal's
GPIB.Write "SENSe:CORRection:COLLect:CKIT:SELect " & Val(Calkitnum)

'Reset to factory default values.
GPIB.Write "SENSe:CORRection:COLLect:CKIT:RESet " & Val(Calkitnum)

'Name this kit with your own name
GPIB.Write "SENSe:CORRection:COLLect:CKIT:NAME 'My Cal Kit'"

'Assign standard numbers to calibration classes
'Set Port 1, class 1 (S11A) to be standard #8
GPIB.Write "SENSe:CORRection:COLLect:CKIT:ORDer1 8"
'Set Port 1, class 2 (S11B) to be standard #7
GPIB.Write "SENSe:CORRection:COLLect:CKIT:ORDer2 7"
'Set Port 1, class 3 (S11C) to be standard #3
GPIB.Write "SENSe:CORRection:COLLect:CKIT:ORDer3 3"
'Set Port 1, class 4 (S21T) to be standard #4
GPIB.Write "SENSe:CORRection:COLLect:CKIT:ORDer4 4"
'Set Port 2, class 1 (S22A) to be standard #8
GPIB.Write "SENSe:CORRection:COLLect:CKIT:ORDer5 8"
'Set Port 2, class 2 (S22B) to be standard #7
GPIB.Write "SENSe:CORRection:COLLect:CKIT:ORDer6 7"
'Set Port 2, class 3 (S22C) to be standard #3
GPIB.Write "SENSe:CORRection:COLLect:CKIT:ORDer7 3"
'Set Port 2, class 4 (S12T) to be standard #4
GPIB.Write "SENSe:CORRection:COLLect:CKIT:ORDer8 4"

'Set up Standard #4 completely
'Select Standard #4; the rest of the commands act on it
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard 4"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:FMIN 300KHz"
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GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:FMAX 9GHz"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:IMPedance 50"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:DELay 1.234 ns"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:LOSS 23e6"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:C0 0"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:C1 1"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:C2 2"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:C3 3"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:L0 10"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:L1 11"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:L2 12"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:L3 13"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:LABel 'My Special Thru'"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:TYPE THRU"
GPIB.Write "SENSe:CORRection:COLLect:CKIT:STANdard:CHARacteristic Coax"
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Perform a Guided 2-Port or 4-Port Cal using SCPI

This example performs a Guided 2-Port or 4-port Calibration using ONE set of calibration standards or

an ECAL module.

A measurement must first be set up with desired frequency range, power, and so forth, ready to be

calibrated.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file, such as Notepad, and save it on the VNA hard drive as *.vbs.

Learn how to setup and run the macro.

See Guided Cal SCPI commands

See Other SCPI Example Programs

Dim app
Dim scpi
' Create / Get the VNA application.
Set app = CreateObject("AgilentPNA835x.Application")
Set scpi = app.ScpiStringParser

' To perform 2-port cal, Uncomment TwoPortGuidedCal()
' Then comment FourPortGuidedCal()

'Do 2-port Cal
'TwoPortGuidedCal()

'Do 4-port Cal
FourPortGuidedCal

Sub TwoPortGuidedCal()
' Select the connectors
scpi.Execute("sens:corr:coll:guid:conn:port1 ""APC 3.5 female"" ")
scpi.Execute("sens:corr:coll:guid:conn:port2 ""APC 3.5 male"" ")
scpi.Execute("sens:corr:coll:guid:conn:port3 ""Not used"" ")
scpi.Execute("sens:corr:coll:guid:conn:port4 ""Not used"" ")
MsgBox("Connectors defined for Ports 1 and 2")

' Select the Cal Kit for each port being calibrated.

scpi.Execute("sens:corr:coll:guid:ckit:port1 ""85052D"" ")
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scpi.Execute("sens:corr:coll:guid:ckit:port2 ""85052D"" ")

' To use an ECal module instead, comment out the above two lines

' and uncomment the appropriate lines below:

' Your ECal module must already be connected

' via USB to the VNA.

'scpi.Parse "sens:corr:coll:guid:ckit:port1 'N4691-60004 ECal'"

'scpi.Parse "sens:corr:coll:guid:ckit:port2 'N4691-60004 ECal'"

' Non-factory characterizations are specified as follows:

'scpi.Parse "sens:corr:coll:guid:ckit:port2 'N4691-60004 User 1 ECal'"

' When two or more ECal modules with the same model number are connected

' also specify the serial number as follows:

'scpi.Parse "sens:corr:coll:guid:ckit:port2 'N4691-60004 ECal 01234'"

' When Disk Memory ECal user characterizations are used,

' specify both the User char and the serial number as follows:

'scpi.Parse "sens:corr:coll:guid:ckit:port2 'N4691-60004 MyDskChar ECal 01234'"

'

MsgBox("Cal kits defined for Ports 1 and 2")

' Initiate the calibration and query the number of steps
numSteps = GenerateSteps()
' Measure the standards, compute and apply the cal
MeasureAndComplete(numSteps)
End Sub

Sub FourPortGuidedCal()
' Select the connectors
scpi.Execute("sens:corr:coll:guid:conn:port1 ""APC 3.5 female"" ")
scpi.Execute("sens:corr:coll:guid:conn:port2 ""APC 3.5 female"" ")
scpi.Execute("sens:corr:coll:guid:conn:port3 ""APC 3.5 female"" ")
scpi.Execute("sens:corr:coll:guid:conn:port4 ""APC 3.5 female"" ")
MsgBox("Connectors defined for Ports 1 to 4")
' Select the Cal Kit for each port being calibrated.
scpi.Execute("sens:corr:coll:guid:ckit:port1 ""85052D"" ")
scpi.Execute("sens:corr:coll:guid:ckit:port2 ""85052D"" ")
scpi.Execute("sens:corr:coll:guid:ckit:port3 ""85052D"" ")
scpi.Execute("sens:corr:coll:guid:ckit:port4 ""85052D"" ")
' To use an ECal module instead, comment out the above four lines
' and uncomment these four lines and use the part number printed
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' on your module (which in our case was N4431-60003), followed
' by the word 'ECal'.  Your ECal module must already be connected
' via USB to the VNA.

' see above for ECal options

'scpi.Execute("sens:corr:coll:guid:ckit:port1 ""N4431-60003 ECal"" ")
'scpi.Execute("sens:corr:coll:guid:ckit:port2 ""N4431-60003 ECal"" ")
'scpi.Execute("sens:corr:coll:guid:ckit:port3 ""N4431-60003 ECal"" ")
'scpi.Execute("sens:corr:coll:guid:ckit:port4 ""N4431-60003 ECal"" ")
MsgBox("Cal kits defined for Ports 1 to 4")

 

' Initiate the calibration and query the number of steps
numSteps = GenerateSteps()
' If your selected cal kit is not a 4-port ECal module which can
' mate to all 4 ports at once, then you may want to choose which
' thru connections to measure for the cal.  You must measure at
' least 3 different thru paths for a 4-port cal (for greatest
' accuracy you can choose to measure a thru connection for all 6
' pairings of the 4 ports).  If you omit this command, the default
' is to measure from port 1 to port 2, port 1 to port 3, and
' port 1 to port 4.   For this example we select to measure
' from port 1 to port 2, port 2 to port 3, and port 2 to port 4.
scpi.Execute("sens:corr:coll:guid:thru:ports 1,2,2,3,2,4")
' Re-generate the connection steps to account for the thru changes
numSteps = GenerateSteps()
' Measure the standards, compute and apply the cal
MeasureAndComplete(numSteps)
End Sub

Function GenerateSteps()
' Initiate the calibration and query the number of steps
scpi.Execute("sens:corr:coll:guid:init")
GenerateSteps =  scpi.Execute("sens:corr:coll:guid:steps?")
End Function

Sub MeasureAndComplete(numSteps)
MsgBox("Number of steps is " + CStr(numSteps))
' Measure the standards
For i = 1 To numSteps
step = "Step " + CStr(i) + " of " + CStr(numSteps)
strPrompt = scpi.Execute("sens:corr:coll:guid:desc? " + CStr(i))
MsgBox strPrompt, vbOKOnly, step
' Note: if you have set up a slow sweep speed (for example, if
' you’re using a narrow IF bandwidth) or you’re using ECal, and
' while a cal step is being measured you wish to have your program
' perform other operations (like checking for the click event of a
' Cancel button) and you’re NOT using the COM ScpiStringParser,
' you can use the optional ASYNchronous argument with the ACQuire
' command as shown in this commented-out line below.  The SCPI
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' parser then will return immediately while the cal step measurement
' proceeds (i.e., the parser will NOT block-and-wait for the
' measurement step to finish, so you can send additional commands
' in the meantime).  So you can do “*ESR?” or “*STB?” queries to
' monitor the status register bytes to see when the OPC bit gets set,
' which indicates the cal measurement step has finished.  This OPC
' detection works for all of the VNA’s SCPI parsers except the COM
' ScpiStringParser.
'  “sens:corr:coll:guid:acq STAN” + CStr(i) + “,ASYN;*OPC”
scpi.Execute("sens:corr:coll:guid:acq STAN" + CStr(i))
Next
' Conclude the calibration
scpi.Execute("sens:corr:coll:guid:save")
MsgBox ("Cal is done!")
End Sub  
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Perform a Simple Source Power Cal

This example performs a Source Power Cal using ONE USB Power Sensor, already connected to the

VNA.

A measurement must first be set up with desired frequency range, power, and so forth, ready to be

calibrated.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file, such as Notepad, and save it on the VNA hard drive as spc.vbs.

Learn how to setup and run the macro.

See Source Power Cal SCPI commands

See Other SCPI Example Programs

'Performs a source power cal on channel 1 - port 1 using a USB power sensor

'This example assumes ONE USB power sensor is connected to the VNA

Dim app

Dim scpi

Dim sensor

' Create / Get the VNA application.

Set app = CreateObject("AgilentPNA835x.Application")

Set scpi = app.ScpiStringParser

scpi.parse "SYST:PRES"

'set power accuracy tolerance and iterations

scpi.parse "SOUR1:POW1:CORR:COLL:ITER:NTOL 0.1"

scpi.parse "SOUR1:POW1:CORR:COLL:ITER:COUN 15"

'set power sensor settling tolerance

scpi.parse "SOUR1:POW1:CORR:COLL:AVER:NTOL 0.1"
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scpi.parse "SOUR1::POW1:CORR:COLL:AVER:COUN 15"

'set offset value for amp or attenuation

scpi.parse "SOUR1:POW1:CORR:OFFS 0 DB"

'show source power cal dialog

scpi.parse "SOUR1:POW1:CORR:COLL:DISP ON"

'read the usb power sensor ID string

sensor=scpi.parse("SYST:COMM:USB:PMET:CAT?")

'specify that sensor

scpi.parse "SYST:COMM:PSEN usb," + sensor

'do the measurement

scpi.parse "SOUR1:POW1:CORR:COLL:ACQ PMR,"ASENSOR""

'save the source cal and create an R-Channel response calset

scpi.parse "SOUR:POW:CORR:COLL:SAVE RREC"
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Perform an ECal User Characterization

This example performs a user-characterization and stores it to both the ECal module memory and VNA

disk memory.  It also demonstrates the use of the EXPort, CLEar, IMPort and ‘KNAMe:INF?’

commands.

It then performs two 2-port cals: the first using the characterization from module memory, then using

the characterization from disk memory.

Note: This example requires that channel 1 be already calibrated.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file, such as Notepad, and save it on the VNA hard drive as ECal.vbs.

Learn how to setup and run the macro.

See all ECal User Characterization SCPI commands

See Other SCPI Example Programs

Option Explicit

Dim pna

Set pna = CreateObject("AgilentPNA835x.Application")

Dim scpi

Set scpi = pna.ScpiStringParser

' Substitute here the model number and serial number of your own ECal.

' Note that this example corresponds to a 4-port ECal module with

' serial number 00001. If you have a 2-port ECal module, their model

' numbers are '5x5' numbers -- for example, 'N4691-60001'.

Dim ecalModelNum

ecalModelNum = "N4433A"

Dim ecalSerialNum
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ecalSerialNum = "00001"

scpi.Parse "SENS1:CORR:CKIT:ECAL:CHAR:ID '" & ecalModelNum & "," & ecalSerialNum
& "'"

MsgBox "ECal module to be characterized is: " &
scpi.Parse("SENS1:CORR:CKIT:ECAL:CHAR:ID?")

' Set which user characterization number (1-12) the new characterization

' will be stored to in the ECal module when it is done.  If you intend to

' store your user characterization just to VNA Disk Memory and NOT the

' ECal module's memory, then omit this command.

Dim characterizationNumber

characterizationNumber = 1

scpi.Parse "SENS1:CORR:CKIT:ECAL:CHAR:CNUM " & CStr(characterizationNumber)

' The following commented-out lines of code show how you can access

' the list of connector type names you can set for the ports of an

' ECal when you user-characterize it.  However, please note that if

' you are writing the user characterization to the ECal module's memory,

' as of yet only the Factory Defined set of connector choices will work

' properly (see SENS:CORR:CKIT:ECAL:CHAR:CONN:CAT?). If you will be saving

' your characterization to just VNA Disk Memory only, then all connector

' names returned by this query will work,

' user-defined connector names as well as factory-defined.

 

'Dim connTypeList

'connTypeList = scpi.Parse("SENS:CORR:CKIT:ECAL:CHAR:CONN:CAT?")

'MsgBox connTypeList

 

' For each port of the ECal module, specify which connector type

' is at the end of the adapter (or cable or fixture) that is

' connected to that port of the ECal for the characterization
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' (must be one of the connector types that is included in the

' list that "SENS:CORR:CKIT:ECAL:CHAR:CONN:CAT?" returns).  The

' default is "No adapter", which assumes you are characterizing that

' port of the ECal "as is" (nothing attached to it).  So in this

' example, Ports C and D of the ECal are being characterized to just

' the ECal's connectors.

scpi.Parse "SENS1:CORR:CKIT:ECAL:CHAR:CONN:PORT1 'APC 3.5 male'" ' ECal Port A

scpi.Parse "SENS1:CORR:CKIT:ECAL:CHAR:CONN:PORT2 'APC 3.5 male'" ' ECal Port B

' As with the connector types, the information set in these next

' few properties also gets stored within the characterization.

' Set the name of the person and/or company that is producing

' this characterization.

scpi.Parse "SENS1:CORR:CKIT:ECAL:CHAR:DESC:USER 'John Doe, Acme Inc.'"

' Set user-specified description of the VNA being used.

scpi.Parse "SENS1:CORR:CKIT:ECAL:CHAR:DESC:VNA 'SN US12345678'"

' Set descriptions of what you have connected to the ECal module's

' ports for the characterization.

' Port A of the ECal

scpi.Parse "SENS1:CORR:CKIT:ECAL:CHAR:DESC:PORT1 '3.5 mm adapter, SN 00001'"

' Port B of the ECal

scpi.Parse "SENS1:CORR:CKIT:ECAL:CHAR:DESC:PORT2 '3.5 mm adapter, SN 00002'"

' Note that the "SENS:CORR:CKIT:ECAL:CHAR:" INITiate, ACQuire and SAVE

' ("CHAR:SAVE" but not "CHAR:DMEMory:SAVE") commands can all each take a
significant

' amount of time to execute/complete.  If you are looking at this example to

' leverage this functionality into a SCPI via GPIB or SCPI via SICL-LAN

' (VXI-11.2/11.3) application, then you could issue the "*CLS" and "*ESE 1"
commands

' as shown in the commented-out lines below, and use your I/O libraries' Serial
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Poll

' function to repeatedly read the status byte until you detect bit 5 (weight of
32)

' in that byte is set.  That will happen when the command you are pairing with

' ";*OPC" has completed its operation.  But that technique only works for the
GPIB

' and SICL-LAN interfaces.  If you need to use the TCPIP Socket or COM

' ScpiStringParser (as is used in this example) SCPI interfaces where there's

' no "built-in" Serial Poll type of function, to ensure your program operates in
a

' synchronized manner it will need to wait on the "*OPC?" reply (and not time
out)

' before proceeding to the next line of your program.  In that event, we
recommend

' you execute these commands on a thread of execution separate from your
program's

' user interface thread.

' Of the "SENS:CORR:CKIT:ECAL:CHAR:" INITiate, ACQuire and SAVE commands, the
SAVE

' command takes the longest amount of time to complete (unless you've set up your

' measurement channel to have a very slow sweep time, in which case the ACQuire

' command could take longer).  For an ECal that is a N469x, N4432A or N4433A, or
an

' 8509x or N4431x produced by Keysight in 2005 or later, the SAVE command can
take a

' maximum of approximately 4 to 5 minutes to complete (that corresponds to a

' characterization that will result in the ECal's memory becoming completely
filled).

' For an 8509x or N4431x ECal that was produced in 2004 or earlier, the SAVE
command

' can take a maximum of 9 to 10 minutes to complete (again that corresponds to a

' characterization that will result in the ECal's memory becoming completely
full).
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' Begin a user characterization on Channel 1.

' If you will be storing this characterization to the ECal module's memory, then

' the boolean argument to this command is optional (but if you choose to include
it

' for that case then you must specify it as 1 or ON).  If you will be storing
this

' characterization to VNA disk memory ONLY, then you should specify 0 or OFF for

' that argument.  In this example we will be storing the characterization to both

' module memory and VNA disk memory, so we can just omit the argument and let it

' default to 1.

scpi.Parse "SENS1:CORR:CKIT:ECAL:CHAR:INIT"

Dim numSteps

numSteps = CLng( scpi.Parse("SENS1:CORR:CKIT:ECAL:CHAR:STEP?") )

Dim opcReply

'Dim statusByte

' Measure the steps.

' Note: prior to measuring the steps you must already have a calibration of the

' necessary number of ports applied to the channel (which in this example is
Channel 1).

' Otherwise an error will be reported to the SCPI error queue.

Dim i

For i = 1 To numSteps

   ' Display the step's description.

   MsgBox scpi.Parse("SENS1:CORR:CKIT:ECAL:CHAR:DESC? " & i)

   ' Clear the instrument's Status Byte.

'   scpi.Execute "*CLS"

   ' Enable for the OPC bit (bit 0, which has weight 1) in the instrument's

   ' Event Status Register, so that when that bit's value transitions from 0 to 1

   ' then the Event Status Register bit in the Status Byte (bit 5 of that byte,
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   ' weight 32) will become set.

'   scpi.Execute "*ESE 1"

   ' Issue the ACQuire command

   opcReply = scpi.Parse("SENS1:CORR:CKIT:ECAL:CHAR:ACQ STAN" & CStr(i) & ";*OPC?
")

'   scpi.Execute "SENS1:CORR:CKIT:ECAL:CHAR:ACQ STAN" & CStr(i) & ";*OPC"

'   Do

      ' here is where if you leverage this example into an environment where

      ' you are using SCPI via GPIB or SICL-LAN, that in this loop you could do a

      ' Serial Poll via that interface to read the status byte into this

      ' statusByte variable.  Then this If statement would detect when bit 5 is
set.

'      If ( (statusByte/32) Mod 2) Then Exit Do

      ' And note that normally you would want to have your program do some other

      ' processing (for example, check for user input from keyboard/mouse, for

      ' a cancellation request) here in this loop.

'   Loop

   MsgBox "ACQuire is complete"

Next

MsgBox "Now the user characterization will be saved to the ECal module and to PNA
disk memory"

'scpi.Execute "*CLS;*ESE 1"

' Save the user characterization to the ECal module's memory.

opcReply = scpi.Parse("SENS1:CORR:CKIT:ECAL:CHAR:SAVE;*OPC?")

'scpi.Execute "SENS1:CORR:CKIT:ECAL:CHAR:SAVE;*OPC"

'Do

   ' again here you could do a Serial Poll to get statusByte if using GPIB or
SICL-LAN

'   If ( (statusByte/32) Mod 2) Then Exit Do

'Loop
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' Save the user characterization to VNA Disk Memory.

Dim characterizationName

characterizationName = "test"

opcReply = scpi.Parse("SENS1:CORR:CKIT:ECAL:CHAR:DMEM:SAVE '" &
characterizationName & "';*OPC?")

Dim pnaDiskMemCalKitName

pnaDiskMemCalKitName = GetCalKitName(characterizationName)

' Exporting the characterization from VNA disk memory into a file.

' The file can be used for loading the characterization into VNA disk memory on
another VNA.

scpi.Parse "SENS:CORR:CKIT:ECAL:EXP '" & pnaDiskMemCalKitName & "'"

' Demonstrating that the characterization can be cleared from VNA disk memory and

' then re-loaded (IMPorted) from the file that was created by the
 '"SENS:CORR:CKIT:ECAL:EXP".

scpi.Parse "SENS:CORR:CKIT:ECAL:DMEM:CLE '" & pnaDiskMemCalKitName & "'"

scpi.Parse "SENS:CORR:CKIT:ECAL:DMEM:IMP 'C:/Program Files/Keysight/Network
Analyzer/ECal User Characterizations/" & pnaDiskMemCalKitName & ".euc'"

Dim moduleMemCalKitName

moduleMemCalKitName = GetCalKitName("User " & CStr(characterizationNumber))

MsgBox "Information about the characterization from ECal module memory = " &
scpi.Parse("SENS:CORR:CKIT:ECAL:KNAM:INF? '" & moduleMemCalKitName & "'")

MsgBox "Information about the characterization from PNA disk memory = " &
scpi.Parse("SENS:CORR:CKIT:ECAL:KNAM:INF? '" & pnaDiskMemCalKitName & "'")

MsgBox "User characterization is complete.  Now we will calibrate using it.
 First we will use it from ECal module memory."

DoTwoPortCal moduleMemCalKitName

MsgBox "Now we will calibrate using the characterization from PNA Disk Memory."

DoTwoPortCal pnaDiskMemCalKitName

MsgBox "Example has completed"

'

Function GetCalKitName(characterizationName)
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Dim calKitName

calKitName = ecalModelNum

If Len(characterizationName) > 0 Then calKitName = calKitName & " " &
characterizationName

calKitName = calKitName & " ECal " & ecalSerialNum

GetCalKitName = calKitName

End Function

 

Sub DoTwoPortCal(calKitName)

' Specify the DUT connector for each VNA port to be calibrated (DUT connector =
ECal characterization's connector)

scpi.Parse "SENS1:CORR:COLL:GUID:CONN:PORT1 'APC 3.5 male'"

scpi.Parse "SENS1:CORR:COLL:GUID:CONN:PORT2 'APC 3.5 male'"

' Specify the "cal kit" for each of those ports

scpi.Parse "SENS1:CORR:COLL:GUID:CKIT:PORT1 '" & calKitName & "'"

scpi.Parse "SENS1:CORR:COLL:GUID:CKIT:PORT2 '" & calKitName & "'"

' This results in a calibration sequence of a single "connection step"

scpi.Parse "SENS1:CORR:COLL:GUID:INIT"

' Acquire the cal connection step

opcReply = scpi.Parse("SENS1:CORR:COLL:GUID:ACQ STAN1;*OPC?")

' Again here instead of waiting for opcReply you could do a Serial Poll to get
statusByte if using GPIB or SICL-LAN

'scpi.Execute "SENS1:CORR:COLL:GUID:ACQ STAN1;*OPC"

'Do

' If ( (statusByte/32) Mod 2) Then Exit Do

'Loop

' Conclude the cal and turn it on

scpi.Parse "SENS1:CORR:COLL:GUID:SAVE"

End Sub
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Perform an Unguided Cal on a 4-Port VNA

This topic describes how to perform an unguided calibration on a multiport network analyzer using

SCPI.  The objective here is to make clear the relationship between the physical port on which a

standard is being measured, the actual device in the cal kit, and the SCPI command used to acquire the

device.

There are two sets of SCPI commands that acquire calibrations.  One set is used for guided cal, the

other for unguided. The SCPI commands that provide remote access to unguided cal are in the

SENS:CORR:COLL block:

SENS:CORR:COLL:METHod

SENS:CORR:COLL:ACQuire

SENS:CORR:COLL:SAVE

On a four port network analyzer, the remote programmer needs to be aware of the relationship between

the physical port and the calibration kit class assignments.  The example program (below) illustrates the

usage by performing three unique 2 port cals, taking care to acquire the appropriate standards.

Calibration standards classes are ‘categories’ of standard types.  To perform a 2 port calibration, the cal

wizard requires the user to measure:

3 reflection standards on the forward port:

Class S11A typically an open

Class S11B typically a short

Class S11C typically a load

Likewise, 3 reflection standards are required for the reverse port:

Class S22A typically an open

Class S22B typically a short

Class S22C typically a load

There is also a transmission standard that is measured in both directions:
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Class S21T typically a thru

The following illustrates the relationship between cal kit physical standards and calibration classes.

Here is a list of the physical devices in my calibration kit.

Standard #1 = "3.5 mm male short"

Standard #2 = "3.5 mm male open"

Standard #3 = "3.5 mm male broadband load"

Standard #4 = "Insertable thru standard"

Standard #5 = "3.5 mm male sliding load"

Standard #6 = "3.5 mm male lowband load"

Standard #7 = "3.5 mm female short"

Standard #8 = "female to female characterized  thru adapter"

Standard #9 = "0-2 Load"

Standard #10 = "Open"

Standard #11 = "Non-insertable thru"

Standard #12 = "3.5 mm female lowband load"

Standard #13 = "3.5 mm female sliding load"

Standard #14 = "3.5 mm female broadband load"

Standard #15 = "3.5 mm female open"

When you perform a calibration remotely using SCPI, you don’t specify the device number directly.

 Rather, you specify the class you want to measure.  Each device in the calibration kit is assigned to a

class.  And since more than one device can be assigned to the same class, each class contains an

ordered list of devices. The class assignments are user-settable using the Advanced Modify Cal Kit

dialog or the SCPI command:

SENS:CORR:COLL:CKIT:ORDer<class>, <std>, <std>, <std>, <std>,<std>,<std>,<std>

The 85052B kit used in the example program had the following standard list for each class:  The list

was obtained by issuing the corresponding SCPI query:

SENS:CORR:COLL:CKIT:OLIST1?   S11A = +2,+15,+0,+0,+0,+0,+0
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SENS:CORR:COLL:CKIT:OLIST2?   S11B = +1,+7,+0,+0,+0,+0,+0

SENS:CORR:COLL:CKIT:OLIST3?   S11C = +6,+5,+3,+12,+13,+14,+0

SENS:CORR:COLL:CKIT:OLIST4?   S21T = +4,+8,+0,+0,+0,+0,+0

SENS:CORR:COLL:CKIT:OLIST5?   S22A = +2,+15,+0,+0,+0,+0,+0

SENS:CORR:COLL:CKIT:OLIST6?   S22B = +1,+7,+0,+0,+0,+0,+0

SENS:CORR:COLL:CKIT:OLIST7?   S22C = +6,+5,+3,+12,+13,+14,+0

SENS:CORR:COLL:CKIT:OLIST8?   S12T = +4,+8,+0,+0,+0,+0,+0

When you perform the calibration, you acquire data by issuing the ACQuire command:

SENS:CORR:COLL:ACQ <class>[, <subst> ]

For example:

SENS:CORR:COLL:SFOR 1

SENS:CORR:COLL:ACQ STANA, SST2

The SFOR command tells the wizard to make the next acquisition in the forward direction.  The

ACQuire command specifies that we are measuring the 2nd device in the list for STANA.  And since

we are measuring SFORward, STANA refers to class #1 or S11A.  The list of devices for this class are

specified in the OLIST1 query above.  The associations are shown in red.

Alternately, you could modify the device order for the S11A class to move device #15 into the first

position (SENS:CORR:COLL:CKIT:ORDER1).  When the desired device is in the first position, you

needn’t specify the order number in the ACQuire command.  The default is the first device in the

OLIST.  This worked well for two port network analyzers where the order for S11A,B,C classes were
setup for port 1 and the order for S22A,B,C was set up for port 2.  With the kit setup in the proper

order, you could eliminate the specification of the substandard number (SST<n>).

When performing 2 port calibrations on 4 Port Network Analyzers, the wizard applies S11A,B,C

standards to the lower numbered port, S22A,B,C standards to the higher numbered port.    Since the

two classes (S11A,B,C and S22A,B,C) are applied to multiple ports, the programmer must take into

account the ports being measured and take greater care when specifying the ACQuire command to

ensure that the correct device is being measured.

 

Port to class relationship
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Ports S11A Port S22A Port

1,2 1 2

1,3 1 3

1,4 1 4

2,3 2 3

2,4 2 4

3,4 3 4

 

The following example program shows one method of handling two port cals on a multiport network

analyzer.  The connectors at the measurement plane are assumed to be (1) male, (2) female, (3) male,

and (4) male.  In the example, three cals are performed:  1-2 (insertable male to female), 2-3 (insertable

female to male), and 3-4 (noninsertable using an characterized adapter).  

option explicit
public scpi
public pna
' assume a 4 port VNA with the following connectors:
' the standard measured on these ports will be the opposite gender
' PORT 1 = 3.5 male
' PORT 2 = 3.5 female
' PORT 3 = 3.5 male
' PORT 4 = 3.5 male
'To perform 2 port calibrations between 1-2, 2-3, and 3-4 you need to do the
following

call main

sub main
set pna = CreateObject("AgilentPnA835x.Application")
set scpi = pna.ScpiStringParser
pna.Preset
' select a kit to use for this demonstration
' kit #1 for the N5230A is the 85052B 3.5mm kit with sliding load
scpi.execute("SENS:CORR:COLL:CKIT:SELECT 1" )
PrintKitStandardInfo 1
PrintKitOlist 1

' --------------------------------------------
'    CALIBRATE PORTS 1 and 2, insertable cal
' --------------------------------------------
wscript.echo
wscript.echo "Calibrating ports 1 and 2"
scpi.execute("SYST:PRES;")
scpi.execute("calc:par:sel CH1_S11_1")
scpi.execute("SENS:CORR:TST:STATE 0")
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scpi.execute("SENS:CORR:COLL:METHod SPARSOLT")
scpi.execute("SENS:CORR:SFOR 1")
MeasureFemaleStandards 1
scpi.execute("SENS:CORR:SFOR 0")
MeasureMaleStandards 2
MeasureTransmissionStandards 1,2
scpi.execute("SENS:CORR:COLL:SAVE")

' --------------------------------------------
'    CALIBRATE PORTS 2 and 3, insertable cal
' --------------------------------------------
wscript.echo
wscript.echo "Calibrating ports 2 and 3"
scpi.execute("SYST:PRES;")
scpi.execute("calc:par:sel CH1_S11_1")
scpi.execute("calc:par:mod S23")
scpi.execute("SENS:CORR:TST:STATE 0")
scpi.execute("SENS:CORR:COLL:METHod SPARSOLT")
scpi.execute("SENS:CORR:SFOR 1")
MeasureMaleStandards 2
scpi.execute("SENS:CORR:SFOR 0")
MeasureFemaleStandards 3
MeasureTransmissionStandards 2,3
scpi.execute("SENS:CORR:COLL:SAVE")

' --------------------------------------------
'    CALIBRATE PORTS 3 and 4, non-insertable cal
' --------------------------------------------
wscript.echo
wscript.echo "Calibrating ports 3 and 4"
scpi.execute("SYST:PRES;")
scpi.execute("calc:par:sel CH1_S11_1")
scpi.execute("calc:par:mod S43")
scpi.execute("SENS:CORR:COLL:METHod SPARSOLT")
scpi.execute("SENS:CORR:SFOR 1")
MeasureFemaleStandards 3
scpi.execute("SENS:CORR:SFOR 0")
MeasureFemaleStandards 4
MeasureAdapter 3, 4
scpi.execute("SENS:CORR:COLL:SAVE")
end sub

sub MeasureMaleStandards ( portNumber )
dim portstr
portstr = formatnumber(portNumber,0)
Promptconnect1 1, 1, portNumber
scpi.execute("SENS:CORR:COLL:ACQ STAN1;*OPC?")

Promptconnect1 2, 1, portNumber
scpi.execute("SENS:CORR:COLL:ACQ STAN2;*OPC?")
Promptconnect1 3, 3, portNumber
scpi.execute("SENS:CORR:COLL:ACQ STAN3,SST3;*OPC?")
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end sub

sub MeasureFemaleStandards (portNumber)
dim portstr
portstr = formatnumber(portNumber,0)
Promptconnect1 1, 2, portNumber
scpi.execute("SENS:CORR:COLL:ACQ STAN1,SST2;*OPC?")
Promptconnect1 2, 2, portNumber
scpi.execute("SENS:CORR:COLL:ACQ STAN2,SST2;*OPC?")
Promptconnect1 3, 6, portNumber
scpi.execute("SENS:CORR:COLL:ACQ STAN3,SST6;*OPC?")
end sub

sub MeasureTransmissionStandards( port1, port2)
dim p1str
dim p2str
p1str = formatnumber( port1, 0)
p2str = formatnumber( port2, 0)

Promptconnect2 4, 1, port1, port2
scpi.execute("SENS:CORR:COLL:ACQ STAN4;*OPC?")
end sub

sub MeasureAdapter( port1, port2)
dim p1str
dim p2str
p1str = formatnumber( port1, 0)
p2str = formatnumber( port2, 0)

Promptconnect2 4, 2, port1, port2
scpi.execute("SENS:CORR:COLL:ACQ STAN4,SST2;*OPC?")
end sub

' return the nth item in the comma separated list
Function GetItemNumber( list, n)
dim strVector
strVector = split(list,",",-1,1)
GetItemNumber = strVector(n-1)
end function
' remove the trailing newline from str
function chop( str )
dim tmp
tmp = str
' remove the appended newline
dim pos
pos = InStrRev(tmp,vblf)
if (pos >0) then
tmp = mid(tmp,1,pos-1)
end if
chop = tmp
end function
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'return the label for the nth standard assigned to the class described by
class_index.
' if class_index = 1, class is S11A (STAN1)
' if class_index = 2, class is S11B (STAN2), etc
function GetStandardLabel( class_index, nth)
dim olist
dim stdnum
dim resp
olist = scpi.execute("SENS:CORR:COLL:CKIT:OLIST" + formatnumber(class_index,0)+"?")
stdnum = GetItemNumber( olist, nth)
scpi.execute("SENS:CORR:COLL:CKIT:STAN " + formatnumber(stdnum,0))
resp = scpi.execute("SENS:CORR:COLL:CKIT:STAN:LABel?")
GetStandardLabel = chop(resp)
end function

sub PromptConnect1( class_index, nth, port)
wscript.echo "CONNECT " + GetStandardLabel( class_index, nth) + " to port " +
formatnumber(port,0)
end sub

sub PromptConnect2( class_index, nth, port1, port2)
wscript.echo "CONNECT " + GetStandardLabel( class_index, nth) + " between ports " +
formatnumber(port1,0) + " and " + formatnumber(port2,0)
end sub

' Print the order of standards per class for this kit
sub PrintKitOlist( kit )
dim i
dim cmd
dim resp
wscript.echo
dim olistcmd
olistcmd = "SENS:CORR:COLL:CKIT:OLIST"
' list the sub standards for each of the following classes
' S11A, S11B, S11C, FWD TRANS, FWD ISOL, S22A, S22B, S22C, REV TRANS, REV ISOL
for i = 1 to  8     
cmd = olistcmd + formatNumber(i,0) + "?"
resp = scpi.execute(cmd)
wscript.echo cmd + "= " + chop(resp)
next
end sub

sub PrintKitStandardInfo( kit )
wscript.echo scpi.execute("SENS:CORR:COLL:CKIT:NAME?")
dim i
for i = 1 to 30
dim slabel
dim snum
snum = formatNumber(i,0)
scpi.execute("SENS:CORR:COLL:CKIT:STAN " + snum)
slabel=scpi.execute("SENS:CORR:COLL:CKIT:STAN:LABel?")
wscript.echo "Standard #"+snum+ " = " + chop(slabel)
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next
end sub

 

The output from this program is as follows:

Microsoft (R) Windows Script Host Version 5.6

Copyright (C) Microsoft Corporation 1996-2001. All rights reserved.

"85052B 3.5 mm with sliding load"

Standard #1 = "3.5 mm male short"

Standard #2 = "3.5 mm male open"

Standard #3 = "3.5 mm male broadband load"

Standard #4 = "Insertable thru standard"

Standard #5 = "3.5 mm male sliding load"

Standard #6 = "3.5 mm male lowband load"

Standard #7 = "3.5 mm female short"

Standard #8 = "female to female characterized  thru adapter"

Standard #9 = "0-2 Load"

Standard #10 = "Open"

Standard #11 = "Non-insertable thru"

Standard #12 = "3.5 mm female lowband load"

Standard #13 = "3.5 mm female sliding load"

Standard #14 = "3.5 mm female broadband load"

Standard #15 = "3.5 mm female open"

Standard #16 = "Open"

Standard #17 = "Open"

Standard #18 = "Open"
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Standard #19 = "Open"

Standard #20 = "Open"

Standard #21 = "Open"

Standard #22 = "Open"

Standard #23 = "Open"

Standard #24 = "Open"

Standard #25 = "Open"

Standard #26 = "Open"

Standard #27 = "Open"

Standard #28 = "Open"

Standard #29 = "Open"

Standard #30 = "Open"

SENS:CORR:COLL:CKIT:OLIST1?= +2,+15,+0,+0,+0,+0,+0

SENS:CORR:COLL:CKIT:OLIST2?= +1,+7,+0,+0,+0,+0,+0

SENS:CORR:COLL:CKIT:OLIST3?= +6,+5,+3,+12,+13,+14,+0

SENS:CORR:COLL:CKIT:OLIST4?= +4,+8,+0,+0,+0,+0,+0

SENS:CORR:COLL:CKIT:OLIST5?= +2,+15,+0,+0,+0,+0,+0

SENS:CORR:COLL:CKIT:OLIST6?= +1,+7,+0,+0,+0,+0,+0

SENS:CORR:COLL:CKIT:OLIST7?= +6,+5,+3,+12,+13,+14,+0

SENS:CORR:COLL:CKIT:OLIST8?= +4,+8,+0,+0,+0,+0,+0

Calibrating ports 1 and 2

CONNECT "3.5 mm female open" to port 1

CONNECT "3.5 mm female short" to port 1

CONNECT "3.5 mm female broadband load" to port 1

CONNECT "3.5 mm male open" to port 2
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CONNECT "3.5 mm male short" to port 2

CONNECT "3.5 mm male broadband load" to port 2

CONNECT "Insertable thru standard" between ports 1 and 2

Calibrating ports 2 and 3

CONNECT "3.5 mm male open" to port 2

CONNECT "3.5 mm male short" to port 2

CONNECT "3.5 mm male broadband load" to port 2

CONNECT "3.5 mm female open" to port 3

CONNECT "3.5 mm female short" to port 3

CONNECT "3.5 mm female broadband load" to port 3

CONNECT "Insertable thru standard" between ports 2 and 3

Calibrating ports 3 and 4

CONNECT "3.5 mm female open" to port 3

CONNECT "3.5 mm female short" to port 3

CONNECT "3.5 mm female broadband load" to port 3

CONNECT "3.5 mm female open" to port 4

CONNECT "3.5 mm female short" to port 4

CONNECT "3.5 mm female broadband load" to port 4

CONNECT "female to female characterized  thru adapter" between ports 3 and 4
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Perform a Guided 1-Port Cal using SCPI

This example performs simultaneous measurement of multiple cal standards and channels, then feeds

all data to SCPI commands to compute and activate 1-port calibrations for the channels.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file, such as Notepad, and save it on the VNA hard drive as *.vbs.

Learn how to setup and run the macro.

See Guided Cal SCPI commands

See Other SCPI Example Programs

Dim app

Dim scpi

' Create / Get the PNA application.

Set app = CreateObject("AgilentPNA835x.Application")

' Get the ScpiStringParser COM object

Set scpi = app.ScpiStringParser

' Ensure data format is ASCII for this example

scpi.Parse "form:data asc,0"

Dim response

' Begging with a FPRESET to start out with no measurements

response = scpi.Parse("syst:fpreset;*opc?")

' For both channels of this example, creating an S11 measurement and an "a1,1"
measurement

scpi.Parse "calc1:par:ext 'CH1_S11_1','S11'"

scpi.Parse "calc1:par:ext 'CH1_a1_1','a1_1'"

scpi.Parse "calc2:par:ext 'CH2_S11_1','S11'"

scpi.Parse "calc2:par:ext 'CH2_a1_1','a1_1'"
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' Feeding all four of the newly created measurements to traces in Window 1

scpi.Parse "disp:wind1:stat on"

scpi.Parse "disp:wind1:trac1:feed 'CH1_S11_1'"

scpi.Parse "disp:wind1:trac2:feed 'CH1_a1_1'"

scpi.Parse "disp:wind1:trac3:feed 'CH2_S11_1'"

scpi.Parse "disp:wind1:trac4:feed 'CH2_a1_1'"

' Setting up for 1-port cal acquisitions on both channels 1 and 2,

' using APC 3.5 female DUT connector and 85033D/E cal kit for this example.

scpi.Parse "sens1:corr:coll:guid:conn:port1 'APC 3.5 female'"

scpi.Parse "sens2:corr:coll:guid:conn:port1 'APC 3.5 female'"

scpi.Parse "sens1:corr:coll:guid:ckit:port1 '85033D/E'"

scpi.Parse "sens2:corr:coll:guid:ckit:port1 '85033D/E'"

scpi.Parse "sens1:corr:coll:guid:init"

scpi.Parse "sens2:corr:coll:guid:init"

' This commented-out command shows how you can query for a given connection step
of a cal,

' which measurement parameters the calibration needs to measure for that step of
the cal.

' But for this example we know for each step the 1-port cals want to measure S11
and

' "a1,1" a.k.a "a1_1".

'response = scpi.Execute("sens:corr:coll:guid:data:cat? STAN1")

'MsgBox response

' Set up for channel coupling and measurement parameter coupling

scpi.Parse "syst:chan:coup:stat on"

scpi.Parse "syst:chan:coup:par on"

' Prompt for the standards to be connected, trigger all the channel-coupled
measurements,

' and feed the measured data into the cal connection steps.

MsgBox "Connect all the Opens"
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MeasureStandards 1

MsgBox "Connect all the Shorts"

MeasureStandards 2

MsgBox "Connect all the Loads"

MeasureStandards 3

' Conclude and activate the calibrations for both channels

response = scpi.Parse("sens1:corr:coll:guid:save;*opc?")

response = scpi.Parse("sens2:corr:coll:guid:save;*opc?")

' Finished!

MsgBox "Done"

'Subroutine that acquires the measurements and feeds the data into the cal steps

Sub MeasureStandards(stepNum)

    response = scpi.Parse("sens1:swe:mode sing;*opc?")

    response = scpi.Parse("calc1:par:mnum:sel 1;*opc?")

    response = scpi.Parse("calc1:data? rdata")

    scpi.Parse "sens1:corr:coll:guid:data STAN" & CStr(stepNum) & ",'S11',0," &
response

    response = scpi.Parse("calc1:par:mnum:sel 2;*opc?")

    response = scpi.Parse("calc1:data? rdata")

    scpi.Parse "sens1:corr:coll:guid:data STAN" & CStr(stepNum) & ",'a1_1',0," &
response

    response = scpi.Parse("calc2:par:mnum:sel 3;*opc?")

    response = scpi.Parse("calc2:data? rdata")

    scpi.Parse "sens2:corr:coll:guid:data STAN" & CStr(stepNum) & ",'S11',0," &
response

    response = scpi.Parse("calc2:par:mnum:sel 4;*opc?")

    response = scpi.Parse("calc2:data? rdata")

    scpi.Parse "sens2:corr:coll:guid:data STAN" & CStr(stepNum) & ",'a1_1',0," &
response

End Sub
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Perform a Guided 1-Port Cal on Port 2

This VBScript program does the following:

Clear measurements from the VNA1.

Create a new S22 measurement2.

Set an instrument state3.

Select the connector types4.

Select a cal kit5.

Initiate a Guided calibration6.

Display a prompt to connect each standard7.

Save the calibration to a newly created cal set8.

Note: This example illustrates an important step when calibrating a reflection measurement in the

reverse direction. You MUST create a reverse (S22) measurement and have it be the active (selected)

measurement on the channel that is being calibrated. This is not necessary for any calibrating any other

measurement parameter.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as Guided.vbs. Learn how to
setup and run the macro.

Dim App
Set App = CreateObject("AgilentPNA835x.Application")
App.Preset

Dim step
Dim Parser
Dim prompt
Dim txtDat
Dim Chan

Rem Clear old measurements
App.Reset

Rem Create a new Measurement
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Set Parser = App.SCPIStringParser
Parser.Parse "DISPlay:WINDow1:STATE ON"
Parser.Parse "CALCulate:PARameter:DEFine:EXT 'MyMeas',S22"
Parser.Parse "DISPlay:WINDow1:TRACe1:FEED 'MyMeas'"

Rem Initialize state
Set Chan = App.ActiveChannel
Chan.StartFrequency = 200e6
Chan.StopFrequency = 1.5e9
Chan.IFBandwidth = 1000
step = 3

Rem Begin a guided calibration
Parser.Parse "SENS:CORR:COLL:GUID:CONN:PORT1 'Not used'"
Parser.Parse "SENS:CORR:COLL:GUID:CONN:PORT2 'Type N (50) male'"
Parser.Parse "SENS:CORR:COLL:GUID:CKIT:PORT1 ''"
Parser.Parse "SENS:CORR:COLL:GUID:CKIT:PORT2 '85054D'"
Parser.Parse "SENS:CORR:COLL:GUID:INIT"

Rem Query the number of steps
txtDat = Parser.Parse("SENS:CORR:COLL:GUID:STEP?")

Rem Display the number of steps
MsgBox("Number of steps is " + txtDat)

Rem Set the loop counter limit
step = txtDat

Rem  Measure the standards
For i = 1 To step
If i= 1 Then
prompt = Parser.Parse("sens:corr:coll:guid:desc? 1")
MsgBox(prompt)
Parser.Parse ("sens:corr:coll:guid:acq STAN1")
ElseIf i = 2 then
prompt = Parser.Parse("sens:corr:coll:guid:desc? 2")
MsgBox(prompt)
Parser.Parse ("sens:corr:coll:guid:acq STAN2")
ElseIf i = 3 then
prompt = Parser.Parse("sens:corr:coll:guid:desc? 3")
MsgBox(prompt)
Parser.Parse ("sens:corr:coll:guid:acq STAN3")
End If
Next

Rem All standards have been measured.  Save the result
Parser.Parse "SENS:CORR:COLL:GUID:SAVE"
MsgBox("The calibration has been completed")
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Perform a Guided Calibration using SCPI

This VBScript program performs a Guided Calibration using ECal or Mechanical standards. This

example includes optional ECal orientation features.

This example has been updated to include:

Guided Power Cal (Oct 8, 2010)

The setting of Unknown Thru or Adapter Removal adapter delay. (March 2006).

The activation of a channel to be calibrated. (Aug. 2006).

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as Guided.vbs. Learn how to
setup and run the macro.

' Performing a Guided 2-port cal (Ports 1 and 2)

TwoPortGuidedCal

Sub TwoPortGuidedCal

Dim app

Dim scpi

Dim connList

Dim selectedConn1, selectedConn2

Dim kitList

Dim selectedKit

Dim message

' Create / Get the VNA application.

Set app = CreateObject("AgilentPNA835x.Application")

Set scpi = app.ScpiStringParser

 

'The following demonstrates that the Active Channel is cal'd
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'Preset the VNA

scpi.Execute "SYST:UPR"

'Create a new measurement on Chan 2

'Now there are two windows, channels and measurements

'This becomes the Active Measurement

scpi.Execute ("DISPlay:WINDow2:STATE ON")

'Define a measurement name, parameter

scpi.Execute ("CALCulate2:PARameter:DEFine:EXT 'MyMeas',S21")

'"FEED" the measurement

scpi.Execute ("DISPlay:WINDow2:TRACe1:FEED 'MyMeas'")

'This is the Active Measurement

'Activate the 'Preset' measurement to cal chan 1

scpi.Execute ("CALC1:PAR:SEL 'CH1_S11_1'")

' Query the list of connectors that the VNA system recognizes

connList = scpi.Execute("sens:corr:coll:guid:conn:cat?")

' Format the list with linefeed characters in place of the commas

connList = FormatList(connList)

message = "Enter your DUT connector for Port 1.  Choose from this list:"

message = message & Chr(10) & Chr(10) & connList

' Select the connector for Port 1

selectedConn1 = InputBox(message)

If selectedConn1 = "" Then Exit Sub

scpi.Execute "sens:corr:coll:guid:conn:port1 '" & selectedConn1 & "'"

message = "Enter your DUT connector for Port 2.  Again, choose from this list:"

message = message & Chr(10) & Chr(10) & connList

' Select the connector for Port 2

selectedConn2 = InputBox(message)

If selectedConn2 = "" Then Exit Sub

1723



scpi.Execute "sens:corr:coll:guid:conn:port2 '" & selectedConn2 & "'"

' Note: If your VNA has more than 2 ports, then uncomment

' one or both of these next two lines.

'scpi.Execute "sens:corr:coll:guid:conn:port3 ""Not used"" "

'scpi.Execute "sens:corr:coll:guid:conn:port4 ""Not used"" "

 

' This next block of commented code demonstrates how to specify an adapter

' and it's electrical delay, in situations where you are performing an

' Unknown Thru or Adapter Removal calibration.  In most situations, the

' VNA is able to correctly determine an adapter's electrical length

' at the end of the calibration.  However, there are scenarios where

' the VNA cannot correctly calculate the length -- such as when the channel

' has a relatively small number of measurement points (for example, 201 or less)

' and the adapter is significantly long (for example, a cable that is several
feet).

' In these cases, the ADAP commands (below) enable you to explicitly specify

' the adapter you are using.

' Send these commands prior to the "sens:corr:coll:guid:init" command.

' Create adapter and return the adapter number

'adapterNum = scpi.Execute("sens:corr:coll:guid:adap:cre? '" & selectedConn1 &
"','"& selectedConn2 & "'")

' The adapterNum string contains a '+' character.  

' Here we convert to integer to remove that.

'adapterNum = CStr( CInt(adapterNum) )

' Specify that this adapter has 10 nanoseconds electrical delay (coaxial).

'scpi.Execute "sens:corr:coll:guid:adap" & adapterNum & ":del 10E-9"

' Text description of adapter

'scpi.Execute "sens:corr:coll:guid:adap" & adapterNum & ":desc 'My adapter'"
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' Select to use this adapter specifically between ports 1 and 2

'scpi.Execute "sens:corr:coll:guid:adap" & adapterNum & ":path 1,2"

' End of adapter block

 

' Query the list of acceptable cal kits and

' ECal module characterizations for Port 1.

kitList = scpi.Execute("sens:corr:coll:guid:ckit:cat? '" & selectedConn1 & "'")

' Format the list with linefeed

' characters in place of the commas

kitList = FormatList(kitList)

message = "Enter your cal kit or ECal module characterization for Port 1.  "

message = message & "Choose from this list:"

message = message & Chr(10) & Chr(10) & kitList

' Select the Cal Kit or ECal module

' characterization to use for Port 1.

selectedKit = InputBox(message)

If selectedKit = "" Then Exit Sub

scpi.Execute "sens:corr:coll:guid:ckit:port1 '" & selectedKit & "'"

' Query the list of acceptable cal kits

' and ECal module characterizations for Port 2.

kitList = scpi.Execute("sens:corr:coll:guid:ckit:cat? '" & selectedConn2 & "'")

' Format the list with linefeed characters in place of the commas

kitList = FormatList(kitList)

message = "Enter your cal kit or ECal module characterization for Port 2.  "

message = message & "Choose from this list:"

message = message & Chr(10) & Chr(10) & kitList

' Select the Cal Kit or ECal module

' characterization to use for Port 2.
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selectedKit = InputBox(message)

If selectedKit = "" Then Exit Sub

scpi.Execute "sens:corr:coll:guid:ckit:port2 '" & selectedKit & "'"

' This determines whether the cal will be a "Guided Power Cal"

' or just a traditional S-parameter cal.

message = "On which port number shall power be measured?  "

message = message & "For a traditional guided cal without power cal, enter 0"

Dim powerPort

powerPort = CInt( InputBox(message) )

If powerPort > 0 Then

scpi.Execute("sens:corr:coll:guid:psen" & CStr(powerPort) & ":stat on")

Dim retVal

retVal = MsgBox("Is the power sensor's connector type or gender different from
the DUT connector for that port?", vbYesNo)

If retVal = vbYes Then

message = "Enter your power sensor's connector.  Choose from this list:"

message = message & Chr(10) & Chr(10) & connList

' Select the sensor's connector.

selectedConn1 = InputBox(message)

If selectedConn1 = "" Then Exit Sub

scpi.Execute "sens:corr:coll:guid:psen" & CStr(powerPort) & ":conn '" &
selectedConn1 & "'"

' Query the list of acceptable cal kits and ECal module characterizations

' that are applicable for the sensor's connector.

kitList = scpi.Execute("sens:corr:coll:guid:ckit:cat? '" & selectedConn1 & "'")

' Format the list with linefeed

' characters in place of the commas

kitList = FormatList(kitList)

message = "Enter your cal kit or ECal module characterization to use for de-embed
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of the sensor's connector.  "

message = message & "Choose from this list:"

message = message & Chr(10) & Chr(10) & kitList

' Select the Cal Kit or ECal module characterization to use for de-embed of the
sensor's connector.

selectedKit = InputBox(message)

If selectedKit = "" Then Exit Sub

scpi.Execute "sens:corr:coll:guid:psen" & CStr(powerPort) & ":ckit '" &
selectedKit & "'"

Else

scpi.Execute("sens:corr:coll:guid:psen" & CStr(powerPort) & ":conn 'Ignored'")

End If ' End of block that considers the sensor's connector

' Ask for the power level to perform the power cal at

' (if this command is omitted, the default is 0 dBm).

Dim powerLevel

powerLevel = InputBox("Enter the power level for the power cal to be performed
at")

If powerLevel = "" Then Exit Sub

scpi.Execute "sens:corr:coll:guid:psen" & CStr(powerPort) & ":pow:lev " &
powerLevel

Else

scpi.Execute("sens:corr:coll:guid:psen1:stat off")

End If ' End of block that considers if the cal will include power calibration

 

' This next block of commented code

' shows optional functions when using ECal.

' Send these "sens:corr:pref" commands prior to the

' "sens:corr:coll:guid:init" command.

' Read ECAL information from ECal module #1 on the USB bus

' about the Keysight factory characterization data
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'module1Info = scpi.Execute("sens:corr:coll:ckit:inf? ECAL1,CHAR0")

'MsgBox "Description of ECal Module #1:" & Chr(10) & Chr(10) & module1Info

 

' The following command enables auto orientation of

' the ECal module (The VNA senses which port of the

' module is connected to which port of the VNA).

'scpi.Execute "sens:corr:pref:ecal:ori ON"

' However, if you are measuring at very low power levels where

' the VNA may fail to sense the module's orientation, then turn auto

' orientation OFF and specify how the module is connected.

' "A1,B2" indicates Port A of the module is connected

' to VNA Port 1 and Port B is connected to VNA Port 2).

'scpi.Execute "sens:corr:pref:ecal:ori OFF"

'scpi.Execute "sens:corr:pref:ecal:pmap ECAL1,'A1,B2'"

' End of optional ECal setup

 

' Select the thru method of "Default".  This instructs the VNA to

' determine which thru standard measurement technique to use

' based upon the selected connectors and

' calibration kit(s) and the VNA model number.

' with new CMET and TMET 'default' is set by not sending the commands

'

' Initiate the calibration and query the number of steps

scpi.Execute "sens:corr:coll:guid:init"

numSteps = scpi.Execute("sens:corr:coll:guid:steps?")

MsgBox "Number of steps is " + CStr(numSteps)

' Measure the standards

For i = 1 To numSteps
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step = "Step " + CStr(i) + " of " + CStr(numSteps)

strPrompt = scpi.Execute("sens:corr:coll:guid:desc? " + CStr(i))

MsgBox strPrompt, vbOKOnly, step

scpi.Execute "sens:corr:coll:guid:acq STAN" + CStr(i)

Next

' Conclude the calibration

scpi.Execute "sens:corr:coll:guid:save"

MsgBox "Cal is done!"

End Sub

Function FormatList(list)

Dim tokens

' Strip the leading and trailing quotation

' marks from the list string

list = Mid(list, 2, Len(list) - 3)

' Tokenize the comma-delimited list string

' into an array of the individual substrings

tokens = Split(list, ",")

' Rebuild the list string, placing linefeed

' characters where the commas were,

' using Trim to remove leading and trailing spaces.

list = ""

For i = 0 To UBound(tokens)

tokens(i) = Trim(tokens(i))

list = list & tokens(i) & Chr(9)

If i < UBound(tokens) Then

 i = i + 1

 tokens(i) = Trim(tokens(i))

 list = list & tokens(i) & Chr(10)
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End If

Next

FormatList = list

End Function
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Perform Guided ECal using SCPI

This VBScript program performs a Guided ECal Calibration. While this example is good to use as a

starting point for Guided ECal, the Guided comprehensive cal example has some advanced features that

are not in this program.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as Guided.vbs. Learn how to
setup and run the macro.

' Performing a 2-port cal (Ports 1 and 2)
Dim app
Dim scpi

' Create / Get the VNA application.
Set app = CreateObject("AgilentPNA835x.Application")
Set scpi = app.ScpiStringParser

' Specify the DUT connectors
' (for each connector of your DUT, one of the ECal module's ports must have
'  that same connector, or else you cannot achieve the cal using that module).
scpi.Execute "sens:corr:coll:guid:conn:port1 ""APC 3.5 female"" "
scpi.Execute "sens:corr:coll:guid:conn:port2 ""APC 3.5 male"" "

' Note: If your VNA has more than 2 ports, you would need to uncomment
' one or both of these next two lines, to explicitly specify this is
' just a 2-port cal.
'scpi.Execute "sens:corr:coll:guid:conn:port3 ""Not used"" "
'scpi.Execute "sens:corr:coll:guid:conn:port4 ""Not used"" "
MsgBox "Connectors defined for Ports 1 and 2"

' Specify ECal modules

scpi.Parse "sens:corr:coll:guid:ckit:port1 'N4691-60004 ECal'"

scpi.Parse "sens:corr:coll:guid:ckit:port2 'N4691-60004 ECal'"

' Non-factory characterizations are specified as follows:

'scpi.Parse "sens:corr:coll:guid:ckit:port2 'N4691-60004 User 1 ECal'"

' When two or more ECal modules with the same model number are connected

' also specify the serial number as follows:

'scpi.Parse "sens:corr:coll:guid:ckit:port2 'N4691-60004 ECal 01234'"
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' When Disk Memory ECal user characterizations are used,

' specify both the User char and the serial number as follows:

'scpi.Parse "sens:corr:coll:guid:ckit:port2 'N4691-60004 MyDskChar ECal 01234'"

'
MsgBox "Cal kits defined for Ports 1 and 2"

' Initiate the calibration and query the number of steps
scpi.Execute "sens:corr:coll:guid:init"
numSteps = scpi.Execute("sens:corr:coll:guid:steps?")
MsgBox "Number of steps is " + CStr(numSteps)

' Measure the standards
For i = 1 To numSteps
step = "Step " + CStr(i) + " of " + CStr(numSteps)
strPrompt = scpi.Execute("sens:corr:coll:guid:desc? " + CStr(i))
MsgBox strPrompt, vbOKOnly, step
scpi.Execute "sens:corr:coll:guid:acq STAN" + CStr(i)
Next

' Conclude the calibration
scpi.Execute "sens:corr:coll:guid:save"
MsgBox "Cal is done!"
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Perform Guided Mechanical Cal using SCPI

This VBScript program performs a Guided Calibration using Mechanical standards. While this

example is good to use as a starting point for guided mechanical cal, the Guided comprehensive cal
example has some advanced features that are not in this program.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as Guided.vbs. Learn how to
setup and run the macro.

' Performing a 2-port cal (Ports 1 and 2)

Dim app
Dim scpi

' Create / Get the VNA application.
Set app = CreateObject("AgilentPNA835x.Application")
Set scpi = app.ScpiStringParser

' Specify the DUT connectors
scpi.Execute "sens:corr:coll:guid:conn:port1 ""APC 3.5 female"" "
scpi.Execute "sens:corr:coll:guid:conn:port2 ""APC 3.5 male"" "

' Note: If your VNA has more than 2 ports, you would need to uncomment
' one or both of these next two lines, to explicitly specify this is
' just a 2-port cal.
'scpi.Execute "sens:corr:coll:guid:conn:port3 ""Not used"" "
'scpi.Execute "sens:corr:coll:guid:conn:port4 ""Not used"" "
MsgBox "Connectors defined for Ports 1 and 2"

' Select the Cal Kit for each port being calibrated.
scpi.Execute "sens:corr:coll:guid:ckit:port1 ""85052D"" "
scpi.Execute "sens:corr:coll:guid:ckit:port2 ""85052D"" "
MsgBox "Cal kits defined for Ports 1 and 2"

' Initiate the calibration and query the number of steps
scpi.Execute "sens:corr:coll:guid:init"
numSteps = scpi.Execute("sens:corr:coll:guid:steps?")
MsgBox "Number of steps is " + CStr(numSteps)

' Measure the standards
'The following series of commands shows that standards
'can be measured in any order. These steps acquire
'measurement of standards in reverse order.
'It is easiest to iterate through standards using
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'a For-Next Loop.
For i = numSteps To 1
step = "Step " + CStr(i) + " of " + CStr(numSteps)
strPrompt = scpi.Execute("sens:corr:coll:guid:desc? " + CStr(i))
MsgBox strPrompt, vbOKOnly, step
scpi.Execute "sens:corr:coll:guid:acq STAN" + CStr(i)
Next

' Conclude the calibration
scpi.Execute "sens:corr:coll:guid:save"
MsgBox "Cal is done!"
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Perform Guided TRL Calibration

This VBScript file performs a 2-Port Guided TRL calibration on 2-port VNA analyzers. (See an
example of TRL cal on a 4-port VNA.) This program does the following:

Clear old measurements from the VNA

Create a new S22 measurement

Set an instrument state

Select the connectors and cal kit

Initiate a Guided calibration

Display a prompt as each new standard must be connected

Save the calibration to a newly created cal set.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as TRL.vbs. Learn how to setup
and run the macro.

Dim App

Dim Parser

Dim Chan

Dim txtDat

Dim step

Dim parserTxt

Dim prompt

Set App = CreateObject("AgilentPNA835x.Application")

' Clear old measurements

App.Reset

' Create a new Measurement
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Set Parser = App.SCPIStringParser

Parser.Parse "DISPlay:WINDow1:STATE ON"

Parser.Parse "CALCulate:PARameter:DEFine:EXT 'MyMeas',S12"

Parser.Parse "DISPlay:WINDow1:TRACe1:FEED 'MyMeas'"

' Initialize state

Set Chan = App.ActiveChannel

Chan.StartFrequency = 18.0e9

Chan.StopFrequency = 20.0e9

Chan.IFBandwidth = 1000

' Begin a guided calibrations

Parser.Parse "SENS:CORR:COLL:GUID:CONN:PORT1 'APC 3.5 male'"

Parser.Parse "SENS:CORR:COLL:GUID:CONN:PORT2 'APC 3.5 female'"

Parser.Parse "SENS:CORR:COLL:GUID:CKIT:PORT1 '85052C'"

Parser.Parse "SENS:CORR:COLL:GUID:CKIT:PORT2 '85052C'"

' Select TRL cal method.

Parser.Parse "SENS:CORR:COLL:GUID:PATH:CMET 1,2,'TRL'"

txtDat = Parser.Parse("SENS:CORR:COLL:GUID:PATH:CMET? 1,2")

MsgBox("Method " + txtDat)

Parser.Parse "SENS:CORR:COLL:GUID:INIT"

' Query the number of steps

txtDat = Parser.Parse("SENS:CORR:COLL:GUID:STEP?")

' Display the number of steps

MsgBox("Number of steps is " + txtDat)

' Set the loop counter limit

step = CInt(txtDat)

' Measure the standards
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For i = 1 To step

parserTxt = "sens:corr:coll:guid:desc? " + CStr(i)

prompt = Parser.Parse(parserTxt)

MsgBox(prompt)

parserTxt = "sens:corr:coll:guid:acq STAN" + CStr(i)

Parser.Parse (parserTxt)

Next

' All standards have been measured.  Save the result

Parser.Parse "SENS:CORR:COLL:GUID:SAVE"

MsgBox("The TRL calibration has been completed")
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Perform an Unguided 1-Port Cal on Port 2

This VBScript program does the following:

Clear measurements from the VNA1.

Create a new S22 measurement2.

Set an instrument state3.

Select a cal kit4.

Initiate an Unguided calibration5.

Display a prompt to connect each standard6.

Save the calibration to a newly created cal set7.

Note: This example illustrates an important step when calibrating a reflection measurement in the

reverse direction. You MUST create a reverse (S22) measurement and have it be the active (selected)

measurement on the channel that is being calibrated. This is not necessary for any calibrating any other

measurement parameter.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as Unguided.vbs. Learn how to
setup and run the macro.

Dim App
Set App = CreateObject("AgilentPNA835x.Application")
App.Preset

Dim Parser
Dim Chan

Rem Clear old measurements
App.Reset

Rem Create a new Measurement
Set Parser = App.SCPIStringParser
Parser.Parse "DISPlay:WINDow1:STATE ON"
Parser.Parse "CALCulate:PARameter:DEFine:EXT 'MyMeas',S22"
Parser.Parse "DISPlay:WINDow1:TRACe1:FEED 'MyMeas'"
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Rem Initialize state
Set Chan = App.ActiveChannel
Chan.StartFrequency = 200e6
Chan.StopFrequency = 1.5e9
Chan.IFBandwidth = 1000

Rem Begin an unguided calibration
Rem Set the calibration method
Parser.Parse "SENSe:CORRection:COLLect:METHod REFL3"

Rem Turn off continuous sweep
Parser.Parse "INITiate:CONTinuous OFF"

Rem Select a cal kit
Parser.Parse "SENSe:CORRection:COLLect:CKIT:SELect 1"

Rem  Measure the standards
MsgBox("Connect OPEN to port 2.  Then press OK")
Parser.Parse ("sens:corr:coll:acq STAN1")

MsgBox("Connect SHORT to port 2.  Then press OK")
Parser.Parse ("sens:corr:coll:acq STAN2")

MsgBox("Connect LOAD to port 2.  Then press OK")
Parser.Parse ("sens:corr:coll:acq STAN3")

Rem All standards have been measured.  Save the result
Parser.Parse "SENS:CORR:COLL:SAVE"

Rem Turn ON continuous sweep
Parser.Parse "INITiate:CONTinuous ON"
MsgBox("The calibration has been completed")
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Perform an Unguided 2-Port Mechanical Cal

This VBScript program performs an Unguided, Full 2-Port, calibration using ONE set of mechanical

calibration standards.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as Unguided.vbs. Learn how to
setup and run the macro.

Set App = CreateObject("AgilentPNA835x.Application")
Set Scpi = App.SCPIStringParser

'Initialize state
Scpi.Execute ("SYSTem:PRESet")

'Select the Preset measurement
Scpi.Execute ("CALCulate:PARameter:SELect 'CH1_S11_1'")

'Set the calibration method
Scpi.Execute ("SENSe:CORRection:COLLect:METHod SPARSOLT")

'Select a cal kit
Scpi.Execute ("SENSe:CORRection:COLLect:CKIT:SELect 1")

'Set one set of standards
Scpi.Execute ("SENSe:CORRection:TSTandards OFF")

'Set acquisition to FORWARD
Scpi.Execute ("SENSe:CORRection:SFORward ON")

'Measure the standards in forward direction
MsgBox "Connect OPEN to Port 1; then press OK"
Scpi.Execute ("SENSe:CORRection:COLLect:ACQuire stan1")

MsgBox "Connect SHORT to Port 1; then press OK"
Scpi.Execute ("SENSe:CORRection:COLLect:ACQuire stan2")

MsgBox "Connect LOAD to Port 1; then press OK"
Scpi.Execute ("SENSe:CORRection:COLLect:ACQuire stan3")

'Set acquisition to REVERSE
Scpi.Execute ("SENSe:CORRection:SFORward OFF")

'Measure the standards in reverse direction
MsgBox "Connect OPEN to Port 2; then press OK"
Scpi.Execute ("SENSe:CORRection:COLLect:ACQuire stan1")
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MsgBox "Connect SHORT to Port 2; then press OK"
Scpi.Execute ("SENSe:CORRection:COLLect:ACQuire stan2")

MsgBox "Connect LOAD to Port 2; then press OK"
Scpi.Execute ("SENSe:CORRection:COLLect:ACQuire stan3")

'Measure the thru standard
MsgBox "Connect THRU between Ports 1 and 2; then press OK"
Scpi.Execute ("SENSe:CORRection:COLLect:ACQuire stan4")

'OPTIONAL Measure Isolation
MsgBox "Connect LOADS to Port 1 AND Port 2; then press OK"
Scpi.Execute ("SENSe:CORRection:COLLect:ACQuire stan5")

'All standards have been measured.  Save the result
Scpi.Execute ("SENS:CORR:COLL:SAVE")
MsgBox "The calibration has been completed"
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Perform an Unguided ECal

This VBScript program performs an Unguided Full 2-Port ECal.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as Unguided.vbs.  Learn how to
setup and run the macro.

See Sense:Correction commands.

See other SCPI Examples

Set pna = CreateObject("AgilentPNA835x.Application")
Set scpi = pna.ScpiStringParser
' Preset the analyzer
scpi.Execute "SYSTem:PRESet"

' Start frequency of 10 MHz
scpi.Execute "SENSe:FREQuency:STARt 10E6"

' Stop frequency of 9 GHz
scpi.Execute "SENSe:FREQuency:STOP 9E9"

' Select the preset S11 measurement
scpi.Execute "CALCulate:PARameter:SELect 'CH1_S11_1'"
' Read the information about the Keysight factory
' characterization data of ECal module #1 on the USB bus
module1Info = scpi.Execute("SENSe:CORRection:COLLect:CKIT:INFormation? ECAL1,CHAR0")

' Prompt for the ECal module
MsgBox "Description of ECal Module #1:" & Chr(10) & Chr(10) & module1Info & _Chr(10)
& Chr(10) & "Make port connections to the ECal module, then press enter"
' ECal full 1 port and 2 port
' Choose a Calibration Type (comment out one of these)
scpi.Execute "SENSe:CORRection:COLLect:METHod refl3"
scpi.Execute "SENSe:CORRection:COLLect:METHod SPARSOLT"
' Specify to have the VNA automatically determine which port of the
' ECal module is connected to which port of the VNA.
scpi.Execute "SENSe:CORRection:PREFerence:ECAL:ORIentation ON"
' Alternatively, if you are measuring at very low power levels where
' the VNA fails to sense the module's orientation, you may need to turn
' off the auto orientation and specify how the module is connected (as in
' these next two commented lines of code -- "A1,B2" would indicate Port A
' of the module is connected to Port 1 and Port B is connected to Port 2).
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'scpi.Execute "SENSe:CORRection:PREFerence:ECAL:ORIentation OFF"
'scpi.Execute "SENSe:CORRection:PREFerence:ECAL:PMAP ECAL1,'A1,B2'"
' Acquire and store the calibration terms.  *OPC? causes a "+1" to be
' returned when finished.  CHAR0 indicates to use the Keysight factory
' characterized data within the ECal module (as opposed to a user characterization).
x = scpi.Execute("SENSe:CORRection:COLLect:ACQuire ECAL1,CHAR0;*OPC?")
' Note: if you have set up a slow sweep speed (for example, if
' you’re using a narrow IF bandwidth), and while this calibration is
' being acquired you wish to have your program perform other operations
' (like checking for the click event of a Cancel button) and you’re
' NOT using the COM ScpiStringParser, you can use the optional
' ASYNchronous argument with the ACQuire command as shown here below
' instead of sending that command in the way shown above. The SCPI
' parser then will return immediately while the cal acquisition
' proceeds (i.e., the parser will NOT block-and-wait for the
' cal to finish, so you can send additional commands in the meantime).
' So you can do “*ESR?” or “*STB?” queries to monitor the status register
' bytes to see when the OPC bit gets set, which indicates the cal has
' finished.  That type of OPC detection works for all of the VNA’s SCPI
' parsers except the COM ScpiStringParser.
' An alternative to querying the status register, is to setup an SRQ handler
' if your IO Libraries supports that.
' When an SRQ event occurs, a call back will automatically
'  “SENSe:CORRection:COLLect:ACQuire ECAL1,CHAR0,ASYNchronous;*OPC”
MsgBox "Done with calibration."
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Perform Unknown Thru or TRL Cal

The following program performs either a 2-port SOLT Unknown Thru Cal or a 2-port TRL Cal. The

85052C Cal Kit used in this program contains both types of standards. This program can be run on 2-

port or 4-port VNAs. When run on select VNA-L models, a Delta Match Cal is required.

See Delta Match Cal example program

See the Guided Cal commands

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as Unknown.vbs. Learn how to
setup and run the macro.

Sub PerformUnknownThruOrTRLCal()

Set pna = CreateObject("AgilentPNA835x.Application")

Set scpi = pna.ScpiStringParser

' Specify connectors for Ports 1 and 2

scpi.Parse "SENS:CORR:COLL:GUID:CONN:PORT1 'APC 3.5 female'"

scpi.Parse "SENS:CORR:COLL:GUID:CONN:PORT2 'APC 3.5 male'"

'If your VNA has 3 or 4 ports, uncomment one or both of

'these next two lines, to explicitly specify this is a 2-port cal.

'scpi.Parse "SENS:CORR:COLL:GUID:CONN:PORT3 'Not used'"

'scpi.Parse "SENS:CORR:COLL:GUID:CONN:PORT4 'Not used'"

' Specify cal kit for Ports 1 and 2

scpi.Parse "SENS:CORR:COLL:GUID:CKIT:PORT1 '85052C'"

scpi.Parse "SENS:CORR:COLL:GUID:CKIT:PORT2 '85052C'"

' Since the 85052C cal kit contains SOLT standards and also TRL

' standards, these next two lines set cal and thru method.

' Always send the init command before and after these two commands

scpi.Parse "SENS:CORR:COLL:GUID:INIT"

scpi.Parse "SENS:CORR:COLL:GUID:PATH:CMEThod 1,2,"SOLT"
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scpi.Parse "SENS:CORR:COLL:GUID:PATH:TMEThod 1,2,"Undefined Thru"

' To set up the cal as TRL, comment the previous 'CMET' line and uncomment

' this next line. The TMEThod is set by default

'scpi.Parse "SENS:CORR:COLL:GUID:PATH:CMEThod 1,2,"TRL"

' Initiate the calibration

scpi.Parse "SENS:CORR:COLL:GUID:INIT"

' Query the list of ports that need delta match

retStr = scpi.Parse("SENS:CORR:COLL:GUID:DMAT:APPL:PORT?")

portList = Split(retStr, ",")

' If portList contains just one element and it's value is 0, then that indicates

' none of the ports being calibrated require delta match data.

' Note: if each testport on the VNA has it's own reference receiver (R channel),

'       then delta match is never needed, so portList will always be just 0.

lowerBound = LBound(portList)
If (UBound(portList) <> lowerBound) Or (CInt( portList(lowerBound) ) <> 0) Then

 ' Delta match data is required for at least one port.

' For this example, we assume a Global Delta Match Cal has previously been

' performed so the Global Delta Match CalSet exists.

' The Global Delta Match CalSet is used when the APPL command is invoked

' without a specific calset ID (GUID).

 scpi.Parse "SENS:CORR:COLL:GUID:DMAT:APPL"

End If

' Query the number of calibration steps

retStr = scpi.Parse("SENS:CORR:COLL:GUID:STEP?")

numSteps = CInt(retStr)

' Measure the cal standards

For i = 1 To numSteps

prompt = scpi.Parse("SENS:CORR:COLL:GUID:DESC? " & CStr(i))
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retVal = MsgBox(prompt, vbOKCancel)

If retVal = vbCancel Then Exit Sub

retStr = scpi.Parse("SENS:CORR:COLL:GUID:ACQ STAN" & CStr(i) & ";*OPC?")

Next

' Compute the error coefficients and save the cal to CalSet, and turn it on

scpi.Parse "SENS:CORR:COLL:GUID:SAVE"

MsgBox "Cal is done!"

End Sub
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Perform Multi DUT Parallel Measurement (M9485A)

The following example show the multi DUT measurement sample code. See Multi DUT parallel
measurement.

Correction for multi DUT

To apply the channel independent correction, need to disable the parallel measurement temporary

during the process. But the channel coupling still can be enabled.

Note that you can’t apply multiple calsets independently, unless the parallel measurement is off.

Example 1: Measure 1-port DUT x2

Setup Configuration

' Setup channels as Ch1-S11 and Ch2-S22.

SYST:PRES

CALC2:PAR:EXT "tr2","S22"

DISP:WIND1:TRAC2:FEED "tr2"

' Set channel coupling. In this case, group {0} means global coupling.

SYST:CHAN:COUP:GROUp 0

SYST:CHAN:COUP:STATe 1

' Set frequency and points. The changes are copied to Channel2 automatically.

SENS1:FREQ:STARt 1e6;STOP 1e8;

SENS1:SWE:POIN 1001

' Turn on parallel measurement. Then the sweep and measurement of Ch1 and 2 runs
at the same time.

SYST:CHAN:COUP:PARallel:ENABle 1
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' Check the state.

SYST:CHAN:COUP:PARallel:STATe? 1

' 1 will be returned

SYST:CHAN:COUP:PARallel:STATe? 2

' 1 will be returned

SYST:CHAN:COUP:GROUp?

' 0 will be returned

 

' Disable the parallel measurement before calibration in order to apply the
channel independent correction.

:SYST:CHAN:COUP:PARallel:ENABle 0

' calibrate the channel 1.
' apply the calset to channel 1.
' calibrate the channel 2.
' apply the calset to channel 2.

' Then restore the state. The channels start the parallel measurement with the
independent correction.
:SYST:CHAN:COUP:PARallel:ENABle 1

 

Example 2: Measure 1-port DUT x2 with 2 groups

 

' Setup channels Ch1-S11 and Ch2-S22 for Group1.

SYST:PRES

CALC2:PAR:EXT "tr2","S22"
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DISP:WIND1:TRAC2:FEED "tr2"

' Setup channels Ch5-S55 and Ch6-S66 for Group2.

DISP:WIND2:STAT ON

CALC5:PAR:EXT "tr5","S55"

DISP:WIND2:TRAC1:FEED "tr5"

CALC6:PAR:EXT "tr6","S66"

DISP:WIND2:TRAC2:FEED "tr6"

' Set channel coupling. Group1 has Ch1-2, Group2 has Ch5-6.

SYST:CHAN:COUP:GROUp 2,1,2,5,6

SYST:CHAN:COUP:STATe 1

' Set independent sweep settings for each groups.

SENS1:FREQ:STARt 1e6;STOP 1e8;

SENS5:FREQ:STARt 5e9;STOP 6e9;

 

' Disable the parallel measurement before calibration in order to apply the
channel independent correction.

:SYST:CHAN:COUP:PARallel:ENABle 0

' calibrate the channel 1.
' apply the calset to channel 1.
' calibrate the channel 2.
' apply the calset to channel 2.

' calibrate the channel 5.
' apply the calset to channel 5.

' calibrate the channel 6.
' apply the calset to channel 6.

 

' Then restore the state. The channels start the parallel measurement with the
independent correction.
:SYST:CHAN:COUP:PARallel:ENABle 1

 

Example 3: Measure 2-port DUT x2
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Setup Configuration

' Setup channels Ch1-S11&S12, Ch2-S33&S34

SYST:PRES

CALC1:PAR:EXT "tr2","S12"

DISP:WIND1:TRAC2:FEED "tr2"

CALC2:PAR:EXT "tr3","S33"

CALC2:PAR:EXT "tr4","S34"

DISP:WIND2:STAT ON

DISP:WIND2:TRAC1:FEED "tr3"

DISP:WIND2:TRAC2:FEED "tr4"

' Set channel coupling

SYST:CHAN:COUP:GROUp 0

SYST:CHAN:COUP:STATe 1

' Turn on parallel measurement. First, port1 and 3 become the source. Next port 2
and 4.

SYST:CHAN:COUP:PARallel:ENABle 1

 

' Disable the parallel measurement before calibration in order to apply the
channel independent correction.

:SYST:CHAN:COUP:PARallel:ENABle 0

' calibrate the channel 1.
' apply the calset to channel 1.
' calibrate the channel 2.
' apply the calset to channel 2.
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' Then restore the state. The channels start the parallel measurement with the
independent correction.
:SYST:CHAN:COUP:PARallel:ENABle 1

 

 

Last modified:

31-Mar-2017 New topic
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Setup Markers using SCPI

This VBScript program does the following:

Preset the VNA

Return active channel number and measurement string

Create a marker

Set X-axis value

Read X, Y-axis values

Set marker to trace Min

Read X, Y-axis values

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as Markers.vbs.  Learn how to
setup and run the macro.

See all Marker SCPI commands.

See Other SCPI Example Programs

Dim na, vi, ret

Set na = CreateObject("AgilentPNA835x.Application")

Set vi = na.ScpiStringParser

'Get Identification String from Analyzer

ret=vi.Parse("*IDN?")

msgbox ret

'Preset VNA

ret=vi.Parse("SYST:PRES; *OPC?")

'Get Active Channel and Measurement
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chan = vi.Parse("SYST:ACT:CHAN?")

meas = vi.Parse("SYST:ACT:MEAS?")

'Convert chan to a single number

chan=CStr(CInt(chan))

'Select Active Measurement

vi.Parse "CALC" + chan + ":PAR:SEL " + meas

'Turn Marker 1 on and set X value to 1 GHz

vi.Parse "CALC" + chan + ":MARK1:STAT ON"

vi.Parse "CALC" + chan + ":MARK1:X 1e9"

'Get X and Y marker values

x_val = vi.Parse("CALC" + chan + ":MARK1:X?")

y_val = vi.Parse("CALC" + chan + ":MARK1:Y?")

'Display Marker Values

msgbox "X Value = " + x_val +  Chr(10) + "Y Value = " + y_val

'Use Marker 1 as a minimum search

vi.Parse "CALC" + chan + ":MARK1:FUNC:EXEC MIN"

'Get X and Y marker values

x_val = vi.Parse("CALC" + chan + ":MARK1:X?")

y_val = vi.Parse("CALC" + chan + ":MARK1:Y?")

'Display Marker Values

msgbox "X Value = " + x_val + Chr(10) + "Y Value = " + y_val
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Setup PNOP and PSAT Marker Search

This example program does the following:

Sets up measurement for either PNOP or PSAT marker search

Sets parameters for search

Reads a parameter for each

See PNOP and PSAT SCPI commands.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as SearchMkr.vbs.  Learn how
to setup and run the macro.

See Other SCPI Example Programs

Dim app

Set app = CreateObject("AgilentPNA835X.Application")

Dim scpi

set scpi = app.ScpiStringParser

scpi.Execute ("SYST:FPReset")

' View Power Out vs Power In

' Create and turn on window/channel 1

scpi.Execute ("DISPlay:WINDow1:STATE ON")

'Define a measurement name, parameter

scpi.Execute ("CALCulate1:PARameter:DEFine:EXT 'MyMeas',B")

'Associate ("FEED") the measurement name ('MyMeas') to WINDow (1)

scpi.Execute ("DISPlay:WINDow1:TRACe1:FEED 'MyMeas'")

scpi.Execute ("CALCulate1:PARameter:SELect 'MyMeas'")
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'perform power sweep

scpi.Execute ("SENSe1:SWEep:TYPE POWer")

scpi.Execute ("SOURce1:POWer:STARt -5")

scpi.Execute ("SOURce1:POWer:STOP 0")

'--------------------

'Choose marker search

resp=Msgbox ("PNOP (yes) or PSAT (no)" , 4, "PNA Marker Search Demo")

if resp=6 then

  PNOP1()

Else

  PSAT1()

End If

'--------------------

'PSAT marker search

Sub PSAT1()

scpi.Execute ("CALCulate1:MARKer:PSATuration:BACKoff 2")

'Read PSAT Parameter

dim answer

answer=scpi.Execute ("CALCulate1:MARKer:PSATuration:GAIN?")

wscript.echo("Gain Sat: "& answer)

End Sub

'--------------------

'PNOP marker search

Sub PNOP1()

scpi.Execute ("CALCulate1:MARKer:PNOP:BACKoff 2")

scpi.Execute ("CALCulate1:MARKer:PNOP:POFFset 1")

'Read PNOP Parameter

dim answer
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answer=scpi.Execute ("CALCulate1:MARKer:PNOP:GAIN?")

wscript.echo("PNOP Gain: "& answer)

End Sub
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Setup Receiver Leveling using SCPI

This VBScript program configures Receiver Leveling.

Preset the VNA

Make all receiver leveling settings

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as RxLev.vbs.  Learn how to
setup and run the macro.

See all Recevier Leveling SCPI commands.

See Other SCPI Example Programs

Set pna = CreateObject("AgilentPNA835x.Application")

Set SCPI = pna.ScpiStringParser

'set source port

dim srcP

srcP = "1"

'Preset PNA

SCPI.Parse "SYST:PRES"

SCPI.Parse "sour1:pow" + srcP + ":alc:mode:rec:ref 'R1'"

SCPI.Parse "sour1:pow" + srcP + ":alc:mode:rec:tol 0.02"

SCPI.Parse "sour1:pow" + srcP + ":alc:mode:rec:iter 10"

SCPI.Parse "sour1:pow" + srcP + ":alc:mode:rec:fast OFF"

SCPI.Parse "sour1:pow" + srcP + ":alc:mode:rec:ifbw 100"

SCPI.Parse "sour1:pow" + srcP + ":alc:mode:rec:offs 0"

SCPI.Parse "sour1:pow" + srcP + ":alc:mode:rec:safe:max 20"
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SCPI.Parse "sour1:pow" + srcP + ":alc:mode:rec:safe:max -100"

SCPI.Parse "sour1:pow" + srcP + ":alc:mode:rec:safe ON"

'Last, enable receiver leveling

SCPI.Parse "sour1:pow" + srcP + ":alc:mode:rec ON"
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Setup Sweep Parameters using SCPI

This Visual Basic program sets up sweep parameters on the Channel 1 measurement.

To run this program, you need:

An established GPIB interface connection

 See Other SCPI Example Programs

GPIB.Write "SYSTem:PRESet"
'Select the measurement
GPIB.Write "CALCulate:PARameter:SELect 'CH1_S11_1'"
'Set sweep type to linear
GPIB.Write "SENSe1:SWEep:TYPE LIN"

'Set IF Bandwidth to 700 Hz
GPIB.Write "SENSe1:BANDwidth 700"

'Set Center and Span Freq's to 4 GHz
GPIB.Write "SENSe1:FREQuency:CENTer 4ghz"
GPIB.Write "SENSe1:FREQuency:SPAN 4ghz"

'Set number of points to 801
GPIB.Write "SENSe1:SWEep:POINts 801"

'Set sweep generation mode to Analog
GPIB.Write "SENSe1:SWEep:GENeration ANAL"

'Set sweep time to Automatic
GPIB.Write "SENSe1:SWEep:TIME:AUTO ON"

'Query the sweep time
GPIB.Write "SENSe1:SWEep:TIME?
SweepTime = GPIB.Read
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Setup the Display using SCPI

This Visual Basic program:

Sets data formatting
Turns ON the Trace, Title, and Frequency Annotation

Autoscales the Trace

Queries Per Division, Reference Level, and Reference Position

Turn ON and set averaging

Turn ON and set smoothing

To run this program, you need:

An established GPIB interface connection

See Other SCPI Example Programs

GPIB.Write "SYSTem:PRESet"

'Select the measurement
GPIB.Write "CALCulate:PARameter:SELect 'CH1_S11_1'"

'Set the Data Format to Log Mag
GPIB.Write ":CALCulate1:FORMat MLOG"

'Turn ON the Trace, Title, and Frequency Annotation
GPIB.Write "Display:WINDow1:TRACe1:STATe ON"
GPIB.Write "DISPlay:WINDow1:TITLe:STATe ON"
GPIB.Write "DISPlay:ANNotation:FREQuency ON"

'Autoscale the Trace
GPIB.Write "Display:WINDow1:TRACe1:Y:Scale:AUTO"

'Query back the Per Division, Reference Level, and Reference Position
GPIB.Write "DISPlay:WINDow1:TRACe1:Y:SCALe:PDIVision?"
Pdiv = GPIB.Read
GPIB.Write "DISPlay:WINDow1:TRACe1:Y:SCALe:RLEVel?"
Rlev = GPIB.Read
GPIB.Write "DISPlay:WINDow1:TRACe1:Y:SCALe:RPOSition?"
Ppos = GPIB.Read

'Turn ON, and average five sweeps
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GPIB.Write "SENSe1:AVERage:STATe ON"
GPIB.Write "SENSe1:AVERage:Count 5"

'Turn ON, and set 20% smoothing aperture
GPIB.Write "CALCulate1:SMOothing:STATe ON"
GPIB.Write "CALCulate1:SMOothing:APERture 20"
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Show Custom Cal Windows during a Guided Calibration

This VBScript program shows how to send commands that allow you to view specific 'custom'

windows, and sweep specific channels, during a UI (Cal Wizard) or remote calibration.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as CalWindow.vbs.  Learn how
to setup and run the macro.

These commands are used to show and sweep windows and channels:

SENS:CORR:COLL:DISP:WIND

SENS:CORR:COLL:SWE:CHAN

SENS:CORR:COLL:DISP:WIND:AOFF

SENS:CORR:COLL:SWE:CHAN:AOFF

SENS:CORR:COLL:GUID:PACQuire

See Other SCPI Example Programs

Dim app

Dim scpi

' Create / Get the PNA application.

Set app = CreateObject("AgilentPNA835x.Application")

Set scpi = app.ScpiStringParser

' A comment

'Preset the analyzer

'This creates an S11 measurement in channel 1, window 1

scpi.Execute "SYST:PReset"

' Create and turn on window 2
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scpi.Execute "DISPlay:WINDow2:STATE ON"

'Define an S21 measurement in channel 2

scpi.Execute "CALCulate2:PARameter:DEFine:EXT 'MyMeas',S21"

'Associate ("FEED") the measurement name ('MyMeas') to WINDow2

'and give the new TRACe a number (1).

scpi.Execute "DISPlay:WINDow2:TRACe1:FEED 'MyMeas'"

 

'The following lines are all you need in order to:

'show and sweep the custom Cal windows during a UI Calibration

'If sending ONLY these commands, make sure you know the

'correct window and channel numbers to show and sweep.

'Flag windows 1 and 2 to show during Ch1 calibration

scpi.Execute "SENS:CORR:COLL:DISP:WIND1 ON"

scpi.Execute "SENS:CORR:COLL:DISP:WIND2 ON"

'Flag channels 1 and 2 to sweep during Ch1 calibration

scpi.Execute "SENS1:CORR:COLL:SWE:CHAN1 ON"

scpi.Execute "SENS1:CORR:COLL:SWE:CHAN2 ON"

 

' ===========================================================

' The following code performs a remote guided Cal on Ch1.

' From a remote cal, the Cal window does not normally show and sweep

' after the previous standard has been acquired.

' This shows how to include the PACQuire (preview) to view and sweep the Cal
Window.

' The Custom window also shows and sweeps due to the flag commands above.

' The flags are cleared at the end of this section.

 

' Specify the DUT connectors
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scpi.Execute "sens:corr:coll:guid:conn:port1 ""APC 3.5 female"" "

scpi.Execute "sens:corr:coll:guid:conn:port2 ""APC 3.5 male"" "

' Select the Cal Kit for each port being calibrated.

scpi.Execute "sens:corr:coll:guid:ckit:port1 ""85052D"" "

scpi.Execute "sens:corr:coll:guid:ckit:port2 ""85052D"" "

' Initiate the calibration and query the number of steps

scpi.Execute "sens:corr:coll:guid:init"

numSteps = scpi.Execute("sens:corr:coll:guid:steps?")

MsgBox "Number of steps is " + CStr(numSteps)

' Measure the standards

For i = 1 to numSteps

step = "Step " + CStr(i) + " of " + CStr(numSteps)

strPrompt = scpi.Execute("sens:corr:coll:guid:desc? " + CStr(i))

'send the Preview Acquire command, then prompt

scpi.Execute "sens:corr:coll:guid:PACquire STAN" + CStr(i)

' Do NOT send any Guided Cal commands here or the cal window will not sweep

MsgBox strPrompt, vbOKOnly, step

scpi.Execute "sens:corr:coll:guid:acq STAN" + CStr(i)

Next

' Conclude the calibration

scpi.Execute "sens:corr:coll:guid:save"

MsgBox "Cal is done!"

 

'Remove the Custom Window flags

scpi.Execute "SENS:CORR:COLL:DISP:WIND:AOFF"

'Remove the channel sweep flags

scpi.Execute "SENS:CORR:COLL:SWE:CHAN:AOFF"
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Perform a Sliding Load Calibration using GPIB

This Visual Basic program does a only the sliding load portion of a Calibration.

To run this program, you need:

An established GPIB interface connection
A measurement and calibration routine to call this sub-program

STAN3 set up as a sliding load standard

See Other SCPI Example Programs

Sub slide()
'Measure the sliding load for at least 5 and no more than 7 slides
'Note that "SLSET" and "SLDONE" must be executed before the actual acquisition of a
slide
MsgBox "Connect Sliding Load; set to Position 1; then press OK"
GPIB.Write "SENS:CORR:COLL SLSET"
GPIB.Write "SENS:CORR:COLL STAN3;"

MsgBox "Set Sliding Load to position 2; then press OK"
GPIB.Write "SENS:CORR:COLL SLSET"
GPIB.Write "SENS:CORR:COLL STAN3;"

MsgBox "Set Sliding Load to position 3; then press OK"
GPIB.Write "SENS:CORR:COLL SLDONE"
GPIB.Write "SENS:CORR:COLL STAN3;"
End Sub
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 See Other SCPI Example Programs

Status Reporting using SCPI

This Visual Basic program demonstrates two methods of reading the analyzer's status registers:

Polled Bit Method - reads the Limit1 register continuously.

SRQ Method - enables an interrupt of the program when bit 6 of the status byte is set to 1. The program then
queries registers to determine if the limit line failed.

To run this program, you need:

An established GPIB interface connection

A form with two buttons: Poll and SRQ Method

A means of causing the limit line to fail, assuming it passes initially.

Private Sub Poll_Click()
' POLL THE BIT METHOD
' Clear status registers
GPIB.Write "*CLS"

'Loop FOREVER
Do
  DoEvents
  GPIB.Write "STATus:QUEStionable:LIMit1:EVENt?"
  onn = GPIB.Read
Loop Until onn = 2

MsgBox "Limit 1 Failed "
End Sub

Private Sub SRQMethod_Click()
'SRQ METHOD
GPIB.Write "SYSTem:PRESet"
GPIB.Write "CALCulate:PARameter:SELect 'CH1_S11_1'"
'slow down the trace
GPIB.Write "SENS:BWID 150"

'Setup limit line
GPIB.Write "CALC:LIM:DATA 2,3e9,6e9,-2,-2"
GPIB.Write "CALC:LIMit:DISP ON"
GPIB.Write "CALC:LIMit:STATe ON"

' Clear status registers.
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GPIB.Write "*CLS;*wai"
' Clear the Service Request Enable register.
GPIB.Write "*SRE 0"
' Clear the Standard Event Status Enable register.
GPIB.Write "*ESE 0"

' Enable questionable register, bit(10) to report to the status byte.
GPIB.Write "STATus:QUEStionable:ENABle 1024"

' Enable the status byte register bit3 (weight 8) to notify controller
GPIB.Write "*SRE 8"

' Enable the onGPIBNotify event
GPIB.NotifyMask = cwGPIBRQS
GPIB.Notify
End Sub

----------------------------------------------------
Private Sub GPIB_OnGPIBNotify(ByVal mask As Integer)
' check to see what failed
' was it the analyzer?
GPIB.Write "*STB?"
onn = GPIB.Read
If onn <> 0 Then
' If yes, then was it the questionable register?
  GPIB.Write "STATus:QUEStionable:EVENt?"
  onn = GPIB.Read
  ' Determine if the limit1 register, bit 8 is set.
  If onn = 1024 Then
  'if yes, then was it trace 1?
  GPIB.Write "STAT:QUES:LIMIT1:EVEN?"
  onn = GPIB.Read
  If onn = 2 Then MsgBox ("Limit Line1 Failed")
  End If
End If
End Sub
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Transfer Data using GPIB

The following RMB examples transfer data to and from a remote PC using the MMEM:TRANsfer
command.

Transferring data FROM the VNA  --  TO a remote PC:

30    !
40    !                  Set up I/O paths
50    !
60    ! Network analyzer address
70    ASSIGN @Na TO 716
75    !
77    ! File to be stored on local computer
80    ! First time -- need to create the file.
90    ! After file name, number records set to 0 (ignored by WinOS)
95    ! Use "PURGE" command to delete if desired.
100   CREATE "mytestdata.s2p",0
110   ASSIGN @File TO "mytestdata.s2p"
120   !
122   !              TRANSFER the data (download)
123   !
125   ! Analyzer has file 'testdata.s2p' in default directory
130   OUTPUT @Na;":MMEM:TRAN? ""testdata.s2p"""
135   !
137   ! Now read the bytes coming back from the analyzer in four steps
138   ! (1) Read and dump the first character - '#'
140   ENTER @Na USING "#,A";A$
141   !
142   ! (2) Read the next character which is the number of digits in the file size
150   ENTER @Na USING "#,A";Digit$
160   !
161   ! (3) Use the value of the number of digits to read back the file byte size
170   ! Create query string using this number of digits
180   Img$="#,"&Digit$&"A"
190   !
200   ! Byte$ holds the number of bytes in string format
210   ENTER @Na USING Img$;Byte$
220   !
225   ! (4) Read the file contents into a buffer and store the buffer contents to a
local file
230   ! Allocate a buffer for holding the data
240   ALLOCATE Dat$[VAL(Byte$)]
250   !
260   ! Set up a different image for filling the buffer
270   Img$=Byte$&"A"
280   !
290   ! Retrieve the actual file data
300   ENTER @Na USING Img$;Dat$
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305   !
307   ! Now save the file locally.
310   OUTPUT @File;Dat$
320   END

Transferring data FROM the remote PC  - TO the VNA:

40    !                  Set up I/O paths
50    !
60    ! Network analyzer address
70    ASSIGN @Na TO 716
77    ! File to be retrieved from local computer
78    ASSIGN @File TO "mytestdata.s2p"
79    !
120   !
122   !              TRANSFER the data
123   !
230   ! Allocate a buffer for holding the data
240   ALLOCATE Dat$[26236]
250   !
260   ! Get data from the file and fill Dat$
270   ENTER @File;Dat$
280   !
325   ! Data to be transferred to analyzer file 'testupld.s2p'
325   ! in default directory.
326   !
327   ! A specific block transfer designator must follow the
328   ! file name:
329   !     '#' specifies a block transfer.
330   !     '6' specifies 6 digits to follow.
331   !     '026236' matches the buffer size allocated above
332   !     not counting <NL><END> (new line and end of file).
430   OUTPUT @Na;":MMEM:TRAN ""testupld.s2p"",#6026236",Dat$
520   END
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Triggering the Analyzer using SCPI

To understand how to trigger the analyzer using SCPI, it is very important to understand the trigger
model. Here is a very simple explanation. These three separate functions control triggering:

Trigger:Source - Where the trigger signals originate:

Internal Continuous

Internal Manual (Single)

External - a trigger source that is connected to the rear panel.

1.

Trigger:Scope - what gets triggered:

Global - each signal triggers all channels in turn.

Channel - each signal triggers ONE channel.

2.

Channel settings (Sense<ch>:Sweep:Mode) How many triggers will each channel accept before going into
hold.

HOLD - channel will not trigger.

CONTinuous - channel triggers indefinitely.

GROups - channel accepts the number of triggers specified with the last SENS:SWE:GRO:COUN
<num>.

SINGle - channel accepts ONE trigger, then goes to HOLD.

Point trigger   SENS1:SWE:TRIG:POINt

3.

When controlling the VNA using SCPI, a SINGLE trigger is used to ensure that a complete sweep is

taken. This example demonstrates how to Single trigger the VNA using the following two methods:

Simplest Triggering  

This method uses the default Trigger Source = Internal to send a stream of trigger signals.

The channel is configured to ACCEPT only a single trigger signal, then HOLD
(Sense<ch>:Sweep:Mode SINGle). This is the ONLY required command.
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This method can also be used when an External trigger source sends a continuous stream of trigger
signals.

Advanced Triggering

This method SENDS a single trigger from the Source, which can be from either Internal (using
INIT:IMM) or External triggering.

Each channel is configured to accept an unlimited number of triggers. This method is the only way to
perform point triggering.

When you require some channels to accept continuous triggers and other channels to accept single
triggers, see INIT:IMM Advanced to learn how.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the analyzer. To do this, copy the following

code into a text editor file such as Notepad and save it on the analyzer hard drive as Trigger.vbs. Learn
how to setup and run the macro.

 

Measurement setup example:  This section of code can be used at the start of both methods. It sets

up:

S11 traces on two channels

10 data points

Sweep time of 2 seconds - this is slow enough to allow us to watch as each trace is triggered.

Dim app

Dim scpi

' Create / Get the VNA application.

Set app = CreateObject("AgilentPNA835x.Application")

Set scpi = app.ScpiStringParser

'============================================

'Setup the VNA

'Preset the analyzer

scpi.Execute ("SYST:FPReset")
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' Create and turn on window/channel 1

scpi.Execute ("DISPlay:WINDow1:STATE ON")

'Define a measurement name, parameter

scpi.Execute ("CALCulate1:PARameter:DEFine:EXT 'MyMeas1',S11")

'Associate ("FEED") the measurement name ('MyMeas') to WINDow (1)

scpi.Execute ("DISPlay:WINDow1:TRACe1:FEED 'MyMeas1'")

' Create and turn on window/channel 2

scpi.Execute ("DISPlay:WINDow2:STATE ON")

'Define a measurement name, parameter

scpi.Execute ("CALCulate2:PARameter:DEFine:EXT 'MyMeas2',S11")

'Associate ("FEED") the measurement name ('MyMeas') to WINDow (2)

scpi.Execute ("DISPlay:WINDow2:TRACe2:FEED 'MyMeas2'")

'Set slow sweep so we can see

scpi.Execute ("SENS1:SWE:TIME 2")

scpi.Execute ("SENS2:SWE:TIME 2")

'set number of points to 10

scpi.Execute ("SENS1:SWE:POIN 10")

scpi.Execute ("SENS2:SWE:POIN 10")

'============================================

' Put both channels in Hold

scpi.Execute ("SENS1:SWE:MODE HOLD")

scpi.Execute ("SENS2:SWE:MODE HOLD")

'================================

'Pick Single Send or Single Accept

resp=Msgbox ("Single Send? - Click No for Single Accept", 4, "PNA Trigger Demo")

If resp=6 Then

SingleSend()

Else
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SingleAccept()

End If

 

 

Simple Triggering  The following example sends a continuous stream of trigger signals and each

VNA channel is set to ACCEPT only a signal trigger signal, then HOLD.

This example can be used to configure External triggering where the trigger source sends a continuous
stream of trigger signals. Configure the type of trigger signal that the VNA responds to using the
CONTrol:SIGNal command. The command in this example sets the VNA to respond to HIGH TTL signals at
the rear-panel BNC1 trigger IN connector. This command also automatically sets Trigger Source to External
Trigger.

The TRIG SCOPE (Global or Channel) setting is NOT necessary with a continuous stream of trigger signals.
The example program directly controls when each channel is triggered.

Point triggering can NOT be used with a continuous stream of trigger signals because in point triggering the
channel will accept as many triggers as necessary to complete ONE full sweep. Use the single SEND
example for point triggering.

Sub SingleAccept()

'VNA sends continuous trigger signals

scpi.Execute ("TRIG:SOUR IMMediate")

'Uncomment the following to set External triggering

'scpi.Execute ("CONT:SIGN BNC1,TILHIGH")

AcceptOne()

End Sub

 

Sub AcceptOne()

'The following command makes the channel immediately sweep

'*OPC? allows the measurement to complete before the controller sends another
command

scpi.Execute ("SENS1:SWE:MODE SINGle;*OPC?")

' You could do something to ch2 here before sweeping it

scpi.Execute ("SENS2:SWE:MODE SINGle;*OPC?")
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resp=Msgbox ("Another trigger?", 1, "PNA Trigger Demo")

If resp=1 Then

AcceptOne()

End If

End Sub

 

Advanced Trigger This example section performs Single Send triggering. Here, single triggering is

accomplished by SENDING one trigger signal from the Trigger source and each channel is setup to

accept unlimited trigger signals. See the INIT:IMM command for more details.

Using this method, it is possible to change Trigger:Scope to Global or Channel. Set trigger scope to channel
if there is some code to execute between channel measurements. Similarly, this method can be used to set
Point triggering. Use this method if there is some code to execute between data point measurements.

In addition, this method can also be used to perform External triggering if the external trigger source is
capable of SENDING single triggers. See the CONTrol:SIGNal command to set the type of signal to which
the VNA will respond.

If the external source can only send a continuous stream of trigger signals, then the Single Accept section
must be used.

Sub SingleSend()

'Set Source Internal - Manual Triggering

scpi.Execute ("TRIG:SOUR MANual")

'If using an External trigger source that is capable of

'sending SINGLE trigger signals, then uncomment the following.

'This command automatically sets trigger source to External

'scpi.Execute ("CONT:SIGN BNC1,TILHIGH")

 

'Setup Trigger Scope

'WHAT gets triggered

'Pick one using comments

'Set Channel triggering

'scpi.Execute ("TRIG:SCOPe CURRent")
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'Set Global triggering (Default)

scpi.Execute ("TRIG:SCOPe ALL")

 

'Set Channel Settings

'The channels respond to UNLIMITED trigger signals (Default)

scpi.Execute ("SENS1:SWE:MODE CONTinuous")

scpi.Execute ("SENS2:SWE:MODE CONTinuous")

 

'To do Point trigger on one or more channels, uncomment the following.

'Point trigger automatically sets Trig:Scope to Current/Channel

'scpi.Execute ("SENS1:SWE:TRIG:POINt ON")

'scpi.Execute ("SENS2:SWE:TRIG:POINt ON")

IntTrig()

End Sub

 

Sub IntTrig()

'If External triggering, replace this Sub with code

'to single trigger the External Trig Source

Dim resp

'*OPC? allows the measurement to complete before the controller sends another
command

scpi.Execute ("INITiate:IMMediate;*OPC?")

resp=Msgbox ("Another trigger?", 1, "PNA Trigger Demo")

If resp=1 Then

IntTrig()

End If

End Sub
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Perform an Unguided Cal on Multiple Channels

This VBScript program performs an Unguided Calibration simultaneously on two channels.

This could be used in the following cases:

If you need more than the current number of data points per trace, so the additional points must be added to
a different channel.

If you need several channels with independent settings, but you want to calibrate all channels with a minimal
number of standard connections.  This would be especially critical for on wafer calibration.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as Unguided.vbs. Learn how to
setup and run the macro.

Dim app

Dim scpi

Dim NumberOfActiveChannels

NumberOfActiveChannels = 2

' Create / Get the VNA application.

Set app = CreateObject("AgilentPNA835x.Application")

Set scpi = app.ScpiStringParser

' Query the list of connectors that the VNA system recognizes

scpi.Execute("SYST:PRES")

'Wait for successful preset before continuing

done=scpi.Execute("*OPC?")

'The following section sets up 2 channels with different frequency ranges

scpi.Execute("DISP:WIND1:STATE OFF")

'Reset Windows

scpi.Execute("DISP:WIND1:STATE ON")
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scpi.Execute("DISP:WIND2:STATE ON")

'

' Assign a measurement to the first window

scpi.Execute("CALC1:PAR:DEF:EXT 'Meas1', S21")

scpi.Execute("DISP:WIND1:TRAC1:FEED 'Meas1'")

'Assign a measurement to the second window

scpi.Execute("CALC2:PAR:DEF:EXT 'Meas2', S21")

scpi.Execute("DISP:WIND2:TRAC1:FEED 'Meas2'")

'Set up two channels with independent parameters

scpi.Execute("SENS1:FREQ:SPAN 1e9")

scpi.Execute("SENS2:FREQ:SPAN 1e6")

'Wait for changes before continuing

done=scpi.Execute("*OPC?")

'

'This section sets the calibration kits for channel 1 and channel 2

'Select a trace from channel 1 and set calibration type and cal kit

scpi.Execute("CALC1:PAR:SEL 'Meas1'")

scpi.Execute("SENS1:CORR:COLL:METH SPARSOLT")

scpi.Execute("SENS1:CORR:COLL:CKIT 2") '85056D for default settings

'Same standards for forward and reverse direction

scpi.Execute("SENS1:CORR:TST OFF")

'Select a trace from channel 2 and set calibration type and cal kit

scpi.Execute("CALC2:PAR:SEL 'Meas2'")

scpi.Execute("SENS2:CORR:COLL:METH SPARSOLT")

scpi.Execute("SENS2:CORR:COLL:CKIT 2") '85056D for default settings

'Same standards for forward and reverse direction

scpi.Execute("SENS2:CORR:TST OFF")
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'Set both channels to manual triggering

scpi.Execute("INIT1:CONT OFF")

scpi.Execute("INIT2:CONT OFF")

'

'The following assumes female port connector on port 1

' and male port connector on port 1

'Step through all active channels and calibrate and measure all standards.

scpi.Execute("SENS1:CORR:SFOR ON") 'Set acquisition to forward

scpi.Execute("SENS2:CORR:SFOR ON") 'Set acquisition to forward

MsgBox("Connect OPEN standard to port 1")

For CurrentChannel  = 1 To NumberOfActiveChannels

scpi.Execute("CALC" & CurrentChannel & ":PAR:SEL 'Meas" & CurrentChannel & "'")

scpi.Execute("SENS" & CurrentChannel & ":CORR:COLL stan1")

done= scpi.Execute("*OPC?")

Next

 

MsgBox("Connect SHORT standard to port 1")

For CurrentChannel = 1 To NumberOfActiveChannels

scpi.Execute("CALC" & CurrentChannel & ":PAR:SEL 'Meas" & CurrentChannel & "'")

scpi.Execute("SENS" & CurrentChannel & ":CORR:COLL stan2")

done=scpi.Execute("*OPC?")

Next

 

MsgBox("Connect LOAD standard to port 1")

For CurrentChannel = 1 To NumberOfActiveChannels

scpi.Execute("CALC" & CurrentChannel & ":PAR:SEL 'Meas" & CurrentChannel & "'")

scpi.Execute("SENS" & CurrentChannel & ":CORR:COLL stan3")

done=scpi.Execute("*OPC?")
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Next

scpi.Execute("SENS1:CORR:SFOR OFF") 'Set acquisition to reverse

scpi.Execute("SENS2:CORR:SFOR OFF") 'Set acquisition to forward

 

MsgBox("Connect OPEN standard to port 2")

For CurrentChannel = 1 To NumberOfActiveChannels

scpi.Execute("CALC" & CurrentChannel & ":PAR:SEL 'Meas" & CurrentChannel & "'")

scpi.Execute("SENS" & CurrentChannel & ":CORR:COLL stan1")

done=scpi.Execute("*OPC?")

Next

 

MsgBox("Connect SHORT standard to port 2")

For CurrentChannel = 1 To NumberOfActiveChannels

scpi.Execute("CALC" & CurrentChannel & ":PAR:SEL 'Meas" & CurrentChannel & "'")

scpi.Execute("SENS" & CurrentChannel & ":CORR:COLL stan2")

done=scpi.Execute("*OPC?")

Next

 

MsgBox("Connect LOAD standard to port 2")

For CurrentChannel = 1 To NumberOfActiveChannels

scpi.Execute("CALC" & CurrentChannel & ":PAR:SEL 'Meas" & CurrentChannel & "'")

scpi.Execute("SENS" & CurrentChannel & ":CORR:COLL stan3")

done=scpi.Execute("*OPC?")

Next

'

'Measure thru standard for all channels in both forward and reverse direction

MsgBox("Connect THRU between ports 1 and 2")

scpi.Execute("SENS1:CORR:SFOR ON") 'Set acquisition to forward
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scpi.Execute("SENS2:CORR:SFOR ON") 'Set acquisition to forward

For CurrentChannel = 1 To NumberOfActiveChannels

scpi.Execute("CALC" & CurrentChannel & ":PAR:SEL 'Meas" & CurrentChannel & "'")

scpi.Execute("SENS" & CurrentChannel & ":CORR:COLL stan4")

done=scpi.Execute("*OPC?")

Next

scpi.Execute("SENS1:CORR:SFOR OFF") 'Set acquisition to reverse

scpi.Execute("SENS2:CORR:SFOR OFF") 'Set acquisition to reverse

For CurrentChannel = 1 To NumberOfActiveChannels

scpi.Execute("CALC" & CurrentChannel & ":PAR:SEL 'Meas" & CurrentChannel & "'")

scpi.Execute("SENS" & CurrentChannel & ":CORR:COLL stan4")

done=scpi.Execute("*OPC?")

Next

 

For CurrentChannel = 1 To NumberOfActiveChannels

scpi.Execute("CALC" & CurrentChannel & ":PAR:SEL 'Meas" & CurrentChannel & "'")

scpi.Execute("SENS" & CurrentChannel & ":CORR:COLL:SAVE")

done=scpi.Execute("*OPC?")

Next

 

'Set both channels to continuous triggering

scpi.Execute("INIT1:CONT ON")

scpi.Execute("INIT2:CONT ON")
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Upload and Download a Segment List

This VBScript program creates two segments, then uploads the segment data to the VNA.

The second part downloads the segment list from the VNA.

The SCPI commands in this example are sent over a COM interface using the SCPIStringParser object.

You do NOT need a GPIB connection to run this example.

This VBScript (*.vbs) program can be run as a macro in the VNA. To do this, copy the following code

into a text editor file such as Notepad and save it on the VNA hard drive as Unguided.vbs. Learn how to
setup and run the macro.

See all Segment SCPI commands.

Create and Upload a Segment List

Option Explicit

Dim app

Set app = CreateObject("AgilentPNA835x.Application")

' Preset the VNA

app.Preset

Dim scpi

Set scpi = app.ScpiStringParser

' In case of a measurement receiver VNA like N5264B

' which has no source ports, "SOURce:CATalog?" will

' return an empty list (just a pair of quotation marks)

Dim srcPortNames

srcPortNames = Split( scpi.Execute("SOURce:CATalog?"), ",")

Dim numberOfSrcPorts

If Left( srcPortNames(0), 2 ) = Chr(34) & Chr(34) Then

   numberOfSrcPorts = 0

Else

   numberOfSrcPorts = UBound(srcPortNames) + 1
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End If

' Building up a string consisting of the sweep segment data

' we want to set up.  This example will create two segments.

Dim segData

' Set state of first segment to be ON (1 = ON, 0 = OFF),

' 101 points, start freq of 10 MHz, stop freq of 1 GHz

segData = "1,101,10E6,1E9"

' If you want to include one or more of: IFbandwidth, Dwell Time

' or Port Power, remove the comments from these next two lines

'TurnOnOptions 1  'Call the subroutine

'segData = AddOptionalSettings(segData, numberOfSrcPorts)

' Set state of second segment to be ON, 201 points,

' start freq of 1 GHz, stop freq of 3 GHz

segData = segData & ",1,201,1E9,3E9"

' Uncomment this line below only if you uncommented the

' AddOptionalSettings line above for the first segment.

'segData = AddOptionalSettings(segData, numberOfSrcPorts)

Const numSegs = 2

' Upload our segment list to the channel

scpi.Execute "SENSe1:SEGMent:LIST SSTOP," & numSegs & "," & segData

' Set segment sweep type on Channel 1

scpi.Execute "SENSe1:SWEep:TYPE SEGment"

' Having the VNA display the segment sweep table for the channel

scpi.Execute "DISPlay:WINDow1:TABLe SEGMent"

Sub TurnOnOptions(ByVal chan)

   scpi.Execute "SENSe"&chan&":SEGMent:BWIDth:CONTrol ON"

   scpi.Execute "SENSe"&chan&":SEGMent:SWEep:TIME:CONTrol ON"

   scpi.Execute "SENSe"&chan&":SEGMent:POWer:CONTrol ON"
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   ' Turning off coupling allows power to vary per each port

   scpi.Execute "SOURce"&chan&":POWer:COUPle OFF"

End Sub

Function AddOptionalSettings(ByVal inStr, ByVal numSrcPorts)

   ' Specifying 1 kHz IF bandwidth and Dwell Time of 0

   inStr = inStr & ",1E3,0"

   ' -10 dBm power for each of the source ports

   Dim i

   For i = 0 To numSrcPorts - 1

      inStr = inStr & ",-10"

   Next

   AddOptionalSettings = inStr

End Function

Download a Segment List

This example assumes that the active trace is in Window 1

Option Explicit

Dim app

Set app = CreateObject("AgilentPNA835x.Application")

Dim scpi

Set scpi = app.ScpiStringParser

' Set the display-active channel's sweep type to segment sweep

' (if the VNA's currently active measurement window doesn't

'  contain any traces, this querying for active channel will

'  result in a SCPI error which scpi.Parse will trap and throw)

Dim chan

chan = CLng( scpi.Parse("SYSTem:ACTive:CHANnel?") )

scpi.Execute "SENSe"&chan&":SWEep:TYPE SEGment"
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' Having the VNA display the segment sweep table for the channel

scpi.Execute "DISPlay:WINDow1:TABLe SEGMent"

' Get the total number of segments

Dim numSegs

numSegs = CLng( scpi.Execute("SENSe"&chan&":SEGMent:COUNt?") )

' Read the segment listing

Dim segDataStr

segDataStr = scpi.Execute("SENSe"&chan&":SEGMent:LIST?")

Dim segData

segData = Split(segDataStr, ",")

' Get upper bound of the array of data values

' (lower bound of array resulting from VB 'Split' function is 0)

Dim segArrayUB

segArrayUB = UBound(segData)

Dim numDataElementsPerSeg

numDataElementsPerSeg = (segArrayUB + 1) / numSegs

WScript.Echo "Number of segments = " & numSegs

WScript.Echo "Number of data values per segment = " & numDataElementsPerSeg

Dim segInfStr

segInfStr = "Segment 1: state = " & CBool(segData(0))

segInfStr = segInfStr & ", num points = " & CLng(segData(1))

segInfStr = segInfStr & ", start freq = " & CDbl(segData(2))

segInfStr = segInfStr & ", stop freq = " & CDbl(segData(3))

segInfStr = segInfStr & ", IFBW = " & CDbl(segData(4))

segInfStr = segInfStr & ", dwell time = " & CDbl(segData(5))

' In case of a measurement receiver VNA like N5264B

' which has no source ports, "SOURce:CATalog?" will

' return an empty list
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Dim srcPortNames

srcPortNames = Split( scpi.Execute("SOURce"&chan&":CATalog?"), ",")

Dim srcPortNamesUB

srcPortNamesUB = UBound(srcPortNames)

' First source port name will be preceded by a quotation mark

' and the last name will be followed by one of those, so stripping

' those off now.

srcPortNames(0) = Right( srcPortNames(0), Len(srcPortNames(0)) - 1 )

srcPortNames(srcPortNamesUB) = Left( srcPortNames(srcPortNamesUB),
InStrRev(srcPortNames(srcPortNamesUB), Chr(34)) - 1 )

Dim firstPortIndex

firstPortIndex = 6

Dim lastPortIndex

lastPortIndex = numDataElementsPerSeg - 1

Dim j

For j = firstPortIndex To lastPortIndex

   segInfStr = segInfStr & ", " & srcPortNames(j - firstPortIndex) & " power = "
& CDbl(segData(j))

Next

WScript.Echo segInfStr

Example in Excel VBA with VISA-COM

Sub SampleSegmentSetup()
   '*** The variables of the resource manager and the instrument I/O are declared.
   Dim ioMgr As VisaComLib.ResourceManager
   Dim GPIB As VisaComLib.FormattedIO488
   '
   '    *** The memory area of the resource manager and the instrument I/O are
acquired.
   Set ioMgr = New VisaComLib.ResourceManager
   Set GPIB = New VisaComLib.FormattedIO488
   '*** Open the instrument.
   Set GPIB.IO = ioMgr.Open("GPIB0::16::INSTR")
   GPIB.IO.timeout = 10000

1787



   Dim Buf As String * 100
   Dim srcPortNames As Variant
   Dim numberOfSrcPorts As Integer
   Dim segData As Variant
   Const numSegs = 2
   Const Chan = 1
   Const addIFBW_PWR = 0
   ' In case of a measurement receiver VNA like N5264A
   ' which has no source ports, "SOURce:CATalog?" will
   ' return an empty list (just a pair of quotation marks)
   GPIB.WriteString "SOURce:CATalog?", True
   Buf = GPIB.ReadString
   srcPortNames = Split(Buf, ",")
   If Left(srcPortNames(0), 2) = Chr(34) & Chr(34) Then
       numberOfSrcPorts = 0
   Else
      numberOfSrcPorts = UBound(srcPortNames) + 1
   End If
   ' Building up a string consisting of the sweep segment data
   ' we want to set up.  This example will create two segments.
   ' Set state of first segment to be ON (1 = ON, 0 = OFF),
   ' 101 points, start freq of 10 MHz, stop freq of 1 GHz
   segData = "1,101,10E6,1E9"
   ' If you want to include one or more of: IFbandwidth, Dwell Time
   ' or Port Power, set Const addIFBW_PWR = 1
   
   If addIFBW_PWR = 1 Then
       GPIB.WriteString "SENSe" & Chan & ":SEGMent:BWIDth:CONTrol ON"
       GPIB.WriteString "SENSe" & Chan & ":SEGMent:SWEep:TIME:CONTrol ON"
       GPIB.WriteString "SENSe" & Chan & ":SEGMent:POWer:CONTrol ON"
       ' Turning off coupling allows power to vary per each port
       GPIB.WriteString "SOURce" & Chan & ":POWer:COUPle OFF"
       segData = AddOptionalSettings(segData, numberOfSrcPorts)
   End If
   
   ' Set state of second segment to be ON, 201 points,
   ' start freq of 1 GHz, stop freq of 3 GHz
   
   segData = segData & ",1,201,1E9,3E9"
   
   ' Uncomment this line below only if you uncommented the
   ' AddOptionalSettings line above for the first segment.
   'segData = AddOptionalSettings(segData, numberOfSrcPorts)
   ' Upload our segment list to the channel
   GPIB.WriteString "SENSe1:SEGMent:LIST SSTOP," & numSegs & "," & segData
   ' Set segment sweep type on Channel 1
   GPIB.WriteString "SENSe1:SWEep:TYPE SEGment"
   ' Having the PNA display the segment sweep table for the channel
   GPIB.WriteString "DISPlay:WINDow1:TABLe SEGMent"
   
   '*** End procedure
   GPIB.IO.Close
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End Sub
Function AddOptionalSettings(ByVal pStr As String, ByVal numSrcPorts As Integer) As
String
  Dim i
  
  ' Specifying 1 kHz IF bandwidth and Dwell Time of 0
  pStr = pStr & ", 1E3, 0"
  ' -10 dBm power for each of the source ports
  For i = 0 To numSrcPorts - 1
     pStr = pStr & ",-10"
  Next
  AddOptionalSettings = pStr
End Function
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Uploading a Source Power Cal using SCPI

Programming the VNA using COM or using SICL/VISA over LAN (as in this example) leaves the

VNA free to control GPIB devices as needed. This Visual Basic program demonstrates:

Uploading a source power calibration of Port 2 for Channel 1.

Reading the calibration data.

Learn more about Power Calibrations

Other SCPI Example Programs

To run this program, you need:

Your PC and VNA both connected to a LAN (if using VISA LAN server / client).

The SICL and VISA components of Keysight I/O Libraries software installed on your PC (both are included when
you install the software, unless you already have another vendor's VISA installed. Then specify Full SICL and
VISA installation to overwrite the other vendor's VISA.

The module visa32.bas added to your VB project.

A form with two buttons: cmdRun and cmdQuit.

A VISA interface configured on your remote PC to control the VNA. This could be GPIB interface or a VISA LAN
Client.

'Session to VISA Default Resource Manager
Private defRM As Long
'Session to VNA
Private viPNA As Long
'VISA function status return code
Private status As Long
Private Sub Form_Load()
defRM = 0
End Sub
Private Sub cmdRun_Click()

' String to receive data from the VNA.
' Dimensioned large enough to receive scalar comma-delimited values
' for 21 frequency points (20 ASCII characters per point)
Dim strReply As String * 420
Dim strPower As String, strCalPower As String
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Dim strStimulus, strCalValue
Dim strResult As String

' Open the VISA default resource manager
status = viOpenDefaultRM(defRM)
If (status < VI_SUCCESS) Then HandleVISAError

' Open a session (viPNA) to the VNA at "address 16" on the VISA
' interface configured as "GPIB0" on this PC.
status = viOpen(defRM, "GPIB0::16::INSTR", 0, 0, viPNA)
If (status < VI_SUCCESS) Then HandleVISAError

' Set the number of sweep points to 2 on Channel 1.
status = myGPIBWrite(viPNA, "SENS1:SWE:POIN 2")
If (status < VI_SUCCESS) Then HandleVISAError

' Ensure there's currently no source power cal on for this channel and port.
status = myGPIBWrite(viPNA, "SOUR1:POW2:CORR OFF")
If (status < VI_SUCCESS) Then HandleVISAError

' Specify if the cal power level is offset (positive value for a gain, negative
' value for a loss) from the VNA port power setting on the channel when no source
' power cal is active.  This is to account for components between the VNA test
' port and cal reference plane.  In this example, let's set up our calibration
' at the output of an amplifier with 15 dB gain.
status = myGPIBWrite(viPNA, "SOUR1:POW2:CORR:OFFS 15 DB")
If (status < VI_SUCCESS) Then HandleVISAError

' Prepare for doing data transfer in ASCII format.
status = myGPIBWrite(viPNA, "FORM:DATA ASCII")
If (status < VI_SUCCESS) Then HandleVISAError

' Send our source power correction data to the VNA.  For purpose of simplicity
' in this example, we'll set up for no correction (0) at our start stimulus and
' 0.5 dB at our stop stimulus (recall that our sweep currently has just 2 points).
status = myGPIBWrite(viPNA, "SOUR1:POW2:CORR:DATA 0,0.5")
If (status < VI_SUCCESS) Then HandleVISAError

' Set the number of sweep points to 21 on Channel 1.
status = myGPIBWrite(viPNA, "SENS1:SWE:POIN 21")
If (status < VI_SUCCESS) Then HandleVISAError

' Read the fixed power level for this port on Channel 1.
status = myGPIBWrite(viPNA, "SOUR1:POW2:LEV?")
If (status < VI_SUCCESS) Then HandleVISAError
status = myGPIBRead(viPNA, strReply)
If (status < VI_SUCCESS) Then HandleVISAError
strPower = strReply

' Turn the source power cal on.
status = myGPIBWrite(viPNA, "SOUR1:POW2:CORR ON")
If (status < VI_SUCCESS) Then HandleVISAError
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' Again read the fixed power level for this port on Channel 1
' (with our calibration turned on, this should now include the 15 dB offset
' we indicated our power amplifier provides).
status = myGPIBWrite(viPNA, "SOUR1:POW2:LEV?")
If (status < VI_SUCCESS) Then HandleVISAError
status = myGPIBRead(viPNA, strReply)
If (status < VI_SUCCESS) Then HandleVISAError
strCalPower = strReply

' Read the stimulus values from Channel 1.
status = myGPIBWrite(viPNA, "SENS1:X?")
If (status < VI_SUCCESS) Then HandleVISAError
status = myGPIBRead(viPNA, strReply)
If (status < VI_SUCCESS) Then HandleVISAError

' Tokenize the reply string into an array containing the values
strStimulus = Split(strReply, ",")

' Read back the source power correction data, now interpolated for 21 points
status = myGPIBWrite(viPNA, "SOUR1:POW2:CORR:DATA?")
If (status < VI_SUCCESS) Then HandleVISAError
status = myGPIBRead(viPNA, strReply)
If (status < VI_SUCCESS) Then HandleVISAError

' Tokenize the reply string into an array containing the values
strCalValue = Split(strReply, ",")

' Print the data using a message box (here, Chr returns the ASCII characters
' for Tab (9) and Linefeed (10)).
strResult = "PNA port power = " & Val(strPower) & Chr(10)
strResult = strResult & "Power at reference plane = " & Val(strCalPower) & Chr(10)
 Chr(10)
strResult = strResult & "Stimulus" & Chr(9) & Chr(9) & "Cal Value" & Chr(10)
For i = 0 To UBound(strStimulus)
 strResult = strResult & Val(strStimulus(i)) & Chr(9) & Val(strCalValue(i)) &
Chr(10)
Next
MsgBox strResult
End Sub
Private Sub cmdQuit_Click()

' Close the resource manager session (which also closes
' the session to the VNA).
If defRM <> 0 Then Call viClose(defRM)

' End the program
End
End Sub
Private Function myGPIBWrite(ByVal viHandle As Long, ByVal strOut As String) As Long

' The "+ Chr$(10)" appends an ASCII linefeed character to the
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' output, for terminating the write transaction.
myGPIBWrite = viVPrintf(viHandle, strOut + Chr$(10), 0)
End Function
Private Function myGPIBRead(ByVal viHandle As Long, strIn As String) As Long
myGPIBRead = viVScanf(viHandle, "%t", strIn)

' Remove trailing linefeed character
If Right(strIn, 1) = Chr(10) Then strIn = Left(strIn, Len(strIn) - 1)
End Function
Sub HandleVISAError()
Dim strVisaErr As String * 200
Call viStatusDesc(defRM, status, strVisaErr)
MsgBox "*** Error : " + strVisaErr, vbExclamation

' Close the resource manager session (which also closes
' the session to the VNA).
If defRM <> 0 Then Call viClose(defRM)
End
End Sub
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GPIB Fundamentals

The General Purpose Interface Bus (GPIB) is a system of hardware and software that allows you to

control test equipment to make measurements quickly and accurately. This topic contains the following

information:

The GPIB Hardware Components

The GPIB / SCPI Programming Elements

Specifications

GPIB Interface Capability Codes

Note: All of the topics related to programming assume that you already know how to program,

preferably using a language that can control instruments.

Other Topics about GPIB Concepts

The GPIB Hardware Components

The system bus and its associated interface operations are defined by the IEEE 488 standard. The

following sections list and describe the main pieces of hardware in a GPIB system:

Early VNA models had only ONE GPIB connector. These models could control other GPIB devices

using one of, or a combination of, the following methods:

Use the SCPI SYST:COMM:GPIB:RDEV: commands.

Use VISA or SICL over LAN to accomplish this. See an example.

Use USB / GPIB Interface

Note: Current VNA models have dedicated Controller and Talker/Listener GPIB ports. See how to
configure these ports.

Controllers

Controllers specify the instruments that will be the talker and listener in a data exchange. The controller

of the bus must have a GPIB interface card to communicate on the GPIB.
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The Active Controller is the computer or instrument that is currently controlling data exchanges.

The System Controller is the only computer or instrument that can take control and give up control of the
GPIB to another computer or instrument, which is then called the active controller.

Talker / Listener Instruments and GPIB Addresses

Talkers are instruments that can be addressed to send data to the controller.

Listeners are instruments that can be addressed to receive a command, and then respond to the command.
All devices on the bus are required to listen.

Every GPIB instrument must have its own unique address on the bus. The VNA address (default = 716)

consists of two parts:

The Interface select code (typically 7) indicates which GPIB port in the system controller is used to
communicate with the device.

1.

The primary address (16) is set at the factory. You can change the primary address of any device on the
bus to any number between 0 and 30. To change the analyzer address click System / Configure / SICL-
GPIB.

2.

A secondary address is sometimes used to allow access to individual modules in a modular instrument

system, such as a VXI mainframe. The VNA does NOT have a secondary address.

Cables

GPIB Cables are the physical link connecting all of the devices on the bus. There are eight data lines in

a GPIB cable that send data from one device to another. There are also eight control lines that manage

traffic on the data lines and control other interface operations.

You can connect instruments to the controller in any arrangement with the following limitations:

Do not connect more than 15 devices on any GPIB system. This number can be extended with the use of a
bus extension.

Do not exceed a total of 20 meters of total cable length or 2 meters per device, whichever is less.

Avoid stacking more than three connectors on the back panel of an instrument. This can cause unnecessary
strain on the rear-panel connector.

The GPIB / SCPI Programming Elements

The following software programming elements combine to become a GPIB program:
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GPIB / SCPI Commands

Programming Statements

Instrument Drivers

GPIB Commands

The GPIB command is the basic unit of communication in a GPIB system. The analyzer responds to

three types of GPIB commands:

1. IEEE 488.1 Bus-management Commands

These commands are used primarily to tell some or all of the devices on the bus to perform certain

interface operations.

All of the functions that can be accomplished with these commands can also be done with IEEE 488.2

or SCPI commands. Therefore, these commands are not documented in this Help system. For a

complete list of IEEE 488.1 commands refer to the IEEE 488 standard. Examples of IEEE 488.1

Commands

CLEAR - Clears the bus of any pending operations

LOCAL - Returns instruments to local operation

2. IEEE 488.2 Common Commands

These commands are sent to instruments to perform interface operations. An IEEE 488.2 common

command consists of a single mnemonic and is preceded by an asterisk ( * ). Some of the commands

have a query form which adds a "?" after the command. These commands ask the instrument for the

current setting. See a complete list of the Common Commands that are recognized by the analyzer.

Examples of IEEE 488.2 Common Commands

*OPC  - Operation Complete

*RST  - Reset

*OPT? - Queries the option configuration

3. SCPI Commands

The Standard Commands for Programmable Instruments (SCPI) is a set of commands developed in

1990. The standardization provided in SCPI commands helps ensure that programs written for a

particular SCPI instrument are easily adapted to work with a similar SCPI instrument. SCPI commands

tell instruments to do device specific functions. For example, SCPI commands could tell an instrument

to make a measurement and output data to a controller. Examples of SCPI Commands:

1796



CALCULATE:AVERAGE:STATE ON

SENSE:FREQUENCY:START?

For more information on SCPI:

The Rules and Syntax of SCPI Commands provides more detail of the SCPI command structure.

SCPI Command Tree is a complete list of the SCPI commands for the analyzer

Programming Statements

SCPI commands are included with the language specific I/O statements to form program statements.

The programming language determines the syntax of the programming statements. SCPI programs can

be written in a variety of programming languages such as VEE, HP BASIC, or C++. Example of a

Visual Basic statement:

GPIB.Write "SOURCE:FREQUENCY:FIXED 1000 MHz"

Note about examples

Instrument Drivers

Instrument drivers are subroutines that provide routine functionality and can be reused from program to

program. GPIB industry leaders have written standards for use by programmers who develop drivers.

When programmers write drivers that comply with the standards, the drivers can be used with

predictable results. To comply with the standard, each instrument driver must include documentation

describing its functionality and how it should be implemented.

GPIB Specifications

Interconnected devices - Up to 15 devices (maximum) on one contiguous bus.

Interconnection path - Star or linear (or mixed) bus network, up to 20 meters total transmission path

length or 2 meters per device, whichever is less.

Message transfer scheme - Byte-serial, bit-parallel, asynchronous data transfer using an interlocking

3-wire handshake.

Maximum data rate - 1 megabyte per second over limited distances, 250 to 500 kilobytes per second

typical maximum over a full transmission path. The devices on the bus determine the actual data rate.

Address capability - Primary addresses, 31 Talk and 31 Listen; secondary addresses, 961 Talk and 961

Listen. There can be a maximum of 1 Talker and up to 14 Listeners at a time on a single bus. See also

previous section on GPIB addresses.

GPIB Interface Capability Codes
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The IEEE 488.1 standard requires that all GPIB compatible instruments display their interface

capabilities on the rear panel using codes. The codes on the analyzer, and their related descriptions, are

listed below:

SH1 full source handshake capability

AH1 full acceptor handshake capability

T6 basic talker, serial poll, no talk only, unaddress if MLA (My Listen Address)

TEO no extended talker capability

L4 basic listener, no listen only, unaddress if MTA (My Talk Address)

LEO no extended listener capability

SR1 full service request capability

RL1 full remote / local capability

PPO no parallel poll capability

DC1 full device clear capability

DT1 full device trigger capability

C1 system controller capability

C2 send IFC (Interface Clear) and take charge controller capability

C3 send REN (Remote Enable) controller capability

C4 respond to SRQ (Service Request)

 

1798



The Rules and Syntax of SCPI

Most of the commands used for controlling instruments on the GPIB are SCPI commands. The

following sections will help you learn to use SCPI commands in your programs.

Branches on the Command Tree

Command and Query

Multiple Commands

Command Abbreviation

Bracketed (Optional) Keywords

Vertical Bars (Pipes)

MIN and MAX Parameters

Other Topics about GPIB Concepts

Branches on the Command Tree

All major functions on the analyzer are assigned keywords which are called ROOT commands. (See

GPIB Command Finder for a list of SCPI root commands). Under these root commands are branches

that contain one or more keywords. The branching continues until each analyzer function is assigned to

a branch. A root command and the branches below it is sometimes known as a subsystem.

For example, under SOURce:POWer are several branch commands.

Sometimes the same keyword, such as STATE, is used in several branches of the command tree. To
keep track of the current branch, the analyzer's command parser uses the following rules:

Power On and Reset - After power is cycled or after *RST, the current path is set to the root level
commands.

Message Terminators - A message terminator, such as a <NL> character, sets the current path to the root
command level. Many programming language output statements send message terminators automatically.
Message terminators are described in Sending Messages to the Analyzer.

Colon (:) - When a colon is between two command keywords, it moves the current path down one level in
the command tree. For example, the colon in :SOURCE:POWER specifies that POWER is one level below
SOURCE. When the colon is the first character of a command, it specifies that the following keyword is a root
level command. For example, the colon in :SOURCE specifies that source is a root level command.
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Note: You can omit the leading colon if the command is the first of a new program line. For example,

the following two commands are equivalent:
SOUR:POW:ATT:AUTO
:SOUR:POW:ATT:AUTO

<WSP> - Whitespace characters, such as <tab> and <space>, are generally ignored. There are two
important exceptions:

Whitespace inside a keyword, such as :CALC ULATE, is not allowed.

Most commands end with a parameter. You must use whitespace to separate these ending parameters
from commands. Always refer to the command documentation. In the following example, there is
whitespace between STATE and ON.

CALCULATE1:SMOOTHING:STATE ON

Comma (,) - If a command requires more than one parameter, you must separate adjacent parameters using
a comma. For example, the SYSTEM:TIME command requires three values to set the analyzer clock: one for
hours, one for minutes, and one for seconds. A message to set the clock to 8:45 AM would be
SYSTEM:TIME 8,45,0. Commas do not affect the current path.

Semicolon(;) - A semicolon separates two commands in the same message without changing the current
path. See Multiple Commands later in this topic.

IEEE 488.2 Common Commands - Common commands, such as *RST, are not part of any subsystem. An
instrument interprets them in the same way, regardless of the current path setting.

Command and Query

A SCPI command can be an Event command, Query command (a command that asks the analyzer for

information), or both. The following are descriptions and examples of each form of command. GPIB

Command Finder lists every SCPI command that is recognized by the analyzer, and its form.

Form Examples

Event commands - cause an action to occur inside the

analyzer.

:INITIATE:IMMEDIATE

Query commands - query only; there is no associated

analyzer state to set.

:SYSTem:ERRor?

Command and query - set or query an analyzer setting.

The query form appends a question mark (?) to the set

form

:FORMat:DATA ! Command
:FORMat:DATA? ! Query
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Multiple Commands

You can send multiple commands within a single program message. By separating the commands with

semicolons the current path does not change. The following examples show three methods to send two

commands:

Two program messages:1.

SOURCE:POWER:START 0DBM
SOURCE:POWER:STOP 10DBM

One long message. A colon follows the semicolon that separates the two commands causing the command
parser to reset to the root of the command tree. As a result, the next command is only valid if it includes the
entire keyword path from the root of the tree:

2.

SOURCE:POWER:START 0DBM;:SOURCE:POWER:STOP 10DBM

One short message. The command parser keeps track of the position in the command tree. Therefore, you
can simplify your program messages by including only the keyword at the same level in the command tree.

3.

SOURCE:POWER:START 0DBM;STOP 10DBM

Common Commands and SCPI Commands

You can send Common commands and SCPI commands together in the same message. (For more

information on these types of commands see GP-IB Fundamentals.) As in sending multiple SCPI

commands, you must separate them with a semicolon.

Example of Common command and SCPI commands together

*RST;SENSE:FREQUENCY:CENTER 5MHZ;SPAN 100KHZ

Command Abbreviation

Each command has a long form and an abbreviated short form. The syntax used in this Help system use

uppercase characters to identify the short form of a particular keyword. The remainder of the keyword

is lower case to complete the long form.

SOUR - Short form
SOURce - Long form

Either the complete short form or complete long form must be used for each keyword. However, the

keywords used to make a complete SCPI command can be a combination of short form and long form.
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The following is unacceptable - The first three keywords use neither short or long form.

SOURc:Powe:Atten:Auto on

The following is acceptable - All keywords are either short form or long form.

SOUR:POWer:ATT:AUTO on

In addition, the analyzer accepts lowercase and uppercase characters as equivalent as shown in the

following equivalent commands:

source:POW:att:auto ON
Source:Pow:Att:Auto on

Optional [Bracketed] Keywords

You can omit some keywords without changing the effect of the command. These optional, or default,

keywords are used in many subsystems and are identified by brackets in syntax diagrams.

Example of Optional Keywords

The HCOPy subsystem contains the optional keyword IMMediate at its first branching point. Both of

the following commands are equivalent:

"HCOPY:IMMEDIATE"
"HCOPY"
The syntax in this Help system looks like this:
HCOPy[:IMMediate]

Vertical Bars | Pipes

Vertical bars, or "pipes", can be read as "or". They are used in syntax diagrams to separate alternative

parameter options.

Example of Vertical Bars:

SOURce:POWer:ATTenuation:AUTO <on|off>

Either ON or OFF is a valid parameter option.

 MIN and MAX Parameters

The special form parameters "MINimum" and "MAXimum" can be used with commands that specify single frequency
(Hz) and time (seconds) as noted in the command documentation.  Note: Also with these commands, kHZ, MHz, and
GHz are accepted as suffixes/units.

The short form (min) and long form (minimum) of these two keywords are equivalent.
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MAXimum refers to the largest value that the function can currently be set to

MINimum refers to the smallest value that the function can currently be set to.

For example, the following command sets the start frequency to the smallest value that is currently

possible:

SENS:FREQ:START MIN

In addition, the max and min values can also be queried for these commands.

For example, the following command returns the smallest value that Start Frequency can currently be

set to:

SENS:FREQ:START? MIN

An error will be returned if a numeric parameter is sent that exceeds the MAX and MIN values.

For example, the following command will return an "Out of range" error message.

SENS:FREQ:START 1khz
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Configure for GPIB, SCPI, and SICL

The following settings are used to configure the analyzer for remote control using SCPI commands.

How to Configure for SICL / GPIB Operation

Using Hardkey/SoftTab/Softkey Using a mouse

Press System > System Setup > Remote Interface....1. Click Utility1.

Select System2.

Select System Setup3.

Select Remote Interface...4.

 

SICL / GPIB dialog box help

 

HiSLIP

HiSLIP is available ONLY when the soft front panel has already been launched.

When checked, the PXI VNA will also advertise itself using port TCPIP port 4880. You must

configure your firewall to enable communication through this port. You can connect to the

module and send SCPI commands by using the VISA address:

TCPIP0::<PXI controller name >::hislip0::INSTR.  ("hislip" is case-sensitive)
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For example, if your PXI controller is named: myPXI, then the TCPIP connection string would

be:

TCPIP0::myPXI::hislip0::INSTR

When configuring an embedded controller, or when configuring an external computer that is

connected using a PXIe cable, then replace <PXI controller name> with "Localhost". For

example:

TCPIP0::Localhost::hislip0::INSTR

SCPI Monitor / Input

Show SCPI Parser Console  Launches a window that is used to send single SCPI/GPIB

commands from the analyzer keyboard.

Note: Press Control+Z , then enter, to close the console window.

Note: The Status Register system can NOT be used from the GPIB Console.

Type a valid command, with appropriate arguments and press enter.

Use the arrow keys to recall previous commands.

The console window may launch behind the analyzer application. Press Control+Tab to

bring the console window to the top.

Local and Remote Operation

The analyzer LCL and  RMT (Local and Remote) operation labels appear in the lower right corner of

the status bar.

Note: The status bar is NOT visible when the analyzer is preset. See how to make the status bar visible.

LCL appears when NOT under SCPI control

RMT appears when under SCPI control. The RMT label does NOT appear when under COM control. Remote
operation disables the front panel keys except for the Macro/Local key.

To return to Local (front panel) operation, press the Macro / Local key

Sending the GPIB "GTL" (go to local) command also returns the analyzer to Local operation.

Sending the GPIB "LLO" (local lockout) command disables the front panel Local button.

1805



Getting Data from the Analyzer

Data is sent from the analyzer in response to program queries. Data can be short response messages,

such as analyzer settings, or large blocks of measurement data. This topic discusses how to read query

responses and measurement data from the analyzer in the most efficient manner.

Response Message Syntax

Clearing the Output Queue

Response Data Types

Transferring Measurement Data

Note: Some PCs use a modification of the IEEE floating point formats with the byte order reversed. To

reverse the byte order for data transfer into a PC, use the FORMat:BORDer command.

Other Topics about GPIB Concepts

Response Message Syntax

Responses sent from the analyzer contain data, appropriate punctuation, and message terminators.

<NL><^END> is always sent as a response message terminator. Most programming languages handle

these terminators transparent to the programmer.

Response messages use commas and semicolons as separators in the following situations:

a comma separates response data items when a single query command returns multiple values

FORM:DATA? 'Query
ASC, +0 'Analyzer Response

a semicolon separates response data when multiple queries are sent within the same messages

SENS:FREQ:STAR?;STOP? --Example Query

+1.23000000000E+008; +7.89000000000E+008<NL><^END> 'Analyzer Response

Clearing the Output Queue

After receiving a query, the analyzer places the response message in its output queue. Your program
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should read the response immediately after the query is sent. This ensures that the response is not

cleared before it is read. The response is cleared when one of the following conditions occur:

When the query is not properly terminated with an ASCII carriage return character or the GPIB <^END>
message.

When a second program query is sent.

When a program message is sent that exceeds the length of the input queue

When a response message generates more response data than fits in the output queue.

When the analyzer is switched ON.

Response Data Types

The analyzer sends different response data types depending on the parameter being queried. You need

to know the type of data that will be returned so that you can declare the appropriate type of variable to

accept the data. For more information on declaring variables see your programming language manual.

The GPIB Command Finder lists every GPIB command and the return format of data in response to a

query. The analyzer returns the following types of data:

Numeric Data

Character Data

String Data

Block Data

Numeric Data

All numeric data sent over the GPIB is ASCII character data. Your programming environment may

convert the character data to numeric data for you. Boolean data (1 | 0 ) is a type of numeric data.

Character Data

Character data consists of ASCII characters grouped together in mnemonics that represent specific

analyzer settings. The analyzer always returns the short form of the mnemonic in upper-case alpha

characters. Character data looks like string data. Therefore, refer to the GPIB Command Finder to

determine the return format for every command that can be queried.

Example of Character Data

MLOG

String Data
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String data consists of ASCII characters. String parameters can contain virtually any set of ASCII

characters. When sending string data to the analyzer, the string must begin with a single quote ( ' ) or a

double quote ( " ) and end with the same character (called the delimiter).

Note: The analyzer responds best to all special characters if the string is enclosed in single quotes. If

quotes are not used, the analyzer will convert the text to uppercase. The analyzer may not respond as

you expect.

The analyzer always encloses data in double quotes when it returns string data.

Example of String Data

GPIB.Write "DISP:WINDow:TITLe:DATA?"

“This is string response data.”

Block Data

Block data is used to transfer measurement data. Although the analyzer will accept either definite

length blocks or indefinite length blocks, it always returns definite length block data in response to

queries unless the specified format is ASCII. The following graphic shows the syntax for definite block

data:

<num_digits> specifies how many digits are contained in <byte_count>

<byte_count> specifies how many data bytes will follow in <data bytes>

Example of Definite Block Data

#210ABCDE+WXYZ<nl><end>

Where:

# - always sent before definite block data

2 - specifies that the byte count is two digits (2)

10 - specifies the number of data bytes that will follow, not counting <NL><END>

ABCDE+WXYZ - 10 digits of data
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<NL><END> - always sent at the end of block data

Transferring Measurement Data

Measurement data is blocks of numbers that result from an analyzer measurement. Measurement data is

available from various processing arrays within the analyzer. For more information on the analyzer's

data processing flow, see Accessing Data Map. Regardless of which measurement array is read,

transferring measurement data is done the same.

See an example.

When transferring measurement data, the FORMat:DATA command allows you to choose from the

following two data types:

REAL

ASCII

The following graphic shows the differences in transfer times between the two:

REAL Data

REAL data (also called floating-point data) types transfer faster. This is because REAL data is binary
and takes about half the space of ASCII data. The disadvantage of using REAL data is that it requires a

header that must be read. See definite length block data. The binary floating-point formats are defined in
the IEEE 754-1985 standard. The following choices are available in REAL format:

REAL,32 - IEEE 32-bit format - single precision (not supported by HP BASIC)

REAL,64 - IEEE 64-bit format - double precision

ASCII Data

The easiest and slowest way to transfer measurement data is to use ASCII data. ASCII data is sent if the

data contains both numbers and characters (the setting of FORMat:DATA is ignored). ASCII data is
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separated by commas.
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Synchronizing the VNA and Controller

Synchronizing the VNA (Vector Network Analyzer) and Controller means to keep VNA and the

controller working at approximately the same pace. In this topic:

The Problem and the Solution

VNA Queues

Synchronization Methods

When To Synchronize the Analyzer and Controller

Completion of a Measurement

Measurements with External Trigger

Averaged Measurements

During Calibration Acquire

See Also

Synchronize an External PSG Source

Triggering the VNA using SCPI

The Problem

The controller sends commands to the VNA as fast as the bus will allow. The VNA stores these

commands in the VNA Input queue. However, the VNA executes those commands at a slower rate than

they are accepted. If left unchecked, the VNA input buffer will contain a long list of commands waiting

to be executed.

At some point, the controller will send a query command which requires a response from the VNA.
The controller will not send more commands until a response is received. It will wait for a response

from the VNA for the amount of time set by the Timeout setting. If the VNA is working off a long list
of commands in the input buffer, if may not execute and respond to the query command until the

controller has quit waiting, or "timed out".

The Solution

The easiest way to keep the controller and the VNA "synched" is to send query commands often. This
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stops the controller from sending more commands until the VNA executes and responds to the query.

This limits the number of commands that are waiting in the VNA input queue to be processed.

Although any query will stop the controller from sending more commands, a good practice is to send

 *OPC? Most of the time, as soon as this query is executed, the VNA will immediately reply. The

exception to this is the Overlapped command.

Sequential commands are executed quickly and in the order in which they are received.

Overlapped (also known as Asynchronous) commands take longer to execute. Therefore, they allow the
VNA to execute other commands while waiting. However, the programmer may want to prevent the analyzer
from processing new commands until the overlapped command has completed. If the VNA is executing an
overlapped command when a *OPC? is received, it will wait until the overlapped command is complete
before processing new commands.

Note: The analyzer has two overlapped commands:

INITitate:IMMediate

SENSe:SWEep:MODE GROUPS (when INIT:CONT is ON)

Several calibration commands have an optional ASYNcronous argument which allows them to

behave like overlapped commands. Learn more.

Analyzer Queues

Queues are memory buffers that store messages until they can be processed. The analyzer has the

following queues:

Input Queue

Output Queue

Error Queue

Input Queue

The controller sends statements to the analyzer without regard to the amount of time required to

execute the statements. The input queue is very large (31k bytes). It temporarily stores commands and

queries from the controller until they are read by the analyzer's command parser. The input queue is

cleared when the analyzer is switched ON.

Output Queue

When the analyzer parses a query, the response is placed in the output queue until the controller reads
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it. Your program should immediately read the response or it may be cleared from the output queue. The

following conditions will clear a query response:

When a second query is sent before reading the response to the first. This does not apply when multiple
queries are sent in the same statement.

When a program statement is sent that exceeds the length of the input queue.

When a response statement generates more data than fits in the output queue.

When the analyzer is switched ON.

Error Queue

Each time the analyzer detects an error, it places a message in the error queue. When the

SYSTEM:ERROR? query is sent, one message is moved from the error queue to the output queue so it

can be read by the controller. Error messages are delivered to the output queue in the order they were

received. The error queue is cleared when any of the following conditions occur:

When the analyzer is switched ON.

When the *CLS command is sent to the analyzer.

When all of the errors are read.

If the error queue overflows, the last error is replaced with a "Queue Overflow" error. The oldest

errors remain in the queue and the most recent error is discarded.

Synchronization Methods

The following common commands are used to synchronize the analyzer and controller. Examples are

included that illustrate the use of each command in a program. See the SCPI command details to
determine if a command is an overlapped command.

*WAI

*OPC?

*OPC

*WAI

The *WAI command:
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Stops the analyzer from processing subsequent commands until all overlapped commands are completed.

It does NOT stop the controller from sending commands to this and other devices on the bus. This is the
easiest method of synchronization.

Example of the *WAI command

"ABORT;:INITIATE:IMMEDIATE" 'Restart the measurement.
"CALCULATE:MARKER:SEARCH:MAXIMUM" 'Search for max amplitude.
"CALCULATE:MARKER:X?" 'Which frequency?

The following time line shows how the processing times of the three commands relate to each other:

INITIATE:IMMEDIATE is an overlapped command. It allows the immediate processing of the

sequential command, CALCULATE:MARKER:SEARCH:MAXIMUM. However, the
INITIATE:IMMEDIATE is not considered complete until the measurement is complete. Therefore,

the marker searches for maximum amplitude before the measurement completes. The
CALCULATE:MARKER:X? query could return an inaccurate value.

To solve the problem, insert a *WAI command.

"ABORT;:INITIATE:IMMEDIATE" 'Restart the measurement.
"*WAI" 'Wait until complete.
"CALCULATE:MARKER:MAXIMUM" 'Search for max amplitude.
"CALCULATE:MARKER:X?" 'Which frequency

The time line now looks like this:

The *WAI command keeps the MARKER:SEARCH:MAXIMUM from taking place until the

measurement is completed. The CALCULATE:MARKER:X? query returns the correct value.
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Note: Although *WAI stops the analyzer from processing subsequent commands, it does not stop the

controller. The controller could send commands to other devices on the bus.

*OPC?

The *OPC? query stops the controller until all pending commands are completed.

In the following example, the Read statement following the *OPC? query will not complete until the

analyzer responds, which will not happen until all pending commands have finished. Therefore, the

analyzer and other devices receive no subsequent commands. A "1" is placed in the analyzer output

queue when the analyzer completes processing an overlapped command. The "1" in the output queue

satisfies the Read command and the program continues.

Example of the *OPC? query

This program determines which frequency contains the maximum amplitude.

"ABORT; :INITIATE:IMMEDIATE"! Restart the measurement
"*OPC?" 'Wait until complete
Meas_done = GPIB.Read 'Read output queue, throw away result
"CALCULATE:MARKER:MAX" 'Search for max amplitude
"CALCULATE:MARKER:X?" 'Which frequency?
Marker_x = GPIB.Read
PRINT "MARKER at " & Marker_x & " Hz"

*OPC

The *OPC command allows the analyzer and the controller to process commands while processing the

overlapped command.

When the analyzer completes processing an overlapped command, the *OPC command sets bit 0 of the

standard event register to 1 . This requires polling of status bytes or use of the service request (SRQ)

capabilities of your controller. See Reading the Analyzer's Status Registers for more information about the

standard event status register, generating SRQs, and handling interrupts.

Note: Be careful when sending commands to the analyzer between the time you send *OPC and the

time you receive the interrupt. Some commands could jeopardize the integrity of your measurement. It

also could affect how the instrument responds to the previously sent *OPC.

Example of polled bit and SRQ processes.

When To Synchronize the Analyzer and Controller

The need to synchronize depends upon the situation in which the overlapped command is executed.
The following section describes situations when synchronization is required to ensure a successful

operation.
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Completion of a Measurement

Measurements with External Trigger

Averaged Measurements

Completion of a Measurement

To synchronize the analyzer and controller to the completion of a measurement, use the

ABORT;INITIATE:IMMEDIATE command sequence to initiate the measurement.

This command sequence forces data collection to start (or restart) under the current measurement

configuration. A restart sequence, such as ABORT;INITIATE:IMMEDIATE is an overlapped

command. It is complete when all operations initiated by that restart command sequence, including the

measurement, are finished. The *WAI,*OPC? and *OPC commands allow you to determine when a

measurement is complete. This ensures that valid measurement data is available for further processing.

Measurements with External Trigger

See Triggering the VNA using SCPI.

External Triggering

Averaged Measurements

Averaged measurements are complete when the average count is reached. The average count is reached

when the specified number of individual measurements is combined into one averaged measurement

result. Use synchronization to determine when the average count has been reached.

If the analyzer continues to measure and average the results after the average count is reached, use

synchronization to determine when each subsequent measurement is complete.

During Calibration Acquire

During a calibration with slow sweep speeds, such as when using a narrow IF bandwidth, you may

want to have your program perform other operations, such as checking for the click event of a Cancel

button.

To do this, use the optional ASYNchronous argument with the ACQuire command as shown in several

calibration example programs. The VNA parser returns immediately while the cal step measurement

proceeds. It does NOT block commands and wait for the measurement step to finish. You can send

*ESR? or *STB? queries to monitor the status register bytes to see when the OPC (operation complete)

bit gets set, which indicates the cal measurement step has finished. Learn more about status registers.

Note: Do NOT issue the *OPC? command when using the ASYN argument. If your program is using
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the ScpiStringParser, then you can ONLY use *OPC? to detect when the OPC bit is set, so do NOT use

the ASYN argument with the calibration commands when using that parser.

When using the ASYN argument, set the timeout value in the IO settings to at least 5 seconds. There

are intervals during the cal acquires when the VNA takes a several seconds to respond to additional

commands, such as  when the processor is calculating error terms.

The following commands have this argument:

Command Example

SENS:CORR:COLL:GUID:ACQuire (Guided Cal) Guided 2-Port or 4-Port Cal

SENS:CORR:COLL:ACQuire (Unguided Cal) Perform Unguided ECAL

SOUR:POW:CORR:COLL:ACQuire (Source Power Cal) Perform a Source and Receiver Power

Cal (shows polling loop)

In addition, the SENS:CORR:COLL:GUIDed:INITialize command has this optional argument for long

calibration initialization, such as a CalAll calibration.
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Calibrating the Analyzer Using SCPI

There are several ways to calibrate the analyzer using SCPI depending on your measurement needs. As

from the Cal Wizard, you can perform a Guided Cal, Unguided Cal, or ECal. This topic explains the

differences in these calibration choices when using SCPI commands.

Guided Calibrations

ECal

Creating Cal Sets

Applying Cal Sets and Cal Types

Uploading Error Terms

Unguided Cals and Calibration Classes

Note: ALWAYS send ALL measurement setup commands BEFORE initializing a remote calibration.

See Also

Synchronizing the Analyzer and Controller (During a calibration)

See SCPI Calibration Examples

Guided Calibrations

Guided versus Unguided is the style of calibration that is selected on the first page of the Calibration
Wizard. A remote 'guided' cal does not present the cal wizard, but prompts for specific standards to be

connected. In a remote 'Unguided', the steps must be 'hard-coded'.

To perform a Guided Calibration, use ONLY Sens:Corr:Coll:Guided commands.

These commands calibrate the ACTIVE channel. Activate a channel by selecting a measurement on the
channel to be calibrated using Calc:Par:Select.

Full 1,2,3,4-port SOLT and TRL calibrations - No response cals.

All of the advanced calibration features (Thru method, specify DUT connectors and Cal kits for each port,
port pairings).

A Cal Set is applied to the channel and saved at the completion of a guided cal according to the preference
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setting SENS:CORR:PREF:CSET:SAVE

Note: To perform an Unguided Calibration, use ONLY the Sens:Corr commands (NOT Guided).

ECal

From the Cal Wizard or from a SCPI program, ECal is fast, accurate, and very repeatable. Unlike from

the Cal Wizard, you can use SCPI to perform ECal using either the Guided or Unguided commands.

The Unguided commands are easiest to use. However, the following situations require that you use the

Guided commands.

To maximize accuracy, all ECal calibrations on the analyzer perform an Unknown Thru measurement of the
ECal module Thru state IF the analyzer model being used has 1 reference receiver per port. If your analyzer
does NOT have 1 reference receiver per port, use Guided ECal commands and specify a Thru method.

If your ECal module connectors do NOT match the DUT connectors, and you choose not to perform a User
Characterization, use Guided ECal commands and specify the Thru method.

ECAL Notes:

When using either Guided or Unguided ECal commands under low power situations, use the Orientation
settings. The Guided example shows the use of these commands. When using Unguided, they must appear
before the Acquire command.

The frequency range of the measurement must be within the range of the ECal module. Otherwise, the
calibration will fail.

You do NOT have to send the ECal module state 'switch' commands. The ECal algorithm switches ECal
states automatically.

All of these ECal choices are listed in the Programming Command Finder function in this Help file.

See Using ECal to learn about all of the ECal features.

Creating Cal Sets

There are several ways to store guided cal data into a unique Cal Set. The following is probably the

easiest. It does not require the name of an existing Cal Set and it allows you to name the Cal Set.
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SENS:CORR:COLL:GUID:INIT  'start the cal with no cal set argument

'Perform the cal

SENS:CORR:COLL:GUID:SAVE 'create cal set with auto-generated name or to cal
register

SENS:CORR:CSET:NAME 'MyCalSet'  'name the current cal set.

Applying Cal Sets and Cal Types

A Cal Set is applied to the channel and saved at the completion of a guided cal according to the

preference setting SENS:CORR:PREF:CSET:SAVE.

When you select a Cal Set to apply to an uncalibrated channel, the analyzer attempts to find the most

comprehensive calibration type in the Cal Set and turn it ON. In addition, changing a measurement

parameter (for example, from S11 to S21) will also initiate an attempt to apply the best Cal Type and

turn correction ON.

There may be times when you do not want the most comprehensive Cal Type. For example, say there is

a Full 2-port Cal Set applied, but there is only an S11 measurement displayed. If measurement speed is

a concern, you can apply a Full 1-Port Cal Type from that same Cal Set and save time by not doing the

extra background sweeps. Learn more about background sweeps.

If you change the measurement parameter, the analyzer will reapply the Full 2-Port Cal Type.

See the SCPI and COM commands for Cal Sets and Cal Types.

Uploading Error Terms

Note: There was a method described here for WinCal 3.x that involved a preference setting. That method

is no longer supported.

To upload error terms into a created or selected Cal Set:

SENS:CORR:CSET:CREAte or SENS:CORR:CSET:GUID
SENS:CORR:CSET:Data <term> <port> <port> <data>
SENS:CORR:CSET:SAVE

This method puts error terms into a Cal Set, outside of a Guided or Unguided calibration session.

The Cal Set can then be applied at any time.

See SENS:CORR:CSET commands.
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Unguided Cals and Calibration Classes

Use Sens:Correction commands.

1-port, 2-port, Response.

Can select 2 sets of standards.

TRL is NOT recommended.

The following describes how to perform an unguided calibration using SCPI. The objective here is to

make clear the relationship between the physical port on which a standard is being measured, the actual

device in the cal kit, and the SCPI command used to acquire the device.

Calibration standards classes are ‘categories’ of standard types.  To perform a 2 port calibration, the cal

wizard requires the following types of standards to be measured:

3 reflection standards on the forward port:

Class S11A typically an open

Class S11B typically a short

Class S11C typically a load

Likewise, 3 reflection standards are required for the reverse port:

Class S22A typically an open

Class S22B typically a short

Class S22C typically a load

There is also a transmission standard that is measured in both directions:

Class S21T typically a thru

The following illustrates the relationship between cal kit physical standards and calibration classes.

Here is a list of the physical devices in my calibration kit.

Standard #1 = "3.5 mm male short"

Standard #2 = "3.5 mm male open"

Standard #3 = "3.5 mm male broadband load"
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Standard #4 = "Insertable thru standard"

Standard #5 = "3.5 mm male sliding load"

Standard #6 = "3.5 mm male lowband load"

Standard #7 = "3.5 mm female short"

Standard #8 = "female to female characterized  thru adapter"

Standard #9 = "0-2 Load"

Standard #10 = "Open"

Standard #11 = "Non-insertable thru"

Standard #12 = "3.5 mm female lowband load"

Standard #13 = "3.5 mm female sliding load"

Standard #14 = "3.5 mm female broadband load"

Standard #15 = "3.5 mm female open"

When you perform a calibration remotely using SCPI, you don’t specify the device number directly.

 Rather, you specify the class you want to measure.  Each device in the calibration kit is assigned to a

class.  And since more than one device can be assigned to the same class, each class contains an

ordered list of devices. The class assignments are set using the Advanced Modify Cal Kit dialog or the

SCPI command:

SENS:CORR:COLL:CKIT:ORDer<class>, <std>, <std>, <std>, <std>,<std>,<std>,<std>

The 85052B kit used in the example program has the following standard list for each class:  The list

was obtained by issuing the corresponding SCPI query:

SENS:CORR:COLL:CKIT:OLIST1?   S11A = +2,+15,+0,+0,+0,+0,+0

SENS:CORR:COLL:CKIT:OLIST2?   S11B = +1,+7,+0,+0,+0,+0,+0

SENS:CORR:COLL:CKIT:OLIST3?   S11C = +6,+5,+3,+12,+13,+14,+0

SENS:CORR:COLL:CKIT:OLIST4?   S21T = +4,+8,+0,+0,+0,+0,+0

SENS:CORR:COLL:CKIT:OLIST5?   S22A = +2,+15,+0,+0,+0,+0,+0

SENS:CORR:COLL:CKIT:OLIST6?   S22B = +1,+7,+0,+0,+0,+0,+0
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SENS:CORR:COLL:CKIT:OLIST7?   S22C = +6,+5,+3,+12,+13,+14,+0

SENS:CORR:COLL:CKIT:OLIST8?   S12T = +4,+8,+0,+0,+0,+0,+0

When you perform the calibration, you acquire data by issuing the ACQuire command:

SENS:CORR:COLL:ACQ <class>[, <subst> ]

For example:

SENS:CORR:COLL:SFOR 1

SENS:CORR:COLL:ACQ STANA, SST2

The SFOR command tells the wizard to make the next acquisition in the forward direction.  The

ACQuire command specifies that we are measuring the 2nd device in the list for STANA.  And since

we are measuring SFORward, then STANA refers to class #1 or S11A.  The list of devices for this

class are specified in the OLIST1 query above.

Alternately, you could modify the device order for the S11A class to move device #15 into the first

position (SENS:CORR:COLL:CKIT:ORDER1).  When the desired device is in the first position, you

need not specify the order number in the ACQuire command.  The default is the first device in the

OLIST.  This works well for two port network analyzers where the order for S11A,B,C classes is set up

for port 1 and the order for S22A,B,C is set up for port 2.  With the kit set up in the proper order, you

eliminate the need to specify the substandard number (SST<n>).

See an example: Perform an Unguided 2-port Cal on a 4-port analyzer.
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Reading the Analyzer's Status Register

The VNA has several status registers that your program can read to know when specific events occur.

There are two methods of reading the status registers in the analyzer: the Polled Bit method and the

Service Request method.

The Status Registers

Setting and Reading Bits in Status Registers

Polled Bit Method

Service Request Method

See Also

IEE 482 Common commands

Example: Status Reporting

Status Commands

Other Topics about GPIB Concepts

Important Notes:

A new Limit Line Fail command that makes it easy to determine if Limit Line testing has failed.

*OPC? can be used to easily determine when a channel has completed a sweep. This requires no interaction
with the Status Register system. Most VNA programming examples use *OPC?.

Most of the Status Register system can NOT be used with the SCPIStringParser Object. However, *OPC?
can be used.

The Status Registers

Most of the status registers in the analyzer have sixteen bits. For simplicity, this topic will illustrate

their use with 8-bit registers. Bits in registers represent the status of different conditions inside of the

analyzer. In the following graphic, a register is represented by a row of boxes; each box represents a bit.

Bit 3 is ON.
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Each VNA Status Register is actually comprised of the following registers. See an image of the VNA
Status registers.

Enable Registers - When using the SRQ method of polling, you first set bits in the enable register which
tells the VNA which events to monitor.  This is not necessary using the Polled Bit method, as you can only
monitor a single event.  A *CLS (clear status) command will not clear the enable register.   The *ESE and
*ESE? commands are used to set and query Enable bits, while *ESR is used to read and clear an Enable
register.  Learn how to set bits.

Condition Registers - A condition register continuously monitors events in the VNA. Bits in the condition
register change real time as conditions occur. These bits are not latched, so this register is used mainly for
diagnostic purposes. The registers that only summarize lower level registers do NOT have a condition
register.

Event Registers - This is the register that is read to determine if an event has occurred. An event register
latches the bits from the corresponding condition register. When an event register bit is set, subsequent
changes to the corresponding condition register bit are ignored. The bit remains set until a query command
such as *CLS clears the bit.  Learn how to read the Event Register.

Positive and Negative Transition Registers  -  Transition registers control what type of condition register
will set the corresponding bit in the event register.

Positive transitions (0 to 1) are only reported to the event register if the corresponding positive
transition bit is set to 1.

Negative transitions (1 to 0) are only reported to the event register if the corresponding negative
transition bit is set to 1.

Setting both transition bits to 1 causes both positive and negative transitions to be reported.

Transition registers are read-write and are unaffected by *CLS (clear status) or queries. They are

reset to their default settings at power-up and after *RST and SYSTem:PRESet commands. The

following are the default settings for the transition registers:

All Positive Transition registers = 1

All Negative Transition registers = 0

This means that, by default, the analyzer will latch all event registers on the negative to positive

transition (0 to 1).

The following is an example of why you would set transition registers:

A critical measurement requires that you average 10 measurements and then restart averaging.

You decide to poll the averaging bit. When averaging is complete, the bit makes a positive

transition. After restart, you poll the bit to ensure that it is set back from 1 to 0, a negative
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transition. You set the negative transition bit for the averaging register.

Setting and Reading Bits in Status Registers

Both the Polled-Bit method and Service Request method require that you set and read status register

bits.  Most of the VNA status registers contain 16 bits, numbered 0 to 15. Each bit has a weighted

value. The following example shows how to set the bits in a 8-bit status register.

8-bit register

Bit 0 1 2 3 4 5 6 7

Weight 1 2 4 8 16 32 64 128

 

How to set bits 4 and 5 in the Standard Event Status Enable register:

Step Example

1. Determine the weighted bit value for these

bits

weights 16 and 32 (respectively)

2. Add these values together 16 + 32 = 48

3. Send this number as an argument in the

appropriate command. (see Status Commands)

STAT:QUES:LIMIT1:ENAB 48

The Polled Bit Method

With the Polled Bit Method, your program monitors a bit in the status register that represents the

condition of interest to you. When the VNA sets the bit to 1, your program sees it and responds

accordingly.

If your program periodically monitors a bit in the status register, it is free to do other things as well.
However, your program can respond only as fast as the bit is polled.

If your program continually monitors a bit, it can respond immediately, but will be unavailable to do anything
other than poll the bit.

Advantage: This method requires very little programming.

Procedure:

Decide which condition to monitor. The Status Commands topic lists all of the possible conditions that can be
monitored in the analyzer.

1.

Determine the command to be used to monitor the bit.2.

3.

4.
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2.

Determine how often to poll the bit until it is set.3.

Construct the routine to respond when the bit is set.4.

The Service Request (SRQ) Method

Your program enables the bits in the status registers representing the condition of interest. When the

condition occurs, the VNA actively interrupts your program from whatever it is doing, and an event

handler in your program responds accordingly. Do this method if you have several conditions you want

to monitor or the conditions are such that it is not practical to wait for the condition to occur.

Advantage: This method frees your program to do other things until the condition occurs. The program

is interrupted to respond to the condition.

Disadvantage: This method can require extensive programming depending on the number and type of

conditions that you want to monitor.

Procedure:

1. Decide which conditions to monitor. The Status Commands topic lists all of the possible analyzer

conditions that can be monitored.

2. Set the enable bits in the summary registers and the status byte register.

Enabling is like making power available to a light. Without power available, the switch can be

activated, but the light won't turn ON. In the analyzer, without first enabling a bit, the condition may

occur, but the controller won't see it unless it is enabled.

The condition, and the bit in the summary registers in the reporting path, must be enabled. This is like

streams (conditions) flowing into rivers (summary registers), and rivers flowing into the ocean

(controller). See the diagram of status registers in Status Commands.

Bit 6 of the status byte register is the only bit that can interrupt the controller. When any representative

bit in the status byte register goes ON, bit 6 is automatically switched ON.

3. Enable your program to interrupt the controller. This is done several ways depending on the
programming language and GPIB interface card you use. An example program is provided showing how

this is done with in Visual Basic with a National Instruments GPIB card.

4. Construct a subroutine to handle the interrupt event. If you are monitoring more than one condition

in your system, your event handler must determine which condition caused the interrupt. Use the *SPE

command to determine the instrument that caused the interrupt, then poll the summary registers, then

poll condition registers to determine the cause of the interrupt.
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Referring to Traces, Measurements, Channels, and Windows Using SCPI

Sometimes in a SCPI program you may need to refer to traces that you have not created. This can be a

bit confusing in the VNA. Here are the THREE ways to refer to a specific measurement trace.

Note: The terms "Trace" and "Measurement" effectively mean the same thing in this discussion.

The Measurement Name is picked by you when you first create a trace using the
CALCulate<cnum>:PARameter[:DEFine]:EXTended <Mname>,<param> command. The measurement name
is only used by SCPI.

1.

The Trace Number is also picked by you when ‘feeding’ a newly-created measurement name to a window
number using DISP:WINDow<wmun>:TRACe<tnum>:FEED. The trace number is used ONLY by SCPI and is
mainly used to refer to traces in the DISPlay node. This is NOT the number that appears as Tr# on the
screen. While you can assign any Trace number you want, when a measurement is created from the GUI,
the VNA assigns numbers to the traces sequentially, starting with one in each window. Therefore, when there
is more than one window, these numbers are not unique.

2.

The Tr# that appears on the VNA screen is the third and most visible way to refer to a trace. Since we
already have a "Trace Number", we call this the Measurement Number in the VNA Help file. This number is
issued sequentially by the VNA regardless of channel and window. It is therefore unique among all traces.
Use CALC<ch>:PAR:MNUM? just after the trace is created to read the measurement number.

3.

The concept of the Active measurement versus Selected Measurement is also a bit confusing. As

seen on the screen, the Active measurement has the highlighted Tr# . While there can only be ONE

active measurement, every channel has a selected measurement. The target measurement must first be

selected before most CALC node settings can be made. There are two ways to select a measurement for

each channel:

Use CALC<ch>:PAR:SEL <measName> which requires the channel number and measurement name.1.

Use CALC<ch>:PAR:MNUM <measNum> which requires the channel and measurement (Tr) number.2.

Here are other relevant commands for referring to traces, measurements, channels, and windows:

CALC<cnum>:PAR:CATalog:EXTended? - Catalog the Measurement Names for the specified channel.

CALC<cnum>:PAR:TNUMber? - Returns the Trace Number of the selected trace.

CALC<cnum>:PAR:WNUMber? - Returns the window number of the selected trace.

SYSTem:ACTive:CHANnel? - Returns the number of the active channel. The active channel is the channel
number that contains the active measurement.
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SYSTem:ACTive:MEAS? - Returns the name of the active measurement. As seen on the screen, the Active
measurement has the highlighted Tr#.

SYSTem:CHANnels:CATalog? - Returns the channel numbers currently in use.

SYSTem:WINDows:CATalog? - Returns the window numbers that are currently being used.

SYSTem:MEAS:CATalog? [chan] - Returns ALL measurement numbers, or optionally measurement numbers
from a specified channel.

SYSTem:MEAS<n>:NAME? - Returns the name of the specified measurement (Tr#) number.

SYSTem:MEAS<n>:TRACe? - Returns the trace number of the specified measurement number.

SYSTem:MEAS<n>:WINDow? - Returns the window number of the specified measurement number.

1830



Configure for SCPI LAN using SICL / VISA

VNA Supported Interfaces

Keysight I/O Libraries

SICL / VISA Programs Running on the VNA

Configure the VNA for SICL / VISA

Configure the External Controller

Other Topics about GPIB Concepts

VNA Supported Interfaces

The VNA supports the following interfaces for SICL / VISA communication:

LAN - as a remote GPIB interface. The VNA LAN is presented as a virtual GPIB interface. It does NOT
support simple TCPIP-based control. Therefore, when configuring the Keysight IO libraries on your PC, add a
REMOTE GPIB interface, which uses the LAN client interface.

GPIB - requires that your external controller have a GPIB card.

Note: For optimum LAN interface performance, use COM to control the VNA. SCPI commands can be

sent to the VNA using the COM SCPIStringParser object.

The following interfaces are NOT supported:

USB

Serial
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Important Note:

To enable VISA or SICL communication over LAN, you must do the following:

On the VNA, click Utility, System, System Setup..., then select Remote Interface....1.

Check SICL Enabled. To automatically enable SICL when the VNA is booted, check Automatically
enable on Startup.

2.

Click OK.  3.

The VNA is now ready to be controlled over LAN.

Learn more about this dialog box.

 

Keysight I/O Libraries

The Keysight I/O libraries includes the drivers to allow you to communicate with Keysight test

instruments. Every VNA is shipped with the Keysight I/O libraries installed. We recommend you do

NOT upgrade the Keysight I/O libraries on the VNA as unexpected results may occur. If you choose to

upgrade the Keysight I/O libraries on the VNA, do NOT change the default folder path in the

InstallShield Wizard.

To communicate with the VNA, the Keysight I/O libraries must also be installed on your external

controller.  To purchase the Keysight I/O libraries, or download a free upgrade, go to www.Keysight.com
and search for IO Libraries. Scroll to find Software, Firmware & Drivers.

SICL / VISA Programs Running on the VNA

You can run your SICL / VISA program on the VNA to control the VNA. Although the Keysight I/O

libraries are already installed on the VNA, it is configured as the Host. You must also configure a SICL
or VISA LAN Client interface on the VNA, specifying the LAN hostname of that same VNA.

If your program uses the COM interface to VISA, and is compiled on a PC with the Keysight IO

Libraries Suite (version 14 or later), and the resulting executable is copied and run on the VNA, it will

produce a “type mismatch error”. This is because the VNA has the ‘M’ version of Keysight I/O

libraries. The following Visual Basic code is an example of how to avoid this error when

communicating with the VNA from within the VNA:

Dim rm As IResourceManager
Dim fmio As IFormattedIO488
Set rm = CreateObject("AgilentRM.SRMCls")
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Set fmio = CreateObject("VISA.BasicFormattedIO")
Set fmio.IO = rm.Open("GPIB0::22")
fmio.WriteString "*IDN?" & Chr(10)
MsgBox fmio.ReadString()
 

Controlling the VNA over LAN while controlling other instruments over GPIB

The VNA can NOT be both a controller and talker/listener on the same GPIB bus. Using SICL / VISA,

you can use LAN to control the VNA, leaving the VNA free to use the rear-panel GPIB interface to

control other GPIB devices.

Configure the VNA for SICL / VISA

Open the Keysight Connection Expert.1.

Select each GPIB Interface and verify (or make) the default settings in the following table. These settings are
REQUIRED when using a 82357A USB / GPIB Interface with the VNA.

2.

When complete, click Accept to close the Keysight Connection Expert.3.

VISA Interface

Name

SICL Interface

Name

Dialog box title Description

GPIB0 gpib0 GPIB Using NI-488.2 VNA Rear-panel GPIB

connector. This GPIB interface

can be used to control the VNA

OR for the VNA to control

external equipment. IT CAN

NOT DO BOTH IN THE SAME

PROGRAM. Learn more about
pass-through options.

GPIB1 hpib7 Internal Instrument

Configuration

Internal interface for programs

running on the VNA to control

itself.

GPIB4 inst0 Internal Instrument

Configuration

Used for LXI compliance.

Do NOT delete this interface.

Configure the External Controller

Please refer to the Keysight I/O libraries documentation to learn how to configure your controller to

communicate with the VNA. These links can show you how to find the following VNA information:

VNA full computer name
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GPIB Address

IP Address

This example program can help test your VISA configuration.
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Keysight VEE Pro  RunTime Installed

Beginning in Dec. 2005, Keysight VEE Pro RunTime is installed on new VNAs. This means that

programs written with Keysight VEE (.vxe files) can be run directly on the VNA.

VNAs without Keysight VEE installed can go to the Keysight VEE website and download Keysight VEE

Pro 6.2 RunTime to the VNA and begin to run VEE programs directly on the VNA. This version does

not require Keysight I/O Libraries suite 14. Do NOT upgrade to Keysight I/O libraries suite 14 on the VNA.

With Keysight VEE Pro RunTime installed on the VNA, the following examples can be run directly on

the VNA:

Basic Control of the VNA

For more VEE examples, see the PNA support website.

For more information on Keysight VEE, see www.Keysight.com/find/VEE
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Basic Control using VEE

This VEE Pro 6.0 example does the following:

Controls VNA windows and traces.

Changes stimulus settings.

Measures all four S parameters.

Create markers and displays marker readout.

If this Help file is on a VNA and VEE Pro RunTime is installed, then:

Run the BasicControl.vxe example1.

Then click Open on the following dialog box to run the program.2.

Otherwise, you can modify the example program using VEE, save the VEE BasicControl.vee

Learn how to run this program as a Macro on the VNA.

The following dialog box will be visible on the VNA when the example program is running.

Click Fwd to activate the Forward (S11 and S21) measurements.
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Click Rev to activate the Reverse (S22 and S12) measurements.

Click Update Markers to sweep the VNA.

Type values to change Marker Frequencies.
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ECal with Confidence Check using VEE

This VEE Pro 6.0 example performs an ECal and subsequent ECal confidence Check.

If this Help file is on a VNA and VEE Pro RunTime is installed:

Run the .vxe example

Then click Open on the following dialog box to run the program.

Or to modify the example program using VEE, save the VEE BasicControl.vee

 

Learn how to run this program as a Macro on the VNA.

The following dialog box will be visible on the VNA when the example program is running.

Click Fwd to activate the Forward (S11 and S21) measurements.

Click Rev to activate the Reverse (S22 and S12) measurements.

Click Update Markers to sweep the VNA.

Type values to change Marker Frequencies.
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I/O Connector (M9485A)

M9376A and M9377A have the I/O connectors which is used to synchronize the triggering of the

analyzer with other equipment. M9376A and M9377A also has the port to generate the pulse for pulse

measurement.

IO Port Assignments

The ports on M9376A/M9377A which are assigned to the ports 1 to 4 can be used as the Handler I/O as

shown below at the default.  

Module Port name Signal name Input/Output Description

Port 1

 

I/O1 /READY

FOR

TRIGGER

Output Indicates that the instrument

is ready for triggering. This

signal is changed to the Low

level when the instrument is

ready for receiving a trigger

signal.

With the point trigger

function on, it goes to

the Low level when

the instrument is

ready to accept the

trigger signal for the

first point and goes to

the High level when

the trigger signal for

the first point is

received. When
measurement of all

measurement points
is completed and the

instrument is ready to
receive the trigger

signal for the first
point of the next

sweep, this signal
goes to the Low level

again.

Trig /EXTERNAL Input An external trigger
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TRIGGER signal. When the

trigger source is set to

the "External," this

port generates a

trigger in respond to

the trailing edge of a

negative pulse.

I/O2

(M9376A),

I/O2, Sync

(M9377A)

/INDEX Output Indicates that analog

measurement is

complete. The

/INDEX signal

changes to the Low

level when analog

measurement (all

sweeps of all

channels) is

complete. When the

handler receives the

signal, it assumes that

it is ready to connect

the next DUT.

However, no

measurement data are

available until data

calculation is

completed.

When the point

trigger function is on,

it goes to the High
level before staring

measurement of the
first measurement

point and returns to
the Low level after

completing
measurement of all

measurement points.

Port 2

 

I/O1 /SWEEP END Output A sweep completion

signal. When

measurement (all
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sweeps of all

channels) and data

calculation are

completed, this signal

provides a negative

pulse.

Trig INPUT1 Input When this port

receives a negative

pulse, /OUTPUT1 are

changed to the

 Low/High level

depending on the

setup.

I/O2

(M9376A),

I/O2, Sync

(M9377A)

OUTPUT1 Output Changes to the logic

level when /INPUT1

receives a negative

pulse. A command

can be available for

altering the Low/High

level logic.

Port 3 I/O1 P1 Output Hardwired pulse train

output #1 (TTL)

Trig PULSE

SYNC IN

Input Pulse generator

synchronization

trigger input (TTL)

I/O2

(M9376A),

I/O2, Sync

(M9377A)

P2 Output Hardwired pulse train

output #2 (TTL)

Port 4 I/O1 P3 Output Hardwired pulse train

output #3 (TTL)

Trig If the left slot

space is not

receiver

modules,

/EXTERNAL

TRIGGER

Input If the left side slot

space of port 4 is not

receiver modules, this

Trig is assigned to an

external trigger

signal. When the

trigger source is set to

the "External," this

port generates a
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trigger in respond to

the trailing edge of a

negative pulse.

I/O2

(M9376A),

I/O2, Sync

(M9377A)

P4 Output Hardwired pulse train

output #4 (TTL)

Ports 5

and

above

I/O1 N/A N/A At default, no signal

is assigned to Trig on

Ports 5 and above.

Trig If the left slot

space is not

receiver

modules,

/EXTERNAL

TRIGGER

Input If the left side slot

space of port 4 is not

receiver modules, this

Trig is assigned to an

external trigger

signal. When the

trigger source is set to

the "External," this

port generates a

trigger in respond to

the trailing edge of a

negative pulse.

I/O2

(M9376A),

I/O2, Sync

(M9377A)

Sync Output Sync

Modification of Pin Assignments

The user can modify the pin assignments of digital I/O port except for the three signals;

READY_FOR_TRIGGER, EXTERNAL_TRIGGER and INDEX which are assigned on the PORT1. If

you have two port system, it is necessary to modify this file in order to use the signals of P1 to P4 and

PULSE SYNC IN.

Save the definition file according to the following examples.  The VNA firmware first initializes the
pin assignments to the default condition defined above then read the user defined file.

File name and location to save

C:\\Users\Public\Public Documents\Network Analyzer\m9485a_digitalio.csv

File format
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<port number>, <signal for I/O1>, <signal for Trig>, <signal for I/O2>

 

Parameter Value

<port number> 2 – maximum port number in the 1st chassis

<signal for

I/O1>

SWEEP_END, OUTPUT1, P1, P2, P3 or P4, RFOUT_N,

NOISE_PORT1 to NOISE_PORT24, NOISE_LO2,

AUX1_TRIG_OUT, AUX2_TRIG_OUT

<signal for

Trig>
INPUT1 or PULSE_SYNC_IN

<signal for

I/O2>

SWEEP_END, OUTPUT1, P1, P2, P3 or P, RFOUT_N,

NOISE_PORT1 to NOISE_PORT24,

NOISE_LO2, AUX1_TRIG_OUT, AUX2_TRIG_OUT

INPUT1 and OUTPUT1 must be assigned to the same port number

If the same signal is assigned to some of the different I/O ports, the lower port is selected. And if the

same signal is assigned to the both of the I/O1 and I/O2 on the same port, the I/O1 is selected.

Auxiliary Trigger

Auxiliary Triggering can be assigned on I/O 1 and 2.  See example 7.

I/O signal for Noise Figure measurement

The following signals are available in Noise Figure measurement. This signal can be used to control the

external RF switch .

Port

name

Signal name Input/Output Description

I/O1
or

I/O2

/RFOUT_N Output Indicates that the source signal is out. This
signal is changed to the Low level when the

source signal is out.

I/O1
or

I/O2

NOISE_PORT1
to

NOISE_PORT24

Output Indicates that noise sweep. This signal is
changed to the high level when the target port

is used in in a sweep for noise measurement.

I/O1
or

I/O2

NOISE_LO2 Output Indicates that noise sweep for dual-band
parallel mode (option). This signal is changed

to the high level when the target port is used
in in a sweep for dual-band parallel noise

measurement.
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Example 1

2 ports system with P1,  PULSE SYNC IN, P2

(SWEEP_END, INPUT1, OUTPUT1, P3 and P4 are not used)

  PORT1 PORT2

I/O 1
READY FOR

TRIGGER
P1

Trig
EXTERNAL

TRIGGER

PULSE

SYNC IN

I/O 2

(M9376A),

I/O2, Sync

(M9377A)

INDEX P2

File format example

2, P1,PULSE_SYNC_IN,P2

Example 2

2 ports system with SWEEP_END,  PULSE SYNC IN, P1

( INPUT1, OUTPUT1, P2 to P4 are not used)

  PORT1 PORT2

I/O 1
READY FOR

TRIGGER
SWEEP_END

Trig
EXTERNAL

TRIGGER

PULSE SYNC

IN

I/O 2
(M9376A),

I/O2, Sync

(M9377A)

INDEX P1

File format example

2, SWEEP_END,PULSE_SYNC_IN,P1

Example 3

4 ports system, signal locations are assigned differently from default as shown below.

1846



  PORT1 PORT2 PORT3 PORT4

I/O 1
READY FOR

TRIGGER
SWEEP_END OUTPUT1 P4

Trig
EXTERNAL

TRIGGER
N/A INPUT1

PULSE

SYNC IN

I/O 2

(M9376A),

I/O2, Sync

(M9377A)

INDEX P1 P2 P3

File format example

2, SWEEP_END,,P1

3, OUTPUT1,INPUT1,P2

4, P4,PULSE SYNC IN,P3

Example 4

6 ports system for Noise Figure measurement, signal locations are assigned differently from default as

shown below.

  PORT1 PORT2 PORT3 PORT4 PORT5 PORT6

I/O 1

READY

FOR

TRIGGER

RFOUT_N NOISE_PORT3 NOISE_PORT4 NOISE_PORT5 NOISE_PORT6

Trig
EXTERNAL

TRIGGER
N/A N/A N/A N/A N/A

I/O 2

(M9376A),

I/O2, Sync

(M9377A)

INDEX N/A N/A N/A N/A N/A

File format example

2, RFOUT_N, ,

3, NOISE_PORT3, ,

4, NOISE_PORT4, ,

5, NOISE_PORT5, ,

1847



6, NOISE_PORT6, ,

Example 5

M9376A/77A 4 ports system with one M9379A RF Amplifier between ports 2 and 3. The I/O2 on Port

2 and Trig on Port 3 should be connected with SMB cable.

  PORT1 PORT2   PORT3 PORT4  

Module M9376A M9377A M9379A M9377A M9377A M9379A

I/O 1
READY

FOR

TRIGGER

SWEEP

END
  P1 P3  

Trig
EXTERNAL

TRIGGER

PULSE

SYNC

IN

 
EXTERNAL

TRIGGER
N/A  

I/O 2

(M9376A),

I/O2, Sync

(M9377A)

INDEX SYNC   P2 N/A  

File format example

2, SWEEP_END,,PULSE_SYNC_IN,

3, P1, ,P2

4, P3, ,

Example 6

M9376A 4 ports system with one M9379A between ports 2 and 3. The Sync on Port 2 and Trig on
Port 3 should be connected with SMB cable.
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  PORT1 PORT2   PORT3 PORT4  

Module M9376A M9376A M9379A M9376A MM9376A M9379A

I/O 1

READY

FOR

TRIGGER

SWEEP

END
  P1 P3  

Trig
EXTERNAL

TRIGGER

PULSE

SYNC

IN

 
EXTERNAL

TRIGGER

EXTERNAL

TRIGGER
 

Sync N/A
Sync

ON
  N/A N/A  

I/O 2

(M9376A),

I/O2, Sync

(M9377A)

INDEX N/A   P2 N/A  

File format example

2, SWEEP_END,,PULSE_SYNC_IN,

3, P1, ,P2

4, P3, ,

Example 7

4 ports system, assign Auxiliary Triggering for I/O 2 on ports 2 and 4.

  PORT1 PORT2 PORT3 PORT4

I/O 1

READY

FOR

TRIGGER

SWEEP_END P1 P3

Trig
EXTERNAL

TRIGGER
N/A

PULSE

SYNC

IN

N/A

I/O 2
(M9376A),

I/O2, Sync

(M9377A)

INDEX AUX1_TRIG_OUT P2 AUX2_TRIG_OUT

File format example

2, SWEEP_END,,AUX1_TRIG_OUT
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3, P1,PULSE SYNC IN,P2

4, P3,,AUX2_TRIG_OUT

Restriction of the usage of M9377A I/O2

In case of the multi-chassis configuration and M9377A is used as the 1st port receiver, the I/O2 pin

must be used as Sync pin to synchronize over the chassis. Then the INDEX signal cannot be output

from the I/O2 of PORT1. In this special case the INDEX signal is output from the I/O1 pin of the 1st

port receiver in the 2nd chassis.

Restriction of the P1 to P4 and PULSE SYNC IN

In case of the multi-chassis configuration, the P1 to P4 can be assigned to the receivers installed in the

1st chassis. The PULSE SYNC IN can be assigned to the receivers installed in the slots which belong

to the same trigger bus segment of the 1st port receiver. In standard configuration, both receiver should

be in slots No. 7 to 12 for M9018A. Refer to M9018A users guide for the trigger bus segment.   

Pin Descriptions

Input1

When this Input line receives a Low pulse from the material handler, data is latched on the OUTPUT1 lines.

The Input Line activity can be read:

SCPI  

CONTrol:HANDler:INPut?  

 

Output1

The current state of these latched TTL outputs may be set High or Low (Default setting) using the

(non-user) OUTPUT commands.

The next state (following a negative edge on the INPUT1 line) may be pre-loaded to High or Low
(Default setting) using the user commands.

For example, on the next negative pulse on the INPUT1 line, you want the OUTPUT1 line to go

from 0 to 1.  To do this:

CONT:HAND:OUTP1:DATA 0  'Force the OUTPUT1 line to 0
CONT:HAND:OUTP1:USER 1  'Set the OUTPUT1:USER buffer to 1, indicating the next
state

  SCPI  
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Write User Data CONT:HAND:OUTP1:USER  

Read last value written CONT:HAND:OUTP1:USER  

Write non-user data CONT:HAND:OUTP1:DATA  

Read last value written CONT:HAND:OUTP1:DATA  

 

External Trigger

When trigger source is set to external, this Input line accepts a trigger signal from the material

handler. This usually means that a part is in place and ready to be tested.

 

 

Sweep End

This output line indicates the status of the VNA sweep. The sweep includes sweeping the source and taking data.

Low (falling edge) indicates that the specified sweep event has finished. This does NOT indicate that all
calculations have finished.

High indicates that the specified sweep event is active.

Set Sweep Event Mode:

Sweep : indicates that a single source sweep has finished. (Default setting)

Channel : indicates that a single channel has finished.

Global : indicates that all enabled channels have finished.

SCPI  

CONTrol:HANDler:SWEepend  

Timing Diagrams

  Description MinimumTypical

T1
Pulse width of

 /EXTERNAL TRIGGER
0.1 µs  

T2
Pulse width of /SWEEP

END
  10 µs

1851



 

 

  Description MinimumTypical

T1 Pulse width of  /INPUT1 0.1 µs  

T2
Response time of

/OUTPUT1
  0.1 µs

 

 

Last modified:
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Material Handler I/O Connector

This rectangular 36-pin female connector provides communication signals between the VNA and a material parts handler. You
can change the settings on the Material Handler IO connector using SCPI commands.

The M9341A I/O module can be work with the M937xA and M9485A PXIe VNA as Material Handler I/O. The input and
output interfaces are compatible with ENA and PNA material handler I/O.

Overview - Controlling a Material Handler

Pin Assignments

Pin Descriptions

Timing Diagrams

Input Output Electrical Characteristics

Note: On early VNAs this connector is labeled "GPIO". It is covered to indicate that the connector is

not functional.

Overview - Controlling a Material Handler

The VNA is capable of interacting with an external material handler or part handler. This allows the

VNA to be used in an automated test environment, where devices to be tested are inserted into a test

fixture by a part handler, and sorted into pass/fail bins by the handler after testing is complete. By

connecting the part handler to the Material Handler I/O ports, the VNA and part handler can

synchronize their activities in a way that makes automated testing possible.

M9341A/B Module Installation

When the M9341A/B I/O module is used with M937xA and M9485A, the cables for sync must be

connected as shown below.
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M9341A/B Location

The M9341A should be placed the following location

M9371A/72A/73A/74A/75A: Any slot.

M9485A: Installing at the right side of the rightmost receiver is recommended. When the

M9341A is installed between receivers, the sync signal connection is required. The Sync on Port

n and Trig on Port (n+1) should be connected with SMB cable when the M9341A is located

between Ports n and (n+1).

Port Connection

M9341A/B M9371A/72A/73A/74A/75A M9485A

Sync 1 Trig Ready on Port 1,2 module I/O 1

Sync 2 Trig In on Port 1,2 module Trig on Port 1

Sync 3
Trig Out on the rightmost

module

I/O2 on Port

1

Recommended Cables
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Number of slot between M9341A/B and VNA

module

SMB Cable Part

Number
Length

1 8121-5091
120

mm

2 to 3 8121-2169
165

mm

4 to 8 M9485-61605
270

mm

More than 9 M9485-61604
340

mm

 

VNA and Part Handler Preparation

Define the measurements you want to make.1.

Define limits for each of the measurements.2.

Configure the VNAs Material Handler port so that it is compatible with your part handler. This usually involves
setting the pass/fail logic, pass/fail scope, and pass/fail mode. These settings are made remotely using SCPI
commands.

3.

Use a cable to connect the VNA to your part handler.4.

Put the VNA in External Trigger mode.5.

Load parts in handler per manufacturer instructions.6.

Note: The Material Handler configuration settings REMAIN after an Instrument Preset. The settings will

revert to their default settings ONLY after the VNA is restarted, or until they are changed by you.

Flow Diagram

The following diagram and descriptions summarizes the events that occur during automated testing.

'DUT' refers to Device Under Test.
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Text Descriptions

(Optional). The VNA sends values out the Material Handler to configure external instruments. The A,B,C, and
D ports of the Material Handler can be used to control devices used in testing, such as step attenuators, part
handlers, or even the DUT itself. If you wish to use the Material Handler for testing, you will need to write a
program to send values out the various lines and ports, as there is no activity on these lines by default.

0.

The part handler receives a Ready for Trigger signal from the VNA. This indicates that the VNA is properly
configured and ready to take a measurement.

1.

The part handler sends an External Trigger signal to the VNA. This signals that the part handler has settled,
and allows the VNA to begin taking measurements.

2.

The VNA takes measurements on all triggerable channels.3.

The Index line on the material handler goes to a Low state, which means that all required data has been
collected by the VNA.

4.

The part handler removes the DUT from the test fixture, and inserts a new DUT into the fixture. This
operation is often referred to as part handler indexing. The device just tested is staged (removed from the
fixture and prepared for binning), and the next part to be tested is put into the fixture. The removed DUT
cannot be assigned to a Pass/Fail bin yet, as the Pass/Fail status is not available.

5.

The VNA sends the Pass/Fail Status.6.

The VNA sends the Pass/Fail Strobe meaning that the Pass/Fail status has been determined.7.

8.

9.
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7.

The part handler reads the Pass/Fail Status line.8.

The part handler bins the staged part based on the Pass/Fail Status.9.

The test process repeats at step 1, waiting for Ready for Trigger from the VNA.10.

 

Material Handler IO Pin Assignments

Pin Description

1 Ground

2 / INPUT1

3 / OUTPUT1

4 / OUTPUT2

5 / Output port A0

6 / Output port A1

7 / Output port A2

8 / Output port A3

9 / Output port A4

10 / Output port A5

11 / Output port A6

12 / Output port A7

13 / Output port B0

14 / Output port B1

15 / Output port B2

16 / Output port B3

17 / Output port B4
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18 / Ext. Trigger

19 / Output port B5

20
/ Output port B6 -or

/ Index Signal
(select by command)

21
/ Output port B7 or
/ Ready for Trigger

(select by command or dialog box)

22 / In/Out port C0

23 / In/Out port C1

24 / In/Out port C2

25 / In/Out port C3

26 / In/Out port D0

27 / In/Out port D1

28 / In/Out port D2

29 / In/Out port D3

30 Port C Status

31 Port D Status

32 / Output Port Write Strobe

33 / Pass/Fail

34 / Sweep End

35 +5V

36 / Pass/Fail Write Strobe

Pin Descriptions
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Input1

When this Input line receives a Low pulse from the material handler, data is latched on the OUTPUT1 and OUTPUT2
lines. See OUTPUT1|2 Data Output Write Timing
The Input Line activity can be read:

SCPI
CONTrol:HANDler:INPut?

 

Output1, Output2

See OUTPUT1|2 Data Output Write Timing

The current state of these latched TTL outputs may be set High or Low (Default setting) using the

(non-user) SCPI  put_Output (COM) commands.

The next state (following a negative edge on the INPUT1 line) may be pre-loaded to High or Low

(Default setting) using the user commands.

For example, on the next negative pulse on the INPUT1 line, you want the OUTPUT1 line to go

from 0 to 1.  To do this:

CONT:HAND:OUTP1:DATA 0  'Force the OUTPUT1 line to 0
CONT:HAND:OUTP1:USER 1  'Set the OUTPUT1:USER buffer to 1, indicating the next
state

  SCPI

Write User Data CONT:HAND:OUTP<pin>:USER

Read last value written CONT:HAND:OUTP<pin>:USER

Write non-user data CONT:HAND:OUTP<pin>:DATA

Read last value written CONT:HAND:OUTP<pin>:DATA
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How to Control Handler Output

 

Using Hardkey/SoftTab/Softkey Using a mouse

Press Setup > Internal Hardware > PXI Device...1.

Click M9341 Handler Setup..2.

Click Instrument1.
Select Setup2.

Select Internal Hardware3.

Select PXI Device..4.

Select  M9341A Handler Setup..5.

 

M9341 Setup dialog box help

You can specify the port A to D output with this dialog box. The setting value is independent for

each channel. These values are set before sweep.

Enable Handler Control Enabling the setting for Parts A to D.

Port A to D Sends values to the respective Handler I/O port. Although ports C and D are normally

bidirectional, ONLY Output mode is allowed using the Interface Control feature. It cannot read
from these, or any other, ports
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Output Ports A and B

These two general purpose, 8-bit output ports are used to write data to the material handler. When any line changes state,
all output lines are latched to the I/O connector as the Output Write Strobe  goes Low.

The default state for data is Low.

See Data Output Write Timing Diagram
Combine to write data to Port F:

Ports A and B can be virtually combined to write data to one 16-bit I/O port F.

SCPI
CONTrol:HANDler:F <num>

 

Input/Output Ports C and D

These two general purpose 4-bit Input/Output ports are used to write data (Output) or read data

(Input). These lines could be used to write to an external device such as a step attenuator.

When any line changes state, all output lines are latched to the I/O connector as the Output Write Strobe  goes Low.  See
Data Output Write Timing.

 

Set Input | Output Mode:

Each port may be independently defined as Output or Input.

SCPI
CONTrol:HANDler:C:MODE
CONTrol:HANDler:D:MODE

 

Set Port Logic:

The logic for the data lines can be set to either: Positive (1 = High) or Negative (1 = Low). This
setting affects all data ports. They cannot be set independently.

SCPI
CONTrol:HANDler:LOGic
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Read or write data:

Ports C and D can be virtually combined to read or write data to one 8-bit I/O port E. When

combined, both C and D ports must be set to either INPUT or OUTPUT mode.

SCPI
CONTrol:HANDler:<port>[:DATa]>

 

Port C Status, Port D Status

These two output lines indicate the Read / Write mode of the C and D ports.

A Low level indicates that the associated port is in INPUT mode (read only).

A High level indicates that the associated port is in OUTPUT mode (write only).

These logic of these status outputs cannot be changed.

See Input/Output Ports C and D to learn how to set I/O Mode

See Data Output Write Timing

 

 

Output Port Write Strobe

This Output line goes Low to write data from Ports A and B and Ports C and D when a change is detected on any of the
data lines.

These logic of this strobe output cannot be changed.

See Data Output Write Timing
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External Trigger

When trigger source is set to external, this Input line accepts a trigger signal from the material

handler. This usually means that a part is in place and ready to be tested.

See Trigger Timing Diagram

 

 

Index  

A Low signal on this Output line indicates to the material handler that the measurement is complete.

This usually means that the handler can connect the next device. However, measurement data is not

available until data is calculated.  See Trigger Timing Diagram.

Set Function:

This line also serves as a data line. Set the function using the following commands:

SCPI
CONTrol:HANDler:INDex:STATe

 

Ready for Trigger

When this output line goes low, it indicates to the material handler that the VNA is ready for a

trigger signal.

See Trigger Timing Diagram

See Pass/Fail Timing Diagram
Set Function:

This line also serves as a data line. Set the function using the following commands:

SCPI
CONTrol:HANDler:RTRigger:STATe
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Pass/Fail State

This Output line indicates to the handler whether the limit test has passed or failed.

Pass/Fail state is valid only when the limit test function is ON and while Pass/Fail strobe line is Low. See Pass/Fail
Timing Diagram
Set Pass / Fail Logic:

Positive Logic: High=Pass, Low=Fail. (Default setting)

Negative Logic: High=Fail, Low=Pass.

SCPI
CONTrol:HANDler:PASSfail:LOGic

Set Default Conditions:

PASS- the line stays in PASS state. When a device fails, then the line goes to fail after the Sweep End
line is asserted.

FAIL- the line stays in FAIL state. When a device passes, then the line goes to PASS state after the
Sweep End line is asserted.

No Wait- the line stays in PASS state. When a device fails, then the line goes to fail  IMMEDIATELY.
(Default setting)

SCPI
CONTrol:HANDler:PASSfail:MODE

Set Pass / Fail Scope:

Channel scope:  The line resets to the default state after the measurements on a channel have
completed.

Global scope:  The line resets to the default state after the measurements on all triggerable channels
have completed. (Default setting)

SCPI
CONTrol:HANDler:PASSfail:SCOPe
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Pass/Fail Write Strobe

A Low pulse indicates that Pass/Fail line is valid and the Pass / Fail State is output to the material handler.

The Pass/Fail Strobe is fixed in duration and timing. However, when the strobe occurs depends on the Pass/Fail Mode and
Pass/Fail Scope (Channel or Global) settings. See Pass/Fail State

See Pass/Fail Timing Diagram

 

 

+5V

+5V nominal output (100mA max).

Protected by self-healing fuse.

 

Sweep End

This output line indicates the status of the VNA sweep. The sweep includes sweeping the source and taking data.

Low (falling edge) indicates that the specified sweep event has finished. This does NOT indicate that all
calculations have finished.

High indicates that the specified sweep event is active.

See Trigger Timing Diagram
Set Sweep Event Mode:

Sweep: indicates that a single source sweep has finished.

Channel: indicates that a single channel has finished.

Global: indicates that all enabled channels have finished.  (Default setting)

SCPI
CONTrol:HANDler:SWEepend

 

Timing Diagrams
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Trigger Timing

All signals are active low.

T1 = 0.1 s  External Trigger pulse width

T2  > 10 s Sweep End pulse width (both High and Low)

 

Pass / Fail Timing

 

T1 = 1 s  Pulse width and response time of Pass / Fail Strobe

T2 > 10 s  Ready for Trigger lag
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Ports A-F(H) Data Output Write Timing

T1 = 1 s  Write Strobe response time

T2 = 1 s  Write Strobe pulse width

 

OUTPUT1|2 Data Output Write Timing

The old state to new state transition can be either low to high (as shown) or high to low.

T1 = 0.1 s  Output1|2 response time

T2 = 0.1 s  Input1 Strobe pulse width

Input / Output Electrical Characteristics

All Material Handler I/O Input and Output lines are TTL compatible.

Input and Input/Output lines

Lines carrying information IN (or bidirectional) to the VNA from the material handler.

Maximum Input Voltages: -0.5 V to 5.5 V

TTL High level: 2.0 V to 5.0 V

TTL Low level: 0 V to 0.5 V

 

VNA Input and Input/Output Circuit Diagram
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To Handler I/O Port

Output Lines

Lines carrying information OUT of the VNA to the material handler.

Maximum Output Current: -10 mA to 10 mA

Output Current
TTL High level: -5 mA

TTL Low level: 3 mA

Output Voltage
TTL High level: 2.0 V to 3.3 V

TTL Low level: 0 V to 0.8 V

 

VNA Output Circuit Diagram

 

To Handler I/O Port
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New PXI Programming Commands

The following are new programming commands for PXIe release A.12.60.

SENSe:DUTControl:M9341:[MODule] commands

Sets and reads the DUT Control function state. SENS:DUTC:M9341

Sets and returns I/O function type of the 8 bit
Input/Output pins, for each I/O group.

SENS:DUTC:M9341:IOTY

Sets and reads the output voltage level of the
M9341B 8bit I/O.

SENS:DUTC:M9341:LEV

Sets and reads the signal direction type of Parallel
IO, for each IO pin.

SENS:DUTC:M9341:PIO:TYPE

Sets and reads the signal level of IO pin, high or
low.

SENS:DUTC:M9341:PIO:LEV

Sets and reads the RFFE clock rate. SENS:DUTC:M9341:RFFE:CLOC

Sets and reads the Slave Address (“SA” in GUI) for
the specified command sequence

SENS:DUTC:M9341:CSEQ:SADD

Sets and reads the command sequence type for
the specified command sequence.

SENS:DUTC:M9341:CSEQ:TYPE

Sets and reads the byte count for the specified
command sequence.

SENS:DUTC:M9341:CSEQ:BCO

 Sets and reads the address value for the specified
command sequence.

SENS:DUTC:M9341:CSEQ:ADDR

Sets and reads  the data values for the specified
command sequence.

SENS:DUTC:M9341:CSEQ:DATA

Reads the data and parity value pairs from DUT for
the specified command sequence.

SENS:DUTC:M9341:CSEQ:READ:DATA

Sets and reads the RFFE Command Sequence
count.

SENS:DUTC:M9341:CSEQ:COUN
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SOURce:DC commands

Sets and returns the negative current limit (in
Amps) when output regulation is in voltage priority
mode.

SOUR:DC:CURR:CLAM:NEG

Sets and returns the positive current limit (in Amps)
when output regulation is in voltage priority mode.

SOUR:DC:CURR:CLAM:POS

Sets and returns a current output range in Amps. SOUR:DC:CURR:RANG

Sets and reads the locked-down state of the output
relays on SMU units with output relays

SOUR:DC:LOCK:OUT:REL:CLOS

Returns the module list which protection function is
activated due to over current or voltage.

SOUR:DC:PROT:CAT

Sets and reads the DC output protection state. SOUR:DC:PROT:ENAB

Sets and reads the protection voltage level for the
DC output.

SOUR:DC:PROT:LEV

Resets the instrument's output protection circuit
after a protection condition occurs.

SOUR:DC:PROT:RES

Sets and reads the DC output sequencing state. SOUR:DC:SEQ

Sets and reads the DC output sequencing settling
time.

SOUR:DC:SEQ:STIM

Sets and returns the output regulation mode SOUR:DC:TYPE

Returns the date of execution output voltage
calibration.

SOUR:DC:VOLT:CALB:DATE

Execute the output voltage calibration for both AO1
and AO2.

SOUR:DC:VOLT:CALB:EXEC

Returns the time of execution output voltage
calibration.

SOUR:DC:VOLT:CALB:TIME

Sets and returns a voltage bandwidth to optimize
the output response time with capacitive loads.

SOUR:DC:VOLT:BAND

Sets and returns the positive voltage limit in Volts
when output regulation is in current priority mode.

SOUR:DC:VOLT:CLAM

Sets and returns a voltage output range in Volts. SOUR:DC:VOLT:RANG

 

 

The following are new programming commands for PXIe release A.12.50. See What's New
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SENSe:AMPLifier:M9379 commands (Only for M9485A)

Returns the total number of M9379A amplifier
modules

SENS:AMPL:M9379:COUNt?

Sets and reads the attenuation of the M9379A
amplifier 1

SENS:AMPL:M9379:MOD:ATT

Returns the chassis number SENS:AMPL:M9379:MOD:CHAS

Sets and reads the status of M9379A control. SENS:AMPL:M9379:MOD:CONT

Sets and reads the path for the M9379A amplifier
1.

SENS:AMPL:M9379:MOD:PATH

Sets and reads the status of M9379A power. SENS:AMPL:M9379:MOD:POW

Reads the slot number where the M9379A is
located.

SENS:AMPL:M9379:MOD:SLOT?

Sets and reads the path for the M9379A switch SENS:AMPL:M9379:MOD:SWIT:PATH

 

The following are new programming commands for PXIe release A.03.00. See What's New

CALCulate commands

Resets the currently-stored data points CALC:HOLD:CLEAr

Sets the type of trace hold to perform CALC:HOLD:TYPE

Returns the number of segments used in a limit
test

CALC:LIMit:SEGMent:COUNt?

Sets and reads the scope of Coupled Markers CALC:MARK:COUP:METHOD

 

Ground Loop De-embedding/Embedding commands

De-embedding  

Sets and returns the Capacitance value CALC:FSIM:GLOop:DEEMbed:PARameters:C

Sets and returns the Inductance value CALC:FSIM:GLOop:DEEMbed:PARameters:L

Sets and returns the Resistance value CALC:FSIM:GLOop:DEEMbed:PARameters:R

Turns ON or OFF De-embedding CALC:FSIM:GLOop:DEEMbed:STATe

Specifies the circuit model type CALC:FSIM:GLOop:DEEMbed:TYPE

Specifies the filename of the s1p file to load CALC:FSIM:GLOop:DEEMbed:USER

Embedding  

Sets and returns the Capacitance value CALC:FSIM:GLOop:EMBed:PARameters:C

Sets and returns the Inductance value CALC:FSIM:GLOop:EMBed:PARameters:L

Sets and returns the Resistance value CALC:FSIM:GLOop:EMBed:PARameters:R

Turns ON or OFF Embedding CALC:FSIM:GLOop:EMBed:STATe

Specifies the circuit model type CALC:FSIM:GLOop:EMBed:TYPE

Specifies the filename of the s1p file to load CALC:FSIM:GLOop:EMBed:USER
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CSET commands

Returns a list of error term names for the given Cal
Set

CSET:ETERm:CATalog?

Sets and returns the error term data CSET:ETERm:DATA

 

DISPlay commands

Sets and returns the X-axis position of the
Limit Line Pass/Fail indicator

DISP:WIND:ANN:LIM:XPOSition

Sets and returns the Y-axis position of the
Limit Line Pass/Fail indicator

DISP:WIND:ANN:LIM:YPOSition

Display marker symbols above trace or not DISP:WIND:ANN:MARK:SYMB:ABOVe[STATe]

 

SENSe commands

Returns a list of all name-value pairs in cal
set

SENS:CORR:CSET:ITEM:CATalog?

Add or change a name-value pair in the Cal
Set

SENS:CORR:CSET:ITEM[:DATA]

Sets and returns the ECAL over range state SENS:CORR:PREF:ECAL:OVERrange[:STATe]

Computes the error correction terms, turns
Correction ON, and saves the calibration to
an existing, specified Cal Set

SENS:CORR:COLL:GUID:ETER:COMPute

Sets the frequency step size across the
selected frequency range

SENS:SWE:STEP

 

SYSTem commands

Returns the maximum possible
number of channels

SYSTem: CAPability:CHAN:MAX[:COUNt]?

Returns whether or not the
analyzer has FOM Opt. 080
installed

SYSTem: CAPability:FOM:EXISTs?

Returns whether or not there is a
receiver attenuator on the specified
port

SYSTem: CAPability:HARDware:ATTenuator:RECeiver:EXISTs?
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Returns the maximum amount of
receiver attenuation on the
specified port

SYSTem: CAPability:HARDware:ATTenuator:RECeiver:MAXimum?

Returns the step size of the
receiver attenuator on the specified
port

SYSTem:
CAPability:HARDware:ATTenuator:RECeiver:STEP[:SIZE]?

Returns the maximum amount of
source attenuation on the specified
port

SYSTem: CAPability:HARDware:ATTenuator:SOURce:MAXimum?

Returns the step size of the source
attenuator on the specified port

SYSTem:
CAPability:HARDware:ATTenuator:SOURce:STEP[:SIZE]?

Returns whether or not the
specified port number has a
reference bypass switch

SYSTem: CAPability:HARDware:RBSWitch:EXISTs?

Returns the maximum specified
frequency of the analyzer

SYSTem: CAPability:PRESet:FREQuency:MAXimum?

Returns the minimum specified
frequency of the analyzer

SYSTem: CAPability:PRESet:FREQuency:MINimum?

Returns the maximum number of
windows

SYSTem: CAPability:WINDows:MAXimum

Returns the maximum number of
traces per window

SYSTem: CAPability:WINDows:TRACes:MAXimum?

Returns the maximum leveled
source power setting

SYSTem:CAPability:ALC:POWer:MAXimum[:LEVel]?

Returns the minimum leveled
source power setting

SYSTem:CAPability:ALC:POWer:MINimum[:LEVel]?

Returns a list of names of the
internal DC receivers

SYSTem:CAPability:HARDware:DC:RECeiver:INTernal:CATalog?

Returns the number of internal DC
receivers in the analyzer

SYSTem:CAPability:HARDware:DC:RECeiver:INTernal:COUNt?

Returns a list of names of the
internal DC sources

SYSTem:CAPability:HARDware:DC:SOURce:INTernal:CATalog?

Returns the number of internal DC
sources in the analyzer

SYSTem:CAPability:HARDware:DC:SOURce:INTernal:COUNt?

Returns a list of test port names SYSTem:CAPability:HARDware:PORTs:CATalog?

Returns the number of test ports SYSTem:CAPability:HARDware:PORTs:COUNt?

Returns a list of internal test port
names

SYSTem:CAPability:HARDware:PORTs:INTernal:CATalog?

Returns the number of internal test
ports

SYSTem:CAPability:HARDware:PORTs:INTernal:COUNt?

Returns the port number SYSTem:CAPability:HARDware:PORTs:PNUMber?

Returns a list of source port names SYSTem:CAPability:HARDware:PORTs:SOURce:CATalog?

Returns the number of source
ports

SYSTem:CAPability:HARDware:PORTs:SOURce:COUNt?
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Returns a list of internal source
port names

SYSTem:CAPability:HARDware:PORTs:SOURce:INTernal:CATalog?

Returns the number of internal
source ports

SYSTem:CAPability:HARDware:PORTs:SOURce:INTernal:COUNt?

Returns the number of receivers in
the analyzer

SYSTem:CAPability:HARDware:RECeiver:INTernal:COUNt?

Returns the number of sources in
the analyzer

SYSTem:CAPability:HARDware:SOURCe:COUNt?

Returns the list of supported Noise
Bandwidth values when using a
noise receiver

SYSTem:CAPability:NBW:NOISe:CATalog?

Returns the list of supported Noise
Bandwidth values when using the
NA receiver for noise
measurements

SYSTem:CAPability:NBW:STD:CATalog?

Returns the list of supported
Resolution BW values for the
IMSpectrum channel

SYSTem:CAPability:RBW:IMS:CATalog?

Returns a comma separated list of
either VISA address strings or
aliases

SYSTem:COMMunicate:VISA:RDEVice:FIND?

Sets or returns the timeout value
for VISA pass-through commands

SYSTem: COMMunicate:VISA:RDEVice:TIMeout?

Returns the system date SYSTem:DATE?

Returns front panel history SYSTem:HISTory:FPANel?

Returns SCPI history SYSTem:HISTory:SCPI?

Set and return whether the keys
are displayed or not

SYSTem:PREFerences:ITEM:KEYS

Set and return whether the
Coupled Markers setting controls
the ON|OFF state of coupled
markers

SYSTem:PREFerences:ITEM:MCControl

Set and return whether Coupled
Markers is set to Channel or All
after Preset

SYSTem:PREFerences:ITEM:MCMethod

Set and return whether Coupled
Markers is set to ON or OFF after
Preset

SYSTem:PREFerences:ITEM:MCPReset

Set and return whether to draw
limits lines in Red

SYSTem:PREFerences:ITEM:REDLimits

Set and return whether to treat
marker 10 as a reference marker

SYSTem:PREFerences:ITEM:REFMarker

Returns the system time SYSTem:TIME?
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The following are new programming commands for PXIe release A.02.00. See What's New

PXIe Speed Enhancement commands

Set logic of the index line CONT:HAND:EXT:INDEX:LOG

Trigger multiple channels SYST:CHAN:SING:COMB

Shared Memory Data Transfer commands SYST:DATA:MEM

PXI Capability commands SYST:CAP:HARD:MODule
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Remotely Specifying a Source Port

In the 'not-too-distant past', it was a simple task to specify a VNA source port. It was either port 1 or

port 2.  Now, for the following reasons, it is not so simple:

Internal 2nd sources are now offered on various VNA models. However, some source ports do not have a
port number.  One example is the second source on the VNA-X  2-port model (option 224). Learn more about
Internal Second Sources.

External sources can now be controlled by the VNA as though they are internal sources. External sources
do not have a source port number, but use String names as identifiers.

For FCA ONLY: Once configured using the Configuration dialog, an external source can be selected
remotely and controlled by the VNA by specifying the LOName using SCPI or COM.

All other uses for External sources: The external source must be configured and selected from the
External Source dialog. You can then save an Instrument State file, then recall that state file remotely.

Multiport test sets…choose between ports 1 through port N, where N is the number of ports on the test set.
You still use a port number, but this port number refers to a logical port. The Port mapping feature maps the
logical port to a physical port. Learn more about Multiport test sets.

iTMSA (Opt S93460A)  When this option is present, the string names for balanced source ports are returned
with the appropriate COM and SCPI commands. For example, "SE Port 1" is used to access 'Single-ended
Port 1".

Source Port String Names

The VNA User Interface (UI) makes it easy to configure and select the sources and ports. Remotely

however, string names are used now, in addition to port numbers, to specify a Source port.

COM  - The existing COM commands specify source ports as numbers and they are still used. It is

necessary to learn the port number from the string using the GetPortNumber Method. Port numbers are
assigned dynamically depending on whether external sources are selected and the number of ports of the

VNA.

SourcePortNames Property

GetPortNumber Method

SourcePortCount Property.

An example:

dim app
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set app = CreateObject("Agilentpna835x.application")
dim channel
set channel = app.Channel
dim portnum
portnum = Channel.GetPortNumber("Src2 Out1")
app.CreateMeasurement 1,"A",portnum

 

SCPI  - ALL of the existing SCPI commands that specify a source port are extended to also allow the

source port to be specified using string names. For example, send the following command to set the

power on Src2 Out1:

SOUR:POW 5, “Src2 Out1”

Use Source:Cat? to list the available source port string names.
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Multi DUT Parallel Measurement (M9485A)

M9485A is a single source multi-port VNA supporting up to 24 ports. The hardware can output source power

from all measurement ports at once, and all receiver can capture signals simultaneously. It is capable of measuring 24

identical individual 1-port devices at once, 12 2-port devices at once, 8 3-port device at once etc.

Note: Multi DUT parallel measurement is available only for M9376A. When your configuration

includes any of M9377A, the Multi DUT parallel measurement is NOT available.

Block Diagram

M9485A uses one source frequency module at a time.

As for the receiver module, one receiver has one measurement port and consumes one PXI slot. One
firmware instance supports up to 36 modules at a time. Each receiver module has two dedicated ADCs

for T and R channels. Multiple R data can be captured at a time. Each receiver module has own source
control switch. Source output can be enabled on multiple measurement port at a time.

M9485A source switch enables multiple output at a time. Each port switch can be controlled

independently.

Difference Between M9485A and ENA

Unlike ENA, M9485Ais capable of measuring DUTs in parallel. Calibration types are identical on both
instrument, however correction data is independent. Topologies are also identical but fixturing data are

1879



independent.

As shown in the below diagram, in M9485A, each port can be controlled independently, unlike in

ENA, only one test port can output RF source signal at a time.

For example, in measuring two 3-port DUTs, by using ENA, it requires 6 sweeps to perform the

measurement. M9485A can do the same by 3 sweeps only and twice faster in total.

 

Multi DUT measurement is achieved by SCPI program not from Soft Front Panel. See Perform Multi DUT
Parallel measurements.

Multi DUT Measurement Limitations

There are some limitations on M9485A multi DUT parallel measurement because of analog hardware

configuration.
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Parallel measurement is restricted to standard S-parameter channel. If there are SMC channel or other

measurement classes, sequential measurement will be held. Parallel measurement does not support

FOM. If FOM is enabled, sequential measurement will be held.

The actual Port Power States are depended on the multi-site DUT assignment:

Master channel directly reflects user settings.
As for slave channels, "Off" state indicates force power off and "Auto" state indicates duplicate the master
channel state.

If the Port Power Coupling is disabled, the actual Port Power Values are dependent on the multi-state

DUT assignment:

Master channel directly reflects user settings
Slave channels duplicates the master channel state

The actual Port Power are dependent on the multi-state DUT assignment:

Master channel directly reflects user settings
Slave channels duplicates the master channel state

Last Modified:

26-Mar-2015 First Release
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Frequency Converter Application

Option M937xA-009 and M9485A-009  allows Scalar Mixer Converter (SMC) measurements on a

maximum of four ports.

In this topic:

FCA Options Explained

SMC Overview

Requirements and Limitations

How to make SMC Measurements

Create a Measurement

Make Measurement Settings

Sweep Tab

Segment Sweep

Power Tab

Mixer Setup Tabs (separate topic)

Select X-axis Display

Save Trace Data

See Also

SMC Measurements and Calibrations

Configure an External LO Source

For a detailed understanding of FCA, see our Mixer Measurements App Notes.

FCA Options Explained

M937xA Option 009 includes Scalar Mixer Converter (SMC) measurements. M9485A provides which
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includes  Scalar Mixer (SMC) and Vector Mixer (VMC) Measurements.

Note: The VMC of the M9485A is provided by macro.

SMC Overview

  Scalar Mixer Calibration

See Hardware setup

Overview Provides highest Scalar accuracy for measurements of conversion loss/gain.

Combines SOLT and power-meter calibration.

Measurements

Offered

Both forward and reverse directions.

DUT can be connected to any VNA ports.

Equipment

Required

Power meter and sensor

Common equipment for SMC

Mechanical cal kit or ECal module

See Comparison of Mixer Characterization using New Vector Characterization Techniques.

Requirements and Limitations

The following VNA features are NOT available with FCA:

Analog Sweep (Stepped sweep mode only)

Log frequency sweeps

ECal User Characterization (can NOT be created in FCA channel)

Time Domain

Balanced measurements

Port extensions

Some Fixturing Features

PMAR (Power Meter As Receiver)

How to make SMC Measurements

The following is an overview of how to make an FCA measurement:

1.
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CREATE an SMC Measurement.1.

SETUP the measurements.2.

CALIBRATE your measurement.3.

Create an SMC Measurement

Press Setup > Main > Meas Class....1.

Select SMC, then either:2.

OK delete the existing measurement, or

New Channel to create the measurement in a new channel.

The default measurement is displayed.3.

See SMC measurements to learn about the parameters that are offered in each.4.

How to make SMC settings

Using Hardkey/SoftTab/Softkey
Using a mouse

Press Freq > Main > SMC Setup... .1. Click Stimulus1.

Select Frequency2.

Select SMC3.

Valid Mixer Configuration / Sweep Type Combinations

Configuring the SMC Setup dialog can be challenging at first.  RED messages like this one appear at

the bottom of the Setup dialog to notify you of an invalid setup.

At least one range (Input, LO, or Output) MUST be Fixed.

The following are the Valid Mixer Configurations:
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Sweep Type Input LO Output

Linear

Swept Swept Fixed

Swept Fixed Swept

Fixed Swept Swept

CW Time

Power
Fixed Fixed Fixed

 

Tips

Although you will soon become comfortable navigating these tabs, at first it may be best to

complete the dialog in the following order:

For 2-stage mixers, select Mixer Setup settings.1.

Select Sweep tab settings.2.

Select Mixer Frequency settings.3.

Select Power settings.4.

Select Mixer (LO) Power settings.5.

 

Sweep Tab - SMC dialog box help

Sweep Type

Linear  Sweep frequency. Measurements are displayed on a standard grid with ten equal

horizontal divisions.  Learn how to select the range to display on the X-Axis.

CW Time  All ranges are set to a Fixed (CW) frequency, and the data is displayed versus time.

Segment Sweep  Sweep user-defined segments. Learn more.

Power  Sweep Input or LO power.

 

X-axis Point Spacing (Available only with Segment Sweep) - Learn about this feature
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Number of Points  Learn about this feature.

IF Bandwidth  Learn about this feature.

 

Learn about these buttons.

 

Power Tab - SMC dialog box help

Note: Set LO Power on the Mixer (LO) Power tab.

Configures Input and Output power settings for an FCA measurement. Use the Mixer Power tab to set

LO power.

Power ON (All channels)  Check to turn RF Power ON or clear to turn power OFF for all

channels.

Port Powers Coupled   Check to set the same power level at the DUT Input and Output ports. The

LO power is NOT coupled. Clear to set power levels independently for each test port. Uncouple

power, for example, to apply more power in the reverse direction than in the forward direction

 Learn more about Setting Independent Port Power

DUT Input / Output Port

Select the VNA port that is connected to the DUT Input and Output. For VMC, the DUT input

must always be connected to VNA port 1 because of the need for a reference mixer on port 1.

Power Level  Set the power level to the DUT Input port. To set power at the Output port, clear

the Port Powers Coupled checkbox.

Source Attenuator Auto  Check to automatically select the correct attenuation to achieve the

specified input power. Clear, then select attenuator setting that is used achieve the specified

Power Level. Learn more about Source Attenuation.

All VNA channels in continuous sweep must have the same attenuation value. Learn more.

Receiver Attenuator  Specifies the receiver attenuator setting for the DUT port.

Source Leveling   Choose from: Internal (normal operation), Open Loop (used only for

Wideband Pulse measurements), or Receiver - R1 for Receiver Leveling.

DUT Input and Output Port Power Sweep

Available when Power (sweep) is selected on the Sweep tab.
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Input Start and Stop Power  To set Start and Stop power at the Output port, clear the Port

Powers Coupled checkbox.

Note: If your DUT requires more input power than this setting allows below 3.2 GHz, use the

VNA-X Hi-power mode, available from the RF Path Configuration dialog. The disadvantage to

this is higher harmonic content.

Power Points  Number of power points to measure.

Power Step (Size)  Calculated value from current Start, Stop, and Points settings. This setting can

NOT be changed directly.

 

 Learn about these buttons.

The following tabs are shared with all Mixer / Converter Applications:

Mixer Frequency tab

Mixer (LO) Power tab

Mixer Setup tab

Mixer Frequency tab - SMC Setup -dialog box help

Learn about this dialog
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Mixer Setup tab - SMC Setup -dialog box help

Learn about this dialog

 

Mixer (LO) Power tab - SMC Setup -dialog box help

Learn about this dialog

FCA Segment Sweep

The following settings appear on the Mixer Frequency tab when Segment Sweep is selected on the

Sweep tab.

Mixer Frequency tab - Segment Sweep - SMC dialog box help
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How to configure a segment:

Click Add. Click Delete to remove a segment and renumber all subsequent segments.1.

State is ON by default. Click OFF and that segment will not be included in the sweep.2.

Configure Frequency settings for Input, LO, and Output ranges.3.

For each segment, the same sweep requirements apply as a standard (non-segment) sweep. For
example, at least one range MUST be Fixed (Start = Stop frequencies).

The Input, Output, and LO frequencies of segments ARE allowed to overlap other segments.

All segments must sweep in either the forward (Start<Stop) or reverse (Start>Stop) directions. Mixed
sweep directions are NOT allowed.

The following settings can be set independently for each segment:

Number of Points - Total number of points for all segments is limited to the Max allowed by the
VNA.

IF Bandwidth

Port Powers: (Input, Output, LO 1, LO2). These settings override the settings on the Power tab.

The following settings apply to ALL segments:

Number of Converter/Mixer Stages (1 or 2).

LO Source Selections
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All Input and LO Multipliers and Dividers

Source and Receiver Attenuator Settings

Source Leveling

Avoid Spurs

Nominal Incident Power (SMC only)

X-Axis Display (Input, LO1, LO2, Output) There must be at least two data points for this setting to
be available.

X-Axis Point Spacing (vs Normal point spacing).

Mixer Segment sweep data can be saved to a *.S2PX file (NOT *.S2P).

Mixer Segment setup information is saved to a *.MXRX file. Learn more.

 Learn about these buttons

Apply and Interpolate FCA Cal Sets

In general, when a Cal Set covers a wider frequency range than the channel, the VNA will offer to

interpolate the Cal Set when it is applied. Learn more. However, with FCA measurements the LO

frequency range may also be considered.

SMC measurements ALWAYS IGNORE the LO frequency range. Therefore, if the Input and Output
frequency ranges of the measurements are within those of the Cal Set, then the Cal Set is interpolated if
necessary and applied. For example, this would allow you to perform ONE SMC calibration with Input range =
the VNA frequency span, LO at 0 Hz, and Output range + the VNA frequency span. This Cal Set could be
applied to ALL SMC measurements. Learn more about applying SMC al Sets.

These same general concepts apply to segment sweeps. However, if ALL applicable frequency ranges

(SMC: Input and Output) are NOT within those ranges of the measurement for ONE segment, then the
Cal Set is NOT applied for ANY segment.

Select X-axis Display for FCA Measurements

Click Sweep > Main > X-Axis Type, then select the desired type.

When Sweep Type = Linear, you can choose to show the frequency range of any of the swept

parameters on the X-axis.

For example, the following image shows an SMC Fixed Output response with the Input frequency
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range on the X-axis:

Output: 100 MHz (data trace)

Input: 2 GHz to 23 GHz (X-axis)

LO: 1.9 GHz to 22.9 GHz (not shown)

Marker annotation shows Output power at Input frequency.  

Save Trace Data

You can save your FCA measurement data in several standard formats.

Click Save Recall > Save Other > Save Data....

The following shows how CSV and SNP files are saved.

Mixer Trace Data

When you select Mixer Trace Data, the FCA data is saved to a CSV file in the following format:

#MIXER TRACE FILE,A.01.00

SegIndex, InputFreq, OutputFreq, LO1Freq, InputPower, LO1Power, SC21
Mag (dB), SC21 Phase (Deg)

SNP Format

Each record contains 1 stimulus value and 4 parameters (total of 9 values) as follows:
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Stim  Real(p1)   Imag(p1)   Real(p2)   Imag(p2)   Real(p3)   Imag(p3)   Real(p4)   Imag(p4)

where pX is the parameter depending on measurement type:

Measurement

Type

p1 p2 p3 p4

Scalar S11 SC21 (FWD) SC12 (REV) S22

If correction is OFF, data is only saved for the active parameter. Zeros are saved for all other parameters.

If correction is ON, data is saved for all of the parameters.

All files contain the following Header Information: Brackets [  ] contain parameters.

!Keysight [Instrument Model Number]: [version]
!Mixer S2P File: [Mixer Measurement Type]
!Parameters: [Parameter List]
!Calibration State: [On/Off]

!# Begin Mixer Setup
![Mixer Setup parameters listed here]
![Mixer Parameter 1]
.
.
![Mixer Parameter n]
!# End Mixer Setup

# [S2P data here]
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Scalar Mixer/Converter Measurements (SMC)

The following information is unique to SMC:

SMC Hardware Setup

Create an SMC Measurement

SMC Parameters Offered

The SMC Mixer Setup dialog

Speed Up SMC Measurements

Use Nominal Incident Power

Apply a Cal Set or SMC Cal Type

Reverse Port 2 Coupler below 55 MHz (separate topic)

SMC Calibration

See Also

Programming Commands

SMC Hardware Setup
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SMC requires a power meter/sensor, two sources, and a Cal Kit or ECal module

Your DUT can be connected to any VNA ports. Learn more.

Connect External Source to the VNA GPIB Controller port. Learn how to Configure an External Source.

Connect the 10 MHz reference signal of an external source to the VNA.

Use either a GPIB power meter or USB power sensor.

Create an SMC Measurement

Press Setup > Main > Meas Class....1.

Select SMC, then either:2.
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1.

2.

OK delete the existing measurement, or

New Channel to create the measurement in a new channel.

An SC21 measurement is displayed.3.

SMC Parameters Offered

To select additional parameters to display, click Trace, then click on a new trace, then select a

parameter from the list.

Important Note: Connecting your DUT to the VNA:

RF and IF terminology is NOT used in FCA because the VNA does not know how the DUT is

labeled or how it will be used. Instead, the general terms INPUT and OUTPUT are used.

INPUT - The DUT port being stimulated with frequencies before conversion.

OUTPUT - The DUT port outputting converted frequencies.

INPUT and OUTPUT Frequencies are specified using the Mixer Setup dialog box.

 

The DUT input and output can be connected to any VNA ports.

Note: Although there are MANY configuration possibilities, the following images and descriptions

show ONLY a DUT connected to VNA ports 1 and 2.

Legend:

   Black are ratioed measurements (test port/reference receiver).

   Green are unratioed measurements (either a test port OR reference receiver).
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DUT Input to VNA port 1

DUT Output to VNA port 2

DUT Input to VNA port 2

DUT Output to VNA port 1

Ratioed

SC21  (Conversion Loss)  Stimulus at Input,
response at Output (B/R1).

SC12 (Reverse Isolation)  Stimulus at Output,
response at Input (A/R2)

S11  (Input match)  Stimulus and response at
Input (A/R1)

S22  (Output match)  Stimulus and response at
Output (B/R2)

Ratioed

SC12  (Conversion Loss) Stimulus at Input,
response at Output (A/R2)

SC21 (Reverse Isolation)  Stimulus at Output,
response at Input (B/R1)

S11  (Output match)  Stimulus and response at
Output (A/R1)

S22  (Input match)  Stimulus and response at
Input (B/R2)

Unratioed  Absolute test port receiver measurements. The receiver is automatically selected

depending on the DUT configuration.

IPwr  (Incident Power) - stimulus and response at Input.

RevIPwr  (Reverse Incident Power) - stimulus and response at Output.

OPwr  (Output Power) - stimulus at Input, response at Output.

RevOPwr  (Reverse Output Power) - stimulus at Output, response at Input.

SMC Mixer Setup
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How to start the SMC Mixer Setup dialog

Using Hardkey/SoftTab/Softkey
Using a mouse

Press Sweep > Main > SMC Setup... > Mixer Setup tab.1. Click Stimulus1.

Select Sweep2.

Select SMC Setup...3.

Select Mixer Setup4.

The following SMC Mixer Setup dialog tabs are presented:

Sweep Tab (shared with VMC)

Power Tab (shared with VMC)

Mixer Freq Tab (shared with all converter apps)

Mixer Power Tab (shared with all converter apps)

Mixer Setup Tab (shared with all converter apps)

Speed Up SMC Measurements

Using default SMC settings, any calibrated SMC measurement requires four sweeps. However, you can

reduce the number of sweeps required by selecting one or more of the following settings.

Use Nominal Incident Power

Apply Cal Set or Cal Type

To speed up a Swept LO measurement when using an external source for the LO, use Hardware List (BNC)
Trigger setting . Learn more.

Reverse Port 2 Coupler below 55 MHz (separate topic)

Use Nominal Incident Power

Click Response, then Measure, then Use Nominal Incident Power  
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Each data sweep of a fully corrected SMC transmission measurement actually requires FOUR data

sweeps. When you clear Use Nominal Incident Power, the reference receiver (R1 or R2) does NOT

measure incident power. Instead, the incident power is assumed to be at the level that was set with the

Source Power Calibration that is done as part of every SMC measurement. The degradation in accuracy is

very negligible if the input or output of your DUT is well-matched.

This selection eliminates sweeps ONLY when both Include Input Match AND Include Output

Match is cleared on the Cal Type dialog. Learn more.

Apply a Cal Set or SMC Cal Type

You can create an FCA measurement and apply an existing Cal Set as you can with any VNA

measurement. Learn about Cal Sets. In addition, from a Cal Set, you can apply a specific SMC Cal Type

to an existing SMC measurement.

How to apply an SMC Cal Type

Create an SMC measurement1.

Calibrate or apply an existing SMC Cal Set, then...2.

Using Hardkey/SoftTab/Softkey

Press Cal > Main > Correction Methods....1.

 

Correction Method dialog box help
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By default, each SMC calibration requires FOUR sweeps. Clearing boxes will eliminate sweeps and

speed up your SMC measurements. The difference in speed is most noticeable when making fixed

input or fixed output measurements with an external LO source.

Include input match correction  Check to perform a sweep to measure and correct for INPUT

match. Clear this box if the input of your mixer is well-matched to the VNA, or if your setup does

not permit a valid S11 measurement.

Include output match correction  Check to perform a sweep to measure and correct for OUTPUT

match. Clear this box if the output of your mixer is well-matched to the VNA, or if your setup does

not permit a valid S22 measurement.

Include SC12 Sweep  Check to perform a reverse sweep to measure SC12.

When checked (default setting), a calibrated SMC measurement sweeps in both forward (SC21) and
reverse (SC12) directions.

Clear this checkbox to eliminate sweeps in the reverse direction. This means that the following
measurements will NOT be corrected: SC12, RevOPwr, RevIPwr.

Corrected Parameters  Lists the parameters that can be corrected given the boxes that are

currently checked. These parameters may not be currently measured.

Calibration Type  Shows the type of SMC Cal that will be applied given the boxes that are

currently checked.
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Learn about Use Nominal Incident Power

How many sweeps can be eliminated?

Setting Parameters Learn about parameter abbreviations # of sweeps

ALL checked and clear
Use Nominal Incident Power

IPwr,OPwr,RevIPwr,RevOPwr,SC21,SC12,S11,S224 Total

Perform this action...  to REMOVE these parameters... and these sweeps

Clear "Include SC12" Remove RevIPwr,RevOPwr,SC12 Removes 1

Clear "Include OUTPUT

match

Remove S22 Removes 1 when

Nominal is

checked*.

Clear "Include INPUT

match"

Remove S11 Removes 1 when

Nominal is

checked*.

Check "Use Nominal

Incident Power"

Remove IPwr, RevIPwr May remove up to

2*

ALL cleared and check

Nominal Incident

Power

OPwr,SC21 1 Total

*S11 shares a sweep with IPwr and S22 shares a sweep with RevIPwr. Therefore, when Include

Input Match or Include Output Match is checked, then checking Nominal incident power does

nothing.

VMC measurement sweeps can NOT be eliminated.

SMC Calibration Overview

The Cal All Wizard guides you through the calibration process on the M937xA.

Note: Before SMC Calibration, perform the System Receiver Cal.

The SMC Calibration Wizard guides you through this process.

When applying a Phase Reference cal set, step 1 (power cal) is NOT performed.

Connect a power meter / sensor to VNA Port 1. At each step of the input and output frequency, the VNA
measures:

input match of the power sensor

source power of the VNA

1.

2.
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Perform two Full 2-port calibrations: one over the INPUT frequencies and one over the OUTPUT frequencies
of the DUT. (If your DUT is a linear device, the calibration uses only the INPUT frequency range.) Use either
a mechanical calibration kit or an ECal module.

2.

For Mixers / Converters with High-output Power

The Unknown Thru method is NOT valid when there is over 40 dB of combined loss in the Unknown

Thru and calibration path. In this case, the following calibration and correction method is

recommended.

On the Cal Wizard Modify Frequency page, select Defined Thru or Flush Thru as the Thru method. When
using an ECal module, also on the Modify Frequency page, disable (clear) Do Orientation due to very low
power.

After calibration, on the Correction Method dialog, CLEAR the Include output match correction and
Include SC12 Sweep check boxes. Check ONLY Include input match correction.

To learn more about High-power measurements, see our App Notes.

SMC Cal Wizard

NOTE: The Smart Cal wizard is not available for the M937xA

The following dialog boxes are presented during an SMC Calibration.

Indented steps are optional.

Calibration Setup

Waveguide/In-fixture/On-Wafer Setup

Select DUT Connectors and Cal Kits

Modify Frequency Cal

Specify how the ECal module is connected

Power Cal Settings

SMC Cal Steps

Calibration Completed

Specify Adapter Delay
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How to Perform a SMC Calibration

Create an SMC measurement, then...1.

Using Hardkey/SoftTab/Softkey
Using a mouse

Press Cal > Main > Smart Cal....1. Click Response1.

Select Cal2.

Select Smart Cal...3.

 

SMC Calibration Setup dialog box help

Allows you to review and change the settings for your SMC calibration.

Note: With release A.09.90 and before, checking both 'Independent power cals' AND 'Use Phase

Reference Calset' would generate an error after performing the calibration. With releases AFTER

A.09.90, the two settings are compatible.

Waveguide/In-fixture/On-Wafer Setup  Click Next to launch the following Setup dialog box.

Independent power cals for input and output ports (no thru)  Check if a Thru standard is NOT

available. During the power cal, you will be prompted to connect the power sensor to the Input, then
the Output port.

Additional Power Cal Steps

Enable LO1 / LO2 Power Cal  Check when LO1 / LO2 is controlled (on the Mixer Setup tab) to

perform a Power Cal on the LO source(s).

Phase Correction
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Enable Phase Correction  Check to enable Phase measurements.

Choose one of the following methods to specify the delay through the characterized mixer. With the

first two methods, the phase delay through a Calibration Mixer is measured and compared to the

known delay, either entered, or stored in an *.S2PX file.

Use Known Mixer Delay  Enter the fixed, known, delay through the calibration mixer.

Use characterized mixer  Select, then browse to the *.S2P file that characterizes the calibration mixer.
 Use an *.S2PX file when making segmented SMC + Phase measurements. Learn more. Use either of
the following two methods to characterize the Cal Mixer over the SMC measurement frequency range:

Use the Mixer Characterization Wizard. (Click Response, then Cal, then Mixer Characterization
Wizard.) The Cal Mixer has the same requirements as the VMC Cal Mixer. Learn more.

1.

In a calibrated VMC channel, measure the group delay of the calibration mixer, then save to an
*.S2P or *.S2PX file. However, a characterized mixer is required to calibrate the VMC channel.

2.

Use Phase Reference Calset  Select, then browse to the Phase Reference Calset that covers the
frequency range of the current measurement. Learn more about SMC with a Phase Reference
Calibration.

 

 

Waveguide/In-fixture/On-Wafer Setup dialog box help

This dialog box appears ONLY if you checked the Waveguide/In-fixture/On-Wafer Setup box in

the previous Cal Setup dialog.

Allows you to embed or de-embed circuit networks on the input and output of your mixer under

test.

For Network1 (Input) and Network2 (Output) select Embed, De-embed, or None.
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Browse  Click to navigate to the .S2P file that models the network to embed or de-embed.

Reverse port positions for input/output  Check to cause the Fixture/Adapter to be configured

with Port 2 connected to the VNA and Port 1 to be connected to the DUT. The image in the dialog

is updated to reflect that change.

Enable Extrapolation  Check (default setting) to apply a simple extrapolation when the S2P file

has a narrower frequency range than the channel. The values for the first and last data points are

extended in either direction to cover the frequency range of the measurement. A warning message is

also displayed when extrapolation is necessary.

To Embed or De-embed

When you have a 2 port network that needs to be connected between the Cal reference plane and the
DUT during the measurement, but it is NOT present during the calibration, then that network has to be
De-Embedded from the port in question during the calibration. In other words, De-Embedding in FCA
calibration extends the calibration reference plane to include the two port network.

When you have a 2 port network that is included as part of the calibration reference plane but has to be
disconnected during the measurement, then that 2-port network has to be Embedded for the port in
question during the calibration. In other words, Embedding in FCA calibration retracts the calibration
reference plane to exclude the two port network during the measurement.

Notes

Characterize Adaptor Macro can be used to create the S2P file.

Interpolation is performed when more frequencies are included in the file than in the channel, and the
data points do not exactly match those of the measurement.
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Select DUT Connectors and Cal Kits dialog box help

Allows you to specify the connector type and Cal Kit for each DUT port.

Port n  For each listed VNA port, specify the DUT connector type and gender, and the Cal Kit

to use.

Note: If your DUT connectors are:

Waveguide  Change the system impedance to 1 ohm before performing a calibration. See Setting
System Impedance.

Not listed (male and female)   Select Type A as the connector type. Type A requires a calibration kit file
containing the electrical properties of the standards used for calibration (see Calibration kits).

Unspecified (like a packaged device)  Select Type B as the connector type. Type B requires a
calibration kit file containing the electrical properties of the standards used for calibration (see Calibration
kits).

Modify Cal  Check, then click Next, to start the Modify Frequency Cal dialog.

Source Cal Settings  Click to start the Source Cal Settings dialog.
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Modify Frequency Cal dialog box help

This dialog appears only when Modify Cal is checked on the previous dialog.

The following selections are available ONLY if using an ECal module.

Do orientation   When this box is checked (default) the VNA senses the ECal model and

direction in which the ECal module port is connected to the VNA ports. If power to the ECal

module is too low, it will appear as if there is no ECal module connected. If you use low power

and are having this problem, clear this check box to provide the orientation manually. Orientation

occurs first at the middle of the frequency range that you are calibrating. If a signal is not

detected, it tries again at the lowest frequency in the range.

 

Power Cal Settings dialog box help

Note: A Use Power Table checkbox (not shown) is available when a mmWave SMC measurement

is active. Learn more.

Power Cal at: Select the source port for which a Power Calibration will be performed. The source

and receiver correction will be transferred to all other sources and receivers involved in the S-

parameter measurements.

Use Multiple Sensors  (NOT available with mmWave SMC measurements.) Check this box

when you want to use more than ONE power sensor to cover the measurement frequency

range. The dialog is replaced with the Multiple Sensors dialog (see following image). When

"Use Multiple Sensors" is cleared (default setting), connect only ONE sensor to the VNA.

1906



Power Meter Settings  Click to start the standard Power Meter Settings dialog.

De-embed (power sensor) adapter  When the power sensor connector is NOT the same type and

gender as the DUT connector for the specified port, then for optimum accuracy, extra cal steps are

required to measure and correct for the adapter that is used to connect the power sensor to the

reference plane.

Clear this box to NOT compensate for the added adapter.

Check this box to perform extra calibration steps to measure and correct for the adapter.

Then select the Power Sensor Connector type and gender of the power sensor. "Ignored" does

NOT compensate for the added adapter, just as if the checkbox were cleared.

When this connector matches the DUT connector for the same port, then the VNA assumes that

there is no adapter. Extra cal steps are NOT required and the Cal Kit selection is not available.

Otherwise, select the Cal Kit to be used to calibrate at the adapter.

See Accuracy Settings below.

 

Specify how the ECal module is connected dialog box help

This dialog box appears when the Do orientation checkbox in the previous Modify Frequency
dialog box is cleared.

Click the ECal Port that is connected to each VNA port.
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SMC Calibration Steps dialog box help

Power Level at which to perform the Power Cal.

It is usually best to set power level to 0 dBm at the power sensor because the power sensor is

calibrated at that level. Lower power levels will yield a slower and noisier calibration.

If an external component is used between the VNA-X test port and the calibration reference plane,

then adjust the power level so that the power at the sensor is about 0 dBm if possible.

The current source attenuation value is shown on the dialog.

LO Power Cal (Optional) When enabled, perform a Source Power Cal at the DUT LO

connector. An LO must already be selected. Learn how. The power level of the LO source

calibration is set on the (LO) Power Tab.

 

Calibration Completed dialog box help

Finish  Save to the channel's calibration register.

Save As User Cal Set  Starts the Save as User Cal Set dialog box AND save to the channel's

calibration register.

Cancel  Calibration is NOT applied or saved.

Learn about Calibration Registers.
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Learn about User Cal Sets

Specify delay dialog box help

This dialog appears ONLY when Adapter Removal or Unknown Thru calibrations are performed.

The following values were estimated from the measurement. Most of the time, they are adequate.

However, for CW sweep or frequency sweep with large step sizes, the accuracy of the values may

be improved.

Adapter delay  To improve this value, measure and record the delay of the adapter with a dense

step size. Enter that value here. The required precision value is the accuracy that is required to

characterize the delay value.

Nominal phase offset  (Waveguide ONLY). To improve this value, measure and record the phase

offset of the Waveguide adapter with dense step size. Enter that value here.

When one connector is coax and the other connector is waveguide, the phase offset has an

ambiguity of 180 degrees. For consistency, the estimate provided here is always between 0 and 180

degrees. You can change this estimate to any value between -180 degrees and +180 degrees.

For SMC calibrations, this dialog box appears twice: once for the input frequencies and once for

the output frequencies. The values can be slightly different.
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Mixer/Converter Setup

The following dialogs are common to all Converter Apps: FCA, Swept IMDx, IMx Spectrum, NFx, and

GCx applications.

Note: Swept IMDx, IMx Spectrum, NFx are supported by PNA only. GCx is currently not supported

on the M9370A/71A/72A/73A/74A/75A.

Mixer Frequency tab

Mixer Setup tab

Mixer (LO) Power tab

Fractional Multiplier Examples

Important Note: Connecting your Mixer/Converter DUT to the VNA.

RF and IF terminology is NOT used in this topic because the VNA does not know how your DUT

is labeled or how it will be used. Instead, the general terms INPUT and OUTPUT are used to

describe the following VNA behavior:

INPUT - the stimulus frequencies BEFORE conversion by your DUT.

OUTPUT - the response frequencies, AFTER conversion (either UP or DOWN) by your DUT. Specify UP
or DOWN conversion using the + or - symbol for each output.

 

Mixer Frequency tab help
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Settings

Frequency Format   Select Start/Stop (Swept) or Fixed. For Linear sweep type, at least one of

these must be fixed. For CW or Power, ALL must be Fixed.

Frequencies  Enter the frequency values for each of the Mixer/Converter ports.

Mixer-Product Selector  Determines whether the receivers will tune to the Sum (+) or

the Difference ( - ) of the Input and LO frequencies.

Calc buttons  Calculates frequency settings based on your other mixer settings. For example, enter
the Input frequency range and LO1 frequency range, then press Calc Output.  The VNA will

calculate and display the Output frequencies.

Input > LO or IF1>LO2  Removes ambiguity when using a Calc button to determine the INPUT

frequency.

These check boxes are used ONLY when all 3 of the following conditions are TRUE:
(If ALL 3 are NOT true, the VNA does not read these check boxes).

Difference (Low) sideband  is selected for the corresponding Calculate button AND1.

2.

3.
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1.

Output frequency is less than the LO frequency AND2.

One of the Calculate buttons are used to calculate the Input frequency.3.

Rules for Configuring a Mixer

A Red message across the bottom of the dialog indicates that one or more of the following settings

are invalid:

Either ALL ranges (Input, LO, Output) must be Fixed, or ONE Range fixed. TWO ranges can

NOT be Fixed or THREE ranges can NOT be Swept.

For determining a valid mixer configuration with 2 LOs, one Fixed LO and one Swept is

equivalent to having a single-stage Swept LO. To configure a 2-stage LO, select Converter

Stages: 2 on the Mixer Setup tab.

INPUT or OUTPUT frequencies cannot be outside the range of the VNA.

Any combination of INPUT and LO which results in an OUTPUT that sweeps through Zero

Hz is NOT allowed.

About Mixer Configuration Files (.mxr and *.mxrx)

Save  Saves SOME of the mixer settings to a *.mxr or *.mxrx file.

Load  Recalls a previously-configured mixer *.mxr or *.mxrx file .

Note: By default, mixer configurations are saved to a *.mxrX file. Previously, they were

saved to a *.mxr file.

ONLY *.mxrx files allow saving segmented sweep mixer setups. Currently, only allows

segmented sweeps. In all other respects, these new file types are completely backward

compatible with *.mxr files.

What Mixer Settings are Saved?

Sweep Type, frequency, and power settings.

With Segment Sweep Type, all segment settings are saved.

Converter App Compatibility

The mixer setup files that are used with FCA, NFx, and GCx for PNA ARE compatible.

However, *.mxr(x) files created in IMDx contain information that is NOT included with other

1912



*.mxr(x) files.

External Sources

A *.mxr(x) file includes an LO source name. However, It does NOT include the LO Source

configuration.

 

Apply  Applies the settings for your mixer/converter test setup to the measurement. The mixer

setup dialog box remains OPEN.

OK  Applies the settings for your mixer/converter test setup to the measurement. The mixer setup

dialog box CLOSES.

Cancel  Closes the mixer setup dialog box and does NOT apply the settings.

 

Mixer Setup tab help

Converter Stages  Select either 1 or 2-stage converters.

Hardware Configuration

Add Source  Click to start the External Device Configuration dialog.

DUT Ports

Select VNA ports to connect to the DUT input and output.

Note: In M9485A, Only ports 1 to 4 can be set even if your unit has more than 4-port configuration.

Fractional Multipliers

The combination of (numerator / denominator) forms a fractional value that is

multiplied by the input and LO frequency ranges. These values are used to calculate the response

frequency of the VNA receiver for the converter output. Use the fractional multipliers to:

simulate the action of harmonic mixers

simulate the action of multipliers and dividers that may exist in your test setup
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tune the VNA receiver frequency to a harmonic of the mixer/converter

The range for the numerator and denominator of a fractional multiplier is from +1 to +10. Negative

values are NOT allowed.

See Fractional Multiplier examples.

LO1 and LO2

Select Not controlled to allow an external source to provide a Fixed LO Frequency at all times.

Otherwise, select an internal VNA source or External source to be used as the LO. Learn how to

Configure an External Device (Source).

See Also

How to measure a DUT with an Embedded LO

 Learn about these buttons.

 

 

Mixer (LO) Power tab help
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Configures LO Power settings.

Power ON (All channels)  Check to immediately turn ON or OFF ALL VNA internal RF Sources

for all channels.

LO1 Power  Sets the power level for LO1.

LO2 Power  Sets the power level for LO2.

Swept Power Settings Set the power sweep setting.

Path Configuration (PNA only)  

 

 Learn about these buttons.

 

Fractional Multiplier Examples

Example 1
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Use the LO fractional multiplier to replicate the action of the third-harmonic mixer so the VNA can

accurately calculate the receiver frequency. The input and LO frequencies are known.

Enter these settings in the Mixer Setup dialog box:

Input Start Freq: 30 GHz

Input Stop Freq: 40 GHz

LO Fixed Freq: 16 GHz

Mixer-Product Selector:  - (difference)

LOs: 1

LO fractional multiplier:  3/1

INPUT fractional multiplier:  1/1

Click Calculate Output

Results:

Output Start Freq: 18 GHz

Output Stop Freq: 8 GHz

Example 2

Use the fractional multipliers to tune the VNA receiver frequency to the second harmonic of the mixer's
14 GHz fundamental output. The input, LO, and output frequencies are known.
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Enter these settings in the Mixer Setup dialog box:

Input Start Freq: 4 GHz

Input Stop Freq: 4 GHz

LO Fixed Freq: 10 GHz

Mixer-Product Selector: + (Sum) of the input and LO signals

LOs: 1

INPUT fractional multiplier = 2/1

LO fractional multiplier = 2/1

Click Calculate Output

Results:

Output Start Freq: 28 GHz

Output Stop Freq: 28 GHz

Example 3

Use the LO fractional multiplier to replicate the action of the divide-by-two mechanism inside the

mixer package. Having done this, the VNA can accurately calculate the receiver frequency. The input

and LO frequencies are known.
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Enter these settings in the Mixer Setup dialog box:

Input Start Freq: 45 MHz

Input Stop Freq: 50 MHz

LO Fixed Freq: 670 MHz

Mixer-Product Selector: + (Sum) of the input and LO signals

LOs: 1

INPUT fractional multiplier = 1/1

LO fractional multiplier = 1/2

Click Calculate Output

Results:

Output Start Freq: 380 MHz

Output Stop Freq: 385 MHz
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Frequency Offset Mode

Frequency Offset Mode (FOM) provides the capability to have the VNA Sources tune to frequencies

that are different (offset) from the VNA Receivers.

This topic discusses the VNA settings that are relevant to making these types of measurements. See

Frequency Converting Device Measurements for more information on making specific device

measurements.

Frequency Offset Dialog Box

Setup Examples

Other Frequency Offset topics

How to make Frequency Offset settings

Using Hardkey/SoftTab/Softkey

Press Sweep > Source Control > Frequency Offset....1.

 

Frequency Offset dialog box help
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The following are major changes to FOM:

Stimulus and Response are now called Sources and Receivers.

Sources and Receivers settings can be made in two ways:

By Coupling to the Primary (Channel) settings. This is the only method used in previous
releases.

1.

By Uncoupling and setting Sources and Receivers values independently. This is the new,
simplified method.

2.

External sources appear here and can be controlled from this dialog. Learn more.

Frequency Offset (ON/OFF)  Enables Frequency Offset Mode on ALL measurements that are

present in the active channel.

When FOM is NOT enabled, all frequencies are the same as the active channel.

Tip: First make other settings on this dialog box, then click Frequency Offset ON.

Primary  The current Active Channel settings. When a Source or Receiver is coupled to the

Primary settings, its Sweep Type is the same as that of the Primary.  The frequency settings of the

coupled range are mathematically derived from the Primary settings using the Multiplier, Divisor, and
Offset values. With this approach, only the Primary settings need to be changed in order to affect

change in the coupled Sources and Receivers. Changes to the Primary channel settings occur

when Frequency Offset is checked ON.  See example using Primary and Coupled setting.

Tip: Primary settings are ONLY used when Sources and Receivers are Coupled. It is often easier

to Uncouple, then set Sources and Receivers independently.

Receivers  All receivers that are used in the channel, including Reference receivers, are tuned to

the specified frequency settings.

Mode

Coupled  Source and Receiver settings are mathematically derived from the Primary settings

using Multiplier, Divisor, and Offset values. Learn more.

Uncoupled  Source and Receiver settings are entered independently, without reference to Primary

settings. When Uncoupled, Source and Receiver Ranges can use separate sweep types.

Sweep Type  Click to change the type of sweep for each range. Only available for Primary and
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Uncoupled Sources and Receivers.

Unsupported Sweep Type combinations

Power Sweep and Segment Sweep can NOT be used together.

Uncoupled Log Sweep yields invalid data whenever the sources are offset from the

receivers.

Coupled Log Sweep is allowed only for the following two conditions:

The offset = 0, the multiplier = 1, and the divisor = 1.1.

The multiplier = 02.

Settings  To change settings, click IN the appropriate Settings cell, then click Edit.

If coupled, invokes the Coupled dialog.

If uncoupled or Primary invokes the Uncoupled settings dialog.

X-Axis  Select the settings to be displayed on the X-Axis.

X-Axis Point Spacing  Only available when a Segment Sweep Type is selected as the X-Axis

display. Learn more.

Note:  When Frequency Offset is enabled, ALL receivers on the channel, including the reference

receivers, tune to the new offset frequencies, Therefore the source and reference receiver will be

at different frequencies. Therefore, FOM measurements that include a reference receiver, which

includes all S-parameters, display invalid data.

To measure and display measurements at both the source and receiver frequencies, you must use

two channels. Use Equation Editor to calculate the conversion loss. See a calibrated FOM conversion
loss example.

Learn how to calibrate frequency offset measurements.
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Coupled settings dialog box help

Coupled Formulas:

Range Start = [Primary Start x (Multiplier / Divisor)] + Offset

Range Stop = [Primary Stop x (Multiplier / Divisor)] + Offset

Where:

Offset  Specifies an absolute offset frequency in Hz. For mixer measurements, this would be the

LO frequency. Range is +/- 1000 GHz. Offsets can be positive or negative.

Multiplier  Specifies (along with the divisor) the value to multiply by the stimulus. Range is +/-

1000.

Negative multipliers cause the stimulus to sweep in decreasing direction. For downconverter

mixer measurements, this would be for setups requiring the Input frequency to be less than

LO frequency. See an example.

0 (zero) as the multiplier nulls the Primary setting. Then the Offset value adds to zero.

Divisor  Specifies (along with the multiplier) the value to multiply the stimulus. Range is 1 to

1000.

 

Primary and Uncoupled settings dialog box help
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This dialog will vary depending on the sweep type:

Linear and Log frequency

Uncoupled Log sweep yields invalid data whenever the sources are offset from the receivers.

Select Start/Stop or Center/Span

Frequency  Enter values

Points  (Primary only) Enter number of data points for the sweep.

Power

CW Freq  Enter frequency in Hz.

Points  (Primary only) Enter number of data points for the power sweep.

CW Time

CW Freq  Enter frequency in Hz.

Sweep Time  Enter time to complete one sweep. Enter 0 for the fastest sweep.

Segment Sweep  Edits are made exactly like the standard segment table.

For Advanced Users: Uncoupled Segment Sweep offers great flexibility in configuring
measurements. In segment sweep mode:

The OK button is NOT available until the total number of data points for all segments matches the
number of Primary data points.

Independent IF Bandwidth and Independent Sweep Time are available ONLY on the Primary (channel)
and the Uncoupled Receivers - NOT Sources.
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Independent Power is available ONLY on the Primary (channel) and the Uncoupled Sources - NOT
Receivers.

Setup Examples

Although the Frequency Offset settings can be used with many types of devices, these examples

include mixer terminology.

1. Fixed LO - Upconverter

Swept Stimulus (Mixer Input): 1000 MHz - 1200 MHz

Fixed LO: 1500

Swept Response (Mixer Output): 2500 MHz to 2700 MHz

Make the following settings on the FOM dialog

Source: Uncoupled

Sweep Type: Linear

Click Settings, then Edit. In the Source dialog:

Start Frequency = 1000 MHz

Stop Frequency = 1200 MHz

Receiver: Uncoupled

Sweep Type: Linear

Click Settings, then Edit. In the Receiver dialog:

Start Frequency = 2500 MHz

Stop Frequency = 2700 MHz

LO Settings

Set external source to CW - 1500 MHz.

2. Fixed LO - Downconverter (Input < LO)

Swept INCREASING Stimulus (Mixer Input): 1000 MHz to 1100 MHz
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Fixed LO: 2500 MHz

Swept DECREASING Response (Mixer Output) 1500 MHz to 1400 MHz

Make the following settings on the FOM dialog

Primary: Not used

Source (Input): Uncoupled

Sweep Type: Linear

Click Settings, then Edit. In the Source dialog:

Start Frequency = 1000 MHz

Stop Frequency = 1100 MHz

Receiver (Output): Coupled

Sweep Type: Linear

Click Settings, then Edit. In the Receiver dialog:

Offset: 2500 MHz

Multiplier: -1 (Minus one)

LO Settings

If using external source, set  to CW: 2500 MHz.

See a calibrated FOM conversion loss example.

3. Swept LO - Fixed Output - Upconverter

Swept External LO measurements in Frequency Offset Mode can be very difficult. The

external LO source must be synchronized with the swept output or input (as in this case). See

Synchronizing and External Source Control to see how this is done. The Frequency Converter
Application Opt S93083A performs makes these measurements easily.

Swept Stimulus (Mixer Input): 1000 MHz to 1100 MHz

Swept LO: 1500 MHz to 1400 MHz

Fixed Response (Mixer Output): 2500 MHz

1925



Make the following settings on the FOM dialog

Source: Uncoupled

Sweep Type: Linear

Click Settings, then Edit. In the Source dialog:

Start Frequency = 1000 MHz

Stop Frequency = 1100 MHz

Receiver: Uncoupled

Sweep Type: CW Time

Click Settings, then Edit. In the Receiver dialog:

CW Frequency = 2500 MHz

LO Settings

If using external source, set to sweep from 1500 - 1400 MHz.

4. Power Sweep for Mixers

To measure the gain compression of a mixer, the input power to the mixer is swept. The input

and output frequencies are fixed but offset from one another.

This is a good use of Coupled settings because the same compression test can be performed at

several different frequencies. With coupled Source and Receiver ranges, the Primary (channel)

frequency can be easily changed from the front panel. The coupled source and receiver

frequencies will update accordingly.

Swept Input Power: -10 dBm to 0 dBm

Fixed Input Frequency: 1500 MHz

Fixed LO: 500 MHz

Fixed Output: 2000 MHz

Make the following settings on the FOM dialog

Primary:
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Sweep Type: Power Sweep

Click Settings, then Edit. In the Primary dialog:

CW Frequency = 1500 MHz

Source: Coupled

Default settings make CW Frequency: 1500 MHz (same as Primary)

Receiver: Coupled

Default settings make Sweep Type: CW Time

Click Settings, then Edit. In the Receiver dialog:

Offset  = 500 MHz

LO Settings

If using external source, set  to CW: 500 MHz.
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Frequency Converting Device Measurements

Note: The M9370A/71A/72A/73A/74A/75A does not support this function.

Many frequency offset measurements can be made using the VNA with option 080.  The following is a

list of some of those measurements and how they are made.

Conversion Loss

Conversion Compression

Return Loss and VSWR

Harmonic Distortion

See Also: Frequency Offset Measurement Accuracy
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Frequency Offset Measurement Accuracy

This topic discuss methods that can be used to make accurate frequency offset measurements.

Calibrations

Mismatch Errors

Accurate and Stable LO

See other Mixer Measurement topics

Calibrations

With Frequency Offset measurements, the stimulus and response frequencies are different. Standard

calibration error terms are calculated using reference measurements. Therefore, traditional calibration

methods such as full 2-port SOLT cannot be used with frequency offset.

Source and Receiver Power calibrations can be used to calibrate your Frequency Offset measurements.

Frequency Converter Application offers fully calibrated scalar and vector frequency offset measurements.

Source Power calibration:

Sets accurate power level at stimulus frequencies regardless of the receiver that will be used in the
measurement.

Can be copied to other channels with copy channels feature.

Can be interpolated.

Receiver Power Cal:

Requires a source cal to have already been performed and applied.

Cannot be copied to other channels.

Therefore:

Start by performing a source power cal over the combined stimulus and response frequencies.
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Copy the channel to other needed channels and the source power cal is copied.

Change the frequency range of the copied channel to response frequencies.

Perform a receiver cal at the response frequencies on individual channels.

Change the frequency range to stimulus frequency and switch frequency offset ON.

On Status Bar, ensure that source and receiver cals are ON (source cal will be interpolated).

See Frequency Offset Conversion Loss Measurements to see a step-by-step example.

Mismatch Errors

Mismatch errors result when there is a connection between two ports that have different impedances.

With S-parameter measurements, these mismatches are measured and mathematically removed during

a full 2-port calibration. This is much more difficult with frequency offset measurements. A much

easier solution is to use high-quality attenuators on the input and output of the mixer.

By adding a high-quality attenuator to a port, the effective port match can be improved by up to twice

the value of the attenuation.  For example, a 10-dB attenuator, with a port match of 32 dB, can

transform an original port match of 10 dB into an effective match of 25 dB. However, as the match of

the attenuator approaches the match of the original source, the improvement diminishes.

Note: The Frequency Converter Application (option S93083A) uses calibration techniques that correct

for mismatch errors.

 

The larger the attenuation, the more nearly the resulting match approaches that of the attenuator, as

shown in the following graphic. However, excessive attenuation is not desired because that will
decrease the dynamic range of the measurement system.
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Accurate and Stable LO

When using frequency offset mode, if the LO signal is not accurate and stable, the output signal will

not be at the expected response frequency. As a result, the output signal can fall on the skirts of the

VNA receiver IF filter, or fall completely outside of the receiver filter passband.

Also, the LO power level is critical in mixer measurements. Be sure to monitor these power levels

closely.
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Conversion Loss (or Gain)

Note: The M9370A/71A/72A/73A/74A/75A does not support this function.

What is Conversion Loss?

Why Measure Conversion Loss?

How to Measure Conversion Loss

See other Frequency Converting Device Measurements

What is Conversion Loss?

Conversion loss is defined as the ratio of the power at the output frequency to the power at the input

frequency with a given LO (local oscillator) power. This is illustrated in the graphic below. A specified

LO power is necessary because conversion loss varies with the level of the LO, as the impedance of the

mixer diode changes.

 

Why Measure Conversion Loss?

Conversion loss (or gain in the case of many converters and tuners) is a measure of how efficiently a

mixer converts energy from the input frequency to the output frequency. If the conversion loss response

of a mixer or converter is not flat over the frequency span of intended operation, valuable information
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may be lost from the resulting output signal.

How to Measure Conversion Loss

Conversion loss is a transmission measurement. It is measured by applying an input signal (stimulus)

and an LO signal at specific known power levels, and measuring the resulting output signal level.

Because the output frequency is different from the input frequency, frequency offset mode (option

S93080A) must be used for this measurement.

Note: This measurement is made much easier if your VNA has the Frequency Converter Application

Equipment Setup

 

Example: A calibrated Conversion Loss (Down-converter) measurement

Swept Input with Fixed LO = Swept Output

RF Input: 3.1 - 3.3 GHz

LO:  2.2 GHz

IF Output: 900 - 1100 MHz

VNA setup and calibrate on channel 1

On channel 1 create an unratioed R measurement over the ENTIRE input and output frequency span (.9 -
3.3 GHz).   This will be the base source power cal that will be copied to the R and B channel measurements.

1.

Perform a source calibration using a power meter. This makes the power level at the input of the mixer very
accurate.

2.
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2.

Setup Reference measurement on channel 2

Copy channel 1 to channel 2 which will display the reference input to the mixer. The channel 1 source power
cal is copied with the other channel settings.

1.

Change measurement to R1 unratioed.  2.

Change RF Input frequency to 3.1 - 3.3 GHz.  The source power cal becomes interpolated.3.

Perform receiver power cal.  Do not need to make physical connections. The VNA source is internally
connected to the R1 receiver. Makes the R receiver read the source power level.

4.

Setup B measurement on channel 3

Copy channel 1 to channel 3.  This channel will display the output of the mixer. The channel 1 source power
cal is copied with the other channel settings.

1.

Change measurement to B unratioed.2.

Change IF Output frequency to .9 - 1.1 GHz.  This causes the source power cal becomes interpolated.3.

Connect thru line from port 1 to port 2.4.

Perform receiver power cal.  This makes the B receiver read the source power at the IF Output frequencies.5.

Turn OFF receiver power cal.  This prevents an error when changing to input frequencies (next step).6.

Change RF Input frequency to 3.1 - 3.3 GHz.  This changes the channel back to the mixer RF Input
frequencies.

7.

Enable Frequency Offset.8.

Change Offset to (-2.2 GHz).  This tunes the B receiver to the IF Output frequencies .9 to 1.1 GHz. Note:
The minus sign indicates a down-converter measurement.

9.

Turn ON receiver power cal.10.

Measure the Mixer

Connect the mixer.1.

Adjust scale to suit your needs.2.

Enable markers to read power levels for each trace.3.

The display below shows:
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3.

Ch3 B receiver (bottom trace) absolute output power.

Ch2 R1 receiver measurement (top trace) absolute input power to the mixer.

With this method, the conversion loss math (B/R1) can be performed with Equation Editor (not shown).

The B/R1 ratio measurement is not supported with receiver power Cal turned on. However, conversion

loss (C21) measurements can be made directly and are much easier using the Frequency Converter

Application, FCA  (Opt S93083A).

 

1935



Conversion Compression

Note: The M9370A/71A/72A/73A/74A/75A does not support this function.

What is Conversion Compression?

Why Measure Conversion Compression?

How to Measure Conversion Compression

Measurement Accuracy Considerations

See other Frequency Converting Device Measurements

What is Conversion Compression?

Conversion compression is a measure of the maximum input signal level for which a mixer will

produce linear operation. It is very similar to the gain compression experienced in amplifiers.

To understand conversion compression, you must first understand conversion loss. This is the ratio of

the mixer output level to the mixer input level. This value remains constant over a specified input

power range. When the input power level exceeds a certain maximum level, the constant ratio between

input and output power levels begins to change. The point at which the ratio has decreased 1 dB is

called the 1-dB compression point. This is illustrated in the graphic below.
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Why Measure Conversion Compression?

Conversion compression is an indicator of the dynamic range of a device. Dynamic range is generally

defined as the difference between the noise floor and the 1-dB compression point.

How to Measure Conversion Compression

The equipment and setup used to measure conversion compression are essentially the same as for

measuring conversion loss and is illustrated in the following graphic.

The VNA performs a power sweep using frequency-offset mode and the resulting display shows the

mixer's output power as a function of its input power. The 1-dB compression point (or others such as 3-

dB) can be determined using markers.

 

 

Measurement Accuracy Considerations

Equipment Setup Considerations

The couplers in the VNA have very good directivity. If the return loss of the DUT is bad, the reflected signal
gets sampled by the VNA and can result in errors. This relates to error in DUT gain. To increase the
accuracy, an attenuator can be added between the VNA's source port and the  DUT's input port. Normally a
6- to 10-dB attenuator is sufficient. Addition of this attenuator, however, decreases the available drive to the
DUT.

With high drive levels the VNA can be driven into compression resulting in measurement error. With
excessive drive levels, the VNA can be damaged. Add an attenuator between the output of the DUT and the
receiver input of the VNA to avoid these problems.
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Calibration Considerations

Source power calibration can be used to provide a high level of accuracy for this measurement.
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Harmonic Distortion

What is Harmonic Distortion?

Why Measure Harmonic Distortion?

How to Measure Harmonic Distortion

Measurement and Accuracy Considerations

See other Frequency Converting Device Measurements

What is Harmonic Distortion?

Harmonics are multiples of any signal appearing at the mixer input and also multiples of the LO input.

The distortion of the mixer's output characteristics caused by these harmonics is referred to as harmonic

distortion. Harmonic distortion is caused by non-linearities in the device.

Harmonics are NOT signals created by two or more signals interacting (mixing); these signals are

known as intermodulation products, which result in intermodulation distortion.

Why Measure Harmonic Distortion?

It can degrade the performance of devices connected to the output of the mixer.

The harmonics can also mix with other signals present in the mixer, adding to the intermodulation distortion
of the mixer.

How to measure Harmonic Distortion

The harmonics can be measured using the VNA with Frequency Offset (option 80). The frequency of the

LO to the mixer is set to zero and multiplier of the RF input is used to set the IF frequency (the

harmonic). The equipment setup is shown below.

Since harmonics are specified in dBc, the fundamental RF and both the second and third harmonics are

measured and the differences calculated. Multiple channels can be used to do this.

Connect the equipment.1.

Setup the measurement for calibration. See also Measurement and Accuracy Considerations.2.
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1.

2.

Use three channels and frequency offset mode:

Channel 1 = F1 to F2

Channel 2 = F1 to 2F2 (frequency offset mode, multiplier = 1)

Channel 3 = F1 to 3F2 (frequency offset mode, multiplier = 1)

Perform a source power calibration and receiver power calibration over the entire frequency range.  See
 Measurement and Accuracy Considerations.

Reduce the frequency span and increase the frequency offset multiplier on Channels 2 and 3:

Channel 2 = F1 to F2 (frequency offset mode, multiplier = 2)

Channel 3 = F1 to F2 (frequency offset mode, multiplier = 3)

Note: Because the frequency span has been changed from that used for calibration, the source

and receiver calibrations will be interpolated.

Connect the DUT, make the measurement, and calculate the harmonic response:

Set up markers on Channels 1, 2 and 3, and determine the difference between the marker values

to get the dBc value of each harmonic.

Channel 1 - Channel 2 = 2nd harmonic (dBc)

Channel 1 - Channel 3 = 3rd harmonic (dBc)

Note:  Be sure to set the markers to the appropriate stimulus. Channel 2 markers should be set to

twice the frequency of Channel 1 markers. Channel 3 markers should be set to three times the

frequency of Channel 1 markers.

Measurement and Accuracy Considerations

Equipment Setup Considerations

A filter must be used at the input of the mixer to remove the VNA source harmonics.
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Return Loss and VSWR

What are Return Loss and VSWR?

Why Measure Return Loss and VSWR?

How to Measure Return Loss and VSWR

See other Frequency Converting Device Measurements

What is Return Loss and VSWR?

Return loss and VSWR are both linear reflection measurements, even when testing frequency

conversion devices, because the reflected frequency is not converted. These measurements are

essentially the same as for filters and amplifiers.  Learn more about Reflection Measurements.

Why Measure Return Loss and VSWR?

Devices which have poor return loss and VSWR result in loss of signal power or degradation of signal

information.

How to Measure Return Loss and VSWR

Setup the VNA measure return loss and VSWR as you would any two-port device. Connect your

frequency converting device as shown in the following diagrams:

 

RETURN LOSS AND VSWR OF MIXER INPUT PORT
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RETURN LOSS AND VSWR OF MIXER OUTPUT PORT

 

RETURN LOSS AND VSWR OF MIXER LO PORT
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Vector-Mixer Calibration

Overview

Characterizing Calibration Mixer (with IF filter)

Executing Characterization of Calibration Mixer

Characterizing Calibration Mixer (with IF filter) for Balance Mixer Measurement

Executing Characterization

Other topics about Mixer Calibration

Overview of VMC (Vector-Mixer Calibration)

The VNA has a vector-mixer calibration function for use in measuring frequency conversion devices.

The vector-mixer calibration allows you to measure the magnitude, phase and group delay of the

mixer's conversion loss by using in combination calibration standards (OPEN/SHORT/LOAD) and

calibration mixer with an IF filter, as well as the network de-embedding function incorporated in the

VNA.

Note: For Fixed RF measurement (RF: Fixed, LO and IF: Swept), it is NOT possible to perform vector-

mixer calibration because touchstone file, which defined with fixed frequency, can not be imported to

ENA.

Note: For Fixed IF measurement (RF and LO: Swept, IF: Fixed), it is possible to perform vector-mixer

calibration and to measure conversion loss and return loss, but NOT possible to measure group delay

because IF frequency is fixed.

Note: For Swept IF measurement (RF and IF: Swept, LO: Fixed), it is possible to perform vector-mixer

calibration and to measure conversion loss, return loss and group delay.

You can also perform balanced mixer measurements by using two calibration mixers that each has an
IF filter.

Vector-mixer calibration is implemented by eliminating the characteristics of the calibration mixer and

IF filter by using the network de-embedding function after full 2-port calibration has been completed.

Using the up/down conversion method allows you to specify the same sweep measurement frequency

for the input and output ports, thus enabling full 2-port calibration at the end of the target port.

Consequently, only the characteristics of the measured mixer (DUT) can be obtained by using the
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network de-embedding function, after eliminating the characteristics of the calibration mixer with an IF

filter from all measurement results.

Note: Since the up/down conversion method is used in vector-mixer calibration, the frequency-offset

function is not used. But, option 009 is required to use the VMC macro, SG control, and etc.

The vector-mixer calibration requires the characteristics data for the calibration mixer with IF filter.

Measured mixer

A measured mixer (DUT) signifies an unknown target mixer of measurement. However, a measured

mixer meeting the requirements for a calibration mixer can be used as a calibration mixer.

Calibration mixer (with IF filter)

The calibration mixer is required for supporting the measurement system of the up/down conversion.

You must also evaluate in advance the frequency response characteristics of the calibration mixer. The

vector-mixer calibration method obtains the characteristics of the measured mixer alone by using the

network de-embedding function to eliminate the characteristics of the calibration mixer from the

measurement result. You can use the IF filter to select any required frequency conversion component
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such as RF+LO, RF-LO, and LO-RF. The calibration mixer and IF filter can be seen as a part of the test

system setup, just like the network analyzer and the test cable; they are connected at the same location

during the entire calibration or measurement.

Note: The frequency range must be equal to or greater than that of the measured mixer. If you want to

test multiple mixers with a single setup, select a wide range of calibration mixers that can cover all

frequencies of the target test devices.

Characterizing Calibration Mixer (with IF filter)

In vector-mixer calibration, you must characterize the calibration mixer with the IF filter. As shown in

the following figure, connect the target mixer (with IF filter) to the port of the network analyzer on

which vector calibration has been performed and then connect an OPEN, SHORT or LOAD standard to

the end of the IF filter to start reflection measurement. The signals measured at the test port include the

reflection signal from the mixer's RF port, the IF signal (IF+) converted by the mixer and then reflected

by the IF filter, and the IF signal (IF-) passing through the IF filer and then reflected by the calibration

standard.

The characteristics of the calibration mixer can be described in a 1-port error model, and each error

item can be determined from ΓO, ΓS, and ΓL, which are obtained in the reflection measurement of

individual standards.

 Characteristics evaluation of calibration mixer (with IF filter)

 

Note: The calibration mixer must be reciprocal. The term "reciprocal" means the magnitude and phase
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of the conversion loss are equal both in the forward and reverse directions. The forward conversion loss

occurs during the measurement of the output signal at the IF port while inputting measurement signals

into the RF port. In contrast, the reverse conversion loss occurs during measurement of the output

signal at the RF port while inputting measurement signals into the IF port.

Note: For precise calibration, the conversion loss in each direction must be less than 10 dB using a

calibration mixer and IF filter in combination. Exceeding 15 dB of the conversion loss in any direction

may deteriorate the calibration accuracy significantly.

Characterizing procedure for calibration mixer (with IF filter)

Executing Characterization of Calibration Mixer

1. Setting Stimulus Conditions 

Set the stimulus conditions for the channel you want to calibrate. You must also set the external signal

source in advance.

2. Running Macro

Note: Full 2-port calibration is recommended for characterizing the calibration mixer with the IF filter,

although 1-port calibration is also available. This is because using full 2-port calibration simplifies the

evaluation procedures.

Press Macro > Marco 1 > VMC.1.

3. Selecting Measurement Port
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Select the 1-port calibration port (1 in menu).

4. Setting IF Frequency

Select IF frequency from RF+LO, RF-LO and LO-RF (2 in menu), depending on the IF frequency of

the calibration mixer.

Note: The number displayed in the Vector Mixer Characterization macro is the frequency set in the

VNA and read from it. You must also set the minimum IF frequency at more than 0 kHz.

IF BW must be set to much smaller value than IF frequency.

5. Selecting a Calibration Kit

Select a calibration kit (3 in menu).

Note: The mechanical calibration kit displayed in the Vector Mixer Characterization macro is the

frequency registered in the VNA and read from it. If an ECal module is connected to the VNA, ECal

will be selected automatically.

6. Measuring Calibration Mixer with IF Filter (when using calibration kit)

Connect the calibration mixer to one of the test ports on which 1-port calibration has been done, as

shown in the following figure.

Connection of calibration mixer (with IF filter)
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Note: Select any port if full 2-port calibration is set.

Note: We recommend that you characterize the calibration mixer with an IF filter when the power

splitter for distributing the LO signal is connected to the measured mixer. In vector-mixer calibration,

where the up/down conversion method is used, the power of the LO signal is distributed to the

calibration mixer and the measured mixer through the power splitter. During a characteristics

evaluation of the calibration mixer, the LO power level used by the drive of the calibration mixer must
be equal to the LO power level with the measured mixer connected. This is because the mixer's

conversion loss and reflection coefficient are significantly affected by the power level of the LO signal.

Select CalKit (3 in menu).1.

Select the type number of the calibration kit from CalKit menu (4 in menu).2.

Click the Open button (5 in menu) to start measurement in OPEN.3.

Click the Short button (6 in menu) to start measurement in SHORT.4.

Click the Load button (7 in menu) to start measurement in LOAD.5.
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5.

7. Measuring Calibration Mixer with IF Filter (when using ECal module)

Select ECal (1 in menu).1.

Select the port used for the ECal module (2 in menu).2.

Click the Measure button (3 in menu) to start measurement.3.

Select the property and click info (4 in menu) to see the measurement.4.

8. Saving Characteristic Data and Closing Macro

Press the Save button (8 in menu) to open the Save screen.1.

Press the Save button to specify a name for the characteristic data of the calibration mixer with IF filter. Then
save it to a Touchstone file.  If you check the Setup Option (9 in menu), the saved characteristic data will be
set for the specified port of the active channel as the characteristic data file of the network de-embedding,
and the fixture simulator function will be enabled. If unchecked, only the characteristic data will be saved.

2.

Click the Close button (10 in menu) to exit the macro.3.

Characterizing Calibration Mixer (with IF filter) for Balance Mixer Measurement

The Vector Mixer Characterization macro provided with the VNA allows you to characterize the

calibration mixer (with IF filter) to be used for the balanced mixer measurement. The characterizing

procedures of the calibration mixer with IF filter used for balance mixer measurement are basically the

same as those used for normal mixer measurement; however, two characteristic data of the calibration
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mixer with IF filter are required for balanced mixer measurement, as shown in the following figure.

Connect the target calibration mixer (with IF filter) to the port of the network analyzer on which

calibration has been performed and then connect the OPEN, SHORT and LOAD standards to the end

of the IF filter to start reflection measurement and characterization. For a balanced mixers, the phase

difference of the LO signals between the calibration mixers with IF filter will remain as an error, since

each calibration mixer with IF filter is characterized independently. Therefore, you must calibrate the

phase difference between the two characterized calibration mixers with IF filters.

Characteristics evaluation of calibration mixer (with IF filter) for balance mixer

Note: We recommend that you use the same products of calibration mixers, IF filters and cables

between the balanced ports to which each calibration mixer (with IF filter) is connected.

You should keep the following electrical lengths the same between the two ports to which the

calibration mixer is connected as much as possible - the electrical length from the external signal
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source output port (a) to the extended calibration plane (b), and the electrical length from the

calibration plane (c) to the extended calibration plane (b). Large electrical length differences between

the two ports to which the calibration mixer is connected could raise 180 degrees phase value error

between the two IF ports even though the Balanced Mixer Calibration Macro is executed. You can

verify it by swapping the IF cable connections with each other.

Executing Characterization

1. Characterizing Calibration Mixer (with IF filter)

Measure the characteristic data of each calibration mixer with the IF filter used for balanced mixer

measurement, using any two ports.

Set the stimulus conditions for the channel you want to calibrate. You must also set the external signal

source in advance.

Note: If you characterize a calibration mixer with an IF filter, we recommend that you perform full 4-

port calibration in advance, since it simplifies the evaluation procedures.

Press Macro > Macro 1 > VMC.1.

Select Port 1 (1 in menu) to characterize the calibration mixer 1 with IF filter. In this case, the data are saved
to a temporary file (MIXER_1.s2p).

2.

 Select Port 2 (1 in menu) to characterize calibration mixer 2 with IF filter. Here, the data are also saved to a
temporary file (MIXER_2.s2p).

Note: For detailed information on characterizing the calibration mixer, see Characterizing procedure for
calibration mixer (with IF filter).

3.

Click (Optional) Balanced Mixer (2 in menu).4.
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4.

As the Vector Mixer Characterization Macro is running, the data files of the pre-measured calibration mixer
with IF filter (MIXER_1.s2p, MIXER_2.s2p) are read automatically into the macro (1 in menu).

8.

Note: If failure occurs when reading the data file for the calibration mixer with IF filter, the

characterization may have done by using only one port instead of using two ports.

Select the measurement port (2 in menu) and then connect a THRU between the IF ports of the calibration
mixers to correct the phase difference of the LO signals for the calibration mixers with IF filters.

1.

Pressing the Execute (3 in menu) button executes a phase error correction and overwrites the results on the2.
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original data file.
2.

You cannot run the Execute function when selecting the measurement port if the data file of the

calibration mixer with IF filter (*.s2p) has not been set for the network removal function of the

fixture simulator.

The phase error correction data reflects the phase difference of the LO signals for the phase

information of the calibration mixer's data file, which is registered in any two ports.

 Press the Close button (4 in menu) to exit macro.3.
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Gain Compression for Amplifiers GCA (Opt  086)

Note: The M9370A/71A/72A/73A/74A/75A does not support this function.

Features, Requirements, and Limitations

Gain Compression Concepts

Understanding the GCA Displayed Traces

Gain Compression Parameters

Compression Methods

Acquisition Modes

Using Gain Compression App

Frequency tab

Power tab

Compression tab

Safe Sweep Mode dialog

Compression Analysis

Saving GCA Data

GCA Measurement Tips

Macros

See Also

GCA Calibration

Programming commands

App Note Amplifier Linear and Gain Compression Measurements

Other VNA Applications
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Features, Requirements, and Limitations

Features

Fast, easy, and complete Gain Compression measurements for amplifiers.

Many compression parameters to choose from, including gain, input power at compression, output power at
compression, input match, and compression level.

Several compression methods to choose from, including deviation from linear gain, deviation from max gain,
back-off, and X/Y, and compression from saturation.

Three acquisition methods to choose from: Power per Freq, Freq per Power, and SMART Sweep

SMARTCal Calibration Wizard to guide you through Full 2-Port or Enhanced Response calibration, plus
Source Power calibration.

Compression Analysis allows traditional power sweep view at a selected frequency.

Receiver Leveling provides continuous source power accuracy.

Supports Wideband (NOT Narrowband) Pulse measurements using the new integrated Pulse setup dialogs.

Requirements

Option S93086A (software option only) must be enabled.

When performing an optional calibration:

ECal module or Calibration Kit

Power meter/sensor

Limitations with GCA

Number of points limited to 100,001 for two-dimensional acquisitions, 50,000 points for SMART Sweep.

Standard CW power sweep is NOT supported in a Gain Compression channel.

Independent IFBW, Power Levels, or Sweep Time in a segment table is NOT supported.

Stepped sweep mode only.

Linear, Log, and Segment frequency sweep modes only.

The following VNA Features are NOT Available in a Gain Compression channel:
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Unratioed receiver measurements (A, B, R)

ECal User Characterization

Some Fixturing Features

FOM or FCA

External Test Set Control

Interface Control

Time Domain

Balanced measurements

Save Auto Formatted Citifile data.

Narrowband Pulse measurements using the Integrated Pulse App

Gain Compression Application Concepts

What is Gain Compression

An amplifier has a region of linear gain, where the gain is independent of the input power level. This

gain is commonly referred to as small signal gain. As the input power is increased to a level that causes

the amplifier to approach saturation, the gain will decrease. The 1 dB gain compression is defined as

the input power level that causes amplifier gain to drop 1 dB relative to the linear gain.

You can quickly measure the gain compression using a compression marker on a power sweep trace.

Terms used in GCA

Linear Power Level  The specified input power that yields linear gain (also known as 'small-signal

gain') in the amplifier.

Reference gain  The measured gain that is used as a reference for determining compression level.  The
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Compression Method that is used could cause this value to be different.

Compression level  The specified amount of gain reduction from the reference gain.

Target gain  The gain at the specified compression level.  Although this term does not appear in GCA,

it is important to understand when discussing the various compression parameters.

For example, when using Compression from Linear Gain method with the following settings:

Linear gain (measured at Linear Input power) = 10.2 dB

Compression level (specified) = 1 dB

Target gain = 9.2 dB

This is called 'Target' gain because GCA will search for the closest measured gain to 9.2000 dB. It may

not measure this gain exactly.

Compression point  The operating point at which the measured gain is closest to the Target Gain. All

compression parameters report data for this operating point.

Understanding the GCA Displayed Traces

One of the most important concepts to remember with GCA is that, each frequency data point

represents many measurements using different input power levels.

Some things to notice about how GCA displays compression data:

1.
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The X-axis values are ALWAYS frequency. Imagine behind each frequency data point, a traditional power
sweep curve with corresponding measurements and calculations to find the specified compression point.

1.

The Y-axis values are always reported at the compression point. The value that is displayed depends on the
compression parameter that you choose.  The S-parameters that are displayed in a GCA channel are
always measured at the linear and reverse power level.

2.

Example: Five of the six GCA compression parameters are displayed in the above image. The missing

trace, DeltaGain21 is discussed below.  

Markers are placed at 4.549 GHz for all of the parameters.

 Tr 3 CompIn21  (Input power at the compression point) shows the marker value to be -5.4117 dBm. This is
the power into the DUT that was required to achieve the compression point   Notice that this is about the
same input power required to achieve the specified compression at ALL frequencies.

 Tr 5 CompGain21  (Gain at the compression point) shows the marker value  9..6443 dB . This is the
measured gain at the compression point.

To see the gain at a different input power at this frequency, use the Compression Analysis feature.

Create a GCA Measurement

Press Meas > S-Param > Meas Class....1.

Select Gain Compression, then either:

OK delete the existing measurement, or

New Channel to create the measurement in a new channel.

2.

Gain Compression Parameters

There are several Gain Compression parameters, as well as standard S-parameters and ADC

parameters, that can be measured in a GCA channel.
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How to add GCA Parameters

Using Hardkey/SoftTab/Softkey Using a mouse

Press Trace, then select trace.1.

Press Meas, then select a parameter.2.

Click Instrument, Trace, Add Trace.1.

Click Response, Meas, then select a parameter.2.

Linear S-Parameters

For convenience, the standard S-parameters are offered in a GCA channel. S11 and S21 are measured

at the specified Linear Input level. S22 and S12 are measured at the specified Reverse power level.

Parameter Description When Measured

S11 Input Match Always

S21 Gain Always

S22 Output Match See Reverse

S12 Reverse Isolation See Reverse

Compression Parameters

Note: The following table assumes: DUT Input = VNA port 1 and  DUT Output = VNA port 2.

When the Port mapping is different, the parameters in GCA are updated accordingly. For example,

with Input = port 2 and Output = port 1, then "CompIn12" would be displayed.

The raw data for these parameters are always measured.

Parameter Description

CompIn21 Input power at the compression point.

CompOut21 Output power at the compression point.

CompGain21 Gain at the compression point.

CompS11 Input Match at the compression point.

RefS21 Linear Gain value used to calculate the compression level.  This is
calculated differently depending on the compression method.

DeltaGain21 CompGain21 MINUS Linear Gain (in Log Mag format).  This

trace can be used to learn a lot about the DUT compression point.
Learn more.

Compression Methods
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GCA offers the following methods to find the compression point of an amplifier using GCA:

Compression from Linear Gain

The Reference Gain is measured using the specified Linear (Input) Power Level. The Target Gain is

calculated as the Linear Gain minus the specified Compression Level. For example 8.3 dB - 1 dB =

7.3 dB.

Compression from Max Gain

The linear region of an amplifier gain may not be perfectly linear.  The highest gain value that is

found at each frequency is used as the Reference (S21) Gain.  The Target Gain is found in the same

way as Compression from Linear Gain.

Compression from Saturation

This method is used to better find the compression point when measuring amplifiers with non-linear

gain as shown in the following image:

The Max power out value * is found at each frequency. Then input power is lowered until the output

power decreases by the specified 'From Max Pout' value. This is the compression point.̂

Backoff and X/Y method

These two compression methods are very similar.

Both methods specify a difference in input power (X axis) between the linear region and

compression point.

For the Y-axis difference:

Backoff method specifies Compression Level which is a difference in Gain.

X/Y method specifies Delta Y which is a difference in Output Power.

GCA searches for these points differently for 2D sweeps and SMART sweep.
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The following images show how Backoff and X/Y method is calculated at ONE frequency.

The compression point (yellow circle) is where 10 dB more

input power yields 1 dB less gain than at the reference point

(blue circle).

 

The compression point (yellow circle) is where 10 dB more

input power yields only 9 dB more output power than at the

reference point (blue circle).

Acquisition Modes

The GCA offers three modes for data acquisition: Two 2D sweep modes, and SMART sweep.
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To see a traditional power sweep at a single frequency, use the Compression Analysis feature. Learn
more.

2D (two-dimensional) Sweeps

This is the easiest method to understand, and the least efficient for finding the compression point. Both

2D sweep modes work as follows:

All GCA measurements begin by measuring S-parameters at the specified Linear Power level. Reverse
parameters are measured ONLY if Full 2-port calibration is applied or if a reverse parameter is displayed.
Learn more about Cal choices.

1.

Gain measurements are then made at ALL of the specified frequency and power values. Although these are
conceptually 2-Dimensional sweeps, a single sweep is constructed in firmware.  See Data Points Limit.

2.

After data has been measured, a search is performed to find the compression point. You can choose to
interpolate between the two measured points closest to the target gain. Learn more.

3.

As each sweep is performed, dots are plotted next to the Ch indicator in the lower left corner of the

display to indicate progress for the current sweep.

Note: For Backoff and X/Y compression method, GCA does not verify that the specified Start - Stop power

range is at least the size of the specified Backoff or X value. The closest compression point is always

reported.

Note: SMU Hardware List trigger mode is NOT supported in GCA 2D sweeps.

2D Sweep Modes

2D Sweep Power per Frequency -  Input power is stepped from Start to Stop at each specified frequency.
 From the following example you can see that the device is exposed to the highest power level (p3) at the
first frequency (f1). This could heat the device early in the measurement and affect compression results.

The following examples show (frequency, power) values for three frequency points and three power

points, resulting in a total of 9 measurements:

1 2 3 4 5 6 7 8 9

f1,p1 f1,p2 f1,p3 f2,p1 f2,p2 f2,p3 f3,p1 f3,p2 f3,p3

2D Sweep Frequency per Power -  Frequency is swept from start to stop at each specified

power level as follows:

1 2 3 4 5 6 7 8 9

f1,p1 f2,p1 f3,p1 f1,p2 f2,p2 f3,p2 f1,p3 f2,p3 f3,p3
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Viewing and Saving 2D Data

It is NOT possible to plot ALL of the 2D measurement data on the VNA display. However, it can be

saved to a *.csv file and then read into an Excel spreadsheet.  The initial S-parameter measurement data

is not saved to this file. Learn more.

You can also view on the VNA all power sweep information at a selected frequency using the

Compression Analysis feature.

SMART Sweep

SMART Sweep is usually the fastest and most accurate method to measure Gain Compression. Unlike

the 2D acquisition modes which measure all of the specified frequency / power points, SMART Sweep

performs a series of power search iterations. At each frequency, an 'intelligent guess' of input power is

made to find the compression level that is within tolerance. This guess is further refined with each

successive power search iteration sweep.  

SMART Sweep continues to iterate until one of the following conditions occur:

ALL data points are within tolerance. When the compression level for a data point achieves the specified
tolerance, it continues to be measured and input power changed to improve the measurement within
tolerance.

1.

The specified compression level can NOT be achieved for the remaining frequencies that are not in
tolerance. Either the Start power is too high or the Stop power is too low.

2.

Maximum iterations have been achieved.  If a measured gain is not within the specified tolerance before the
specified Max number of Iterations has been reached, then the last power reading is used as the
compression point.

3.

The Iteration Counter, Dots, and Bangs(!)

Next to the Ch indicator, in the lower left corner of a GCA window, the following annotation
appears:

An iteration counter is incremented each time input power is adjusted.

A dot appears when another 10% of the frequency points are within tolerance.

! (bangs) are displayed after the last iteration. Each bang represents 10% of the data points that are NOT
within tolerance.
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SMART Sweep and Compression Method

The intelligent guess process works differently depending on the compression method.  This is

important because Backoff and X/Y compression methods subject the DUT to significant changes in

input power during an iteration sweep.  This can affect the DUT and the measurement results.

Learn all about Backoff and X/Y compression methods.

ALL GCA measurements begin by measuring S-parameters at the specified Linear Power level.

Reverse parameters are measured ONLY if Full 2-port calibration is applied or if a reverse parameter is

displayed. Learn more about Cal choices.

Backoff and XY   Because both compression methods specify the separation between the 'linear" region and
the "compressed" region, each iteration requires a single sweep at two dramatically different power levels
over the same frequency range. The first half of the sweep measures the DUT at the Backoff or X power
level. The second half of the sweep measures the DUT at the compressed power level, specified by the Start
and Stop power range.  At the beginning of the second half, the power level rises by the Backoff or X value.
The specified Settling Time is applied at this point to allow the DUT time to react to this significant change in
power level.  Safe Sweep does NOT minimize this change in input power. However, Safe Sweep with Backoff
and XY methods DOES prevent the DUT from being exposed to too much input power.

Compression From Linear Gain  After the reference gain is measured at the linear input power, the next
iteration measures the DUT at a higher power level which attempts to push the DUT well into compression.
Subsequent sweeps, depending upon the compression level of the DUT, either increases or decreases the
power in order to reach the desired compression level. Usually, by the third iteration sweep, a curve-fit
algorithm is utilized to precisely find the compression point.

Note: The DUT can be subject to significant changes in power from one iteration sweep to the

next. This can be minimized by the use of SAFE Sweep and careful selection of the corresponding

settings.

Compression from Max Gain  The maximum gain that is found at each frequency is stored and used to
calculate the compression point. SMART Sweep does NOT perform extra iterations to search for the
maximum possible gain of the amplifier at each frequency.

Compression from Saturation  The maximum power out that is found at each frequency is stored and used
to calculate the compression point. SMART Sweep does NOT perform extra iterations to search for the
maximum possible power out of the amplifier at each frequency.

Using the Gain Compression Application

The following is a general procedure for performing a GCA measurement. The challenge with GCA is

configuring a measurement that yields the true compression performance of YOUR DUT. This requires

knowledge of the Gain Compression settings and knowledge of the DUT.
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See specific dialog boxes below.

Disconnect the DUT if preset or default power levels may damage the VNA or DUT.1.

Preset the VNA, or configure a suitable User Preset that will be safe in case the DUT is connected.2.

Create a GCA channel. Learn how. The default trace is S21.3.

Start GCA Setup dialog and configure the measurement settings based on the DUT, adapters, attenuators,
booster amplifiers, and fixtures to be used in the measurement.

4.

Save the instrument state (optional).5.

Connect DUT and apply bias and RF power as appropriate. The default measurement for a GCA channel is
S21 (amplifier gain). Inspect the gain measurement to ensure the DUT is operating as expected.

6.

Add GCA compression parameter traces. Learn how.7.

Adjust the measurement settings to yield satisfactory compression parameters. See GCA Measurement Tips.8.

Start and complete the GCA Calibration wizard.9.

How to start the Gain Compression Setup dialog

Using Hardkey/SoftTab/Softkey Using a mouse

Press Freq > Main >  GCA Setup....1. Click Stimulus1.
Select GCA Setup...2.

 

 

Frequency tab - Gain Compression -dialog box help
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Configures the frequency settings over which Gain compression is to be measured, as well as the

measurement method.

Sweep Type

Choose a method in which to sweep frequency: Linear, Log, and Segment Sweeps. This setting

applies to all data acquisition modes.

Notes

CW Sweep is NOT available in GCA.  However, to see a traditional power sweep at a single
frequency, use the Compression Analysis feature.

Segment Sweep Notes (GCA ONLY)

The segment table shown on the dialog is 'READ-ONLY'.

Learn how to Create and edit the Segment Sweep table.

Independent IFBW and Power are NOT available.

X-axis point spacing is available beginning with A.09.10.

Data Acquisition Mode

Specifies HOW the gain compression data is collected.

SMART Sweep

At each frequency, input power is 'intelligently' adjusted to find a measured gain equal to the target gain.

Faster and more accurate than 2D sweeps to measure Gain Compression point at a number of
frequencies.

Learn ALL about SMART Sweep

2D (two-dimensional) Sweeps

Sweep Power per Frequency   Performs a series of power sweeps at each successive frequency.

Sweep Frequency per Power  Performs a series of frequency sweeps at each successive power level.

Learn ALL about 2D sweeps

Sweep Settings
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Click each to learn more about these settings.

Number of points  Number of frequency points to measure. The Frequency points may be limited due to
the number of specified Power points. See Data Points Limit.

IF Bandwidth   Set this value to yield acceptable trace noise when measuring gain at the linear power
level. This level of noise contributes directly to the accuracy of compression point. A lower value
(narrower IFBW) allows for more accurate, but slower, measurements.  See GCA Measurement Tips to
see how to best set IFBW.

Start / Stop, Center / Span frequencies.  Set the frequency range over which to measure Gain
compression.

Data Points Limit

The maximum number of measurement data points depends on Acquisition method and

Compression method as follows:

  SMART sweep 2D sweep

Compression method

Number of frequency points

is reduced to ensure the total

number of data points does

not exceed the specified

limit.

Number of power points is

reduced to ensure the total

number of data points does

not exceed the specified limit.

Compression from linear gain
Data points = freq points

Max  = 20,001
Data points =

(freq. points) * (power

points)

Max power points = 2,001

Max data points = 20,000

Compression from max gain
Data points = freq points

Max  = 20,001

X/Y and Backoff
Data points = 2 * freq points

Max  = 20,001

Note: Although the dialog box will allow you to enter any number of frequency or power points, the

values are checked when OK or Apply is pressed. If a limit is exceeded, the relevant data points are

reduced to the maximum allowable number without warning.

 

Power tab - Gain Compression dialog box help
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Configures RF power and Power Sweep settings for Gain Compression measurement.

Power ON (All channels)  Check to turn RF Power ON or clear to turn power OFF for all

channels.

Input Port

Select the VNA port that is connected to the DUT Input.

Linear Power Level  The input power that yields the linear gain of the DUT. The linear gain is

used as the reference gain when calculating the Compression from Linear Gain.  Input match is

also measured at this power level.

Source Leveling   Specifies the leveling mode. Choose Internal or Receiver R1. Learn how to
configure Receiver Leveling. Open Loop should only be used when doing Wideband Pulse
measurements.

Output Port

Select the VNA port that is connected to the DUT Output.

Reverse Output Power  Sets power level into the output of the DUT for reverse sweeps. Port
power is automatically uncoupled.

Reverse power is applied to the DUT ONLY under the following conditions. Otherwise, this

setting is ignored.

When Linear Output Match or Linear Reverse Isolation parameters are requested.

When Full 2-port correction is used. You can perform a full 2-port cal and downgrade to an
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Enhanced Response Cal to prevent reverse power from being applied to the DUT. Learn
more.

Source Leveling   Specifies the leveling mode. Choose from: Internal (normal operation) or Open

Loop (used only for Wideband Pulse measurements).

Power Sweep

Power Points  Number of power points to measure for 2D acquisition modes.  The Power Points

may be limited due to the number of frequency data points. See Data Points Limit.  This setting is

NOT available in SMART Sweep, which uses only enough power points to find the specified

compression level.

Start and Stop Power

2D sweep   In Backoff, X/Y, and Compression from Max Gain methods, sets the range of

power levels that are applied to the DUT to find BOTH the Reference Gain and Compression
point. Make sure this range is wide enough to include both. For example, if the Backoff level

is 10 dB, then the power range must be greater than 10dB.  Otherwise, GCA will report a

compression value using the closest reference gain and compression point, which may be

inaccurate.  In Compression from Linear Gain, the reference gain is measured at the Linear

Power Level, so the Start and Stop power levels are used to find the compression point.

SMART sweep  Sets the range of power over which GCA will search for the compression

point. The reference gain is found using the Linear Power Level, Backoff, and X values,

depending on the Compression Method. To reduce the number of iterations that are required

to find the compression point, limit the Start / Stop power range to the input levels that will

achieve compression. Do not include the linear region.

Power Step (Size)  Calculated value from current Start, Stop, and Points settings. This setting can

NOT be changed directly.

 

Compression tab - Gain Compression dialog box help
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Compression Method

Learn ALL about these Compression Methods

Compression from Linear Gain   The specified compression level is measured from the linear gain. The
linear gain is measured using the Linear Power Level that is specified on the Power tab.

Compression from Max Gain  The specified compression level is measured from the maximum gain level.
 In SMART sweep, the Max Gain value is updated as each iteration occurs. To increase the chances of
measuring the actual maximum gain of the amplifier, Safe Sweep should be invoked using low Coarse and
Fine increments.

Compression from Back Off  This compression method uses the Compression Level and Back Off values
for finding the compression point.

X/Y Compression  This compression method uses the specified parameters (X and Y) as the criterion for
finding the compression point.

Compression from Saturation  Similar to Compression from Max Gain, except the specified compression
level is measured from the maximum power out level. Use this method to better find the compression point
when measuring amplifiers with non-monotonic gain. In SMART sweep, the Max power out value is updated
as each iteration occurs. To increase the chances of measuring the actual maximum power out of the
amplifier, Safe Sweep should be invoked using low Coarse and Fine increments

SMART Sweep

Learn ALL about Smart Sweep.

Tolerance  Specifies an acceptable range for measuring the compression level. Reducing this

value can significantly increase the number of iterations that are required to find the compression
point.

Maximum Iterations  Specifies the maximum number of power search iterations SMART Sweep

is allowed. Reducing this value can cause SMART sweep to terminate before all compression

levels are found to within the specified tolerance.

1971



Show Iterations  When checked, the compression parameter traces are updated at the completion

of each power search iteration. When cleared, compression parameter traces are updated when

SMART Sweep completes the power search iteration process.

Read DC at Compression Point  When checked, only the DC readings at the compression point

in the last iteration of a smart sweep will be taken. This improves measurement speed.

2D Sweep - Compression Point Interpolation

When a 2D Sweep is selected (on the Frequency tab), check this box to calculate and display

interpolated compression traces.

The Target gain is calculated using a complex linear ratio between the two closest measured

values.  All compression parameters are then interpolated using this same ratio.

Clear the box to display compression parameters for the closest compression point, either high or

low, to the level specified in the Compression Method setting.

 

End of Sweep Condition  Specifies the power level applied to the DUT at the completion of a

GCA measurement.

GCA performs numerous power and frequency sweeps on the DUT during the overall measurement

process. This setting has no affect on these intermediate sweeps. This setting only applies at the end

of the very last sweep in the GCA channel.

In addition, this setting applies ONLY to the GCA channel. All other channels operate

independently of this setting. Therefore, the power applied to the DUT after all channels have been

measured may be different from this setting.

Choose from:

Default  Use the default VNA method.  Learn more.

RF OFF   RF power is turned off when GCA completes a measurement cycle.

Start Power  RF power is set to the start power level.

Stop Power  RF power stays at the stop power level.

Settling Time

Used ONLY in SMART Sweep when Back Off or X/Y compression algorithms are selected.

1972



This setting allows additional dwell time when the input power changes from the back-off level to

the compression level. Learn more.

 

Safe Sweep Mode dialog box help

For use with SMART Sweep ONLY.

When enabled, Safe Sweep increases the input power to the DUT by the specified amounts,

allowing the compression point to be achieved gradually. While this will increase the number of

iterations required to achieve compression, it also minimizes the possibility of driving the DUT too

far into compression.  

Note:  Safe Sweep does NOT minimize the dramatic change in input power with Backoff and XY

method.  However, Safe Sweep with Backoff and XY methods DOES prevent the DUT from being

exposed to too much input power. Learn more.

Safe Mode (Enable)  Check to enable Safe Sweep.

Coarse Increment  Sets the maximum change in input power, up or down, which will be applied to

the DUT from one iteration to the next. Default = 3.0 dB.

Without Safe Sweep, the maximum change in input power can be the entire Backoff or X value

when using these compression methods.

Fine Increment   Once the Fine Threshold has been achieved, this becomes the maximum change
in input power, up or down, which will be applied to the DUT. Default = 1.00 dB

Fine Threshold  Specifies the compression level in which Safe Sweep changes from the COARSE

to the FINE increment. Default = 0.5 dB. This means that, by default,  the VNA uses the Fine

Increment adjustment when compression reaches 0.5 dB.

Max Output Power  To protect the VNA from damage, when the VNA port that is connected to
the DUT Output measures the specified value, the input power to the DUT is no longer incremented

at that frequency. In these cases, the compression point would probably not be achieved.
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Compression Analysis

Compression Analysis changes the current trace into a power sweep trace at a specified CW frequency .

The current parameter and acquisition method is unchanged. For example, with a CompGain21 trace

displayed and SMART Sweep selected, enable Compression Analysis. The trace becomes a power

sweep trace at the specified CW frequency. The Y-axis displays S21 Gain at each X-axis power point.

When Smart sweep is used, a complete power sweep is not performed, but only the data points that are

required to find the compression point. To see a traditional power IN vs power OUT compression

sweep, use one of the 2-D acquisition methods.

You can create PNOP or PSAT markers on a CompOut trace with Compression Analysis mode ON.
Learn more.

How to perform Compression Analysis

With any compression parameter (such as CompGainS21) displayed:

Using Hardkey/SoftTab/Softkey Using a mouse

Click Math > Analysis > Compression Analysis....1. Click Response1.

Select Math2.
Select Compression Analysis3.

 

Compression Analysis dialog box help

Notes: When an S21 or S11 trace is active, any compression parameter (such as CompGainS21) must
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also be displayed.

Compression Analysis is NOT allowed for S12 or S22 traces.

Scroll up to learn more about Compression Analysis.

Analysis Frequency: CW  Enter a frequency to use for the compression analysis trace.

Compression Analysis  Check to perform compression analysis. A compression trace is displayed

at the Analysis (CW) Frequency.

Use Discrete Frequencies  Check to allow Analysis Frequencies at only the discrete points where

data is measured. Clear to allow Analysis CW Frequencies that are interpolated from the data

points. Then select ANY CW frequency between the start and stop frequencies of the GCA channel.

X-Axis

Use Measured Pin  The X-axis displays the actual power that is applied to the DUT after match
correction and R-channel drift correction.

Use Source Pwr Settings  The X-axis displays the power level of the stimulus.

Saving GCA Data

Beginning with VNA release A.08.20, GCA data can be saved to a *.csv file in both 2D and SMART

Sweep modes (previously only 2D modes). Also, a Delta Gain, AI1, and AI2 columns have been added

to the data. Learn about ADC parameters.

How to save GCA data

With a GCA Compression trace active:

Using Hardkey/SoftTab/Softkey Using a mouse

Press Save Recall > Save Other > Save Data....1.

File Type= CSV Formatted Data (*.csv).2.

Click File1.
Select Save Data2.

File Type= CSV Formatted Data (*.csv).3.

 

Notes
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This data type can be read by spreadsheet programs, such as Microsoft Excel.

Data from the last complete sweep is saved to the specified *.csv file.

If calibration is turned ON when the file is saved, then all data is calibrated. Otherwise, raw data is saved.

All *.csv data saves include a reference power level sweep at the beginning of each frequency data.

SMART Sweep data with 5 iterations and 3 frequency points. The yellow highlight is added here for

readability.

When saving or recalling 2D data:

When Linear Input Power EQUALS Start Power, then the number of data points (rows)/ freq = num power
points.

When Linear Input Power does NOT EQUAL Start Power, the number of data points (rows)/ freq = num
power points + 1.

Make these selections on the GCA/GCX Power tab dialog.

GCA Measurement Tips

There are many settings in the Gain Compression Application. Here are a few tips when using GCA to
learn as much as possible about the compression characteristics of your DUT in the most efficient

manner.

DUT Compression Characteristics and GCA  

Although GCA provides excellent results with a wide variety of amplifiers, it works best with

amplifiers which have a monotonic compression curve.  In some cases where the compression curve is
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not monotonic, for example if the amplifier gain expands before it compresses, the correct compression

level may not be found.

To help a SMART sweep find the correct compression point, limit the Start and Stop power levels

around the anticipated compression point.  Learn more.

The following two power-sweep traces are examples of non-monotonic gain:

DeltaGain

A DeltaGain trace is the best way to see how closely GCA is actually measuring to the desired

compression level.  In addition, you can view the phase of DeltaGain to see the phase deviation

between the compressed gain and the reference gain. DeltaGain is calculated as:

DeltaGain = Measured Gain (watts) / Ref Gain (watts)

In LogMag format: DeltaGain = (Measured Gain) - (Ref Gain)

With SMART Sweep, DeltaGain (in LogMag format) shows how soon certain frequencies achieve the

specified tolerance.  Learn more.

Some other settings which may be helpful:

Trigger source: Manual allows you to analyze data and make adjustments while allowing the device to cool.  

Construct Limit Lines around the compression point at the tolerance level.
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The following image shows a DeltaGain21 trace using SMART Sweep. The Limit Lines were added

manually.

In the above image:

Relevant

Settings

Method = Compression From Linear Gain

Compression level = 1

Iteration Tolerance = 0.05 dB.

Maximum Iterations = 10

Displayed

Results

A data point on -1.00 indicates that, at that frequency, the exact compression level (1

dB) was measured.

Several frequencies did not achieve the specified tolerance (0.05 dB) before the Max

Iterations (10) was reached.

FAIL and red data points outside the limit lines.

Nine dots (....) indicate that 90% of the data points achieved the specified compression
level.

one ! indicates that 10% of the data points did not achieve compression.

Learn more about the Iteration Counter and annotation.

SMART Sweep Tips

Compression from Linear Gain is the easiest compression method to understand and control in SMART
Sweep. Learn more.

If SMART Sweep requires more than twenty iterations, this is an indication that something is wrong. Try
changing the Tolerance setting, Frequency Range, Start / Stop power range, IF bandwidth, or Dwell Time.
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If the number of iterations required to achieve the desired compression level changes significantly from one
set of measurements to the next, this could be due to other effects, such as heating. Try increasing the dwell
time or using a wideband pulse measurement configuration.

If the DUT should not be significantly overdriven into compression, or the changes in the input power should
be limited, use Safe Sweep mode with Deviation from Linear Gain compression method.

Single Frequency Macros

Note: Beginning with VNA rev. A.09.00, the Compression Analysis feature provides an easier method of

viewing a traditional power sweep at a single frequency than the GCA macros. However, the Macros

are still maintained on the VNA hard drive.

The macros perform a single power sweep on the DUT using a standard channel with corresponding

stimulus settings. The macro can show measurement differences from the compression analysis traces

due to bias/thermal/settling effects of the DUT. So, the macro can help confirm a DUT is exhibiting

some type of settling behavior which will need to be handled in some way.

Also, the macro is a great GCA programming example.

With a 2D sweep (NOT SMART Sweep) a script that is stored on the VNA hard drive automatically

creates a traditional power sweep measurement in a standard channel using the same stimulus setting as

the GCA channel. Use a marker in the GCA channel to specify the frequency for the measurement.

The script has two modes of operation:

View Mode displays all of the previous 2D sweep data at that frequency.1.

Measure Mode performs a new measurement at that frequency.2.

Both modes create a new S-Parameter channel using the same stimulus settings as the GCA channel,

including port power, attenuator, IF Bandwidth, and dwell settings. The new channel does not support

calibration or pulse characteristics.

To see noise on a measurement, use the Measure macro in continuous sweep. Adjust the IFBW and
averaging until the noise versus sweep speed meets your needs.

To see other effects of your DUT at a specific frequency, use the View macro and the Measure macro

with 2D sweep mode. Both macros present data using a standard channel. The View macro shows 2D

data at a specific frequency, while the Measure macro shows freshly-measured data at the same

frequency. Ideally, the data from these two would be identical. However, changes in your DUT

behavior due to heating or other effects can cause these to be different. If significant differences exist,

try:
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Using the 2D Frequency per Power setting rather than Power per Frequency

Adjusting the dwell time

Adjusting IFBW

Use a wideband pulse configuration

How to setup the Macros

Each macro must be setup separately.

Press Macro > Key Setup > Macro Setup....1.

Select a blank line, then click Edit.2.

In Macro Title, type a short description such as Meas GCA or View GCA.3.

Click Browse, then navigate to C:/Program Files/Keysight/Network Analyzer/Applications/GCA/GCA.vbs4.

In Macro run string parameters:

Type M for the Measure macro or V for View macro.1.

Optional: Supply the following additional parameters in any order:2.

5.

To run the program from a remote computer, specify the full computer name of the VNA .

Channel in which to create the measurement. If not specified, Measure is created in Ch30 and View is
created in Ch31.

Example: Run string parameters for the Measure macro run from a remote computer in Channel 5.----
M MyVNA 5.

Click OK.6.

How to run the Macros

On a GCA channel:

Create a 2D sweep. Either Power per Freq or Freq per Power. Both macros always create a power sweep at
the frequency of interest.

1.

Create a CompIn trace.2.

3.

4.
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2.

On the CompIn trace, right-click and select Add Marker. Drag the marker to the frequency of interest.3.

Press Macro, then select either by the short description your provided in Step 3.4.
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Gain Compression Calibration

Note: The M9370A/71A/72A/73A/74A/75A does not support this function.

The GCA Calibration Wizard guides you through a calibration of GCA or GCX channel. The

procedure is the same regardless of the Gain Compression Settings.

A Source Power Calibration is performed first.

Then, your choice of a Full 2-port Cal or an Enhanced Response Cal.

See Also

Gain Compression Application

Calibration Programming commands

 

How to start a GCA Calibration

Using Hardkey/SoftTab/Softkey Using a mouse

Press CAL > Main > Smart Cal....1. Click Response1.

Select Cal2.

Select Smart Cal...3.

Overview -  GCA Source Power Cal

The GCA Calibration Wizard first performs a Source Power Cal. The GCA Source Power Cal is a little
different from a standard Source Power Cal. Although GCA measurements are performed at many

power levels, the GCA source power cal is performed at a single power level over the specified frequency
span of your GCA measurement. The required source correction from that single power level is applied

to ALL power levels.  This method ensures that the 'absolute' power level being applied to the DUT is
within the VNA-X source power linearity specification.

Although it is important for GCA to be able to set the absolute power level to the DUT, it is MOST

important to be able to exactly measure the actual incident power. Therefore, during the GCA Source

Power Cal, a receiver calibration is applied to the port 1 reference receiver, and indirectly to both test

port receivers during the S-parameter calibration, correcting for impedance mismatch between the

power meter and the VNA source, and the DUT and the VNA source.
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Although the cal process is also at a single power level, the dynamic accuracy of the VNA-X receivers

is typically about +/- .05 dB, which is comparable to the accuracy of Keysight's best power sensors.

This allows GCA to very accurately measure and report ALL power levels that are actually applied to

the DUT.

Full 2-port or Enhanced Response (ER) Cal

By default, a full 2-port calibration is performed as part of a GCA and GCX calibration. However, you

can change to an Enhanced Response Cal.  The following issues may help you decide between these two

Cal types:

Accuracy  A full 2-port correction is more accurate than ER when GCA measures linear gain.  However, for
non-linear measurements, ER yields identical compression values as a full 2-port cal, so this may not be a
significant factor.

Measurement speed  An ER correction only requires measurements in the forward direction. The reverse
parameters (usually S22 and S12) are not measured unless requested. With a full 2-port cal applied, all four
S-parameters are measured, which requires an additional reverse sweep.  Learn more.

Ease  A full 2-port cal is easiest with an ECal module. An ER Cal requires a Defined Thru or a Flush Thru Cal
method. If these are possible, then an ER cal is easiest when using a mechanical Cal Kit.

High power  The test port damage level of a standard VNA-X is +30 dBm. Therefore, external attenuation
may be required on the output of high power amplifiers, which degrades calibration accuracy for reverse (full
2-port) measurements.  In addition, the external attenuation improves the DUT output / load match error,
which allows a better uncorrected response and makes an Enhanced Response Cal the better choice.

DUT limitations With an ER Cal applied, reverse measurements on the DUT are not performed unless
requested.

How to select Enhanced Response Cal

At the Select DUT Connectors page of the GCA Cal Wizard:

Check Modify Cal, then click Next.1.

A Defined Thru or a Flush Thru Cal method must be selected.2.

Click Cal Type/Stds3.

Under Calibration type, select EnhResp  (2 <= 1 refers to the receive port 2 and source port 1).4.

Downgrade a Full 2-port Cal to Enhanced Response Cal if you prefer to perform a Full 2-port cal,

but not perform reverse sweeps on the DUT.  

To change the correction on the channel from Full 2-port to Enhanced Response:

1.
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Press CAL > Main > Correction Methods.1.

Select GCA EnhResp, then OK.2.

 

GCA Cal Wizard

Select DUT Connectors and Cal Kits - GCA Cal dialog box help

This is a standard Cal Wizard page except for the following:

Power Sensor  Specify the connector type and gender of the power sensor. When the power sensor

connector is not the same type and gender as the DUT Port 1 connector, then an adapter is required

to connect the power sensor to the port 1 reference plane during the Source Power Cal. An extra 1-

port cal is performed to measure and correct for the adapter. No characterization S2P files are

required.

Select Ignored (at the bottom of the DUT Connectors list) to NOT compensate for the adapter.

Select the Cal Kit that will be used for that process.

Modify Cal  Check, then click Next, to Modify Cal (Standards AND Thru Method).

Source Cal Settings  Click to launch the Source Cal Settings dialog.
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Learn more about GCA Source Power Calibration

 

Gain Compression Calibration Step 1 dialog box help

Power Level at which to perform the Source Power Cal.

It is usually best to perform the Source Power Cal at 0 dBm because the power sensor is calibrated

at that level.

However, if the Gain Compression measurement is performed entirely below or above 0 dBm, then

perform the Source Power Cal at the Stop power which probably has the lowest level of

measurement noise.

Learn more about GCA Source Power Calibration

The remaining Gain Compression Cal dialogs are the same as the standard SmartCal dialogs.

Return to Gain Compression Application.
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Integrated Pulse Measurements

Note: The M937xA does not support this function.

The Pulse Setup dialogs shown in this topic are now integrated in the VNA firmware and are available

with Opt 025.

External pulse generators can be used along with the VNA internal pulse generators. Learn more.

In this topic

Hardware Setup

Pulse Setup

Pulse Generator Setup

Pulse Trigger Tab

Pulse Gens and IF Block Diagram

Calibration in Pulse

See Also (separate topics)

Configure and Use External Pulse Generators

Programming commands

App Note: Active-Device Characterization in Pulsed Operation Using the VNA-X (1408-21)

Hardware Setup for Pulsed-RF measurement for M9485

Connect the cable (p/n M9485-61604)  between M9310A Trig 1 connector and one of the four pulse

output pins (connectors). See Handler I/O Connector (M9485A) for pulse output pins.
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How to start the Pulse Setup dialog

Using Hardkey/SoftTab/Softkey Using a mouse

Press Sweep > Source Control >  Pulse Setup....1. Click Stimulus1.

Select Sweep2.

Select Sweep Control3.

Select Pulse Setup...4.

 

Pulse Setup dialog box help

Note: The M937xA does not support this function.
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The Basic controls allow simple pulse measurements using the default (Autoselect) settings in the

Advanced section of the dialog.

Pulsed measurements are performed in a Standard channel. See Measurement Class. However,

several VNA measurement settings are controlled by the Pulse setup, such as sweep type, number of

points, and so forth.

Pulse Measurement

Off - Source and Receivers are NOT pulsed

Standard Pulse - With pulsed RF, the VNA can be configured to sweep in frequency, power

sweep, and CW time.

Pulse Profile - Pulse profile measurements provides a time domain (CW frequency) view of the

pulse envelope. Profiling is performed using a measurement technique that "walks" a narrow

receiver "snapshot" across the width of the pulse. This is analogous to using a camera to take

many small snapshots of a wide image, then piecing them together to form a single, panoramic

view.

Pulse Profile measurement using default settings and R1 receiver.

Pulse Profiling can be performed using ratioed or unratioed measurements. You can preview the pulse
on port 1 by using an R1 receiver measurement.

Pulse Profiling is performed at a single CW frequency in either Narrowband or Wideband mode.

To select the CW Frequency, click Stimulus, then Sweep Type.

Pulse Timing

Pulse Width - Sets the width of the source pulse. See measurement timing to learn how to control

the receiver width and delay.

1988



Pulse Period  The time to make one complete pulse.

Pulse Frequency (PRF) The reciprocal of Period (1/ Period). See Internal Pulse Generators to learn

more.

By default, these settings configure Pulse Gen 1 to drive Source Modulators 1 and 2. This can be

changed from the Advanced Settings Pulse Generator Setup dialog.

-------- Advanced Settings ----------

The following settings allow maximum control of a Pulse measurement.

Properties

Autoselect pulse detection method - check to automatically switch between Narrowband and

Wideband based on the Pulse Width.

In Standard Pulse:

Wideband - used when the (source) Pulse Width is WIDER than the fastest receiver acquisition time.
 This allows the receiver to measure all pulse ON time - no pulse OFF time.  The VNA will select
Wideband whenever possible. (Only Wide band is available for M9485A)

Autoselect IF Path Gain and Loss - For future use.

Optimize Pulse Frequency - Automatically selects the Pulse Frequency and Pulse Period. (This

is not available on M9485A)

Autoselect Profile Sweep Time - In Pulse Profile mode, adjusts the default X-axis start time to

zero and the stop time double the Pulse Width. This allows you to see one complete pulse. If

unchecked, the Sweep Time will not be changed.

Measurement Timing

Source1 - Used as RF Source Modulation Drive.

Width - source pulse width.

Delay - source pulse delay relative to the pulse generator clock.

Pulse Gen - Pulse generator used to modulate the source. Select CW to have NO source modulation.
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all receiver paths are the same.

Pulse Trigger Source   Choose from:

Internal - Default setting. The pulse generator is triggered by an internal pulse clock.

External - External pulse input from PULSE SYNC IN is used for pulse trigger.

<External Pulse Gen name> - Available when a 81110A is configured as an External Device
and Master Mode is checked on the pulse generator properties dialog.  See how to make this

setting using SCPI.  

Autoselect Width and Delay - When checked, for Wideband mode and Pulse Gen = Pulse

Trigger, the default setting for the receiver is adjusted to approximately 75% of the source pulse

width, with 20% delay. This leaves approximately 5% of the source pulse ON after acquisition is

complete.

Autoselect Pulse Generators - When checked:

Pulse1 is selected for Modulator Drive.

Pulse Generators  Click to launch the Pulse Generators Setup dialog.

 

Pulse Generators Setup dialog box help

This dialog is available with Option S93025A (pulse generators).

To see this dialog, press Pulse Gen Setup on the Pulse Setup dialog.

Pulse Generators

Configure the Pulse Generators to be used for your measurement.
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When configured, external pulse generators appear in this list. Learn more.

Delay defines the delay between the pulse clock and when the receiver begins to make a

measurement. Learn more.

D = Delay; the time before each pulse begins

W = Width; the time the pulse is ON

Duty Cycle = W/P

P = Period; one complete pulse cycle

Pulse Frequency (PRF) = 1 / Period

Important: If D + W is greater than P, then undefined VNA behavior results. There is NO error

message or warning. P-(D+W) >120 ns should be satisfied.

Invert  Check to cause the pulse ON time to be active low and OFF be active high.

Enable  Check to enable individual pulse generators.

Trigger  Choose from: (When ONE of these is changed, they ALL change. The internal Pulse

Generators can NOT be triggered individually).

Internal - Pulse generators are triggered by the internal pulse clock.

External - Pulse generators are triggered by an external pulse generator.

Frequency - Set the pulse frequency of each generator.

Pulse Frequency (PRF) = 1 / Period

P = Period; one complete pulse cycle

Period - Set the period of each generator.

Learn more about the Pulse Generators.

Pulsed Sources
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Check to enable one or both internal source modulators.

T

Important: When internally modulating the sources, source leveling is automatically set to Open-loop
(ALC Open Loop box will be checked automatically).

Modulator Drive  Choose the pulse generator to modulate the specified source. Choose from CW

(NO pulse), Pulse 1, 2, 3, 4, External.

Pulsed Receivers

Synchronize ADCs using pulse trigger - Check to enable triggering used to gate the ADC for

wideband receiver measurements. This is the same as Pulse0 Enable. The Width can NOT be

configured.

ADC trigger delay - Set the amount of time to wait before triggering the ADC to begin

acquisition. This is the same as Pulse0 Delay.

Pulse4 output indicates ADC activity - Check to use an oscilloscope connected to pin 13 of the

PULSE I/O connector on the rear panel of the VNA to display when the ADC is making

measurements.

Pulse Trigger.. - Click to start the Pulse Trigger dialog.

Trigger... - Accesses the Trigger dialog for setting up triggering. Learn more.

 

 

Pulse Trigger Tab - Trigger dialog box help
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To see this dialog, press Pulse Trigger on the Pulse Generator Setup dialog or select Stimulus, then

Trigger from the VNA Menu.

Trigger Source

Select Internal or External to provide sync capability for the internal pulse generators.

Internal - The pulse generator is internally triggered and puts out a periodic pulse train with a period
defined by the Pulse Generator Setup dialog.

External - The internal pulse generator puts out one set of pulses (P0-P4) per external trigger. All five
pulse outputs have unique delay and pulse width settings.

(M9485A) The PULSE SYNC IN pin provides a configurable trigger signal into the Pulse

Generators. Only one set of pulses is emitted when edge triggering is used. The length of time

that it takes to emit one set of pulses is the end time of the last enabled pulse (largest of width

+ delay of all the pulses P0-P4).

Trigger Level/Edge

Sets the edge or level of the trigger signal to which the internal pulse generators will respond when

being externally triggered at the PulseSyncIn pin.

Positive = rising edge; Negative = falling edge.
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Receiver synchronization

Synchronize ADCs using pulse trigger - Check to enable triggering used to gate the ADC for

wideband receiver measurements. The Width can NOT be configured.

ADC trigger delay - Set the amount of time to wait before triggering the ADC to begin

acquisition.

 

Using External Pulse Generators

Setup the External Pulse Generator as an External Device.

Calibration in Pulse Mode

To perform a calibration in pulse mode, first configure and apply the pulse parameters (PRF, Pulse

Width, Delays, IF gating, and so forth) before calibrating the system. This will ensure the VNA is

configured properly during the calibration and measurement.
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Noise Figure Application (Opt 028)

Note: The M9370A/71A/72A/73A/74A/75A does not support this function.

The Noise Figure Application makes fast, easy, and accurate noise figure measurements.

The information presented in this topic pertains to Noise Figure measurements on BOTH Amplifiers

and Converters unless stated otherwise.

Noise Figure Hardware and Software Options Explained (028)

Features, Requirements, and Limitations

Noise Concepts

How the Noise Figure Application Works

M9485A External Switch Setup

Noise Parameters that are Offered

Using Noise Figure App

Connect Tuner and Noise Source

Create a Noise Figure Measurement

Make Noise Figure Settings

Perform Calibration (separate topic)

Save Noise Data

Noise Figure Measurement Tips

Using Noise Figure Traces in Equation Editor

Noise Model and the Noise Correlation Matrix

See Also

Noise Figure Calibration

Programming commands
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Noise Figure and TRL Cal

See other VNA Applications

Noise Figure Hardware and Software Options Explained

028 - Uses M9376A standard or M9377A DRA VNA receivers to measure noise figure.  A noise source is
used during calibration. Any two ports can be used. Use with DUTs that have sufficiently high gain and noise
figure. Additional filtering may be necessary. Learn more.

Noise Figure Application Features

Cold noise method includes correction for imperfect system source match for highly accurate noise figure
measurements.

During calibration, ENR values are interpolated for frequencies between the supplied data points.

Noise Figure Application Requirements

Recommended: An accurate thermometer. Learn more .

Noise Source

When using a Noise Source, the following requirements apply:

The 346C Noise Source (recommended) produces ENR values to 26.5 GHz.

The 346B Noise Source can be used up to 18 GHz.  

The 346A Noise Source can also be used up to 18 GHz, but requires more averaging
for calibration.

The 346C K01 (50 GHz) Noise Source typically has about 6 dB of ENR at 50 GHz
which may NOT yield an adequate calibration, depending on how many noise averages
are used.

An adapter may be necessary to connect the Noise Source to the VNA port 2 reference
plane during calibration . Cal Kit (or second ECal module) with same connector type
and gender as DUT connectors.

Limitations with the Noise Figure Application
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The following features are NOT supported in a noise figure channel:

FCA or Frequency Offset (opt 080) .

Analog sweep . All frequency sweeps are STEPPED.

Independent IFBW, Power Levels, or Sweep Time in a segment table is NOT supported.

Receiver calibration .

Enhanced Response Cal

ECal User Characterization .

Some Fixturing Features

Auto Port Extensions

Auto Formatted Citifile data.

External DC Devices

Pulsed noise figure measurements are supported with the following limitations:

Minimum 300 microsecond pulse width using 24 MHz noise bandwidth

Narrower noise bandwidths cause larger minimum pulse widths

A drop-out may occur at start of sweep and at 3 GHz. This is corrected by a 1 ms pulse width at 24
MHz Noise BW.

Noise Concepts

The following conceptual information is a short summary taken from the Keysight Noise Figure App

Note 57-1 .

All electronic circuits have some degree of random noise. The most common form is thermal noise,

which increases as the temperature of the circuit increases.

The signal-to-noise (S/N) ratio of components in a communications system is a very important
parameter. To improve the S/N ratio, it is usually easier and more cost-effective to reduce noise than to

increase signal power.  In order to reduce noise, an accurate method to measure noise is required.

Noise Figure

Noise Figure is the degradation in the signal-to-noise ratio as a signal passes through a device. For
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example, in the following images:

(a) At the INPUT of the DUT:

The noise floor is  -100 dBm, the

signal is at -60 dBm,  40 dB above

the noise floor.

(b) At the OUTPUT of the same

DUT:

The gain has boosted the signal AND

the noise floor by 20 dB.

The DUT then added 10 dB of its

own noise.

The output signal is now only 30 dB

above the noise floor.

Since the degradation in signal-to-

noise ratio is 10 dB, the DUT has a

10 dB noise figure .

For consistency, noise measurements are calculated as if using a 1 Hz bandwidth, although

measurements are almost always made at higher bandwidths.

The following formula shows the lowest possible noise power in dBm at 290°° K (room temperature).

The only way to measure noise lower than this is to make the measurement at a lower temperature.

P = 10LOG(4.0 x 10 -21 watts/.001 watt)

P = -174 dBm / Hz

How the Noise Figure Application Works

The goal of the noise figure application is to accurately measure the noise that is generated by the DUT.
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 This may be done using the standard VNA receivers. The standard receivers are always calibrated

using a characterized noise source. Learn more about the noise calibration process .

Here is how a vector noise figure measurement is made. The sweep numbers are annotated on the VNA

display as they occur.

S-parameter measurements are made to accurately characterize the gain of the DUT.  This requires sweeps
in both forward and reverse directions. (sweep #1 and #2).

1.

The noise measurements are performed  next. The source power is turned OFF. At each frequency, the
noise receiver samples a large number of readings in order to attain one valid measurement. If Noise
Averaging is selected, the specified number of measurements are made and averaged together to obtain one
noise measurement. This continues for all frequencies (sweep #3).

2.

Calibration error terms are applied. The sweep result is plotted on the VNA display.3.

The VNA begins sweeping again with step 1.4.

M9485A External Switch Setup

When you make a Noise Figure measurement with the M9485A, the external source switch is required

to avoid inputting the noise into DUT from the source signal.
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Case 1

The external source switch is controlled by I/O output signal . So that, the path a should be selected

during S-parameter measurement and The path b is selected during noise power measurement. Amp &

Switch module can be used in order to improve the noise figure measurement sensitivity

Recommended Noise Source and Pre-Amplifier Gain

Receiver configuration
Input noise power at receiver

input port (*1)

External preamp gain (*2)

For noise source

calibration (*3)

For power meter

calibration

M9376A <-100dBm/Hz 30dB to 50dB < 25dB

M9377A & M9378A/B

(Standard configuration)
<-105dBm/Hz 25dB to 45dB < 20dB

M9377A & M9378A/B

(Wide dynamic range

configuration)

<-120dBm/Hz 10dB to 30dB < 5dB
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( *1) For example, DUT(gain =20dB, NF= 5dB) with 25dB gain external preamp will output -

124dBm/Hz noise power.

(*2) When M9379A is used as external preamp, select configuration(1-stage or 2-stage) and internal

ATT setting appropriately to avoid unexpected receiver compression during calibration and

measurement.

(*3) Recommend to use 346B or 346C (nominal ENR = 15 dB).

 

Case 2

When you use M9379A RF Amplifier module and M9161D switch module, you can setup a Noise

Figure measurement more easily. The VNA firmware can control each module automatically.

Example 1:

The M9161D Switch 1 is used as RF source switch. (DUT should be connected with P1-1. 50 ohm

termination should be connected with P1-2.)

The M9379A Out is connected with port 2

Switch Module Control Setup: Switch 1 > Auto RF Out

RF Amplifier Module Control Setup: PATH > Auto NF Port 2 , Switch > Auto NF Port 2

Using the Noise Figure Application

Use the following general procedure to make noise figure measurements:

Connect Noise Source .1.

Create a Noise Figure Measurement .2.

Make Noise Figure Settings .3.

Perform Calibration  4.

Connect the DUT. Learn more about DUT input and output ports.5.

Measure Noise Figure.6.

Optional  Click File , then Save to save noise figure data. Learn more .7.
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7.

Connect Noise Source

Connect the noise source and DC source.

Configure the DC source using Configure a DC Device to set up waiting time and commands as required.
Set “Timeout” and “Dwell Before Sweep”. VNA doesn’t use other settings for noise source control.

> When 346CH08 is used, Click Load and select 346CH08.xml file.

Input commands for setting the noise source on into “Before sweep” and  “After sweep”. Other settings are
ignored for noise source control.

2002



Create a Noise Figure Measurement

On the VNA front panel, press Meas > S-Param > Meas Class... .1.

Select Noise Figure Cold Source, then either:

OK delete the existing measurement, or

New Channel to create the measurement in a new channel.

2.

A noise figure measurement is displayed. The following shows how to select or change displayed
parameters.

3.

Noise Parameters

Several noise parameters, as well as standard parameters, can be measured in the same Noise channel.
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How to add Noise Parameters

Create a Noise Figure channel.1.

Then do the following:2.

Using Hardkey /SoftTab /Softkey Using a mouse

Press Trace > Trace N >  Trace N .1.

Press Trace > Trace Setup >  Measure... .2.

Click Instrument1.

Select Trace2.

Select Add Trace3.

Click Instrument4.

Select Trace5.

Select Measure...6.

How to CHANGE Noise Parameters

Create a Noise Figure channel.1.

Select the parameter to change.2.

Then do the following:3.

Select a trace by pressing Trace > Trace N >  Trace N .1.

Press Trace > Trace Setup >  Measure... .2.

Select a parameter.3.

Right-click on a trace.1.

Select a parameter2.

Noise Measurements that are offered

The following three categories of noise measurements can be made with the VNA:

Noise Figure is the amount of noise that the DUT is adding in a 50 ohm test setup. This is explained in detail
in Noise Concepts .

1.

Noise Power Parameters show the amount of noise coming out of the DUT in a 50 ohm test setup. With gain
measurements of the DUT, these noise power parameters are used to calculate noise figure.

2.

3.
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2.

Noise Parameters are models of the noise that is generated in a DUT, similar to how S-parameters model
how RF flows through a DUT.

3.

Noise Figure (NF) - Explained in Noise concepts .

Excess Noise Ratio - Select when measuring the noise source. Compare with the ENR table to validate
accuracy of the system. ENR is calculated as:

ENR (in dB) = 10 log10((Thot Tcold) / T0), where T0 = 290K.

Learn more about the ENR table and Noise Source. Learn more about Noise Source ENR

measurements.

T-Effective - The effective temperature, in Kelvin, of the measured noise level. For example:

290°° K =  -174 dBm/Hz.

T e is the unknown variable

Available Gain G a is a function of S11 , S22 , and Γ s

Noise Power Parameters

The Noise Power parameters below are offered in the following two formats:

Available Noise Power  The calculated power that is based on an ideal impedance match at the output of
the DUT. These parameters have always been offered in the VNA noise figure App.

Incident Noise Power - An 'I ' is appended to the end of the Available Noise Power parameter. The
calculated power into a perfect 50 ohm noise receiver, regardless of the output impedance of the DUT.  

SYSNPD / SYSNPDI - System Noise Power Density:  Total noise power available at the ADC, including the
noise contributed by both the DUT and the internal noise receiver.  This is generally expressed as an
absolute power measurement in dBm, but can also be expressed in Watts or Kelvin.   
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dBm = 10 log10 (k * T * B * 1000)

where:  

  k = Boltzmann's constant

  T = the measured noise

temperature

  B = bandwidth

  1000 = conversion from milliwatts

SYSRNP / SYSRNPI - System Relative Noise Power:  The noise temperature of the combined DUT and
receiver relative to 290 Kelvin.  This is generally reported as a ratio in dB.  Therefore a perfectly quiet device
would render a trace at 0 dB.

dB = 10 log10 (T/290)

DUTNPD / DUTNPDI - DUT Noise Power Density:  When correction is ON, this trace exhibits the available
noise power, best described as the maximum power available from the DUT where the impedance of the
noise port is equal to the output match of the DUT. To be more precise, this occurs when the noise port
match is equal to the conjugate of the output match of the DUT.  The noise power contributed by the receiver
is removed.

When correction is OFF, the trace exhibits what is more accurately described as delivered power.

 Delivered power is the power actually seen by the ADC.  Any mismatch between the receiver

and the DUT is ignored.  The noise power contributed by the receiver is removed.

This measurement is generally expressed in dBm, normalized to a 1 Hz bandwidth. For

convenience, marker and trace readout shows dBm .

You could display the power in a different bandwidth using Equation Editor .

dBm/Hz = 10 log10 ( (DUT Temperature - Receiver Temperature) * B *

1000)

where:  

  B = bandwidth

  1000 = conversion from milliwatts

DUTRNP / DUTRNPI - DUT Relative Noise Power:  This measurement is rendered as a ratio of the DUT
temperature to 290 Kelvin.  It is generally expressed in dB.  The same comments apply with respect to
available versus delivered power as described above for DUTNPD.

dB = 10 log 10 (DUT Temperature - Receiver Temperature)

Noise Model, Noise Parameters, and the Noise Correlation Matrix
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Note: M9485A does not support Noise Parameters

Noise Parameters are models of the noise that is generated in a DUT, similar to how S-parameters

model how RF flows through a DUT.  

Noise Model

The noise wave model of any linear 2-port network may be represented by the following image:

This shows a noiseless 2-port network with noise waves (a n1 and b n1 ) added to the input terminals.

The a 1 a 2 and b1 b2  are standard S-parameter waves.

The noise correlation matrix relates to the noise waves as follows:

Where:

 are time-averaged noise power in 1 Hz bandwidth.

  are time-averaged cross correlation terms, correlation of a n1 to b n1 .

Overbars represent time-averaging

Star superscripts represent complex conjugation

Noise Parameters

Gamma Opt  (Optimum Complex Reflection Coefficient) - The optimal impedance for the noise figure
measurement. Select the data format to display Gamma-Opt-Magnitude and Gamma-Opt-Phase (most
common), or Gamma-Opt-Real and Gamma-Opt-Imaginary.

NF min - The minimum noise figure that occurs at GammaOpt .

R n  (Noise Resistance) - Specifies the rate of change of the level of noise when varying the source
impedance.
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NCorr_11, NCorr_21, NCorr_12, NCorr_22 - The NCorr_11 and NCorr_22 terms are effective noise
temperature, normalized to 290 K. Both terms are time-averaged, noise-wave powers referred to the input of
the DUT, where NCorr_11 is the forward wave (noise going through the device towards the output), and
NCorr_22 is the reverse noise wave (noise coming out of port 1 of the DUT, going back towards the source).

To convert to available noise power, multiply the terms by 290*k*B where:

k = Boltzmanns constant

B = system bandwidth

Standard Parameters that are offered (Amplifiers-only)

S-parameters : S11, S21, S22, S12

Unratioed parameters using the following notation: (Receiver, source port). These parameters REPLACE
the active measurement.  To do this (from front-panel ONLY), press MEAS , then [More] , then [Receivers] .

(R1,1), (R2,2), (A,1), (A,2), (B,1), (B,2)

Save Noise Data

To save noise data, click File , then Save Data As   Then select from the following Save As Types:

(*.prn), (*.cti), (*.csv), (*.mdf) - Noise Figure data can be saved ONLY with these choices. PRN saves only
the active trace. CITI formatted, CSV Formatted, and MDF can save all displayed traces. Learn more about
these formats.

(*.s2p) - Saves S-parameter data only after performing a Noise calibration. This data is saved regardless of
which noise measurement is active or displayed. Learn more about *.s2p data .

Trace and Noise parameter (*.s2p) - Saves S-parameter data, then the Noise Parameters . This data is
saved regardless of which noise measurement is active or displayed.  When the vector calibration is not
enabled or if the noise parameters are not realizable, then the noise parameters have no calculated value. In
this instance, the following values are displayed instead:

Gamma Opt = 0

NF min = raw noise figure

R n = Z0 / 4 * (F - 1). This equation is how Rn is currently calculated for ill-conditioned data. F is the
noise factor where F is related to the noise correlation value ct11 and the normalized noise
temperature Tn by F = 1 + ct11 = 1 + Tn so that Rn = (Z0 / 4) x ct11
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NoiseCorr (*.nco) - Saves Noise Correlation data regardless of which noise measurement is active or
displayed.  The *.nco file is a noise correlation matrix expressed in T-parameter form (Ct11, Ct21, Ct12,
Ct22) . These parameters are exactly the same as the Noise parameters NCorr_11, NCorr_21, NCorr_12,
NCorr_22 that can be displayed as traces.

When the vector calibration is not enabled, this data is set to -200 dBm.

How to start the Noise Figure Setup dialog

Using Hardkey /SoftTab /Softkey Using a mouse

Freq > Main >  NF Setup... .1. Click Stimulus1.
Select NF Setup...2.

 

Noise Figure Setup dialog box help

Note: In this topic, the term Jitter is used to describe the trace-to-trace fluctuations in a

measurement. In other topics, this is called 'trace noise'.

Bandwidth/Average

The following settings work together to achieve the optimum balance of measurement accuracy

versus speed:  

Noise Bandwidth   Increase the bandwidth to reduce the amount of trace noise on the noise

power or noise figure measurement (jitter). However, a wider setting reduces the frequency

resolution of the measurement.  The noise bandwidth setting should always be smaller than the

bandwidth of the DUT. The noise bandwidth setting is used only while measuring noise powers,

and is independent from the IF bandwidth setting used to measure S-parameters. Noise figure is

calculated from noise power and S-parameter measurements.

The calibration and measurement should be performed using the SAME noise bandwidth. When
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the noise bandwidth is changed after calibration, noise figure measurements can change by 0.5 dB

or more, depending on the DUT frequency range, gain, and noise figure.

M9485A Sweep Time for Noise BW (@ Noise Average = 1)

Noise BW Sweep Time (µ) Noise BW Sweep Time (µ)

800 kHz 500 8 MHz 50

2 MHz 200 12 MHz 30.3

4 MHz 100 24 MHz 16.7

Average Number  Increase the number of averages to reduce jitter. This also reduces

measurement speed. For maximum accuracy, use the following recommendations for the noise

calibration. When using the noise receivers, 10 noise averages is recommended. When using the

standard receivers, at least 100 averages are recommended.

During a measurement, the gain of the DUT helps overcome the noise of the VNA receivers, so

the number of noise averages can be reduced to improve measurement speed with minimal or no

degradation to measurement accuracy.

Use Narrowband Compensation

Note: M9485A does not support this function.

The mathematics of noise figure assumes that the gain of the DUT is constant over the bandwidth

of the noise receiver. The following image illustrates a case in which the gain (S21) of the DUT

falls off sharply outside the passband region. When the VNA measures noise figure at the

frequency indicated by the solid vertical line using a 4 MHz noise bandwidth, standard noise

figure calculations assume the gain to equal its midpoint value (dashed horizontal line) over the

entire 4 MHz bandwidth. This assumption yields a composite gain-bandwidth value that is lower

than the actual value, which in turn results in a noise figure value that is too high. This is the

reason for the bump in the displayed NF value at this frequency and surrounding frequencies.
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In the following image, Narrowband Compensation combines DUT measurements with

characteristics of the noise receiver, which accommodates changes in DUT gain over the receiver

bandwidth. The result is a better gain-bandwidth value of the system. Notice how the peaks and

valleys of the NF measurement disappear when narrowband compensation is applied.

Notes on using Narrowband Compensation:

Can be used with both Scalar and Vector NF calibrations, on NF channels.

The ON / Off state has no effect on calibration. In other words, it does not matter if Narrowband
Compensation is On or Off while a noise calibration is being performed.

2011



Is applied only when corrected DUT measurements are made. If correction is turned off, it has no effect.

Can be ON or Off while the NF channel is in Hold mode, and it will modify the NF trace appropriately.
There is no need to re-sweep.

Noise Receiver

Note: M9485A does not support this function.

Receiver Gain  

Note: M9485A does not support this function.

Ambient Temperature

Enter the room temperature at the time of the measurement, in Kelvin. For best results, use a

thermometer to read the temperature at test port 2 (the noise receiver input) or the DUT output

cable.

Note: This setting is only used for calibrated noise figure measurements, but has no effect in an

uncalibrated noise figure channel. The default value is used for uncalibrated measurements.

This ambient temperature number has an inverse relationship to the noise figure.  When using the

effective noise temperature (Te) format, a 3 degree increase in the ambient temperature will make

the calibration measurement result drop 3 degrees, which will then have an effect on subsequent

noise figure measurements.

Impedance States

Note: M9485A does not support this function.
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Frequency Tab - Noise Figure dialog box help

These settings can also be made from the normal VNA setting locations. Click links below to learn

how.

Sweep Type

Choose a sweep type. Learn more.

Segment Sweep Notes:

The segment table shown on the dialog is 'READ-ONLY' .

Learn how to Create and edit the Segment Sweep table .

Independent IFBW and Power are NOT available.

X-axis point spacing is available beginning with A.09.10.

Sweep Settings

Click each to learn more about these settings.

Number of points   

IF Bandwidth  This setting is important for improving noise measurement accuracy. Learn more.

Start / Stop , Center / Span frequencies.

 

Power Tab - Noise Figure dialog box help
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Note: S-parameter power settings are critical for accurate noise figure measurements. See Noise

Figure Measurement Tips.

Configures RF power settings for the S-parameter measurements that occur before noise

measurements. Input power to the DUT is turned OFF during noise measurements.

These settings can also be made from the normal Power setting locations.

Power ON (All channels)  Check to turn RF Power ON for all channels.

DUT Input Port

Select a VNA port to be connected to the DUT input.

Note: Input power levels are critical for accurate noise figure measurements. Learn more.

Power Level  The input power to the DUT during S-parameter measurements.

Receiver Attenuator  Specifies the receiver attenuator setting for input port.

NOTE: When the M9377A DRA receiver is used, Receiver Attenuator is available. 0 dB

attenuator is recommended for Noise Figure measurement.

Source Leveling   Specifies the leveling mode. Choose Internal.  Open Loop should only be used

when doing Wideband Pulse measurements (not available with Noise figure measurements).

DUT Output Port

Select a VNA port to be connected to the DUT output.

Output Power  Sets power level in to the output port for reverse sweeps. Port power is
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automatically uncoupled. Reverse sweeps are always applied to the DUT when Full 2-port

correction is applied.  Enhanced Response Cal is NOT available for noise figure measurements.

Receiver Attenuator  Specifies the receiver attenuator setting for the output port. Learn more

about Receiver Attenuation.

NOTE: When the M9377A DRA receiver is used, Receiver Attenuator is available. 0 dB

attenuator is recommended for Noise Figure measurement.

Source Leveling   Specifies the leveling mode. Choose Internal.

 

Noise Figure Measurement Tips

Note: In this topic, the term Jitter is used to describe the trace-to-trace fluctuations in a measurement.

In other topics, this is called 'trace noise'.

IF Bandwidth

Jitter is further reduced by narrowing the IF bandwidth. If the calibration needs to be performed at a

low source power, or with receiver attenuation due to high DUT gain, the IF bandwidth should be

reduced during the calibration to reduce jitter. The IF bandwidth can then be increased to improve

measurement speed.  The C  annotation can be ignored when changing IFBW after calibration.

Noise Settings

See Noise Figure dialog box help for a complete description of these important settings.

Temperature

Noise Figure measurements are extremely sensitive to temperature. As such, there are two settings that

require an accurate temperature measurement: At the DUT input , and at the Noise Source connector.

Interference

When measuring the noise figure of an unshielded device, like an amplifier on a printed-circuit board,

it is very common to pick up interference from external signals such as cellular phones, wireless LAN,

or mobile radios. This interference shows up as non-repeatable spikes in the measurement, as shown

below.
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Usually, the interference adversely affects the noise figure measurement only at the frequency where it

occurs. However, if the interference is large enough and present all of the time, it can cause the noise

receivers to compress, which results in inaccurate measurements at many frequencies. In this case, the

noise figure measurements should be done in a shielded environment like a screen room.

Option 028

Noise Figure of VNA receiver - Option 028 gives you the flexibility to measure noise figure using a

standard VNA receiver. For best measurement accuracy, the DUT excess noise power, which is gain

plus noise figure minus cable loss in dB (G + NF - Loss), should meet or exceed the noise figure of the

receiver. This is generally not a problem with very high-gain devices such as converters with

approximately 60 dB of gain.

If your DUT is NOT a very high-gain device, you can re-configure the VNA front panel loops to

increase receiver sensitivity.

Using Noise Figure Traces in Equation Editor

In a Noise Power trace, the underlying unit is noise temperature.  

10*log10( temperature * 1000mw/w * 1.38e-23)

(1.38e-23 is Boltzmanns constant)

Any time you use Equation Editor on a Noise Power trace, the LogMag formatting will apply the above
equation.  Therefore, first select REAL format and then generate the equation.

The following screen is an example showing three traces: DUTNPD (DUT Noise Power Density), NF

(Noise Figure), and S11 with the equation set to "***=10". Note that formatting for noise figure

measurements is different than noise power measurements or temperature measurements.
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Radio-Frequency Electromagnetic Field Immunity

When a 3Vm-1 radio-frequency electromagnetic field is applied to an VNA with Opt 029 according

to IEC 61000-4-3:1995, degradation of performance may be observed. When the frequency of the

incident field matches the frequency of a measured noise figure or gain, the values displayed will

deviate from those expected. This phenomenon will only affect that specific frequency, and the

analyzer will continue to perform to the specification at all other frequency sample points.

The VNA with Opt 029 may be unable to calibrate a chosen frequency sample point if the frequency

matches that of an incident electromagnetic field.
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Calibration for Noise Figure on Amplifiers

Note: The M9370A/71A/72A/73A/74A/75A does not support this function.

This topic discusses calibration for both Noise Figure on Amplifiers .

Overview

How to Perform a Noise Figure Cal

Select Calibration Method

Configure Noise Source

Select DUT Connectors and Cal Kits

Measure Standards Steps

Validate Noise Source Cal

See Also

Noise Figure and TRL Cal

See Noise Figure Applications

Noise Figure Calibration Overview

Note: Noise Figure results are NOT at all accurate without a Noise Figure calibration.

Calibrating the Noise Receivers

Using a Noise Source (See Noise Source requirements). NOT used when measuring noise figure with
Standard VNA receivers.

A Noise Source is a device that generates two very consistent levels of noise over its operating

frequency range:

Hot (On) -  the Noise Source is biased in order to provide a high level of noise.

Cold (Off) -  the Noise Source is unbiased to provide ambient temperature noise level.
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These levels are measured by the Noise Source manufacturer and provided in table and electronic

format with each Noise Source by serial number. The electronic file is known as the ENR (Excess

Noise Ratio) file.

The Noise Source is connected to the noise receiver through test port 2.1.

Note: For highest accuracy, the noise source should be connected as close as possible (the least

amount of electrical loss) to the VNA port 2 connector. This causes the largest difference

between the Noise Source HOT (on) and COLD (off) settings.

The Noise Source is measured by the noise receivers at each measurement frequency. The differences
between the known ENR noise levels and the measured noise levels are the noise error terms. These values
are removed from subsequent noise measurements.  

2.

During the Noise Source measurements, noise averaging and noise bandwidth is automatically turned ON to
the values that you specify. Learn more about Noise Averaging.  

3.

Following the Noise Receiver Cal

A 2-port S-parameter calibration is performed on the noise figure channel. This is because S-parameters
are measured at each frequency step before a noise measurement. Also during the S-parameter cal, at least
FOUR different impedance states are presented at port 2 in order to later characterize the noise generated
by the noise receiver. This cal can be either a SOLT or TRL cal. See Noise Figure and TRL Cal.

After calibration, correction is automatically turned ON. The VNA status bar shows VNC_2P (for Vector) or
SMC_2P (for Scalar).

How to Perform a Noise Figure Calibration

Make the noise figure channel the active channel.

Connect the noise figure Tuner to the VNA (for Vector noise figure cal).

Using Hardkey/SoftTab/Softkey Using a mouse

Press CAL > Main > Smart Cal....1. Click Response1.

Select Cal2.

Select Smart Cal...3.
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The following Cal Wizard pages are unique to noise figure calibration. The remaining pages that are

presented are the same as those in the standard Cal Wizard SmartCal.

Select Calibration Method dialog box help

Calibration Method

Note: The M9485A does not support Vector Noise.

Vector Noise - Comprehensive noise figure calibration

S-Parameter Only - Does NOT calibrate the noise receivers. NOT offered with NFX.

Scalar Noise - Calibration for scalar noise figure measurements. Learn more.

Noise Tuner

Note: The M9485A does not support this function.

Orientation

Note: The M9485A does not support this function.

Receiver Characterization - Learn more about this process.

Use Noise Source - A noise source is used to characterize the low-noise receivers.

Use Power Meter - A Power Meter/Sensor is used to calibrate a VNA source, which then is used to
characterize either the low-noise receivers or a VNA receiver.  This selection is made for you and can
NOT be changed when NA Receiver is selected on the Noise Figure Setup dialog.

Note: (M9485A) Select Internal for Power > Leveling & Offsets > ALC Hardware setting  
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Configure Noise Source dialog box help

DC Bias Noise Source using Select the required noise source from selection.

DC Setup Setup the external DC source.

Temperature  Specify the current temperature at the Noise Source connector.  The Noise source is

kept ON during noise figure measurements. This results in the Noise Source being a few degrees

warmer than Ambient temperature, and a more accurate calibration. See Noise Figure tips to learn

more about the significance of temperature.

ENR File  Select the Noise Source ENR file. If not already there, copy your Noise Source ENR file

to the VNA C:/Program Files/Keysight/Network Analyzer/Noise folder. Then click Browse to find

the ENR file.

Clear ENR List  Scroll to the bottom of the ENR list, then click to remove the selected ENR file.

Then browse or select to find a new file.

Edit ENR   Click to launch the ENR Editor dialog box which is used to change or create ENR files.

This is NOT usually necessary.

 

See Noise Source requirements.

 

Click either Create or Edit to launch the same dialog box, shown below.

Edit populates all fields with existing data which can then be edited and stored.

Create has empty fields except for frequencies.
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Edit / Create ENR File dialog box help

ENR Numeric Data

Use Previous and Next buttons to scroll to Entry # to edit. Type ENR value in  dB, then press

Enter.

Done  Click when finished editing all values. Then click Store ENR File to save the file.

Identifying Data

Model # of the Noise Source. This can NOT be changed.

Serial # of the Noise Source.

Temperature and Humidity in which the Noise Source was calibrated. This is for information

only. The ENR data is always normalized to 290 Kelvin.

KeyBd  launches a mouse-driven keyboard.

Store ENR File  Click to launch a dialog to save the new or edited ENR file.

 

Select DUT connectors and Cal Kits dialog box help
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Port 1  and Port 2

DUT (Device Under Test) Connectors  Specify the connector and gender of the DUT.

Cal Kits  Select the Cal Kit to be used to calibrate each test port. The list for each DUT Port

displays kits having the same connector type as the DUT. Using incorrect calibration standards can

significantly degrade measurement accuracy. Learn more.

Power Sensor  Used to calibrate the source port. Specify the connector and gender of the Power

Sensor.

Noise Src  Used to calibrate the noise receivers. The Keysight 346C has an "APC 3.5 male"

connector.

Note: For highest accuracy, the noise source should be connected as close as possible to the VNA

port 2 connector. This causes the largest difference between the Noise Source HOT (on) and COLD

(off) settings.

For both Cal devices (power sensor and noise source, specify the connector type and gender. When

the Cal device connector is NOT the same type and gender as the DUT Port connector, then for

optimum accuracy, extra cal steps are used to measure and correct for the adapter that is used to

connect the Cal device to the reference plane.

Select Ignored (at the bottom of the DUT Connectors list) to NOT compensate for the adapter.

Select the Cal Kit that will be used for that process.

De-embed power sensor adapter / noise source adapter  The VNA uses the connector type and

gender of the DUT along with the connector type and gender of the cal device to determine if an
adapter removal operation is taking place AND whether or not that removal operation requires an

additional cal step.  

However, the use of the connector type can, in special cases, hide the need for the extra cal step.

 Check the "De-embed..." box in these cases to inform the VNA that the extra step is needed.

Such a case is illustrated below where the noise source is connected close to test port 2 for higher
accuracy. If unchecked, the VNA would assume in this case that the Noise Source is connected to
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the Thru standard at the port 1 (DUT input) reference plane.

 

Source Cal Settings  Click to launch the Source Power Cal (for apps) dialog. This dialog is used to

set Power Meter / Sensor settings for both the Port 1 Power Cal, and the optional LO Power Cal.

Modify Cal  Check, then click Next, to Modify Cal (Standards AND Thru Method).

Note: Enhanced Response Calibration is NOT supported with noise figure.

 

Measure Standards Steps dialog box help

Power Level at which to perform the Power Cal.

It is usually best to set power level to 0 dBm at the power sensor because the power sensor is

calibrated at that level. Lower power levels will yield a slower and noisier calibration.

However, with 20 dB of source attenuation (default NF setting), the VNA may not be capable of

achieving this power level at higher frequencies. To check the max leveled power, view an R1

(port 1 reference receiver) trace over the frequency range of interest, then increase the power until

roll-off appears. Power levels at the test port may be approximately 2 dB lower than at the R1
receiver.

If an external component is used between the VNA test port and the calibration reference plane,

then adjust the power level so that the power at the sensor is about 0 dBm if possible.
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The current source attenuation value is shown on the dialog.

Connect Noise Source to the Port 2 measurement (reference) plane

When the "De-embed Adapter.." boxes are checked, additional cal steps are required.

Subsequent Steps

Connect Port 1 to Port 2 - Connect port 1 reference plane to the port 2 reference plane using the

required Thru standard or adapter.

Connect ECal to Ports 1 and 2 - Connect the ECal module between the port 1 reference plane

and the port 2 reference plane.

Validate Noise Source Cal

To validate a Noise Source calibration, connect the Noise Source to Port 2 and measure ENR.

Compare the measured values to the values in the ENR table.

How to manually turn the Noise Source ON | OFF

Press Power > Main > Noise Source.1.
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Noise Figure and TRL Cal

Note: The M9370A/71A/72A/73A/74A/75A does not support this function.

When performing a TRL (or LRL, LRM) Cal as the 2-port S-parameter calibration of a Scalar or Vector
Noise Figure measurement, you may see an error message that states that there are not enough standards

for the cal.

This appears because, during the TRL calibration, at least FIVE impedance states must be presented to

the Noise Receiver port. A typical TRL Cal Kit does not have 5 standards with the same connector type

and gender as the DUT output port, and with different impedances.

To correct this situation, you must define additional standards for your TRL Cal Kit using the Edit Cal
Kit dialog.

Notes

Extra impedance standards are NOT required when you select and use an ECal module to perform the De-
embed noise source adapter. In this case the ECal module is used to present five different impedance states
to the Noise Receiver port.

You can view the impedance match by measuring the standard over the frequency range of interest while
viewing the Smith Chart format. Ideally, all five standards should have a response at different areas of the
Smith Chart.

To Modify the Cal Kit

If the TRL Cal Kit is also defined as an SOLT kit, those Selected Standards will also be searched for

an appropriate Reflect Standard.

Click Edit on the Error dialog, or Cancel.1.

Press CAL > Cal Sets & Cal Kits > Cal Kit....2.

Select the Cal Kit to be edited, then click Edit....3.

On the Edit Kit dialog, click the TRL tab.4.

5.
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3.

4.

For each of the following Calibration Kit Classes, note the ID number in the Selected Standards field:  5.

TRL THRU

TRL REFLECT

TRL LINE/MATCH

For example, in the following image two shorts are defined as TRL REFLECT standards: ID

numbers 7 and 14. Because they are already being used, you can NOT use these IDs for the

additional standards required by the Noise Cal.  You must select other standards available in the

kit or you can define new standards.

Select the SOLT tab, then select any of the following Calibration Kit Class definitions:

SA (Open)a.

SB (Short)b.

6.
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b.

In the Available Standards field, find a standard that is NOT one of the TRL IDs noted above. In this image,
two opens are already assigned as SOLT standards, but because they are NOT assigned as TRL reflection
standards, they are eligible to be additional standards.

7.

If necessary, click >> to add it to the Selected Standards.8.

Note: Be sure to choose standards with the same connector gender as the DUT output port.

If no others exist, the following are good options:

Offset Short

Offset Open

If your TRL Cal Kit does NOT have FIVE standards

You can create a new device by reusing the LINE standard. However, instead of connecting both ends

of the line, leave the line unterminated.  

Although the following example creates an Open standard, during the calibration you will connect any

line standard to the Noise Receiver port. The standard or definition is not important. It is simply

another impedance state.

The following is an example of how to create this device.

On the Standards tab, click Add.
The following dialog appears:

1.
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1.

Select OPEN, then click OK.
The following dialog appears:

2.

 

Change the description to Unterminated Line. This will provide a prompt during the calibration.3.

Change Connector to match your physical line standard.4.

Note the new Standard ID number.5.

In the same manner as step 6 (above), on the SOLT tab, select SA.6.

Assign the new standard ID to the Selected Standards.7.
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7.

Important: Leave the new standard at the bottom of the Available standards list to which it was added.

That way it will have no effect of the SOLT cals using that kit.

 

 

2030



Time Domain

Time Domain allows you to view a device response as a function of time. The following are discussed

in this topic:

Overview

How the Analyzer Measures in the Time Domain

Calibration for Time Domain

Transmission Measurements

Measurement Response Resolution

Measurement Range and Alias Responses

How to make Time Domain Settings

Gating

Window Settings

Note: Time Domain measurements are only available on analyzers with Option S93010A. See
Configurations

See the updated App Note: Time Domain Analysis Using a Network Analyzer.

Overview

In normal operation, the analyzer measures the characteristics of a test device as a function of

frequency. With Time Domain (opt S93010A), the frequency information is used to calculate the

inverse Fourier transform and display measurements with time as the horizontal display axis. The

response values appear separated in time, allowing a different perspective of the test device's

performance and limitations.

The graphic below compares the same cable reflection measurement data in both the frequency and
time domain. The cable has two bends. Each bend creates a mismatch or change in the line impedance.
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The frequency domain S11 measurement shows reflections caused by mismatches in the cable. It is
impossible to determine where the mismatches physically occur in the cable.

The time domain response shows both the location and the magnitude of each mismatch. The responses
indicate that the second cable bend is the location of a significant mismatch. This mismatch can be gated
out, allowing you to view the frequency domain response as if the mismatch were not present. Distance
Markers can be used to pinpoint the distance of the mismatch from the reference plane.

How the Analyzer Measures in the Time Domain

Time domain transform mode simulates traditional Time-Domain Reflectometry (TDR), which

launches an impulse or step signal into the test device and displays the reflected energy on the TDR

screen. By analyzing the magnitude, duration, and shape of the reflected waveform, you can determine

the nature of the impedance variation in the test device.

The analyzer does not launch an actual incident impulse or step. Instead, a Fourier Transform algorithm

is used to calculate time information from the frequency measurements. The following shows how this

occurs.

A single frequency in the time domain appears as a sine wave. In the following graphic, as we add the

fundamental frequency (F0), the first harmonic (2F0), and then the second harmonic (3F0), we can see

a pulse  taking shape in the Sum waveform. If we were to add more frequency components, the pulse

would become sharper and narrower. When the analyzer sends discrete frequencies to the test device, it

is in effect, sending individual spectral pieces of a pulse separately to stimulate the test device.

During an S11 reflection measurement, these incident signals reflect from the test device and are

measured at the A receiver. This is when the time domain transform calculations are used to add the

separate spectral pieces together.
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For example, consider a short length of cable terminated with an open. All of the power in the incident

signal is reflected, and the reflections are 'in-phase' with the incident signal. Each frequency component

is added together, and we see the same pattern as the simulated incident would have looked (above).

The magnitude of the reflection is related to the impedance mismatch and the delay is proportional to

the distance to the mismatch. The x-axis (time) scale is changed from the above graphic to better show

the delay.

Alternately, the same cable terminated with a short also reflects all of the incident power, but with a

phase shift of 180 degrees. As the frequency components from the reflection are added together, the

sum appears as a negative impulse delayed in time.

Calibration for Time Domain

For simplicity, we have discussed incident signals reflecting off discontinuities in the test device. By

far the most common network analyzer measurement to transform to time domain is a ratioed S11

measurement.  An S11 reflection measurement does not simply display the reflections measured at the

A receiver - it displays the ratio (or difference) of the A receiver to the Reference receiver. In addition,

the S11 measurement can also be calibrated to remove systematic errors from the ratioed measurement.

This is critical in the time domain as the measurement plane, the point of calibration, becomes zero on

the X-axis time scale. All time and distance data is presented in reference to this point. As a result, both

magnitude and time data are calibrated and very accurate.

The following shows where the time domain transform occurs in the analyzer data flow: (see Data
Access Map)

1.
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Acquire raw receiver (A and R1) data1.

Perform ratio (A/R1)2.

Apply calibration3.

Transform data to time domain4.

Display results5.

Therefore, although a time domain trace may be displayed, a calibration is always performed and

applied to the frequency domain measurement which is not displayed.

Transmission Measurements

The most common type of measurement to transform is an S11 reflection measurement. However,

useful information can be gained about a test device from a transformed S21 transmission

measurement. The frequency components pass through the test device and are measured at the B

receiver. If there is more than one path through the device, they would appear as various pulses

separated in time.

For example, the following transmission measurement shows multiple paths of travel within a Surface

Acoustic Wave (SAW) filter. The largest pulse (close to zero time) represents the propagation time of

the shortest path through the device. It may not be the largest pulse or represent the desired path. Each

subsequent pulse represents another possible path from input to output.

Triple travel is a term used to describe the reflected signal off the output, reflected again off the input,

then finally reappearing at the output. This is best seen in a time domain S21 measurement.

Measurement Response Resolution

In the previous paragraphs, we have seen that using more frequency components causes the assembled
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waveform to show more detail. This is known as measurement response resolution, which is defined as

the ability to distinguish between two closely spaced responses.

Note: Adjusting the transform time settings improves display resolution, but not measurement resolution.

The following graphic shows the effect of both a narrow and wide frequency span on the response

resolution. The wider frequency span enables the analyzer to resolve the two connectors into separate,

distinct responses.

 

Resolution Formula

For responses of equal amplitude, the response resolution is equal to the 50% (-6 dB) points of the

impulse width, or the step rise time which is defined as the 10 to 90% points as shown in the following

image.

The following table shows the approximated relationship between the frequency span and the window

selection on response resolution for responses of equal amplitude.
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Window Low-pass step

(10% to 90%)

Low-pass impulse

(50%)

Bandpass impulse

Minimum 0.45 / f span 0.60 / f span 1.20 / f span

Normal 0.99 / f span 0.98 / f span 1.95 / f span

Maximum 1.48 / f span 1.39 / f span 2.77 / f span

For example, using a 10 GHz wide frequency span and a normal window in Bandpass impulse mode,

response resolution (in time) equals:

Time Res = 1.95 / frequency span

Time Res = 1.95 / 10 GHz

Time Res = 195 ps

To calculate the physical separation (in distance) of the responses which can be resolved, multiply this

value times the speed of light (c) and the relative velocity (Vf) of propagation in the actual transmission

medium. In this case, Vf = 0.66 for polyethylene dielectric.

Distance Res = 195 ps x c x Vf

Distance Res = 195 ps x (2.997925 E8 m/s) x .66

Distance Res = 38 mm

For reflection measurements, because of the 2-way travel time involved, this means that the minimum

resolvable separation between discontinuities is half of this value or 19 mm.

Although a wider frequency span causes better measurement resolution, the measurement range becomes

limited. Also, increasing the frequency range can cause a measurement calibration to become invalid.

Be sure to adjust the frequency span BEFORE performing a calibration.

Measurement Range and Alias Responses

Measurement range is the length in time in which true time domain responses can be seen. The

measurement range should be large enough to see the entire test device response without encountering

a repetition (alias) of the response.  An alias response can hide a true time domain response.

To increase measurement range in both modes, change either of these settings:

Increase the number of points
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Decrease the frequency span

Notes:

After making these settings, you may need to adjust the transform time settings to see the new measurement
range.

Decreasing the frequency span degrades measurement resolution.

Make frequency span and number of points settings BEFORE calibrating.

Maximum range also depends on loss through the test device. If the returning signal is too small to measure,
the range is limited regardless of the frequency span.

Alias Responses

An alias response is not a true device response. An alias response repeats because each time domain

waveform has many periods and repeats with time (see How the Analyzer Measures in the Time Domain).

Alias responses occur at time intervals that are equal to 1/ frequency step size.

The analyzer adjusts the transform time settings so that you should only see one alias free range on either

side (positive and negative) of zero time.  However, these settings are updated only when one of the

toolbar settings are changed.

To determine if a response is true, put a marker on the response and change the frequency span. A true

device response will not move in time. An alias response will move.

For example, in the above graphic, the marker 1 response occurs at 14.07 inches. When the frequency

span is changed, this response remains at 14.07 inches. The marker 2 response moves.

Range Formula

You can calculate the alias-free measurement range (in meters) of the analyzer using the following
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formula for TDR (reflection) measurements:  

Range (meters) = (1/∆f) x Vf x c

Where:

Äf = frequency step size (frequency span/number of points-1)

Vf = the velocity factor in the transmission line

c = speed of light =  2.997925 E8 m/s

For example: For a measurement with 401 points and a span of 2.5 GHz, using a polyethylene cable

(Vf = 0.66)

Range = (1 / (2.5E9 / 400)) x 2.997925 E8 m/s x 0.66

Range = 6.25E6 x 2.997925 E8 m/s x 0.66

Range = 32 meters

In this example, the range is 32 meters in physical length. To prevent the time domain responses from

overlapping or aliasing, the test device must be 32 meters or less in physical length for a transmission

measurement.

To calculate the one-way distance for a reflection measurement rather than round-trip distance, simply

divide the length by 2.  In this case, the alias-free range would be 16 meters.

How to make Time Domain Settings

Using Hardkey/SoftTab/Softkey

Press Math > Time Domain > Time Domain Setup....1.

 

Transform dialog box help

2038



Transform On  Turns time domain transform ON and OFF.

Time Settings

The following settings adjust the display resolution, allowing you to zoom IN or OUT on a

response. They do NOT adjust measurement range or measurement resolution.

These settings automatically update (when one of these values are updated) to limit the display to

one alias-free response on either side of zero time.

Start  Sets the transform start time that is displayed on the analyzer screen.  

Note: Zero (0) seconds is always the measurement reference plane. Negative values are useful if

moving the reference plane.

Stop  Sets the transform stop time that is displayed on the analyzer screen.

Center  Sets the transform center time that is displayed in the center of the analyzer screen.

Span  Sets the transform span time that is split on either side of the Center value.

Transform Mode

Transform modes are three variations on how the time domain transform algorithm is applied to the
frequency domain measurement. Each method has a unique application.
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Mode Benefit - application Limitation

Low

pass

Impulse

Highest resolution.

Most useful for seeing

small responses in devices

that pass low frequencies,

such as cables.

In both Low pass modes, frequencies down to DC

and negative frequencies are extrapolated.

Therefore, the Start frequency is adjusted when you

click Set Freq.Low Pass

Because this will affect calibration accuracy, be sure

to calibrate AFTER completely setting up your time

domain measurement.
Low

pass

Step

Easiest to identify

inductive and capacitive

discontinuities in devices

that pass low frequencies,

such as cables.

Band

pass

Impulse

Easiest method - can be

used with any frequency

sweep.

Most useful for measuring

band limited devices such

as filters and DC blocked

cables.

Does NOT show capacitive and inductive reactance

For the same frequency span and number of points,

band pass mode has twice the impulse width, which

hides closely spaced responses degrading the

response resolution.

 

The following chart shows how to interpret results from various discontinuity impedances using

Low pass Step and either Low pass or Band pass Impulse modes.

 

Effect on Measurement Range

Band pass mode -  measurement range is inversely proportional to frequency step size.
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Low pass mode -  measurement range is inversely proportional to the fundamental (start )

frequency AFTER clicking Set Freq. Low Pass.

 

Set Low Pass Frequencies  USE ONLY IN LOW PASS MODES  

Recomputes the start frequency and step frequencies to be harmonics of the start frequency. Start

frequency is computed by the following formula: Low Pass Start Frequency = Stop Frequency /

Number of points.

The computed value must always be greater than or equal to the analyzer's minimum frequency.

Note:  The number of points or stop frequency may be changed in order to compute this value.

Gating

Perhaps the most beneficial feature of time domain transform is the Gating function. When viewing the

time domain response of a device, the gating function can be used to "virtually" remove undesired

responses.  You can then simultaneously view a frequency domain trace as if the undesired response

did not exist.. This allows you to characterize devices without the effects of external devices such as

connectors or adapters.

Note: When a discontinuity in a test device reflects energy, that energy will not reach subsequent

discontinuities. This can "MASK", or hide, the true response which would have occurred if the

previous discontinuity were not present. The analyzer Gating feature does NOT compensate for this.

The following measurements images show a practical example how to use and perform gating. The test

device is a 10inch cable, then a  6 dB attenuator, terminated with a short. The following four

discontinuities are evident in window 2, from left to right:

A discontinuity in the test system cable which appeared after calibration. It is identified by marker 2 at -10.74
inches (behind the reference plane).

1.

A discontinuity in the 10 inch device cable shortly after the reference plane.2.

The largest discontinuity is the attenuator and short shown by marker 1 at -12.67 dB ( 6 dB loss in both
forward and reverse direction).

3.

The last discontinuity is a re-reflection from the device cable.4.

We will gate IN the attenuator response. All other responses will be gated OUT.

Window 1. Create original S11 frequency domain trace. Shows ripple from all of the reflections.
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Window 2. Create a new S11 trace - same channel; new window. Turn Transform ON.

Window 3. On the transformed trace, turn gating ON. Center the gate on the large discontinuity

(2.500ns). Adjust gate span to completely cover the discontinuity. Select Bandpass gating type.

Window 4. On the original frequency measurement, turn Gating ON (Transform remains OFF). View

the measurement without the effects of the two unwanted discontinuities. The blue trace is a

measurement of the 6 dB attenuator with the unwanted discontinuities PHYSICALLY removed. The

difference between the two traces in window 4 is the effect of "masking".

 

Learn how to launch the Transform dialog box

 

Transform Gating dialog box help
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Gating  Turns Gating ON and OFF.

Start  Specifies the start time for the gate.

Stop  Specifies the stop time for the gate.

Center  Specifies the value at the center of the area that is affected by the gating function. This

value can be anywhere in the analyzer range.

Span  Specifies the range to either side of the center value of area that is affected by the gating

function.

Gate Type  Defines the type of filtering that will be performed for the gating function. The gate

start and stop flags on the display point toward the part of the trace you want to keep.

Bandpass - KEEPS the responses within the gate span.

Notch - REMOVES the responses with the gate span.

Gate Shape  Defines the filter characteristics of the gate function. Choose from Minimum, Normal,

Wide, Maximum
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Gate Shape Passband

Ripple

Sidelobe Levels Cutoff Time Minimum Gate

Span

Minimum 0.1 dB -48 dB 1.4/Freq Span 2.8/Freq Span

Normal 0.1 dB -68 dB 2.8/Freq Span 5.6/Freq Span

Wide 0.1 dB -57 dB 4.4/Freq Span 8.8/Freq Span

Maximum 0.01 dB -70 dB 12.7/Freq Span 25.4/Freq Span

Cutoff time -- is the time between the stop time (-6 dB on the filter skirt) and the peak of the first

sidelobe. The diagram below shows the overall gate shape and lists the characteristics for each gate

shape.

T1 is the gate span, which is equal to the stop time minus the start time.

T2 is the time between the edge of the passband and the 6 dB point, representing the cutoff rate of the
filter.

T3 is the time between the 6 dB point and the edge of the gate stopband.

For all filter shapes T2 is equal to T3, and the filter is the same on both sides of the center time.

Minimum gate span -- is twice the cutoff time. Each gate shape has a minimum recommended gate

span for proper operation. This is a consequence of the finite cutoff rate of the gate. If you specify a

gate span that is smaller that the minimum span, the response will show the following effects:

distorted gate shape that has no passband

distorted shape

incorrect indications of start and stop times

may have increased sidelobe levels

Window Settings

There are abrupt transitions in a frequency domain measurement at the start and stop frequencies,

causing overshoot and ringing in a time domain response. The window feature is helpful in lessening

the abruptness of the frequency domain transitions. This causes you to make a tradeoff in the time

domain response. Choose between the following:

Minimum Window = Better Response Resolution - the ability resolve between two closely spaced
responses.
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Maximum Window = Dynamic Range - the ability to measure low-level responses.

 

Learn how to launch the Transform dialog box

 

Transform - Window dialog box help

The window settings balance response resolution versus dynamic range.

Minimum Window = Best Response Resolution

Maximum Window = Best Dynamic Range

The following three methods all the set window size.  For best results, view the time domain
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response while making these settings.

Minimum - Maximum  Move the slider with a mouse to change the window size

Kaiser Beta  Changes window size using a Kaiser Beta value

Impulse Width  Changes window size using an Impulse Width value

Learn more about Windowing (top)

 

 

To launch the Coupling dialog box, click Coupling tab on the Time Domain Setup dialog box.

Trace Coupling Settings dialog box help

Trace coupling allows you to change time domain parameters on a measurement, and have the same

changes occur for all other measurements in the channel.

For example:

If you are simultaneously viewing a frequency domain measurement and time domain

measurement,

and Coupling is enabled in this dialog box,

and ALL Gating Parameters are checked in this dialog box,
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and on the time domain measurement you change the Gate Span parameter,

Then the frequency domain measurement will automatically change to reflect the time

domain gated span.

Note: Trace coupling applies ONLY to the Y-axis scale/reference settings. There are no changes to

your data as a result of trace coupling.

Coupling On  Check to enable coupling. All of the measurements in the active channel are

coupled.

The following parameters are available for coupling:

Transform Parameters  

Stimulus  Start, Stop, Center, and Span TIME settings.

State (On/Off)  Transform ON and OFF

Window   Kaiser Beta / Impulse Width

Mode  Low Pass Impulse, Low Pass Step, Band Pass

Gating Parameters  

Stimulus  Start, Stop, Center, and Span TIME settings.

State (On/Off)  Gating ON and OFF

Shape  Minimum, Normal, Wide, and Maximum

Type  Bandpass and Notch

 

 

To launch the Distance marker dialog box, click Dist. Marker Settings on the Transform dialog box.

 

Distance Marker Settings  dialog box help
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When markers are present on a time domain measurement, distance is automatically displayed on

the marker readout, marker table, and print copy.  To learn how to create markers on your

measurement see marker settings.

You can read out impedance versus time by creating a marker on a Time Domain trace, then

changing the marker format to R+jX. Learn how.

This dialog box allows you to customize the time domain distance marker readings.

These settings affect the display of ALL markers for only the ACTIVE measurement (unless

Distance Marker Unit is coupled on the Trace Coupling dialog box.

Marker Mode  Specifies the measurement type in order to determine the correct marker distance.

Select Auto for S-Parameter measurements.

Select Reflection or Transmission for arbitrary ratio or unratioed measurements.

Auto  If the active measurement is an S-Parameter, automatically chooses reflection or

transmission. If the active measurement is a non S-Parameter, reflection is chosen.

Reflection  Displays the distance from the source to the receiver and back divided by two (to

compensate for the return trip.)

Transmission  Displays the distance from the source to the receiver.

Units  Specifies the unit of measure for the display of marker distance values.

Velocity Factor   Specifies the velocity factor that applies to the medium of the device that was

inserted after the measurement calibration. The value for a polyethylene dielectric cable is 0.66 and
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0.7 for PTFE dielectric. 1.0 corresponds to the speed of light in a vacuum. This is useful in Time

Domain for accurate display of time and distance markers.

This setting can also be made from the Electrical Delay and Port Extensions dialog boxes.

 

 

How to launch the Time Domain Toolbar

 

Using Hardkey/SoftTab/Softkey

Math > Time Domain > TD Toolbar1.

On the toolbar, click More... to launch the Time Domain dialog box
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Troubleshooting the VNA

By running a few checks, you can identify if the analyzer is at fault. Before calling Keysight

Technologies or returning the instrument for service, please make the following checks.

Check the Basics

Check Error Terms

Check the Service Guide

Other Support Topics

Check the Basics

A problem can often be solved by repeating the procedure you were following when the problem

occurred. Before calling Keysight Technologies or returning the instrument for service, please make the

following checks:

Is there power at the power socket? Is the instrument plugged in?1.

Is the instrument turned on? Check to see if the front panel line switch and at least one of the LED rings
around the test ports glows green. This indicates the power supply is on.

2.

If you are experiencing difficulty with the front-panel keypad or peripherals, the USB bus may be overloaded.
Remove the USB devices, restart the VNA, and reconnect the USB devices. See Power-up.

3.

If other equipment, cables, and connectors are being used with the instrument, make sure they are
connected properly and operating correctly.

4.

Review the procedure for the measurement being performed when the problem appeared. Are all the settings
correct?

5.

If the instrument is not functioning as expected, return the unit to a known state by pressing the Preset key.6.

Is the measurement being performed, and the results that are expected, within the specifications and
capabilities of the instrument?

7.

If the problem is thought to be due to firmware, check to see if the instrument has the latest firmware before
starting the troubleshooting procedure.

8.

Check that the measurement calibration is valid. See Accurate Measurement Calibrations for more
information.

9.
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9.

Check Error Terms

If you print the error terms at set intervals (weekly, monthly, and so forth), you can compare current

error terms to these records. A stable, repeatable system should generate repeatable error terms over

long time intervals, for example, six months. If a subtle failure or mild performance problem is

suspected, the magnitude of the error terms should be compared against values generated previously

with the same instrument and calibration kit. See the procedure for monitoring error terms.

A long-term trend often reflects drift, connector and cable wear, or gradual degradation, indicating the need
for further investigation and preventative maintenance. Yet, the system may still conform to specifications.
The cure is often as simple as cleaning and gaging connectors or inspecting cables.

A sudden shift in error terms reflects a sudden shift in systematic errors, and may indicate the need for
further troubleshooting.

Consider the following while troubleshooting:

All parts of the system, including cables and calibration devices, can contribute to systematic errors and
impact the error terms.

Connectors must be clean and gauged, and within specification for error term analysis to be meaningful. See
the Chapter 2 in the VNA Service Guide for information on cleaning and gaging connectors.

Avoid unnecessary bending and flexing of the cables following measurement calibration, thus
minimizing cable instability errors.

Use good connection techniques during the measurement calibration. The connector interface must be
repeatable. See the VNA Service Guide for information on connection techniques.

It is often worthwhile to perform the procedure twice (using two distinct measurement calibrations) to
establish the degree of repeatability. If the results do not seem repeatable, check all connectors and cables.

Use error-term analysis to troubleshoot minor, subtle performance problems. See Chapter 3,
"Troubleshooting," in the VNA Service Guide if a blatant failure or gross measurement error is evident.

Check the Service Guide

Check the VNA Service Guide for specific troubleshooting procedures to help identify problems. You

can download a copy of the Service Guide from our Web site: http://www.Keysight.com.

 

2051

http://www.Keysight.com


Analyzer Error Messages

500 - 750  Calibrate

770 - 1000  Hardware

1000 - 1200  Measure

1281 - 1535  Parser

1536 - 1650  Display

1700 - 2000  Channel

2048 - 2200  General

Standard SCPI Errors

See Also: About Error Messages

Memory Overflow Error

Memory overflow. Trigger state set to Hold. Lower the IF bandwidth, or increase dwell or sweep time.

Severity: Informational

Further explanation: The measurement that you are currently making requires that data be stored

faster than it can be processed.  Very few customers will experience this situation.

Suggestions: To limit the amount of data to be stored, try lowering the IF Bandwidth, slow the sweep

time, increase the dwell time, or limit the number of data points.  There are many other settings that can

be adjusted to solve this problem.

EventID:

Cal Errors

Message: 512

"A secondary parameter (power, IFBW, sweep time, step mode) of the calibrated state has changed."

Severity: Informational

Further explanation: The calibration is questionable when any of these secondary parameters change
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after the calibration is performed.

Suggestions: If you require an accurate measurement with the new settings, repeat the calibration.

EventID: 68020200 (hex)

Message: 513

"Calibration cannot be completed until you have measured all the necessary standards for your selected

Cal Type."

Severity: Informational

Further explanation: You probably received this message because you attempted to turn correction on

without first measuring all of the calibration standards

Suggestions: Finish measuring the cal standards

EventID: 68020201 (hex)

Message: 514

"Calibration set has been recalled using a file previously saved on an analyzer that had a different

hardware configuration."

Severity: Informational

Further explanation:

Suggestions:

EventID: 68020202 (hex)

Message: 515

"Calibration is required before correction can be turned on. Channel number is <x>, Measurement is

<x>."

Severity: Informational

Further explanation: There are no error correction terms to apply for the specified channel and

measurement.

Suggestions:Perform or recall a calibration

EventID: 68020203 (hex)

Message: 516
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"Critical parameters in your current instrument state do not match the parameters for the calibration set,

therefore correction has been turned off. The critical instrument state parameters are sweep type, start

frequency, frequency span, and number of points."

Severity: Informational

Further explanation: None

Suggestions: You can either recalibrate using the new settings or change back to the original setting

that was used when the calibration was performed.

EventID: 68020204 (hex)

Message: 517

"Interpolation is turned off and you have changed the stimulus settings of the original calibration, so

correction has been turned off."

Severity: Informational

Further explanation: The most accurate calibration is maintained only when the original stimulus

settings are used.

Suggestions: If reduced accuracy is OK, set interpolation ON to allow stimulus setting changes.

EventID: 68020205 (hex)

Message: 518

"Interpolation is turned off and you have selected correction ON. Correction has been restored with the

previous stimulus settings."

Severity: Informational

Further explanation: None

Suggestions: None

EventID: 68020206 (hex)

Message: 519

"Stimulus settings for your current instrument state exceeded the parameters of the original calibration,

so correction has been turned off."

Severity: Informational
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Further explanation: Correction data outside the stimulus settings does not exist.

Suggestions: Perform a broadband calibration, with increased numbers of points with interpolation

ON, to maintain calibration over the widest possible stimulus frequency settings.

EventID: 68020207(hex)

Message: 520

"Cal Type is set to NONE for Channel <x>, Measurement <x>; please select Calibration menu or press

Cal hard key."

Severity: Informational

Further explanation:  A cal operation can not proceed until a calibration exists or the cal type is

selected. This error can occur if the calibration can not be found. Also this error can happen if a

calibration type is not specified before attempting to programmatically execute cal acquisitions.

Suggestions  To find a calibration, select a Cal Set that contains the calibration needed for the current

measurements.  OR specify the cal type before beginning a calibration procedure.

EventID: 68020208 (hex)

Message: 521

"The measurement you set up does not have a corresponding calibration type, so correction has been

turned off or is not permitted."

Severity: Informational

Further explanation:  The calibration for the channel may apply only to certain S-Parameters.  For

example, a 1-Port calibration for S11 can not be applied to a 1-Port calibration applied to S22.

Suggestions: Select a calibration type, such as full 2-Port cal, that can be applied to all the

measurements to be selected.

EventID: 68020209 (hex)

Message: 522

"The calibration type you selected cannot be set up."  

Severity: Informational

Further explanation:  "Please use the SCPI command ROUTe:PATH:DEFine:PORT <num>,<num>

for full 2 port type port assignment."
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Suggestions:

EventID: 6802020A (hex)

Message: 523

"The calibration path you selected cannot be set up because it is not valid for the current measurement."

Severity: Informational

Further explanation:  "Please use the SCPI command ROUTe:PATH:DEFine:PORT <num>,<num>

for full 2 port type port assignment related to your current measurement."

Suggestions:  

EventID: 6802020B (hex)

Message: 524

"The source power calibration is complete."

Severity: Informational

Further explanation:  

Suggestions:  

EventID: 6802020C (hex)

Message: 525

"You have specified more than 7 standards for one or more calibration classes."

Severity: Informational

Further explanation: These have been truncated to 7 selections.

EventID: 6802020D (hex)

Message: 526

"No user calibration found for this channel."

Severity: Informational

Further explanation:  A cal operation can not proceed until a calibration exists.

Suggestions:  To find a calibration, you can select a Cal Set that contains the calibration needed for the
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current measurement.

EventID: 6802020E (hex)

Message: 527

"You do not need to acquire this standard for this calibration type."

Severity: Informational

Further explanation: This error can happen as a result of PROGRAMMATICALLY requesting the

measurement of an un-needed calibration standard during a calibration procedure.  

Suggestions: Check the specified cal type or eliminate the request for the measurement of the standard.

EventID: 6802020F (hex)

Message: 528

"Could not configure the Electronic Calibration system. Check to see if the module is plugged into the

proper connector."

Severity: Informational

Further explanation:  During an ECal operation, communication could not be established with the

ECal module.  The calibration will not be initiated until the presence of the ECal module is verified.

Suggestions: Verify the USB cable is connected properly. Disconnect and re-connect the cable to

ensure the analyzer recognizes the module.

EventID: 68020210 (hex)

Message: 529

"DATA OUT OF RANGE: Design Limits Exceeded"

Severity: Error

Further explanation:

Suggestions:

EventID: E8020211(hex)

Message: 530

"EXECUTION ERROR: Could not open ECal module memory backup file"
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Severity: Error

Further explanation:

Suggestions:

EventID: E8020212 (hex)

Message: 531

"EXECUTION ERROR: Access to ECal module memory backup file was denied"

Severity: Error

Further explanation:

Suggestions:

EventID: E8020213 (hex)

Message: 532

"EXECUTION ERROR: Failure in writing to ECal module memory backup file"

Severity: Error

Further explanation:

Suggestions:

EventID: E8020214 (hex)

Message: 533

"EXECUTION ERROR: Failure in reading from ECal module memory backup file"

Severity: Error

Further explanation:

Suggestions:

EventID: E8020215 (hex)

Message: 534

"EXECUTION ERROR: Array index out of range"

Severity: Error
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Further explanation:

Suggestions:

EventID: E8020216 (hex)

Message: 535

"EXECUTION ERROR: Arrays wrong rank"

Severity: Error

Further explanation:

Suggestions:

EventID: E8020217 (hex)

Message: 536

"EXECUTION ERROR: CPU"

Severity: Error

Further explanation:

Suggestions:

EventID: E8020218 (hex)

Message: 537

"EXECUTION ERROR: Cannot ERASE module"

Severity: Error

Further explanation:

Suggestions:

EventID: E8020219 (hex)

Message: 538

"EXECUTION ERROR: Cannot WRITE module"

Severity: Error
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Further explanation:

Suggestions:

EventID: E802021A (hex)

Message: 539

"EXECUTION ERROR: Entry Not Found"

Severity: Error

Further explanation:

Suggestions:

EventID: E802021B (hex)

Message: 540

"EXECUTION ERROR: Invalid command while system is busy"

Severity: Error

Further explanation:

Suggestions:

EventID: E802021C (hex)

Message: 541

"Electronic Cal:  Unable to orient ECal module. Please ensure the module is connected to the necessary

measurement ports."

Severity: Error

Further explanation:  There is no RF connection to the ECal module during a calibration step.  An

ECal orientation measurement has been attempted but the signal was not found.

Suggestions: Connect the ECal module RF connections to ports specified for the calibration step.  The

ECal module typically requires at least  -18dBm for measurements. If your measurement requires the
power level to be less than that, clear the Do orientation checkbox to bypass the automatic detection

step.

EventID: E802021D (hex)

Message: 542
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"EXECUTION ERROR: NO SPACE for NEW CAL, DELETE A CAL"

Severity: Error

Further explanation:

Suggestions:

EventID: E802021E (hex)

Message: 543

"EXECUTION ERROR: No More Room"

Severity: Error

Further explanation:

Suggestions:

EventID: E802021F (hex)

Message: 544

"EXECUTION ERROR: Other array error"

Severity: Error

Further explanation:

Suggestions:

EventID: E8020220 (hex)

Message: 545

"EXECUTION ERROR: Ranks not equal"

Severity: Error

Further explanation:

Suggestions:

EventID: E8020221 (hex)

Message: 546
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"EXECUTION ERROR: Too few CONSTANT ranks"

Severity: Error

EventID: E8020222 (hex)

Message: 547

"EXECUTION ERROR: Too few VARYing ranks"

Severity: Error

EventID: E8020223 (hex)

Message: 548

"EXECUTION ERROR: Unknown error"

Severity: Error

EventID: E8020224 (hex)

Message: 549

"EXECUTION ERROR: ecaldrvr.dll bug or invalid module #"

Severity: Error

EventID: E8020225 (hex)

Message: 550

"EXECUTION ERROR: unexpected error code from ecal driver"

Severity: Error

EventID: E8020226 (hex)

Message: 551

"EXECUTION ERROR: unexpected internal driver error"

Severity: Error

EventID: E8020227 (hex)

Message: 552

"HARDWARE ERROR: Can't access ECal Interface Module"
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Severity: Error

EventID: E8020228 (hex)

Message: 553

"HARDWARE ERROR: Can't release LPT port, reboot"

Severity: Error

EventID: E8020229 (hex)

Message: 554

"HARDWARE ERROR: VNA Error"

Severity: Error

EventID: E802022A (hex)

Message: 555

"HARDWARE ERROR: not enough data read from ECal module"

Severity: Error

EventID: E802022B (hex)

Message: 556

"OPERATION ABORTED BY HOST COMPUTER"

Severity: Error

EventID: E802022C (hex)

Message: 557

"OPERATION ABORTED BY USER"

Severity: Error

EventID: E802022D (hex)

Message: 558

"OUT OF MEMORY"
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Severity: Error

EventID: E802022E (hex)

Message: 559

"QUERY INTERRUPTED:Message(s Abandoned"

Severity: Error

EventID: E802022F (hex)

Message: 560

"QUERY UNTERMINATED: INCOMPLETE PROGRAM Message"

Severity: Error

Further explanation:

Suggestions:

EventID: E8020230 (hex)

Message: 561

"QUERY UNTERMINATED: NOTHING TO SAY"

Severity: Error

Further explanation:

Suggestions:

EventID: E8020231 (hex)

Message: 562

"QUEUE OVERFLOW"

Severity: Error

EventID: E8020232 (hex)

Message: 563

"SETTINGS CONFLICT: ADDITIONAL STANDARDS ARE NEEDED"

Severity: Error
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EventID: E8020233 (hex)

Message: 564

"SETTINGS CONFLICT: Adapter Cal is NOT possible"

Severity: Error

EventID: E8020234 (hex)

Message: 565

"SETTINGS CONFLICT: COMMAND OUT OF SEQUENCE"

Severity: Error

EventID: E8020235 (hex)

Message: 566

"SETTINGS CONFLICT: Cal STOPPED - VNA SETUP CHANGED"

Severity: Error

EventID: E8020236 (hex)

Message: 567

"SETTINGS CONFLICT: Calibration is NOT in progress"

Severity: Error

EventID: E8020237 (hex)

Message: 568

"SETTINGS CONFLICT: Can't find specified GPIB board"

Severity: Error

EventID: E8020238 (hex)

Message: 569

"SETTINGS CONFLICT: Can't find/load gpib32.dll"

Severity: Error
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EventID: E8020239 (hex)

Message: 570

"SETTINGS CONFLICT: Can't find/load sicl32.dll"

Severity: Error

EventID: E802023A (hex)

Message: 571

"SETTINGS CONFLICT: Can't initialize VNA (bad address?"

Severity: Error

EventID: E802023B (hex)

Message: 572

"SETTINGS CONFLICT: Can't load LPT port driver or USB driver DLL"

Severity: Error

EventID: E802023C (hex)

Message: 573

"SETTINGS CONFLICT: Invalid Calibration Sweep Mode."

Severity: Error

EventID: E802023D (hex)

Message: 574

"SETTINGS CONFLICT: Invalid Calibration Type"

Severity: Error

EventID: E802023E (hex)

Message: 575

"SETTINGS CONFLICT: Invalid Calibration"

Severity: Error

EventID: E802023F (hex)
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Message: 576

"SETTINGS CONFLICT: Invalid GPIB board number specified"

Severity: Error

EventID: E8020240 (hex)

Message: 577

"SETTINGS CONFLICT: Invalid GPIB board type specified"

Severity: Error

EventID: E8020241 (hex)

Message: 578

"SETTINGS CONFLICT: Invalid Module Status"

Severity: Error

EventID: E8020242 (hex)

Message: 579

"SETTINGS CONFLICT: Invalid States"

Severity: Error

EventID: E8020243 (hex)

Message: 580

"SETTINGS CONFLICT: LPT port must be between 1 and 4"

Severity: Error

EventID: E8020244 (hex)

Message: 581

"Could not configure the Electronic Calibration system. Check to see if the module is properly

connected."

Severity: Error

EventID: E8020245 (hex)
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Message: 582

"SETTINGS CONFLICT: Specified LPT port does not exist"

Severity: Error

EventID: E8020246 (hex)

Message: 583

"SETTINGS CONFLICT: Use frequency domain for cal"

Severity: Error

EventID: E8020247 (hex)

Message: 584

"SETTINGS CONFLICT: Use step sweep type for cal."

Severity: Error

EventID: E8020248 (hex)

Message: 585

"SETTINGS CONFLICT: VNA address must be between 0 and 30"

Severity: Error

EventID: E8020249 (hex)

Message: 586

"SETTINGS CONFLICT: Wrong LPT port driver or USB driver DLL"

Severity: Error

EventID: E802024A (hex)

Message: 587

"SYNTAX ERROR: ECAL:DELAY command must have 2 numbers"

Severity: Error

EventID: E802024B (hex)
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Message: 588

"SYNTAX ERROR: INCORRECT SYNTAX"

Severity: Error

EventID: E802024C (hex)

Message: 589

"SYNTAX ERROR: UNKNOWN COMMAND"

Severity: Error

EventID: E802024D (hex)

Message: 590

"Wrong port of module in RF path"

Severity: Error

EventID: E802024E (hex)

Message: 591

"User characterization not found in module"

Severity: Error

EventID: E802024F (hex)

Message: 592

Severity:Informational

"No source power calibration found for the channel and source port of the current measurement."

Further explanation:  You tried to turn on source power cal but there is no source power cal data.

Suggestions: Perform a source power calibration

EventID: 68020250 (hex)

Message: 593

Severity:Informational

"A source power calibration sweep was not performed, so there is no correction for the channel and
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source port of the current measurement."

Further explanation: You tried to turn on source power cal but there is incomplete source cal data.

Suggestions:Perform a complete source power calibration

EventID: 68020251 (hex)

Message: 594

Severity: Informational

"A new trace could not be added to the active window for viewing the source power cal sweep, because

it would have exceeded the limit on number of traces/window. Please remove a trace from the window

before proceeding with source power cal."

Further explanation: The source power cal attempts to add a data trace to the active window. The

active window already contains four traces.

Suggestions:Make the active window contain less than four traces.

EventID: 68020252 (hex)

Message: 595

Severity: Informational

"A new measurement could not be added for performing the source power cal sweep, because the limit

on number of measurements has been reached. Please remove a measurement before proceeding with

source power cal."

Further explanation: The source power cal attempts to add a measurement. The analyzer already has

the maximum number of measurements.

Suggestions: Delete a measurement.

EventID: 68020253 (hex)

Message: 596

Severity: Informational

"The calibration power value associated with the source power calibration of Port %1 on Channel %2

was changed with the calibration on. The calibration was not turned off, but the power value might no

longer represent the calibration."

Further explanation: The source power cal accuracy is questionable.
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Suggestions: If high accuracy is required, perform another source power calibration.

EventID: 68020254 (hex)

Message: 597

Severity: Informational

- Message that is passed from the power meter driver for a source power calibration. -

Further explanation: This error is generated by the power meter driver and passed through the

analyzer.

EventID: 68020255 (hex)

Message: 598

"During the acquisition of the sliding load standard, the slide was not properly moved to perform a

circle fit.  The standard's raw impedance was used to determine the directivity for one or more points."

Severity: Informational

Further Explanation:  To accurately characterize the standard, the sliding load must be move

sufficiently to ensure enough samples around the complex circle or Smith Chart.  Under-sampling will

cause an inaccurate result.

Suggestions:  For best results when using a sliding load, be sure to use multiple slide positions that

cover the full range of movement from front to back of the slot.

EventID: 68020256 (hex)

Message: 599

"This feature requires an unused channel, but could not find one. Please free up a channel and try
again."

Severity: Informational

Further Explanation:  You attempted to view an item within a calset.  However, the calset viewer
requires that the result be displayed in a channel that is not currently in use.  All the channels are

currently used.  The view can not display the requested item.

Suggestions:  You must delete at least one channel that is currently in use.

EventID: 68020257 (hex)

Message: 600
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"Interpolation of the original calibration is not allowed since it was performed using Segment Sweep.

 Correction has been turned off."

Severity: Informational

EventID: 68020258 (hex)

Message: 601

"Cal preferences saved. Cal preference settings can be changed from the 'Cal Preferences' drop down

Cal menu."

Severity: Informational

EventID: 68020259 (hex)

Message: 608

"CalType not set."

Severity: Error

Further explanation: A cal operation can not proceed until a calibration exists or the proper cal type is

selected.

Suggestions: This error can happen if the calibration can't be found.   To find a calibration, you can

select a Cal Set that contains the calibration needed for the current measurements.  This error can also

happen if a calibration type is not specified before attempting to programmatically execute cal

acquisitions.  Specify the cal type before beginning a calibration procedure.

EventID: E8020260 (hex)

Message: 609

"The Calibration feature requested is not implemented."

Further explanation:  The specified cal type can be one of many choices.  For example, response

calibrations require single standards, 1-Port calibrations require 3 standards, and 2-Port calibrations

require up to 12 standards.

Suggestions: Be sure to measure only the standards needed for the specified cal type.

EventID: E8020261 (hex)

Message: 610

"The Calibration Class Acquisition requested is not valid for the selected Calibration Type. Please
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select a different acquisition or a different Calibration Type."

EventID: E8020262 (hex)

Message: 611

"The Calibration Standard data required for the selected caltype was not found."

Severity: Error

Further explanation:  An unsuccessful attempt was made to retrieve a specified standard from the raw

measurement buffer.  The buffer should contain the raw measurements of cal standards stored during a

calibration procedure.

Suggestions:  Be sure the requested standard is required for the current cal type.  Not all standards are

needed for all cal types.

EventID: E8020263 (hex)

Message: 612

" The Error Term data required for the selected caltype was not found."

Severity: Error

Further explanation: An unsuccessful attempt was made to retrieve a specified error term from the

error correction buffer.  The buffer should contain the error correction arrays for the current calibration.

Suggestions:  Be sure the requested error term is required for the current cal type.  Not all error terms

are needed for all cal types.

EventID: E8020264 (hex)

Message: 613

The Calibration data set was not found.

Severity: Error

Further explanation: An unsuccessful attempt to access a cal set has been made.  This may indicate a

calset has been deleted or has been corrupted.

Suggestions:  Try again or select another cal set.  If the cal set appears in the cal set list, it may need to

be deleted.

EventID: E8020265 (hex)
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Message: 614

"The specified measurement does not have a calibration valid for Confidence Check. Please select a

different measurement, or recall or perform a different Calibration Type."

Severity: Error

Further explanation:  The measurement choice is prevented so that calibration will not be turned off.

 Not all cal types support all measurements.  For example, an 1-Port cal on S11 can not be used to

calibrate an S12 measurement.  When a measurement is selected that does not have a calibration which

can be applied, an informational message is displayed and calibration is turned off.

Suggestions:  Use a full 2-Port calibration to be compatible with any S-Parameter.

EventID: E8020266 (hex)

Message: 615

" New calset created."

Severity: Informational message.

Further explanation: The newly created cal set will be automatically named and time stamped.  If this

is the beginning of a calibration procedure, the cal set will not be stored to memory until the calibration

has completed successfully.  The new cal set will be deleted if the calibration is canceled or does not

otherwise complete successfully.

Suggestions: Informational

EventID: 68020267

Message: 617

The calset file: <x> appears to be corrupted and cannot be removed. Exit the application, remove the
file, and restart.

Severity: Error

Suggestions:  The cal set file is stored in the application home directory C:/Program
Files/Keysight/Network Analyzer/analyzerCalSets.dat.  Remove this file, then restart the application.

EventID: E8020269 (hex)

Message: 634

"The calset file: <x> load failed."

2074



Severity: Error

Further explanation: The calset file contains a collection of calsets.  The file resides on the hard drive.

Suggestions:  Try restarting the application.  If the failure persists, you may have to delete the cal set

data file and restart the application. The cal set file is stored in the application home directory.

C:/Program Files/Keysight/Network Analyzer/analyzerCalSets.dat.  Remove this file, then restart the

application.

EventID: E802027A (hex)

Message: 635

"The calset file: <x> save failed."

Severity: Error

Further explanation: The file operation detected an error.  The save operation was aborted.

Suggestions:  Retry.

EventID: E802027B (hex)

Message: 636

"A calset was deleted."

Severity: Informational

Further explanation: One of the calsets has been successfully deleted from the collection of calsets

available.  This can happen as the result of a user request or intentional operation.

Suggestions: None

EventID: 6802027C (hex)

Message: 637

"The version of the calset file: <x> is not compatible with the current instrument."

Severity: Error

Further explanation: A versioning error can prevent a calset from being used.  This can happen as a

result of instrument firmware upgrades.

Suggestions:  If the versioning error is the result of firmware upgrade, you will have to re-install the

old version of firmware to re-use the calset file.  Or you can re-create the calsets with the current
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version of firmware.

The cal set file is stored in the application home directory C:/Program Files/Keysight/Network

Analyzer/analyzerCalSets.dat.  Remove this file, then restart the application.

EventID: E802027D (hex)

Message: 638

"Incompatible CalSets found: <x> of <y> stored calsets have been loaded."

Severity: Error

Further explanation: Errors were found on some of the calsets stored in the calset file.  The errors

may have been caused by versioning issues that may have corrupted the various calset keys.

Suggestions:  Use the calset viewer to look at the contents of calset files.  Delete the files that are

corrupted.

EventID: 6802027E (hex)

Message: 639

"The Calset file: <x> was not found.  A new file has been created."

Severity: Informational

Further explanation: The calset file should be stored on the hard drive.  When the application is

started, a search is done and the file is loaded if it can be found. If the file is not found, the analyzer

will create a new file and display this message.

Suggestions:  None

EventID: 6802027F (hex)

Message: 640

"The Calset specified is currently in use."

Severity: Error

Further explanation: This may indicate a conflict between multiple calset users attempting calibration

tasks.

Suggestions:  Save the instrument state. Preset the analyzer and recall the instrument state.  This may

abort any processes that may be in progress.
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EventID: E8020280 (hex)

Message: 641

"The calset specified has not been opened."

Severity: Error

Further explanation: Multiple users may be attempting to access the calset.

Suggestions:  Close multiple calset users so that only one user will access the calset.

EventID: E8020281 (hex)

Message: 642

"The maximum number of cal sets has been reached. Delete old or unused cal sets before attempting to

create new ones."

Severity: Error

Suggestions:  You may also delete the calsets data file.

The cal set file is stored in the application home directory.  C:/Program

Files/Keysight/Network_Analyzer/analyzerCalSets.dat.  Remove this file, then restart the application.

EventID: E8020282 (hex)

Message: 643

The requested power loss table segment was not found.

Severity: Error

EventID: E8020283 (hex)

Message: 644

"A valid calibration is required before correction can be turned on."

Severity: Error

Further explanation: This usually indicates a calibration procedure has not run to completion or that

the selected measurement does not have a valid calibration available from within the currently selected

cal set.

Suggestions: To find a calibration, you can select a Cal Set that contains the calibration needed for the

current measurements.  This error can happen if a calibration type is not specified before attempting to
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programmatically execute cal acquisitions.  Specify the cal type before beginning a calibration

procedure.

EventID: E8020284 (hex)

Message: 645

The cal data for <x> is incompatible and was not restored. Please recalibrate."

Severity: Warning

Further explanation: None

Suggestions: None

EventID: A8020285 (hex)

Message: 646

"CalSet not loaded, version is too new."

Severity: Error

Further explanation: An old version of firmware is attempting to run with a new calset version.  The

version is incompatible.

Suggestions:  The calset can be removed. You may also delete the calsets data file if you are migrating

between various firmware revisions often and you would like to avoid this error.  The cal set file is

stored in the application home directory. C:/Program Files/Keysight/Network

Analyzer/analyzerCalSets.dat.  Remove this file, then restart the application.

EventID: E8020286 (hex)

Message: 647

"Custom cal type not found."

Severity: Error

Further explanation:

Suggestions:  

EventID: E8020287 (hex)

Message: 648

"Custom correction algorithm defers to the client for interpolation."
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Severity: Informational

EventID: 68020288 (hex)

Message: 649

"Custom cal dll threw an exception."

Severity: Error

EventID: E8020289 (hex)

Message: 650

"Could not load the ecal.dll library"

Severity: Error

EventID: E802028A (hex)

Message: 656

"The argument specified is not a valid cal type."

Severity: Error

EventID: E8020290 (hex)

Message: 657

"The function found existing interpolated data"

Severity: Informational

EventID: 68020291 (hex)

Message: 658

"The function computed new interpolation values."

Severity: Informational

EventID: 68020292 (hex)

Message: 659

"The source power measurement failed."
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Severity: Error

Suggestions:  Please check GPIB, power meter settings and sensor connections.

EventID: E8020293 (hex)

Message: 660

"Duplicate session found.  Close session and retry."

Severity: Error

EventID: E8020294 (hex)

Message: 661

"The session does not exist.  Open the session and try again."

Severity: Error

Further explanation:

EventID: E8020295 (hex)

Message: 662

"Attempt to launch a custom calibration failed."

Severity: Error

Further explanation:

EventID: E8020296 (hex)

Message: 663

"Request to measure a cal standard failed."

Severity: Error

Further explanation: Please ensure you are requesting to measure standards which are defined for this

calibration.

EventID: E8020297 (hex)

Message: 664

"Since Electronic Calibration Kit is selected, Mechanical Cal Kit parameter cannot be changed."
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Severity: Error

Further explanation:

EventID: E8020298 (hex)

Message: 665

"Frequencies of the active channel are below minimum or above maximum frequencies of the ECal

module factory characterization."

Suggestions:  Change the channel frequencies, or select another ECal module.

Severity: Error

EventID: E8020299 (hex)

Message: 666

"Calset chosen for characterizing the ECal Module Ports %1 does not contain a calibration for analyzer

Ports %2."

Severity: Error

Suggestions:  Go back to select another calset or to perform another cal.

EventID: E802029A (hex)

Message: 667

"ECal module only has sufficient memory remaining to store a maximum of %1 points in User

Characterization %2."

Severity: Error

Suggestions:  Decrease your number of points, or choose to overwrite another user characterization.

EventID: E802029B (hex)

Message: 668

Input values are non-monotonic. Cannot interpolate.

Severity: Error

EventID: E802029C (hex)

Message: 669
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Interpolation target is out of range. Cannot interpolate.

Severity: Error

EventID: E802029D (hex)

Message: 670

Guided Calibration Error:  <>

Severity: Error

EventID: E802029E (hex)

Message: 671

The first call to the guided calibration interface must be Initialize.

Severity: Error

EventID: E802029F (hex)

Message: 672

The selected thru cal method was not recognized.

Severity: Error

EventID: E80202A0 (hex)

Message: 673

Could not generate the error terms.

Severity: Error

EventID: E80202A1 (hex)

Message: 674

Guided calibration must be performed on the active channel

Severity: Error

EventID: E80202A2 (hex)

Message: 675
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You can not start using calibration steps until you have successfully called generate steps.

Severity: Error

EventID: E80202A3 (hex)

Message: 676

The step number given is out of range. Step numbers should be between 1 and the number of steps.  0

is not a valid step number.

Severity: Error

EventID: E80202A4 (hex)

Message: 677

A calset was selected for channel: <n> without restoring stimulus.

Severity: Informational

EventID: 680202A5 (hex)

Message: 678

A calset was selected for channel: <n> restoring stimulus.

Severity: Informational

EventID: 680202A6 (hex)

Message: 679

The selected calset stimulus could not be applied to the channel.

Severity: Informational

EventID: 680202A7 (hex)

Message: 680

You attempted to measure power at a frequency outside the frequency  range defined for the specified

power sensor. Select another sensor or adjust the range for this sensor.

Severity: Error

EventID: E80202A8 (hex)
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Message: 681

Specified frequency is outside the frequency ranges currently defined for the power meter's sensors.

Severity: Error

EventID: E80202A9 (hex)

Message: 682

Additional Calibration Standards need to be acquired in order to calibrate over the entire frequency

range currently being measured.

Severity: Informational

EventID: 680202AA (hex)

Message: 683

The analyzer failed to convert cal kits for use by unguided calibrations.  The recommended action is to

restore Cal Kit defaults.

Severity: Error

EventID: E80202AB (hex)

Message: 684

The analyzer failed to convert cal kits for use by unguided calibrations.  CalKit defaults have been

restored.

Severity: Error

EventID: E80202AC (hex)

Message: 685

Power meter is reserved by a source power cal acquisition already in progress.

Severity: Error

EventID: E80202AD (hex)

Message: 686

Source power calibration has not been performed or uploaded for the specified channel and source port.

Severity: Error
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EventID: E80202AE (hex)

Message: 687

Source power calibration data array size for the specified channel and  source port does not match it's

associated stimulus number of points.

Severity: Error

EventID: E80202AF (hex)

Message: 688

Source power calibration of Port <n> on Channel <n> was turned off because the correction array no

longer exists.

Severity: Error

EventID: E80202B0 (hex)

Message: 689

This command can only be used on a measurement created with a specified calibration loadport.

Severity: Error

EventID: E80202B1 (hex)

Message: 690

Interpolation is turned off and you have changed the stimulus settings of the original calibration, so

correction has been turned off.

Severity: Error

EventID: E80202B2 (hex)

Message: 691

Stimulus settings for your current instrument state exceeded the parameters of the original calibration,

so correction has been turned off.

Severity: Error

EventID: E80202B3 (hex)

Message: 692
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Fixturing: the requested S2P file cannot be read.  Possible formatting problem.

Severity: Error

EventID: E80202B4 (hex)

Message: 693

Fixturing: the requested S2P file cannot be opened.

Severity: Error

EventID: E80202B5 (hex)

Message: 694

Fixturing: the requested S2P file cannot be interpolated.  This is usually because the frequency range in

the file is a subset of the current channel frequency range.

Severity: Error

EventID: E80202B6 (hex)

Message: 695

Cal Registers can only be used by one channel: the channel conveyed in the name of the cal register.

 The name cannot be changed.

Severity: Error

Further explanation: See Cal Registers

EventID: E80202B7 (hex)

Message: 696

Fixturing: cannot be enabled with Response Calibrations and has been turned off.

Severity: Error

EventID: E80202B8 (hex)

Message: 697

The selected calibration cannot be performed for this measurement.

Severity: Error
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EventID: E80202B9 (hex)

Message: 698

Fitting: RemoveAllConnectors() should be called prior to calling  AddConnector after a fit has been

attempted.

Severity: Error

EventID: E80202BA (hex)

Message: 699

An attempt was made to acquire calibration data before the system was properly initialized.

Severity: Error

EventID: E80202BB (hex)

Message: 700

Use IGuidedCalibration for multiport calibration types.

Severity: Error

EventID: E80202BC (hex)

Message: 701

Guided calibration requires number of thru measurement paths be at least equal to the number of

calibration ports minus 1.

Severity: Error

EventID: E80202BD (hex)

Message: 702

A thru path was specified that includes a port which the calibration was not specified to include.

Severity: Error

EventID: E80202BE (hex)

Message: 703

One or more of the ports to be calibrated was not found in the set of specified thru paths.
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Severity: Error

EventID: E80202BF (hex)

Hardware Errors

Message: 770

Input power too high. Source power is off.

Severity: Warning

EventID: A8030302 (hex)

Message: 771

Source power restored.

Severity: Informational

EventID: 68030303 (hex)

Message: 772

"The spampnp.sys driver is not working. Check system hardware. ! Data will be simulated. !"

Severity: Error

Further explanation: The Network Analyzer application cannot locate the DSP board. Hardware or a

driver may be malfunctioning. This is also common when attempting to run the Network Analyzer on a

workstation.

EventID: E8030304 (hex)

Message: 773

"Instrument Serial Bus Not Working."

Severity: Error

Further explanation: The instrument EEPROM appears to contain either all ones or all zeros. A serial

bus hardware failure prevents reading the EEPROM.

EventID: E8030305 (hex)

Message: 784
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Unleveled, source <n>, out <n>.

Severity: Error

Further explanation: The analyzer was unable to set the power on port <n> to the desired level

Message: 848

"Phase lock lost"

Severity: Error

Further explanation: The instrument source was not able to lock properly. This can be the result of

broken hardware, poor calibration, or bad EEPROM values.

Suggestions: Perform source calibration. Click System / Service / Adjustments / Source Calibration

EventID: E8030350 (hex)

Message: 849

Phaselock restored.

Severity: Success

EventID: 0x28030351 (hex)

Message: 850

"Unknown hardware error."

Severity: Error

Further explanation: Hardware malfunctioned prevents communication with the DSP.

EventID: E8030352 (hex)

Message: 851

DSP communication lost.

Severity: Error

EventID: E8030353 (hex)

Message: 852

RF power off.
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Severity: Error

EventID: E8030354 (hex)

Message: 853

RF power on.

Severity: Success

EventID: 28030355 (hex)

Message: 854

Hardware OK.

Severity: Success

EventID: 28030356 (hex)

Message: 855

"Source unleveled."

Severity: Error

Further explanation: The source was unable to properly level at the requested power. The indicated

power may not be accurate.

Suggestions: Try a different power level. Recalibrate source, if problem persists.

EventID: E8030357 (hex)

Message: 856

Source leveled.

Severity: Success

EventID: 28030358 (hex)

Message: 857

Input overloaded.

Severity: Error

EventID: E8030359 (hex)
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(M9485A) Noise power in source signal may cause the overload. Reducing the noise power level at the

receiver by adjusting the gain of peripherals  and increasing full scale of the receiver may solve the

overload.

Message: 858

Input no longer overloaded.

Severity: Success

EventID: 2803035A (hex)

Message: 859

"Yig calibration failed."

Severity: Error

Further explanation: Internal self-calibration of YIG oscillator tuning failed.

EventID: E803035B (hex)

Message: 860

Yig calibrated.

Severity: Success

EventID: 2803035C (hex)

Message: 861

"Analog ramp calibration failed."

Severity: Error

Further explanation: Internal analog sweep ramp calibration has failed.

EventID: E803035D (hex)

Message: 862

Analog ramp calibrated.

Severity: Success
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EventID: 2803035E (hex)

Message: 864

Source temperature OK.

Severity: Success

EventID: 28030360 (hex)

Message: 865

"EEPROM write failed."

Severity: Error

Further explanation: Attempt to store calibration data to EEPROM has failed. There is a possible

hardware failure.

EventID: E8030361 (hex)

Message: 866

EEPROM write succeeded.

Severity: Success

EventID: 28030362 (hex)

Message: 867

Attempted I/O write while port set to read only.

Severity: Error

Further explanation: Attempt to write to an I/O data port while the port set to input/read only.

Suggestions: Set data port to write/output before attempting to write to port.

EventID: E8030363 (hex)

Message: 868

" Attempted I/O read from write only port.

Severity: Error

Further explanation: Attempt to read from an I/O data port while the port set to output/write only.
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Suggestions: Set data port to read/input before attempting to read from port.

EventID: E8030364 (hex)

Message: 869

Invalid hardware element identifier.

Severity: Error

EventID: E8030365 (hex)

Message: 870

Invalid gain level setting.

Severity: Error

EventID: E8030366 (hex)

Message: 871

Device driver was unable to allocate enough memory. Please try rebooting.

Severity: Error

EventID: E8030367 (hex)

Message: 872

DSP Error.  Please Contact Keysight Support.  Technical Information: DSP Type 1

Severity: Error

EventID: E8030368 (hex)

Message: 873

DSP Error.  Please Contact Keysight Support.  Technical Information: DSP Type 2

Severity: Error

EventID: E8030369 (hex)

Message: 874

DSP Error.  Please Contact Keysight Support.  Technical Information: DSP Type 3

Severity: Error
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EventID: E803036A (hex)

Message: 875

DSP Error.  Please Contact Keysight Support.  Technical Information: DSP Type 4

Severity: Error

EventID: E803036B (hex)

Message: 876

DSP Error.  Please Contact Keysight Support.  Technical Information: DSP Type 5

Severity: Error

EventID: E803036C (hex)

Message: 910

The trigger connection argument was not recognized as valid by the firmware.

Severity: Error

EventID: 0xE803038E (hex)

Message: 911

The trigger connection specified does not support this trigger behavior

Severity: Error

EventID: E803038F (hex)

Message: 912

The trigger behavior specified was not recognized as valid by the firmware.

Severity: Error

EventID: E8030390 (hex)

Message: 913

The trigger connection specified does not physically exist on this network analyzer

Severity: Error
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EventID: E8030391 (hex)

Message: 914

Cannot set "Accept Trigger Before Armed", since this hardware configuration does not support edge

triggering.

Severity: Error

EventID: E8030392 (hex)

Message: 915

Cannot set "Trigger Output Enabled", since this hardware configuration does not support BNC2.

Severity: Error

EventID: E8030393 (hex)

Message: 916

Exceeded maximum trigger delay.

Severity: Error

EventID: E8030394 (hex)

Message: 917

Exceeded minimum trigger delay.

Severity: Error

EventID: E8030395 (hex)

Measure Errors

Message: 1024

If you are going to display or otherwise use a memory trace, you must first store a data trace to

memory.

Severity: Warning

EventID: A8040400 (hex)

Message: 1025
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"The measurement failed to shut down properly. The application is in a corrupt state and should be shut

down and restarted."

Severity: Error

Further explanation: This message is displayed if the analyzer application becomes corrupt. If you

continue to get this error, please call customer service

EventID: E8040401 (hex)

Message: 1026

The measurement failed to shut down properly.  The update thread failed to exit properly.

Severity: Warning

EventID: A8040402 (hex)

Message: 1027

"Group Delay format with CW Time or Power sweeps produces invalid data."

Severity: Warning

Further explanation: Group Delay format is incompatible with single-frequency sweeps. Invalid data

is produced.

Suggestions: Ignore the data or choose a different format or sweep type.

EventID: A8040403 (hex)

Message: 1028

Severity: Informational

"MSG_LIMIT_FAILED"

Further explanation:  Limit line test failed.

EventID: 68040404 (hex)

Message: 1029

Severity: Informational

"MSG_LIMIT_PASSED"
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Further explanation:  Limit line test passed.

EventID: 68040405 (hex)

Message: 1030

"Exceeded the maximum number of measurements allowed."

Severity: Warning

Further explanation:  See Traces, Channels, and Windows on the analyzer for learn about maximum

measurements.

EventID: A8040406 (hex)

Message: 1031

"Network Analyzer Internal Error. Unexpected error in AddNewMeasurement."

Severity: Warning

Further explanation:  If you continue to get this message, contact product support.

EventID: A8040407 (hex)

Message: 1032

"No measurement was found to perform the selected operation. Operation not completed."

Severity: Warning

Further explanation: None

Suggestions:Create a measurement before performing this operation.

EventID: A8040408 (hex)

Message: 1033

The Markers All Off command failed.

Severity: Warning

EventID: A8040409 (hex)

Message: 1034

"A memory trace has not been saved for the selected trace. Save a memory trace before attempting
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trace math operations."

Severity: Warning

Further explanation:  Must have a memory trace when trying to do Trace Math,

EventID: A804040A (hex)

Message: 1035

"MSG_SET_AVERAGE_COMPLETE"

Severity: Informational

Further explanation:  Informational for COM programming. Averaging factor has been reached.

EventID: 6804040B (hex)

Message: 1036

"MSG_CLEAR_AVERAGE_COMPLETE"

Further explanation:  Informational for COM programming. Averaging factor has NOT been reached.

EventID: 6804040C (hex)

Message: 1037

"Time Domain transform requires at least 3 input points. The transform has been deactivated."

Severity: Informational

Further explanation: None

Suggestions:Increase the number of points.

EventID: 6804040D (hex)

Message: 1038

Smoothing requires a scalar format, and has been deactivated.

Severity: Informational

EventID: 6804040E (hex)

Message: 1039

A receiver power calibration in this instrument state file cannot be recalled into this firmware version.
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Severity: Warning

EventID: A804040F (hex)

Message: 1047

Could not achieve target power.

Severity: Error

Further explanation: This indicates that the analyzer was unable to find a source power during the

THRU step of the cal sufficiently high to boost the measured noise power on port 2 to 6 dB above the

noise floor.

Message: 1104

"Exceeded limit on number of measurements."

Severity: Error

Further explanation: See Traces, Channels, and Windows on the analyzer for measurement limits.

EventID: E8040450 (hex)

Message: 1105

"Parameter not valid."

Severity: Error

Further explanation: A measurement parameter that was entered programmatically is not valid.

EventID: E8040451 (hex)

Message: 1106

"Measurement not found."

Severity: Error

Further explanation: Any of these could be the cause:

Trying to calibrate but already have maximum measurements.

Trying to do a confidence check but there is not a measurement.

Trying to create, activate, or alter a measurement through COM that has been deleted through the front
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panel.

Trying to use a trace name through programming that is not unique.

EventID: E8040452 (hex)

Message: 1107

"No valid memory trace."

Severity: Error

Further explanation: Must have a memory trace when trying to do Trace Math,  

Suggestions: Store a memory trace.

EventID: E8040453 (hex)

Message: 1108

"The reference marker was not found."

Severity: Error

Further explanation: Attempted to create a delta marker without first creating a reference marker

(COM only).

EventID: E8040454 (hex)

Message: 1109

"Data and Memory traces are no longer compatible. Trace Math has been turned off."

Severity: Error

Further explanation:  Warning - channel setting has changed while doing trace math.

Suggestions:Store another memory trace and turn trace math back on.

EventID: A8040455 (hex)

Message: 1110

"Data and Memory traces are not compatible. For valid trace math operations, memory and data traces

must have similar measurement conditions."

Severity: Error
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Further explanation:  Tried to do trace math without compatible data and memory traces.

Suggestions: Store another memory trace.

EventID: E8040456 (hex)

Message: 1111

"Marker Bandwidth not found."

Severity: Error

Further explanation:  Could not find a portion of trace that meets the specified bandwidth criteria.

EventID: E8040457 (hex)

Message: 1112

"The peak was not found."

Severity: Error

Further explanation: Could not find portion of trace that meets peak criteria.

Suggestions: See Marker Peak criteria.

EventID: E8040458 (hex)

Message: 1113

"The target search value was not found."

Severity: Error

Further explanation: Could not find interpolated data point that meets search value.

EventID: E8040459 (hex)

Message: 1114

"Reflection measurement, such as S11, must supply an auxiliary port to disambiguate 2-port

measurements on multiport instruments."

Severity: Error

Further explanation:  

EventID: E804045A (hex)
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Message: 1115

"The receiver power calibration has been turned off because the type of measurement or source port has

changed, so the calibration is no longer valid."

Severity: Warning

Further explanation:  

EventID: A804045B (hex)

Message: 1116

"Receiver power cal requires the active measurement to be of unratioed power."

Severity: Warning

Further explanation:  

EventID: A804045C (hex)

Message: 1117

"There is currently no source power calibration associated with the channel and source port of the

active measurement.  A source power cal should be performed or recalled before performing a receiver

power calibration."

Severity: Warning

Further explanation:  

EventID: A804045D (hex)

Message: 1118

"The attempted operation can only be performed on a standard measurement type."

Severity: Error

Further explanation:  

EventID: E804045E (hex)

Message: 1119

"The custom measurement cannot be loaded because it is not compatible with the Network Analyzer

hardware."
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Severity: Error

Further explanation:  

Suggestions:

EventID: E804045F (hex)

Message: 1120

"The custom measurement cannot be loaded because it is not compatible with the Network Analyzer

software."

Severity: Error

Further explanation:  

EventID: E8040460 (hex)

Message: 1121

"The custom measurement load operation failed for an unspecified reason."

Severity: Error

Further explanation:  

EventID: E8040461 (hex)

Message: 1122

"The custom measurement data processing has generated an unhandled exception, and will be

terminated.  The analyzer software may be in an unstable state and it is recommended that the analyzer

software be shutdown and restarted."

Severity: Error

Further explanation:  

EventID: E8040462 (hex)

Message: 1123

"The attempted operation can only be performed on a custom measurement type."

Severity: Error

Further explanation:  
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EventID: E8040463 (hex)

Message: 1124

"The requested custom measurement is not available."

Severity: Error

Further explanation:  

EventID: E8040464 (hex)

Message: 1125

"The requested custom algorithm was not found."

Severity: Error

Further explanation:  

EventID: E8040465 (hex)

Message: 1126

"Normalization cannot be turned on because the measurement does not have a valid divisor buffer."

Severity: Error

Further explanation:  

EventID: E8040466 (hex)

Message: 1127

"The Raw Data requested by the measurement could not be provided."

Severity: Warning

Further explanation:  

EventID: A8040467 (hex)

Message: 1128

"The selected Sweep Type does not allow Transform and Gating. Transform and Gating disabled. "

Severity: Error
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Further explanation:  

EventID: E8040468 (hex)

Message: 1129

Memory trace can not be applied to this measurement

Severity: Error

EventID: E8040469 (hex)

Message: 1130

Normalization can not be applied to this measurement

Severity: Error

EventID: E804046A (hex)

Message: 1131

The data provided has an invalid number of points. It could not be stored

Severity: Error

EventID: E804046B (hex)

Message: 1132

The measurement stored in the save/recall state has an invalid version. It could not be loaded

Severity: Error

EventID: E804046C (hex)

Message: 1133

This data format argument for this operation must be "naDataFormat_Polar"

Severity: Error

EventID: E804046D (hex)

Message: 1134

This data format argument for this operation must be a scalar data format

Severity: Error
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EventID: E804046E (hex)

Message: 1135

The memory trace is not valid for the current measurement setup.

Severity: Error

EventID: E804046F (hex)

Message: 1136

This measurement is incompatible with existing measurements in this channel. Choose another

channel.

Severity: Error

EventID: E8040470 (hex)

Message: 1137

Port extension correction is not available for offset frequency measurements.  Port extension correction

has been disabled.

Severity: Error

EventID: E8040471 (hex)

Message: 1138

Physical port number assignments for logical port mappings must be unique.

Severity: Error

EventID: E8040472 (hex)

Parser Errors

Message: 1281

"You have sent a read command to the analyzer without first requesting data with an appropriate output

command. The analyzer has no data in the output queue to satisfy the request."

Severity: Error

EventID: 68050501 (hex)
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Message: 1282

"You must remove the active controller from the bus or the controller must relinquish the bus before

the analyzer can assume the system controller mode."

Severity: Error

EventID: E8050502(hex)

Message: 1283

"The analyzer did not receive a complete data transmission.  This is usually caused by an interruption

of the bus transaction."

Severity: Error

EventID: E8050503 (hex)

Message: 1284

"The instrument status byte has changed."

Severity: Informational

EventID: 68050504 (hex)

Message: 1285

"The SCPI command received has caused error number %1: "%2"."

Severity: Informational

EventID: 68050505 (hex)

Message: 1286

"The INET LAN server has been started as process number %1."

Severity: Informational

EventID: 68050506 (hex)

Message: 1360

"Execution of the SCPI command has failed"

Severity: Error
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EventID: E8050550 (hex)

Message: 1361

" The INET/LAN device is not accessible."

Severity: Error

EventID: E8050551 (hex)

Message: 1362

"The INET/LAN driver was not found. "

Severity: Error

EventID: E8050552 (hex)

Message: 1363

"The INET/LAN driver was not found."

Severity: Error

EventID: E8050553 (hex)

Message: 1364

"The INET/LAN device is unable to acquire the necessary resources. "

Severity: Error

EventID: E8050554 (hex)

Message: 1365

"The INET/LAN device generated a generic system error. "

Severity: Error

EventID: E8050555 (hex)

Message: 1366

"Invalid address for the INET/LAN device."

Severity: Error

EventID: E8050556 (hex)
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Message: 1367

"The INET I/O library was not found. "

Severity: Error

EventID: E8050557 (hex)

Message: 1368

"An error occured in the INET system. "

Severity: Error

EventID: E8050558 (hex)

Message: 1369

"Access to the INET/LAN driver was denied. "

Severity: Error

EventID: E8050559 (hex)

Message: 1370

"Could not load error system message dll."

Severity: Error

EventID: E805055A (hex)

Message: 1371

"ErrorSystemMessage.dll does not export the right function."

Severity: Error

EventID: E805055B (hex)

Message: 1372

"Custom scpi library was not able to be knitted"

Severity: Error

EventID: E805055C (hex)
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Message: 1373

"Could not knit the scpi error messages from the ErrorSystemMessage lib"

Severity: Error

EventID: E805055D (hex)

Message: 1374

Command is obsolete with this software version.

Severity: Error

EventID: E808055E (hex)

Message: 1375

CALC measurement selection set to none. Use Calc:Par:Sel

Severity: Error

EventID: E808055F (hex)

Message: 1535

"Parser got command: %1."

Severity: Informational

EventID: 680505FF (hex)

Display Errors 1536 - 1621

Message: 1536

"Exceeded the maximum of 4 traces in each window. The trace for <x> will not be added to window

<x>."

Severity: Warning

Further explanation: None

Suggestions: Create the trace in another window. See the analyzer window limits.

EventID: A8060600 (hex)
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Message: 1537

"Exceeded the maximum of 16 data windows. New window will not be created."

Severity: Warning

Further explanation: None

Suggestions: Create the trace in an existing window. See the analyzer window limits.

EventID: A8060601 (hex)

Message: 1538

"No Data Windows are present. Unable to complete operation."

Severity: Warning

Further explanation: Your remote SCPI operation tried to create a new measurement while there were

no windows present

Suggestions: Create a new window before creating the measurement. See example Create a
measurement using SCPI

EventID: A8060602 (hex)

Message: 1539

"No data traces are present in the selected window. Operation not completed."

Severity: Warning

Further explanation: None

EventID: A8060603 (hex)

Message: 1540

"Cannot complete request to arrange existing measurements in <x> windows due to the limit of <x>

traces per window."

Severity: Informational

Further explanation: The arrange window feature cannot put the existing traces into the number of

windows you requested because only 4 traces per window are allowed. See Arranging Existing
Measurements

Suggestions:Either create more windows or delete some traces.
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EventID: 68060604 (hex)

Message: 1541

"Unable to establish a connection with the specified printer."

Severity: Warning

Further explanation: None

Suggestions: Refer to Printer Help 

EventID: A8060605 (hex)

Message: 1542

"Printout canceled."

Severity: Informational

EventID: 68060606 (hex)

Message: 1616

"Window not found."

Severity: Error

Further explanation:  A window was specified in your program which does not exist.

Suggestions: Query the name of your window before specifying.

EventID: E8060650 (hex)

Message: 1617

"Duplicate window ID specified."

Severity: Error

Further explanation: None

EventID: E8060651 (hex)

Message: 1618

"Exceeded limit on number of windows."

Severity: Error
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Further explanation: There is a limit of 4 windows per screen.

EventID: E8060652 (hex)

Message: 1619

"Exceeded limit on number of traces/window."

Severity: Error

Further explanation: There is a limit of 4 traces per window. See the Traces, Channels, and Windows on
the analyzer.

Suggestions: Create the trace in another window

EventID: E8060653 (hex)

Message: 1620

"Trace not found."

Severity: Error

Further explanation: Your program tried to communicate with a non-existing trace.

Suggestions:Query the trace ID before writing to it.

EventID: E8060654 (hex)

Message: 1621

"The operating system does not recognize this printer."

Severity: Warning

EventID: A8060655 (hex)

Message: 1622

Duplicate trace ID specified.

Severity: Error

EventID: E8060656 (hex)

Channel Errors 1792 -1878
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Message: 1792

"Sweep Complete."

Severity: Informational

Further explanation: None

Suggestions:None

EventID: 68070700 (hex)

Message: 1793

"All triggerable acquisitions have completed."

Severity: Informational

Further explanation:

EventID: 68070701 (hex)

Message: 1794

"The last trigger produced an aborted sweep."

Severity: Informational

Further explanation:

EventID: 68070702 (hex)

Message: 1795

"The segment list must be adjusted to have at least one active segment with more than 0 points to use

segment sweep."

Severity: Informational

Further explanation:  You attempted to change Sweep type to Segment sweep, but there is either no

segments defined or no sweep points in the defined segments

Suggestions: Define at least one segment with at least one measurement point. See Segment sweep for

more information

EventID: 68070703 (hex)

Message: 1796
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"MSG_SET_CHANNEL_DIRTY"

Severity: Informational

Further explanation: This informational message occurs when a channel setting has changed but the

channel still has data that was taken with the previous setting. The following CLEAR message occurs

when new channel data is taken.

EventID: 68070704 (hex)

Message: 1797

"MSG_CLEAR_CHANNEL_DIRTY"

Severity: Informational

Further explanation:  The previous SET message occurs when a channel setting has changed but the

channel still has data that was taken with the previous setting. This CLEAR message occurs when new

channel data is taken.

EventID: 68070705 (hex)

Message: 1798

Sweep time has changed from Auto to Manual mode.  If desired to return to Auto mode,  enter sweep

time value of 0.

Severity: Informational

EventID: 68070706 (hex)

Message: 1799

"Set Sweep Completed"

Severity: Informational

Further explanation: This event occurs when a sweep and it's associated sweep calculations finish.

This is typically when all sweeps on a channel complete.

EventID: 68070707 (hex)

Message: 1800

"Clear Sweep Completed"

Severity: Informational
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Further explanation: This event occurs immediately after the SET SWEEP COMPLETED event.

These two events set and clear the "Sweep Completed" bit (bit 4) on the SCPI Device Status register.

EventID: 68070708 (hex)

Message: 1801

"All Sweeps Completed and Processed"

Severity: Informational

Further explanation: This event occurs when all of the sweeps and sweep calculations are complete

for a channel.

EventID: 68070709 (hex)

Message: 1802

Low Pass : Frequency limits have been changed.

Severity: Informational

EventID: 6807070A (hex)

Message: 1803

Low Pass : Number of points have been changed.

Severity: Informational

EventID: 6807070B (hex)

Message: 1804

Low Pass : Frequency limits and number of points have been changed.

Severity: Informational

EventID: 6807070C (hex)

Message: 1805

"Channel created"

Severity: Informational

EventID: 6807070D (hex)
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Message: 1806

"Channel deleted"

Severity: Informational

EventID: 6807070E (hex)

Message: 1872

"Channel not found."

Severity: Error

Further explanation: A non-existent channel is being referenced under program control.

Suggestions: Query the channel number, then refer to it by number.

EventID: E8070750 (hex)

Message: 1873

"The requested sweep segment was not found."

Severity: Error

Further explanation:  A non-existent sweep segment is being referenced under program control.

EventID: E8070751 (hex)

Message: 1874

"The sweep segment list is empty."

Severity: Error

Further explanation:  Segment Sweep cannot be specified unless there is at least one defined

segment. This error will only occur under remote control.

EventID: E8070752 (hex)

Message: 1875

"The number of points in active sweep segment list segments is 0."

Severity: Error

Further explanation: Segment Sweep cannot be specified unless there is at least data point specified

2117



in a segment. This error will only occur under remote control.

EventID: E8070753 (hex)

Message: 1876

"The specified source attenuator is not valid."

Severity: Error

Further explanation:  You tried to set the Attenuator property on the Channel object on a analyzer

that doesn't have a source attenuator.

EventID: E8070754 (hex)

Message: 1877

"Log Frequency sweep cannot be selected with the current Number of Points.  Please reduce Number of

Points."

Severity: Error

Further explanation: The maximum number of points that can be used for Log sweep is 401.

EventID: E8070755 (hex)

Message: 1878

"The requested Number of Points is greater than can be selected for Log Frequency sweep."

Severity: Error

Further explanation:  The maximum number of points that can be used for Log sweep is 401.

EventID: E8070756 (hex)

Message: 1879

"Response frequencies exceeded instrument range so Frequency Offset has been turned off."

Severity: Error

Further explanation: This error is returned whenever the instrument detects that the stimulus sweep

setup and Frequency Offset settings result in computed response frequencies that exceed instrument

limits. When this occurs, the instrument automatically turns off Frequency Offset to avoid the out-of-

range conditions.

Suggestions: When this condition has occurred, change settings for either the stimulus frequencies or
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Frequency Offset so that the Response frequencies are within instrument bounds. Once this is done,

Frequency Offset can once again be turned on.

EventID: E8070757 (hex)

Message: 1880

The total number of points for all the given segments exceeds the maximum number of points

supported. The segments were not changed.

Severity: Error

EventID: E8070758 (hex)

Message: 1881

This instance of the Channels object was not used to place the channels in Hold, so no channels were

resumed.

Severity: Error

EventID: E8070759 (hex)

Message: 1882

The port number was outside the range of allowed port numbers.

Severity: Error

EventID: E807075A (hex)

Message: 1883

More ports than are present are required for this operation.

Severity: Error

EventID: E807075B (hex)

General Errors

Message: 2048

"The function you requested requires a capability provided by an option to the standard analyzer. That

option is not currently installed."
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Severity: Error

Further explanation: None

Suggestions:To view the options on your analyzer, click Help / About Network Analyzer. For more

information see analyzer Options

EventID: 68080800 (hex)

Message: 2049

"The feature you requested is not available on the current instrument."

Severity: Error

Further explanation: None

EventID: 68080801 (hex)

Message: 2050

"The feature you requested is incompatible with the current instrument state."

Severity: Error

Further explanation: None

Suggestions: None

EventID: 68080802 (hex)

Message: 2051

"File<x> has been saved."

Severity: Informational

Further explanation: None

EventID: 68080803 (hex)

Message: 2052

"Attempt to save <x> failed."

Severity: Error

Further explanation:  None
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Suggestions: If using a floppy disk, ensure it is inside the drive and the disk is not full. Check the

filename for special characters.

EventID: E8080804 (hex)

Message: 2053

"Attempt to recall file failed because <x> was not found."

Severity: Error

Further explanation: None

EventID: E8080805 (hex)

Message: 2054

"<x> has a bad header."

Severity: Error

Further explanation: None

Suggestions: Recopy the file and / or delete the file.

EventID: E8080806 (hex)

Message: 2056

"Request to enter hibernate state."

Further explanation: None

EventID: 68080808 (hex)

Message: 2057

"Power up from automatic hibernate state. Program received PBT_APMRESUMEAUTOMATIC

Message."

Further explanation: None

EventID: 68080809 (hex)

Message: 2058

"Power up from suspend hibernate state. Program received PBT_APMRESUMESUSPEND Message."
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Further explanation: None

EventID: 6808080A (hex)

Message: 2059

"Power up from suspend hibernate state. Program received PBT_APMRESUMECRITICAL Message."

Severity: Warning

Further explanation: None

EventID: A808080B (hex)

Message: 2060

"Power up from unknown hibernate state UI recovery called. Program received no PBT_Message

within the time allotted and is attempting recovery."

Severity: Warning

Further explanation: None

EventID: A808080C (hex)

Message: 2061

"<x> already exists. File is being overwritten."

Further explanation: Used only for remote applications

EventID: 6808080D (hex)

Message: 2062

"File has not been saved."

Severity: Error

Further explanation: Used only for remote applications

EventID: E808080E (hex)

Message: 2063

"File <x> has been recalled."

Further explanation: Used only for remote applications
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EventID: 6808080F (hex)

Message: 2064

"State version in <x> is considered obsolete by this version of this code."

Severity: Error

Further explanation: You attempted to recall a file that is no longer valid.

Suggestions: You must recreate the file manually.

EventID: E8080810 (hex)

Message: 2065

"State version in <x> is newer than the latest version supported by this code."

Severity: Error

Further explanation: You attempted to recall a file that was created by a later version of the analyzer

application.

Suggestions: You must recreate the file manually.

EventID: E8080811 (hex)

Message: 2066

"Error occurred while reading file <x>"

Severity: Error

Further explanation: The file may be corrupt.

Suggestions: Try to recreate the file.

EventID: E8080812 (hex)

Message: 2067

"Windows shell error: <x>"

Severity: Error

Further explanation: None

EventID: E8080813 (hex)
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Message: 2068

Send message timed out returning: <x>.

Severity: Error

Further explanation: None

EventID: E8080814 (hex)

Message: 2069

"Changing GPIB mode to System Controller."

Severity: Informational

Further explanation: None

EventID: 68080815 (hex)

Message: 2070

"Changing GPIB mode to Talker Listener."

Severity: Informational

Further explanation: None

EventID: 68080816 (hex)

Message: 2071

"The Network Analyzer can not be put in GPIB System Controller mode until the GPIB status is Local.

Stop any remote GPIB programs which may be using the Network analyzer, press the Macro/Local key

and try again. "

Severity: Informational

Further explanation: See LCL and RMT Operation

Suggestions: Press the Macro/Local key and try again.

EventID: 68080817 (hex)

Message: 2120

"This method can not be invoked through a late-bound COM call."
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Severity: Error

Further explanation: None

Suggestions: Use the alternate method described in the COM programming documentation

EventID: E8080878 (hex)

Message: 2128

"The specified format is invalid."

Severity:Error

Further explanation: None

EventID: E8080850 (hex)

Message: 2129

"WINNT exception caught by Automation layer."

Severity: Error

Further explanation: None

EventID: E8080851 (hex)

Message: 2130

"Bad port specification."

Severity: Error

Further explanation: None

EventID: E8080852 (hex)

Message: 2131

"Failed to find a printer."

Severity: Error

Further explanation: None

Suggestions: See Connecting to a Printer

EventID: E8080853 (hex)
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Message: 2132

"Manual trigger ignored."

Severity: Error

Further explanation: None

EventID: E8080854 (hex)

Message: 2133

"Attempt to set trigger failed."

Severity: Error

Further explanation: None

EventID: E8080855 (hex)

Message: 2134

"Macro execution failed."

Severity: Error

Further explanation: None

EventID: E8080856 (hex)

Message: 2135

"Specified macro definition is incomplete."

Severity: Error

Further explanation:

EventID: E8080857 (hex)

Message: 2137

"Block data length error."

Severity: Error

Further explanation: See Getting Data from the Analyzer
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EventID: E8080859 (hex)

Message: 2139

"Requested data not found."

Severity: Error

Further explanation: None

EventID: E808085B (hex)

Message: 2142

"The parameter supplied was out of range, so was limited to a value in range before being applied to

the instrument."

Severity: Success

Further explanation: None

Suggestions: View range limits before sending programming commands.

EventID: 2808085E (hex)

Message: 2143

The parameter supplied was out of range, so was limited to a value in range before being applied to the

instrument.

Severity: Error

EventID: E808085F (hex)

Message: 2144

"Request failed. The required license was not found."

Severity: Error

Further explanation: None

EventID: E8080860 (hex)

Message: 2145

"A remote call to the front panel has returned hresult <x>"
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Severity: Error

Further explanation: This may indicate a problem with the front panel

Suggestions: Contact Technical support

EventID: E8080861 (hex)

Message: 2146

The recall operation failed.

Severity: Error

Further explanation:

EventID: E8080862 (hex)

Message: 2147

Attempt to save file failed.

Severity: Error

Further explanation:

EventID: E8080863 (hex)

Message: 2148

Recall attempt failed because file was not found.

Severity: Error

Further explanation:

EventID: E8080864 (hex)

Message: 2149

Recall file has a bad header.

Severity: Error

Further explanation:

EventID: E8080865 (hex)

Message: 2150
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Recall file version is obsolete and no longer compatible with this instrument.

Severity: Error

Further explanation:

EventID: E8080866 (hex)

Message: 2151

The recall file contains an istate version newer than this instrument. A remote call to the front panel has

returned hresult %1

Severity: Error

Further explanation:

EventID: E8080867 (hex)

Message 2152

"Front Panel <x>

Severity: Error

Further explanation: None

EventID: E8080868 (hex)

Message 2153

"Front Panel message"

Severity: Informational

Further explanation: None

EventID: 68080869 (hex)

Message 2154

"Power Service <x>

Severity: Error

Further explanation: There is more than 1 instance of powerservice running. There  should only be

one running. This might happen after running  install shield - especially when upgrading the CPU

board.
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Suggestions:  Try rebooting. If this persists, please call Customer Support.

EventID: E808086A (hex)

Message 2155

"Power Service <x>

Severity: Informational

Further explanation: None

EventID: 6808086B (hex)

Message 2156

"The Keysight Technologies GPIB driver can not be loaded or unloaded."

Severity: Error

Further explanation: None

Suggestions: If the problem persists, from the analyzer desktop, right-click on My Computer. Click

Properties, Click Hardware Tab. Click Device Manager Button. Expand GPIB Devices. Right-click and

click Uninstall all GPIB interfaces devices. Reboot the analyzer.

EventID: E808086C (hex)

Message 2157

"The National Instruments GPIB driver can not be loaded or unloaded."

Severity: Error

Further explanation: None

Suggestions: If the problem persists, from the analyzer desktop, right-click on My Computer. Click
Properties, Click Hardware Tab. Click Device Manager Button. Expand GPIB Devices. Right-click and

click Uninstall all GPIB interfaces devices. Reboot the analyzer.

EventID: E808086D (hex)

Message 2158

"The Keysight GPIB driver is loaded but it can not start its parser."

Severity: Error

Further explanation: None
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EventID: E808086E (hex)

Message: 2159

The front panel is in remote mode.

Severity: Warning

EventID: A808086F (hex)

Message: 2160

The Registry Key specified could not be found.

Severity: Error

EventID: E8080870 (hex)

Message: 2161

An overcurrent condition has been detected on a probe plugged into the front panel.

Severity: Warning

EventID: A8080871 (hex)

Message: 2162

The operation timed out.

Severity: Error

EventID: E8080872 (hex)

Message 2163

"The Network Analyzer executed a preset."

Severity:Informational

Further explanation: None

EventID: 68080873 (hex)

Message 2164

"Access to file denied."

Severity: Error
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Further explanation: This means that the system can not open an output file for writing. Most likely

because the file is write protected.

Suggestions:  Pick another file name or file directory, check floppy disk hard disk write access.

EventID: E8080874 (hex)

Message 2165

"File type is structured storage."

Severity: Informational

Further explanation: None

EventID: 68080875 (hex)

Message 2166

"The trigger operation failed."

Severity: Error

Further explanation: None

EventID: E8080876 (hex)

Message 2167

"Argument out of range error."

Severity: Error

Further explanation: None

Suggestions: None

EventID: E8080877 (hex)

Message: 2169

The given COM object is not a custom application

Severity: Error

EventID: E8080879 (hex)

Message: 2170
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The eventID supplied was not recognized as a valid analyzer eventID

Severity: Error

EventID: E808087A (hex)

Message: 2171

The operation was canceled.

Severity: Error

EventID: E808087B (hex)

Message: 2172

High security level cannot be disabled directly. Only an instrument preset or recall of lower security

instrument state will reset this security level.

Severity: Error

EventID: E808087C (hex)

Message: 2173

Local lockout mode is on.  The analyzer application will not  accept input from front panel, keyboard

or mouse until  this mode is turned off from a remote interface.

Severity: Error

EventID: E808087D (hex)

Message: 2174

The SnP request is not valid for the selected measurement.

Severity: Error

EventID: E808087E (hex)

Message: 2175

Preset is not supported while this dialog or wizard is open. Close the dialog or wizard and then try

again.

Severity: Error
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EventID: E808087F (hex)

Message: 2176

The function you requested requires a capability provided by an option to the standard analyzer. That

option is not currently installed.

Severity: Error

EventID: E8080880 (hex)

Message: 2177

Catastrophic error.  Crash dump recorded at <n>

Severity: Error

EventID: E8080881 (hex)

Message: 2179

Failed to open gen.lic.

Severity: Error

EventID: E8080883 (hex)
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About Error Messages

Analyzer errors and Operating System errors are displayed and logged in an error file. You can choose

how to display errors, or choose to not display errors at all.

Error Display

View Error Log

List of VNA Errors

SCPI Errors

Other System topics

Error Display

By default, error messages appear on the screen for a brief period. You can choose to have them stay on

the screen until you click an OK button, or have them not appear at all.  When they stay on the screen,

a Help button is available to provide further assistance.

How to select the display of Error Messages

Using Hardkey/SoftTab/Softkey

Press System > Help > Error Display....1.
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Error Display dialog box help

On Preset, these settings revert to their defaults (enabled, timed popups).

Enable Messages  Check to display all error messages as they occur. Clear to suppress the display

of error messages. You can still view them in the error log.

Calibration Error Message Windows  

Status bar Display  Displays error messages on the screen for a duration of time proportional to

the length of the message. You can then view the message in the error log and get further

assistance.

Confirmation Dialog boxes  Displays error messages in a standard dialog box. You then choose

OK or Cancel to close the dialog box, or press Help to get further information on the error

message.

View Error Log

The analyzer Error Log is a list of all events that have occurred. (Events are used in programming the

analyzer using COM.) Analyzer errors are a subset of events. Only events with severity codes of

ERROR are displayed on the screen as they occur. From the error log, you can access further help with

an error by selecting the error and clicking Help.

How to view the Error Log

Using Hardkey/SoftTab/Softkey

Press System > Help > View Error Log....1.

No programming commands

 

Error Log dialog box help
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Network analyzer errors only  Select to view only analyzer errors. Clear to view all errors that

occur on all applications of the computer.

Description  Error message that appears on the analyzer screen.

A - Event ID  Error message number

B - Date the Error occurred

C - Time the Error occurred

D - Severity Code - All events have one of the following severity codes:

SUCcess - the operation completed successfully

INFormational - events that occur without impact on the measurement integrity

WARning - events that occur with potential impact on measurement integrity

ERRor - events that occur with serious impact on measurement integrity

E - Application in which the error occurred.

OK  Closes the Dialog box

Help  Provides further information on the selected Error message

To clear the Error Log:

1.
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From the System > Main menu click Minimize Application.1.

On the desktop, select Start, Control Panel2.

On the Control Panel, click Administrative Tools3.

On the Administrative Tools window, click Event Viewer4.

On the Event Viewer window, right-click Application5.

Select Clear all Events6.

If you want to save a file with the contents of the Event Log, click Yes. Otherwise, click No7.

To restore the VNA application, click on the VNA Analyzer taskbar button at the bottom of the

screen.
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Analyzer Accessories

Coax Mechanical Calibration Kits

Waveguide Mechanical Calibration Kits

Electronic Calibration (ECal)

Mechanical Verification Kits

Adapter and Accessory Kits

Test Port Cables

USB Peripherals

Connector Care and ESD Supplies

Other Support topics

For product and order information:

Visit www.Keysight.com/find/accessories

Use the search function to locate information about a particular accessory or view the entire RF and
Microwave Test Accessories Catalog.

Accessories are available in these connector types:

50 ohm Type-N

75 ohm Type-N

3.5 mm

7 mm (APC-7)

7-16

2.92 mm

2.4 mm
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1.85 mm

1 mm

Test port cables and a calibration kit are necessary for a complete measurement system.

A verification kit is used to verify corrected system performance.

Coax Mechanical Calibration Kits

Model Connector Type Frequency Upper Limit

85032B Type-N (50 Ohm) 6 GHz

85032F Type-N (50 Ohm) 9 GHz

85054B Type-N (50 Ohm) 18 GHz

85036E Type-N (75 Ohm) 3 GHz

85050B 7 mm 18 GHz

85033D 3.5 mm 6 GHz

85038A 7-16 7.5 GHz

85033E 3.5 mm 9 GHz

85052B 3.5 mm 26.5 GHz

85052C 3.5 mm TRL 26.5 GHz

85056K 2.92 mm 50 GHz

85056A 2.4 mm 50 GHz

85058B/E
(data-based)

1.85 mm 67 GHz

85059A
(data-based)

1.00 mm DC to 110 GHz

85059B
(data-based)

1.00 mm DC to 120 GHz

Waveguide Mechanical Calibration Kits
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Model Connector Type Frequency Range

X11644A WR-90 8.2-12.4 GHz

P11644A WR-62 12.4-18 GHz

K11644A WR-42 18-26.5 GHz

R11644A WR-28 26.5-40 GHz

Q11644A WR-22 33-50 GHz

U11644A WR-19 40-60 GHz

V11644A WR-15 50-75 GHz

Electronic Calibration (ECal)

Model Connector Type Frequency Range

RF Two-Port

85091C 7 mm (APC-7) 300 kHz-9 GHz

85092C Type-N (50 ohm)

Port B available with 3.5 mm or 7-16a

300 kHz-9 GHz

85093C 3.5 mm

Port B available with Type-N (50 ohm)

or 7-16a

300 kHz-9 GHz

85096C Type-N (75 ohm) 300 kHz-3 GHz

85098C 7-16a

Port B available with Type-N (50 ohm)

or 3.5 mm

300 kHz-7.5 GHz

85099C Type-F 300 kHz-3 GHz

RF Four-Port

N4431B 3.5mm (f) (four-port), Type-N (f) (four-

port), Mixed connector types

9 kHzb-13.5 GHz

N4432A
Option 020

Type-N (f) (four-port) 300 kHz-18 GHz
(available Feb. 2006)

N4432A

Option 030

APC 7 (four-port) 300 kHz-18 GHz

(available Feb. 2006)
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N4433A

Option 010

3.5mm (f) (four-port) 300 kHz-20 GHz

(available Feb. 2006)

Microwave Two-Port

N4690B Type-N (50 ohm) 300 kHz-18 GHz

N4691B 3.5 mm 300 kHz-26.5 GHz

N4692A 2.92 mm 10 MHz-40 GHz

N4693A 2.4 mm 10 MHz-50 GHz

N4694A 1.85 mm 10 MHz-67 GHz

N4696BA 7 mm 300 kHz-18 GHz

a Limits ECal module high frequency to 7.5 GHz.

b Performance from 9 kHz to 300 kHz is valid only for the E5071C with firmware version A.09.10 and

above, and E5080A with firmware A.11.70.03 and above.

Verification Kits

Model Connector Type Frequency Range

85055A Type-N (50 Ohm) 300 kHz-9 GHz

85053B 3.5 mm 300 kHz-26.5 GHz

85057B 2.4 mm .045-50 GHz

R11645A WR-28 26.5-40 GHz

Q11645A WR-22 33-50 GHz

Adapters and Accessory Kits
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Model Description

11878A Type-N to 3.5 mm Adapter Kit

11525A Type-N (m) to 7 mm (APC-7)

11853A Type-N Accessory Kit

11900B 2.4 mm (f) to 2.4 mm (f)

11900C 2.4 mm (f) to 2.4 mm (m)

85130G Test Port Adapter Set, 2.4 mm (f) to 2.4 mm (m,f)

11901B 2.4 mm (f) to 3.5 mm (f)

11901D 2.4 mm (f) to 3.5 mm (m)

85130F Test Port Adapter Set, 2.4 mm (f) to 3.5 mm (m,f)

11902B 2.4 mm (f) to 7 mm (APC-7)

11920A 1 mm (m) to 1 mm (m)

11920B 1 mm (f) to 1 mm (f)

11920C 1 mm (m) to 1 mm (f)

11921A 1 mm (m) to 1.85 mm (m)

11921B 1 mm (f) to 1.85 mm (f)

11921C 1 mm (m) to 1.85 mm (f)

11921D 1 mm (f) to 1.85 mm (m)

11922A 1 mm (m) to 2.4 mm (m)

11922B 1 mm (f) to 2.4 mm (f)

11922C 1 mm (m) to 2.4 mm (f)

11922D 1 mm (f) to 2.4 mm (m)

Test Port Cables
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Model Description

N4697E 1.85 mm (f) to 1.85 mm (rugged f) flexible (single)

N4697F 1.85 mm (rugged f, f) to 1.85 mm (rugged m, rugged f) flexible (set)

N6315A Type-N (m) to Type-N (f), 16 in. (single)

N6314A Type-N (m) to Type-N (m), 24 in. (single)

85133D 2.4 mm (f) to 2.4 mm (m,f) semi-rigid (set)

85133F 2.4 mm (f) to 2.4 mm (m,f) flexible (set)

85134D 2.4 mm (f) to 3.5 mm (m,f) semi-rigid (set)

85134F 2.4 mm (f) to 3.5 mm (m,f) flexible (set)

USB Peripherals

Model Description

N4688A CD RW drive - with USB cable.

N4689A USB 4-port hub - for connecting additional USB peripherals.

82357A USB/GPIB Interface - for controlling GPIB devices through USB. Learn more

about using the 82357A with the VNA

Connector and ESD Supplies

See ESD topic

See more Connector Care supplies

Part Number Description

9300-1367 Adjustable antistatic wrist strap

9300-0980 Antistatic wrist strap grounding cord (5 foot)

9300-0797 Static control table mat (2 foot x 4 foot) with earth ground wire

9300-1126 ESD heel strap

1401-0248 ESD Safe End-Cap, Type-N (m)

1401-0247 ESD Safe End-Cap, Type-N (f)

1401-0214 Standard End-Cap, Type-N (m)

1401-0225 Standard End-Cap, Type-N (f)
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82357A USB / GPIB Interface

The Keysight 82357A is an adapter that creates a GPIB Interface from one of your unused VNA USB

ports.

Applications

Installing

Configuring

Connecting

Communicating with other Equipment

Applications

The 82357A can be used to connect a GPIB device using the VNA USB for any VNA application. In

addition, the 82357A can be used to connect a power meter for a source power calibration.

Installing the 82357A USB/GPIB Interface

Download and install firmware VNA revision 3.0 or greater. To check the revision of your VNA firmware, click
Help then About Network Analyzer.

1.

Upgrade to the latest Keysight IO libraries from the CDROM that was shipped with the 82357A.  If not
available, download them from www.Keysight.com (search for 82357A)

2.

Configure the 82357A USB/GPIB Interface

When the 82357A is connected to the VNA USB, the following dialog box appears:
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Normally, you do NOT need to edit these settings. The 82357A USB/GPIB Interface is configured

automatically as the next unused VISA interface. This is usually GPIB2 unless you have already

configured it for another purpose.

If the VISA Interface Name appears as GPIB0 or GPIB1, these Interfaces must be returned to their

default settings for the 82357A to work properly with the VNA. See Configure for VISA / SICL to learn
how.

Connecting the 82357B USB/GPIB Interface

The following diagram illustrates how to connect GPIB test equipment using the USB/GPIB Interface.

Plug the USB/GPIB Interface into any unused VNA USB port.

The driver installation and connection is performed automatically.

Communicating with Equipment Connected to the USB/GPIB Interface

The Frequency Converter Application will automatically find and communicate with test equipment that is
connected to the USB/GPIB Interface.

Source power calibration: Select GPIB at the Power Meter Settings dialog and specify the GPIB address of
the power meter.

To control other devices through your own program using the 82357A, you must include the new GPIB
Interface number when addressing the devices.
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Firmware Update

VNA firmware updates are available to you at no cost in a self-extracting Install Shield file. The update

includes the VNA application, Online help, and Service Utilities.

To manually check the version of firmware on the VNA, click System > Help > About NA....

Note: After a firmware update...

Custom Cal Kits must be imported. Learn more

If a different desktop icon named "Network Analyzer" exists, the shortcut to the VNA application will
assume the same icon. Right-click on the desktop, then click Refresh.

Other Support Topics

 

Updating firmware

 

Download the latest firmware from  http://www.keysight.com/find/na1.

Terminate the VNA application by pressing System > Main > Exit.2.

Transfer the file from your PC to your VNA using LAN or USB Pen drive.3.

Double-click the file on the VNA and follow the instruction.4.

 

2148

http://www.keysight.com/find/na


PXIe VNA Configurations and Options

Included with each M937x Module is a mouse and keyboard.

Options

Warranty Period

See Also

M937x Series Configuration Guide (requires an Internet connection)

M9485A Configuration Guide.

Click Help then About Network Analyzer to view the options that are installed on your analyzer.

Other Support Topics

M937x Series Modules

M9370A - 300 kHz to 4 GHz.

M9371A - 300 kHz to 6.5GHz.

M9372A - 300 kHz to 9 GHz.

M9373A - 300 kHz to 14 GHz.

M9374A - 300 kHz to 20 GHz.

M9375A - 300 kHz to 26.5 GHz.

M9485A Multiport PXIe VNA

See M9485A Configuration Guide for hardware options

Software Options for PXI VNA

Learn how to install options.
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Option Required Model/Options Description Supported Model

010 None Time Domain M9485A, M937xA

007 None Automatic Fixture Removal M9485A, M937xA

009 None Frequency offset mode M9485A, M937xA

025 None Gain Compression M9485A

086 None Basic RF pulse measurement M9485A

551 None N port calibrated measurement M9485A, M937xA

 

 

 

 

 

 

 

 

 

Option Available on

models:

Description

S93011A ALL models Enhanced Time Domain Analysis

Adds time domain reflectometry (TDR) and time domain

transmission (TDT) capability to analyzer. Learn more.
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Option Enable

Locate the Software License Entitlement Certificate.1.
Follow the instructions on the Software License Entitlement Certificate to redeem your license.2.
You will receive a license file (in an email). The file has the suffix .lic.3.
Follow the instructions in the email to complete the installation of the license file.4.

Detailed instructions can also be found in the Keysight License Manager help.

 

 

2151



Instrument Calibration

An instrument calibration is a process where the analyzer performance is measured to ensure that it

operates within specifications. If any performance parameter does not conform to the published

specifications, adjustments are made to bring the performance into conformance.

See Also: Instrument Calibration Verification (Sticker)

Why Should I Get an Instrument Calibrated?

Over time, the active components in the analyzer age and the performance may degrade or drift.

To ensure that the analyzer is performing to the published specifications, you should have an

instrument calibration performed periodically.

How Often Should I Get an Instrument Calibrated?

It is your responsibility to determine the calibration period which best meets your requirements.

However, a 12 to 18 month calibration cycle is appropriate for most users.

There are two things to consider: performance drift and connector wear.  

The instrument specifications are set to consider the performance drift that may occur over a 24 month
period. Therefore, getting the instrument calibrated at 24 month intervals ensures that the analyzer maintains
performance within the operating specifications. If you need the analyzer to maintain more consistent
operation, you may want to have the instrument calibrated more often than the recommended 24-month
interval.

Connector wear is a bigger factor and depends on the number of connections that are made. The test ports
become noticeably worn after 500 to 700 connections. This could represent about 12 months with average
use. With more frequent connections, the calibration cycle should be sooner. You can extend the time
between calibrations and thereby save money by using connector savers and by performing proper
Connector Care.

How Do I Get an Instrument Calibrated?

To get the instrument calibrated, send it to one of the Keysight Technologies service centers. See

Technical Support.

To perform the instrument calibration yourself, you must have the following required items:

Instrument Calibration Test Equipment

Performance Test Software
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What Are My Choices of Instrument Calibration?

The following types of instrument calibration are available from Keysight Technologies at the time of

initial order:

Standard
Includes a certificate of calibration stating the instrument has been calibrated and is

operating within the published specifications.

Option

UK6

Available ONLY at the initial shipment. Includes the test data from the calibration and

the certificate of calibration stating the instrument has been calibrated and is operating

within the published specifications.

Option A6J

Available ONLY at the initial shipment. Includes the test data and measurement

uncertainties from the calibration and the certificate of calibration stating the instrument

has been calibrated using a process in compliance with ANSI Z540 and is operating

within the published specifications.

Option 1A7

Available ONLY at the initial shipment. Includes the test data and measurement

uncertainties from the calibration and the certificate of calibration stating the instrument

has been calibrated using a process in compliance with ISO 17025 and is operating

within the published specifications.

 

The following types of instrument calibration are available from Keysight Technologies service center:

Keysight

Calibration

 Includes the test data from the calibration and the certificate of calibration, stating

the instrument has been calibrated and is operating within the published

specifications.

ANSI Z540

Calibration

Includes the test data from the calibration and the certificate of calibration, stating

the instrument has been calibrated using a process in compliance with ANSI Z540.1

and is operating within the published specifications.

ISO 17025

Calibration

Includes the test data from the calibration and the certificate of calibration, stating

the instrument has been calibrated using a process in compliance with ISO 17025

and is operating within the published specifications.

For more information on these options, visit www.Keysight.com/find/calibration.

 

 

2153



Other Resources

The following network analysis resources are also available.

Document Resources

Application Notes

Third-Party Resources

For information about test fixtures and part handlers, contact:

Inter-Continental Microwave
www.icmicrowave.com
 

For information about probing equipment and accessories, contact:

Cascade Microtech, Inc.

www.cascademicrotech.com

 

2154



SCPI Errors

SCPI Errors

-100 to -200 Command Errors

-200 to -299 Execution Errors

-300 to -399 SCPI Specified Device-Specific Errors

-400 to -800 Query and System Errors

100 to 200  VNA-specific Errors

See Also

Analyzer Error messages.

-100 to -200 Command Errors

A command error indicates that the test set's GPIB parser has detected an IEEE 488.2 syntax error.

When one of these errors is generated, the command error bit in the event status register is set.

-100 std_command Command - This event bit (Bit 5) indicates a syntax error, or
a semantic error, or a GET command was entered, see IEEE
488.2, 11.5.1.1.4.

-101 std_invalidChar Invalid character - Indicates a syntactic elements contains a
character which is invalid for that type.

-102 std_syntax Syntax - Indicates that an unrecognized command or data
type was encountered. For example, a string was received
when the device does not accept strings.

-103 std_invalidSeparator Invalid separator - The parser was expecting a separator and
encountered an illegal character. For example, the semicolon
was omitted after a program message  unit.

-104 std_wrongParamType Data type -The parser recognized a data element different
than one allowed. For example, numeric or string data was
expected but block data was encountered.

-105 std_GETNotAllowed GET not allowed - Indicates a Group Execute Trigger was
received within a program message. Correct the program so
that the GET does not occur within the program  code.
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-108 std_tooManyParameters Parameter not allowed - Indicates that more parameters were
received than expected for the header. For example, *ESE
common command only accepts one parameter,  so *ESE 0,1

is not allowed.

-109 std_tooFewParameters Missing parameter - Indicates that less parameters were
received than required for the header. For example, *ESE
requires one parameter, *ESE is not allowed.

-110 std_cmdHeader Command header - Indicates an error was detected in the
header. This error is used when the device cannot detect the
more specific errors -111 through -119.

-111 std_headerSeparator Header separator - Indicates that a character that is not a
legal header separator was encountered while parsing the
header.

-112 std_IDTooLong Program mnemonic too long - Indicates that the header
contains more that twelve characters, see IEEE 488.2,
7.6.1.4.1.

-113 std_undefinedHeader Undefined header - Indicates the header is syntactically
correct, but it is undefined for this specific device. For
example, *XYZ is not defined for any device.

-114 std_suffixOutOfRange Header suffix out of range - Indicates the value of a header
suffix attached to a program mnemonic makes the header
invalid.

-120 std_numericData Numeric data - This error, as well as errors
-121 std_invalidCharInNumber Invalid character in number - Indicates an invalid character

for the data type being parsed was encountered. For
example, an alpha in a decimal numeric or a "9"  in octal data.

-123 std_exponentTooLarge Exponent too large - Indicates the magnitude of an exponent
was greater than 32000, see IEEE 488.2, 7.7.2.4.1.

-124 std_decimalTooLong Too many digits - Indicates the mantissa of a decimal
numeric data element contained more than 255 digits
excluding leading zeros, see IEEE 488.2, 7.7.2.4.1.

-128 std_numericNotAllowed Numeric data not allowed - Indicates that a legal numeric
data element was received, but the device does not accept
one in this position for the header.

-130 std_suffix Suffix - This error, as well as errors -131 through -139, are
generated when parsing a suffix. This particular error
message is used if the device cannot detect   a more specific

error.

-131 std_badSuffix Invalid suffix - Indicates the suffix does not follow the syntax
described in IEEE 488.2, 7.7.3.2, or the suffix is inappropriate
for this device.

-134 std_suffixTooLong Suffix too long - Indicates the suffix contain more than 12
characters, see IEEE 488.2, 7.7.3.4.
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-138 std_suffixNotAllowed Suffix not allowed - Indicates that a suffix was encountered
after a numeric element that does not allow suffixes.

-140 std_charData Character data - This error, as well as errors
-141 std_invalidCharData Invalid character data - Indicates that the character data

element contains an invalid character or the particular
element received is not valid for the header.

-144 std_charDataTooLong Character data too long - Indicates the character data
element contains more than twelve characters, see IEEE
488.2, 7.7.1.4.

-148 std_charNotAllowed Character data not allowed - Indicates a legal character data
element was encountered where prohibited by the device.

-150 std_stringData String data - This error, as well as errors
-151 std_stringInvalid Invalid string data - Indicates that a string data element was

expected, but was invalid, see IEEE 488.2, 7.7.5.2. For
example, an END message was received before the terminal

quote character.

-158 std_stringNotAllowed String data not allowed - Indicates that a string data element
was encountered but was not allowed by the device at this
point in parsing.

-160 std_blockData Block data - This error, as well as errors -161 through -169,
are generated when parsing a block data element. This
particular error message is used if the device cannot detect a

more specific error.

-161 std_badBlock Invalid block data - Indicates a block data element was
expected, but was invalid, see IEEE 488.2, 7.7.6.2. For
example, and END message was received before the end

length was satisfied.

-168 std_blockNotAllowed Block data not allowed - Indicates a legal block data element
was encountered, but not allowed by the device at this point
in parsing.

-170 std_expr Expression - This error, as well as errors -171 through -179,
are generated when parsing an expression data element.
This particular error message is used if the device cannot detect

a more specific error.

-171 std_invalidExpression Invalid expression - Indicates the expression data element
was invalid, see IEEE 488.2, 7.7.7.2. For example,
unmatched parentheses or an illegal character.

-178 std_exprNotAllowed Expression data not allowed - Indicates a legal expression
data was encountered, but was not allowed by the device at
this point in parsing.
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-180 std_macro Macro - This error, as well as error -181 through -189, are
generated when defining a macro or execution a macro. This
particular error message is used if the device cannot detect a

more specific error.

-181 std_validOnlyInsideMacro Invalid outside macro definition - Indicates that a macro
parameter place holder was encountered outside of a macro
definition.

-183 std_invalidWithinMacro Invalid inside macro definition - Indicates that the program
message unit sequence, sent with a *DDT or a *DMC
command, is syntactically invalid, see IEEE 488.2, 10.7.6.3.

-184 std_macroParm  Macro parameter - Indicates that a command inside the
macro definition had the wrong number or type of
parameters.

-200 to -299 Execution Errors

These errors are generated when something occurs that is incorrect in the current state of the

instrument. These errors may be generated by a user action from either the remote or the manual user

interface

-200 std_execGen Execution - This event bit (Bit 4) indicates a PROGRAM DATA

element following a header was outside the legal input range or

otherwise inconsistent with the device's capabilities, see IEEE 488.2,

11.5.1.1.5.

-201 std_invalidWhileInLocal Invalid while in local

-202 std_settingsLost Settings lost due to rtl

-203 std_commandProtected Command protected - Indicates that a legal password-protected

program command or query could not be executed because the

command was disabled.

-210 std_trigger Trigger

-211 std_triggerIgnored Trigger ignored

-212 std_armIgnored Arm ignored

-213 std_initIgnored Init ignored

-214 std_triggerDeadlock Trigger deadlock

-215 std_armDeadlock Arm deadlock

-220 std_parm Parameter - Indicates that a program data element related error

occurred.

-221 std_settingsConflict Settings conflict - Indicates that a legal program data element was

parsed but could not be executed due to the current device state.
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-222 std_dataOutOfRange Data out of range - Indicates that a legal program data element was

parsed but could not be executed because the interpreted value was

outside the legal range defined by the devices

-223 std_tooMuchData Too much data - Indicates that a legal program data element of block,

expression, or string type was received that contained more data than

the device could handle due to memory or related device-specific

requirements.

-224 std_illegalParmValue Illegal parameter value - Indicates that the value selected was not part

of the list of values given.

-225 std_noMemoryForOp Out of memory - The device has insufficient memory to perform the

requested operation.

-226 std_listLength Lists not same length - Attempted to use LIST structure having

individual LIST's of unequal lengths.

-230 std_dataCorruptOrStale Data corrupt or stale - Indicates invalid data, a new reading started but

not completed since the last access.

-231 std_dataQuestionable Data questionable - Indicates that measurement accuracy is suspect.

-232 std_invalidFormat Invalid format

-233 std_invalidVersion Invalid version - Indicates that a legal program data element was

parsed but could not be executed because the version of the data is

incorrect to the device. For example, a not supported file version, a

not supported instrument version.

-240 std_hardware Hardware - Indicates that a legal program command or query could

not be executed because of a hardware problem in the device.

-241 std_hardwareMissing Hardware missing - Indicates that a legal program command or query

could not be executed because of missing device hardware. For

example, an option was not installed.

-250 std_massStorage Mass storage - Indicates that a mass storage error occurred. The

device cannot detect the more specific errors described for errors -251

through -259.

-251 std_missingMassStorage Missing mass storage - Indicates that a legal program command or
query could not be executed because of missing mass storage.

-252 std_missingMedia Missing media - Indicates that a legal program command or query

could not be executed because of missing media. For example, no

disk.

-253 std_corruptMedia Corrupt media - Indicates that a legal program command or query

could not be executed because of corrupt media. For example, bad

disk or wrong format.

-254 std_mediaFull Media full- Indicates that a legal program command or query could
not be executed because the media is full. For example, there is no

room left on the disk.
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-255 std_directoryFull Directory full - Indicates that a legal program command or query

could not be executed because the media directory was full.

-256 std_fileNotFound File name not found - Indicates that a legal program command or

query could not be executed because the file name was not found on

the media.

-257 std_fileName File name - Indicates that a legal program command or query could

not be executed because the file name on the device media was in

error. For example, an attempt was made to read or copy a nonexistent

file.

-258 std_mediaProtected Media protected - Indicates that a legal program command or query

could not be executed becuse the media was protected. For example,

the write-protect switch on a memory card was set.

-260 std_expression Expression

-261 std_math Math  in expression

-270 std_macroExecution Macro - Indicates that a macro related execution error occurred.

-271 std_macroSyntax Macro syntax - Indicates that a syntactically legal macro program data

sequence, according to IEEE 488.2, 10.7.2, could not be executed due

to a syntax error within the macro definition.

-272 std_macroExec Macro execution - Indicates that a syntactically legal macro program

data sequence could not be executed due to some error in the macro

definition, see IEEE 488.2, 10.7.6.3.

-273 std_badMacroName Illegal macro label - Indicates that the macro label was not accepted, it

did not agree with the definition in IEEE 488.2, 10.7.3

-274 std_macroPlaceholderMa cro parameter - Indicates that the macro definition improperly used a

macro parameter placeholder, see IEEE 4882, 10.7.3.

-275 std_macroTooLong Macro definition too long - Indicates that a syntactically legal macro

program data sequence could not be executed because the string of

block contents were too long for the device to handle, IEEE 488.2,

10.7.6.1.

-276 std_macroRecursion Macro recursion - Indicates that a syntactically legal macro program

data sequence count not be executed because it would be recursive,

see IEEE 488.2, 10.7.6.6.

-277 std_cantRedefineMacro Macro redefinition not allowed - Indicates that redefining an existing
macro label, see IEEE 488.2, 10.7.6.4.

-278 std_macroNotFound Macro header not found - Indicates that a legal macro label in the

*GMS?, see IEEE 488.2, 10.13, could not be executed because the

header was not previously defined.

-280 std_program Program

-281 std_cantCreateProgram Cannot create program
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-282 std_illegalProgramName Illegal program name

-283 std_illegalVarName Illegal variable name

-284 std_programRunning Program currently running

-285 std_programSyntax Program syntax

-286 std_programRuntime Program runtime

-290 std_memoryUse Memory use

-291 std_execOutOfMemory Out of memory

-292 std_nameNotFound Referenced name does not exist

-293 std_nameAlreadyExists Referenced name already exists

-294 std_incompatibleType Incompatible type

-300 to -399 SCPI Specified Device-Specific Errors

A device-specific error indicates that the instrument has detected an error that occurred because some

operations did not properly complete, possibly due to an abnormal hardware or firmware condition. For

example, an attempt by the user to set an out of range value will generate a device specific error. When

one of these errors is generated, the device specific error bit in the event status register is set.

-300 std_deviceSpecific Device specific - This event bit (Bit 3) indicates that a device operation

did not properly complete due to some condition, such as overrange see

IEEE 488.2, 11.5.1.1.6.

-310 std_system System

-311 std_memory Memory - Indicates some physical fault in the devices memory, such as a

parity error.

-312 std_PUDmemoryLost PUD memory lost - Indicates protected user data saved by the *PUD

command has been lost, see IEEE 488.2, 10.27.

-313 std_calMemoryLost Calibration memory lost - Indicates that nonvolatile calibration data used

by the *CAL? command has been lost, see IEEE 488.2, 10.2.

-314 std_savRclMemoryLost Save/recall memory lost - Indicates that the nonvolatile data saved by the
*SAV command has been lost, see IEEE 488.2, 10.33.

-315 std_configMemoryLost Configuration memory lost - Indicates that nonvolatile configuration
data saved by the device has been lost.

-320 std_storageFault Storage fault - Indicates that the firmware detected a fault when using
data storage. This is not an indication of physical damage or failure of

any mass storage element.

-321 std_outOfMemory Out of memory - An internal operation needed more memory than was

available

-330 std_selfTestFailed Self-test failed - Indicates a problem with the device that is not covered

by a specific error message. The device may require service.
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-340 std_calFailed Calibration failed - Indicates a problem during calibration of the device

that is not covered by a specific error.

-350 std_queueOverflow Queue overflow - Indicates that there is no room in the queue and an

error occurred but was not recorded. This code is entered into the queue

in lieu of the code that caused the error.

-360 std_comm Communication - This is the generic communication error for devices

that cannot detect the more specific errors described for error -361

through -363.

-361 std_parity Parity  in program message - Parity bit not correct when data received

for example, on a serial port.

-362 std_framing Framing  in program message - A stop bit was not detected when data

was received for example, on a serial port (for example, a baud rate

mismatch).

-363 std_inputBufferOverrun Input buffer overrun - Software or hardware input buffer on serial port

overflows with data caused by improper or nonexistent pacing.

-400 to -800 Query and System Errors

A Query error is generated either when data in the instrument's GPIB output queue has been lost, or

when an attempt is being made to read data from the output queue when no output is present or

pending. 

-400 std_queryGen Query - This event bit (Bit 2) indicates that an attempt to read data

from the Output Queues when no output is present or pending, to

data in the Output Queue has been lost see IEEE488.2, 11.5.1.1.7.

-410 std_interrupted Query INTERRUPTED - Indicates the test set has been interrupted

by a new program message before it finishes sending a RESPONSE

MESSAGE see IEEE 488.2, 6.3.2.3.

-420 std_unterminated Query UNTERMINATED - Indicates an incomplete Query in the

program see IEEE 488.2, 6.3.2.2.

-430 std_deadlocked Query DEADLOCKED - Indicates that the Input Buffer and Output

Queue are full see IEEE 488.2, 6.3.1.7.

-440 std_responseNotAllowed Query UNTERMINATED after indefinite response - Indicates that a

query was received in the same program message after a query
requesting an indefinite response was executed see IEEE 488.2,

6.5.7.5.

-500 std_powerOn Power on

-600 std_userRequest User request

-700 std_requestControl Request control

-800 std_operationComplete Operation complete

.
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Analyzer-Specific (Positive) SCPI Errors

100 dupWindNum "Duplicate window number"

101 windNumNotFound "Window number not found"

102 failedWindCreate "Window creation failed"

103 noCalcParamSelection
"CALC measurement selection set to none"  

See CALC:PAR:SEL
104 dupMeasName "Duplicate measurement name"

105 dataNotFound "Requested data not available"

106 measNotFound "Requested measurement not found"

107 traceNotFound "Requested trace not found"

108 notImplemented "Mnemonic not yet implemented"

109 noDocument "No measurement container found"

110 dupTraceNum "Duplicate trace number"

111 titleStrTooLong "Title string exceeds 50 characters"

112 memoryNotFound "Requested memory not found"

113 exceedMaxTraces "Exceeded the maximum number of traces per window"

114 SerNumNotFound
"The serial number was not found. Please store the serial

number."

115 LoadFailed "The state was not loaded. Please check the file name."

116 StoreFailed
"The state was not stored. Please check the file and path

names."

117 File
"An  in the File operation occurred. Please check file and

path names."

118 measChanConflict "Measurement does not belong to specified channel."

119 exceedMaxWindows "Exceeded the maximum number of data windows"

120 markerNotFound "The specified marker was not found."

121 diagnostic "Diagnostic ."

122 channelNotFound "The specified channel was not found."

123 exceedMaxMeasurements "Exceeded the maximum number of allowed mesurements."

124 parameterOutOfRange "The specified value was out of range."

125 userRangeNotValid "The currently selected user range is not valid."

126 referenceMarkerNotFound "The reference marker is not active."

127 sweepSegmentNotFound "The sweep segment was not found."

128 markerNotDelta "The specified marker is not a delta marker."

129 printoutFailed "Attempt to output to a printer failed."

130 memory_trace_not_compatible "Memory not compatible. Trace Math not applied."

131 trace_math_reset "Memory not compatible. Trace Math turned off."

132 hw_read_failed "Hardware read failed."
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133 hw_write_failed "Hardware write failed."

134 dsp_active "Failed because DSP was not halted."

135 secure_memory "Attempt to access secure memory region."

136 snum_protected "The serial number is protected."

137 snum_format_bad "The serial number format is bad."

138 snum_already_set "The serial number is already set."

139 hw_setting_failed "Hardware setting failed."

140 cal_access_failed "Calibration data access failed."

141 db_access_failed "Database access failed."

142 memory_range_exceeded "Command exceeds usable memory range."

143 lost_phase_lock "Phase lock has been lost."

144 over_power "Detected too much power at input."

145 ee_wrt_failed "EEPROM write failed."

146 yig_cal_failed "YTO calibration failed."

147 ramp_cal_failed "Analog ramp calibration failed."

148 dspcom_bad "DSP communication failed."

149 no_license_found "Request failed. The required license was not found."

150 argLimited "The argument was out of range

151 markerBWNotFound "The Marker Bandwidth was not found."

153 peakNotFound "The Peak was not found."

154 targetNotFound "The Target search value was not found."

155 calNotImpl "The Calibration feature requested is not implemented."

156 calClassNotValidForCalType "SENS:CORR:CCH measurement selection set to none"

158 calNotValidForConfidenceChe
"Selected measurement does not have a calibration valid for

Confidence Check"

159 invalidPort "Specified port is out of range"

160 invalidPortPath
 "ROUT:PATH:DEF:PORT  x, y does not match

measurement; setting to defaults"

161 ioInvalidWrite "Attempted I/O write while port set to read only."

162 ioInvalidRead "Attempted I/O read from write only port."

163 calsetNotFound "Requested Cal Set was not found in Cal Set Storage."

164 noCalSetSelected
"There is no Cal Set currently selected for the specified
channel."

165 cantDeleteCalSetInUse "Cannot delete a Cal Set while it is being used."

166 calsetStimChange
"Channel stimulus settings changed to match selected Cal

Set."

167 exceedMaxCalSets "Exceeded the maximum number of cal sets."
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168 calCouldNotTurnOn
"A valid calibration is required before correction can be

turned on."

169 standardMeasurementRequired
 "The attempted operation can only be performed on a

standard measurement type."

170 noDivisorBuffer
"A valid divisor buffer is required before normalization can

be turned on."

171 InvalidReceiverPowerCalParagraph
"Receiver power cal requires the measurement to be of

unratioed power."

172 ecalCouldNotConfigure

"Could not configure the Electronic Calibration system.

Check to see if the module is plugged into the proper

connector."

173 measHasNoMemoryAlg "This measurement does not support memory operations"

174 measHasNoNormalizeAlg "This measurement does not support normalize operations."

175 userCharacterizationNotFound
"User characterization was not found in the Electronic

Calibration module."

176 measInvalidBufferSize
"The data provided has an invalid number of points. It could

not be stored."
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Technical Support

Click on the region of interest.

 

For more contact information, visit http://www.Keysight.com/find/contactus

Other Support Topics

United States:

(tel) (+1) 800-829-4444

(alt) (+1) 303 662 3999

(fax) (+1) 888 900 8921

Canada

(tel) 1 877 894 4414

(fax) 1 (905) 206 4120

Europe:

Austria

(tel) 0820 87 44 11*

(fax) 0820 87 44 22

2166

http://www.Keysight.com/find/contactus


Belgium

(tel) (+32) (0)2 404 9340

(alt) (+32) (0)2 404 9000

(fax) (+32) (0)2 404 9395

Denmark

(tel) (+45) 7013 1515

(alt) (+45) 7013 7313

(fax) (+45) 7013 1555

Finland

(tel) 08 0052 4000

(alt) (+358) 10 855 2100

(fax) (+358) 92 536 0176

France

(tel) 0825 010 700*

(alt) (+33) (0)1 6453 5623

(fax) 0825 010 701*

Germany

(tel) 01805 24 6333*

(alt) 01805 24 6330*

(fax) 01805 24 6336*

Ireland

(tel) (+353) (0)1 890 924 204

(alt) (+353) (0)1 890 924 206

(fax) (+353) (0)1 890 924 024

Israel
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(tel) (+972) 3 9288 500

(fax) (+972) 3 9288 501

Italy

(tel) (+39) (0)2 9260 8484

(fax) (+39) (0)2 9544 1175

Luxemburg

(tel) (+32) (0)2 404 9340

(alt) (+32) (0)2 404 9000

(fax) (+32) (0)2 404 9395

Netherlands

(tel) (+31) (0)20 547 2111

(alt) (+31) (0)20 547 2000

(fax) (+31) (0)20 547 2190

Russia

(tel) (+7) 095 797 3963

(alt) (+7) 095 797 3900

(fax) (+7) 095 797 3901

Spain

(tel) (+34) 91 631 3300

(alt) (+34) 91 631 3000

(fax) (+34) 91 631 3301

Sweden

(tel) 0200 88 22 55*

(alt) (+46) (0)8 5064 8686
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(fax) 020 120 2266*

Switzerland (French)

(tel) 0800 80 5353 opt. 2*

(alt) (+33) (0)1 6453 5623

(fax) (+41) (0)22 567 5313

Switzerland (German)

(tel) 0800 80 5353 opt. 1*

(alt) (+49) (0)7031 464 6333

(fax) (+41) (0)1 272 7373

Switzerland (Italian)

(tel) 0800 80 5353 opt. 3*

(alt) (+39) (0)2 9260 8484

(fax) (+41) (0)22 567 5314

United Kingdom

(tel) (+44) (0)7004 666666

(alt) (+44) (0)7004 123123

(fax) (+44) (0)7004 444555

Japan:

(tel) 0120 421 345

(alt) (+81) 426 56 7832

(fax) 0120 421 678

Latin America:

Mexico

(tel) (+52) 55 5081 9469
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(alt) 01800 5064 800

(fax) (+52) 55 5081 9467

Brazil

(tel) (+55) 11 4197 3600

(fax) (+55) 11 4197 3800

Australia:

((tel) 1800 629 485

(alt) 1800 143 243

(fax) 1800 142 134

New Zealand

(tel) 0 800 738 378

(fax) 64 4 495 8950

Asia Pacific:

China

(tel) 800 810 0189

(alt) (+86) 10800 650 0021

(fax) 800 820 2816

Hong Kong

(tel) 800 930 871

(alt) (+852) 3197 7889

(fax) (+852) 2 506 9233

India

(tel) 1600 112 929
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(fax) 000800 650 1101

Malaysia

(tel) 1800 888 848

(alt) 1800 828 848

(fax) 1800 801 664

Singapore

(tel) 1800 375 8100

(fax) (+65) 6836 0252

South Korea

(tel) 080 769 0800

(alt) (+82) 2 2004 5004

(fax) (+82) 2 2004 5115

Taiwan

(tel) 0800 047 866

(alt) 00801 651 317

(fax) 0800 286 331

Thailand

(tel) 1800 226 008

(alt) (+66) 2 268 1345

(fax) (+66) 2 661 3714
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Licenses

Open Source Software License

JPEG Software Package

This software is based in part on the work of the Independent JPEG Group.  

TightVNC

Redistribution of TightVNC is licensed under the General Public License version 2. Source code of

TightVNC and a copy of the GPLv2 may be found in the directory of \opensource\TightVNC.

Portions of this software are distributed under one or more Open Source terms and are not warranted

and supported by Keysight.  This disclaimer does not affect any statutory rights that may exist in any

country of distribution.  The disclaimed Open Source software portions include the following software

package(s): TightVNC.  The text of the license for each software package is contained in a directory

reflecting the name of the Open Source software that is found in the "\opensource" directory.  The

author and not Keysight grants a license to use and further distribute the Open Source software.  Any

license to use and further distribute the Open Source software is granted by the author(s) of such Open

Source software in their Open Source license, not by Keysight in this license instrument.  The

author(s)’s license terms, if any, are found in text files and, if applicable, the source code of the

separate Open Source software packages.  

TO THE EXTENT PERMITTED BY LOCAL LAW:

Keysight provides the Open Source software listed above "as is" and any express or implied warranties,

including, but not limited to any warranty of non-infringement, the implied warranties of

merchantability, satisfactory quality, reasonable care and skill, and fitness for a particular purpose are

expressly disclaimed; and

Keysight shall not be liable for any direct, indirect, incidental, special, exemplary, or consequential

damages (including: procurement of substitute goods or services; loss of use, data, or profits; or
business interruption) arising from the use of open source software, however caused and regardless of

whether such claims are based upon contract, strict liability or tort (except gross negligence or willful
misconduct of Keysight), or any other legal theory even if advised of the possibility of such damage

and even if it has been ensured that such data can be reconstructed with reasonable expenditure from
data material provided in machine-readable form.

Commercial Software License

MathWorks MATLAB Complier Runtime v7.14
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MathWorks MATLAB Compiler ; Permission to use the MatLab MCR library is defined in a license

agreement between MatLab and you, the Licensee.  A copy of the license agreement may be found in

“c:\Program Files (x86)\MATLAB\MATLAB Compiler Runtime” directory.
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Diagnostic Tools, Utilities, and Adjustments

The following Tools, Utilities, and Adjustments are available to help you keep your VNA at peak

performance.

Diagnostic Tools

Operators Check

System Verification

Utilities

Receiver Display

Restore ECal Memory

Receiver Temperature

Adjustments

Not all of the adjustments listed below are valid for every VNA model. Only the adjustments needed

for each particular VNA will be listed.

To access the service adjustments on the VNA, click Utility, then System, then Service, then

Adjustment Routines...
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10 MHz Reference Frequency Adjustment

Source Adjustment

Loop Bandwidth Adjustment

System Receiver Cal
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System Verification

The performance of the network analyzer is specified in two ways: system specifications, and

instrument specifications. It is the end user’s responsibility to determine which set of specifications is

applicable to their use of the analyzer.

A network analyzer measurement “system” includes the analyzer, calibration kit, test cables, and any

necessary adapters. The system verification software in the analyzer is used to verify the system’s

conformance to the “system” specifications. A “pass” result demonstrates that the analyzer, test cables,

and adapters, perform correctly as a system. It DOES NOT demonstrate that any one component

performs according to its individual specifications. A change to any part of this measurement system

requires a re-verification of the system.

Instrument specifications specify the network analyzer’s uncorrected measurement port characteristics

and its output and input behavior. The analyzer performance tests are used to verify the analyzer’s

conformance to “instrument” specifications.

The system verification utility verifies the analyzer system specifications by automatically measuring

the magnitude and phase for all four S-parameters for each verification device, and comparing the

values against the following:

Factory measured data from files on the verification disk

Limit lines based on the measurement uncertainty

System Verification requires the use of a calibration kit and verification kit which has been certified

within the past 12 months by Keysight. System Verification can NOT be used to perform this kit

certification.

Operator's Check should also be performed to verify the basic operation of the analyzer.

Equipment Used in the System Verification

Precautions for Handling Airlines

Flow Diagram of Procedure

Procedure for System Verification

If the System Fails the Verification Test

Interpreting the Verification Results
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Notes

Although the performance for all S-parameters is measured, the S-parameter phase uncertainties are
less important for verifying system performance. Therefore, the limit lines will not appear on the printouts.

System Verification can NOT be run with a Multiport test set enabled. However, you can run a
performance check as described in the Test Set User's Guide. See the N44xx User's Guide.

Equipment Used in the System Verification

VNA Models with 3.5 mm test ports

Equipment Type 3.5 mm Type-N

Calibration kit

or

ECAL Module

85052B/C/D

N4691A

85054B/D

N4690A

Verification kit 85053B 85055A

RF Cable(s) Single: 85131C/E

Pair: 85131D/F

Single: 85132C/E

Pair: 85132D/F

Adapters None Single: 85130C and one 7mm-to-Type-N from

85054B cal kit

Pair: Two 7mm-to-Type-N from 85054B cal kit

Cable Substitution

The test port cables specified for the analyzer have been characterized for connector repeatability,

magnitude and phase stability with flexing, return loss, insertion loss, and aging rate. Since test port

cable performance is a significant contributor to the system performance, cables of lower performance

will increase the uncertainty of your measurement. It is highly recommended that the test port cables be

regularly tested.

If the system verification is performed with a non-Keysight cable, ensure that the cable meets or

exceeds the operation of the specified cable. Refer to the cable User's Guide for specifications.

Cable Flex Factor

Flex Factor determines how much of the cable phase uncertainty to include in determining the limit

lines.  

Set to 0% (zero) if the cables are held down in a fixture and are not allowed to move during the calibration
and verification.
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Set to 100% if the cables are allowed to move a lot.

Calibration Kit Substitution

Non-Keysight calibration kits are not recommended nor supported.

Precautions for Handling Airlines

When you are using the airlines in the verification kit, observe the following practices to ensure good

measurement techniques.

Be very careful not to drop the airline's center or outer conductor. Damage will result if these devices are
dropped.

Use proper Electro-Static Discharge (ESD) procedures.

Clean your hands or wear gloves as skin oils will cause a change in electrical performance.
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Flow Diagram of Procedure

The operational flow of the software is depicted by the flowchart shown below.
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Procedure for System Verification

If you want printed test outputs, connect a printer to the analyzer. Let the analyzer warm up for at least 30
minutes.

1.

2.

3.
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1.

Insert the verification kit floppy disk into the analyzer disk drive.2.

Press System > Service > Verification > System Verification . The System Verification window similar to
this will be displayed.

3.

System Verification Dialog

In the Calibration Kit box, select the calibration kit or ECal module that is being used. The corresponding
verification kit to use appears in the Verification Kit box.

4.

Under Printer Output click on any of the following options.

Print Tabular Data: Prints the verification data in tabular form which includes measured data and
uncertainty limits. Refer to a tabular data example, later in this topic.

Print Graphs: Prints the verification data in graphical form. The graphic form includes the measured
data trace, factory supplied data trace and uncertainty limits. Refer to a plot data example, later in this
topic.

File Tabular Data: Writes the verification data in tabular form to a text file in the D:\ directory.

File Graphs: Saves a screen image in .PNG format in the D:\ directory.

5.

Note: If you want printed output, it is assumed you have already installed the Windows driver for your

particular printer, and have tested that you can print to the printer from the network analyzer. This

software is designed to print to whichever printer is currently set as the Default printer (see Printers in

the Windows Control Panel).

6.

2181



To modify the number of ports to be verified, to change the number of devices to measure, or to use a
previously stored verification calibration, click on the Configure tab and make the desired selections.

For the system verification to be truly adequate, the software must measure all devices in the kit with a
recent calibration applied. Removing and reattaching any test port cables or adapters invalidates all
previous calibrations.

6.

Click Run.7.

Follow the instructions on the analyzer for performing the system verification, inserting the verification
devices as prompted.

8.

Note for 3 Port analyzer:

The System Verification Procedure is repeated three times. The first time, Ports 1 and 2 are

measured as a pair; then Ports 1 and 3 are measured; and lastly, Ports 2 and 3 are measured.

Note for 4 Port analyzer:

The System Verification Procedure is repeated two times. The first time, Ports 1 and 2 are measured

as a pair, then Ports 3 and 4 are measured.

Step-by-Step Process Description

Depending upon the selected choice in the Calibration submenu of the Configure menu, the user is either
prompted to recall a previous calibrated instrument state, or is guided through a full 2-port calibration using
the selected calibration kit. For ECal, the ECal module is connected just once; a standby message is posted
while the software is performing the calibration.

1.

The user is prompted to connect the first verification device.2.

The software reads the factory measured data for that device and uncertainty values for that data (CITIfiles)
from the floppy disk supplied with the verification kit.

3.

The software sends the factory measured data, calibration kit and instrument state information to the
uncertainty calculator DLL, which generates uncertainty values specific to the analyzer.

4.

The analyzer first sets up for magnitude measurements of all four S-parameters, each parameter in a
separate window (lin mag for S11 and S22, log mag for S21 and S12). Each of the factory measured S-
parameters are fed to the appropriate window as a memory trace. Limit line offsets are calculated as the sum
of the factory measured data uncertainties and analyzer uncertainties reported by the DLL. Upper and lower
limits are displayed (factory measured data + uncertainty sum, factory measured data - uncertainty sum). The
analyzer takes a sweep, limit test is turned on and PASS/FAIL status is reported in each of the four windows.

5.

The user clicks a button when ready to view phase measurements. The four windows get updated for phase
format, phase memory traces, phase limits and PASS/FAIL result.

6.

If the limit test of any of the four S-parameters (magnitude or phase) indicates a FAIL status, the software
suggests troubleshooting tips and asks if the user would like to repeat measurement of that device or
proceed to the next device. If proceeding to the next device, the factory measured data and uncertainties for

7.
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the next device are read from floppy, the uncertainty DLL gets called with this next set of factory measured
data, and the four measurement windows get updated for magnitude measurement of the next device.

7.

The software follows this same process until all selected devices have been measured, at which point a
summary window is displayed containing the set of PASS/FAIL results for all four parameters of each device.

8.

If the System Fails the Verification Test

IMPORTANT: Inspect all connections. Do not remove the cable from the analyzer test port. This will

invalidate the calibration that you have done earlier.

Repeat this verification test. Make good connections with correct torque specifications for each verification
device.

1.

Disconnect, clean and reconnect the device that failed the verification test. Then measure the device again.2.

If the analyzer still fails the test, check the measurement calibration by viewing the error terms as described
in "Front Panel Access to Error Terms" on page 4-7 of the Service Guide.

3.

Refer to the graphic below, for additional troubleshooting steps.4.

Verification Fails Flowchart
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Interpreting the Verification Results

The graphic below shows an example of typical verification results with Tabular Data selected in the

Printer Output area of the System Verification window. A graphic later in this topic shows an

example of typical verification results with Measurement Plots selected in the Printer Output area of

the System Verification windows. These printouts include a comparison of the data from your

measurement results with the traceable data and corresponding uncertainty specifications. Use these

printouts to determine whether your measured data falls within the total uncertainty limits at all

frequencies.

The tabular data consists of:

Frequency of the data points (in MHz).

Lower limit line as defined by the total system uncertainty specification.

Results of the measurement.

Upper limit line as defined by the total system uncertainty specification.

Test status (PASS or FAIL) of that measurement point.

Printout of Tabular Verification Results

 

The printed graphical results show:
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Upper limit points as defined by the total system uncertainty specifications.

Lower limit points as defined by the total system uncertainty specifications.

Data measured at the factory.

Results of measurements.

Measurement parameter names and formats (Lin Mag or Log Mag).

Serial number of device (00810).

Device being measured (Sys Ver 20 dB attenuator).

Printout of Graphical Verification Results
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Operator's Check

Overview

How to Run the Operator's Check

Operators Check Dialog Box Help

Tip: Use Move App to Back to cause the VNA application to move behind this application on the

screen.

Overview

The Operator's Check should be performed when you first receive your VNA, and any time you wish to

have confidence that the VNA is working properly.

Notes

The Operator's Check does not verify performance to specifications. To verify VNA performance to
specifications, run System Verification.

Allow the VNA to warm up for 30 minutes before considering a failed test to be valid.

How to Run the Operator's Check

Using Hardkey/SoftTab/Softkey

Press System > Service > Verification > Operator's Check.1.

Follow the instructions to proceed with the test.1.

M937xA
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This dialog box will look slightly different, depending on VNA model number and installed options.

Some of the tests are not run if the appropriate option is not installed.

To learn about how each test is performed, click one of the tests on the right of the dialog  For example,

the following information dialog is launched when Leveling is clicked:
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Operators Check dialog box help

Note: It is normal for a momentary unleveled condition to appear during portions of the Operators

Check.

Configure

Prompt for attachment of Short / Open   If you do not have enough shorts or opens for all test

ports, you will be prompted to move the standard to the next test port. Connect either a short or

open to port 1, then click Begin.

Shorts / Opens are attached to all ports   Connect either a short or open for each test port, then

click Begin. All ports are tested without interruption. You can mix shorts and opens on the test

ports.

VNA   Shows information about the VNA that is being tested.

Legend   Shows the status icons used in the Operator's Check and their meaning. Pending

Pass means that a portion of the testing has been completed successfully.

Results   Shows the current status of each test. Click on the test name to learn how that test is

performed. This may help in troubleshooting failed tests. If any tests Fail, refer to Chapter 3

of the VNA service guide.

Begin   Starts the Operator's Check.

View Results  Shows all results in text format.  Failed items are preceded by ===>>>.

This text file can be printed or saved with a unique file name to compare results with previous or

subsequent testing.

Exit   Ends the program and closes the window.

M9485A

The Operator's Check is executed at power on at default. It can be selected at preference. If some tests

are failed, see Trobleshooting Hint for M9485A
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Troubleshooting Hint for M9485A

Trouble on Launcher

When you encounter a problem on the M9485A launcher such as the modules cannot be displayed,

execute the following steps.

Close the M9485A SFP launcher.1.

Execute the Connection Expert.2.

Click "Rescan" button at the top left in the Instrument tab.3.

Execute the M9485A SFP launcher.4.

If it is still not resolved, reboot the system (chassis and PC).5.

If it is still not resolved, reinstall the IO library.6.

Operator's check or Start up Self Test Fail

When the operator's check or start up self test is failed, read the dialog message and check the cable

connection first. The cable connection includes not only cable itself but also the divider and smp-smp

adapter which connects between receiver modules and divider.

The operator's check consists of the following three parts.

Module Check

Digital Connection Check

Analog Connection Check

The following figure shows the flow. When a test is failed, an error message is displayed and store the
failed information into the log file.
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Digital Connection Check

PXI Local Bus

When you have this error, replace the module into the other slot. If the failed slot is still the same, the
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chassis is suspicious.

Front Panel

Check the front panel cable connections.

Back Plane

Check the Connection Expert to confirm if the chassis is detected correctly.

When you are using non-keysight chassis and digital connection test failed, check the trigger bus

routing of chassis. See FAQ of M9485A in the Keysight web page for non-Keysight chassis setup. The

trigger bus routing for the Keysight chassis is defined automatically, however, check the chassis SFP to

confirm if the trigger bus routing is correct. Refer to the Trigger Bus Routing below. If it is not correct,

see Trouble_on_Launcher .

Module and Analog Connection Test

If multiple failures occur, open the M9485A_SelftestLog.txt under C:\Users\Public\Public

Documents\Network Analyzer. Check the failed test number (Rx, Sx or Lx) in the log file. See the

following tables to find out the failure point.

1-Chassis Configuration  

Trigger Bus Routing

2-Chassis Configuration

Trigger Bus Routing

Here are notes for troubleshooting.

When both module and analog connection checks are failed at the same time, refer to the module

test first and check it. When both Sxx and Lxx are filed at the same time in analog connection

check, refer to Lxx first and check it. If it seems good, refer to Sxx result.

When PXI trigger bus connection test is failed, confirm if the Connection Expert detects the

chassis by clicking "Rescan" in its Instrument tab, then restart Soft Front Panel (SFP) again. If it

is still failed, the chassis may have problem. If you are using non-Keysight chassis, see FAQ of

M9485A in the Keysight web page for non-Keysight chassis setup.

When the self test is passed but the absolute measurement is noisy, confirm if the unused output

ports on the M9340A are terminated with 50 Ω loads.

If you have some same modules, swapping the modules will help to isolate the module.
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1-Chassis Configuration

***: Most suspicious, ** : Middle, *: Low

F: Fail, Blank: Pass, NC: Pass or Fail

Reference Test

R6: M9309A Synthesizer Module 100MHz Output Test  (Left one, for source signal)

R7: M9310A Source Output Module 100MHz Input Test

Test

No.
Suspicious Points

R6 R7
M9309A (Left

one, Source)

Connection between

M9309A (Left one, Source)

and M9310A

M9310A

F F ***    

  F   ** *

R11: M9376A/M9377A Receiver Module{1-12} 100MHz In 100MHz Input Level Test

R12: M9376A/M9377A Receiver Module{1-12} 100MHz In 100MHz Input Frequency Test

Test

No.
Suspicious Points

R11 R12

Connection between

M9300A and

M9376A/M9377A

M9376A/M9377A

F F ** *

  F ***  
Source Test

S19: M9310A Source Output Module Output Amp Test1

S20: M9310A Source Output Module Output Amp Test2

S4: M9340A Distributor Module A In Source Input Level Test

S5: M9340A Distributor Module A In Source Frequency Test

S6: M9340A Distributor Module A Out1/2/3 Source Output Test

S7: M9376A/M9377A Receiver Module{1-12} Source In Source Input Test
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S8: M9376A/M9377A Receiver Module{1-12} Source Connection Test

S9: M9376A Receiver Module{1-12} Test Port Test (No test for M9377A)

Test No. Suspicious Points

S19 S20 S4 S5 S6 S7 S8 S9 M9310A

Connection

between

M9310A and

M9340A

M9340A

Connection

between M9340A

and

M9376A/M9377A

M9376A/M9377A

F F F F F F F F ***        

  F F F F F F F ***        

    F F F F F F * ** *    

      F F F F F   ***      

        F F F F     ***    

          F F NC         ***

            F NC       ***  

              F         ***

          F   NC       ***  
LO Test

L1: M9309A Synthesizer Module LO Output Test (Right one, for LO signal)

L2: M9340A Distributor Module B In LO Input Level Test

L3: M9340A Distributor Module B In LO Input Frequency Test

L4: M9340A Distributor Module B Out1/2/3 LO Output Test

L5: M9376A/M9377A Receiver Module{1-12} LO In LO Input Test

L6: M9376A/M9377A Receiver Module{1-12} LO In LO Connection Test
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Test No. Suspicious Points

L1 L2 L3 L4 L5 L6

M9309A

(Right

one, LO)

Connection

between

M9309A

(Right one,

LO) and

M9340A

M9340A

Connection

between M9340A

and

M9376A/M9377A

M9376A/M9377A

F F F F F F ***        

  F F F F F   ** *    

    F F F F   ***      

      F F F     ***    

        F F         ***

          F       ***  

        F         ***  

 

Cable Connections for M9376A configuration

If your configuration includes M9377A, refer to the installation guide.

 

 

Chassis Trigger Bus Routing
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When the number of receivers is equal and more than 7, the red arrows should be connected.

2-Chassis Configuration

***: Most suspicious, ** : Middle, *: Low

F: Fail, Blank: Pass

Chassis A: has M9310A and M9309A

Chassis B: has M9300A

Note: Refer to PXI/AXIe Chassis tab in Keysight Connection Expert for chassis No. 1 or 2 in the error

message.

Reference Test

R6: M9309A Synthesizer Module 100MHz Output Test (Left one, for source signal)

R7: M9310A Source Output Module 100MHz Input Test

2195



Test

No.
Suspicious Points

R6 R7
M9309A (Left

one, Source)

Connection between

M9309A (Left one, Source)

and M9310A

M9310A

F F ***    

  F   ** *

R13: M9340A Distributor Module{1,3} B In 100MHz Input Level Test

R14: M9340A Distributor Module{1,3} B In 100MHz Input Frequency Test

R15: M9340A Distributor Module{1,3} B Out1/2/3 100MHz Output Test

R11: M9376A/M9377A Receiver Module{1-24} 100MHz In 100MHz Input Level Test

R12: M9376A/M9377A Receiver Module{1-24} 100MHz In 100MHz Input Frequency Test

Test No. Suspicious Points

R13 R14 R15 R11 R12

Connection

between

M9300A

and

M9340A

(Left one in

Chassis A

or Chassis

B)

M9340A

(Left one in

Chassis A or

Chassis B)  

Connection

between M9340A

(Left one in

Chassis A or

Chassis B)  and

M9376A/M9377A

M9376A/M9377A

F F F F F ** *    

  F F F F ***      

    F F F   ***    

      F F     ** *

        F     ***  
Source Test

S19: M9310A Source Output Module Output Amp Test1

S20: M9310A Source Output Module Output Amp Test2

S10: M9340A Distributor Module1 A In Source Input Level Test
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S11: M9340A Distributor Module1 A In Source Input Frequency Test

S12: M9340A Distributor Module1 A Out1/2/3 Source Output Test

Test No. Suspicious Points

S19 S20 S10 S11 S12 M9310A
Connection between M9310A and

M9340A (Left one in Chassis A)

 M9340A (Left one

in Chassis A)

F F F F F ***    

  F F F F ***    

    F F F * ** *

      F F   ***  

        F     ***

S4: M9340A Distributor Module{2,4} A In Source Input Level Test

S5: M9340A Distributor Module{2,4} A In Source Frequency Test

S6: M9340A Distributor Module{2,4} A Out1/2/3 Source Output Test

S7: M9376A/M9377A Receiver Module{1-24} Source In Source Input Test

S8: M9376A/M9377A Receiver Module{1-24} Source Connection Test

S9: M9376A Receiver Module{1-24} Test Port Test (No test for M9377A)

2197



Test No. Suspicious Points

S4 S5 S6 S7 S8 S9

Connection

between

M9340A

(Leftt one in

Chassis A)

 and M9340A

(Right one in

Chassis A

and B)

M9340A

(Right

one in

Chassis

A and B)

 Connection

between  M9340A

(Right one in

Chassis A and B)

and

M9376A/M9377A

M9376A/M9377A

F F F F F F ** *    

  F F F F F ***      

    F F F F   ***    

      F F NC       ***

        F NC     ***  

          F       ***

      F   NC     ***  
LO Test

L1: M9309A Synthesizer Module LO Output Test (Right one, for LO signal)

L7: M9340A Distributor Module3 A In LO Input Level Test

L8: M9340A Distributor Module3 A In LO Input Frequency Test

L9: M9340A Distributor Module3 A Out1/2/3 LO Output Test

Test No. Suspicious Points

L1 L7 L8 L9 M9309A (Right one, LO)

Connection

between

M9309A

(Right one

in Chassis

A)  and

M9340A

(Left one

in Chassis

B)

M9340A

(Left

one in

Chassis

B)

F F F F ***
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  F F F   ** *

    F F   ***  

      F     ***

L2: M9340A Distributor Module{2, 4} B In LO Input Level Test

L3: M9340A Distributor Module{2, 4} B In LO Input Frequency Test

L4: M9340A Distributor Module{2, 4} B Out1/2/3 LO Output Test

L5: M9376A/M9377A Receiver Module{1-24} LO In LO Input Test

L6: M9376A/M9377A Receiver Module{1-24} LO In LO Connection Test

Test No. Suspicious Points

L2 L3 L4 L5 L6

Connection

between M9340

(Right one in

Chassis B)  and

M9340A (Left

one in Chassis

B)  

M9340A (Right

one in Chassis

A and B)  

Connection

between M9340A

(Right one in

Chassis A and B)

 and

M9376A/M9377A

M9376A/M9377A

F F F F F ** *    

  F F F F ***      

    F F F   ***    

      F F       ***

        F     ***  

      F       ***  
 

Cable Connections for M9376A configuration

If your configuration includes M9377A, refer to the installation guide.
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Chassis Trigger Bus Routing

Chassis A
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When the number of receivers is equal and more than 6, the arrows in red circle are not connected.

Chassis B
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When the number of receivers is equal and more than 6, the arrows in red circle are not connected.

Last modified:

31-Mar-2017 New topic
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10 MHz Reference Frequency Adjustment

This routine adjusts the analyzer's internal time-base to exactly 10 MHz by changing a DAC value.

This DAC value is stored in the analyzer's non-volatile memory. This routine should only be necessary

in the following situations:

The frequency reference assembly is replaced.

The 10 MHz reference has drifted significantly from the factory adjusted value.

WARNING: The range of this adjustment is only about 20 Hz. It is highly recommended that a very

accurate frequency standard be used to measure this 10 MHz signal.

NOTE: The is not available for E5080A and M9485A. An adjustment software is provided as an

external software.

Frequency Counter Compatibility

This procedure uses SCPI commands (over GPIB) to communicate with the frequency counter. It

should work with the Keysight R5313xA, 5315xA, 53181A series of counters as well as the older 5350

series.

If no compatible counters are available, select the "Manual" mode of operation.

Procedures

Note: You must be logged onto the VNA as an Administrator to perform an adjustment. Learn more.

Click Utility, then System, then Service, then Adjustment Routines...

At the Adjustments selection, click10 MHz Frequency Adjustment

Procedure for GPIB Counters Only

Connect the analyzer rear panel 10 MHz Reference output to the frequency counter .1.

Connect a GPIB cable from the analyzer to the counter. Make sure no other controllers are active on the
same connection.

2.

If applicable, connect the house frequency standard to the counter reference input.3.

Set the counter GPIB address to 03. Ensure that the counter is the only device at this address.4.

5.

6.
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3.

4.

On the VNA, press System > Service > Adjustment Routines..., then 10 MHz Freq. Adjust..5.

Click Begin Adj. The application adjusts the internal reference for minimal error and stores the results.6.

Click Read Freq to trigger another reading of the 10 MHz signal.7.

Read the current DAC value stored in the analyzer's non-volatile memory (value = 0 - 4095).8.

When the status area indicates the adjustment is complete, click  Exit.9.

Procedure for Non-GPIB Counters

Connect the counter input to the rear panel 10 MHz Reference Output.1.

Set the counter to at least 1 Hz resolution.2.

If applicable, connect the house-frequency standard to the counter reference input.3.

In the analyzer System > Service > Adjustment Routines..., then click 10 MHz Freq. Adjust.4.

Under Frequency Counter, select Manual.5.

Adjust the slider bar arrows until the frequency counter reads 10.0 MHz at your desired level of accuracy.

Click Exit to save the results.

Data Storage

The correction data is stored in the EEPROM on the 10MHz Ref board assembly.

Note: If the counter is misreading the frequency, it may be necessary to attenuate the input, or set the

input impedance to 50 ohms, or both.
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Source Adjustment

Source Adjustment is a SERVICE Routine which should be performed when a component in the

source chain is replaced, or when the VNA fails an annual calibration. It adjusts the VNA source power

for flatness across its full frequency range.

This topic does NOT discuss Source Power Calibration, which calibrates a VNA source over the current

measurement range.

NOTE: The is not available for E5080A and M9485A. An adjustment software is provided as an

external software.

Required Equipment

Note: The power sensor depends on the VNA frequency range. Depending on the VNA model, two

power sensors may be required to test the full frequency range. The VNA front panel connector type

will determine the cable used and if an adapter is required with the power sensor(s).

See list of supported power meters and sensors.

See VNA Accessories

Procedure

Note: You must be logged onto the VNA as an Administrator to perform an adjustment. Learn more.

Refer to your power meter documentation to ensure the proper calibration factors for the power sensor have
been entered into the table on the power meter.

1.

Connect a GPIB cable between the power meter and network analyzer (use the System Controller GPIB port
if applicable.)

2.

Ensure the power sensor(s) are connected to the power meter.3.

Click Utility, then System, then Service, then Adjustment Routines...4.

At the Adjustments selection, click Source Adjustment.5.

There are 3 different version of the Source Calibration software; all are slightly different. All have a button
that is labeled "Calibrate" or "Adjust". This is the button that will begin the calibration process. Some versions
will also have a button labeled "Verify" that will test the source calibration without making any changes. Other
selections are for factory personnel use only.

6.

Once begun, you must enter the power meter and sensor information. The software will verify the power
meter and sensor. You are then prompted to connect the sensor(s) and cable as needed.

7.
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7.

Additional Information

All ports are tested on all VNAs. Source calibration takes approximately 10 to 45 minutes to complete

depending on the frequency range and model number of the VNA.

Troubleshooting

In the event there is a problem with Source Adjustment, please refer to the "Troubleshooting" chapter

in the VNA Service Guide.

Data Storage

The correction data is stored in the flash memory on the Test Set Mother Board.
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Receiver Adjustment

This program adjusts the network analyzer receivers for a flat response across its full frequency range.

This adjustment is for service only; not for measurement calibration.

NOTE: The is not available for E5080A and M9485A. An adjustment software is provided as an

external software.

Required Equipment

See list of supported power meters and sensors.

See VNA Accessories

 

Notes

The power sensor depends on the VNA frequency range. Depending on the VNA model, two

power sensors may be required to test the full frequency range. The VNA front panel

connector type will determine the cable used and if an adapter is required with the power

sensor(s).

In this adjustment, a power sensor with a specified lower frequency limit of 50 MHz may be used on all
instrument that have a lower frequency limit of 10 MHz.  Any added uncertainty is negligible.  

If using an older style sensor (without built-in correction factors), refer to your power meter documentation
to ensure the proper calibration factors for the power sensor have been entered into a table on the power
meter.

You must be logged onto the VNA as an Administrator to perform an adjustment. Learn more.

Procedure

Click Utility, then System, then Service, then Adjustment Routines...1.

At the Adjustments selection, click Receiver Adjustment.2.

Connect a GPIB cable between the power meter and network analyzer.3.

Ensure the power sensor(s) are connected to the power meter.4.

The software presents you with two choices:5.

a.
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5.

Click Inspect Flatness to observe flatness of receiver response versus frequency. Although there is no
explicit specification for receiver flatness, Receiver Calibration should improve Transmission and
Reflection Tracking error terms which are specified.

a.

Click Calibrate to begin the receiver calibration process. The software prompts you to connect the
sensor(s), cable and adapter as needed.

b.

Additional Information

Receiver Adjustment tests all VNA receivers, taking approximately 15 and 45 minutes. Length is dependent
on frequency range and number of ports.

Upon completion of the Receiver Adjustment, a transmission measurement of a good quality cable should
appear to be smooth, with slightly increasing loss versus frequency.  A reflection measurement of a short or
open should appear to be a flat line across the entire frequency range with only a dB or two of
variation/ripple.  If instead, you see variations of 10-40dB, then the VNA may have a mixer problem.
 Typically, this means the uncorrected low end frequency phase relative to other receivers is different.  This
causes the correction algorithm to "blow up" and provide wildly incorrect data.  This is almost always a
hardware problem and typically one or more receivers must be replaced.   The adjustment procedure has a
quick test for this and it will show a warning message if excess phase shift is detected, however this test is
not definitive and may not always catch every problem.

Troubleshooting

In the event there is a problem with Receiver Adjustment, please refer to the "Troubleshooting" chapter

in your VNA Service Guide.

Data Storage

The correction data is stored in the flash memory on the Test Set Mother Board.
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Receiver Display

The Receiver Display as a Troubleshooting Tool

How to start the Receiver Display

NOTE: The is not available for E5080A and M9485A. An adjustment software is provided as an

external software.

Other Support Topics

The Receiver Display as a Troubleshooting Tool

The Receiver Display is a Troubleshooting Tool. It enables the analyzer to isolate faulty functional

groups within its own Measurement System. Traces for each Receiver are Displayed in individual

windows. Identifying discrepancies of the traces in these windows can help isolate the faulty assembly.

For a thorough description of Receiver Display and the troubleshooting steps see the Service Guide for

your VNA. You can download the Service Guide from our website: http://na.support.keysight.com/pna/ or
http://na.support.keysight.com/pxi/

How to Start the Receiver Display

Using Hardkey/SoftTab/Softkey Using a mouse

Press System > Service > Diagnostics > Receiver Display...1. Click Utility1.

Select System2.

Select Service3.

Select Diagnostics4.

Select Receiver Display...5.
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RF Amplifier Module Control

When you use the M9485A, you can control the M9379A amplifiers through the VNA firmware if the

M9379As are included at launcher.

The Atten, Path, and Switch can be set independently for each channel when the connection for sync

signal is made. Refer to  Handler I/O Connector (M9485A). The independent settings (Atten/Path/Switch)

for sweep segment are not possible.

WARNING:  When connecting or disconnecting a cable to the module, do not touch the open end of

the cable. Doing so may damage the module by electrostatic discharge (ESD).

Note: Place M9379A at just right after M9376A/7A/8AB, M9341A/B or M9161D modules or between

them. Empty slot or the M9485A unsupported modules (other than M9376A/7A/8AB, M9341A/B,

M9161D) is not allowed to locate between M9340A and M9379A.   

How to Control RF Amplifier Module

 

Using Hardkey/SoftTab/Softkey Using a mouse

Press Setup > Internal Hardware > PXI Device...1.

Click M9379 Amp Setup.. to control the M9379A amplifier.2.

Click Instrument1.
Select Setup2.

Select Internal Hardware3.

Select PXI Device..4.

Select  M9379A Amp Setup..5.

 

M9379A Amp Setup dialog box help
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Turn on M9379A amps for all channels: Master switch for all amplifiers and switch of all

M9379A modules. LED on the front panel is changed as follows.

ON: Dark green

OFF: Light green

Note: 45-minute warm up time after this switch ON is required to meet the specification accuracy.

Enable Switch/Path/Atten control for Channel n: The settings are applied for the selected

channel. The setting of Switch/Path/Atten is independent for each channel.

Name: Module number.

Chassis: Chassis number where the module is located.

Slot: Slot number where the module is located.

Atten: Attenuator setting for the amplifier 1. This can be set from 0 to 28 dB with 2 dB step.

Path: Path for amplifier 1. Select Thru or Amp. When Noise Figure Cold Source is selected as

Meas Class,  NF Port n can be selected.

NF Port n: The switch is used for pre-amp/thru selection between DUT and test port n. The

Thru is selected during S parameter measurement. The Amp is selected during NF
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measurement.

Switch: Path for switch. Select A or B. When Noise Figure Cold Source is selected as Meas Class,

NF RF OUT, NF LO2 or NF Port n can be selected.

NF RF OUT: The switch is used as RF Out switch to terminate the DUT input with 50 ohm.

RF out should be connected with port A. 50 ohm termination should be connected with port B.

The port A is selected during S parameter measurement. The port B is selected during NF

measurement.

NF LO2: The switch is used as Local selection for dual band NF measurement. (Option 720

only)

NF Port n: The switch is used for pre-amp/thru selection between DUT and test port n. The

port A is selected during S parameter measurement. The port B is selected during NF

measurement.

Note: Control the gain of M9379A properly in order to avoid saturation and overload from

receivers due to amplified source signal noise by the M9379A. When the M9379A Amp1 is used

with the M9377A DRA modules (receiver attenuator = 0 dB), It is recommended that the M9379A

Amp1 attenuator sets at 10 dB or above. When the M9379A Amp2 is used, inserting 10 dB

attenuator between Amp2 and the M9377A is recommended.

Limitations

Changing the M9379A settings does not affect the error correction level notation on the status bar.

The correction level is not changed even if the M9379A settings are changed. However, the

M9379A setting may affect the correction. In that case, re-calibration is recommended.

The state file can be recalled even if the number of M9379A module on save is different. When

more M9379A modules are installed at recall, the additional modules are set at default. The slot

number and M9379A serial number are not saved into the state file. Hence, the state is recalled

even if you install it into any other slot or the other M9379A module. The M9379A configuration

change does not affect the error correction level notation. Re-calibration may be required if your

M9379A configuration is different from the time of save.

2213



Switch Module Control

When you use the M9485A and M937xA, you can control the M9161D PXI Solid State Dual SP4T

Switch Module through the VNA firmware if the M9161Ds are included at launcher.

The switch can be set independently for each channel. The independent settings for sweep segment are

not possible. In NF measurement, the switch can be controlled automatically between S Parameter and

NF measurement.

Note: Place M9161D at just right after M9376A/7A/8AB, M9341A/B, M9379A modules or between

them.. Empty slot or the M9485A unsupported modules (other than M9376A/7A/8AB, M9341A/B,

M9379A) is not allowed to locate between M9340A and M9161D.  

How to Control RF Amplifier Module

 

Using Hardkey/SoftTab/Softkey Using a mouse

Press Setup > Internal Hardware > PXI Device...1.

Click M9161D Switch Setup.. to control the PXI switch.2.

Click Instrument1.
Select Setup2.

Select Internal Hardware3.

Select PXI Device..4.

Select  M9161D Switch Setup..5.
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PXI Switch Setup dialog box help

Enable Switch/Path/Atten control for Channel n: The settings are applied for the selected

channel. The setting of Switch/Path/Atten is independent for each channel.

Name: Module number.

Chassis: Chassis number where the module is located.

Slot: Slot number where the module is located.

Switch1, Switch2: Path for switch 1. 1, 2, 3 or 4. When Noise Figure Cold Source is selected as

Meas Class, Auto RF OUT, Auto LO2 or Auto NF Port n can be selected.

Auto RF OUT: The switch is used as RF Out switch to terminate the DUT input with 50

ohm. RF out should be connected with port 1 and 50 ohm termination should be connected

with port 2. The port 1 is selected during S parameter measurement. The port 2 is selected

during NF measurement.

Auto LO2: The switch is used as Local selection for dual band NF measurement. (Option 720

only)

Auto NF Port n: The switch is used for pre-amp/thru selection between DUT and test port n.

The port 1 is selected during S parameter measurement. The port 2 is selected during NF

measurement.
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DUT Control and 8 bit Digital I/O

M9485A/M937xA with M9341B can control the device under test (DUT) directly with serial or

parallel digital signals. For example, the signals from the M9341B can be applied to select operation

modes of the RF front-end module which integrates power amplifiers, switches, low noise amplifiers,

duplexer or filters in a single component. The operation can be synchronized with the sweep of VNA

measurement.

Signa from 8-bit I/O can provide up to 4-channels RFFE-like interface with software selectable clock

rate (25 MHz maximum).

The following five commands are supported.

Register 0 Write

Register Read

Register Write

Extended  Register Read

Extended Register Write

See also

M9341A/B Module Installation

How to configure DUT control and 8 bit digital I/O

 

Using Hardkey/SoftTab/Softkey Using a mouse

Press Setup > Internal Hardware > PXI Device...1.

Click M9341 IO Control Setup.. to control the M9161Der.2.

Click Instrument1.
Select Setup2.

Select Internal Hardware3.

Select PXI Device..4.

Select  M9341 IO Control Setup..5.

 

2216



DUT Control dialog box help

This tab is displayed only when the M9341B is installed.

Enable DUT Control  The settings are applied for the selected channel. The I/O configuration is

independent for each channel.

IO Level  Set the voltage level of Vout (ST40X Pin No. 9). This level defines the "HIGH" logic

level of all I/O pins. The value range is 0.9 to 3.5 V with 0.05 V resolution.

Type  Eight I/O pins are consists of 4 group of 2-pins pair: (Pins No. 1 and 2), (Pins No. 3 and 4),

(Pins No. 5 and 6), (Pins No. 7 and 8). Each group can be assigned with Parallel or RFFE

Name: The name of assigned signal.

State  

When Parallel is selected:

In or OUT -  Select the pin function from Input or Output.

Low or High - For input pin, show the current state. For output pin, select the level from

Low or High

 When RFFE is selected:

Clicking RFFE setup.. shows the RFFE setup dialog box.
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RFFE Setup dialog box help

#  RFFE command sequence number up to 16

Clock Rate  Specify the clock rate from 25 kHz to 25 MHz. Possible values are 50000/n, with

integer n, 2000 to 2.

Slave Addr  Specify the slave address in decimal. Slave address should be from 0 to 15 (4 bits).

Command Type  Select the RFFE command sequence type.

RREad: Register Read

RWRite: Register Write

ERRead: Extended Register Read

ERWRite : Extended Register Write

Byte Count  Specify byte count value in decimal. The value range is depending on command

sequence type setting.
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Command sequence type Byte count

range

Register 0 Write

Register Read

Register Write

1

Extended Register Write

Extended Register Read

1 to 16

 

Addr Specify the address value in hex Integer value. The value range is coupled with command

sequence type setting.

Command sequence type Addr range

Register 0 Write 0 (fixed)

Register Read

Register Write

#h00 to #h1F

(0-31)

Extended Register Write

Extended Register Read

#h00 to #hFF

(0-255)

 

Data  Specify or read the data in hex value. Comma separated of data values. The value length is

coupled with byte count setting

Parity  Show the parity value for each data.
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Configure a PXI Internal SMU

PXI VNA application can control an PXI SMU M9111A.

How to Configure a PXI SMU

Using Hardkey /SoftTab /Softkey
Using a mouse

Press Setup > Internal Hardware > PXI Devices > M9111 SMU
Setup...

1. Click Instrument1.

Select Setup2.

Select Internal Hardware3.

Select PXI Devices4.

Select M9111 SMU
Setup...

5.

 

 

Output Tab help

Either Voltage or Current Source Mode can be selected by toggle switch

Voltage Source Mode  Selects voltage priority mode.
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Range  Selects 6-V or 13-V output range.

Bandwidth  Selects one of four source bandwidths. To avoid output oscillation, ringing, overshoots, and
poor transient response, refer to the following table for the correct bandwidth setting. The Low setting is
the most stable, but has the slowest response. The High settings provide faster response times for the
specified load capacitances.

Bandwidth

Setting

Sensing Load

Capacitance

(CL )

ESR

@100

kHz

Maximum

distance from

sense point to

load capacitance

(SB )

Low Local or

remote

0–150 µF 50 to

200

m&

Full lead length

High1 Remote

only

0–1 µF 50 to

200

m&

15 cm

High2 Remote

only

1–7 µF 50 to

200

m&

15 cm

High3 Remote

only

7–150 µF 50 to

200

m&

15 cm

+I Clamp  Sets the positive current limit. When the output source level exceeds this, the trace is clipped.

-I Clamp  Sets the negative current limit. When the output source level exceeds this, the trace is clipped.

Current Source Mode  Selects current priority mode.

Range  Selects 1-mA or 3-A output range .

V Clamp  Specifies the voltage limit. When the output source level exceeds this, the trace is clipped.

Protection Status  Show the current output status: Source On or Off

Reset Protection  Resets a protection trip, after you clear the cause of the trip

Refresh Status  Update the latest protection status.

Enable oscillation protection  Enables or disables protection against oscillation of the output. This
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setting is used for all channels.

Overvoltage protection level  Specifies the value at which overvoltage protection trips

Lock output relay closed for all channels  When this box is checked, the relay in SMU is always

closed even output is enabled or disabled.  This function avoids its mechanical relay from abrasion.

This setting is used for all channels.

Enable Source Sequence :

Enable: At the beginning of the channel, it will turn on SMU outputs in order from lowest number to
highest number, waiting the "Source Settling Time" between each SMU. At the end of the channel, it will
turn off SMU outputs in order from highest number to lowest number, waiting the Source Settling time
between each SMU.

Disable: the SMUs will be turned on and off in the same order as described above, but there will be no
settling time between the SMUs.  However, the "source settling time" will be used to calculate the time to
wait at the beginning of sweep after all SMUs are turned On and at the end of sweep after all SMUs are
turned Off.

This is set per-channel and the same for all SMUs.

Settling time :

When the source voltage or source current is enabled/disabled/changed at the beginning or end of the
sweep,

The VNA will check to see when it has settled, tThen it will wait the additional time indicated by the
"Source Settling Time" before continuing with the measurement.  

Note that if the source is turned off at the end of the sweep, then the VNA will wait for this settling
time before continuing with the next sweep.

"Settling Time" only affects timing at the beginning and end of the sweep. If the SMU output is changed
during a sweep (per point), the "Settling Time" does not affect the settling timing for each point.

This is set per-channel and the same for all SMUs.
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Channel  Specifies the target channel to setup.

SMU  Specifies the target SMU to setup

Set Output Level  Open DC Source Dialog box to specify the output level

 

 

Input dialog box help

Current Sense Range  Selects one of three current sense ranges

Measurement Points  Sets the number of points to be measured, from 0 to 100,000
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Measurement Delay Points  Sets the number of offset points relative to the trigger

 

Channel  Specifies the target channel to setup.

SMU  Specifies the target SMU to setup
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Configure an External Device

Once configured (as shown in this topic), an external device will appear in, and be controlled from,

relevant VNA dialogs as though it were internal to the VNA.

External Device Configuration dialog

The following (separate) topics discuss how to set properties for these types of devices:

External Source Properties

Power Meter As Receiver (PMAR) Properties

External Pulse Generator Properties

Configure an SMU (Source/Measure Unit)

Configure a DC Source/Meter

 

How to access the External Device Configuration dialog

VNA Applications have additional methods of launching this dialog.

Using Hardkey/SoftTab/Softkey Using a mouse

Press Setup > External Hardware > External Device...1. Click Instrument1.
Select Setup2.

Select External Hardware3.

Select External Device...4.

See Remotely Specifying a Source Port

 

External Device Configuration dialog box help
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Important Notes

This dialog is used to configure the following types of external devices:

External Source Properties (requires FOM Opt S93080A)

Power Meter As Receiver (PMAR) Properties

External Pulse Generator Properties

DC Power Analyzer

SMU (Source/Measure Unit)

To configure an external source using this dialog, your VNA must have FOM Option S93080A.
Without this option, you must control an external source manually. See Synchronize an External
Source for help with manual source control.

By default, an external device is de-activated when the VNA is Preset or when a Instrument State is
recalled. This behavior can be changed with a Preference setting so that it remains active through a
Preset or Instrument State recall.

External Device properties are NOT saved in an Instrument State file. However, the reference to the
External Device from relevant VNA dialogs IS saved. Therefore, recalling a state file that refers to a
device that is NOT present will result in a “Device configuration not found” error.

Multiple configurations for the same physical device can be Active. However, only one configuration
for the same external source can have the I/O Enabled.

External Devices  

The devices that are currently configured appear in this list. The number of devices that can be
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configured is limited by the specified Interface.

New  Click to create a new device configuration. The default name is Device<n>, where <n> is

the next number for 'Device'.

Remove  Click to remove the selected device from the list.

Properties

Name  Enter a device name as it will appear when referring to this device in VNA dialog boxes.

Edit the name at any time. Duplicate names are not allowed.

Because External Devices can be used with FOM ranges, do NOT name an external device any of the
following FOM range names: “primary”, “receivers”, or “source”, “source1”, source2” and so forth. Learn
more about FOM ranges.

Do NOT use a parameter name such as "S11" or "R1".

DC Analyzer devices MUST use at least three characters in the name.

Device Type  Select one of the following:

(Quotes are used when specifying in a remote program.)

"DC Meter" - Learn more

"DC Source" - Learn more

"Power Meter" (PMAR) - Learn more

"Pulse Generator" -  Only the Keysight 81110A Pulse Generator is supported. Learn more

"SMU" - Learn more

"Source" (RF) - Learn more

"None" - returned remotely before setting Device Type.

Driver  Select the appropriate model to be configured.

(Quotes are used when specifying in a remote program.)

For Source Device Type choose from:

("AG" is short for Agilent.-
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"AGESG"  (ESG)

"AGEXG"  (EXG) See configuration note

"AGPSG"  (PSG)

"AG836XX"  (8360 and 8340)

"AGMXG" (MXG) The MXG must have at least firmware A.01.44 for FOM power sweep to work correctly.

"AGGeneric"  For sources that are NOT listed but can be controlled using SCPI. Click Device
Properties, then Edit Commands to send commands to these sources. Learn how.

For SMU Device Type, choose from:

"B29xx" -  B2900 Series

"N67xx" - N6700 Series

All other device types have only one driver.

Active  Check to make the device available for use in the relevant dialogs.  An instrument state

that is saved with an Active device (checked) will include the device in the state file. Otherwise, if

the Active box is cleared, the device will NOT appear in the state file. Learn more about Instrument
State files.

Enable I/O  Clear this box to disable communication with the selected device. Do this to

configure a device that is not yet connected to the VNA.

Communication with devices is attempted when Enable I/O is checked, Active is checked,

and OK is pressed.

When communication is attempted, devices with Enable I/O checked are queried for

selected limits, such as frequency, power, and number of points. If there are limit problems,

the VNA sends an error and the affected channels are put into Hold. These limits are

enforced by the dialog box in which they are set. Resolve the reported limit problem and

then restore the triggering.

If communication with a device is lost the affected channels are put into Hold.

Device Properties  Click to launch the Properties dialog for relevant Device type:

Configure External Sources

Configure a Power Meter As Receiver
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Configure an External Pulse Generator

Configure a DC Meter / Source

Configure a SMU

IO Configuration

Interface  Select the interface that is used to connect the device to the VNA. These devices will

then appear in the 'Available' field. Choose from:

GPIB - Devices connected to the System Controller GPIB port.

USB - Devices connected to the VNA USB ports.
See Important First-time USB connection note.

Aliases - Devices that are connected to ANY interface for which you created an alias. See Configure
Alias and LAN devices.

LAN - Devices connected to a network using a LAN connection. The VNA must also be connected to the
network.

Note: Devices connected to LAN must first be configured in Keysight IO libraries before they will

appear on the Available list. See Configure Alias and LAN devices.

Available  Shows a list of devices that are connected to the specified IO Interface.

Refresh Click to rescan the specified interface for devices.

Selected  Enter the IO configuration or select from the available list of IO Interfaces found.

Configure Alias and LAN Devices

Use this procedure to configure a device using a LAN interface. Also use for ANY device for which

you want to set an alias (easily-recognized) name. The alias name appears in the Available field

when Aliases is selected as the Interface.

On the VNA, minimize the VNA application (System > Main > Minimize Application).1.

In the system tray (lower-right corner) right-click the IO icon, then click Keysight Connection Expert.2.

To Add a LAN Device:

In Keysight Connection Expert, click Manual Configuration tab.1.

Select LAN Instrument.2.

3.
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1.

2.

Click, then enter the IP address of the external source.3.

Click Test This VISA Address to verify communication.4.

Click Accept.5.

To create an Alias for a connected device:

In the list of connected instruments, click the instrument, then click Add or Change Aliases.1.

Enter the Alias Name to be used in the External Device Configuration dialog.2.
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Configure DC Sources and DC Meters

Once configured, one or more DC Sources and DC Meters can be controlled by the VNA. DC Power

Analyzers are also supported, but they must be configured as a separate Source and Meter.

The Keysight N6700 series and B2900 series DC Analyzers are supported with configuration files that

can be loaded on the DC Meter and DC Source property page. Once loaded, the SCPI commands that

control the DC device can be modified and saved. Learn how.

See Also

External DC Meter Data Conversion

 

How to Configure a DC Meter or DC Source

Important: Create a DC Source / Meter device by name (one-time). Learn how (separate topic).1.

On the Configure an External Device dialog, click Device Properties. (This topic).2.

Using Hardkey/SoftTab/Softkey Using a mouse

Press Setup > External Hardware > External Device...1.

Click Device Properties to Configure the External Source.2.

Click Instrument1.
Select Setup2.

Select External Hardware3.

Select External Device...4.

 

Once configured, set the DC source voltage and display DC meter measurements:

DC Sources:  DC Source control is available in Standard, Gain Compression/GCX , and FCA channels.
 

Set the Start and Stop voltage on the DC Control dialog. To access this dialog:  Press Sweep,
then More, then DC Source.

DC Meters:  DC meter measurements are available in Standard, Gain Compression /GCX, Swept IMD /
IMDX, and FCA channels.

In Gain Compression /GCX, Swept IMD / IMDX, and FCA channels, display DC parameters as you
would an RF parameter, by clicking Trace/Chan, then New Trace.
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In a Standard channel, configure an unratioed measurement. Press Meas, then More, then
Receivers. For Numerator, select the external (or internal) DC meter.

Change the X-axis to display the DC Meter parameters, click Response, then Display, then
Labels, then Select X-Axis, then select the DC Meter.

 

DC Source / Meter Configuration dialog box help

The DC Source and DC Meter properties are almost identical in how they operate. Both are

documented here.

Device Settings

Timeout - Sets a time limit for the DC source or meter to make contact with the VNA. If this

time limit is exceeded, the VNA stops the measurement and displays the following error message.

EXECUTION ERROR;OPC QUERY TIMEOUT ERROR

If this occurs, check the connections between your VNA and external device.

Dwell Before Sweep  Wait time before making a sweep.

Dwell After Point

DC source  Wait time after setting the voltage/current at each data point.

DC meter  Wait time before measuring voltage/current at each data point.
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Type: This setting changes the units that are displayed in the DC Source dialog, the X-axis display

annotation, and the underlying data format. Use these settings with Receiver or Source Correction

(Scaling and Offset) to display and scale measurements with these units. Choose from:

V (volts -

default)

dBm F (degrees)

A (amperes) W (watts) C (degrees)

    K (kelvin)

Note: To change the X-axis to display the DC Meter units, click Response, then Display, then

Labels, then Select X-Axis, then select the DC Meter.

Receiver / Source Correction

For a DC source, use the correction settings to scale and offset the output voltage.

For a DC Meter (receiver), use the correction settings, along with Type, to display and scale
measurements with appropriate units.  For example:

Measure the voltage across a 5 ohm resistor, then display the results in A(mperes).

Using ohms law,  I = V / 5 ohms or I = V *.2

For receiver correction, enter Scaling = .2; Offset = 0.

 

ON  Check to apply the following correction factors to each measurement.

Offset: Enter the value to offset the DC Meter reading or set the DC Source voltage.

Scaling: Enter the value to scale the DC Meter reading or set the DC Source voltage.

Displayed Output = (Measured / Set value - Offset) * Scaling value.

Edit Commands - Click to start the Edit Commands dialog.
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Important Note:

The Edit Commands dialogs (see below) MUST be completed. They are used to set the SCPI

commands with which the VNA communicates with the DC device.

These commands are saved, along with other configuration settings, to configuration (*.xml)

files. These files can then be loaded later when communicating with the same DC Device.

Configuration files for the Keysight N67xx and B29xx Power Analyzers are pre-loaded on the

VNA. Click Load, then navigate to: c:\users\public\network analyzer\documents\drivers.

 

Save - Press to save the current DC Source or DC Meter configuration to an *.xml file. The list of

files is NOT filtered by "DCMeter" or "DCSource", so use a descriptive filename.

Load - Press to load an existing configuration.

 

 

DC Meter Edit Commands dialog box help

Global Tab
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The Global tab includes the system settings for the DC Meter.

ID Query - Enter the SCPI command to return the ID string of the DC Meter. Typically *IDN?

Error Query - Enter the SCPI command that is used to return DC Meter errors. Typically

SYST:ERR?

Enable I/O - Enter the SCPI commands that is used to enable the DC Meter to read voltages.

Disable I/O - Enter the SCPI commands that is used to disable the DC Meter from reading

voltages.

Test Connection

Click to start the Test Connection dialog. You must first have entered the I/O Configuration settings

 and select Enable IO on the External Device dialog.

Enter a SCPI command, then click Send or Send&Read when a return value is expected.

Sweep Tab

Use the Sweep Tab to send SCPI commands to the DC Meter at the beginning or end of each
sweep.

Abort Sweep - Enter the SCPI command that is used to Abort or reset the DC Meter. This would
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be necessary when the VNA sweep is aborted or terminated. The VNA will then send the

command to the DC Meter.

Point Tab

Read (commands) - Enter the SCPI command that is used to make a DC measurement at each data

point.

Set (commands) - Use <%variable> to make a DC Meter setting.

 

DC Source Edit Commands dialog box help

Global Tab

The Global tab includes the system settings for the DC Source.

ID Query - Enter the SCPI command to return the ID string of the DC Source. Typically *IDN?

This entry can be left blank.

Error Query - Enter the SCPI command that is used to return DC Source errors. Typically
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SYST:ERR?

Enable I/O - Enter the SCPI commands that is used to enable the DC Source to output voltages.

Disable I/O - Enter the SCPI commands that is used to disable the DC Source from outputting

voltages.

Maximum / Minimum DC Output

Read Max / Min Using - Select, then enter the commands used to return the output limits of the

DC source.

Define Max / Min As - If the DC Source has no commands to return these values, or you would

rather define the limit for your DC Source, select then enter the Max and Min voltage limits.

Test Connection

Click to start the Test Connection dialog. You must first have entered the I/O Configuration settings

 and select Enable IO on the External Device dialog.

Enter a SCPI command, then click Send or Send&Read when a return value is expected.

Sweep Tab

Use the Sweep Tab to send SCPI commands to the DC Source at the beginning or end of each
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sweep.

Typically, you might send the output ON at the beginning of each sweep, and output OFF at the

end of each sweep as shown above.

Abort Sweep - Enter the SCPI command that is used to Abort or reset the DC Source. This would

be necessary when the VNA sweep is aborted or terminated. The VNA will then send the

command to the DC Source.

Point Tab

Note: The DC Source output voltages are configured on the DC Source dialog.

This dialog is used to configure the commands that are used to communicate with the DC Source.

Set commands - Enter the SCPI command, enclosed in {curly brackets} to output (set) a

voltage/current from the DC Source for each data point.

{%f} - The value is a double value. (Most common).

{%d} - The value is a integer. This would be used when the voltage controls a remote switch. For
example, you can program the value to: “0,1,0,1,0,1….”. where “0”  = OFF and “1” = ON.
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Configure a Power Meter As Receiver (PMAR)

When a power meter is configured as a VNA receiver (in standard measurement channels ONLY), you

can...

Extend the number of measurement receivers.

Use the power meter as a scalar detector.

Monitor the power at any point in a measurement system.

Use multiple power meters in a Guided Power Cal to cover a wide frequency range.

Use the power meter to level the stimulus power at any point in a measurement system.

Use the power sensor as a PMAR device to confirm the accuracy of a Source Power Cal. Learn how.

Once configured, a power meter can be used like any other VNA receiver in the following dialogs:

New Trace / Meas dialog - used in Ratioed and Unratioed measurements.

Receiver Leveling

Frequency Offset Mode - Extend frequencies beyond VNA

See Also

Supported Power Meters

Important first-time USB connection note.
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How to Create and Configure a PMAR Device

Create a PMAR device by name (one-time).1.

Then click Device Properties to configure the Power Meter/Sensor.2.

VNA Applications have additional methods of launching this dialog.

Using Hardkey/SoftTab/Softkey Using a mouse

Press Setup > External Hardware > External Device...1.

Click Device Properties to configure the Power Meter/Sensor.2.

Click Instrument1.
Select Setup2.

Select External Hardware3.

Select External Device...4.

 

External Device Configuration dialog box help

This dialog allows you to create and configure a power meter to be used as a receiver by the VNA.

Once you create and configure a power meter from this dialog box, it becomes available from VNA

dialog boxes as well as the softkeys and entry toolbar, as if it were an internal VNA receiver.

This dialog is ALSO used to configure an External Source. Learn more.

To configure a single power meter for a Source Power Cal, use the Power Meter Settings dialog.
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Important Notes

By default, an external PMAR device is de-activated when the VNA is Preset or when an Instrument
State is recalled. This behavior can be changed with a Preference setting so that it remains active
through a Preset or Instrument State recall.

PMAR configuration is NOT saved in an Instrument State file. Therefore, recalling a state file that
refers to a device that has been removed, or recalling a state file on a different VNA will result in a
“Device configuration not found” error.

External Devices  

The devices that are currently configured appear in this list. The number of devices that can be

configured is limited by the specified Interface.

New  Click to create a new PMAR configuration. The default name is Device<n>, where <n> is

the next number for 'Device'.

Remove  Click to remove the selected device from the list.

Properties

Name  Enter a device name as it will appear when referring to this device in all VNA dialog

boxes. Edit the name at any time. Duplicate names are not allowed.

Notes

Because External Devices can be used with FOM ranges, do NOT name an external device any of
the following FOM range names: “primary”, “receivers”, or “source”, “source1”, source2” and so
forth. Learn more about FOM ranges.

Do NOT use a parameter name, such as "S11, or "R1".

Device Type  Select Power Meter.

Driver  Use AGPM for all Keysight Power Meters. See Supported Power Meters

Active  Check to make the device available for use in the FOM, New Trace, and Receiver

Leveling dialogs. An instrument state that is saved with an Active device (checked) will include
the device in the state file. Otherwise, if the Active box is cleared, the device will NOT appear in

the state file.

Note: Multiple PMAR configurations for the same physical device can be Active and Enabled.

Device Properties  Click to launch the Configure Power Sensor dialog.
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IO Configuration

Interface  Select the interface that is used to connect the device to the VNA. These devices will

then appear in the 'Available' field. Choose from:

GPIB - Devices connected to the System Controller GPIB port.

USB - Devices connected to the VNA USB ports.  See Important First-time USB connection note.

Aliases - Devices that are connected to ANY interface for which you created an alias. See Configure
Alias and LAN devices.

LAN - Devices connected to a network using a LAN connection. The VNA must also be connected to the
network. Note: Devices connected to LAN must first be configured in Keysight IO libraries before they will
appear on the Available list. See Configure Alias and LAN devices.

Available  Shows a list of devices that are connected to the specified IO Interface.

Refresh Click to rescan the specified interface for devices.

Selected  Enter the IO configuration or select from the available list of IO Interfaces found.

Enable I/O  Clear this box to disable communication with the selected device. You would do this

to configure a device that is not yet connected to the VNA.

Communication with devices is attempted when Enable I/O is checked, Active is checked,

and OK is pressed.

If communication with a device is lost, the affected channels are put into Hold.

When communication is attempted, devices with Enable I/O checked are queried for limits

for frequency, power, and number of points. If there are limit problems, the VNA sends an

error and the affected channels are put into Hold. These limits are enforced by the dialog

box in which they are set. Resolve the reported limit problem and then restore the triggering.

Communication is also attempted when clicking the Settings button on the Configure Power
Sensor dialog. You can not change any of the sensor settings unless Enable I/O and Active
are checked and communication is possible with the sensor.

Configure Alias and LAN Devices

Use this procedure to configure a device using a LAN interface. Also use for ANY device for which

you want to set an alias (easily-recognized) name. The alias name appears in the Available field

when Aliases is selected as the Interface.

1.
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On the VNA, minimize the VNA application.1.

In the system tray (lower-right corner) right-click the IO icon, then click Keysight Connection Expert2.

To Add a LAN Device:

In Keysight Connection Expert, click Manual Configuration tab.1.

Select LAN Instrument.2.

Click, then enter the IP address of the external source.3.

Click Test This VISA Address to verify communication.4.

Click Accept.5.

To create an Alias for a connected device:

In the list of connected instruments, click the instrument, then click Add or Change Aliases.1.

Enter the Alias Name to be used in the External Device Configuration dialog.2.

 

Power Sensor Configuration dialog box help  

To launch this dialog, with the PMAR device selected in the External Device Configuration dialog,

click Device Properties .
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This dialog is used to configure a power meter / sensor for use as a receiver.

To configure a single power meter for a Source Power Cal, use the Power Meter Settings dialog.

About Power Sensor Calibration

PMAR traces are NOT calibrated using standard VNA calibrations, including response

corrections.

PMAR traces are calibrated using methods that are appropriate for the selected sensor. Follow

the proper guidelines for zeroing or calibrating the sensors that are in use. Check to ensure that

the selected sensor is appropriate for the frequency range and the power level at which PMAR

measurements occur.

The VNA does not automatically prompt you to perform a calibration.

To calibrate a power sensor, click Settings on this dialog box, then click Zero/Calibrate

Sensor. Learn more.

 

Note: By default, a PMAR is de-activated when the VNA is Preset or when a Instrument State is

recalled. This behavior can be changed with a Preference setting.

Sensor

For power sensors that are connected to a power meter, select a sensor to configure.

Settings  Click to launch the Power Sensor Settings dialog.

When pressed, communication with the sensor is tested. Sensor settings can NOT occur unless

Enable I/O is checked on the External Device Configuration dialog, and the sensor is properly

connected and configured.

Sensor Settling

Each power meter reading is "settled" when either:

two consecutive meter readings are within this Tolerance value or

when the Max Number of Readings has been met.

The readings that were taken are averaged together to become the "settled" reading.

Tolerance  When consecutive power meter readings are within this value of each other, then the
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reading is considered settled.

Max Number of Readings  Sets the maximum number of readings the power meter will take to

achieve settling.

Sensor Loss Compensation

Use Loss Table  Select this checkbox to apply loss data to Source Power calibration correction

(such as for an adapter on the power sensor).

Edit Table  Invokes the Power Loss Compensation dialog box.

 

 

Power Sensor Settings dialog box help

This dialog appears when you click the Settings button on the Configure Power Sensor dialog.

Note: Be sure that the frequency range of your power sensor covers the frequency range of your
measurement. This does NOT occur automatically.

Sensor A (B)  Displays one of the following messages depending on type of sensor.

Not connected  The VNA is not detecting a power sensor.
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Sensor Data  Allows the following entries for power sensor data:

Reference Cal Factor  Specifies the Cal Factor for the 50 MHz reference signal.

Cal Factor Table  Specifies the frequency and corresponding Cal Factor for the sensor.  

Delete Cal Factor  Deletes the indicated row in the table.

Delete All  Deletes all data in the table.

To Add a Row to the table, click on a row in the table and press the down arrow on either the VNA
front panel or keyboard. A row is added to the bottom of the table. The table is automatically sorted
by frequency when OK is pressed.

Cal factors are contained within this sensor  Internal Reference Cal Factor and Cal Factor data are
loaded automatically and the following dialog appears.

Use Internal Cal Factors  This box only appears when  internal cal factors have been detected for
the sensor and by default will be checked. Clear this box to not use internal cal factors.

Load Cal Factors  Click to load cal factors from a *.csv file that you create from the cal factors

that appear on the sensor. The first line of the file MUST have the reference Cal Factor (typically

100), followed by Freq / Cal Factor pairs as show in the following image:

Save Cal Factors  Click to save the cal factor table to a *csv file.
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Limit Frequency Range  

Check to limit the use of the power sensor to those within the Minimum and Maximum frequency values.

Clear to use the power sensor for all measurements. If the measurement frequency is not within the
Minimum and Maximum frequency values, the closest min or max correction data is used for the
measurement.

Minimum Frequency  Specifies the minimum frequency range for the sensor.

Maximum Frequency  Specifies the maximum frequency range for the sensor.

Zero and Calibrate the Power Sensor

For highest accuracy, Zero AND Calibrate the power sensor before measuring data. Follow prompts

that may appear.

Zero - If the following settings are 'greyed', Internal or External zeroing is selected automatically

based on the power meter/sensor model. Otherwise, select the appropriate type of zeroing to

perform, then press Zero.

Internal Zero - A switch inside the power sensor removes the sensor from the incident power.

External Zero - Requires that you physically remove the sensor from incident power.

Note for the U2000 Series USB power sensors

Calibration is NOT available. Select External Zero ONLY when the power to be measured is

below the specified level. Otherwise, the U2000 series performs internal zeroing automatically

when needed. See your power sensor documentation for more details.

U200xA - below -30 dBm

U200xH - below -20 dBm

U200xB - below 0 dBm

If your U2000 power sensor 'hangs' when external zeroing, upgrade the power sensor firmware

to Rev. A.01.02.00 or higher to fix this problem.

Calibrate - Available when the selected sensor has calibration capability. Calibration involves

measuring an internal 1 mW source.

Keysight P-Series sensors have an internal reference so you can calibrate them without connecting to the
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meter’s reference port.

Keysight U2000 USB power sensors do not require calibrating.

For other sensors, refer to the documentation to determine if it has calibration capability.

Press Calibrate, then follow the prompts.

 

Power Loss Compensation dialog box help

To Add a Row to the table, click on a row in the table and press the down arrow on either the VNA

front panel or keyboard.

To Edit a value, double-click in the cell to be edited.

Compensates for losses that occur when using an adapter or coupler to connect the power sensor to

the measurement port. These components will be removed when the calibration is complete. To

account for components that will remain during the measurement, use the Power Offset setting.

The Frequency / Loss pairs define the amount of loss for the entire frequency range. For example,

using the entries in the above dialog image:

0.5 dB is used to compensate power sensor measurements up to 1 GHz.

Each data point between 1 GHz to 2 GHz is linearly interpolated between 0.5 dB and 1 dB.

1 dB is used above 2 GHz.

A single frequency/loss segment is applied to the entire frequency range.
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Beginning with A.09.80, enter up to 9999 segments to achieve greater accuracy. Previously the

limit was 100.

These values can be loaded from an S2P file using the Characterize Adaptor Macro.

Note: Large segment counts with one or more power sensors can result in long load and close

times for the VNA Application.

 

Frequency  Enter a frequency in Hz.

Loss  Enter a loss as a POSITIVE value in dB.  To compensate for gain, use NEGATIVE values.

Delete Table Segment  Deletes row indicated in the field.

Delete All  Deletes all data in the table.

The Power Loss Compensation table survives VNA Preset and Power OFF. To NOT use Loss

compensation, clear the Use Loss table checkbox on the Configure Power Sensor dialog.

Use a PMAR Device to confirm a Source Power Cal

Learn how to create and configure PMAR device.

After a Source Power Cal has been performed, use the same sensor as a configured PMAR to analyze

the accuracy of the Calibration.

Create a PMAR device with the power sensor that will be used for the Source Power Cal.1.

Perform a Source Power Cal. Learn how.2.

Create an unratioed measurement with the PMAR device. Learn how.3.

With the power sensor still connected to the test port, monitor the corrected source power using Min and Max
markers or the Trace Statistics peak-to-peak feature.

4.
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Configure and Use External Pulse Generators

Once configured, one or more 81110A External Pulse Generators can be accessed from the VNA

Integrated Pulse Application. The external pulse generators can be used without Opt. S93025A (internal

pulse generators). However, the Integrated Pulse App is available ONLY with Opt. S93025A.

Only the 81110A Keysight Pulse Generator is supported.

In this topic:

How to Configure an External Pulse Generator

Pulse Generator Configuration dialog box help

Using External Pulse Generators with the Integrated Pulse App

See Also

Integrated Pulse Application

IF Path Configuration

81110A Quick Start Guide.

 

How to Configure an External Pulse Generator

Important: Create an External Pulse Generator device by name (one-time). Learn how
(separate topic).

1.

On the Configure an External Device dialog, click Device Properties (this topic).2.

Setup the external pulse generator in the Integrated Pulse Application.3.

Using Hardkey/SoftTab/Softkey Using a mouse

Press Setup > External Hardware > External Device...1. Click Instrument1.
Select Setup2.

Select External Hardware3.

Select External Device...4.
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Tip: In the External Device Configuration dialog, you can configure the same 81110A twice; once for

each output module. For example:

Name = "81110A-1"   Output = Out1

Name = "81110A-2"   Output = Out2

 

Pulse Generator Configuration dialog box help

System Settings

Time out - Set the amount of time allowed to communicate with the external pulse generator. If

communication has not been established before this amount of time has elapsed, a Timeout

message will appear. Check connection settings on the External Device dialog.

Master Mode - When checked, the 81110A trigger mode is set to Internal. This also causes the

81110A to appear as a selection on Integrated Pulse App, Master Pulse Trigger setting. When

selected here and on that dialog, the timing of configured 'slave' pulse generators is controlled by

the 81110A pulse generator. Although more than one configured pulse generator can have the

Master Mode setting checked, only one pulse generator can be connected to the rear-panel Pulse

connections. Learn more about making physical connections.

When this setting is cleared, the 81110A trigger mode is set to External and can be configured as
a 'slave' pulse generator to the VNA internal pulse generators or another external pulse generator.

Output Settings

The following are 81110A settings made by the VNA. Some settings may not be possible depending

on the modules that are installed on the 81110A. Please refer to the 81110A Quick Start Guide for

more information.
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Output - Select an output on the 81110A.

High/Low - Set the pulse voltage levels at the 81110A output.

Src Imp (Source Impedance) - Source impedance of the pulse generator output.

Load Imp (Load Impedance) - The load impedance value expected at the pulse generator output.

 

Using External Pulse Generators with the Integrated Pulse App

Once configured, an external pulse generator can be used with the Integrated Pulse App as though it

were an internal pulse generator.

N1966A Pulse I/O Adapter.           See an enlarged view of the IF Block diagram

An External Pulse Generators can be used for ONE OR MORE of the following pulsed functions

within the Integrated Pulse Application.

Modulate the sources

Drive the IF (Receiver) Gates (Narrowband mode ONLY).

Trigger the ADC to make receiver measurements (Wideband mode ONLY).

How to Modulate a Source with an External Pulse Generator

When using an external source modulator (Z5623AH81):

Connect: the 8110A to the Z5623AH81 as shown in the Narrowband Pulse topic.
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Setting: On the Pulse Generator Setup dialog, disable (clear) the Internal Pulse Modulators .

When using internal source modulators, the external pulse generator can drive the internal modulators

in two ways:

81110A directly to the internal pulse modulators.

Connect: 81110A to RF Pulse Mod In on the N1966A OR rear-panel Pulse I/O connector.

Setting: On the Pulse Generator Setup dialog, set Modulator Drive to "External".

81110A drives internal pulse generators, which drives the internal modulator.

Connect: 81110A to Pulse Sync IN, on the N1966A OR rear-panel Pulse I/O connector.

Settings:

On the Pulse Generator Configuration dialog (above) check Master mode.

On the Pulse Setup dialog, set Master Pulse Trigger to <ext pulse gen name> .

How to Gate IF Receivers with an External Pulse Generator

(Used ONLY in Narrowband mode.)

When IF Gating is used, the external drive can be routed in two ways:

81110A drives gates directly at the rear-panel IF Gate inputs.

Connect: 81110A to the Pulse IN for one or more VNA receivers on the N1966A OR rear-panel Pulse
I/O connector.

Setting: On the Pulse Setup dialog, under Measurement Timing, for the receivers to be gated, set
Pulse Gen to <ext pulse gen name>.

81110A drives the internal generators, which drive the gates.

Connect: 81110A to Pulse Sync IN, on the N1966A OR rear-panel Pulse I/O connector.

Settings:

On the Pulse Generator Configuration dialog (above) check Master mode.

On the Pulse Setup dialog, set Master Pulse Trigger to <ext pulse gen name>.

On the Pulse Setup dialog, under Measurement Timing, for the receivers to be gated, set Pulse
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Gen to the internal pulse generator (Pulse0 through Pulse4) to be used to pulse the Rcvr<n>.
Set unique pulse Width and Delay for the Receiver.

How to trigger the ADC with an External Pulse Generator

(Used ONLY in Wideband mode).

Pulse0 may be used to trigger the ADC. The following shows how P0 may be driven by an external

pulse generator.

Connect: 81110A to Pulse Sync IN, on the N1966A OR rear-panel Pulse I/O connector.

Settings:

On the Pulse Generator Configuration dialog (above) check Master mode.

On the Pulse Setup dialog, set Pulse Trigger Source to <ext pulse gen name>.

On the Pulse Setup dialog, under Measurement Timing, for the receivers to be triggered, set Pulse
Gen to Pulse Trigger. Set Delay for the Receivers.
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Display Colors

You can modify the colors that are used to draw various elements on the VNA screen and on a

hardcopy print of the display.

See Also

Print Preview

How to modify DISPLAY Colors

These settings can also be accessed from the Preferences dialog box.

Using Hardkey/SoftTab/Softkey

Press System > System Setup > Preferences... > Colors....1.

Click Display Colors... in the Customize Display dialog box.2.

How to modify PRINT Colors

Press System > System Setup > Preferences... > Colors....1.

Click Print Colors... in the Customize Display dialog box.2.

 

Display and Print Colors dialog box help

The Display Colors and Print Colors dialog boxes function in exactly the same manner. See Print
Preview procedure below.
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Pen

"Pen" is a term used to describe the various elements. Each pen can have a unique color.

You can change the color of the following pens:

Background - The background color of the inactive windows.

New Active Background -  The background color of the active window.

Grid - The inner lines of all grids in all windows, and the grid frame in inactive windows.

Active Labels, Grid Frame - The labels and grid frame colors in the active window. Note: when this pen is
selected, the current window becomes inactive. Therefore, changes for this pen color will not be visible
until OK is pressed.

Inactive Window Labels

Failed Trace - Limit Line failed traces or failure indicators (dots) and the word Fail.

The following pens for up to 8 Traces:

Data and Limits

Memory trace

Markers

Memory markers

About Trace Pens

'1st Trace' is NOT always Trace1 (Tr1). For example, the first trace in a window might be Tr2

which is drawn with the "1st Trace" pen.

The first 8 traces are drawn with the defined pen colors. The next eight traces reuse the same colors,

and so forth. For example, if all traces are numbered sequentially, the 9th and 17th traces are drawn

using the same color as the 1st trace.

Change Color  Click the button or the color swatch to launch the Change Color dialog.

Reset Color  Restores the default color for the selected pen.

Color Themes

A theme is a complete set of pens and their colors. The current theme persists until you change it.

Themes can also be saved to a file and then later recalled.
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Save Theme  Click to save the current set of pens to a file.

Recall Theme  Click to recall and use a saved theme.

Reset Theme  Click to recall the default VNA color theme.

The colors for the following Display elements can NOT be changed: toolbars, softkeys, menus,

dialogs and popup messages.

 

Change Color dialog box help

To use a basic color, click the color from the 'Basic colors' pallette, then click OK.

To define and use a custom color:

Click Define Custom Colors>> to open the right side of the dialog.1.

Optionally, pick a Custom color slot to replace. Otherwise, the replacement will occur at the first slot
location and continue with subsequent custom color definitions.

2.

Click the color pane, or drag the crosshairs, to the location of the custom color.3.

Drag the arrow to the desired saturation level of the custom color.4.

Click Add to Custom Colors5.

Continue to define more colors, or click OK to close the Color dialog.6.
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6.

After a custom color has been assigned to a VNA pen, the custom color can be changed. The VNA

pen color remains unchanged.

 

 

Print Preview Procedure

Use the following procedure to preview your Print Colors on the VNA screen:

From the Print Colors dialog, select Reset Theme  then Save Theme.  Name the new theme
“MyPrintTheme.colors”.  This will give you a starting point equal to the default print colors.

1.

Launch the Display Colors dialog, select Recall Theme, then select “MyPrintTheme.colors”. The display will
now show the default print theme.

2.

Customize the display colors.  You will be previewing how the hardcopy will appear when printed.3.

Save the customized display colors to “MyPrintTheme.colors”.4.

Go to the Print Colors dialog and Recall “MyPrintTheme.colors.5.
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Mechanical Devices

Overview

How to access Mechanical Devices settings

Mechanical Devices dialog

Other System Configuration Topics

Overview

Note: To prevent premature wear, the VNA does not allow attenuators or other mechanical switches

to switch continuously.

These mechanical devices are set for the entire channel. When more than one channel is used, and a

mechanical device setting is NOT the same for all channels, only the ACTIVE channel is allowed to

sweep. All other channels are Blocked - NOT allowed to sweep. Blocked channels will resume

sweeping when they are made ACTIVE, or when the conflict is resolved.

Press Trigger > Main > Restart to cause ALL channels to sweep once. Then the active channel will

resume sweeping continuously.

The Mechanical Devices dialog shows the settings of all of the switches and attenuators in the VNA.

The settings for all active channels are shown side-by-side for easy comparison. This dialog allows you

to determine the settings which would cause mechanical devices to switch between states on

consecutive sweeps, potentially leading to device wear-out. It also allows you to determine if the

conflict can be resolved to enable continuous sweeps on all channels.

The following are the mechanical devices that are potentially shown in the dialog. These components

may not appear in your VNA model:

Port 1 through Port 4 Bypass Switches

Port 1 through Port 4 Source Attenuator settings

Receiver A through Receiver R Attenuator settings

Port 1 Noise Tuner Switch and Port 2 Noise Receiver Switch
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How to access Mechanical Devices settings

Using Hardkey/SoftTab/Softkey Using a mouse

Press Setup > Internal Hardware > Mechanical Devices...1. Click Instrument1.
Select Setup2.

Select Internal Hardware3.

Select Mechanical Devices...4.

Remote commands

SCPI: SENSe<cnum>:SWEep:BLOCked?

COM: IsBlocked Property

 

Mechanical Devices dialog box help

See Mechanical Devices Overview (scroll up)

The devices that appear in the table depend on the VNA model and options.

> Yellow highlighted cell indicates the Active channel.

 Blue  highlighted cells indicate the following:

The channel is NOT able to sweep. Blocked is shown in the top row.
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The highlighted device settings differ from that of the sweeping channels.

To modify entries in the table, click a cell.

When a selection is changed, the new setting is applied immediately.

If Port Power is coupled, a dialog prompts if coupling should be turned OFF.

Limitations

Measurement Class can NOT be changed from this dialog.

The dialog does NOT report device settings for multiport test sets.

This dialog does NOT report device settings for external sources.

Copy Active  Available ONLY when there is a conflict which causes at least one channel to be

Blocked.  When clicked, the mechanical device settings of the Active channel are copied to the

Blocked channels.  A warning message appears to remind you that power to one or more channels

may be increased.  Exception: When one or more Noise channels are present, then the settings of

the two Noise switches are be determined by the lowest-numbered Noise channel if none are the

active channel.

Trigger  Launches the Trigger dialog box.

OK  Closes the dialog box.

Cancel  Does not apply changes that were made, and closes the dialog box.
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Power Limit and Power Offset

Overview

How to access Power Limit and Power Offset settings

Other System Topics

Overview

Power Limit (Global scope)

Global power limit sets a maximum source power level for individual test ports. This value limits port

power for all channels and all applications. Power levels that attempt to exceed the power limit is

clipped at the limit.

Notes

The power limit can NOT be set for power levels which are below the power level that is required by the
analyzer to achieve phase lock -  approximately -30 dBm.

Because Fast Sweep mode allows power spiking, it is NOT allowed when a power limit is enabled.

Components that are added to the RF path are accounted for by entering their loss (negative) or gain
(positive) in the Power Offset section of the dialog box.

Power limiting does NOT clip power spikes that may occur during frequency band crossings.

Power Offset (Channel scope)

Power Offset provides a method of compensating port power for added attenuation or amplification in

the source path. The result is that power at the specified port, all dialogs, and annotation, reflects the
added components.
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How to access the Offsets and Limits settings

Also accessed through the Preferences dialog.

Using Hardkey/SoftTab/Softkey Using a mouse

Press Power > Leveling & Offsets > Offsets and Limits...1. Click Stimulus1.
Select Power2.

Select Offsets and Limits...3.

 

Offsets and Limits dialog box help

Click a WHITE cell to change values. Shaded cells can NOT be changed.

Remote commands can be sent to lock and unlock the dialog box (UI) settings.

Power Limit

Limits the source power at each test port for ALL channels. Use this feature to protect DUTs that

are sensitive to overpowering at the input. Power levels that exceed the limit at the specified port

are clipped at the limit and an error message is displayed on the screen.

The Power Limit settings survive Instrument Preset. When an Instrument State is recalled, the current
Power Limit settings are applied to the recalled state.

To learn more, see Power Limit Overview (scroll up).

State / Limit

ON - Power is limited to the adjacent value at the specified source port.

OFF - Power is NOT limited to this value, but to the maximum power of the source.
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Power Offset

Power Offset provides a method of compensating port power for added attenuation or amplification

in the source path. The result is that power at the specified port, all dialogs, and annotation reflects

the added components.

For amplification, use positive offset.

For attenuation, use negative offset.

 

Optionally change the Source Power or Port Power values so that the following equation reflects

your requirement:

Source Power + Power Offset = Port Power

Source Cal  ON / OFF

Notes

Power Offset can be used with Power Sweeps. When a power sweep is enabled, the Start and Stop
power levels are reported in this dialog.

When port power offsets are used, port powers are automatically uncoupled. Port powers may not be
coupled again until all port offsets are zero.

OK  Closes the dialog box.
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Receiver Temperature

This feature allows you to read the current temperature on the receiver microcircuit.

To read temperature, press System > Service > Diagnostices > Receiver Temperature....

The temperature reading is updated with every sweep.

Temperature is available in Celsius and Fahrenheit.

Temperature can also be read using remote commands.

SCPI: SENSe:TEMPerature?
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Setting System Impedance

The system impedance can be changed for measuring devices with an impedance other than 50 ohms,

such as waveguide devices. The VNA mathematically transforms and displays the measurement data as

though the VNA ports were the specified impedance value. Physically, the test ports are always about

50 ohms.

How to change the System Impedance

Using Hardkey/SoftTab/Softkey

Press Scale > Constants > System Z01.

System Z0 softtab help

Allows you to change the system impedance (default setting is 50 ohms).

Z0  Displays the current system impedance.

For 75 ohm devices:

Change the system Z0 to 75 ohms.1.

Connect minimum loss pads (75 ohm impedance) between the analyzer and the DUT to minimize the
physical mismatch.

2.

Perform a calibration with 75 ohm calibration standards.3.

For waveguide devices

When selecting a Cal Kit with an impedance other than 50 ohms (Waveguide = 1 ohm), it is NO

LONGER NECESSARY to change the System Impedance setting before performing a calibration.
The impedance for the calibration is now derived from the Cal Kit 'Connector' impedance setting.
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Application Notes

The following links require an Internet connection.

Note: Check out the multimedia VNA Demo presentations, including 'Network Analyzer Basics'.

Calibrations

AN1287-11 Specifying Calibration Standards and Kits for Keysight Vector Network Analyzers (5989-4840EN)

PN8510-8A TRL Calibration for Non-Coaxial Measurements (5091-3645E)

Calibrating Standards for In-Fixture Device Characterization (White Paper) (5989-3245EN)

Electronic vs. Mechanical Calibration kits: Calibration methods and accuracy (White Paper) (5988-9477EN)

On-Wafer Calibration Using a 4-port, 20 GHz PNA-L Network Analyzer (N5230A Option 240/245) (5989-2287EN)

ECal

Keysight Electronic vs. Mechanical Calibration Kits: Calibration Methods and Accuracy (5988-9477EN)

User Characterization: Electronic Calibration Feature Allows Users to Customize to Specific Needs (5988-9478EN)

Embedding / De-embedding

De-embedding and Embedding S-Parameter Networks Using a Vector Network Analyzer (5980-2784EN)

Amplifier Measurements

AN1408-7 Amplifier Linear and Gain Measurements (5988-8644EN)

AN1408-8 Amplifier Swept-Harmonic Measurements (5988-9473EN)

AN1408-9 Amplifier and CW Swept Intermodulation-Distortion Measurements (5988-9474EN)

AN1408-10 High-power measurements using the PNA (5989-1349EN)

AN1408-16 Power-Added Efficiency (PAE) 5989-7293EN

AN1408-17 Making Accurate IMD Measurements with the PNA-X Network Analyzer (5989-7265EN)

AN1408-19 High Power Amplifier Measurements Using NVNA

Antenna Measurements

Triggering PNA Microwave Network Analyzers for Antenna Measurements (5988-9518EN)
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New Network Analyzer Methodologies in Antenna/RCS Measurements (5989-1937EN)

Pulsed Antenna Measurements Using PNA Network Analyzers (5989-0221EN)

Antenna and RCS Configurations (White Paper) (5989-0220EN)

Radar Measurements (Application Note) (5989-7575EN)

Balanced Measurements (Although the following refer to the ENA, they are also relevant to the PNA.)

On-wafer Balanced Component Measurement with the Cascade Microtech Probing System (5988-5886EN)

Network De-embedding/Embedding and Balanced Measurement (5988-4923EN)

Backplane Differential Channel Microprobe Characterization in Time and Frequency Domains (White Paper) (5989-
3248EN)

Mixer Measurements

AN1408-1 Mixer Transmission Measurements Using the Frequency Conversion Application (5988-8642EN)

AN1408-2 Mixer Conversion-Loss and Group Delay Measurement Techniques and Comparisons (5988-9619EN)

AN1408-3 Improving Measurement and Calibration Accuracy Using the Frequency Converter Application (5988-
9642EN)

AN1408-18 Measuring Group Delay of Frequency Converters with Embedded Local Oscillators (5989-7385EN)

Comparison of Mixer Characterization using New Vector Characterization Techniques (5988-7827EN)

Novel Method for Vector Mixer Characterization and Mixer Test System Vector Error Correction (5988-7826EN)

Measuring Absolute Group Delay of Multistage Converters Using PNA Microwave Network Analyzers (5989-
0219EN)

Pulsed Measurements

AN1408-11 Accurate Pulsed Measurements (5989-0563EN)

AN1408-12 Pulsed-RF S-Parameter Measurements Using Wideband and Narrowband Detection

AN1408-21 Active-Device Characterization in Pulsed Operation Using the PNA-x (5990-7781EN)

Pulsed Antenna Measurements Using PNA Network Analyzers (5989-0221EN)

Materials Measurements

Basics of Measuring the Dielectric Properties of Materials (5989-2589EN)

Split Post Dielectric Resonators for Dielectric Measurements of Substrates (5989-5384EN)
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Other Measurements

AN1287-12 Time Domain Analysis Using a Network Analyzer (5989-5723EN)

AN1408-14 Using the PNA Series to Analyze Lightwave Components (5989-3385EN)

AN1408-15 Using the PNA for Banded Millimeter-Wave Measurements (5989-4098EN)

AN1408-19 High Power Amplifier Measurements Using NVNA (5990-5039EN)

AN1408-20 High-Accuracy Noise Figure Measurements Using the PNA-X

MM-Wave Network Analyzers: Analysis of Cable Length on VNA System Performance (5989-1941EN)

Ultra-Low Impedance Measurements Using 2-Port Measurements (White Paper) (5989-5935EN)

Modeling

Utilizing TDR and VNA Data to Develop 4-port Frequency Dependent Models (White Paper) (5989-0638EN)

Advanced Measurements and Modeling of Differential Devices (White Paper) (5989-4518EN)

Automation

AN 1408-13 Introduction to Application Development using the PNA (5980-2666EN)

Connectivity Advances for Component Manufacturers (5980-2782EN)

The 'Need for Speed' in Component Manufacturing Test (5980-2783EN)
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Network Analyzer Basics

This self-paced two hour video discusses the basic concepts of Network Analysis.

From the Internet: http://na.support.keysight.com/pna/NaBasics/network_analysis_basics.htm in streaming

format.
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Connector Care

Proper connector care is critical for accurate and repeatable measurements. The following information

will help you preserve the precision and extend the life of your connectors - saving both time and

money.

Connector Care Quick Reference Guide

Connector Cleaning Supplies

Safety Reminders

About Connectors

Gaging Fundamentals

Connector Care Procedures

See Also

mmWave Connector Care at http://na.support.keysight.com/pna/connectorcare/Connector_Care.htm

Preventing Test Port Connector Damage

Handling and Storing Connectors

Do Do Not

Keep connectors clean

Protect connectors with plastic end caps

Keep connector temperature same as analyzer

Touch mating-plane surfaces

Set connectors contact-end down

Store connectors loose in box or drawer

Visual Inspection

Do Do Not

Inspect connectors with magnifying glass.

Look for metal debris, deep scratches or dents

Use a connector with a bent or broken center

conductor

Use a connector with deformed threads

Cleaning Connectors

Do Do Not

Clean surfaces first with clean, dry compressed air Use high pressure air (>60 psi)
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Use lint-free swab or brush

Use minimum amount of alcohol

Clean outer conductor mating surface and threads

Use any abrasives

Allow alcohol into connector support beads

Apply lateral force to center conductor

Gaging Connectors

Do Do Not

Inspect and clean gage, gage master and device

tested

Use correct torque wrench

zero gage before use

Use multiple measurements and keep record of

readings

Use an out of specification connector

Hold connector gage by the dial

Making Connections

Do Do Not

Align connectors first

Rotate only the connector nut

Use correct torque wrench

Cross thread the connection

Twist connector body to make connection

Mate different connector types

Connector Care and Cleaning Supplies

Description Web Site

Swabs http://www.berkshire.com/swabs.shtml

Lint Free Cloths- Air dusters http://www.ccrwebstore.com

Isopropyl http://www.techspray.com

Nitrilite Gloves and Finger Cots http://www.techni-tool.com

Safety Reminders

When cleaning connectors:

Always use protective eyewear when using compressed air or nitrogen.

Keep isopropyl alcohol away from heat, sparks and flame. Use with adequate ventilation. Avoid contact with
eyes, skin and clothing.

Avoid electrostatic discharge (ESD). Wear a grounded wrist strap (having a 1 M  series resistor) when
cleaning device, cable or test port connectors.

Cleaning connectors with alcohol shall only be done with the instruments power cord removed, and in a well-
ventilated area. Allow all residual alcohol moisture to evaporate, and the fumes to dissipate prior to
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energizing the instrument.

About Connectors

Connector Service Life

Connector Grades and Performance

Adapters as Connector Savers

Connector Mating Plane Surfaces

Connector Service Life

Even though calibration standards, cables, and test set connectors are designed and manufactured to the

highest standards, all connectors have a limited service life. This means that connectors can become

defective due to wear during normal use. For best results, all connectors should be inspected and

maintained to maximize their service life.

Visual Inspection should be performed each time a connection is made. Metal particles from

connector threads often find their way onto the mating surface when a connection is made or

disconnected. See Inspection procedure.

Cleaning the dirt and contamination from the connector mating plane surfaces and threads can extend

the service life of the connector and improve the quality of your calibration and measurements. See

Cleaning procedure.

Gaging connectors not only provides assurance of proper mechanical tolerances, and thus connector

performance, but also indicate situations where the potential for damage to another connector may

exist. See Gaging procedure.

Proper connector care and connection techniques yield:

• Longer Service Life • Higher Performance • Better Repeatability

Connector Grades and Performance

The three connector grades (levels of quality) for the popular connector families are listed below. Some

specialized types may not have all three grades.

Production grade connectors are the lowest grade and the least expensive. It is the connector grade most
commonly used on the typical device under test (DUT). It has the lowest performance of all connectors due
to its loose tolerances. This means that production grade connectors should always be carefully inspected
before making a connection to the analyzer. Some production grade connectors are not intended to mate
with metrology grade connectors.
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Instrument grade is the middle grade of connectors. It is mainly used in and with test instruments, most
cables and adapters, and some calibration standards. It provides long life with good performance and tighter
tolerances. It may have a dielectric supported interface and therefore may not exhibit the excellent match of a
metrology grade connector.

Metrology grade connectors have the highest performance and the highest cost of all connector grades.
This grade is used on calibration standards, verification standards, and precision adapters. Because it is a
high precision connector, it can withstand many connections and disconnections and, thus, has the longest
life of all connector grades. This connector grade has the closest material and geometric specifications. Pin
diameter and pin depth are very closely specified. Metrology grade uses an air dielectric interface and a
slotless female contact which provide the highest performance and traceability.

Note: In general, Metrology grade connectors should not be mated with Production grade connectors.

Adapters as Connector Savers

Make sure to use a high quality (Instrument grade or better) adapter when adapting a different

connector type to the analyzer test ports. It is a good idea to use an adapter even when the device under

test is the same connector type as the analyzer test ports. In both cases, it will help extend service life,

and protect the test ports from damage and costly repair.

The adapter must be fully inspected before connecting it to the analyzer test port and inspected and

cleaned frequently thereafter. Because calibration standards are connected to the adapter, the adapter

should be the highest quality to provide acceptable RF performance and minimize the effects of

mismatch.

Connector Mating Plane Surfaces

An important concept in RF and microwave measurements is the reference plane. For a network

analyzer, this is the surface that all measurements are referenced to. At calibration, the reference plane

is defined as the plane where the mating plane surfaces of the measurement port and the calibration

standards meet. Good connections (and calibrations) depend on perfectly flat contact between

connectors at all points on the mating plane surfaces (as shown in the following graphic).
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Gaging Fundamentals

Connector gages are important tools used to measure center conductor pin depth in connectors.

Connector pin depth, measured in terms of recession or protrusion, is generally the distance between

the mating plane and the end of the center conductor, or the shoulder of the center conductor for a

stepped male pin.

Typical Connector Gage

RECESSION PROTRUSION

 

Recession and Protrusion

Pin depth is negative (recession) if the center conductor is recessed below the outer conductor mating

plane, usually referred to as the  "reference plane". Pin depth is positive (protrusion) if the center

conductor projects forward from the connector reference plane.

Pin Depth
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1. Recession of female contact

2. Recession of male pin shoulder

Difference with Type-N Connectors

Type-N connectors have the mating plane of the center conductors offset from the connector reference

plane. In this case the zero setting "gage masters" generally offset the nominal distance between the

center conductor mating plane and the connector reference plane.

When to Gage Connectors

Before using a connector or adapter the first time.

When visual inspection or electrical performance suggests the connector interface may be out of range.

After every 100 connections, depending on use.

Connector Gage Accuracy

Connector gages (those included with calibration and verification kits), are capable of performing

coarse measurements only. This is due to the repeatability uncertainties associated with the

measurement. It is important to recognize that test port connectors and calibration standards have
mechanical specifications that are extremely precise. Only special gaging processes and electrical

testing (performed in a calibration lab) can accurately verify the mechanical characteristics of these
devices. The pin depth specifications in the Keysight calibration kit manuals provide a compromise

between the pin depth accuracy required, and the accuracy of the gages. The gages shipped with
calibration and verification kits allow you to measure connector pin depth and avoid damage from out-

of-specification connectors.

Note: Before gaging any connector, the mechanical specifications provided with that connector or

device should be checked.

To Gage Connectors

1.

2.
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Wear a grounded wrist strap (having a 1 M  series resistor).1.

Select proper gage for device under test (DUT).2.

Inspect and clean gage, gage master, and DUT.3.

Zero the connector gage.

While holding gage by the barrel, carefully connect gage master to gage. Finger-tighten connector nut
only.

a.

Use proper torque wrench to make final connection. If needed, use additional wrench to prevent gage
master (body) from turning. Gently tap the barrel to settle the gage.

b.

The gage pointer should line up exactly with the zero mark on gage. If not, adjust "zero set" knob until
gage pointer reads zero. On gages having a dial lock screw and a movable dial, loosen the dial lock
screw and move the dial until the gage pointer reads zero. Gages should be zeroed before each set of
measurements to make sure zero setting has not changed.

c.

Remove gage master.d.

4.

Gage the device under test.

While holding gage by the barrel, carefully connect DUT to gage. Finger-tighten connector nut only.a.

Use proper torque wrench to make final connection and, if needed, use additional wrench to prevent
DUT (body) from turning. Gently tap the barrel to settle the gage.

b.

Read gage indicator dial for recession or protrusion and compare reading with device specifications.c.

5.

Caution: If the gage indicates excessive protrusion or recession, the connector should be marked for disposal or sent out for

repair.

For maximum accuracy, measure the device a minimum of three times and take an average of the readings.
After each measurement, rotate the gage a quarter-turn to reduce measurement variations.

6.

 If there is doubt about measurement accuracy, be sure the temperatures of the parts have stabilized. Then
perform the cleaning, zeroing, and measuring procedure again.

7.

Connector Care Procedures

Inspecting Connectors

Cleaning Connectors
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Making Connections

Using a Torque Wrench

Handling and Storing Connectors

To Inspect Connectors

Wear a grounded wrist strap (having a 1 M  series resistor).

Use a magnifying glass (>10X) and inspect connector for the following:

Badly worn plating or deep scratches

Deformed threads

Metal particles on threads and mating plane surfaces

Bent, broken, or mis-aligned center conductors

Poor connector nut rotation

Caution: A damaged or out-of-specification device can destroy a good connector attached to it even on

the first connection. Any connector with an obvious defect should be marked for disposal or sent out

for repair.

To Clean Connectors

Wear a grounded wrist strap (having a 1 M  series resistor).1.

Use clean, low-pressure air to remove loose particles from mating plane surfaces and threads. Inspect
connector thoroughly. If additional cleaning is required, continue with the following steps.

2.

Moisten–do not saturate–a lint-free swab with isopropyl alcohol. See Cleaning Supplies for recommended
type.

3.

Clean contamination and debris from mating plane surfaces and threads. When cleaning interior surfaces,
avoid exerting pressure on center conductor and keep swab fibers from getting trapped in the female center
conductor.

4.

2278



4.

Let alcohol evaporate–then use compressed air to blow surfaces clean.5.

Inspect connector. Make sure no particles or residue remains.6.

If defects are still visible after cleaning, the connector itself may be damaged and should not be used.
Determine the cause of damage before making further connections.  

7.

To Make Connections

Wear a grounded wrist strap (having a 1 M  series resistor).1.

Inspect, clean, and gage connectors. All connectors must be undamaged, clean, and within mechanical
specification.

2.

Carefully align center axis of both devices. The center conductor pin–from the male connector–must slip
concentrically into the contact finger of the female connector.

3.

Carefully push the connectors straight together so they can engage smoothly. Rotate the connector nut (not
the device itself) until finger-tight, being careful not to cross the threads.

4.

  

Use a torque wrench to make final connection. Tighten until the "break" point of the torque wrench is
reached. Do not push beyond initial break point. Use additional wrench, if needed, to prevent device body
from turning.

5.
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To Separate a Connection

Support the devices to avoid any twisting, rocking or bending force on either connector.1.

Use an open-end wrench to prevent the device body from turning.2.

Use another open-end wrench to loosen the connector nut.3.

Complete the disconnection by hand, turning only the connector nut.4.

Pull the connectors straight apart.5.

To Use a Torque Wrench

Make sure torque wrench is set to the correct torque setting.1.

Position torque wrench and a second wrench (to hold device or cable) within 90° of each other before
applying force. Make sure to support the devices to avoid putting stress on the connectors.

2.

  HOLD  

CORRECT
METHOD

INCORRECT METHOD

 

(TOO MUCH LIFT)

Hold torque wrench lightly at the end of handle–then apply force perpendicular to the torque wrench handle.
Tighten until the "break" point of the torque wrench is reached. Do not push beyond initial break point.

3.
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3.

TORQUING DIRECTION

STOP WHEN HANDLE BEGINS TO YIELD

To Handle and Store Connectors

Install protective end caps when connectors are not in use.

Never store connectors, airlines, or calibration standards loose in a box. This is a common cause of
connector damage.

Keep connector temperature the same as analyzer. Holding the connector in your hand or cleaning connector
with compressed air can significantly change the temperature. Wait for connector temperature to stabilize
before using in calibration or measurements.

Do not touch mating plane surfaces. Natural skin oils and microscopic particles of dirt are difficult to remove
from these surfaces.

Do not set connectors contact-end down on a hard surface. The plating and mating plane surfaces can be
damaged if the interface comes in contact with any hard surface.

Wear a grounded wrist strap and work on a grounded, conductive table mat. This helps protect the analyzer
and devices from electrostatic discharge (ESD).
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Electrostatic Discharge (ESD) Protection

Protection against electrostatic discharge (ESD) is essential while removing or connecting cables to the

network analyzer. Static electricity can build up on your body and can easily damage sensitive internal

circuit elements when discharged. Static discharges too small to be felt can cause permanent damage.

To prevent damage to the instrument:

Always have a grounded, conductive table mat in front of your test equipment.

Always wear a grounded wrist strap, connected to a grounded conductive table mat, having a 1 MÙ resistor
in series with it, when making test setup connections.

Always wear a heel strap when working in an area with a conductive floor. If you are uncertain about the
conductivity of your floor, wear a heel strap.

Always ground yourself before you clean, inspect, or make a connection to a static-sensitive device or test
port. You can, for example, grasp the grounded outer shell of the test port or cable connector briefly.

Always ground the center conductor of a test cable before making a connection to the analyzer test port or
other static-sensitive device. This can be done as follows:

Connect a short (from your calibration kit) to one end of the cable to short the center conductor to the
outer conductor.

1.

While wearing a grounded wrist strap, grasp the outer shell of the cable connector.2.

Connect the other end of the cable to the test port and remove the short from the cable.3.

See Analyzer Accessories for ESD part numbers.
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Absolute Output Power

An absolute output-power measurement displays absolute power versus frequency.

What is Absolute Output Power?

Why Measure Absolute Output Power?

Accuracy Considerations

How to Measure Absolute Output Power

See other Amplifier Parameters topics

What is Absolute Output Power?

An absolute-output power measurement displays the power present at the analyzer's input port. This

power is absolute-it is not referenced (ratioed) to the incident or source power. In the log mag format,

values associated with the grid's vertical axis are in units of dBm, which is the power measured in

reference to 1 mW.

0 dBm = 1 mW

-10 dBm = 100 W

+10 dBm = 10 mW

In the linear mag format, values associated with the grid's vertical axis are in units of watts (W).

Why Measure Absolute Output Power?

Absolute output power is measured when the amplifier's output must be quantified as absolute power

rather than a ratioed relative power measurement. For example, during a gain compression

measurement, it is typical to also measure absolute output power. This shows the absolute power out of

the amplifier where 1-dB compression occurs.

Accuracy Considerations

The output power of the amplifier should be sufficiently attenuated if necessary. Too much output

power could:
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Damage the analyzer receiver

Exceed the input compression level of the analyzer receiver, resulting in inaccurate measurements.

Attenuation of the amplifier's output power can be accomplished using either attenuators or couplers

The amplifier may respond very differently at various temperatures. The tests should be done when the

amplifier is at the desired operating temperature.

How to Measure Absolute Power

Do the following to measure absolute output power:

Preset the analyzer.1.

Select an unratioed power measurement (receiver B). Learn how.2.

Set the analyzer's source power to 0 dBm.3.

Select an external attenuator (if needed) so the amplifier's output power will be sufficiently attenuated to
avoid causing receiver compression or damage to the analyzer's port-2.

4.

Connect the amplifier as shown in the following graphic, and provide the dc bias.5.

Select the analyzer settings for your amplifier under test.6.

Remove the amplifier and connect the measurement ports together. Store the data to memory. Be sure to
include the attenuator and cables in the test setup if they will be used when measuring the amplifier.

7.

Save the instrument state to memory.8.

Reconnect the amplifier.9.

Select the data math function Data/Memory.10.

11.
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9.

10.

Scale the displayed measurement for optimum viewing and use a marker to measure the absolute output-
power at a desired frequency.

11.

Print or save the data to a disk.12.
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AM-PM Conversion

The AM-PM conversion of an amplifier is a measure of the amount of undesired phase deviation (PM)

that is caused by amplitude variations (AM) inherent in the system.

What Is AM-PM Conversion?

Why Measure AM-PM Conversion

Accuracy Considerations

How to Measure AM-PM Conversion

Other Tutorials topics

What Is AM-PM Conversion?

AM-to-PM conversion measures the amount of undesired phase deviation (PM) that is caused by

amplitude variations (AM) of the system. For example, unwanted phase deviation (PM) in a

communications system can be caused by:

Unintentional amplitude variations (AM)

Power supply ripple

Thermal drift

Multipath fading

Intentional modulation of signal amplitude

QAM

Burst modulation

AM-to-PM conversion is usually defined as the change in output phase for a 1-dB increment in the

power-sweep applied to the amplifier's input (i.e. at the 1 dB gain compression point). It is expressed in

degrees-per-dB (°/dB). An ideal amplifier would have no interaction between its phase response and

the power level of the input signal.
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Why Measure AM-PM Conversion

AM-to-PM conversion is a critical parameter in systems where phase (angular) modulation is used,

such as:

FM

QPSK

16QAM

It is a critical parameter because undesired phase deviation (PM) causes analog signal degradation, or

increased bit-error rates (BER) in digital communication systems. While it is easy to measure the BER

of a digital communication system, this measurement alone does not help you understand the

underlying causes of bit errors. AM-to-PM conversion is one of the fundamental contributors to BER,

and therefore it is important to quantify this parameter in communication systems.

Refer to the I/Q diagram below for the following discussion on how AM-to-PM conversion can cause

bit errors.
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The desirable state change is from the small solid vector to the large solid vector.

With AM-to-PM conversion, the large vector may actually end up as shown with the dotted line. This is due to
phase shift that results from a change in the input power level.

For a 64QAM signal as shown (only one quadrant is drawn), we see that the noise circles that surround each
state would actually overlap, which means that statistically, some bit errors would occur.

Accuracy Considerations

With this method of measuring AM-to-PM conversion, the modulation frequency is approximately the

inverse of the sweep time. Even with the fastest power sweep available on most network analyzers, the

modulation frequency ends up being fairly low (typically less than 10 Hz). This could cause a slight

temperature change as the sweep progresses, especially if the amplifier has low thermal mass, typical of

an unpackaged device. Results using this method could differ slightly if the nonlinear behavior of an

amplifier is extremely sensitive to thermal changes.

The amplifier may respond very differently at various temperatures. The tests should be done when the
amplifier is at the desired operating temperature.

The output power of the amplifier should be sufficiently attenuated if necessary. Too much output power
could:

damage the analyzer receiver

exceed the input compression level of the analyzer receiver, resulting in inaccurate measurements

Attenuation of the amplifier's output power can be accomplished using:

Attenuators

Couplers
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The frequency-response effects of the attenuators and couplers must be accounted for during calibration
since they are part of the test system. Proper error-correction techniques can reduce these effects.

The frequency response is the dominant error in an AM-to-PM conversion measurement setup. Performing a
thru-response measurement calibration significantly reduces this error. For greater accuracy, perform a 2-
port measurement calibration.

How to Measure AM-PM Conversion

Preset the analyzer.1.

Select an S21 measurement in the power-sweep mode.2.

Enter the start and stop power levels for the analyzer's power sweep. The start power level should be in the
linear region of the amplifier's response (typically 10-dB below the 1-dB compression point). The stop power
should be in the compression region of the amplifier's response.

3.

Select an external attenuator (if needed) so the amplifier's output power will be sufficiently attenuated to
avoid causing receiver compression or damage to the analyzer's port 2.

4.

Connect the amplifier as shown in the following graphic, and provide the dc bias.5.

  

Select the analyzer settings for your amplifier under test in order to perform a swept-power gain compression
measurement at a chosen frequency. See Gain Compression.

6.

Remove the amplifier and perform a measurement calibration. Be sure to include the attenuator and cables
in the calibration setup if they will be used when measuring the amplifier.

7.

Save the instrument state to memory.8.

Reconnect the amplifier.9.

Use a reference marker to target the amplifier's input power at the 1-dB gain compression point. Select a
second marker and adjust its stimulus value until its response is 1-dB below the reference marker.

10.

11.
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10.

Change the S21 measurement from a log magnitude format to a phase format (no new calibration is
required).

11.

Find the phase change between the markers. The value is the AM-to-PM conversion coefficient at the 1-dB
gain compression point.

12.

Print the data or save it to a disk.13.
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Amplifier Parameters Reference

Gain

Gain Flatness

Reverse Isolation

Gain Drift Versus Time

Deviation from Linear Phase

Group Delay

Return Loss (SWR, )

Complex Impedance

Gain Compression

AM-to-PM Conversion

See Also

High-Gain Amplifiers

Gain

The ratio of the amplifier's output power (delivered to a Z0 load) to the input power (delivered from a

Z0 source). Z0 is the characteristic impedance, in this case, 50 .

For small signal levels, the output power of the amplifier is proportional to the input power. Small

signal gain is the gain in this linear region.

As the input power level increases and the amplifier approaches saturation, the output power reaches a

limit and the gain drops. Large signal gain is the gain in this nonlinear region. See Gain Compression.
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Gain Flatness

The variation of the gain over the frequency range of the amplifier. See Small Signal Gain and Flatness.

Reverse Isolation

The measure of transmission from output to input. Similar to the gain measurement except the signal

stimulus is applied to the output of the amplifier. See Reverse Isolation.

Gain Drift versus Time (temperature, bias)

The maximum variation of gain as a function of time, with all other parameters held constant. Gain

drift is also observed with respect to other parameter changes such as temperature, humidity or bias

voltage.

Deviation from Linear Phase

The amount of variation from a linear phase shift. Ideally, the phase shift through an amplifier is a

linear function of frequency. See Deviation from Linear Phase.

Group Delay

The measure of the transit time through the amplifier as a function of frequency. A perfectly linear

phase shift would have a constant rate of change with respect to frequency, yielding a constant group

delay. See Group Delay.

Return Loss (SWR, )

The measure of the reflection mismatch at the input or output of the amplifier relative to the system Z0
characteristic impedance.
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Complex Impedance

Complex impedance (1+G). The amount of reflected energy from an amplifier is directly related to its

impedance. Complex impedance consists of both a resistive and a reactive component. It is derived

from the characteristic impedance of the system and the reflection coefficient. See Complex Impedance.

Gain Compression

See Gain Compression Application.

AM-to-PM Conversion Coefficient

The amount of phase change generated in the output signal of an amplifier as a result of an amplitude

change of the input signal.

The AM-to-PM conversion coefficient is expressed in units of degrees/dB at a given power level

(usually P1dB, which is the 1 dB gain compression point). See AM-PM Conversion.
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Antenna Measurements

This topic describes how to setup a Keysight Vector Network Analyzer (VNA) to make S21

measurements on an array of antennas. Measurements can be made on up to 100 antenna arrays (Ports)

and up to 15 discrete frequencies

Measurement Sequence

The VNA is set to a start frequency.1.

As the antenna moves, the VNA responds to each external trigger signal by measuring an antenna port.2.

When all ports are measured, the VNA increments to the next frequency3.

Again the VNA measures all ports, and so forth until all ports are measured at all frequencies in the forward
direction.

4.

As the antenna begins moving in the opposite direction, the same sequence occurs, except the VNA
decrements in frequency until all ports are measured at all frequencies and the VNA is set back to the
original start frequency.

5.

Once setup, only external trigger signals are sent to the VNA. After each trigger, measurement data is

stored in internal VNA memory.

How to set up the VNA

Press Preset1.

Press Trigger > Main > Trigger Source > External2.

Press Trigger > Main > Trigger3.

In the Trigger dialog under Trigger Scope, select Channel4.

Click OK5.

Forward Sweep

Press Trace > Trace N > Trace N to add a new trace.1.

Press Trace > Trace Setup > Measure....2.

Select S21 then Channel Number 13.

4.

5.
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3.

Press Trigger > Main > Trigger4.

In the Trigger dialog under Channel Trigger State, set the Trigger Mode to Point5.

Click OK6.

Press Sweep > Main > Sweep Type > Segment Sweep7.

Click OK8.

Press Sweep > Segment Table > Insert Segment9.

Do this 15 times10.

For each Segment in the Segment table:

Click State:and select ON1.

Click both START and STOP Frequency: (each new segment ascends in frequency)2.

Click Points: type Number of Ports (elements)3.

11.

Reverse sweep

Repeat the following steps for each frequency: (up to 15)

Increment the channel number (X) Starting with Channel 2

Decrement the frequency (F)

Press Trace > Trace N > Trace N to add a new trace.1.

Press Trace > Trace Setup > Measure....2.

Click S21 then Channel Number X3.

When a window contains four traces, press Trace > Trace Setup > Add Trace > New Trace + Window.4.

Click OK5.

Press Trigger > Main > Trigger6.

In the Trigger dialog under Channel Trigger State, set the Trigger Mode to Point7.

Click OK8.

Press Sweep > Main > Sweep Type > Segment Sweep9.

10.
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8.

9.

Click OK10.

Press Sweep > Segment Table11.

In the Segment table

Click State:and select ON1.

Click both START and STOP Frequency F2.

Click Points: type Number of Ports (elements)3.

12.
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Balanced Measurements

What are Balanced Devices?

Differential and Common Modes Model

Measuring Mixed Mode (Balanced) S-Parameters

Measuring Imbalance Parameters

Measuring CMRR

Port Mapping

Calibrating Balanced Measurements

How the analyzer makes Balanced Measurements

Other Measurement Setup Topics

What are Balanced Devices?

Standard Single-ended devices generally have one input port and one output port. Signals on the input

and output ports are referenced to ground.

Balanced devices have two pins on either the input, the output, or both. The signal of interest is the

difference and average of the two input or output lines, not referenced to ground.

Differential and Common Modes Model
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On balanced devices, the signal of interest is the difference and average of the two input or output

lines. In balanced device terminology, these signals are known as the Differential and Common modes.

The following model shows how two signals (A and B) combine to create Differential and Common

mode signals:

Signal A is fixed at 1V peak

Signal B is selectable

Differential is calculated as A minus B

Common is calculated as the AVERAGE of A and B

Note: Click Signal B selections to see various Differential and Common signals.

Signal A =1V    

Differential

(A - B)

 

 

Common

(Avg)

(A + B) / 2

 

 
Signal B =  SELECTABLE Calculations

Single-ended 0V 1 - 0 = 1 (1 + 0)/2 = .5

180° Out of Phase. 1V 1 - (-1) = 2 (1 + (-1))/2 = 0

180° Out of Phase 2V 1 - (-2) = 3 (1 + (-2))/2 = -.5

In Phase       1V 1 - 1 = 0 (1 + 1)/2 = 1

In Phase       2V 1 - 2 = -1 (1 + 2)/2 = 1.5

Notes:

Even when Signal B is 0V, like a Single -ended signal, there is still a unique Differential and Common mode
representation of the two individual signals.

The above model does not show a DUT. The difference and average of two signals can be calculated for
both the balanced INPUT and balanced OUTPUT of a device.

Measuring Mixed Mode (Balanced) S-Parameters
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Mixed mode S-parameters combine traditional S-parameter notation with balanced measurement

terminology.

Some balanced devices are designed to amplify the differential component and reject the common

component. This allows noise that is common to both inputs to be virtually eliminated from the output.

For example, a balanced device may amplify the differential signal by a factor of 5, and attenuate the

common signal by a factor of 5. Using traditional S-parameter notation, an S21 is a ratio measurement

of the device Output / device Input. Mixing this with balanced terminology, we could view the

amplifier's Differential Output signal / Differential Input signal.  To see this parameter on the analyzer,

we would select an Sdd21 measurement using the following balanced notation:

Sabxy -

Where

a - device output mode

b - device input mode

(choose from the following for both a and b:)

d - differential

c - common

s - single ended

x - device output "logical" port number

y - device input "logical" port number

See Also

Logical port mapping

Measuring Imbalance Parameters

Imbalance is a measure of how well two physical ports that make up a balanced port are matched. With

a perfectly balanced port, the same amount of energy flows to both ports and the magnitude of the ratio

of these ports is 1.

The notation is similar to traditional S-parameters. In the following diagrams, the letters a, b, c, and d

are used because any analyzer port can be assigned to any logical port using the port mapping process.  

For example, in the following single-ended - balanced formula, Sba indicates the device output port is

logical port b and the input port is logical port a.
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Imbalance parameter when measuring a balanced

device.

 

Imbalance parameter when measuring a single-ended

- balanced device.

 

Imbalance parameter when measuring a balanced -

single-ended device.
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Imbalance1 and Imbalance2 parameters when

measuring a balanced - balanced device.

 

Imbalance1 and Imbalance2 parameters when

measuring a single-ended - single-ended - balanced

device.

Measuring CMRR (Common Mode Rejection Ratio)

CMRR is a ratio of the transmission characteristic in differential mode over the transmission

characteristic in the common mode of the balanced port as the measurement parameter. A high value

indicates more rejection of common mode, which is desirable in a device that transmits information in

the differential portion of the signal. The table below shows the CMRR parameter you can select when

measuring each balanced device.
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Single-ended - balanced device

Sds21

---------

Scs21

and

Ssd12

---------

Ssc12

Balanced - single-ended device

Ssd21

---------

Ssc21

and

Sds12

---------

Scs12

Balanced - balanced device

Sdd21

---------

Scc21

   

Single-ended - single-ended -

balanced device

Sds31

---------

Scs31

and

Sds32

---------

Scs32

Device Topology and Port Mapping

As we have seen on balanced inputs and outputs, the signal of interest is the difference or average of

two BALANCED input or BALANCED output lines. It is also possible to have single-ended ports

AND balanced ports on the same device. The two balanced input or output lines are referred to as a

single "logical" port.

When configuring a balanced measurement on the analyzer, select a device 'topology'. Then map each

test port to the DUT ports. The analyzer assigns "logical ports". See how to set device topology.

The following device topologies can be measured by a 4-port analyzer.

Balanced / Balanced
(2 logical ports - 4 physical ports)
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Single-ended / Balanced
(2 logical ports - 3 physical ports)

Balanced / Single-ended
(2 logical ports - 3 physical ports)

Single-ended - Single-ended / Balanced
(3 logical ports - 4 physical ports)

These topologies can be used in the reverse (<==) direction to measure:

Balanced / Single-ended topology

Balanced / Single-ended - Single-ended topology

For example, to measure a Balanced / Single-ended topology, measure the S12 (reverse direction) of a
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Single-ended / Balanced topology.

Calibrating Balanced Measurements

Balanced measurements are calibrated in the same manner as single-ended (standard) measurements.

However, for highest accuracy, you must choose Thru paths so that each transmission path of the

balanced measurement is represented. For a Balanced/Balanced topology, this means that FOUR Thru

connections should be made.  

For example (see following image):

Balanced Port 1 is ports 1 and 3

Balanced Port 2 is ports 2 and 4

Thru paths to be calibrated should be: 12, 14, 32, 34.

Paths 13, and 24 are less important.

To select Thru paths:

From SmartCal, on the Select DUT Connectors and Cal Kits page, check Modify Cal.1.

Click Next to see the following Cal Wizard page:2.

How the analyzer makes Balanced Measurements

When using standard Balanced measurements, the analyzer does not provide true balanced

measurements by stimulating both balanced inputs together and measuring both outputs relative to one
another. Instead, the analyzer makes only Single-ended measurements. On a Balanced/ Balanced

device, it stimulates each input and measures each output individually. From the output data, the
analyzer calculates the Differential and Common outputs from the DUT using the same math formulas

as the above model. However, all measurements and calculations are performed in frequency domain
using complex (magnitude and phase) data. The Balanced S-parameter display data is then calculated
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from the Differential and Common inputs and outputs.
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Complex Impedance

When making an S11 or S22 measurement of your device under test, you can view complex-impedance

data such as series resistance and reactance as well as phase and magnitude information. Complex

impedance data can be viewed using either the Smith Chart format or the Polar format.

What Is Complex Impedance?

Accuracy Considerations

How to Measure Complex Impedance

What Is Complex Impedance?

Complex-impedance data is information that can be determined from an S11 or S22 measurement of

your device under test, such as:

Resistance

Reactance

Phase

Magnitude

The amount of power reflected from a device is directly related to the impedances of both the device

and the measuring system. For example, the value of the complex reflection coefficient ( ) is equal to 0

only when the device impedance and the system impedance are exactly the same (i.e. maximum power

is transferred from the source to the load). Every value for  corresponds uniquely to a complex device
impedance (as a function of frequency), according to the equation:

ZL= [(1 + ) / (1 - )]  Z0

where ZL is your test device impedance and Z0 is the measuring system's characteristic impedance.

Complex Impedance is best viewed using either Polar or Smith Chart format.

Accuracy Considerations

The Smith chart is most easily understood when used with a full scale value of 1.0.
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For greater accuracy when using markers in the Smith chart or polar formats, activate the discrete marker
mode.

The uncertainty of reflection measurements is affected by:

Directivity

Reflection tracking

Source match

Load match (with 2-port devices)

With a 2-port calibration, the effects of these factors are reduced. A 1-port calibration provides the

same accuracy if the output of the device is well terminated. Refer to the graphic below for the

following discussion.

If you connect the device between both analyzer ports, it is recommended that you use a 10 dB pad on the
output of the device to improve measurement accuracy. This is not necessary if you use a 2-port calibration
since it corrects for load match.

If you connect a two-port device to only one analyzer port, it is recommended that you use a high-quality load
(such as a calibration standard) on the output of the device.

How to Measure Complex Impedance

Connect the device as shown in the previous graphic.1.

Preset the analyzer.2.

Set up, calibrate, and perform an S11 or S22 measurement.3.

View impedance data:

Select the Smith Chart format.a.

b.

c.

4.
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a.

Scale the displayed measurement for optimum viewing.b.

Position the marker to read the resistive and reactive components of the complex impedance at any
point along the trace.

c.

Print the data or save it to a disk.d.

View the magnitude and phase of the reflection coefficient:

Select the Smith chart format or the Polar format.a.

Select either Lin Marker or Log Marker formats.b.

Scale the displayed measurement for optimum viewing.c.

Position the marker to read the frequency, magnitude, and phase of the reflection coefficient ( ) at any
point along the trace.

d.

Print the data or save it to a disk.e.

5.
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Comparing the VNA "Delay" Functions

The VNA has three Delay functions which are similar but are used in different ways.

1.  Group Delay format is used to display the Group Delay of a network. Group Delay is defined as:

-d(phi)/d(omega) -- where phi is radian angle, and omega is radian frequency.  

Since it is defined by a derivative, the value must be determined from an analytic function. However,

the VNA makes discrete measurements, so we approximate the group delay by taking the finite

difference:

-(1/360)*delta(phi)/delta(f) -- where phi is degree angle and f is frequency in

Hz. The 1/360 does the proper conversion of degrees to radians and Hz frequency to radian

frequency.  

From this we can see that, if the phase response of a network varies with frequency, then the Group

Delay must vary as well.  In fact, many filters are specified by the variation of their Group Delay.  

If we measure the phase response of a lossless cable, it should be a straight line. But, of course, nothing

is perfect.  The phase response will have a small amount of noise. This is due to trace noise of the

VNA, and the loss with real cables or transmission lines, which causes a small amount of non-linear

phase change with frequency.  So, if we look at the Group Delay of a cable, we will see a small amount

of variation.  Also, if the frequency spacing is small enough when you make the measurement, the
delta(f) in the denominator becomes very small, so the delay can have wide swings with just a

little noise.

To overcome this issue, we sometimes add smoothing to a phase trace, which widens the effective
delta(f), called the aperture, and provides a less noisy Group Delay response.  The Group Delay of

a device is only valid for a given frequency aperture. Learn more about Group Delay.

2.  Electrical Delay function.  On many filters, the passband response is specified for a maximum value

of "Deviation from Linear Phase".  When looking at the passband of a multi-pole filter, one sees the

phase changing very rapidly. This makes it difficult to determine the linearity of the phase response.

 The Electrical Delay function subtracts out a "LINEAR PHASE" equivalent to the delay time value

computed as above.   When you use this function, you dial in the Linear Delay such that a CONSTANT

PHASE SLOPE is removed from the phase trace, until the phase trace is mostly flat.  The remaining

variation is the deviation from linear phase.  

To make this task a little less tedious, the VNA has a marker function called Marker =>> Delay. This

function computes the Group Delay value at the marker position, using a 20% smoothing aperture, then
changes the Electrical Delay value to this value. Obviously, if the phase trace is not perfectly linear,

moving the marker and recomputing the delay will result in different values.  The phase slope added by
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the electrical delay function applies only to the current measurement. That is, each measurement (S11,

S22, S12, S21) can have its own value of electrical delay. Learn more about Deviation from Linear Phase.

3.  Port Extension is a function that is similar to calibration. It applies to all the traces in a given

channel.  It compensates for the phase response change that occurs when the calibration reference plane

is not the same as the measurement plane of the device.  

Let's look at an example of a DUT that is mounted on a PCB fixture with SMA connectors. We can

easily calibrate at the SMA connectors. But if we add the fixture to measure the board-mounted device,

the apparent phase of the DUT is changed by the phase of the PCB fixture.  We use port extensions to

add a LINEAR PHASE  (constant delay) to the calibration routines to shift the phase reference plane to

that of the DUT. This is ONLY valid if the fixture consists of a transmission line with linear phase

response, and this limitation is usually met in practice.  The main reason that it is NOT met is that there

is mismatch at the SMA-to-PCB interface. This mismatch was not removed with the error correction

because it occurs AFTER the SMA connector. Ripple can be seen on the display as signals bounce

back and forth between the mismatch and the DUT. If the DUT is well matched, the ripple effect is

very small. However, when we use Automatic Port Extension (APE), and we leave the fixture open

(the DUT removed), the reflection is large and we see larger ripples.  That is why APE uses a curve

fitting process to remove the effects of the ripple.  For best effect, the wider the IF Bandwidth, the

better we can "smooth-out" the ripples with curve fitting.  Still, we are fitting a LINEAR PHASE

SLOPE to the phase response, and thus we use only a single Port Extension Delay value to represent

the phase slope.

The method used by older VNAs to get this same functionality was to add a mechanical line stretcher

to the reference channel, which removed a fixed delay amount from the port. Port extensions give 1x

the delay for transmission at each port, and 2x the delay for reflection, so it differs somewhat from

Electrical Delay above, in that the math function depends upon the measurement being made. The

signal passes twice through the fixture for reflection (out and back), but only once for each port on

transmission.  For S21, the phase slope added is the sum of the port 1 and port 2 Port Extension Delay

values.

The "User Range" APE function is used in cases where a fixture has limited bandwidth, perhaps due to

tuning elements or bias elements.  In this case, the model of constant delay for the fixture over the

whole bandwidth is not valid, so a narrower "User Range" of frequencies can be selected to compute

the delay. Since the aperture is smaller, there is more uncertainty in the delay computation for port

extension.  Also, for those who had been using the Marker =>> Delay function to estimate the delay, we

added the "Active Marker" selection to APE, which works exactly the same as Marker->Delay. Learn
more about Automatic Port Extensions.
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Deviation from Linear Phase

Deviation from linear phase is a measure of phase distortion. The electrical delay feature of the analyzer is

used to remove the linear portion of the phase shift from the measurement. This results in a high-

resolution display of the non-linear portion of the phase shift (deviation from linear phase).

What Is Linear Phase Shift?

What Is Deviation from Linear Phase?

Why Measure Deviation from Linear Phase?

Using Electrical Delay

Accuracy Considerations

See also Comparing the Analyzer Delay Functions

See other Tutorials

What Is Linear Phase Shift?

Phase shift occurs because the wavelengths that occupy the electrical length of the device get shorter as

the frequency of the incident signal increases. Linear phase-shift occurs when the phase response of a

device is linearly proportional to frequency. Displayed on the analyzer, the phase-versus-frequency

measurement trace of this ideal linear phase shift is a straight line. The slope is proportional to the

electrical length of the device. Linear phase shift is necessary (along with a flat magnitude response) for

distortionless transmission of signals.

What Is Deviation from Linear Phase?

In actual practice, many electrical or electronic devices will delay some frequencies more than others,

creating non-linear phase-shift (distortion in signals consisting of multiple-frequency components).

Measuring deviation from linear phase is a way to quantify this non-linear phase shift.

Since it is only the deviation from linear phase which causes phase distortion, it is desirable to remove

the linear portion of the phase response from the measurement. This can be accomplished by using the

electrical delay feature of the analyzer to mathematically cancel the electrical length of the device under

test. What remains is the deviation from linear phase, or phase distortion.
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Why Measure Deviation from Linear Phase?

The deviation from linear phase measurement accomplishes the following:

Presents data in units of phase rather than units of seconds (group delay). For devices that pass modulated
signals, units of phase may be most practical.

Provides a less noisy measurement than a group delay measurement.

Using Electrical Delay

The electrical delay feature is the electronic version of the mechanical "line stretcher" of earlier analyzers.

This feature does the following:

Simulates a variable-length lossless transmission line, which is effectively added to or removed from the
reference signal path.

Compensates for the electrical length of the device under test.

Flattens the measurement trace on the analyzer's display. This allows the trace to be viewed at high
resolution in order to see the details of the phase nonlinearity.

Provides a convenient method to view the deviation from linear phase of the device under test. See the
following graphic.

Learn how to set Electrical Delay.

Accuracy Considerations

The frequency response of the test setup is the dominant error in a deviation from linear phase

measurement. To reduce this error, perform a 2-port measurement calibration.

How to Measure Deviation from Linear Phase:

Preset the analyzer.1.

2.
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1.

If your device under test is an amplifier, it may be necessary to adjust the analyzer's source power:

Set the analyzer's source power to be in the linear region of the amplifier's output response (typically
10-dB below the 1-dB compression point).

Select an external attenuator (if needed) so the amplifier's output power will be sufficiently attenuated
to avoid causing receiver compression or damage to the analyzer's port 2.

2.

Connect the device under test as shown in the following graphic.3.

Select an S21 measurement.4.

Select the settings for your device under test, including the following:

Format: phase

Scale: autoscale

5.

Remove the device and perform a calibration.6.

Reconnect the device.7.

Scale the displayed measurement for optimum viewing.8.

Create a marker in the middle of the trace.9.

Press Marker > Marker -> Functions > Marker -> Delay to invoke the Marker to Electrical Delay function.
This flattens the phase trace.

10.

If desired, on the Scale menu, click Electrical Delay to fine-tune the flatness of the phase trace.11.

Use the markers to measure the maximum peak-to-peak deviation from linear phase.12.

Print the data or save it to a disk.13.
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13.
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20 GHz Coupler Directivity Measurement Example

The purpose of this example is to show how to use the PNA Equation Editor to create a directivity

measurement trace, in order to measure a directional coupler’s directivity easily. Two different

methods, using measurement trace data formatted differently are explained below. Results are

displayed on the bottom left and bottom right hand side windows of the PNA screen. It’s important to

note that either approach produces the same end result, as shown with markers on both equation editor

traces. Measurement trace selection and formatting are critical for making this work correctly. A user

would only need to use one method or the other, but both ways are explained.

 

Set up the connections between the PNA and a directional coupler as shown below.1.

Connect PNA Port 1 to coupler's input port.a.

Connect PNA Port 2 to coupler's output port.b.

Connect PNA Port 3 to coupler's coupled port.c.

Set up basic stimulus conditions for directional coupler's measurement.

Preset the PNA.a.

Set start frequency to 1 GHz.b.

Set stop frequency to 20 GHz.c.

Set power level to the default value.d.

Set IFBW to 30 Hz.e.

2.

Make window setup, trace measurement, and formatting selections.3.

Establish four measurement windows on the display screen.  Set up windows and traces
such that the left-hand side will show traces 1, 2, and 3 in upper left window, as well as
trace 7 in lower-left window. Corresponding to the DUT connection diagram, traces 1, 2,
and 3 will be S21, S31, and S32 measurements, respectively; and all must be
formatted as real. Trace 7, an equation editor trace, will be log magnitude
formatted. Trace 7 will be a S11 trace when it is created, but it will be modified to be a
directivity equation trace later.

For the right-hand side of the display screen, create traces 4, 5, and 6 in upper-right
window, as well as trace 8 in lower right window. Traces 4, 5, and 6, will also be S21,
S31, and S32 measurements, respectively, but these traces are formatted in linear
magnitude. Trace 8, an equation editor trace, will need to be log magnitude formatted,
just like the lower-left window for equation Trace 7. Trace 8 will be a S11 trace when it
is created, but it will be modified to be a directivity equation trace later, too.

4.
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Create the directivity traces for Tr 7 and Tr 8 with the equation editor.4.

Tr 7 will use real formatted data from Tr 1, Tr2, and Tr3 in the equation.

Select Tr 7.a.

From the Marker/Analysis menu, select Analysis, then Equation Editor....b.

Enter the Equation as Dir_from_REAL_Data=S32/(S31*S21).c.

Check the Enable Equation box.d.

Click on OK.e.

Tr 8 will use linear magnitude formatted data from Tr 4, Tr 5, and Tr 6 in the equation.

Select Tr 8.a.

From the Marker/Analysis menu, select Analysis, then Equation Editor....b.

Enter the Equation as Dir_from_LinMag_Data=Tr6/(Tr5*Tr4).c.

Check the Enable Equation box.d.

Click on OK.e.

Note:  Window titles were added to show user comments about the traces in each
window. This is strictly optional, but if desired, window titles can be added by doing the
following:

a.  Select the Response menu, then choose Display, Labels, then Window Title....

b.  In the Window Title dialog box, enter a meaningful title.

c.  Check the Enable box.

d.  Click on OK.

 

Note:  To demonstrate the equivalent results of both equation editor methods for
directivity measurements, marker tables were set up for Tr 7 and Tr 8 in windows 3 and
4, respectively. Again, this is optional, but recommended.

Perform a 3-port calibration.5.

Note: An N4433A-010 ECal module was used in this example.

Display directivity measurement results.

Initiate a single sweep.a.

Observe that Tr 7 and Tr 8 are the same.b.

6.
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a.

b.

 

Discussion

In linear terms, the textbook equation for calculating a coupler's directivity is:

Directivity = Isolation - (Coupling + Loss)

Using log rules, this equation becomes:

Directivity = Isolation / (Coupling * Loss)

 

The PNA equation editor has all the underlying data structures in complex real/imag (linear)
values. All the math in the textbook is also in linear terms, so the equation needs to be
Dir_from_LinMag_Data=Tr6/(Tr5*Tr4). That equation was implemented in Tr 8. 

The equation editor also returns the complex data structure in real/imag, so to get directivity
in dB, set the format to log magnitude for Tr 7 - just like Tr 8. (And the equation is complex,
so phase will be preserved for directivity too, so you can think of this as directivity_re_im.)

For Tr 8 (in dB), the correct directivity is for isolation – (coupling + loss).  But since you cannot
form this equation in equation editor, you have to use the complex form.  So you can refer to
Tr 6, but the reference is to the last complex result, not to the formatted trace.

This equation, Directivity_LogM=20*log(mag(S32/(S31*S21)), while correct (and not used in
this example), will result in the complex value being formed in dB (you are formatting in the
equation editor), so you would need to set the format to real to see the dB value, oddly
enough. So, it is best to use Dir=S32/(S31*S21) and set the format as desired (e.g. Logmag)
to get directivity in dB.
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Dual Band Parallel Noise Figure Measurement

The M9485A Dual Band Parallel Noise Figure measurement can reduce the time of  the noise

measurement figure measurement in multi port measurement. This function is available when M9485A

has option 028 and 720.   

Configuration

The following figure shows an example of Dual Band Parallel Noise Figure measurement.  The DUT

has four power amplifiers and  band-pass filters.

 

 

SPDT switch 1: This switch avoids the noise from the output of port 1 during the noise figure

measurement. Controlled by RFOUT_N signal.

SPDT switch 2: This switch control the LO path in order to supply the different measurement
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frequency for the noise measurements. The frequency f1 is supplied to port 3 and the frequency f2 is

supplied to port 5. Controlled by NOISE_LO2 signal.

I/O Port Setup

The I/O port should be configured as follows in order to control the SPDT switches. Refer to

RPHandler I/O Connector (M9485A) .

Only the port 3 assignment is required to set. The other settings are default.

 

  PORT1 PORT2 PORT3 PORT4 PORT5 PORT6

I/O

1

READY

FOR

TRIGGER

SWEEP

END
RFOUT_N P3 N/A N/A

Trig
EXTERNAL

TRIGGER
INPUT 1 N/A

EXTERNAL

TRIGGER

EXTERNAL

TRIGGER

EXTERNAL

TRIGGER

I/O

2
INDEX OUTPUT1 NOISE_LO2 P4 SYNC SYNC

File format example

3, RFOUT_N, , NOISE_LO2
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Sequence

 

 

Group 1

(Sweep 1)

Ch1: 1 GHz to 2

GHz

Path: B1

S31

S33

NF 1 to 3

Ch2: 5 GHz to 6

MHz

Path: B3

S51

S55

NF 1 to 5

Group 2

(Sweep 2)

Ch3: 3 GHz to 4

GHz

Path: B2

S41

S44

NF 1 to 4

Ch2: 7 GHz to 8

GHz

Path: B4

S61

S66

NF 1 to 6
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' Setup channels Ch1-S31, S33, NF and Ch2-S51, S55, NF for Group1.

SYST:PRES

CALC1:PAR:EXT "tr1","S31"

DISP:WIND1:TRAC1:FEED "tr1"

CALC1:PAR:EXT "tr2","S33"

DISP:WIND1:TRAC2:FEED "tr2"

CALC1:PAR:EXT "tr3","NF"

DISP:WIND1:TRAC3:FEED "tr3"

CALC2:PAR:EXT "tr4","S51"

DISP:WIND1:TRAC4:FEED "tr4"
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CALC2:PAR:EXT "tr5","S55"

DISP:WIND1:TRAC5:FEED "tr5"

CALC2:PAR:EXT "tr6","NF"

DISP:WIND1:TRAC6:FEED "tr6"

 

' Setup channels Ch3-S41, S44, NF and Ch4-S61, S66, NF for Group1.

CALC3:PAR:EXT "tr7","S41"

DISP:WIND2:TRAC7:FEED "tr7"

CALC3:PAR:EXT "tr8","S44"

DISP:WIND2:TRAC8:FEED "tr8"

CALC3:PAR:EXT "tr9","NF"

DISP:WIND2:TRAC9:FEED "tr9"

 

CALC4:PAR:EXT "tr10","S61"

DISP:WIND2:TRAC10:FEED "tr10"

CALC4:PAR:EXT "tr11","S66"

DISP:WIND2:TRAC11:FEED "tr11"

CALC4:PAR:EXT "tr12","NF"

DISP:WIND2:TRAC12:FEED "tr12"

' Set channel coupling. Group1 has Ch1-2, Group2 has Ch3-4.

SYST:CHAN:NOIS:PAR:GROU 2,1,2,3,4

SYST:CHAN:COUP:STATe 1

' Set independent sweep settings for each groups.

SENS1:FREQ:STARt 1e9;STOP 2e9;

SENS2:FREQ:STARt 5e9;STOP 6e9;

SENS3:FREQ:STARt 3e9;STOP 4e9;

SENS4:FREQ:STARt 7e9;STOP 8e9;

' Turn on parallel measurement. First Ch1-2 sweeps at the same time. Then Ch3-4
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sweeps.

SYST:CHAN:NOISe:PARallel:ENABle 1

 

Perform Multi DUT Parallel measurements
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Small Signal Gain and Flatness

Small signal gain is the gain in the amplifier's linear region of operation. This is typically measured at a

constant input power over a swept frequency. Gain flatness is the measure of the variation of gain over

a specified frequency range.

What Is Gain?

What Is Flatness?

Why Measure Gain and Flatness?

Accuracy Considerations

How to Measure Gain and Flatness

See other Amplifier Parameter topics

What Is Gain?

RF amplifier gain is defined as the difference in power between the amplifier output signal and the

input signal. It is assumed that both input and output impedances of the amplifier are the same as the

characteristic impedance of the system.

Gain is called S21 using S-parameter terminology

Gain is expressed in dB-a logarithmic ratio of the output power relative to the input power.

Gain can be calculated by subtracting the input from the output levels when both are expressed in dBm,
which is power relative to 1 milliwatt.

Amplifier gain is most commonly specified as a minimum value over a specified frequency range. Some
amplifiers specify both minimum and maximum gain, to ensure that subsequent stages in a system are not
under or over driven.

What Is Flatness?

Flatness specifies how much the amplifier's gain can vary over the specified frequency range.

Variations in the flatness of the amplifier's gain can cause distortion of signals passing through the

amplifier.
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Why Measure Small-Signal Gain and Flatness?

Deviations in gain over the bandwidth of interest will induce distortion in the transmitted signal

because frequency components are not amplified equally. Small-signal gain allows you to quantify the

amplifier's gain at a particular frequency in a 50-ohm system. Flatness allows you to view the

deviations in the amplifier's gain over a specified frequency range in a 50-ohm system.

Accuracy Considerations

The amplifier may respond very differently at various temperatures. The tests should be done when the
amplifier is at the desired operating temperature.

The output power of the amplifier should be sufficiently attenuated if necessary. Too much output power
could:

damage the analyzer receiver

exceed the input compression level of the analyzer receiver, resulting in inaccurate measurements.

Attenuation of the amplifier's output power can be accomplished using:

attenuators

couplers

The frequency-response effects and mismatches of the attenuators and couplers must be accounted for

during calibration since they are part of the test system. Proper error-correction techniques can reduce

these effects.

The frequency response is the dominant error in a small-signal gain and flatness measurement setup.
Performing a thru-response measurement calibration significantly reduces this error. For greater accuracy,
perform a 2-port measurement calibration.
Reducing IF bandwidth or using averaging improves measurement dynamic range and accuracy, at the
expense of measurement speed.

How to Measure Gain and Flatness

Preset the analyzer.1.

Select an S21 measurement parameter.2.

Set the analyzer's source power to be in the linear region of the amplifier's output response (typically 10-dB
below the 1-dB compression point).

3.

4.
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3.

Select an external attenuator (if needed) so the amplifier's output power will be sufficiently attenuated to
avoid causing receiver compression or damage to the analyzer's port-2.

4.

Connect the amplifier as shown in the following graphic, and provide the dc bias.5.

Select the analyzer settings for your amplifier under test.6.

Remove the amplifier and perform a measurement calibration. Be sure to include the attenuator and cables
in the calibration setup if they will be used when measuring the amplifier.

7.

Save the instrument-state to memory.8.

Reconnect the amplifier.9.

Scale the displayed measurement for optimum viewing and use a marker to measure the small signal gain at
a desired frequency.

10.

Measure the gain flatness over a frequency range by using markers to view the peak-to-peak ripple.11.

Print or save the data to a disk.12.
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Gain Compression

Gain compression measures the level of input power applied to an amplifier that will cause a distorted

output.

What Is Gain Compression?

Why Measure Gain Compression?

Accuracy Considerations

How to Measure Gain Compression

See other Amplifier Parameter topics

What Is Gain Compression?

Gain compression occurs when the input power of an amplifier is increased to a level that reduces the

gain of the amplifier and causes a nonlinear increase in output power.

The analyzer has the ability to do power sweeps as well as frequency sweeps. Power sweeps help

characterize the nonlinear performance of an amplifier. Refer to the graphic below (a plot of an

amplifier's output power versus input power at a single frequency) for the following discussion.

The amplifier has a linear region of operation where gain is constant and independent of power level. The
gain in this region is commonly referred to as "small-signal gain."

As the input power increases, the amplifier gain appears to decrease, and the amplifier goes into
compression.

The most common measurement of amplifier compression is the 1-dB compression point. This is defined as
the input power (or sometimes the output power) which results in a 1-dB decrease in amplifier gain (relative
to the amplifier's small-signal gain).
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Why Measure Gain Compression?

When driven with a sinusoid, the output of an amplifier is no longer sinusoidal in the compression

region. Some of the amplifier output appears in harmonics, rather than occurring only at the

fundamental frequency of the input signal.

As input power is increased even more, the amplifier becomes saturated, and output power remains

constant. At this point, further increases in amplifier input power result in no change in output power.

In some cases (such as with TWT amplifiers), output power actually decreases with further increases in

input power after saturation, which means the amplifier has negative gain.

Since gain is desired in amplifier operation, it is important to know the limit of input signal that will

result in gain compression.

Accuracy Considerations

The network analyzer must provide sufficient power to drive the amplifier into saturation. If you need a

higher input-power level than the source of the analyzer can provide, use a preamplifier to boost the

power level prior to the amplifier under test. If using a preamplifier, you can increase measurement

accuracy in the following ways:

Use a coupler on the output of the preamplifier so that a portion of the boosted input signal can be used for
the analyzer's reference channel. This configuration removes the preamplifier's frequency response and drift
errors from the measurement (by ratioing).

Perform a thru-response calibration including the preamplifier, couplers, and attenuators in the test setup.

The output power of the amplifier should be sufficiently attenuated if necessary. Too much output

power could:

Damage the analyzer receiver

Exceed the input compression level of the analyzer receiver

Attenuation of the amplifier's output power can be accomplished using:

Attenuators

Couplers

The frequency-response effects of the attenuators and couplers must be considered during calibration

since they are part of the test system. Proper error-correction techniques can reduce these effects.
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The frequency response is the dominant error in a gain compression measurement setup. Performing a thru-
response measurement calibration significantly reduces this error.

The amplifier may respond very differently at various temperatures. The tests should be done when the
amplifier is at the desired operating temperature.

Reducing IF bandwidth or using measurement averages improves accuracy, at the expense of measurement
speed.

How to Measure Gain Compression

This procedure shows you how to make the following three measurements used to determine amplifier

gain compression:

A Swept-Frequency Gain Compression measurement locates the lowest frequency at which the 1-dB gain
compression first occurs.

1.

A Swept-Power Gain Compression measurement shows the input power at which a in a 1-dB drop in gain
occurs as a power ramp is applied to the amplifier at a particular frequency point (found in measurement 1).

2.

An Absolute Power measurement shows the absolute power out (in dBm) at compression.3.

Swept-Frequency Gain Compression Measurement

A measurement of swept frequency gain compression locates the frequency point where 1-dB

compression first occurs.

Preset the analyzer.1.

Select an S21 measurement parameter.2.

Set the analyzer's source power to be in the linear region of the amplifier's output response (typically 10-dB
below the 1-dB compression point).

3.

Select an external attenuator (if needed) so the amplifier's output power will be sufficiently attenuated to
avoid causing receiver compression or damage to the analyzer's port-2.

4.

Connect the amplifier as shown in the following graphic, and provide the dc bias.5.

Select the analyzer settings for your amplifier under test. To reduce the effects of noise, you may want to
specify a narrower IF bandwidth.

6.
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6.

Remove the amplifier and perform a thru-response calibration. Be sure to include the attenuator and cables
in the calibration setup if they will be used when measuring the amplifier.

7.

Save the instrument-state to memory.8.

Reconnect the amplifier.9.

Position a marker at approximately mid-span.10.

Adjust the analyzer's scale to 1 dB per division.11.

Store the trace in memory and display Data/Mem.12.

Gradually increase the source power until a 1-dB decrease in gain is observed at the first frequency over
some portion of the trace.

13.

Use markers to locate the frequency where the 1-dB decrease in gain first occurs. Note this frequency for
use in the following measurement.

14.

Print the data or save it to a disk.15.

Swept-Power Gain Compression Measurement

A swept-power gain compression measurement shows the input power resulting in a 1-dB drop in gain

as a power ramp at a particular frequency (found in step 13 of the previous measurement) is applied to

the amplifier.

If not already done, perform the previous measurement of swept-frequency gain compression.1.

Setup an S21 measurement in the power-sweep mode. Include the following settings:

Set the CW frequency to the frequency noted in step 14 of the previous measurement of swept-
frequency gain compression.

2.
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Enter the start and stop power levels for the sweep. The start power should be in the linear region of
the amplifier's response (typically 10 dB below the 1-dB compression point). The stop power should be
in the compression region of the amplifier's response.

Adjust the scale to 1-dB per division.3.

Use markers (including reference marker) to find the input power where the 1-dB decrease in gain occurs.4.

Print the data or save it to a disk.5.

Absolute Output Power Measurement

An absolute-power measurement shows the absolute power-out (in dBm) of the amplifier at

compression.

Select an unratioed (absolute) power measurement. Choose the B input if using the test setup in the previous
graphic.

1.

Retain the CW frequency used in the previous measurement of swept-power gain compression.2.

Set a marker to the input power level where the 1-dB decrease in gain occurs (found in step 4 of the previous
measurement).

3.

Scale the displayed measurement for optimum viewing.4.

Read the marker value to find the absolute output power of the amplifier (in dBm) where the 1-dB decrease in
gain occurs.

5.

Print the data or save it to a disk.6.

Note: The measurement calibration does not apply to absolute power. Therefore, if there is any

attenuation external to the analyzer, you will have to correct for it manually.
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Group Delay

Group delay is a measure of phase distortion. Group delay is the actual transit time of a signal through

a device under test as a function of frequency. When specifying group delay, it is important to specify

the aperture used for the measurement.

What is Group Delay?

Group Delay versus Deviation from Linear Phase

What Is Aperture?

Accuracy Considerations

How to Measure Group Delay

See also Comparing the Delay Functions.

See other Amplifier Parameter topics

What Is Group Delay?

Group delay is:

A measure of device phase distortion.

The transit time of a signal through a device versus frequency.

The derivative of the device's phase characteristic with respect to frequency.

 Refer to the graphic below for the following discussion:
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The phase characteristic of a device typically consists of both linear and higher order (deviations from linear) phase-shift
components. 

Linear phase-shift component: Higher-order phase-shift component:

Represents average signal transit time. Represents variations in transit time for different
frequencies.

Attributed to electrical length of test device. Source of signal distortion.

 

Refer to the graphic below for the following discussion:

In a group delay measurement:

The linear phase shift component is converted to a constant value (representing the average delay).

The higher order phase shift component is transformed into deviations from constant group delay (or group
delay ripple).

The deviations in group delay cause signal distortion, just as deviations from linear phase cause distortion.

The measurement trace depicts the amount of time it takes for each frequency to travel through the device
under test.

Refer to the following equation for this discussion on how group delay is calculated:

2333



Phase data is used to find the phase change (-d ). 

A specified frequency aperture is used to find the frequency change  (d ).

Using the two values above, an approximation is calculated for the rate of change of phase with frequency.

This  approximation represents group delay in seconds (assuming linear phase change over the specified
frequency aperture).

Group Delay versus Deviation from Linear Phase

Group delay is often a more accurate indication of phase distortion than Deviation from Linear Phase.

Deviation from linear phase results are shown in the upper region of the following graphic:
Device 1 and device 2 have the same value, despite different appearances.

Group Delay results are shown in the lower region: Device 1 and device 2 have different values of

group delay. This is because in determining group delay, the analyzer calculates slope of phase

ripple, which is dependent on number of ripples which occur per unit of frequency.

What Is Aperture?

During a group delay measurement, phase is measured at two closely spaced frequencies and then

computes the phase slope. The frequency interval (frequency delta) between the two phase
measurement points is called the aperture. Changing the aperture can result in different values of group
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delay. The computed slope ( -delta phase / delta frequency)  varies as the aperture is increased. This is

why when you are comparing group delay data, you must know the aperture that was used to make the

measurements.

Refer to the graphic below for the following discussion:

Narrow aperture: Wide aperture:

Provides more detail in phase linearity. Provides less detail in phase linearity because some phase
response averaged-out or not measured.

Makes measurement susceptible to noise (smaller signal-
to-noise ratio) and phase detector resolution.

Makes measurement less susceptible to noise (larger
signal-to-noise ratio).

 

Group delay measurements can be made using the following sweep types:

Linear frequency

List frequency sweep segment - The group delay aperture varies depending on the frequency spacing and
point density. Therefore the aperture is not constant in segment sweep. In segment sweep, extra frequency
points can be defined to ensure the desired aperture.

How to set Group Delay Aperture

Using Hardkey/SoftTab/Softkey Using a mouse

Press Format > Format 1 > Group Delay Aperture...1. Click Response1.

Select Format2.

Select Group Delay Aperture3.
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Group Delay Aperture dialog box help

Although the Group Delay Aperture is defined as the difference in frequency between two data

points (see What Is Aperture?), the group delay calculation can be averaged over many adjacent data

points, similar to the smoothing feature. The number of adjacent data points can be set using any of

the following methods:

Note: You can change the default Group Delay Aperture to two points using a Preference. Learn how.

Points  Number of adjacent data points to average. Default setting is 11 points. Choose a value between 2 and the

current number of points in the channel.

Percent of Span  The data points within this percentage of the current frequency span are averaged. Choose a value
between (2 points / current number of points) and 100 percent. The span must contain at least two data points.

Frequency  The data points within this frequency range are averaged. The frequency range must contain at least two

data points.

When the frequency span or number of points is reduced so that the current Group Delay Aperture is NOT attainable, the
Aperture is adjusted to the new frequency span or number of points.

OK  Applies setting changes and closes the dialog box.

Cancel  Closes the dialog. Setting changes are NOT applied.

 

Accuracy Considerations

It is important to keep the phase difference between two adjacent measurement points less than 180  (see the following
graphic). Otherwise, incorrect phase and delay information may result. Undersampling may occur when measuring devices
with long electrical length. You can verify that the phase difference measured between two adjacent points is less than 180  by
adjusting the following settings until the measurement trace no longer changes:

Increase the number of points

Narrow the frequency span

Electrical delay may also be used to compensate for this effect.
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The frequency response is the dominant error in a group delay test setup. Performing a thru-response measurement calibration
significantly reduces this error. For greater accuracy, perform a 2-port measurement calibration.

Particularly for an amplifier, the response may vary differently at various temperatures. The tests should be done when the

amplifier is at the desired operating temperature. 

How to Measure Group Delay

Preset the analyzer.1.

If your DUT is an amplifier, it may be necessary to adjust the source power:

Set the source power to be in the linear region of the amplifier's output response, typically 10 dB below
the 1 dB compression point.

 If needed, use an external attenuator so the amplifier output power will be sufficiently attenuated to
avoid causing receiver compression or damage to test port 2.

2.

Connect the DUT as shown in the following graphic.3.

4.

5.
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Select an S21 measurement.4.

Select the settings for your DUT:

frequency range

number of measurement points.

format: delay

scale: autoscale

5.

Remove the DUT and perform a measurement calibration.6.

Reconnect the DUT.7.

Scale the displayed measurement for optimum viewing.8.

Use the Group Delay Aperture setting to increase the aperture, reducing noise on the trace while maintaining
meaningful detail.

9.

Use the markers to measure group delay (expressed in seconds) at a particular frequency of interest.10.

Print the data or save it to a disk.11.
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High-Gain Amplifier Measurements

When measuring High-Gain Amplifiers, errors in measuring any of the S-parameters during calibration

can result in error in the S21 measurement. This is because all the S-parameters are used in the error

correction math.

A particular problem occurs with high gain amplifiers because the source power is set very low.  Thus,

when making reverse measurements (S22, S12) the signal-to-noise is poor and the raw measurements

can be dominated by noise.  This noise in the raw measurements will result in a noisy trace appearing

for corrected S21 or S11.

If you are using a large attenuator on port 2 (which improves output match), perform an Enhanced

Response Calibration as follows. This corrects for the same errors as the full 2-port correction

EXCEPT the interaction between the raw load match and the DUT output match.

There is NO need to Uncouple the port powers.1.

Set port powers to an acceptable level. Do NOT overpower the test port.2.

Perform Enhanced Response Cal. Learn how. (Does not measure or correct for S12 or S22 port match).3.

If you want to do a full correction (for example, when your amplifier output match is poor so the

Enhanced Response Cal above is not adequate), then...

Uncouple the port powers. Learn how.1.

Set input (port 1) power to approximately the output power of the amplifier up to 0 dBm2.

Set reverse (port 2) power to the same power (for measuring isolation and S22)  3.

Perform a Full 2-port Cal.4.

Re-set the input power (port 1) to a lower power level appropriate for driving the amplifier.5.
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4.

5.

Additional Error due to Mismatch of DUT Output

Match and Raw Load Match
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Phase Measurements

Knowledge of both magnitude and phase characteristics is needed for successful higher-level

component integration.

What are Phase Measurements?

Why Measure Phase?

Using the Analyzer's Phase Format

Types of Phase Measurements

See other Tutorials

What are Phase Measurements?

Phase measurements are made using S-parameters, just like amplitude measurements. A phase

measurement is a relative (ratio) measurement and not an absolute measurement. Phase measurements

compare the phase of the signal going into a device (the incident signal) to the phase of the device's

response signal. The response signal can be either reflected or transmitted. Assuming an accurate

calibration has been performed, the difference in phase  between the two signals (known as phase shift)

is a result of the electrical characteristics of the device under test.

The following graphic shows the phase shift (in time or degrees) between an incident signal and a

transmitted signal (as might be seen on an oscilloscope display).

Why Measure Phase?

Measuring phase is a critical element of network analysis. The following graphic lists five reasons for

measuring both magnitude and phase.
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When used in communications systems to pass signals, components or circuits must not cause

excessive signal distortion. This distortion can be:

Linear, where flat magnitude and linear phase shift versus frequency is not maintained over the bandwidth of
interest.

Nonlinear, such as AM-to-PM conversion.

It is important to measure how reflective a component or circuit is, to ensure that it transmits or absorbs

energy efficiently. Measuring the complex impedance of an antenna is a good example.

Using the Analyzer's Phase Format

The analyzer's phase format displays a phase-versus-frequency or phase-versus-power measurement.

The analyzer does not display more than ±180 degrees phase difference between the reference and test

signals. As the phase value varies between +180 degrees and -180 degrees, the analyzer display creates

the sawtooth pattern as shown in the following graphic.

The sawtooth pattern does not always reach +180 degrees and -180 degrees. This is because the

measurement is made at discrete frequencies, and the data point at +180 degrees and -180 degrees may

not be measured for the selected sweep.
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Types of Phase Measurements

Complex impedance data is information such as resistance, reactance, phase, and magnitude that can be
determined from an S11 or S22 measurement. Complex impedance data can be viewed using either the
Smith Chart format or the Polar format.

AM-to-PM conversion is a measure of the amount of undesired phase deviation (PM) that is caused by
amplitude variations (AM) of the system. AM-to-PM conversion is usually defined as the change in output
phase for a 1-dB increment in the input power to an amplifier (i.e. at the 1 dB gain compression point). This is
expressed in degrees-per-dB (°/dB).

Deviation from linear phase is a measure of phase distortion caused by a device. Ideally, the phase shift
through a device is a linear function of frequency. The amount of variation from this theoretical phase shift is
known as its deviation from linear phase (also called phase linearity).

Group delay is another way to look at phase distortion caused by a device. Group delay is a measure of
transit time through a device at a particular frequency. The analyzer computes group delay from the
derivative of the measured phase response.

Deviation from Linear Phase Versus Group Delay

Although deviation from linear phase and group delay are similar measurements, they each have their

purpose.

The following are the advantages of deviation from linear phase measurements:

Less noisy than group delay.

Able to characterize devices that pass phase modulated signals, and show units of phase rather than units of
seconds.

The following are the advantages of group delay measurements:

More easily interpreted indication of phase distortion than deviation from linear phase.

Able to most accurately characterize a device under test. This is because in determining group delay, the
analyzer calculates the slope of the phase ripple, which is dependent on the number of ripples which occur
per unit of frequency. Comparing two phase responses with equal peak-to-peak phase ripple, the response
with the larger phase slope results in:

More group delay variation.

More signal distortion.
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See also Comparing the Analyzer Delay Functions.
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Reverse Isolation

Reverse isolation is a measure of amplifier reverse transmission response- from output to input.

What is Reverse Isolation

Why Measure Reverse Isolation?

Accuracy Considerations

How to Measure Reverse Isolation

See other Tutorials

What is Reverse Isolation?

Reverse isolation is a measure of how well a signal applied to the device output is "isolated" from its

input.

The measurement of reverse isolation is similar to that of forward gain, except:

The stimulus signal is applied to the amplifier's output port.

The response is measured at the amplifier's input port.

The equivalent S-parameter is S12.

Why Measure Reverse Isolation?

An ideal amplifier would have infinite reverse isolation-no signal would be transmitted from the output

back to the input. However, reflected signals can pass through the amplifier in the reverse direction.

This unwanted reverse transmission can cause the reflected signals to interfere with the desired

fundamental signal flowing in the forward direction. Therefore, reverse isolation is important to

quantify.

Accuracy Considerations

Since amplifiers often exhibit high loss in the reverse direction, generally there is no need for any

attenuation that may have been used to protect the port 2 receiver during forward transmission

measurements. Removing the attenuation will:
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Increase the dynamic range, resulting in improved measurement accuracy.

Require a new calibration for maximum accuracy.

The RF source power can be increased to provide more dynamic range and accuracy.

Note: With the attenuation removed and the RF source power increased, a forward sweep could

damage the analyzer's port 2 receiver. Do not perform a forward sweep or use 2-port calibration unless

the forward power is set low enough to avoid causing port 2 receiver compression or damage.

If the isolation of the amplifier under test is very large, the transmitted signal level may be near the

noise floor or crosstalk level of the receiver. To lower the noise floor:

Use or increase measurement averages.

Reduce the IF bandwidth of the analyzer.

Note: Reducing IF bandwidth or using averaging improves measurement dynamic range and accuracy,

at the expense of reduced measurement speed.

When crosstalk levels affect the measurement accuracy, reduce the crosstalk error term by performing a
response and isolation calibration. When performing the isolation part of the calibration it is important to use
the same average factor and IF bandwidth during the calibration and measurement.

The frequency response of the test setup is the dominant error in a reverse isolation measurement.
Performing a thru-response measurement calibration significantly reduces this error. This calibration can be
done as part of the response and isolation calibration.

The amplifier may respond very differently at various temperatures. The tests should be done when the
amplifier is at the desired operating temperature.

How to Measure Reverse Isolation

Connect the amplifier as shown in the following graphic.1.

2.
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1.

Preset the analyzer.2.

Select an S12 measurement.3.

Select the settings for your amplifier under test.4.

Remove the amplifier and perform a thru-response calibration or a response and isolation calibration.5.

Scale the displayed measurement for optimum viewing and use a marker to measure the reverse isolation at
a desired frequency.

6.

Print or save the data to a disk.7.

 

2347



Reflection Measurements

Reflection measurements are an important part of network analysis.

What are Reflection Measurements?

Why Make Reflection Measurements?

Expressing Reflected Waves

Return Loss

VSWR

Reflection Coefficient

Impedance

Summary of Expressions

See other Tutorials

What are Reflection Measurements?

To understand reflection measurements, it is helpful to think of traveling waves along a transmission

line in terms of a lightwave analogy. We can imagine incident light striking some optical component

like a clear lens. Some of the light is reflected off the surface of the lens, but most of the light continues

on through the lens. If the lens had mirrored surfaces, then most of the light would be reflected and

little or none would be transmitted.

1. Incident    2. Reflected    3. Transmitted

With RF energy, reflections occur when the impedance of two mated devices are not the same. A
reflection measurement is the ratio of the reflected signal to the incident signal. Network analyzers

measure the incident wave with the R (for reference) channel and the reflected wave with the A
channel. Therefore, reflection is often shown as the ratio of A over R (A/R). We can completely

quantify the reflection characteristics of our device under test (DUT) with the amplitude and phase
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information available at both the A and R channel. In S-parameter terminology, S11 is a reflection

measurement of port1 of the device (the input port); S22 is a reflection measurement of the port 2 (the

output port)

Why Make Reflection Measurements?

One reason we make reflection measurements to assure efficient transfer of RF power. We do this

because:

RF energy is not cheap. When energy is reflected, that means less energy is transmitted to where it is
intended to go.

1.

If the reflected energy is large, it can damage components, like amplifiers.2.

For example, in the following graphic, the radio station on the left is not operating at peak efficiency.

The amplifier impedance is not the same as the transmission line, and the transmission line impedance

is not the same as the antenna. Both of these conditions cause high reflected power. This condition

results in less transmitted power, and the high reflected power could damage the amplifier.

The radio station on the right installed properly "matched" transmission line and antenna. Very little of

the transmitted signal is reflected, resulting in increased broadcast power, more listeners, more

advertising revenue, and more profit. The amplifier, transmission, and antenna all need to be measured

to ensure that reflected power is minimized.

Expressing Reflected Waves

After making a reflection measurement, the reflection data can be expressed in a number of ways,

depending on what you are trying to learn. The various expressions are all calculated by the analyzer

from the same reflection measurement data. Each method of expressing reflection data can be

graphically displayed in one or more formats. For more information, see display formats.

Return Loss

The easiest way to convey reflection data is return loss. Return loss is expressed in dB, and is a scalar

(amplitude only) quantity. Return loss can be thought of as the absolute value or dB that the reflected

signal is below the incident signal. Return loss varies between infinity for a perfect impedance match
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and 0 dB for an open or short circuit, or a lossless reactance. For example, using the log magnitude

format on the analyzer, the measured reflection value on the screen may be -18dB. The minus sign is

ignored when expressing return loss, so the component is said to have 18dB of return loss.

VSWR

Two waves traveling in opposite directions on the same transmission line cause a "standing wave".

This condition can be measured in terms of the voltage standing wave ratio (VSWR or SWR for short).

VSWR is defined as the maximum reflected voltage over the minimum reflected voltage at a given

frequency. VSWR is a scalar (amplitude only) quantity. VSWR varies between one for a perfect match,

and infinity for an open or short circuit or lossless reactance.

Reflection Coefficient

Another way of expressing reflection measurements is reflection coefficient gamma ( ). Gamma

includes both magnitude and phase.

The magnitude portion of gamma is called rho ( ). Reflection coefficient is the ratio of the reflected

signal voltage to the incident signal voltage. The range of possible values for  is between zero and

one. A transmission line terminated in its characteristic impedance will have all energy transferred to

the load; zero energy will be reflected and  = 0. When a transmission line terminated in a short or

open circuit, all energy is reflected and  = 1. The value of rho is unitless.

Now for the phase information. At high frequencies, where the wavelength of the signal is smaller than

the length of conductors, reflections are best thought of as waves moving in the opposite direction of

the incident waves. The incident and reflected waves combine to produce a single "standing" wave with

voltage that varies with position along the transmission line.

When a transmission line is terminated in its characteristic impedance (Zo) there is no reflected signal.

All of the incident signal is transferred to the load, as shown in the following graphic. There is energy

flowing in one direction along the transmission line.

  Zo

Incident

Voltage

Reflected

Voltage = 0

  (All the incident power is absorbed in the load)

 

When a transmission line is terminated in a short circuit termination, all of the energy is reflected back

to the source. The reflected wave is equal in magnitude to the incident wave (  = 1). The voltage across
any short circuit is zero volts. Therefore, the voltage of the reflected wave will be 180 degrees out of

phase with the incident wave, canceling the voltage at the load.
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When a transmission line is terminated in an open circuit termination, all of the energy is reflected back

to the source. The reflected wave is equal in magnitude to the incident wave (  = 1). However, no

current can flow in an open circuit. Therefore, the voltage of the reflected wave will be in phase with

the voltage of the incident wave.

When a transmission line is terminated in a 25 ohm resistor, some but not all of the incident energy will

be absorbed, and some will be reflected back towards the source. The reflected wave will have an

amplitude 1/3 that of the incident wave and the voltage of the two waves will be out of phase by 180

degrees at the load. The phase relationship will change as a function of distance along the transmission

line from the load. The valleys of the standing wave pattern will no longer go to zero, and the peaks

will be less than that of the open / short circuit.

For more information, see Phase Measurements.

Impedance
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Impedance is another way of expressing reflection data. For more information on Impedance, see Smith
Charts.

Summary of the Expressions of Reflection Measurements:
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Avg BW

Standard

GCA

NF
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Cal

Standard Cal

Scalar Mixer/Converter Cal
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Channel

Channel 1-8

Channel 1-8

Channel Setup

Select

Meas Class...

Add Channel

Copy Channel

Delete Channel
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Display

Window 1-8

Windows 1-8

Window Setup

Select: Select the desired window.

Window Title...

Add Window

Delete Window

Move Window...

Window Layout

Window Max

Sheet Setup

Select

Sheet Title...

Add Sheet

Delete Sheet

Sheet Layout

Display Setup

Customize Display...

Display Update
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Format

Format 1

Log Mag

Lin Mag

Phase

Delay

Smith

Polar

SWR

Group Delay Aperture...

Format 2

Real

Imaginary

Unwrapped Phase

Positive Phase

Inverted Smith
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Freq

Standard

Scalar Mixer/Converter
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Macro

Favorite1-3

To Add a Favorite, press and hold any softkey for three seconds and select the desired Favorite

number (Favorite 1 to 3).

Macro1-3

VMC

Key Setup

Macro Setup...

Clear Favorites : Clear all favorites items
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Marker

Marker 1-7

Marker 1 to 7

Reference

Marker 8-15

Market 8 to 15

Marker Setup

Delta

Discrete

Type

Format

Coupled

Marker Display...

Marker Table

All Off

Marker -> Functions

Marker -> Start

Marker -> Stop

Marker -> Center

Marker -> Span

Marker -> Ref Level

Marker -> Delay

Marker -> CW Freq

2360



2361



Math

Memory

Data -> Memory

Normalize

Data Math

Display

8510 Mode

Interpolate

Analysis

Conversions

Equation Editor...

Statistics...

Limits...

Limit Table

Time Domain

Transform

Start Time

Stop Time

Center Time

Span Time

TD Mode

TD Toolbar

Time Domain Setup...
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Time Gating

Gating

Gate Start

Gate Stop

Gate Center

Gate Span

Gate Type

Gate Shape

Gating Setup...
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Meas

Standard

Scalar Mixer/Converter
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Power

Standard

Scalar Mixer/Converter
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Preset

Main

Preset

User Preset ...

Confirm Preset
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Save Recall

Recall

Recall State

Recall State

Recall State...

Recall Register

Recall Calset...

Recall Data...

Recall Order

Save State

Save State

Auto Save

Save State As...

Save Register

Save Type

Delete State

Save Other

Save Calset...

Save Data...

Save Screen...

Save User Preset...

Manage Files...
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Scale

Main

Autoscale

Autoscale All

Scale

Reference Level

Reference Position

Scale Coupling

Electrical Delay

Delay Time

Delay Distance

Distance Units

Velocity Factor

Media

Wavegd Cutoff

Constants

System Z0

Phase Offset

Mag Offset

Mag Slope
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Search

Main

Max Search

Min Search

Domain

Domain Start

Domain Stop

Tracking

Peak

Peak Search

Peak Right >> Search

<< Peak Left Search

Next Peak Search

Threshold

Excursion

Peak Polarity

Tracking

Target

Target Search

Target Right >> Search

<< Target Left Search

Target Value

Transition

Tracking
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Multi Peak & Target

Multi Peak Search

Peak Threshold

Peak Excursion

Peak Polarity

Multi Target Search

Target Value

Transition

Tracking

Bandwidth & Notch

Bandwidth Search

BW Ref To

BW Level

Notch Search

Notch Ref To

Notch Level

Tracking

Comp & Sat

Compression Search

Comp Level

Saturation Search

Pmax Backoff

Tracking

Normal Op Pt
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Normal OP Search

Backoff

Pin Offset

Tracking
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Setup

Standard

Scalar Mixer/Converter
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Sweep

Standard

Scalar Mixer/Converter
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System

Main

Show Taskbar: Show the Windows Taskbar

Move App to Back

Minimize Application

Exit: Exit the VNA application

Security...

Control Panel... : Open Windows Control Panel

Manage Files... : Open Windows File Explore

System Setup

Next/Prev Keys : Select Next/Previous window/channel/trace for the selected one

Preferences...

Sound: Turn On/Off beep sound

Remote Interface...

Print

Print...

Print to File...

Page Setup...

Print Colors...

Help

NA Help...

On The Web... : Connect to the Web on the keysight.com.
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Error Display...

View Error Log...

About NA...

Service

Update Firmware

Verification

Operator's Check

System Power Cal... (M948xA only)

System Verification

Adjustment Routines

Diagnostics

Receiver Display

Receiver Temperature

Option Enable
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Trace

Trace 1- 7/ 8-15

Trace 1-15

New Traces...

Trace Setup

Select

Measure

Trace Title...

Add Trace

Delete Trace

Move Trace...

Trace Hold

Trace Maximize
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Trigger

Main

Hold

Single

Groups

Continuous

Manual Trigger

Restart

Trigger Source

Trigger...

2377



Undo

Main

Undo

Redo

Return To Task

Clear Undo History
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Glossary

 

A B C D E F G H I J K L M

N O P Q R S T U V W X Y Z

12-Term Error Correction See Error Correction, 12-Term.

1-Port Device A device with a single connector or path to the device's circuitry. Examples include an

oscillator and a load.

2-Port Calibration, Full See Error Correction, 12-Term.

2-Port Device A device with two connectors or other paths to the device's circuitry. Examples include

filters, SAW devices, attenuators, matching pads, and amplifiers.

3-Term Error Correction See Error Correction, 3-Term.

A

Active Channel The highlighted channel affected by front panel functions.

Active Function Readout The area of a display screen where the active function and its state are

displayed. The active function is the one that was completed by the last key selection or remote

programming command.

Active Marker The marker on a trace that can be repositioned either by front panel controls or by

programming commands.

Active Trace A trace that is being swept (updated) with incoming signal information.

ADC Analog to Digital Converter

Address The identification (represented by a name, label, or number) for a register, location in storage,

or any other data source or destination. Examples are the location of a station in a communications

network, or a device on the GP-IB.

ADM Add-Drop Multiplexer

Admittance (Y) The inverse of an impedance (i.e. the ratio of current to voltage). Complex

admittances take the form Y = G + jB(t).

ALC Automatic Level Control. See Automatic Gain Control.
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AM Amplitude Modulation

AM Group Delay A technique for the measurement of group delay through a device which utilizes an

amplitude modulated (AM) source. Note: The actual delay of the modulation envelope is measured

directly with an external scalar detector. Devices that distort the amplitude of a signal cannot be

measured. These include amplifiers with automatic gain control (AGC) and devices subject to

saturation or power limiting.

Amplitude Modulation The process, or result of the process, of varying the amplitude of a carrier

signal. The resulting modulated carrier contains information that can be recovered by demodulation.

See also Modulation.

Analog The general class of devices or circuits in which the output varies as a continuous function of

the input.

Annotation The labeling of specific information on the display (such as frequency or power).

ANSI American National Standards Institute: A national membership organization (open to

manufacturers, organizations, users, and communications carriers) that approves standards, accredits

standards development groups and certificate programs, and represents and coordinates US interests in

non-treaty and non-government standards bodies.

Aperture The frequency span of the network analyzer used for calculating group delay. The narrower

the aperture, the finer the resolution of the group delay variations, but noise is reduced by increasing

the aperture.

Array A set of numbers or characters that represents any given function.

ASCII American Standard Code for Information Interchange

Attenuation Denotes a reduction in signal amplitude. The difference between transmitted and received

power due to loss through equipment, lines, or other transmission devices; usually expressed in

decibels.

Attenuator An RF or microwave device used to reduce the power level of a signal by precise,

incremental amounts over its entire frequency range.

Automatic Calibration System AutoCal: Feature offered on Rohde&Schwarz network analyzers.

Automatic Gain Control (AGC) A circuit used in amplifiers and other active devices to keep its RF

power level constant as other parameters change, such as frequency. Synonym: Automatic Leveling

Control (ALC)

Autoscale An analyzer feature that evaluates waveforms and adjusts controls to stable and enhance the

display.
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AUX Auxiliary; refers to rear-panel input connector.

Averaging A noise reduction technique that computes each data point based on consecutive sweeps

and weighted by a user-specified averaging factor. Each new sweep is averaged into the trace until the

total number of sweeps is equal to the averaging factor.

B

B/R The ratio of data sampled at B to the data sampled at R.

Band Pass A range of frequencies that are passed through a device, such as a filter. Frequencies not

within the band pass are limited or attenuated. See also Cutoff Frequency.

Bandwidth (BW) The difference between the frequencies of a continuous frequency band within

which performance of a device falls within specifications.

Bandwidth Limit The condition prevailing when the system bandwidth is exceeded and signal

distortion occurs beyond specifications.

Bandwidth Selectivity A measure of a filter's ability to resolve signals unequal in amplitude. It is the

ratio of the 60 dB bandwidth to the 3 dB bandwidth for a given resolution filter (IF). Bandwidth

selectivity tells us how steep the filter skirts are. Bandwidth selectivity is sometimes called shape

factor.

Binary A method of representing numbers in a scale of two (on or off, high-level or low-level, one or

zero). A compact, fast format used to transfer information to and from the analyzer.

BMP Bit-Mapped

Brightness See Color Brightness.

Broadband Device A device that operates over a very wide frequency range and exhibits only small

variations in response over that range.

Buffer A storage device used when transmitting information to compensate for a difference in the rate
of flow of information between two devices.

Burst Carrier A carrier that is periodically turned off and on. A burst carrier may or may not be

modulated.

BUS Basic Utility System

Bus One or more conductors used as a path to deliver transmitted information from any of several

sources to any of several destinations.
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BW Bandwidth

Byte Eight bits of data representing one character processed as a unit.

C

CAD Computer Aided Design

CAE Computer Aided Engineering

Calibration In HP instrumentation, the process of periodically (usually annually) verifying an

instrument is performing to specifications. A calibration certificate is awarded after verification.

In network analyzers, the process of removing systematic errors from measurements. See Error
Correction.

Calibration Kit Hardware and software required to perform error correction on a network analyzer for

a specific measurement and/or test set.

Calibration, 2-Port See Error Correction,12-Term.

Calibration, Blackburn Calibrations of transmission path with corrected source match involving 15

calibration terms. Synonym: 15-term error correction

Calibration, Frequency Response The simplest error correction procedure to perform, but only

corrects for a few of the twelve possible systematic error terms. Frequency response corrections can be

made for reflection measurements, transmission measurements, and isolation measurements.

Calibration, Interpolation A user selectable network analyzer feature that calculates (interpolates)

new error correction terms from existing terms when there is a change in network analyzer parameters,

such as IF bandwidth, power, or sweep time. The resulting error correction is not as accurate as

completing a full 2-port calibration.

Calibration, Port Extension See Port Extension.

Calibration, Reference Plane See Reference Plane.

Calibration, Set Z Sets the system impedance, usually 50 or 75 ohms.

Calibration, SOLT A calibration using four known standards: Short-Open-Load-Through. Also
known as a full two-port calibration and 12-term error correction. See also Error Correction.

Calibration, TRL and LRM A calibration used in environments where the DUT cannot be connected

directly to the network analyzer ports, (MMIC, microstrip, beam-lead diodes etc.). Thru-Reflect-Line

(TRL) and M (Match) standards are fabricated and used because known high-quality standards are not
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readily available. The requirements for characterizing these standards are less stringent, but the

calibration is not as accurate as the traditional full two-port calibration using S-O-L-T standards. The

terms are used interchangeably (TRL, LRL, LRM etc.) but they all refer to the same basic calibration

method.

Characteristic Impedance The impedance looking into the end of an infinitely long lossless

transmission line.

Color Brightness A measure of the intensity (brightness) of a color.

Command A set of instructions that are translated into instrument actions. The actions are usually

made up of individual steps that together can execute an operation.

Continuous Sweep Mode The analyzer condition where traces are automatically updated each time

trigger conditions are met.

Controller A device capable of specifying the talker and listeners for an information transfer. An

external computer connected to an instrument to control its operation.

Corrected Measurements made after performing error correction.

Coupler See Directional Coupler.

CPU Central Processing Unit

Crosstalk The occurrence of a signal at one port of a device being affected by a signal in any other

path. Isolation is the measurement of crosstalk.

Cursor An electronically generated pointer that moves across the display to manipulate controls.

Cutoff Frequency In filters, the frequency at which attenuation is 3dB below the band pass signal

level, known as the 3dB points.

CW Continuous wave: A single frequency (rather than a swept frequency).

D

DAC Digital to Analog Converter

dB Decibel: a relative unit of measure. The ratio in dB is given by: 10 log10 (P1/P2) where P1 and P2
are the measured powers. The dB is preferred instead of arithmetic ratios or percentages because when
components are connected in series, their effect on power, expressed in dB, may be arithmetically

added and subtracted. For example, if a 3dB attenuator is connected to a 10dB amplifier, the net gain of
the two components is (-3dB + 10dB = +7dB).
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dBm Absolute unit of measure in decibels: 0dBm = 1 mW. The conventions of the dB (adding and

subtracting) continue to apply.

DBMS Database Management System

DC Direct Current

Default A known set of conditions used in the absence of user-defined conditions.

Delay See Group Delay.

Demodulation The process of recovering from a modulated carrier, information in the form of a signal

having essentially the same characteristics as the original modulating signal. Recovery of the

modulating signal accomplished by signal detection.

Detection The process of demodulating signal carriers. There are two basic ways of providing signal

detection in network analyzers: Diode detectors (used in broadband applications) and heterodyning,

(used in narrowband applications).

Detector, Diode A device used to convert a RF signal to a proportional DC level. If the signal is

amplitude modulated, the diode strips the RF carrier signal from the modulation. Many sources used

with scalar analyzers are amplitude modulated with a 27.778 kHz signal and then detected in the

network analyzer. Phase information on the signal carrier is lost in diode detection.

Deviation from Linear Phase Linear phase refers to the nature of the phase shift of a signal through a

device. The phase is linear if a plot of phase shift versus frequency is a straight line using linear scales.

Deviation from linear phase causes signal distortion.

Digital Pertaining to the class of devices or circuits in which the output varies in discrete steps.

Digital Demodulation Describes a technique of extracting the information used to modulate a signal.

Digital signal processing algorithms are used on the signal after it has been converted from an analog to

a digital form (digitized).

Dimension To specify the size of an array. The number of array rows or columns.

Directivity In a 3-port directional coupler, the ratio of the power present at the auxiliary port when the

signal is traveling in the forward direction to the power present at the auxiliary port when the same

signal is traveling in the reverse direction.

Directional Coupler A 3-port device typically used for separately sampling the backward (reflected)

wave in a transmission line.

Disk A circular, magnetic storage medium.

Display Noun: See Screen.
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Verb: To show annotation and measurement data on the display.

Display Detector Mode The manner in which analog, video information is processed prior to being

digitized and stored in memory.

Display Dynamic Accuracy The amplitude uncertainty, usually in dB, over the display dynamic range.

Display Dynamic Range The amplitude range, in dB, over which the display dynamic accuracy

applies.

Display Formats Graphical formats for displaying measurement data. These include single channel,

overlay (multiple traces on one graticule), split (each trace on separate graticules).

Display Modes The ways in which measurement data can be presented graphically. On a network

analyzer, the choices are Cartesian/rectilinear (XY plot with log or linear magnitude, phase, group

delay, SWR, real and imaginary, and dBV, dBmV and dBuV), polar (magnitude and angle), magnitude

and phase, and Smith chart. Not all display modes are available on all network analyzers. In addition,

displays can present this information in various combinations of traces. Common modes are dual, (the

ability to display more than one trace, usually over the same frequency range), and alternate, (the ability

to display more than one trace, each with different frequency range and type).

Display Phase Dynamic Accuracy The phase measurement uncertainty, usually in degrees, for

measurements whose units are in degrees.

Display Points The total number of measurement points made in a single measurement. The points can

be in units of frequency, power, or time. The number of points often dictates measurement speed,

resolution, and aperture.

Display Trace Noise, Magnitude The amplitude uncertainty of the trace, in dB, due to random noise

in the test system.

Display Trace Noise, Phase The phase uncertainty of the trace, in degrees, due to random noise in the

test system.

Display Type The type of display screen built into the analyzer. Data can be displayed as a raster

drawing (a computer-like dot map) or as a vector drawing (lines drawn on the display). Color and
display standard can also be specified as monochrome (single color), or color (two or more colors). The

format standard may also be specified, such as VGA or SVGA, for IBM-compatible personal
computers.

Distortion Deterioration of a signal's quality due to the nonlinear characteristics of a device or system

transfer function. Distortion is measured as a combination of the changes in amplitude, frequency and

phase of signal at the output of a device or system as compared to the signal at the input.

Drift The slow change in signal frequency.
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DSP Digital Signal Processing

DUT Device Under Test

DVM Digital Volt Meter

Dynamic Range In a receiver, the range of signal levels, from minimum to maximum, that can be

reliably measured simultaneously. Dynamic range allows small signals to be measured in the presence

of large signals. Source power and receiver compression usually limits the maximum boundary to

dynamic range. Receiver residual responses and noise floor usually limit the minimum power

boundary.

E

ECal See Electronic Calibration.

Electrical Delay A simulated variable length of lossless transmission line, added to or subtracted from

a receiver input, to compensate for interconnecting cables. The firmware equivalent of mechanical or

analog "line stretchers" in other network analyzers.

Electronic Calibration (ECal) A calibration system for electronic calibration of RF and microwave

vector network analyzers. The electronic calibration system creates a twelve-term, two-port error model

and then provides a confidence check of the calibration. The Ecal system consists of a repeatable,

variable-impedance, solid-state calibration standard and a mainframe control unit which interfaces with

the 8510, 8720 series, and the 8753 network analyzers or a USB module which interfaces with the PNA

series network analyzers.

EMC Electro-Magnetic Compatibility

EMI Electro-Magnetic Interference: Unintentional interfering signals generated within or external to

electronic equipment. Typical sources could be power-line transients, noise from switching-type power

supplies and/or spurious radiation from oscillators. EMI is suppressed with power-line filtering,

shielding, etc.

Engage To activate a function.

Enter The process of inputting information.

EPROM Electronically Programmable, Read-Only Memory

Error Correction In network analyzers, a process that removes or reduces systematic (repeatable)

measurement errors by measuring known standards from a calibration kit. Synonym: measurement

calibration
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Error Correction, 3-Term Used to remove systematic measurement errors on a device with one port,

such as a load.

Error Correction, 12-Term Correction for a two port device using six parameters:

Directivity

Source match

Load match

Reflection frequency response

Transmission frequency response

Isolation

To completely characterize a two-port device, these six parameters must be characterized in the

forward and reverse directions, making a total of 12 terms. The user usually has the option of omitting

isolation from the correction process. Synonym: Full two-port error correction

Error Correction, 1-Port Corrects a test set for port 1 or port 2 directivity, frequency response, and

source match errors. The process requires three known standard terminations, for example, open, short,

and load.

Error Message A message on a display that indicates an error condition. Missing or failed hardware,

improper user operation, or other conditions that require additional attention can cause an error

condition. Generally, the requested action or operation cannot be completed until the condition is

resolved.

ESD Electro Static Discharge

Ethernet A network that adheres to the IEEE 802.3 Local Area Network standard.

Ethernet address A hexadecimal number which is used to identify a machine on a network. Each

analyzer is assigned a unique Ethernet address at the factory and it is stored in the analyzer's ROM.

External trigger signal A TTL signal that is input to an analyzer and initiates a measurement sweep or
similar event, making the measurements synchronous with the external triggering source.

F

Filter A passive device that allows some frequencies to pass and attenuates others, depending on the

type and specifications. A high-pass filter passes frequencies above the cutoff frequency, a low-pass

filter passes frequencies below the cutoff frequency, and a band-pass filter passes frequencies between

two specific frequencies.

Firmware An assembly made up of hardware and instruction code. The hardware and instruction code
is integrated and forms a functional set that cannot be altered during normal operation. The instruction

2387



code, permanently installed in the circuitry of the instrument, is classified as ROM (read only memory).

The firmware determines the operating characteristics of the instrument or equipment.

Flatness The amplitude and phase response of a device under test (DUT), a signal source, a receiver, or

a combination of these. See also Frequency Response.

FM Frequency Modulation

Frequency The number of periodic oscillations, vibrations, or waves per unit of time, usually

expressed in cycles per second, or Hertz (Hz).

Frequency Accuracy The uncertainty with which the frequency of a signal or spectral component is

indicated, either in an absolute sense or relative to another signal or spectral component. Absolute and

relative frequency accuracies are specified independently.

Frequency Range The range of frequencies over which a device or instrument performance is

specified.

Frequency Resolution The ability of a network analyzer to measure device characteristics at closely

spaced frequencies and display them separately. Resolution of equal amplitude responses is determined

by IF bandwidth. Resolution of unequal amplitude responses is determined by IF bandwidth and

bandwidth selectivity.

Frequency Response The peak-to-peak variation in the displayed amplitude response over a specified

center frequency range. Frequency response is typically specified in terms of dB, relative to the value

midway between the extremes.

Frequency Span The magnitude of the displayed frequency component. Span is represented by the

horizontal axis of the display. Generally, frequency span is given as the total span across the full

display. Some analyzers represent frequency span (scan width) as a per-division value.

Frequency Stability The ability of a frequency component to remain unchanged in frequency or

amplitude over short and long-term periods of time. Stability refers to an oscillator's ability to remain

fixed at a particular frequency over time.

Front Panel Key Keys that are located on the front panel of an instrument. The key labels identify the
function the key activities. Numeric keys and step keys are two examples of front panel keys.

Full 2-Port Calibration See Error Correction, 12-Term.

Function The action or purpose that a specific item is intended to perform or serve. The network
analyzer contains functions that can be executed via front panel key selections, or through

programming commands. The characteristics of these functions are determined by the firmware in the
instrument. In some cases, a DLP (downloadable program) execution of a function allows you to

execute the function from front panel key selections.
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Fundamental Frequency In any waveform, the lowest frequency component; all other components are

harmonics. A pure sinusoid has only one component, the fundamental.

G

Gb Gigabit

GB Gigabyte

GHz Gigahertz

GIF Graphics Interchange Format - Standard graphic format to store bitmapped graphics files.

Giga Prefix for one billion.

GP I/0 General Purpose Input / Output; a connector usually on the back of an instrument that allows

communication with other test equipment, external test sets, switches, and computers that enable the

instrument to be triggered or to trigger external equipment. An example is a foot switch that continues

or cycles a measurement, allowing the operator to use both hands on the test hardware.

GPIB General Purpose Interface Bus - IEEE 488 bus is interconnect bus and protocol, allows linking

of instruments and computer.

Graticule (or Grid) Enclosed area where waveform is displayed on instrument. Tick marks, on frame

or axis, are a scaling aid for making visual measurements.

Group Delay A measure of the transit time of a signal through a DUT versus frequency. Group delay

can be calculated by differentiating the DUT's insertion-phase response with respect to frequency. See

also AM Group Delay and Deviation from Linear Phase.

GUI Graphical User Interface

H

Hardcopy Paper copy of data.

Hardkey A front-panel key, which engages a single analyzer function or presents a single menu of

softkeys.

Horizontal Reference See Reference Level.

Horizontal Resolution The analyzer's ability to take closely spaced horizontal data points over the full

sweep.
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Host Computer A computer or device on a network that provides end users with services such as

computation and database access and that usually performs network control functions.

Host Name A unique name that is used to identify each host machine on a network. The host name is

directly linked to, and can usually be used in place of, the IP address. The user or the system

administrator usually creates the host name.

HP Hewlett-Packard Company

HPGL Hewlett-Packard Graphics Language

HP-IB Hewlett-Packard Interface Bus. A parallel interface that allows "daisy chaining" of more than

one device to a port on a computer or instrument. Interface protocol is defined in IEEE 488.2;

equivalent to the industry standard GPIB.

HTTP HyperText Transfer Protocol: Used to carry World Wide Web (WWW) traffic.

Hue The dimension of color referred to a scale of perceptions ranging from red through yellow, green,

and blue, and back to red. A particular gradation of color, tint, shade.

I

I/O Input/Output

I/O Path Input/Output Path

IEEE Institute of Electrical and Electronic Engineers

IF Intermediate Frequency: the frequency at which a signal is processed after mixing.

Impedance The ratio of voltage to current at a port of a circuit, expressed in ohms.

Initialize The process that assigns information locations to a disk to prepare the magnetic media to

accept files.

Input A path intended for putting a signal into an instrument.

Most network analyzers have either 3 (labeled A, B, and R) or 4 inputs (labeled A, B, R1, and R2).

Inputs are not the same as channels.

Input Attenuator An attenuator between the input connector and the first mixer of a spectrum
analyzer (also called an RF attenuator). The input attenuator is used to adjust the signal level incident to

the first mixer, and to prevent gain compression due to high-level or broadband signals. It is also used
to set the dynamic range by controlling the degree of internally-generated distortion. For some

analyzers, changing the input attenuator settings changes the vertical position of the signal on the
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display, which then changes the reference level accordingly. In Keysight microprocessor-controlled

analyzers, the IF gain is changed to compensate for changes in input attenuator settings. Because of

this, the signals remain stationary on the display, and the reference level is not changed.

Insertion Loss The difference between the power measured before and after the insertion of a device.

The attenuation between the input and output of a device.

Intensity Brightness; emitting or reflecting light; luminosity.

Interface A connection that allows a common communication link between two or more instruments.

Intermodulation Distortion Undesired frequency components resulting from the interaction of two or

more spectral components passing through a device having nonlinear behavior, such as a mixer or an

amplifier. The undesired components are related to the fundamental components by sums and

differences of the fundamentals and various harmonics. The algorithm is: f1 ±f2, 2xf1 ±f2, 2xf2±f1,

3xf1 ±2x f2, and so on.

Internet The connection of two or more distinct networks. Often a gateway or router is used to make

the connection.

Interpolate To determine a value of a signal between to adjacent points by a procedure or algorithm.

IP Internet Protocol

IP Address Internet protocol address: a unique number that is assigned to each device which is to be

connected to a TCP/IP network. Before using an analyzer on a network, your network administrator

will need to assign an IP address. An IP address consists of a 32-bit value presented in decimal dot

notation: 4 octets (bytes) separated by a dot.

ISDN Integrated Services Digital Network: A standard digital service capability that features one or

more circuit-switched communication channels capable of carrying digital voice, data, or image

signals, a packet-switched channel for out-of-band signaling and control. In addition, ISDN provides a

collection of standard and optional features that support information productivity for the user,
providing higher-speed Internet access than analog systems.

ISO International Standards Organization

Isolation A specification or measure of the immunity that one signal has to being affected by another
adjacent signal. The occurrence is known as crosstalk.

Isolator An RF device used for providing isolation between paths and components. Made from a 3-port

circulator, the third port being terminated in a 50ohm load.

J
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K

Kilo Prefix for one thousand.

KB Kilobyte

Kb/s Kilobytes per second

L

LAN Local Area Network

LANS Local Area Network System

LCD Liquid Crystal Display

LED Light Emitting Diode

LIF Logical Interchange Format (used for older HP disk drives/computers)

Limit Lines Lines input by the user that overlay the analyzer's measurement data to allow automatic

detection of data that is out of the acceptable range. Pass/Fail annotation, audio alarms, or electronic

output can be triggered to notify the operator or on-line computer program of the over-limit condition.

Limit-Line File The user-memory file that contains the limit-line table entries.

Limit-Line Table The line segments of a limit line are stored in the limit-line table. The table can be

recalled to edit the line segments, then restored in the limit-line file.

Linear Device A device in which the output is continuously proportional to the input.

LO Local Oscillator. In a superheterodyne system, the LO is mixed with the received signal to produce
a sum or difference equal to the intermediate frequency (IF) of the receiver.

LO Feedthrough The response that in a superheterodyne system when the first local oscillator

frequency is equal to the first IF.

Load A one port microwave device used to terminate a path in its characteristic impedance.

Load Match A measure of how close the device's terminating load impedance is to the ideal

transmission line impedance. Match is usually measured as return loss or standing wave ratio (SWR) of

the load.

Local Lock Out A condition or command that prevents analyzer front-panel entries (and disables the
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Local key).

Local Operation To operate manually from the front panel.

Log Logarithm

Log Display The display mode in which vertical deflection is a logarithmic function of the input signal

amplitude. Log display is also called logarithmic display. The display calibration is set by selecting the

value of the reference level position and scale factor in dB per division.

LRM Line-Reflect-Match. See Calibration, TRL, and LRM.

M

Magnitude The amplitude of a signal measured in its characteristic impedance without regard to phase.

See also Scalar.

Marker A graphical symbol along a display trace that is annotated with measurement characteristics of

that specific data point.

Marker Functions Mathematical or statistical computation on the data of one or more markers to

provide the operator more information. For example, the marker delta function calculates and displays

the difference between two markers.

Maximum Input Level The maximum signal power that may be safely applied to the input of an

analyzer. The maximum input level is typically 1 W (+30 dBm) for Keysight spectrum analyzers.

MB Megabyte

Measurement Uncertainty The quantified amount of error in a measurement situation. Calibrations

are intended to reduce the amount of uncertainty. The following are sources of measurement errors that

lead to uncertainty:

Systematic errors (imperfections in calibration standards, connectors, cables, and instrumentation)

Random errors (noise, connector repeatability)

Drift (source and instrumentation)

Mega Prefix for one million.

Memory A storage medium, device, or recording medium into which data can be stored and held until

some later time, and from which the entire original data may be retrieved.

Memory Card A small memory device shaped like a credit card that can store data or programs.
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Menu The analyzer functions that appear on the display and are selected by pressing front panel keys.

These selections may invoke a series of other related functions that establish groups called menus.

MHz Megahertz

milli Prefix for one-thousandth.

Modem Modulator/Demodulator

Modulation The process, or the result of the process, of varying a characteristic of a carrier signal with

an information-bearing signal, causing the carrier to contain the information. See AM and FM.

Monitor Any external display.

Monochrome Having only one color (chromaticity).

ms Millisecond

mW Milliwatt: one thousandth of a watt

Multisync A type of monitor that can synchronize its horizontal sweep to various frequencies within a

specified range.

N

Narrowband In network analysis, the frequency resolution of the analyzer's receiver that is sufficiently

narrow to resolve the magnitude and phase characteristics of narrowband devices. The reduced receiver

bandwidth usually decreases the noise floor of the receiver, providing more measurement amplitude

range.

Narrowband Device A device whose transfer characteristics are intended to operate over a very

narrow frequency range and are designed to provide well-defined amplitude responses in that range,

such as a band pass filter.

Network Analysis The characterization of a device, circuit, or system derived by comparing a signal

input going into the device to a signal or signals coming out from the device.

NIST National Institute of Standards and Technology

Nit The unit of luminance (photometric brightness) equal to one candela per square meter.

Noise Random variations of unwanted or disturbing energy in a communications system from man-

made and natural sources that affects or distorts the information carried by the signal. See also Signal-to-
Noise Ratio.
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Noise Figure (F): For a two-port device, a measure of how the noise generated inside the device

degrades the signal-to-noise ratio of a signal passing through the device at 290 degrees, usually

expressed in dB.

Noise Floor The analyzer's internal displayed noise. The noise level often limits how small a signal

magnitude can be measured. In network analysis, noise floor is measured with the test ports terminated

in loads, full two-port error correction, 10 Hz IF bandwidth, maximum test port power, and no

averaging during the test.

Non-Insertable Devices In measurement calibration, a device that cannot be substituted for a Zero-
Length Through Path. It has the same type and sex connectors on each port, or a different type of

connector on each port.

Nonvolatile Memory Memory data that is retained in the absence of an ac power source. This memory

is typically retained with a battery. Refer also to battery-backed RAM.

Normalize To subtract one trace from another to eliminate calibration data errors or to obtain relative

information.

O

Offset To move or set off a determined amount. Used in instruments for offsetting frequencies, limits,

delay, loss, impedance, etc.

Output Attenuation The ability to attenuate the signal, the source, in order to control its power level.

P

PC Personal Computer

PDF Portable Document Format (used on the Web)

Parser, Command Reads program messages from the input queue of a device in the order they were

received from the controller. The parser determines what actions the analyzer should take. One of the

most important functions of the command parser is to determine the position of a program message in

the analyzer SCPI command tree. When the command parser is reset, the next element it receives is

expected to arise from the base of the analyzer command tree.

Peak Search A function on an analyzer that searches for the largest response and places a marker on it.

Phase The fractional part of a cycle through which an oscillation has advanced, measured from an

arbitrary starting point; usually measured in radians or degrees. In network analysis, the phase response

of the device under test is the change in phase as a function of frequency between the input stimulus
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and the measured response.

Port The physical input or output connection of an instrument or device.

Port Extension Redefining the reference plane to other than that established at calibration. A new

reference plane is defined in seconds of delay from the test set port.

Positive Peak The maximum, instantaneous value of an incoming signal.

Postscript (.ps files) Stores bitmapped graphics files in an encapsulated format for direct use by

postscript printers.

Power, Max Input The upper limit to input power for which the specifications apply. Some

specifications may have different levels of maximum inputs. For example, compression power

maximum is usually higher than the harmonic distortion maximum.

Power, Safe Input The input power, usually in dBm, allowed without damaging the instrument.

Preset A pre-defined instrument state (that also runs an analyzer self-test). The action of pushing the

Preset key.

Protocol A set of conventions that specify how information will be formatted and transmitted on a

network, and how machines on a network will communicate.

Q

Q or Q Factor The ratio of energy stored to energy lost in a resonant circuit. High Q indicates a sharp

resonance response over frequency.

Query Any analyzer programming command having the distinct function of returning a response.

These commands may end with a question mark (?). Queried commands return information to the

computer.

R

r + jx Expression for complex impedance, where r represents the resistive portion and x represents the
reactive portion.

R Channel Reference Channel

RAM Random Access Memory, or read-write memory: A storage area allowing access to any of its
storage locations. Data can be written to or retrieved from RAM, but data storage is only temporary.

When the power is removed, the information disappears. User-generated information appearing on a
display is RAM data.
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ROM Read Only Memory: A storage area that can be read only; it cannot be written to or altered by the

user. In instruments, the storage area that contains the "brains" or operational programming; the

firmware.

Receiver A circuit or system designed for the reception and/or measurement of signals in a specified

frequency spectrum.

Receiver Dynamic Range See Dynamic Range.

Reference Level An instrument function that allows the user to set the amplitude value at the reference

position. On network analyzers, the reference position is also selectable. On some spectrum analyzers,

the reference position is fixed at the top of the display.

Reference Plane The electrical location at which a network analyzer assumes the system connectors

and fixturing ends and the DUT begins. The reference plane is set by using calibration standards with

known electrical length. The closer the reference plane is to the device under test (DUT), the better the

characterization of the device because of the elimination of test system uncertainties.

Reference Receiver  In a network analyzer, the receiver that measures signals as they come out of the

source, before they are incident on the test port and DUT. Typically, these signals are used to compare

with the signal at the Test Port Receiver, to determine the affect that the DUT has on the signal. In a 2-

port network analyzer, these are typically named 'R1' (port 1) and 'R2' (port 2). See a block diagram of

the receivers in your PNA.

Reflection The phenomenon in which a traveling wave strikes a discontinuity and returns to the

original medium.

Reflection Coefficient The ratio of the reflected voltage to the incident voltage into a transmission line

or circuit. If a transmission line is terminated in its characteristic impedance, the reflection coefficient

is zero. If the line is shorted or open the coefficient is 1. See also Return Loss and SWR.

Reflection Measurements Measurements that characterize the input and /or output behavior of the

device under test (DUT). Measured as the ratio of the reflected signal to the incident signal as a

function of frequency. Parameters are called return loss, reflection coefficient, impedance, and standing

wave ratio (SWR), all as a function of frequency. See also S-Parameters.

Remote A mode of operation where another device (or computer) controls an instrument via the HP-

IB. In this mode, the instrument front panel keys are disabled. Front panel operation is called local
operation.

Remote Programming The automatic operation of an instrument by a computer, usually through a HP-

IB, LAN, or RS-232 link.

Resolution The ability of a receiver to resolve two signals.
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Resolution Bandwidth The ability of a spectrum analyzer to display adjacent responses discretely

(Hertz, Hertz decibel down). This term is used to identify the width of the resolution bandwidth filter of

a spectrum analyzer at some level below the minimum insertion loss point (maximum deflection' point

on the display). Typically, it is the 3 dB resolution bandwidth that is specified, but in some cases the 6

dB resolution bandwidth is specified.

Return Loss The amount of dB that the reflected signal is below the incident signal. If zero signal is

reflected, the impedance of the device is equal to the characteristic impedance of the transmission

system, and return loss is infinite. If the entire incident signal is reflected, the return loss is zero. See

also S-Parameters, Reflection Coefficient, and SWR.

Reverse Measurement The measurement of a device from output to input.

RF Radio Frequency (from approximately 50 kHz to approximately 3 GHz). Usually referred to

whenever a signal is radiated through the air.

ROM Read Only Memory

S

S/N Signal-to-Noise Ratio

Sampler An electronic component that captures the signal level and phase across a known impedance

at a uniform rate. In Network Analyzers, this sampling rate must be sufficiently high and precisely

timed to make accurate measurements. Network analyzers typically have three or four samplers or

mixers.

Sampler Bounce The leakage or crosstalk between a network analyzer's samplers. Delay in this

crosstalk caused by leakage transmission propagation, give the interference its "bounce" appearance.

Sampler bounce causes an increase in the noise level of the affected channel, reducing the sensitivity of

the analyzer.

Saturation The degree of color purity, on a scale from white to pure color.

Scalar A quantity that has magnitude but no phase. A network analyzer capable of measuring only

magnitude.

Scale Factor The display vertical axis calibration in terms of units per division.

SCPI Standard Commands for Programmable Instruments

Screen The physical surface of the CRT or flat panel upon which the measurement results, setup

information, softkey definitions, and other instrument communication is presented.
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Self-Test A group of tests performed at power-up (or at preset) that verify proper instrument operation.

Sensitivity The minimum input signal required to produce a specified output signal having a specified

signal-to-noise ratio, or other specified criteria.

On a spectrum analyzer, the level of the smallest sinusoid that can be observed, usually under

optimized conditions of minimum resolution bandwidth, 0 dB input attenuation, and minimum video

bandwidth.

The normalized change in YIG component's center frequency resulting from a change in tuning coil

current, specified in MHz/mA.

Serial Prefix The five-character prefix that begins an instrument serial number; used to represent

versions of firmware or hardware changes that have occurred.

Server A device that is configured to provide a service to other devices on a network, such as shared

access to a file system or printer.

Signal-to-Noise Ratio SNR: The ratio of the amplitude of the desired signal to the amplitude of noise

signals, usually expressed in dB and in terms of peak values for impulse noise and root-mean-square

values for random noise.

Single Sweep Mode The spectrum analyzer sweeps once when trigger conditions are met. Each sweep

is initiated by pressing an appropriate front panel key, or by sending a programming command.

Small Signal Gain Compression A situation when the input signal's measured amplitude is less than

its actual level due to overloading of the network analyzer's input mixer; the analyzer is operating

nonlinearly. For broadband analyzer detectors, a signal other than the one under test can put the

analyzer into this gain compressed mode, thereby making even lower level signals appear at a lower

level than actual. The broadband mode measures all the power incident to the analyzer, not just the

signals at the frequency of interest.

Smith Chart A graphical mapping of the complex reflection coefficient into normalized complex

impedance. Circles on the chart represent constant resistance and radiating lines orthogonal to the

circles represent constant reactance. The center of the chart represents the characteristic impedance of

the transmission system. Any point on the chart defines a single complex impedance. A line on the

chart represents changing impedance over frequency.

SOLT Short-Open-Load-Through calibration. See also Calibration, SOLT.

Source A device that supplies signal power; a sweep oscillator or synthesized sweeper.

Source Amplitude Accuracy The amplitude uncertainty, in dB, of the source power readout.

Source Amplitude Flatness The amplitude flatness, in dB, of the source power over the frequency
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range specified.

Source Frequency Resolution The smallest unit of frequency which can be set and/or measured, in

Hz.

Source Frequency Time Base Accuracy A measure of the analyzer's frequency stability measured in

parts per million (ppm. or 1 part in 10E6). For example, a stability of ±5.0 ppm means that an analyzer

will measure 1 MHz to an accuracy of ±5 x 10-6 x 10E6 Hz = +5 Hz.

Source Frequency Time Base Stability A measure of the analyzer's time base accuracy over time and

temperature. Typically the time base accuracy will be specified for 1 year. A typical temperature

frequency stability is ±10 ppm for 250 C± 50 C.

Source Harmonics The level of harmonics generated by the analyzer's signal source, in dBc from the

fundamental.

Source Match A measure of how close the signal source impedance is to the ideal transmission line

impedance of the test system. Match is usually measured as return loss or standing wave ratio (SWR)

of the source.

Span The stop frequency minus the start frequency. The span setting determines the horizontal-axis

scale of the analyzer display.

Span Accuracy The uncertainty of the indicated frequency separation of any two signals on the

display.

S-Parameters (Scattering Parameters) A convention used to characterize the way a device modifies

signal flow using a network analyzer. A two port device has four S-parameters: forward transmission

(S21), reverse transmission (S12), forward reflection (S11), and reverse reflection (S22).

Stop/Start Frequency Terms used in association with the stop and start points of the frequency

measurement range. Together they determine the span of the measurement range.

Storage States The number of settings, programs, traces, and other parameters available to be saved,

cataloged, and recalled at any one time.

Storage, Disk An internal or external digital storage disk for saving test data, instrument settings,

IBASIC programs, and other measurement parameters. Storage formats include MS-DOS (R) and HPs
standard LIF with binary, PCX, HP-GL, or ASCII data formats.

Structural Return Loss Poor return loss in cable due to a periodic fault such as a periodic dent caused

by dropping the cable spool or by the cable pulling process during manufacture.

Supplemental Characteristics Typical but non-warranted performance parameters, denoted as

"typical", "nominal" or "approximate".
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Sweep The ability of the source to provide a specified signal level over a specified frequency range in a

specified time period. Also see Sweep Mode and Sweep Type.

In data processing mode, a series of consecutive data point measurements, taken over a sequence of

stimulus values.

Sweep Mode The way in which a sweep is initiated or selected, e.g., single, continuous, alternate, or

chopped.

Sweep Type The method of sweeping the source, e.g., linear, log, or frequency step.

Sweeper A signal source that outputs a signal that varies continuously in frequency.

SWR Standing Wave Ratio, calculated as (1 + ) / (1 - ) where  is the reflection coefficient.

Sync Synchronization, or Synchronized

Syntax The grammar rules that specify how commands must be structured for an operating system,

programming language, or applications.

System Dynamic Range The difference between the maximum receiver input level and the receiver's

noise floor. System dynamic range applies to transmission measurements only, since reflection

measurements are limited by directivity.

T

T/R See Transmission/Reflection.

Termination A load connected to a transmission line or other device.

Test Limit The acceptable result levels for any given measurement.

Test Port See Port.

Test Port Receiver  In a network analyzer, the receiver directly behind the test ports, used to measure

the signal as it is reflected off, or transmitted through, the DUT. This signal is typically compared with
the signal at the Reference Receiver to determine how the DUT affects a signal. In a 2-port network

analyzer, these are typically named 'A' (port 1) and 'B' (port 2).  See a block diagram of the receivers in
your PNA.

Test Set The arrangement of hardware (switches, couplers, connectors and cables) that connect a test

device input and output to the network analyzer's source and receiver to make s-parameter

measurements.

Third Order Intercept TOI: The power input to a non-linear device that would cause third order
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distortion at the same power level. TOI is a measurement to determine the distortion characteristics of a

mixer or receiver. The higher the value, the more immune the receiver to internal distortion.

Thru Through line: A calibration standard. See Calibration, SOLT.

Tint A shade of color; hue.

Toggle To switch states, usually to change a function from on to off, or off to on.

TOM Thru-Open-Match: A Rohde&Schwarz term to describe a calibration method.

Trace A series of data points containing frequency and response information. The series of data points

is often called an array. The number of traces is specific to the instrument.

Tracking The ability of the analyzer's receiver to tune to the source frequency over the measurement

frequency range. Poor tracking results in amplitude and phase errors due to the receiver IF circuits

attenuating and delaying the device under test output.

Transfer Function The ratio of the output signal to the stimulus signal, both as a function of

frequency.

Transmission See Transmission Measurements.

Transmission Intermodulation Spurious A measure of the capability of the transmitter to inhibit the

generation of intermodulation distortion products. Intermodulation spurious is sometimes called

intermodulation attenuation.

Transmission Measurements The characterization of the transfer function of a device, that is, the ratio

of the output signal to the incident signal. Most common measurements include gain, insertion loss,

transmission coefficient, insertion phase, and group delay, all measured over frequency. See also S-
Parameters.

Transmission/Reflection (T/R) Refers to the suite of measurements made by a scalar or vector
network analyzer to characterize a device's behavior over frequency. See also S-Parameters.

Transparent Something that is not visible to the user. Usually a procedure that occurs without the

user's initiation or knowledge.

Trigger A signal that causes the instrument to make a measurement. The user can select several

options for triggering, such as manual, continuous, or external (for synchronizing measurements to an
external source).

TRL Through-Reflect-Line. See Calibration, TRL and LRM.

TTL Transistor-Transistor Logic
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Two-Port Error Correction See Error Correction, 12-Term.

U

Uncorrected Measurements made without performing error correction.

Uncoupled Channels Stimulus or receiver settings allowed to be set independently for each channel.

UNI User-Network Interface: The point at which users connect to the network.

Units Dimensions on the measured quantities. Units usually refer to amplitude quantities because they

can be changed. In analyzers with microprocessors, available units are dBm (dB relative to 1 mW

dissipated in the nominal input impedance), dBmV (dB relative to 1 mV), dBW (dB relative to 1 1W),

V (volts), W (watts).

V

Variable A symbol, the value of which changes either from one iteration of a program to the next, or

within each iteration of a program.

Vector A quantity that has both magnitude and phase.

A network analyzer capable of measuring both magnitude and phase.

VEE Visual Engineering Environment (Keysight software product)

Velocity Factor A numerical value related the speed of energy through transmission lines with

different dielectrics (.66 for polyethylene). Used in making time domain measurements.

Vertical Resolution The degree to which an instrument can differentiate amplitude between two

signals.

Video An electrical signal containing timing, intensity, and often color information that, when
displayed, gives a visual image.

Video Bandwidth In spectrum analyzers, the cutoff frequency (3 dB point) of an adjustable low-pass

filter in the video circuit. When the video bandwidth is equal to or less than the resolution bandwidth,

the video circuit cannot fully respond to the more rapid fluctuations of the output of the envelope

detector. The result is a smoothing of the trace, or a reduction in the peak-to-peak excursion, of

broadband signals such as noise and pulsed RF when viewed in broadband mode. The degree of

averaging or smoothing is a function of the ratio of the video bandwidth to the resolution bandwidth.

Video Filter In spectrum analyzers, a post-detection, low-pass filter that determines the bandwidth of

the video amplifier. It is used to average or smooth a trace. Refer also to Video Bandwidth.
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VNA Vector Network Analyzer

W

Waveform A representation of a signal plotting amplitude versus time.

Wireless A term that refers to a broad range of technologies that provide mobile communications for

home or office, and "in-building wireless" for extended mobility around the work area, campus, or

business complex. It is also used to mean "cellular" for in-or out-of-building mobility services.

WWW World Wide Web

X

 

Y

 

Z

Zero-Length Through Path In a measurement calibration, when the two test cables mate together

directly without using adapters or a thru-line. See also Non-Insertable Devices.
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Specifications - Select the Analyzer Model

PXI Specifications

The specifications are stored ONLY on the internet.

Doc Number Model
M9370-90002 M9370A - 4 GHz

M9371A - 6.5GHz

M9372A - 9 GHz

M9373A - 14 GHz

M9374A - 20 GHz

M9375A - 26.5 GHz
5992-0756 M9485A

See the equations that are used to generate uncertainty curves.
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